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1 Upgrade to this version

When you are ready to upgrade to a new version of Tekla Structural Designer:

1. Read the Tekla Structural Designer 2020 release notes (page 37) to get to
know what has changed since the previous version:

2. Check the supported operating system versions and hardware
requirements (page 89) for this version.

3. Update the licenses, as explained in Upgrade Tekla Structural Designer to
a new version (page 90), or apply a service pack to a previously installed
version as explained in Install a Tekla Structural Designer service pack
(page 96).

1.1 Tekla Structural Designer 2020 release notes
Welcome to Tekla Structural Designer 2020!

Select your headcode/region from the list below to see the many new features
and improvements that apply to you in this version:

US
Issues with Associated Bulletins

• [TSD-6440] - Snow Loading - US Head Code & ASCE 7-2016 - for Roof
Projection and Parapet Snow Drift loads to Cl.7.8 of ASCE7-16, the
Importance factor value was used directly in the calculation of the drift
height hd rather than its square root per the equation of Figure 7.6-1. This
could produce unconservative drift load values for some risk categories.
For more information please see: Product Bulletin PBTSD-2003-1.

• This issue is addressed in this release.

General & Modelling
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• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

• Enhanced Grasshopper Link for Live Parametric Modeling and Analysis
(page 42)

• New Beam End Partial Fixity (page 43)

• Improved Selection & Editing and Level Creation at a Point (page 47)

Loading

• Load Combination Generator - enhanced with intelligent generation of
default combinations (page 50)

• New Diaphragm Load type - allows application of single lateral and torsion
loads to diaphragms (page 51)

Analysis & Results

• Analysis & Design Process - automatic termination when extremely large
deflections occur (page 49)

• New Review-View Control of Cracked/Uncracked Setting for Concrete
Members (page 53)

• New 2D In-Plane Stress Contouring useful for assessing extent of cracking
of Concrete Walls (page 54)

Design

• Steel Simple Connection Resistance Check - Significantly enhanced with
new database of Standard Connections (page 56)

• Concrete Design - Result Line Design saving of reinforcement and manual
design forces (page 70)

• Seismic Analysis & Design Enhancements (page 72)

BIM Integration

• New Trimble Connect Integration Link (page 77)

• New Integration with ETABS (page 81)

• New Tekla Open API (page 83)

Other

• Minor Enhancements and Fixes (page 83)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

Eurocode
General & Modelling

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

Upgrade to this version 38 Tekla Structural Designer 2020 release notes



• Enhanced Grasshopper Link for Live Parametric Modeling and Analysis
(page 42)

• New Beam End Partial Fixity (page 43)

• Steel Beams - New Section Database of Peikko DELTABEAM beams
(page 45)

• Improved Selection & Editing and Level Creation at a Point (page 47)

Loading

• New Diaphragm Load type - allows application of single lateral and torsion
loads to diaphragms (page 51)

Analysis & Results

• Analysis & Design Process - automatic termination when extremely large
deflections occur (page 49)

• New Review-View Control of Cracked/Uncracked Setting for Concrete
Members (page 53)

• New 2D In-Plane Stress Contouring useful for assessing extent of cracking
of Concrete Walls (page 54)

Design

• Steel Simple Connection Resistance Check - Significantly enhanced with
new database of Standard Connections (page 56)

• Steel - New Fire Resistance Check (page 58)

• Steel - New Design for High Shear in Combined Bending & Axial Check
(page 61)

• Concrete - Result Line Design saving of reinforcement and manual design
forces (page 70)

• New Precast Concrete Member design via Tekla Tedds 2020 Integration
(page 63)

• New option for presumed bearing capacity method for Mat Foundation
(page 74)

BIM Integration

• New Trimble Connect Integration Link (page 77)

• New Bi-directional FBEAM® Link for design of FABSEC® Beams (page 79)

• New Integration with ETABS (page 81)

• New Tekla Open API (page 83)

Other

• Minor Enhancements and Fixes (page 83)
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BS
General & Modelling

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

• Enhanced Grasshopper Link for Live Parametric Modeling and Analysis
(page 42)

• New Beam End Partial Fixity (page 43)

• Improved Selection & Editing and Level Creation at a Point (page 47)

Loading

• New Diaphragm Load type - allows application of single lateral and torsion
loads to diaphragms (page 51)

Analysis & Results

• Analysis & Design Process - automatic termination when extremely large
deflections occur (page 49)

• New Review-View Control of Cracked/Uncracked Setting for Concrete
Members (page 53)

• New 2D In-Plane Stress Contouring useful for assessing extent of cracking
of Concrete Walls (page 54)

Design

• Concrete - Result Line Design saving of reinforcement and manual design
forces (page 70)

BIM Integration

• New Trimble Connect Integration Link (page 77)

• New Integration with ETABS (page 81)

• New Tekla Open API (page 83)

Other

• Minor Enhancements and Fixes (page 83)

India
General & Modelling

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

• Enhanced Grasshopper Link for Live Parametric Modeling and Analysis
(page 42)

• New Beam End Partial Fixity (page 43)

• Improved Selection & Editing and Level Creation at a Point (page 47)

Loading
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• Load Combination Generator - enhanced with intelligent generation of
default combinations (page 50)

• New Diaphragm Load type - allows application of single lateral and torsion
loads to diaphragms (page 51)

• Wind Wizard for Indian Head Code Updated to IS 875 (Part 3) : 2015
(page 51)

Analysis & Results

• Analysis & Design Process - automatic termination when extremely large
deflections occur (page 49)

• New Review-View Control of Cracked/Uncracked Setting for Concrete
Members (page 53)

• New 2D In-Plane Stress Contouring useful for assessing extent of cracking
of Concrete Walls (page 54)

Design

• Steel Design - New Design of Plated Beam and Columns for the Indian
Head Code (page 62)

• Concrete Design - Result Line Design saving of reinforcement and manual
design forces (page 70)

• New Design Warning Controls - Indian Head Code (page 76)

BIM Integration

• New Trimble Connect Integration Link (page 77)

• New Integration with ETABS (page 81)

• New Tekla Open API (page 83)

Other

• Minor Enhancements and Fixes (page 83)

Australia
General & Modelling

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

• Enhanced Grasshopper Link for Live Parametric Modeling and Analysis
(page 42)

• New Beam End Partial Fixity (page 43)

• Improved Selection & Editing and Level Creation at a Point (page 47)

Loading

• New Diaphragm Load type - allows application of single lateral and torsion
loads to diaphragms (page 51)
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Analysis & Results

• Analysis & Design Process - automatic termination when extremely large
deflections occur (page 49)

• New Review-View Control of Cracked/Uncracked Setting for Concrete
Members (page 53)

• New 2D In-Plane Stress Contouring useful for assessing extent of cracking
of Concrete Walls (page 54)

Design

• Concrete Design - Result Line Design saving of reinforcement and manual
design forces (page 70)

• Foundation Design - New Pile Cap Design for Australian Head Code to AS
3600 : 2009 (page 75)

BIM Integration

• New Trimble Connect Integration Link (page 77)

• New Integration with ETABS (page 81)

• New Tekla Open API (page 83)

Other

• Minor Enhancements and Fixes (page 83)

Compatibility
We suggest that you complete any unfinished models using your current
version of Tekla Structural Designer.

This version is not backwards compatible. When you create or save a model in
Tekla Structural Designer 2020, you cannot open it in older versions due to
database differences.

We suggest that Tekla Structural Designer 2020 is only installed on systems
meeting these hardware recommendations (page 89).

If you are upgrading from a version earlier than the latest release 2019i SP3
(version 19.1.3.17 released Jan 2020) you can find details of requirements,
enhancements and fixes for all previous releases in Tekla User Assistance
(TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads
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Enhanced Grasshopper Link for Live Parametric Modeling
and Analysis
The Grasshopper-Tekla Structural Designer (GH-TSD) live link, first released in
the 2019i version, enables parametric modelling for Tekla Structural Designer
using Rhino (64-bit)/Grasshopper. The link is comprised of a set of
Grasshopper components that can create and update objects live in Tekla
Structural Designer. For full information on how to get started with the link see
the TUA article Grasshopper - Tekla Structural Designer Live Link.

In this release the link is further enhanced with new controls for loading and
analysis...

• Note that the Grasshopper Link currently functions for the US Head Code
and Eurocode (all Countries/ NA’s) Head Code.

• Also see this video demonstrating the link in action.

Related video

Data driven design with Grasshopper

New Beam End Partial Fixity
A new partial fixity option is added for beam end fixity. This will be especially
useful for example when modelling precast concrete structures in which it is
common to to consider some amount of end fixity, but not full end fixity
(which is commonly assumed for in-situ concrete buildings).

See this video demonstrating partial fixity in action.
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The new end fixity settings are available for review and edit both in the
individual member dialog and the Properties Window for selected beam(s) as
shown in the picture below.

• To apply the new end fixity setting, first set the end Fixity to “Fully fixed” to
enable the new fixity options of “Spring linear” and “Partially fixed”.

• For “Spring linear” a value of stiffness in moment/rad is directly entered.

• For “Partially fixed” a % value is entered. Note that this is the % of the
member flexural stiffness of 4EI/L (not of full fixity), the value of which is
automatically calculated and applied in the analysis model.

End fixity settings can also be applied and verified efficiently via Review View >
Show/Alter State, using the new Rotational Stiffness (page 890) Attribute.

• Use Set mode to rapidly apply or edit the % Partial fixity and Rotational
stiffness values.
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• Use Review mode, to display the values in an automatic color-coded range
as shown below.

Related video

Automatic modelling of partial fixity

Steel Beams - New Section Database of Peikko DELTABEAM
beams
DELTABEAM (page 411)® beams manufactured by Peikko in Finland are now
added to the Steel section databases for the Nordic countries of Finland,
Sweden and Norway and the general Europe database. This proprietary beam
type is typically used in long span. slim floor systems in which they are cast
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into and act compositely with the floor slab. With this addition, floors of this
type can now be modelled and analysed in Tekla Structural Designer.

• A new dedicated DELTABEAM (page 411)® option is added to the droplist of
Steel Beam types on the Model Ribbon. When working from the Properties
Window, set the Fabrication to DELTABEAM® to apply the new sections as
shown below.
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• Two series of DELTABEAM® sections are then available for selection; D-type
internal and DR-type edge. Currently only the section properties required
for analysis are defined in the database hence there is no design for them
within Tekla Structural Designer. A report of design forces can be produced
for external design.

Related video

Easy modeling of Peikko Deltabeams

Improved Selection & Editing and Level Creation at a Point
These ease of use enhancements are made in Tekla Structural Designer 2020
to improve the effectiveness and efficiency of modeling.
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Selection and Editing
• Selected objects are now highlighted in two colours identifying which are

Active (type selected in property grid) and Remaining. This helps clarify the
case where a single span/stack of a member is the active selection.

• Additionally, the Tooltip and member selection defaults to objects of the
Active type first, making it much easier to focus work on a given object
type.

Level Creation at a point
A construction point can now be selected and a level created at its elevation.
This is particularly useful for example for creating a level at the apex of a
Portal Frame or at a point along an inclined plane. This enhancement adds the
following information and capabilities:

• Construction Points can now be selected, including Free points (note that
“points” must be active in scene content).

• The following information is displayed in the cursor Tooltip for the selected
point:

• The associated plane.

• The Global coordinates of the point (to the precision set in Home >
Model Settings > Units).
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• When you right click on a point the context menu now includes the option
to “Create Level” for the point elevation (if no level exists).

Analysis & Design Process - automatic termination when
extremely large deflections occur
[TSD-3399] The Analysis & Design Process will now terminate automatically
when extremely large deflections* result from the First Order Linear 3D
Building Analysis (which is always at the beginning of any Analysis & Design
process). This will prevent the process continuing to higher order forms of
analysis - such as non-linear - and the design phase, which may expend
considerable processing resources and time running potentially into several
hours before the process ultimately fails. This will prove to be a waste of time
if the model contains errors which need to be addressed before running
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design. A typical example of the new termination and the message issued in
this case is shown in the picture below.

*Such extremely large deflections are usually the result of mechanisms in the
model - from for example incorrect connectivity or too many releases etc. We
recommend these are always investigated and resolved before attempting
Design. See the following TUA articles for guidance on what to do in this case;
Guide to resolving Mechanisms and (N-1) rule for the number of pins to apply
at a node where N members meet.

Load Combination Generator - enhanced with intelligent
generation of default combinations
[TSD-3624] From investigation and customer feedback on the use of previous
releases, it was found that many engineers were simply accepting the
combination generator defaults which could produce many unnecessary
combinations. Additional intelligence is now built into the Load Combination
Generator to produce fewer combinations by default, appropriate to the
content and design settings of the model. Since the Analysis and Design
process’s speed and duration are directly related to the number of
combinations (potentially geometrically), this could significantly improve
performance.

• For example for the US Head Code, ASD combinations* are not required in
general where the LRFD code has been selected for steel design. Not
generating the ASD combinations can halve the total number. Such
superfluous combinations will no longer be generated by default in this
circumstance potentially significantly improving performance.

• *Note that ASD combinations are NOT required for foundation design
for US Head Code models.
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New Diaphragm Load type - allows application of single
lateral and torsion loads to diaphragms
To assist with applying loads of a single value of lateral and torsion load per
floor in a building, a new Diaphragm load (page 547) tool is added. Such loads
may be needed for example for tall/ atypical structures requiring wind tunnel
testing for wind loading which is then provided as total lateral and torsion
level loads.

Related video

Diaphragm loading
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Wind Wizard for Indian Head Code Updated to IS 875 (Part
3) : 2015
Following popular requests, the Wind Wizard for the Indian Head Code has
been fully revised and updated to the new IS 875 (Part 3) : 2015 (incorporating
amdt. no.1 April, 2016).

• The new 2015 code year option is selected in the Design Codes > Action
Codes settings as shown in the picture above.

• With this selected the Wind Wizard determined pressures are calculated
considering all the relevant and newly introduced design factors of the
2015 code version.

• The update allows cyclonic design effects to be considered for structures
situated on the Indian east and west coasts (Gujarat coastal region).

• Key aspects of the Wind code update are:

• Classification of building class (A, B and C) based on structure’s greatest
horizontal or vertical dimension (exposed to wind) as per Cl.5.3.2.2 (of IS
875 (Part 3) - 1987 (reaff.2003) has been omitted in the new code.

• A new importance factor for cyclonic region k4 (Clause 6.3.4) is
introduced for the wind pressure determination.

• For the design wind pressure determination the following new factors
are introduced:

• Kd - wind directionality factor (Clause 7.2.1)

• Ka - area averaging factor (Clause 7.2.2)

• Kc - combination factor (Clause 7.3.3.13)

• Design wind speed is now (Vz) = Vb x k1 x k2 x k3 x k4; wind pressure pz
= 0.6 x Vz2 and design wind pressure (Pd) = Kd x Ka x Kc x pz

• Certain values in the table for pressure coefficient, figures for factors
associated with cliff and escarpment and ridge and hill topography have
been updated.
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New Review-View Control of Cracked/Uncracked Setting for
Concrete Members

NOTE This feature goes together with the New 2D In-Plane Stress Contouring
(page 54) to facilitate more rapid assessment and control of the appropriate
analysis properties to use for concrete buildings.

You can now graphically modify the assume cracked property (page 875) for all
concrete elements via Show\Alter State.

NOTE The assumed cracked property controls the modification factors used
for the concrete members in analysis - for more on this topic see:
Where do the default values for cracked and uncracked properties of
concrete come from?

• This should prove a significant time saver for those spending time making /
applying decisions on what is cracked.

• The Mode options allows switching between Toggle and Set Cracked or
Uncracked - objects can then be clicked or windowed to edit the setting.
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• Additionally the Entity type can be set to restrict editing to only certain
object types; Members, Walls, Beams or Columns.

See also

Concrete member cracked or uncracked status (page 1286)

New 2D In-Plane Stress Contouring useful for assessing
extent of cracking of Concrete Walls
New 2D stress contours are added to the existing options giving the in-plane
stresses in 2D element meshes.

• The in-plane stress is in effect the average stress through the thickness of
the element, which we think will be of greater interest to more engineers
especially those wanting to assess the extent of cracking in concrete walls.
For this purpose the (vertical) “σy in-plane tension” result will be of most
use.

• This will be the case especially when the engineer creates envelopes, which
will make it very easy to see panels with zero tension (which could then be
set to uncracked).

• This feature goes together with the New Review-View Control of Cracked/
Uncracked Setting for Concrete Members (page 53) to facilitate more rapid
assessment and control of the appropriate analysis properties to use for
concrete buildings. The user can have two side-by-side views open to
simultaneously review the stress contour results via one and review/edit
the Assume cracked setting via the other.
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See also

Concrete member cracked or uncracked status (page 1286)
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Connection Resistance Check - Significantly Enhanced with
new database of Standard Simple Connections
The Connection Resistance check is a quick and simple way of checking the
capacity of Simple Connections in beams (major axis shear) and braces (axial
compression or tension). It is a long standing feature which was enhanced in
release 2018i to allow definition of any number of connection types and
resistances. For this release it has been completely overhauled and
significantly enhanced, improving the ability for engineers to identify, early in
the design process, potential issues with forming standard simple
connections.

Details of the enhancements are:

• Pre-defined Resistances database (page 1009) - the existing functionality
is retained, but now includes a large in-built database of pre-defined
resistances for the Eurocode and US Head Codes in new viewer format
which includes significantly more detail about the connection
configuration.

• New Connection Resistance dialog (page 2399) - as shown in the pictures
below, the new viewer now separates Beams and Braces and has multiple
new controls to define the configuration of the connection in terms of;
Steel Grade, Number of Notches, Bolt Lines and Rows and, for the US Code,
plate thickness and bolt sizes.

• The engineer can now also control the connection types and individual
resistances to be considered by the check using the ‘Active’ checkbox in
the Resistances Table. Multiple rows can be selected and Inactivated/
Activated simultaneously in the usual manner.

• Additionally a number of criteria can be set to automatically filter the
active list using the Activate/Deactivate... dialog (see picture
below)

• New Connection Types and Resistances can also be added.

• Existing resistances defined in previous releases will be imported.
However further action is required for these - please see the Install the
upgrade (page 91) section for what to do.
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• Enhanced Check (page 809) - as well as the new database of pre-defined
resistances and additional connection details, the check itself has also been
enhanced and refined:

• Now both (pin) ends of the beam are checked, with the gravity shear
now reported as a positive value for the Rh end of beam

• Optimisation - the check now loops through active Bolt Lines & Rows
and reports first passing and last failing resistance (applies to both pre
and user-defined resistances)

• A warning is now issued where uplift occurs (since the connection
resistance is not checked for this condition)

• Report - a new “Connection Resistance” report is added to the list of
available default reports which contains all the available Connection
Resistance report items (Beams and Braces for both Steel and Cold
Formed).

Related video

Predefined connection resistance database for Eurocode and AISC

Steel Design - New Fire Resistance Check to Eurocode EN
1993-1-2, Cl 4.2.4 - All NA’s
A new simple to use Steel Fire Resistance design check is added in this release
in accordance with EN 1993 & the National Annex for; the UK, Ireland,
Singapore, Malaysia, Sweden, Norway, Finland or the recommended Eurocode
values. The check is carried out in the temperature domain by using the critical
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temperature method per EN 1993-1-2, Cl 4.2.4. Detailed, transparent and
comprehensive design details are reported, including the Temperature-Time
relationship graph per EN 1991-1-2 Cl.3.1 (10) as shown below.

• The design calculation checks the mechanical resistance of a single steel
member in case of fire for a required time of exposure which is set by the
engineer in the check properties.

• The Fire check parameters can be set in the member dialog for a single
member and are also listed in the Properties Windows, as shown in the
picture below.

• There is an additional setting in Design > Settings > Fire check for the
time interval for critical temperature iteration.

• The steel member may be unprotected (bare steel) or protected and may
be exposed on 3 (under a slab) or 4 sides.

• Specified protection can be Contour or Hollow encasement for which
the engineer then specifies the; thickness, thermal conductivity, specific
heat and density.

• The design scope is as follows:

• Beam characteristic (Non-composite) with fabrication type of Rolled

• Single span, pin-ended and restrained beam members subjected to
Major axis bending only.

• The check is applied only to gravity combinations and is a check only -
i.e. is not considered as an Auto Design criteria.
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Steel Design - New Design for High Shear in Combined
Bending & Axial Check - Eurocode EC3 All NA’s
Previously beyond scope in steel beam design, design for high shear in the
combined bending and axial check is now checked. The new calculations have
been based on Eurocode EC3 part 1 and also with reference to the research
paper ‘Resistance of steel cross-sections subjected to bending, shear and axial
forces’ by Jerzy Goczek and Lukasz Supel, Engineering Structures 70 (2014)
271-277, Elsevier.

• No additional input is required for the new check - valid beam members
which satisfy the load condition requirements will automatically be
designed for high shear where this exists. The new check is considered in
the autodesign routine thus sections failing the check will not be selected
and further section sizes will be attempted.

• The scope of the new check is as follows:

• Members: doubly symmetric rolled or plated I section beams

• Loading: uniaxial major bending and axial force with major axis high
shear is the only condition for which high shear will be designed

• Note the presence of torsion force (above the ignore torsion force
level) will not be a valid load condition for the high shear check,
regardless of whether ‘check for torsion’ is ticked on or off, and will
result in Beyond Scope status

• Note that where the shear web buckling exceeds 50% of capacity,
this will not be a valid condition for the high shear check, hence will
result in Beyond Scope status.

• A new warning will be displayed in each of the three buckling checks when
high shear is present (including minor axis high shear and for non-valid
members and loading conditions). This states that buckling design is
assumed to be unaffected by the presence of high shear (which is not
explicit in EC3 but mirrors the statement in BS5950 clause 4.8.1).
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Steel Design - New Design of Plated Beam and Columns for
the Indian Head Code
Expanding the design capabilities for India, steel plated beams and columns
can now be designed to IS 800 : 2007.

The new design capability caters for both checking and autodesign.
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Key aspects of the new design are:

• In developing the design process, reference has been made to BS 5950-1:
2000 and EN 1993-1-1 : 2005 for some aspects of design not covered in IS
800 : 2007.

• The scope of the new check is as follows;

• Beam characteristic (Non-composite) and Column characteristic with
fabrication type of Plated and Plated I sections only.

• Design of Class 4 slender sections is supported for axial compression
and for Flexure.

• Moment Minor + High shear is beyond scope as is Slender section +
High shear.

• Connection details between the flange plate and web plate are not
considered.
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New Precast Concrete Member modeling and design via
Tekla Tedds 2020 Integration
In an exciting development, integration with Tekla Tedds has been thoroughly
enhanced to allow the efficient design of precast concrete beams (page 1540)
and columns (page 1554) using the new in Tedds 2020 precast concrete
member design calculations.

See the feature in action in this video.

NOTE Use of this feature requires an installation of and license for Tekla Tedds
2020.

The workflow (page 1528) fully supports multiple analysis and design loops and
even Design Groups (when these are enabled, which is the default), just as for
in-situ concrete design within Tekla Structural Designer.

Key aspects of the new integrated design process and workflow are:

• The “Fabrication” property of precast beams and columns is first set to
“Precast” to enable the new dedicated precast settings and integrated
Tedds design for the members. A dedicated ‘Precast’ option is also added
to the drop list options for the Concrete Column, Beam and Wall buttons of
the Model Ribbon as shown below.

• The engineer should also decide at an early stage if they wish to use
Design Groups and enable/ disable these accordingly via Design > Settings
> Design Groups for Concrete Beams and/ or Columns.

• New beam section shapes are added in Tekla Structural Designer for
precast concrete beams to match the section options in the Tedds
calculation; L-section, T-section and inverted options of both these.

• For precast concrete beams, multiple design sections are populated in
the Tedds calculation as required. These are determined by the Design
settings for Precast beams which specify the bar patterns and regions
as shown below.

• There are also reinforcement and general settings for precast concrete
columns which control initial values set in the Tedds calculation.
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• The design link can be run for individual members in the model via the
right-click member context menu > “Design using Tekla Tedds” with options
to perform the design for the selected Member or its Design Group (when
Design Groups for concrete members are enabled). Design parameters
such as concrete grade, section size and design forces are automatically
populated from the model to the Tedds calculation. Additional parameters
not defined in the model can be fully reviewed and set as required in the
Tedds calculation interface. The member can then be fully and interactively
designed in the Tedds calculation

• With Design Groups disabled, Design > Member designs only the
individual selected member for its specific design forces.

• For continuous beams and columns composed of multiple spans/
stacks, the view will automatically zoom to and highlight the span/
stack currently being considered for design.

• With Design Groups enabled, the process is as follows for each option:

• Design > Member; the Tedds calculation is populated with the
design forces of the selected member. When the calculation dialog is
finished, all the design settings made - such as number and size of
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reinforcement bars and links etc - are copied to all members of the
group which are then checked for their individual design forces.

• Design > Group; the Tedds calculation is populated with the worst-
case design forces of the group as a whole. When the calculation
dialog is finished, the further process is the same as for Design >
Member.

• Once the design is completed and the Tedds calculation dialog is finished,
ALL of the Tedds design data as well as the results are embedded in the
Tekla Structural Designer model for each designed member. This enables
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looping of analysis and checking/ design to accommodate model changes,
such as to loading.

• The resulting design Pass/Fail status and utilization ratios (UR’s) from
Tedds can be checked in the Review View and via the member Tooltip in
the usual manner just as for design of in-situ concrete members within
Tekla Structural Designer. When using Design Groups, the engineer can
review the UR’s of members and their automatic grouping and make
changes to this as required.

• After the design is complete and the Tedds data has been written to the
model, the following additional options will be listed in the member
context menu Tedds options; “Check using Tekla Tedds”, “Clear Tekla
Tedds Data”, and “Export to Tekla Tedds” (see below for more on these
options).

• If required, the section size can also be changed in the Tedds calculation
and the model will automatically be updated with this change (for all
members in the Design Group where these are enabled). In this case,
the analysis can then be re-run and all members of the group checked
using Tekla Tedds to update the design fully.

• When Design Groups for concrete members are enabled, Tedds design for
Design Groups of precast beams and/or columns is also available from the
Project Workspace > Groups Window. Design groups for precast concrete
beams and columns are automatically created and populated just as for in-
situ concrete members. Group checking/design is run by moving the cursor
over a group to select it, then right-clicking and selecting the desired option
from the context menu. As for design of individual members from the
model, where the group has been previously designed and embedded
Tedds Data exists, a “Check using Tekla Tedds” option will be listed as well
as “Design using Tekla Tedds”.
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• The “Check…” option will run the Tedds Calculation ‘silently’ for all members
and update the results to the model which can then be reviewed as
described above.

• The “Design...” options (either for Group or Member) automatically open
the calculation interface as described above, allowing the engineer to
review and change the design data if required. On finish, all members in
the group are then checked for the revised input without further display of
the calculation interface.

• Where the group has been previously designed, a “Clear Tekla Tedds Data”
option is also listed allowing the engineer to begin the design from scratch
if they wish.

• For Reporting of the design, the engineer selects the “Export to Tekla
Tedds” option which will open the Tedds application and create a Tedds
Project containing calculation documents for the designed precast
member.

• This option is available for;

• An individual Member in the model (Design Groups disabled).

• A single Group (via right-click over a Group in the Groups Window or
a member of the model).

• All Beam or Column Groups together (via right-click over the
Concrete Precast Beam/ Column Parent Group).

• The entire model via right-click over the “Design” Parent Group for
Precast Beams/Columns in the Groups Window.

• A graphical Selection of part of or the entire model.

• With Design Groups enabled, this will create a Tedds Project containing
one calculation document* (.ted file) for each group included in the
selection.

• When Design Groups are disabled, the model member context menu
export option will change to “Member” and will create a Project and
calculation document for the selected member*.

• *In the case of continuous multi-stack/span columns and beams
there will be a calculation document for each stack/span of the
member.
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• For the scenario of re-checking multiple existing Tedds designs after
changes to the model - made either via the Tedds calculation dialog e.g. for
change of section size, or directly in the model e.g. for changes to loading -
the analysis results can be updated via Analyze All (Static), then all the
designed precast members in the model checked in a single operation
using the Design Ribbon’s new “Check in Tedds” command.
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Related video

Precast modeling, analysis and design using Tekla Tedds

Concrete Design - Result Line Design saving of
reinforcement and manual design forces
2D Result Lines were first implemented in Structural Designer release 2019
(released Mar 2019) allowing the engineer to investigate sectional forces
around openings in concrete walls for example. Subsequent releases have
continually enhanced this feature, adding interactive concrete section design
in release 2019 SP1 and enhanced design forces in release 2019 SP2.

See this video demonstrating result lines in action.

This release further enhances the Interactive design using Result lines feature
to add the saving of both the reinforcement and manually added/adjusted
design forces defined in the interactive design dialog.
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• Key aspects of Interactive design using Result Lines are:

• The Interactive Design option is accessed from the right-click context
menu for Result Lines as shown above. The engineer then chooses from
wall or column section design options and the appropriate Interactive
section design dialog is displayed.

• The wall length/ column depth considered is the Result Line length.
The design dialog features full interactive manual selection of both
lateral and vertical reinforcement, Interaction Diagrams and auto-
design and check options, just as for a regular wall/ column section.
All edits to the reinforcement settings are now saved when the
Interactive design dialog OK button is clicked (please note that
changes to concrete column/wall size is not saved).

• Result Lines are not constrained to cross sections in the horizontal
plane - vertical sections can be used above/between openings to
investigate forces and reinforcement requirements in “coupling
beams”.

• The section design always considers the main bars (running
perpendicular to the cross section) as being on the inner layer, from
a design perspective this will tend to be conservative but the
engineer should give this some consideration when working with
non-horizontal sections.

• Additional Design Cases and Adjustments - the Result Line forces are
listed in the “Additional Design Cases” page. These forces can be
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manually added to and adjusted. All additions/ adjustments are now
saved when the Interactive design dialog OK button is clicked.

• There are three potential “Design Moment” adjustments for each
direction:

• Set an imperfection eccentricity allowance (Eurocode only). This
is added to the analysis moment.

• Apply an amplification factor to allow for Second Order Effects
(could also be considered as a way to introduce an extra factor of
safety)

• Apply a minimum moment check in one or both directions (the
calculation of this is specific to the Head Code set and is a
function of the section dimension “h” in the direction
considered).

• When applied, the resulting adjusted design moment is
automatically calculated and displayed in the dialog.

• The adjustment values and options can be applied manually to
individual Cases and also quickly in a single operation to all Active
cases (those with “Active” option checked on) via the [Design
Moment Factors…] button as shown above.

• Note that the design does not consider the reinforcement specified in
wall properties - only that which is defined in the Interactive design
dialog.

• Currently the feature is not linked with Reports and so it is envisaged
output will be via screenshots of the interactive design and check
results dialogs.

Related video

Interactive design using Result lines

Seismic Analysis & Design Enhancements
The following enhancements are made in this area following customer
feedback.

• Seismic Wizard and Seismic Combinations - the engineer can now
directly specify the use of orthogonal seismic combinations, in which the
seismic load cases for both directions are included. Formerly the creation
of these was automated only for certain specific types of Structural
Irregularity. The new setting to directly activate these combinations is on
the Structural Irregularities page of the Seismic Wizard as shown in the
picture below.
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• Seismic Torsion Assessment of Columns & Walls - in previous releases,
every column/wall in the model was considered when calculating the
effects of Seismic Amplified Accidental Torsion. However, there may be
situations in structures where columns/ walls are remote from the core
structure and would be ignored for seismic torsion. The inclusions of
columns/ walls in this calculation can now be controlled via the checkbox
“Drift/Seismic drift checks and consider for seismic torsion”. This can be set
both in the Properties Window for all and individual stacks/ panels in the
Properties Window and the member edit dialog. When unchecked, the
member is not considered for; the assessment of Accidental Torsion; the
assessment of Amplified Accidental Torsion.
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Foundation Design - New option for presumed bearing
capacity method for Mat Foundation - Eurocode
The option to use a presumed bearing capacity method (instead of the
Ultimate bearing pressure capacity) for per EN-1997-1 cl. 6.5.2.4 was added in
an earlier release for isolated foundations. The presumed bearing capacity
method uses SLS pad pressure results checked against a presumed bearing
resistance entered by the engineer. Following customer requests this method
option is now extended to include Mat Foundations.

• The Design setting to control the application of this method is moved from
the Isolated Foundations > General Parameters group to the
Foundations > General group of the Foundations Design Settings, as
shown below, and now applies to both isolated and mat foundations
together.

• The new combined setting will be off by default for new models.
However, for existing models in which it was activated for Isolated
Foundations, it will be checked on automatically when they are opened
in this release.

• When activated, the mat foundation Soil Parameter properties change to
allow input of the Presumed bearing resistance of the check as shown
below.
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Foundation Design - New Pile Cap Design for Australian
Head Code to AS 3600 : 2009
Bringing foundation design to the Australian Head Code in line with that in
other Head codes, this release adds the design of Pile Caps to AS 3600 : 2009.
The functionality matches that of the existing design for the Eurocode and US
design codes and supports auto-design of both the pile cap and pile selection.
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Comprehensive detail drawings of pile caps and piles can also automatically
be produced.

• Key aspects of the design are:

• Pile caps can be modelled with 1 to 9 pile configurations.

• There are options to auto-design; cap depth, number of piles and
reinforcement.

• The following checks are performed with extensive design details
reported for each:

• Pile capacity check

• Pile cap bending check

• Pile Cap shear capacity check

• Column and pile punching shear check

• Pile pair punching check

• Pile one-way shear check.

• Check for limiting parameters (spacings, edge distance, thickness
etc.)

• The engineer can choose the pile capacity to be considered for pile
punching and shear checks.

New Design Warning Controls - Indian Head Code
Following customer requests, controls are now added for design warnings for
Concrete Seismic Design, and Steel static design, for the Indian Resistance
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Codes of Seismic Design and Detailing to IS 13920: 2016, and Steel Design to IS
800: 2007.

This feature allows the warning design status and messages for selected
checks/ considerations to be removed at the engineers discretion.

• The new controls are accessed via Design Settings > Design Warnings as
shown in the picture below.

• Warning controls are listed for the following areas and include Clause
references to guide the engineer; general seismic topographical and SFRS
type considerations; Material properties; Geometric properties; Beams,
Columns, Walls and Joints.

New Trimble Connect Integration Link
Furthering our drive towards a Connected World, the new Trimble Connect
Link in this release allows easy collaboration between project stakeholders,
making sharing of Tekla Structural Designer model information as easy as
possible. The link is accessed via Trimble Connect command on the new
dedicated BIM Integration Ribbon, as shown in the picture below. You can
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then browse your Trimble Connect Projects, create new folders in them and
send Tekla Structural Designer model data to them.

• Note that in order to use the link you must have a Trimble Connect license
and be signed in to your Tekla Online Account (using your Trimble Identity
credentials).

• Selecting the main “Trimble Connect” option opens the new dedicated
Trimble Connect Window, which is docked to the right of the main window
by default. Your Trimble Connect projects will then be listed in the Window.

• The Trimble Connect button has additional options to launch either
“Trimble Connect Web” (in your default browser) or “Trimble Connect
Desktop” if you have this installed.

• Once your Trimble Connect projects are listed you can then click the link

icon  adjacent to a project to open and browse it. Options to create and
rename folders within the project are then available from the right-click
context menu for the Window.

• To add the open Tekla Structural Designer model to Trimble Connect,
select the context menu “Upload new IFC file” command which launches
the IFC Export dialog. When this is completed the IFC file will automatically
be added to the project.

• Once added, the IFC file can then be opened in Trimble Connect (both
Web and Desktop) from the context menu options. To accommodate
model changes, the IFC can also be updated using the context menu
option “Upload new version of IFC” as shown in the picture below,
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New Bi-directional FBEAM® Link for design of FABSEC®
Beams
Listed on the new dedicated BIM Integration Ribbon, as shown below, is a new
link with the FABSEC® FBEAM® software for the design of beams with their
Fabrication set to FABSEC in Tekla Structural Designer models.

• FABSEC sections are a form of proprietary plated beams used in the UK
construction market. There is no native design for such sections within
Tekla Structural Designer.

• The new link now allows beams specified as FABSEC in the Tekla Structural
Designer model to be sent to FBEAM via Export (page 333) for detailed
design and optimization. Finalized design data can then be passed back to
the Tekla Structural Designer model from FBEAM via the Import (page 334)
function.
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• The table below shows the data transferred between the programs for
each stage:

 Exported to FBEAM Imported to TSD
Beam section properties

Beam name, span
properties

-

Beam layout, secondary
beams and restraints

-

Loading and load
combinations

-

Floor (slab) properties -

Web openings and
stiffeners (rectangular
and circular only)
Shear connector
properties and layout
Transverse
reinforcement and slab
reinforcement
Fire design details -
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• Import status and data imported from FBEAM populates the following new
UDAs in the Tekla Structural Designer model which can then be reviewed in
Review View > Show/Alter State/UDA as shown below:

• Import status,

• Position of elongated openings

• Fire design details

New Integration with ETABS: ETABS-Tekla Structural
Designer Link Plugin
By popular request in a number of regions, this release adds a link to export
an ETABS model to Tekla Structural Designer. This caters for the scenario
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where for example the engineer has an ETABS model and wishes to
investigate design options using Tekla Structural Designer.

For full details on using the link and the data imported see the new Help Topic
on this feature.

Key details of the link are:

• The link is via a plugin to ETABS which can be downloaded from the Tekla
Warehouse.

• The ETABS plugin export creates a CXL file which is the same file format
used for integration with other applications such as Tekla Structures and
Revit. The CXL file is then imported into Tekla Structural Designer in the
same manner as for other CXL files using the BIM Integration > Structural
BIM Import command.

• The following data is transferred by the link in this first release:

• Grid lines, Levels and Materials

• Beams and Columns:

• Concrete - alignment, orientation, end releases, material type and
grade and section size:

• *Note that inclined concrete members are imported as beams,
so section sizes not permitted for beams will be converted to
rectangular and curved beams are imported as straight.

• Steel beams, columns, and braces are imported if their section
names can be mapped to an equivalent section in Tekla Structural
Designer sections database - alignment, orientation, end releases,
material type and grade are maintained.

• Other material beams, columns and braces (and steel sections that
can’t be mapped) - are imported as analysis elements with their
alignment, orientation and end releases maintained. Section sizes
can then be easily applied as required in Tekla Structural Designer.

• Concrete Walls - imported as meshed concrete walls with geometry,
thickness and alignment maintained (sloping walls are excluded).

• Slabs - imported as two-way spanning slabs on beams

• Openings - rectangular & circular holes in slabs are imported as slab
openings (holes of other shapes imported as rectangular)

• Curved slab edges are imported as straight edges and sloping slabs
are excluded.

• Thickened slab areas - such as column drops - which are created in
ETABS by overlaying slab panels are imported as two panels. They
will then be flagged by a validation error and can be easily
remodelled in Tekla Structural Designer using the dedicated column
drop tool or the slab thickness override option.
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• Diaphragms - ETABS diaphragm objects are not transferred. However
all imported slabs have their diaphragm option set to rigid. This can
then be reviewed/ edited by the engineer as required.

• Supports - ETABS support objects are not directly transferred so
supports are created as follows:

• Pinned supports (Fx, Fy, Fz and Mz fixed) are created under every
column (unless a supporting member such as a transfer beam is
detected)

• Supports pinned about the minor axis created under every wall
(unless a supporting member is detected)

• All other ETABS joint restraints are excluded, including Springs.

• Trusses - imported as analysis elements

• Loads - are excluded.

New Tekla Open API
An Open API is now available allowing the integration of Tekla Structural
Designer with other applications...This will shortly be available in the Tekla
Developer Center so check back here regularly for updates.

Related video

Tekla Structural Designer API

Minor Enhancements and Fixes

General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability.

• Steel Section Database - Nordic Countries - some missing sections are
added for both steel and cold formed materials to the section databases of
Norway, Finland and Sweden. Additionally we have:

• [TSD-5898-9] - some missing sections are added for both steel and cold
formed materials to the section databases of Norway, Finland and
Sweden.

• [TSD-5906] - the naming of plated sections is changed to use the *
symbol instead of lower-case x.

• [TSD-4501] - new sections are added to existing order files.
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• [TSD-5551] - Section and order file defaults are updated to use only
commonly available ones.

• [TSD-5224] - Properties Window - the note window at the bottom of the
Properties window will now auto size to display the full text of the property
where formerly this could be truncated.

BIM Integration
• Structural BIM Import

• [TSD-4014] - for imported concrete models, the Autodesign member
property for concrete 1D elements is now considered as follows:

• When importing a CXL file into a new model file, the Autodesign
member property is checked ON (previously it was OFF).

• If importing a CXL file into an existing model, the current member
autodesign property is retained irrespective of the value in the CXL
file.

• [TSD-4337, 4338] - a new UDA entitled Pour phases has been added to
allow pour phase value to be passed between Tekla Structures and
Tekla Structural Designer for concrete elements. The UDA is created on
import where Pour Phase attribute exists in the CXL file.

• Existing Pour phase UDA’s are checked on import and the BIM Status
tree will list messages for any updated Pour phase UDA’s.

• [TSD-2965] - Tekla Structures/ Revit Export - for transfer columns (e.g. a
column supported on a beam) the misleading warning for analysis forces at
bottom of column not including additional moment - issued in the BIM >
Structural BIM Export status tree - is removed (as it applies only for column
splice loads).

• [TSD-2756] - Structural BIM Integration (CXL) File - the CXL file data
structure is enhanced to include member fabrication, slab deck types and
wall types:

• On export from TSD, concrete members will be assigned a fabrication
type.

• On import to TSD if Other Data is ON in the import wizard, the
fabrication/deck type will be updated as appropriate. Associated
messages are shown in the BIM status tree.

Performance
• [TSD-6075] - Graphics - the graphics driver settings in Home > Settings >

Scene > Graphics are updated and adjusted.
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• DirectX is now called DirectX (old)

• DirectX V2 is now called DirectX

• DirectX (old) is based on DirectX 9 and is becoming obsolete while the new
DirectX is based in DirectX 11 and is currently the primary HOOPS driver for
3D acceleration.

• For existing installations (which will carry forward old settings) we
recommend that the Driver setting is checked and set to the Auto
option if necessary, as continuing with Direct X (old) could impair
performance and stability.

• To check your adapter’s compatibility visit the HOOPS developer
website for HOOPS 20.x, DirectX and OpenGL requirements.

• The “Auto” setting will let HOOPS pick the best driver (and is now the
default)

• [TSD-5870] - Design Process- the Process window now reports the progress
% of the Presizing stage of autodesign (for steel members). The Cancel
button can also now be selected during this process to terminate design.

Loading
• [TSD-6200] - Loading Ribbon - buttons on the loading ribbon have been

reorganized to keep the most commonly used items at large size as the
application window size or screen resolution is adjusted.

• “Load Groups” is moved after Combination.

• “Panel Loads” re-ordered to promote the use of “Level” load when
appropriate.

• “Point” load moved to the left.
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• The redundant word “Load” is removed from each button.

• [TSD-4017] - Load Combination Generator - US Head Code - the default
service factors for dead loads in the combinations ASD-1.0D and LRFD-1.4D
have been changed from 0 to 1.0.

• The previous default value of zero, if not corrected, would produce
incorrect beyond scope status for isolated foundation design where
these combinations were generated and active. This issue should no
longer occur.

• [TSD-5827] - Perimeter Load - previously the Perimeter Load command
could only be used provided that the 'create as line loads' option was
checked on in the load properties. This has now been corrected.

• [TSD-6004] - Temperature Loads - Slabs - temperature loading applied to
slabs set as semi-rigid diaphragms was not applied if the diaphragm mesh
type was also changed to be triangular (not the default). Temperature
loads are now applied to semi-rigid diaphragms for any mesh type
selection.

• [TSD-6154] - Seismic Loading - US Head Code - for Seismic Loading to
ASCE7-16, the revised capping provision for short period regular structures
per Section 12.8.1.3 is now applied for building meeting all requirements of
the clause with SDS < 1.0 using the actual SDS value. Previously in this
circumstance SDS = 1.0 was used, resulting in over-conservative seismic
loads.

Validation
• [TSD-5795] - Composite beams - the validation time for models containing

composite beams (of their effective widths) is considerably reduced.

• [TSD-5459] - Wind Wall Panels - Decompose to Diaphragms - an additional
model validation check is now performed to check the validity of area loads
applied to wind panels that have been set to decompose to rigid
diaphragms. For such panels the load can only be decomposed provided
that it has been applied perpendicular to the plane of the panel. If the load
is acting in any other direction a validation warning "Wind wall load beyond
scope" is now issued.

Analysis & Results
• Vibration Analysis renamed to “Modal” Analysis - in many regions, the term

“vibration analysis” is more commonly associated with the perceptible
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vertical movement of floors (such as is checked by the DG11 Floor Vibration
Check for example) or lateral sway of tall building subjected to service wind
load, and the term “modal analysis’ is used to refer to an analysis which
determines vibration modes and their properties (such as period etc).
Hence the term “vibration analysis” is replaced by “modal analysis” in all
instances within the program, such as in the Seismic Wizard and on the
Analyze Ribbon as shown below.

• [TSD-6382] - 2D Results - imposed load reductions are now implemented
for meshed concrete wall Fy (vertical force) 2D contour values and the
associated vertical stresses σy etc. Click the “Reduce Axial Force” toggle
button in the Results View to see the results with imposed load reductions
applied.

Design - General
• [TSD-6248] - Timber Design using Tedds Link - design forces sent to the

Tedds Timber design calculation now include the maximum forces of only
active load combinations. Previously, maximum values considering load
combinations, load cases and envelopes were used causing conservative
design results in some scenarios.
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Design - Head Code US
• [TSD-5445] - Steel Joist Design - when a steel grade other than 50 ksi is

applied to steel joists, the design will now details now issue a warning
stating that the design assumes steel grade 50 ksi as shown below.

Reports
• [TSD-5219] - Punching Checks - the “Report for Member” option is added to

the right-click context menu for a selected punching check, allowing the
engineer to produce an individual report for a punching check object.

• [TSD-5224] - Material Listing - the Cold formed table now includes a column
for the total number of cold formed members for each grade and the total.

• [TSD-6052] - Portal Frames - Wind Drift Table - in the Wind Drift table of
Review View > Tabular Data and the associated Report item, Portal frame
columns are now given a unique reference which includes the Portal Frame
reference for example “PF F/1-F/3 Span 1 Rh Column” rather than just
“Span 1 Rh Column”.

• [TSD-5797] - Report List - the Report Styles in new and existing models are
now listed in alphabetical order. This also applies to the Member Type list
in the Member Reports dialog. With this new feature, user-defined reports
can be listed in a grouped order by careful prefixing.

• [TSD-4991, 6010] - 2D Result Diagrams & Views - in some circumstances,
reports including analysis diagrams of 2D contour results would not display
the contours correctly. This issue has now been corrected.
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NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

1.2 Tekla Structural Designer 2020 hardware
recommendations

System requirements for effective operation
CPU: Multi core Intel i5 Series or above, Xeon or AMD equivalent

• Highest affordable performance recommended.

Memory: 16GB (32GB or more recommended)

• Memory requirements are highly dependent on model content.

OS: 64-bit Microsoft Windows 8.1 / 10

• Operating systems must be running the latest service packs / updates.

• Graphics: 1600 x 900 resolution (1920 x 1080 or higher recommended)

• 1GB or higher of dedicated RAM.

• Utilizes HOOPS Visualize, a third party graphics engine available from
Tech Soft 3D. To check your adapter’s compatibility visit the HOOPS
developer website for HOOPS 20.x, DirectX and OpenGL requirements.

• Disk space: 1GB or more of free space for installation

• Operational disk space requirements are highly dependent on model
content.

Internet connection: Required for access to Online Services and some
documentation.

License Service:

• Tekla Structural License Service 3.00 including Sentinel RMS 9.5

License Server: The latest version of the Tekla Structural Licence Service, at
time of release, is shipped and installed with the software. If you have chosen
to have a separate licence server, it is always our recommendation that you
also run the latest version of the Tekla Structural License Service on it to
ensure compatibility. Please see System Requirements for specific version
details.
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Test environments
The application is tested and supported on the following business versions of
Microsoft Windows with the latest updates applied:

• Windows 10 64-bit

• Windows 8.1 64-bit

1.3 Upgrade Tekla Structural Designer to a new version

NOTE The following instructions are specifically for users who already have a earlier
version of Tekla Structural Designer installed.

You can have multiple Tekla Structural Designer versions on your computer.
When you install a new version you are not required to immediately uninstall
the previous version.

Service packs are cumulative updates, which replace the previous service pack
installation for the same Tekla Structural Designer version. So you should only
have the latest service pack installed per version.

NOTE We recommend that you complete any models you are already
working on using your current version of Tekla Structural Designer.
Once you save a model in the new version, you cannot open it in a
previous version.

Licensing information specific to Tekla Structural Designer
2020
• Upgrade Licenses - Tekla Structural Designer 2020 will require the

activation of a new license. You should already be in possession of your
Product Activation Key (PAK) as these are usually distributed prior to the
software release. Please contact your local Service Department now if you
do not have your PAK. To minimise any down time we advise that your PAK
is activated BEFORE installing Tekla Structural Designer 2020.

• License Server Version - the Tekla Structural License Service must be
updated to the new version 3.00.0001 (incorporating Sentinel RMS 9.5) to
be compatible with this release. Licensing will not function correctly if this
update is not performed! Please see this article for more information about
this, and see System Requirements for specific version details.

• Subscription Licenses & Tekla Online Licensing - if you have switched to
subscription licensing select the new Tekla Online License Method when
installing the program as shown in the picture below. Please note the
following:
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You can download the installation package for Tekla Structural Designer 2020
from the Tekla Downloads service.

Install the upgrade
Complete the upgrade in this general order (follow the links in the text for
detailed instructions):

1. Install and license Tekla Structural Designer (page 238) as if you were a
new user.

2. Upgrade your local databases

NOTE In the Tekla Structural Designer 2020 release and for future
releases, the local database is now version-specific. A version
directory (called “20.0” for this release) is added to the local
database directory which is located in C:\Users\username
\AppData\Local\Tekla\Tekla Structural Designer\Database. A copy
of the current local Database from your previous version will be
made in the version-specific directory.

When you first run Tekla Structural Designer 2020 a message informing
you that new databases are available will be displayed in the Process
Window as shown below.
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These should be upgraded as detailed below.

a. Open “Materials” from the Home Ribbon

b. Select the “Sections” page in the list of options

c. Click the “Upgrade” button, then click this button again in the
subsequent “Upgrade Database” dialog

d. Repeat this process for all the other databases (Material,
Reinforcement...etc ) to ensure all your databases are up to date.

3. Transfer Connection Resistances

In Tekla Structural Designer 2020 the Connection Resistance check and
associated data has been considerably expanded to include such
information as steel grade (of supported beam) number of bolt rows &
lines etc. If you have added your own Connection Resistance values in a
previous release, the following action is required:

a. When Tekla Structural Designer 2020 is run for the first time, existing
Connection Resistance data will be imported and listed in the new
Connection Resistance dialog and flagged with a warning status as
requiring review/ updating (see pictures below).

b. As shown below, use the Edit buttons to review/ set the Connection
Resistance data as follows:

• Select each imported Connection Type then click the Edit… button
below this section of the dialog to review then set/ confirm the
required data; Steel Grade and number of notches and bolt lines.

• Then for each row of the Resistances table for each type, click the
Edit… button below this table to review/ set the number of Bolt
Rows

c. Engineers using India or US head codes with connection resistance
data from a previous version will see a query at the point of
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Upgrading the database asking if they want to import the data for
ASD/Working Stress, or LRFD/Limit State, or both as shown below.

d. During the data transfer and Upgrade the value of parameters for
‘old’ beam data are assigned based on defaults as follows:

• Eurocodes: Grade S355, # Notches 0, # Bolt Lines 1.

• US codes: Fy Any, Coping None, # Bolt Lines 1, Bolt Diameter 3/4
in (20 mm), Thickness 1/4 in (6.4 mm).

• IS codes: Grade Fe 410, # Notches 0, # Bolt Lines 1.

• AS codes: Grade 300 (AS/NZS 3679.1), # Notches 0, # Bolt Lines 1.
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• BS codes these: Grade S355, # Notches 0, # Bolt Lines 1.
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1.4 Tekla Structural Designer service packs
Tekla Structural Designer service packs are Tekla Structural Designer version
updates.

Tekla Structural Designer service packs update the existing installed Tekla
Structural Designer version software. You do not need to separately install
previous service packs in order to install the most current service pack. For
example, you can install service pack 2 without installing service pack 1.

• Service packs can include new features, and improvements and fixes to
existing features. We recommend that all users install the latest service
pack.

You can find the service packs in Tekla Downloads.

See also:

Install a Tekla Structural Designer service pack (page 96)
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Latest Releases:

Release notes: Tekla Structural Designer 2020 SP6 (page 96)

Release notes: Tekla Structural Designer 2020 SP5 (page 113)

Release notes: Tekla Structural Designer 2020 SP4 (page 127)

Release notes: Tekla Structural Designer 2020 SP3 (page 198)

Release notes: Tekla Structural Designer 2020 SP2 (page 207)

Release notes: Tekla Structural Designer 2020 SP1 (page 215)

Install a Tekla Structural Designer service pack
You can install a service pack to update a Tekla Structural Designer version or
a previous service pack. Service packs can contain new features, and
improvements and fixes to existing features

If you have the related Tekla Structural Designer version or a previous service
pack installed on your computer, you do not need to remove it before
installing a new service pack.

To install the service pack

1. Download the service pack software installation file from Tekla
Downloads to your computer.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

Release notes: Tekla Structural Designer 2020 SP6
This release will update your Tekla Structural Designer installation to version
number 20.0.6.30 and should be installed to ensure optimum function of the
program. It includes a number of new features, enhancements and issue
resolutions as detailed below.

If you are upgrading from a version earlier than the immediately prior release
2020 SP5 (version 20.0.5.56 released Nov 2020), you can find details of
requirements, enhancements and fixes for all previous releases in Tekla User
Assistance (TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads
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Licensing
• No new license is required for this version.

• Tekla Structural License Service - the latest Service Pack for this was
released in July 2020. This is available in Tekla Downloads and should be
installed on all clients for optimum functionality.

• For more information see the Release Notes page for the Tekla License
Service update July 2020 (v3.1.3.4).

• License Server Version - for Server licensing, the latest version of the
Tekla Structural License Service 3.1.2 (incorporating Sentinel RMS 9.5) must
be installed on your license server to be compatible with this release.
Licensing will not function correctly if this is not the case. For more on this
requirement please see the TUA article Tekla Analysis & Design 2020
Releases & Sentinel RMS Server Licensing - the License Server must be
updated.

Installation

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) or later to be installed and will replace your current
version.

• Please note that because the Trimble digital certificate used to digitally
sign the original installation (Trimble Solutions Oy) expired in December
2020, users will require Administrator privileges to install this latest
update which they would not have required for previous updates. This
update is signed with the Trimble Solutions Corporation digital
certificate which is valid until April 2021

• Integration

• Tekla Tedds - to use the new Timber Design using Tekla Tedds feature
(page 174), you must install the Tekla Tedds Engineering Library update
(September 2020) or later. All Tedds updates can be obtained from
Tekla Downloads or via the Update Service.

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate this release with Tekla Portal Frame Designer/ Tekla
Connection Designer, you should install Tekla Portal Frame Designer/
Tekla Connection Designer 20 Service Pack 2. This was released in Sept
2020 and can be obtained from the Tekla Download Service.

• Autodesk Revit© - the Tekla Structural Designer Integrator for
Autodesk Revit© 2021 (version 7.0) was released on 1st July 2020 and
updated to version 7.01 in September 2020. The installation and update
are available in Tekla Downloads. If you are using Autodesk Revit©
2021, you can install this to perform BIM integration with Tekla
Structural Designer.

• All fixes and enhancements included in the 2021 release and update
were also included in updates for the Integrators specific to the
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other currently supported Revit© versions (2018, 2019, 2020). For
more information see the Tekla Structural Designer Integrator
September 2020 updates. If you are performing BIM integration with
any of these Revit© versions, we recommend you update to the
latest version of the associated Integrator.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - Depending which version you are upgrading from, some
Databases may be updated by this release. When this release is first run,
your Databases will now automatically be updated and it is no longer
necessary to do this manually via Home > Materials. See the Release notes:
Tekla Structural Designer 2020 SP4 for more about this.

Highlights
General & Modeling

• Review View - Design Status Enhancements (page 102)

• Material List Enhancements (page 106)

• Review View - Show/Alter State Reinforcement command extended to
Isolated Foundations (page 112)

Issues with Associated Bulletins
• [TSD-8551] - Seismic Design - Steel Columns - USA Head Code - this issue

relates to the the design of steel columns assigned to Seismic Force
Resisting Systems (SFRS) to the seismic provisions of the 2016 version of
AISC 341 (years 2005 and 2010 were not affected). In some circumstances
the expected seismic axial force amplification for the axial strength check
of section D1.4a was not applied which could result in an unconservative
design. For more information please see Product Bulletin PBTSD-2101-1.

• This issue is fixed in this release.

• [TSD-8637] - Concrete Beam Design - British Standards (BS) Head Code (all
countries) - the overall deflection check design status was always that of
the last load combination instead of the most critical from all
combinations. Therefore, in the most extreme case, this check could fail for
one or more load combinations but the beam would still be marked as
passing if the last combination had a passing status. For more information
please see Product Bulletin PBTSD-2101-02.

• This issue is fixed in this release.
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General & Modeling
Highlights

• Review View - Design Status Enhancements (page 102)

• Material List Enhancements (page 106)

• Review View - Show/Alter State Reinforcement command extended to
Isolated Foundations (page 112)

• A number of additional fixes which are not detailed explicitly here are also
made to improve general performance and stability. An example of this is
given directly below:

• [TSD-8382] - Analysis - A memory corruption issue has been fixed that
could cause the analysis process to abort and/or the program to force
close unexpectedly for some models that included short beam spans
with partially fixed ends.

• [TSD-7317] - Keyboard Functions - new keyboard shortcuts have been
added Z1, Z2 and Z3 to zoom to a 1-3m area around the current cursor
location. These new shortcuts compliment the existing ZA and ZS shortcuts
- for more on these and others see the Help topic Keyboard shortcuts
(page 291).

• Use the shortcuts as follows; first locate the cursor where you want to
zoom, then press the “Z” keyboard key, followed by the “1”,”2” or “3”
keyboard number key.

• [TSD-8043] - Connections - when a model has been populated with
connections (see the Help topic Design connections (page 819) for how to
do this), they are now shown graphically in construction plane (Levels,
Slopes and Frames) and sub model views.

Interoperability
• [TSD-7851] - Grasshopper - Tekla Structural Designer Live Link - the Slab

component in the Grasshopper plugin has been enhanced to allow
creation of the previously released General material slabs. For more
information about this feature see the article Grasshopper - Tekla
Structural Designer Live Link. Please note the following:

• This enhancement requires the installation of the new Grasshopper
plugin specific to this release. This can be obtained from the Tekla
Warehouse.

• In existing scripts, the user can replace the old slab component with the
new one to make use of the new parameters.

• [TSD-8557] - Export to One Click LCA - changes have been made to the
format of the exported data to improve data mapping in One Click LCA.
Also data exported from US Customary unit models is now in Metric units,
since One Click LCA does not support the use of US Customary units for the
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uploaded data. For more about this feature see the Help Topic Export to
One Click LCA (page 341).

• [TSD-8361] - BIM Integration - Revit - Column Splices - improvements are
made in this release to the way in which splices added in the BIM
application (i.e. in Revit) are handled before updating the Tekla Structural
Designer model. Some situations that were causing this process to behave
unexpectedly have been identified and the following enhancements made
to improve this:

• If one or more stacks are excluded from the update process (BIM status
= Exclude in Tekla Structural Designer model) then we shall exclude the
whole column

• [TSD-8495] - Update messages have been improved to ensure they are
associated with an object in the Tekla Structural Designer model.

• Note that there is one related outstanding issue when round
tripping Tekla Structural Designer > Revit > Tekla Structural Designer
without making any changes that may cause confusion. This can
cause erroneous "Position Update" messages for some of the
column stacks in Tekla Structural Designer when splices with offsets
exist.

Loading
• [TSD-8428] - Load Decomposition - an issue is fixed that could cause some

slab loads to not be decomposed correctly in the rare circumstance of
models with only one decomposition plane (i.e. no other planes at all with
loaded slab/roof panels) which included 1-way spanning slabs supported
by 2-way spanning slabs. This issue relates only to release 2020 SP4 (v
20.0.4.55 released Sept 2020) - in which it was introduced - and later.

• This issue has only been encountered internally and we expect it is
highly unlikely customers will have, given its unusual conditions. We
would note also that it would be very clear if the issue occurred and
resulted in any significant missing load, as it would be flagged by all of;
a decomposition warning “Some loads have not been applied > Load LL
xx lies outside of panels”); a warning in the Process Window "Total
reactions vs Applied loading do not balance" and errors for the affected
load case(s) in the Project Workspace > Loading Window.

Design
Head Code US

• [TSD-8415] - Concrete Design - Beams - the deflection check has been
corrected so that it now compares the position of the neutral axis to the
depth to the compression surface reinforcement, identifying if this
reinforcement lies in the compression zone and a decision is then made by
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the program if its beneficial effect should be considered in the calculation
of the long term additional deflection multiplier.

• [TSD-1298] - Seismic Design - Steel Braces - for the 2010 and 2016 years of
the AISC 360/341 steel resistance code, tension only braces are not
permitted for the Seismic Force Resisting System (SFRS) type Special
Concentric Braced Frame (SCBF - as directed by the design code). In this
release new validation is added to check for this circumstance and a
Validation error “Tension only brace not permitted in SCBFs” is issued when
this is the case.

• Tension only braces are permitted in both OCBFs and SCBFs for the
2005 year of the AISC 360/341 steel resistance code, and OCBFs only for
the 2010 and 2016 years of the code.

• [TSD-4146] - Steel Beam Design - Torsion - for the Torsion Combined Forces
check, in some situations the wrong flange was considered when
determining the laterally unbraced length used for the calculation of the
critical stress Fcr,bx when governed by LTB. This could produce an incorrect
failure status for the check when the laterally unbraced length of the
bottom flange was incorrectly used for positive bending moment + torsion
in beams with the top flange either fully or partially restrained. This issue is
fixed in this release.

Reports and Drawings
• [TSD-8532] - Reports - as detailed above, many Material Listing tables have

been enhanced with additional columns, making them wider. To assist with
their effective display in reports, new automatic Landscape table
orientation is introduced in this release (applies to all report tables). This is
controlled by a new setting Report Settings > Table Options > “Use
landscape orientation for wide tables” as shown in the picture below. When
enabled (default) the report page orientation will automatically change to
landscape mode when the table header will not fit in portrait orientation.

• Note that you can reduce the need for landscape orientation and
number of pages by; reducing page margins (default values may be
quite wide); increasing the allowable table width from 90 to 95% of the
available width

Upgrade to this version 101 Tekla Structural Designer service packs



Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

Review View - Design Status Enhancements
There is a growing emphasis on mitigating the Carbon Impact of design and
construction, so we have been focusing on new and improved features to
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assist engineers with this. For more about this and existing features related to
it, see the Help Topic Measuring the carbon impact of a structure (page 1643).
This emphasis has led to a renewed focus on efficiency of design in terms of
minimizing material usage - and thus maximizing utilization - rather than on
reduction of direct construction costs through rationalization of sections/
details, potentially at the expense of some increased material and reduced
utilization efficiency.

For a detailed discussion of this topic, please see for example this paper from
the UK Institute of Structural Engineering: Rationalisation versus optimisation
– getting the balance right in changing times, by Ian Poole.

Enhancements are made in the Tekla Structural Designer 2020 SP6 release to
assist the engineer in assessing the efficiency of their design in these terms.
These go hand in hand with the enhancements to Material listing (page 106)
information also made in this release. Improvements are made to the Review
View > Design Status functionality, with the Legends being made more
informative and the addition of new viewing filters. Together we believe these
enhancements will make the Design Status view even more effective, allowing
the engineer to remove ‘clutter’ and, for example, to focus on objects with low
utilization so they can improve the efficiency of their design. For more
information see the new Help Topic Design review filters (page 853).

• These enhancements apply principally to the Status and Ratio views for:
Member Design, Foundations, Piles, Slab/Mat Design, Connections.

• Note however that the filters can also be used in the Review View with
no Ribbon buttons selected.

• Legend - when the Status view is active, the total number of entities with
each design status is now given adjacent to each color group in the Legend
as shown in the picture below. This highlights that Fails/ Warnings exist,
even when the failing entities may be obscured in the current view - the
engineer can then adjust the view to find where they occur. This is also the
case for the (Utilization) Ratio view - the total number of entities in each
ratio band is shown in brackets adjacent to the band legend color.
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NOTE For the count of entities with each status, each span/stack/panel of
continuous beams/columns/walls respectively counts as one
entity. So, for example, if all stacks of a four-stack continuous
column are failing, then this will contribute 4 to the count of failing
entities.

• New Filters - the following new Review View filters are now available and
are accessed via the Properties window: Status, Utilization ratio, Entity type.

• These allow the engineer to show/ emphasize in the active view only
entities that comply with the filter settings.

• By default, with the “Ghost excluded” general setting enabled, other
entities are ghosted, as shown in the picture below right, making the
location of filtered entities in the model clear. With “Ghost excluded”
disabled, excluded entities are removed entirely from the view.

• By default, with the “Manual filters” general setting disabled, when the
Status or Utilization ratio Ribbon buttons are selected, only the
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associated Status/ Utilization ratio filters are automatically listed in the
Properties window.

• You can see all the filters simultaneously by enabling the “Manual
filters” setting - you then check the “Active” box to enable each set of
filters you require as shown below left.

• The filters can be used individually or in combination and allow the
engineer to focus on specific results, typically for status/utilization displays
- for example the picture below shows simultaneous use of the Utilization
ratio (UR) and Entity type filters, with “Ghost excluded” off, to see only
members with a low UR (below 0.3).

• Note also the number of entities listed for each band in brackets
adjacent to the Legend band color as mentioned above - so in this
example we know there are 12 entities with UR between 0.2 and 0.3,
and 42 between 0 and 0.2
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Material List Enhancements
In Tekla Structural Designer 2020 SP6, as a key part of the development work
for the recent and ongoing Carbon Impact features (for more information on
this see the Help Topic Measuring the carbon impact of a structure
(page 1643)), the Material List data tables are significantly enhanced, both for
the Review View > Tabular Data and the associated Report item. Having the
material content of the model in more detail allows the engineer to more
readily assess many aspects of design, including efficient material usage and
thus Carbon Impact. For more information on the enhancements, see the new
Help Topic Review material list tabular results (page 902) and its subtopics.

• Reports Levels - A key enhancement is that there are now two levels of
Material List tables - Summary Only and Detailed - where previously there
was just one level. See the pictures below showing the difference this
makes for concrete beams for example. The new available levels are:

• Summary Only - this is the default level and is a new very condensed
report, giving only the total quantities for each section size for beams/
columns for example.
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• Detailed (“Summary Only” Ribbon button disabled) - the tables for
concrete beams / columns / walls now give quantities for each span/
stack/ panel, making them much more detailed than previously.
Additionally, the tables for beams and columns now include the
detailing group reference.

• Export to Excel - note that all the new/ enhanced Material List tables can
be exported to an Excel file directly from Review View > Tabular Data for
further sharing/ further processing, just as for all other tables.

• Reports - the enhancements detailed here also apply to the associated
Material List Report item. By default the Materials Listing report will also
give the Summary level. A new Setting “Show summary only” is added to
control the Report level as shown in the picture below - set this Off to
produce a Detailed level report.

• Reinforced concrete members - new Reinforcement quantities - the
tables for both levels also now include new columns for reinforcement
quantities* giving the total weight (e.g. kg) and weight/ unit volume (e.g. kg/
m3). This applies to all of the following concrete elements; Beams,
Columns, Wall, Slabs, Pad/Strip bases and Pile Caps. Note the following:

• *In general reinforcement quantities are given only for cast-in-place
(CIP) fabrication. An exception to this is slabs, for which reinforcement
can be specified for example for precast concrete planks (with topping)
- such reinforcement will also be included in the material list table for
these.
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• For concrete beams and columns, at the Detailed level every span/stack
is listed separately (or when group design is active this reduces to every
group span/stack)

• For beams, reinforcement running between spans is shared.

• There is no additional detailing weight allowance (as previously)

• Concrete Slabs - the Detailed table for concrete slabs also includes
additional columns giving quantity values for; slab reinforcement,
punching shear reinforcement, total reinforcement (slab + punching) as
well as the total reinforcement weight and weight/ unit volume. Note
the following:

• The calculation of overall reinforcement quantities is as previously -
a user defined additional detailing allowance is still added (specified
in Design Settings > Concrete > CIP > Slab > General Parameters).

• Punching shear reinforcement - this gives an approx weight for
punching shear rails (based on ACI guidance)

• Some approximation also results from slab patch and punching
reinforcement - this is shared equally between slab items patches/
punching checks touch, not apportioned by covered areas.
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• Other notable aspects of the enhancements are:

• The table order can now be sorted by any column by clicking the column
header. Additionally, a new arrow symbol adjacent to the header text
indicates the sort order; ▲indicating ascending and ▼ descending order.

• In a similar manner to the Review View > Design Summary table, you can
now double click on a row in the active table to locate the entity - or entities
- it references in the 3D View of the model. Together with the sort facility
discussed above, this makes it very easy for example to locate elements
with a high reinforcement weight/ unit volume, that the engineer may wish
to focus on.

• Composite beams - as shown in the picture below, the table now gives
Transverse Shear Reinforcement quantities both in terms of size/spacing
and weight (calculation of the weight value follows guidance taken from SCI
publication AD 437).
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• Slabs:

• Composite - the table now includes decking and reinforcement details.
The reported mass value is also corrected to account for the profiled
steel decking section where previously it was for a solid rectangular
section and so was an overestimate.

• Precast (concrete planks) - the following enhancements are made:

• Manufacturer and reference (e.g. Bison Hollow Core) and
reinforcement information is added to the table.

• Reinforcement data is calculated on the same basis as in concrete
slabs (which allows for laps at slab item boundary and user defined
detailing allowance). To see more reinforcement detail, you can set
the Ribbon Content button = “loose bars” or “mesh”.

NOTE The Detailing allowance specified in design settings for CIP
slabs applies to all rebar defined in any slab type.
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• The reported concrete volume is corrected so it relates only to the
topping (if it is specified at all).

• Timber/ General Deck - there is now much more detailed reporting than
previously giving; Level, thickness, material grade, and in the Detailed
table each slab item reference.

Review View - Show/Alter State Reinforcement command extended to
Isolated Foundations
In Tekla Structural Designer 2020 SP6 the Review View > Show/Alter state
Reinforcement command is now extended to include Isolated Foundations,
enabling rapid graphical review and editing of their reinforcement. This
applies to: Column pad bases (spread footings), Wall strip footings and Pile
caps.

• To use this new feature, select Entity type = Isolated Foundations in the
Properties window, as shown in the picture below. Just as for slabs, you can
then select the Surface and or Reinforcement direction for review/ editing.
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Release notes: Tekla Structural Designer 2020 SP5
This release will upgrade your Tekla Structural Designer installation to version
number 20.0.5.56 and should be installed to ensure optimum function of the
program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than the immediately prior release
2020 SP4 (version 20.0.4.55 released Sept 2020), you can find details of
requirements, enhancements and fixes for all previous releases in Tekla User
Assistance (TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

Licensing
• No new license is required for this version.

• Tekla Structural License Service - the latest Service Pack for this was
released in July 2020. This is available in Tekla Downloads and should be
installed on all clients for optimum functionality.

• For more information see the Release Notes page for the Tekla License
Service update July 2020 (v3.1.3.4).

• License Server Version - for Server licensing, the latest version of the
Tekla Structural License Service 3.1.2 (incorporating Sentinel RMS 9.5) must
be installed on your license server to be compatible with this release.
Licensing will not function correctly if this is not the case. For more on this
requirement please see the TUA article Tekla Analysis & Design 2020
Releases & Sentinel RMS Server Licensing - the License Server must be
updated.

Installation

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) or later to be installed and will replace your current
version.

• Integration

• Tekla Tedds - to use the new Timber Design using Tekla Tedds feature
(page 174), you must install the Tekla Tedds Engineering Library update
(September 2020) or later. All Tedds updates can be obtained from
Tekla Downloads or via the Update Service.

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate this release with Tekla Portal Frame Designer/ Tekla
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Connection Designer, you should install Tekla Portal Frame Designer/
Tekla Connection Designer 20 Service Pack 2. This was released in Sept
2020 and can be obtained from the Tekla Download Service.

• Autodesk Revit© - the Tekla Structural Designer Integrator for
Autodesk Revit© 2021 (version 7.01) was released in September 2020
and is available in Tekla Downloads. If you are now using Autodesk
Revit© 2021, you can install this to perform BIM integration with Tekla
Structural Designer.

• All fixes and enhancements included in this release are also included
in updates for the Integrators specific to the following currently
supported Revit© versions; 2020 (Integrator version 6.02); 2019
(Integrator version 5.03); 2018 (Integrator version 4.04). For more
information see the Tekla Structural Designer Integrator September
2020 updates. If you are performing BIM integration with any of
these Revit© versions, we recommend you update to the latest
version of the associated Integrator.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - Depending which version you are upgrading from, some
Databases may be updated by this release. When this release is first run,
your Databases will now automatically be updated and it is no longer
necessary to do this manually via Home > Materials. See the Release notes:
Tekla Structural Designer 2020 SP4 for more about this.

Issues with Associated Bulletins
• [TSD-8103] - Piled Mat Foundation Slabs - RSA Seismic Design - For the

seismic combinations Static+RSA & Static-RSA and where tension occurred
in these, piles were not checked for tension capacity in some
circumstances. This could produce an unconservative result where an
unchecked tension capacity would govern the pile design. For more
information please see Product Bulletin PBTSD-2011-1.

• This issue is fixed in this release. In addition the pile design report now
includes the pile capacity check for all selected RSA combinations

General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability. An example of this is
given directly below:

• [TSD-7940] - Report Generation - Analysis Elements with no material
(e.g. Linear and non-linear axial/torsional springs) no longer prevent the

Upgrade to this version 114 Tekla Structural Designer service packs

https://teklastructuraldesigner.support.tekla.com/support-article/3072521
https://teklastructuraldesigner.support.tekla.com/support-article/3072521
http://download.tekla.com/
https://teklastructuraldesigner.support.tekla.com/support-article/3072825
https://teklastructuraldesigner.support.tekla.com/support-article/3072825
https://download.tekla.com/tekla-structural-design-suite/for-businesses/all-downloads?version=245&downloadtype=221
https://teklastructuraldesigner.support.tekla.com/support-article/3072825
https://teklastructuraldesigner.support.tekla.com/support-article/3072825
https://teklastructuraldesigner.support.tekla.com/tekla-structural-designer-2020/en/rel_releasenotes2020sp4
https://teklastructuraldesigner.support.tekla.com/tekla-structural-designer-2020/en/rel_releasenotes2020sp4
https://teklastructuraldesigner.support.tekla.com/support-article/3072865


generation of reports that contain the following report chapters:
Material Listing, Analysis>Elements, Analysis>Element-Member, or
Analysis>Element Properties.

• [TSD-7773] - Selection Properties Grid - the organisation of the property
grid dropdown list of currently selected entities has been changed as
shown in the picture below:

• As the range of objects available in the program has increased, a simple
list organised alphabetically has become unwieldy in some
circumstances, so it is now organised by object, material and fabrication
types (in a similar manner to the Entities to be deleted filter dialog).

• We believe that all users will appreciate this more clear and logical
organisation, however we do acknowledge there may be an initial sense
of unfamiliarity for longer-term users.

• [TSD-6135] - Export to Excel - the send to Excel export option (for Model
and Results and Design tabular data, Wind Tunnel Data and Reports) no
longer relies on Microsoft Excel being installed on your computer; if it is not
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installed an Excel (*.xlsx) file is still created. In addition, the time taken to
export large files has been significantly reduced.

• Note that a further difference to previous releases behaviour is that an
Excel file (*.xlsx file) is now created in your Windows user Temp
directory (C:\Users\user_name\AppData\Local\Temp where
“user_name” is your Windows user name). You can then elect to save
the file to another name/ location as you require.

• [TSD-7691] - Slabs - Steel & Timber Deck & General - slabs of any General
material (e.g Aluminium or any user-defined material) can now be created.
In addition, on the Model ribbon the Steel and Timber Deck types are now
combined under one common tab ‘General’ with the inclusion of the new
‘General’ deck option, as shown in the picture below. General material
slabs are created in the same manner as other slabs (slab on beams) and
have the same one and two-way decomposition, properties and loading
options as the existing deck types.

• Other aspects of this enhancement are:

• Timber decks can now be set to two-way decomposition.

• The Imposed Load Reduction % option is now available for all these
General slab types.

• The material of Steel and Timber (and the new general type) decks
can now be selected from the material database where previously it
was only user-defined. As shown in the picture below, there is a new
property for selection of the steel/timber/general material grade.
There is also a new “Override material properties” checkbox to allow
user-defined properties (when enabled the grade selection option is
removed). This option is off by default for new slabs.
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Note the following:

• Existing models - in those with Steel or Timber deck slabs, the
“Override material properties” checkbox for these will be enabled
and thus the existing properties retained. The user can then
decide if they wish to edit this and instead apply a material
grade.

• Timber grades cannot currently be directly set for Timber decks
because the Poisson’s ratio is generally invalid for isotropic
elastic analysis (of 2D elements), for which it must be > 0 and <
0.5. Hence, if you disable the override and select a timber grade,
you must then enable it again to enter a valid poisson’s ratio
(other grade properties such as density and modulus of elasticity
will be retained).

• Two-way General material slabs can be meshed in 3D analysis and
graphical analysis 2D results obtained just as for two-way concrete
slabs (including result lines and strips), however there is no design
for them. New Analysis modification factors are also added for them
(default value 1.0).
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• BIM Integration - General slabs can be imported/exported as per the
current functionality of Structural BIM Import/Export. Note that for
optimum integration (in relation to material mapping) it is
recommended to use database materials for General slabs rather
than applying ‘override’ properties.

• General slabs are also added to the Scene Content settings, and the
Review View > Tabular data for material listing (and the associated
report item settings) is now separated and enhanced for general
material slabs.

• [TSD-7590] - Structural Walls - different types of wall fabrication - e.g. Cast-
in-place and Precast - are now separated in the property grid as shown
below to allow easier editing of similar wall types in complex models. These
different wall types are also now separated when reviewing Material list
data, both in the tabular data view - via new Fabrication filter buttons as
shown in the picture below - and in the settings of the associated Reports
item.
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• [TSD-3038] - Copy/ Move Beams and Construction Levels - copying or
moving a beam that is created at an existing construction level to a location
which is NOT at a level - e.g. between floors - no longer creates a new
construction level at this location height. This is important since it has
implications for the creation of column stacks and hence design. Note the
following:

• It is not necessary to have a construction level in order to place beams
(or cladding rails etc) at a level - e.g. to span between columns between
floors. Beams can be connected to columns at any point within their
length.

• Where a beam connects to a column at a construction level, the column
will be divided into stacks above/below this level. This has implications
for design and is an engineering decision since the stack lengths are
used to determine effective lengths and in sway/drift checks.

Performance
• [TSD-7221] - Graphics - the graphics driver settings in Home > Settings >

Scene > Graphics are updated and adjusted as shown in the picture below.

• Note the following regarding this change:

• The “DirectX (old)” option was based on DirectX 9. This is no longer
supported by the latest version of the graphics engine and has been
removed from the list.

• Existing installations set to “DirectX (old)” by default will see this
setting automatically updated to the “Auto” option. This setting
allows HOOPS (the 3rd party graphics engine used by Structural
Designer) to pick the optimum driver and is now the default for new
installations. We do recommend checking your current Graphics
Driver setting and setting it to the Auto option if necessary.
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• To check your graphics adapter’s compatibility visit the HOOPS
developer website for HOOPS 25.xx, DirectX and OpenGL
requirements.

• [TSD-7523 & 7545] - Graphical Issues - it is expected that this update will
render the program graphics more reliable in general and potentially
resolve some more rare graphics issues such as gridlines becoming
intermittently invisible and associated crashes.

• [TSD-4843] - Analysis Process - the handling of analysis warnings/errors
during analysis is improved to limit the number of these stored and listed
with results. Previously, for larger models containing analysis issues (such
as instabilities due to mechanisms), this process could occupy significant
analysis time/ resources and prevent saving after analysis. The
improvement resolves the latter issue and can reduce analysis times for
such models from several minutes to a matter of seconds, enabling much
more rapid troubleshooting and resolution of analysis problems.

Interoperability
• [TSD-8064] - Carbon Calculation - Export data to "One Click LCA" - the

carbon impact of construction is under ever greater scrutiny and engineers
are often now required to assess the Building Carbon Footprint of their
projects. An exciting and powerful new feature is added in this release to
assist with this. The engineer can now easily create a report of the project
materials data to quickly determine its embodied carbon using One Click
LCA. Note that a subscription to the One Click LCA App is required in order
to use this (see the website One Click LCA for more details). As shown in
the picture below, a new button for this is added to the BIM Integration
ribbon. This automatically compiles a very compact summary of materials
in the project which can then either be uploaded to One Click LCA or
viewed directly. For more information please see the Help Topic Export to
One Click LCA (page 341).
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• When the One Click LCA export button is selected, the Report options
dialog is displayed as shown below. To view the report directly, click the
“Show report” option - the report is written to an Excel (*.xlsx) file, which
will open automatically provided you have an installed application
associated with this file type. This data file can then be shared with any
other parties. Alternatively you can send the data directly to One Click
LCA cloud by entering your sign-in credentials (your One Click LCA
credentials not those of your Trimble Identity) and selecting Log in.

• In One Click LCA you can then create or choose a project for your data,
consider groupings and review/ apply mapping. An example of how this
looks is shown below. For further information on using One Click LCA
see the One Click LCA website.
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• [TSD-6321] - Export to CXL (Structural BIM) and IFC - Levels - to give greater
control over the export of levels to BIM Applications (both Tekla Structures
and Revit via CXL file) and IFC, a new setting “Include in Export” is added to
Level properties as shown in the picture below. The setting option
determines whether the level is exported as follows:

• Floor Only - included in export only if defined as a floor (the “Floor”
option is enabled in Level Properties/ Construction Levels)
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• Yes - always included in export

• No - never included in export.

• [TSD-6970] - Structural BIM Import - Foundations - Wall Strip Bases
(Footings) - the import of valid strip footings via the Structural BIM import
process is improved to cater for cases where the footing does not extend
to one or both ends of the wall. Previously, such footings would be
imported automatically as foundation mats. New tolerance has been
added such that this will only occur when the overlap between the wall and
the footing is smaller than 20% of the wall length on either side, effectively
allowing for strip footings up to 40% shorter than the wall length.

• [TSD-6615] - BIM Integration - Column Splices - an issue is fixed which
caused an error when importing a CXL file to update an existing Structural
Designer model when column splice locations were altered in the BIM
application (e.g. Revit).

Analysis & Results
• [TSD-7634] - Trusses - Releases - for any truss bottom chord, the axial load

release option can now be enabled at both ends simultaneously, where
previously only one end was allowed. This allows the easy modeling of
“slotted” type connections - which allow some amount of horizontal
movement and hence do not transfer axial load - which are commonly
used where parallel chord truss bottom chords connect to a column.
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• [TSD-6597] - Solver Model - Rigid Offsets - a more rare issue causing rigid
offsets not to be updated correctly in the solver model following some
model edits is fixed in this release. For existing models with this issue the
solver model will be rebuilt and any existing analysis results cleared when
opened in this release - results can then be re-established by running
analysis or design.

Design
• [TSD-7930] - Design Groups - Columns - In previous releases, the grouping

criteria for steel, timber and cold formed columns were not as stringent as
those for concrete columns in that there was no requirement for all group
members to share the same section size. This significantly hindered the
workflow when attempting to design using groups. This is addressed In this
release by the introduction of a new grouping criterion for timber and steel
columns requiring section sizes to be consistent within each group. Note
the following:

• For timber design using Tekla Tedds, this removes the previous
restriction that made it the users responsibility to ensure all members
of column groups were the same size.

• When a model from a previous version is opened in 2020 SP5, the new
grouping criterion is automatically applied. Any existing timber or steel
column groups containing mixed section sizes have the inconsistent
members removed, (either to another suitable existing group, or if none
exists a new group is automatically created).

• [TSD-7606 & 7644] - Precast Concrete Columns - Eccentricity Moments and
Load Patterning - eccentricity moments are now automatically calculated
and considered in the determination of the moments for the design of
precast columns using Tekla Tedds. Additionally, eccentricity patterning of
live loads can also now be considered for determination of both axial
forces and design moments for precast columns in the same manner as
that introduced for Steel columns in the 2020 SP4 release.

• The following new settings are added for this feature:

• Column properties - new settings for Eccentricities for each face and
level at which beams connect to the column.
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• Global and Model setting - new setting under Loading > General to
enable patterning “Use patterning of eccentricity moments for
precast columns” (on by default for new and existing models).

• Note the following:

• Analysis of eccentricity moments applies to all Head Codes, however
design using Tekla Tedds is only available currently for the Eurocode.

• Eccentricity moments are calculated only for connected beams that
are pinned. They can be viewed in the Load Analysis view in the
same manner as for steel columns.

• The minimum axial force considered by design using Tekla Tedds is
capped by the Axial force ignorable limit if it is less than this (default
0.5 kN).
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• A warning for tension is issued if the axial force in a lower stack is
below 0.0.

• For more details on this feature, see Precast column connection
eccentricity moments (page 1558).

• [TSD-3801] - Isolated Foundations - Pad/Strip Footings - All Head Codes -
the auto-design process for Pad/Strip Footings is improved to increase the
depth to attempt to pass the uplift condition where previously only the
footing size (plan dimensions) was increased. Where uplift governs this
should produce a passing solution in more cases, or a more logical and
useful failure where the design size constraints (Design > Settings >
Concrete > Foundations > Isolated Foundations > Foundation size) are too
restrictive for a passing solution to be found.

• Note that the user can reduce the maximum side length/ strip width
constraint to promote solutions of smaller plan dimension/ deeper
footings.

• [TSD-7606] - Slab Design - Column Drops - the design of slab drops and
punching shear checks draw some of their design data from the parent
slab they are assigned to. Although these entities can only be assigned to
one parent slab, in previous releases they would be allowed to overlay
different parent slabs and this could sometimes create issues such as
incorrect geometry, unexpected design data or invalid objects. This is
addressed in this release as follows:

• Both slab drops and punching shear checks are restricted to the parent
slab they are assigned to, on the assumption that connected slab items
of identical type are expected to have the same slab parent.

• For existing models with more unusual situations this could result in
changes in slab drop and punching shear check geometry or these
objects becoming invalid. Hence for existing models opened in this
release, you are advised to review these for any such occurrences.
Where they do occur you can consider alterations to the slab items or
parent slabs to ensure drops/ punching checks overlay them as
expected.

• Note that for invalid slab drops, their properties can be exposed
from Model Geometry > Slab Items in the Status tree in order to
change their parent slab.

• [TSD-8109] - Concrete Beam Design - Links (Stirrups) - improvements are
made to the creation of top closures for open links. Only one top closer is
now created at each position. When there are multiple links at the position,
if there is no "outer link" then the top closer will still link the outer legs.
Note that this change could result in a (very small) reduction in quantity of
reinforcement.

• [TSD-8049] - Review View - Sway/ Drift tabular data - a problem introduced
in the previous 2020 SP4 release preventing the sorting of the Sway/ Drift
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tables via the column headers (e.g. by lambda/alpha/ drift ratio value) is
fixed in this release.

Reports and Drawings
• Reports:

• [TSD-7728] - Report Creation and Send to Excel - when a report is
generated, or report data is sent to Excel, the status of existing analysis
and design data is checked and the following warning issued if this is
out of date - "Some results are out of date. Do you want to continue?".
The warning could often be issued erroneously when it did not relate to
the data being reported/ exported. Improvements are made in this
release to reduce the occurrence of such unnecessary warnings and the
warning message is enhanced to state which results (of Analysis,
Concrete Design or Steel Design) are out of date.

• Drawings:

• [TSD-7601] - General Arrangement - Cold Formed Trusses - new DXF
layers for cold formed trusses have been added so that they are now
displayed in General Arrangement Drawings where previously they
were omitted. The default drawing settings have been updated with
these in the settings sets. Note that these can be loaded into existing
models via Draw > Settings > Load.

Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

Release notes: Tekla Structural Designer 2020 SP4
This release will upgrade your Tekla Structural Designer installation to version
number 20.0.4.55 and should be installed to ensure optimum function of the
program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than release 2020 SP3 (version
20.0.3.28 released July 2020), you can find details of requirements,
enhancements and fixes for all previous releases in Tekla User Assistance
(TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads
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Licensing & Installation

Licensing

• No new license is required for this version.

• Tekla Structural License Service - the latest Service Pack for this was
released in July 2020. This is available in Tekla Downloads and should be
installed on all clients for optimum functionality.

• For more information see the Release Notes page for the Tekla License
Service update July 2020 (v3.1.3.4).

• License Server Version - for Server licensing, the latest version of the
Tekla Structural License Service 3.1.2 (incorporating Sentinel RMS 9.5) must
be installed on your license server to be compatible with this release.
Licensing will not function correctly if this is not the case. For more on this
requirement please see the TUA article Tekla Analysis & Design 2020
Releases & Sentinel RMS Server Licensing - the License Server must be
updated.

Installation

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) or later to be installed and will replace your current
version.

• Integration

• Tekla Tedds - to use the new Timber Design using Tekla Tedds feature
(page 174), you must install the Tekla Tedds Engineering Library update
(September 2020) which is released at the same time as this Service
Pack and can be obtained from Tekla Downloads or via the Update
Service.

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate this release with Tekla Portal Frame Designer/ Tekla
Connection Designer, you should install Tekla Portal Frame Designer/
Tekla Connection Designer 20 Service Pack 2. This is released at the
same time as this Service Pack and can be obtained from the Tekla
Download Service.

• Autodesk Revit© - the Tekla Structural Designer Integrator for
Autodesk Revit© 2021 (version 7.0) was released on 1st July 2020 and is
available in Tekla Downloads. If you are now using Autodesk Revit©

2021, you can install this to perform BIM integration with Tekla
Structural Designer.

• All fixes and enhancements included in this release are also included
in updates for the Integrators specific to the following currently
supported Revit© versions; 2020 (Integrator version 6.01); 2019
(Integrator version 5.02); 2018 (Integrator version 4.03). For more
information see the Tekla Structural Designer Integrator July 2020
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updates Release Notes. If you are performing BIM integration with
any of these Revit© versions, we recommend you update to the
latest version of the associated Integrator.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - Some Databases are updated in this release. When this
release is first run, your Databases will now automatically be updated and
it is no longer necessary to do this manually via Home > Materials. See
Other Enhancements & Fixes, in the General & Modeling section below
for more on this.

Highlights
General & Modeling

• New Line and Area Ancillaries - application of loading from ladders, stairs,
pipework etc (page 148)

• New Inactive Members (page 153)

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

Interoperability

• Enhanced Grasshopper Live Link - Design Results and Reporting (page 162)

Analysis & Results

• Dynamic Analysis - Wind Tunnel Data Report Generation (page 165)

• Walls - Distributed Wall Reactions (page 168)

Design

• Timber Design - Comprehensively Enhanced Timber/ Wood design using
Tekla Tedds 2020 - US & Eurocode (page 174)

• Steel Design - New Patterning of Eccentricity Moments (page 188)

• Minimum Design Forces & Rounding Increment (page 192)

• Steel Design - Compound Section Design - Indian Head Code (page 195)

• Concrete Design - Pile Punching Checks on Mat Foundations - Eurocode
and US Head Codes (page 197)

Issues with Associated Bulletins
• [TSD-7035] - Shear only walls - these were introduced in the 2020 first

release (version 20.0.0.129 March 2020). However, the initial modeling
formulation for these had the limitation of failing to report the vertical
‘push-pull’ effects at the ends of the panel that would be expected to be
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present to resist overturning. Due to the potential for mis-use and mis-
understanding this caused, the option to use shear only walls was
accordingly removed in the 2020 SP2 release (version 20.0.2.33 May 2020).
For more information please see Product Bulletin PBTSD-2005-2.

• This issue has been resolved in this release and use of shear only walls
reinstated. See New Lateral Force Resisting System Wall Type - Shear
Only Walls (page 158) for more information.

• [TSD-2529] - Wind Wizard - Finland (Eurocode) Head Code - for Terrain
category 0 (Sea), the calculated peak velocity pressure qp was incorrect and
too low, thus producing wind loads which were not conservative. Loads for
other Terrain categories were not affected. For more information please
see Product Bulletin PBTSD-2007-1.

• This issue is fixed in this release. Note that for existing models with this
circumstance, the Wind Wizard must be run again to correct the peak
velocity pressure qp value.

General & Modeling
Highlights

• New Line and Area Ancillaries - application of loading from ladders, stairs,
pipework etc (page 148)

• New Inactive Members (page 153)

• New Lateral Force Resisting System Wall Type - Shear Only Walls (page 158)

Enhancements and Fixes

• A number of additional fixes which are not detailed explicitly here are also
made to improve general performance and stability. An example of this is
given directly below:

• [TSD-5746] - Composite Beams and Concrete Beams - significant
improvements are made to the calculation process for both the
effective width of composite beams (both floor and natural frequency)
and flange widths of concrete beams. This improves the performance
particularly for very large models with 1000’s of beam spans:

• Composite beams - this primarily impacts the time taken to populate
the Properties Window for a selection of beams - a selection of many
beams in larger models which previously could occupy a few
minutes now takes a matter of seconds.

• Flanged concrete beams - this impacts the time taken for analysis
and design and can result in an improvement in performance (in
terms of reduced overall analysis and design time) of 2-3 times or
more.

• [TSD-4943] - Sub Structures - further to recent enhancements to the
creation and management of Sub Structures, additional enhancements
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have been made in this release so that members created/edited/copied/
moved while working in a Sub Structure view are retained in the Sub
Structure.

• [TSD-4890] - Isolated Foundations - when the base level of an isolated
foundation is moved, the current foundation along with support moves to
the new level where in previous releases it would be deleted. This applies
to foundations of; columns, walls and portal frame columns.

• [TSD-3672, 7377] - Steel Beams - Plated Fabrication - different types of
plated beams can be modeled, including those used in proprietary systems
(such as Westok and Fabsec]. Previously, whenever there was a change in
plated beam fabrication, the default section size would be applied. This
behavior is improved in this release to retain the dimensions of the beam
section in this circumstance thus enabling a more convenient workflow.

• If the corresponding section does not exist in the Steel section
database, it is created on the fly (in the model) and can be added to the
local database at the engineer’s discretion by reviewing the new
sections in the model (via Home > Materials > Model).

• Note that the same section size - namely the one from the first span -
will be assigned to all spans of multi-span plated beams when changing
fabrication.

• [TSD-6831, 6834] - FABSEC Fabrication - Openings - elongated openings can
now be defined in beams set to the FABSEC fabrication option, as
illustrated below. Elongated openings are also imported/ exported
correctly when conducting integration with the FBEAM program (for more
on this see Export to and import from FBEAM (page 330)).

• The Web opening dialog features automated validation checks that the
elongated opening satisfies recommended dimension limits, as for
existing opening shapes. As part of this enhancement, for all openings a
warning triangle icon is now displayed rather than an error icon for
dimensions that exceed recommended limits but can still be OK’d (at
the engineer's discretion).
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• Note that, prior to this release, such openings were handled using a
UDA - this method is now removed and the UDA no longer used. Any
existing models containing equivalent elongated openings can be
updated by re-importing the appropriate FBeam .xml file.

• Elongated openings are not valid for other fabrication types, however
they will be retained if this is changed from FABSEC. Hence new
validation is added to check for this circumstance and a validation error
will be reported for it as shown below.
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• [TSD-5578] - Databases - as noted in the Installation section above, this
release introduces automatic updating of your local Databases, so it is no
longer necessary to do this manually. This process works as follows:

• Providing all databases can be updated automatically without user
intervention, when this release is first run then the updates are applied
and a message is displayed stating "updating to latest database
versions" as shown below. On successful completion this closes and the
program will open.
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• [TSD-7194] - Timber Columns - Splices can now be introduced into timber
column stacks in the same manner as for steel columns (via the stack
properties) to enable having different section sizes above/ below the splice.

• Section Properties:

• [TSD-5618] - Timber - the major and minor Shear Area values for
rectangular Timber sections are revised to (5/6)*Ag from the previous
0.5xAg (where Ag = Gross section area). This change aligns the shear
area value with that used by Tedds. Note the following:

• The shear area affects only the component of deflection from
analysis due to shear deformation and is not used elsewhere by the
program. Moreover the proportion of the gross area used to
calculate the shear area - commonly termed the “form factor” - is
essentially an estimate and different references on elastic theory
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may differ on the value for various section shapes. The factor of 5/6
is commonly accepted for rectangular sections and elastic behavior.

• Since shear deflections are inversely proportional to the shear area
and - for normally proportioned beams - usually account for a
smaller proportion of overall displacement, the previous smaller
0.5xAg value would have produced a generally minor overestimate
of the shear component of deflections only, hence this update will
produce a reduction in deflections of a similar order.

• To update the shear area values for existing models, go to Home >
Materials > Model > Sections then select the timber section(s) listed
and select “Update from Database”.

• [TSD-5427] - Steel - the names of Continental UB “350x175” sections
(Nominal depth D = 350 mm and nominal breadth B = 175), have been
corrected from the previous “300x175” name according to the
manufacturer's catalog. This change is relevant for the regions of
Singapore and Malaysia. Note that the issue relates to the name only -
the section values were correct per the manufacturer's catalog for
“350x175” sections.

• [TSD-3992] - Review View - Slab Reinforcement - the legend for Show/Alter
State > Slab Reinforcement is now expanded with multiple page options in
the same manner as other options - such as Section/ Material Grade - have
been in previous releases. This removes the previous limit of 9
reinforcement variations and enables the graphical review and editing of
any number of these. When the number of variations exceeds 9, the next
legend page right arrow > is enabled as shown in the picture below - you
can then move forward/ backward between legend pages to review all the
reinforcement variations.
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Interoperability
Highlights

• Enhanced Grasshopper Live Link - Design Results and Reporting (page 162)

Enhancements and Fixes
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• Trimble Connect - Integration with Trimble Connect is enhanced with the
following new options:

• Drawings - Upload of any DXF drawing to a linked Trimble Connect
Project. This option is listed in the DXF Export Preferences dialog as
shown below.

• Reports - Upload a PDF of any Report to a linked Trimble Connect
Project via the new “PDF Upload” button in the Trimble Connect group
of the Report Ribbon.

• Both this and the DXF Export Preferences dialog include an option to
open the new Trimble Connect File browser to allow the selection of
the target project folder for created Drawing/ Report (see picture
below).

• Defaults for the default Target folder in the Trimble Connect project,
and whether to keep a local copy of the report, can also be set via
the “Upload Settings’ button.

• Model Links - Uploaded Member Drawings/ Reports can also optionally
be linked to their specific member in the uploaded IFC model, as shown
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in the pictures below. They can then be conveniently accessed directly
from the IFC model attachments in Trimble Connect.
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Open API
This release includes further enhancements to the Tekla Structural Designer
Open API. For how to get started with the API, see the Tekla Developer Center.
New additions to the API enable interrogation by an external application /
process of the following objects and items:

• Construction points & point groups

• Planes (Levels / Frames / Slopes)

• Slab items / slabs / slab openings / decks / slab patches

• For slabs: Reinforcement, decomposition types, diaphragm options,
mesh types

• Roofs

• Structural walls

• Wind walls

• Piles
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Loading
• Load Combinations - US Head Code:

• [TSD-3294] - Seismic Combinations - In a similar manner to Gravity and
other Lateral combinations, Notional Loads (NL) can now be included in
seismic combinations. Addition of NL’s to seismic combinations is a
manual process at the engineer’s discretion via the combinations
dialogue - there is no automatic generation option in the Combination
Generator.

• The notional load value is calculated in all cases from the
combination’s constituent "gravity" load cases - i.e., Self weight, Slab
Dry, Dead, Live, Live (Other), Roof Live, Snow.

• [TSD-4018] - Combinations Generator - the LRFD 1.4D combination is
now enabled by default in the Load Combination Generator.

• [TSD-7668] - Wind Loading - US Head Code - the Wind Loadcases dialog
"Auto" command now correctly enables the "Roof Loads" option for the
“±X’±Y’” cases when the Roof Cp checkbox is selected in load case
generator, so all Wind loadcases now have Roof Loads enabled by default.

• [TSD-4678] - Consequence/ Reliability Class - the setting for "Consequence
Class" for Finland (Eurocode NA) and "Reliability Class" for Sweden
(Eurocode NA) has been moved from the Structure Tree Properties to
Settings (Global and Model) > Loading > General as shown below.

• Note that if the class is changed, existing combinations are deleted and
must be re-created as some dead load combination factors are
dependent upon the class.
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• [TSD-7574] - Notional Loads, Equivalent Horizontal Forces (NL, NHL, EHF) -
NL’s for previously analysed loadcases from which all loading had
subsequently been removed were not updated to reflect this, leading to
higher than required NL’s being considered. We expect this would be an
extremely rare occurrence, however it has been encountered and is
addressed in this release. The issue no longer occurs for new models. For
existing models which you suspect may have this issue you should:

• Review the applied notional forces and check they appear reasonable. If
required the stored results can be cleared and hence NL’s updated by
doing one of the following:

• Use the Save model only command - will remove all stored analysis
results and update the NL’s when you next analyze/ design.

• Edit objects in the model such as the geometry of a member or it's
supporting conditions - will set results to out of date so NL’s are
updated when you next analyze/ design.

• Use the Ctrl+right-click context menu from the Structure tree
heading and select the “Clear solver results” option.

Analysis & Results
Highlights

• Dynamic Analysis - Wind Tunnel Data Report Generation (page 165)

• Walls - Distributed Wall Reactions (page 168)

Enhancements and Fixes

• [TSD-6770] - 3D only (Static) - a new analysis option “3D only (Static)” is
added to the Analyze Ribbon as shown below. As the tooltip for this details
- this performs the same analyses as “Analyse All (Static)” but excluding the
chase-down analyses. It is thus a more rapid form of overall analysis which
can be used to obtain/ update the results for all processes that use the 3D
Building Analysis results, such as sway/ drift* checks and steel design.

• *Seismic drift check results are not updated by this analysis when the
RSA method is selected for Seismic - as in previous releases, RSA Design
must be run to update these.
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Design
Highlights

• Comprehensively Enhanced Timber/ Wood design using Tekla Tedds
(page 174)

• Minimum Design Forces & Rounding Increment (page 192)

• Steel Design - New Patterning of Eccentricity Moments (page 188)

• Steel Design - Compound Section Design - Indian Head Code (page 195)

• Concrete Design - Pile Punching Checks on Mat Foundations - Eurocode
and US Head Codes (page 197)

General Design Enhancements and Fixes

• [TSD-4551] - Foundation Design - Isolated Pad Bases - Sliding Check- a new
option is added allowing the engineer to control whether the passive
resistance of the soil is included in the check of Sliding Resistance. In
previous releases, the soil passive resistance was always included for all
Head Codes except the Eurocode (all country NA’s) which always omitted it.
As shown in the picture below, the new control is a check box in Design
Settings > Concrete > Isolated Foundations > General Parameters >
“Consider passive resistance of soil…”

• To match previous behaviour, the setting defaults to on for all Head
Codes except the Eurocode (all country NA’s).

• In addition to the new control for all Head Codes, the soil passive
resistance is also included in the sliding checks for the Eurocode Head
Code (all country NA’s) when the new setting is enabled (default off).
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• [TSD-7527] - Design Summary Table - of particular use during the Design
Review stage, you can now double-click a row of the Review Data > Design
Summary table to select the associated entity in the Structure 3D view. This
functions for all entities - beams, columns, walls, slabs etc - and materials
which have a Design Summary table, including those for Timber Members
introduced as part of the Timber design using Tekla Tedds feature detailed
above and illustrated below.

• As shown, you can arrange the table and Structure 3D view windows so
they are both visible to assist with this process (the active view will
automatically switch to the Structure 3D view after double-clicking the
table row if this is not the case).

• On double-clicking, the view automatically zooms/ pans to the location
of the associated entity which is both selected and indicated with an
arrow. Simultaneously the Properties Window is also populated with
those of the entity.

• This feature works particularly well in conjunction with Ghost
Unselected On, making the selected entity exceptionally clear as
illustrated.
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• [TSD-6674] - Concrete Design - Beams - All Head Codes - the design shear
identification process has been enhanced such that the design shear force
can originate from anywhere within the respective design region. In effect
this increases the scope of the design to ensure that the maximum shear
force in the region is considered for beams under special and less usual
loading conditions such as forces applied within a distance ‘d’ of the
support. Also included are minor adjustments and clarifications to the
reported check results to make the origin of the design shear more
transparent.

• [TSD-7607] - Member Design - this issue relates only to release 2020 SP3 in
which it was introduced and design/ check of individual members using the
right-click context menu. In the 2020 SP3 release, a change was introduced
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which cleared analysis results on members which were changed by a direct
edit - e.g. of their section size. This removed the workflow available in
previous versions of investigating alternative member sizes using analysis
results which could be out of date, but still considered useful. The change
has been reversed in this release enabling this workflow once more.

• [TSD-7223] - Composite Beams - Effective Width - in the unusual
circumstances of an alignment offset being applied to composite beams
such that the top of the beam was dropped below the bottom of the slab
creating a gap - as illustrated in the picture below - the detection of
adjacent beams in the automatic effective width calculation was impacted.
This could result in the automatically calculated effective width (which can
be reviewed/ edited by the engineer at their discretion) not being correctly
limited by the beam spacing. Although we consider this to be an unlikely
circumstance, it has been encountered and is addressed in this release.
Such offsets (which are not structurally significant as noted in the
properties dialog) are now correctly ignored by adjacent beam detection
and the effective width limited by the beam spacing, where this governs.

• Note that existing models with this circumstance will be flagged/
corrected by validation in this release depending on the setting Design
> Settings > Composite Beams > “Update effective width prior to design
check”:

• When Off - affected beams will be flagged with a validation warning.

• When On - the effective width of affected beams will automatically
be corrected by validation and check/design.
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Eurocode Design Enhancements and Fixes

• [TSD-4551] - Foundation Design - Isolated Pad Bases - Passive Resistance -
as noted above, the soil passive resistance can now be included in the
sliding checks for the Eurocode Head Code (all country NA’s) by enabling
the new setting for this; Design Settings > Concrete > Isolated Foundations
> General Parameters > “Consider passive resistance of soil…”.

• This new option also enables the “Ignorable percentage of passive
pressure” value for pinned bases, which simplifies the design for small
values of shear values which would commonly be ignored. Previously,
this was only available for Head Codes which considered the soil
passive pressure (always).

• The % value default is 1.00 - set the value to zero to consider all
forces no matter how small.
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• [TSD-6738] - Precast Design (using Tekla Tedds) - Columns - the Tedds
Precast column design (EN1992) calculation was recently enhanced (in the
Tedds Engineering April 2020 Update) with a basic shear check. The link
with Tekla Tedds for precast concrete design is accordingly enhanced in
this release to populate the calculation with shear force values from the
Structural Designer model.

US Design Enhancements and Fixes

• [TSD-5994, 7579] - Steel Design - Braces - Design is now carried out for
steel braces with Rod section type for all years of AISC 360 (ASD and LRFD).
The design is only carried out for axial tension, since rod sections are
commonly only used for tension-only bracing and ties. Compression is
beyond scope - a design details note is issued stating this and that the
section is assumed slender and additional hand calculations are required.

• A new Order list for Rod sections is also added in this release.
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Reports & Drawings
Reports

• [TSD-5518] - on selecting Show Report, the report is now opened with the
continuous display mode active (so the report can easily be scrolled
through with the mouse wheel) and the Project Workspace Report Index is
also automatically activated.

Drawings

• [TSD-7000] - Gable Posts - General Arrangement (GA) Drawing - Gable Posts
(Steel, Timber & Cold Formed) are now included in GA drawings and in
Scene Content > Plan View.

Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

New Line and Area Ancillaries Loading
This powerful new feature enables the quick and efficient application of
loading from ancillary items - such as ladders, stairs and pipework etc - that
are not part of the main structural frame. These are termed “Ancillary Loading”
and can be applied as either line or area objects. While the feature has been
developed especially with Industrial Structures in mind, it has a wider potential
applicability to many kinds of structures. For more information see the new
Help Topic Ancillaries

• A comprehensive list of Ancillary types is pre-defined with default loading
for both lines and areas. The Global settings for these can be reviewed and
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their load values edited in the Home > Settings dialog as shown in the
picture below. The same settings are also replicated in Home > Model
Settings for an individual model.

• Key aspects of Line and Area Ancillaries are:

• Dedicated Dead and Imposed (Live) load cases for the ancillary loads
are automatically created and can be included in combinations
produced by the Combination Generator (note that if working to
Eurocodes, Imposed case Ψ and ɸ factors default to zero and must be
manually defined).
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• Default Dead Loads and Imposed/Live Loads for each type are set and
can be overridden by the User. These can also be pre-set to be project
specific via Home > Model Settings > Ancillary Loading.

• Note that there is an additional setting for Pipework Operating &
Testing Content Loadcase Types, to define whether these are
considered as Dead or Imposed (Live) loads. This is found in both
Home > Settings and Home > Model Settings on the Loading >
General page as shown below.

• Imposed stair loading can be projected on the horizontal or along the
member.
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• All decomposed loads from Line and Area Ancillaries are present in the
Analysis and Design. Once loads are decomposed from Line and Area
Ancillaries, they play no further part in Analysis and Design.

• Since they represent physical objects, Ancillaries are applied via dedicated
new tools added to the “Walls & Loading Objects” group of the Model tab
of the Ribbon.

• Line Ancillary - creates a rectangular panel of a selected type and defined
width which are set in the Properties window during creation (and can
subsequently be edited). The applied loading is thus line loads determined
from the ancillary type area load(s) (as shown above) multiplied by the line
width.

• The panel can be defined singly or in a continuous run of a number of
lengths, which can be at different angles and in different planes. They
are created just like beams; by single mouse clicks to define the
start/end points of each length. Similarly to creating continuous beams,
after clicking the final point of the last length you escape to end the
operation.

• The plane of a panel is automatically determined when a length is
drawn in an existing plane such as a level or frame. When this is not the
case, an additional click after that of the end point is prompted for to
define the plane, with a dynamic graphic of the panel displayed as the
cursor is moved to aid the user.

• Once created, each length of a panel is a discrete object which can be
selected and edited individually. Its geometry can be edited graphically
just like a beam; by selecting and moving the start/ end nodes to
different points. The properties of selected individual or multiple panels
can be reviewed and edited via the properties window.

• The Line Ancillary default load values (shown above) are displayed in
the properties window during creation. These can be overridden by
checking off the “Default Load Values” properties setting, either during
creation or subsequently for one or more selected ancillaries.

• Line Ancillaries are treated as simply supported beams, spanning one-
way onto supporting members/slabs. Decomposition is in two stages;
from the Line Ancillary to its supports then onwards - the initial load
decomposition thus produces point loads at the support points of the
line ancillary, which may then be further decomposed - for example in a
2-way manner where support is provided by 2-way slabs.
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• Area Ancillary - creates a single panel of a selected type of any shape - the
applied loading is then that of the ancillary type area load(s) (as shown
above) over the defined panel area.

• They are defined in the same manner as existing Panel types by
selecting the vertices points and can be horizontal, vertical or sloped.
Once created a selected panel’s geometry can be graphically adjusted in
the same manner as a roof panel.

• Operation of the panel properties during creation and subsequently is
the same as that of Line Ancillary described above.

• Area Ancillaries have a span direction and load distribution is in this
direction onto surrounding supporting members/slabs, just like a Roof
Panel. The initial load decomposition thus produces line loads at the
end support points of the line ancillary - see “Stage 1” below. These may
then be further decomposed by the supporting members - for example
where support is provided by 2-way slabs ( must be in the same plane
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as the area ancillary to provide support) they will be decomposed in a 2-
way manner - see “Stage 1” below.

New Inactive Members
This new feature enables the definition of members which are required for
load decomposition but that you do not wish to be considered otherwise by
the analysis, nor to be designed, and is a companion feature to the new Line
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and Area Ancillaries feature described above. However it potentially has a
considerably wider use and appeal for many types of structure, for example in
defining staircases as shown in the second image below. For more information
see the new Help topic Inactive members (page 482).
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• As shown in the picture above, the option to set members inactive - by
unchecking the member properties “Active” checkbox - is now extended to
the Beam, Purlin (Track) and Rail (Stud) characteristics (formerly limited to
Brace and Analysis elements). Furthermore, all loads applied to inactive
members are now decomposed to the rest of the structure.

• Load decomposition - during the pre-analysis load decomposition
stage, the inactive members receive decomposed loads as normal
(which could be from two-way as well as one-way spanning slabs etc).
The resulting end reactions are then calculated and applied during this
stage to supporting primary members. Only these resulting loads are
then carried forward into the subsequent global analyses.

• Review View > Show/Alter State - a new “Active” Attribute is also
added to the Review View > Show/Alter State options, enabling rapid
graphical review and editing of the Active status of members (see
picture below)
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• Staircases - A clear general use-case is for staircases and members (that
the engineer does not wish to be designed or add additional stiffness to
the structure) supporting the landings and top/bottom of staircase Area
Ancillaries, as illustrated above right. As shown, the inactive members
transfer the area load of the staircase to the supporting primary members/
supports, but will not add any additional stiffness to the analysis model.

• There can be many other use-case scenarios for industrial structures
and line/ area ancillaries e.g. the engineer may be required to allow for
equipment and associated access arrangements that will be supplied by
others during fit out of a plant.

• Note another use-case for staircases, could be an area ancillary stair
spanning onto a slab edge. This is currently beyond scope, however an
inactive member can be added along the slab edge to provide the
required load path (requires slab to be meshed in 3D). Note that, while
this ensures the load is applied, it will introduce some approximation as
the ancillary line load (see “Stage 1” above) becomes two point loads at
the ends of the inactive member.

• Other potential use-cases are:

• Cladding Members - secondary/ tertiary members such as Purlins
(Studs) and Rails (Joists) supporting cladding are typically modeled
primarily to decompose wind wall and roof loads and to provide design
restraints to main structural members. They are commonly cold rolled/
formed and so are not designed within the program.

• However, they may develop internal forces - such as axial loads -
and/ or cause additional forces in the main structural members that
are neither expected nor desired by the engineer. Furthermore,
their results can clutter the Results View Analysis result diagrams,
obscuring those of the main structural members in which the
engineer is principally interested.

• Both these problems can now be avoided by setting such members
to be inactive, as illustrated below - load applied to the inactive
members is applied as required to the main structure (during the
pre-analysis load decomposition stage), but a) they are not included
in the analysis model and so do not develop any internal forces and
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b) hence there are no analysis results for them to clutter the Results
View diagrams or output.

• Grouped Design - Inactive members could be used to speed up the
Design process where group design is enabled, by limiting the number
of active members in a group.

• So for example for regular floor arrangements, where all the beams
in the group have very similar forces, only one beam could be set as
active and designed rather than every beam in the group (which
could run into 10’s or more) thus improving performance. For this
scenario note that:
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• Only secondary beams can be inactive - primary beams must be
active to provide support to secondary members in the analysis
model.

• The user is responsible for choosing critical beam(s) (an initial
design run could establish this then all other beams inactivated
for subsequent design runs).

• Wind Wall & Roof Panel Supports - where previously the engineer
may have used inactive Analysis elements to assist with the support of
Wind Wall and or Roof Panels - for example for overhangs or at the
base of vertically spanning walls - inactive beams can be used.

• All loads decomposed to such members will now be applied to the
structure/ supports where previously they would not (errors in the
Load Summary check would highlight this issue to the engineer).

New Lateral Force Resisting System Wall Type - Shear Only Walls
A new type of Wall is available in this release for modeling for example a
lateral system of infill masonry panels. Typically engineers wish to model these
with only in-plane lateral stiffness of a defined value, and zero vertical and out
of plane stiffness. The new wall object automatically models this idealized
behavior with a sophisticated underlying analysis model involving axial spring
and link elements (new and enhanced in this release). The new wall type can
be used in models with both rigid and semi-rigid diaphragms. For more
information see the new Help Topic on this feature How shear only walls are
represented in solver models (page 757).

NOTE Shear Only walls were originally included in the first 2020 release but due to
the issue described in Product Bulletin PBTSD-2005-2 they were removed in
the 2020 SP2 release (version 20.0.2.33 May 2020). Full details about them are
therefore included in these release notes.

• Shear Only Walls are added via a new button command on the Model
Ribbon in the “Walls & Loading Objects” group as shown below. A single
wall object of the full building height can be placed within a bay and will
automatically be divided into panels for each level.

• The requirements for Shear Only walls are that they must be; within a
single bay (i.e. do not overlap one or more columns); strictly
rectangular; vertical and surrounded by columns and beams (other
than at the bottom edge).

• For existing walls, the Wall Type can also be reviewed and edited via the
Properties Window as shown in the picture below.
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• The material and thickness of the wall can be set, but note that these
control only the wall self weight, not its stiffness. The latter is specified
directly by the engineer.

• Results - Shear Only wall results are available both graphically and
numerically and give the total value of shear in each panel of the wall and
the reaction at the wall base. These can be reviewed:

• In the Results View via 1D Results > Shear Wall Forces (in 1D Results
group) for the panel forces and the base reactions via Reactions (Fy
controlled by the [2D] reactions toggle button).

• in Analyze > Tabular Data > Shear Only Walls and in Reports via the
associated Report item.
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• The expected vertical (Fz) push-pull overturning reactions can also be
viewed using the 1D reactions option.
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• The new shear only wall object is included in the Integrator and CXL file.

• For Tekla Structural Designer → Revit, a new TSDI_Type object tag
“SHEAR_ONLY” is included in the CXL file and written to the Revit model for
all exported Shear Only wall objects as shown in the picture below.

• Note that the Revit Name for the wall Material Grade must be manually
selected on import into Revit (this selection can then be saved in the
Mapping file).
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Enhanced Grasshopper Live Link - Design Results and Reporting
The Grasshopper - Tekla Structural Designer Live Link (GH-TSD) is enhanced
with new Design and Reporting components to extend the Optioneering &
Optimization workflows. For more information about the Grasshopper link see
the TUA article Grasshopper -Tekla Structural Designer Live Link (GH-TSD)

• To investigate different design configurations using the new components
you can now:

• Generate several configurations of a structure, in different materials or
with different geometry

• Run design for each configuration

• Determine if that configuration is a passing design (and the URs for
each beam plus for example average/max/min UR)

• Measure the ‘cost’ of that configuration using material quantities

• Calculate the efficiency of each design configuration
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• Find the best design configuration using automation

• Design - the following three new design components are added and are
available from the Design group of the ribbon as shown below:

• Run design - allows the use to run design for the model (provided by
the model component) with the following options; Subject - Steel,
Concrete or All; Type - Gravity or Static (no RSA)

• Member & Wall Design Results:

• Member Design Results - reports Design Status & Utilization Ratio
for a member or list of members. Results are available by whole
member and for all spans/stacks within that member (see picture
below illustrating this).

• Wall Design Results - reports the same data for Walls - again per
whole wall or per wall panel.
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• Reporting - two new components are added to report steel and concrete
material quantities in a new “Review” ribbon Group. These can report in
Grasshopper quantities from the Tekla Structural Designer materials list
such as; number of objects, mass, surface area, volume and rebar mass
(concrete models).
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Dynamic Analysis - Wind Tunnel Data Report Generation
Specialist wind tunnel consultants are sometimes employed to determine
structure specific wind loading on a project, typically this applies to tall or
unusual structures. Following customer requests a new feature set has been
added to enable easy and rapid generation of Dynamic Analysis data required
by the wind tunnel testing consultant. Note that the Modal analysis capability
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and output principally required for such data has always existed in Structural
Designer - this feature adds a new simple workflow and automated report
tables to produce the commonly required data. A new dedicated “Wind Tunnel
Data” Ribbon Tab - shown in the picture below - walks the engineer step-by-
step through the required input and generated tabular output which can then
be conveniently exported straight to Excel for sharing with third parties.

Tall Building Features - note that this feature adds to and will likely be used
in conjunction with a number of more recently added features targeted
particularly at the design of tall buildings. These are:

• Design for high strength concrete grades (Eurocode) - for more on this see
the Tekla Structural Designer 2019i Release Notes

• Stresses in 2D elements (page 679)

• 2D In-Plane Stress Contouring useful for assessing extent of cracking of
Concrete Walls (page 54)

• Concrete member cracked or uncracked status (page 1286)

• Modify assumed cracked settings (page 875)

• Diaphragm loads and diaphragm load tables (page 546)

The key aspects of this new feature are:

• The new dedicated ribbon tab is opened by selecting the “Wind Tunnel”
button in the Data group of the Analyze Ribbon as shown above. The tab
contains all the commands required to define the required Mass
combination, configure the analysis settings, run the analysis and review
and export the report data.
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• The basic process to produce a Report is as follows:

• Select the “Add” button to create a new Load Combinations of the
“Modal Mass” class which is required for Modal Analysis - add the
required load cases with their appropriate factors to this.

• Also review the “Applied mass” tab; while all directions are active by
default, you can uncheck the “Dir Z” option so only lateral modes are
included.

• Should it be required, you can the select the “Edit” button to go
directly to the Modal Mass combination(s)

• Select “Settings” to directly access the Analysis settings for 1st Order
Modal to review/ edit these.

• The default settings are likely to be adequate for many
circumstances, but the experienced engineer may prefer to enable
the Lumped Mass Model and Simple Mass reporting options.

• Select “Run Modal Analysis” - on completion the automated report
tables will be populated and can be reviewed.

• The report tables are listed in the View type group of the ribbon and
are:

• Total Masses by Level - a completely new output table
summarizing the dynamic mass at each level*; the Dynamic Mass
Total**, the Center of Mass (COM) coordinates and the Mass
Moment of inertia (often termed the Rotational Inertia).

• *Note that only levels with the “Floor” checkbox enabled in
Construction Levels are included.

• **The existing tables giving the mass distribution to all nodes
(Total and Active) are also still available.

• Modal Frequencies - the same table of frequencies that has always
been available after Modal Analysis

• Mode Shape by Level - a completely new output table giving a
single mode shape deflection value at the COM for each floor - select
the mode shape to view results for in the drop list in the “Result
Mode” ribbon group to the right.

• Since mode shape deflection values are typically very small* -
especially for very large structures - for improved precision the
engineer may like to set the Exponential format threshold for
values lower than to 1E-3 (Home > Model Settings > Units).

• *For why this is see the TUA Article What is the magnitude of
the deflections from Modal Analysis?

• Finally, the entire report - or the currently selected table - can be
exported directly to Excel via the Export current/ full report buttons in
the Export group of the ribbon.
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• Reminder - when the wind consultants complete their work they will
typically pass back wind forces as a series of level loads. The recently
added Diaphragm Loads option can be used to apply these to the model.
Using this, the level loads can easily be imported as described in
Diaphragm loads and diaphragm load tables.
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Distributed Wall Reactions
In line with customer requests, distributed line (force/ unit length) reactions
are now automatically calculated and reported for all wall types; Meshed, Mid-
pier, Bearing and General. A new filter button for these is added to the
Reactions group of the Results Ribbon as shown below. The distributed
reaction is generally more directly useful in additional calculations and checks
for foundation design.

Key points of this feature are:

• Distributed wall reactions are:

• The continuous line reaction along the length of the analytical chord at
the wall bottom

• Available for all structural wall types and all Head Codes

• Applicable to the vertical (Fz) component of the discrete analytical wall
reactions of meshed walls

• Available for all result types except Envelopes and Seismic RSA
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• Reported only for the horizontal bottom levels (analytically) of self-
supported walls

• Derived from elastic theory formulae used to calculate stress/unit
length based on the total moment and vertical force acting at the
centroid of the reaction line.

• (this assumes that the wall and foundation material are sufficiently
homogeneous and isotropic to allow for load distribution according
to the Saint-Venant's Principle)

• Graphical Results - Distributed wall reactions can be viewed in the Results
View as follows:

• The new Distributed wall reactions filter button is active only when Fz is
selected in the reaction type drop-down list (Fz, Fxyz, Total).

• When active, the discrete vertical reactions of the wall (1D and 2D)
supports are hidden. Note also that the distributed reaction is not
displayed for walls in a core when Core reactions are active.

• The cursor tooltip gives the reaction length and the force/length values
at each extreme.

• The graphical representation of the distributed reaction is typically the
same color as other reactions. An orange color indicates a high nodal
force concentration - more information on this is then listed in the
tooltip.

• Drawings - Distributed wall reactions can be included in the Foundation
Reactions drawing as follows:

• A new Layer Settings option is added in Draw > Settings > Layer
Configuration for the Foundation Reactions drawing - “Foundation
Reaction values” in the set of controls for Walls (on by default).

• A new summary table of Distributed wall reactions can also be included,
the borders, text and notes for which are controlled by the existing
“Notes” and “Tables” Layer Configuration options.

• Note the text color and size of the reaction values in the drawing is
controlled by the “Foundation Reaction Values” Layer Styles item for
the Foundation Reactions drawing.

• New options are also added to Draw > Settings > Options > Planar
Drawings > Foundation Reactions > Walls to control their inclusion as
shown below.
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• A summary table of reaction values can be included (see picture
below).

• Vertical reaction values can be shown on each wall, the options for
these being:

• Distributed (maximum): Maximum value UDL,

• Distributed (Average): Average value UDL,

• Distributed (Extremes): Calculated linear UDL/VDL extreme
values,

• Total - Integrated total

• Note that the new Layer Configuration options will be active by default
in new models - for existing files you can load these default settings by
selecting the “Load…” button in the Drawing Settings dialog.
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Comprehensively Enhanced Timber/ Wood design using Tekla Tedds
In an exciting development, integration with Tekla Tedds for Timber member
design has been thoroughly enhanced, enabling seamless and efficient Timber
design to both the US Head Code and Eurocode. The new workflow fully
supports multiple analysis and design loops and Design Groups (enabled by
the default). The design process for timber members now works in the same
manner and matches the power and capability of that for Precast concrete
members using Tekla Tedds introduced in the 2020 first release (for more on
this see the Precast member design handbook (page 1527) ). Note that use of
this feature requires an installation of and license for Tekla Tedds 2020. For
more details, see the Timber member design handbook (page 1564).
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Timber Design Workflow - the essentials of design of Timber members (and
Precast concrete) using Tekla Tedds can be thought of as being very similar to
Interactive concrete member design (page 1310) within the program:

• Just like the concrete beam/ column/ wall interactive design dialog, the
Tedds Timber member design calculation interface lists the design forces
and settings for a selected member/ group, populated from the model and
analysis, the design pass/fail status and individual check results and
utilization ratios. You can make changes in the interface - such as to section
size and/ or grade - and immediately see the design results for these. All
the data you input and changes you make are updated to and stored in the
model. You can then re-analyse and run a check on all designed members
to ensure the design results are up to date. And you can perform design
and analysis loops as necessary so that all members are passing and to
cater for any other changes to the model or loading.

• Design Groups work in a similar manner also - these are automatically
created for Timber members and listed in the Project Workspace Groups
Tree, and can be reviewed and customized as necessary. Group design is
enabled by default ( in Design Settings > Design Groups > Timber Beams/
Columns/ Braces) and can be run both via the model and from the Groups
Tree

Key aspects of the new Tedds integrated design process and workflow are:

• Tedds Settings - First ensure that you set the Tedds Locale and Default
calculation settings appropriate to the Head Code of your Tekla Structural
Designer model - e.g. for a US Head Code model using US Customary units
you would set the Locale = US and and Tedds Options > Regional Settings
as shown below.

• Design is supported for the US Head Code and Eurocode for the
following National Annexes (NA); UK, Ireland, Norway, Finland, Sweden.
Note that for the Singapore and Malaysia NA’s, the Tedds calculation
adopts the base Eurocode Recommended values.
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• New Settings and Controls - as part of the enhancement, Design Code
options have been expanded and new settings added to Load
Combinations and Design settings as follows:

• New Resistance codes for NDS ASD and LRFD for code years 2005, 2012,
2015 and 2018 are added for the US Head Code. These can be set in
both Home > Settings > Design Codes for new models and Home >
Model Settings > Design Codes for an open model.
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• A new “Timber design” parameter set is added to Load Combinations
for the Load duration/ Time effect factor for the US code and Duration
of Loading for the Eurocode as shown below. The factor/ duration is
automatically assigned to combinations based on their constituent
loadcases and can then be reviewed/ set by the engineer as they
require.
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• These new settings enable automatic selection of the appropriate
design code and year and setting of the load duration factor in the
Tedds calculation - the critical factor/ duration associated with member
design loads being populated to Tedds.

• Timber design defaults - a new set of Timber Design settings is added
for those that typically apply to an entire structure such as the Service
condition/ class and temperature range - these are then populated to
the Tedds calculation for all members.
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• Design Process - after Analysis, Design or Check using Tekla Tedds can be
initiated from both the Project Workspace and any graphical view of the
model:

• You can right-click over any individual member in any view, and also
make a graphical selection, then right-click to open the context menu
listing the Tekla Tedds design options as shown below. You can then
select Design or Check of the Member, Group or Selection as
appropriate (see below for more on this). Design/ check of a Selection
can also be used for example to design all members of a truss - which
can be selected with one click - in one operation.
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• You can also right-click over any individual member or Group listed in
the Project Workspace to access the Tekla Tedds design options, in both
the Structure Tree (including Sub Structures) and Groups Tree as
shown below:
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• The Tekla Tedds options are:

• Design using Tekla Tedds - opens the Tekla Tedds Timber member
design calculation interface and populates it with member and analysis
data from the model for the selected member/ group.

• Check using Tekla Tedds - this option is available once a Design has
been run for the member/ group, and runs a check of the selected
member/ group without displaying the Tedds calculation interface and
updates the model with the results of this.

• Export to Tekla Tedds - opens Tekla Tedds and creates a new Project
containing the design calculation document(s) for the selected
member(s).

• Clear Tekla Tedds Data - clears the stored Tedds data if you wish to
start again.

• For the Design option, the process is as follows:

• The active view automatically zooms/ pans to the location of the
member being currently designed and highlights it with an arrow - or
the first span/stack of continuous beams/ columns - so that this is clear,
then opens and populates the Tedds calculation interface.

• For design of a selection and continuous members, after the design
of the first member (or span/ stack) is complete, the view and
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highlight arrow automatically shift to indicate the next member/
span/ stack considered, and so on, so this is always clear.

• Design forces - the Tedds calculation is automatically populated with
results appropriate to the design method (set in Design Options >
Resistance Code) so, for example, for US Head Code models only the
results of LRFD combinations are used when LRFD is set as the
Resistance Code option.

• All critical load combinations are considered in one Tedds
calculation by populating where necessary separate conditions of
tension + bending and compression + bending as separate Design
Sections. The engineer can then select, review and design for each of
these conditions, as shown below.

• The Tedds calculation is also populated with the design settings defined
in the model and mentioned above, such as Load duration factor and
Service condition/ class. Other design settings - such as effective length
factors - will be set to default values. All the settings can then be
reviewed/ edited as the engineer requires to obtain an adequate
passing design.
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• Following a completed design, the model is automatically updated with
all the input made in the Tedds calculation interface for each member
designed, including any changes made to timber sections and/ or
grades.

• Design Status & Review - the design status and governing utilization ratio
(UR) are updated and stored in the model and can be reviewed in exactly
the same manner as for steel and concrete design within Tekla Structural
Designer; via the Tooltip; in the Review View > Design Status and Tabular
Data > Design Summary.

• The Tedds calculation for a specific member can even be opened
directly from the Tabular Data > Design Summary table by clicking on
the Results… button at the right hand end of a row.

• Group Design - with Design Groups enabled (the default), the process is as
follows for each option of Design > Member and Design > Group:

• Design > Member; the Tedds calculation is populated with the design
forces of the selected member. When the calculation dialog is
finished, all the design settings made - such as section size/ grade - are
copied to all members of the group which are then checked for their
individual design forces.

• With Design Groups disabled (Design Settings > Design Groups),
Design > Member designs only the individual selected member for
its specific design forces.

• Design > Group; the Tedds calculation is populated with the worst-case
design forces of the group as a whole. When the calculation dialog is
finished, the further process is the same as for Design > Member.

• Checking & Re-Checking - following any changes to the model (such as
changes of section/ grade during design), all designed members can be
easily checked in one operation by re-analysing then running the “Check in
Tedds” command on the Design Ribbon. This can also be done by right-
clicking at the top of the Groups Tree in the Project Workspace and
selecting Check using Tekla Tedds > Model, as shown in the picture below
(Design for the entire model is also available here).
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• Reporting - For reporting of the design, the engineer selects the “Export to
Tekla Tedds” option which will open the Tedds application and create a
Tedds Project containing calculation documents for the designed
member(s).

• This option is available for;

• An individual Member in the model (Design Groups disabled).

• A single Group (via right-click over a Group in the Groups Window or
a member of the model).

• All Beam or Column Groups together (via right-click over the Timber
Beam/ Column/ Brace Parent Group).

• The entire model via right-click over the “Design” Parent Group for
Timber members in the Groups Window.

• A graphical Selection of part of or the entire model.

• With Design Groups enabled, the Tedds Project will contain one
calculation document* (.ted file) for each group included in the
selection.

• When Design Groups are disabled, the model member context menu
export option will change to “Member” and will create a Project and
calculation document for the selected member*.

• *In the case of continuous columns and beams there will be a
calculation document for each stack/span of the member.
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• Note also that there is a new (Global) setting for the default output level
for the Tedds timber calculations in Home > Settings > Report > Tedds
Reports.

• By ensuring this is set correctly beforehand you can avoid having to
manually set the level in each Tedds timber calculation as it is run.
The setting applies to all Tedds linked calculations (precast concrete
and timber).

Steel Design - New Patterning of Eccentricity Moments
Since the very first release of Tekla Structural Designer, additional “eccentricity
moments” - resulting from the eccentricity of supported beam reactions - have
automatically been calculated and considered in steel column design. For
more on this feature see the Help topic Steel column connection eccentricity
moments (page 1256). In this release the feature is enhanced with the option to
consider patterning of eccentricity moments, resulting from different
permutations of loading of the supported beams producing unbalanced load
and hence potentially increased moments. Five patterns are considered as
illustrated in the picture below, in which the ✔ indicates full loading of the
beam connected to that face of the column and the ✕ reduced load. The
analysis of patterned eccentricity moments applies to all Head Codes, while
they are considered by design in the Eurocode and US Head Codes.
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• The feature is fully automatic and requires no additional modeling or
loading. To activate it, as shown in the pictures below, simply:

• Check on the new “Use patterning of eccentricity moments…” option ( in
Home > Settings > Loading > General for Global Settings and new
models, and the same location in Home > Model Settings for an existing
open model)

• Check on the “Pattern Eccentricity Moments” for the Imposed (Live)
Load case(s) in the Loading dialog (no other load types can be
patterned)

• (Note that the default for both settings is Off)
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• Key aspects of this new feature are:

• The inferred ecc. moment profile assumes the same pattern at the top
and bottom of a stack e.g. it is not possible to have P1 at the top and P4
at the bottom of a stack.

• Patterned ecc. moments are combined with ‘real’ moments in the same
way as in previous releases (which essentially considered only P0).

• Axial force; this is reduced (by patterns P1-4) at the current level while
that from floors above is from P0 (which is a conservative assumption)

• All design checks apart from ‘Shear’ can be affected by patterning

• Note that, in this and all previous releases, there is no rigorous
implementation of ‘Simple Construction’ in which load patterning is
explicitly ignored (per BS 5950 Clause 4.7.7)

• Eccentricity moments are determined by a post-analysis process which
applies to all Head Codes.

• The Load Analysis View is also enhanced to enable the viewing of
results for patterns to see how they affect the major and minor
moments, and axial force. The picture below shows the effect on the
major axis moment. A pattern number drop-down list is added
allowing the results of a specific pattern to be selected (the
eccentricity moments are denoted by a dashed line).
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• The eccentricity moments are considered by the steel column design
process for the Eurocode (all country NA’s) and US Head Codes.

• To keep the design details to a manageable level, results for every
pattern are not listed; the pattern which produces the governing
design forces is listed in the check combination and location tree
and details heading, as shown in the picture below.
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Minimum Design Forces & Rounding Increment
To aid efficiency and rationalization of design, comprehensive new settings are
added giving the engineer control and flexibility of Design forces; both those
considered by checks within the program and reported and exported. As
shown in the picture below, the new settings are added to the “Design Forces”
page of Design Settings. Using these the engineer can now control minimum
values considered and set optional rounding increments for both Brace and
Beam End Forces and Foundation reactions.
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• This feature applies to all Head Codes and note that it has no impact on
forces considered in member design.

• These settings impact the values considered/ reported in the following
checks and areas:

• Brace & Beam End Forces:

• Connection Resistance Checks for both Beams and Braces.

• Brace/ Member End Forces Report Items and Beam End Forces
Drawing.

• Forces populated to Connections (Beam to Beam, Beam to Column
and General) - both those designed by/ exported to Tekla
Connection Design (TCD) and exported to IDEA Statica.

• Foundation Reactions:

• Foundation Reaction Report Items and Drawing.
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• Forces populated to Connections (Base Plate and General) - both
those designed by/ exported to Tekla Connection Design (TCD) and
exported to IDEA Statica.

• Minimum Design Force - this replaces the force from analysis where it is
the greater - e.g. if for the beam connection resistance checks to consider a
minimum shear value of 75 kN, enter this value in the Beam End Forces >
Major Axis Shear Force box, and so on.

• When the Minimum value is used, a note to this effect is displayed in
the row for that check in the Tabulated Data Connection Resistance
check table and associated report item.

• Rounding Increment - separate rounding increment options are available
for Brace/Beam forces and Foundation Reactions for Force and Moment.

• When enabled, the force value from analysis is rounded up to the next
value of the increment considering the sign of the force - e.g. for a force
increment of 5.0 kN; a force of 10.438 kN will be rounded to 15.0 kN; a
force of -6.224 kN will be rounded to -10.0 kN...and so on.

• Note that the Moment increment applies to both major and minor axis
moments but not torsion (Mx) which is not rounded.

Upgrade to this version 194 Tekla Structural Designer service packs



Steel Design - Compound Section Design - Indian Head Code
Following customer requests, a number of steel compound sections can now
be designed to the Indian design code. Such sections can be user-defined
using the Compound section tool in Home > Materials > Sections > Manage
Sections.
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• The section shapes supported by the new design are:

• Rolled Channels back to back

• Rolled Channels toe to toe

• Doubled rolled I sections

• Doubled rolled I sections with plates

• The scope of design of these compound sections includes both beams and
columns and auto-design. For auto-design, the user can create their own
section Order Lists for compound sections once they have added these to
their database.

• In general, the scope of strength checks undertaken is the same as for
rolled sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• High Shear case with minor axis moment is beyond scope.

• Design of the lacing or battening system is beyond scope.

• Only parallel flange sections can be used.

Upgrade to this version 196 Tekla Structural Designer service packs



Concrete Design - Pile Punching Checks on Mat Foundations - Eurocode
and US Head Codes
The scope of mat foundation slab design is now expanded to including pile
punching checks for the Eurocode and US Head Codes.

• The process of creating, designing and reporting punching checks of piles is
essentially the same as that for columns:

• The punching check object can be created in both 2D and 3D views -
both by selecting individual piles and by drawing a selecting line/
window to create checks for multiple piles in a single operation. Just as
for columns, the check location and tension reinforcement surface are
automatically set.

• Pile punching check is independent of mat foundation design.

• All punching checks can be designed via the “Design Punching Shear”
button in the Punching Shear group of the Foundations tab of the
ribbon. Design details of individual checks can also be opened via the
context menu as shown in the picture below.
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• Key aspects of the check performed are:

• Punching shear resistance is assumed to be provided by the concrete
alone - there is no option to add specific punching shear reinforcement
in the form of studs and rails (as there is for column punching checks,
including those supported by mats).

• The check considers 3D Building Analysis, FE Chase-Down and Grillage
Chase-Down results for all active gravity, wind, seismic and RSA load
combinations.

• The check considers only a single pile - not a pair - and only vertical
shear not moment (as piles are modeled a pinned spring supports
without moment fixity).

• Just as for punching checks of columns supported by piled mats, all
loading and reactions (from ground bearing springs) within the
punching perimeter are considered.

• There is an additional new pile-specific Design setting to use the pile
capacity in the punching check in Design Settings > Concrete > Cast-in-
place > Foundations > Mat Foundations > Piles as shown below (default
Off).

Release notes: Tekla Structural Designer 2020 SP3
This release will upgrade your Tekla Structural Designer installation to version
number 20.0.3.28 and should be installed to ensure optimum function of the
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program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than release 2020 SP2 (version
20.0.2.33 released May 2020), you can find details of requirements,
enhancements and fixes for all previous releases in Tekla User Assistance
(TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

Licensing
• No new license is required for this version.

• Tekla Structural License Service - the latest Service Pack for this was
released in July 2020. This is available in Tekla Downloads and should be
installed on all clients for optimum functionality.

• For more information see the Release Notes page for the Tekla License
Service update July 2020 (v3.1.3.4).

• License Server Version - for Server licensing, the latest version of the
Tekla Structural License Service 3.1.xxxx (incorporating Sentinel RMS 9.5)
must be installed on your license server to be compatible with this release.
Licensing will not function correctly if this is not the case. For more on this
requirement please see the TUA article Tekla Analysis & Design 2020
Releases & Sentinel RMS Server Licensing - the License Server must be
updated.

Installation

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) or later to be installed.

• Integration

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate Tekla Structural Designer 2020 SP3 with Tekla Portal Frame
Designer and/or Tekla Connection Designer, you must use Tekla Portal
Frame Designer and/or Tekla Connection Designer release 20 or later
(note that these require activation of 2020 release PAK’s for these
products). For optimum function we recommend you install Service
Pack 1 for these products, which is available from the same date as this
release. Installations for these can be obtained from Tekla Download
Service.

• Autodesk Revit© - the Tekla Structural Designer Integrator for
Autodesk Revit© 2021 (version 7.0) was released on 1st July 2020 and is
available in Tekla Downloads. If you are now using Autodesk Revit©
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2021, you can install this to perform BIM integration with Tekla
Structural Designer.

• All fixes and enhancements included in this release are also included
in updates for the Integrators specific to the following currently
supported Revit© versions; 2020 (Integrator version 6.01); 2019
(Integrator version 5.02); 2018 (Integrator version 4.03). For more
information see the Tekla Structural Designer Integrator July 2020
updates Release Notes. If you are performing BIM integration with
any of these Revit© versions, we recommend you update to the
latest version of the associated Integrator.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - Some Databases are updated in this release. Hence for an
existing installation a message informing you that new databases are
available will be displayed in the Process Window when this release is run,
as shown below.

• Please ensure you upgrade your local databases as follows;

• Open “Materials” from the Home Ribbon, select the “Sections” page
in the list of options, click the “Upgrade” button if it is displayed, then
click this button again in the subsequent “Upgrade Database” dialog.
Repeat this process for all the other databases (Material,
Reinforcement, Decking...etc ) to ensure all your databases are up to
date.

General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability. An example of such
an issue is listed directly below here:

• [TSD-6927] - Databases - Decking and Connectors - an exception would
occur on closing the Materials dialog after adding user defined Decking
and/ or Connector data for certain more recently added Countries, such
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as Finland. This issue is fixed in this release and such user defined data
can now be added for the affected countries.

• Note that the fix requires that you upgrade your local Decking and
Connector databases after installing this release - see the
Installation section above for more directions.

• [TSD-6916] - Ghost Unselected - use of the powerful new Ghost Unselected
toggle (at bottom right of the view) is extended to a number of additional
operations in this release. For more about this new feature see also
Release notes: Tekla Structural Designer 2020 SP2 (page 208).

• As illustrated below, Ghost Unselected can now be used during the
following operations; Copy, Move, Mirror and also Edit geometry - i.e.
for example when graphically adjusting the node positions of a selected
member, or of a slab panel or patch etc.
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• [TSD-7364] - Licensing - in some circumstances, when a valid license could
not be detected, it would not be possible to perform a manual save which
could result in a loss of work. Now in this circumstance the user will be able
to perform one manual save, removing the potential for lost work while re-
establishing the license.

• Note that if you are using an LT license, as before, when the limits of the
license are exceeded, saving of the model will not be allowed. For more
about this topic please see the article What is Tekla Structural Designer
LT?

• [TSD-6900] - Cores - walls with a sloping top and/or bottom edge can no
longer be selected for inclusion in cores, as they are beyond the scope of
the current core forces calculations. While such walls could be added to
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cores in previous releases, this would cause a program error when trying to
view core results.

• For existing models with this circumstance, the problem wall(s) will be
removed from the core(s) when opened in this release. A message to
this effect listing the removed wall(s) will be issued in the Process
window as shown below.

• [TSD-7037] - Delete - Slabs - when selecting multiple slab items for deletion,
due to a recent change in release 2020, the parent slab item would also be
selected as default which could lead to the inadvertent deletion of all items
of a slab. This is changed in this release so that only the selected slab items
are populated in the list of entities to be deleted.

Integration
• [TSD-6910] - Structural BIM Integration - Autodesk Revit© - the Tekla

Structural Designer Integrator for Autodesk Revit© 2021 (version 7.0) was
released on 1st July 2020 and is available in Tekla Downloads. If you are
now using Autodesk Revit© 2021, you can install this to perform BIM
integration with Tekla Structural Designer.

• All fixes and enhancements included in this release are also included in
updates for the Integrators specific to the following currently supported
Revit© versions; 2020 (Integrator version 6.01); 2019 (Integrator version
5.02); 2018 (Integrator version 4.03). For more information about this
see the Tekla Structural Designer Integrator July 2020 updates Release
Notes. If you are performing BIM integration with any of these Revit©

versions, we recommend you update to the latest version of the
associated Integrator.

Loading
• [TSD-4790] - Snow Loading - US Head Code - in some circumstances, for

Step and Parapet type drift loads applied using the Snow Wizard > Local
Drift Snow command, the automatically calculated drift load pd and drift
extent w could be incorrect. The issue affected all years of the ASCE7 Snow
Loading Action code available in Design Codes.

• The error would occur when the drift height was > the step/parapet
height and had two effects:

• The maximum drift load pd was double-counted
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• The drift width w would be incorrect and generally too low due to
the use of the total parapet / step height for hc, rather than the clear
height above balanced snow load.

• We note that the double-counting of pd would generally counteract
the reduction in w, producing too much rather than too little total
drift load.

• The engineer could work around the issue by enabling the “Override
load value” option in the Drift Load properties and entering their own
correct calculated values of drift load and extent. The issue is fixed in
this release. Note that for existing files the drift values are automatically
re-calculated and corrected when opened in this release.

• As shown in the picture below, as part of the fix the Drift Load
properties are adjusted; the (user defined) Step/ Parapet height is now
labelled “hstep”/”hpara” (formerly incorrectly labelled “hc”) and the
calculated value of hc is now reported beneath this.

• [TSD-6697] - Swedish NA (EKS11) - Eurocode based loading has been
updated to reflect the changes brought by the latest version of the
mandatory provisions and general recommendations on the application of
European design standards for Sweden EKS 11. The new design in TSD
replaces the design to the previous version, which can now be considered
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withdrawn from the program. The update affects both combinations from
the Load Combination Generator and loads from the Wind Wizard:

• Load Combinations Generator - variable actions are no longer
considered in combinations of actions based on equation 6.10a per EKS
11.

• Wind Wizard Loads:

• Wind peak velocity - calculation of this is changed to include the
peak factor kp per EKS 11.

• The peak factor kp is now displayed in the Wind Data Report,
appearing in the section titled 'Site Details' between the existing
items 'Default Height for Internal Pressure, z_i' and 'Average height
of roof tops of upwind buildings, h_ave'.

Design
US Head Code

• [TSD-7092] - Concrete Design - Beams - the calculation of the minimum
beam depth hmin is corrected to follow the provisions of Table 9.5(a) of ACI
318-2008 and 2011 and Section 9.3.1 of ACI 318-2014. Previously, for all
grades of reinforcement, the calculation incorrectly used a factor of fy /
fy,mod . This is corrected in this release as follows:

• For fy = 60,000 psi; hmin = ht

• For fy other than 60,000 psi; hmin = ht *fy,mod

• Where fy,mod = (0.4 + fy / 100,000)

Reports and Drawings
• Reports:

• [TSD-6906] - Concrete Design - Slabs - a concise new report content
item for Slab/Mat Design Summary is now available under Model report
> Concrete > Slab/Mat Design/. As shown in the picture below, this
replicates in the report the Review Data > Design Summary table for
Slabs/Mats which was added in the previous 2020 SP2 release. For
more on this new feature see Release notes: Tekla Structural Designer
2020 SP2 (page 213).
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• [TSD-7160] - Analysis Diagrams - 2D - when 2D contour diagrams - e.g.
such as Mdx Top - were included in reports, the title displayed under
the diagram could be incorrect. The actual effect being displayed would
however be correctly shown in the top left of the diagram. This is now
corrected.

• [TSD-3898] - Combinations - the report tables of load combinations
listing the constituent load cases and their factors now include the
Equivalent Horizontal Forces (EHF) - also termed Notional Loads (NL)
and Notional Horizontal Loads (NHL) in the US and BS codes
respectively - case(s) and factors where appropriate, as shown in the
picture below.

• Drawings

• [TSD-6945] - All Drawings - Units - in some circumstances, DXF drawings
produced by the program would appear to use Imperial units despite
the model being set to Metric units. This is now corrected.

• [TSD-7106] - Foundation Reactions - the reactions for supports which
referenced a frame, rather than the foundation level, would be
incorrectly excluded from the drawing. This is now corrected.
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Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

Release notes: Tekla Structural Designer 2020 SP2
This release will upgrade your Tekla Structural Designer installation to version
number 20.0.2.33 and should be installed to ensure optimum function of the
program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than release 2020 SP1 (version
20.0.1.54), you can find details of requirements, enhancements and fixes for
all previous releases in Tekla User Assistance (TUA) and Tekla Downloads via
the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

Licensing & Installation
Licensing:

• No new license is required for this version.

• License Server Version - for Server licensing, version 3.00.0001 or later of
the Tekla Structural License Service (incorporating Sentinel RMS 9.5) must
be installed on your license server to be compatible with this release.
Server Licensing will not function correctly if this is not the case. The latest
version of the License Service can be obtained from Tekla Downloads.

• For more on this requirement please see the TUA article Tekla Analysis
& Design 2020 Releases & Sentinel RMS Server Licensing - the License
Server must be updated.

Installation:

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) to be installed.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - For an existing installation, if your databases are out of date, a
message informing you that new databases are available will be displayed
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in the Process Window as shown below when Tekla Structural Designer is
first opened.

• Please ensure you upgrade your local databases as follows;

• Open “Materials” from the Home Ribbon, select the “Sections” page
in the list of options, click the “Upgrade” button, then click this
button again in the subsequent “Upgrade Database” dialog. Repeat
this process for all the other databases (Material,
Reinforcement...etc ) to ensure all your databases are up to date.

Issues with Associated Bulletins
• [TSD-7014] - Concrete Column Design - US Head Code - this issue relates to

the design of concrete columns to the 2014 edition of ACI 318 (years 2008
and 2011 are not affected). The issue affects the slenderness limit of
section 6.2.5 for braced columns and the calculation of the uniform
moment factor Cm for columns classified as slender, and could result in an
unconservative design in some circumstances. For more information
please see Product Bulletin Product Bulletin PBTSD-2005-1.

• The issue is fixed in this release.

• [TSD-7035] - Modeling - Shear Only Walls - this issue relates to the new
feature introduced in TSD 2020 for ‘Shear only walls’. The current modeling
formulation, as the name suggests, is restricted to shear resistance and
shear stiffness behaviour only. This has the limitation of failing to report
the vertical ‘push-pull’ effects at the ends of the panel that would be
expected to be present to resist overturning. For more information please
see Product Bulletin PBTSD-2005-2.

• Due to the potential for mis-use and mis-understanding, the option to
use shear only walls is accordingly removed in this release.

• For existing models containing shear only walls a validation error will
now be issued and the analysis and design conditions are set to out of
date. In order to run analysis or design, any shear only walls must then
be removed, changed to a valid wall type or replaced with a bracing
system as suggested in the Product Bulletin.
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General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability.

• [TSD-5522] - Enhanced Find and Select - the Find feature and working with
Selections has been significantly enhanced as detailed below:

• The Find command is now added to the Quick Access Toolbar by default
as shown in the picture above.

• Other dialogs and View windows are now accessible while the Find
dialog is open. Thus, for example, the view can now be manipulated by
panning, rotating etc and/ or object references checked in various
locations all during an active Find operation.

• The following new options are added

• "Ghost unselected" (enabled by default) - when enabled, everything
other than the selected item is now switched to the Ghosted view
(for more on this feature see the video Ghosted Structure view) ,
making the selected item extremely clear and easy to locate.

• When the Find dialog is closed, the selected item remains
selected and the view reverts to normal (un-ghosted)

• “Cutting plane” (not enabled by default) - when enabled, an
automatic cutting plane perpendicular to the current view direction
is activated, rendering the part of the model containing the selected
object even more clear.

• The cutting plane can then be changed simply by altering the
view direction then disabling and reenabling the cutting plane
option.

• The object location arrow, that previously displayed to highlight the
selected item only in some cases, now applies to all object types.

• When the Find command is run again, the Find dialog now re-opens
with the last found object listed and selected.
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• Ghost Unselected Toggle - in addition to the above, the Ghosting of
unselected objects is extended to all views - of all or part of the
structure - via the new “S” toggle button at the bottom right of the view
window.

• As illustrated in the pictures below, when toggled On (at right), all
unselected objects are shown as ghosted and only selected objects
have solid shading but without the distinct opaque selection colours.
The selection can be altered as the engineer requires in this view,
making editing and working with selections even easier.

• This can prove especially useful in the Review View where
otherwise the selection colours would obscure other colour-
coding such as pass/fail status and utilization ratio etc. This
facilitates reviewing the status of parts of the structure, such as
member design groups, especially in larger models.

• The new control can be used in a view of part of the structure -
for example a floor or sub structure view - to further focus the
desired selection operation. 2D views - such as of Levels and
Frames - must first be toggled to 3D ‘mode’ to enable this option.

• When toggled Off (on the left) behaviour is as previously; all objects
have regular shading, with selected objects assigned the distinct
opaque selection colours.
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• [TSD-6192] - Review View - Copy Properties - following customer feedback,
the default attribute for the Copy Properties Show/Alter State attribute is
changed to “All properties” where formerly it was “Deflection Limits”.

Integration
• [TSD-6193] - Steel Connections - IDEA Statica - export of steel connections

to IDEA StatiCa has now been enabled for models set to the British
Standards (BS) Head Code. Note the following:

• Connection design in IDEA StatiCa can only be performed to Eurocode
EC3 and not BS 5950.

• The elastic modulus in such cases is exported as 205,000 MPa which is
the BS value rather than the EC3 value of 210,000 MPa.

Design - General
• Concrete Design - Slabs - All Head Codes:

• [TSD-1229] - Review View > Design Summary - a brand new Design
Summary for Slabs & Mats is added to the Review View design result
tables, giving a concise tabular view of slab design results for all slab
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and mat types. This can be selected as shown in the picture below and,
like other tabular design details, can be exported directly to Excel.

• All slab items and patches associated with the slab are listed
together. By default, slab and patch items are listed in order of
utilization ratio with slab items listed first followed by patches, then
mats and their patches.

• The table can be sorted differently simply by clicking on a column
header (with the exception of the Grade and Result columns)

• The summary table reflects the critical results from all the available
RSA and Static combinations.

• [TSD-6872] - Analysis Method - the design details now state the Analysis
method from which the critical design moment originates, as shown in
the picture below.
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Reports and Drawings
• [TSD-4253] - Tabular Data & Reports - Member Design Summary - user-

defined span/ stack names are now included in the Tabular Data design
summary and associated report item where previously the span/ stack
number only was reported. This applies to all member types and materials.

• [TSD-6749] - Wall Schedule Drawing - improved tolerance is added to
prevent detection of very slight section differences along the wall height
which would commonly be ignored and could formerly result in
unnecessary section duplication and notes regarding the cross section not
being consistent in the drawing.

Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

Release notes: Tekla Structural Designer 2020 SP1
This release will upgrade your Tekla Structural Designer installation to version
number 20.0.1.54 and should be installed to ensure optimum function of the
program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than release 2020 first release
(version 20.0.0.129), you can find details of requirements, enhancements and
fixes for all previous releases in Tekla User Assistance (TUA) and Tekla
Downloads via the links below:
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• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

Licensing & Installation
Licensing:

• No new license is required for this version.

• Tekla Structural License Service - a Service Pack for this was released on
1st April 2020. This addressed the issue of the “Automatic” license method
not correctly checking for a Sentinel RMS Server license when all Online
licenses were in use. This is available in Tekla Downloads and should be
installed on all clients for optimum functionality.

• For more information see: https://
teklastructuraldesigner.support.tekla.com/support-article/3050337

• License Server Version - for Server licensing, the latest version of the
Tekla Structural License Service 3.00.0001 (incorporating Sentinel RMS 9.5)
must be installed on your license server to be compatible with this release.
Licensing will not function correctly if this is not the case. For more on this
requirement please see the TUA article Tekla Analysis & Design 2020
Releases & Sentinel RMS Server Licensing - the License Server must be
updated.

Installation:

• This service pack requires Tekla Structural Designer 2020 first release
(version 20.0.0.129) to be installed.

• Integration

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate Tekla Structural Designer 2020 SP1 with Tekla Portal Frame
Designer and/or Tekla Connection Designer, you must use Tekla Portal
Frame Designer and/or Tekla Connection Designer release 20 or later
(note that these require activation of 2020 release PAK’s for these
products). For optimum function we recommend you install Service
Pack 1 for these products, which is available from the same date as this
release. Installations for these can be obtained from Tekla Download
Service.

• Previous Versions and file compatibility - Files from all previous versions
can be opened in this release however note that, once saved, they may not
open in an older version. If you wish to retain this option we therefore
recommend using the File > Save As… option to save a new version of the
file and retain the original.

• Databases - For an existing installation, if your databases are out of date, a
message informing you that new databases are available will be displayed
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in the Process Window as shown below when Tekla Structural Designer is
first opened.

• Please ensure you upgrade your local databases as follows;

• Open “Materials” from the Home Ribbon, select the “Sections” page
in the list of options, click the “Upgrade” button, then click this
button again in the subsequent “Upgrade Database” dialog. Repeat
this process for all the other databases (Material,
Reinforcement...etc ) to ensure all your databases are up to date.

Issues with Associated Bulletins
• None of the issues addressed in this service pack have associated bulletins.

General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability. An example of such
an issue is listed directly below here:

• [TSD-6704] - Property Sets - Using the Apply... button at the top of the
Properties Window to apply an existing property set to a selected
member could in certain circumstances produce a crash. This has now
been corrected. Note that this issue applies only to version 2020 first
release in which this issue was introduced.

• [TSD-422] - Review View - Show/Alter State - The legend of the Show/Alter
state operation of the Review regime has been enhanced so that it now
allows multiple pages and will effectively list, for the selected mode, all the
different states/attributes from all relevant objects in view. This is a
significant enhancement for cases where the maximum number legend
items (10) is exceeded, which previously limited functionality.

• As shown in the picture below, where > 10 items/states exist (e.g.
section sizes for the Section Attribute), forward/ back buttons now
appear at the bottom of the legend; click the forward > button to access
the next legend page. On subsequent pages the legend colours
differentiate objects classed as ‘Other’ on the previous page(s).
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• This new functionality applies to the following Review View > Show/Alter
State Attributes:

• Section (Review mode)

• Material Grade (Review mode)

• SFRS (Review mode)

• Size Constraints (Review mode)

• UDA

• [TSD-5113] - General Walls - following customer requests, a new wall type
“General Wall” has been added to the modeling options. This uses the
same analytical model as that of meshed concrete walls (for more on this
see the Help Topic How meshed walls are represented in solver models
(page 750)), however the material type is General and any of the materials
types defined in this category can be used.

• Key aspects of the new General Walls are:

• The wall properties type of “Meshed Shear Wall” is the same as that
used for meshed concrete walls - thus the distinction between
meshed Concrete and General wall is controlled solely by the
Material Type.

• Mid-pier walls can only be Concrete.

• They are distinguished graphically in Scenes by use of a specific
default light blue colour different to the grey of concrete walls.

• Geometric rules are as for meshed concrete walls; they can be
vertical or sloped and openings are allowed.

• The same graphical and tabular data results are available for them
as for concrete meshed walls, including 2D contours (other than As
Req), 2D Wall Lines and Result Lines.

• New Analysis Modification factors are added for them, accessed via
Analyze > Settings > Modification Factors > General > Wall

• They cannot be included in cores, are not designed and have no
reinforcement or seismic properties.

• Some new sample general materials for walls are included in the latest
database version (note this requires the Material Database to be
updated to the latest version).

• As for meshed concrete walls, the behaviour of the 2D mesh elements -
and hence General Walls - is isotropic. We do not advocate their use for
any particular wall type or building/ structure - this and the material
properties used for them are the responsibility of the engineer.
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• [TSD-1365] - Columns - Releases - following customer feedback, for
continuous columns composed of two or more stacks, the ability is added
to pin columns in one direction (My or Mz) whilst the other direction
remains fixed at the top and bottom of stacks within a column. While such
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a release condition is less usual, it is now allowed for columns of all
materials.

• Note that, when such a release is applied, a Warning status will be issued
as shown in the picture below. This is intentional and does not prevent
analysis or design - as the Warning tooltip states, it is to prompt the
engineer to consider the connection details at this location in the column.

• Review View > Show/Alter state Fixed/Pinned command is also enhanced to
enable rapid review and application of these releases (for beams as well as
columns); new “Moment (pin My)” and “Moment (pin Mz)” options are
added to the Fixity Types and legend as shown in the picture below.
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• [TSD-6110] - Steel Compound Sections - the plate width for the double I
section with plates compound section may now be less than the combined
width of the I section plus any gap.

• [TSD-6709] - Connection Resistance Data - when upgrading the connection
resistance database from earlier versions, zero values in the database
(which previously indicated a connection type as being not applicable),
would be incorrectly transferred, leading to connection types being listed
that were not applicable for the selected Head Code. This issue applies only
to the release 2020 first-release and is now corrected.

Integration
• [TSD-6230, 6232] - API - the API version has been updated to enable the

extraction of internal Member forces both directly from the Solver and
Loading analysis. Full details of the API, including worked examples, will be
available shortly in the Tekla Developer Center.

Performance
• [TSD-5437] - Reports - Enhancements have been made which significantly

reduce peak RAM demands during report creation, this may improve
general operation speed for some structures.
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Loading
• [TSD-5678] - New Diaphragm Loads Table - building on the new Diaphragm

Loads feature of the recent 2020 release - for the application of externally
determined level loads (for example from Wind Tunnel testing of large/
unusual structures) - in this release a Diaphragm Loads Table is added for
these as illustrated in the picture below. The Table allows rapid tabular
definition, editing and verification of Diaphragm loads.

• All Diaphragm loads added using the existing Diaphragm Load
command (active in 2D views) are listed in the table. Note that multiple
loads can be applied to a single diaphragm, and that by default only
diaphragms with loads applied are listed.

• Loads can also be added manually in the table to existing diaphragms
with no current loads as follows:

• Check on the “Show diaphragms with no loads” check box to list all
diaphragms with no loads currently applied.

• Select the Loadcase you wish to add loads to from the Loadcase list
box

• Select the row for a diaphragm then click the “Add” button - the cells
of the row are then activated and the Load and X and Y coordinate
values can be input.
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• Data can also be pasted into the table from an external application for
example Excel - ensure that the data is in the same format and order
and includes a Z (Level height) column as shown in the picture below
(this is not the same order as in the diaphragm loads table).

• Note that pasted data replaces any existing loads in the current
loadcase, it does not merge loading. Also note that the level height
does not need to be exact, during the import process the closest
diaphragm will be identified and the height will be adjusted (with
warnings if the adjustment is excessive).
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• Load Combination Generator:

• [TSD-6347] - Eurocode - GEO Combinations - to help prevent the
automatic creation of unnecessary combinations, new intelligence is
added to the combination generator for the case where the
foundation bearing capacity calculation is set to use the presumed
bearing capacity method of EN 1997-1:2004, cl. 6.5.2.4 (Design
Settings > Concrete > Cast-in-place > Foundations > General > "Use
presumed bearing capacity (...)" checked on) and hence GEO
combinations are not usually required. In this case the GEO
combinations option is no longer checked on by default in the
Combination generator. The engineer can still activate these for
inclusion should they so wish.

• [TSD-6341] - Eurocode - EQU Combinations - since these
combinations are less commonly required and for the same reason
as described in the above issue, the EQU combinations option is no
longer checked on by default in the Combination Generator. The
engineer can still activate these for inclusion should they so wish.

• Note related issue in the Design - Eurocode section - EQU
combination results are not considered currently for any
member design within Tekla Structural Designer, nor are there
any EQU limit state checks performed based on them.

Validation
• [TSD-6040] - Concrete Walls - All Head Codes - a new validation warning is

now issued for isolated walls defined with “the dimensions of a column”
(with L ≤ 4W where L is the wall length and W the thickness) and not
forming part of a core wall. The warning message states “Isolated wall
defined with dimensions of a column” and the tooltip "If the wall is not part
of an interconnected concrete core then it should be defined and designed
as a column".

• At some ratio of L to W a concrete member would be considered to be
more a column than a wall. Logically, some level of engineering
judgement applies in the distinction and when - i.e. at what ratio - it
should be made. Eurocode EC2 Cl 5.3.1(7) states a member is a column
when the ratio “does not exceed 4”. Hence this ratio is adopted for the
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warning limit and we thought it prudent it be applied for all Head
Codes.

• The warning can be acted upon or ignored at the engineer’s discretion.
It can also be enabled/ disabled via Home - Model settings - Validation -
checkbox for "Isolated wall defined with the dimensions of a column” as
shown in the picture below.

Analysis & Results
• [TSD-6480] - Solver model - improvements are made to the solver model

for haunched beams which could result in a zero length analysis element
error for some geometries.

• [TSD-6373] - Chase-down Analysis - an analysis process error would occur
during the calculation of chasedown combinations when slab mesh
elements in a semi-rigid diaphragm were connected at the supported end
of a meshed shear wall. The analysis model is enhanced to cater for this
circumstance and the error no longer occurs.

• [TSD-6544] - Analyze Ribbon - the following minor changes are made to the
ribbon to make its function more clear:

• “Solver” group is renamed to “Data”.

• “Tabular Data” button renamed to “Model & Results”

• The Meshing group (with buttons Mesh Slabs and Update Wall Beams)
now only appears when a graphical view is active.
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Design - General
• [TSD-5107, 5109] - Concrete Walls - Cracked State - as illustrated in the

pictures below, the Review View > Show/Alter State > Assume cracked
command is significantly enhanced with a powerful new “Review Wall
Stress” mode. This builds on the enhancements made in recent releases for
the assessment and control of the cracked status of concrete walls; the
addition of In-plane stress 2D result values and the Assume cracked
Attribute to Review View > Show/Alter State.

• The Review Wall Stress mode controls allow the engineer to set the
Result and Stress type and stress threshold value to be used for the wall
panel cracked status determination - the view is updated immediately
following changes to these.

• Note that a (tension) stress threshold of zero as shown in the picture
below would be conservative.

• Using this feature the engineer can rapidly assess the cracked status of
wall panels relative to the current option settings. Panels where the
cracked status is correct based on the current settings are shown in
shades of green colours, panels where the status is not correct are
shown in shades of red.

• There is also a powerful Auto update feature which automatically sets
the assume cracked status from the graphical check results; as
illustrated below, this is activated via the [...] button at the right of the
Set all compatible > Auto update Properties cell.
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For more information please see: Concrete member cracked or
uncracked status (page 1286)

• [TSD-2341] - Concrete Seismic Design - US and Indian Head Codes -
following the enhancement in previous releases to allow columns to be
assigned to an SFRS in both directions, the Seismic Force Resisting System
framing members check is enhanced to cater for all different SFRS Type /
Direction combinations between the two allowed SFRS directions.

Design - Eurocode
• [TSD-6341-5] - EQU Combinations - the results of EQU combinations are no

longer included in any member design.

• Eurocode EQU combinations were added to the Combination Generator
in an earlier release, principally for industrial structures in which they
are used for checking the equilibrium of the structure as a rigid body,
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but not for member design. However, in previous releases, results of
these combinations were incorrectly used in member design.

• Note the related issue in the Loading section - EQU combinations
are no longer active by default in the Combination Generator.

• This applies to the following circumstances and member types (which
were formerly checked for EQU combinations); concrete members,
walls and slabs; Steel/Cold formed members of all designed
characteristics.

• Concrete Design - Beams:

• [TSD-1377] - Longitudinal Reinforcement - the method to calculate the
minimum area of longitudinal reinforcement, as required by EN 1992-1
clause 9.2.1.4, has been altered so that the requisite applies directly to
the required areas of reinforcement instead of applying to the design
moments as previously. This change ensures that the minimum is
checked against an overall area of reinforcement in the design region
without any further additions. As a result engineers may, in cases where
min reinforcement requirements govern, obtain a more efficient
longitudinal reinforcement design.

• Design Control - Allowing engineers to exercise their judgement , the
following new "Design control" options are added (available for
individual spans of continuous beams):

• [TSD-1801] - new option to consider or ignore lateral instability for
slender spans to EC2 clause 5.9(1) (off by default). When the option
is checked on - as shown in the picture below - the slender span
check is excluded from design.

• [TSD-1893] - Deflection Check - new option "Structure supporting
sensitive finishes" is now available under "Design Control" (on by
default) to control the value of the f2 parameter used in the
deflection check. When unchecked f2 will be taken as 1.0.
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• Floor Vibration Check to SCI P354:

• [TSD-5668] - the “Factor for increased dynamic stiffness of the concrete
flange” value set for the beams specified in the check is now used by
the Floor Vibration check to determine the dynamic modular ratio of
the slab (rather than a fixed value of 1.100 as previously). For more
information about this see the TUA article Beam and Floor Vibration
Checks - Dynamic Modular Ratio and SCI AD 433.

• The “Factor for increased dynamic stiffness of the concrete flange” is
set in the Natural Frequency group of the Beam properties as shown
in the picture below. The value must be the same for both the
primary and secondary beams of the check. The check is not
performed and a warning now issued if this is not the case, as
shown below.
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• [TSD-4234] - Fabsec beams with openings are now considered without
error in the SCI Floor Vibration Check to the SCI P354 Handbook.

Design - US
• Seismic Drift:

• [TSD-4134] - Shear demand / capacity ratio (beta) - the engineer can
now directly define the shear demand / capacity ratio (beta) for
columns and walls. Previously this was fixed to a value of 1.0 which
could be over-conservative. The option to specify the value is added to
the “Seismic” group of member properties, and can be set separately
for 'Direction 1' and 'Direction 2' and for each stack/panel, as shown in
the picture below.

• The setting is applicable to all years of the ASCE7 code and has the
following default and limits: Default = 1; Min = 0.001; Max = 10.

• [TSD-4234] - Seismic Stability Coefficient - the calculation of the seismic
stability coefficient, theta, is modified to take advantage of Clause 12.8.7
when 2nd order analysis is used in design. This change applies to all
years of the ASCE7 code and the changes are summarized as follows:

• Modified theta calculation following Clause 12.8.7 when 2nd order
analysis is set for design (Design > Settings > Analysis)

• Where First order analysis is set for design, a warning is issued to
use 2nd order analysis even if theta is greater than theta max.

• The drift ratio check and status are updated to follow Clause
12.12.1.1 when the seismic design category is D,E or F and it is not a
fixed structure.

• [TSD-4136] - Review Data - following customer feedback, the Seismic
Drift results table in Review data (and the associated Report item) has
been improved; the table now reports the drift ratio and theta ratio
respectively for Dir 1 & Dir 2 where previously it reported absolute
values of drift and theta for Dir 1 & Dir 2.

• Seismic Design:

• [TSD-6623] - SFRS Direction - Beams - when beams are selected as a
part of an SFRS system, the SFRS direction is now assigned
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automatically based on the modelling direction of the beam. The
automatically assigned direction can be reviewed and edited by the
engineer as required. Automatic assignment works as follows:

• Applies to both concrete and steel beams.

• Beams that are skewed in plan w.r.t. the building directions are
assigned a direction as follows: where the angle with Dir 1 is < = to
45 degrees, Dir 1is assigned, otherwise Dir 2 is assigned.

• The default SFRS type assigned is SMF (again this can be reviewed
and edited by the engineer as required).

• [TSD-6494] - Concrete Walls - some conservatism is removed from the
calculation of minimum vertical reinforcement in walls designed to ACI 318
(all available years). For walls with a height to length ratio (hw/lw) ≤ 0.5, the
program now considers the minimum allowed ratio of vertical
reinforcement equal to that for horizontal reinforcement - as prescribed by
the design code - rather than using a single equation in all cases where
hw/lw < 2.5.

• [TSD-5444, 6650, 6612] - Steel Joists - an erroneous Fail status and message
regarding “Non-uniform load…” could be issued when uplift occurred for
combination service factors but not strength factors. This is corrected such
that the uplift condition for strength and service combination factors are
checked and reported separately. In addition, the load types are reported
separately for both strength and service in all combinations.

Reports and Drawings
• Reports:

• [TSD-5678] - Material List - Westok Cellular Beams - the gross weight of
cellular sections (as reported in the Material List) is calculated as the
average of the two Tee sections to give the same value as that in the
Westok Cellbeam application.

• [TSD-6115] - Analysis Diagrams - the labeling of diagrams added to
reports has been enhanced to include the applied model filter.

• [TSD-6365] - Analysis Result Reports - analysis result reports for
envelopes which included pattern load combinations did not include
the results for the pattern combinations. Note that this issue would only
have applied where envelopes were created and for reports with these
envelope filters applied. The issue did not affect the analysis or design
procedures.

• Drawings - Concrete Beam Detail:

• [TSD-6537] - Side bars - for some cases where a reinforced concrete
(RC) beam was connected to another RC beam and the connection was
collinear, the side bar anchorage in the detail drawing would be
excessive. This is now improved.
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• [TSD-6551] - Cross-sections - in some circumstances the cross-sections
could overlap with the elevation. This is now fixed.

Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.
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2 Get started with Tekla
Structural Designer

Tekla Structural Designer is an integrated model-based 3D tool for analysis
and design (of both concrete and steel members) in multi-material structures.

Features include interactive modeling, automated structural analysis and
design, drawing, and report creation.

Multiple design codes are supported:

• ACI/AISC

• Eurocodes

• British Standards

• Indian Standards

• Australian Standards

2.1 Philosophy
The aim is to allow you to rapidly build your model, apply loads, and design
the model for an appropriate set of design forces.

On a day to day basis, you do not need to be involved with the underlying
analysis models to achieve this. Instead, you can focus on the design results.

To make this possible, Tekla Structural Designer automatically creates and
analyzes multiple solver models, each one being based on a different but
widely accepted approach.

By designing for the forces from all the solver models, you can be confident
that each scenario has been catered for.
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2.2 Tekla Structural Designer way of working
Tekla Structural Designer differs slightly from traditional modeling, analysis
and design process.

Traditional modeling, analysis and design process

The traditional modeling, analysis and design process can be summarized in
the following phases:

1. Provide a way to input or describe the model.

2. Analyze the model.

3. Design the model.

4. Produce calculations.

5. Produce drawings.

Process in Tekla Structural Designer

In Tekla Structural Designer, the analysis and design phases are merged into a
single process. As a result, the workflow is as follows:

1. Input the geometry and loads

A key requirement these days is BIM integration, or the ability to be able
to transfer data from one application to another. Tekla Structural
Designer has tools to automatically import model data from Neutral Files
and from 3D DXF to facilitate BIM integration.

Of course, you can also build the model directly.

Once the physical model has been created, the next step is loading it.
Tekla Structural Designer allows you to apply a wide range of loads in a
flexible system of load cases. The system contains, among other things, a
wind load generator available to automatically create wind load cases.
You can also generate load combinations automatically.

You should also consider pattern loading. You can create patterned beam
loads automatically, and create patterned slab loads manually for design
of slabs.

2. Analyze and design the model

Tekla Structural Designer automatically performs the analyses required to
enable member design to proceed. This means that analysis and design
are combined into a single automated process. The only exception to this
rule is slab design.

3. Produce reports

You can create a wide range of calculations. You can also tailor the
calculations extensively to meet your requirements.

4. Produce drawings

You can produce beam and column detail drawings, and member
schedules.
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2.3 Install and license Tekla Structural Designer
When you install Tekla Structural Designer, you will be asked to select your
license method from a range of options. These are fully explained in the "Tekla
Engineering Software - Installation and Licensing Guide 2020" which can be
viewed during the installation process by clicking the button shown below.

To install Tekla Structural Designer:

1. Download the installation file from Tekla Downloads to your computer.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

If you are upgrading an existing Tekla Structural Designer version, you will also
need to upgrade your local databases, see: Install the upgrade (page 91).

Licensing & installation information specific to Tekla
Structural Designer 2020
• Upgrade Licenses - Tekla Structural Designer 2020 will require the

activation of a new license. You should already be in possession of your
Product Activation Key (PAK) as these are usually distributed prior to the
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software release. Please contact your local Service Department now if you
do not have your PAK. To minimise any down time we advise that your PAK
is activated BEFORE installing Tekla Structural Designer 2020.

• License Server Version - the Tekla Structural License Service must be
updated to the new version 3.00.0001 (incorporating Sentinel RMS 9.5) to
be compatible with this release. Licensing will not function correctly if this
update is not performed! Please see this article for more information about
this, and see System Requirements for specific version details.

• Subscription Licenses & Tekla Online Licensing - if you have just
purchased your license(s) they will use the new Tekla Online License
Method. Select this option when installing the program as shown in the
picture below.

Please note the following:

• In order to use a Tekla Online license you will need:

• A verified Trimble Identity Account. For more on this see the TUA
Article Trimble Identity for Tekla Online services

• To be a member of a Tekla Online Organization. For more on this see
the TUA Articles Managing your Tekla Online services Organization and
How do I join a Tekla Online Service Organization?

• To have an Online License assigned to you by your Organization’s
Administrator.
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• To be Signed In in the program. When the Tekla Online license method
is set, you will be prompted to sign into the program when you start it
as shown in the picture below - ensure you check on the “Stay signed in”
option.

Installation - no previous installation of Structural Designer is required. To aid
with transition, this release will install alongside existing versions and does not
overwrite them.

• Integration

• Tekla Structures - improvements to integration with Teka Structures
requires version 2020 of Tekla Structures. See the Tekla Structures 2020
Release Notes > Other interoperability improvements for more
information.

• Tekla Portal Frame and Connection Designer 20 - if you wish to
integrate Tekla Structural Designer 2020 with Tekla Portal Frame
Designer and/or Tekla Connection Designer you must install Tekla
Portal Frame Designer 20 and/or Tekla Connection Designer 20
available from Tekla Download Service (note that these too will also
need a new license).
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Further help and update information

Tekla User Assistance
The Tekla User Assistance services are 24/7 online support channels for fast
self-service, where you can find all the product guides, additional knowledge-
base articles and instructional videos.

Tekla Discussion Forum
The Tekla Discussion Forum is the place to meet other users and discuss
topics related to Tekla products. You can ask questions, contribute to the
community by sharing your knowledge or get answers from support
personnel.

Helpdesk
The Tekla Helpdesks support your daily operations so that our systems
function as expected and any problems are solved as quickly as possible.

Software Update Service
The Software Update Service allows you to get the latest improvements to
Tekla Structural Designer as soon as they are available. Providing you have an
active internet connection you will be notified by Tekla whenever a new
update is available.

The Software Update Service is enabled via Settings> General> Update Service
on the Home ribbon.

You can also check for updates at any time via Check for Updates on the Home
ribbon.

Previous versions
You can find details of requirements, enhancements and fixes for all previous
releases in Tekla User Assistance (TUA) and Tekla Downloads via the links
below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads
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2.4 Start Tekla Structural Designer
When you start Tekla Structural Designer for the first time, you are asked to
choose a country or region. Based on your selection various region specific
settings such as design codes, units and default section sizes are configured.
These settings, which can be changed to meet your company requirements,
are applied when you start each new project.

Choose the country for your settings
1. Start Tekla Structural Designer by selecting it from the Windows Start

menu or by double-clicking the desktop icon. 

A dialog box where you choose your settings appears.

2. Select a country that fits the region where your project is done.

3. Click OK The Tekla Structural Designer interface appears, with settings
configured for the selected country.

Check or change your settings
You can check or change the settings that get applied to new projects at any
time.

1. On the Home ribbon, click  Settings The Settings dialog opens,
displaying the settings that have been configured for the selected settings
set.

2. Change the settings as needed. 
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NOTE Any changes that you make only apply to new projects, existing
projects are unaffected. For more information about changing
settings, see: Manage settings sets (page 1000).

Start a new project

1. On the Home toolbar, click  New 

NOTE Once familiar with the program, some users might prefer to set
up a template (page 246) to use as the basis for new projects -
particularly when there is a lot of commonality between projects.

Your new project opens and you will see:

• Two scene views (page 250): Structure 3D and St. Base (Base) 2D

• A tabbed (page 251)

• A (page 252)

2. Click the  Structure tab under the Project Workspace 

A Structure tree is displayed in the Project Workspace.

3. In the Structure tree, click Structure 

The Properties window displays the Structure properties.

4. In the Structure tree, click Levels 

The Properties window changes to display Levels properties - at this
point there is only only level in the model.

NOTE The units in which the levels are displayed, (along with other
settings), have been copied into the model from the settings set
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that was active when the project was started. These are known as
'model settings'. Model settings apply to the current project only
and can be edited to suit the model as required.

What to do next:

• Check or change model settings in your project (see below).

• Try setting out some grid lines (page 371) in the St. Base (Base) 2D view.

• Next, double-click Levels in the Structure tree to create some levels
(page 367).

• With grids in place and levels established, you can then open views of the
other levels (page 276).

• You are now ready to begin creating the model (page 366).

Check or change model settings in your project
You can check or change the model settings in the current project at any time.

1. On the Home ribbon, click Model Settings 

The Model Settings dialog opens, displaying the model settings that have
been copied in to your project from the active settings set.

2. Change the model settings as needed. 

NOTE Any changes that you make only apply to the current project, new
projects are unaffected. For more information about changing
model settings, see: Apply and manage model settings (page 991).

Modify project details
The Project Wiki allows you to modify project details, view revision history,
and record revisions.

Modify project details and view revision history
You set the initial project details as you create a new project. If you want to
change the project details later, or view other project parameters, see the
following instructions.

1. On the Home tab, click Project Wiki. 

The Project Wiki dialog box opens.

In the Project Wiki dialog box, you can:
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• Manage the parameters that are included in the output reports on the
Project Summary page.

• Track revision history on the Revisions page.

• View the time at which each revision was started and last saved on the
Sessions page.

• View the changes associated with each revision on the Changes page.

• View statistics related to the model size on the Metrics page and its
sub-pages.

2. On the Project Summary page, modify the project details according to
your needs.

3. Click OK.

Record revisions
1. Save the project before recording revisions.

2. In the file menu, click Start Revision. 

The Start Revision dialog box opens.

3. Type the revision ID and add additional notes related to the revision
according to your needs.

4. In order to keep a record of the changes made in the revision, select the
Track Changes option.

5. Click OK.

6. Continue to develop the model and save the model under a new name.

7. Repeat steps 2–5 as required.

Apply revision ID as an attribute for each modified element

1. On the Home tab, click Project Wiki.

2. Click Changes.

3. Select an appropriate UDA from the Revision Attribute droplist.

4. Either:.

a. Click Apply automatically in order for the revision ID to be
automatically recorded against the selected UDA on each change, or

b. Click Apply to manually record the revision ID against the selected
UDA for the currently elements listed in the dialog.

5. Click OK.
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Use templates in new projects
If you are creating projects that share a common start point, you can use
templates to avoid having to repeat inputting information.

In order to use a template, you must first create one.

A template can contain as much or as little information on the model as you
consider applicable to serve as the start point for subsequent models.

For example, you can create a template that only contains a simple grid and
the height of the first floor construction level.

See also

Create a new template (page 246)

Create a new project based on a template (page 246)

Create a new template
You can create a new template to simplify creating new models that have the
same starting point. For more information, see the instructions below.

1. Start a new project (page 243)

2. Create the model data that you want to include in the template.

3. On the Home tab, click Save As. 

The Save As dialog opens.

4. Change Save as type to Tekla Structural Designer template file
(*.tsmdt).

5. Name the template and ensure that it is saved in the right location.

6. Click Save.

See also

Create a new project based on a template (page 246)
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Create a new project based on a template
You can use an existing template as the base of your project. For more
information, see the following paragraphs.

NOTE Before creating a new project, ensure that an appropriate settings set
is active.

For more information, see Use settings sets.

1. On the Home tab, click . 

A list opens.

2. In the list, select the required template. 

The template opens.

3. On the Home tab, click Save As. 

The Save As dialog opens.

4. Change the Save as type to Tekla Structural Designer project files
(*.tsmd;*.cscbd).

5. Name the file and ensure that it is saved in the right location.

6. Click Save.

7. Add the necessary building objects and loads in order to complete the
project.

See also

Create a new template (page 246)

2.5 Get familiar with the user interface
Before creating a new project, we recommend you take a moment to
familiarize yourself with the user interface as explained in the following topics:

• Interface components (page 247)

• How to use the project workspace (page 261)

• How to manage scene views, view modes and scene content (page 275)

• How to hide, re-display and move windows (page 289)

• Keyboard shortcuts (page 291)
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Interface components
The main components of the Tekla Structural Designer user interface are
labeled in the image below:

1. File menu
The File menu contains those commands that you can use to perform file-
related operations.

Button Description

New

Creates a new blank project from scratch.

Open

Opens an existing project.

Save

Saves the currently open project.

Save As

Saves the currently open project with a new name, or
as a template.
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Button Description

Save Model Only

Saves smaller model-only files without the analysis
results. The model-only files can easily be shared
amongst the project team.

Close

Closes the currently open project.

Print

Prints the currently open project.

Start Revision

Records changes to this revision of the project.

Send As Email

Creates a new email with the project attached.

Contact Support

Automatically uploads your model file and sends
this, together with your issue description and key
information (needed by Support to assist you) about
your installation and system, to your Local Support
Team as defined in your Tekla Online Profile.

Exit

Prompts you to save any open project, and then
closes Tekla Structural Designer.

2. Quick access toolbar

The Quick Access toolbar displays commonly used commands, listed below:

•
New

•
Open

•
Save
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•
Undo

•
Redo

•
(page 2187)

•
(page 2201)

•
Delete

3. Ribbon
The ribbon consists of a number of toolbars, placed on various tabs. Each
toolbar contains related commands organized into logical groups.

1. Toolbar tab

2. Command

3. Group
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4. Scene views
2D views, 3D views and solver views, of the model, sub models, frames,
construction levels and individual members can be displayed in tabbed
windows.

For more information, see: How to manage scene views, view regimes and
scene content (page 275)

5. Structure tree
The Structure tree refers to the hierarchy of information displayed on the
Structure tab in the Project Workspace . Similar 'trees' are displayed for the
other tabs also.

6. Project Workspace
The Project Workspace is a central location of organizing the entire model
into a hierarchical structure.
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It provides access to a range of functions and is a key tool in creating and
controlling your model.

For more information, see: How to use the project workspace (page 261)

7. Properties window
The Properties window facilitates the input, review and editing of model
properties.

The Properties window is used to:

• input data when a command is run from a toolbar.

• review or edit existing properties when individual or multiple items are
selected in the active scene view.

• review or edit properties when a branch of the Properties window is
selected.

The properties displayed vary according to the selection. You can edit all of the
properties, unless they are greyed out.
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A key feature of the Properties window is that it enables the editing of
multiple items at the same time. Existing properties of selected items are only
displayed when if are identical for all selected items. If the properties differ,
the property field is left empty.

By default, the Properties window is docked at the bottom left of the main
window, but you can reposition it if required.

8. Show Process button
Click to display the Process Window, described below.

9. Process Window
Initially, the Process Window is minimized. It can be displayed by clicking the
Show Process button, located at the left end of the Status bar.

When you analyze or design the model, each step of the process is logged and
displayed in the window.

When the window is minimized in the Status bar, any detected warning and
errors are flagged. See the flags below:

•

•

Such warnings and errors should always be fully investigated, as they may
have an adverse affect the design.
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10. Select Entity tooltip
The program is automatically in ‘select mode’ when no other commands are
being performed. In this mode you can hover the cursor over an entity and its
name will be displayed in the Select Entity tooltip.

When the correct entity is displayed, click the entity to select it. If several
entities are displayed, you can select one by using the Tab key or Up/Down
arrow keys.

11. Context menu
You can right-click anywhere within a 2D or 3D view to display a menu that is
context-sensitive to the item that is currently highlighted.
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12. Properties dialog
You can use the Properties dialog box for viewing and editing parameters
associated with an individual model object.

The Properties dialog box is displayed by right-clicking an object in the
graphical display and selecting the Edit option from the context menu that
appears.

13. Ghost Unselected and Ghosted toggle buttons

• Ghost Unselected button is displayed in all 2D and 3D Views. It is used to
toggle the display of selected and unselected objects, making it easier to
focus on a particular subset of objects within the model.

See: Use Ghost Unselected to focus on the selection (page 357)

• Ghosted button is displayed in Sub Structure and Sub-model Views. It is
also displayed in Level, Frame, and Slope Views when they have been
toggled into 3D (via the 2D/3D toggle button). It is used to toggle the
display of a ghosted view allowing you to see the current view in the
context of the whole structure.

See: Use Ghosted to see the view in the context of the whole model
(page 1034)
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Related video

Ghosted Structure view

14. 2D/3D toggle button

2D/3D button is displayed in 2D Scene Views only. It is used to toggle the view
between 2D and a 3D isometric projection.

Example of a level view in 2D:

The same level view when toggled to 3D:
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15. Global XYZ axes
The global XYZ axis system within which all other systems exist.

16. Building directions
The principle axes of the building can be rotated about global Z if required.

The building direction axes can be switched on/off (and their labelling
contriolled) in Structure Properties (page 2067).

17. Cutting planes
The Cutting Planes symbol is displayed in the bottom right corner of the
scene view when any of the cutting planes are currently active.
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18. Loading List
The Loading list is permanently docked at the bottom edge of the main
window.

The Loading list has two main functions:

• Selecting a specific load case to add loads into

• Selecting a specific load case, combination, or envelope to view the results
for.

When viewing results, first click the Loadcase, Combination, or Envelope
button according to your needs. The, choose the specific load case,
combination, or envelope name in the list.

19. Status bar
The Status bar is permanently docked at the bottom edge of the main
window. The Status bar performs a number of different functions.

The Status bar provides feedback by indicating:

1. The analysis and design validity

2. The units system

3. The design code

4. The coordinates of the cursor relative to the global origin in 2D views

5. The view regime buttons that allow you to switch the view regime applied
to the active scene view, see View Regime buttons below.

6. Coordinate display that allows you to set the display method for
coordinate tooltips:

• ABS (Absolute)

• REL (Relative)

• POL (Polar)

7. 2D/3D toggle button

• 2D: the content of the 2D view is displayed in plan.
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• 3D: the content of the 2D view is displayed in isometric.

20. View regime buttons
The view regime buttons allow you to switch the view regime applied to the
active scene view:

•  Structural View shows the geometry and loading of the structure.

• Solver View shows the analysis model.

• Results View shows the analysis results.

• Wind View shows the wind model.

• Review View graphically examines the model properties or status.

•  Slab Deflections View shows the slab delection analysis results.

21. ViewCube
In 3D views, you can click a vertex, edge, or face of the ViewCube to rotate the
model to a preset view.

For more information, see: Zoom, pan, rotate and walk through scene views
(page 348)
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22. Scene Content
The Scene Content sidebar is used to control the displayed content in the 2D
and 3D Scene Views.

The sidebar contains:

1. Entity categories (with check boxes)

Some categories have arrow symbols to their side, indicating sub
categories. Click the arrow symbol in order to see the sub categories.

The check box controls whether the entity category and its associated
information is displayed. You can check the entities that you want to
display and clear the ones that you do not.

2. Entity information controls

Entity information controls list the information in each category that will
be displayed. When clicked, they expand to lists that allow you to select
the information you want to display in the model view.

For more information, see: Manage scene content information (page 280)

23. Tekla Online side pane
The Tekla Online side pane is used to access Tekla Online services provided for
users of Tekla Structural Designer, for example Tekla User Assistance and
Tekla Discussion Forum.
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24. Trimble Connect side pane
The Trimble Connect side pane is used to access the the Trimble Connect
project collaboration tool.

For more information, see: Working collaboratively with Trimble Connect
(page 310)

25. Sign in
Signing in to your Trimble Identity gives you access to a greater number of
online resourses.

You can sign in to one service and then browse to another online service
without a need to log in again. Find the services landing page here: http://
www.tekla.com/services

How to use the project workspace
The Project Workspace is the central control area for your model.

Its tabs are used to access a range of functions:

I
c
o
n

Tab Content

Structure Structure (page 262) tree: for opening scene views, viewing
and modifying model properties, controlling grids and sub
models.

Groups Groups (page 267) tree: for organizing members into design
and detailing groups and for displaying UDAs.

Loading Loading (page 270) tree: for viewing load status.
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I
c
o
n

Tab Content

Wind Model Wind Model (page 271) tree: for viewing and modifying wind
model properties

Status Validation (page 272) tree: for highlighting validation issues
and other aspects of the model status, i.e.

• Model Geometry

• Wind Model

• Meshing

• Decomposition

• Solver

• BIM

• Design
Connections Connections (page 273) tree: for viewing and designing steel

connections
Report Index Report Index (page 955): contains bookmarks that can be

used to move around the report when a report view is
displayed.

View and modify model properties in the Project Workspace
The Structure tree organizes the model geometry in a hierarchical way. It also
allows you to view and modify model properties.
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When you open a new model, the Structure tree contains two sub-branches:
Levels and Sub Models. As the model geometry develops new branches are
added, as shown above.

When a branch or sub-branch is selected, the common properties of the
selected branch are viewed in the Properties window. You can then modify
the common properties in the Properties window.

View and modify structure properties

Structure properties, or building parameters, control the principal direction
and default meshing properties of the building.

1. In the Structure tree, click Structure. 

The structure properties are viewed in the Properties window.

2. Modify the structure properties according to your needs.

View and modify construction level properties

• In the Structure tree, do one of the following:

To Do this
View and modify the properties common to all
construction levels

1. Click Levels.

The construction level properties common
to all levels are viewed in the Properties
window.

2. Modify the properties according to your
needs.

View and modify the parameters of a single
construction level

1. Click the + sign next to Levels.

All construction levels in the model are
viewed.

2. Click the desired construction level.

The level properties are viewed in the
Properties window.

3. Modify the level parameters according to
your needs.

View and modify frame properties

The Frames branch is added in the Structure tree when you create the
first frame in the model.

1. In the Structure tree, click the + sign next to Frames. 

All frames in your model are viewed.

Get started with Tekla Structural Designer 263 Get familiar with the user interface



2. Click the desired frame. 

The frame properties are viewed in the Properties window.

3. Modify the frame properties according to your needs.

View and modify the slope properties

The Slopes branch is added in the Structure tree when you create the
first frame in the model.

1. In the Structure tree, click the + sign next to Slopes. 

All slopes in your model are viewed.

2. Click the desired slope. 

The slope properties are viewed in the Properties window.

3. Modify the slope properties according to your needs.

View and modify grid properties

• In the Structure tree, do one of the following:

To Do this
Modify the color, name, or visibility of a grid

1. Click the + sign next to Architectural
Grids.

All architectural grids in your model are
viewed.

2. Click the desired grid.

The grid properties are viewed in the
Properties window.

3. Modify the color, name and visibility of the
grid according to your needs.

Renumber all grids

1. Right-click Architectural Grids.

2. In the context menu, click Renumber.

View and modify sub model properties

1. In the Structure tree, click the + sign next to Sub Models. 

The sub models in your model are viewed.

2. Click the desired sub model. 

The sub model properties are viewed in the Properties window.

3. Modify the properties according to your needs. 
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TIP To open the Sub Models dialog dialog, double-click Sub
Models.

View and modify sub structure properties

See: Manage sub structures (page 1031)

View and modify member properties

Tekla Structural Designer classifies members by material and type, and further
by fabrication and by shape. Members are classified by material and type,
then further classified by fabrication and then by shape.

• In the Structure tree, do one of the following:

To Do this
View and modify common properties for
members of a particular type and fabrication

1. Click the + sign next to Members.

The existing member types are viewed.

2. Click the + sign next to a member type.

The existing fabrication types are viewed.

3. Click a fabrication type.

Common properties of all members of the
fabrication type are viewed in the
Properties window.

4. Modify the properties according to your
needs.

View and modify common properties for
members of a particular type, fabrication and
shape 1. Expand the Members branch and its

sub branches by clicking them.

2. Click the + sign next to the desired
fabrication type.

The shapes of the fabrication type are
viewed.

3. Click a shape.

The common properties of all members of
the selected shape are viewed in the
Properties window.

4. Modify the properties according to your
needs.

View and modify the properties of an individual
member

1. Expand the Members branch and its
sub branches by clicking them.

2. Click the + sign next to the shape type.

The member references of the shape are
viewed.
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3. Click a member reference.

The properties of the member are viewed in
the Properties window.

4. Modify the properties according to your
needs.

View a member in a new window, select it in
visible views, delete it, or modify it in the
Properties dialog box 1. Expand the Members branch and its

sub branches by clicking them.

2. Right-click a member reference.

3. In the context menu, select the desired
option.

View and modify slab properties

• In the Structure tree, do one of the following:

To Do this
View and modify properties common to all slabs

1. Click Slabs.

The common properties to all slabs are
viewed in the Properties window.

2. Modify the properties according to your
needs.

View and modify the properties of a parent slab

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Click the desired parent slab.

The properties of the parent slab are
viewed in the Properties window.

3. Modify the properties according to your
needs.

Modify the properties of a parent slab, or delete it

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Right-click a parent slab.

3. In the context menu, select if you want to
modify the parent slab in the, or delete it.

View and modify the properties of a slab item

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Click the + sign next to a parent slab.

All the slab items within the parent slab are
viewed.

3. Click a slab item.

The properties of the slab item are viewed
in the Properties window.
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4. Modify the properties according to your
needs.

View and modify wall or roof panel properties

1. In the Structure tree, click the + sign next to Walls or Roofs. 

The currently defined walls and roof panels are viewed.

2. Click the desired wall or roof panel. 

The properties of the selected wall or roof panel are viewed in the
Properties window.

3. Modify the properties according to your needs.

View and modify result strip properties

1. In the Structure tree, click the + sign next to Result Strips. 

All the currently exiting result strips are viewed.

2. Click the desired result strip. 

The properties of the selected result strip are viewed in the Properties
window.

3. Modify the properties according to your needs.

Manage groups in the Project Workspace
The Groups tree organizes the members in your model into design groups. It
also allows you to manage design groups according to your needs.
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If you have defined concrete members, they are also organized into further
groups for detailing purposes. The application of grouping is most useful when
handling concrete structures.

User defined attributes (UDAs) are also listed, allowing you to see which
members have been assigned specific UDAs.

NOTE You can right-click on a group name (or UDA) in order to select all members in
the group, (or with that UDA), simultaneously in the visible views.

Regroup a specific member type

1. In the Groups tree, right-click the member type you want to re-group.

2. In the context menu, select Regroup Members. 

The selected member type is regrouped.

Re-group all member types

WARNING Re-grouping all member types undoes any manual grouping you
may have done.

• Click the Re-group ALL Model Members button on the top left corner of
the Groups tree.

Add group

1. In the Groups tree, select the appropriate branch within which you want
to manually create a new group.

2. In the context menu, select Add Group. 

A new group empty group is created.

Set as default group

When a new empty group is set as default, if you create a new member it will
be placed in that group in preference to another empty group.

1. In the Groups tree, select an empty group.

2. In the context menu, select Set As Default Group. 

An asterix is placed next to the group name to indicate that it is the
default group for new members.

Split a member group into smaller groups

1. In the Groups tree, right-click the name of the group that you want to
split.
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2. In the context menu, select Split Group. 

All members of the group are ungrouped and placed into individual
groups.

Move members from one group to another

1. In the Groups tree, open the group that contains the member(s) to be
moved.

2. Click the first member name to select it, then if you want to add further
members to the selection, hold down Ctrl while clicking on their names.

3. Drag the selection over the group name where you want to move it. 

Provided that the selection meets the geometric criteria to belong to the
group, a small rectangle will be displayed alongside the cursor.

NOTE You must drag over the group name as shown above, rather than
over the group content for the rectangle to appear.

4. Release the mouse button.

TIP You can also change the group to which members belong by selecting
them and then updating the group name in the Properties window.

Rename a member group

1. In the Groups tree, right-click the group that you want to rename.

2. In the context menu, select Rename Group.

3. Type the new name of the group and press Enter.
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Modify the group name defaults for future projects

1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets, and select the settings set that you want to edit.

3. Go to the Grouping page.

4. Review and modify the default group names according to your needs.

5. To save the changes, click OK.

Check a member group

1. In the Groups tree, right-click the member type you want to check.

2. In the context menu, select Check Group. 

The selected member group is checked.

Check a member group using Tekla Tedds

1. In the Groups tree, right-click the member type you want to check.

2. In the context menu, select Check Group. 

The selected member group is checked using Tekla Tedds.

Design a member group

1. In the Groups tree, right-click the member type you want to check.

2. In the context menu, select Design Group. 

The selected member group is designed.

Remove a member group

1. In the Groups tree, right-click the name of the group you want to remove.

2. In the context menu, select Remove Group. 

All members are ungrouped and placed into individual groups.

See also

Create and manage user-defined attributes (page 1026)

View load status in the Project Workspace
The Loading tab lists the individual loads that have been applied in each load
case. After analysis it sums the applied loads in each combination and checks
these against the sum of reactions.
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See the status options in the following table:

Icon Meaning
Total Reaction is in equilibrium with
the Total Load on Structure.
Total Reaction is not in equilibrium
with the Total Load on Structure.
Total Reaction is unavailable.

1. In the Project Workspace, go to the  Loading tab.

2. Click the desired load case. 

The properties of the load case are viewed in the Properties window.

View and modify wind properties in the Project Workspace
The Wind Model tree is used after completing the wind modeling process to
display wind direction views, modify wind directions, and modify wind load
cases.
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View a wind direction view

1. In the Wind Model tree, click Wind Directions.

2. Right-click the desired wind direction.

3. In the context menu, select Open View.

Modify wind direction properties

1. In the Wind Model tree, click Wind Directions.

2. Click the desired wind direction. 

The properties of the wind direction are viewed in the Properties
window.

3. Modify the properties according to your needs.

View and modify wind loadcases

1. In the Wind Model tree, click Wind Loadcases.

2. Click the desired wind loadcase. 

The properties of the wind direction are viewed in the Properties
window.

3. Modify the properties according to your needs.

View validation status in the Project Workspace
The Status tree is used to review the validation messages and other model
status indicators.
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You can review:

• The validation status for the model

For more information, see Check the model (page 512)

• The validation status for the analysis

The analysis model validation is performed automatically when you analyze
the model.

• The decomposition status

The Decomposition branch shows if load decomposition has been
successfully completed.

• The solver status

The Solver branch lists the analyses that have been performed.

• The BIM validation

If the model has been imported or exported, the BIM branch lists any
warnings and errors that relate to the import or export process.

NOTE •  indicates that the analysis or process has been successfully completed.

•  indicates that the analysis or process has resulted in an error.

•  indicates that the analysis or process has resulted in a warning.

Manage and design connections in the Project Workspace
The Connections tree organizes the model’s steel connections in a
hierarchical way, by Type (i.e. Type/Reference), and by Group (i.e. Type/Section
size/Reference).
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When opened for the first time, or if the model has been edited in a way that
affects the connection configurations within it, you must run Update
Connections in order to determine the valid connections.

This applies a set of rules (page 822) to create and organize connections into
the following Types:

• Base plate connections

• Beam to Beam Moment Connections

• Beam to Beam Simple Connections

• Beam to Column Moment Connections

• General Connections

Valid connections are displayed in the scene views and are also listed in the
Connections tree

Update connections

To create connection objects for the first time, or to recreate connections after
changes to the model:

1. Click on the Connections tree in the Project Workspace

2. Right-click the Connections branch.

3. Choose Update Connections from the context menu. 

This applies a set of rules (page 822) to determine all valid steel
connections in the model. The resulting connections are listed in the
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Connections Tree and are also shown by bounding boxes in the Scene
Views.

NOTE If the model has been changed so that new connections exist,
these are not created automatically; you are required to update
connections as required.

Edit connection

• In the Connections tree, right click on the appropriate connection
reference and choose Edit... from the context menu. A dialog opens
allowing the connection to be edited.

Select connection in visible views

• In the Connections tree, right click on the appropriate connection
reference and choose Select in visible views from the context menu. The
connection is selected if it exists in the active scene view.

Design connection

• In the Connections tree, right click on the appropriate connection
reference and choose Design connection from the context menu. The
connection is designed using Tekla Connection Designer.

Export connection to Tekla Connection Designer

• In the Connections tree, right click on the appropriate connection
reference and choose Design connection from the context menu. The
connection is designed using Tekla Connection Designer.

See also

Check steel connections (page 809)

How to manage scene views, view regimes and scene
content

Scene views

A scene view displays the model or a part of it in a tabbed window. It might
display: the entire structure, a sub structure, or an individual member in 3D; a
specific level, frame, or plane in 2D. A separate load analysis view is also
available for displaying force and moment diagrams for individual members.

Click the following links to learn how to manage and manipulate scene views:

• Open, close and save scene views (page 276)

• Create and modify scene view tab groups (page 279)
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View regimes

For each scene view, you should select a view regime from the Status bar
appropriate to the task being performed:

I
c
o
n

View regime Used for

Structural
View

Creating the structure geometry and applying loads

Solver View Displaying the analysis model
Results View Viewing analysis results
Wind View Viewing the wind model
Review View Examining the design status or reviewing specific model

properties
Slab
Deflections
View

Viewing slab deflection analysis results

Click the following link to learn how to switch between view regimes:

• Change the view regime (page 280)

Scene content

You control the level of information displayed in each scene view by switching
items on/off in the Scene Content dialog.

Click the following links to find out more about scene content:

• Manage scene content information (page 280)

• Scene Content entity categories (page 282)

Open, close and save scene views
You can display multiple different scene views simultaneously as tabbed
windows within the main window. See the following instructions to open, close
and save scene views.

Open 3D views

1. In the Project Workspace, go to the Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Open a 3D view of the entire structure

• Double-click Structure.
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Open a 3D solver view of the entire structure

a. Right-click Structure.

b. In the context menu, select Open solver
view.

Open a 3D view of a sub model

a. Click the + sign next to Sub Models.

The existing sub models are viewed.

b. Double-click a sub model.

Open a 3D solver view of a sub model

a. Click the + sign next to Sub Models.

The existing sub models are viewed.

b. Right-click a sub model.

c. In the context menu, select Open solver
view.

Open a 3D view of a sub structure a. Click the + sign next to Sub Structures.

The existing sub structures are viewed.

b. Double-click a sub structure.

Open a 3D solver view of a sub structure a. Click the + sign next to Sub Structures.

The existing sub structures are viewed.

b. Right-click a sub structures.

c. In the context menu, select Open solver
view.

Open a 3D view of a single member from within
another view

a. Hover the mouse over the desired member
to highlight it.

b. Right-click the member.

c. In the context menu, select Open
[element name] view.

Open a 3D view of a single member in the
Project Workspace a. Click the + sign next to Members.

b. Expand the required sub branches
similarly.

c. Right-click the required member.

d. In the context menu, select Open view.

Open 2D views

1. In the Project Workspace, go to the Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Open a 2D view of a construction level

a. Click the + sign next to Levels.

The existing construction levels are viewed.

b. Double-click the desired level.
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Open a 2D solver view of a construction level

a. Click the + sign next to Levels.

The existing construction levels are viewed.

b. Right-click the desired level.

c. In the context menu, select Open solver
view.

Open a 2D view of a frame

a. Click the + sign next to Frames.

The existing frames are viewed.

b. Double-click the desired frame.

Open a 2D solver view of a frame

a. Click the + sign next to Frames.

The existing frames are viewed.

b. Right-click the desired frame.

c. In the context menu, select Open solver
view.

Open a 2D view of a sloped plane
NOTE Before you can view a 2D view of a

sloped plane, you must create a sloped
plane in your model.

a. Click the + sign next to Slopes.

The existing slopes are viewed.

b. Double-click the desired slope.

Open a 2D solver view of a sloped plane
NOTE Before you can view a 2D view of a

sloped plane, you must create a sloped
plane in your model.

a. Click the + sign next to Slopes

The existing frames are viewed.

b. Right-click the desired slope.

c. In the context menu, select Open solver
view.

Save, open and delete view configurations
Once a scene view has been adjusted to show a specific area of the model, you
can save the scene view to a view configuration.
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NOTE You can use view configurations in two ways:

• Include them as views in model reports.

In this case, the view configurations retain the scene content
settings that were in place when you saved the view configuration.

• Re-open them in a new scene view at a subsequent time.

In this case, the view configurations adopt the scene content
settings that are currently in place in the scene view.

• According to your needs, do one of the following:

To Do this
Save a view configuration 1. Right-click anywhere in the view.

2. In the context menu, select Save View
Configuration...

The View name dialog box opens.

3. Name the view.

4. Click OK.

Open a saved view configuration

1. On the Home tab, click Manage
View Configurations.

2. Select the desired view configuration.

3. Click Open View.

4. Click OK.

Delete a view configuration

1. On the Home tab, click Manage
View Configurations.

2. Select the desired view configuration.

3. Click Delete.

4. Click OK.

Close views

• Click x on the top right corner of the view tab.

Create and modify scene view tab groups
When you have created multiple scene views, only the active view is visible by
default. However, it is often useful to display views side by side or one below
another. You can do this by creating tab groups.

Create a new tab group from an existing view tab

1. Right-click an existing view tab.

2. In the context menu, select New Horizontal Tab Group or New Vertical
Tab Group according to your needs.
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Create a new tab group using the docking control

1. Start dragging a view tab. 

A docking control appears in the middle of the view.

2. Do one of the following:

To Do this
Create a new vertical tab group • Drag the view over the left or right button of

the docking control and release the mouse.

Create a new horizontal tab group • Drag the view over the top or bottom button
of the docking control and release the
mouse.

Move a view from one tab group to another

1. Right-click the view tab.

2. In the context menu, select Move to Next Tab Group.

Change the view regime
• In the Status bar at the bottom of the main window, click the desired view

regime button. 

•  Structural View to show the geometry and loading of the
structure.

• Solver View to show the analysis model.

• Results View to show the analysis results.

• Wind View to show the wind model.

• Review View to graphically examine the model properties or
status.

•  Slab Deflections View to show the slab delection analysis results.
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Manage scene content information
Different entity types have different levels of information associated with
them. You can select how much of this information is displayed in each of the
different scene views and view regimes. Scene content selections are saved
independently with each scene view.

For example, in a Solver View regime, it is generally sufficient to represent
beams by their insertion lines. However, in a Structural View regime, you are
likely to also include their geometric outlines. In either of the views, you may
also choose to display their direction arrows and possibly their reference texts
also.

View the Scene Content window

1. Do one of the following:

If Do this
Scene Content is set to Auto Hide The Scene Content tab is docked on the edge of

the main window.

• Click the tab to expand the Scene Content
window.

The Scene Content has been closed • On the Windows tab, click Scene Content.

Select items in the Scene Content window

• In the Scene Content window, do one of the following:

To Do this
View the sub categories of an entity category • Click the arrow sign on the left side of the

category name.

View a category in the model view • Select the check box on the left side of the
category name.

Hide a category in the model view
NOTE If you hide an entity category, you can no

longer perform some commands that
affect that entity category.

For example, if you hide slab items, you
cannot define slab or area loads on a
floor because there are no slab panels to
select.

• Clear the check box on the left side of the
category name.

Adjust the information viewed in the model view 1. Click the cell on the right side of the
category name.

A list of possible details opens.

2. Select the details you want to view.

3. Click OK.
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Reinstate the default Scene Content selections

You can discard your current selections and reinstate the default Scene
Content selections at any time.

See the following instructions.

1. Close the current view.

2. Re-open the view using the Structure tree.

See also

Open, close and save scene views (page 276)

Scene content entity categories
The following paragraphs describe some of the most important entity
categories of Scene Content.

Architectural Grids

Allows you to show or hide architectural grids in 3D views. When selected,
architectural grids are displayed at the lowest level of the model.

Grid & Construction Lines

Allows you to show or hide grid and construction lines at individual levels in
both 2D and 3D views.

You can control the levels at which grids are or are not displayed in the
Properties window for each level. Grids are only displayed in 3D views if the
Show grids in the 3D view option is selected and in 2D views if the Show
grids in plane view option is selected.

Members

Allow you to manage how each member type is displayed. For each of the
mentioned elements, you can display the following information:

Geometry

Displays the faces of the member by shading them according to the member
type.

The following image displays a concrete beam and column example with the
Geometry and Architectural Grids options selected.
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InsertionLine

Displays a solid line between the start and end node of the member.

The following image displays the concrete beam and column example with the
InsertionLine and Architectural Grids options selected.

LoadingLine

Displays a solid line through the center of the member. Any member loads are
applied along the line.

The following image displays the concrete beam and column example zoomed
with the InsertionLine and LoadingLine options selected.

Normals

Displays the normal directions at each corner of the member.

The following image displays the concrete beam and column example zoomed
with the Geometry and Normals options selected.
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Text

Displays the member name.

The following image displays a composite steel beam example with the
Geometry and Text options selected.

Text2D

Displays the member name, section and class in the 2D plane of the member.

The following image displays the composite beam example with the
Geometry and Text2D options selected.

Direction

Displays the direction from end 1 to end 2 of the member.

If the direction is incorrect, go to the Edit tab and click Reverse.

The following image shows the composite steel beam example with the
InsertionLine and Direction options selected.
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BoundingBox

Displays the bounding box of sections. Selecting the option may simplify right-
clicking sections of a small cross section.

The following image displays the composite steel beam example with
Geometry and BoundingBox selected.

Decking

Displays the strip of decking that is connected to the member.

The following image displays the composite steel beam example with
Geometry and Decking selected.

Plan

NOTE The Plan entity category is only available in 2D views.

The initial display for 2D views is configured for modeling purposes, so by
default, it does not display all the information that will be output when
drawings are created. However, you can select the Plan entity category to
overlay one of the following planar drawing categories on the 2D view:

• General arrangement

• Beam end forces

• Foundation layout

• Loading plan

• Slab/mat layout
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You can also select the individual drawing layers to be overlaid. The Plan
category can be very useful, as it allows you to display information that would
otherwise not be available whilst modeling.

To use the Plan category, do the following:

1. Open a 2D view.

2. In Scene Content, select Plan.

3. In the list on the right side of the Plan category, you can select the
drawing category.

4. Click the arrow on the left side of the Plan category to view the different
drawing layers that you can optionally display. 

Only the layers that exist in the previously mentioned planar drawing
categories can be displayed. The most important layers are:

Name Description
General Allows you to display grids, construction lines,

and dimensions as they would appear in
drawings.

Members Allows you to display the various different
member types labeled as they would appear in
drawings.

Walls Allows you to display concrete walls labeled as
they would appear in drawings.

Slabs/Mats Allows you to display concrete slabs labeled as
they would appear in drawings.

Other Allows you to display various other items that
can be output to drawings.

NOTE It is not yet possible to overlay beam
end forces or foundation reactions on a
scene view. However, you can display
them in general arrangement drawings.

Tables Allows you to display tables of information that
can be output to drawings.

Connections Allows you to display connection names,
attributes, and reactions as they would appear in
drawings.

Beam End Forces Allows you to display beam end forces as they
would appear in drawings.

By default, the layers that are initially selected match those in the first
layer configuration for the drawing category in Model Settings -->
Drawings --> Layer Configurations.

5. Select or clear the layers according to your needs. 

TIP Layer content can be further controlled in Model Settings -->
Drawings --> Layer Configurations.
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Example

To illustrate how the Plan category would typically be used, consider the
following composite beam example designed to the AISC 360 ASD head code:

In the following floor view, the standard beam labeling for modeling is applied.
The labeling consists of the beam name, section, grade, number of connectors,
and transverse reinforcement.

When you produce drawings, additional design information would probably
also be conveyed. The information can contain, for example, the amount
beam camber required. The camber is included in one of the drawing layers,
so you can include it in the 2D scene view, as long as you know the layer it
belongs to.

To include the camber, do the following:

1. Open a 2D scene view containing the beams.

2. In Scene Content, select Plan.
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Depending on the current scene content selection, there may be a
substantial duplication of axes, members, labeling, and so on.

3. Expand the Plan category and do the following:

a. Clear the Members and Slabs/Mats options.

b. Select options according to the following images:

The scene view should now appear less cluttered, as shown in the
following image.
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4. On the Draw tab, click Settings and adjust the drawing settings as
follows:

a. Go to Options --> Planar Drawings --> General Arrangement.

b. Go to the Beams tab.

c. Ensure that the Camber option is selected.

d. Go to the Slabs/Mats tab.

e. Clear all Panel Labelling options and the Include panel span
direction symbol option.

f. Click OK.

The drawing is updated to match the new drawing options.
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How to hide, re-display and move windows
TheProperties window, the , Scene Content, and each of the Project
Workspace tabs are displayed in windows that can be resized and
repositioned, or docked to an edge of another window.

Auto-hide a window
To increase the area available for graphical display, you can choose to auto-
hide any of the windows.

• In the desired window, click  Auto Hide. 

The window immediately contracts to a tab.

• Click the window tab to expand it. 

You can only expand a window if it is docked against an edge of the main
window.

Close a window

• Click Close at the top right corner of the window.

Re-display a closed window
1. Click the Windows tab.

2. In the View group, click the window name. 

If the window is already displayed, its control is highlighted in the View
group.

Move a window
• Select the title bar of the window, and drag the window to its new location. 

If you place the selected window over an edge of the main window, or over
a divider within the main window, the window docks to that edge or
divider.

Dock a window as a tabbed page in another window
• Select the title bar of the window, and drag the window over the title bar or

the tab group of the other window.

Open a tabbed page in another window
• Select the tabbed page, and drag the page to its new location. 

The tabbed page opens in a new window.
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Dock a window using the docking control
1. Select the title bar of the window, and start dragging the window. 

The window docking control appears in the middle of the main window.

2. Drag the window over the docking control button that indicates the
desired location.

Dock a window to a tabbed page of the current window

1. Select the title bar of the window, and drag the window over the central
button of the docking control.

2. Release the left mouse button.

Keyboard shortcuts
Keyboard shortcuts in Tekla Structural Designer are described in the tables
below.

General keyboard shortcuts
Keys that perform general functions in Tekla Structural Designer are listed
below.

Key Function
F1 Displays the Tekla Structural Designer Help.
Ctrl Holding down Ctrl while selecting entities adds the new

entities to the current selection.
Esc Cancels the current command.
Ctrl F Opens the Find dialog
Ctrl O Open a file
Ctrl N Starts a new file
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Keyboard shortcuts in 2D and 3D Views
The following keys function as described below in the Structural View and
other graphical views.

Key Function
ZA Zooms to the extents of the model.
ZS Zooms to the selected entities.

NOTE Prior to using this shortcut, at least one entity
must be selected in order for the command to
zoom to it.

Z1 Zooms to 1m (3ft) area around the cursor.
Z2 Zooms to 2m (6ft) area around the cursor.
Z3 Zooms to 3m (9ft) area around the cursor.
Up/Down arrow
keys

Allows you to scroll between entities in the Select Entity
tooltip when Tekla Structural Designer has detected
multiple entities.

Ctrl Holding down Ctrl while selecting entities adds the new
entities to the current selection.

F2 Whenever you are prompted to pick a point, the Data
Entry tooltip displays the co-ordinates at the cursor
position.

Pressing F2 enables keyboard input of the exact co-
ordinates required.

Get started with Tekla Structural Designer 292 Get familiar with the user interface



Key Function
F8 Switches between displaying and hiding the ViewCube in

3D views.

Keyboard shortcuts in Properties windows
Keys that perform specific functions in any Properties window are described
below.

Key Function
Up/Down arrow
keys

Move between different properties and navigate within
combo-box drop-down lists.

Tab Tab - Enter or leave (and save) property editing mode.
Space Space - Toggle check-boxes and expand combo-boxes.
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Key Function

Enter Select and save property editing.

When a Review View is active, the following Properties window shortcuts are
also available for [A]ttibute and [M]ode.

Key Function
A Press A to cycle through attributes in the [A]ttibute list.

TIP If this doesn't work it is probably because the focus
is in the Properties window. Click the Review View
to makes it active and try again.
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Key Function
M Press M to cycle through modes in the [M]ode list.

TIP If this doesn't work it is probably because the focus
is in the Properties window. Click the Review View
to makes it active and try again.

Keyboard shortcuts in tree structures
Keys that perform specific functions in any tree structure are described below.

Key Function
Right/Left arrow
keys

Expand and collapse headings.

Keyboard shortcuts to the Quick Access Toolbar

The Quick Access Toolbar is normally displayed as below.

If you press the Alt key letters are superimposed to enable each command to
be accessed directly from the keyboard.
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Command Shortcut

New

Alt N

(or, you can also use Ctrl N)

Open

Alt O

(or, you can also use Ctrl O)

Save

Alt SA

Undo

Alt U

Redo

Alt RD

(page 2187)

Alt FI

(or, you can also use Ctrl F)

(page 2201)

Alt V

Delete

Alt DE

Keyboard shortcuts to ribbon commands
All commands on the ribbon toolbars can be accessed from the keyboard after
pressing the Alt key.

1. Press Alt then the appropriate letters (summarized in the table below) to
open the required ribbon toolbar.
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2. Press the appropriate letter(s) for the command you want to run.

Example: Press Alt HFN to open the Home toolbar and run the Find
command shown above.

Toolbar Shortcut
File Press Alt AP then the letter(s) shown against the

required command.
Home Press Alt H then the letter(s) shown against the

required command.
BIM Integration Press Alt B then the letter(s) shown against the

required command.
Model Press Alt M then the letter(s) shown against the

required command. .
Edit Press Alt E then the letter(s) shown against the

required command.
Load Press Alt LO then the letter(s) shown against the

required command.
Analyze Press Alt AN then the letter(s) shown against the

required command.
Design Press Alt DE then the letter(s) shown against the

required command.
Slab Deflection Press Alt SL then the letter(s) shown against the

required command.
Foundations Press Alt FO then the letter(s) shown against the

required command.
Report Press Alt RE then the letter(s) shown against the

required command.
Draw Press Alt DR then the letter(s) shown against the

required command.
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Toolbar Shortcut
Windows Press Alt W then the letter(s) shown against the

required command.
Loading Analysis Press Alt LA then the letter(s) shown against the

required command.
Results Press Alt RS then the letter(s) shown against the

required command.
Review Press Alt RV then the letter(s) shown against the

required command.
Review Data Press Alt RV then the letter(s) shown against the

required command.

2.6 NOTE: Steps to take if the Help Viewer appears to be
inactive
Please note that, since Help is displayed within a Tekla Structural Designer
dialog, it will become inactive when another dialog is opened.

Should this occur, the following workarounds are suggested:

• Simply close the other dialog to continue.

• Alternatively you can access Tekla Online Help (TUA) for Structural Designer
directly within any browser.

The Help can also be opened in a browser from any page by clicking the
'arrow' button at the bottom of the page as shown below:
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3 BIM integration

To simplify your work, Tekla Structural Designer allows you to both export
data to different file formats, and import files to Tekla Structural Designer.

Click the following links to find out more:

• Import a project from a Structural BIM Import file (page 301)

• Import a project from a TEL file (page 302)

• Import data from a 3D DXF file (page 308)

• Working collaboratively with Trimble Connect (page 310)

• Export a model to Tekla Structures (page 318)

• Export to Tekla Connection Designer (page 318)

• Export to Tekla Portal Frame Designer (page 319)

• Export to Tekla Tedds (page 324)

• Export a model to Autodesk Revit Structure (page 327)

• Export a model to IFC (page 328)

• Export to and import from Westok Cellbeam (page 329)

• Export to and import from FBEAM (page 330)

• Export a model to ADAPT (page 335)

• Export a model to STAAD (page 339)

• Export a model to Autodesk Robot Structural Analysis (page 340)

• Export a model to the cloud (page 341)

• Export to IDEA StatiCa Connection Design (page 344)
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3.1 Import model data
Tekla Structural Designer allows you to import model data from other
applications.

Click the following links to find out more about importing a model into Tekla
Structural Designer:

• Import a project from a Structural BIM Import file (page 301)

• Import a project from a TEL file (page 302)

• Import data from a 3D DXF file (page 308)

Import a project from a Structural BIM Import file

1. On the BIM Integration toolbar, click Structural BIM Import. 

The BIM Integration wizard opens.

2. Use the […] button to browse and select the appropriate CXL file. 

The remainder of the fields are populated with the settings read directly
from the file.

3. Click Next to continue. 

The Import Options page shows the settings related to the file, it will
indicate if this is a first time import or an update, and allows the user to
choose Metric or Imperial for the units, a design code and the default level
type. The level type can later be adjusted in the construction levels dialog
if required.

4. Click Next to continue. 

The Relocate Import Model page allows for models to be moved to
around the datum position in Tekla Structural Designer from a real world
co-ordinate. The extent of the model can be seen from the information
displayed on the right hand side of the dialog.

5. Click Next to continue. 

The Integration Filter will be displayed. The five options shown here
allow you to verify if grids, levels etc. are to be imported. Please note that
the settings held in the Delete Existing… and four Update… columns
should not be used when performing a First Time Import and are only
used when synchronizing changes into an existing Tekla Structural
Designer model.

6. Click Next to continue. 

Mapping of materials to recognised grades will be shown now. Here you
can view the different materials recognised in the incoming CXL file and
the options to alter materials with a more preferred grade.
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7. Click Next to continue (if available). 

Following on from Material mapping, the dialog for Decking mapping will
be shown (if applicable). Again this allows users to view the decking types
being imported and have the option of overwriting the details if required.

8. Click Finish 

After the file has completed processing, the model will be displayed within
the Structural 3D view and you can then proceed with validation of the
structure before applying any analytical information.

BIM fundamentals (Playlist)

Integration with Tekla Structures (Playlist)

Integration with Autodesk Revit (Playlist)

Revit-TSD Integration

Import a project from a TEL file
Before importing a project from a TEL file, you are advised to be aware of the
restrictions. Then, you can proceed to follow the detailed instructions to
perform the import.

Restrictions
When importing TEL files, note the following points:

Round tripping Does not exist in TEL file imports.

This means that the import data is
used to create new objects in the
model, not to update existing ones.
All existing objects and data are
maintained.

Data that is imported • Project summary (new models
only)

• Project name, engineer, etc.

• Support conditions

• Any associated UCS

• Spring supports, including
linear and non-linear

NOTE In S-Frame, for non-linear
spring the default is
F_max = 0. This does not
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mean that the spring has
zero capacity, but F_max
is simply ignored.

This is not the case in
Tekla Structural Designer.
In Tekla Structural
Designer, F_max =0
means the spring has zero
capacity. Hence for
models with compression-
only springs imported
from S-Frame, all
nonlinear spring supports
with F_max = 0 will need
editing, or analysis will fail.

• 1D elements

• Imported as analysis elements.
However, contiguous elements
are not merged into members
(straight or curved).

• Replicated by additional
relatively stiff 1D elements.

NOTE Automatic supports
are not created, for
example, under
columns.

• Panels - area load only

• Created as roof or wall panels
without openings

• Panels - shell: tri, quad, or mixed

• Created as meshed concrete
walls (vertical planes only) or 2-
way spanning slab items

• Material properties are
mapped manually during the
import.

• Thickness

• Panels - rigid or independent
diaphragm

• Created as 1-way spanning slab
items.
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• Material properties are
mapped manually during the
import.

• Thickness

• Panels - holes

• Created as slab or wall
openings.

NOTE The holes must be
rectangular for walls
and rectangular or
circular for slabs.
Otherwise, Tekla
Structural Designer will
generate a warning.

• Loadcases (linear only)

• Nodal loads

• Settlement loads

• 1D element loads, including
uniform temperature loads

• Area panel loads, not including
uniform temperature loads

• Combinations
Exclusions • Units: the Tekla Structural

Designer model units are not
changed to match the TEL file
units. However, values are
converted to the Tekla Structural
Designer model units.

• There is no special handling for 2D
files. 2D files are imported in the
same plane as they are defined in
S-Frame (the X-Y plane), and
default constraints are not
imported.

• Default constraints are not
imported, and no warning is
generated. Default constraints are
supports applied to all nodes
without exception internally
during analysis. Default
constraints are not displayed in
the S-Frame interface. For models
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marked as 2D, default constraints
restrict displacement to the X-Y
plane and are as follows: Fz, My
and Mz fixed. Default constraints
may be manually applied in 3D
models, and the S-Frame model
can be examined to confirm their
nature. The import does not
replicate default constraints. To
ensure equivalence, default
constraints must be applied
manually to all nodes, either in the
S-Frame model prior to import, or
in Tekla Structural Designer
subsequently.

• The import does not create any
physical members. S-Frame
physical members are treated like
any other 1D element and
imported as a single analysis
element. In particular, Tekla
Structural Designer does not
merge contiguous elements into
members (straight or curved) or
identify columns, beams, and so
on. No warnings are generated.

In addition, for S-Frame physical
models please note the following:

• Intermediate nodes that do not
form the ends of other
elements are not imported. If
such nodes have supports
applied, the model will not be
equivalent and should be
adjusted to ensure
equivalence.

• If physical members have
tapered sections, the sections
should be sub-divided in S-
Frame before importing to
Tekla Structural Designer to
produce an equivalent model.

• Alternatively, the S-Frame
model can be converted to an
analytical model in S-Frame
prior to import, using the S-
Frame command for this.
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• Staged construction data is not
imported, and no warning is
generated. Typically, the entire
model is imported, representing
the last stage in which the model
is complete. Otherwise, turn the
Staged Construction setting in S-
Frame off prior to import. This will
remove all stages but the last one,
and issue a warning to this effect.
The model is then non-staged, and
so should be valid for import.

• Although the following can be
modeled as single objects in Tekla
Structural Designer, no attempt is
made to import them as single
objects from collections of S-
Frame objects:

• Mid-pier walls

• Trusses

• Portal frames

• Inactive elements are imported as
inactive analysis elements of the
beam type.

NOTE Inactive elements are
quite likely to originate
from tension-only cross
bracing in Fastrak Building
Designer models. In this
situation, we recommend
that you click the warning
to identify the relevant
part of the model, delete
both "braces", and create
new braces using the
specific X-brace pair.

• Wall and strip integration lines are
not imported. A warning is issued
to this effect.

• Tapered sections: a 1D element is
imported. However, no tapered
section dimension data is
imported. A warning is issued to
this effect.
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• Prestress data for 1D & 2D
elements is not imported.

• Percentage fixity data for 1D
elements is not imported.

• Non-linear spring data by graph:
1D elements and supports are
imported, but the spring
stiffnesses are set to 0. A warning
is issued to this effect.

• Non-structural alignment and
offsets (cardinal point data) are
ignored, and warnings are issued
if they are non-zero.

• Panels: general diaphragms, mat
foundations, membranes and
plates are excluded, and a warning
is issued.

• Diaphragm panel node exclusions
are ignored.

• 2D elements are excluded, and a
warning is issued.

• Meshing properties for panels are
excluded without warning.

• Shear Walls: only quadrilaterals
can be created.

• Diaphragm constraints are
excluded, and a warning is issued
to this effect. Any diaphragm
constraints must be replicated in
Tekla Structural Designer to
ensure equivalence.

• Slaved nodes are excluded, and a
warning is issued.

• Lumped mass is excluded.

• Groups are excluded.

• Notional load factors: NHF and
EHF are added to combinations,
with the sign indicating positive or
negative for each direction.
However, the actual value is
ignored. The standard notional
load calculation method and
default strength factor are used.
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• Non-zero gravitational factors for
Global X & Y are excluded, and a
warning is issued.

• Thermal gradient loads for 1D and
2D elements are excluded.

• Moving loads are excluded.

• Time history loads are excluded.

• 2D elements are excluded, and a
warning is issued.

• RSA data is excluded.

Instructions
The model is imported. If there are any associated warning messages, these
can be reviewed from the BIM branch of the Status tree in the Project
Workspace.

1. On the BIM Integration tab, click 'TEL' File Import. 

The 'TEL' File Import button is not active unless you have a Tekla
Structural Designer document open.

The BIM Integration wizard opens.

2. Click ... to browse the .TEL file, and click Next.

3. If necessary, adjust the location and rotation of the import model, and
click Next.

4. Select an appropriate material type and grade for each material using the
lists.

5. Click Finish.

The model is now imported. Any associated warning messaged can be
reviewed in the BIM sub-branch of the Status tree.

Import data from a 3D DXF file
See the following paragraphs for the restrictions of 3D DXF import, and the
instructions on importing data from a 3D DXF file.

Restrictions
Note the following points when importing 3D DXF files:

• Round tripping does not exist in TEL file imports. This means that the
import data is used to create new objects in the model, not to update
existing ones. All existing objects and data are maintained.
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• Analysis elements are created from line segments in the selected layers of
the DXF file as follows:

• All lines in these layers become 1D analysis elements.

• Arcs and circles in the selected layers are excluded without a warning.

• Blocks are not handled, and no warnings are issued.

• Polylines in the selected layers are excluded without a warning.

• 3D solids in the selected layers are excluded without any warning.

• 2D faces for 3D objects in the selected layers are excluded without a
warning.

• All ends of lines in the selected layers become nodes.

• Nodes are not introduced in the intersections of crossing lines.

• The following elements are not included in the import:

• Reading of any text

• Intelligence on "through members"

• Gridlines and construction lines

• 2D elements

• Supports

• Section properties

• Materials

• Loads

• Combinations

Instructions
1. On the BIM Integration tab, click 3D DXF Import. 

The 3D DXF Import can only be selected in a 3D view.

The Open dialog opens.

2. Browse to the required .dxf file.

3. Click Open. 

The DXF Import Wizard opens.

4. Select the layers and colors that you want to import.

5. If necessary, apply offsets and rotate the model before data is imported.

6. Click OK.

Any line segments found in the selected layers are now imported as analysis
elements.
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3.2 Working collaboratively with Trimble Connect
Trimble Connect is a project collaboration tool allowing project stakeholders
access to reliable, up-to-date project information. It is available as a cloud-
based platform (Trimble Connect Web) and a Windows application (Trimble
Connect for Windows). Projects are synchronised between the Windows app
and the cloud.

NOTE To learn more about Trimble Connect, see:

• https://connect.trimble.com/

• https://trimbleconnect.support.tekla.com/

NOTE You need to have a Trimble Identity before you can start using Trimble
Connect

Trimble Connect Project Explorer is used within Tekla Structural Designer to
control the flow of information between the open model and a Trimble
Connect project.

With Trimble Connect Project Explorer you can:

• link a Tekla Structural Designer model to a Trimble Connect project

• create and rename folders in a Trimble Connect project

• view a file list and rename files in a Trimble Connect project

• upload an IFC of the model to a Trimble Connect project

• upload drawings

• upload reports

NOTE A Tekla Structural Designer model can only be linked to a Trimble Connect
project from the Trimble Connect Project Explorer and not from the web or
Windows apps. The model must be linked before any information can move
between Tekla Structural Designer and Trimble Connect.

Launch Trimble Connect Project Explorer
1. Log in using your Trimble Identity, (if not already signed in).

2. On the BIM Integration tab, click the Trimble Connect droplist.

3. Select Trimble Connect
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Trimble Connect Project Explorer opens, either as a docked window, or
as a tab on the right of the interface.

Available projects are listed with link icons as below.

TIP If the project in which you want to collaborate is not shown, try clicking
the refresh button to synchronise with the cloud. If it still not shown you
would need somebody with the appropriate permissions to create it, or
grant you access, using Trimble Connect Web, or Trimble Connect for
Windows.

TIP If a 'Cannot find linked project' message is displayed, this indicates either
that you do not have permission to view the project; or, that the project
to which the model was previously linked has been deleted - in this
situation you would need to click 'Unlink' before you are able to link the
model with another project.

Link or unlink a project
1. To link to a project:

1. Click  next to the project you want to link to. 

When the model is linked, the project name appears at the top of the
window and the icon changes as shown below.
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Any folders or files in the Trimble Connect project that you have read
access to are also displayed.

2. To unlink from a project:

2. Click  to unlink the project. 

The full list of available projects is displayed once more.

Create folders, rename folders, rename files
When you link to a Trimble Connect project the existing project folder
structure is displayed. You can add to this, if required.

NOTE You can only create but not delete folders in Trimble Connect Project
Explorer. Folders can only be deleted in Trimble Connect Web, or
Trimble Connect for Windows.

You can only rename folders and files to which you have write access.

1. To create a folder:

1. Right click in the Trimble Connect Project Explorer window.

2. Select Create folder and enter the folder name.

2. To create a subfolder:

3. Right click on an existing folder.

4. Click Create folder and enter the folder name.
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3. To rename a file or folder:

5. Right click on the file/folder.

6. Select Rename

Upload an IFC file of a model
1. Right-click on the folder where you want to create the IFC.

2. Select Upload New IFC file

3. Follow the steps in the Export to IFC wizard to create the ifc file.

a. Adjust the location and rotation of the model, and click Next

b. Specify the export names of material grades, and click Next

c. Specify the ifc file name

The ifc file will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the IFC model in
Trimble Connect.

NOTE If the model is subsequently updated, you can upload a new revision
of the ifc file. To do this, right-click on the ifc file name and select
Upload new version of IFC.

Upload a multi-member drawing
1. Open a view displaying the part of the model that you want to include in

the drawing.

2. On the Draw ribbon, click the drawing type. 

The DXF Export Preferences dialog box opens.

3. Select Upload to Trimble Connect 

NOTE The above option is only available after the model has been
linked to a Trimble Connect project.

A default drawing name for the upload is displayed.

If required, the drawing name and upload folder can be changed by
clicking […] to open the Trimble Connect File Browser.

The Create link between model member and uploaded drawing
option is not applicable to multi-member drawings, so this option cannot
be selected.
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4. Click OK 

The drawing will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the drawing in Trimble
Connect.

NOTE The Defaults button on the DXF Export Preferences dialog box can
be used to set a default file location, output target and link creation
option. The options defined here will be true for the whole model.

Upload a single member drawing
1. Highlight the member for which you want to create a drawing.

2. Right click, then from the context menu select Generate Drawing 

The DXF Export Preferences dialog box opens.

3. Select Upload to Trimble Connect 

NOTE The above option is only available after the model has been
linked to a Trimble Connect project.

A default drawing name for the upload is displayed.

If required, the drawing name and upload folder can be changed by
clicking […] to open the Trimble Connect File Browser.

4. To link the model member and drawing, click Create link between
model member and uploaded drawing. 

See the Link a drawing or report to an existing IFC topic below for more
details about this option.

5. Click OK 

The drawing will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the drawing in Trimble
Connect.

NOTE The Defaults button on the DXF Export Preferences dialog box can
be used to set a default file location, output target and link creation
option. The options defined here apply for the whole model.

Upload a model report
1. Open the required report in Tekla Structural Designer.

2. On the Report ribbon, click PDF Upload 
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NOTE Both PDF Upload and Upload Settings are only available after
the model has been linked to a Trimble Connect project. (The
latter can be used to set a default file location, output target and
link creation option that applies for the whole model.)

The Upload Report dialog box opens and a pdf name for the report is
displayed.

If required, the pdf name and upload folder can be changed by clicking
[…] to open the Trimble Connect File Browser.

The Create link between model member and uploaded report option
is not applicable to model reports, so this option cannot be selected.

3. Click OK 

The pdf will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the report in Trimble
Connect.

Upload a member report
1. Highlight the member for which you want to create a report.

2. Right click, then from the context menu select Report for Member 

The report is displayed in Tekla Structural Designer.

3. On the Report ribbon, click PDF Upload 

NOTE Both PDF Upload and Upload Settings are only available after
the model has been linked to a Trimble Connect project. (The
latter can be used to set a default file location, output target and
link creation option that applies for the whole model.)

The Upload Report dialog box opens and a pdf name for the report is
displayed.

If required, the pdf name and upload folder can be changed by clicking
[…] to open the Trimble Connect File Browser.

4. To link the model member and report, click Create link between model
member and uploaded report. 

See the Link a drawing or report to an existing IFC topic below for more
details about this option.

5. Click OK 

The pdf will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the report in Trimble
Connect.
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Link a drawing or report to an existing IFC
When drawings and reports are uploaded they are automatically linked to an
existing IFC file as long as the appropriate option is selected (Create link
between model member and uploaded report / Create link between model member
and uploaded drawing).

It is important to save the Tekla Structural Designer model after exporting the
IFC to Trimble Connect so that the link between the two is stored in the TSD
model.

Linking reports

Linking of reports occurs for member reports only. If there are 3 IFC objects
associated with one member (eg a 3 span beam) there will be a link created on
each of the 3 IFC objects.

Linking drawings

Linking of drawings occurs for member drawings only. If there are 3 IFC
objects associated with one TSD member (eg a 3 span beam) there will be a
link created on each of the 3 IFC objects.

Check linking progress in the Process Window
The progress of the linking is logged in the process window. This will show the
number of successful/unsuccessful links that have been created.

There are a few reasons why linking could be unsuccessful:

1. The member associated with the report/drawing does not exist in IFC
model

2. Connection to the Trimble Connect project is lost

3. IFC model was not successfully uploaded
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Open Trimble Connect to a model view for an IFC
1. In the Trimble Connect Project Explorer window, right-click on the IFC file

to be viewed.

2. Select Open in Trimble Connect Web, or Open in Trimble Connect for
Windows as required. 

Trimble Connect opens the linked project and displays a view of the
selected ifc.

Open Trimble Connect
1. To open Trimble Connect from the ribbon:

1. If not already signed in, click log in (at the top right of the interface).

2. On the BIM Integration tab, click the Trimble Connect droplist.

3. Select select Trimble Connect Web, or Trimble Connect for Windows as
required.

• Trimble Connect Web: This launches the in-browser web app. If the
open model is associated with a Trimble Connect project, the project
itself is opened, otherwise a default Trimble Connect page is opened.

• Trimble Connect for Window: This launches the Windows
application. Again, if the open model is associated with a Trimble
Connect project then that project is opened.

2. To open Trimble Connect from Trimble Connect Project Explorer:

4. Right-click on a folder in the Trimble Connect Project Explorer window.

5. Select Open in Trimble Connect Web, or Open in Trimble Connect for
Windows as required. 

The in-browser web or Windows app is launched and opened at the
selected folder.

3.3 Export to Trimble applications
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Click the following links to find out more about exporting to other Trimble
applications:

• Export a model to Tekla Structures (page 318)

• Export to Tekla Connection Designer (page 318)

• Export to Tekla Portal Frame Designer (page 319)

• Export to Tekla Tedds (page 324)

Export a model to Tekla Structures
To export a model to Tekla Structures, see the following instructions.

1. Create your model in the usual way.

2. On the BIM Integration tab, click Tekla Structures Export. 

The BIM Integration wizard opens.

3. On the first page, click Next.

4. Adjust the location and rotation of the model, and click Next.

5. Select the items that are included in the model, and click Next.

6. Specify the export names of material grades, and click Next.

7. Specify the file name and location.

8. Select whether the file is exported for the first time, or whether you want
to update an existing model.

9. Click Finish.

10. Start Tekla Structures and open the file to see your project.

NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 2069). This allows individual levels to be:

• only included if the level is a floor

• always included

• never included

Integration with Tekla Structures (Playlist)
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Export to Tekla Connection Designer
Before exporting connections to Tekla Connection Designer, you are advised
to be aware of the limitations and also the recommended workflows for the
different connection types.

NOTE Only valid base plate, column splice and moment connections listed in the
Project Workspace Connections (page 273) tree can be exported.

To export a single connection

NOTE Export requires a Tekla Connection Designer licence.

1. Right-click the connection in a Scene View.

2. Choose Export (connection name) to Tekla Connection Designer from the
right-click menu. 

The Tekla Connection Designer application opens to allow the selected
connection to be designed.

To export multiple connections

NOTE Export requires a Tekla Connection Designer licence.

1. Select the connections to be exported in a Scene View.

2. On the BIM Integration tab, click TCD Export. 

The Tekla Connection Designer application opens to allow the selected
connections to be designed.

To return connection data from Tekla Connection Designer
Connection data from Tekla Connection Designer can be returned to Tekla
Structural Designer as follows:

1. In Tekla Connection Designer click Connection> Return Connection to
Tekla Structural Designer 

NOTE In the current release, Moment Connection data from Tekla
Connection Designer is only partially returned. (e.g. Bolt layouts
and endplate dimensions are not returned).

Export to Tekla Portal Frame Designer
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Export to Tekla Portal Frame Designer workflow
It is important to follow the correct definition, loading and design sequence
when frames are to be transferred for design to Tekla Portal Frame Designer.

1. Define frames/loading etc inTekla Structural Designer.

2. Run Analyse All (Static).

Analysis is necessary in order for the loading to be included in the export
to Tekla Portal Frame Designer.

3. Export the frame to Tekla Portal Frame Designer to design it and check
member stability.

4. Return revised sections/grades and haunch geometry back to the Tekla
Structural Designer model.

NOTE Only section sizes, haunch dimensions and steel grades are returned to Tekla
Structural Designer. Any other changes to the model data and loading are not
returned.

How loading, restraints and supports are handled in the export

Loadcases and combinations

When you open the Loadcases dialog in Tekla Portal Frame Designer the first
four loadcases are automatically created and named as follows:

• Self Weight

• Frame Dead Load

• Frame Service Load

• Frame Imposed Load

The loading in these loadcases will be taken from Tekla Structural Designer
loadcases (providing the loadcase names have been specified exactly as per
the below table):

Tekla Structural Designer Loadcase Tekla Portal Frame Designer
Loadcase

Self weight - excluding slabs Self weight
Dead Frame Dead Load
Services Frame Service Load
Imposed Frame Imposed Load

Every other Tekla Structural Designer loadcase that applies in-plane loading to
the frame gets exported to Tekla Portal Frame Designer retaining it's original
name.
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If a particular Tekla Structural Designer loadcase does not apply any in-plane
load to the frame being exported, the loadcase is not exported and it is also
removed from the Tekla Portal Frame Designer load combinations.

If the Tekla Structural Designer model does not contain loadcases named
"Dead", "Services" or "Imposed"; the "Frame Dead Load", "Frame Service Load"
and "Frame Imposed Load" loadcases are created regardless, (defaulting to
the loading values specified in the Tekla Portal Frame Designer Preferences).
However, since these loadcases are not included in any load combinations
they will have no affect on the design.

If the Tekla Structural Designer model contains loadcases named "Dead",
"Services" or "Imposed" which do not apply any in-plane load to the frame
being exported; then in the same way as any other loadcase that does not
apply any in-plane load, the loadcase is removed from the Tekla Portal Frame
Designer load combinations. (In this situation the "Frame Dead Load", "Frame
Service Load" or "Frame Imposed Load" loadcase is still created regardless
(defaulting to the loading value specified in the Tekla Portal Frame Designer
Preferences), but once again since it does not get included in any load
combinations it will have no affect on the design.

Once loadcases that do not apply in-plane load have been removed from a
load combination, if the resulting combination is empty, or if it only contains
self weight, the combination itself is removed.

Lateral Restraints

The Tekla Structural Designer lateral restraints are exported, strut restraints
are ignored.

NOTE The below mappings assume default rotations of the rafters and
columns. (Changing the rotation by 180 degrees flips the restrained
flange in Tekla Portal Frame Designer.)

Rafter Restraints

These are exported to Tekla Portal Frame Designer restraints as follows

Tekla Structural Designer Lateral Restraint Tekla Portal Frame
Designer RestraintTop Flange Bottom Flange

X X Torsional
X - Outer
- X Inner
- - No restraint

Column Restraints

These are exported to Tekla Portal Frame Designer restraints as follows
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Tekla Structural Designer Lateral Restraint Tekla Portal Frame
Designer RestraintFace A Face C

X X Torsional
X - Outer
- X Inner
- - No restraint

NOTE The rafter top flange and column face A can be identified graphically,
for details expand the Axis systems topic and then refer to the Object
Orientation section within it.

Supports

The Fy, Fz and Mx Tekla Structural Designer support properties are used to
configure the Tekla Portal Frame Designer base fixities as follows

Tekla Structural
Designer Support

Tekla Portal Frame Designer Base Fixity

Fy Fixed Horiz. Stiffness (ULS, SLS, Stability): Restrained
Fz Fixed Vertic. Stiffness (ULS, SLS, Stability): Restrained
Mx Fixed ULS: Rot. 100%, Cap. 100%

SLS: Restrained
Stability: Restrained

Fy Free-Release Horiz. Stiffness (ULS, SLS, Stability): 0kN/m
Fz Free-Release Vertic. Stiffness (ULS, SLS, Stability): 0kN/m
Mx Free-Release ULS: Rot. Free, Cap. 1%

SLS: Free
Stability: Free

Fy Free-Spring Linear:
XkN/m

Horiz. Stiffness (ULS, SLS, Stability): XkN/m

Fz Free-Spring Linear:
XkN/m

Vertic. Stiffness (ULS, SLS, Stability): XkN/m

Mx Free-Spring Linear:
XkNm/rad

ULS: Rot. XkNm/rad, Cap. 1%
SLS: XkNm/rad
Stability: XkNm/rad

Fy Free-Spring Non
Linear:

-ve=XkN/m, +ve YkN/m

Horiz. Stiffness (ULS, SLS, Stability): Max (X, Y) kN/m

Fz Free-Spring Non
Linear:

-ve=XkN/m, +ve YkN/m

Vertic. Stiffness (ULS, SLS, Stability): Max (X, Y)
kN/m
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Tekla Structural
Designer Support

Tekla Portal Frame Designer Base Fixity

Mx Free-Spring Non
Linear:

-ve=XkNm/rad, +ve
YkNm/rad

ULS: Rot. Max (X, Y) kNm/rad,
Cap. 1%

SLS: Max (X, Y) kNm/rad
Stability: Max (X, Y) kNm/rad

Mx Free-Nominally
Pinned: 10%

ULS: Rot. Free, Cap. 1%
SLS: 20%
Stability: 10%

Mx Free-Nominally
Pinned: X%

ULS: Rot. X%, Cap. 1%
SLS: X%
Stability: X%

Mx Free-Nominally
Fixed: X%

ULS: Rot. X%, Cap. 100%
SLS: X%
Stability: X%

To export a single frame

NOTE Export requires a Tekla Portal Frame Designer licence.

1. Right-click the frame in a Scene View.

2. Choose Export (frame name) to Tekla Portal Frame Designer from the
right-click menu. 

The Tekla Portal Frame Designer application opens to allow the selected
frame to be designed.

To export multiple frames

NOTE Export requires a Tekla Portal Frame Designer licence.

1. Select the frames to be exported in a Scene View.

2. On the Home tab, click TPFD Export. 

The Tekla Portal Frame Designer application opens to allow the selected
frames to be designed.
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To return revised sections from Tekla Portal Frame Designer
If the section sizes have been revised in Tekla Portal Frame Designer they can
be returned to Tekla Structural Designer as follows:

1. In Tekla Portal Frame Designer click Portal Frame> Return sections to
model

Export to Tekla Tedds
Once they have been designed using Tekla Tedds, precast and/or timber
members can then be exported to Tedds in order to output the calculations.

NOTE Export requires a Tekla Tedds licence.

Understanding each of the export options

Command Description
Export to Tekla Tedds > Model Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member in the model.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Member This option only appears for a
highlighted member if the option to
design using groups is not active.

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing a single document for
the member.

• The data exported is taken from
the last design run (either Member
or Selection) associated with the
member.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Group This option only appears for a
highlighted member if the option to
design using groups is active.

Launches Tekla Tedds and:
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Command Description
• Creates a new Tedds Project

containing a single document for
the group.

• The data exported is taken from
the last design run (either
Member, Group, or Selection)
associated with the group.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Selection This option only appears if one or
more members are selected.

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member or group in the
selection.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds >
<Substructure name>

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member in the sub
structure.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

To export all timber and precast members
1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.

3. In the context menu, select Export using Tekla Tedds > Model 

Tekla Tedds opens to allow the calculations for the all the exported
members to be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.
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To export a single member
1. Right-click the member in a Scene View.

2. Choose Export to Tekla Tedds > Member from the right-click menu. 

Tekla Tedds opens to allow the calculations for the highlighted member to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export multiple members
1. Select the precast and/or timber members to be exported in a Scene

View.

2. Right-click and choose Export to Tekla Tedds > Selection from the
context menu. 

Tekla Tedds opens to allow the calculations for the selected members to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export a group
1. Right-click any member of the group in a Scene View.

2. Choose Export to Tekla Tedds > Group from the right-click menu. 

Tekla Tedds opens to allow the calculations for the highlighted group to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export a substructure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
export.

3. In the context menu, select Export using Tekla Tedds > <Sub structure
name> 
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Tekla Tedds opens to allow the calculations for the substructure to be
output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

3.4 Export to and import from other applications
Tekla Structural Designer allows you to import and export data to different file
formats.

Click the following links to find out more about importing to and exporting
from other applications:

• Export a model to Autodesk Revit Structure (page 327)

• Export a model to IFC (page 328)

• Export to and import from Westok Cellbeam (page 329)

• Export to and import from FBEAM (page 330)

• Export a model to ADAPT (page 335)

• Export a model to STAAD (page 339)

• Export a model to Autodesk Robot Structural Analysis (page 340)

• Export a model to the cloud (page 341)

• Export to One Click LCA (page 341)

• Export to IDEA StatiCa Connection Design (page 344)

Export a model to Autodesk Revit Structure
To export a model to Revit Structure, see the following instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click Autodesk Revit Export. 

The BIM Integration wizard opens.

3. Adjust the location and rotation of the model, and click Next.

4. Select the items that are included in the model, and click Next.

5. Specify the export names of material grades, and click Next.

6. Specify the file name and location.

7. Select whether the file is exported for the first time, or whether you want
to update an existing model.
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8. Click Finish.

NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 2069). This allows individual levels to be:

• only included if the level is a floor

• always included

• never included

NOTE To open the exported file in Revit, you will need to have installed the
Tekla Structural Designer Integrator for Autodesk Revit. This is
available for download from the following link: https://
download.tekla.com/tekla-structural-designer/for-businesses/all-
downloads?field_package_reference_tid_selective=5713

Integration with Autodesk Revit (Playlist)

Revit-TSD Integration

Export a model to IFC
To export your model to IFC, see the following instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click IFC Export. 

The BIM Integration wizard opens at the Relocate Export Model page.

The Relocate Export Model page allows for models to be moved from
the datum position in Tekla Structural Designer to a real world co-
ordinate.

3. Move and rotate the export model if required, and click Next.

4. On the Integration Filter page, select the items that are included in the
export model, and click Next.

5. On the IFC Export File page, select whether the file is exported for the
first time, or whether you want to update an existing model. Then specify
the file format, name and location.

6. Click Finish.

NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 2069). This allows individual levels to be:

• only included if the level is a floor
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• always included

• never included

Export to and import from Westok Cellbeam
To export and import beams to and from Westok Cellbeam, see the following
restrictions and instructions.

RESTRICTION Cellbeam import and export are only available for BS and
Eurocode head codes.

Export to Cellbeam
1. On the BIM Integration tab, click Cellbeam Export. 

The Export Westok Beams dialog box opens. Any Westok Cellular beams
in the model are listed in the dialog.

2. Select the beams that you want to transfer to Westok Cellbeam, and click
Next.

3. Select the export format and name the file.

4. Click Next.

5. Ensure that you have selected the design combinations whose results you
want to use in the Westok beam design.

6. Click Next.

7. Select the folder where you want to place the Westok files, and click
Export.

8. Click Finish.

Import from Cellbeam

NOTE In order to import Westok beams into your model, you must have
previously created the beams in your Tekla Structural Designer model,
and have exported them to Westok design. When you do this, each
beam is given a unique identifier. This means that when you import
the results from the Westok file, Tekla Structural Designer knows to
which beam in your model the imported details apply.

1. On the BIM Integration tab, click Cellbeam Import. 

The Import Westok Beams dialog box opens.

2. Click Add...
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3. Select the files that you want to import.

4. If necessary, change the file names.

5. Click Open.

6. Click Import. 

Provided that Tekla Structural Designer recognizes the identifier, the
details in the files are imported to the associated beam in your model.

Export to and import from FBEAM
To export to and import from FBEAM, see the following instructions.

TIP Create substructures for your FABSEC® beams to make it easier to
review and manage the FBEAM workflow.

Overview
FBEAM is software from Fabsec for the design of composite and non-
composite plain and cellular beams.

The workflow for taking FABSEC® beams from a Tekla Structural Designer
model and designing then within FBEAM is as follows:

• Select the FABSEC® beams in your Tekla Structural Designer model and
click FBEAM Export.

This generates an XML file containing all the required properties required
for each member.

• You can then launch FBEAM and open the project you wish to import the
beams into.

• You then click the import button which starts FBEAM's import work flow.
This will allow you to load the previously created XML file and select a
subset or all of the beams in the file to import.

Once the process is complete FBEAM will have created all of the members
and their associated properties.

• You can then design the FABSEC® beams and specify fire protection
coatings.

• Once complete, click the export button in FBEAM.

This generates another XML file that can be imported back into Tekla
Structural Designer.

• In Tekla Structural Designer, (with the model that was used to export the
beams open), click the FBEAM Import to start the import workflow. This
will then update each of the previously exported FABSEC® beams with the
properties contained within the FBEAM generated XML file.
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The above workflow can be summarized as follows:

Limitations
This following limitations apply to the import/export of FABSEC® beams:

1. Consider the case where multiple combinations are exported and a
loadcase of a particular load type e.g Dead appears in one combination
but not all. In FBEAM the analysis will include all loadcases of the same
type in each combination. This can overestimate the load significantly.
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2. When Wind loadcases are exported to the 'Additional Load Set' for a
particular beam, Tekla Structural Designer searches for the Wind loadcase
that has the largest positive end force and exports that value to the
'Additional Load Set' and gives it a 'Type', 'Wind' in FBEAM. Similarly for the
maximum negative value in Tekla Structural Designer to the 'Type', 'Wind
Up' in FBEAM. This loadcase will be used in the design of that beam for all
positive wind combinations and all negative wind combinations
respectively. Whether a wind combination is considered negative is
determined from the start and end values of the distributed (Wind) load
applied to that beam (or point loads). If both are negative then the wind
combination is negative (uplift).

3. The special loadcase in Tekla Structural Designer 'Self weight - excluding
slabs' (i.e. beam self weight) is assumed always to be included in design
combinations. Consequently, the setting in FBEAM, 'Include the beam self
weight' is always switched on.

4. In any combination if any load type e.g. Dead or Imposed appears more
than once with different load factors, only one value of load factor is
exported. This situation is unusual but might occur for imposed loads for
example when different psi factors might apply.

5. Any load types or direction not supported by FBEAM are not passed
through. This includes minor axis loading, axial loading, trapezoidal loads
and torsion.

6. Imposed loads are typically entered into the 'protected' Construction
Stage load combination in Tekla Structural Designer to represent live
loads during construction e.g. due to 'heaping'. These are exported to
FBEAM as Load Type 'CL'. They are given a load factor that will be the
maximum from all imposed loadcases included in the Construction Stage
combination although typically only one is included and with a load factor
of 1.5.

7. Beam self weight loads are typically entered into the 'protected'
Construction Stage load combination in Tekla Structural Designer.
Normally these would be represented by the Load Type ' D' in FBEAM.
However, in order to avoid taking into account all of the dead loads,
including those at composite stage, the Construction Stage load
combination in FBEAM is populated with the beam self weight as a
'cladding' load, 'C'.

8. The Slab Wet loads exported from Tekla Structural Designer should set
the 'Construction Stage Floor type' in FBEAM to 'CL' - typically this will
ensure that a load factor of 1.5 is used in the design combination for
Construction Stage. For EC this is correct but for BS it should be set to 'D'.
This setting is not accessible to the export from Tekla Structural Designer
and so must be changed manually if BS 5950 design is to be used.

9. For composite beams when the wet weight of the concrete is included in
the Construction Stage combination in Tekla Structural Designer, the
results in FBEAM will only be correct in the following circumstances:

BIM integration 332 Export to and import from other applications



a. Automatic Loading is checked on in the loadcase dialogue when Slab
Dry is selected as the load Type,

b. Automatic Loading is checked on in the loadcase dialogue when Slab
Wet is selected as the load Type,

c. At least on combination includes the Slab Dry loadcase,

d. The Construction Stage combination includes the Slab Wet loadcase.

10. Beams can be rotated in Tekla Structural Designer but in FBEAM are
always assumed to have their web vertical i.e. unrotated. Consequently
any beam rotation is not passed through from Tekla Structural Designer
to FBEAM and any loads in the global axis system that are applied to a
rotated beam are passed through to FBEAM as if they are applied through
the vertical web of the beam.

11. When several beams on the same floor are exported from Tekla Structural
Designer there can be several instance of 'Floor' in FBEAM. Each of these
could be assigned a different size of 'Mesh'. However, only one of these
will be imported into Tekla Structural Designer. It is recommended that
either only one value of mesh is set for these beams or that any required
changes to the slab mesh are made in Tekla Structural Designer and not
FBEAM.

12. In composite design, transverse reinforcement whether in the slab or as
part of the beam data is exported and imported as an area only. In Tekla
Structural Designer the area is derived from the bar size and spacing (or
mesh size). In the case of bars, the export transfers the area and in FBEAM
the default bar size will be shown with the exported area. For import the
area in FBEAM is processed by Tekla Structural Designer to find a bar size
and spacing that has an area greater than (or equal to) the area held in
FBEAM. Furthermore when 'loose bars' are used in the slab (unusual)
these are added to any from the beam data and transferred as one value
to FBEAM. Clearly on import these cannot be separated. This approach
has an impact on round tripping that the user must be aware of and make
appropriate adjustments post import or export.

13. Partial length shear connector layout with empty segments cannot be
created in Tekla Structural Designer. If cases like these are detected when
importing from FBEAM the partial shear connector layout will be extended
for the full length of the beam in Tekla Structural Designer.

14. Web opening stiffeners applied only to one side of a beam are always set
to the right hand side when importing into FBEAM. When importing from
FBEAM to Tekla Structural Designer, the existing stiffeners in Tekla
Structural Designer keep their side regardless of how they were modeled
in FBEAM.
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Export to FBEAM
Before exporting your FABSEC® beams, you should ensure the analysis has
been performed.

1. On the BIM Integration tab, click FBEAM Export. 

The FBEAM Export dialog box opens. Any FABSEC® beams in the model
are listed in the dialog.

2. Select the beams that you want to transfer to FBEAM, and click Next.

3. Select the combinations you want the beams designed for, and click Next.

4. Select the location to save to, name the file, and click Next. 

The export status of the selected beams is displayed.

5. Click Finish.

You can now go in to FBEAM and import the file that you have just created into
an existing or new project, so that the beams can be designed.

Import from FBEAM

NOTE In order to import FABSEC® beams, you must have previously created
them in your Tekla Structural Designer model, and have exported
them to FBEAM. When you do this, each beam is given a unique
identifier. After the beams have been designed in FBEAM you must
then choose the Tekla Structural Designer XML option to export them
to a file. This enables Tekla Structural Designer to know to which
beam in your model the imported details apply.

1. On the BIM Integration tab, click FBEAM Import. 

The FBEAM Import dialog box opens. Any FABSEC® beams in the model
are listed in the dialog.

2. Select the file that you want to import.

3. Click Next 

A list of the FABSEC® beams in the file is displayed from which you can
choose the beams to be imported.

4. Select the beams that you want to import. 

You can only select beams to import that correspond to existing beams in
the Tekla Structural Designer model.

5. Click Next 

The import status of the selected beams is displayed. If any errors have
occurred, hovering the cursor over the error displays the reason in a
tooltip.
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6. Click Finish. 

Provided that Tekla Structural Designer recognizes the beams, the details
in the file are imported to the associated beam properties, (including in
particular the beam UDA properties) in your model.

Review the imported beams
When FABSEC® beams are imported, User Defined Attributes are added to the
beam properties to record import status and fire design details. These can be
reviewed graphically.

To review the FABSEC® beam UDAs graphically:

1. If necessary, change the view regime (page 280) to a Review View.

2. On the Review tab, click UDA.

3. In the Properties window, with [M]ode set as Review, change the
Attribute to Import Status. 

Each FABSEC® beam is color-coded to represent the import status that
applies.

Export a model to ADAPT
Before exporting to ADAPT, read the following limitations. Then, you can
proceed to follow the detailed instructions to perform the export.

Limitations
The scope of the ADAPT Export is constrained by the fact that some
geometries, configurations and properties possible in Tekla Structural
Designer are beyond the scope of ADAPT. This imposes some unavoidable
limitations on the Export at this time, for example:

• Only concrete and steel materials are exported.

• Only horizontal beams and slabs are exported.

• Roof and wall panels are not supported.

• For concrete walls, the following are not supported (all of which may be in
a Tekla Structural Designer); wall openings, non-rectangular walls, wall
extension, walls with top ends not at a level.

NOTE Both loads as well as reactions are linked to their reference member/
object in Tekla Structural Designer. This means that any loads or
reactions applied to a member that are beyond scope of the export
will not be exported either.
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Details of what gets exported and what is beyond scope are as follows:

Units • Units are SI in the export file
Levels • Number of levels Included

• Level height Included
Gridlines • Beyond scope (Adapt import)
Materials • Concrete: Normal weight Included

• Structural Steel Included

• Concrete: Lightweight Beyond
scope (Adapt import)

• Mild Steel (Rebar) Beyond Scope
(Tekla Structural Designer export)

• Timber Beyond Scope (Tekla
Structural Designer export)

• Prestressing Beyond Scope (Tekla
Structural Designer export)

• Other / generic Beyond Scope
(Tekla Structural Designer export)

Load combinations • All active combinations are
included apart from Seismic
Inertia which is beyond scope

Loadcases • All loadcases are included apart
from EHF/NHF which is beyond
scope

Beams • Regular and irregular sections are
Included

• Beam at level Included

• Export by span Included

• Horizontal offsets Included

• Vertical offsets Included

• Tekla Structural Designer Labelling
Included

• Beam not at level Beyond Scope
(Tekla Structural Designer export)

• End trimming at column interface
Beyond Scope (Tekla Structural
Designer export)

• Sloping beams Beyond scope
(Adapt import)
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• Axially rotated beams Beyond
scope (Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Columns • Regular and irregular sections are
Included

• Export by stack Included

• Axially rotated columns Included

• Tekla Structural Designer labeling
Included

• Tilted columns Included

• Multi-stack columns Included

• Columns with holes Beyond scope
(Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Walls • Concrete meshed walls Included

• Concrete mid-pier walls Included

• Export by stack Included

• Tekla Structural Designer labeling
Included

• No internal wall members
Included

• Multi-stack walls Included

• Bearing walls Included (exc.
reactions)

• Wall alignments Included

• Slopping walls Beyond scope
(Adapt import)

• Wall openings Beyond scope
(Adapt import)

• Wall extensions Beyond Scope
(Tekla Structural Designer export)

• Non-rectangular walls Beyond
scope (Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Slabs • Concrete slab on beams Included
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• Concrete flat slabs Included

• Export by panel Included

• Tekla Structural Designer labeling
Included

• Vertical offsets Included

• Slab overhangs Included

• Non-concrete slabs Beyond Scope
(Tekla Structural Designer export)

• Slopping slabs Beyond scope
(Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Drop panels • Concrete slab drops Included

• Trimming at slab edges Included

• Reinforcement Beyond scope
(Adapt import)

Openings • Slab rectangular openings
Included

• Slab circular openings Included
Braces • Beyond Scope (Tekla Structural

Designer Export)
Loading • Self weight Included

• User applied Force Included

• User applied Moment Included

• Level Point loads Included

• Horizontal Line loads Included

• Level area loads Included

• Offsets from reference level
Beyond scope (Adapt import)

• Line and Area Loads applied to
horizontal plane Beyond scope
(Adapt import)

• Vertical line loads applied as point
loads at levels

Releases • Translational releases Beyond
Scope (Tekla Structural Designer
Export)
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• Torsional releases Beyond Scope
(Tekla Structural Designer Export)

Stiffness modifiers • Beyond Scope (Tekla Structural
Designer Export)

Instructions

1. On the BIM Integration toolbar, click ADAPT Export. 

This shows a dialog which gives the name of the ADAPT import file which
Tekla Structural Designer will create. You can change the name and
location of the file if necessary.

2. Once the file details are correct click Save to create the ADAPT import file.

3. Launch ADAPT and import the file to see your project.

Export a model to STAAD
To export a model to STAAD, see the following limitations and instructions.

Limitations

The scope of the STAAD Export is constrained by the limitations of the STAAD
Text File (.std) format.

Note that:

• Elastic extensions cannot be defined in STAAD. Therefore, additional 1D
elements are created to preserve model connectivity.

• The exported file will not group elements in any way. 1D elements will not
be grouped as members (or columns, beams, etc). In addition, there will
not be any grouping of faceted elements from a curved member. 2D
elements will not be grouped into panels.

• Section data is exported as analysis properties only. This means that no
attempt is made to reference STAAD library sections.

• Material data is exported as analysis properties only. This means that no
attempt is made to reference STAAD library materials.

• Objects such as Shear Only Walls have no equivalent native object in
STAAD and some of the internal data such as panel geometry and spring
properties end up lost during conversion.

Instructions

1. Create the model as usual.

2. On the BIM Integration tab, click STAAD Export. 

The Save As dialog opens.

3. If necessary, change the name and location of the file.
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4. Click Save.

5. Start STAAD and open the file.

Export a model to Autodesk Robot Structural Analysis
Before you export a Tekla Structural Designer model to Autodesk Robot
Structural Analysis, read the limitations of Robot Export in the following
paragraphs. Once you have read the limitations, you can proceed to the
detailed instructions on how to export models from Tekla Structural Designer
to Autodesk Robot Structural Analysis.

Limitations

The scope of the Robot Export is constrained by the limitations of the Robot
Text File (STR) Format.

Note that:

• The model exported is the one used for 1st order linear static analysis (see
<Linear analysis of structures containing material non-linearity> to remove
non-linearity from the exported model.)

• 1D element springs are totally omitted from the export.

• Elastic extensions cannot be defined in Robot. Therefore, additional 1D
elements are created to preserve model connectivity.

• The exported file will not group elements in any way. 1D elements will not
be grouped as members (or columns, beams, etc). In addition, there will
not be any grouping of faceted elements from a curved member. 2D
elements will not be grouped into panels.

• Section data is exported as analysis properties only. This means that no
attempt is made to reference Robot library sections.

• Material data is exported as analysis properties only. This means that no
attempt is made to reference Robot library materials.

• Loads in projection are converted to equivalent loads in Robot.

• Robot will not import the material properties for timber from the STR file.
When the file is opened in Robot, you can delete the G value and adjust the
values manually after import.

• It is not possible to define part-length distributed torsional loads in the STR
file. Therefore, they are converted to equivalent full-length distributed
torsional loads.

Instructions

1. Create the model as usual.

2. On the BIM Integration tab, click Robot Export. 

The Save As dialog opens.
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3. If necessary, change the name and location of the file.

4. Click Save.

5. Start Robot and open the file.

Export a model to the cloud
To export a Tekla Structural Designer model to the cloud, see the following
instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click Cloud Export. 

The Save As dialog opens.

3. If necessary, change the file name and location.

4. Click Save.

Export to One Click LCA

One Click LCA is third party software for performing a life cycle
assessment of your structure and optimizing its embodied carbon.

From Tekla Structural Designer you can either compile an offline report, which
is a compact summary of materials in the structure that can be edited if
required before being manually imported into One Click LCA, or you can
upload the report data directly to One Click LCA online.

Overview

Scope

Tekla Structural Designer includes material information in tabular data tables,
in general the scope of the exported data matches this. This gives a lot of the
most commonly requested material quantity information, but is not
considered to be exhaustive:

• Data available in Tekla Structural Designer but not exported

• Shear studs on composite beams

• Data NOT available in Tekla Structural Designer (and therefore not
exported)

• Reinforcement in any slab other than cast-in-place reinforced concrete
slabs

• Bearing Walls
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• Shear Only Walls

• Transverse shear reinforcement required by composite beams

• surface area of timber members, cold rolled members, general material
members

• DELTABEAM® mass - a zero value is exported to help ensure allowance
is added manually

• analysis elements

• Exported Data not otherwise available in Tekla Structural Designer

• Precast slab screed/topping area

• Composite slab decking type / area

• material in gable and parapet posts

• surface area of defined “roof panels” and “wall panels”

The above summary is not guaranteed to be exhaustive, it is important to
consider “what is missing”? Are all the significant physical items you defined in
Tekla Structural Designer being covered by the export?

Additional information

The following notes may assist with initial use of the export:

• Grouping in One Click LCA

On import there is a phase where it is suggested that lots of the exported
data items can be grouped together on the basis of a shared
“IFCMATERIAL”. The sections below give examples where you may consider
the value of doing this:

• composite / non-composite beams

the mass of these beam types are exported separately.

you may wish to apply higher carbon factors to composite beams to
allow for shear studs and transverse shear reinforcement.

• steel beams of all different fabrication types

the mass of steel members of different fabrication types are exported
separately.

e.g. rolled, plated, Westok, FABSEC®, DELTABEAM®

you may wish to apply different carbon factors to these different types
of member

• surface areas

the surface areas of slabs and many beams are all exported separately.

if you have no requirement to use any surface area information then it
will be easier to leave these grouped for simpler deletion.
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• Slabs

• The data for each slab is exported separately (a slab may contain many
slab-items).

In simple situations this will mean one group of data for each level, but
if multiple slabs are defined in a level you will get separate data for
each.

• Data for different types of slab is also kept separate

e.g. Cast-in-place reinforced slabs, post-tensioned slabs, precast slabs,
composite slabs, various other general material slabs

For reinforced concrete slabs this allows a more detailed understanding
of reinforcement per slab.

• Limitation - as noted above reinforcement data is not available/
exported for other slab types, this will need to be allowed for in one of
two ways:

• Use the surface area information to add an allowance per m2

• Adjust the carbon factor or concrete/topping in the slabs to allow for
reinforcement content

In either case this will mean avoiding grouping of the relevant data
items.

• “roof panels” and “wall panels” surface areas

• Roof and wall surface area data is included in case it assists with the
inclusion of cladding materials.

Feedback

• Please send us feedback if you feel that:

• Important data is missing

• Included data should be totalled/presented differently - perhaps there
should be options to do things in different ways (possibly at different
stages of design?)

• There should be options to filter out certain data types because you
don’t always want to use them (for example surface area info)

Show report

1. On the BIM Integration tab, click One Click LCA. 

The One Click LCAReport dialog opens.

2. Click Show report The report opens in Excel, (or whatever software is
associated with .xlsx files).
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The resulting materials file can then be edited if required before being
manually imported into One Click LCA, or it can be passed on to a third party
and imported into One Click LCA.

Show online results

NOTE Online export requires a One Click LCA license.

1. On the BIM Integration tab, click One Click LCA. 

The One Click LCAReport dialog opens.

2. Enter your One Click LCA user name and password, then click Log in.

3. Click Show online results. The material data from the Tekla Structural
Designer model is uploaded to One Click LCA.

4. Proceed through the One Click LCA wizard:

a. Create/Choose project

b. Consider groupings

c. Review / apply mapping

On completion the amount of embodied carbon in the model is
determined.

Export to IDEA StatiCa Connection Design
Before exporting connections to IDEA StatiCa, you are advised to be aware of
the limitations. Then, you can proceed to follow the detailed instructions to
perform the export.

NOTE Only valid connections listed in the Project Workspace Connections (page 273)
tree can be exported.

Limitations

NOTE The link is compatible with the latest versions of IDEA StatiCa 9.1 and 10.0; it is
also compatible with IDEA StatiCa 10.1 (build 10.1.113), but may not work with
earlier builds of 10.1.

The following geometrical limitations should be noted.

• Connection checks to BS 5950 are not supported.

• For connections identified as ‘Moment Connections’ using Update
connections in Tekla Structural Designer any out of plane members are not
exported.
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• For any connections identified in Tekla Structural Designer the brace
members are not passed through to IDEA.

• For any connection type, haunches are not exported.

• Tekla Structural Designer uses ToS and the wire model is at this level too.
The export to IDEA depicts the ToS so that the 3D graphic looks correct.
However, the wire model typically connects at offsets of half the beam
depth. This introduces additional forces/moments due to eccentricity of
line of action etc. This line of action of the force set can be adjusted in IDEA.

Instructions for the export to IDEA StatiCa

NOTE Export requires an IDEA StatiCa licence.

1. Right-click the connection in a Scene View.

2. Choose Export Connection to IDEA StatiCa from the right-click menu,
selecting the analysis results to use at the same time.

3. Specify the file name and location for this connection. 

The IDEA StatiCa application opens to allow the connection to be
designed, the following data having been transferred:

• Connection geometry

• Section profile & material grade

• Connection forces for each active solved Tekla Structural Designer
combination.

NOTE The Tekla Structural Designer model remains frozen until you
close the IDEA StatiCa connection.

4. Add bolts, stiffeners etc as required and design the connection.

When you close the connection Tekla Structural Designer becomes active once
more; the connection file is automatically embedded in the model.

Review of IDEA connections designed in Tekla Structural Designer
1. Within Tekla Structural Designer click Review>UDA

2. In the Properties Window set Mode to Review and Attribute to IDEA
StatiCa file 

Joints associated with IDEA StatiCa are shown

3. Use the right-click context menu to open previously exported connections
back to IDEA StatiCa.
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Related video

Integration with IDEA StatiCa Connection design

BIM integration 346 Export to and import from other applications



4 Create models

To get started with modeling in Tekla Structural Designer see:

• Get to know Tekla Structural Designer basic working methods (page 347),
for a few first principles

• Create the model (page 366), to learn how to create and modify model
objects

Once you are comfortable creating objects, see:

• Edit the model (page 494), to get familiar with the model editing commands

• Check the model (page 512), for validation and measuring commands

• BIM integration (page 300), to learn how to exchange model data between
applications

See also

Create and design foundations (page 836)

BIM integration (page 300)

4.1 Get to know Tekla Structural Designer basic working
methods
Before creating real models, get to know some basic methods and techniques
that will help you to work efficiently.

We recommend you familiarize yourself with how to:

• work with grids and construction lines (page 380)

• define construction levels (page 367)

• zoom and rotate (page 348) the model

• create (page 366), select (page 350) and edit the properties of (page 360)
entities
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• re-position entities (page 361) by moving nodes or edges

• copy, move and mirror (page 494) part of, or all of the model

Zoom, pan, rotate and walk through the model
You can use the mouse to manually zoom, pan, or rotate the model.
Additionally, you can rotate the model by using the ViewCube, and walk
through your model in 3D views.

Zoom in and out, or zoom extents
• According to your needs, do one of the following:

To Do this
Zoom in or out • Scroll in or out with the middle mouse

button.

Zoom to the center of the visible objects • Right-click anywhere within the view.

• In the context menu, select Zoom Out.

NOTE You can also use the keyboard shorcut
ZA to zoom extents.

Pan the view
• Hold down the middle mouse button and drag the view according to your

needs.

Rotate the view manually
You can use the ViewCube to adjust the view. However, if none of the
standard ViewCube are appropriate, you can also rotate the model manually.

• Hold down the right mouse button and drag the view according to your
needs.

Adjust the view with the ViewCube
1. Move the mouse pointer over the ViewCube.

2. According to your needs, do one of the following:

To Do this
Display one of the eight isometric views • Click the required vertex on the ViewCube.
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TIP If the required vertex is not visible, click
one of the other vertices to spin the
ViewCube until you can see the required
vertex.

Display one of the twelve edge views • Click the required edge on the ViewCube.

TIP If the required edge is not visible, spin the
ViewCube by clicking the vertex that is
adjacent to the required edge.

Display one of the six face views • Click the required face on the ViewCube.

TIP If the required face is not visible, spin the
ViewCube by clicking the vertex adjacent
to the required face.

NOTE When a face view is displayed, the
additional ViewCube controls appear:

• If the required face is not visible in
a face view, roll the ViewCube by
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clicking one of the triangular
controls.

Walk through the model in a 3D view

• On the Home tab, click Walk. 

NOTE In the Walk mode:

• To move forward, backward, left or right, use the arrow keys.

• To move up and down, use the Q and Z keys.

• To rotate the view, hold down the right mouse button and drag
the view.

• To exit Walk mode, press Esc.

Display a 2D view in 3D
1. In a 2D view, click the 2D/3D toggle button, located on the bottom right

corner of the window.

Select entities
Many Tekla Structural Designer commands require you to make selections.
You can make single and area selections from any 2D or 3D view. You can also
make selections from the Project Workspace.

TIP Use (page 255) to display everything not in the selection as ghosted, this makes it
easier to focus on the selection.

TIP If planar objects, such as slabs, roofs and area loads, obscure what you want to
select, you can hide them using the (page 259) window.

Use the different methods listed below to select the entities.

Select single entities
1. In a 2D or 3D view, move the mouse pointer over the desired entity. 

If the entity is the only one at the location, it becomes highlighted and its
name is shown in the Select Entity tooltip.

If several entities are located at the same location, their names are all
listed in the Select Entity tooltip.
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Use the up and down keys to scroll through the list to reach the desired
entity.

2. When the desired entity is highlighted in the Select Entity tooltip, press
Enter to select it.

The selected entity is then displayed in the active selection color, the nodes
for positioning it are exposed, and the entity properties are displayed in
the Properties window.

Select multiple entities using area selection
1. You can select multiple objects using area selection. The dragging

direction affects the selection of objects.

a. To select all entities that are completely within a rectangular area,
hold down the left mouse button and drag the mouse from left to
right.
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b. To select all entities that are at least partly within a rectangular area,
hold down the left mouse button and drag the mouse from right to
left.

c. To select all objects that are at least partly crossed by a straight line,
hold down the shift key, then hold down the left mouse button and
drag the mouse to draw the line.

After selection, one entity type is displayed in the active selection color and
has its properties shown in the Properties window.

Any other entity types in the selection are displayed in the local selection
color.
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NOTE You can change the active and local selection colors by clicking
Home > Settings > Scene > Colors > Selection.

2. To display the properties of another entity type in the selection, choose it
from the droplist at the top of the Properties window.

 

NOTE If there is only a single item in the active selection, all its
properties are shown; if there are multiple items in the active
selection, only common properties are shown.

Select using Find
1. Click Find on either the Home tab, or the Quick Access toolbar. 

The Find dialog opens.

2. In the Find box type any of the following, in whole, or in part:

a. An object 'Type'

b. An object 'Name'

c. An object 'Index'

As you type, any objects that match the criteria are listed in the table
below.
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3. When the object(s) that you require are shown, click to highlight them as
follows:

a. Single click to highlight a single object

b. Ctrl+click to select multiple non-sequential rows

c. Shift+click to select multiple sequential rows Once the object(s) are
highlighted, Select becomes available.

4. Click Select to locate the object in the active view, zoom in, and display its
properties in the Properties window. 

NOTE If the object doesn't exist in the active view a new view containing
the object will become active.

TIP Sometimes when clicking Select the object being located is
obscured from view by other objects. By leaving (page 255) checked
this is avoided, as all objects other than those being found are made
semi-transparent.

NOTE If not using Ghost Unselected, you can change the color used to
highlight the found entity by clicking Home > Settings > Scene >
Colors > Selection and changing the Global - User color.

Select from the Project Workspace

1. Do one of the following:

To Do this
Select individual members from the Structure
tree

a. Expand the Members branch and any
appropriate sub branches until you can
click the required member.

b. Right-click the member name.

c. In the context menu, select Select in
visible views.

The member's properties are viewed in the
Properties window.

Select member groups or individual members
from the Groups tree

a. Expand the appropriate branches until you
can click the required group or member
name.

b. Right-click the member or group name.

c. In the context menu, select Select in
visible views.

The member's or group's properties are viewed
in the Properties window.
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Select nodes
Sometimes you need to select only the nodes of an entity, for example when
moving a beam.

1. In a 2D or 3D view, select the entity. 

The entity is selected and any nodes associated with the entity are
displayed.

2. Move the mouse pointer over the desired node. 

The node becomes highlighted and appears in the Select Entity tooltip.

3. Press Enter. 

You will now be prompted to pick a point to move the node to.

4. Click at a new location to reposition the node. 
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The entity is updated accordingly.

See also: Re-position entities by moving nodes or edges (page 361)

Modify the selection
You can add or remove entities from the current selection.

1. Do one of the following:

To Do this
Add an entity to the current selection a. Hold down the Ctrl key.

b. Click the entity that you want to add to the
selection.

The properties of the newly selected entity
are added to the Properties window.

Remove an entity from the current selection • Click the entity you want to de-select.

The entity's properties are removed from
the Properties window.

Remove multiple entities a. Do one of the following:

• To de-select only the entities that are
encompassed by the box, move the
mouse pointer to the left corner of the
imaginary box that will encompass the
entities.

• To de-select the entities that are
encompassed by the box and that it
crosses, move the mouse pointer to
the right corner of the imaginary box
that will encompass the entities.

b. Hold down the Ctrl key and drag the
mouse pointer to the opposite corner of
the box.

A rectangle on the screen shows the area
that you are selecting.

c. Release the mouse button and the Ctrl
key.

The entities are removed from the
Properties window.

Remove a beam/column/wall and simultaneously
remove its constituent spans/stacks/panels

If a continuous beam and its constituent spans
are selected, they can all be deselected with a
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single mouse-click while holding down the Ctrl
key.

The same method can be applied to a continuous
column and its constituent stacks, or a wall and
its constituent panels.

Remove all entities • Press Esc.

The information displayed in the Properties
window is cleared.

Use Ghost Unselected to focus on the selection

You can toggle Ghost Unselected on and off using the  button in the
bottom corner of the view.

• Ghost Unselected off: selected entities are displayed in the active selection
color, this can make it hard to distinguish between individual entities in the
selection.

• Ghost Unselected on: selected entities are displayed in their nomal colors
(appropriate to the Scene View that is active), unselected objects are semi-
transparent. If nothing is selected, everything is displayed in its normal
color.

• In a Structure View, the selection would be displayed as:

Create models 357 Get to know Tekla Structural Designer basic
working methods



• In a Review View showing Design Status, the selection would be
displayed as:
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Select a section in the Select Section dialog box
Select Section dialog box allows you to select sections to use them in your
model. You can also add and delete user-defined sections in the database by
using the dialog, if necessary.

To access the Select Section dialog box:

1. On the Model tab, select the member you want to design.

2. In the , click the arrow on the right side of the Section field.

3. Click <New\Edit...>.

The Select Section dialog box opens.

1. Country list

2. Geometry filter

3. Page pane

4. Selected section

5. Section filter

6. Item pane

7. Details pane

1. In the Country list, select the desired country.

2. In the Page pane on the left, select the desired geometry. 
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NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

3. In the Item pane on the right, select the desired section size.

4. Click Select.

Edit entity properties
Any selection of one or more entities can be edited using the Properties
window. Individual model objects can also have their properties edited using
the Properties dialog box.

Edit properties using the Properties window
All entities can have their properties edited using the Properties window

1. Select the entity either in the graphical display or in the Structure tree. 

For more information, see Selection methods (page 350).

2. In the Properties window, modify the properties according to your needs.

Edit properties using the Properties dialog box
Individual model objects can have their properties edited using the
Properties dialog box

1. Hover the mouse pointer over the object that you want to edit.

2. In the Select Entity tooltip, select the object. 

For more information, see Selection methods (page 350).

3. Right-click the object.

4. In the context menu, select Edit. 

The Properties dialog box opens.

5. Modify the properties according to your needs.

6. Click OK.
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Edit properties of multiple entities

NOTE You can view and modify the common properties of multiple entities
in the Properties window.

Note that:

• If the value of a certain item is not identical for all the selected
entities, the cell appears blank in the Properties window.

• If you modify the blank cell, Tekla Structural Designer applies the
new setting to all the selected entities.

• If you have selected multiple entities of different types, the
property information is displayed separately for each type. Use the
list at the top of the Properties window for moving between types.

1. Select the entities in the graphical display. 

For more information, see Selection methods (page 350).

2. If you have selected entities of different types, select the desired type in
the list on top of the Properties window.

3. In the Properties window, modify the properties according to your needs.

4. Repeat steps 2–3 for entities of different types.

Re-position entities by moving nodes or edges
After selecting an entity you can re-position it by moving nodes or edges.

Modify one end of a grid or construction line
Grid and construction lines can only be modified in 2D views.

1. Select the grid or construction line. 
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The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click where you want to move the end node. 

Tekla Structural Designer redraws the line, moving the end node to the
selected point.

Move a grid or construction line
Grid and construction lines can only be moved in 2D views.

1. Select the grid or construction line. 

The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click where you want to move the end node. 

Tekla Structural Designer redraws the line, moving the end node to the
selected point.
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Modify one end of a member
To move an entire member, see: Move objects (page 495).

To move just one end of a member, proceed as follows:

1. Select the member in a 2D or 3D view. 

The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click a grid or construction point where you want to move the end node. 

Tekla Structural Designer redraws the member, moving the end node to
the selected point.

Modify slab items and panels by moving a node
To move entire slab items and panels, see: Move objects (page 495).

To move a slab/panel node, proceed as follows:

1. Select the slab item or panel that you want to modify in a 2D or 3D view. 

The nodes at each vertex and at the mid-point of each edge become
visible.

2. Click a node to select it. 

You can select either corner nodes, or nodes at the mid-points of the
edge.
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3. Move the mouse pointer over an existing construction point or
intersection.

4. Click the point to reposition the node. 

NOTE When you reposition nodes, note that:

• The new node position must be in the same plane as the slab
item or panel.

• When you move a node at the mid-point of an edge, it
becomes a new corner node. Tekla Structural Designer
automatically creates two new mid-point nodes.

• When you move a corner node directly over an adjacent
corner node, Tekla Structural Designer deletes the original
corner node.

Modify slab items by moving an edge
To move entire slab items and panels, see: Move objects (page 495).

To move a slab/panel edge, proceed as follows:

1. Select the slab item that you want to modify in a 2D or 3D view.

2. Click an edge to select it. 

Ensure that you have selected an edge, and not a node.

3. Move the mouse pointer over an existing construction point or
intersection.

4. Click to reposition the edge so that it passes through the selected point. 

NOTE The new edge position must be in the same plane as the slab
item.

Modify walls by moving a node
To move an entire wall, see: Move objects (page 495).

To move a wall node, proceed as follows:
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1. Select the wall that you want to modify in a 2D or 3D view. 

The nodes at each vertex become visible.

2. Click a node to select it.

3. Move the mouse pointer over an existing construction point or
intersection.

4. Click the point to reposition the node. 

NOTE The new node position must be in the same plane as the wall.

Tips for basic tasks
Here we provide useful hints and tips that help you use the Tekla Structural
Designer user interface and its basic features more efficiently.

Use the tooltip for input in a command
When you need to specify a distance or pick a point, a tooltip appears,
displaying the current value.

1. Do one the following:

• Move the mouse pointer to the required point and click the point to
use it.

• Press F2 to type an exact number, and press Enter.

Undo a command

1. In the Quick Access toolbar, click Undo.
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Cancel a command or go back to the previous prompt
Yellow command prompts are viewed on the top of the active view to guide
you through each command. To react to command prompts, see the following
instructions.

• Do one of the following:

To Do this
Cancel a command • Press Esc at the first command prompt.

Go back to the previous command prompt • Press Esc at a subsequent command prompt.

TIP Selecting another command also cancels the current command.

Example

The parallel grid line command consists of four steps. Hence, four consecutive
command prompts are displayed.

1.

2.

3.

4.

The grid line is created after the fourth prompt. After that, prompt 2 is
automatically redisplayed.

At this point, you can either continue to create additional lines parallel to the
original, or go back to the first prompt by pressing Esc.

Then, you can either select a new reference line and continue again, or cancel
the command by pressing Esc again.

4.2 Create the model
When you model in Tekla Structural Designer, you create and work with
different types of model object. In most cases, a model object represents a
member type that will exist in the real building or structure, or that will be
closely related to it. You will also work with modeling aids such as grids and
construction lines, that represent information that is only relevant when you
are creating the model.

You can use the following modeling aids:

• Construction levels (page 367)

• Grids (page 370), construction lines (page 380) and free points

• Frames and slopes

• Dimensions (page 388)
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• DXF reference drawings (page 377)

You can create the following physical member/object types:

• Beams, columns and braces (page 388)

• Walls and cores (page 425)

• Slabs and decks (page 448)

• Trusses and steel joists

• Portal frames

• Cold rolled members

The following panels/objects are useful for applying loads to the model:

• Wall panels and roof panels

• Ancillaries (page 474)

• Inactive members (page 482)

You can also use the following general members/objects when required:

• Supports (page 490)

• Analysis elements (page 493)

Create and manage construction levels
In the Construction Levels dialog box, you can define and modify the levels
that you need to construct your model. The levels can be floors, roofs, or
intermediate levels required to define specific items.

Open the Construction Levels dialog
• Do one of the following:

• On the Model tab, click Construction Levels.

• In the Structure tree, double-click Levels.

Insert a single construction level
1. In the Construction Levels dialog box, select an existing level.

2. According to your needs, click either Insert Above or Insert Below.

3. If necessary, change the level type:

• If you are creating a steel structure, set each new level as T.O.S. (top of
steel).
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• If you are creating either a concrete or mixed material structure, set
each new level as S.S.L. (structural slab level).

4. If necessary, change the level name.

5. For the new level, do one of the following:

• Specify the height above the base in the Level field.

The inter-storey spacing is calculated automatically.

• Specify the inter-storey spacing in the Spacing field.

The level is calculated automatically.

NOTE A default height is calculated for the new level based on the
spacings of any existing levels immediately above or below it.
Either accept the height, or adjust it as required.

6. If you want Tekla Structural Designer to treat the level as a floor, select the
Floor option.

Insert multiple construction levels
Multiple levels can be inserted, either above the current top level, or below the
current bottom level.

1. In the Construction Levels dialog box, select an existing level.

2. According to your needs, click New on Top or New at the Bottom

3. For each construction level, type the level spacing and click OK. 

TIP If you have new levels at 12' 6" , 18' 6" , 27' 6" , 36' 6" and 27" above
the current level, you can specify the levels as 12' 6" , 18' 6" , 3*9'.

4. If necessary, change the level names.

5. If necessary, change the level type:

• If you are creating a steel structure, set each new level as T.O.S. (top of
steel).

• If you are creating either a concrete or mixed material structure, set
each new level as S.S.L. (structural slab level).

Make a level an identical copy of another level
If needed, you can determine a level as an identical copy of another level. In
this case, all changes made to either the source level or the identical level are
automatically applied to both levels. To make a level an identical copy of
another level, see the following instructions.

1. Open the Construction Levels dialog box.

2. At the level you want to be a copy, click the arrow in the Source column.
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3. Select the level that you want the current level to be identical to.

4. Click OK.

Make a level an independent copy of another level
If you determine a level as an independent copy of another level, any changes
made to each level only apply to that level. To make a level an independent
copy of another level, see the following instructions.

1. Open the Construction Levels dialog box.

2. At the level you want to be a copy, click the arrow in the Source column.

3. Select the level that you want the current level to be identical to.

4. Click OK.

5. Reopen the Construction Levels dialog box.

6. At the same level, click the arrow in the Source column again.

7. Set the level as -unique-.

8. Click OK.

Modify the properties of a construction level
You can modify some properties of construction levels in the Construction
Levels dialog box dialogs, but other parameters can only be edited in the
Properties window. For more information, see the following instructions.

1. In the Structure tree, click the + sign next to Levels.

2. Click the name of the construction level that you want to modify. 

The properties of the level are viewed in the Properties window.

3. In the Properties window, modify the level properties according to your
needs.

Delete construction levels
To delete construction levels, see the following instructions.

WARNING Deleting a construction level completely deletes the entire level
and all its associated details, such as beams, members, or slab.
You cannot recover the level once you have deleted it.

1. In the Construction Levels dialog box, select the level that you want to
remove.

2. Click Delete.

3. Click OK. 
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NOTE You can also delete construction levels using the Structure tree.
Note that :

a. Click the + sign next to Levels.

b. Right-click the level that you want to remove.

c. In the context menu, select Delete.

Create and manage architectural grids and grid lines

Architectural grids

An architectural grid is a collection of grid lines that lie in a horizontal plane.
Each architectural grid is only displayed in the 3D View and at the lowest level
in the structure. Vertical lines can be projected from each grid intersection of
the architectural grid. The vertical lines extend to the topmost level at which
the architectural grid has been applied.

You can assign a color for each architectural grid, and set to display grid line
names and vertical lines in the architectural grid properties.

NOTE Even when architectural grid properties are checked, they are only
displayed provided that the Architectural Grids --> Text2D and
Architectural Grids --> VerticalLines options are selected in
(page 259).

Grid lines

Each grid line is associated with an architectural grid, and is only created at a
given level, provided the architectural grid has been applied at that level.

Grid lines that have been created at a given level can optionally be shown or
not shown in both the 2D and 3D views using the level properties.

NOTE Even when the show/hide options are checked the lines are only
displayed provided that the relevant Grid & Construction Lines
options are also checked in (page 259).

TIP Even when you have activated the display of grid & construction lines in
Scene Content for a particular 2D or 3D view, you may still find that the
grid lines are not displayed on particular levels.

In this situation, do the following:

1. In the Structure tree, open the Levels branch.
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2. Click the level at which you want to view the grids.

The level properties are viewed in the Properties window .

3. In the Properties window:

• To make grids visible in a 2D view, select the Show grids in
plane view option.

• To make grids visible in a 3D view, select the Show grids in the
3D view option.

If the grids are still not visible in the 3D view at certain levels, ensure that
grids are applied at the levels in question. For further information, see
Apply an architectural grid to a specific level (page 377).

Create grid lines
Tekla Structural Designer allows you to create various types of grid lines
according to your needs. For detailed instructions, see the following
paragraphs.

Create a single grid line

NOTE If you want to create a series of grid lines which form a regular or
irregular, rectangular or radial grid line system, the Rectangular
Wizard and Sector Wizard are the fastest options.

1. Ensure that the 2D view containing the construction level on which you
want to create your grid line is active.

2. Go to the Model tab.

3. In the Grid Line list, select Grid Line.

4. Select the point where you want the grid line to start. 

TIP The tooltip views the mouse pointer's exact coordinates. If the
mouse pointer has not snapped to the required point, press F2 to
type the exact coordinates of the required point.

5. Select the point where you want the grid line to end. 

TIP The tooltip views either the absolute, relative, or polar coordinates
of the end point, depending on whether the ABS, REL, or POL
button is selected in the (page 258).

• To switch the display, click one of the other buttons.

Create models 371 Create the model



NOTE The grid line does not extend to infinity. Do ensure that the grid
line is sufficiently long to meet your needs.

Tekla Structural Designer creates the grid line between the selected
points.

Create parallel grid lines
This option creates a grid line parallel to an existing one, but of a different
length. To use this option, you must have at least one existing grid line in the
current 2D view.

1. Go to the Model tab.

2. In the Grid Line list, select Parallel.

3. In the Properties window, type a name for the grid line.

4. Select the grid line to which your new grid lines will be parallel.

5. Move the mouse pointer to the distance where you want to place the
parallel grid line. 

TIP The tooltip views the distance of the dotted line from the initial grid
line you selected in step 3. Press F2 to type the exact distance.

For more accuracy, you can zoom in.

6. Click to locate the new grid line.

7. Click the points where you want the new grid line to start and end. 

The construction line is now created.

8. Move the mouse pointer and place other grid lines with respect to the line
you selected in step 3, or press Esc to end grid placement. 

TIP To create parallel grid lines of the same length as the selected

gridline, select the Parallel (quick) command.

When you create quick parallel grid lines, you can press F2 to define
the distance between successive pairs of grid lines, separating the
numbers with commas. If you have a number of bays that are at the
same centers, then you can specify these as a single entry.

For example, you can specify bay centers of 18', 27' , 18' 6" , 18' 6" ,
18' 6" and 27" as 18' , 27' , 3x18' 6" , 27".
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Create perpendicular grid lines

To use this option, you must have at least one existing grid line in the current
2D view.

1. Go to the Model tab.

2. In the Grid Line list, select Perpendicular.

3. In the Properties window, type a name for the grid line.

4. Select the grid line to which your new grid line will be perpendicular.

5. Move the new grid line to the desired position and click to locate it. 

TIP The tooltip views the perpendicular distance of the dotted line from
the middle of the grid line you selected. Press F2 to type the exact
distance.

6. Click the points where you want the new grid line to start and end.

7. Move the mouse pointer and place other grid lines with respect to the line
you selected in step 4, or press Esc to end grid placement.

Create a rectangular grid line system

1. Ensure that the 2D view representing the construction level on which you
want to create your rectangular grid line system is active.

2. On the Model tab, in the Grid Line list, select Rectangular
Wizard. 

The Rectangular Grid Wizard opens.

3. Type a name for the grid and select a color for the grid lines.

4. Ensure that each construction level on which you want to create the grid
layout is selected.

5. Click Next.

6. Define the origin of the grid line system either by clicking it in the 2D view,
or by entering its coordinates in the Rectangular Grid Wizard.

7. Click Next.

8. Select if you want to create grid lines in the X direction only, in the Y
direction only, or in both directions.

9. Select the style that you want to use for the grid lines.

10. Click Next.

11. On the following pages, define the layout of grids for the bays in the X and
Y directions. 
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NOTE You can define either a regular or an irregular grid layout:

• For a regular grid, define the number of bays you want to
create and the bay centers.

• For an irregular grid, define the distance between successive
pairs of grid lines, separating the numbers by commas. If you
have a number of bays that are at the same centers, you can
specify them as a single entry (for example, 3x18'6").

You can also specify the reference of the first grid line, and by
how much you want to increment that reference to give the
references of the other lines that you create.

• For alphanumeric grid lines, if you specify that the first grid
line reference is to be D, and specify an increment of 3, your
grid lines will be referenced D, G, J, M, and so on.

12. Click Next.

13. Define the rotation of the grid either by moving the mouse over the 2D
view and clicking, or by typing values into the Rectangular Grid Wizard. 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the grid line system's local x or local y direction.
This is helpful if you are creating a grid line system that is not
orthogonal.

14. Click Next.

15. Specify the angle between the axes with respect to either the X or Y axis
system.

16. Click Finish.

Create a radial grid line system

1. Ensure that the 2D view representing the construction level on which you
want to create your radial grid line system is active.

2. On the Model tab, in the Grid Line list, select Radial Grid
Wizard. 

The Radial Grid Wizard opens.

3. Type a name for the grid and select a color for the grid lines.

4. Ensure that each construction level on which you want to create the grid
layout is selected.

5. Click Next.
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6. Define the origin of the grid line system either by clicking it in the 2D view,
or by entering its coordinates in the Radial Grid Wizard.

7. Click Next.

8. Select whether you want to create the radial lines only, the arcs only, or
both of these.

9. Select the style that you want to use for the grid lines.

10. Click Next.

11. Define the layout of the arcs that you will create. 

NOTE You can define either a regular or an irregular grid layout:

• For a regular grid, define the number of bays you want to
create and the bay centers.

• For an irregular grid, define the distance between successive
pairs of grid lines, separating the numbers by commas. If you
have a number of bays that are at the same centers, you can
specify them as a single entry (for example, 3x10'6").

You can also specify the reference of the first grid line, and by
how much you want to increment that reference to give the
references of the other lines that you create.

• For alphanumeric grid lines, if you specify that the first grid
line reference is to be D, and specify an increment of 3, your
grid lines will be referenced D, G, J, M, and so on.

You can also select whether the arc grid lines are represented as
curves, or as a series of straight lines between the points where
the arc intersects the other grid lines created as part of this
process.

12. Click Next.

13. Define the layout of radial grid segments that you want to achieve. 

Again, you can specify the reference of the first grid line, and how you
want to increment the reference to give the references of the other radial
lines that you create.

14. Click Next.

15. Define the rotation of the grid either graphically by moving the mouse
over the 2D view and clicking, or by typing values into the Rectangular
Grid Wizard 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the grid line system's local x or local y direction.

16. Click Finish.
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Create a grid arc

1. Go to the Model tab.

2. In the Grid Line list, select Arc.

3. In the Properties window, type a name for the grid line.

4. Select the point which lies at the center of the grid arc which you want to
create. 

The tooltip views the mouse pointer's exact coordinates.

5. Click the points where you want the grid arc to start and end.

6. Move the mouse pointer and place other grid arcs with respect to the line
you selected in step 4, or press Esc to end grid placement.

Number and renumber grids
Each grid that you create is automatically numbered. To set the initial number
or letter for naming grids, or to renumber all grids, see the following
instructions.

Set the initial number or letter used for grids

1. On the Home tab, click Model Settings.

2. Go to References --> General.

3. In the Grid Line Naming section, set the initial values and the naming
style.

4. Click OK.

Renumber all grids

1. In the Structure tree, right-click Architectural Grids.

2. In the context menu, select Renumber. 

All grids in the model are renumbered in sequence.

See also

Change the name of a grid line or grid arc (page 376)

Change the name of a grid line or grid arc
To change the name of a single grid line or grid arc, see the following
instructions.

1. Select the grid line or grid arc that you want to name.
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2. In the Properties window, modify the name according to your needs.

See also

Number and renumber grids (page 376)

Change the name or color of an architectural grid (page 377)

Apply an architectural grid to a specific level
To view an existing architectural grid at a specific level of your model, you
must apply the grid to the level. See detailed instructions in the following
paragraphs.

1. In the Structure tree, click Architectural Grids.

2. Right-click the architectural grid name.

3. In the context menu, select Edit...

4. Ensure that the levels where you want the architectural grid to be applied
are selected.

See also

Create and manage architectural grids and grid lines (page 370)

Change the name or color of an architectural grid
To modify the properties of an existing architectural grid, see the following
instructions.

1. In the Structure tree, click the + sign next to Architectural Grids.

2. Select the architectural grid whose name you want to change.

3. In the Properties window, modify the architectural grid's properties
according to your needs.

See also

Change the name of a grid line or grid arc (page 376)

Import grids from a DXF file or a shadow of the DXF file
If necessary, you can import grids from an existing DXF file to your Tekla
Structural Designer document. In addition, you can use a DXF file as a shadow,
or a base that helps you in creating objects in Tekla Structural Designer.
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NOTE The DXF file that you use must be available before you start the
import process, either sent to you, or created by you.

1. Open a 2D view of a construction level, and go to the Model tab

2. In the Grid Line list, select Import DXF. 

An Open dialog opens.

3. Browse to the file that you want to import, select the file, and click Open. 

The DXF Import Wizard opens.

4. On the first page, manage the layers and colors that you want to import.

5. Select if you want to import the architectural grids from the file, or import
the file as a shadow.

• If you import the architectural grids, all elements in the selected layers
of the DXF file are mapped to the Tekla Structural Designer grid lines.
You must therefore ensure that you switch off all the layers in the DXF
file, apart from the layers in which the grids have been defined.

• • If you import the DXF file as a shadow, Tekla Structural Designer
imports the .dxf file but does not create any Tekla Structural Designer
objects. You can use the intersection points and other elements as the
source on which to add the Tekla Structural Designer objects you
require.

6. If necessary, adjust the scale and offsets for the DXF file.

7. Click Next.

8. Select how the grids are created:

• To create separate named grids for each layer, select By layer.

• To create separate named grids for each color in the DXF file, select By
color.

• To create a single merged grid containing all layers and colors, select
Merged.

9. Ensure that each level to which you want to import the grid layout is
selected.

10. Click Finish.

See also

Create and manage architectural grids and grid lines (page 370)

Change the name of a grid line or grid arc (page 376)

Change the name or color of an existing architectural grid (page 377)
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Extend, move, or rotate grid lines and arcs
You can modify grid lines and arcs in different ways according to your needs.
You can stretch, shorten, or rotate grid lines, or move them in a perpendicular
direction. As for grid arcs, you can stretch and shorten them, adjust their
radius, or move them in any direction. For detailed instructions, see the
following paragraphs.

RESTRICTION You can only move grid lines and arcs in 2D views.

Stretch, shorten, or rotate a grid line

1. In a 2D view, select the grid line that you want to modify. 

The end nodes and the center node of the grid line become visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The node moves to its new position.

Move a grid line to a perpendicular direction

1. In a 2D view, select the grid line that you want to modify. 

The end nodes and the center node of the grid line become visible.

2. Click the center node.

3. Click the location where you want to move the node. 

The grid line moves to its new position.

Stretch or shorten a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The arc stretches or shortens accordingly.

Adjust the radius of a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end and center nodes of the arc perimeter and the center node of the
arc visible.

2. Click the center node of the arc perimeter.

3. Click the location where you want to move the node. 

The arc radius adjust accordingly.
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Move a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click the center node of the arc.

3. Click the location where you want to move the node. 

The arc moves to its new location.

Create and manage construction lines
Construction lines serve the same purpose as architectural and construction
lines. The only difference is that they do not display a construction bubble. To
create construction lines, see the following instructions.

Create a single construction line

NOTE If you want to create a series of construction lines which form a
regular or irregular, rectangular or radial construction line system, the
Rectangular Wizard and Sector Wizard are the fastest options.

1. Ensure that the 2D view representing the construction level on which you
want to create your construction line is active.

2. Go to the Model tab.

3. In the Construction Line list, select Construction Line.

4. Select the point where you want the construction line to start. 

TIP The tooltip views the mouse pointer's exact coordinates. If the
mouse pointer has not snapped to the required point, press F2 to
type the exact coordinates of the required point.

5. Select the point where you want the construction line to end. 

TIP The tooltip views either the absolute, relative, or polar coordinates
of the end point, depending on whether the ABS, REL, or POL
button is selected in the (page 258).

• To switch the display, click one of the other buttons.

NOTE The construction line does not extend to infinity. Do ensure that
the construction line is sufficiently long to meet your needs.
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Tekla Structural Designer creates the construction line between the
selected points.

Create parallel construction lines
This option creates a construction line parallel to an existing one, but of a
different length. To use this option, you must have at least one existing
construction line in the current 2D view.

1. Go to the Model tab.

2. In the Construction Line list, select Parallel.

3. Select the construction line to which your new construction lines will be
parallel.

4. Move the mouse pointer to the distance where you want to place the
parallel construction line. 

TIP The tooltip views the distance of the dotted line from the initial
construction line you selected in step 3. Press F2 to type the exact
distance.

For more accuracy, you can zoom in.

5. Click to locate the new construction line.

6. Click the points where you want the new construction line to start and
end. 

The construction line is now created.

7. Move the mouse pointer and place other construction lines with respect
to the line you selected in step 3, or press Esc to end construction
placement. 

TIP To create parallel construction lines of the same length as the

selected construction line, select the Parallel (quick)
command.

When you create quick parallel construction lines, you can press F2
to define the distance between successive pairs of construction
lines, separating the numbers with commas. If you have a number
of bays that are at the same centers, then you can specify these as a
single entry.

For example, you can specify bay centers of 18', 27' , 18' 6" , 18' 6" ,
18' 6" and 27" as 18' , 27' , 3x18' 6" , 27".
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Create perpendicular construction lines
To use this option, you must have at least one existing grid or construction line
in the current 2D view.

1. Go to the Model tab.

2. In the Construction Line list, select Perpendicular.

3. Select the construction line to which your new construction line will be
perpendicular.

4. Move the new construction line to the desired position and click to locate
it. 

TIP The tooltip views the perpendicular distance of the dotted line from
the middle of the construction line you selected. Press F2 to type the
exact distance.

5. Click the points where you want the new construction line to start and
end.

6. Move the mouse pointer and place other construction lines with respect
to the line you selected in step 4, or press Esc to end construction
placement.

Create a rectangular construction line system
1. Ensure that the 2D view representing the construction level on which you

want to create your rectangular construction line system is active.

2. On the Model tab, in the Construction Line list, select 
Rectangular Wizard. 

The Rectangular Grid Wizard opens.

3. Define the origin of the construction line system either by clicking it in the
2D view, or by entering its coordinates in the Rectangular Grid Wizard.

4. Click Next.

5. Select if you want to create construction lines in the X direction only, in
the Y direction only, or in both directions.

6. Select the style that you want to use for the construction lines.

7. Click Next.

8. On the following pages, define the layout of constructions for the bays in
the X and Y directions. 

NOTE You can define either a regular or an irregular construction
layout:
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• For a regular construction, define the number of bays you
want to create and the bay centers.

• For an irregular construction, define the distance between
successive pairs of construction lines, separating the numbers
by commas. If you have a number of bays that are at the same
centers, you can specify them as a single entry (for example,
3x18'6").

9. Click Next.

10. Define the rotation of the construction either by moving the mouse over
the 2D view and clicking, or by typing values into the Rectangular Grid
Wizard. 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the construction line system's local x or local y
direction. This is helpful if you are creating a construction line
system that is not orthogonal.

11. Click Next.

12. Specify the angle between the axes with respect to either the X or Y axis
system.

13. Click Finish.

Create a radial construction line system
1. Ensure that the 2D view representing the construction level on which you

want to create your radial construction line system is active.

2. On the Model tab, in the Construction Line list, select Radial
Grid Wizard. 

The Radial Grid Wizard opens.

3. Define the origin of the construction line system either by clicking it in the
2D view, or by entering its coordinates in the Radial Grid Wizard.

4. Click Next.

5. Select whether you want to create the radial lines only, the arcs only, or
both of these.

6. Select the style that you want to use for the construction lines.

7. Click Next.

8. Define the layout of the arcs that you will create. 
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NOTE You can define either a regular or an irregular construction
layout:

• For a regular construction, define the number of bays you
want to create and the bay centers.

• For an irregular construction, define the distance between
successive pairs of construction lines, separating the numbers
by commas. If you have a number of bays that are at the same
centers, you can specify them as a single entry (for example,
3x10'6").

You can also select whether the arc construction lines are
represented as curves, or as a series of straight lines between the
points where the arc intersects the other construction lines
created as part of this process.

9. Click Next.

10. Define the layout of radial construction segments that you want to
achieve. 

Again, you can specify the reference of the first construction line, and how
you want to increment the reference to give the references of the other
radial lines that you create.

11. Click Next.

12. Define the rotation of the construction either graphically by moving the
mouse over the 2D view and clicking, or by typing values into the
Rectangular Grid Wizard 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the construction line system's local x or local y
direction.

13. Click Finish.

Create construction arcs
1. Go to the Model tab.

2. In the Construction Line list, select Arc.

3. Select the point which lies at the center of the construction arc which you
want to create. 

The tooltip views the mouse pointer's exact coordinates.

4. Click the points where you want the construction arc to start and end.
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5. Move the mouse pointer and place other construction arcs with respect to
the line you selected in step 3, or press Esc to end construction
placement.

Extend, move, or rotate construction lines and arcs
You can modify construction lines and arcs in different ways according to your
needs. You can stretch, shorten, or rotate construction lines, or move them in
a perpendicular direction. As for construction arcs, you can stretch and
shorten them, adjust their radius, or move them in any direction. For detailed
instructions, see the following paragraphs.

RESTRICTION You can only move construction lines and arcs in 2D views.

Stretch, shorten, or rotate a construction line

1. In a 2D view, select the construction line that you want to modify. 

The end nodes and the center node of the construction line become
visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The node moves to its new position.

Move a construction line to a perpendicular direction

1. In a 2D view, select the construction line that you want to modify. 

The end nodes and the center node of the construction line become
visible.

2. Click the center node.

3. Click the location where you want to move the node. 

The construction line moves to its new position.

Stretch or shorten a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The arc stretches or shortens accordingly.
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Adjust the radius of a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end and center nodes of the arc perimeter and the center node of the
arc visible.

2. Click the center node of the arc perimeter.

3. Click the location where you want to move the node. 

The arc radius adjust accordingly.

Move a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click the center node of the arc.

3. Click the location where you want to move the node. 

The arc moves to its new location.

Create frames and slopes
Frames and slopes are different 2D views of the model that can help you in
creating your model. To create a frame or a slope, see the following
instructions.

Create a frame
A frame is a 2D View of the model, created in a vertical plane defined by an
existing grid line. Since only the members that lie within the plane of the frame
are displayed, a frame view can be particularly useful for defining bracing.

1. Obtain a 3D view of your model where you can see the base grid line
associated with the frame that you want to create.

2. On the Model tab, click Frame.

3. Position the mouse pointer over the grid line for the frame that you want
to create.

4. Click to create the frame. 

Tekla Structural Designer creates a frame view for the selected grid line.

TIP To open a frame view:

a. Click the + sign on the left side of Frames in the Structure
tree.
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b. Double-click the name of the frame whose view you want to
open.

Create a slope
A slope is a 2D View of the model, created in a sloped plane. You can define a
slope by selecting 3 existing grid points. Since only those members that lie
within the plane of the slope are displayed, this type of view can be particularly
useful for defining inclined roofs and ramps.

NOTE Before creating a slope, note that:

• In order to create a slope, you need to be able to click three
existing (not co-linear) grid points that lie in the plane of the slope.

• Grid points are formed at grid line intersections on construction
levels. Therefore, if the points required to define the slope do not
currently exist, you may need to insert new construction levels and
grid lines to form them.

• A sloped plane must be entirely contained within a single sub
model because the sub model determines the mesh parameters to
be applied.

• In a sloped plane, positive Y is always aligned to the up-slope
direction, so that positive X is always perpendicular to the slope.

1. Obtain a 3D view of your model where you can see three grip points that
define the sloped plane. 

TIP If you cannot see the grid line intersections on a particular
construction level in the 3D view:

a. In the Structure tree, select the level.

b. In the , select the Show grids in the 3D view option.

If you wish, you can clear the Show grids in the 3D view option
for other levels to simplify the display.

2. On the Model tab, click Sloped Plane.

3. Click the three points which define the sloped plane. 

Tekla Structural Designer creates sloped plane view.

TIP To open a slope view:

a. Click the + sign on the left side of Slopes in the Structure
tree.
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b. Double-click the name of the slope whose view you want to
open.

Create dimensions
Dimensions allow you to show distances between the appropriate points in
your structure. The dimension lines are included on any drawings you create.
To create dimensions, see the following instructions.

Create a single dimension

1. On the Model tab, click Dimension.

2. Click the grid point at the start of the dimension.

3. Click the grid point at the end of the dimension. 

Tekla Structural Designer shows a line between the selected points.

4. Move the line to the point where you want the dimension line to lie. 

Choose a point that is easily visible and does not conflict with the rest of
your model's details.

5. Click to create the dimension.

Create beams, columns and braces
These topics introduce you to the methods of creating beams columns and
braces (in any material).

We recommend you familiarize yourself with how to:

• Create beams (page 401)

• Create columns (page 388)

• Create braces (page 418)

Create columns
This section focuses on the operations required to create columns (in any
material).

• Specify the column type and section size (page 389)

• Create a single column or series of columns (page 391)

• Create inclined columns and cranked columns (page 393)

• Create gable posts or parapet posts (page 394)
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• Align a column to a specific angle or an angled... (page 395)

• Modify the position of columns and column stacks (page 395)

The following topics are relevant to steel columns only:

• Setting out steel and cold formed columns (page 396)

• Create plated or compound section steel columns (page 397)

• Specify a column splice (page 398)

• Create web openings (page 414)

Concrete columns specifically have an automatic alignment facility:

• Specify concrete column alignment relative to the grid (page 399)

• Modify the column alignment or specify offsets (page 400)

See also

Column properties (page 2089)

Specify the column type and section size
Before you can place a column you must first specify the column type and an
initial section size.

Specify the type of column

• On the Model tab, do one of the following:

To Do this
Specify a steel column

1. Click the arrow under Steel Column.

2. In the list, select the Steel Column type.

Specify a plated or compound steel column

1. Click the arrow under Steel Column.

2. In the list, select the Plated column type.

Specify a concrete filled steel column

1. Click the arrow under Steel Column.

2. In the list, select the Concrete Filled
column type.

Specify a concrete encased steel column

1. Click the arrow under Steel Column.

2. In the list, select the Concrete Encased
column type.

3. In theProperties window, click Encasing
section.

4. Click the arrow on the right side of
Encasing section.

5. In the list that appears, select <New\Edit...>

6. Enter the size of encasing concrete section.
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Specify a cast-in-place, or precast concrete
column

•

1. Click the arrow under Concrete
Column.

2. In the list that appears, select Concrete
Column for cast-in-place, or Precast.

Specify a timber column Click Timber Column.

Specify a cold formed column In the Cold Formed group, click Column.

Specify the size of steel, cold formed and timber columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 358) opens.

4. Select the desired section size, and click Select. 

TIP To define a custom section, click Add...

5. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Specify the size of plated or compound steel columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 358) opens.

4. In the (page 358), choose the required compound section type from the
left hand pane.

5. Select the desired section size, and click Select. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.
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d. Select the section in the Select Section dialog box.

6. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Specify the size of cast-in-place, or precast concrete columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The Section dialog box opens.

4. Select the column shape.

5. Define the dimensions of the column. 

NOTE Only click Add if you want to create a hollow column.

Then, to define the void:

a. In the tabular part of the dialog, select the shape and
dimensions of the void.

b. Leave the minor and major offsets as 0.0 to position the void
centrally in the column, or adjust as necessary to create an
offset.

6. Click OK

7. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Create a single column or series of columns
With Tekla Structural Designer, you can create various kinds of column. You
can model columns in 2D views, frame views, and structure views.

Create columns in a level view

1. Ensure that you have defined the construction levels between which the
column will run and the grid points between which it will lie.

2. Select the column type and size (page 389).

3. In the Properties window , adjust the base level and top level of the
column, and other column properties, if necessary.

4. Do one of the following:

To Do this
Create a single column a. Click the point where you want to place the

column.

b. Press Esc to finish creating columns.
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Create a series of columns a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
grid intersection points where you want to
create columns.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the
diametrically opposite corner of the box.

d. Release the mouse button.

Create a single column in a frame or structure view

NOTE In order to define a column in a frame view or a structure view, you
must have already created the construction levels between which the
column will run, and the grid points between which it will lie.

1. Select the column type and size (page 389).

2. Click the start point of the column.

3. Click the end point of the column. 

Tekla Structural Designer creates the column between the selected points.

Create plated or compound section steel columns

1. On the Model tab, click the arrow under Steel Column.

2. In the list that appears, select Plated.

3. In the Properties window, click the arrow next to the Section property.

4. In the list that appears, select <New\Edit...> 

The Select Section dialog box opens.

5. Select the desired section type and section size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.
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7. To proceed, see Create columns in a 2D view and Create a single
column in a frame view or a structure view. 

TIP In order to apply a plated or compound section an existing steel
column, do the following:

a. In the Properties window, set Fabrication to Plated.

b. Click the arrow next to the Section property.

c. In the list, either select a compound section that has already
been applied in the model, or select <New\Edit...> to add a new
one.

Create concrete filled or encased concrete columns

1. On the Model tab, click the arrow under Steel Column.

2. In the list that appears, select either Concrete Filled or Concrete
Encased. 

The column adopts the properties that are currently displayed in the
Properties window for creating steel columns.

3. In the Properties window, adjust the properties as necessary.

4. To proceed, see Create columns in a 2D view and Create a single
column in a frame view or a structure view. 

NOTE You can now modify the Section property and specify a different
section size above the space position.

See also

Create gable posts or parapet posts (page 394)

Create inclined columns and cranked columns
Tekla Structural Designer allows you to create inclined and cranked steel and
concrete columns.

Create an inclined column
An inclined column is any column that is not truly vertical. In order to define an
inclined column, you must have defined the construction levels between which
the column will run, and the grid points between which it will lie.

NOTE An inclined column can only be created in a frame view or a structure
view.

1. Select the column type and size. (page 389)

2. In a frame or structure view, Click the start point of the column.
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3. Click the end point of the column. 

Tekla Structural Designer creates the column between the selected points.

Create a cranked column

In order to define a cranked column, you must have created the construction
levels between which the column will run and the grid points between which it
will lie.

NOTE An inclined column can only be created in a frame view or a structure
view.

1. Select the column type and size. (page 389)

2. Click the start point of the column.

3. Hold down the Ctrl key and click the next node of the column.

4. Repeat step 3 until you have selected the second to last node of the
column.

5. Release the Ctrl key and click the end point of the column. 

Tekla Structural Designer creates the column.

Create gable posts or parapet posts
Steel parapet posts are single span members with fixed end connections.
Their specific purpose is to act as a means to transfer load from wind wall
panels into columns: the decomposed load from the panel is applied as a
point load, and the moment at the node connects the parapet post to the
column. To create parapet or gable posts posts in Tekla Structural Designer,
see the following instructions.

NOTE Parapet posts are not designed in Tekla Structural Designer.

1. On the Model tab, click any element type (for example, Steel
Column).

2. In the Properties window, set the Characteristic to Gable post or
Parapet post. 

The properties in the Properties window are updated to a type that is
appropriate for the chosen post.

3. In the Properties window, adjust the properties according to your needs. 

NOTE For gable posts:

• If an axial load release is required at the top, consider carefully
which wind load deflection parameters are required.

4. Click the start point of the post. 
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NOTE If you are using a point along a member, do the following:

a. Click the member to see its points.

b. Either click the point that you want to use, or type the
distance to the point from the start of the member.

5. Click the end point of the post. 

Tekla Structural Designer creates the post.

Align a column to a specific angle or an angled grid line
You can align a column to a specific angle or a grid line either before creating
the column or by editing an existing column in the Properties window.

1. Do one of the following:

• To create a new column, on the Model tab, select the desired column
type.

• To align an existing column to a specific angle, in the model, click the
desired column.

2. In the Properties window, click the Rotation property.

3. In the list, select one of the following options: 

• The 0°, 90°, 180°, and -90° options align the column to the global axes.

• The Angle option aligns the column to the exact rotation angle you
specify.

• The Define option aligns the column to the angle of any grid line you
select.

Related information

Related video

Align columns to grids

Modify the position of columns and column stacks
You may sometimes need to modify the position of columns and column
stacks in your model. To do so, see the following instructions.

Move a column

See: Move objects (page 495).

Modify the position of a single column stack
You can change the position of a column stack in either a frame view or a
structure view.
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1. In (page 247), ensure that the Grid & Construction Lines options is
selected.

2. Select the column stack that you want to move.

3. Click one end node for the column stack to be moved. 

Ensure the node is highlighted in the Select Entity tooltip when selecting.

4. Click a grid or construction point where you want to move the selected
end node. 

The entire column is redrawn, with the selected node moved to the new
position.

5. Select the next end node.

6. Click a grid or construction point where you want to move the selected
end node. 

The column is redrawn once more, with the selected node moved to the
new position.

Setting out steel and cold formed columns
With Tekla Structural Designer, you can create various different types of steel
and cold formed columns, including series of columns, inclined and cranked
columns, gable or parapet posts, and plated, concrete filled or concrete
encased columns. In addition, Tekla Structural Designer allows you to specify a
column splice, align a column to a specific angle, or modify the position of
existing columns.

Steel column alignment

You can create a single steel column over several storey heights. These kind of
columns are referred to as column stacks. The columns can start and finish at
any level. Different column sections can be defined in each stack, provided
that a splice is defined at the change point.

Each steel column stack is placed on an insertion line between points, but its
geometry is drawn to reflect the major and minor snap points and any offsets
specified in the column properties.

Major offset:
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Minor offset:

NOTE Steel column alignment snap points and offsets have no effect on the
positioning of 1D solver elements in the solver models. The solver
elements are always inserted along the steel column insertion lines.

This is different to the approach adopted for concrete column solver
elements, in which the alignment snap points and offsets are
structurally significant.

Create plated or compound section steel columns
Along with many other types of steel columns, Tekla Structural Designer allows
you to create plated or compound section steel columns in your models.

Create plated or compound section columns

1. On the Model tab, click the arrow under Steel Column.

2. In the list that appears, select Plated.
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3. Click the arrow on the right side of the Section property.

4. In the list that appears, select <New\Edit...>. 

The Select Section dialog box opens.

5. Select the section type and size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.

7. Click the start point of the column.

8. Click the end point of the column. 

Tekla Structural Designer creates the column.

9. Do one of the following:

• To create more similar column, click the start point of the new column.

• To stop creating columns, press Esc.

Apply a plated or compound section to an existing steel column

1. In the Properties window, go to Fabrication.

2. Set Fabrication to Plated.

3. Go to Section and do one of the following:

• Select an existing compound section.

• Click <New\Edit...> to select a new section.

See also

Add, modify and delete user-defined sections (page 1004)

Specify a column splice
You can add splices at the base of each column stack (except for stack 1) as
required. The splice offset is used to locate each splice at a practical distance
above the floor level.
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1. Select the desired columns. 

The properties of the columns are displayed in the Properties window.

2. Expand the properties of the column stack within which you want to
create the splice.

3. Under Release, select the Splice option.

4. If necessary, modify the splice offset. 

NOTE The Section property is now editable, so that you can specify a
different section size above the splice position, if necessary.

See also

Specify the column type and section size (page 389)

Specify concrete column alignment relative to the grid
The initial placement of each column relative to the grid depends on whether
the Automatic alignment option is selected in the concrete column
properties.

If Automatic alignment is selected:

Tekla Structural Designer aligns the columns on the perimeter of the grid with
their faces flush to the perimeter, and the internal columns centrally on the
grid.

If Automatic alignment is not selected:

Tekla Structural Designer aligns the columns according to the Major
alignment and Minor alignment options in the concrete column properties.
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• To switch the alignment option, in the Properties window, select or clear
Automatic alignment.

See also

Align a column to a specific angle or an angled grid line (page 395)

Modify concrete column alignment or specify offsets (page 400)

Modify concrete column alignment or specify offsets
Once you have created columns, you can adjust their alignments and specify
their offsets, if necessary. You can adjust the alignment of a single column in
the Properties window or the Properties dialog box, whereas multiple
columns can only be realigned in the Properties window.

The following example illustrates editing the alignment in the Properties
window.

1. Select the columns that you want to offset.

2. Ensure that the column properties are viewed in the Properties window. 
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3. Modify the Major offset and Minor offset values according to your
needs. 

Tekla Structural Designer moves the columns relative to the major and
minor snap levels by the value that you specified.

See also

Specify concrete column alignment relative to the grid (page 399)

Create beams
This section focuses on the operations required to create beams (in any
material).

• Specify the beam type and section size (page 402)
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• Create single-span beams (page 404)

• Create continuous beams (page 405)

• Create curved beams (page 406)

• Modify the position of beams (page 407)

The following topics are relevant to steel beams only:

• Setting out steel and cold formed beams (page 407)

• Create plated or compound section steel beams (page 409)

• Create Westok cellular, Westok plated or FABSEC® beams (page 410)

• DELTABEAM® (page 411)

• Create web openings (page 414)

• Add haunches to steel beams (page 417)

See also:

Beam properties (page 2073)

Member global offsets (page 422)

Specify the beam type and section size
Before you can place a beam you must first specify the beam type and an
initial section size.

Specify the type of beam

• On the Model tab, do one of the following:

To Do this
Specify a steel beam

1. Click the arrow under Steel Beam.

2. In the list that appears, select the desired
beam type.

Specify a plated, Westok, FABSEC®, or
DELTABEAM®

1. Click the arrow under Steel Beam.

2. In the list, select the required beam type.

Specify a cast-in-place, or precast concrete beam •

1. Click the arrow under Concrete
Beam.

2. In the list that appears, select Beam for
cast-in-place, or Precast.

Specify a timber beam Click Timber Beam.

Specify a cold formed beam In the Cold Formed group, click Beam.
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Specify the size of steel, cold formed and timber beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 358) opens.

4. Select the desired section size, and click Select. 

TIP To define a custom section, click Add...

5. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Specify the size of plated or compound steel beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 358) opens.

4. In the (page 358), choose the required compound section type from the
left hand pane.

5. Select the desired section size, and click Select. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Specify the size of cast-in-place, or precast concrete beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.
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3. In the list that appears, select <New\Edit...> 

The Section dialog box opens.

4. Select the beam shape.

5. Define the dimensions of the beam.

6. Click OK

7. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Create single-span beams
Tekla Structural Designer allows you to create concrete, steel, and timber
single-span beams. For detailed instructions, see the following paragraphs.

Create a single-span beam

1. Specify the beam type and section size (page 402)

2. In the Properties window, adjust the beam properties according to your
needs.

3. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

4. Click the end point of the beam. 

NOTE If Tekla Structural Designer prompts you to pick another point,
and you do not want to create a continuous beam, do one of the
following:

• Click again the end point again.

• Press Enter.

Create a series of single-span beams

RESTRICTION In order to a series of single-span beams using this method,
the floor or construction level must already contain the
columns between which the beams will run. You must also
use a 2D view of the floor or construction level.

1. Select the beam type and size (page 402)

2. In the Properties window, adjust the beam properties according to your
needs.
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3. Move the mouse pointer to one corner of an imaginary box that will
encompass the columns between which you want to create beams.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the diametrically opposite corner of the box. 

Ensure that the box encompasses all of the columns between which you
want to create beams.

6. Release the mouse button. 

Tekla Structural Designer creates the beams between each adjacent pair
of columns within the area you selected.

See also

Create continuous beams (page 405)

Create curved beams (page 406)

Create continuous beams
You can create continuous beams in your model by selecting the Continuous
option before creating the beam. For more information, see the following
instructions.

RESTRICTION You cannot create continuous beams that are curved either
horizontally or vertically.

1. Specify the beam type and section size (page 402) 

You can create steel, concrete, timber, or cold rolled beams.

2. In the Properties window, ensure that the Continuous option is selected.

3. In the Properties window, adjust the remaining properties according to
your needs.

4. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the next node of the beam.

6. Repeat step 5 until you have clicked the second to last node of the beam.

7. Click the end point of the beam. 

Tekla Structural Designer prompts you to pick another point.

8. To create the beam, do one of the following:
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• Click the end point again.

• Press Enter.

Tekla Structural Designer creates the continuous beam.

See also

Create single span beams (page 404)

Create curved beams (page 406)

Create curved beams
Tekla Structural Designer allows you to create curved steel, concrete, and cold
formed beams in your models, if necessary. To model curved beams, see the
following instructions.

1. Select the beam type and size. (page 402)

2. In the Properties window, ensure that Linearity is set to one of the
following:

• Curved major, if you want the beam to curve vertically.

• Curved minor, if you want the beam to curve horizontally.

TIP You can control the direction in which horizontally curved beams
curve.

When you place the beam, you select its start point and its end
point. The curve of the beam always lies on the left side of the line
from the start point to the end point of the beam.

3. Still in the Properties window, specify an appropriate chord height value
to define the curve. 

TIP You can reverse the curve direction of a vertically curved beam by
using a negative chord height value.

NOTE Horizontally curved beams always use the chord height defined in
the property set. Therefore, they do not curve automatically to fit
on any curved grid line that you may have defined.

4. In the Properties window, adjust the remaining properties according to
your needs.

5. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.
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b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

6. Click the end point of the beam. 

Tekla Structural Designer creates the beam.

NOTE If you are using a 2D view when defining beams that curve
vertically, you cannot see the beam on the graphical display.

Change to a 3D view to see the beams.

See also

Create single span beams (page 404)

Create continuous beams (page 406)

Modify the position of beams
If necessary, you can modify the position of an individual beam in your model
by moving one of its end nodes. You can modify the position of a beam in both
2D and 3D views.

To move an entire beam, see: Move objects (page 495).

1. Select the desired beam.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

Setting out steel and cold formed beams
You can define steel beams as single span, or continuous over multiple spans.
Even if you create a continuous beam, you can still define different beam
sections in each span, if necessary.

Each steel beam span is placed on an insertion line between points, but its
geometry is drawn to reflect:

• the major and minor snap points and any offsets specified in the beam
properties

Major snap and offset:
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Minor snap and offset:
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• the level type specified in the Construction Levels dialog box dialog:

• When the type is set to T.O.S. (top of steel), each beam is displayed
according to the alignment snap points and offsets specified.

• When the level type is set to S.S.L. (structural slab level), each beam is
also lowered by the slab thickness specified in the Construction Levels
dialog box.

NOTE Steel beam alignment snap points and offsets and the construction
level type have no effect on the positioning of 1D solver elements in
solver models. This is a different approach to that adopted for
concrete beam solver elements.

Create plated or compound section steel beams
Along with many other types of steel beams, Tekla Structural Designer allows
you to create plated or compound section steel beams in your models.

Create plated or compound section beams

1. On the Model tab, click the arrow under Steel Beam.

2. In the list that appears, select Plated.

3. Click the arrow on the right side of the Section property.

4. In the list that appears, select <New\Edit...>. 

The Select Section dialog box opens.

5. Select the section type and size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.
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c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.

7. Click the start point of the beam.

8. Click the end point of the beam. 

Tekla Structural Designer creates the beam.

9. Do one of the following:

• To create more similar beams, click the start point of the new beam.

• To stop creating beams, press Esc.

Apply a plated or compound section to an existing steel beam

1. In the Properties window, go to Fabrication.

2. Set Fabrication to Plated.

3. Go to Section and do one of the following:

• Select an existing compound section.

• Click <New\Edit...> to select a new section.

See also

Add, modify and delete user-defined sections (page 1004)

Create Westok cellular, Westok plated or FABSEC® beams
Tekla Structural Designer also allows you to create Westok Cellular, Westok
Plated or FABSEC® beams, if that is necessary in your model. For more
information, see the following instructions.

1. On the Model tab, click the arrow next to Steel Beam.

2. In the list, select the desired beam type. 

The beam adopts the properties that are currently displayed in the
Properties window.

3. In the Properties window adjust the properties according to your needs.

4. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.
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b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the beam. 

TIP If Tekla Structural Designer prompts you to pick another point, do
one of the following:

• Click the end point again.

• Press Esc.

Tekla Structural Designer creates the beam.

See also

Create single span beams (page 404)

Create plated or compound section steel beams (page 409)

Create continuous beams (page 405)

Create curved beams (page 406)

DELTABEAM®

DELTABEAM® is a proprietary slim floor system. While DELTABEAM® sections
can be analysed in Tekla Structural Designer they are not designed.

NOTE DELTABEAMS® are manufactured by Peikko in Finland: www.peikko.com.

The Peikko Designer download, (English language version) is available from:

https://www.peikko.com/design-tools/

Workflow in Tekla Structural Designer

• Initial DELTABEAM® section sizes are selected from the database and
applied in the model. Peikko Designer can be used if required to better
determine suitable initial sizes.

• The model is analysed, and a member forces report is created. This report
is then sent to Peiko.

• Peiko provide the detailed design and final analysis properties.

• The Tekla Structural Designer model is updated as required.

• If the properties have been revised, the self weight could be affected and
the model should be reanalysed.

• A further iteration may or may not be required.
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Create DELTABEAMS®

1. On the Model tab, click the arrow next to Steel Beam.

2. In the list, select DELTABEAM® 

The beam will adopt the properties displayed in the Properties window.

3. In the Properties window select the section required. 

NOTE D Series internal beams and DR Series edge beams can be
selected provided the database country is set to Finland, Norway,
Sweden, or Europe. You can add user defined sections to the
database for the same countries if required.

4. Select the construction as either composite, or non-composite, as
required.

5. Adjust the remaining properties according to your needs.

6. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the beam. 

TIP If Tekla Structural Designer prompts you to pick another point, do
one of the following:

• Click the end point again.

• Press Esc.

Tekla Structural Designer creates the beam.

NOTE If you are placing a DR series edge beam, the flange will be drawn
to the left of the line from start point to end point (easily verified
in a 3D scene view). Once the beam has been placed, if you want
to switch it to the other side simply select Reverse on the Edit tab
and then click on the beam.

See also:

• Create single-span beams (page 404)

• Create continuous beams (page 405)
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Create a member forces report

If you haven't already got a suitable report style configured you will need to
create one as follows:

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. To add a report, click Add and type a name for the report in the Active
Style field.

3. To add the member forces chapter to the report, expand the Analysis
headung in 'Chapters and Options' and drag the Member Forces chapter
to the Report Structure pane on the right.

4. Review the report structure and modify it (page 950) according to your
needs.

5. To limit the output to selected levels, frames, planes, or sub structures,
apply a model filter (page 951). 

TIP You can further limit the output of Loadcases and Combinations
sub chapters by applying a loading filter (page 951).

6. Click OK.

7. Click Show Report to review the report and check that it is displaying the
required level of data.

Once the report is configured to your needs, it can then be exported to Excel,
PDF, Word, or Tedds.

See also:

• Create general arrangement drawings (page 972)

Add DELTABEAM® properties to the database

Having submitted your member forces report to Peiko, you might be provided
with a new set of analysis properties that are not in the Tekla Structural
Designer database. In this situation you would need to add them as follows:

1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the appropriate DELTABEAM Series.

5. Click Add...

6. Enter values for each of the requested variables as supplied by Peiko.
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7. Click OK.

The new section size is now displayed in the Item pane.

Related video

Easy modeling of Peikko Deltabeams

Create web openings in steel members

You can add square, rectangular, and circular web openings to beams and
columns either by specified them manually, or by using a Quick layout
option. FABSEC® beams can also have elongated openings specified.

RESTRICTION 1. Although web openings can be added to steel beams and
columns, they are only considered in the design of:

• Non-composite beams designed to US codes, BS
codes, or Eurocodes

• Composite beams designed to US codes, BS codes, or
Eurocodes

2. Web openings are only valid in check design. If the auto
design flag is switched on the openings will be removed.

Web opening creation methods

You add web openings via the Web openings page of the Properties dialog
box.

The Quick layout method adds web openings to meet the geometric and
proximity recommendations published by the SCI. With this method, Tekla
Structural Designer creates web openings at the maximum depth and spaced
at the minimum centers recommended for the section size.

With the Quick layout option cleared you can also define web openings
manually using one of the following two methods:

• Clicking the Add button adds a new line to the web openings grid and
allows you to define the geometric properties of the opening.

• Clicking the Add... button opens the Web opening dialog box where you
can get more help and guidance when defining the opening.

Both manual methods use  and  signs to indicate faulty data when
defining the opening parameters.

For more assistance, hover the mouse pointer over a  or  sign.
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The Web opening dialog box

In the Web opening dialog box, you can use the following buttons to
automatically define the position of the web opening:

• The Center button positions the opening on the center of the member.

• The Auto button positions the opening to meet the spacing
recommendations by the SCI.

As web openings are defined, they are immediately visible in the diagram in
the Web opening dialog box.

Tekla Structural Designer also performs design checks when you are defining
web openings in the Web opening dialog box. The checked areas are end
posts, web posts, web opening dimensions and tee dimensions.

The  and  signs in the Web opening dialog box help you to decide
whether to make any adjustments to the opening parameters before Tekla
Structural Designer checks the design.

NOTE The design checks carried out at the current stage are geometric
checks only. Compliance with recommended limits is no guarantee
that the opening will pass the subsequent engineering design checks.

Add web openings using the Quick layout option

Using the Quick layout method allows you to create maximum depth
openings spaced at the minimum centers, appropriate to the section size.

1. Click the member to which you want to add web openings.

2. In the Properties window, ensure that the Autodesign option is cleared.

3. Right-click the member, and in the context menu, select Edit [element
name]. 

The Properties dialog box opens.

4. Go to Web openings.

5. Select the Quick layout option.

6. In the Label openings from list, select where you want to start the setting
out from.

7. In the Type column, select the web opening type. 

Data for the first web opening is automatically created as follows:

• IO: the length of the opening (applies to rectangular openings only)

• dO: the depth of the opening

• LCR: the distance from the setting out point to the center of the
opening
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• LC: the distance from the end 1 on the member to the center of the
opening

• dC: the distance from the top of the member to the center of the
opening

• LCR relative to: indicates the setting out point from which LCR is
measured.

• Nr. rel. to: specifies an existing opening number that you want to use
as the setting out point for the new opening.

Nr. rel. to only applies if you selected one of the Opening -> options
in the LCR relative to column.

8. If necessary, in the Stiffening column, select the location of stiffening.

a. Type the details of the stiffeners manually as follows: 

• dS: depth of the stiffener

• tS: thickness of the stiffener

• LS: length of the stiffener

• eS: the distance from the edge of the opening to the center of the
stiffener

9. To create further openings from the selected setting out points, click Add
and select the opening type. 

TIP You can use the Label openings from list to switch to a new setting
out point for the next opening at any point.

10. When you have created the desired openings, click OK.

Add web openings manually

1. Click the member to which you want to add web openings.

2. In the Properties window, ensure that the Autodesign option is cleared.

3. Right-click the member, and in the context menu, select Edit [element
name]. 

The Properties dialog box opens.

4. Go to Web openings.

5. Ensure that the Quick layout option is not selected.

6. In the Label openings from list, select where you want to start the setting
out from.

7. Click Add...

8. In the Type column, select the web opening type.
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9. Specify the following details for the opening: 

• IO: the length of the opening (applies to rectangular openings only)

• dO: the depth of the opening

• LCR: the distance from the setting out point to the center of the
opening

• LC: the distance from the end 1 on the member to the center of the
opening

• dC: the distance from the top of the member to the center of the
opening

TIP Click Center for dC to be automatically calculated to position the
opening centrally in the section depth.

• LCR relative to: indicates the setting out point from which LCR is
measured.

• Nr. rel. to: specifies an existing opening number that you want to use
as the setting out point for the new opening.

Nr. rel. to only applies if you selected one of the Opening -> options
in the LCR relative to column.

10. If necessary, in the Stiffening column, select the location of stiffening.

a. Type the details of the stiffeners manually as follows: 

• dS: depth of the stiffener

• tS: thickness of the stiffener

• LS: length of the stiffener

• eS: the distance from the edge of the opening to the center of the
stiffener

11. To create the opening, click OK.

12. To create further openings, do one of the following:

• To create multiple copies of a selected opening, click Copy...

• To create a single opening of a different size or spacing, click Add...

Add haunches to steel beams

1. Right-click the steel beam to which you want to add a haunch, and in the
context menu, select Edit [element name]. 

The Properties dialog box opens.

2. Go to Haunches.

3. Select the appropriate Create option for the required haunch location.
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4. In the Haunch dialog, define the haunch parameters as required. 

The haunch depth is measured from the beam centerline and length is
measured horizontally from the sharp end of the haunch to the beam
insertion point. In the case of an inclined beam the haunch length and
depth would therefore be measured as shown below.

5. When you have defined the haunch parameters, click OK.

See also

Create single span beams (page 404)

Create braces
Tekla Structural Designer allows you to create single braces, or pairs of braces
(in an X, K, V, or A configuration).

Braces are single span members with pinned end connections that are only
able to resist axial compression and tension. Their purpose is to provide
lateral stability to your structure.

TIP You can specify rigid frames to achieve the same effect as by using
braces. If necessary, you can use both rigid frames and braces within a
single structure.

Element loads cannot be applied directly to a brace itself and moments due to
self weight loading are ignored.

NOTE Although it is possible to model A or V brace configurations using individual
brace members instead of a brace pair, Tekla Structural Designer is then not
able to calculate the notional loads or EHFs (Equivalent Horizontal Forces)
correctly. In this case, elements of the vertical loads that are supported by the
bracing system are lost, and are not included in the notional load or EHF
calculations.
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Setting out braces
Each steel brace is placed on an insertion line between points, with its
geometry being drawn to reflect the major and minor snap points and any
offsets specified in the brace properties.

NOTE The alignment snap points and offsets have no effect on the
positioning of the solver elements created in the solver models, as
these will be created directly between the insertion points.

1. Do one of the following:

To Do this
Create a steel brace a. On the Model tab, click the arrow under

Steel Brace.

b. In the list, select the desired brace type.

Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

c. Select the desired brace type.

Create a timber brace a. On the Model tab, click the arrow on the

right side of Timber Brace.

b. In the list, select the desired brace type.

2. In the Properties window, go to the Section property.

3. Click the arrow on the right side of Section.

4. In the list that appears, click <New\Edit...>. 

The Select Section dialog box opens.

5. Select the desired section, and click Select.

6. In the Properties window, adjust the remaining properties according to
your needs.

Specify the brace type and section size
Before creating a brace, you need to specify its type and section size. For more
information, see the following instructions.

1. Do one of the following:

To Do this
Create a steel brace a. On the Model tab, click the arrow under

Steel Brace.

b. In the list, select the desired brace type.
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Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

c. Select the desired brace type.

Create a timber brace a. On the Model tab, click the arrow on the

right side of Timber Brace.

b. In the list, select the desired brace type.

2. In the Properties window, go to the Section property.

3. Click the arrow on the right side of Section.

4. In the list that appears, click <New\Edit...>. 

The Select Section dialog box opens.

5. Select the desired section, and click Select.

6. In the Properties window, adjust the remaining properties according to
your needs.

Create a single brace

NOTE A and V Braces should be modeled using special tools. Although you
can model the exact same A or V brace arrangement using individual
brace members, Tekla Structural Designer cannot calculate the
notional loads or EHFs (Equivalent Horizontal Forces) of the braces
correctly. In this case, elements of the vertical loads that are
supported by the bracing system are lost, and are not included in the
notional load or EHF calculations.

1. Select the brace type and size.

2. Click the start point of the brace. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

3. Click the end point of the brace. 

Tekla Structural Designer creates the brace.

Create an X, K, V or A brace

1. Do one of the following:
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To Do this
Create a steel brace • On the Model tab, click the arrow under

Steel Brace.

Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

Create a timber brace • On the Model tab, click the arrow on the

right side of Timber Brace.

2. In the list, select the desired brace pattern. 

The braces adopt the properties that are currently displayed in the
Properties window.

3. In the Properties window, adjust the properties according to your needs.

4. Click to identify a bottom corner of the bay that you want to brace.

5. Click to identify the opposite bottom corner of the bay.

6. Click to identify a top corner of the bay.

7. Click to identify the opposite top corner of the bay. 

Tekla Structural Designer creates the brace pattern within the selected
area.

Specify a brace as tension only or compression only
You can move the end nodes of individual steel, concrete, cold formed, or
timber braces in both 2D and 3D views. For more information, see the
following instructions.

Once a brace has been created, you can specify it as Tension only or
Compression only in the Properties window.

NOTE Tension only and Compression only members are non-linear elements
and therefore require non-linear analysis. If linear analysis is
performed, they will be treated as linear elements.

1. Select the brace.

2. In the Properties window select either Compression only, or Tension
only as required.
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Modify the position of a brace
You can move the end nodes of individual steel, concrete, cold formed, or
timber braces in both 2D and 3D views. For more information, see the
following instructions.

To move an entire brace, see: Move objects (page 495).

1. Select the brace.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click a grid or construction point where you want to move the end node. 

Tekla Structural Designer redraws the brace, moving the end node to the
selected point.

See also

Brace properties (page 2085)

Member global offsets (page 422)

Member global offsets
In certain situations you may have a requirement to model different global
(X,Y,Z) physical offsets at each end of a member.

In Tekla Structural Designer global offsets can be applied to steel, cold formed,
cold rolled and timber member types, but with the following exceptions:

• columns (all materials),

• concrete beams

• analysis elements

• members with haunches

• curved members

NOTE Global offsets have no affect on the positioning of the 1D solver elements in
the solver models; they have no impact on loading, analysis or design. Global
offsets only affect the graphics and BIM integration.

Global offsets are applied to the member ends before any major/minor local
offsets, the local offsets thus being applied to the whole length of the member
in relation to the new line.

NOTE Global offsets are included in the BIM import/export to/from Tekla Structures
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Global offset combined with major offset example

A horizontal brace member is specified with a Global End 2 offset of -200mm
and a major (local) offset of -500mm, so that its alignment properties are as
follows:

While the offsets do not affect the insertion line (denoting the 1D solver
element in the analysis model), the brace itself is offset in the graphics as
shown below:
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Global offset only example

A diagonal brace member is specified with a Global End 1 offsets of 200mm in
Z and 400mm in Y, the Major and Minor (local) offsets are both 0mm, so that
its alignment properties are as follows:

While the offsets do not affect the insertion line (denoting the 1D solver
element in the analysis model), the brace itself is offset in the graphics as
shown below:
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Global offsets

Create walls, cores and bearing walls
These topics introduce you to the methods of creating walls, cores, and
bearing walls.

We recommend you familiarize yourself with how to:

• Create concrete walls (page 426)

• Create concrete cores (page 435) (from existing concrete walls, columns
and beams)

• Create bearing walls (page 438)

• Create shear only walls (page 442)

• Create general walls (page 444)
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Create concrete walls
This section focuses on the operations required to create concrete walls.

• Overview of the concrete wall model (page 426)

• Create concrete walls (page 428)

• Specify extensions and releases (page 429)

• Create concrete cores (page 435)

• Create and modify wall supports (page 430)

• Create door or window openings (page 432)

Overview of the concrete wall model
Tekla Structural Designer allows you to create both meshed and mid-pier
concrete walls.

Geometric rules for meshed concrete walls

• Meshed walls are defined as quadrilaterals in a single plane that can be
vertical or sloping, (unlike mid-pier concrete walls which must be
rectangular in a vertical plane).

• Openings (page 432) are permitted in meshed walls.

• The alignment and offsets in the wall properties are not structurally
significant as they have no affect on the solver elements that are formed in
the solver model.

• By default, meshed walls use the mesh parameters that are defined in
Structure Properties. However, you can override these for an individual
wall by checking Override model's in the Meshing section of the wall's
properties. You are then able to apply a user-defined mesh to the wall.

• Concrete meshed walls can be included in cores, General meshed walls
cannot.

Sub-division of meshed walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Geometric rules for mid-pier concrete walls

• Mid-pier walls must be rectangular in a vertical plane.

• Wall openings are ignored.

• The alignment and offsets specified in the wall properties are not
structurally significant as they have no affect on the solver elements that
are formed in the solver model.

• Mid-pier walls can be included in cores.
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Sub-division of mid-pier walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Continuous concrete walls

Tekla Structural Designer allows you to create walls that are several storeys
high and that can start and finish at any level.

Although Tekla Structural Designer only creates one wall in this case, you can
define different thicknesses for each wall panel. The panels are then set back
on one or both faces, depending on the alignment that you have specified.

Creating a continuous wall this way, instead of defining a new wall on each
floor, does not have any significance for analysis or design purposes. However,
it is ultimately important for detailing purposes.

Analysis of concrete walls

The points that you use to place a concrete wall define the exact size and
position of the wall’s analysis model. The alignment and extension properties
of the wall have no effect on the analysis model.

Tekla Structural Designer can adopt either an FE meshed or mid-pier wall
analysis on a wall by wall basis.

Support

Provided that the AutomaticGenerateSupport option is selected, if no slab or
other member exists beneath the wall when it is first created, Tekla Structural
Designer automatically places a support underneath the wall.

Material Type

For walls with the Material type set to concrete (as opposed to general), there
are then two types of Fabrication available:

• Cast-in-place

• Precast

For each fabrication type there are two Concrete types available:

• Normal

• Lightweight

The Grade lists all the available grades in the Materials database under the
current head code for the selected Concrete type.

Releases

You can apply minor axis releases at the top and the bottom of each panel in
order to model pinned connections to incoming slabs and members.
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Door and window openings

You can only define door and window openings in meshed walls. Tekla
Structural Designer does not allow you to create openings in mid-pier walls.
For more information openings, and the alternative ways to model them, see:
Concrete wall openings analysis model (page 432)

Purpose of concrete walls

Both meshed and mid-pier concrete walls introduce structural strength and
stiffness to your model. However, they do not perform the same function as
wall panels. This means that wind loads calculated by the Wind Wizard cannot
be applied to your structure if the model does not contain wall panels.

In order to apply wind loads, you must create additional wall panels in the
same physical locations as the concrete walls.

Create meshed or midpier concrete walls
You can create meshed or mid-pier concrete walls both in 2D views and frame
or structure views. For detailed information on creating concrete walls, see the
following instructions.

Create concrete walls in a level view

1. On the Model tab, click the arrow below Concrete Wall.

2. In the list that appears, select the desired wall type.

• Mid-pier Wall

• Meshed Wall

3. Go to the Properties window.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. In the model, click the start point of the wall. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the wall. 

Tekla Structural Designer creates the wall.
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Create concrete walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below Concrete Wall.

2. In the list that appears, select the desired wall type.

• Mid-pier Wall

• Meshed Wall

3. Go to the Properties window.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. Click the point where the base of the wall should start.

7. Click the point where the base of the wall should end.

8. Click the point where the top of the wall should start.

9. Click the point where the top of the wall should end. Tekla Structural
Designer creates the wall between the selected four points.

See also

Concrete meshed and mid-pier wall properties (page 2098)

How meshed walls are represented in solver models (page 750)

How mid-pier walls are represented in solver models (page 755)

Create door or window openings (page 432)

Specify extensions and releases
Tekla Structural Designer allows you to trim new walls automatically, and trim
or extend existing walls manually. In addition, you can specify minor axis
releases to the top or bottom part of panels. For more information, see the
following instructions.

See also

Create concrete walls (page 428)

Create door and window openings (page 432)

Concrete wall extensions

Specify extensions

• Do one of the following:
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To Do this
Automatically trim a new wall back to the face of
existing columns and walls

1. In the Properties window, select the
AutomaticExtension option.

2. Create the wall.

Manually trim or extend existing walls 1. Select the wall that you want to trim or
extend.

2. Go to the Properties window.

3. In the End 1 extension or End 2 extension
field, define the desired extension.

NOTE A positive extension extends the
wall length beyond its insertion
point.

A negative extension trims the wall
back from its insertion point.

Specify releases

1. Select the wall to be released.

2. In the Properties window, go to Releases.

3. In the Minor Top or Minor Bottom list, select the desired release:

• Fixed

• Pinned

• Continuous (incoming members pinned): only available for FE
meshed walls

TIP To specify a pinned connection to a supported slab, use an FE
meshed wall and select the Continuous (incoming members
pinned) option.

We recommend this option because the Pinned option also
releases the wall panel above from the wall panel below. This
may result in a mechanism during the analysis.

Create and modify wall supports
If needed, you can set Tekla Structural Designer to automatically generate
support for walls. In addition, you can modify the degree of freedom of the
wall support, and remove an unnecessary wall support. For more information,
see the following paragraphs.

Automatic support generation

The AutomaticGenerateSupport option in wall properties controls whether a
support is automatically created at the wall base level.

When the AutomaticGenerateSupport option is selected:
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• If there are members or slabs underneath the wall capable of providing
support, no support is generated.

• If there are no members or slabs underneath the wall capable of providing
support, a support is generated.

When the AutomaticGenerateSupport option is cleared:

• If the Generate support option is selected, a support is generated.

• If the Generate support option is not selected, no support is generated.

When a support is required, Tekla Structural Designer forms it as follows:

• Under a meshed wall, Tekla Structural Designer creates a line support.

• Under a mid-pier wall, Tekla Structural Designer creates a point support.

• Under a bearing wall, Tekla Structural Designer creates a series of point
supports.

When a support is required, its degrees of freedom are as specified in wall
properties, under Wall support.

See also

Create concrete walls (page 428)

Modify wall support fixity

NOTE Supports can only be edited or deleted for both mid-pier and meshed
concrete walls via the wall properties.

1. In the Properties window, expand Wall support.

2. Specify the degrees of freedom according to your needs. 

NOTE The discrete supports at each node are always angled in the
global axis system, and not aligned with the wall major/minor
axes.

That is why you need to set both Mx and My to Free. This way,
you can ensure that angled walls are pinned out of plane. This is
not strictly necessary if the wall is aligned in global X or Y. In this
case, you can set only Mx or My free, as appropriate.

Similarly, set both Mx and My to Fixed in order to ensure that
angled walls are fixed out of plane.

Remove a wall support

NOTE Supports can only be edited or deleted for both mid-pier and meshed
concrete walls via the wall properties.
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1. In the Properties window, clear the Generate support option. 

NOTE The Generate support option is only available for editing if the
AutomaticGenerateSupport option is inactive. When
AutomaticGenerateSupport is selected, Generate support is
automatically cleared if members are created underneath a wall
to support it. Similarly, Generate support is automatically
reselected, if the supporting members are deleted.

Create door or window openings
Tekla Structural Designer allows you to create openings for both doors and
windows in existing walls. For detailed instructions, see the following
paragraphs.

RESTRICTION Openings are only active in meshed walls.

1. Open a frame view of the frame that contains the desired meshed wall.

2. On the Model tab, click Wall Opening.

3. Do one of the following:

• To define the opening relative to the bottom left corner of the wall,
click the outline of an existing wall panel.

• To define the opening relative to the selected node, click a specific
node in the model.

4. Click the first corner of the opening or press F2 to define its exact
position.

5. Drag the mouse pointer to the opposite corner of the opening.

6. Click the opposite corner of the opening or press F2 to define its exact
position. 

Tekla Structural Designer creates the opening.

See also

Create meshed or midpier concrete walls (page 428)

Meshed wall openings analysis model (page 432)

Meshed wall openings analysis model

Limitations of wall openings

1. If you have specified a door or window opening in a wall panel you must
model the wall using FE elements, otherwise a "Walls with openings have
a mid-pier" validation error is displayed and the analysis will not proceed.
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2. A "Panel contains openings - these are ignored in design" warning will
always be issued when a wall containing openings is designed. When you
encounter this warning, as well as taking stock of the design implications;
you need also to consider if the analysis model is appropriate, as
potentially it may not reflect your original intention. In certain situations
the Alternative model for wall openings (described below) may prove to
be a better solution.

Analysis model applied to meshed wall panels with openings

If an opening is introduced in a meshed wall, the properties of the "lintel" wall
beam directly above the opening are automatically adjusted in order to
prevent the panel being unrealistically stiff. The adjustments that are applied
are as follows:

• wall beam properties in the lintel use the lintel depth (h2), rather than the
panel depth (h1)

• wall beam nodes in the lintel are removed from the slab diaphragm

Modeling in this way the lintel becomes less stiff resulting in improved wall
results when subject to gravity and lateral loading.

Alternative model for wall openings

If the presence of an opening would form a beam like strip above or below the
opening, you are advised to create separate wall panels to each side of the
opening and then model the strip between the panels with a connecting beam
('coupling beam').

This method can be demonstrated by considering the below example,
consisting of a two story wall with a large opening at each level.
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If the openings were to be created as a window and door the resulting model
would be as shown:

However, by separating the wall into discrete panels and inserting coupling
beams you obtain an alternative model as below:
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Such an idealisation enables the panels either side of the openings to be
designed for their respective forces and enables the strips between the
openings to be designed as beams.

Of course, this approach will require some additional detailing, but that would
have been the case anyway had the openings been added and subsequently
ignored by the design.

Create concrete cores
Tekla Structural Designer allows you to combine concrete wall panels,
columns, and beams to form cores.

Overview of concrete cores

Concrete wall panels, columns, and beams can be combined to form cores for
which overall analysis results are automatically calculated and available for
review and output.

Such cores might then be used in a number of ways, for example:

• The engineer may wish to see/ output core forces to; better understand the
distribution of lateral forces within the structure; for additional checks they
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wish to undertake; for overall core foundation forces or exclusive core
reactions for cores on foundation mats.

• Cores provide a way of checking lateral forces per object type or SFRS type.
This might be used when assessing buildings for some codes which require
frames in dual systems to resist a minimum amount of seismic load.

• Adding all elements of the lateral system to a single core will give overall
building vertical and lateral load, overturning moments or accumulated
seismic torsion, in any direction.

Any number of walls (meshed and mid-pier), columns, and beams can be
added to a core.

• Constituent objects of a core do not need to be physically attached.

• Once defined the core is listed in the structure tree and can be graphically
selected as a single entity. When selected, its properties are displayed in
the Property Window and Delete, Move, Copy and Mirror operations can be
applied to it.

The directions of each core can be defined as any of; Dir 1/2 - Main Building
Directions; Principal 1/2 - Major and minor local axis; Angle - (w.r.t.) Global
Coordinate System.

The following core properties are automatically calculated/ displayed; Core
section for each level; Core centroid and its coordinates above and below each
level; a Core line with Local coordinate system (LCS) assigned and displayed at
the centroid location; a Core support (for reporting purposes not analysis).

After analysis the following core results are available:

• Core Line Forces - 2D Integrated Results termed “Core Line” results for
cores giving the following overall core forces; Axial Force, Major and Minor
axis Moment and Shear, Torsion.

• In the Results View via 2D Integrated Results > Core Lines, force
diagrams of these results are displayed along the core line w.r.t. its LCS,
with numerical values displayed at the top and bottom of each core
stack and in the Tooltip when the result diagram is cursored over.

• Results are available for all of; All Static Analyses including chase-down;
RSA Seismic both for individual modes and Modal combination;
Imposed/Live load reductions.

• Tabular Results - Core results are also available in Tabular form via
Analyze > Tabular Data and the associated Report option Analysis >
“Core Line Forces”.

NOTE Settings controls in the Member Forces and Wall Line Forces
Report items allow you to optionally exclude columns/walls
assigned to cores.

• Core Reactions - overall Reaction results are calculated for the core and
can be viewed in the Results view via Reactions > Cores and output.
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Create concrete core (assisted mode)

Cores are either created in Assisted or Unassisted mode. In assisted mode
(which is the default), all potential members of a core are automatically
highlighted when the cursor is moved over any of the constituent members,
giving a preview of the core that can be created - a single click then adds all
the highlighted walls to a new core.

1. On the Model tab, click Cores.

1. Assisted Mode

2. In the Properties window, select Assisted.

3. Select an appropriate wall panel or column and all highlighted members
are added to the core. 

The mode switches to Modify to enable you to edit the core if required.

4. If no modifications are required, press Esc to finish. 

NOTE Assisted Mode detects overlapping concrete walls, columns and
coupling beams* that may potentially form a core.

*Beams for which the Construction property is set = “Coupling
Beam”. Note that no additional design checks are performed for
this construction type so currently it serves only to mark beams;
for consideration by the assisted mode core function; for which
additional design checks beyond those currently made in the
program may be required.

Create concrete core (unassisted mode)

1. On the Model tab, click Cores.

2. In the Properties window, unselect Assisted.

3. Select either a wall panel or column as the first member of the core.

4. Select the next wall panel, column, or beam to be part of the core. 

NOTE You can drag the mouse pointer to select multiple members.

5. Continue selecting until all the members of the core have been chosen,
and then press Esc to finish. 

Tekla Structural Designer combines the selected members into a single
core.
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Set the core axis direction
Analysis results are displayed with respect to the axis diection of each core.
This can be aligned to the main building directions, the major and minor local
axis, or to a specified angle.

1. Select the core.

2. In the Properties window, choose the rotation angle as required.

Modify concrete core

1. On the Model tab, click Cores.

2. In the Properties window,

a. Set Mode to Modify

b. Select the Active Core as required.

c. Set Area Selection Mode to Set On to add members to the core, or
Set Off to remove members from the core.

3. Select a member to add or remove from the core.

4. Continue selecting or press Esc to finish. 

Tekla Structural Designer combines the selected members into a single
core.

Dissociate concrete core
Existing cores can be disconnected if required.

1. Hover the mouse pointer over the core.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the required core reference is shown in the Select Entity tooltip.

3. Right click and select Dissociate Core.

Related video

Core modeling

Create bearing walls
Bearing walls provide resistance to vertical compressive loads (but not lateral
loads) and support certain other member types. Unreinforced masonry walls,
for example, can be modeled as bearing walls.
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You can model bearing walls over several storey heights. In these cases, Tekla
Structural Designer creates a single wall with a uniform thickness between the
base and top level.

Tekla Structural Designer determines the location of the wall from the
alignment specified in the bearing wall properties, and the selected insertion
points.

NOTE Bearing walls do not perform the same function as wall panels. In other
words, bearing walls do not allow you to apply loads calculated by the Wind
Wizard to your structure.

Therefore, in order to apply wind loads, you must create additional wall
panels in the same locations as the bearing walls.

Material type

Three Material types are available for bearing walls:

• Concrete

• Timber

• General

Concrete Bearing Walls

There are two Concrete types available:

• Normal

• Lightweight

The Grade lists all the available grades in the Materials database under the
current head code for the selected Concrete type.

Timber Bearing Walls

The Grade lists all the available grades in the Materials database under the
current head code for Timber.

General Bearing Walls

The Grade lists all the available General materials in the Materials database
under the current head code.
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If the grade you want to use is not listed, you can open the Materials dialog
and add the grade to the database (page 1016), taking care to first select the
General material type as shown below.
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Geometric rules

• Bearing walls can only be created as rectangular in a vertical plane.

• Wall openings are ignored.

• Bearing walls cannot be included in cores.

Create bearing walls in a level view

NOTE Ensure that you have defined the construction levels between which
the wall will run, and the grid points between which the wall will lie.
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1. On the Model tab, click Bearing Wall. 

The wall will adopt the properties displayed in the Properties window.

2. Go to the Properties window.

3. If necessary, adjust that the base level and top level of the wall.

4. Adjust thickness and other wall properties according to your needs.

5. In the model, click the start point of the wall.

6. Click the end point of the wall. 

Tekla Structural Designer creates the wall between the selected start and
end points.

Create bearing walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run and the grid points between which it will lie.

1. On the Model tab, click Bearing Wall. 

The wall will adopt the properties displayed in the Properties window.

2. In the Properties window, adjust the thickness and other wall properties
according to your needs.

3. In the model, click the first corner of the wall.

4. Click the opposite corner of the wall. 

Tekla Structural Designer creates the wall between the selected points.

See also:

Bearing wall properties (page 2133)

How bearing walls are represented in solver models (page 761)

Create shear only walls
Shear only walls provide resistance to in-plane lateral loads only.

You can model shear only walls over several storey heights. In these cases,
Tekla Structural Designer creates a single wall with a uniform thickness
between the base and top level.

Tekla Structural Designer determines the location of the wall from the
alignment specified in the shear only wall properties, and the selected
insertion points.
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NOTE Requirements for these walls are that they must be; within a single bay (i.e. do
not overlap one or more columns); strictly rectangular; vertical and
surrounded by columns and beams (other than at the bottom edge).

NOTE Shear only walls do not perform the same function as wall panels. In other
words, shear only walls do not allow you to apply loads calculated by the
Wind Wizard to your structure.

Therefore, in order to apply wind loads, you must create additional wall
panels in the same locations as the shear only walls.

Material type

The chosen material will only affect the weight of the wall. Whilst Shear only
walls are most suited to masonry, three Material types are available:

• Concrete

• Timber

• General

Geometric rules

• Shear only walls can only be created as rectangular in a vertical plane.

• They must be totally enclosed by members (concrete or steel), except at
the base.

• Wall openings are ignored.

• Shear only walls cannot be included in cores.

Create shear only walls in a level view

NOTE Ensure that you have defined the construction levels between which
the wall will run, and the grid points between which the wall will lie.

1. On the Model tab, click  Shear Only Wall. 

The wall will adopt the properties displayed in the Properties window.

2. Go to the Properties window.

3. If necessary, adjust the base level and top level of the wall.

4. Adjust stiffness, thickness, and other wall properties according to your
needs.

5. In the model, click the start point of the wall.

6. Click the end point of the wall. 

Tekla Structural Designer creates the wall between the selected start and
end points.
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Create shear only walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run and the grid points between which it will lie.

1. On the Model tab, click  Shear Only Wall. 

The wall will adopt the properties displayed in the Properties window.

2. In the Properties window, adjust the stiffness, thickness, and other wall
properties according to your needs.

3. In the model, click the first corner of the wall.

4. Click the opposite corner of the wall. 

Tekla Structural Designer creates the wall between the selected points.

See also:

Shear only wall properties (page 2136)

How shear only walls are represented in solver models (page 757)

Create general walls
You can create meshed general walls in level, frame, or structure views. For
detailed information on creating general walls, see the following instructions.

Material type

The Grade lists all the available General materials in the Materials database
under the current head code.
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NOTE Care should be taken when choosing the grade, as some general
materials in the database may not be appropriate for meshed walls.
Meshed walls resist loads in all directions and isotropic stiffness
properties are assumed.

If the grade you want to use is not listed, you can open the Materials dialog
and add the grade to the database (page 1016), taking care to first select the
General material type as shown below.
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Geometric rules

• Meshed walls are defined as quadrilaterals in a single plane that can be
vertical or sloping, (unlike mid-pier concrete walls which must be
rectangular in a vertical plane).

• Openings (page 432) are permitted in meshed walls.

• The alignment and offsets in the wall properties are not structurally
significant as they have no affect on the solver elements that are formed in
the solver model.
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• Concrete meshed walls can be included in cores, General meshed walls
cannot.

Sub-division of meshed walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Create general walls in a level view

1. On the Model tab, click the arrow below  General Wall.

2. Go to the Properties window.

3. Ensure the Material Type is set to General, then use the Grade property to
select the general material type.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. In the model, click the start point of the wall. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the wall. 

Tekla Structural Designer creates the wall.

Create general walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below General Wall.

2. Go to the Properties window.

3. Ensure the Material Type is set to General, then use the Grade property to
select the general material type.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. Click the point where the base of the wall should start.

7. Click the point where the base of the wall should end.
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8. Click the point where the top of the wall should start.

9. Click the point where the top of the wall should end. Tekla Structural
Designer creates the wall between the selected four points.

See also

General wall properties (page 2106)

How meshed walls are represented in solver models (page 750)

Specify extensions and releases (page 429)

Create and modify wall supports (page 430)

Create door or window openings (page 432)

Create slabs and decks
This section focuses on the operations required to create slabs and decks.

• Overview of the slab model (page 448)

• Create slab items (page 453)

• Create slab or mat openings (page 455)

• Add overhangs to existing slab or mat edges (page 457)

• Apply curved edges to existing slab items (page 459)

• Create column drops (page 459)

• Specify the material for general slab types (page 460)

• Split and join slabs and mats (page 462)

Overview of the slab model
Slabs allow you to decompose loads placed on a floor back to the supporting
structure. You can create slabs in either levels or inclined planes. For more
information, see the following paragraphs.

Slabs and slab items

Tekla Structural Designer stores slab data in the form of parent slabs, each
consisting of one or more individual panels, called slab items. Slab items can
be either connected or separated from each other. However, they must be on
the same level.

Every parent slab has a unique name. A slab name used at one level can not
be re-used at a different level.

Every parent slab has general properties of slab type (and associated deck
type) as follows:
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• Slab on beams

• Reinforced concrete

• Post tension

• Flat slab

• Reinforced concrete

• Post tension

• Precast

• Precast concrete planks

• Composite slab

• Profiled metal decking

• General

• Steel plate

• Timber

• General

Every parent slab also has a load decomposition property:

• One-way

• Two-way

Slab items initially inherit their properties from the parent slab. However, once
the slab items have been created, you can modify them to amend certain
properties: you can change the rotation angle, override the slab depth, or
exclude a panel from the diaphragm. Once you have overridden the slab
depth, you can also apply a vertical offset in order to model a slab step.

In the view below, there are 24 slab items grouped together in one slab.

Tekla Structural Designer sets some data on the slab level and is common to
all slab items, while other data is set at the slab item level. In simple overview
terms, the data breakdown is as follows:

Slab data:
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• Slab type

• Deck type

• Decomposition

• Thickness

• Vertical offset

• Material properties

• Analysis settings

• General design settings

Slab item data:

• Cover

• Reinforcement information

• Specific design settings

Therefore, you can create slabs over a wide area. While creating slabs, you do
not have to consider sub-sections of the slab - you can simply create one big
expanse of slab.

When it comes to design, you need to conceptualize the slab as a series of
design panels, or slab items. Each slab item will have its own design settings
and its own design results. You can select different reinforcement in different
panels. You also have to consider pattern loading, where some panels are
loaded, and others not.

When results are later presented in calculations and drawings, you can
specifically reference the design panels.

Comparison of slab types

The different slab types available in Tekla Structural Designer are compared in
the below table.

 Slab on
beams

Flat slab Precast Composite General

Deck Type • Reinforc
ed
concret
e

• Reinforc
ed
concret
e

• Precast
concret
e planks

• Profiled
metal
decking

• steel
plate

• timber

• general
See: Create slab items (page 453)

Decomposi
tion

• 1-way

• 2-way

• 2-way • 1-way • 1-way • 1-way

• 2-way
See: Overview of one-way and two-way load decomposition
(page 557)
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 Slab on
beams

Flat slab Precast Composite General

Diaphragm
action

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none
See: Overview of diaphragm action in roof panels and slabs
(page 655)

Load • all panel
load
types

• all panel
load
types

• all panel
load
types

• all panel
load
types

• all panel
load
types

See: Apply panel loads (page 538)
Modificati
on factors
for 2-way
spanning
slabs

• yes • yes • n/a • n/a • yes
See: Analysis Settings>Modification factors (page 2290)

Meshed in
3D
analysis
and
grillage
chasedow
n models

• 1-way:
no

• 2-way:
optional

• optional • no • no • 1-way:
no

• 2-way:
optional

See: Define whether slabs are meshed for 3D building analysis
and grillage chasedown analysis (page 637)

Meshed in
FE
Chasedow
n analysis

• 1-way:
no

• 2-way:
yes

• yes • no • no • 1-way:
no

• 2-way:
yes

See: Manage FE meshed slabs (page 637)
Designed
in Tekla
Structural
Designer

• 1-way -
beyond
scope

• 2-way-
yes

• yes • beyond
scope

• beyond
scope

• beyond
scope

See: Design slabs and run punching shear checks (page 789)

Vertical alignment

The vertical alignment of all slabs in a given level is determined by the
construction level type specified in the Construction Levels dialog. The
possible types are:

• T.O.S. (Top Of Steel): the base of each slab item aligns with the level.

• S.S.L. (Structural Slab Level): the top of each slab item aligns with the level.
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• T.O.F. (Top Of Foundation): the base of each slab item aligns with the level.

Vertical offsets

A vertical offset can be specified after checking ‘Override slab depth’ in the
slab item properties.

These offsets are not structurally significant in slabs as they have no effect on
the analysis mesh position relative to the top of the slab in the solver model.
However, the mesh properties would reflect any change in the slab thickness.

Slab edges

Slab edges can be either straight or curved.

See: Apply curved edges to existing slab items (page 459)

Slab openings

You can create openings of any shape within slabs. These are only considered
when the slab is meshed for load decomposition or analysis.

See: Create slab or mat openings (page 455)

Column drops

Column drop panels are slab items with an increased thickness. In flat slabs, at
points where the slab is supported by columns, you can use column drops to
thicken the slab.

See: Create column drops (page 459)

Panel sub-division

Regardless of how the slabs and slab items are initially created, you can
further divide or re-form them with the Slab Split and Slab Join commands.
There are several reasons why you may choose to use the previously
mentioned commands, related to adding steps, loading patterns, and
designing panels.

For flat slabs in particular, the way that slabs are split for the purposes of
pattern loading is a matter of engineering judgement. The views below view
two options that two different engineers might both justifiably choose for the
same slab perimeter.
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See: Split and join slabs and mats (page 462)

Create slab items
Slab items are individual slab panels that form parent slabs. You can create
slab items either by bay, or by points. For more information, see the following
instructions.

Select the slab type and specify slab properties

1. On the Model tab, click the arrow under  Slabs.

2. In the list that appears, select the desired slab type.

3. In the Properties window, define the slab item parameters for the
selected slab type.

4. Ensure that the Slab and Select bays properties are set according to your
needs.

Specify the parent slab to which the slab item belongs

1. In the Properties window, go to the Slab property.

2. Click the arrow on the right side of Slab.

3. In the list that appears, select whether you want to:

• Create a new slab
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• Add to existing slab

NOTE When you select this option, at the point of creating the slab
item, Tekla Structural Designer checks if there is a existing slab
in the plane with same properties.

If Tekla Structural Designer finds an identical slab, the new
slab item will be added to it.

If Tekla Structural Designer finds two identical slabs, the
closest one is used.

If Tekla Structural Designer does not find an identical slab, a
new parent slab is created.

• Manually select the parent slab

NOTE This option is only available in 2D views after one or more slab
items have been placed in that view.

4. When the slab item properties are defined, you can place the item either
by bays or by picking points.

Create slab items by bay

You can only create slab items by bay in 2D Views.

1. In the Properties window, ensure that the Select bays option is selected.

2. Do one of the following:

To Do this
To add an individual slab item a. Click the outline of a bay bounded by

beams or walls.

To add slab items into all bounded bays • Drag a box that encompasses the bays.

NOTE Dragging the box from left to right
places items in those bays totally
enclosed by the box.

Dragging the box from right to left
places items in all bays that are either
enclosed by the box, or cross it.

Holding down Shift while dragging
creates a line instead of a box. Tekla
Structural Designer places slab items in
all bays that cross the line.

Create slab items by points

You can create slabs in both 2D and 3D Views.

1. In the Properties window, ensure that the Select bays option is cleared.
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2. Click the start point of the slab item.

3. Click other points that define the slab item outline.

4. Double-click the final point to create the slab item.

Create slab or mat openings
When you have created slabs or mats, you can create different kinds of
openings to them according to your needs. You can define rectangular,
circular, and irregular openings. For more information on how to create and
delete slab and mat openings, see the following instructions.

Simple openings

You can quickly define simple openings within existing slabs. Simple openings
are rectangular or circular in plan.

The Slab Opening command is located on the list in the Slabs group. The
command is only active in 2D views.

Slab openings can:

• Cross more than one slab item or slab

• Be overlaid or joined to create openings which together have shapes other
than rectangular

• Cut across a stepped edge

• Be applied to level an sloping slabs

Openings cannot:

• Be applied to one-way spanning slabs

• Reside within or cut a column drop

Irregular Openings

Alternatively, you can create more complex openings by using construction
lines and constructing slab items around an irregular shape.

Create rectangular openings

1. Open a 2D view of the level containing the slab item or mat panel within
which you want to create an opening.

2. Do one of the following:

To Do this
Create slab openings a. On the Model tab, click the arrow on the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Opening.
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Create mat openings

• On the Foundations tab, click Mat
Opening.

The opening properties are viewed in the Properties window.

3. In the Properties window, set the Opening Type to Rectangular.

4. If necessary, specify a rotation angle to rotate the opening on plan.

5. Click within the outline of an existing slab item or mat panel to define the
first corner of the opening, or press F2 to define its exact position.

6. Drag the mouse pointer to the opposite corner of the opening.

7. Click the opposite corner of the opening, or press F2 to define its exact
position. 

Tekla Structural Designer creates the opening.

Create circular openings

1. Open a 2D view of the level containing the slab item or mat panel within
which you want to create an opening.

2. Do one of the following:

To Do this
Create slab openings a. On the Model tab, click the arrow on the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Opening.

Create mat openings

• On the Foundations tab, click Mat
Opening.

The opening properties are viewed in the Properties window.

3. In the Properties window, set the Opening Type to Circular.

4. Click within the outline of an existing slab item or mat panel to define the
center of the opening, or press F2 to define its exact position.

5. Drag the mouse pointer to define the radius of the opening, or press F2 to
define the exact radius. 

Tekla Structural Designer creates the opening.

Delete slab or mat openings

1. In the Structure tree, open the Slab Openings branch.

2. Right-click the name of the slab or mat opening that you want to delete.
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3. In the context menu, select Delete. 

Tekla Structural Designer deletes the opening.

Add overhangs to existing slab or mat edges
At times, the edge of a slab or mat may extend beyond a grid line, either to the
edge of the beam which supports the edge of the slab, or around the
perimeter of the building to meet the inside face of the cladding. In order to
take these cases in to account, Tekla Structural Designer allows you to define
overhangs to the edges of a slab. An overhang may extend across many slab
items in one slab and can be curved, or tapered if required.

Any loads that you define over an overhang are included in the total loading
on your building.

You can only create overhangs in 2D views.

Add an overhang along the full length of a supporting beam

NOTE This method can only be used if a beam exists along the entire
slab/mat edge to which the overhang is to be added.

1. Open a 2D view of the level containing the slab/mat for which you want to
create the overhang.

2. Do one of the following:

To Do this
Create an overhang over a supporting beam to a
slab edge

a. On the Model tab, click the arrow in the
top right corner of the Slabs group.

b. In the list that appears, select Slab
Overhang.

c. In the Properties window, check
LengthOfBeam.

d. If necessary, in the Properties window,
modify the width and other properties of
the overhang.

e. Click on the beam over which the overhang
is to extend.

Create an overhang over a supporting beam to a
mat edge

• On the Foundations tab, the arrow under

Mat Opening.

• In the list that appears, select Mat
Overhang.

• In the Properties window, check
LengthOfBeam.

• If necessary, in the Properties window,
modify the width and other properties of the
overhang.
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• Click on the beam over which the overhang
is to extend.

Tekla Structural Designer creates the overhang along the length of the
beam.

Add an overhang to a slab or mat edge between two points

NOTE In order to define a slab overhang between two points, you must have
already defined the slab to which it applies.

1. Open a 2D view of the level containing the slab/mat for which you want to
create an overhang.

2. Do one of the following:

To Do this
Create an overhang to a slab edge a. On the Model tab, click the arrow in the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Overhang.

Create an overhang to a mat edge • On the Foundations tab, the arrow under

Mat Opening.

• In the list that appears, select Mat
Overhang.

The slab or mat overhang properties are viewed in the Properties
window.

3. Ensure the LengthOfBeam property is unchecked.

4. If necessary, in the Properties window, modify the width and other
properties of the overhang.

5. Click along the edge of an existing slab item or mat panel to define the
start point of the overhang, or press F2 to define its exact position.

6. Click along the same edge to define the end point of the overhang, or
press F2 to define its exact position. 

Tekla Structural Designer creates the overhang between the two points.

Add a curved overhang to a slab or mat edge

While following one of the above procedures to add an overhang along the
length of a supporting beam, or between two points:

1. In the Properties window, uncheck the Edge parallel property.

2. In the Properties window, define the Curvature of the overhang.

3. Continue to create the overhang in the normal way.
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Add a tapered overhang to a slab or mat edge

While following one of the above procedures to add an overhang along the
length of a supporting beam, or between two points:

1. In the Properties window, check the Tapered property.

2. Use the Width1 property to define the length of overhang at end 1.

3. Use the Width2 property to define the length of overhang at end 2.

4. Continue to create the overhang in the normal way.

Apply curved edges to existing slab items
You may sometimes need to create slab items that have curved edges instead
of linear ones. For detailed instructions to do so, see the following paragraphs.

1. Select the slab items that you want to modify.

2. According to you needs, do one of the following:

To Do this
Apply the same degree of curvature to all
selected slab edges

a. In the Properties window, go to All edges.

b. Clear the Linear option.

c. Define the required curvature.

A positive value creates an inward curve,
whereas a negative value creates an
outward curve.

Apply curvature to a specific edge a. In the Properties window, go to the
properties of the required edge.

The edges are numbered.

b. Clear the Linear option.

c. Define the required curvature.

A positive value creates an inward curve,
whereas a negative value creates an
outward curve.

Tekla Structural Designer redraws the slab item with the specified
curvature.

Create column drops
In order to increase punching resistance, you can insert drop panels, or
column drops, within concrete slabs at points where they are supported by
columns. Column drops are slab thickenings that can be positioned above the
slab, below the slab, or both. Column drops are rectangular in plan, and
aligned to the column axes. Column drops are always positioned centrally over
the supporting column.
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The extent of the column drop is limited by the extent of the slab boundary.
The cut back drop shape may not be rectangular.

NOTE In order to define a slab drop you must have already defined the
concrete slab to which it applies.

1. On the Model tab, click the arrow on the top right corner of the Slabs
group.

2. In the list that appears, select Column Drop. 

The column drop properties are viewed in the Properties window.

3. If necessary, in the Properties window, modify the properties of the
column drop.

4. Click an existing column connected to a concrete slab panel to create a
single column drop, or drag a box around multiple columns to create a
series of column drops. 

NOTE To insert the column drop correctly, ensure that the type of the
construction level containing the slab is S.S.L., not T.O.S.

Specify the material for general slab types
General slab types can have steel plate, timber, or general deck types. The
material grade properties for each deck type can either be selected from the
material database or they can be user-defined.

Choosing the grade from the material database

If the Deck type is set to:

• Steel plate - the Grade lists all the available Steel materials in the
Materials database under the current head code.

• Timber - the Grade lists all the available Timber materials in the Materials
database under the current head code.

NOTE When using a timber deck type, the program will initially default to
a material override option rather than displaying a Grade. This is
because the Poisson’s ratio in the timber materials database is
generally invalid for isotropic elastic analysis (of 2D elements), for
which it must be > 0 and < 0.5. You can disable the override to
select a timber grade, but you must then enable it again to enter a
valid Poisson’s ratio (other grade properties such as density and
modulus of elasticity will be retained).

• General - the Grade lists all the available General materials in the
Materials database under the current head code.
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If the general material grade you want to use is not listed, you can open the
Materials dialog and add the grade to the database (page 1016), taking care to
first select the General material type as shown below.

Override material properties option

Unlike other slab types, general slab types each have an option to override
material properties. This option is provided primarily to allow the existing
properties of steel or timber deck slabs created in older versions of Tekla
Structural Designer (pre 2020 SP5) to be retained, but it can also be used to
enter the material properties directly if required.

NOTE When creating new timber decks, the program will default to the override
option. This is because the Poisson’s ratio in the timber materials database is
generally invalid for isotropic elastic analysis (of 2D elements), for which it
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must be > 0 and < 0.5. You can disable the override to select a timber grade,
but you must then enable it again to enter a valid Poisson’s ratio (other grade
properties such as density and modulus of elasticity will be retained).

Split and join slabs and mats
Tekla Structural Designer allows you to both sub-divide existing slab items into
smaller items, and merge slab items into larger items.

NOTE The commands for splitting and joining slab items are only accessible in 2D
views.

Split slab and mat items

1. Do one of the following:

To Do this
Split slabs

• On the Model tab, click Slab Split.

Split mats

• On the Foundations tab, click Mat
Split.

2. Hover the mouse pointer over the slab or mat edge, grid point, or other
point where you want to start the split. 

NOTE The points used to define the cut line can be outside the
boundary of the slabs being split. Thus, they do not need to be on
the slab edges.

3. Click the start point of the split.

4. Click the second point of the split on either the same or other item or
panel.

5. Do one of the following:

• To continue the split, click subsequent split points.

• To end the split, click the second point of the split again.

Tekla Structural Designer splits any slab items entirely crossed by the split
along the cut line.

Join slab and mat items

RESTRICTION You can only join slab items that share a common edge.

1. Do one of the following:

To Do this
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Split slabs

• On the Model tab, click Slab Join.

Split mats

• On the Foundations tab, click Mat
Join.

2. Select the first of the slab items (the master item) that you wish to join. 

NOTE The slab items selected later will adopt the properties of the
master item.

3. Select the second slab item. 

Tekla Structural Designer joins the selected slab items to create a new
one.

4. Select additional slab items as required, or press Esc.

Create trusses and joists
These topics introduce you to the methods of creating trusses and joists.

We recommend you familiarize yourself with how to:

• Create trusses (page 463)

• Create steel joists (page 465)

Create trusses
Trusses are particular arrangements of members that Tekla Structural
Designer calculates automatically for you. Once you have created a truss, you
can copy the truss throughout your model as necessary. In addition, you can
pick a truss in your model, and move it to a desired location.

Create a truss
The Truss Wizard helps you to create trusses in your models. For detailed
instructions on how to use the Truss Wizard to create trusses, see the
following instructions.

1. On the Model tab, click Steel Truss, or Timber Truss according
to your needs. 

The Truss Wizard opens.

2. Select the truss shape.

3. In the model, click the start point of the truss. 

TIP If you are using a point along a member, do the following:
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a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

4. In the model, click the end point of the truss.

5. In the Truss Wizard, click Next.

6. Specify the truss alignment parameters.

7. Click Next.

8. Specify the truss details.

9. Click Finish.

Create a space truss
Tekla Structural Designer allows you to create linear and planar space trusses.
You can create space trusses in a 2D or 3D view. For more information, see the
following instructions.

1. On the Model tab, click the arrow next to Steel Truss, or Timber
Truss, according to your needs.

2. In the list that appears, select Space. 

The Space Truss Wizard opens.

3. Define the truss type, the alignment, and the number or bays.

4. Click Next.

5. In the model, click the truss location points:

• For a linear truss, click the start and end points.

• For a planar truss, click the four corners of the truss.

6. In the Space Truss Wizard, specify the truss width and height. 

If you are creating a planar truss, Tekla Structural Designer calculates the
width automatically.

7. Click Next.

8. Define whether the truss should be straight or curved.

9. Click Finish.

Create a free form truss
You can create a free form truss by placing a series of truss members in the
required shape. For more information, see the following instructions.

RESTRICTION Free form trusses cannot be created in a 3D view, or a 2D level
view.

Create models 464 Create the model



1. Open the 2D frame view in which you want to create the truss.

2. On the Model tab, click the arrow next to Steel Truss, or Timber
Truss, according to your needs.

3. In the list that appears, select Free Form.

4. Click the start point of the first truss member.

5. Click the end point of the first truss member.

6. Repeat steps 4 and 5 to place each truss member as required.

7. When the truss geometry is complete, press Esc to finish.

Modify the geometry of existing steel and space trusses
After creating a steel, timber, or space truss, you can modify their geometry by
using the Edit command. For more information, see the following instructions.

1. Hover the mouse pointer over the desired truss so that it becomes
highlighted.

2. Right-click the truss.

3. In the context menu, select Edit [element name]. 

Depending on the type of the truss, either the Truss Wizard or the Space
Truss Wizard opens.

4. Modify the truss properties according to your needs.

5. To save the changes, click Finish.

Modify the properties of existing trusses
You can modify the section sizes, material grades, section orientations, and
other truss properties in the Properties window. For more information, see
the following instructions.

1. Move the mouse pointer over the desired truss, so that it becomes
highlighted.

2. Click the truss.

3. In the Properties window, modify the truss properties according to your
needs.

Create steel joists
Steel joists, or bar joists, are a specific type of members used in the United
States. They are simply supported secondary members that, in turn, support
slab and roof loads. Steel joists are constrained to standard types specified by
the US Steel Joist Institute, and standardized in terms of span, depth and load
carrying capacity. To create steel joists in your model, see the following
paragraphs.
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Specify the section for Standard and Special joist types

1. On the Model tab, click Steel Joist.

2. In the Properties window, specify the Steel joist type

3. Click the arrow on the right side of Steel joist type.

4. In the list that appears, select either Standard or Special as required.

5. Select the Section parameter.

6. Click the arrow on the right side of Section.

7. In the list that appears, select <New\Edit...> The Select Section dialog
box opens.

8. Select the desired joist type and size.

9. Click Select.

10. In the Properties window, adjust the remaining parameters according to
your needs.

Specify the section for the Girder joist type

1. On the Model tab, click Steel Joist.

2. In the Properties window, select the Steel joist type parameter.

3. Click the arrow on the right side of Steel joist type.

4. In the list that appears, select Girder.

5. Select the Section parameter.

6. Click the arrow on the right side of Section.

7. In the list that appears, select <New\Edit...> The Girder Section dialog
opens.

8. Either:

• Enter the girder properties and then click OK.

• Click Add if you want to add another girder section.

9. In the Properties window, adjust the remaining parameters according to
your needs.

Create a steel joist

1. Select the joist type and size.

2. Click the start point of the joist. 

TIP If you are using a point along a member, do the following:
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a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

3. Click the end point of the joist.

NOTE The ends of steel joists can be on different levels.

Move a steel joist

You can modify the joist position in both 2D and 3D views.

1. Select the joist.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

Create portal frames
Tekla Structural Designer allows you to create both single-span and multi-span
portal frames. After creating the portal frame, you can modify the properties
of either the entire portal frame, or a portal frame member. For more
information, see the following paragraphs.

Create a single or multi-span portal frame
1. On the Model tab, click Portal Frame.

2. In the Properties window use Span Count to specify the number of
spans.

3. Click the start point of the first span of the portal frame. 

The start point sets the local X and Y coordinate origin for the portal
frame.

4. Click the end point of the last span of the portal frame. 
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The start point defines the positive local X axis direction for the portal
frame.

NOTE The end point must lie in the same construction level as the start
point.

The Portal Frame dialog box opens.

5. On the Spans page, select the first span and click Edit...

6. Define the eaves level, select the frame type, and complete the frame
geometry for the span.

7. Click OK.

8. According to your needs, do one or all of the following:

• On the Rafters page, review the rafter section sizes.

• On the Columns page, review the column section sizes.

• On the Haunches page, specify eaves and apex haunches. See:Portal
frame haunch geometry (page 469)

• On the Bases page, specify the base fixity, and adjust the base levels
according to your needs.

NOTE You can also specify bases as nominally pinned or nominally
fixed if required, as follows:

a. close the Portal Frame dialog box,

b. open the appropriate Support in the Portal Frame
Properties window,

c. set the Rotational stiffness x Type as nominally pinned or
nominally fixed,

d. enter the stiffness %

For more details, see: Partial fixity of column bases (page 492).

• Use the Valleys, Ties, Tie Members, Parapets, and Parapet
Members pages to specify any additional elements.

9. To create the portal frame, click OK.

Modify the properties of an existing portal frame
• According to your needs, do one of the following:

To Do this
Modify the overall frame properties 1. Hover the mouse pointer over the desired

portal frame, so that it becomes
highlighted.

2. Right-click the portal frame.
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3. In the context menu, select Edit [element
name].

The Portal Frame dialog box opens.

4. Modify the properties according to your
needs.

5. Click OK.

Modify the properties of an individual portal
frame member

1. Hover the mouse pointer over the desired
portal frame member, so that it becomes
highlighted.

2. In the Select Entity tooltip, scroll until the
desired member is highlighted.

3. In the model, right-click the member.

4. In the context menu, select Edit [element
name].

The Properties dialog box opens.

5. Modify the properties according to your
needs.

6. Click OK.

Add copy or mirror spans in an existing portal frame
1. Open the Portal Frame dialog box (as described in the above topic).

2. Go to the Spans page of the Portal Frame dialog box.

3. Use the available buttons to introduce additional spans: 

• To introduce a new span at the end of the frame, click Add.

• To insert a new span below the currently highlighted span, click Insert.

• To copy the currently highlighted span to a pre-existing target span,
click Copy...

• To mirror the currently highlighted span to a pre-existing target span,
click Mirror...

4. Click OK.

Portal frame haunch geometry
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Eaves haunch dimensions

Apex haunch dimensions

Create cold-rolled sections
Tekla Structural Designer allows you to create multiple characteristic types of
cold-rolled sections. The types are track, stud, and joist (US), or eaves beam,
purlin, and rail (UK), depending on the language that you are using. For more
information, see the following paragraphs.

RESTRICTION You can model and analyze cold-rolled in Tekla Structural Designer,
but cold-rolled sections are not designed.

Create cold-rolled sections

1. On the Model tab, click any steel member type, for example, Steel
Beam.

2. In the Properties window, set the Characteristic property to the desired
cold-rolled section type. 

The properties in the Properties window are updated to match the
selected cold-rolled section type.
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3. In the Properties window, adjust the properties of the cold-rolled section
according to your needs.

4. Click the start point of the member. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the member. 

Tekla Structural Designer creates the member.

Modify the position of a cold-rolled section
You can modify a cold-rolled section in both 2D and 3D views.

To move an entire cold-rolled section, see: Move and rotate objects (page 495).

1. Click the section that you want to modify.

2. Click the end node that you want to move.

3. Click the new position of the selected end node. 

The end node moves to the selected position.

Create wall and roof panels
Wall panels, also referred to as wind walls, allow you to apply loads calculated
by the Simple Wind Loading Generator and Wind Wizard to your structure.
Wall panels do not introduce any structural strength or stiffness to your
structure. If you wish to introduce walls that resist gravity, or lateral loads, you
must define them as concrete walls.

Roof panels allow loads placed on a sloping plane to be decomposed back to
the supporting structure. Area loads on roofs can act either vertically, or
normal to the roof plane. To create and modify roof panels, see the following
instructions.

Create wall panels

RESTRICTION Note that:

• In order to define a wall panel, you must have already
defined the grid points that define the panel vertices.

• Wall panels must lie in a single plane. Otherwise, Tekla
Structural Designer will fail the panel during validation.
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• The wall panel must consist of at least 3 points.

1. On the Model tab, click Wall Panel.

2. Click the start point of the panel.

3. Click the remaining points of the panel.

4. To define the end point of the panel, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates a wall panel between the selected
points.

Create wall panels with parapets

NOTE To ensure the wind analysis accounts for the parapet correctly, a wall
panel with a parapet should be modeled in two parts:

1. Create an ordinary wall panel up to the roof level

2. Create a second wall panel above the roof level and marking the
panel as a parapet

1. Open a frame view in which you want to create the wall.

2. Create the wall panel below the roof level normally.

3. Create the wall panel above the roof level normally. 

NOTE You may need to create a new construction level to define the top
level of the parapet.

4. Press the Esc key.

5. Hover the mouse pointer over the second wall panel, so that it becomes
highlighted.

6. Click the second wall panel.

7. In the Properties window, select the Is a parapet wall option.

See also: Parapet wall panel load decomposition (page 2139)

Modify the properties of a wall panel
You can modify the properties of a panel wall in both 2D and 3D Views.

1. Hover the mouse pointer over the panel, so that i becomes highlighted.

2. Click the panel to select it. 
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TIP If necessary, add further roof panels to the selection by holding
down the Ctrl key and clicking the panels.

3. Go to the Properties window.

4. Modify the properties according to your needs. 

Tekla Structural Designer automatically applies the changes to all the
selected panels.

Create roof panels

RESTRICTION Note that:

• In order to define a roof panel, you must have already
defined the grid points that define its outline.

• Roof panels must lie in a single plane. Otherwise, Tekla
Structural Designer will fail the panel during validation.

1. On the Model tab, click Roof Panel.

2. Click the start point of the panel.

3. Click the remaining points of the panel.

4. To define the end point of the panel, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates a roof panel between the selected
points.

Modify the properties of roof panels
You can modify the properties of roof panels in both 2D and 3D Views.

1. Hover the mouse pointer over the panel, so that it becomes highlighted.

2. Click the panel to select it. 

TIP If necessary, add further roof panels to the selection by holding
down the Ctrl key and clicking the panels.

3. Go to the Properties window.

4. Modify the properties according to your needs. 

Tekla Structural Designer automatically applies the changes to all the
selected panels.
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Ancillaries
Ancillaries enable the quick and efficient application of loading from ancillary
items such as ladders, stairs and pipework etc - that are not part of the main
structural frame.

What are ancillaries used for?
While primarily intended for use in industrial structures, some features
associated with ancillary loads are also beneficial to the AEC market - eg:

• Modeling of stairs in steel, concrete, and timber structures,

• The use of stairs in combination with inactive members.

Ancillaries can also be used to model loads from:

• Walkways/Catwalks

• Ladders (with/without cages)

• Access Platforms

• Operating Platforms (Storage/Standard)
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• Lines of Pipework

• Lines of Cable Tray

In Tekla Structural Designer each of the above types can be created in the
form of either a line, or area ancillary.

Line ancillaries

Line ancillaries can be defined horizontally, vertically or sloped. They are
created by selecting a series of support points in order to create a "run". Each
line has a defined width in a user defined plane (perpendicular to length).

Area ancillaries

Area ancillaries can be defined horizontally, vertically or sloped. They are
created in the same way as a panel, by selecting the vertices of the area.
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Ancillary load default values
Each Line or Area Ancillary has default Dead Loads and Imposed/Live Loads
which can be preset to be project specific from the sub-pages under Loading
in Model Settings.

Create models 476 Create the model



The default values can be overridden when individual ancillaries are created.

NOTE For Pipework Operating & Testing Content Loadcase Types, you can
select whether these are considered as Dead or Imposed (Live) loads
from Model Settings > Loading > General.

Ancillary loadcases
Ancillary loads are always created in dedicated ancillary loadcases which are
automatically added and removed as the loads are added/deleted. These
dedicated ancillary loadcases specifically aid combination building for
Industrial design.
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NOTE If working to Eurocodes, the ancillary imposed case Ψ and ɸ factors
default to zero and must be manually defined.

Ancillary load decomposition
All decomposed loads from ancillaries are present in the analysis and design.

Once loads are decomposed the ancillaries themselves play no further part in
analysis and design.

Line ancillary decomposition

Line ancillaries are treated as simply supported beams, spanning onto
supporting members/slabs.

Decomposition is in two stages from the line ancillary to its supports then
onwards.

In the below example the line ancillary is supported by a beam at one end and
a slab spanning perpendicular to the ancillary at the other. At the slab end,
stage 2 decomposition occurs to distribute the load on to beams supporting
the slab.
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Area ancillary decomposition

In the same way as a roof panel, an area ancillary has a span direction which
determines the load decomposition onto surrounding supporting members/
slabs.

Decomposition is in two stages from the area ancillary to its supports then
onwards.

In the below example the area ancillary is supported by a slab which spans in
the same direction as the ancillary.

The UDLs generated in the stage 1 decomposition are then decomposed on to
the members supporting the slab in stage 2.
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Create line ancillary loads

1. On the Model tab, click Line Ancillary.

2. In the Properties window,

a. If the load is to only span between two points, uncheck the
Continuous setting, otherwise leave it checked.

b. Enter the load width

c. Select the required Type.

d. Accept the default load values, or define your own.

e. Specify the remaining properties as appropriate to selected Type. 

NOTE 1. For walkways and platforms the presence of a guardrail
and channel height alters dead loading.

2. For lines of pipework/cable trays the height is displayed
and it can be visually reversed by checking the Reversed
property.
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3. Click the start point of the line.

4. Click the remaining points of the line.

5. Double-click to define the end point of the line.

6. Pick a reference point to define the ancillary plane. 

Tekla Structural Designer creates a line ancillary between the selected
points.

Create area ancillary loads

1. On the Model tab, click Area Ancillary.

2. In the Properties window,

a. The rotation angle defines the span direction measured relative to
the first two points clicked to identify the area.

b. Select the required Type.

c. Accept the default load values, or define your own.

d. Specify the remaining properties as appropriate to selected Type. 

NOTE 1. For walkways and platforms the presence of a guardrail
and channel height alters dead loading.

2. For lines of pipework/cable trays the height is displayed
and it can be visually reversed by checking the Reversed
property.
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3. Click the start point of the area.

4. Click the remaining points of the area.

5. To define the end point of the area, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates an area ancillary load between the
selected points.

Inactive members
Single span members can be made inactive for analysis and design while still
being kept in the model for load distribution and for determination of effective
lengths.

This feature is particularly useful for industrial structures, as frequently not all
the secondary beams are included in the analysis and design model, but they
are still required to distribute load in the structure and act as restraints to
supporting members.

An inactive member is totally ignored in the solver model as is any load carried
by it. Therefore, to allow the load to be distributed it is instead decomposed to
nodal forces in a pre-analysis decomposition stage - this happens for all
applied loads on inactive members on the basis of the members being simply
supported.
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Which members can be made inactive?
Only single span beams, braces, analysis elements, purlins and rails have the
potential to be inactive. They each have an Active setting in the properties
which defaults to 'on' but can be unchecked.

NOTE Members cannot be made inactive if:

• they are multi-span, or,

• they support another member (active or inactive)

To make a member inactive
By selecting the Show/Alter State Active (page 875) attribute in a Review View,
inactive members are color coded allowing the active/inactive setting to be
toggled graphically.

Alternatively, you can change the setting manually in the Properties window
as follows:

1. Select the member in a 2D or 3D view.

2. In the Properties window deselect Active.

Inactive member load decomposition
The first stage of load decomposition treats active and inactive members in
exactly the same way.

This is then followed by a second stage of load decomposition for the inactive
members only, as follows:

• End reactions are calculated for the inactive members.

• These are then applied as nodal forces to the supporting members.

After decomposition has taken place analysis can proceed with the inactive
members removed from the solver model.

In the below example, by using the Show/Alter State Active (page 875) attribute
one beam has been made inactive. The view shows decomposed loads - note
that the inactive beam still has slab load decomposed to it in the same way as
the active beams (as a result of the first decomposition stage).
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The effects of the second decomposition stage can be seen by switching to a
Results View showing major moments.
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In the second stage the end reactions of the inactive beam have been applied
as nodal forces to the supporting edge beams in the first bay causing
moments to be generated in them, (without this second stage the two
supporting beams would have otherwise been completely unloaded.)

No moments are generated in the inactive beam itself because after the
decomposition has taken place it does not exist in the solver model.

Typical usage cases for inactive members
There are potentially many uses for inactive members, the following being
some examples.

Industrial Structures

Inactive members can be used in conjunction with ancillaries in order to apply
loads to the structure while not themselves participating in the analysis.

In the below example an area ancillary decomposes load on to two inactive
beams, which is then applied as nodal forces on to the supporting members.
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Purlins and Rails

In large portal sheds, purlins and rails may be included in the model to act as a
means of load distribution; the engineer would not want to see the forces in
them when reviewing forces in the main structural members, or consider the
small axial loads that develop in purlins and rails when gravity load cases are
analysed.

By setting the purlins and rails to be inactive these goals are achieved.

This is demonstrated in the below example - in the top view the purlins are
rails are active, consequently small forces develop in them in gravity
combinations and the results views are quite clutterred with values that are of
no interest to the engineer.
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In the second view the purlins and rails have been set inactive, providing a
clearer display and showing the values the engineer would expect/assume
from such a combination.

Grouped Design

Design can be speeded up by enabling group design and limiting the number
of active members in a group.

This is demonstrated in the below example of a regular floor, all beams in the
group apart from one have been made inactive which significantly reduces the
design time.
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NOTE When making the non-critical beams inactive to speed up design:

• You are responsible for choosing critical beam(s)

• Primary beams cannot be set to inactive

To support stairs at a slab edge

If an area ancillary stair spans onto a slab edge, in order to decompose the
stair load on to the slab you can add an inactive member along just that part
of the slab edge to which the stair attaches.
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Provided that the slab is meshed for 3D analysis, the inactive member
provides a load path - the load becomes point loads on slab at each end
inactive member (i.e. at the edges of the stair).
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Create supports
Supports allow you to constrain points in your structure vertically and
rotationally. You can use supports to model connections to existing structures,
so that you do not need to incorporate them in your current model. In
addition, you can change the fixity provided at an existing support by
modifying the support properties.

Create a single support

RESTRICTION You can only place supports at existing grid points.

1. On the Model tab, click Support. 

The support will adopt the properties currently displayed in the
Properties window.

2. If necessary, in the Properties window, adjust the support properties.

3. Click the grid point where you want to create the support.
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Create a rotated support using 3 grid points
You can apply a local coordinate system to your supports, allowing the X and Y
axes to be rotated about global the Z axis.

NOTE The z direction of the support cannot be changed.

1. On the Model tab, click Support.

2. Go to the Properties window.

3. Ensure that the 3 Grid Points option is selected.

4. Click the grid point where you want to create the support.

5. To define the support direction along the x axis, click a second grid point.

6. To define the support direction along the y axis, click a third grid point.

Create spring supports
You can create linear and non linear spring supports in a similar fashion.

1. On the Model tab, click Support.

2. Go to the Properties window.

3. Ensure that in the direction where you want the spring to act, the degree
of freedom is set to Free.

4. In the appropriate stiffness properties, do one of the following:

• Select the Spring Linear option, and define a single stiffness value that
acts in both the positive and negative directions.

• Select the Spring Non-linear option, and define two stiffness values,
one to act in the positive direction and another to act in the negative
direction.

5. Click the grid point where you want to create the support.

Create nominally pinned or nominally fixed supports
A support placed under a column is a special case which can be specified as
nominally pinned, or nominally fixed if required.

NOTE A validation error is produced if a nominally pinned or nominally fixed
support is placed at any other location.

1. On the Model tab, click Support.

2. Go to the Properties window.

Create models 491 Create the model



3. Ensure that the Mx and/ or My directions about which you require partial
fixity are set to Free.

4. In the appropriate rotational stiffness properties, do one of the following:

• Select the Nominally pinned option, and define the required stiffness
value as a percentage of the column stiffness 4EI/L.

• Select the Nominally fixed option, and leave the stiffness value as
100% of the column stiffness 4EI/L.

5. Click the grid point where you want to create the support.

For more information, see: Partial fixity of column bases (page 492)

Modify support properties
You can modify support properties in both 2D and 3D views.

1. Hover the mouse pointer over the desired support, so that it becomes
highlighted.

2. Click the support. 

TIP You can add further supports to the current selection by holding
down the Ctrl key and clicking the additional supports.

3. Go to the Properties window.

4. Modify the support properties according to your needs. 

Tekla Structural Designer automatically applies any changes to the
selected supports.

Partial fixity of column bases
Two additional types of rotational linear spring are provided to allow partial
fixity to be modelled, these are:

• Nominally pinned

• Nominally fixed

These are specifically provided for supports under columns (of any material),
but will result in a validation error if placed under walls, or if they are used for
any other supports.

The support stiffness is based on the column properties (E*I/L)

• E = Young’s Modulus of the column

• I = relevant bending stiffness (Ixx or Iyy) of the column

• L = distance from the support to the first column point (stack) that is on a
Construction Level checked as a Floor in the Levels dialog, i.e. combined
length of all the stacks until a floor is found.
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NOTE Where no Floor has been defined in the column above the support,
then L is taken as total length of column.

Partial fixity spring stiffness is calculated as follows for each of the two
bending releases Mx and My:

• Nominally pinned (spring stiffness) - x% * 4 * E*I/L (default x% = 10%)

• Nominally fixed (spring stiffness) - x% * 4 * E*I/L (default x% = 100%)

Since the spring stiffness is dependent upon stack height and column stiffness
(E and I), the spring stiffness will change if any changes are made to column
stack height, column E or I values.

In addition, since for steel, Auto Design can change the column size (and hence
I value) the spring stiffness will change with any change in column size.

Create analysis elements
Analysis elements allow you to quickly model and analyze both steel, concrete
and timber elements that are not in the existing section databases, and
elements made of other materials. For more information on how to create and
modify analysis elements, see the following paragraphs.

RESTRICTION Tekla Structural Designer analyzes analysis elements, but
does not design them.

How do I edit the properties of a single model object?

How do I edit the properties of multiple entities?

Create analysis elements

TIP In order to create analysis elements in a new material, first create the :

1. On the Home tab, click Materials.

2. In the Materials dialog box, go to the Material page.

3. Set Material Type to General.

4. Click Add...

5. Type the name of the material in the Grade field.

6. Specify the material details, and click OK.
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1. On the Model tab, click Element. 

The element will adopt the properties currently displayed in the
Properties window.

2. In the Properties window, adjust the material and properties of the
element according to your needs.

3. Click the start point of the element. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

4. Click the end point of the element. 

Tekla Structural Designer creates the element.

Modify the position of analysis elements
You can modify the position of an individual analysis element in both 2D and
3D views.

1. Select the element that you want to move.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

4.3 Edit the model
After creating the model and the necessary members within it, you may need
to make some modifications.

For example you may want to:

• Edit the properties of (page 360) entities
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• Re-position entities (page 361) by moving nodes or edges

Additional model editing commands are located on the Edit tab, these allow
you to:

• copy objects (page 495) and loads

• move objects (page 495) or move the model

• mirror objects (page 496)

• delete objects (page 503)

• join and split members

• Automatically join all concrete beams (page 505)

• Reverse member axes and panel faces (page 506)

• use cutting planes to hide a part of your model

• remove any unused unused slopes, frames, construction and grid lines

• merge planes (page 511)

• Rationalize the model (page 509)

• create infill members

• edit or add free points

Copy and rotate objects
To copy, or copy and rotate objects, see the following instructions.

1. Select the objects that you want to copy.

2. On the Edit toolbar, click Copy.

3. If you want to rotate the object when you copy it, in the Properties
window, type the rotation about the Z axis.

4. Click the reference node.

5. Click the point where you want to copy the reference node. 

Tekla Structural Designer moves the selected member to the new
location, and rotates them according to the specified rotation value.

6. Place more copies in your model, or press Esc to finish.

Move and rotate objects
To move, or move and rotate objects, see the following instructions.

1. Select the objects that you want to move.

2. On the Edit toolbar, click Move.
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3. If you want to rotate the object while moving it, in the Properties window,
type the rotation about the Z axis.

4. Click the reference node.

5. Click the point where you want to move the reference node. 

Tekla Structural Designer moves the selected member to the new
location, and rotates them according to the specified rotation value.

Mirror objects to new locations
To copy existing elements by mirroring them, see the following instructions.

1. Select the objects that you want to mirror.

2. On the Edit toolbar, click Mirror.

3. In the Properties window, select the desired Mirror mode:

• Along Y axis mirrors the objects about a global XZ plane defined by a
single reference point.
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• Along X axis mirrors the objects about a global YZ plane defined by a
single reference point.
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• Pick mirror plane mirrors the objects about a plane defined between
two points.
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• Pick destination point mirrors the objects about a plane which
perpendicularly bisects a line defined between two points.
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4. In the model, click the reference points.

5. If you are using the Pick mirror plane or Pick destination point mode,
click the second point to define the mirror plane.

See also

Copy and rotate objects (page 495)

Copy loads
Tekla Structural Designer allows you to quickly apply the same loads to
multiple members by using the Copy Loads command.

Copy all member loads from one span to another
1. On the Edit toolbar, click Copy Loads.

Create models 500 Edit the model



2. Go to the Properties window.

3. Set Mode to Copy Span Loading.

4. Select whether you want to copy loads in the current loadcase or in all
loadcases. 

NOTE If you select the current loadcase, remember to select the
required loadcase in the (page 247).

5. In the model, click the span that contains the member loads that you want
to copy.

6. Click the span that you want to apply the loads to. The source span and
the destination span do not need to be the same length. 

Tekla Structural Designer copies the member loads to the selected span.

7. Do one of the following:

• Click additional spans to continue applying the loads.

• Press Esc to select a different loaded element span to copy loads from.

• Press Esc twice to finish.

Only copy one member load to another span
1. On the Edit toolbar, click Copy Loads.

2. In the Properties window, set Mode to Copy Member/Area Load.

3. In the model, click the member load that you want to copy.

4. Click the span that you want to apply the load to. The source span and the
destination span do not need to be the same length. 

Tekla Structural Designer copies the member load to the selected span.

5. Do one of the following:

• Click additional spans to continue applying the loads.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy panel area, level, and slab loads
1. On the Edit toolbar, click Copy Loads.

2. In the (page 247), select the desired loadcase.

3. In the Properties window, set Mode to Copy Member/Area Load.

4. Click the area, slab, or level load that you want to copy.
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5. Click the panel that you want to apply the load to. 

Tekla Structural Designer copies the load to the selected panel.

6. Do one of the following:

• Click additional panels to continue applying the loads.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy panel point, line, and patch loads
1. On the Edit toolbar, click Copy Loads.

2. In the (page 247), select the desired loadcase.

3. In the Properties window, set Mode to Copy Plane Loads.

4. Click the panel point, line, or patch load that you want to copy. 

TIP If necessary, you can click to add other loads to the selection, or
remove them from the selection by clicking them once more.

A red circle indicates the original reference point for the selected loads.

5. To apply the loads, do one of the following:

• Click a panel node to define a new reference point at that node.

The loads are applied at the same offset from the new reference point.

• Click anywhere within a panel boundary at a different level to define a
new reference point directly above or below the original reference
point.

The loads are applied at the same offset from the new reference point.

WARNING If you choose a new reference point that results in the
loads being applied outside the panel area, Tekla
Structural Designer does not apply the loads to the
model. In this situation, a warning appears during
validation.

6. Do one of the following:

• Click to define further reference points to continue applying the
loads. .

• Press Esc to select a different loads to copy.

• Press Esc twice to finish.
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Copy structure loads
1. On the Edit toolbar, click Copy Loads.

2. In the Properties window, set Mode to Copy Member/Area Load.

3. In the model, click the structure load to be copied.

4. Click the position you want to apply the load to. 

Tekla Structural Designer copies the load to the new location.

5. Do one of the following:

• Click additional locations to continue applying the load.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy loads to another loadcase
1. On the Edit toolbar, click Copy Loads.

2. In the (page 247), select the loadcase from which you want to copy the
loads.

3. Go to the Properties window.

4. Set Mode to Copy Loads to another Loadcase.

5. Select the loadcase that you want to copy the loads to.

6. In the model, click the load that you want to copy. 

TIP If necessary, you can click to add other loads to the selection, or
remove them from the selection by clicking them once more.

7. To copy the loads to the loadcase displayed in the Properties window,
press Enter.

8. Do one of the following:

• Press Esc to select additional loads, and then press Enter to copy
them.

• Press Esc twice to finish.

Delete entities
1. Do one of the following:

To Do this
Delete using the keyboard • Select the entity.

• Press Delete

Delete using the Quick Access toolbar • Select the entity.
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• From the Quick Access toolbar choose
Delete

Delete using the context menu • Right click the entity you want to delete.

• From the context menu choose Delete
Element

Delete from the Edit ribbon • Select the entity.

• From the Edit ribbon choose Delete

Join and split members
You can use the Join command for joining discontinuous members, thus
creating a continuous member. The Split command, on the other hand, allows
you to split continuous members of any material.

See also

Automatically join all concrete beams (page 505)

Join members
You can use the Join command to manually join concrete beams, even when
the Allow automatic join end options are not selected. This is because the
Allow automatic join end only applies to the automatic joining that occurs
during design process or when you run the Beam Lines command.

RESTRICTION You can only join:

• Two similar members if that the angle between the
members is less than 45 degrees in both plan and
elevation.

• Beams that have an end point in common.

If Tekla Structural Designer fails to join two beams, their
end points have probably been defined using different
construction or grid lines.

1. On the Edit toolbar, click  Join.

2. Hover the mouse pointer over the member that you want to join to
another member. 

Both the original member and the member to which it will be joined
become highlighted. The point where they will be joined is indicated by a
red dot.

NOTE If Tekla Structural Designer tries to join the wrong end, move the
mouse pointer towards the other end of the member until Tekla
Structural Designer indicates the correct end.
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3. Click the highlighted members to join them.

4. Click additional members to join them, or press Esc to finish.

Split members

RESTRICTION You can only split members that have previously been joined.

1. On the Edit toolbar, click Split.

2. Hover the mouse pointer over previously joined members that you want
to split. 

The member is highlighted, and Tekla Structural Designer uses a red dot
to indicate the point where the member will split.

3. According to your needs, do one of the following:

• Click the member to split it at the indicated point.

• Move the mouse pointer further along the member to identify other
points where the member could be split.

NOTE If the member being split is a concrete beam, Tekla Structural
Designer splits the member into two separate beams. The first
beam has the Allow automatic join end 2 option cleared,
whereas the second one has the Allow automatic join end 2
option cleared. This prevents Tekla Structural Designer from
automatically making the two beams continuous again when the
model is designed.

Automatically join all concrete beams
Tekla Structural Designer automatically forms concrete beam lines as part of
the combined analysis and design process. However, if you would prefer to
have greater control yourself, you can run the Beam Lines command
manually. This way, you can verify that continuous beam lines are formed as
you intend before proceeding with the design.

When run manually, the Beam Lines command applies to all concrete beam
members in the model, irrespective of whether they are selected or not.

NOTE Discontinuous concrete beam ends can only be joined if the Allow
automatic join end option is selected for the appropriate beam ends
at the join. Then, Tekla Structural Designer only joins the ends if all the
following criteria are met:

• The angle in plan at which the two beams meet is less than the
Limiting join angle in plan specified in Model Settings --> Beam
Lines
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• The angle in elevation at which the two beams meet is less than
the Limiting join angle in elevation specified in Model Settings --
> Beam Lines

• The amount by which the cross sectional areas of the two beams
overlap is greater than the Minimum section overlap percentage
specified in Model Settings --> Beam Lines

In addition, if either of the two beam ends being joined is pinned,
Tekla Structural Designer does not join them unless the Join pinned
beam end option is selected in Model Settings --> Beam Lines.

To join the concrete beams in the model automatically, do the
following:

• On the Edit tab, click Beam Lines.

See also

Join and split members (page 504)

Reverse member axes and panel faces
Sometimes when creating a model, you may end up creating beams or wall
panels that run or face in the wrong direction. This may lead to problems in
the analysis phase. In order to fix these kinds of inconsistencies, you can use
the Reverse command.

Reverse the local axis of a beam
You can easily end up with beams running forwards and backwards if a
consistent approach has not been adopted when selecting start and end
nodes. Beams that run in different directions can result in confusing force
diagrams. By manually reversing the axes of beams, you can make all beams
run left to right and bottom to top in a plan view.

To reverse a beam, do the following:

1. On the Edit toolbar, click Reverse.

2. Click a beam to reverse its direction.

Reverse the outward face of a wind panel
The front of each wall should be facing outwards in order to correctly
determine the wind direction relative to the wall. Ensure that all the outward
faces are displayed in the color assigned to the front of the wind wall.

If a wall is facing in the wrong direction, reverse it by doing the following:
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1. On the Edit toolbar, click Reverse.

2. Click a wind panel to reverse its direction.

Manage cutting planes
Initially, the six cutting planes form a cube around the extents of each model.
By activating a cutting plane, you can move it inwards so that it slices through
the model. Everything on the positive side of the plane is temporarily hidden
from the view, making it easier to work on different areas inside the model.

Activate or deactivate a cutting plane
The active cutting plane faces are shown in a different colour. (By default blue
indicates the positive side of the plane and red the reverse side).

1. On the Edit toolbar, click Cutting Planes. 

Tekla Structural Designer displays the six existing cutting planes.

2. Click a cutting plane to activate it. 

Tekla Structural Designer displays the positive side of the plane in blue,
and the reverse side in red.

TIP To deactivate a cutting plane, click an active plane again.

Move a cutting plane to hide a part of the model
When a cutting plane is active, an arrow projects from its center. You can use
the arrow to reposition the plane.

1. Click the arrow at the center of the cutting plane. 

Tekla Structural Designer views a line that indicates the direction in which
you can move the plane.

2. Click the desired position of the plane, or press F2 to type the exact
distance. 

Tekla Structural Designer redraws the cutting plane at its new position.
The cutting plane slices to the model, and everything to the positive side
of the plane is hidden.
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Re-display a hidden part of the model
• Click the cutting plane to deactivate it. 

Tekla Structural Designer displays any previously hidden parts of the
model.

Move the model or the DXF shadow
If necessary, you can relocate the entire model to a new coordinate in the XY
plane by using the Move Model. You can relocate the DXF shadow of the
model similarly with the Move DXF Shadow command.

Move the model
In order to move the model, you first have to decide which reference point to
use.

You can determine the reference points by drawing an imaginary box aligned
to X and Y around the extents of the model, as shown in the following image:

Bounds Corner equals the lower left hand corner of the imaginary box,
whereas Bounds Centroid equals the centroid of the imaginary box.

1. On the Edit toolbar, click Move Model.

2. Set the reference point to either Bounds Corner or Bounds Centroid.

3. Enter the required target coordinate of the reference point.

4. Click Move.
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Move the DXF shadow
The Move DXF Shadow command is only available if you have previously
imported a DXF shadow (page 308).

1. On the Edit toolbar, click Move DXF Shadow.

2. Select an existing point in the DXF shadow as the reference point.

3. Click the new position of the reference point.

Rationalize the model
In order to remove all unused sloped planes, frames, grids, and construction
lines in your model, you can use the Rationalize command. If necessary, the
Rationalize command also allows you to update all grid and construction lines
to extend only a short length beyond the point where they are required. After
running the command, you can see a summary of the changes in the Process
Window.

Delete unused sloped planes, frames, grids, and construction lines
1. On the Edit toolbar, click Rationalize. 

The Rationalize dialog box opens.

2. Select the unused items that you want to remove.

3. Click OK. 

Tekla Structural Designer deletes the unused items of the selected types,
and their associated items.

Update grid and construction line length
1. On the Edit toolbar, click Rationalize. 

The Rationalize dialog box opens.

2. Select Shrink/Extend Grid & Construction lines.

3. Click OK. 

Tekla Structural Designer updates all grid and construction lines in the
model to extend a fixed length (500 mm / 1'8") beyond the point where
they are required.
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Create infill members
In order to quickly place a pattern of infill members into selected plays in a
level, sloped plane, or frame, you can use the Create Infills command. Note
that only the bays with members attached to all sides can be selected.

RESTRICTION You cannot create infills in 3D views.

Define the infill properties and pattern

1. On the Edit toolbar, click Create Infills.

2. Go to the Properties window.

3. In Define Beams, select one of the following:

• By number allows you to specify the number of equally spaced
members in the pattern.

• By spacing allows you to specify the exact positions of the beams,
separating them by a comma.

• By max spacing allows you to create as many equally spaced beams
in the pattern as possible without exceeding the max spacing.

4. In Direction, select one of the following:

• Perpendicular allows you to have the members drawn perpendicular
to the highlighted edge member.

• Parallel with left allows you to have the members drawn parallel to
the edge member that connects to the end 1 of the highlighted edge
member.

• Parallel with right allows you to have the members drawn parallel to
the edge member that connect to the end 2 of the highlighted edge
member.

5. Define the element parameters according to your needs. 

TIP If you have saved infill properties to a named property set, you can
recall them by selecting the set in the drop list at the top of the
Properties window.

Place the pattern in a single bay
1. Hover the mouse pointer over the required bay, adjacent to the required

edge member.

2. If necessary, change the orientation by moving the cursor to a different
edge member, or by adjusting the general parameters in the Properties
window.
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3. Click the bay to create the pattern.

Place the pattern in multiple bays
1. Hover the mouse pointer over one of the bays, adjacent to the required

edge member.

2. If necessary, change the orientation by moving the cursor to a different
edge member, or by adjusting the general parameters in the Properties
window.

3. Click the bays in which you want to create the pattern.

Merge planes
Where a model contains very close planes, as can often occur in imported
models, for example, the Merge Planes command allows the you to merge two
planes by selecting a destination plane and then a source plane.

1. On the Edit toolbar, click Merge Planes. 

Existing Level, Frame, and Slope planes are displayed in the active view.

NOTE If the view is cluttered by having all the plane types displayed
simultaneously, and you only want to merge Levels, consider
switching off Frames and Slopes in Scene Content.

2. Pick the destination plane.

3. Pick the source plane. 

If the planes can be merged, everything on the source plane will be
moved to the destination plane, and the source plane will be deleted. If
the merge is not possible, a message is given in the Process window and
the model will be unchanged.

Create and manage free points
Free points can be used to connect beams, columns, braces etc. without
having to define an intersection between grid lines or construction lines.

NOTE Once a free point has an item connected to it, if the item is moved a
new point is created and the existing free point remains.
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Create a free point
A frame is a 2D View of the model, created in a vertical plane defined by an
existing grid line. Since only the members that lie within the plane of the frame
are displayed, a frame view can be particularly useful for defining bracing.

1. Make sure that Free Points are visible in Scene Content.

2. Right click in the view and pick Add free point... from the context menu.

3. Enter the point co-ordinates and click OK.

Adding, moving or deleting free points from the Edit tab
1. On the Edit tab, click Free Points... 

A Free Points dialog is displayed.

2. Click Add to add a new point, Delete to remove an existing point, or click
in the table to edit the co-ordinates of existing points.

Related video

Free point defined by XYZ coordinates

4.4 Validate the model
You can validate the model at any time in order to trap errors that will cause
the solver to fail before the model is submitted for analysis. Validation is also
automatically performed during design.

NOTE You can also measure distances and angles (page 513) to check your
modeling.

Run model validation

• On the Model or Load tab, click Validate. 

Tekla Structural Designer performs the validation checks. If your model
contains any issues, warning messages appear.

Adjust the conditions considered in model validation

1. On the Home tab, click Model Settings.
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2. Go to the Validation page.

3. Select the conditions that you want Tekla Structural Designer to consider
during validation checks.

4. Click OK.

Measure distances and angles
To know the exact distances or angles between different points in the model,
you can use the Tekla Structural Designer measuring commands. You can find
the measuring commands on the Model tab, in the Miscellaneous group.

Measure distances
To measure the distance between any two points in the model, see the
following instructions.

1. On the Model tab, click Measure.

2. Click a node to define the start position.

3. Click a second node to define the end position. 

The distance between the nodes is displayed in the current view. To clear
the measurement, press Esc.

Measure angles

RESTRICTION You can only measure angles in 2D Views.

1. On the Model tab, click Measure Angle.

2. Click a node to define the arc center.

3. Click a second node to define the start position.

4. Click a third node to define the end position. 

The clockwise angle between the start and end position is displayed in the
current view. To clear the measurement, press Esc.
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5 Apply loading

The Load tab allows you to:

• Manage load cases, groups, combinations, envelopes and patterns
(page 514)

• Apply panel, member, and structure loads (page 538)

• Apply wind, snow, and seismic loads (page 559)

5.1 Manage load cases, groups, combinations, envelopes
and patterns
Load cases, groups, combinations and envelopes are all managed in the
Loading dialog (page 531). Load patterns are reviewed via Update Patterns
on the Load tab.

• Manage load cases (page 514)

• Manage load groups (page 516)

• Manage load combinations (page 518)

• Manage load patterns (page 527)

Manage load cases
Before applying loads to your model, you must first define the loadcases
within which the loads will be contained.

To define loadcases, see:

• Create load cases (page 515)

• Activate reductions in live or imposed load cases (page 515)

• Renumber all load cases (page 516)
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Create load cases
When you create a new model, Tekla Structural Designer automatically creates
a load case whose type is Self weight - excluding slabs. You cannot access
the load case because Tekla Structural Designer automatically calculates the
loads within it using the objects in your structure. Tekla Structural Designer
also creates three other load cases that are initially empty. However, you will
almost certainly need to create other load cases that contain the loads that
your building must withstand.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 531) opens on the Loadcases page. On this
page, you can see all currently existing load cases.

2. Click Add.

3. In Loadcase Title, name the load case.

4. In Type, select the desired load case type.

5. Select whether the load case is included when you automatically generate
load combinations.

6. Click OK. 

Tekla Structural Designer adds the new load case to the list of load cases
in the Loading list.

Activate reductions in live or imposed load cases
When you create a load case whose type is Live (US) or Imposed (other head
codes), you can allow Tekla Structural Designer to automatically calculate load
reductions in accordance with the percentages specified on the Load
reductions page in Model Settings. To do so, see the following instructions.

Activate reductions in live and roof live load cases (US)

1. On the Load tab, click Loadcases. 

The Loading dialog (page 531) opens on the Loadcases page. On this
page, you can see all currently existing load cases.

2. Select the Live or Roof Liveload case to which you want to apply the
reductions.

3. Select the Live Load Reductions option.

4. Click OK.
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Activate reductions in imposed load cases (other head codes)

NOTE You cannot activate reductions in load cases whose type is set to Roof
Imposed.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 531) opens on the Loadcases page. On this
page, you can see all currently existing load cases.

2. Select the Imposed load case to which you want to apply the reductions.

3. Select the Imposed Load Reductions option.

4. Click OK.

Renumber all load cases
When you delete load cases from the Loading dialog (page 531), the
remaining load cases retain their original load case number. If necessary, you
can renumber the remaining load cases in sequence.

For more information, see the following instructions.

1. On the Loading tab of the Project Workspace, right-click Loadcases.

2. In the context menu, select Renumber.

Manage load groups
Load Groups facilitate the generation of combinations (primarily for design of
industrial structures where many loading scenarios must be considered).

To manage load groups, see:

• Overview of load groups (page 516)

• Create load groups (page 517)

• Inclusive and exclusive load groups example (page 518)

Overview of load groups
Features of load groups

• Load Groups are an aid to building Combinations - both manually and
using the Generator - and their use is entirely optional.

• Once a Combination is built using Load Groups, the link to the Load Group
is lost – the Combination is made up only of Loadcases. Only Loadcases
and Combinations are analysed – Load Groups are not.
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• Each Load Group holds items of a single load type - e.g. “Dead” or
“Live”...etc. - and can contain both multiple loadcases and other Load
Groups

• The fundamental Load Groups setting is the “Class” which is either
“Inclusive” or “Exclusive”

• When “Inclusive” – all loadcases are added at once into a combination

• When “Exclusive” – loadcases are used one at a time in combinations.
Thus for example, where an Exclusive Load Group contains four
loadcases, the Generator will produce four combinations for all
required combinations which include the group’s load Type (e.g.
“Imposed”), each containing only one of the group’s four cases.

The load groups process

To make use of Load Groups you would proceed as follows:

1. Define Loadcases as normal

2. If required, create Load Groups from Loadcases and/or other Load
Groups

3. Create Combinations by combining Loadcases and/or Load Groups

The end result is Loadcases and Combinations (built up of factored loadcases).
These are then run through analysis and design.

Create load groups

1. On the Load tab, click  Load Groups. 

The Loading dialog (page 531) opens on the Load Groups page. On this
page, you can see all currently existing load groups.

2. Click Add.

3. Enter the Load Group Title.

4. In Class, select the desired load group class.

• Inclusive - all loadcases are added at once into a combination

• Exclusive – loadcases are used one at a time in combinations

5. Click the load group name in the left hand panel of the dialog to display
the available load cases.

6. Select each load case in turn to be included and click the right arrow
button to copy it into the load group. 

NOTE A load group can only contain items of one load type.
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7. Click OK. 

Tekla Structural Designer adds the new load group to the list of load
groups.

Inclusive and exclusive load groups example

If you were to manually create a combination to include:

• Loadcase 1

• Load Group 1 ("Inclusive" which contains Loadcases 2 & 3)

• Load Group 2 ("Inclusive" which contains Loadcases 4 & 5)

• Load Group 3 ("Exclusive" which contains Loadcases 6 & 7)

• Load Group 4 ("Exclusive" which contains Loadcases 8 & 9)

When you click OK to close the Loading dialog, the following combinations are
created with the relevant factors according to Load Type

Combination Contains Load cases
Combination 1 1 + 2 + 3 + 4 + 5 + 6 + 8
Combination 2 1 + 2 + 3 + 4 + 5 + 6 + 9
Combination 3 1 + 2 + 3 + 4 + 5 + 7 + 8
Combination 4 1 + 2 + 3 + 4 + 5 + 7 + 9

See also

Create load groups (page 517)

Manage load combinations
Load combinations allow you to assemble sets of load cases, applying the
appropriate factors for the strength and service condition. These factors are
specific to the design code that you are using.

To manage load combinations, see:

• Load combination classes (page 518)

• Generate load combinations automatically (page 519)

• Create load combinations manually (page 520)

• Create modal mass combinations (page 521)

• Import loadcases and combinations from a spreadsheet (page 522)

• Renumber all load combinations (page 526)
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Load combination classes
Combinations fall into five different classes, with a number of options available
for each of the classes:

Combination
class

Description Active Strength Service

Construction
Stage

Only required
for design of
composite
beams

Not applicable Not applicable Not applicable

Gravity Consists of
gravity loads
only (self
weight, dead,
slab dry, slab
wet, imposed,
roof imposed,
snow)

On/Off On/Off On/Off

Lateral In addition to
gravity loads,
contains
lateral loads
due to
notional loads
or wind

On/Off On/Off On/Off

Seismic Consists of
gravity and/or
lateral loads
as well as
seismic load
cases

On/Off On Not applicable

Modal Mass Only required
if you perform
a modal
analysis

On/Off Not applicable Not applicable

• Active: Selecting and clearing the option switches the combination on and
off for analysis and design.

• Strength: If the Strength option is not selected and the combination is
active, the combination is not assessed for design.

• Service: If the Service options is not selected and the combination is
active, the combination is not assessed for deflection.
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Generate load combinations automatically
The easiest way to create load combinations is to generate the combinations
automatically. In order to do so, see the following instructions.

NOTE Construction Stage combinations must be created manually.

1. On the Load tab, click Combination. 

The Loading dialog (page 531) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Generate... 

The Combination Generator dialog box opens.

3. On the first page of the dialog, specify the initial parameters according to
your needs. 

Depending on the number of combination types that you selected on the
first page, Tekla Structural Designer creates one or more pages of
combinations.

4. Click Next.

5. Review each page of combinations, and adjust them as necessary.

6. Click Next to move on to the next page.

7. To save the load combination, click Finish. 

Tekla Structural Designer adds the load combination to the list of
combinations available in the Loading list.

TIP To review the factors and options that have been applied to a
combination, click the combination name in the list on the left side
of the Loading dialog box.

Create load combinations manually
If necessary, you can create load combinations manually. In this case, Tekla
Structural Designer uses a default factor for each load case when you add it to
the combination.

1. On the Load tab, click Combination. 

The Loading dialog (page 531) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Add.

3. In Design Combination Title, name the combination.

4. In Class, select the combination class.
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5. Depending on the combination class that you selected, do some of the
following:

• Select Active in order to include the combination in analysis or design.

• Select Strength in order to assess the combination for design.

• Select Service in order to assess the combination for deflection.

6. In the left side pane of the Loading dialog box, click the combination
name.

7. Select the load cases that you want to add in the combination, and click
>>.

8. Click OK to save the load combination. 

Tekla Structural Designer adds the new load combination to the list of
combinations in the Loading list.

TIP To review the factors and options that have been applied to a
combination, click the combination name on the left side pane of
the Loading dialog box.

Create modal mass combinations

1. On the Load tab, click Combination. 

The Loading dialog (page 531) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Add.

3. In Design Combination Title, name the combination.

4. In Class, set the combination class to Modal Mass.

5. In the left side pane of the Loading dialog box, click the combination
name.

6. Select the load cases that you want to add in the combination, and click
>>.

7. On the Applied mass tab, set the directions to be considered, and if
necessary, specify the level below which mass can be ignored.

8. On the Second order effects tab, define the amplifier that you want to
apply to the combination.

9. Click OK to save the load combination. 

Tekla Structural Designer adds the new load combination to the list of
combinations in the Loading list.
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Import loadcases and combinations from a spreadsheet
Loadcases and combinations defined in an Excel Spreadsheet can be imported
via the ‘Import…’ button on the Loading dialog.

The data must be in the form of a matrix of combination factors in which load
cases form the row headers and combinations the column headers or vice-
versa. Where a matrix value is blank the associated case is omitted from the
combination. The load type can be set by including in the loadcase name “DL”
for dead load, “LL” for Imposed and “Wind” for Wind (without quotes).

The selected spreadsheet’s Worksheets are automatically listed and one is
selected for import.

Flexible controls allow definition of whether Loadcases are listed in a column
and combinations in a row or vice-versa and selection of the case and
combination column/row sources. Identified cases and combinations can be
reviewed prior to import and the case Type can be edited as necessary.

NOTE The following default/ automatically determined load cases are not supported
by this feature and would need to be manually added to combinations after
import; Self weight - excluding slabs, Slab self weight, Notional Loads (EHF,
NHF and NL).

Example

We want to import the following loadcases and combinations:

Combination Name Loadcase Strength Factor
dead + imposed DL Dead 1.35

LL Imposed 1.5
Dead+Imp+Wind
Accomp

DL Dead 1.35
LL Imposed 1.5
Wind 0.75

Dead+Imp Accomp
+Wind

DL Dead 1.35
LL Imposed 1.05
Wind 1.5

Dead+Wind DL Dead 1.35
Wind 1.5
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1. In an Excel spreadsheet a matrix of loadcases and combinations is set out
like this:

NOTE An empty cell is used to indicate a Loadcase is not to be included
in particular Combination.

2. Starting from either the Loadcases or Combinations dialog in Tekla
Structural Designer, click Import to start the Import loading wizard, the
first page of which is:

3. Click Open ... to navigate to the Excel file and the Sheet within the Excel
file which contains the matrix and then click Next.
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4. In the next page of the dialog you then choose the orientation of your
matrix and confirm the Excel column & row which contain the Loadcase
and Combination names (i.e. the matrix column and row headers). For
this example the correct orientation and name sources are:

5. The next page of the dialog allows you to confirm/amend Loadcase
options (a) Include (in the imported loadcases) - default is Include
checked on, and (b) Type (the Loadcase type from Dead, Slab Dry, Slab
Wet, Live, etc) - default is Dead for those names that can’t be identified
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automatically:

6. The next page of the dialog allows you to confirm/amend the
Combination option Include (in the imported combinations) - default is
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checked on:

7. The final page of the dialog summarizes the number of loadcases and
combinations that will be imported, after which click Finish to complete
the import process.

8. In the Loading dialog review the combinations, amend the combination
classes where required, and if necessary include additional loadcases (e.g.
automatically determined self weight).

Renumber all load combinations
When you delete load combinations from the Loading dialog box, the
remaining load combinations retain their original load case number. If
necessary, you can renumber the remaining load combinations in sequence.
For more information, see the following instructions.

1. On the Loading tab of the Project Workspace, right-click 
Combinations.

2. In the context menu, select Renumber.
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Manage envelopes
You can use envelopes to view analysis results for multiple combinations
simultaneously. When you do so, Tekla Structural Designer displays the
maximum positive and negative values along each member from any
combination included in the envelope.

NOTE When using envelopes, note the following:

• If you have defined patterned load combinations, you only need to include
the base case pattern combination in the envelope. This way, Tekla
Structural Designer automatically includes all pattern combinations
derived from the base case in the envelope.

• You can include gravity, lateral, and seismic combinations in the same
envelope.

• You should not include seismic RSA combinations in envelopes, as Tekla
Structural Designer currently cannot display the results.

Create envelopes

1. On the Load tab, click Envelope. 

The Loading dialog (page 531) opens on the Envelopes page. This page
displays all currently existing envelopes.

2. Click Add.

3. Name the envelope.

4. On the left side pane of the Loading dialog box, click the name of the
envelope.

5. Select the load combinations that you want to add in the envelope, and
click >>.

6. Click OK to save the envelope.

Manage load patterns
Having live/imposed loads applied only to a portion of the structure can
produce a more unfavorable loading than the "fully loaded" condition. More
unfavorable loading conditions can be considered in Tekla Structural Designer
by the use of load patterns.

To manage load patterns, see:

• Overview of load patterns (page 528)

• Apply patterning to live load cases (page 530)
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• Apply patterning to load combinations (page 530)

• Update load patterns (page 530)

Overview of load patterns

NOTE When you apply pattern loading to imposed loads, the factors of the loaded
and unloaded spans are specific to the design code that you are using.

The basic steps of applying pattern loads

1. Set individual imposed load cases to be patterned (page 530) according
to your needs.

These load cases are referred to as fully loaded pattern load cases.

2. Set the gravity combinations that contain imposed load cases to be
patterned (page 530) according to your needs.

These gravity combinations are referred to as base case pattern
combinations.

After load decomposition, the building analysis automatically sets up the
pattern cases for concrete beams in Dir1 and Dir2 directions as follows:

• 10 pattern cases for each pattern gravity combination

• 5 pattern cases for beams along Dir1 and 5 for beams along Dir2

NOTE By default, patterns are only applied to beam loads, and slab loads
that have been decomposed on to beams. Loads applied to meshed
slabs should be manually patterned using engineering judgement. For
more information, see Update load patterns (page 530).
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Pattern load cases

A pattern combination containing patterned imposed load cases results in 11
combinations: the base case combination, and 10 pattern combinations
derived from the base combination.

If you later modify the building geometry, update load patterns (page 530) to
ensure the load patterns reflect the changes.

NOTE Tekla Structural Designer contains a set of 10 pattern combinations
associated with each fully loaded pattern combination. The pattern
combinations are the same for beams and slabs.

The rules of applying load patterns to slabs and beams

Slab load patterning only applies where two-way slabs have been meshed in
the solver model:

• in FE chasedown analysis

• in 3D analysis where two-way slabs are set as meshed

Therefore, the slab load pattern setting has no affect on:

• one-way spanning slabs

• two-way slabs not meshed in 3D analysis, as the slab loads are being
decomposed to beams and walls prior to creation of the solver model

• two-way slab in Grillage chasedown analysis, as the slab loads are being
decomposed to beams and walls prior to creation of the solver model

Therefore, in 3D analysis and Grillage chasedown analysis:
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• When a beam is set to Full Load, it receives the full decomposed load from
adjacent unmeshed two-way slabs, irrespective of whether the slabs
themselves are set to Full Load or Min Load.

• When a beam is set to Min Load, it receives the min decomposed load
from adjacent unmeshed two-way slabs, irrespective of whether the slabs
themselves are set to Full Load or Min Load.

Apply patterning to live load cases
If necessary, you can apply load patterning to live/imposed load cases in a
combination. In order to do so, see the following instructions.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 531) opens on the Loadcases page. On this
page, you can see all currently existing load cases.

2. Click the live/imposed load case to which you want to apply patterning.

3. Select the Pattern Load option.

4. Click OK.

Apply patterning to load combinations
You can only apply load combinations to gravity combinations, as lateral and
seismic combinations do not consider pattern loading. For detailed
information on how to apply pattern loading to load combinations, see the
following instructions.

1. On the Load tab, click Combination. 

The Loading dialog (page 531) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. On the left side pane of the Loading dialog box, select the name of the
load combination.

3. In Parameters, ensure that the Pattern option is selected.

4. Click OK. 

NOTE If you wish, you can use pattern loading for every gravity
combination in your model. However, doing so may create many
additional combinations.
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Update load patterns
Tekla Structural Designer applies patterning to beam loads automatically.
However, if you need to apply patterning to slab loads for slab design or other
purposes, you must update the load patterns manually.

1. On the Load tab, click Update Patterns.

2. In the Properties window, select each pattern and adjust the loading
status of the existing beams and slabs.

3. To switch the loading status of a slab, click the slab in the model.

Loading dialog

Summary

The Loading dialog is used to define loadcases, load groups, combinations
and envelopes.

Location

On the Load tab, click:

• Loadcases - to open the dialog on the Loadcases page.

•  Load Groups to open the dialog on the Load Groups page.

• Combination- to open the dialog on the Combinations page.

•  Envelope- to open the dialog on the Envelopes page.

Content
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1. Loadcases

Loadcases table

Select Loadcases in the left hand pane to show a table of loadcases that have
been defined.

You can click within the table to:

• Rename a Loadcase Title.

• Change the type of a loadcase.

• Choose whether the "Self weight excludiung slabs" and Slab self weight"
cases are to be calculated automatically, or defined manually.

• Choose which cases are to be included when generating the load
combinations.

• Apply reductions to live/imposed cases.

• Apply pattern loading to live/imposed cases.

Using the buttons you can:

• Add a new loadcase to the table.

• Copy an existing loadcase.

• Delete an existing loadcase.

• Reorder to move loadcases up or down the table.

• Import... loadcases from a spreadsheet.

Loadcase parameters

Select an individual loadcase in the left hand pane to show parameters
specifically applicable to that loadcase.
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Certain values can only be specified by selecting individual loadcases, for
example:

• For dead loadcases: Prior to Brittle Finishes % .

• For live/imposed loadcases: Long Term % .

See also

Manage load cases (page 514)

2. Load Groups

Load Groups table

Select Load Groups in the left hand pane to show a table of any load groups
that have been defined.

Click within the table to:

• Rename a load group title.

• Set the load group class as Inclusive, or Exclusive.

• Choose whether the load group is to be included in the generator.
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Using the buttons you can:

• Add a new load group in the table.

• Copy an existing load group.

• Delete an existing load group.

• Reorder to move load groups up or down the table.

• Import... load groups from a spreadsheet.

Load group parameters

Select an individual load group in the left hand pane to set up the load group
content.

The load group class is set as Inclusive, or Exclusive.

The loadcases/load groups currently in the load group are shown in the
Included list.

Use the [>>] and [<<] buttons to add or remove loadcases/load groups from
the Available list to the Included list.

See also

Manage load groups (page 516)

3. Combinations

Combinations table

Select Combinations in the left hand pane to show a table of combinations
that have already been defined or generated.
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You can click within the table to:

• Rename a combination title.

• Change the class of a combination.

• Choose the gravity combination to be used for any steel beam camber
calculations.

• Choose which combinations are active for analysis and design.

• Choose which active combinations are to be assessed for strength.

• Choose which active combinations are to be assessed for service.

Using the buttons you can:

• Add a new combination in the table.

• Copy an existing combination.

• Delete an existing combination.

• Reorder to move combinations up or down the table.

• Import... combinations from a spreadsheet.

Combination parameters

Select an individual combination in the left hand pane to show the parameters
specifically applicable to that combination only.
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The tabbed boxes are used to set:

• Parameters: (Active, Pattern, Strength and Service).

• Type: Head code dependant type settings:

• US head code - ACI/LRFD or ASD.

• Eurocode - Formula type (STR, EQU, GEO)

• India - Limit State or Working Stress

• BS & Australia - not applicable

• Second order effects: the amplification factor, its direction, and whether it
is applied to all loads or lateral loads only.

• Timber design: (US and Eurocodes only) the load duration/time effect
factor.

The loadcases currently in the combination and the strength and serviceability
factors that apply are shown in the Included list.

• Use the [>>] and [<<] buttons to add or remove loadcases from the
Available Loadcases list to the Included list.

• In the Strength column specify the strength factors.

• In the Service column specify the service factors.

See also

Manage load combinations (page 518)
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6. Envelopes

Envelopes table

Select Envelopes in the left hand pane to show a table of any envelopes that
have been defined.

Using the buttons you can:

• Add a new envelope in the table.

• Copy an existing highlighted envelope.

• Delete an existing highlighted envelope.

• Reorder to move envelopes up or down the table.

• Import... to import envelopes from a spreadsheet.

Envelope parameters

Select an individual envelope in the left hand pane to set up the envelope
content.
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The combinations currently in the envelope are shown in the Included list.

Use the [>>] and [<<] buttons to add or remove combinations from the
Available Combinations list to the Included list.

5.2 Apply panel, member, and structure loads
• Apply panel loads (page 538)

• Apply member loads (page 544)

• Apply structure loads (page 546)

• Modify panel, member, and structure loads (page 555)

• Delete panel, member, and structure loads (page 555)

• Decompose panel loads (page 555)

Apply panel loads
You can use panel loads to apply loads to slab items, roof panels, and wall
panels. Tekla Structural Designer contains several types of panel loads,
including point loads, line loads, patch loads, polygonal loads, area loads, slab
loads, and level loads. In order to apply the different panel loads to your
model, see the following instructions.
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You can use the different panel loads in the following ways:

Panel load
type

Use Notes

Point load Can be applied anywhere
within an individual or across
multiple slab items, roof
panels, or wall panels.

Can only be applied in 2D
views.Patch load

Polygonal
load
Area load Entirely covers a slab item, a

roof panel, or a wall panel.
Not applicable

Slab load Entirely covers all slap items
in a parent slab.

A parent slab can consist of
slab items that are physically
separate from each other, but
are on the same level.

Level load Entirely covers all parent
slabs in a level.

Create point loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Point.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the load position, or press F2 to type the exact position. 

NOTE If you move the slab item or panel by manually selecting & re-
positioning its nodes, the point load does not move with the slab
or panel.

However, if you move any of the grid lines defining the reference
node, the load will move as well.

Create line loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate load case.
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3. On the Load tab, click Line.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

7. Click the end point of the load, or press F2 to type the exact position. 

Note that when you type the position using the keyboard, the end point is
an offset (X, Y) from the load start position.

Create patch loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Patch.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click to specify a corner position of the load, or press F2 to type the exact
corner position.

7. Click to specify the size of the load, or press F2 to type the size. 

The size is specified as the offset dimensions from the selected corner
position.

8. Click to specify the rotation angle of the load, or press F2 to type the
rotation angle.
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Create polygonal loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Polygon.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

7. Click a corner point of the load, or press F2 to type the exact position.

8. Repeat step 7 according to your needs.

9. When the polygon is complete, do one of the following:

• Press Esc.

• Click the first corner that you defined.

TIP To modify the shape of an existing polygonal load the following:

a. In the model, select the load.

b. Click one vertex of the load.

c. Click the point where you want to move the vertex.

Create perimeter loads
1. Open a 2D or 3D view showing the level at which you want to apply the

load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Perimeter.

4. In the Properties window, adjust the load details according to your needs.

TIP If necessary, you can select one or both of the following options:
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• Create as line loads: creates the load as a series of separate line
loads along each external edge.

• Ignore openings: only creates the load around external
perimeters, and not around internal opening perimeters.

5. Click any slab or mat item. 

Tekla Structural Designer creates the load around the external perimeter
of every continuous area of slabs at the selected level.

Create variable patch loads

NOTE Variable patch loads do not have to be quadrilaterals. Instead, they
can be any polygonal shape.

1. Open a 2D or 3D view showing the level at which you want to apply the
load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Var. Patch.

4. In the Properties window, specify three load values to describe the
variable loads.

5. Adjust the remaining load details according to your needs.

6. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

7. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

8. Click a corner point of the load, or press F2 to type the exact corner
position.

9. Repeat step 8 according to your needs.

10. When the polygon is complete, do one of the following:

• Press Esc.

• Click the first corner that you defined.

11. Click one of the corners of the polygon to specify the position of Load 1.

12. Click another corner to specify the position of Load 2.
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13. Click a third corner to specify the position of Load 3. 

TIP To modify the shape of an existing patch load the following:

a. In the model, select the load.

b. Click one vertex of the load.

c. Click the point where you want to move the vertex.

Create area loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Area.

4. In the Properties window, adjust the load details according to your needs.

5. Click the panel to which you want to apply the load.

Create variable area loads
Variable area loads can only be applied to non-horizontal slab items and roof
panels, as well as wall panels and concrete walls. Therefore, they cannot be
applied in a 2D view.

1. Open the 3D view, frame, or sloped plane view in which you want to apply
the load.

2. In the Loading list, select an appropriate load case.

3. On the Load tab, click Var. Area.

4. In the Properties window, adjust the load details according to your needs.

5. Click the slab item or panel to which you want to apply the load.

Create slab loads
1. In the Loading list, select an appropriate load case.

2. On the Load tab, click Slab.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load to all the slab items within a parent slab, in the model,
click any slab item within the parent slab.

Create level loads
Click any slab panel in order to apply the load to all slabs within the level.

1. In the Loading list, select an appropriate load case.
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2. On the Load tab, click Level.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load to all slabs within the level, in the model, click any slab
item.

Apply member loads
By using member loads, you can apply loads to one-dimensional members,
such as beams, columns, and braces.

Tekla Structural Designer allows you to create and apply the following types of
member loads:

• Full-length uniformly distributed loads (UDLs)

• Partial-length uniformly distributed loads (UDLs)

• Partial-length variable deck loads (VDLs)

• Trapezoidal loads

• Point loads

• Moment loads

• Full-length torsional uniformly distributed loads (UDLs)

• Partial-length torsional uniformly distributed loads (UDLs)

• Partial-length torsional variable deck loads (VDLs)

Create full-length UDLs
In order to create a full-length uniformly distributed load (UDL) and apply it to
a member, see the following instructions.

1. In the Loading list, select an appropriate load case.

2. On the Load tab, click Full UDL.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click anywhere along the member.

Create partial-length UDLs or VDLs
In order to create UDLs (uniformly distributed loads) or VDLs (variable deck
loads) that only apply to a selected part of the member, see the following
instructions.

1. In the Loading list, select an appropriate load case.

2. On the Load tab, click UDL or VDL.
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3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the start point of the load along the member, or press F2 to type the
exact position.

6. Click the end point of the load along the member, or press F2 to type the
exact position.

Create trapezoidal loads
In order to apply trapezoidal loads to the members in your model, see the
following instructions.

1. In the Loading list, select an appropriate load case.

2. On the Load tab, click Trapezoidal.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member that you want to apply the
load to.

5. Click the load position along the member, or press F2 to type the exact
position. 

The load position defines the point at which the symmetrical trapezoidal
load reaches its maximum intensity.

Create point loads and moment loads
In order to create and apply point loads or moment loads to the members in
your model, see the following instructions.

1. In the Loading list, select an appropriate load case.

2. On the Load tab, in the Member Loads group click Point or 
Moment.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the load position along the member, or press F2 to type the exact
position.

Create full-length torsional UDLs
In order to apply full-length torsional uniformly distributed loads (UDLs) to the
members in your model, see the following instructions.
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1. In the Loading list, select an appropriate load case.

2. On the Load tab, click Torsion Full UDL.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click anywhere along the member.

Create partial-length torsional UDLs and VDLS
In order to create and apply torsional uniformly distributed loads (UDLs) or
variable deck loads (VDLs) that only apply to a selected part of the member,
see the following instructions.

1. In the Loading list, select an appropriate load case.

2. On the Load tab, click Torsion UDL or Torsion VDL.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the start point of the load along the member, or press F2 to type the
exact position.

6. Click the end point of the load along the member, or press F2 to type the
exact position.

Apply structure loads
The four types of structure loads that you can apply are:

• Diaphragm loads: applied at any point within a rigid or semi-rigid
diaphragm

• Nodal loads (page 554): applied at solver node locations

• Temperature loads (page 554): global rises in temperature applied to
elements or panels.

• Settlement loads (page 554): translations or rotations applied to supports
in the support UCS system.

Diaphragm loads and diaphragm load tables
Diaphragm loads are Building Direction 1, Building Direction 2, and Mz torsion
loads applied at any point within a rigid or semi-rigid diaphragm.

Typically these might be used for the application of externally determined
level loads (for example from Wind Tunnel testing of large/ unusual
structures).
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The Diaphragm load command is available when a 2D plan view is active - it
can be used to apply a load to any diaphragm within the current view.

If you have multiple loads to apply at different levels, the Diaphragm Table of
loads provides a quicker means of doing this - either by typing the loads and
their positions directly into the table, or by pasting the data into the table from
a spreadsheet.

Add a diaphragm load in a 2D view
To apply a load to any diaphragm within the current 2D view:

Related video

Diaphragm loading

1. Open a 2D view of the level containing the diaphragm to which you want
to apply the load.

2. Click the Load tab on the ribbon.

3. In the Loading list, select an appropriate load case. 

 Diaphragm on the Load tab should now be active.

4. Click  Diaphragm

5. In the Properties window, adjust the load details according to your needs.

6. Click the load position, or press F2 to type the exact position.

Add multiple loads using the diaphragm load table

The diaphragm loads table provides a way to quickly apply multiple diaphragm
loads at different levels, either by typing the loads and their positions directly
into the table, or by pasting the data into the table from a spreadsheet.

1. On the Load tab, click Diaphragm Table.
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The Diaphragm Loads table opens in a dialog. If any loads had already
been added (via the Diaphragm Load command, or the Diaphragm Loads
table) these would be listed.

2. In order to see all the separate diaphragms at each level to which loads
could be applied, click the Show diaphragms with no loads box.
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Each level containing a diaphragm is listed, (if more than one diaphragm
exists at the same level a separate row is created for each).

3. In the Loading list at the bottom of the dialog, select the loadcase within
which you want to apply the load.
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4. In the table, click on the diaphragm level to which you want to apply the
load, then click Add.
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A row is displayed for entering the load. The initial default for the load
position is simply the middle point in X and Y of the diaphragm
extremities.

5. Enter the load values and the actual X and Y coordinates.

6. Add further rows of loading data as required, either at the same level or
other levels. 

NOTE Multiple loads can be applied to a single diaphragm if required.

7. Click OK when done. 

The loads are displayed on the model iat their defined locations.

NOTE To edit existing loads in the table, simply open it once more. To delete
loads from the table, select the diaphragm in the table and click
Delete.

Paste multiple loads into the diaphragm load table

If you have been provided with the loading data in the form of a spreadsheet
you can simply paste the data directly into the table.
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NOTE The data must includes a Z (Level height) column and you must ensure
that it is in the following order (which is not the same order as in the
diaphragm loads table):

1. Force in direction 1

2. Force in direction 2

3. Torsion moment

4. Position X

5. Position Y

6. Position Z

1. Open the spreadsheet containing the data to be pasted and copy the
contents to the clipboard.

2. In Tekla Structural Designer, on the Load tab, click Diaphragm Table.

The Diaphragm Loads table opens in a dialog.

3. In the Loading list at the bottom of the dialog, select the loadcase within
which you want to apply the load.
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4. Click Paste New.
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Provided the spreadsheet contents were in the expected format, the loads
and their positions are pasted into the table.

NOTE Existing diaphragm loads will be deleted / replaced by the pasted
data.

5. Click OK when done.

Create nodal loads
To create nodal loads at the solver nodes in your model, see the following
instructions.

1. Click the Load tab on the ribbon.

2. In the Loading list, select an appropriate load case. 

Nodal on the Load tab should now be active.

3. Click Nodal.

4. In the Properties window, adjust the load details according to your needs.

5. To define the load position, click the desired node.

Create temperature loads
Temperature loads are global rises in temperature that you can apply to
individual elements or panels in the model. For more information on how to
create temperature loads, see the following instructions.

1. Click the Load tab on the ribbon.

2. In the Loading list, select an appropriate load case. 

Temperature on the Load tab should now be active.

3. Click Temperature.

4. In the Properties window, adjust the load details according to your needs.

5. Click anywhere along the element to apply the load.

Create settlement loads
Settlement loads are translations or rotations that you can apply to a support.
To create settlement loads, see the following instructions.

1. Click the Load tab on the ribbon.
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2. In the Loading list, select an appropriate load case. 

Settlement on the Load tab should now be active.

3. Click Settlement.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a supported node to place the load.

Modify panel, member, and structure loads
To modify the properties of existing loads, see the following instructions.

1. In the model, select the load that you want to modify.

2. In the Properties window, adjust the load details according to your needs.

Delete panel, member, and structure loads
If necessary, you can delete existing loads in your model. In order to do so, see
the following instructions.

1. Ensure that the load case containing the load is displayed in the Loading
list.

2. On the Quick Access toolbar at the top of the window, click Delete.

3. Click the load that you want to delete.

Decompose panel loads

TIP Although Tekla Structural Designer carries out load decomposition automatically
when you click to analyze the structure, you have the option to decompose loads
manually by using the Decomposition command.

In the context of big or complex models, decomposing manually can potentially
save time, as it allows you to check that panel loads have been decomposed as
you intend before running the analysis.

Decompose panel loads for an individual construction level
1. Open a 2D view of the desired level. (page 276)

2. Click the '2D' toggle button at the bottom right corner of the view to
display it in 3D.
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3. On the Load tab, click Decomposition. 

Tekla Structural Designer generates an FE mesh within the two-way slab
panels, and applies the resulting decomposed loads to the supporting
members.

TIP In case you cannot see the changes in the model at this point,
ensure that you have selected the correct settings in Scene Content
- See View decomposed loads below.

Decompose panel loads to all required levels
1. Open the Structure 3D view.

2. On the Load tab, click Decomposition. 

Tekla Structural Designer generates an FE mesh within the two-way slab
panels, and applies the resulting decomposed loads to the supporting
members.

TIP In case you cannot see the changes in the model at this point,
ensure that you have selected the correct settings in Scene Content
- See View decomposed loads below.

View decomposed loads graphically
1. Open a 3D view of the model, or a 2D view displayed in 3D.

2. In Scene Content, go to Loading.

3. Select the Decomposed option.

4. According to your needs, do one of the following:

To Do this
View the decomposed load values • In the cell on the right side of Decomposed,

select both Geometry and Text.

View the decomposed loads without load values • In the cell on the right side of Decomposed,
only select Geometry.

5. In the Loading list, select the load case. 
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NOTE Decomposed loads do not exist for 2-way slab items at levels
where the Mesh 2-way Slabs in 3D Analysis option has been
selected.

At levels where this is not the case, you can view the decomposed
loads. However, you cannot see any shell results from the FE load
decomposition.

View applied and decomposed member loads in a table
1. Open a 3D view of the model, or a 2D view displayed in 3D.

2. Right-click on the member, and from the context menu select Show
Member Loading. Loads that have been applied directly to the member,
and loads that have been decomposed to the member are displayed in a
table. The 'In Proj.' checkbox is used to indicate applied loads applied in
projection as opposed to along the element.

3. To filter the data by Loadcase, Source, Direction, or Type:

a. Click the appropriate column header to filter by (Loadcase...,
Source..., Direction..., or Type...)

b. From the drop list that appears clear the categories that you don’t
want to be displayed.

c. Click the Close button under the drop list.

Overview of one-way and two-way load decomposition
The way in which Tekla Structural Designer decomposes panel loads depends
on how the slabs/panels are modeled and how they are spanning.

Slab/Panel type Decomposition
One-way spanning slab item Tekla Structural Designer 1-way

decomposes panel loads applied to
the slab directly on to those
supporting members/two-way
spanning slab edges before
performing 3D analysis.

The rotation angle of the slab item
determines the decomposition
direction.

NOTE Any openings in 1 way slabs
are ignored and thus have no
impact on load
decomposition.
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Slab/Panel type Decomposition
Roof panel Tekla Structural Designer 1-way

decomposes panel loads directly on
to supporting members/two-way
spanning slab edges before
performing 3D analysis.

The rotation angle of the roof panel
determines the decomposition
direction.

Two-way spanning slab item • At those levels where the Mesh 2-
way Slabs in 3D Analysis option
is selected, load decomposition is
not required.

• At other levels, any loads applied
to two-way slabs are automatically
2-way decomposed back to
supporting members during the
3D pre-analysis stage, immediately
prior to the 3D analysis stage.

NOTE Where openings have been
defined, any portion of a
panel load that lies within the
opening will not be
decomposed.

Roof panel overlapping a one-way
spanning slab item

Tekla Structural Designer 1-way
decomposes panel loads applied to
the slab directly on to supporting
members/two-way spanning slab
edges before performing 3D analysis.

The rotation angle of the slab item
(and not the roof panel) determines
the decomposition direction.

NOTE Any openings in 1 way slabs
are ignored and thus have no
impact on load
decomposition.

Roof panel overlapping a two-way
spanning slab item

• If there are no openings in the
slab, decomposition is as per Two-
way spanning slab item type
described above.

• Where openings exist, any panel
load applied inside the opening is
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Slab/Panel type Decomposition
first one-way decomposed in the
direction defined by the rotation
angle of the roof panel on to the
two-way slab at the edge of the
opening. It is then further
decomposed back to supporting
members as per Two-way
spanning slab item type
described above.

NOTE This does not apply when
the panel load is an area
load that has been
applied to the slab item
(as opposed to the roof
panel), or a level load, or a
slab load. In each of these
instances the load will
automatically be boxed
out around the opening.

5.3 Apply wind, snow, and seismic loads
Wind loads can be applied using the Wind Wizard, or they can be applied
manually - when applied manually they can take the form of panel, member,
or structure loads, or simple wind loads.

Similarly, snow loads can either be applied using the Snow Wizard or they can
be applied manually.

Seismic loads can only be applied using the Seismic Wizard.

• Apply wind loads using the wind wizard (page 559)

• Apply wind loads manually (page 565)

• Apply snow loads using the snow wizard (page 566)

• Apply snow loading manually (page 577)

• Apply seismic loads (page 577)
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Apply wind loads using the wind wizard
In Tekla Structural Designer, you can apply wind loads to your structure by
using the Wind Wizard to generate a wind model.

• Create a wind model and wind loads (page 560)

• Modify wind zones and wind zone loads (page 562)

• Create and manage wind load cases (page 564)

See also

Wind modeling handbook (page 1040)

Create a wind model and wind loads
You can use the Wind Wizard to automate the wind modeling process. Where
appropriate, the Wind Wizard uses databases to determine the appropriate
wind details for your structure location, and then calculates the appropriate
wind loading details according to the selected wind loading code.

RESTRICTION The Wind Wizard is not currently available for the Australian
AS:1170.2 wind loading code variant.

Once you have defined the wind directions in which you are interested, Tekla
Structural Designer automatically calculates the appropriate wind zones on
the roofs and walls of your structure. You can set the type of each roof to
achieve the correct zoning, and then tailor the zoning to account for particular
features in more detail, if you so require.

The wind modeling process can automatically define standard wind load cases
for you based on the usual internal pressure coefficients, or you can define
the load case information yourself. In both cases, the appropriate wind
pressures are calculated on each zone. You can then combine the wind load
cases into design combinations as usual.

NOTE The determination of the wind speeds, the pressures, and the zones is
rigorous. However, do remember that the final wind loads that are adopted
are your responsibility.

Run the Wind Wizard

NOTE You must define at least one wall or roof panel before running the
Wind Wizard.

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.
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NOTE The Wind Wizard varies slightly according to the head code that
you are using.

2. Define the necessary information for the wind model. To go to the next
page in the wizard, click Next.

3. Once you have defined all the necessary information, click Finish. 

NOTE After running the Wind Wizard, you can review the roof and wall
zones for each wind direction.

After you have created the wind model with the Wind Wizard,
you can open a wind view to graphically display the wind zones
and loading that apply for a particular wind direction.

Add wind directions

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

2. Click Next until you are on the Results page.

3. Click Add Dir.

4. Specify the properties of the new wind direction.

5. Click Finish. 

NOTE Remember to add new wind load cases and design combinations
to incorporate the wind loading for the new direction into your
calculations.

Delete wind directions

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

2. Click Next until you are on the Results page.

3. Click the wind direction that you want to delete.

4. Click Del Dir.

5. Click Finish. 

NOTE Remember to update the existing wind load cases and design
combinations to remove the details for the wind direction you
have deleted from your calculations.
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Delete the entire wind model

To delete the entire wind model and start the wind modeling process from
scratch, do the following:

1. On the Load tab, click Delete Wind. 

Tekla Structural Designer deletes all the previously defined wind
directions and wind load cases.

See also

Wind modeling handbook (page 1040)

Modify wind zones and wind zone loads
In order to view and modify the wind zones and loading that apply to a
particular wind direction, you have to open the appropriate wind view. Then,
you can modify the wind zones and wind zone loads according to your needs.

Open a wind view

NOTE Wind views are only available if you have already created the wind
model with the Wind Wizard.

1. In the Project Workspace, go to the  Wind tab.

2. Right-click the wind direction that you want to view.

3. In the context menu, click Open View. 

Tekla Structural Designer opens the selected wind view, and the Zone
Loads tab, which allows you to review wind zone data graphically.

View wind zones

1. Open a wind view that displays the details of the desired wind direction.

2. On the Zone Loads tab, click Wind Zones. 

The wind view displays the zones that are applied to the structure for the
selected wind direction.

Modify wind zones

1. Open a wind view that displays the details of the desired wind direction.

2. In the Project Workspace, go to the Wind tab.

3. For the wind direction in question, expand the Roof Zones or Wall Zones
branch.
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4. In the desired branch, right-click the panel label containing the zone that
you want to edit.

5. In the context menu, select Edit Zones... 

The Zone Properties dialog box opens.

6. Modify the wind zones according to your needs.

7. Click OK.

View the wind zone loads

NOTE Remember to update the zone loads when you make changes to your
model.

1. Open a wind view that displays the details of the desired wind direction.

2. On the Zone Loads tab, click Zone Loads.

3. In the Loading list, select the desired wind load case. 

Tekla Structural Designer displays the loads that are applied to the
structure for this load case in this wind direction.

Modify wind zone loads

1. Open a wind view that displays the details of the wind direction whose
zone loads you want to modify.

2. On the Zone Loads tab, click Zone Loads.

3. In the Loading list, select the desired wind load case. 

Tekla Structural Designer displays the loads that are applied to the
structure for this load case in this wind direction.

4. In the model, click the wind zone that you want to change.

5. In the dialog that opens, clear the Use Default Values option.

6. Modify the values that determine the loads. 

TIP If you want to reduce the net pressure for benecifial loads to zero,
select the Beneficial Load option.

7. To update the zones, OK.

Update wind zone loads

When you change the roofs or walls of your structure, Tekla Structural
Designer does not automatically update the changes to existing wind zoning.

Apply loading 563 Apply wind, snow, and seismic loads



Updating the zoning is manual because you may wish to make more
alterations before you recalculate the zoning.

Once you have completed your changes, incorporating them and recalculating
the zoning details is simple. To reinstate the zoning after making changes, do
the following:

1. On the Load tab, click Update Zones. 

The wind zoning calculations run in the background. Once the calculations
are complete, Tekla Structural Designer views the new zoning layout for
your structure.

NOTE If you have defined your own zone layout for any roof or wall, the
existing zones will be maintained when you make changes. Make
sure to update these zones appropriately.

Create and manage wind load cases
Once you have defined the basic wind data for your model, and calculated
wind zoning in the Wind Wizard, you can define the required wind load cases
manually. For detailed instructions, see the following paragraphs.

Define wind load cases

1. On the Load tab, click Wind Loadcases. 

The Wind Loadcases dialog box opens.

2. Do one of the following:

• Click Add to add the details of each wind load case individually.

• Click Auto to generate standard wind load cases for the wind
directions that you have defined in the Wind Wizard.

NOTE You cannot use the Auto option once you have created other
wind load cases.

Add wind load cases

1. On the Load tab, click Wind Loadcases. 

The Wind Loadcases dialog box opens.

2. Click Add.

3. Define the details of the new load case according to your needs.

4. Repeat steps 2 and 3 for each load case that you want to create.
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5. Click OK to close the Wind Loadcases dialog box. 

NOTE Remember to update or add design combinations, so that they
take the new wind load cases into account.

Delete wind load cases

1. On the Load tab, click Wind Loadcases.

2. Click the wind load case that you want to delete.

3. Click Delete.

4. Repeat steps 2 and 3 to delete further load cases.

5. Click OK to close the Wind Loadcases dialog box. 

NOTE Remember to update your design combinations, so that they take
the deleted wind load cases into account.

Apply wind loads manually
In case you do not want to construct an entire wind model, you can elect
instead to apply the wind loads manually. These can be applied as panel,
member, or structure loads in the usual way, or as simple wind loads.

Create load cases for manual wind loads

1. On the Load tab, click Loadcases. 

The Loading dialog box opens.

2. On the Loadcases page, click Add.

3. Name the new load case.

4. Set the type to Wind.

5. Click OK.

Create simple wind loads

RESTRICTION You can only create simple wind loads in the Structure 3D
view.
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NOTE In order access the Simple Wind Loading dialog box, you must first
create and select the load case where you want to add the simple
wind loads.

1. In the Loading list, select a manually created wind load case.

2. On the Load tab, click Simple Wind.

3. In the model, click to define the start point of the load width.

4. Click to define the end point of the load width. 

The Simple Wind Loading dialog box opens. The dialog box allows you to
specify a single area wind load from the lowest level of the building up to
the highest level that contains a rigid diaphragm.

TIP The wind load does not have to begin at the lowest level of the
building.

If you have one or more levels below ground, you can adjust the
value of the lowest level in the Simple Wind Loading dialog box.

5. Specify the required area load.

6. To create a stepped profile up the height of the building, use the Insert
Above, Insert Below, Quick Above... and Quick Below... buttons.

7. Specify the load for each level.

8. When you load is complete, click OK.

Modify simple wind load vertical properties
1. Double-click anywhere in an existing simple wind load. 

The Simple Wind Loading dialog box opens.

2. Modify the load properties according to your needs.

3. Click OK.

Modify the simple wind load width
1. Select the simple wind load that you want to modify.

2. Select one of the two nodes that define the load width.

3. Click where you want to move the selected node. 

Tekla Structural Designer moves the selected node to the new location,
and regenerates the load.
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Apply snow loads using the snow wizard
In Tekla Structural Designer, you apply snow loads to your structure by
running the Snow Wizard to input basic snow data and set up the required
snow loadcases. Provided that Roof Panels have been modeled, some of these
loadcases will be populated with Uniform Snow automatically; the remaining
loadcases then have Uniform Snow, Valley Snow and Local Drift Snow applied
manually as required. As an alternative, you can also choose to apply the snow
loads manually.

NOTE The Snow Wizard is not currently available for the Indian, Australian, or
British Standard snow code variants.

• Overview of snow loading using the snow wizard (page 567)

• Roof panel types (page 568)

• Run the snow load wizard (page 568)

• Snow loadcases (ASCE7) (page 569)

• Snow loadcases (Eurocode) (page 572)

• Apply drift loads to load cases on completion of the snow wizard
(page 574)

• Update snow loads (page 577)

• Delete the snow model (page 577)

Apply snow loading manually (page 577)

How do I define snow loading? (Playlist)

Overview of snow loading using the snow wizard
This section provides a brief overview of snow loading in Tekla Structural
Designer.

The intensity of snow load is based upon geographic location, building/roof
geometry, environmental factors and local roof factors.

All snow loading falls into three categories:

• Uniform Snow load (the first fall of snow)

• Drifted uniform snow (the first fall of snow blown into uneven uniform
loading)

• Drift loading (local build-up of snow load behind steps, objects, parapets)
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Prior to running the Snow wizard... you should ensure that roofed areas of
the model are 'clad' with roof panels.

The Snow wizard... can then be run in order to define the basic snow load
factors and in the case of the Eurocode, the snow load cases and types
relevant to the particular National Annex.

From this information all the required snow loadcases are automatically set up
and the loads in the undrifted (or balanced) snow load case are created.

Following the wizard, you then manually define the drift cases. To do this,
select the relevant snow loadcase, and then define the key attributes for the
drift load prior to placing the load in the relevant position on the roof of the
building.

The end result is a series of snow loadcases ready to be combined in the
Combination Generator with other load cases.

The basic steps are summarized as follow:

1. Apply Roof Panels to the model

2. Run the Snow wizard...

3. Apply snow loads to the drift loadcases set up by the wizard

4. Combine snow loadcases into design combinations

5. Perform the static design

How do I define snow loading? (Playlist)

Roof panel types
For the snow loading calculations, Tekla Structural Designer has to distinguish
between monopitch (monoslope) and pitched roofs. This is determined from
the RoofType property that has been assigned to the roof panel.

The RoofType property is mapped for the determination of snow loading as
follows:

RoofType For snow loading this is considered
as:

Default Monopitch (Monoslope)
Flat Monopitch (Monoslope)
Monopitch (Monoslope) Monopitch (Monoslope)
Hip Gable Pitched
Hip Main Pitched
Mansard Pitched
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Run the snow load wizard
With the Snow Wizard, you can automatically generate snow load cases in
both ASCE7 and EN 1991-1-3 snow loading codes. Using the wizard, you can
set up basic snow data, snow load cases, and snow loads within the balanced,
or undrifted, snow load cases.

RESTRICTION • The Snow Wizard is not currently available for the Indian,
Australian, or British Standard snow loading code variants.

• Snow loads in drift snow load cases are not set up
automatically, and must therefore be manually applied.
For more information, see Manually apply snow loads to
snow load cases.

1. On the Load tab, click Snow Load --> Snow wizard... 

The Snow Wizard opens.

2. On the first page of the Snow Wizard, define the basic data.

3. Click Next.

4. On the second page, specify the load cases that you want to generate, and
the number of drift directions to be considered.

5. Click Finish. 

If necessary, you can now review the snow load cases that you created.

See also

Snow wizard (ASCE7) (page 2435)

Snow wizard (Eurocode) (page 2426)

How do I define snow loading? (Playlist)

Snow loadcases (ASCE7)
This section will look at the snow loadcases when the headcode is set to AISC.

The snow loadcases that are set up will depend on the head code that is being
worked to.

NOTE All loads and lengths of loads are assumed to act on a horizontal projection of
the roof surface.

Once set up these loadcases are standard loadcases so you can include them
in combinations in the normal manner.

In the Snow wizard... you specify the Snow Loadcases to be set up from the
following list:

• Minimum Snow Load - for low sloped roofs

• Balanced Snow load - uniform snow load and rain on snow load
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• Unbalanced Snow Load - the number of cases required being chosen to
reflect the number of wind directions considered

• Drift Snow Load

• Rain on Snow Surcharge

Minimum snow load

Loads would need to be manually applied to this loadcase on completion of
the Snow wizard... - the only snow load applicable being Uniform Snow.

Balanced snow load

This loadcase is automatically populated on completion of the Snow wizard...
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Unbalanced snow load

Loads would need to be manually applied to these loadcases on completion of
the Snow wizard... - both Uniform Snow and Valley Snow loads may be
applicable, (depending on the model geometry).
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Drift snow loads

Loads would need to be manually applied to these loadcases on completion of
the Snow wizard... - the only snow load applicable being Local Drift Snow.

Rain on Snow Load Surcharge

This loadcase is automatically populated on completion of the Snow wizard...

Snow loadcases (Eurocode)
This section will look at the snow loadcases when the headcode is set to
Eurocode.
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The snow loadcases that are set up will depend on the head code that is being
worked to.

NOTE All loads and lengths of loads are assumed to act on a horizontal projection of
the roof surface.

Once set up these loadcases are standard loadcases so you can include them
in combinations in the normal manner.

In the Snow wizard... you choose the Snow Loadcases to be set up from the
following list:

• Snow Load - Case A - 1) Undrifted

• Snow Load - Case A - 2) Drifted *

• Snow Load - Case B1 - 1) Undrifted Snow Load - Case B1 - 2) Drifted *

• Snow Load - Case B1 - 3) Undrifted (Acc)

• Snow Load - Case B1 - 4) Drifted (Acc) *

• Snow Load - Case B2 - 1) Undrifted

• Snow Load - Case B2 - 2) Drifted *

• If any drifts from Annex B are selected

• Snow Load - Case B2 - 3) Drifted (Annex B) (Acc) *

• Snow Load - Case B3 - 1) Undrifted

• Snow Load - Case B3 - 2) Drifted *

• Snow Load - Case B3 - 3) Undrifted (Acc)

• If any drifts from Annex B are selected

• • Snow Load - Case B3 - 4) Drifted (Annex B) (Acc) *

NOTE For cases marked * - the number of cases actually set up will depend on the
number of wind directions that are asked for.

NOTE The Eurocode / National Annex recommends which loadcases to generate.
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Undrifted loadcases

Any undrifted loadcases that have been set up in the Snow wizard... are
automatically populated with uniform loading on completion of the wizard

Drifted loadcases

All drifted loadcases that have been set up in the Snow wizard... would need
to be have their snow loads manually applied on completion of the wizard.
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Apply drift loads to load cases on completion of the snow wizard
The loads in the drifted snow load cases have to be applied manually as
uniform snow, valley snow, or local drift snow loads. Any snow loads that are
not appropriate for the selected load case cannot be selected.

Apply uniform snow loads

1. In the Loading list, select a snow load case generated by the wizard
appropriate for uniform snow.

2. On the Load tab, click Snow Load --> Uniform Snow.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click the relevant roof panel. 

NOTE In the unbalanced cases, setting Roof type option to Pitched
allows you to select whether the wind type of the load should be
Windward or Leeward.

Apply a valley snow load

1. In the Loading list,select a snow load case generated by the wizard
appropriate for valley snow.

2. On the Load tab, click Snow Load --> Valley Snow.

3. Select the left roof panel of the valley in which the load is applied. 

Tekla Structural Designer automatically determines the right panel, and
calculates the valley load.

TIP If necessary, you can use apply a user override to the calculated
load. Even if you rerun the Snow Wizard, Tekla Structural Designer
maintains any user overrides that you have applied.

NOTE Graphic displays depict the loading magnitude of a snow load,
and not depth of loading. Remember this when reviewing the
load that has been calculated on structures like the low pitched
valley model shown below:
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Although the above image appears to indicate snow load rising
above the ridges, the display actually views the loading
magnitude.

Apply a local drift snow load

1. In the Loading list, select a snow load case generated by the wizard
appropriate for local drift snow.

2. On the Load tab, click Snow Load --> Local Drift Snow.

3. Go to the Properties window.

4. Specify the drift type, and then enter the height, and any other
parameters required to define the drift.

5. In the model, select the roof panel edge where the drift is to form, taking
care to click close to the required edge. 

TIP The edge closest to the cursor is highlighted, if this isn't where you
want the drift to form move the cursor toward the edge required
before clicking to select.

6. Click the start point of the drift on the highlighted edge.

7. Click the end point of the drift on the highlighted edge. 

TIP If necessary, you can use apply a user override to the calculated
load. Even if you rerun the Snow Wizard, Tekla Structural Designer
maintains any user overrides that you have applied.

Override snow loads

You can apply user overrides for snow load values and drift lengths, if
necessary.

1. Select the snow load.

2. In the Properties window, select the Override load value option.
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3. Specify the override value. 

Tekla Structural Designer maintains the user overrides, even if you rerun
the Snow Wizard.

Update snow loads
If you have created a snow model using the Snow Wizard, and later decide to
modify the roof geometry, the snow loads need to be recalculated. To do so,
see the following instructions.

• On the Load tab, click Snow Load --> Update Snow Loads.

See also

Delete the snow model (page 577)

Delete the snow model
Occasionally, you may need to delete the entire snow model, and start the
process from scratch. In order to do so, see the following instructions.

• On the Load tab, click Snow Load --> Delete Snow. 

Tekla Structural Designer resets the basic data that was previously defined
in the Snow Wizard, and deletes the snow load cases.

Apply snow loading manually
This approach provides an alternative method to apply snow loading to the
structure, without having to run the Snow Wizard

In order to manually apply snow loads, you must first create a loadcase
(page 515) and set its load type to Snow.

You can then manually apply loads (page 538) to this loadcase in the normal
way.

NOTE Snow loadcases created manually in this way can have panel,
member, and structure loads applied but cannot have snow (i.e.
Uniform Snow, Valley Snow and Local Drift Snow) loads applied.

Apply seismic loads
Use the Seismic Wizard to define all the parameters required to set up the
seismic loadcases and combinations.
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RESTRICTION The Seismic Wizard is not currently available for the Australian
AS:1170.4 loading code variant.

Create seismic loads in the Seismic Wizard

1. On the Load tab, click Seismic Load --> Seismic Wizard... 

The (page 579) opens.

NOTE The parameters in the Seismic Wizard vary according to the
loading code that you have selected in Model Settings.

2. In the Seismic Wizard, define the necessary parameters for the seismic
loading and load cases. To go to the next page, click Next.

3. Once you have defined the parameters, click Finish. 

The Combination Generator dialog box opens.

4. In the Combination Generator dialog box, define the seismic load
combinations.

5. Click Finish.

Display the horizontal design spectrum
After running the Seismic Wizard, you can view the horizontal design
spectrum.

1. On the Load tab, click Seismic Load --> Horizontal Spectrum.

2. If necessary, in the Properties window, you can switch Direction between
Dir 1 and Dir 2.

Delete seismic loads
• On the Load tab, click Seismic Load --> Delete Seismic. 

Tekla Structural Designer deletes all the previously defined seismic loads in
your model.

See also

Seismic wizard in detail (page 579)

Seismic analysis and conventional design (page 1199)

Seismic analysis and seismic design (page 1200)

Seismic analysis and design handbook (page 1186)
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Seismic wizard in detail
The Seismic Wizard is run to specify the seismic analysis method (RSA or ELF)
and to set up the seismic loadcases and combinations.

The information that is entered in the seismic wizard will vary according to the
seismic loading code that is being worked to:

• Using the ASCE7 seismic wizard (page 579)

• Using the UBC 1997 seismic wizard (page 587)

• Using the Eurocode EN1998-1:2004 seismic wizard (page 594)

• Using the IS1893 seismic wizard (page 603)

• Code spectra and site specific spectra (page 609)

• Seismic loadcases (page 621)

See also

Seismic analysis and design handbook (page 1186)

Using the ASCE7 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

• Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the ASCE Horizontal Design
Spectrum (page 611).

Site
Specific
Spectra
(user
defined -

User defined spectra are appropriate for locations
which use another country's loading and design codes
where the code spectrum is not relevant.
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Property Description
based on
Sd and T)

For this option you create a user defined spectrum by
specifying the required curve parameters and slope
options.

See: Code spectra and site specific spectra (page 609).
Site
Specific
Spectra
(user
defined -
generic
curve)

User defined spectra are appropriate for locations
which use another country's loading and design codes
where the code spectrum is not relevant.

For this option you create a user defined spectrum by
specifying the required curve manually, or by pasting
data from a spreadsheet.

NOTE The spreadsheet data must be in the form of
period vs acceleration values and in ascending
order of period (the input dialog features an
automatic Sort command if the latter is not
the case).

See: Code spectra and site specific spectra (page 609).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

The Seismic Design Category (SDC) is determined on this page.

NOTE In ASCE7-10 (not ASCE7-05) there is an additional value of Cs calculated for a
building < 5 stories and where T <0.5s. In this instance Ss is taken as 1.5 and
the additional value of Cs should be used to give a final value of Cs. This clause
has not been implemented in Tekla Structural Designer.

Property Description
Structure details
Height to
the
highest
level

This field defaults to the structure height (calculated
from the base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the
seismic weight combination is determined.
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Property Description
Number
of stories

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field
above.

Site Occupancy
Site class This field allows you to set the appropriate soil

conditions, A-E - (A - Hard rock, B - Rock, C - Very dense
soil/soft rock, D - Stiff soil, E - Soft soil. as defined in
ASCE7-05 & ASCE-10 Table 20.3-1.

Occupanc
y/Risk
Category

This field allows you to set the appropriate occupancy
category, I-IV, as defined in ASCE 7-05 &-10 Table 1-1.

Importan
ce Factor,
Ie

This is automatically derived from the occupancy class.

Override
check box

Checking this box allows you to override the
importance factor, (some countries require different
Importance Factors to those given in the US codes).

Seismic Design Category (SDC)
Seismic
Design
Category
(SDC)

User editable (range A-F)

Alternativ
e seismic
design
category
determin
ation

Select this check box in order to use the alternative
determination from IBC2009 1613.5.6.1 / IBC2012
1613.5.6.

User
Defined
SDC

Select this check box in order to specify your own SDC
Category

Max earthquake spectral response acceleration
Ss – short
period
(0.2s)

This figure can be determined from the maps found in
ASCE 7-05 &-10

(units % of g, range 1 – 500)
S1 – 1.0s
period

This figure can be determined from the maps found in
ASCE 7-05 &-10

(units % of g, range 1 – 500)
Design spectral response spectral acceleration
SDS –
short
period

This is automatically determined from SS and the site
class, according to ASCE 7-05&-10
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Property Description
SD1 – 1s
period

This is automatically determined from S1 and the site
class, according to ASCE 7-05&-10

Next Unless the SDC is type A, clicking Next takes you to the
Structure Irregularities page described below; for
SDC type A only, clicking Next takes you to the Seismic
Loading page.

Structure Irregularities page

For SDC types B to F this page is used to indicate any irregularities in plan or
vertically.

Property Description
Structur
e Plan
Irregular
ities

Check the appropriate boxes to define any plan
irregularities.

Structur
e
Vertical
Irregular
ities

Check the appropriate boxes to define any vertical
irregularities.

Analysis
procedur
e to be
used

Having specified any irregularities, you then choose
the analysis procedure.

• Use Equivalent Lateral Force Procedure

• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined,
one or both of the above methods may be
unavailable.

Any additional information, assumptions or
warnings applicable to the selected a method
are displayed for information.

Next Clicking Next takes you to the Fundamental Period
page described below.

Fundamental Period page

For SDC types B to F this page is used to determine the fundamental period,
TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
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Property Description
Use
approx
fundame
ntal
period Ta

This is automatically derived from ASCE7-05&-10
clause 12.8.2.1.

User
defined
fundame
ntal
period T

If RSA was selected on the previous page this option is
dimmed.

Use
modal
analysis

Modal analysis is run to determine fundamental
periods of the structure in Dir1 and Dir2.

Fundamental Period
Long
period
transition
period, TL

This figure can be determined from figs 22-15, 16, 17,
18, 19 and 20 found in ASCE 7-05 or figs 22-12, 13, 14,
15 and 16 found in ASCE 7--10.

TS This value is derived (Ts = SD1/SDS)

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Steel moment resisting frames, Concrete
moment resisting frames, Eccentrically braced steel
frames or All other structural systems (ref ASCE7-05 /
ASCE7-10 Table 12.8-2

Approx
fundame
ntal
period, Ta

This is automatically derived from ASCE7-05&-10
clause 12.8.2.1.

Fundame
ntal
period,
TDir 1, TDir

2

Depending on your choice of definition this will either
be taken as Ta, or it can be a user defined value, or it
will be calculated from the modal analysis.

Next Clicking Next takes you to the Seismic Force
Resisting System page described below.

Seismic Force Resisting System page

For SDC types B to F this page is used to determine the response modification
coefficient, R, and other factors in the X and Y directions.

Property Description
Seismic force resisting system Dir 1 and Dir 2
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Property Description
System This field allows you to set the appropriate system, (eg.

bearing wall, building frame, moment resisting frame
etc.) from ASCE7-05 &-10 Table 12.2-1.

Type This field allows you to set the appropriate type for the
chosen system from ASCE7-05 &-10 Table 12.2-1.

Coefficients & Factors Dir 1 and Dir 2
Response
modificati
on
coefficien
t, R

This is automatically derived, but you are given the
facility to edit the calculated value.

System
over-
strength
factor

This is automatically derived, but you are given the
facility to edit the calculated value.

Deflectio
n
amplificat
ion
factor, Cd

This is automatically derived, but you are given the
facility to edit the calculated value.

Redunda
ncy
factor, ρ

This is automatically derived from the SDC, (SDC B-C ρ
= 1.0, SDC D-F ρ = 1.3) but you are given the facility to
edit the calculated value.

Next Clicking Next takes you to the Effective Seismic
Weight page described below.

Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those load cases that you want to contribute to the
Structure Seismic Dead Weight.

NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

If you select the Include localization option, this page is then used to define
appropriate localization parameters for using the ASCE7 code outside of the
US.

Property Description
Seismic & RSA
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Property Description
Scale
Factor
between
elastic
and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the
scale factor, (ASCE7 code value = 1/(R/I)).

User
Defined
Static
Base
Shear
(Dir1 and
Dir2)

This field allows you to override the code value for the
static base shear, (ASCE7 code value V = Cs x W and Cs
= SDS / (R /Ie)).

%
eccentrici
ty for
accidenta
l torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity
for accidental torsion, (ASCE7 code value = 5%).

NOTE The same value is applied to all floors in the
structure.

Vertical
seismic
load
effect
combinati
on factor

This field allows you to override the combination
factor for vertical seismic loading (usually a small
additional factor for the dead loads in the
combination),(ASCE7 factor = 0.2 x SDS x Dead loads).

RSA only (only available if RSA has been selected)
% Mass
participat
ion for
RSA

This field allows you to set your own required % mass
participation, (ASCE7 code value = 90%).

NOTE This overrides the setting in Analysis
Options/1st order seismic when running the
Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value
is 99%.

NOTE This setting can benefit some users wanting
nearer 100% to be conservative.
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Property Description
Scaling of
forces (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors, (ASCE7 code value: 85% x V / Vt).

Scaling of
Deflectio
ns for
Drift
Checks (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors, (ASCE7 code value: 85% x V / Vt).

NOTE A zero factor means no scaling will be
performed on deflections.

Finish Click Finish to automatically generate the Seismic
loadcases (page 621) and open the ASCE7 Seismic
Combination Generator described below.

ASCE7 Seismic Combination Generator

The Combination Generator sets up seismic combinations from the following
ASCE7-5 and ASCE7-10 "core" combinations that include seismic loads.

ASD - Seismic Combinations

5) 1.0D + 0.714E

6) 1.0D + 0.75L + 0.536E + 0.75S

8) 0.6D + 0.714E

NOTE In ASCE, in the above 0.714 equates to 0.7 and 0.536 equates to 0.525. Tekla
Structural Designer utilizes the ASCE factors - you can however change them if
required.

LRFD - Seismic Combinations

5) 1.2D + 1.0E + 1.0L + 0.2S

7) 0.9D + 1.0E

(Where E is the seismic component of the loading in the combination.)

Property Description
Initial Parameters page
Delete /
Replace
combinati
ons

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
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Property Description
Scenario If you need to generate combinations for a range of

different scenarios, ensure you type in (or choose from
the droplist if appropriate) a scenario name. This
scenario name is then added as a prefix to all the
combinations generated in the this run of the
generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page
described below.

Combinations page
Generate Select the seismic combinations to be generated with

factors as specified.
Keep
existing
Seismic
Combinat
ions

If you want to retain previously set up Seismic
Combinations you can select this check box to do so.

NOTE Warning - some factors may no longer be
correct for these combinations after rerunning
the Wizard.

Next Click Next to specify the service factors.
Finish Click Finish to generate the Seismic combinations.

Using the UBC 1997 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure in accordance with the Uniform Building Code.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

1. Click Home > Model Settings > Design Codes

a. Set the Design Code for Seismic Loading to UBC

b. Click OK

2. Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:
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Property Description
Code
Spectra

Choose this option to use the UBC Horizontal Design
Spectrum.

Site
Specific
Spectra

This option is appropriate for locations which use
another country's loading and design codes where the
code spectrum is not relevant.

For this option you create a user defined spectrum by
specifying the required curve parameters and slope
options.

See: Code spectra and site specific spectra (page 609).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

The Seismic Design Category (SDC) is determined on this page.

NOTE In ASCE7-10 (not ASCE7-05) there is an additional value of Cs calculated for a
building < 5 stories and where T <0.5s. In this instance Ss is taken as 1.5 and
the additional value of Cs should be used to give a final value of Cs. This clause
has not been implemented in Tekla Structural Designer.

Property Description
Structure details
Height to
the
highest
level

This field defaults to the structure height (calculated
from the base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the
seismic weight combination is determined.

Number
of stories

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field
above.

Soil Profile Occupancy
S - Soil
Profile
Type

This field allows you to set the appropriate soil
conditions, A-E - (A - Hard rock, B - Rock, C - Very dense
soil/soft rock, D - Stiff soil, E - Soft soil. As defined in
UBC97 Table 16-J.
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Property Description
Occupanc
y
Category

This field allows you to set the appropriate occupancy
category, I-IV. As defined in UBC97 Table 16-K.

Importan
ce Factor,
I

This is automatically derived from the occupancy
category.

Override
check box

Checking this box allows you to override the
importance factor, (some countries require different
Importance Factors to those given in the US codes).

Seismic Zone
Seismic
Zone

This field allows you to set the appropriate zone, I-4. As
defined in UBC97 Figure 16-2

Z -
Seismic
Zone
Factor

This is automatically derived for the seismic zone.

Near Source (for Seismic Zone 4 only)
Seismic
Source
Type

This field allows you to set the appropriate source
type, A-C.

Distance
to
Seismic
Source

The distance to the seismic source.

Next Clicking Next takes you to the Structure
Irregularities page described below.

Structure Irregularities page

For SDC types B to F this page is used to indicate any irregularities in plan or
vertically.

Property Description
Structur
e Plan
Irregular
ities

Check the appropriate boxes to define any plan
irregularities.

Structur
e
Vertical
Irregular
ities

Check the appropriate boxes to define any vertical
irregularities.

Analysis
procedur

Having specified any irregularities, you then choose
the analysis procedure.
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Property Description
e to be
used

• Use Static Force Procedure

• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined,
one or both of the above methods may be
unavailable.

Any additional information, assumptions or
warnings applicable to the selected a method
are displayed for information.

Next Clicking Next takes you to the Fundamental Period
page described below.

Fundamental Period page

For SDC types B to F this page is used to determine the fundamental period,
TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
Use
approx
fundame
ntal
period Ta

This is automatically derived.

If RSA was selected on the previous page this option is
dimmed.

User
defined
fundame
ntal
period

If RSA was selected on the previous page this option is
dimmed.

Use
modal
analysis

Modal analysis is run to determine fundamental
periods of the structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Steel moment resisting frames, Concrete
moment resisting frames, Eccentrically braced steel
frames or All other structural systems

Approx
fundame
ntal
period, Ta

This is automatically derived.
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Property Description
Fundame
ntal
period,
TDir 1, TDir

2

Depending on your choice of definition this will either
be taken as Ta, or it can be a user defined value, or it
will be calculated from the modal analysis.

Next Clicking Next takes you to the Seismic Force
Resisting System page described below.

Seismic Force Resisting System page

This page is used to determine the response modification coefficient, R, and
other factors in the directions 1 and 2.

Property Description
Seismic force resisting system Dir 1 and Dir 2
System This field allows you to set the appropriate system, (eg.

bearing wall, building frame, moment resisting frame
etc.) from UBC97 Table 16-N.

Type This field allows you to set the appropriate type for the
chosen system from UBC97 Table 16-N.

Coefficients & Factors Dir 1 and Dir 2
Response
modificati
on
coefficien
t, R

This is automatically derived, but you are given the
facility to edit the calculated value.

System
over-
strength
factor

This is automatically derived, but you are given the
facility to edit the calculated value.

Redunda
ncy factor
drift, ρdrift

This factor has to be entered manually.

Redunda
ncy
factor, ρ

This factor has to be entered manually.

Next Clicking Next takes you to the Effective Seismic
Weight page described below.
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Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those load cases that you want to contribute to the
Structure Seismic Dead Weight.

NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

If you select the Include localization option, this page is then used to define
appropriate localization parameters for using the UBC code outside of the US.

Property Description
Seismic & RSA
Scale
Factor
between
elastic
and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the
scale factor, (UBC code value = 1/R).

User
Defined
Static
Base
Shear
(Dir1 and
Dir2)

This field allows you to override the code value for the
static base shear, (UBC code value V = Cv x I x W / (R x
T)).

%
eccentrici
ty for
accidenta
l torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity
for accidental torsion, (UBC code value = 5%).

NOTE The same value is applied to all floors in the
structure.

Vertical
seismic
load
effect
combinati
on factor

This field allows you to override the combination
factor for vertical seismic loading (usually a small
additional factor for the dead loads in the
combination), (UBC factor = 0.5 x Ca x I x Dead loads
for strength design and 0.0 for allowable stress
design).

RSA only (only available if RSA has been selected)
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Property Description
% Mass
participat
ion for
RSA

This field allows you to set your own required % mass
participation, (UBC code value = 90%).

NOTE This overrides the setting in Analysis
Options/1st order seismic when running the
Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value
is 99%.

NOTE This setting can benefit some users wanting
nearer 100% to be conservative.

Scaling of
forces (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors,

UBC code values:

Code ground motion = 90% x V / VDesign

Site specific ground motion = 80% x V / VDesign

Irregular structures = 100% x V / VDesign

Scaling of
Deflectio
ns for
Drift
Checks (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors,

UBC code values:

Code ground motion = 90% x V / VDesign

Site specific ground motion = 80% x V / VDesign

Irregular structures = 100% x V / VDesign

NOTE A zero factor means no scaling will be
performed on deflections.

Finish Click Finish to automatically generate the Seismic
loadcases (page 621) and open the UBC Seismic
Combination Generator described below.

UBC Seismic Combination Generator

The Combination Generator sets up seismic combinations from the following
UBC 1997 "core" combinations that include seismic loads.

ASD - Seismic Combinations

5) 1.0D + 0.714E
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6) 1.0D + 0.75L + 0.536E + 0.75S

8) 0.6D + 0.714E

NOTE In ASCE, in the above 0.714 equates to 0.7 and 0.536 equates to 0.525. Tekla
Structural Designer utilizes the ASCE factors - you can however change them if
required.

LRFD - Seismic Combinations

5) 1.2D + 1.0E + 1.0L + 0.2S

7) 0.9D + 1.0E

(Where E is the seismic component of the loading in the combination.)

Property Description
Initial Parameters page
Delete /
Replace
combinati
ons

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of

different scenarios, ensure you type in (or choose from
the droplist if appropriate) a scenario name. This
scenario name is then added as a prefix to all the
combinations generated in the this run of the
generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page
described below.

Combinations page
Generate Select the seismic combinations to be generated with

factors as specified.
Keep
existing
Seismic
Combinat
ions

If you want to retain previously set up Seismic
Combinations you can select this check box to do so.

NOTE Warning - some factors may no longer be
correct for these combinations after rerunning
the Wizard.

Next Click Next to specify the service factors.
Finish Click Finish to generate the Seismic combinations.
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Using the Eurocode EN1998-1:2004 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

• Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the EN 1998-1 Horizontal
Design Spectrum (page 613).

Site
Specific
Spectra

This option is appropriate for locations which use
another country's loading and design codes where the
code spectrum is not relevant.

For this option you create a user defined spectrum by
specifying the required curve parameters and slope
options.

See: Code spectra and site specific spectra (page 609).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

The Seismic Design Category (SDC) is determined on this page.

NOTE In ASCE7-10 (not ASCE7-05) there is an additional value of Cs calculated for a
building < 5 stories and where T <0.5s. In this instance Ss is taken as 1.5 and
the additional value of Cs should be used to give a final value of Cs. This clause
has not been implemented in Tekla Structural Designer.

Property Description
Structure details
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Property Description
Height to
the
highest
level

This field defaults to the structure height (calculated
from the base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the
seismic inertia combination is determined.

Number
of storeys

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field
above.

Ground acceleration
Region Only applies for the Malaysia NA:

• Peninsular Malaysia,

• Sarawak,

• Sabah
Referenc
e Peak
Ground
Acc, agR

Refer to PD6698:2009

Design
Ground
Acc, ag

agR x γI.

Importance & Ground
Importan
ce class

For Base Eurocode and UK NA: I- IV as defined in BS EN
1998-1:2004 - Table 4.3.

For Singapore NA: Ordinary or Special
Ground
type

For Base Eurocode and UK NA: A-E

For Malaysia NA: Rock, Stiff Soil, Flexible Soil

For Singapore NA: C, D, S1

(A - Rock, B - Very dense soil/gravel/clay, C - Deposits of
dense/medium dense soil, D - Loose to medium soil, E
- Surface alluvium. Ref BS EN 1998-1:2004 - Table 3.1.)

Importan
ce Factor,
γI

This is automatically derived from the occupancy class.
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Property Description
Spectrum
type

For Base Eurocode and UK NA: Spectrum Type - 1 or 2
BS EN 1998-1:2004 - Cl 3.2.2.2.1(P)

For Malaysia NA: Spectrum Type - 1

For Singapore and Norway NA: (No choice)
Lower
bound
factor, β

This is automatically derived.

Upper
limit of
the
period of
the
constant
spectral
accelerati
on
branch,
Tc

This is automatically derived.

Structural
Ductility
Class

Low, Medium or High - for whole building (not
directional)

If ag ≤ 0.78 m/s2 or if ag x S ≤ 0.98 m/s2 - Structure
suitable for Low Seismicity (where S is the soil factor)

If not - Structure suitable for Medium or High
Seismicity

Site
natural
period, TS
(Malaysia
NA only)

This is only required if the ground type is Flexible Soil.

Elastic
response
spectral
displace
ment, SDR
(Malaysia
NA only)

This is only required if the ground type is Flexible Soil.

Next Clicking Next takes you to the Structure regularity
page described below.

NOTE The Norway NA for EC1998 has the following differences:-

Soil factors specific to Norway

- φ factor for Imposed load types A, B and C = 1.0 (not 0.8)
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- γI importance factors specific to Norway- Spectrum specific to Norway (TB,
TC and TD factors)

- q values for Ductility Class Medium use for both Medium and High

Structure regularity page

For Medium and High structural ductility this page is used to indicate any
irregularities in plan or elevation. (For Low structural ductility only the
irregularities in elevation are displayed.)

Property Description
Structur
e Plan
Regularit
y - Cl
4.2.3.2

Check the appropriate boxes to define any plan
irregularities.

Structur
e
Elevation
Regularit
y - Cl
4.2.3.3

Check the appropriate boxes to define any elevation
irregularities.

Analysis
procedur
e to be
used

Having specified any irregularities, you then choose
the analysis procedure.

• Use Equivalent Lateral Force Procedure

• Use Modal Response Spectrum Analysi

NOTE Based on the irregularities you have defined,
one or both of the above methods may be
unavailable.

Any additional information, assumptions or
warnings applicable to the selected a method
are displayed for information.

Next Clicking Next takes you to the Fundamental Period
page described below.

Fundamental Period page

This page is used to determine the fundamental period, TDir 1 and TDir 2

Property Description
Fundamental Period Definition
Use
approx

If RSA was selected on the previous page this option is
dimmed.
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Property Description
fundame
ntal
period TA

User
defined
fundame
ntal
period

If RSA was selected on the previous page this option is
dimmed.

Use
modal
analysis

Modal analysis is run to determine fundamental
periods of the structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Moment resistant space steel frames,
Moment resistant space concrete frames, Eccentrically
braced steel frames, All other structures (ref BS EN
1998-1 Cl 4.3.3.2.2)

Approx
fundame
ntal
period, TA

This is automatically derived.

Fundame
ntal
period,
TDir 1, TDir

2

Depending on your choice of definition this will either
be taken as TA, or it can be a user defined value, or it
will be calculated from the modal analysis.

Next Clicking Next takes you to the Behaviour Factor page
described below.

Behaviour Factor page

For Low Ductility Class, q = 1.5, (but the value can be changed by the user) - all
other fields on the page are dimmed and cannot be changed.

For Medium or High Ductility Classes, this page is used to determine the
Behaviour Factor in direction 1 and 2.

Property Description
Ductility
Class

Medium or High.

Structure
Type

Moment resistant space steel frames, Moment
resistant space concrete frames, Eccentrically braced
steel frames, All other structures

Frame
Type

This options displayed here depend on the structure
type selected above.
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Property Description
αu/ αl This is a user defined multiplication factor - for the

structure
User
defined q

For Medium or High Ductility Classes, select this check
box in order to edit the calculated q value.

Behaviou
r Factor,
q

This is automatically derived, but you are given the
facility to edit the calculated value.

Next Clicking Next takes you to the Seismic Inertia
Combination page described below.

Seismic Inertia Combination page

This page is used to set up the load cases for the Seismic Inertia Combination.

You should include those load cases that you want to contribute to the
effective seismic weight of the structure.

NOTE This “Seismic Inertia Combination” is used to develop the seismic design
loading and is classed as a modal mass combination for the modal analysis. It
is not used in any other analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

If you select the Include localization option, this page is then used to define
appropriate localization parameters for using the ASCE7 code outside of the
US.

Property Description
Seismic & RSA
Scale
Factor
between
elastic
and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the
scale factor, (Eurocode value = 1/q ).

Design
Static
Base
Shear, V
(Dir1 and
Dir2)

This field allows you to override the code value for the
static base shear, (Eurocode value FB = Sd (Tl) x m x λ).
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Property Description
%
eccentrici
ty for
accidenta
l torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity
for accidental torsion, (Eurocode value = 5%).

NOTE The same value is applied to all floors in the
structure.

Vertical
seismic
load
effect
combinati
on factor

This field allows you to override the combination
factor for vertical seismic loading (usually a small
additional factor for the dead loads in the
combination),( (Eurocode - No vertical loads
considered - factor = 0.0).

RSA only (only available if RSA has been selected)
% Mass
participat
ion for
RSA

This field allows you to set your own required % mass
participation, (Eurocode value = 90%).

NOTE This overrides the setting in Analysis
Options/1st order seismic when running the
Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value
is 99%.

NOTE This setting can benefit some users wanting
nearer 100% to be conservative.

Scaling of
forces (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors, (Eurocode - No base shear adjustment).

Scaling of
Deflectio
ns for
Drift
Checks (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors, (Eurocode - No adjustment).

NOTE A zero factor means no scaling will be
performed on deflections.

Apply loading 601 Apply wind, snow, and seismic loads



Property Description
Finish Click Finish to automatically generate the Seismic

loadcases (page 621) and open the EC8 Seismic
Combination Generator described below.

EC8 Seismic Combination Generator

The Combination Generator uses the two “core” combinations from EC8 that
include seismic loads as below:

Equation 6.12a

Gkj + AEd + ψ2,i x Qk,i

Equation 6.12b

Gkj + AEd

Provided the generate option is selected these will then be used, with factors
as specified, to generate an appropriate number of combinations to cover for
direction +/- Dir1 and Dir2 with +/- eccentricities.

Property Description
Initial Parameters page
Delete /
Replace
combinati
ons

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of

different scenarios, ensure you type in (or choose from
the droplist if appropriate) a scenario name. This
scenario name is then added as a prefix to all the
combinations generated in the this run of the
generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page
described below.

Combinations page
Generate Select the seismic combinations to be generated with

factors as specified.
Keep
existing
Seismic
Combinat
ions

If you want to retain previously set up Seismic
Combinations you can select this check box to do so.

NOTE Warning - some factors may no longer be
correct for these combinations after rerunning
the Wizard.

Next Click Next to specify the service combinations.
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Property Description
Finish Click Finish to generate the Seismic combinations.

Using the IS1893 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure in accordance with the Indian IS1893 code.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

1. Click Home > Model Settings > Design Codes

a. Set the Design Code for Seismic Loading to IS1893 (Part 1) and select
the year required

b. Click OK

2. Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the IS893 (Part 1) Horizontal
Design Spectrum.

Site
Specific
Spectra

This option is appropriate for locations which use
another country's loading and design codes where the
code spectrum is not relevant.

For this option you create a user defined spectrum by
specifying the required curve parameters and slope
options.

See: Code spectra and site specific spectra (page 609).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.
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Basic information page

The SZone Factor is determined on this page.

Property Description
Structure details
Height to
the
highest
level

This field defaults to the structure height (calculated
from the base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the
seismic weight combination is determined.

Number
of storeys

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field
above.

Zone & Site
Seismic
Zone

This field allows you to set the appropriate zone, II-V.

Site class This field allows you to set the appropriate soil
conditions, I-III.

Importan
ce Factor,
I

This is automatically derived from the occupancy class.

Next Clicking Next takes you to the Structure
Irregularities page described below.

Structure Irregularities page

This page is used to indicate any irregularities in plan or vertically.

Property Description
Structur
e Plan
Irregular
ities

Check the appropriate boxes to define any plan
irregularities.

Structur
e
Vertical
Irregular
ities

Check the appropriate boxes to define any vertical
irregularities.

Analysis
procedur
e to be
used

Having specified any irregularities, you then choose
the analysis procedure.

• Use Equivalent Lateral Force Procedure
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Property Description
• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined,
one or both of the above methods may be
unavailable.

Any additional information, assumptions or
warnings applicable to the selected a method
are displayed for information.

Next Clicking Next takes you to the Fundamental Period
page described below.

Fundamental Period page

This page is used to determine the fundamental period, TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
Use
approx
fundame
ntal
period Ta

This is automatically derived.

If RSA was selected on the previous page this option is
dimmed.

User
defined
fundame
ntal
period

If RSA was selected on the previous page this option is
dimmed.

Use
modal
analysis

Modal analysis is run to determine fundamental
periods of the structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select the structural type.

Approx
fundame
ntal
period, Ta

This is automatically derived.

Fundame
ntal
period,
TDir 1, TDir

2

Depending on your choice of definition this will either
be taken as Ta, or it can be a user defined value, or it
will be calculated from the modal analysis.
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Property Description
Next Clicking Next takes you to the Seismic Force

Resisting System page described below.

Seismic Force Resisting System page

This page is used to determine the response modification coefficient, R, and
other factors in the directions 1 and 2.

Property Description
Seismic force resisting system Dir 1 and Dir 2
Type This field allows you to set the appropriate type.
System This field allows you to set the appropriate system for

the chosen type.
Coefficients & Factors Dir 1 and Dir 2
Response
modificati
on
coefficien
t, R

This is automatically derived, but you are given the
facility to edit the calculated value.

Next Clicking Next takes you to the Effective Seismic
Weight page described below.

Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those load cases that you want to contribute to the
Structure Seismic Dead Weight.

NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

If you select the Include localization option, this page is then used to define
appropriate localization parameters.

Property Description
ELF & RSA
Scale
Factor
between
elastic
and

This field allows you to override the code value for the
scale factor.
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Property Description
design
spectra
(Dir1 and
Dir2)
User
Defined
Static
Base
Shear
(Dir1 and
Dir2)

This field allows you to override the code value for the
static base shear.

%
eccentrici
ty for
accidenta
l torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity
for accidental torsion).

NOTE The same value is applied to all floors in the
structure.

Vertical
seismic
load
effect
combinati
on factor

This field allows you to override the combination
factor for vertical seismic loading (usually a small
additional factor for the dead loads in the
combination).

RSA only (only available if RSA has been selected)
% Mass
participat
ion for
RSA

This field allows you to set your own required % mass
participation.

NOTE This overrides the setting in Analysis
Options/1st order seismic when running the
Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value
is 99%.

NOTE This setting can benefit some users wanting
nearer 100% to be conservative.

Scaling of
forces (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors
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Property Description
Scaling of
Deflectio
ns for
Drift
Checks (%
of Base
Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling
factors.

NOTE A zero factor means no scaling will be
performed on deflections.

Finish Click Finish to automatically generate the Seismic
loadcases (page 621) and open the Seismic
Combination Generator described below.

Seismic Combination Generator

The Combination Generator sets up seismic combinations from the "core"
combinations that include seismic loads.

Property Description
Initial Parameters page
Delete /
Replace
combinati
ons

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of

different scenarios, ensure you type in (or choose from
the droplist if appropriate) a scenario name. This
scenario name is then added as a prefix to all the
combinations generated in the this run of the
generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page
described below.

Combinations page
Generate Select the seismic combinations to be generated with

factors as specified.
Keep
existing
Seismic
Combinat
ions

If you want to retain previously set up Seismic
Combinations you can select this check box to do so.

NOTE Warning - some factors may no longer be
correct for these combinations after rerunning
the Wizard.

Next Click Next to specify the service factors.
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Property Description
Finish Click Finish to generate the Seismic combinations.

Code spectra and site specific spectra

Code Spectra

Different analysis procedures are provided for determining the elastic design
response spectrum, the first of which is simply to adopt the code spectra.

• Default spectra (page 609)

Site Specific Spectra (user defined)

In addition to the code spectra, Tekla Structural Designer also allows you to
define your own site specific spectra by specifying significant periods and
acceleration. This procedure is applicable to both ELF and RSA analysis.

The curve equations used for the different head codes are as follows:

• ASCE Horizontal Design Spectrum (page 611)

• EN 1998-1 Horizontal Design Spectrum (Europe, UK, Singapore NA)
(page 613)

• EN 1998-1 Horizontal Design Spectrum (Malaysia NA) (page 615)

• IS893 (Part 1) Horizontal Design Spectrum (page 617)

• ASCE7/UBC Horizontal Design Spectrum - Taiwan (page 619)

This procedure can be used for locations which use another country's loading
and design codes where the code spectra are not relevant and so the local site
spectra need to be defined.

Site Specific Spectra (user defined - generic curve)

A third route is to set a site specific generic curve, either manually, or by
pasting data from a spreadsheet. This procedure requires an RSA to be run
(not ELF). This has been added primarily for remote markets using the US
codes It is available for the US Headcode with loading codes:

• ASCE7-05

• ASCE7-10

• ASCE7-16

It is not available for UBC, EC or IS codes as these codes do not define the
process to be used with a generic spectrum.

User defined RSA curve

Default spectra
The following details the initial values of the parameters for spectra for each of
the seismic head codes:
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ASCE - Horizontal Design Spectrum

Limits Equation Segment Ref
0 ≤ T ≤ T0 SDS x (0.4 + 0.6 x T / T0 ) x (1/(R/Ie) Start point/

linear
11.4.5 (1)

T0 ≤ T ≤ Ts SDS x (0.4 + 0.6 x T / T0 ) x (1/(R/Ie) Constant 11.4.5 (2)

Ts ≤ T ≤ TL (SD1/T)/(R/I) Constant/T 11.4.5 (3)

TL ≤ T ≤ 4s (SD1 x TL / T2)/(R/I) Constant/T2 11.4.5 (4)

UBC - Horizontal Design Spectrum

Limits Equation Segment
0 ≤ T ≤ T0 Ca + 1.5 x T / T0 x (2.5 / R-1) Start point/linear

T0 ≤ T ≤ Ts 2.5 x Ca /R Constant

Ts ≤ T Cv / T/R Constant/T

EC - Horizontal Design Spectrum (UK, Singapore and Europe)

Limits Equation Segment Ref
0 ≤ T ≤ TB ag x S x [ 2/3 + T/TB x ( 2.5 / q - 2/3 )] Start point/

linear
3.13

TB ≤ T ≤ TC ag x S x 2.5 / q Constant 3.14

TC ≤ T ≤ TD ag x S x TC/T x 2.5 / q Constant/T 3.15

TD ≤ T ≤ 4s ag x S x 2.5 / q x (TC x TD) / T2 Constant/T2 3.16

EC - Horizontal Design Spectrum (Malaysia)

For Rock soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR(1.25) / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.25) / (T x TD)) / q Constant/T

TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.25) + γl x mr x (T -
TD))] / q

Constant/T2

For Stiff soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR(1.25) x 1.5 / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.25) x 1.5 / (T x TD)) / q Constant/T
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Limits Equation Segment
TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.25) x 1.5 + γl x mr x

(T - TD))] / q
Constant/T2

For Flexible soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR (1.5TS) x 3.6 / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.5TS) x 3.6 / (T x TD)) / q Constant/T

TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.5TS) x 3.6 + γl x mr
x (T - TD))] / q

Constant/T2

IS - Horizontal Design Spectrum

For rocky, or hard soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.40

(2.50) Constant/T

0.40 ≤ T ≤
4.00

(1.00/T) Constant/T2

For medium soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.55

(2.50) Constant/T

0.55 ≤ T ≤
4.00

(1.36/T) Constant/T2

For soft soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.67

(2.50) Constant/T

0.67 ≤ T ≤
4.00

(1.67/T) Constant/T2

Apply loading 611 Apply wind, snow, and seismic loads



ASCE Horizontal Design Spectrum

NOTE ASCE7 has either sloped second segment or horizontal 4th segment - not
both.

Parameters

• SDuser(0) – units g

• SDuser(T0user) – units g

• T0user – units sec

• TSuser – units sec

• TLuser – units sec

• T4user – units sec, default = 4s

Input limits

• SDuser(0) > 0

• SDuser(T0user) > 0 if T0user > 0

• 0s ≤ T0user < TSuser < TLuser ≤ T4user

Curve Equations

Design Response Spectrum curves for Sa(g) are defined by

NOTE same curve for both Dir1 and Dir2
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Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T0user Sa(g)(T) = SDuser(0) + ((SDuser(T0user) –
SDuser(0)) x T / T0user)

(2) – straight
line

T0user ≤ T ≤ TSuser Sa(g)(T) = SDuser(T0user)

(3) – curve TSuser ≤ T ≤ TLuser Sa(g)(T) = SDuser(T0user) x TSuser/ T

(4) – curve TLuser ≤ T ≤ T4user Sa(g)(T) = SDuser (T0user) x TSuser x TLuser/ T2

(5) – straight
line
continued
from (4)

  

Adjusted Design Response Spectrum curves for Sa(g)/(R/Ie) are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T0user SD(T) = [SDuser(0) + ((SDuser(T0user) - SDuser(0))
x T / T0user)] /(R/Ie)

(2) – straight
line

T0user ≤ T ≤ TSuser SD(T) = SDuser(T0user) / (R/Ie)

(3) – curve TSuser ≤ T ≤ TLuser SD(T) = SDuser(T0user) x TSuser / T / (R/Ie)

(4) – curve TLuser ≤ T ≤ T4user SD(T) = SDuser(T0user) x TSuser x TLuser / T2 /
(R/Ie)

(5) – straight
line
continued
from (4)

  

NOTE If T0user = 0, then no line (1) exists

If TLuser = T4user then no line (4) exists
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EN 1998-1 Horizontal Design Spectrum (Europe, UK, Singapore NA)

Parameters

• Suser(0) – units g

• Suser(TBuser) – units g

• TBuser – units sec

• TCuser – units sec

• TDuser – units sec

• TEuser – units sec, default = 4s

Input limits

• Suser(0) > 0

• Suser(TBuser) > 0

• 0s ≤ TBuser < TCuser < TDuser ≤ TEuser

Curve Equations

Elastic Response Spectrum curves for Se/agare defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Se/ag(T) = Suser(0) + ((Suser(TBuser) x η –
Suser(0)) x T / TBuser)

(2) – straight
line

TBuser ≤ T ≤ TCuser Se/ag(T) = Suser(TBuser) x η
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Line Limits Equation
(3) – curve TCuser ≤ T ≤ TDuser Se/ag(T) = Suser(TBuser) x η x TCuser/ T

(4) – curve TDuser ≤ T ≤ TEuser Se/ag(T) = Suser (TBuser) x η x TCuser x TDuser/
T2

(5) – straight
line
continued
from (4)

  

Design Spectrum for Elastic Analysis curves for Se/ag are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Sd/ag(T) = [ 2/3 x Suser(0) + ((Suser(TBuser) / q –
2/3 x Suser(0)) x T / TBuser)]

(2) – straight
line

TBuser ≤ T ≤ TCuser Sd/ag(T) = Suser(TBuser) / q

(3) – curve TCuser ≤ T ≤ TDuser Sd/ag(T) = Suser(TBuser) x TCuser/ T / q

(4) – curve TDuser ≤ T ≤ TEuser Sd/ag(T) = Suser (TBuser) x TCuser x TDuser/ T2/ q

(5) – straight
line
continued
from (4)

  

NOTE If TBuser = 0, then no line (1) exists

If TDuser = TEuser then no line (4) exists
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EN 1998-1 Horizontal Design Spectrum (Malaysia NA)

Parameters

• SDRuser(0) – units g

• SDRuser(TBuser) – units g

• TBuser – units sec

• TCuser – units sec

• TDuser – units sec

• TEuser – units sec, default = 4s

Input limits

• SDRuser(0) > 0

• SDRuser(TBuser) > 0

• 0s ≤ TBuser < TCuser < TDuser ≤ TEuser

Curve Equations

Elastic Response Spectrum curves for Se/agare defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Se/ag(T) =SDRuser(0) + ((SDRuser(TBuser) -
SDRuser(0)) x T / TBuser)
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Line Limits Equation
(2) – straight
line

TBuser ≤ T ≤ TCuser Se/ag(T) = SDRuser(TBuser)

(3) – curve TCuser ≤ T ≤ TDuser Se/ag(T) = SDRuser(TBuser) x TCuser / T

(4) – curve TDuser ≤ T ≤ TEuser Se/ag(T) = SDRuser(TBuser) x TCuser x TDuser / T2

(5) – straight
line
continued
from (4)

  

Design Spectrum for Elastic Analysis curves for Sd/ag are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Sd/ag(T) = [SDRuser(0) + ((SDRuser(TBuser) -
SDRuser(0)) x T / TBuser)] / q

(2) – straight
line

TBuser ≤ T ≤ TCuser Sd/ag(T) = SDRuser(TBuser) / q

(3) – curve TCuser ≤ T ≤ TDuser Sd/ag(T) = SDRuser(TBuser) x TCuser / T / q

(4) – curve TDuser ≤ T ≤ TEuser Sd/ag(T) = SDRuser(TBuser) x TCuser x TDuser /
T2 / q

(5) – straight
line
continued
from (4)

  

NOTE If TBuser = 0, then no line (1) exists(as in the example above)

If TDuser = TEuser then no line (4) exists

NOTE The above by default does not quite equate to Line (4) in the Malaysian NA
because there is an extra term (2 x π)2 / T2 x γl x mr x (T - TD) that tweaks the
1/T2 curve slightly. In Sarawak, this term is non-existent, in Peninsular
Malaysia it does not exist for Flexible soils. In the Tekla Structural Designer
User defined spectrum it is also non-existent.
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IS893 (Part 1) Horizontal Design Spectrum

NOTE In this example T3user = T4user so there is no line (4)

Parameters

• Damping factoruser

• Sauser/g(0) – units g

• Sauser/g(T1user) – units g

• T1user – units sec

• T2user – units sec

• T3user – units sec, default = 4s

• T4user – units sec, default = 4s

Input limits

• Sauser/g(0) > 0

• Sauser/g(T1user) > 0

• 0s ≤ T1user < T2user < T3user ≤ T4user

Curve Equations

Average Response Spectrum curves for Sa/g are defined by

NOTE same curve for both Dir1 and Dir2
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Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T1user Sa(g)(T) = Damping factoruser x [Sauser/g(0) +
((Sauser/g(T1user) – Sauser/g(0)) x T / T1user)]

(2) – straight
line

T1user ≤ T ≤ T2user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user)

(3) – curve T2user ≤ T ≤ T3user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user/ T

(4) – curve T3user ≤ T ≤ T4user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user x T3user/ T2

(5) – straight
line
continued
from (4)

  

Design Response Spectrum curves for Ah(g) (=Sa/g/((2xR)/(ZxI))) are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T1user Ah(g)(T) = Damping factoruser x [Sauser/g(0) +
((Sauser/g(T0) – Sauser/g(0)) x T / T1user)]

But not less than Z/2
(2) – straight
line

T1user ≤ T ≤ T2user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) / ((2xR)/(ZxI))

(3) – curve T2user ≤ T ≤ T3user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user/ T / ((2xR)/(ZxI))

(4) – curve T3user ≤ T ≤ T4user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user x T3user/ T2 / ((2xR)/(ZxI))

(5) – straight
line
continued
from (4)

  

NOTE If T1user = 0, then no line (1) exists

If T3user = T4user then no line (4) exists
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ASCE7/UBC Horizontal Design Spectrum - Taiwan

Taiwan code Figure 2

Specifically, the last section of curve (Segment 4) extends horizontally from
2.5T0 with a value of 0.4 x SDS

NOTE The above curve can be obtained by selecting Horizontal 4th Segment on the
Site Specific Spectra page of the Seismic Wizard.

ASCE7/UBC Horizontal Design Spectrum - Thailand

When Sd1 > Sds

Thailand code Figure 1-4-3
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Specifically, the previously flat section of curve (Segment 2) rises from SDS at T
= 0.2 to SD1 At T = 1.0

NOTE The above curve can be obtained by selecting Sloped 2nd Segment on the Site
Specific Spectra page of the Seismic Wizard.

Seismic loadcases

Once the Seismic Wizard has been run the loadcases required to be applied to
the structure can be generated.

Equivalent Lateral Force (ELF) Loadcases

If an Equivalent Lateral Force (ELF) analysis procedure was selected in the
Wizard, the load is applied to the structure at each level as determined for the
relevant direction - loadcases being created as follows:

For structures with no torsion

• Seismic Dir1 - loadcase type Seismic

• Seismic Dir2 - loadcase type Seismic

For all other structures:

• Seismic Dir1 - loadcase type Seismic

• Seismic Dir2 - loadcase type Seismic

• Seismic Torsion - loadcase type Seismic

NOTE + and - factors are applied in the combinations to achieve the possible options
- +Dir, -Dir, +torsion and -torsion.
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Response Spectrum Analysis (RSA) Loadcases

If a response spectrum analysis procedure was selected in the Wizard, the
loadcases are created as follows:

For structures with no torsion

• Seismic Dir1 - loadcase type Seismic RSA

• Seismic Dir2 - loadcase type Seismic RSA

For all other structures:

• Seismic Dir1 - loadcase type Seismic RSA

• Seismic Dir2 - loadcase type Seismic RSA

• Seismic Torsion - loadcase type Seismic RSA

NOTE Enveloping is used in the combinations to achieve the possible options - +Dir,
-Dir, +torsion and -torsion.
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6 Analyze models

With Tekla Structural Designer you can perform an extensive range of
different analyses.

• Get started with analysis (page 623)

• To run a specific analysis for selected loadcases/combinations, or to run all
the analyses necessary for design, see Run analyses (page 664)

• To review the results once the analyses have completed, see Display
analysis results (page 671)

• To review the solver model used for a particular analysis type, see View and
manage solver models (page 724)

See also

Static analysis and design handbook (page 1159)

Seismic analysis and design handbook (page 1186)

6.1 Get started with analysis
This section explains some basic concepts and procedures you need to know
to get started with analysis in Tekla Structural Designer.

Click the links below to find out more:

• Analysis types in

• Adjust and apply analysis settings (page 633)

• What is a solver model (page 633)

• FE meshing, sub models and diaphragms (page 636)
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Analysis types in Tekla Structural Designer
The following analysis types can be run in Tekla Structural Designer.

1st order linear
1st order linear static analysis is suitable for structures where secondary
effects are negligible. Any nonlinear springs or nonlinear elements present are
constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: No

Related task: Run 1st order linear analysis (page 664)

1st order non-linear
This is a nonlinear analysis with loading applied in a single step.

It is suitable for structures where secondary effects are negligible and
nonlinear springs/elements are present.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: Yes

Related task: Run a 1st order non-linear analysis (page 665)

1st order modal
This is an unstressed modal analysis which can be used to determine the
structure's natural frequencies.

The structure is assumed to be in an unstressed state and nonlinear elements
are constrained to act linearly.

Nonlinearity Included:

• Geometric: No

• Material: No

Related task: Run a 1st order modal analysis (page 665)
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2nd order linear
This is a 2-stage P-Delta analysis which is suitable for structures where
secondary effects are of comparable magnitude to primary effects. Any
nonlinear springs or nonlinear elements present are constrained to act
linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

Related task: Run a 2nd order linear analysis (page 666)

2nd order non-linear
This is a nonlinear analysis with loading applied in a single step.

It is suitable for structures where secondary effects are of comparable
magnitude to primary effects and nonlinear springs/elements are present.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: Yes

Related task: Run a 2nd order non-linear analysis (page 666)

2nd order buckling
This is a linear buckling analysis which can be used to determine a structure's
susceptibility to buckling.

The stressed state of the structure is determined from linear analysis;
therefore nonlinear elements are constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

Related task: Run a 2nd order buckling analysis (page 666)
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FE chasedown
This analysis type cannot be run in isolation, it is only performed when it is
required as part of another process, such as Analyze All (Static), or Design
All.

Separate analyses are performed for a series of 3D sub models each
containing the members between two horizontal planes with fully meshed
floors. The complete series of models is chased down from top to bottom so
loads are carried from the level above to the level below. The results are
always used for slab design and optionally used for beam, column and wall
design.

Grillage chasedown
This analysis type cannot be run in isolation, it is only performed when it is
required as part of another process, such as Analyze All (Static), or Design
All.

Separate analyses are performed for a series of 3D sub models each
containing the members between two horizontal planes, floors only being
meshed at those levels where they have also been meshed in 3D Analysis. The
complete series of models is chased down from top to bottom so loads are
carried from the level above to the level below.

Analyze All (Static)
This is a full series of analyses that would be carried out as part of Design All
(Static) but with no design. All the analyses required to enable a design to be
performed are included:

• 3D analysis

• 1st order linear/non-linear

• 2nd order linear/non-linear (only if this has been specified by the user
in Design > Design Settings > Analysis)

• FE chasedown analysis (if required)

• Grillage chasedown analysis (if required)

Related task: Run Analyze All (Static) (page 669)

3D only (Static)
This is a similar to Analyze All (Static) but excludes chasedowns to save time
during scheme design, (for example while addressing overall stability, sway,
drift, wind drift, etc.)

Analyses performed:

• 3D analysis

• 1st order linear/non-linear
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• 2nd order linear/non-linear (only if this has been specified by the user
in Design > Design Settings > Analysis)

Related task: Run 3D only (Static) (page 669)

1st order RSA seismic
This is a Modal Response Spectrum Analysis used to determine the peak
response of the structure to earthquakes. Any nonlinear springs or nonlinear
elements present are constrained to act linearly. For RSA Seismic
Combinations, the peak responses are enveloped around the static results for
1st Order Linear Analysis

Related task: Run a 1st order RSA seismic analysis (page 667)

2nd order RSA seismic
This is a Modal Response Spectrum Analysis used to determine the peak
response of the structure to earthquakes. Any nonlinear springs or nonlinear
elements present are constrained to act linearly. For RSA Seismic
Combinations, the peak responses are enveloped around the static results for
2nd Order Linear Analysis

Related task: Run a 2nd order RSA seismic analysis (page 667)

Analysis limitations and assumptions
Certain specific limitations and assumptions relating to the various analysis
types are expanded upon below:

Linear analysis of structures containing material nonlinearity

If a structure containing nonlinear springs or nonlinear elements is subjected
to a linear (i.e. 1st or 2nd order linear, 1st order modal, or 2nd order buckling)
analysis, then the nonlinear springs/elements are constrained to act linearly as
described below:

Nonlinear spring supports

In each direction in which a nonlinear spring has been specified, a single value
of stiffness is applied which is taken as the greater of the specified -ve or +ve
stiffness.

Any specified maximum capacities of the spring are ignored.

Tension only, or compression only elements

If either tension only or compression only element types have been specified,
they are constrained to act as truss element types instead.

Nonlinear axial spring, or nonlinear torsional spring elements

If either of these element types have been specified, they are constrained to
act as linear axial spring, or linear torsional spring element types instead.
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A single value of stiffness is applied which is taken as the greater of the
specified -ve or +ve stiffness.

Any specified maximum capacities of these spring elements are ignored.

Tension only X braces

It is essential that the "X Brace" pattern is used to input cross braces as brace
pairs rather than creating them individually. For linear analysis one of the
braces in a brace pair is automatically inactivated, ensuring that the model's
lateral stiffness, and hence lateral drift, is reasonably correct. If braces are
input individually this will not be the case.

To determine which brace in each pair is inactivated the program pushes the
structure simultaneously in the positive direction 1 and positive direction 2.
The brace that goes into tension retains its full stiffness, while the
compression brace becomes inactive.

If the above process fails to determine which of the pair goes into tension and
which is inactivated then a shear is applied to the structure and the braces are
re-assessed.

Analysis of structures containing geometric nonlinearity

It is assumed that where secondary effects are significant (for example the
structure is close to buckling), the engineer will elect to undertake a 2nd order
analysis. If a 1st order analysis is performed any secondary effects will be
ignored.

Analysis of structures containing curved beams

The member analysis for curved members in the plane of the curve is
approximated by joining the values at the nodes, which are correct. For
detailed analysis of curved members it is your responsibility to ensure
sufficient discretization. More refined models can be achieved, if required, by
decreasing the maximum facet error.

Analysis of compound (plated) steel beams and columns

Compound (plated) sections are 2 chords or more connected by battens,
lattice or welded.

• Static calculations for these section types are the same as for solid
sections. The section characteristics are calculated in the basis of the actual
section.

• The torsional constant of a compound section is calculated as a total of
torsional constants of the chords in a compound section.

• Plane section remain plane.

• The material is homogeneous, isotropic and linearly elastic.

• Saint Venant's principle applies.
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Story shears

The story shears that are output are obtained by resolving the loads at column
nodes horizontally into Direction 1 and Direction 2. Any loads associated with
V & A braces are not included because these occur at mid-beam position and
not at column nodes.

Member Deflections

There is a known issue when calculating member deflection profiles in
combinations which can affect the following analysis types:

• 2nd Order Linear

• 1st Order Nonlinear

• 2nd Order Nonlinear

This occurs when the structures behavior is significantly nonlinear because the
deflection profile is currently based on linear superposition of the load cases
within it. Clearly as structural response becomes more nonlinear the
assumption that deflections can be superposed becomes less valid. This can
cause a deflected profile to be calculated which deviates from the correct
profile. The deviation can become significant if load cases fail to solve, but the
combination succeeds in solving, as components of the deflected shape are
missing entirely. It is suggested that for the three analysis types listed member
deflections in combinations be used with caution and engineering judgment.

It should be noted that this limitation only affects member deflection profiles
between solver nodes. All other results, including member force profiles and
deflection at the solver nodes are correct.

Torsion load analysis - relative angle of twist

Any section that is subject to torsional moment will rotate through an angle, θ.
If the cross-section is non-circular this will also be accompanied by warping.

To be able to determine stresses on members subject to torsional moments it
is necessary to determine θ (and for "Open" sections its derivatives also).

For single span pinned steel beams only: a torsion load analysis is
performed which enables θ (and its derivatives) to be calculated and made
available in the Load Analysis View.

For open sections: a more accurate approach is used to determine θ and its
derivatives. The 'cases' in DG9, SCI P057 & SCI P385 being used which depend
on the end conditions and loading conditions on the beam.

This more accurate analysis is carried out for the following open sections:

i. I Symmetric

ii. I Asymmetric

iii. I Plated (including Westok Plated)

iv. Channel
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v. Westok cellular beyond scope

For all other sections not mentioned above (including compound
sections): a "Standard" analysis is carried out to determine θ only using the
following equation:

1 / GI T * ∫ T(x)

Where:

I T = torsion constant

G = shear modulus of steel

T(x) = function of torsion moment

• 2nd Order Linear

• 1st Order Nonlinear

• 2nd Order Nonlinear

Modal analysis - active mass

Modal analysis - active mass

In a 1st order modal analysis mass is assigned to nodes of the analysis model.
In simple terms (neglecting rotation terms for the consistent mass matrix) half
of each element mass is assigned to each node it is attached to.

Mass that is assigned to a translational support cannot go anywhere - i.e. it is
not "active".

Summed Active Mass

Reported in the Dynamic Masses table, this is the actual total active mass for
each direction, but expressed in terms of force units rather than mass.

Summed Total Translational Mass

Reported in the Dynamic Masses table, this is the total system mass for each
direction, again expressed in terms of force units rather than mass.

Translation %

Reported in the Summed Mass table, this is the proportion of mass that is
active for each direction. For a building this will usually be close to but not
quite 100% as some mass always goes to the supports.

Translation % = (Summed Active Mass / Summed Total Translational Mass) x
100

Participation Translation %

Reported in the Summed Mass table, this is the sum of Mass Participation
(reported in the Modal frequencies table) for all modes for each direction.
Design codes stipulate this should be >= 90% for seismic analysis usually for
two orthogonal lateral directions.
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Modal analysis - modal mass

After running a 1st order modal analysis, modal masses for each mode are
available in the Modal Frequencies tabular display.

Modal Mass

In Tekla Structural Designer the modal mass, Mi is given by the following
matrix equation:

Where { Ψ}i is the unity-scaled mode shape (often termed mode vector) of the
ith mode (i.e. any single mode) and [M] is the mass matrix. The meaning of the
unity-scaled mode shape is that the (numerically) largest modal displacement
is set to unity and all other displacements are scaled accordingly. The term
{Ψ}i is used to differentiate this mode shape from the mass-normalized shape
{Φ}i which is the mode shape actually reported by Tekla Structural Designer .

This equation comes from modal analysis theory. It may also be termed
"generalized mass".

Another way to state this equation, which is found in some design guides, is a
summation equation for point masses and their associated modal
displacements for a system of discretized mass distribution:

We have from CCIP-016:
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where i is each on N points on the structure, having mass mi at which the
mode shape μj,i is the jth mode is known.

According to this reference - "Conceptually, the modal mass can be thought of
as the mass of an equivalent single degree of freedom system... which
represents the jth mode."

It can be seen how this is equivalent to the matrix equation given above.
Actually Tekla Structural Designer makes use of a shortcut calculation since it
already has mode shapes which are normalized to mass.

The mass-normalized mode shape { Φ}i and the unity-normalized mode shape
{ Ψ}i are related as follows:

From this we can state the following, where Φ2 is the largest modal
displacement from the mass-normalized mode shape (which we already have
from the Tekla Structural Designer modal analysis):

Hence:

Unstable Structures

Flat Slab Structures

If a concrete structure exists with only flat slabs and columns (i.e. no beams
and no shear walls), and the slab is modelled with a diaphragm this is an
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unstable structure, assuming that the concrete columns are pinned at the
foundation level (current default).

To prevent the instability you should mesh the slabs, as the resulting model
does then consider the framing action that results from the interaction of the
slabs and columns.

Adjust and apply analysis settings
To adjust the analysis settings of the current project or set them as default
settings for future projects, see the following instructions.

Adjust analysis settings in the current project
1. On the Analyze toolbar, click Settings 

The Model Settings dialog box opens.

2. Review and modify the analysis settings according to your needs.

3. Do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes to the selected settings set, click Save...

• To revert to the analysis settings specified in the selected settings set,
click Load...

Adjust analysis settings in future projects
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to the Analysis Settings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. Review and modify the analysis settings according to your needs.

5. To save the settings as defaults for future projects that use the selected
settings set, click OK.

See also

Analysis Settings (page 2278)
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What is a solver model
When you use Tekla Structural Designer to model, analyze, and design
structures, you will become familiar with the following concepts:

A structural model is a 3D model that includes the physical members/objects
you create using Tekla Structural Designer, and information related to them.
Each member/object in the physical model will exist in the completed
structure.

The structural model also contains information about the loadcases and
combinations that act on the physical members/objects.

Analyze models 634 Get started with analysis



A solver model is a 3D model that is created from the structural model. It is
used for analyzing structural behavior, and for design.
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When you create a solver model, Tekla Structural Designer generates the
following analysis objects and includes them in the solver model:

• Solver nodes

• Support conditions for nodes

• 1D solver elements

• 2D solver elements

FE meshing, sub models and diaphragms
Click the links below to find out more about FE meshing, sub models and
diaphragms.

To Click the link below:
Choose whether to mesh slabs for 3D
analysis; specify slab mesh

Manage FE meshed slabs (page 637)

Specify wall mesh Manage FE meshed walls (page 653)
Manage the sub models used in
chasedown analyses

Manage sub models (page 661)
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To Click the link below:
Activate and manage rigid and/or
semi-rigid diaphragms

Diaphragm action in roof panels and
slabs (page 655)

Manage FE meshed slabs
At the levels where two-way spanning slabs exist, Tekla Structural Designer
applies FE meshing as follows:

• Two-way spanning slabs are always meshed in the FE chasedown analysis
that occurs as part of the static design process.

• Two-way slabs are by default not meshed for 3D building analysis or
grillage chasedown analysis. This ensures the quickest solution time. A 3D
pre-analysis process (in which the slabs are meshed) is used to decompose
loads from the slabs on to supporting members.

• Alternatively, you can choose to mesh two-way slabs for 3D building
analysis and grillage chasedown analysis, either at all, or selected
construction levels. In this case Tekla Structural Designer does not perform
the load decomposition during 3D pre-analysis for the two-way slabs at
those levels.

In all of the above mentioned situations, the slab mesh density is set globally,
but can be overridden at individual levels if required.

Click the links below to find out more:

• Define whether slabs are meshed for 3D building analysis and grillage
chasedown analysis (page 637)

• Adjust global slab mesh properties (page 638)

• Apply different mesh properties at different levels (page 639)

• Review the slab mesh before the analysis (page 639)

• How slab properties and features impact on meshing (page 640)

• Slab meshing controls (page 644)

Define whether slabs are meshed for 3D building analysis and grillage
chasedown analysis

To ensure the quickest solution time, two-way slabs are by default not
meshed for 3D building analysis or grillage chasedown analysis. In this case,
the diaphragm option (none, semi-rigid, or rigid) in the slab properties
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determines their axial rigidity and a 3D pre-analysis process is used to FE
decompose loads from the slabs on to supporting members.

If you prefer, you can instead choose to mesh the slabs, either at all, or
selected construction levels.

NOTE Two-way spanning slabs are always meshed in the FE chasedown
analysis that occurs as part of the static design process.

Use meshed two-way slabs in at all construction levels

1. Go to the Project Workspace.

2. In the Structure tree, select Levels.

3. In the Properties window, select the Mesh 2-way Slabs in 3D Analysis
option.

Use FE decomposed slab loads at all construction levels

1. Go to the Project Workspace.

2. In the Structure tree, select Levels.

3. In the Properties window, clear the Mesh 2-way Slabs in 3D Analysis
option.

Use meshed two-way slabs at selected construction levels

1. In the Structure tree, expand the Levels branch.

2. Click one of the desired construction levels.

3. According to your needs, either select or clear the Mesh 2-way Slabs in
3D Analysis option.

4. Repeat step 3 for all the desired construction levels.

Adjust global slab mesh properties
Initially, the same mesh properties are applied globally to all meshed slabs. In
order to adjust the global slab mesh properties, see the following instructions.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.

4. Accept or adjust the Slab Mesh Size.
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5. Accept or adjust the Slab Uniformity Factor. At 100% uniformity all slabs
in the mesh will be of approximately equal area.

6. Accept or adjust the Slab Mesh Type:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.

See also

Apply different mesh properties at different levels (page 639)

Apply different mesh properties at different levels
If you need to apply different mesh parameters at a specific level, you can do
so by creating sub models. For more information, see the following
instructions.

1. Create a sub model. (page 662)

2. In the Structure tree, expand the Sub Models branch.

3. Select the sub model that you created.

4. In the Properties window, select the Override model's option.

5. Adjust the mesh size and uniformity factor according to your needs.

Review the slab mesh before the analysis
In order to review the existing slab mesh in your model before running a
particular analysis, see the following instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

The solver view opens.

2. Right-click anywhere in the solver view.

3. In the context menu, go to Solver models.

4. In the list, select the solver model appropriate to the analysis that you
want to run. 

If the slab mesh is applicable to the selected solver model, it is displayed.

NOTE The slab mesh is not displayed in the working solver model. This
is because the working solver model displays the model in its
form before any analysis, and 2D elements are only formed
during the analysis.
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See also

View and manage solver models (page 724)

How slab properties and features impact on meshing

The slab mesh is always created in a single plane, but the resulting mesh is can
be affected by the slab properties and features as described below.

Slab thickness, vertical offsets, column drops and openings

The mesh of shell 2D solver elements is always created in the same plane,
irrespective of whether slabs have different thicknesses, slabs items have
been raised/lowered via vertical offsets, or column drops have been applied.
Shells are not created inside slab openings and any loads placed within
openings are not applied to the model.

Consider the example shown below. This features curved slab boundaries,
circular and rectangular openings, thickened slab panels, lowered slab panels
and a slab overhang. A column drop panel has also been inserted at one of the
locations where the slab is supported by a column.

In the resulting FE solver model, since vertical offsets are not structurally
significant the analysis mesh is formed at the same level relative to the top of
the slab. The mesh properties do however reflect the change to the slab
thicknesses in the different slab areas.
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NOTE Beam solver elements and slab meshes can only be offset vertically from one
another by being defined in different construction levels.

Other slab properties

Rotation Angle

Different slab items in the same slab can have different rotation angles.

This property is used for the following where appropriate:

• Span direction for 1-way load decomposition

• To determine the 2D solver element local axes in the solver model

• Bar direction for Slab on Beam and Flat Slabs.

Include in Diaphragm

This property is only available when the Diaphragm option is Semi-Rigid or
Rigid. Individual slab items in the same slab can be included or excluded as
required.

The effect of excluding a slab item depends on the Diaphragm option as
follows:

• Semi-Rigid - excluded slab items are not meshed with semi-rigid 2D solver
elements

• Rigid - internal nodes not considered in the nodal constraints

NOTE Where 2 items share a boundary and one item is included and one excluded,
then the nodes along the shared boundary are included in the diaphragm.

NOTE When a slab item is excluded from the diaphragm this has no effect on the
mesh of shell 2D solver elements used in some of the solver models for 2-way
spanning slabs.
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Mesh groups

To facilitate meshing, Tekla Structural Designer automatically gathers slab
items and features together into mesh groups, and meshes them as a single
entity. A mesh group contains one or more slab items with identical analysis
attributes. Since slab depth is a key analysis attribute, by definition a slab step,
or a column drop, will produce an additional mesh group.

Example: Mesh groups at a slab step

In the following image, you can see three separate slab items:

1. d = 300 mm

2. d = 100 mm

3. d = 100 mm

Although there are three slab items in the previous image, there are only two
different slab depths. That is why Tekla Structural Designer only creates two
mesh groups, as shown in the following image:

1. mesh group 1

2. mesh group 2
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Discontinuity of force contours at slab steps and column drops

When slab items on either side of a slab step are placed into different mesh
groups, the solver nodes along the boundary are shared by both groups. Each
node on the boundary reports a single value of deflection, but two values of
force, one for each group. That is why there will be a discontinuity of force
contours along the boundary.

See the following examples:

Example: Deflection contours (no discontinuity)

Example: Moment contours, discontinuity along boundary

The force discontinuity is a genuine result. The slab items share the same
curvature at the step and have the same elastic modulus, so the moment must
be directly proportional to the inertia of each slab item.

NOTE Other programs may average the value across the boundary when
generating the contours. However, we prefer the approach of Tekla
Structural Designer because averaging would result in an
unrealistically high design of the thinner slab.
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Mesh group boundary warnings

Meshing may fail or produce undesirable results when there is challenging
mesh group boundary geometry. In this case, Tekla Structural Designer warns
you about the source points source of meshing issues.

Examples of possible warning triggers are:

• short edges

• distance between a hole and an edge

• small area enclosed by a mesh group

Slab meshing controls
Meshing issues tend to be caused when the area being meshed ends up with
really narrow strips of slab, for example when the slab edge ends up just
outside the edge of a column.

On the Meshing page of Analysis options (page 2278) certain meshing
tolerance controls can be adjusted when required to solve these type of issue.

The model shown above has various challenging situations which are
discussed below along with an indication of whether changing the automatic
merging distances in Analysis Options can have an impact:
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1. Column face close to parallel slab edge - (yes)

In this example the slab edge is positioned 50mm outside the column face.
The view above left shows the analysis model you would get when the Column
boundary to slab edge merging distance is < 50mm. The view above right
shows the model you get if the merging distance is set to 50mm or above. The
column corner nodes merge (move to) the slab edge eliminating the narrow
strip.

The simplified analysis model avoids mesh quality warnings and gives almost
identical results in terms of column transfer forces and slab design.

2. Column face close to inclined slab edge - (yes)

In this example the slab edge sits just a few mm outside the column corner.
The view above left shows analysis model where a very poor quality element
runs past the corner, (you would only end up with this model if the Column
boundary to slab edge merging distance were to be set less than the default
5mm. The view above right shows the model you get if the merging distance is
set to the default 5mm or above. One column corner node merges (moves to)
the slab edge eliminating the narrowest part of strip.

The simplified analysis model avoids mesh quality warnings and gives almost
identical results in terms of column transfer forces and slab design.
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3. Column close to multiple non-parallel slab edges - (yes)

This is just another variation on positions 1 and 2. The view above left shows
analysis model you would end up with if the Column boundary to slab edge
merging distance were to be set less than the default 5mm. The view above
right shows the model you get provided the default merging distance (5mm) is
retained - meshing is simplified avoiding mesh quality warnings and gives
almost identical results in terms of column transfer forces and slab design.

4. Opening near slab edge - (yes)

In the following examples merging will make things better, but the reality is
that a slab will never be cast with thin isolated strips at the edge - you cannot
effectively reinforce a 50 to 100mm wide strip of slab. In all these the ideal
solution is that the modelling should reflect the reality of realistic minimum
edge distances.

A hole is defined approximately 20mm from the slab edge. The effect is the
same as at the column cut-out boundary - above on the right shows how with
the Opening to slab edge merge distance set to 50mm the opening corners
move to the slab edge. This creates a better analysis model.
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5. Opening near wall inserted along slab edge - (yes)

This is basically the same as the previous situation except that a wall happens
to be defined along the edge. In such cases the user is often tempted to
extend the opening into the physical width of the wall but does not extend it
right to the wall insertion line.

There are pros and cons to both models. On the left the narrow meshed strip
of slab can give mesh quality warnings and errors. On the right the slab mesh
is better, but the model relies a bit more heavily on the wall beam to transfer
moments. However, the overall minor axis moment transferred to the wall
only drops from 75.7 to 72.5 kNm.
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6. Circular opening near slab edge - (yes)

Above left shows the sort of meshing that will occur when a circular opening is
created near to the slab edge. Above centre shows an example where closest
point on the circle is merged to edge. The meshing looks a bit better but this is
still not a great model because you will get strange local results at the
connecting node. On the right where theOpening to slab edge merge distance
is set to 100mm the edge gets completely broken - this is probably the best
model.

7. Closely spaced openings - (no)

These are all examples where the merging settings have no effect.

In each case the problems can generally be resolved by adjusting the openings
so that they overlap slightly.
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Above - shows meshing when a narrow (unbuildable?) strip of slab is left
between openings.

Below shows the model when the openings are manually adjusted to eliminate
this strip.
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8 and 9. Opening near column - (no)

In both these cases it would again be better to adjust the openings so that
they overlap the column boundaries as suggested below.
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10. Opening near wall with slab on other side - (no, unless certain conditions apply)

In this case the opening is defined with an edge that is approximately 4mm
from the insertion line of the wall. With the Hardpoint to edge distance
tolerance at the default of 5mm this creates a model that is poorly connected
along the edge of the opening. The node highlighted in red is not included in
the slab meshing (because it is just 4mm away from the edge). The 3 slab
nodes highlighted in blue are not directly connected to the wall.

If the hard point distance is reduced to 1mm then the model changes as
shown below, the node marked in red above is now included in the slab mesh
so the adjacent nodes have a better connection to the wall.
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However, the best model would be obtained if the opening edge got exactly
aligned with the wall, this can actually be quite hard to achieve in the manual
positioning of openings. A workaround at present is to force a “slab mesh
boundary” along the line of the wall by making the slab on one side slightly
different to the slab on the other - then the automatic mergings will create a
model as shown below.
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Manage FE meshed walls
By default, concrete walls automatically adopt an FE meshed model when the
structure is analyzed. Meshed walls automatically use the mesh parameters of
the model. However, if necessary, you can override the mesh parameters and
apply a user defined mesh to an individual wall.

NOTE If necessary, you can modify concrete walls so that they use a mid-pier model
instead of an FE meshed model.

Adjust global wall mesh properties
Initially, the same mesh properties are applied globally to all meshed walls. In
order to adjust the global wall mesh properties, see the following instructions.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.
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4. If necessary, in Wall Mesh Type, change the shape of the wall mesh:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.

5. Adjust the horizontal and vertical sizes of the wall mesh according to your
needs.

See also

Apply different mesh properties to an individual wall (page 654)

Apply different mesh properties to individual walls
If you need to apply different wall mesh properties to specific walls, you can
override the model mesh properties, and modify the properties of the
individual wall. For more information, see the following instructions.

1. In the model, select the walls that you want to modify.

2. Go to the Properties window.

3. If necessary, in Wall Mesh Type, change the shape of the wall mesh:

• QuadDominant

• QuadOnly

• Triangular

4. Adjust the horizontal and vertical sizes of the wall mesh according to your
needs.

Review the wall mesh before the analysis
In order to review the existing slab mesh in your model before running a
particular analysis, see the following instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

The solver view opens.

2. Right-click anywhere in the solver view.

3. In the context menu, go to Solver models.

4. In the list, select the solver model appropriate to the analysis that you
want to run. 

If the wall mesh is applicable to the selected solver model, it is displayed.

NOTE The wall mesh is not displayed in the working solver model. This
is because the working solver model displays the model in its

Analyze models 654 Get started with analysis



form before any analysis, and 2D elements are only formed
during the analysis.

Diaphragm action in roof panels and slabs
Roof panels and slabs both have the potential to act as a diaphragms.

Both rigid and semi-rigid diaphragms can be modelled.

• Overview of diaphragm action in roof panels and slabs (page 655)

• Managing diaphragm action in roof panels and slabs (page 658)

Overview of diaphragm action in roof panels and slabs

Roof panels and slabs will both act as a diaphragms provided they have
Include in diaphragm checked in their properties.

While Include in diaphragm is the only property used to determine
diaphragm action in roof panels, for slab items the diaphragm properties are
also determined by the solver model under consideration and the following
properties:

• Diaphragm option slab item property

• Decomposition slab item property

• Mesh 2-way Slabs in 3D analysis level or slope property

How these and other choices affect the diaphragm model are described in the
topics below.

Include in Diaphragm

Roof panels:

The Include in diaphragm choice works as follows:

• On - a diaphragm is created within the roof panel using a mesh of semi-
rigid 2D solver elements

• Off - no diaphragm is created

Slab items:

For slab items the Include in diaphragm choice is only available when the
Diaphragm option is Semi-Rigid or Rigid. Individual slab items can then be
included or excluded as follows:

• On - a diaphragm is created within the slab item which may take the form
of a shell mesh, a semi-rigid mesh, or nodal constraints

• Off - no diaphragm is created
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NOTE Where 2 slab items share a boundary and one item is included and one
excluded, then the nodes along the shared boundary are included in the
diaphragm.

NOTE When a slab item is excluded from the diaphragm this has no effect on the
mesh of shell 2D solver elements used in some of the solver models for 2-way
spanning slabs.

Diaphragm option

The choice of Diaphragm option is set in the slab item properties. The chosen
option is applied to all slab items in the same slab.

The available options are:

• Rigid

• Semi-rigid

• None

How your choice affects the 2D solver element types used depends on the
method of decomposition selected.

NOTE For roof panels there is no choice of diaphragm option - it is always treated as
semi-rigid.

Decomposition

While roof panels are always one-way spanning, for slab panels you can
choose the Decomposition method in the slab item properties. The chosen
option is applied to all slab items in the same slab.

Two options are available: Two-Way Spanning or One-Way Spanning - although
for certain slab types the value is fixed as follows:

• Composite Slab - One-Way only

• Precast Slab - One-Way only

• Slab on Beams - Two-Way or One-Way

• Flat Slab - Two-Way only

• Steel Deck - One-Way or Two-Way

• Timber Deck - One-Way only

One-way spanning slabs are unmeshed unless the Diaphragm option is set to
Semi-rigid, in which case they will be meshed with semi-rigid 2D solver
elements.

NOTE Semi-rigid 1-way spanning slabs cannot be designed.
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Two-way spanning slabs always adopt a mesh of shell 2D solver elements for
the FE chasedown and FE Load Decomposition solver models. However for the
3D Analysis and Grillage chasedown solver models they are:

• unmeshed - if the Diaphragm option is set to None,

• meshed with semi-rigid 2D solver elements - if the Diaphragm option is set
to Semi-rigid, or,

• meshed with shell 2D solver elements - if the Diaphragm option is set to
Rigid.

NOTE Semi-rigid 2-way spanning slabs can be designed, but only using the results
from the FE Chasedown, not the 3D Analysis or Grillage Chasedown.

Mesh 2-way Slabs in 3D Analysis

Two-way spanning slabs are always meshed with shell 2D solver elements in
FE Chasedown and Load decomposition solver models. When the Mesh 2-way
Slabs in 3D Analysis property (specified in the Level, or Slope properties) is
checked the same meshing parameters are then extended to the Grillage
chasedown and 3D Analysis solver models.

Summary of diaphragm constraint and mesh type configurations

The configurations of mesh and nodal constraints applied to each solver
model resulting from the different permutations of the Decomposition,
Diaphragm option, and Mesh 2-way slabs in 3D analysis properties are
recapped in the table below.

Deco
mpos
ition

Diaphra
gm
Option

Mesh 2-way
slabs in 3D
Analysis

FE Load
Decomposition & FE
Chasedown Models

Grillage
Chasedown & 3D
Analysis Models

1-way None Not Applicable No mesh; no nodal
constraints

No mesh; no nodal
constraints

Semi-
Rigid

Not Applicable Semi-Rigid mesh; no
nodal constraints

Semi-Rigid mesh; no
nodal constraints

Rigid Not Applicable No mesh; Nodal
constraints

No mesh; Nodal
constraints

2-way None Yes Shell Mesh; no nodal
constraints

Shell Mesh; no nodal
constraints

No Shell Mesh; no nodal
constraints

No mesh; no nodal
constraints

Semi-
Rigid

Yes Shell mesh; no nodal
constraints

Semi-Rigid mesh; no
nodal constraints

No Shell Mesh; no nodal
constraints

Semi-Rigid mesh; no
nodal constraints
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Rigid Yes Shell Mesh; Nodal
constraints

Shell Mesh; Nodal
constraints

No Shell Mesh; Nodal
constraints

No Mesh; Nodal
constraints

Managing diaphragm action in roof panels and slabs
Tekla Structural Designer forms diaphragms in every slab item of a parent slab
when Diaphragm option is set to Rigid or Semi-rigid.

When a rigid diaphragm is specified, Tekla Structural Designer automatically
applies nodal constraints to the associated slab nodes.

In turn, when a semi-rigid diaphragm is specified, Tekla Structural Designer
creates a mesh of semi-rigid 2D elements within the slab.

Activate rigid diaphragm option within a slab
By default, Tekla Structural Designer automatically creates rigid diaphragm
within slabs. If necessary, you can review and modify the setting for specific
slabs as follows:

1. Go to the Project Workspace.

2. In the Structure tree, expand the Slabs branch.

3. Select the slab that contains the diaphragm.

4. In the Properties window, set Diaphragm option as required. 

NOTE You can set the Diaphragm option as required in both slab item
properties and parent slab properties. Either way, all slab items
within the parent slab adopt the new setting.

Activate semi-rigid diaphragm option within a slab
You can form semi-rigid diaphragms in both one-way and two-way spanning
slabs. In addition, you can review and modify the diaphragm properties by
selecting the slab within which they are located.

1. Go to the Project Workspace.

2. On the Structure tree, expand the Slabs branch.

3. Select the desired slab.

4. In the Properties window, set Diaphragm option to Semi-rigid.

5. If necessary, to adjust the flexibility of the diaphragm, type a value in the
Divide stiffness by option. 
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TIP You can set the Diaphragm option as required in both slab item
properties and parent slab properties. Either way, all slab items
within the parent slab adopt the new setting.

Activate semi-rigid diaphragm option within a roof panel
You can form semi-rigid diaphragms in roof panels as follows:

1. Go to the Project Workspace.

2. On the Structure tree, expand the  Roofs branch.

3. Select the desired roof panel.

4. In the Properties window, select Include in diaphragm. 

NOTE You cannot form a rigid diaphragm within a roof panel.

Adjust semi-rigid diaphragm flexibility

When the Diaphragm option is Semi-Rigid a Divide stiffness by value can be
set in the slab item properties. The same value is applied to all slab items in
the same slab.

The stiffness determined from the material properties and slab thickness is
divided by this value in order to adjust semi-rigid diaphragm flexibility.

Adjust global semi-rigid mesh properties

When a semi-rigid mesh is created the 2D solver element shape (triangular or
quad), the degree of mesh uniformity, and mesh type adopted are obtained
from the Structure Properties. These parameters can be overridden for
individual sub-models by setting different values in the respective Sub Model
Properties.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.

4. Accept or adjust the Semi-Rigid Mesh Size.

5. Accept or adjust the Semi-Rigid Uniformity Factor.

6. Accept or adjust the Semi-Rigid Mesh Type:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.
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NOTE Beam elements are not split by semi-rigid 2D element nodes.

Apply different semi-rigid mesh properties at different levels
If you need to apply different semi-rigid mesh parameters at a specific level,
you can do so by creating sub models.

1. Create a sub model. (page 662)

2. In the Structure tree, expand the Sub Models branch.

3. Select the sub model that you created.

4. In the Properties window, select the Override model's option.

5. Adjust the semi-rigid mesh size, uniformity factor and type according to
your needs.

Identify the nodes constrained by rigid diaphragms
In order to see which nodes are constrained by diaphragms, see the following
instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

A solver view opens. The rigid and semi-rigid diaphragms are represented
as different colored shaded planes.

Nodes that are constrained by a rigid diaphragm:

• Must lie within, or be on the edge of, the shaded rigid diaphragm
plane.

• Must be solid rather than hollow, or excluded.

Therefore, the following nodes are not constrained by a rigid diaphragm:

• Solid nodes that lie outside the shaded rigid diaphragm plane.

• Hollow, or excluded, nodes.

Exclude individual nodes from a rigid diaphragm
If necessary, you can exclude specific nodes from a rigid diaphragm. In order
to do so, see the following instructions.

1. In the status bar at the bottom of the window, click Review View. A
review view opens.

2. On the Review tab, click Diaphragm On/Off. 
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The nodes are displayed as follows:

• Included nodes are only constrained if they lie within or on the edge of
a rigid diaphragm. If they lie outside the rigid diaphragm, they are not
constrained by it.

• Excluded nodes are always unconstrained.

3. Click a node to switch whether it is included in the diaphragm or not.

Exclude slab items from a diaphragm
By default, Tekla Structural Designer forms a rigid diaphragm in all the
individual slab items within a slab. However, you can decide to exclude specific
slab items. In order to do so, see the following instructions.

1. In the structure view, select the slab item that you want to exclude.

2. In the Properties window, clear the Include in diaphragm option. 

TIP You can also exclude individual slab items graphically in the Review

View. On the Review tab, click Diaphragm On/Off and then
click the slab item to include/exclude.

Manage sub models
Tekla Structural Designer initially treats each structure as a single sub model.
In practice, this means that the Tekla Structural Designer applies the same
mesh parameters to all meshed slabs. However, if needed, you can create sub-
models in your model by creating horizontal planes between levels. Each
individual sub model controls the slab mesh parameters at the levels within it.

Tekla Structural Designer creates additional sub models automatically for
every level specified as a Floor in the Construction Levels dialog box when
Tekla Structural Designer performs one of the following:

• Grillage chasedown analysis

• FE chasedown analysis

You can also define sub models manually in the Sub Models dialog box.

Tekla Structural Designer uses the he slab mesh parameters specified for a
sub model in any analysis that requires the slabs to be meshed, such as load
decomposition, building analysis with meshed floors, or FE chasedown
analysis.

In both grillage and FE chasedown, Tekla Structural Designer performs the
analyses one sub model at a time. Tekla Structural Designer first analyzes the
topmost sub model, and then applies its support reactions as loads for the
analysis of the sub model below. The sequence continues until Tekla Structural
Designer has analyzed all sub models down to the foundation level.
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For both grillage and FE chasedown analysis, you can modify the default
support conditions applied to the sub-models, if necessary.

Definitions of sub model characteristics

• Sub model: a part of the 3D model between two horizontal sub model
divide planes.

Each sub model contains all members entirely between the two horizontal
planes. For the columns, wall and braces split by a divide plane, the stacks
and brace length above the top plane are included in the sub model, as are
the stacks and brace length below the lower plane.

• Sub model divide planes: horizontal planes that you can add, delete or
move in the 3D structure. Sub model divide planes are notional and
infinite. Tekla Structural Designer only allows the planes to cut through the
structure where they only split the following members:

• Column stacks

• Wall stacks

• Steel braces

• Sub model supports: the artificial supports that Tekla Structural Designer
defines for the column and wall stack ends and braces that pass through
the divide planes

• Structure supports: the supports that the user has defined in the 3D
structure

• Column and wall stacks: the span length of a column or wall.

• Volume of the sub model: the 3D space that exists between any two
adjacent sub model divide planes.

Basic rules of sub models

When all sub models are considered together, they form the complete
structure. Only column stacks, wall stacks, and braces that are split by sub
model divide planes can be in several sub models.

This means that:

• Each member in the 3D model is in at least one sub model.

• A sub model cannot contain a member that is already in another sub
model, unless that member is a column, wall, or brace divided by a sub
model divide plane.

• A sub model must contain at least one beam member, one truss member,
or one slab item.

Create sub models
Sub models allow you to apply different slab mesh parameters within your
structure. To create sub models, see the following instructions.
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1. In the Structure tree, double-click Sub Models. 

The Sub Models dialog box opens.

2. According to your needs, do one of the following:

To Do this
Automatically create sub models • Click Generate.

Manually create sub models • According to your needs, click Insert Above,
or Insert Below.

3. If necessary, modify the height above the base of each level in the Level
field.

4. Click OK.

See also

Sub Models dialog (page 2438)

Sub Model Properties (page 2072)

Open a 3D view of a sub model
To display a sub model in its own 3D view, see the following instructions.

1. In the Project Workspace, open the Structure tree.

2. Expand the Sub Models branch.

3. Double-click the sub model. 

Tekla Structural Designer opens a 3D view of the selected sub model.

TIP To open a solver view of the sub model, right-click the sub model,
and select Open solver view.

Delete sub models
If necessary, you can delete existing sub models in the Sub Models dialog box.
For detailed information on deleting sub models, see the following
instructions.

1. In the Structure tree, double-click Sub Models. 

The Sub Models dialog box opens.

2. Select the sub model that you want to delete.

3. Click Delete. 

Tekla Structural Designer deletes the sub model, and the floors are
transferred to the sub model immediately above the deleted one.
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6.2 Run analyses
Various analyses can be run from the Analyze toolbar.

Click the links below to find out how to:

• Run a 1st order linear or non-linear analysis (page 664)

• Run a 1st order vibration analysis (page 665)

• Run a 2nd order linear or non-linear analysis (page 666)

• Run a 2nd order buckling analysis (page 666)

• Run a seismic analysis (page 667)

• Run FE chasedown or grillage chasedown analysis (page 668)

• Run Analyze All (Static) (page 669)

• Run 3D only (Static) (page 669)

Once the analysis has completed, the Project Workspace can be used to verify
the results in a couple of ways:

• Check sum of reactions against load input (page 670)

• Check stability and overall displacement (page 671)

Run a 1st order linear or non-linear analysis
To run either a linear or non-linear 1st order analysis on your model, see the
following instructions.

See also

The Results View (page 671)

View tabular results for support reactions (page 765)

View tabular results for nodal deflections (page 765)

View tabular results for solver element end forces (page 766)

Run 1st order linear analysis
1. On the Analyze tab, click 1st Order Linear. 

The Select loading dialog box opens.

2. In the Select loading dialog box, select the combinations and load cases
that you want to analyze.

3. Click OK. 
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Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 1st order non-linear analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 1st Order Non-Linear page.

3. If necessary, adjust the convergence criteria and relaxation factors.

4. Click OK.

5. On the Analyze tab, click 1st Order Non-linear. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and load cases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 1st order modal analysis
In order to run a modal analysis on your model, see the following instructions.

NOTE To run a modal analysis, your model must contain an active modal
mass combination.

For more information, see Create modal mass combinations
(page 521).

1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the page (page 2281).

3. If necessary, adjust the analysis options.

4. On the Analyze tab, click 1st Order Modal. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View opens to allow you to
display the mode shapes graphically. Tabular results can also be viewed in
a Solver Model Data View.
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Run a 2nd order linear or non-linear analysis
In order to run either a linear or a non-linera 2nd order analysis on your
model, see the following instructions.

Run a 2nd order linear analysis
1. On the Analyze tab, click 2nd Order Linear. 

The Select loading dialog box opens.

2. In the Select loading dialog box, select the combinations and load cases
that you want to analyze.

3. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order non-linear analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 2nd Order Non-linear page.

3. If necessary, adjust the convergence criteria and relaxation factors.

4. Click OK.

5. On the Analyze tab, click 2nd Order Non-linear. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and load cases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order buckling analysis
In order to run a buckling analysis on your model, see the following
instructions.

1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.
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2. In the dialog box, go to the 2nd Order Buckling page.

3. If necessary, adjust the buckling options.

4. Click OK.

5. On the Analyze tab, click 2nd Order Buckling. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and load cases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

See also

The Results View (page 671)

View buckling factors (page 770)

Run a seismic analysis
In order to run either a 1st or 2nd order seismic analysis on your model, see
the following instructions.

Run a 1st order RSA seismic analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 1st Order Seismic page.

3. If necessary, adjust the analysis options.

4. Click OK.

5. On the Analyze tab, click 1st Order RSA Seismic. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order RSA seismic analysis
• On the Analyze tab, click 2nd Order RSA Seismic. 
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Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

See also

RSA seismic results (page 691)

The Results View (page 671)

View tabular results for support reactions (page 765)

View tabular results for nodal deflections (page 765)

View tabular results for solver element end forces (page 766)

Run FE chasedown or grillage chasedown analysis
You can run FE chasedown and grillage chasedown analyses by using the
Analyze All (Static) command. The analyses are also run when they are
required as a part of the combined analysis and design process.

RESTRICTION FE chasedown and grillage chasedown analyses are run for
load cases only, and not for load combinations.

In a combined analysis and design process, Tekla Structural Designer performs
the previously mentioned analyses as follows:

• If the model contains two-way slabs or the user has selected the
appropriate option in the Design Settings dialog box, Tekla Structural
Designer performs FE chasedown analysis.

TIP To control whether Tekla Structural Designer performs FE chasedown
analysis, do the following:

1. On the Design tab, click Settings.

2. Under concrete beams, columns, or walls, go to General
Parameters.

3. Select whether you want to design the members for FE
chasewdown analysis results.

4. Click OK.

• If the model contains one or more concrete members, Tekla Structural
Designer performs the grillage chasedown analysis.

See also

Analyze all combinations and load cases (page 669)
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Run Analyze All (Static)
Static designs can only be performed provided suitable analysis results exist -
while these results are created when you run a combined analysis and
member design, in some situations you may prefer to run the analysis
separately and then selectively design parts of the model as required.

Analyze All (Static) facilitates this as it performs all the analyses for static
loadcases and active static load combinations that are required to enable the
selective designs to be carried out.

To run a separate analysis in this way proceed as follows:

1. On the Analyze toolbar, click  Analyze All (Static). 

Tekla Structural Designer performs the following analyses:

• 1st order linear/non-linear

• 2nd order linear/non-linear (only if this has been specified by the user in
Design > Design Settings > Analysis))

• Grillage chasedown (if one or more concrete members exist)

• FE chasedown (if two-way spanning slabs exist)

At the end of the analyses if a 2D or 3D view is active it is switched to a Review
View.

See also

The Results View (page 671)

View tabular results for support reactions (page 765)

View tabular results for nodal deflections (page 765)

View tabular results for solver element end forces (page 766)

Run 3D only (Static)
3D only (Static) analysis can be used to save time during scheme design, for
example while addressing overall stability, sway, drift, wind drift, etc.

To run a 3D only analysis proceed as follows:

1. On the Analyze toolbar, click 3D only (Static).

Tekla Structural Designer performs the following 3D analyses:

• 1st order linear/non-linear
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• 2nd order linear/non-linear (only if this has been specified by the user in
Design > Design Settings > Analysis)

At the end of the analysis if a 2D or 3D view is active it is switched to a Review
View.

See also

The Results View (page 671)

View tabular solver model data and results (page 764)

Review tabular data (page 898)

Check sum of reactions against load input
Once you have performed an analysis in your model, you can use the Loading
tree to quickly check that the total reaction from each analysis equates to the
total load on structure. This way, you can quickly verify that none of the
applied loads is missing.

1. In the Project Workspace, go to the Loading tab.

2. Review the status of each load case and combination. 

The status options are the following:

• : total reaction equates to the total load on structure

• : total reaction does not equate to the total load on structure

• : total reaction is not available

Example cross-checks

The General section of the properties for each loadcase provides summations
(in global X, Y & Z) of the different load types applied to the structure, from
these the total applied load is determined. The total reaction from the 3D
Analysis result is also reported in this section. Assuming a 3D analysis, FE
chasedown analysis and grillage chasedown analysis have all been performed:

• The Total User Applied Load should equate to the Total Load on
Structure.

• The Total Load on Structure should equate to the Total Reaction for 3D
analysis reported in the General section.

• The Total Load on Structure should equate to the Total Reaction for FE
chasedown analysis reported in the FE ChaseDown section.

• For each sub-model in the FE ChaseDown section the Load Applied when
added to the Load from above should equate to the Reaction

• The Total Load on Structure should equate to the Total Reaction for
Grillage chasedown analysis reported in the Grillage ChaseDown section.
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• For each sub-model in the Grillage ChaseDown section the Load Applied
when added to the Load from above should equate to the Reaction

Check stability and overall displacement
You can use the Status tree in the Project Workspace to review the stability
checks and overall displacement of the model.

Review the stability checks and overall displacement in the Status tree
1. In the Project Workspace click the Status tab

2. In theStatus tree , expand the Design heading.

3. Expand the required check or overall displacement to review as required. 

NOTE Further details of the checks performed are available by reviewing
the tabular design data.

See also:

Filter tabular data (page 929)

Stability and imperfections handbook (page 1133)

6.3 Display analysis results
Once analysis has been run, you can switch 2D and 3D scene views to the
Results View regime to display graphical analysis results. You can also display
analysis results for individual members and walls in a Load Analysis View

Click the links below to find out more:

• The Results View (page 671)

• The Load Analysis View (page 715)

Tabular results are also available, either by creating reports, or by viewing the
tabular solver model data.

See also

View tabular solver model data (page 764)
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The Results View

To change to a Results View click  in the Status bar at the bottom of the
main window.

After setting the analysis type and loading (page 673), most of the results can
then be displayed simply by selecting from the appropriate toolbar group:

Reactions

• Display reactions (page 673)

1D Results

• Display 1D results (page 675)

• Display 1D deflections (page 675)

• Animate 1D and 2D deflections (page 675)

Sway Drift...

• Display sway drift and story shear (page 676)

Notional Loads

• Display notional forces and seismic equivalent lateral forces (page 677)

2D Results

• Display 2D results (page 677)

• Display 2D deflections (page 683)

• Animate 1D and 2D deflections (page 675)

• Display AsReq contours (page 683)

2D Integrated Results

• Display wall lines (page 684)

• Display core lines (page 684)

• Manage, display and design result lines (page 688)

• Manage and display result strips (page 685)

• NOTE Result lines and result strips must be created before they can be
displayed.

Mode Shapes

• Display mode shapes (page 691)

RSA Results

• RSA seismic results (page 691)
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If required, adjustments can be applied to the diagrams as follows:

• To change contour intervals and colors, see Customize the display of 2D
contours (page 696)

• To adjust the amplitude of the diagrams, see Change result diagram scale
settings (page 697)

• In 2D views, it is sometimes necessary to switch to an isometric projection,
see Display 2D view in isometric projection (page 697)

Set the analysis type and loading for viewing analysis results
When Tekla Structural Designer has performed several analysis types, the
results of each analysis are held separately. Therefore, there is no need to re-
perform a particular analysis to recall its results.

1. On the Results toolbar, in the Result Type group, select the required
analysis method. 

NOTE If you select: 1st order modal, 2nd order buckling, 1st order RSA
seismic or 2nd order RSA seismic analyses, you should also
choose the Mode to be displayed.

2. In the Result Type group, if required, click Reduce Axial Force if you
want to take into account reductions when viewing axial forces in a
loadcase or combination in which reductions have been applied.

3. In the Result Type group, click Strength Factors, or Service Factors, as
required, to control which factors are used when displaying results for
combinations.

4. In the Loading list, click either the Select Loadcase, Select

Combination, or Select Envelope button.

5. In the Loading list, select the desired load case, combination, or envelope.

You can now proceed to select the diagram to be displayed.

See also

The Results View (page 671)

Display reactions

Support reactions

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).
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3. In the Reactions group, select the reactions to be displayed:
1D Reactions at supports under 1D elements (e.g.

column support reactions),

2D Reactions at supported nodes of 2D elements
(individual meshed wall supports and mat
foundation supports),

Distributed wall reactions (Fz) - available for self-
supported meshed, mid-pier, bearing and shear-
only wall panels with horizontal bottom levels.

When active the nodal support reactions
exclusive to the wall are hidden.

Summary of assumptions,

• Wall panel has enough height to ensure that
all loading that contributes to the reaction is
far enough from the support such that the
principle of St. Venant is considered valid,

• Material is perfectly homogeneous and
isotropic,

• Elastic limit is nowhere exceeded and 'E' is
same in tension and compression.

Integrated reactions at core supports.

When active support reactions exclusively from
1D and 2D core members are hidden.

4. For Distributed wall reactions the droplist beneath should be set to
Total, for other support reactions you can select the desired reaction
from the droplist.
Fx support local x axis reaction (corresponds to

Fminor in the Foundation Reactions Report),

Fy support local y axis reaction ((corresponds to
Fmajor in the Foundation Reactions Report),

Fz support local z axis reaction (corresponds to
Fvert in the Foundation Reactions Report),

Mx support local x axis moment (corresponds to
Mmajor in the Foundation Reactions Report).

My support local y axis moment (corresponds to
Mminor in the Foundation Reactions Report)

Mz support local z axis moment (corresponds to
Mtor in the Foundation Reactions Report)

Fxyz support local reactions in Fx and Fy and Fz

Mxyz support local reactions in Mx and My and Mz

Total all support local reactions (Fx, Fy, Fz, Mx, My and
Mz.

5. From the Text group select Reaction to display values on the diagram.

Beam end reactions

1. Go to the Results toolbar.
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2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the Reactions group, select Beam Ends, then from the droplist
beneath select the desired reaction.

4. From the Text group select Reaction to display values on the diagram.

Display 1D results

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the 1D Results group, select Results, then from the droplist
underneath it, select the desired result.

4. From the Text group select Forces to display values on the diagram.

See also

Change result diagram scale settings (page 697)

Display 2D view in isometric projection (page 697)

Display 1D deflections

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the 1D Results group, select Deflections, then from the droplist
underneath it, select the desired deflection type.

4. From the Text group select Deflection to display values on the diagram.

See also

Change result diagram scale settings (page 697)

Animate 1D and 2D deflections (page 675)

Animate 1D and 2D deflections
Once the required deflections are displayed, they can be animated as follows:

1. Right click in the view and from the context menu select Animate. 

The animation commences.

2. If required you can change the number of frames per second, the cycle
duration and the amplitude by adjusting the sliders and clicking Apply in
the Animation dialog.

3. To end the animation, simply close the Animation dialog. 
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NOTE Animations are available for static displacements and those for
modal and buckling analysis.

Display sway drift and story shear
Once you have selected the analysis type, and the load case, combination, or
envelope, you can simply view the results by selecting the desired reaction on
the Results tab. The commands in the 1D Results group and the Deflections
group display the results for 1D elements, such as beams, columns, and
trusses, and walls modelled using the mid-pier option. Conversely, the
commands in the 2D Results group and the 2D Deflections group display the
results for 2D elements, such as FE slabs and FE walls. For more information,
see the following instructions.

Sway

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the Sway Drift and Storey Shear group, select Drift, then from the
droplist beneath select Sway Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Relative sway

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the Sway Drift and Storey Shear group, select Drift, then from the
droplist beneath select Relative Sway Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Wind drift

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the Sway Drift and Storey Shear group, select Drift, then from the
droplist beneath select Wind Drift Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Shear

1. Go to the Results toolbar.
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2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the Sway Drift and Storey Shear group, select Drift, then from the
droplist beneath select Dir 1 Shear or Dir 2 Shear as required.

See also

Change result diagram scale settings (page 697)

Display notional forces and seismic equivalent lateral forces
To view the notional forces or seismic equivalent lateral forces that apply to a
particular load combination or load case, see the following instructions.

View the magnitude of EHF in a combination

RESTRICTION The command is only applicable to the Eurocode head code.

1. In the Loading list, select the required combination.

2. On the Results tab, click EHF.

View notional loads in a combination

RESTRICTION The command is only applicable to the ACI/AISC head code.

1. In the Loading list, select the required combination.

2. On the Results tab, click NF.

View the magnitude of NHF in a combination

RESTRICTION The command is only applicable to the BS and Australian head
codes.

1. In the Loading list, select the required combination.

2. On the Results tab, click NHF.

View the magnitude of equivalent lateral forces in a seismic load case or
combination

1. In the Loading list, select the required seismic load case or combination.

2. On the Results tab, click Seismic.

Display 2D results

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).
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3. In the 2D Results group, select Results, then from the droplist beneath
select the result required.
Mdx top Wood Armer bending along panel x axis, top

surface

Mdx bottom Wood Armer bending along panel x axis, bottom
surface

Mdy top Wood Armer bending along panel y axis, top
surface

Mdy bottom Wood Armer bending along panel y axis, bottom
surface

Bearing pressure Bearing pressure

Fx Axial force in panel x axis

Fy Axial force in panel y axis

Fxy Complimentary in-plane shear

Fxz Shear in panel z axis in the panel xz plane

Fyz Shear in panel z axis in the panel yz plane

Mx Bending along panel x axis

My Bending along panel y axis

Mxy Plate torsional moment

σx top In-plane axial stress in the x direction, top
surface

σy top In-plane axial stress in the y direction, top
surface

τxy top In-plane shear stress, top surface

σx bottom In-plane axial stress in the x direction, bottom
surface

σy bottom In-plane axial stress in the y direction, bottom
surface

τxy bottom In-plane shear stress, bottom surface

σx max tension Maximum tension stress in the x direction for
both surfaces

= max (σxtop, σxbottom, 0) ≥ 0

σy max tension Maximum tension stress in the y direction for
both surfaces

= max (σytop, σybottom, 0) ≥ 0

σx max compression Maximum compression stress in the x direction
for both surfaces

= min (σxtop, σxbottom, 0) ≤ 0

σy max compression Maximum compression stress in the y direction
for both surfaces

= min (σytop, σybottom, 0) ≤ 0

σx in-plane In-plane center stress in the x direction

σy in-plane In-plane center stress in the y direction

σx in-plane tension In-plane center tension stress in the x direction

= max (σxin-plane, 0) ≥ 0

σy in-plane tension In-plane center tension stress in the y direction

= max (σyin-plane, 0) ≥ 0
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σx in-plane compression In-plane center compression stress in the x
direction

= min (σxin-plane, 0) ≤ 0

σy in-plane compression In-plane center compression stress in the y
direction

= min (σyin-plane, 0) ≤ 0

NOTE Tooltips are available for the contour plots, by hovering over nodes.
These display all the relevant results at the node for the selected
loading.

See also

Stresses in 2D elements (page 679)

Stresses in 2D elements

Which stresses can be displayed?

You can view the stresses on the outer faces of 2D elements for both slabs
and walls by selecting the required result from droplist beneath Results in the
2D Results group.

The first 6 values are calculated directly from the forces and moments:

1. σx top - in-plane axial stress in the x direction, top surface

2. σy top - in-plane axial stress in the y direction, top surface

3. τxy top - in-plane shear stress in xy direction, top surface

4. σx bottom - in-plane axial stress in the x direction, bottom surface

5. σy bottom - in-plane axial stress in the y direction, bottom surface

6. τxy bottom - in-plane shear stress in xy direction, bottom surface

NOTE The above 6 values are available for loadcases & combinations, but not
envelopes

The next 4 values are determined from the first 6 values:

1. σx max tension - maximum tension stress in the x direction for both
surfaces

2. σy max tension - maximum tension stress in the y direction for both
surfaces

3. σx max compression - maximum compression stress in the x direction for
both surfaces

4. σy max compression - maximum compression stress in the y direction for
both surfaces
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NOTE The above 4 values are available for loadcases, combination &
envelopes.

The center stress values are calculated directly from the forces and moments:

1. σx in-plane - in-plane axial stress in the x direction, center

2. σy in-plane - in-plane axial stress in the y direction, center

The last 4 values are determined from the above 2 values:

1. σx in-plane tension - maximum tension stress in the x direction center

2. σy in-plane tension - maximum tension stress in the y direction center

3. σx in-plane compression - maximum compression stress in the x direction
center

4. σy in-plane compression - maximum compression stress in the y direction
center

How might these results be used?

Users performing the design of structures with concrete core walls are
interested to know which panels within the walls are cracked. Which panels
are cracked can be determined by comparing the maximum tensile stress in
each panel to the concrete tensile strength.

Tekla Structural Designer calculates stress values from the gross section
properties (ignoring the reinforcement). To determine cracked panels, you can
see the maximum tension (and compression) stress in each direction for each
panel, across loadcases, combinations and envelopes.

Calculation of in-plane axial and shear stress

For loadcases and combinations, by using the 2D element thickness, stresses
(based on the gross section properties) can be calculated from the forces at
the nodes:

σxtop = Fx / t + 6Mx / t2

σytop = Fy / t + 6My / t2

τxytop = Fxy / t + 6Mxy / t2

σxbottom = Fx / t - 6Mx / t2

σybottom = Fy / t - 6My / t2

τxybottom = Fxy / t - 6Mxy / t2

σxin-plane = Fx / t

σyin-plane = Fy / t
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NOTE • Tension stresses are positive

• Compression stresses are negative

The process for enveloping the above values is the same as that used for other
envelopes. For each of the items, a pair of values is found, these are the
minimum & maximum values across all loadcases and combinations.

Calculation of maximum tension and compression stress for loadcases and combinations

For loadcases and combinations, the maximum tension and compression
values are determined for a specific direction by finding the maximum or
minimum of the top and bottom stresses in that direction:

σx max tension = Max ( σxtop, σxbottom, 0.0 )

σy max tension = Max ( σytop, σybottom, 0.0 )

σx max compression = Min ( σxtop, σxbottom, 0.0 )

σy max compression = Min ( σytop, σybottom, 0.0 )

σx in-plane tension = Max ( σxin-plane, 0.0 )

σy in-plane tension = Max ( σyin-plane, 0.0 )

σx in-plane compression = Min ( σxin-plane, 0.0 )

σy in-plane compression = Min ( σyin-plane, 0.0 )

For envelopes, the maximum tension and compression values are determined
by applying the above equations to the enveloped values. Envelopes yield two
values for each of the 4 entries in the dropdown.

Calculation of maximum tension and compression stress for envelopes

For envelopes, the maximum tension and compression values are determined
by applying the above equations for loadcases and combinations to the
enveloped values.

Envelopes yield two values for each of the 4 entries in the droplist.

For tension stresses (x or y - only x shown for brevity) the values are returned
are:

σx max tension = m1 / m2 , where:

m1 = Min ( σxtop max across all cases & combs , σxbottom max across all cases & combs ,
0.0 )

m2 = Max ( σxtop max across all cases & combs , σxbottom max across all cases & combs ,
0.0 )

For compression stresses (x or y - only x shown for brevity) the values
returned are:
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σx max compression = m1 / m2 , where:

m1 = Min ( σxtop min across all cases & combs , σxbottom min across all cases & combs, 0.0 )

m2 = Max ( xtop min across all cases & combs , σxbottom min across all cases & combs , 0.0 )

In summary the values visible in the tooltip are:

σx max tension  = Min (σxtopmax across all

cases & combs, σxbottommax

across all cases & combs, 0.0) /

Max (σxtopmax across all

cases & combs, σxbottommax

across all cases & combs, 0.0)

   
σy max tension  = Min (σytopmax across all

cases & combs, σybottommax

across all cases & combs,
0.0 ) /

Max (σytopmax across all

cases & combs, σybottommax

across all cases & combs, 0.0)

   
σx max compression  = Min (σxtopmin across all

cases & combs, σxbottommin

across all cases & combs, 0.0) /

Max (σxtopmin across all

cases & combs, σxbottommin

across all cases & combs, 0.0)

   
σy max compression  = Min (σytopmin across all

cases & combs, σybottommin

across all cases & combs,
0.0 ) /

Max (σytopmin across all

cases & combs, σybottommin

across all cases & combs, 0.0)

Key points when using stress values

1. In Walls X direction is horizontal in plane of wall and Y is vertical
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2. “Top”/”Bottom” is dependent on shell local axis system, but if you are only
concerned about max values you don’t need to worry about this - use the
“max” options which consider both faces.

3. For engineers wanting to consider tensile stresses in walls the “σy in-plane
tension” option will be of greatest interest.

• This is based purely on the membrane tension stress (i.e. ignoring out
of plane bending effects).

• This can be viewed for enveloped results

• It is very easy to see walls/panels in which no tension stress is
developing.

• In a full 3D view it may be difficult to assess whether a particular
cracking stress level is exceeded. Viewing results in 2D views or sub
structures may be helpful here.

• It should be clear that this is based on the concrete section only -
reinforcement content is not considered.

See also

Display 2D results (page 677)

Display 2D deflections

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the 2D Results group, select Deflections, then from the droplist
beneath select the desired deflection type.

4. From the Text group select Deflection to display values on the diagram.

See also

Customize the display of 2D contours (page 696)

Change result diagram scale settings (page 697)

Animate 1D and 2D deflections (page 675)

Display AsReq contours
AsReq contours can either be displayed as values, or as a pass/fail threshold.
Displaying as a pass/fail threshold helps to visualize minimum patch sizes
when optimizing panel and patch reinforcement as it highlights the specific
areas in which the existing reinforcement is not sufficient.

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 673). 
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NOTE Typically the analysis method will be FE chase-down

3. In the 2D Results group , select As Req.

4. From the first droplist, select the desired direction and slab face.

5. From the second droplist, select Value, or Pass/Fail as required.

See also

Customize the display of 2D contours (page 696)

Change result diagram scale settings (page 697)

Display wall lines
Tekla Structural Designer automatically creates a wall line at the centroid of
every meshed shear wall to facilitate the display of wall forces.

1. In the Status bar, click Results View. 

The Results toolbar opens.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the 2D Integrated Results group, select Wall Lines, then from the
droplist in the same group, select the desired result.

4. From the Text group select Forces to display values on the diagram. 

Tekla Structural Designer displays the selected result on the wall line.

TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 697).

Display core lines
Tekla Structural Designer automatically creates a core line at the centroid of
each concrete core to facilitate the display of core forces.

1. In the Status bar, click Results View. 

The Results toolbar opens.

2. Set the analysis type and loading for viewing analysis results (page 673).

3. In the 2D Integrated Results group, select Core Lines, then from the
droplist in the same group, select the desired result.

4. From the Text group select Forces to display values on the diagram. 
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Tekla Structural Designer displays the selected result on the core line.

NOTE All forces in the results are rotated to be in the axis system of the
core line.

TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 697).

See also

Create concrete cores (page 435)

Manage and display result strips
You can place user-defined result strips across 2D element meshes. For these
strips, Tekla Structural Designer determines the force and moment results
from the shell/plate/membrane nodal analysis results. These results can then
be used for design purposes, typically for slab design.

Engineering judgement is required when positioning the strips to ensure
suitable design forces are obtained.

By default, strips have parallel edges, but tapering strips can also be defined
as shown in the following image:

Create result strips

1. Open a 2D view of the FE mesh where you want to place the strip.

2. In the Status bar, click Results View. 

The Results toolbar opens.

3. In the 2D Integrated Results group, click Result Strip.

4. In the Properties window, adjust the result strip properties according to
your needs.

5. Click the start point of the strip.

6. Click the end point of the strip. 
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TIP Neither the start or the end point have to match nodes in the mesh.

Tekla Structural Designer creates a strip between the selected points.

7. Do one of the following:

• Continue placing further strips.

• Press Esc to exit the command.

View the results for result strips

Once you have created a result strip in the model, you can obtain results for it
without re-running the analysis. In order to view the results, do the following:

1. Open a 3D view containing the strips whose results you want to view.

2. Go to the Results toolbar.

3. In the first list of the Result Type group, select the desired result type.

4. In the Loading list, select the load case or combination that you want to
display.

5. In the 2D Integrated Results group, click the effect that you want to view.

Tekla Structural Designer displays the selected effect on the strip, and its
maximum positive and negative values, calculated according to the result
type specified in the strip properties.

NOTE Tekla Structural Designer contains the following three ways to
calculate the results:

Me
th
od
na
me

Details

No
rm
al

• The results on the center of the result
strip are calculated at each station*.

• Tekla Structural Designer considers
the shell elements local to each
station, and calculates a weighted
average force based on the distance
of the element nodes from the
station.

The process is repeated for all
stations along the center line of the
strip to give the results.
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• The results on the transverse line
across the strip are calculated for
each station* along the strip.

• Tekla Structural Designer considers
the shell elements local to each point,
and calculates a weighted average
force based on the distance of the
element nodes from the point. The
maximum result across the strip from
all points is taken as the result for the
station on the strip center line.

The process is repeated for all
stations along the center line of the
strip to give the results.

• The values calculated at points are
always weighted averages of results at
adjacent nodes. Therefore, they are
always less than the peak nodal
values.

• Maximum values include nodes within
the strip.

Av
era
ge

• Average over strip width.

• The results are obtained in the same
way as for the maximum option, but
in this case, they are averaged to give
the results for each station*.

The process is repeated for all
stations along the center line of the
strip to give the results.

•

* Along the strip center line, there is a user-defined number of
stations. At each station, there is a transverse line with a user
defined number of points along it. Final results are always given
by station, and obtaining them may or may not use points.

All forces in the results are rotated to be in the axis system of the
result strip.
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Delete result strips

TIP To delete a strip, ensure that Result Strips are switched on in Scene
Content.

1. Open a view containing the strip that you want to delete.

2. In the Quick Access toolbar, click Delete.

3. In the model, click the strip that you want to delete. 

Tekla Structural Designer deletes the selected strip.

See also

Change result diagram scale settings (page 697)

Display 2D view in isometric projection (page 697)

Manage, display and design result lines
You can place user-defined result lines across 2D element meshes. For these
lines, Tekla Structural Designer determines the force and moment results from
the shell/plate/membrane nodal analysis results. These results can then be
used to assess design solutions, typically for the design of wall panels with
openings.

Engineering judgement is required when positioning the lines to ensure
suitable design forces are obtained.

Create result lines

1. Open a 2D view containing the wall or slab within which you want to place
the strip.

2. In the Status bar, click Results View. The Results toolbar opens.

3. In the 2D Integrated Results group, click  Result Line.

4. Click the start point of the line.

5. Click the end point of the line. 

TIP Neither the start or the end point have to match nodes in the mesh.

Tekla Structural Designer creates a result line between the selected
points.

6. Do one of the following:

• Continue placing further result lines.

• Press Esc to exit the command.
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View the analysis results for result lines

NOTE An analysis must be performed after adding or editing result lines in
order to obtain up to date results.

To view the results, do the following:

1. Open a view containing the result lines whose results you want to view.

2. In the Status bar, click Results View. 

The Results toolbar opens.

3. Set the analysis type and loading for viewing analysis results (page 673).

4. In the 2D Integrated Results group, click Result Lines, then from the
droplist in the same group, select the desired result.

5. From the droplist in the 2D Integrated Results group, select the effect
that you want to view.

6. From the Text group select Forces to display values on the diagram. 

Tekla Structural Designer displays the selected result on the result line.

NOTE All forces in the results are rotated to be in the axis system of the
result line.

TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 697).

See also:

View tabular results for result lines (page 767)

Interactively design result lines

1. Open a view containing the result line to be designed.
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2. Hover the mouse pointer over the result line that you want to design. 

The Select Entity tooltip appears.

3. In the Select Entity tooltip, navigate to the result line (RL) name by using
the arrow keys.

4. Right-click the result line.

5. In the context menu, select Interactive Design... (as a column section, or
as a wall section as required). 

The selected (column or wall) interactive design dialog is displayed with
the Additional Design Cases page populated with the result line results.

6. Modify the reinforcement parameters as required to achieve a
satisfactory design, and click the Check button to examine the detailed
design results.

7. Click OK to save the designed reinforcement to the result line. 

NOTE For help on using the interactive dialogs, see Interactive concrete
column design (page 1315) and Interactive concrete wall design
(page 1335).

Features of result line design

• The interactive design dialog features full interactive manual selection of
both lateral and vertical reinforcement, interaction diagrams and auto-
design and check options, just as for a regular wall/ column section
interactive design.

• The wall length/ column depth considered is the Result Line length.

• Result lines are not constrained to cross sections in the horizontal plane -
vertical sections can be used above/between openings to investigate forces
and reinforcement requirements in “coupling beams”.

• The section design always considers the main bars (running
perpendicular to the cross section) as being on the inner layer, from a
design perspective this will tend to be conservative but the engineer
should give this some consideration when working with non-horizontal
sections.

• The design does not consider the existing reinforcement specified in
wall properties - only that which is defined in the Interactive design
dialog.

• Currently this feature is not linked with Reports and so it is envisaged
output will be via screenshots of the interactive design and check
results dialogs.

• The same result line can be used to interactively design as a column, and
as a wall. Both designs are saved to the result line independently.
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Delete result lines

TIP To delete a result line, ensure that Result Lines are switched on in Scene
Content.

1. Open a view containing the result line that you want to delete.

2. In the Quick Access toolbar, click Delete.

3. In the model, click the result line that you want to delete. 

Tekla Structural Designer deletes the selected result line.

Related video

Interactive design using Result lines

Display mode shapes
When Tekla Structural Designer has performed several analysis types, the
results of each analysis are held separately. Therefore, there is no need to re-
perform a particular analysis to recall its results.

1. Open a suitable 2D or 3D View and change the view regime (page 280) to
a Results View.

2. On the Results tab, in the Result Type group, select the required analysis
type.

3. In the Loading list, select the required load case or combination. 

NOTE For RSA seismic analysis, only select load cases, as mode shapes
are not applicable for combinations, and therefore cannot be
viewed.

4. In the second list of the Result Type group, select the desired mode.

5. Select the diagram that you want to display.

See also

The Results View (page 671)

RSA seismic results
For information on how RSA seismic results are displayed for different load
cases and combinations, see the following paragraphs.

Result Type

When the result type is 1st or 2nd order RSA seismic, the results that can be
displayed depend on the type of the currently selected load case or
combination.

Analyze models 691 Display analysis results



Mode Shapes

Mode shapes can be displayed for:

• RSA Seismic load cases:

• Combined (CQC) or combined (SRSS), depending on your choice in
Analysis Settings

• All modes that are relevant for the selected load case

• Effective seismic weight combination:

• List of all modes returned by the modal analysis

Mode shapes are not displayed for:

• RSA torsion load cases

• Static load cases included in the RSA seismic combination

• RSA seismic combinations

   

See also

• Display mode shapes (page 691)

1D Element Results

1D element results (and Load Analysis View results) are displayed as follows:

Load case or combination Display method
RSA seismic load cases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
various points along each member
and displayed on both the positive
and negative side of the diagram.
Therefore, the diagrams are always
symmetrical about the base line.

All relevant modes:

A standard enveloped diagram is
displayed.

RSA torsion load cases Displayed as per 1st order linear
analysis.

Static load cases included in the RSA
seismic combination

Displayed as per 1st order linear
analysis.

Effective seismic weight combination Not available
RSA seismic combinations An envelope is drawn displaying the

seismic results above and below the
static result:
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Load case or combination Display method
• Baseline goes through the static

values

• Top line = static value + seismic
value

• Bottom line = static value - seismic
value

   

See also

• Display 1D results (page 675)

Story Shear

Story shears are displayed as follows:

Load case or combination Display method
RSA seismic load cases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
each position of interest and the
result is displayed as both positive
and negative.
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Load case or combination Display method
All relevant modes:

A standard diagram with a single
value at each point of interest is
displayed.

RSA torsion load cases Displayed as per 1st order linear
analysis.

Static load cases included in the RSA
seismic combination

Displayed as per 1st order linear
analysis.

Effective seismic weight combination Not available
RSA seismic combinations The diagram displays two values at

each point of interest:

• Static value + seismic value

• Static value - seismic value

   

See also

• Display sway drift and story shear (page 676)

Support Reactions

Support reactions are displayed as follows:

Load case or combination Display method
RSA seismic load cases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
each support and the result is
displayed as both positive and
negative.

All relevant modes:

A standard diagram is displayed.
RSA torsion load cases A standard diagram is displayed.
Static load cases included in the RSA
seismic combination

A standard diagram is displayed.

Effective seismic weight combinations Not available
RSA seismic combinations The diagram displays two values at

each support:

• Static value + seismic value

• Static value - seismic value
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See also

• Display reactions (page 673)

Concrete Wall Results

Concrete wall results are displayed as follows:

Load case or combination Display method
RSA seismic load cases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
points along the wall line and
displayed on both the positive and
negative side of the diagram.
Therefore, the diagrams are always
symmetrical about the wall line.

All relevant modes:

A standard diagram is displayed.
RSA torsion load cases A standard diagram is displayed.
Static load cases included in the RSA
seismic combination

A standard diagram is displayed.

Effective seismic weight combinations Not available
RSA seismic combinations An envelope is drawn displaying the

seismic results above and below the
static result:

• Baseline goes through the static
values

• Top line = static value + seismic
value

• Bottom line = static value - seismic
value
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Customize the display of 2D contours
By default, all contour diagrams consist of 10 evenly sized contours, each
accounting for 10% of the total range. If necessary, you can increase or
decrease the number of contours, and also change the size and the color of
individual contours.

1. On the Home tab, click Settings. 

The Settings dialog box opens.

NOTE If you intend to make the changes to the contours in the current
model, ensure that you are making changes to the active settings
set.

2. Go to Scene --> Contours .

3. According to your needs, do one or more of the following:

To Do this
Add new contours • Click Split.

Delete existing contours • Click Delete.

Modify the size of contours • In the Size [%] column, type new values in
the appropriate cells.

Change the color of contours a. In the Color column, click the color that
you want to change.

b. Select a new color.

c. Click OK.

Revert to the default contour settings • Click Reset.

4. Click OK.
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See also

The Results View (page 671)

Change result diagram scale settings
• Move the sliders in the Scale Settings group according to adjust the

diagram amplitude according to your needs. 

The below example shows the effect on an axial force diagram when the
1D Results slider is increased from minimum to maximum.

See also

The Results View (page 671)

Display 2D view in isometric projection
Because the diagrams are plotted on each element in the planes in which they
act when you are working in a 2D view, you will need switch on an isometric
display to see the out of plane forces.

If the 2D view is currently displayed in plan, the 2D/3D toggle button at the
bottom right corner of the screen is labeled 3D.

• To change the current view, click the 2D/3D toggle button.

See also

The Results View (page 671)
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Sign conventions and coordinate systems
Tekla Structural Designer adopts the standard convention that lower case x, y,
and z represent local coordinate systems, whereas upper case X, Y, and Z
represent the global coordinate system. For more information on analysis
result sign conventions, see the following paragraphs.

Axis systems

The following table presents the axis systems that can be used in Tekla
Structural Designer:

Axis system name Description
Global coordinate system The global XYZ axis system within

which all other systems exist.
Building directions 1 and 2 The principle axes of the building,

where dir 1 is rotated at an angle to
global X in the horizontal plane.

User coordinate system A local coordinate system defined by
the system or the user.

1D member local coordinate system The local coordinate system that is
applicable to all 1D members, such as
beams, columns, and braces.

Mid-pier wall coordinate system The local coordinate system that is
applicable to walls modeled using the
mid-pier option.

2D member local coordinate system The local coordinate system that is
applicable to all 2D members, walls,
and slabs.

Result line coordinate system The local coordinate system that is
applicable to result lines.

Result strip coordinate system The local coordinate system that is
applicable to result strips.

Foundation reaction coordinate
system

The local coordinate system that is
applicable to foundations.

General information

All global (XYZ) and local (xyz) axis systems follow the right-hand rule, where:

• x axis is the pointing index finger.

• y axis is the crooked middle finger.

• z axis is the extended thumb.

In the directions of positive rotation:

• About x: the y axis moves toward the z axis.

• About y: the z axis moves toward the x axis.
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• About z: the x axis moves toward the y axis.

Object orientation

Tekla Structural Designer considers the orientation of the object when
displaying the analysis results. Therefore, to apply the sign convention
correctly, you need to know which is the end 1 and which is the end 2 of
beams or walls, and which is the face A of columns.

If you select the Direction option for an element in Scene Content, Tekla
Structural Designer displays an arrow on all beams, walls and columns. This
arrow points from the start to the end of beams and walls, and from the
bottom to the top of columns along the face A. Looking down from the top of
a column, Face B, C, and D then follow in the clockwise direction.

Diagram conventions

All arrows should point in the direction of the force or moment, as the
following image illustrates:

If the arrows are reversed, they become negative forces and moments, as the
following image illustrates:
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Global coordinate system

The following image illustrates the global axis system and applied load
directions.

The resulting deflection directions appears as follows.

Building directions 1 and 2

Global axes (positive Z vertically up) and angle between X and direction 1 is θ,
where θ is positive in right-hand rule about Z.

The following image illustrates the building directions and applied load
directions.

The resulting deflection directions appear as follows.
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User coordinate system

A user coordinate system can be at any angle to the global coordinate system.

The following image illustrates the axis system of a user coordinate system
axis and applied load directions.

The resulting deflection directions appear as follows.

NOTE Every support is given a user coordinate system. Automatically
created supports under certain objects default to the following
method:

• Support under a single column or wall rotates the foundation
forces to align with the y/z-axes of the column or wall

• Support under a mat foundation - uses the global coordinate
system.

All other supports default to the global coordinate system.
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1D member local coordinate system (general case)

Local axis system and applied load directions:

• The local x axis along member starts from end 1 and ends in end 2

• When γ = 0:

• The local z axis lies in the plane created by the local x axis and the
global Z axis.

• The global Z component of the local z axis is always negative.

• The local y axis follows the right-hand rule.

γ = positive clockwise rotation of y and z axes about the x axis looking
towards positive x.

Applied force directions:

• z = Major (Fz and My):
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• y = Minor (Fy and My):

• x = Axial:

Result axis system and directions

In the major axis:

• Moment major = bending about the y axis

• Shear major = shear along the z axis

In the minor axis:

• Moment minor = bending about the z axis
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• Shear minor = shear along the y axis

In the axial direction:

Resulting member end forces and directions

Member end forces are the forces applied to the rest of the structure by the
member. Based on loading applied above, the forces would be applied as
follows:
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1D member local coordinate system (vertical members)

Local axis system and applied load directions

Local x aligns with global Z (vertical):

• When γ = 0:

• The local y axis aligns with global X.

• The local z axis according to the right-hand rule.

γ = positive clockwise rotation of y and z about the x axis towards positive
x.

Applied force directions as displayed in the previous image:

• z = Major

• y = Minor

• x = Axial

Result axis system and directions

In the major axis:

• Moment major = bending about the y axis

• Shear major = shear along the z axis
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In the minor axis:

• Moment minor = bending about the z axis

• Shear minor = shear along the y axis

In the axial direction:
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Mid-pier wall coordinate system

Wall axis system and applied load directions

As the following image illustrates, centered on the centroid of the cut section:

• the x axis lies along the stem mid-pier element (positive lowest to highest)

• the z axis lies along the plane of the wall (positive end 2 to end 1)

• the y axis follows the right-hand rule and is normal to the wall.

The results from a mid-pier model are in the same axis system as the result
line in a meshed wall.

Result axis system and direction

In the major axis:
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• Moment major = bending about the y axis:

• Shear major = shear along the z axis:

In the minor axis:
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• Moment minor = bending about the z axis:

• Shear minor = shear along the y axis:

In axial and torsion, force is in the x axis and torsion about the x axis:
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2D member local coordinate system

Horizontal panel local axis system and applied load directions

Horizontal panel local axes are the following:

• The local z axis is normal to the plane of the panel

• When θ = 0:

• The local x axis plane is in the plane of the panel, aligned with the global
X axis and positive in the positive global X direction.

• The local y axis is in the plane of the panel and follows the right-hand
rule.

θ = positive clockwise rotation of the x and y axis about the z axis looking
towards positive z.

Vertical and sloped panel local axis system and applied load directions

Vertical and sloped panel local axes are the following:

• The local z axis is normal to the plane of the panel.

• When θ = 0:

Analyze models 710 Display analysis results



• The local x axis plane is in the plane of the panel and in a horizontal
plane.

• The local y axis is in the plane of the panel and follows the line of
greatest slope of the plane (positive in the direction of positive global).

θ = positive clockwise rotation of x and y a bout z looking towards positive
x.

Sloped panel (axes at θ):

Vertical panel (axes when q = 0):

Analyze models 711 Display analysis results



2D member forces sign convention

The sign convention for 2D member forces is not the same as that of 1D
elements. The following diagram illustrates the forces and the panel and 2D
element axis system (for results):

• The arrows in the diagram show positive force directions.

• The double-arrow convention is used for moments: the moment is
around the double-arrow, positive being clockwise when looking in the
arrow direction.

• The forces act on a member face cut anywhere in the FE mesh,
perpendicular to the force direction.

Thus, for example, Mx acts on the X face that is perpendicular to the X axis
and is moment resulting from spanning in the X direction, Fxz is the out-of-
plane shear force acting on the X face, and so on.

• The wood armer design moments (denoted by the d suffix) act in the same
manner as the unprocessed moments without the d suffix. Thus, Mdx acts
in the same manner as Mx, and so on.

• The design moments are further classified into top and bottom
components for the slab design process.

• The positive Z axis direction (up) follows the right-hand rule and, therefore,
is not the same as that for the 2D member local coordinate system. This is
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because the 2D member local coordinate system for the applied load
directions displays the positive applied load direction convention that, for Z
only, is opposite to the convention of the global and 2D element axes.

• A positive moment creates tension in the top surface of the shell.
Therefore, the moment over a supporting column is positive, whereas the
span moment is negative.

• The conventions for wall results are exactly the same as conventions for
columns, so they can be interpreted in the same way.

• The compression of axial loads (Fx and Fy) is negative.

• Out-of-plane shear (Fxz and Fyz) is positive when shear is such that
moment is increasing in the positive X or Y direction.

Result line coordinate system

Centered on the centroid of the cut section:

• The z axis lies along the result line (positive end 2 to end 1).

• The y axis normal to plane of mesh (generally positive in the positive Z
direction, in special cases positive x towards positive Z).

• The x axis follows the right-hand rule and lies in the mesh, so x is
perpendicular to the cut line.

NOTE The results from a result line are exactly like those for a mid-pier
model when the cut is horizontal and the cut direction matches the
direction required.

Result Axis System

• In the major axis: bending about the y axis and shear along the z axis

• In the minor axis: bending about the z axis and shear along the y axis

• Axial and torsion: force in x and bending about the x axis

General case:

Special case:
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Result strip coordinate system

Centered at each station along the strip center line, whether there is a single
or several continuous strips:

• The z axis is normal to plane of mesh (generally positive in the negative Z
direction, in special cases positive x towards positive Z).

• The x axis lies along the result strip (positive end 1 to end 2)

• The y axis lies along the transverse line to the result strips and follows the
right-hand rule, so the y axis is perpendicular to the strip line.

Result axis system

• Deflection in the z direction

• Out of plane moment about the y axis

• Shear in the z direction

General case:

Special case:
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Foundation reaction coordinate system

As the following image illustrates, the foundation reaction coordinate system
is aligned with the coordinate system for the support node, whether that is the
global coordinate system or a user coordinate system.

Reactions are the forces applied to the structure by the foundation. They
appear as follows.

The Load Analysis View
Analysis results for individual members and walls can be displayed in a Load
Analysis View.
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Open a Load Analysis View
1. Right-click the member whose loading and analysis results you want to

view.

2. In the context menu, select Open Load Analysis View. 

Tekla Structural Designer opens the load analysis view and the Loading
Analysis tab.

3. In the Loading list, select the load case or combination whose results you
want to view.

4. Select the analysis type using the list in the Result Type group.

5. If you are viewing the results for a load combination, in the Result Type
group, select whether you want to view the results based on strength or
service factors.

6. In the Direction group, select the axis type (Axial, Major, or Minor). 

Tekla Structural Designer displays the results according to the selected
options. If necessary, you can control the results in the Properties
window.

Load Analysis View properties for columns
Result Type: Axial

Property Description
Distance The results can be reported at any

position along the column, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider

 to the position required.

NOTE For concrete columns only: If
rigid zones have been
applied, only the non-rigid
length of the column is
displayed in the loading
analysis view.

Stack Specifies the stack for which results
are displayed.

Axial force above The axial force in the column
immediately above the cross section
at the distance specified.
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Property Description
Axial force below The axial force in the column

immediately below the cross section
at the distance specified.

Axial force reduced above The axial force in the column
immediately above the cross section
at the distance specified, taking into
account imposed load reductions.

Axial force reduced below The axial force in the column
immediately below the cross section
at the distance specified, taking into
account imposed load reductions.

Torsion moment above The torsion in the column
immediately above the cross section
at the distance specified.

Torsion moment below The torsion in the column
immediately below the cross section
at the distance specified.

Show axial force If cleared, the axial force diagram is
removed from the view.

Show axial force reduced If cleared, the axial force diagram is
removed from the view.

Show torsion moment If cleared, the torsion diagram is
removed from the view.

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.

Result Type: Major, Minor

Property Description
Distance The results can be reported at any

position along the column, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider

 to the position required.

NOTE For concrete columns only: If
rigid zones have been
applied, only the non-rigid
length of the column is
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Property Description

displayed in the loading
analysis view.

Stack Specifies the stack for which results
are displayed.

Shear above The major or minor shear force
immediately above the cross section
at the distance specified.

Shear below The major or minor shear force
immediately below the cross section
at the distance specified.

Moment above The major or minor moment
immediately above the cross section
at the distance specified.

The Moments diagram is solid and
shaded.

Moment below The major or minor moment
immediately below the cross section
at the distance specified.

Ecc. Moment above The major or minor moment due to
eccentricity immediately above the
cross section at the distance
specified.

The eccentricity moments diagram is
dashed and unshaded.
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Property Description

Ecc. Moment below The major or minor moment due to
eccentricity immediately below the
cross section at the distance
specified.

Relative deflection The relative deflection in the major or
minor direction at the distance
specified.

Applied load above The applied distributed load in the
major or minor direction immediately
above the cross section at the
distance specified.

Applied load below The applied distributed load in the
major or minor direction immediately
below the cross section at the
distance specified.

Applied force The applied point load in the major or
minor direction at the distance
specified.

Applied moment The applied moment in the major or
minor direction at the distance
specified.

Show loading If cleared, the loading diagram is
removed from the view.

Show shear If cleared, the shear diagram is
removed from the view.

Show moment If cleared, the moment diagram is
removed from the view.

Show relative deflection If cleared, the relative deflections
diagram is removed from the view.

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.
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Load Analysis View properties for beams
Result Type: Axial

Property Description
Distance The results can be reported at any

position along the beam, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider
shown below to the position required.

NOTE For concrete beams only: If
rigid zones have been
applied, only the non-rigid
length of the beam is
displayed in the loading
analysis view.

Span Specifies the span for which results
are displayed.

Axial force left The axial force in the beam
immediately to the left of the cross
section at the distance specified.

Axial force right The axial force in the beam
immediately to the right of the cross
section at the distance specified.

Torsion moment left The torsion in the beam immediately
to the left of the cross section at the
distance specified.

Torsion moment right The torsion in the beam immediately
to the right of the cross section at the
distance specified.

Relative angle of twist The relative angle of twist (due to
torsion) in the beam cross section, at
the distance specified.

Angle of twist derivative A droplist allowing the selection of the
derivative of angle of twist:

• First

• Second
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Property Description
• Third

(This property is displayed for “Open”
sections only).

Angle of twist derivative left The relative angle of twist (due to
torsion) in the beam cross section,
immediately to the left of the distance
specified.

(This property is displayed for “Open”
sections only).

Angle of twist derivative right The relative angle of twist (due to
torsion) in the beam cross section,
immediately to the right of the
distance specified.

(This property is displayed for “Open”
sections only).

Show axial force If cleared, the axial force diagram is
removed from the view.

(This property is only displayed if the
Axial direction is selected.)

Show torsion moment If cleared, the torsion diagram is
removed from the view.

(This property is only displayed if the
Axial direction is selected.)

Show relative angle of twist If cleared, the relative angle of twist
diagram is removed from the view.

Show angle of twist derivative If cleared, the angle of twist derivative
diagram is removed from the view.

(This property is displayed for “Open”
sections only).

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.

Result Type: Major, Minor, (plus Major Principal and Minor Principal for
angle sections)

Property Description
Distance The results can be reported at any

position along the beam, either by
typing the distance directly into the
Properties window, or, on the
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Property Description
diagram, by dragging this slider
shown below to the position required.

NOTE For concrete beams only: If
rigid zones have been
applied, only the non-rigid
length of the beam is
displayed in the loading
analysis view.

Span Specifies the span for which results
are displayed.

Shear left The major or minor shear force
immediately to the left of the cross
section at the distance specified.

Shear right The major or minor shear force
immediately to the right of the cross
section at the distance specified.

Moment left The major or minor moment
immediately to the left of the cross
section at the distance specified.

Moment right The major or minor moment
immediately to the right of the cross
section at the distance specified.

Relative deflection The relative deflection in the major or
minor direction at the distance
specified.

Applied load left The applied distributed load in the
major or minor direction immediately
to the left of the cross section at the
distance specified.

Applied load right The applied distributed load in the
major or minor direction immediately
to the right of the cross section at the
distance specified.

Applied force The applied point load in the major or
minor direction at the distance
specified.

Applied moment The applied moment in the major or
minor direction at the distance
specified.
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Property Description
Show loading If cleared, the loading diagram is

removed from the view.
Show shear If cleared, the shear diagram is

removed from the view.
Show moment If cleared, the moment diagram is

removed from the view.
Show relative deflection If cleared, the relative deflection

diagram is removed from the view.
Show dimensions If cleared, the dimensions are

removed from the view.
Show extremes If cleared, the max and min values are

removed from the view.

RSA Seismic Results in a Load Analysis View
Loading Analysis Views for 1st or 2nd Order RSA Seismic result types use the
same rules as those applied to multi-member Results Views for the same
result types, i.e. as follows:

RSA Seismic Loadcases

• Combined (CQC) or Combined (SRSS) - depending on your choice in
Analysis Options

• Absolute values are determined at various points along each member
and then plotted on both the positive and negative side of the diagram,
(so that the diagrams are always symmetrical about the base line).

• All relevant modes - a standard enveloped diagram is displayed

• RSA Torsion Loadcases - displayed as per 1st order linear analysis

• Static Loadcases included in the RSA Seismic Combination - displayed as
per 1st order linear analysis

• Effective Seismic Weight Combination - not available

RSA Seismic Combinations

A droplist is provided to allow you to view:

• Design Profile - derived from the Static+Seismic result, the Design Profile is
always plotted on the same side of the base line as the Static Only result

• Static Only - displayed as per 1st order linear analysis

• Seismic Only - absolute values are determined at various points along each
member and then plotted on both the positive and negative side of the
diagram

• Static+Seismic - an envelope is drawn showing the seismic results above
and below the static result.
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• Base line is through the static values

• Top line is static value + seismic value

• Bottom line is static value - seismic value

6.4 Solver models
You can display the solver model used for each analysis type in 2D or 3D by
opening an appropriate solver view.

If you have performed more than one analysis type, then (providing the
geometry and loading have not changed between runs), each solver model is
retained.

NOTE Changes to mesh size or uniformity do not constitute a change in the
geometry. Hence, if different meshes have been applied for each analysis
type, the different solver models are retained.

To Click the link below:
Learn about the different solver
model types and what is displayed
within them

Solver model types (page 725)

Open a solver view to display a solver
model

Open a solver view (page 732)

Change the solver model type
displayed in a solver view

View the solver model used for a
particular analysis (page 733)
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To Click the link below:
View properties of solver model
objects

View solver model object properties
(page 734)

Learn about rigid offsets and rigid
zones used in concrete beams and
columns

How concrete beams and columns
are represented in solver models
(page 738)

Learn about the analytical model
used for meshed walls

How meshed walls are represented in
solver models (page 750)

Learn about the analytical model
used for mid-pier concrete walls

How mid-pier walls are represented
in solver models (page 755)

Learn about the analytical model
used for shear only walls

How shear only walls are represented
in solver models (page 757)

Learn about the analytical model
used for bearing walls

How bearing walls are represented in
solver models (page 761)

View tabular solver model data and
solver model results

View tabular solver model data
(page 764)

Solver model types
You can review the different solver models by opening a Solver View and then
choosing the solver model type required from the right-click menu.

Working Solver Model
The Working Solver Model shows the model in its form prior to any analysis.

Although 1D elements, solver nodes, and diaphragms are displayed, 2D
elements are not (even when you have chosen to mesh slabs/walls). This is
because 2D elements are only formed at the point of analysis.

Solver Model used for 1st Order Linear and 2nd Order Linear
The solver model used for 1st order and 2nd order linear analysis potentially
features a mix of 1D analysis elements, FE meshes and diaphragms as follows:

• beams and columns are modelled as 1D analysis elements

• walls are either mid-pier analysis elements, or FE meshes

• slabs (optionally) form rigid, or semi rigid, diaphragms in floors

• 1-way slabs have their loads decomposed on to supporting members at a
preliminary stage of the analysis.
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• 2-way slabs are (typically) not meshed, in which case they will also have
their loads decomposed on to supporting members at a preliminary stage
of the analysis.

• 2-way slabs (optionally) can be meshed, this is only recommended for
special cases, typically where slabs participate in the lateral load stability
system, e.g. transfer slabs

• supports are user defined

Any FE meshes in the solver model are formed using the mesh parameters in
place for the most recent run of the chosen analysis (i.e. 1st order linear or
2nd order linear).

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.
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NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

2-way slabs meshed

Optionally you can choose to mesh all 2-way slabs - making a fully meshed
model (both walls and floors) possible.

This is generally not recommended as it will inevitably increase the model size,
(and potentially the time to solve for large models), although it might be
considered that a fully meshed model behaves more "correctly" where slabs
are considered to be part of the lateral load resisting system of the structure.

It is more likely that you will choose to mesh specific floor levels only (e.g.
transfer levels), keeping other levels unmeshed.

Solver Model used for 1st Order Non Linear and 2nd Order Non Linear
These solver models are basically the same as those used for 1st order
analysis with the exception that they will also feature non linear elements.

Any FE meshes in these solver models are formed using the mesh parameters
in place for the most recent run of the chosen analysis (i.e. 1st order non-
linear or 2nd order non-linear).

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis types after changes to either geometry or loading
will prevent you from displaying results for these models.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

Solver Model used for 1st Order Modal
Any FE meshes in this 3D solver model are formed using the mesh parameters
in place for the most recent run of 1st order modal analysis.

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.
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NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

Solver Model used for 2nd Order Buckling
Any FE meshes in this 3D solver model are formed using the mesh parameters
in place for the most recent run of 2nd order buckling analysis.

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

Solver Model used for Grillage Chasedown
In grillage chasedown a 3D sub model is formed for each floor including those
columns and walls that connected to the floor.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.
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Two-way slabs are only meshed in grillage sub-models at those levels where
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they have been set as meshed for 3D Analysis. For all other slabs load
decomposition is carried out prior to the analysis.

Solver Model used for FE Chasedown
FE chasedown is similar to grillage chasedown, with 3D sub models being
formed at each level; the one difference being that in the FE chasedown the
two-way slabs are always meshed.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.
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Solver Model used for Load Decomposition
At each level, (provided you have not checked the Mesh 2-way Slabs in 3D
Analysis option), a solver model is created solely for the purpose of
decomposing slab and panel loads back on to the supporting members. As
these load decomposition models are only used during the pre-analysis stage,
by default they are not retained.

However, if you want to examine the load decomposition model used at a
given level this is possible by editing the level properties prior to analysis and
selecting keep solver model.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.

Refresh Solver Model
The solver model currently displayed is updated to reflect changes that have
occurred in the working solver model since the last analysis. The 2D element
mesh is also updated to reflect the current mesh parameters. Previous
analysis results are also erased for this solver model

Open a solver view
You can either open a new view that displays the solver model, or change
another 2D or 3D view to a solver view. In order to open a solver view, see the
following instructions.
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Open a solver view as a new view
1. To duplicate the existing 2D or 3D view, right-click the tab.

2. In the context menu, select Duplicate view. 

A duplicate of the current view opens.

3. To change the view type of the duplicate, do one of the following:

• Right-click the duplicate tab, and in the context menu, select 
Solver view.

• In the Status bar at the bottom of the window, click Solver View.

Change the existing view to a solver view
1. Open an appropriate 2D or 3D view.

2. To change the view type of the view, do one of the following:

• Right-click the view tab and in the context menu, select Solver
view.

• In the Status bar at the bottom of the window, click Solver View.

See also

View the solver model used for a particular analysis (page 733)

View solver model object properties (page 734)

View the solver model used for a particular analysis
In case you need to view the solver model that Tekla Structural Designer uses
for a particular analysis type, see the following instructions.

1. Open a solver view. (page 732)

2. Right-click anywhere in the solver view.

3. In the context menu, select Solver models.

4. In the submenu, select the desired solver model. 

Tekla Structural Designer opens the selected solver model.

See also

View solver model object properties (page 734)
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View solver model object properties

After opening a solver view (page 732), you can select solver nodes, solver
elements, and supports in order to see their properties in the Properties
window.

• Solver node properties (page 734)

• Solver element properties (page 734)

• Solver element (1D) types (page 735)

• Solver element 2D properties (page 737)

• Support properties (page 2142)

Solver node properties
When in a Solver View, solver node properties are displayed in the Properties
Window as shown below. Only certain of these can be edited; properties that
are dimmed are derived and cannot be changed directly.

Property Description
General
Fx, Fy, Fz The translational degrees of freedom

at the node.
Fx, Fy, Fz The rotational degrees of freedom at

the node.
Coordinate The node location.
P-Delta This property cannot be edited.
Exclude from Diaphragm Check to remove the node from the

diaphragm.
Diaphragm # Specifies the diaphragm number to

which the node is connected.

Solver element properties
When in a Solver View, solver element properties are displayed in the
Properties Window as shown below. Only certain of these can be edited;
properties that are dimmed are derived and cannot be changed directly.

Property Description
General
Active When this is set to False the solver

element is inactive in the analysis.
Only certain member types (braces,
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Property Description
analysis elements) can be made
inactive.

Type The type of the solver element
Fabrication The fabrication type of the solver

element.
Construction The construction type of the solver

element.
Material The solver element material.
Gamma angle Defines the element orientation

about its local x axis.

When gamma = 0, the local z lies in
the plane created by the local x axis
and the global z axis.

Length The solver element length.
Start Releases
Fx, Fy, Fz These define the translational end

releases at end 1.
Mx, My, Mz These define the rotational end

releases at end 1.
End Releases
Fx, Fy, Fz These define the translational end

releases at end 2.
Mx, My, Mz These define the rotational end

releases at end 2.

Solver element (1D) types
Eight different 1D solver element Types are available in Tekla Structural
Designer as follows:

Beam

An element in any material, with user defined area and inertia properties, and
user-definable end releases - used in all solver models for:

• Columns (any material)

• Beams (any material)

• Truss top, bottom and side members (any material)

• Mid-pier concrete wall: wall-beam, and wall-column elements

• Bearing wall: wall-beam elements

• Analysis Elements (any material) with element type: Beam
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Truss

An element in any material, with user-defined cross sectional area, and pinned
ends (releases not being editable) - used in all solver models for:

• Braces (any material) that have not been set as tension or compression
only

• Truss internal members (any material) that have not been set as tension or
compression only

• Bearing wall: wall-column elements

• Analysis Element (any material) with element type: Truss

Truss 1D solver elements are also used in linear solver models only for:

• Braces (any material) that have been set as tension or compression only

• Truss internal members (any material) that have been set as tension or
compression only

Tension only

A pin ended member in any material, with user-defined cross sectional area,
that can only transfer tension. This is a non-linear element which requires
non-linear analysis - hence used in non-linear solver models only for:.

• Braces (any material) that have been set as tension only

• Truss internal members (any material) that have been set as tension only

• Analysis Element (any material) with element type: Tension only

Compression only

A pin ended member in any material, with user-defined cross sectional area,
that can only transfer compression. This is a non-linear element which
requires non-linear analysis -hence used in non-linear solver models only
for:

• Braces (any material) that have been set as compression only

• Truss internal members (any material) that have been set as compression
only

• Analysis Element (any material) with element type: Compression only

Linear axial spring

An element that deflects linearly when an axial force is applied, in accordance
with a user-defined axial spring stiffness. These are specified as:

• Analysis Element (any material) with element type: Linear axial spring
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Linear torsional spring

An element that rotates linearly when a torsion force is applied, in accordance
with a user-defined rotational spring stiffness. These are specified as:

• Analysis Element (any material) with element type: Linear torsional spring

Non-linear axial spring

An element that deflects non-linearly when an axial force is applied, in
accordance with a user-defined axial spring stiffness. These are used in non-
linear solver models only for:

• Analysis Element (any material) with element type: Non-linear axial spring

Non-linear torsional spring

An element that rotates non-linearly when a torsion force is applied, in
accordance with a user-defined rotational spring stiffness. These are used in
non-linear solver models only for:

• Analysis Element (any material) with element type: Non-linear torsional
spring

Solver element 2D properties
When in a Solver View, solver element 2D properties are displayed in the
Properties Window as shown below. None of these properties can be directly
edited in the Solver View.

Property Description
Panel
Type The 2D element type will be Shell or

Semi-rigid depending on the Slab
Type, Decomposition and Diaphragm
Options that have been set.

Thickness The 2D element thickness is derived
from a different property depending
on the slab type:

• Composite Slab; Precast Slab; Slab
on Beams; Flat Slab - Overall Depth

• Steel Deck; Timber Deck - Thickness
Orientation The 2D element orientation in the

solver model follows the rotation
angle defined for the slab item to
which it belongs.
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Property Description
DivideStiffnessBy This property applies to semi-rigid

elements only.

It adjusts the stiffness determined
from the material properties in order
to control semi-rigid diaphragm
flexibility.

CrackedOption yes/no
Nodes
Node 1, Node 2, Node 3 The node numbers associated with

this element.

How concrete beams and columns are represented in
solver models
Solver elements for most members are created directly between the member
insertion points - they do not take into account major and minor snap points,
or any offsets that might have been specified in the member properties. The
exception to this rule is that solver elements for concrete columns and
concrete beams do take into account snap points and offsets - Rigid offsets
(page 738) are then automatically introduced where necessary to connect the
solver elements.

NOTE The rules applied to insertion of solver elements for concrete columns are
different to those that are applied to concrete beams. For concrete structures
this enables you to simplify the grid layout but then employ offsets to position
the members exactly.

Design codes also allow engineers to assume parts of concrete beams and
columns are rigid, leading to more efficient designs. Tekla Structural Designer
uses Rigid zones (page 739) to cater for this where columns and beams are
connected and where beams are connected to other beams. Columns can
have rigid zones when they are the supporting or supported member, but
beams will only have rigid zones when they are the supported member.

Rigid offsets
For concrete beams and columns rigid offsets are automatically applied to the
start and end of solver elements as required to ensure that the solver model is
properly connected.

This will be necessary whenever the 1D solver elements are not co-linear. A
typical example of this occurs when concrete edge beams are aligned to be
flush with the face of the supporting columns, as shown below:
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TIP To see rigid offsets: open a Solver View, and then in Scene Content ensure that
1D Elements> RigidOffsets is selected.

Click the below link to view a couple of examples illustrating the use of rigid
offsets in concrete columns and beams:

• Rigid offsets examples (page 740)

Rigid zones
Unless you have chosen not to apply them, rigid zones are created at concrete
column/beam connections. The proportion of the zone which is modelled as
rigid (the thick black line shown below) is specified as a percentage, the
remaining portion of the rigid zone (the red line inside the rigid zone) remains
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elastic. The proportion of the rigid zone that is rigid is specified in Model
Settings and can vary between 0 - 100%

As shown above, the elastic portion of the rigid zone is aligned with the central
span solver element.

In most situations in order to get an efficient design you would want rigid
zones to be applied. You can however choose not to consider them by
checking the Rigid zones not applied option that is provided in Model
Settings, this will deactivate them throughout the model. You can also
selectively deactivate rigid zones at specific column/beam connections by
unchecking the Apply rigid zones option that is provided in the column
properties under the Design control heading.

• For example, you might choose not to apply them if you encounter
problems with short members and rigid zones which cannot be overcome
by modifying the physical model.

• When rigid zones are not applied, the position of releases in analysis model
is affected, and member start and end points for design are also adjusted.

There is a significant difference between Rigid Zones Not Applied and Rigid
Zones Applied with 0% rigidity. The total elastic length of a member is the
same in the two models, but the position of releases and start/end of design
members will be different.

Rigid zones should not be confused with rigid offsets which are used to ensure
that the analysis model is properly connected, i.e. it is possible to have rigid
offsets in the model even if rigid zones are turned off.

Click the below link to view a couple of examples illustrating the use of rigid
zones in fixed and pin ended beams:

• Rigid zones examples (page 744)

Rigid offsets examples
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Rigid offsets example 1 - concrete column

Consider the two stack concrete column shown below - this has been inserted
with its alignment properties set to bottom left so that the outer column faces
remain flush despite a smaller section being introduced in stack 2.

Since solver elements for concrete columns always take into account any snap
points or offsets, they will always be located at the centroid of each stack -
thus they do not necessarily coincide with the insertion line used to position
the column originally. In this example the centroid position shifts from one
stack to the next which causes a “rigid offset” to be created automatically to
connect the solver elements. Similar rigid offsets would also be created as
required to connect incoming beams into the column centroids.
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TIP To see solver elements, solver nodes and rigid offsets: open a Solver View, and
then in Scene Content select 1D Elements> Geometry & RigidOffset and
Solver Nodes> Geometry.

As a consequence of this method of modeling, you are freer to simplify the
grid layout in order to create the structure more effectively, and then employ
column offsets to position each column exactly, knowing that during analysis
the program automatically assumes the column is located at its centroid as
shown in the plan view.
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Rigid offsets example 2 - concrete beam

Consider the two span concrete beam shown below - this has been inserted
with both major and minor axis offsets applied to span 2 only.

NOTE For concrete beams:

• The minor snap points and offsets are structurally significant and have an
effect on the positioning of the 1D solver elements.

• The major snap points and offsets are not structurally significant.

In the minor direction beam solver elements are always located at the center
of each beam section - as beam widths or minor offsets may vary, this may
result in the introduction of lateral rigid offsets to make the connection
between spans.

In the major direction beam solver elements are always created at the same
level as the insertion line used to position the beam.

Consequently, for this particular example a lateral rigid offset is required to
make the connection between the two spans.
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TIP To see solver elements, solver nodes and rigid offsets: open a Solver View, and
then in Scene Content select 1D Elements> Geometry & RigidOffset and
Solver Nodes> Geometry.

Rigid zones examples
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Rigid zones example 1 - fixed ended beam

Consider the following 2 span beam supported on columns and loaded with a
udl:

Rigid Zones Not Applied

The analysis model is simply constructed from the solver elements with rigid
offsets applied as necessary to connect the beam solver elements to the
column solver elements.
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The resulting beam bending moment diagram is as follows:

Rigid Zones Applied (default 50%)

Rigid Zones are activated via Model Settings, and this is also where the
percentage of rigidity of the zones can be specified. Initially for this example it
will be left at the default of 50%.

The revised solver model is as shown below, note the rigid zones that have
been formed where the columns and beams connect:
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The beam bending moment diagram for the revised model is as shown below.

NOTE The above diagram was generated from a Results View to illustrate that a
“gap” is formed in the diagram where there are rigid zones. It should be noted
that when the same result is displayed in a Load Analysis View the gap is
removed, leaving only the non-rigid length of the member displayed.

We might expect the extra stiffness introduced at the supports to increase the
hogging moments and reduce the sagging moments, however because the
element end forces are now reported at the rigid zone boundaries (rather than
the ends of the solver elements) - in this example the main effect is that the
hogging moment over the central column support is substantially reduced.
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Rigid Zones Applied (100%)

To investigate the effect of the percentage rigidity an additional run is made
with the percentage rigidity increased to 100%. The bending moment diagram
that results is shown below:

As expected the extra stiffness introduced at the supports increases the
hogging moments and reduce the sagging moments in comparison to the run
at 50%.

Rigid Zones Applied (0%)

If the percentage rigidity is reduced to 0% the bending moment is as shown
below:

If this result is compared to the run in which rigid zones were not applied, it is
clear that although the sagging moments are identical, the hogging moments
that are reported are not the same. This is because, although the total elastic
length of a member is the same in the two models, the position of the start
and end of design members is different (being taken at the rigid zone
boundaries when applied).
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Rigid zones example 2 - pin ended beam

When rigid zones are applied to a pin ended member, the end release is
shifted from the end of the solver element to the rigid zone boundary.

To illustrate this effect the model illustrated in Rigid zones example 1 is
modified to have pinned connections introduced at the two remote ends of
the beam.

Rigid Zones Not Applied

The analysis model is constructed from the solver elements with rigid offsets
applied to connect the beam and column solver elements. Releases are
formed at the two remote ends of the beam solver elements.

The beam bending moment diagram is as follows:

Rigid Zones Applied (0%)
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For comparison, rigid zones are then introduced, (with 0% rigidity in order to
keep the total elastic length of the beams the same in both models).

Because the releases are moved to the rigid zone boundaries, this has the
effect of reducing the moments in the beams.

How meshed walls are represented in solver models
Meshed walls have isotropic stiffness properties and resist loads in all
directions.

Wall beam elements

Wall beam elements are inserted into walls primarily to collect slab mesh
nodes and line elements. For meshed walls, they are generated along the top
of the wall and also at intermediate levels where an object (e.g. slab, beam,
truss) is physically connected. A wall beam element is also generated along the
bottom edge of the wall if Generate Support is not selected.

Sloping wall beam elements can be generated by sloping top or bottom edges
or connected sloping slabs.

Where horizontal wall beam elements are required, they are generated across
the entire width of the wall at that level.

Wall beam elements can also be created where certain properties, (e.g.
thickness), differ across panel boundaries.

2D solver elements

For meshed walls the type of 2D solver element used will depend on whether
the wall mesh type is set to Quad only, Tri only, or, Quad dominant.

Modification Factors

Different modification factors applied to meshed walls in the analysis
depending on the Material type that has been applied.

Meshed concrete wall example

Consider the following two stack wall supporting a slab; the wall has different
thickness panels aligned to produce a flush surface on one face.
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1D and 2D solver elements for each wall panel are always located along the
insertion line used to position the wall originally, irrespective of any alignment
offsets that have been specified.

Quad only

In this two stack example, when the Wall Mesh Type is set to Quad only, solver
elements are formed as shown below:
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NOTE To see solver elements, solver nodes and 2D elements: open a Solver View,
and then in Scene Content check 1D Elements> Geometry, 2D Elements>
Geometry and Solver Nodes> Geometry.

Tri only

In this two stack example, when the Wall Mesh Type is set to Tri only, solver
elements are formed as shown below:
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Quad dominant

In this two stack example, when the Wall Mesh Type is set to Quad dominant,
solver elements are formed as shown below:
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Wall openings

When wall openings are introduced, the mesh will adjust to form around the
openings.
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See also: Meshed wall openings analysis model (page 432)

How mid-pier walls are represented in solver models
Wall beam and wall column elements

Wall beam elements are inserted into walls primarily to collect slab mesh
nodes and line elements. For mid-pier walls, they are generated along the top
and bottom edges of the wall and also at intermediate levels where an object
(e.g. slab, beam, truss) is physically connected.

NOTE Only horizontal wall beam elements can be generated in mid-pier walls -
sloping wall beam elements cannot be generated - this will be indicated by an
error in validation.

Each mid-pier wall object also has a single vertical wall column element in the
middle of the wall, from the top to the bottom level.

Modification Factors

The modification factors applied to concrete walls in the analysis depend on
whether they have been specified as meshed or mid-pier.

Analyze models 755 Solver models



Mid-pier wall example

Consider the following two stack mid-pier wall supporting a slab; the wall has
different thickness panels aligned to produce a flush surface on one face.

The wall beam and wall column elements are always located along the
insertion line used to position the wall originally, irrespective of any alignment
offsets that have been specified, so for this example, the elements are formed
as shown below:
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NOTE To see wall beam elements, wall column elements and solver nodes: open a
Solver View, and then in Scene Content select 1 D Elements> Geometry and
Solver Nodes> Geometry.

How shear only walls are represented in solver models
Shear only walls resist in-plane shear only and have no out of plane stiffness
or load bearing resistance.

Background
The ‘shear only wall’ is configured to allow, as the name implies, shear forces
only to be resisted. These arise from frame action in the lateral load resisting
system when subject to lateral loads. The behaviour is typical of unreinforced
masonry walls built into a steel or concrete frame. Under lateral loading the
top of the column adjacent to the wall panel bears on a relatively short length
of wall, creates compression in some width of masonry in the diagonal and
exits the wall panel at the toe of the opposite corner.

A masonry wall panel resists this force couple at each corner primarily as a
shear panel. The failure mechanism either follows a stepped pattern through
the joints or by shear bond along the bed joints. The compression strut
manifests as a failure in diagonal tension across the bed joints in a stepped
fashion. Failure can also occur by local crushing in the top left or bottom right
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of the wall (or vice versa). These failure modes are depicted in the figure
below.

The third failure mode mentioned, crushing in the corners, is very difficult to
model and is believed to have a minor influence on overall behaviour. It is
thought to be self compensating to some extent because when the masonry
begins to crush more length of wall is brought into play.

The diagonal cracking and sliding in the bed joint are the primary effects of the
wall acting as a shear panel. This is the only behaviour that ‘shear only walls’
are able to model.

The compression strut that is also inferred by the diagonal cracking generates
push-pull forces in the frame and complementary axial forces in the beams.
These are incorporated in the Tekla Structural Designer implementation by the
use of special ‘Link Elements’.

The oft used and simplest model of a single brace or pair of braces from
corner to corner of the wall panel can adequately represent the lateral
stiffness of the infilled frame but introduces unwanted axial forces (from
gravity loads), particularly in columns. The Tekla Structural Designer
implementation is a significant improvement on this simplest model and
requires only the determination of the spring stiffness associated with the
shear behaviour.

Crisafulli (2007)1 provides a formula for the stiffness, ks, of the shear spring as,

ks  = γs x Ams x Em/dm x cos2θ

Where,   
Ams  = total area of equivalent

strut based on a width of
strut of the order of ¼ to
⅓ of the diagonal length
of the panel
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Em  = Elastic modulus of the
masonry

dm  = diagonal length of the
wall panel

θ  = the angle of the ‘strut’
with the horizontal

The factor γs is the proportion of total stiffness that is assigned to the spring
whilst the remainder is provided in the Crisafulli model by a pair of ‘masonry
struts’. In Tekla Structural Designer γs is 1.0 i.e. all of the stiffness is provided
by the spring whilst the force effects of the ‘masonry struts’ are replicated by
the special ‘Link Element’.

Other formulations for the spring stiffness are likely to exist in the literature.

In Tekla Structural Designer, the spring is a either a linear or non-linear
uniaxial spring, the former being used when all diaphragms are ‘Rigid’.

One of the consequences of the configuration of ‘shear only walls’ adopted in
Tekla Structural Designer is that no loads can be applied out of plane and no
members can be connected into the main body of the wall panel. Similarly, the
wall panel must be completely surrounded by column and beam members to
ensure transfer of lateral loads. For this type of shear wall the head detail is
assumed to be such that there is no load transfer from the beam above to the
head of the wall.
1 Crisafulli F. J. and Athol J. C., Proposed macro-model for the analysis of infilled
frame structures, Bulletin of the New Zealand Society for Earthquake Engineering,
Vol. 40 No. 2 June 2007.
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Solver model in Tekla Structural Designer
Shear only wall panels are modelled using two axial springs between 'panel
nodes' connected to 'corner nodes' by link elements. How these are
configured differs for interstory panels and the base panel.

NOTE The axial spring and link elements are only shown in the Solver View
used for analysis. The above illustrations are not to scale, the actual u
and v dimensions being 10mm (25/64 in.) and 20mm (50/64in.)

Interstory panels

For each interstory panel, two springs, each with a pair of nodes are created
and connected to the ‘corner’ nodes where the panel connects to the beam-
column node. The connection is made using four special ‘Link Elements’. The
orientation of the axial spring means there is stiffness only in the plane of the
wall, specifically only in the horizontal direction. The Link Elements coordinate
systems and their degrees of freedom are configured such that the panel
operates in-plane and is stable out-of-plane whilst not generating any
untoward moments and forces.

Base panel

Where a base panel exists, a single fixed base is created. Two springs are
created at the same level, and connected to the ‘corner’ nodes where the
panel connects to the beam-column node using two Link Elements. The
orientation of the axial springs means there is stiffness only in the plane of the
wall, specifically only in the horizontal direction. The Link Element coordinate
system and their degrees of freedom are configured such that the panel
operates in-plane and is stable out-of-plane whilst not generating any
untoward moments and forces. Only horizontal reaction is produced at the
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support and this must be distributed manually along the wall footing if
required.

Walls supported on meshed slabs and foundation mats are treated as base
panels with the springs and consequent forces applied to a ‘seeded’ node in
the mesh.

Self weight

The self weight of each panel is automatically calculated by Tekla Structural
Designer and applied to the supporting beam. For a base panel this applied
directly to the wall support. For meshed slabs and foundation mats the wall is
treated as a base panel and the self weight is applied to a ‘seeded’ node in the
mesh.

How bearing walls are represented in solver models
Bearing walls have no in-plane or out-of-plane stiffness and resist vertical load
only.

For bearing walls the alignment (Front, Middle, or Back) specified in the wall
properties is not structurally significant as it has no effect on the positioning of
the solver elements in the solver model.

Consider the two stack bearing wall shown below.
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The solver model for this wall is formed using a series of vertical "wall column"
and horizontal "wall beam" solver elements. The beams have pinned ends and
are placed at the top of the wall spanning between the columns. The next
panel above is pinned to the one below and similarly the lower end of a
column is pinned to a supporting beam. At the lowest level the column is
'fixed' to a pinned support.

Members supported by the wall either (fortuitously) bear directly on one of the
wall columns or on one of the wall beams at the head of the wall. All wall
columns and wall beams in an individual bearing wall are given properties
automatically by Tekla Structural Designer, based on the width of the bearing
wall with which they are associated.

If the bearing wall did not continue to the lowest level, but was instead
supported by a transfer beam, then at the lowest level the wall columns would
have pinned ends and no supports would be introduced.
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For bearing walls that are defined between other vertical column members
e.g. steel columns, the wall columns at the edge of the panel are omitted and
the associated wall beam is connected to the steel column (for example) and
the adjacent wall column - as below.

Wall columns at the edge of the panel are also omitted when it is defined
between concrete walls.

Irrespective of whether the wall spans between other vertical column
members or not - any load applied to the wall beam at the edge of the panel is
shared between the end column and the first internal column. This can result
in some load being `lost' directly into the supports.
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Load transfer in the bearing wall model is not the same as it would be in for
example, a masonry wall. A point load applied at the top of a masonry wall
would result in a distributed load on any beam supporting the masonry wall,
whereas in a bearing wall the supporting beam would be subjected to a pair of
point loads, (or possibly even a single point load if the applied load coincides
exactly with a wall column location).

Self weight of the bearing wall is concentrated in the wall beams so seismic
weight is concentrated at the top of the wall and not split between the floor
above and below.

View tabular solver model data and results
Solver model data views can be used to view tabulated node and element data
and specific results for the different solver models.

The full list of tabular data view types is shown below.

NOTE Some of the view types are only available for specific solver model
types.

• View solver model object properties (page 734)

• View tabular results for support reactions (page 765)

• View tabular results for nodal deflections (page 765)

• View tabular results for solver element end forces (page 766)

• View tabular results for wall lines (page 767)

• View tabular results for result lines (page 767)

• View tabular results for core lines (page 768)

• View the summed mass for modal mass combinations (page 768)

• View the dynamic masses for modal mass combinations (page 769)

• View active masses by node (page 769)

• View modal frequencies and modal masses (page 770)

• View buckling factors (page 770)

View tabulated solver node and element data
To view node coordinate and degrees of freedom, or solver element
properties in tables, see the following instructions.

View tabulated node coordinates and degrees of freedom

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

Analyze models 764 Solver models



2. In the upper list of the Result Type group, select the solver model result
type required.

3. In the View Type list, select Nodes. 

Tekla Structural Designer displays the node coordinates and degrees of
freedom in a table.

View tabulated solver element properties

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the solver model type
required.

3. In the View Type list, select Elements. Tekla Structural Designer
displays solver element properties in a table.

View tabular results for support reactions
In order to view the results for support reactions, or nodal forces, in tables,
see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view support reactions for all solver model types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Nodal Forces.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope.

View tabular results for nodal deflections
To view the deflections of the nodes in your model as tables, see the following
instructions.
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1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view nodal deflections for all solver model types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Nodal Deflections.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope.

View tabular results for solver element end forces
To view the raw results for element end forces in tables, see the following
instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view solver element end forces for all solver model types
except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Element End Forces.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope. 

Tekla Structural Designer displays the raw analysis results of element end
forces. This means that no axial load reductions have been applied.

NOTE The asterisk next to certain element numbers signifies that the
results are actually output at the end of a rigid arm that you have
modeled, rather than at the node itself.
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View tabular results for wall lines
To view the results of the wall lines in your model as tables, see the following
instructions. The result tables include information on such aspects as the
location, position, axial force, and torsion of the wall lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view wall line forces for all solver model types except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Wall Lines.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.

View tabular results for result lines
To view the results of the result lines in your model as tables, see the following
instructions. The result tables include information on such aspects as the
location, position, axial force, and torsion of the result lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired analysis
type. 

NOTE You can view 2D result lines forces for all analysis types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select 2D Result Lines.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.
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View tabular results for core lines
To view the results of the core lines in your model as tables, see the following
instructions.

The result tables include information on such aspects as the location, position,
axial force, and torsion of the wall lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired analysis
type. 

NOTE You can view core line forces for all analysis types except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Core Lines.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.

View tabular results for mode shapes
To view the mode shapes analyzed in a 1st order modal or 2nd order buckling
analysis, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the solver model type. 

NOTE You can only view mode shapes for the following solver model
types:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Mode Shape.

4. In the Loading list at the bottom of the window, select the desired load
case, combination, or envelope.

5. In the lower list of the Result Type group, select the mode.
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View the summed mass for modal mass combinations
In order to view the summed total mass of the modal mass combinations in
your model, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Summed Mass. 

Tekla Structural Designer displays the total mass of the modal mass
combinations in a table.

View the dynamic masses for modal mass combinations
To view the total dynamic masses for modal mass combinations, see the
following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Dynamic Masses. Tekla Structural Designer
displays the total dynamic masses for the modal mass combinations in a
table.

View active masses by node
To view the dynamic active masses of the nodes in your model, see the
following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Active Masses by Node. 

Tekla Structural Designer displays the dynamic active masses of the nodes
in your model.

View total masses by node
To view a table of the total masses of the nodes in your model, see the
following instructions.
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1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Total Masses by Node. 

Tekla Structural Designer displays the dynamic total masses of each node
in your model in a table.

View modal frequencies and modal masses
In order to view the modal frequencies and modal masses of a particular load
combination, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Modal Frequencies.

4. In the Loading list, select the desired load combination. 

Tekla Structural Designer displays the modal frequencies and modal
masses of the selected load combination in a table.

View buckling factors
To view the buckling factors analyzed in the 2nd order buckling analysis in a
table, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of Result Type group, select 2nd Order Buckling.

3. In the View Type list, select Buckling Factors.

4. In the Loading list, select the desired load case or combination.
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7 Design models

From the Design toolbar you can batch design all the members and walls in
your model and (separately) batch design all the slabs. From the same toolbar
you can also check the response of floors to dynamic excitation.

As an alternative to batch design you might choose to selectively design parts
of the model as required.

To get to know about combined analysis and member design and selective
member design, see:

• Design steel members and cast-in-place concrete beams, columns and
walls (page 772)

To design slabs, see

• Design slabs and run punching shear checks (page 789)

If working to either the Eurocode or US headcode, you may also want to
introduce more/less conservatism to the design process by specifying user
defined utilation ratios:

• Apply user defined utilization ratios (page 786)

To check the response of floors to dynamic excitation, see:

• Create and run floor vibration checks (page 806)

NOTE Foundation design topics are covered separately, see Create and design
foundations (page 836)

Certain member types can be designed using Tekla Tedds, see:

• Design timber and precast members using Tekla Tedds (page 805)

See also

Concrete member and slab design handbook (page 1274)

Steel member design handbook (page 1203)

Vibration of floors to DG11 (page 1843)

Vibration of floors to SCI P354 (page 1989)
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7.1 Design steel members and cast-in-place concrete
beams, columns and walls
Before commencing the design you should take a moment to ensure design
options and autodesign settings are set as required. If working to either the
Eurocode , US, or India headcode, you may also want to introduce more/less
conservatism to the design process by specifying user defined utilation ratios.

• Apply and modify design options (page 772)

• Autodesign versus check design (page 773)

• Apply user defined utilization ratios (page 786)

Having set the properties and options as required you can then proceed to
rapidly assess all steel members and/or concrete members/walls in your
model:

• Combined analysis and member design

Alternatively, you may find it more efficient to run an analysis in the first
instance and then:

• Check selected members and walls (page 779)

• Design selected members and walls (page 782)

NOTE Additional considerations may be necessary when designing members and
walls for seismic analysis, see Seismic design methods (page 1199) in the
Seismic analysis and design handbook.

See also

Concrete member and slab design handbook (page 1274)

Steel member design handbook (page 1203)

Design timber and precast members using Tekla Tedds (page 805)

Apply and modify design settings
The design options in Tekla Structural Designer allow you to adjust the way in
which your model is designed.

The different Design Settings (page 2293) sub pages enable you to, for
example:

• set which analysis type is run for the design, (on the Analysis sub page)

• set reinforcement and other parameters for concrete design, (on the
Concrete sub page)

• set the levels at which forces can be ignored, (on the Design Forces sub
page)
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• set which members to design using groups, (on the Design Groups sub
page)

• control how Autodesign settings will be reset after the design, (on the Auto
design sub page)

Modify design settings in the current project

1. On the Design tab, click Settings.

2. Modify the Design Settings (page 2293) according to your needs.

3. After making the changes, do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes as defaults for future projects, click Save...

TIP To revert the analysis options specified to the default design options
of the active settings set, click Load...

Modify design settings defaults for future projects
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Go to the Design Settings (page 2293) page.

4. Select the settings set that you want to modify.

5. Modify the settings according to your needs.

6. To save the changes to the settings set, click OK.

See also

Design Settings (page 2293)

Autodesign versus check design
Before you begin the design process you should select a suitable design mode
for each member in your model. The available design mode options are check
design mode and autodesign mode.
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Each member in your model is set to one of two design modes:

• Check design mode:

You assign the desired section size (for steel members), or section size and
reinforcement (for concrete members). Then, Tekla Structural Designer
determines if the section or reinforcement is sufficient

• Autodesign mode:

For steel members, you select the desired section type. Tekla Structural
Designer then determines a suitable size for the selected section type.

For concrete members, you assign the desired section size.Tekla Structural
Designer then automatically determines a suitable reinforcement
configuration.

TIP To quickly review and update the mode applied to all members in the model,
open a review view and use the Auto/Check Design command to switch
between the two modes.

NOTE The Autodesign setting is only considered when you choose to design multiple
members, as explained below:

• If you choose to run a combined analysis and design (Design Steel,
Design Concrete, Design All); or choose a selective design of multiple
members (Design model, Design plane, Design Selection etc.) - members
will either be designed or checked according to their individual 'auto-
design' setting.

• If you choose a check (Check model, Check plane, Check Selection, Check
Member etc.) - each member will be checked irrespective of its 'auto-
design' setting.

• If you design an individual member (Design Member, Design Wall etc.) -
the member will be designed irrespective of its 'auto-design' setting.

See also

Select whether to design steel, concrete, or all (page 777)

Select between static and gravity design (page 778)

Combined analysis and member design
Run a combined analysis and design in order to rapidly check, or design; every
concrete, steel, or, concrete and steel menber in the model for active gravity,
static, or RSA load combinations.
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Overview
Located on the Design toolbar, three groups of commands can be used for
combined analysis and design as follows:

• Design steel - to design all steel beams and columns in your model.

• Design concrete - to design all concrete beams, columns and walls.

• Design all - to design all steel beams and columns, and concrete beams,
columns and walls.

By selecting a Gravity, Static, or RSA option, you can control which classes of
combination are considered in the analysis and design process.

At the end of the chosen process the Review tab and the review view open so
that you can inspect the results

NOTE As design validation is performed automatically as part combined analysis
and design, there is no requirement to run design validation manually
beforehand.

NOTE In combined analysis and design each member is either designed or checked
according to its individual 'auto-design' setting.

NOTE Additional considerations may be necessary when designing members and
walls for seismic analysis, see Seismic design methods (page 1199) in the
Seismic analysis and design handbook.

Run Design Steel (Gravity)

• On the Design tab, click Design Steel (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all steel beams and columns in the model.

Run Design Steel (Static)

• On the Design tab, click Design Steel (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all steel beams and columns in the model.

Run Design Steel (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 579) (choosing the option to use
Modal Response Spectrum Analysis).
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NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see Seismic design methods
(page 1199) in the Seismic analysis and design handbook.

• On the Design tab, click Design Steel (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all steel beams and columns in the model.

Run Design Concrete (Gravity)

• On the Design tab, click  Design Concrete (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all concrete beams, columns and walls in the model.

Run Design Concrete (Static)

• On the Design tab, Click Design Concrete (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all concrete beams, columns and walls in the model.

Run Design Concrete (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 579) (choosing the option to use
Modal Response Spectrum Analysis).

NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see Seismic design methods
(page 1199) in the Seismic analysis and design handbook.

• On the Design tab, Click Design Concrete (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all concrete beams, columns, and walls in the model.
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Run Design All (Gravity)

• On the Design tab, click  Design All (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all steel and concrete beams and columns and all concrete walls in
the model.

Run Design All (Static)

• On the Design tab, click  Design All (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all steel and concrete beams and columns and all concrete walls in the
model.

Run Design All (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 579) (choosing the option to use
Modal Response Spectrum Analysis).

NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see Seismic design methods
(page 1199) in the Seismic analysis and design handbook.

• On the Design tab, Click Design All (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all steel and concrete beams and columns and all concrete walls in
the model.

Select whether to design steel, concrete, or all
The appropriate design command depends on the materials you have used in
the model. For more information on selecting the appropriate command, see
the following paragraphs.

In simple terms:

• If your model consists of steel members only, you can run the design by
using the Design Steel commands.

• If your model consists of concrete members only, you can run the design
by using the Design Concrete commands.

• If your model consists of a mix of both concrete and steel members, you
can run the design by using the Design All commands.
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TIP For structures that are mostly steel but have a few concrete members: instead
of running Design All, you could run Design Steel (in order to focus on the steel
design) before switching to Design Concrete for the remaining members.

In this way during the steel design phase you are not running grillage and FE
chasedown analyses when they are not required .

For more details on how each command affects the analysis process, see the
following:

Design steel

• Performs a 3D analysis.

• Does not perform grillage chasedown or FE chasedown analysis.

• Designs or checks all steel elements and shear walls.

• Does not design or check concrete beams or columns.

Design concrete

• Performs a 3D analysis and a grillage chasedown analysis.

• May also be required to perform an FE chasedown analysis.

• Designs or checks all concrete beams, columns and shear walls.

• Does not design or check steel elements.

Design all

• Performs a 3D analysis and a grillage chasedown analysis.

• May also be required to perform an FE chasedown analysis.

• Designs or checks all concrete beams, columns and shear walls.

• Designs or checks all steel elements.

See also

Select between static and gravity design (page 778)

Select between static and gravity design
If you are not sure whether you should use the Design (Static) or Design
(Gravity) commands when designing the model, see the following paragraphs
for more details on each option.

Design (Gravity)

Although your final design should consider all combinations, designing for
gravity combinations can be a useful way to rapidly pre-size the members in
the model that are not subjected to lateral loads.
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Designing members for gravity combinations is more common for steel
structures than concrete structures.

The gravity design commands involve the use of first order analysis on a
limited set of design combinations as follows:

• Design Steel (Gravity): rapid gravity sizing of the majority of steel
members

• Design Concrete (Gravity): design of concrete members for gravity
combinations only

• Design All (Gravity): design of all steel and concrete members for gravity
combinations only

Because you may not have created lateral systems at this stage, the column
nodes that are not in a rigid floor diaphragm are, by default, fixed horizontally.
To change the default setting, go to Home --> Settings --> Design Settings -->
General.

Design (Static)

Once initial member sizes have been adequately sized, you should make a
sway sensitivity assessment (ACI/AISC), as this can affect the choice of analysis
type (ACI/AISC) used in the final static design.

The final static design is invoked by selecting the suitable Design (Static)
command:

• Design Steel (Static): full design of all steel members

• Design Concrete (Static): full design of all concrete members

• Design All (Static): full design of all steel and concrete members

For each command above, Tekla Structural Designer performs a 3D analysis
for all active combinations to establish a set of design forces. The 3D analysis
can be either first or second order, depending on the settings specified on the
Analysis page of the Design Settings dialog box.

If the model contains concrete members, Tekla Structural Designer also
performs a Grillage chasedown and potentially FE chasedown analysis to
establish additional sets of design forces.

All members are checked or designed for the appropriate design
requirements. Gravity members are only checked for gravity combinations,
while lateral members are checked for all combinations. Only active
combinations are checked.

See also

Select whether to design steel, concrete, or all (page 777)
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Check selected members and walls
There are various ways to check specific members only, using the results of
the analyses that have already been performed.

Using a selective approach can be a more efficient way to work with large
models.

Check an individual member, wall, or core
• Do one of the following:

To Do this
Check a member/wall from a 2D or 3D view 1. Hover the mouse pointer over the member.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right click and select Check Member >
Static/RSA, or Check Wall > Static/RSA as
required.

Check a member from the Structure Tree 1. In the Members branch locate the member
reference.

2. Right click and select Check Member >
Static/RSA as required.

Check a wall from the Structure Tree 1. In the Walls branch locate the wall
reference.

2. Right click and select Check Wall >
Static/RSA as required.

Check all members in a core from the Structure
Tree

1. In the Cores branch locate the core
reference.

2. Right click and select Check member >
Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check selected members and walls
1. In the active view, select the members to check.

2. Right-click, then in the context menu, select Check Selection > Static/RSA
as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members in a level, slope, or frame
• In the Project Workspace, click Structure tab.
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• In the Structure tree, do one of the following:

To Do this
Check all members in a construction level Right click the required Level and select Check

plane > Static/RSA as required.

Check all members and walls in a frame Right click the required Frame and select Check
plane > Static/RSA as required.

Check all members in a slope Right click the required Slope and select Check
plane > Static/RSA as required.

NOTE These commands use the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members
1. In the Project Workspace, click Structure tab.

2. Right-click the Members tree.

3. In the context menu, select Check members > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all walls
1. In the Project Workspace, click Structure tab.

2. Right-click the Walls tree.

3. In the context menu, select Check walls > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members and walls
1. In the Project Workspace, click Structure tab.

2. Right click on the Structure branch.

3. In the context menu, select Check model > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members of a particular section or type
1. In the Project Workspace, click Structure tab.
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2. In the Members tree, right-click the section type or size you want to
check.

3. In the context menu, select Check members > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members in a group
1. In the Project Workspace, click Groups tab.

2. In the Design tree, right-click the member group you want to check.

3. In the context menu, select Check Group > Static/RSA as required.

NOTE • Check Groups uses the existing analysis results, (even if the
analysis status is 'Out of Date').

It is not available unless the Design Groups option is checked for
the member type in Design Settings.

Check all members and walls in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
check.

3. In the context menu, select Check sub structure > Static/RSA as
required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Design selected members and walls
There are various ways to design specific members only, using the results of
the analyses that have already been performed.

Using a selective design approach can be a more efficient way to work with
large models.

NOTE In all of the selective design methods, each member in the selection
will be individually checked or designed according to its individual
autodesign setting, (while also taking account of any member design
groups that are active). The exception being that if there is only a
single member in the selection it will always be designed irrespective
of its autodesign setting.
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Design an individual member, wall, or core
Design Member designs an individual member (taking into account any
member design groups that are active).

Design Wall designs an individual wall.

Both these commands ignore the auto-design setting of the member/wall. (i.e.
a design is always performed even if the autodesign property is off.)

• Do one of the following:

To Do this
Design a member/wall from a 2D or 3D view 1. Hover the mouse pointer over the member/

wall.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right click and select Design Member >
Static/RSA, or Design Wall > Static/RSA as
required.

Design a member from the Structure Tree 1. In the Members branch locate the member
reference.

2. Right click and select Design Member >
Static/RSA as required.

Design a wall from the Structure Tree 1. In the Walls branch locate the wall
reference.

2. Right click and select Design Wall >
Static/RSA as required.

Design all members in a core from the Structure
Tree

1. In the Cores branch locate the core
reference.

2. Right click and select Design member >
Static/RSA as required.

NOTE The Design Member and Design Wallcommands both use the
existing analysis results, (even if the analysis status is 'Out of Date').

Design selected members and walls
Design Selection performs a check or design of each entity in the current
selection, according to each entity's autodesign setting, (taking into account
any member design groups that are active).

1. In the active view, drag a box to make your selection.

2. Right-click, then in the context menu, select Design Selection >
Static/RSA as required. 

The selected members/walls are designed/checked.

If any members in the selection are in a design group, other members in
the same group are updated and checked as required.
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NOTE The Design Selection command uses the existing analysis results,
(even if the analysis status is 'Out of Date').

Interactively design a concrete member
Interactive design is only available for concrete beams columns and walls. A
dialog opens showing the existing design of the highlighted member for the
currently supplied reinforcement. From here you can interactively modify the
reinforcement and instantly see the result.

1. In the active view, hover the mouse pointer over the concrete member
you want to interactively design.

2. Right click and select Interactive Design > Static/RSA as required. 

The interactive dialog opens from where the member can be designed.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also: Interactive concrete member design (page 1310)

Design all members in a level, slope, or frame
Design plane performs a check or design of each entity in the plane,
according to each entity's autodesign setting, (taking into account any member
design groups that are active).

1. In the Project Workspace, click Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Design all members in a construction level Right click the required Level and select Design

plane > Static/RSA as required.

Design all members and walls in a frame Right click the required Frame and select Design
plane > Static/RSA as required.

Design all members in a slope Right click the required Slope and select Design
plane > Static/RSA as required.

NOTE • The Design plane command uses the existing analysis results,
(even if the analysis status is 'Out of Date').

• It requires at least one member in the selection to be in auto-
design mode.

• If any grouped members are designed and the grouped member
design option is on, all members of the group are considered in
the design even if they are not in the selected level, slope, or
frame.
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Design all members
Design members performs performs a check or design of every member
according to each member's autodesign setting, (taking into account any
member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. Right-click the Members tree.

3. In the context menu, select Design members > Static/RSA as required.

NOTE • Design members uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all walls
Design walls performs performs a check or design of every wall according to
each wall's autodesign setting.

1. In the Project Workspace, click Structure tab.

2. Right-click the Walls tree.

3. In the context menu, select Design walls > Static/RSA as required.

NOTE • Design walls uses the existing analysis results, (even if the analysis
status is 'Out of Date').

• It is not available until at least one wall to be in auto-design mode.

Design all members and walls
Design model performs performs a check or design of every member/wall in
the model according to the individual member/wall autodesign settings,
(taking into account any member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. Right click the Structure branch.

3. In the context menu, select Design model > Static/RSA as required.

NOTE • Design model uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all members of a particular section or type
Design members performs performs a check or design the selected members
according to each member's autodesign setting, (taking into account any
member design groups that are active).
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1. In the Project Workspace, click Structure tab.

2. In the Members tree, right-click the section type or size you want to
design.

3. In the context menu, select Design members > Static/RSA as required.

NOTE • Design members uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all members in a group
Design Group performs performs a check or design of the selected member
group according to the autodesign settings in the group.

1. In the Project Workspace, click Groups tab.

2. In the Design tree, right-click the member group you want to design.

3. In the context menu, select Design Group > Static/RSA as required.

NOTE • Design Group uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available unless the Design Groups option is checked for
the member type in Design Settings.

Design all members and walls in a sub structure
Design sub structure performs performs a check or design of all members/
walls in the selected sub structure according to their individual autodesign
settings, (taking into account any member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
design.

3. In the context menu, select Design sub structure > Static/RSA as
required.

NOTE • Design sub structure uses the existing analysis results, (even if
the analysis status is 'Out of Date').

• It is not available until at least one member in the sub structure is
in auto-design mode.

Apply user defined utilization ratios
By default designs and checks are performed against a utilization ratio (U/R) of
1.0.
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To facilitate design optimization Tekla Structural Designer allows you to specify
user defined U/Rs on an individual member basis (currently for Eurocode, US,
and India head codes only).

NOTE Utilization ratio = actual performance value / maximum allowable
performance value.

Overview of user defined U/R
When applied to the autodesign process user defined U/Rs introduce a
measure of:

• Conservatism - if the value is less than 1.0

• Non conservatism - if the value is greater than 1.0

By not applying user defined U/Rs to the check process, you are still able to
work to the original U/R of 1.0 when working in check mode.

User defined U/Rs can be applied to the following objects:

• Members; steel and concrete columns and beams, composite beams, steel
joists and braces. This includes separate settings for each span/stack/panel
of continuous beams/columns/walls.

• Steel Trusses - includes; Truss member top/bottom, Truss member side/
internal.

• Portal frames (Individual members within Frames are treated as steel
columns and steel beams as appropriate).

• Concrete Walls and Slabs including panels, patches, and punching shear
checks.

• Foundations; Pad Bases (Spread Footings), Strip Bases, Pile Caps, Mat and
Piled Mat Foundation slabs and Piles.

Apply user defined U/R for autodesign only
Applying a value of utilization ratio < 1.0 for autodesign only introduces a
measure of conservatism into the autodesign process but doesn't fail the
member until the ratio default value of 1.0 is exceeded.

1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand Utilization ratio and select Apply (to autodesign), but do not
select Apply to check

3. Enter the Ratio limit as required. 
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NOTE For continuous beams/columns/walls you can apply separate
ratio limits for the individual spans/stacks/panels if required.

When an Autodesign is performed, the design will be incremented to achieve
a utilization ratio less than the ratio limit. When a Check is performed, the
check will pass provided the utilization ratio is less than 1.0.

Apply user defined U/R for autodesign and check
Applying a value of utilization ratio < 1.0 for autodesign and check introduces a
measure of conservatism into the autodesign process and fails the member
when the ratio value that was set is exceeded.

1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand Utilization ratio and select bothApply (to autodesign) and
Apply to check

3. Enter the Ratio limit as required. 

NOTE For continuous beams/columns/walls you can apply separate
ratio limits for the individual spans/stacks/panels if required.

When an Autodesign is performed, the design will be incremented to achieve
a utilization ratio less than the ratio limit. When a Check is performed, the
check will pass provided the utilization ratio is less than the ratio limit.

See also

Review and modify user defined utilization ratios (page 894)

Related video

User defined utilization ratio

Validate the model for design issues
If required, you can manually validate the model for design issues before the
model is submitted for design in order to trap errors that will cause the design
to fail.
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Run design validation

NOTE As design validation is performed automatically as part of all the
combined analysis and design processes, there is no requirement to
run design validation manually beforehand in those cases. You might
however elect to run the validation manually when performing
selective member and wall checking or design.

NOTE Design validation cannot be performed if model validation is
outdated.

• On the Design tab, click Validate. 

Tekla Structural Designer performs the design validation checks. If your
model contains any design validation issues, warning messages appear in
the Status tab of the Project Workspace.

Adjust the conditions considered in design validation

1. On the Home tab, click Model Settings.

2. Go to the Validation page.

3. Select the conditions that you want Tekla Structural Designer to consider
during validation checks.

4. Click OK.

7.2 Design slabs and run punching shear checks
Slab design in Tekla Structural Designer requires a certain amount of user
interaction, (which is why slabs are not considered when any of the combined
analysis and design commands are run).

Slab design can therefore be considered in isolation, the process being able to
be broken down into the following discreet steps:

1. Create slab patches over columns, beams, walls, or panels

2. Design slabs (the slab areas that lie outside the patches)

3. Design patches (the slab areas inside the patches)

4. Create punching shear checks as required

5. Design punching shear (page 803) for the whole model or individually

See also

Apply user defined utilization ratios (page 786)
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Concrete member and slab design handbook (page 1274)

Create and modify patches
You can apply rectangular patches of reinforcement to individual slab items to
act in addition to the background reinforcement. After selecting the patch
type, you can place patches in the model by clicking or boxing around
elements in 2D or 3D views.

Overview of patches and patch types
Patches are used during the design of concrete slabs as a way of managing the
physical and design data. Each patch defines a rectangular area of slab within
which FE analysis results are collected, enabling Tekla Structural Designer to
perform the design process. Design moments are calculated along result
strips, embedded within each patch. Depending on the patch type, a patch can
contain up to 6 result strips, catering for up to 3 strips of reinforcement in
each of two perpendicular directions.

Tekla Structural Designer contains the following patch types:

• Column patch: can be placed at column stack heads

• Beam patch: can be placed along beams

• Wall patch: can be placed along walls

• Panel patch: can be placed at a specified position within the panel
boundary

• not restricted to a centralized position or to existing within one panel

• can be positioned under loads

Patches can be either on the top or the bottom of the slab and may or may not
have reinforcement defined in them. If you have not defined any
reinforcement, Tekla Structural Designer uses the background reinforcement.
If you have defined reinforcement, then for the top/bottom, x/y direction, you
can optionally use the sum of the background + patch reinforcement option, if
the patches are reasonably aligned.

NOTE Any patches may overlap on the plan view. However, during design,
the eventual overlap is ignored.

Create column patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Column.

3. In the Properties window, adjust the patch properties according to your
needs.
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a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.

c. To have the reinforcement automatically designed, select the
Autodesign option.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place a patch over a specific column • Click a column node within the slab.

Tekla Structural Designer creates a patch to
the selected column.

Place multiple patches a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
columns to which you want to create
patches.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the opposite
corner of the box.

d. Release the mouse button.

Tekla Structural Designer creates patches
to all columns entirely within the box.

Create beam patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Beam.

3. In the Properties window, define the required patch width (perpendicular
to the beam span) and the center slab width. 
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Tekla Structural Designer recalculates the two end strips accordingly. The
strips cannot be modified.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place a patch over a specific beam span • Click the required beam span.

Tekla Structural Designer creates a patch
centered on and orientated to the beam
center line.

Place multiple patches a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
beams to which you want to create
patches.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the opposite
corner of the box.

d. Release the mouse button.

Tekla Structural Designer creates patches
to all beams entirely within the box.

Create wall patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Wall.

3. In the Properties window, adjust the patch properties according to your
needs.

a. To specify the layer of the patch, select the desired option in Surface.

b. To have the reinforcement automatically designed, select the
Autodesign option.

c. Define the required patch width perpendicular to the wall.
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NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Create a patch along a specific wall a. In the Properties window, set Create

Mode to Single Patch Along Wall.

b. Click the required wall.

Tekla Structural Designer creates a patch,
centered on and orientated to the wall
center line.

Place an internal patch and two end patches
along a specific wall

a. In the Properties window, set Create
Mode to Internal With End Patches.

b. Click the required wall.

Tekla Structural Designer creates an
internal patch and two end patches,
centered and orientated to the wall center
line.

Place an end patch at one end of a specific wall: a. In the Properties window, set Create
Mode to End Patch at Wall End.

b. Click near the required end of the wall.

Tekla Structural Designer creates a patch
at the end of the wall that is closest to the
point that you clicked.

Place an internal patch part way along a specific
wall

a. In the Properties window, set Create
Mode to Internal Patch.

b. Click to define the start point of the patch
along the required wall.

c. Click to define the end point of the patch
along the required wall.

Tekla Structural Designer creates a patch
between the selected points.

Create patches along multiple walls a. In the Properties window, set Create
Mode to Single Patch Along Wall or
Internal With End Patches.

b. Move the mouse pointer to one corner of
an imaginary box that will encompass the
walls to which you want to create patches.

c. Hold down the left mouse button.

d. Drag the mouse pointer to the opposite
corner of the box.

Design models 793 Design slabs and run punching shear checks



e. Release the mouse button.

Tekla Structural Designer creates patches
to all walls entirely within the box.

Create panel patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Panel.

3. In the Properties window, adjust the patch properties according to your
needs.

a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.

c. To have the reinforcement automatically designed, select the
Autodesign option.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place the patch at the centroid of a specific panel a. In the Properties window, ensure that the

Create Patch at Centroid option is
selected.

b. Click anywhere within the required panel.

Tekla Structural Designer creates a patch
at the panel centroid.

Place the patch elsewhere within a specific panel a. In the Properties window, ensure that the
Create Patch at Centroid option is
cleared.

b. Still in the Properties window, do one of
the following:

• To define the patch by its corners,
select the Define corner points
option.

• To define the patch by its center, clear
the Define corner points option.
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c. In the panel, click the points that define the
patch.

Tekla Structural Designer creates a patch
at the selected position.

Create multiple centroid patches a. In the Properties window, ensure that the
Create Patch at Centroid option is
selected.

b. Move the mouse pointer to one corner of
an imaginary box that will encompass the
panels to which you want to create
patches.

c. Hold down the left mouse button.

d. Drag the mouse pointer to the opposite
corner of the box.

e. Release the mouse button.

Tekla Structural Designer creates patches
to the centroids of all panels entirely within
the box.

Modify patch properties
1. Hover the mouse pointer over the patch that you want to modify. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, use the arrow keys to navigate to the patch
name and press Enter.

3. In the Properties window, modify the patch properties according to your
needs.

a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.

c. To have the reinforcement automatically designed, select the
Autodesign option.

d. To specify the directions of the reinforcement that you want to
design, select the appropriate option in Consider Strips.

e. To specify the type and direction of the reinforcement that you want
to design, select the appropriate option in Reinforcement.

f. To specify the required width for each strip, type a value in the Width
field.

g. To specify whether each strip should be designed for the average or
maximum design force, select the appropriate option in Design
Force.
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Resize patches
1. Hover the mouse pointer over the patch that you want to resize. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, use the arrow keys to navigate to the patch
name and press Enter.

3. Hover the mouse pointer over the patch edge or corner that you want to
adjust. 

The Select Entity tooltip appears.

4. In the Select Entity tooltip, use the arrow keys to navigate to the edge or
corner node and press Enter.

5. Hold down the left mouse button and drag to move the edge or corner.

Design and check slabs
After creating any necessary patches, you can determine the top and bottom
reinforcement requirements in all the slab item areas that lie outside of the
patch areas. Because patch areas are excluded from slab item design, you
should create patches before designing slab items.

NOTE Slabs can only be designed/checked after slab design moments have been
established from a suitable analysis. If valid analysis results do not yet exist
you would need to create them (by, for example, clicking Analyze All (Static)
from the Analyze toolbar).

Check an individual slab item
• Do one of the following:

To Do this
Check an individual slab from a 2D or 3D view 1. Hover the mouse pointer over the slab.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Check Panel.

Check an individual slab from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Slabs branch, locate the slab
reference.

3. Right click and select Check Panel.
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NOTE Check Panel uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

• Concrete slab design (page 1354)

Check all slab items
1. In the Project Workspace, click Structure tab.

2. Right click on the Structure branch.

3. In the context menu, select Check model slabs as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

• Concrete slab design (page 1354)

Check all slab items on a single floor
• Do one of the following:

To Do this
Check all slabs in a floor from a 2D view 1. Open a 2D view of the floor that you plan to

design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select
Check Slabs.

Tekla Structural Designer checks the
reinforcement of all slab items on the floor.

Check all slabs in a floor from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Levels branch, right click the required
Level and select Check plane slabs.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

• Concrete slab design (page 1354)

Check all slab items in a sub structure
1. In the Project Workspace, click Structure tab.
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2. In the Sub Structures tree, right-click the sub structure containing the
slabs you want to check.

3. In the context menu, select Check sub structure slabs. 

Tekla Structural Designer checks the reinforcement of all slab items on
the floor.

See also:

• Concrete slab design (page 1354)

Design an individual slab item
• Do one of the following:

To Do this
Design an individual slab from a 2D or 3D view 1. Hover the mouse pointer over the slab.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Design Member.

Design an individual slab from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Slabs branch, locate the slab
reference.

3. Right click and select Design panel.

NOTE Design panel uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

• Concrete slab design (page 1354)

Design all slab items

• On the Design tab, click Design Slabs. 

Tekla Structural Designer designs or checks all slab items in the model
according to their autodesign settings.

See also:

• Concrete slab design (page 1354)

Design all slab items on a single floor
• Do one of the following:

To Do this
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Design all slabs in a floor from 2D view 1. Open a 2D view of the floor that you plan to
design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select
Design Slabs.

Design all slabs in a floor from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Levels branch, right click the required
Level and select Design plane slabs.

See also:

• Concrete slab design (page 1354)

Design all slab items in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure containing the
slabs you want to design.

3. In the context menu, select Design sub structure slabs. 

Tekla Structural Designer designs all slab items in the sub structure,
possibly selecting new reinforcement for them.

See also:

• Concrete slab design (page 1354)

Design and check patches
When that the slab item designs resulting from the slab or mat design process
are satisfactory, you can then proceed to design patches. You should design
slab items before designing patches, as the additional patch reinforcement
requirement takes account of the existing level of reinforcement provided by
the slab items.

NOTE For each strip within each patch, Tekla Structural Designer determines the
area of the required steel (A s,reqd) and the area of the provided steel (A s,prov).
The A s,prov calculation always considers the patch reinforcement, but if
necessary and allowed, you can also include additional background
reinforcement in the calculation.

Check an individual patch
1. Hover the mouse pointer over the patch that you want to check.

2. Right-click the patch.
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3. In the context menu that appears, select Check Slab Patch. 

Tekla Structural Designer displays the results of the check in a new dialog.

Check all patches in the model
• The same command can be accessed in two ways:

• In a 3D Structural View, right click on the background and choose Check
Patches from the context menu.

• In the Project Workspace Structure tree, right-click on the Structure
branch and choose Check model patches (command) (page 2239) from
the context menu.

Tekla Structural Designer checks the reinforcement of all patches in the
model.

Check all patches on a single floor
1. Open a 2D view of the floor that you plan to design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select Check Patches. 

Tekla Structural Designer checks the reinforcement of all patches on the
floor.

Design an individual patch
1. Hover the mouse pointer over the patch that you want to design.

2. Right-click the patch.

3. In the context menu that appears, select Design Slab Patch. Tekla
Structural Designer displays the results of the design in a new dialog.

The results of the design are displayed in a new dialog.

Design or check all patches in the model
• The same command can be accessed in three ways:

• On the Design tab, click  Design Patches

• In a 3D Structural View, right click on the background and choose
Design Patches from the context menu.
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• In the Project Workspace Structure tree, right-click on the Structure
branch and choose Design model patches (command) (page 2250) from
the context menu.

Tekla Structural Designer designs or checks all patches in the model
according to their autodesign settings.

Design all patches on a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select Design Patches. 

Tekla Structural Designer designs all patches on the floor, possibly
selecting new reinforcement for them.

Create punching shear checks
You can apply punching shear checks to flat slabs and foundation mats by
using the Add Check command on the Design tab.

Punching check locations
You can apply punching shear checks as follows:

In flat slabs:

• Concrete columns supporting a flat slab with and without drops

• Concrete columns supported by a flat slab

• Concrete columns through a flat slab with or without drops

• Concrete walls supporting a flat slab

• Concrete walls supported by a flat slab

• Concrete walls through a flat slab

• Steel columns supported by a flat slab

• Point loads at either face of a flat slab

In foundation mats:

• Concrete columns supported by a foundation mat

• Concrete walls supported by a foundation mat

• Steel columns supported by a foundation mat

• Point loads on a foundation mat

• individual piles supporting a foundation mat
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Punching check axis orientation
• When you apply a punching shear check to a column, the check Y and Z

axes are automatically orientated to align with the column major and
minor axes. The two axis systems are locked together, so if the column is
rotated, the punching check axes also rotate.

• When you apply a punching shear check to a point load, you must
manually define the punching shear check Z axis orientation. You can do
this in the Properties window by specifying the point load orientation in
relation to the global Y axis.

NOTE Point load properties (including point load orientation, point load
breadth, and point load depth) are not applicable when you apply
a check to a column.

Create punching check items

NOTE Punching check items can generally be created in 2D and 3D
Structural or Review Views, apart from checks around walls which can
only be created in Structural Views, but not currently in Review Views.

Punching check items are the objects to which the punching shear information
and calculations are attached. To create punching check items, do the
following:

1. On the Design tab, click Add Check.

2. Go to the Properties window-

3. Ensure that the location for the slab tension reinforcement is correct.

4. Adjust the remaining properties according to your needs. 

NOTE The point load properties are only relevant if you are adding the
check to a point load position.

5. To create the check, do one of the following:

• Hover the mouse pointer over the desired column node, wall node, or
point load. When the Pick Punching Check Location tooltip appears,
click to add the punching shear at the selected node.

• Hold down the left mouse button and drag a box to add punching
check items to all potential check locations within the box.
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Specify stud rail reinforcement

RESTRICTION Stud rail reinforcement is only available for Eurocode and ACI
head codes.

You can specify an orthogonal or circular arrangement of stud
rails, and then check or design it as required.

1. Create a punching check item as instructed above.

2. Go to the Properties window.

3. Select the Use reinforcement option.

4. Select whether you want to autodesign the reinforcement.

5. Adjust the remaining reinforcement properties according to your needs.

Modify the properties of existing punching check items
1. Right-click the punching check item.

2. In the context menu, select Edit Reinforcement.

Design and check punching shear

Overview of the Design Punching Shear command
The Design Punching Shear command calculates an applied load on the slab,
accounting for the difference in column/wall axial load and bending. In
addition, the command checks the slab shear stresses, accounting for the
reinforcement present (background and column/general patches).

Provided that you are using the Eurocode or ACI head code, you can also
design the punching reinforcement as an orthogonal or circular arrangement
of stud rails at the following locations:

In flat slabs:

• Concrete columns supporting a flat slab without drops

• Concrete columns supported by a flat slab

• Concrete columns through a flat slab without drops

• Point loads at either face of a flat slab

In foundation mats:

• Concrete columns supported by a foundation mat

• Point loads on a foundation mat
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Column head drops and the presence of openings within a certain distance of
the punching shear boundary are taken into account in the punching shear
calculations.

Where punching checks are closely spaced and the perimeters overlap the
checks are beyond scope.

NOTE • Since the checks are dependent on using the correct levels of slab
reinforcement (typically provided by patch reinforcement), do not check
punching before designing the patches.

• View punching checks applied to walls with caution. Their applicability to
long walls is particularly questionable, as the check does not consider the
potential for stress concentrations at the ends of the wall.

Check punching shear for an individual punching check item
• Do one of the following:

To Do this
Check an individual punching check item from a
2D or 3D view

1. Hover the mouse pointer over the punching
check.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Check Punching Shear.

Check an individual punching check item from the
Structure Tree

1. In the Project Workspace, click Structure
tab.

2. In the Slabs> Punching Checks branch,
locate the check reference.

3. Right click and select Check Punching
Shear.

Check all punching check items
1. In the Project Workspace, click Structure tab

2. Right click the Structure branch and select Check Punching Shear

Check all punching shear check items on a floor
1. In the Project Workspace, click Structure tab.

2. In the Levels branch, right click the required Level and select Check
Punching Shear.

Design all punching check items
• Do one of the following:
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To Do this
Design all punching check items from the ribbon

1. On the Design tab, click Design
Punching Shear.

Design all punching check items from the
Structure Tree

1. In the Project Workspace, click Structure
tab.

2. Right click the Structure branch and select
Design Punching Shear.

Tekla Structural Designer performs punching shear checks for all punching
check items in the model based on their individual auto-design setting. If
the punching check item does not connect to a flat slab, punching shear is
flagged as beyond scope.

Design all punching shear check items on a floor
1. In the Project Workspace, click Structure tab.

2. In the Levels branch, right click the required Level and select Design
Punching Shear.

Design an individual punching check item
• Do one of the following:

To Do this
Design an individual punching check item from a
2D or 3D view

1. Hover the mouse pointer over the punching
check.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Design Punching Shear.

Design an individual punching check item from
the Structure Tree

1. In the Project Workspace, click Structure
tab.

2. In the Slabs> Punching Checks branch,
locate the check reference.

3. Right click and select Design Punching
Shear.

Tekla Structural Designer displays the results of the design in a new dialog
box.
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7.3 Design timber and precast members using Tekla
Tedds
Timber and precast members that have been modelled and analysed in Tekla
Structural Designer can then be designed in Tekla Tedds if a licence is
available.

For further information, see:

• Timber member design handbook (page 1564)

• Precast member design handbook (page 1527)

7.4 Create and run floor vibration checks
To establish the response of the floor to dynamic excitation you can apply a
floor vibration checks. These are applied over a user-defined rectangular or
polygon shaped slab area by using the Add Check command in the Floor
Vibration group. In order to create the check, you need to identify a primary
beam, secondary beam and critical slab item. In addition, you must specify
associated data in order to perform the floor vibration calculation.

See also

Create and modify floor vibration checks (page 806)

Run floor vibration checks (page 809)

Create and modify floor vibration checks
To establish the response of the floor to dynamic excitation you can apply a
floor vibration checks. These are applied over a user-defined rectangular or
polygon shaped slab area by using the Add Check command in the Floor
Vibration group. In order to create the check, you need to identify a primary
beam, secondary beam and critical slab item. In addition, you must specify
associated data in order to perform the floor vibration calculation.

Vibration of Floors to SCI P354 Handbook; Vibration of Floors to DG11
Handbook; Vibration of Floors to SCI P354 Example

Create floor vibration check items
Floor vibration check items are the objects to which the floor vibration check
information and calculations are attached.
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NOTE Floor vibration check items can only be created in 2D Views.

1. On the Design tab, click Add Check.

2. Go to the Properties window.

3. In FloorPlateDefinition, select whether you want to create a rectangular
or polygonal slab.

a. If you selected the Rectangular option, adjust the local x angle to
define the angle at which the rectangle will be drawn, if necessary.

4. To create a check area, in the model, do one of the following depending
on the slab shape:

• Rectangular: Click once to define the first corner of the rectangle, and
again to define the opposite corner.

• Polygon: Click to define the corners of the polygon. In order to close
the shape, click the first point again.

5. Click to define the primary beam. 

The primary beam properties appear in the Properties window.

6. Click to define the secondary beam. 

The secondary beam properties appear in the Properties window.

7. Click to define the critical slab item. 

NOTE If the critical slab item is a composite slab, Tekla Structural
Designer automatically defines the slab item properties. In other
cases, you need to input the properties yourself.

The critical slab item properties appear in the Properties window.

8. In the Properties window, review and adjust the check item properties.

9. Click anywhere in the model to create the check item. 

Tekla Structural Designer highlights the primary beam, secondary beam
and critical slab item of the current check item.

10. Create new checks, or press Esc to finish creating floor vibration check
items.
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Create floor vibration checks that consider two or three adjoining
spans
Creating two-span or three-span floor vibration checks is almost identical to
that required for single spans. When creating the check item, do the following:

• In the Properties window, set the Adjoining Spans property of a primary
and/or secondary beam to Two span or Three span.

NOTE If the Two span option is selected, note the following:

• When you hover the mouse pointer to select the beam, only
beams of two or more spans are available.

• When a beam is highlighted, note that the beam directly under the
mouse pointer will become the critical beam, and the second
highlighted beam will become the adjoining beam.

• The second highlighted beam (the adjoining beam) will be the
beam closest to the mouse pointer position. That's why, in order to
highlight the adjoining beam at a particular end of the critical
beam, you can move the mouse pointer toward that end of the
critical beam.

NOTE If the Three span option is selected, note the following:

• When you hover the mouse pointer to select the beam, only
beams of three or more spans are available to be highlighted,

• When a beam is highlighted, note that the beam directly under the
mouse pointer will become the critical beam, and the second
highlighted beam will become the adjoining beam.

• The second highlighted beam (the adjoining beam) will be the
beam closest to the mouse pointer position. That's why, in order to
highlight the adjoining beam at a particular end of the critical
beam, you can move the mouse pointer toward that end of the
critical beam.

Modify the properties of existing floor vibration check items
1. In Scene Content, ensure that Floor Vibration Checks have been turned

on.

2. Hover the mouse pointer over the slab area where the floor vibration
check item lies. 

The Select Entity tooltip appears.

3. Navigate to the floor vibration check item name by using the arrow keys,
and click Enter. 

The floor vibration check properties appear in the Properties window.
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4. In the Properties window, adjust the check item properties according to
your needs.

Run floor vibration checks

Vibration of Floors to SCI P354 Handbook; Vibration of Floors to DG11
Handbook; Vibration of Floors to SCI P354 Example

Check vibration for all floor vibration check items
• On the Design tab, click Check Floor Vibration. 

Tekla Structural Designer performs floor vibration checks for all floor
vibration check items in the model.

Check floor vibration for an individual floor vibration check item
1. Hover the mouse pointer over the floor vibration check item that you

want to check. 

The Select Entity tooltip appears.

2. If necessary, navigate to the floor vibration check item name by using the
arrow keys.

3. Right-click the check item.

4. In the context menu, select Check Floor Vibration. Tekla Structural
Designer displays the results of the design in a new dialog box.

7.5 Check steel connections
• Check simple connection resistance (page 809)

• Design connections (page 819)

• Export connections to another application for design (page 825)

• SidePlate connections (page 825)

Check simple connection resistance
Tekla Structural Designer provides a quick and simple way of checking the
shear capacity of simple beam connections, and the axial capacity of brace
connections.
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Overview
Tekla Structural Designer has a Connection Resistance database for simple
beams and braces. For simple beams the database contains pre-defined types
with pre-defined resistances (page 1009) to Eurocode and US head codes.

You can add user-defined connection types (page 1012) and user-defined
resistances (page 1012) to the database for any head code, for steel and cold
formed materials. Once defined, these can then be used across all projects.

Each resistance value in the database has an 'active' flag which must be 'on'
for the resistance to be considered. (Simple beams and braces in the model
that have no active resistances are not checked.)

Having configured the active resisistances in the database as required, the
checks are then performed in the model as follows:

• For each simple beam the active shear resistances for each available
connection type are read from the database.

• These resistances are compared to the maximum shear force at the
connection (determined from a 3D analysis)

• The connection configuration is optimized accordingly for each connection
type.

• A similar process is then followed for each brace, by comparing the active
axial resistances to the maximum applied axial force.

Results can be displayed in a review data table, or output via a connection
resistance report.

Specify 'active' connection resistances (Eurocodes)
Since only active resistances are considered in the check, you can deactivate
resistances for those connection configurations you do not want to be
considered.

The active status of resistances can be set on or off directly (by ticking or
unticking a checkbox in the Active column) but a quicker way of changing the
active status is with the Activate/Deactivate dialog.

1. In the Connection Resistance dialog (page 2399), click Activate/
Deactivate...

2. Set the filters in the dialog, then set either Activate or Deactivate, as
required.

3. Click Apply if you want to change further Active settings, or click Apply &
Close to finish.

Example: From the pre-defined connection types you want only Fin Plates to
be active, only for S355 Universal Beams, and only those Fin Plates with 1 line
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of bolts. There are a number of ways to achieve this using Activate/
Deactivate but one way would be as follows:

1. Click Activate/Deactivate...

2. Deactivate everything - select ‘All’ in each of the Activate/Deactivate filters,
select ‘Deactivate matching resistance values’, then Apply

3. To activate only Fin Plates for S355 Universal Beams with 1 line of bolts

a. select Fin Plate in the Connection Type filter,

b. select S355 in the Grade filter,

c. select 1 in the # Bolt Lines filter,

d. select Universal Beams in the Section List filter,

e. select ‘All’ in the other filters (# Notches, # Bolt Rows),

f. select ‘Activate matching resistance values’,

g. click Apply & Close
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Following step 3, you will find ticks in the Active column only for Fin Plates with
S355 Universal Beams with 1 line of bolts, but note these changes are not saved
to the database, and do not become active in Reports or in Tabular Data, until
clicking OK in the main dialog.

Specify 'active' connection resistances (US)
Since only active resistances are considered in the check, you can deactivate
resistances for those connection configurations you do not want to be
considered.

The active status of resistances can be set on or off directly (by ticking or
unticking a checkbox in the Active column) but a quicker way of changing the
active status is with the Activate/Deactivate dialog.

1. In the Connection Resistance dialog (page 2399), click Activate/
Deactivate...

2. Set the filters in the dialog, then set either Activate or Deactivate, as
required.

3. Click Apply if you want to change further Active settings, or click Apply &
Close to finish.

Example: From the pre-defined connection types you want only Single Plates
to be active, for W & M beams of ‘Any’ Fy, only for 3/4 in bolts, but for all
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defined thicknesses of plate. There are a number of ways to achieve this using
Activate/Deactivate but one way would be as follows:

1. Click Activate/Deactivate...

2. Deactivate everything - select ‘All’ in each of the Activate/Deactivate filters,
select ‘Deactivate matching resistance values’, then Apply

3. To activate only Single Plates for W & M Beams of ‘Any’ Fy, with 3/4 in
diameter bolts and all plate thickness

a. select Single Plate in the Connection Type filter,

b. select Any in the Fy filter, select 3/4 in in the Bolt Diameter filter,

c. select W & M in the Section List filter,

d. select ‘All’ in the other filters (Coping, # Bolt Lines, # Bolt Rows,
Thickness),

e. select ‘Activate matching resistance values’,

f. click Apply & Close
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Following step 3, you will find ticks in the Active column only for Single Plates,
with Any Fy selected, and W & M Beams with 3/4 in diameter bolts, but note
these changes are not saved to the database, and do not become active in Reports
or in Tabular Data, until clicking OK in the main dialog.

Run resistance checks
Provided you have an appropriate set of 'active' resistances, the checks are
performed automatically, using the current analysis results - you can proceed
directly to a review of the check results.

• If necessary, analyse the model to generate an up-to-date set of analysis
results,

• Review the check results, see: Display connection resistance checks in a
review data table below.
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The connection optimization process
Tekla Structural Designer carries out an optimization process to find the first
passing Active resistance based on the name of the Connection Type and the
number of Bolt Lines and Bolt Rows assigned to that name.

For Eurocodes, separate check results are reported for each 'active'
connection type and each notch variation.

For US codes, separate check results are reported for each 'active' connection
type and each coping variation.

Example: to Eurocode, a Fin Plate for an S355 UB 457x152x52 with 1 and then
2 lines of bolts has pre-defined resistances as shown below. All resistances are
indicated as Active.
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If an S355 UB 457x152x52 in a model is found to have an applied major shear
force of 250 kN then the connection resistance check will report that a Fin
Plate with 1 bolt line and 4 bolt rows (resistance 263 kN) is adequate.

If the applied major shear force is 300 kN then the connection resistance
check will report that a Fin Plate with 1 bolt line and 5 bolt rows (resistance
352 kN) is adequate.
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If the applied major shear force is 355 kN then the connection resistance
check will report that a Fin Plate with 2 bolt lines and 5 bolt rows (resistance
450 kN) is adequate.

For each of the applied major shear forces given above only the first passing
resistance is reported, by looping through the Active bolt rows for 1 bolt line
followed, where necessary, by looping through the Active bolt rows for 2 bolt
lines.

If Tekla Structural Designer gets to the end of these loops and still doesn’t find
a passing resistance then it reports the last resistance found and a fail status
e.g. if the applied major shear force is 455 kN then the connection resistance
check will report that a Fin Plate with 2 bolt lines and 5 bolt rows (resistance
450 kN) fails.

Now suppose that the UB 457x152x52 with 1 bolt line and 5 bolt rows
(resistance 352 kN) is not Active. The first shear check above (applied force 250
kN) would be unchanged but the second check (applied force 300 kN) would
now report that a Fin Plate with 2 bolt lines and 4 bolt rows (resistance 349 kN)
is adequate. This illustrates the interplay of the resistance Active status with
the optimization process.

Display connection resistance checks in a review data table
To create a tabular connection resistance summary:

1. If necessary, change the view regime (page 280) to a Review View.

2. On the Review ribbon tab, click Tabular Data. 

A Review Data tab opens on the ribbon and a Review Data View is
displayed.

3. On the Review Data ribbon tab, in the list in the View Type group, select
Connection Resistance.

4. In the Material Type group, select the material (either Steel, or Cold
Formed).

The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

5. In the Characteristic group, select the required characteristic (either
Beams, or Braces).
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6. In the Construction group, select Composite, Non-composite, or both.

7. In the Fabrication group, select the required fabrication types.

A resistance check is provided for the filtered selection for every section where
a resistance has been specified in the database.

NOTE A resistance check is not provided for beams that do not have simple
connections.

NOTE If there is uplift in any load combination then the maximum uplift
shear force will be displayed, with a warning that connection
resistance is not checked for uplift condition.

NOTE Each time you re-analyse the building, if you have the Connection
Resistance data table open you must close and then re-open it to
update the results.

Create and display a connection resistance report

1. On the Report tab, use the droplist to select the existing Connection
Resistance report.

2. Click Model Report...

3. Review the report structure and adjust as required.
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4. Click OK to save the report.

5. Click Show Report

Related video
Predefined connection resistance database for Eurocode and AISC

Design connections

NOTE These topics relate to the design of connections using either Tekla Connection
Designer, or IDEA StatiCa; they do not cover checking of simple connection
resistance (page 809), which is a separate topic.

Overview
Before connections can be designed in Tekla Structural Designer valid
connection objects have to be created in the model. This is achieved by
running Update connections from the Project Workspace. This applies a set
of rules (page 822) to create and organize connections into the following
types:

• Base Plate Connections

• Beam to Beam Moment Connections

• Beam to Beam Simple Connections

• Beam to Column Moment Connections

• Beam to Column Simple Connections

• Column Splice Connections

• General Connections

Valid connections are then displayed in the scene views and are also listed in
the Connections tree.
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Provided a licence of Tekla Connection Designer is available, some of these
can then be designed or exported to Tekla Connection Designer. If you have a
licence of IDEA StatiCa you can also export some types to that software for
design.

Type Connection Design Options
Base Plate Connections • Design Connection

• Export to Tekla Connection
Designer

Beam to Beam Moment Connections • Design Connection (Eurocode and
BS Head Codes only)

• Export to Tekla Connection
Designer (Eurocode and BS Head
Codes only)

• Export to IDEA StatiCa
Beam to Beam Simple Connections • Export to IDEA StatiCa
Beam to Column Moment
Connections

• Design Connection (Eurocode and
BS Head Codes only)

• Export to Tekla Connection
Designer (Eurocode and BS Head
Codes only)

• Export to IDEA StatiCa
Beam to Column Simple Connections • Export to IDEA StatiCa
Column Splice • Design Connection (Eurocode and

BS Head Codes only)

• Export to Tekla Connection
Designer (Eurocode and BS Head
Codes only)
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Type Connection Design Options
• Export to IDEA StatiCa

General Connections • Export to IDEA StatiCa

See also

• Recommended workflows for specific connection types (page 822)

• Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 824)

Update connections
To create connection objects for the first time, or to recreate connections after
changes to the model:

1. Click on the Connections tree in the Project Workspace

2. Right-click the Connections branch.

3. Choose Update Connections from the context menu. 

This applies a set of rules (page 822) to determine all valid steel
connections in the model. The resulting connections are listed in the
Connections Tree and are also shown by bounding boxes in the Scene
Views.

NOTE If the model has been changed so that new connections exist,
these are not created automatically; you are required to update
connections as required.

Design connections
Design using Tekla Connection Designer is initiated in one of two ways:

1. From the Project Workspace:

• Expand the appropriate branch in the Connections tree

• Right click on the required connection reference and choose Design
connection from the context menu.

2. From a scene view:

• Right click on the connection object and choose Design connection
from the context menu.

See also

Recommended workflows for specific connection types (page 822)

Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 824)
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Export connections to another application for design (page 825)

Steel connection formation rules
The following rules relate to connection formation in Tekla Structural
Designer.

1. beam to column connection

a. beam connections to the column base are ignored

b. column must be a symmetric section

c. more then 1 beam attached to the same column face prevents any
connection

d. a continuous beam connected to the column flanges prevents any
connection

e. a beam with a fully fixed or moment end condition connected to the
column web prevents any connection

2. beam to beam - for a particular construction point (node)

a. any column at the node prevents the connection

b. only two beam ends can be connected, a 3rd beam at the same node
prevents any connection.

c. connections cannot be formed at beam internal nodes

d. the beams being connected must be symmetric and of the same
section size

e. connected beam ends cannot be free or pinned

f. top flange haunches prevent the connection

g. beam ends being connected must have no end plates specified, or
both have the same end plate

h. beam ends being connected must have no bottom haunch specified,
or both have the same bottom haunch

3. any non-steel member at the node prevents any connection

4. braces are ignored in the procedure

Recommended workflows for specific connection types

NOTE Connection design requires a Tekla Connection Designer licence.

Portal frame connections

Although it is possible to design portal frame connections in Tekla Structural
Designer - i.e. Base Plate, Eaves, and Apex moment connections; it should be
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noted that the design forces used for connection design within Tekla
Structural Designer are those from its own elastic analysis and may not be
appropriate.

A more correct approach would be to derive the connection forces from a
Tekla Portal Frame Designer plastic analysis. To do this you would need to
export the portal frame to Tekla Portal Frame Designer and then design both
the frame and its connections within Tekla Portal Frame Designer.

Note that it in addition to the connection forces (usually) being fundamentally
different between Tekla Portal Frame Designer and Tekla Structural Designer
there are other potential differences also:

• for eaves connections - in Tekla Portal Frame Designer the connection
design forces are taken at the column face (rather than the rafter/column
intersection),

• for column bases - in Tekla Portal Frame Designer they can be pinned at
ULS but % fixity can be taken for SLS, while Tekla Structural Designer will
always give an analysis moment for % fixity regardless of ULS/SLS and this
moment would be designed for.

NOTE Connection design via Tekla Portal Frame Designer requires both a Tekla
Portal Frame Designer and a Tekla Connection Designer licence.

Base plate connections (not in portal frames)

Base plate connections can be edited directly in Tekla Structural Designer.

Provided they are in elastically analyzed frames they can be also be designed
using the design forces obtained from Tekla Structural Designer.

NOTE The analysis results used for the connection design follow the selection (1st
order or 2nd order) made on the Analysis page of the Tekla Structural
Designer Design Options.

Base plate connections can be exported to Tekla Connection Designer if you
require, in which case if you edit the connection geometry while in Tekla
Connection Designer you should use the “Return Connection to Tekla
Structural Designer” command (under the “Connection” menu) to return the
edited connection data back to Tekla Structural Designer.

Other connections (not in portal frames)

The recommended workflow for connection types other than Base Plate
Connections is:

• Select the connection(s) to be designed and export to Tekla Connection
Designer always.

• Design in Tekla Connection Designer and print the reports.

• While the “Return Connection to Tekla Structural Designer” command can
be used, this does not currently return all connection data to Tekla
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Structural Designer (principally the data derived from the connected
elements). Hence, if changes are made in Tekla Structural Designer and the
analysis and/ or design processes run and the connection exported again
for checking, the engineer should review the connection data and may
need to re-enter some of the settings previously made.

NOTE While the “Return Connection to Tekla Structural Designer” command can be
used In Tekla Connection Designer, this does not currently return all
connection data to Tekla Structural Designer (principally the data derived
from the connected elements). Hence, if changes are made in Tekla Structural
Designer and the analysis and/or design processes are re-run; if the
connection is exported again for checking, the engineer would need to review
the connection data as it may be necessary to re-enter some of the settings
previously made.

See also

Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 824)

Limitations when using Tekla Connection Designer with Tekla
Structural Designer

General

• The analysis results used for the connection design follow the selection (1st
order or 2nd order) made on the Analysis page of the Tekla Structural
Designer Design Options.

• It is always necessary to export all connection types to Tekla Connection
Designer for reporting purposes.

Base plate connections

• Base Plate Connections only deal with major axis shear - only one value for
shear is available in the Combinations grid in Tekla Connection Designer.
(This is a limitation in the Green Book also.)

Moment connections

• While the “Return Connection to TSD” command can be used, this does not
currently return all connection data to Tekla Structural Designer (principally
the data derived from the connected elements). Hence, if changes are
made in Tekla Structural Designer and the analysis and/ or design
processes run and the connection exported again for checking, the
engineer should review the connection data and may need to re-enter
some of the settings previously made.

• For Beam to Column moment connections, column forces are exported
and displayed on the "Column" tab of the Combinations page.
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• When designed to Eurocodes, there is a reduction factor for column
web in compression to allow for coincident forces in the column itself
i.e. moment and axial force. This is called kwc and in most cases is 1.0
i.e. no reduction. But where the stress due to the column forces is high
(> 0.7 fy) then kwc is < 1.0. See Clause 6.2.6.2 (2).

• These forces are NOT populated by the TCD integration link and must
be entered manually by the engineer.

Simple connections

• It is not currently possible to transfer Simple Connections from Tekla
Structural Designer to Tekla Connection Designer.

Hollow section connections

• It is not currently possible to transfer Simple Connections from Tekla
Structural Designer to Tekla Connection Designer.

Column splice connections

• Splice connections with significant ‘real’ moments (other than eccentricity
moments) cannot currently be transferred from Tekla Structural Designer
to Tekla Connection Designer.

NOTE Significent 'real' moments being greater than the Ignore forces below
(page 2323) limit in Design Settings.

Export connections to another application for design
Click the following links to find out more about exporting specific connections
into another application for design:

• Recommended workflow for TCD connection types (page 822)

• Export to Tekla Connection Designer (page 318)

• Export to Tekla Portal Frame Designer (page 319)

• Export to IDEA StatiCa Connection Design (page 344)

SidePlate connections
SidePlates are a US proprietary connection system that can be applied in Tekla
Structural Designer but are considered separately to other connection types.

Click the following links to find out more:

• For background to their usage in Tekla Structural Designer, see

SidePlate connections theory (page 826)
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• For modeling instructions, see

Create SidePlate connections (page 833)

SidePlate connections theory

Overview of SidePlate connections

SidePlate® is a type of moment connection for connecting I or HSS section
beams to I, HSS, built up box or built up WF (cruciform) section columns.

SidePlates are welded to the column section in the fabrication shop. Plates or
angles are similarly welded to beam ends.

The column and beam units are transferred to site where the columns are
erected and the beams are lifted into place and either bolted or welded to the
columns. SidePlate connections are used on buildings of 1 to 30 stories tall.

Within the structure, the beam end is held in position by SidePlates. The net
result is moment connection with a very stiff section of column and a stiffened
beam end.

SidePlate connection types can be:

• Non-Seismic moment connections

• A beam/column moment connection anywhere in the structure

• Seismic moment connections

• A seismic beam/column moment connection within any of the following
seismic force resisting systems Ordinary Moment Frame (OMF),
Intermediate Moment Frame (IMF) or Special Moment Frame (SMF).

SidePlate connections work for all WF and HSS sections in the AISC steel book,
and for all UB and UKB sections. However it is worth noting the SidePlate
datafile may NOT have a full set of values for all 'clear spans' or all %Mps for all
these sections; if this is the case then no SidePlate connection can be applied
at the joint.

Tekla Structural Designer can perform an initial sizing for the SidePlate
connection, but the final detailed design of the SidePlate connection has to be
undertaken in SidePlate® software.

Permitted SidePlate connections in Tekla Structural Designer

RESTRICTION In Tekla Structural Designer, sideplate connections are
currently only permitted for US Customary sections and not
for metric sections.
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Column

Side Plate Permitted Connections

 

Tekla
Structu

ral
Designe
r Status

Non-Seismic
Moment

Connections

Seismic Moment
Connections

Beam Beam
I HSS I HSS

WF Flange yes yes yes yes Modele
d

Analyze
d

Designe
d

Web yes yes Warning Warning

HSS Flange yes yes yes yes Modele
d

Analyze
d

Designe
d

Web yes yes yes yes

Plated
box

Flange yes yes yes yes Modele
d

Analyze
d

Not
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Side Plate Permitted Connections
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Not
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Not
Designe
d
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SidePlate workflow in Tekla Structural Designer

A brief description of the SidePlate workflow in Tekla Structural Designer is
given here with more detail available in the subsequent topics.

• Modeling: You define SidePlate connections by changing properties of the
relevant beam or beams.

NOTE The Update Connections process used for defining other
connection types is not applicable for SidePlate.

Connection objects are not created for any point on a steel column
where any of the beams attached at that point have a SidePlate
connection.

• Visualisation: Each connection is initially shown in the graphics as a simple
box. After sizing has been performed it is shown as a pair of plates.

• Validation: Some preliminary checks are carried out in Model validation
(page 512), (additional checks are done subsequently in Initial sizing and
Analysis model adjustment). Any problems do not stop the analysis and
design process but mean the relevant beam and or column will not benefit
from the enhanced properties.

• Initial sizing: The initial SidePlate dimensions are determined during the
Design Steel (Static & RSA) and Design All (Static & RSA) processes, using
data provided by SidePlate and incorporated into Tekla Structural
Designer.

NOTE After the initial sizing process, any changes to loading, (individual
loads, load cases and combinations), will not trigger change control
for the SidePlates, i.e. they will keep those initial sizes. You can
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reset the status using Review mode (page 892) if you decide that
the sizing process needs to be run again.

• Analysis model adjustment: Where valid SidePlate dimensions exist, the
analysis model passed to the solver is adjusted to reflect the increased
stiffness of the SidePlate connections. This is done during stand-alone
analysis as well as Design.

• Steel member design: If SidePlate connections exist, they are taken into
account in the member design for steel beams and columns. The changes
affect both static and seismic design.

• Review: The SidePlate connection status can be seen easily in a Review
view (page 892), and tooltips give more information.

• Reports: A “SidePlate Connection Report” can be generated.

• Final design: SidePlate developers can use the Tekla Structural Designer
API in order to fully design a SidePlate connection defined and initially
sized in Tekla Structural Designer

NOTE Design of SidePlate connections is beyond scope for both Tekla
Connection Designer and export to the IDEA StatiCa Connection
Design program.

SidePlate 'joint' and 'connection' terminology

NOTE • A SidePlate joint exists at a column node and consists of 1 to 4 valid
connections.

• Every suitable beam framing into the column node can create a SidePlate
connection.

A SidePlate connection exists at End 1 and / or End 2 of a steel beam where
Apply SidePlate Connection is true. It will still exist even if other data makes
it invalid. The connection position is the reference point at the relevant end of
the beam.

All connections sharing the same position on a column are considered as a
single SidePlate Joint. No attempt is made to merge separate SidePlate joints
even where the relevant levels are close.

Various checks are performed on each connection and each joint, and the
analysis model is only be adjusted if they all pass. In particular, if the depths of
two SidePlate joints overlap then a warning is generated and the analysis
model is not be adjusted.
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SidePlate validation

SidePlate validation is performed during model validation.

If warnings are issued, this will typically result in the Connection Status being
set to "Not Applied" in the Properties window.

NOTE Until the “Not Applied” Connection Status is resolved, the connection will not
be considered for the initial sizing process.

Initial sizing of the SidePlates

The initial SidePlate dimensions are determined during the Design Steel (Static
& RSA) and Design All (Static & RSA) processes.

The initial sizing process is only performed where the Sizing Status is “Not
Performed” and the Connection Status is not “Not Applied”.

For each connection that is considered, a number of checks are performed in
order to verify that SidePlate can be applied. If any of the checks fail, the
Connection Status is set to "Not Applied".

NOTE After the initial sizing process, any changes to loading, (individual
loads, load cases and combinations), will not trigger change control for
the SidePlates, i.e. they will keep those initial sizes. You can reset the
status using Review mode if you decide that the sizing process needs
to be run again.

Analysis model adjustment

Analysis model adjustment is only performed for valid SidePlate connections
that have successfully completed the initial sizing process, i.e. where the Sizing
Status is not “Not Performed”.

Both the geometry and the properties of the Solver model are dependent
upon the size of the SidePlate connection.
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For the beam

• B2 – a new 1d element on the beam, with stiffened beam properties.

• B1 – a rigid offset on the end of B2

• B3 – normal bare beam properties

For the Column

• C1 – a rigid offset at the top of the column 1d element

• C2 – normal column properties

Design/Analysis processes and recommended workflows

Tekla Structural Designer can automatically size members throughout a
structure – we call this Autodesign. The process is complex and involves
sophisticated initial sizing, multiple analysis runs with repeated design cycles.
The interweaving of initial sizing for SidePlate connections into the Autodesign
routines is a highly complex process and for the first implementation remains
beyond scope. Instead you have to manually reduce section sizes to take
advantage of the SidePlate advantages.

Any beams and columns not affected by SidePlate connections can be
AutoDesigned as normal during this process.

The following examples show the results for 2 different workflows where each
step is carried out in the exact order specified and assuming that there are no
model issues.
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Recommended Workflow

• Full model created including loadcases and combinations - AutoDesign left
checked for all columns, beams etc.

• Check “Apply SidePlate Connection” for selected beams - also set Utilization
Ratio to 1.25 for those beams.

• Set Utilization Ratio to 1.1 for selected columns

• Run 1st order linear analysis

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because not Static Design

• Adjust Solver Model will not be performed because no Connections will
have Sizing Status not “Not Performed”.

• Run Gravity Design Steel

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because not Static Design

• Adjust Solver Model will not be performed because no connections will
have Sizing Status not “Not Performed”.

• Reset Utilization Ratio to 1.0 for relevant beams and columns

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed for all connections

• Adjust Solver Model will be performed for subsequent analysis

• Manually adjust section sizes to achieve further size savings with SidePlate
connections

• SidePlate Connection Status will be reset where necessary

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed only where section sizes have been
changed

• Adjust Solver Model will be performed

At the end of this workflow, any subsequent stand-alone analysis will also use
the adjusted solver model.

Other Workflow

• Full model created including loadcases and combinations - AutoDesign left
checked for all columns, beams etc.

• Check “Apply SidePlate Connection” for selected beams.
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• Run Static Design Steel

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because Connection Status
will be set to Warning

• Adjust Solver Model will not be performed because no Connections will
have Sizing Status not “Not Performed”.

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed for all Connections

• Adjust Solver Model will be performed for subsequent analysis

Effects of SidePlate on steel member design

Any beams and columns not affected by SidePlate connections can be
AutoDesigned as normal.

Beams and columns affected by SidePlate connections cannot be
AutoDesigned.

Where SidePlate connections exist, changes are required for both static and
seismic member design.

For static design

• Beam and column buckling lengths are affected.

• Beam and column design checks are adjusted so that they are applied
outside the physical length of any SidePlate connection

For seismic design

• OMF frames - no change

• IMF frames – various changes

• SMF frames – various changes

Create SidePlate connections
To add SidePlate connections:

1. Select the steel beam(s) to which you want to apply SidePlate connections.

2. In the Properties window, expand the SidePlate heading and select Apply
SidePlate connection at one, or both ends as required.

3. In the Properties window, select the SidePlate Connection type that is
appropriate to the SFRS type that has been specified, or, if not in a seismic
frame, set the type as SidePlate MF (moment frame). 

Each connection is initially shown in the graphics as a simple box. After
sizing has been performed it will be shown as a pair of plates.
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See also

Beam properties - SidePlate (page 834)

Modify SidePlates (page 892)

Beam properties - SidePlate

For steel beams the Properties window has a SidePlate group within which an 
Apply SidePlate Connection check box can be selected for End 1 and End 2 of
the beam.

When selected the following properties are displayed:

• Seismic Provision - depending on the head code, one of:

• Non-Seismic (ACI/AISC only)

• Seismic OMF

• Seismic IMF (ACI/AISC only)

• Seismic SMF

• Field Connection, (user option if Connection Type is Seismic SMF, otherwise
fixed to Bolted)

• Bolted (default)

• Welded

• Datafile look up criteria (readonly)

• Use %Mp (if Connection Type is Non-Seismic)

• Use clear span (otherwise)

• Connection Status - one of

• Unknown (default)

• Pass

• Warning

• Not Applied

• Failure Reason - one of

• Unknown (default)

• Datafile Look Up Failed

• Geometric Compatibility

• Beam Element too short for Rigid Offset

• Column Element too short for Rigid Offset

• Sizing Status - one of

• Not Performed (default)
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• Initial

• Final

• SidePlate size and other data set during the Initial Sizing Process, (Invisible
if Sizing Status is Not Performed)

• DimA – the outstand distance required for the SidePlate connection

• DimB – the depth required for the SidePlate connection

• Tsp – the thickness of the SidePlates

• DimH – the length of the SidePlates

• %Mp- if calculated during initial sizing

• Clear span - if calculated during initial sizing

NOTE These properties are for the start and end of the whole beam. Where
a steel beam is multi-span it is not possible to apply SidePlate
connections to the internal points.
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8 Create and design foundations

You can create and design both isolated and mat foundations using the
Foundations toolbar.

8.1 Create isolated foundations
Tekla Structural Designer allows you to create pad base, strip base and pile
cap isolated foundations. Before you can create a pile cap the Pile Catalogue
must contain at least one pile type.

Click the links below to find out more:

• Create pad bases and strip bases (page 836)

• Create a pile type catalogue (page 838)

• Create pile caps (page 838)

See also

Design isolated foundations (page 840)

Foundation design handbook (page 1580)

Create pad bases and strip bases
You can create both pad base columns and strip base walls in your model. Pad
bases and strip bases are both isolated foundations. The difference is that pad
bases support a column, while strip bases support a wall.

Create pad base columns
A pad base is an isolated foundation that supports a single column. To place
pad bases in your model, see the following instructions.
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Create a pad base under a specific column

1. On the Foundations tab, click  Pad Base Column.

2. In the Properties window, adjust the pad base properties according to
your needs.

3. Click anywhere in the wall under which you want to place the pad base. 

Tekla Structural Designer places a pad base under the selected column.

Create multiple pad base columns

1. On the Foundations tab, click  Pad Base Column.

2. In the Properties window, adjust the pad base properties according to
your needs.

3. Move the mouse pointer to a corner of an imaginary box that will
encompass the columns under which you want to place pad bases.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places pad bases under all columns within the
box.

Create strip base walls
A strip base is an isolated foundation that supports a single wall. To place strip
bases in your model, see the following instructions.

Create a strip base under a specific wall

1. On the Foundations tab, click  Strip Base Wall.

2. In the Properties window, adjust the strip base properties according to
your needs.

3. Click anywhere in the wall under which you want to place the strip base. 

Tekla Structural Designer places a strip base under the selected wall.

Create multiple strip bases

1. On the Foundations tab, click  Strip Base Wall.

2. In the Properties window, adjust the strip base properties according to
your needs.
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3. Move the mouse pointer to a corner of an imaginary box that will
encompass the walls under which you want to place strip bases.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places strip bases under all walls within the box.

Create a pile type catalogue
In order to use pile foundations in your model, you must create a catalogue of
pile types. To do so, see the following instructions.

1. On the Foundations tab, click  Catalogue. 

The Pile Catalogue opens.

2. To create a new pile type, click Add... 

The Edit Pile Type dialog box opens.

3. On the different pages of the Edit Pile Type dialog box, define the
properties of the new pile type.

4. Click OK. 

Tekla Structural Designer creates the pile type.

5. Repeat steps 2–4 as necessary. 

TIP In the Pile Catalogue, you can also modify or delete the existing pile
types:

• To modify a pile type, select the pile type and click Edit...

• To delete a pile type, select the pile and click Delete.

Create pile caps
A pile cap is an isolated piled foundation that supports a single column.

NOTE Before you can create pile caps, the Pile Catalogue must contain at least one
pile type.

To create pile types, see Create a pile type catalogue (page 838).
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Create pile cap under a specific column

1. On the Foundations tab, click  Pile Cap Column.

2. In the Properties window, adjust the pile cap properties according to your
needs.

3. Click anywhere in the column under which you want to place the pile cap. 

Tekla Structural Designer places a pile cap under the selected column.

Create multiple pile caps

1. On the Foundations tab, click  Pile Cap Column.

2. In the Properties window, adjust the pile cap properties according to your
needs.

3. Move the mouse pointer to a corner of an imaginary box that will
encompass the columns under which you want to place pile caps.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places pile caps under all columns within the
box.

Create a user-defined pile arrangement
If necessary, you can modify the pile arrangement in a pile cap and create
user-defined pile arrangements. Creating user-defined pile arrangements can
be particularly useful when you want to check a pile cap where the pile
positions on site do not exactly match the originally specified arrangement.

Do the following:

1. In the model, select the pile cap that you want to modify.

2. In the Properties window, go to Pile arrangement.

3. Click the ... button next to Pile arrangement. 

The Pile Arrangement dialog box opens.

4. In the Pile Arrangement dialog box, select the User Defined
Arrangement option. 

NOTE If the Auto-design piles option is selected in the Properties
window, Tekla Structural Designer asks you whether you want to
turn off the option. Click Yes.
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5. Specify the pile arrangement properties according to your needs:

a. Select the pile type.

b. Define the pile length and width.

c. If necessary, define the eccentricity of the pile cap centroid from the
centroid of the column it supports in X and Y directions.

TIP To add more piles into the arrangement, click Add.

6. If necessary, in the table below the properties, adjust the position of piles
by defining the eccentricity of the pile centroid from the pile cap centroid.

7. Click OK. 

Tekla Structural Designer creates the pale arrangement that you defined.

8.2 Design isolated foundations
You can design isolated foundations (pad bases, strip bases, and pile caps)
either in a batch or individually.

NOTE Before bases or pile caps can be designed, you have to run an analysis
to establish the design forces. You can run either the Analyze All
(Static) command or one of the combined analysis and design
commands (such as Design All).

Design or check all pad bases and strip bases

1. On the Foundations tab, click  Design Pad Bases. 

Tekla Structural Designer designs or checks all pad bases and strip bases
in the model according to their individual auto-design settings. In the
process, Tekla Structural Designer considers all active static and RSA
combinations .

Design or check all pile caps

1. On the Foundations tab, click  Design Pile Caps. 

Tekla Structural Designer designs or checks all pile caps in the model
according to their individual auto-design settings. In the process, Tekla
Structural Designer considers all active static and RSA combinations .
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Check an individual isolated foundation
1. Hover the mouse pointer over the foundation that you want to check. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, navigate to the foundation name by using the
arrow keys.

3. Right-click the foundation.

4. In the context menu, select  Check Member. Tekla Structural Designer
displays the results of the check in a new dialog box.

Design an individual isolated foundation
1. Hover the mouse pointer over the foundation that you want to design. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, navigate to the foundation name by using the
arrow keys.

3. Right-click the foundation.

4. In the context menu, select Design Member. Tekla Structural Designer
displays the results of the design in a new dialog box.

See also

Pad base design workflow (page 1581)

Pile cap design workflow (page 1587)

Apply user defined utilization ratios (page 786)

8.3 Create mat foundations
Mat foundations support multiple columns and walls. Mats can be ground
bearing, supported on piles, or both. Tekla Structural Designer contains he
following commands for creating mat foundations:

• Minimum Area: creates an overhanging polygonal mat to minimize the
required area

• Rectangular: creates an overhanging rectangular mat either at a specified
angle to the global axes or at the smallest rectangular area aligned to the
global axes

• Strip: creates a constant width mat along a series of points that do not
have to be on the same line
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• Area: creates an overhanging polygonal mat when you identify points
around its outline

• Bays: creates a mat with no overhang when you click within a closed grid
area

• Pile: creates individual piles underneath existing mats

• Pile Array: creates an array of piles underneath existing mats

Click the links below to find out more:

• Create mats (page 842)

• Place piles and pile arrays in mats (page 844)

See also

Create slab or mat openings (page 455)

Add overhangs to existing slab or mat edges (page 457)

Create column drops (page 459)

Split and join slabs and mats (page 462)

Design isolated foundations (page 840)

Foundation design handbook (page 1580)

Create mats
In Tekla Structural Designer, you can create various types of mat foundations,
including minimum area mats, rectangular mats, strip mats, area mats, and
mats with bays. For detailed information on creating mats, see the following
instructions.

Create a minimum area or rectangular mat

1. On the Foundations tab, click either  Minimum Area or 
Rectangular.

2. In the Properties window, adjust the mat properties according to your
needs.

3. Do one of the following:

To Do this
Create a mat in a 3D view a. Click anywhere on the first column or wall

to be supported.

b. Click to define the other necessary
columns and walls.

c. To create the mat, click the last column or
wall again or press Enter.
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Create a mat in a 2D view a. Do one of the following:

1. To select multiple walls, hold down
the left mouse button and drag a
box from right to left to encompass
the walls under which you want to
create the mat.

2. To select multiple columns, hold
down the left mouse button and
drag a box from left to right to
encompass the columns under
which you want to create the mat.

3. To add individual columns and walls,
click each member individually.

b. To create the mat, click one of the
previously selected members or press
Enter.

Create a strip mat
1. Open a 2D view at the base level where you want to place the strip mat.

2. On the Foundations tab, click  Strip.

3. In the Properties window, adjust the strip width and other mat properties
according to your needs.

4. In the model, click the start point of the strip.

5. Click to define the other necessary points.

6. To create the strip, click the last point again or press Enter.

Create an area mat
Either click once again on the last point, or press <Enter> to create the mat.

1. On the Foundations tab, click  Area.

2. In the Properties window, adjust the mat properties according to your
needs.

3. In the model, click a construction point at a corner of the area.

4. Click to define the remaining corner points.

5. To create the mat, click the last point again or press Enter.

Create a mat within bays
1. On the Foundations tab, click Bays.

2. In the Properties window, adjust the mat properties according to your
needs.
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3. To select a bay, do one of the following:

• Click within an enclosed area defined by grid lines.

• Hold down the left mouse button and drag a box around the required
area.

Place piles and pile arrays in mats
A piled mat can either be supported on piles alone, or by a combination of
ground springs and piles. Piles can either be placed individually at specific
locations within the mat, or an array of equally spaced piles can be created. To
place piles in mats and define their inclination, see the following instructions.

Specify if a piled mat is ground bearing
1. Click the desired mat.

2. In the Properties window, go to Soil Parameters.

3. Do one of the following:

To Description
Create a mat supported on piles alone • Clear the Use Ground Bearing Springs

option.

Create a mat supported by a combination of
ground spring and piles

• Ensure that the Use Ground Bearing
Springs option is selected.

Place an individual pile in a mat

1. On the Foundations tab, click  Pile.

2. Click the mat in which you want to place the pile.

3. Click the pile position in the selected mat. 

Tekla Structural Designer places the pile in the selected position.

Place a pile array in a mat

1. On the Foundations tab, click  Pile Array.

2. In the Properties window, adjust the pile type, spacing, and pile direction
according to your needs. 

TIP To preview the array, hover the mouse pointer over a mat.

3. Click an individual mat, or hold down the left mouse button and drag a
box around multiple mats.
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4. If necessary, add further mats to the selection by clicking or boxing them.

5. To create the mat, click the last mat you selected again. 

Tekla Structural Designer places the piles in the mat.

6. Repeat steps 2–4 to place more piles or press Esc to finish placing piles.

Specify the pile direction of an inclined pile

1. On the Foundations tab, click  Pile.

2. In the Properties window, do one of the following:

To Do this
Specify the direction as a vector a. Adjust the X and Y components of the

vector.

TIP If you do not want the pile to slope
in the global X or Y direction, leave
the appropriate value as 0.

b. Type a negative value in the Z component
field.

For example:

To create an inclined pile of 45 degrees in
positive X, define the components as follows: X =
1.0, Y = 0.0, Z = -1.0.

To create an inclined pile of 45 degrees in
negative Y, define the components as follows: X
= 0.0, Y = 0.5, Z = -1.0

Specify the direction as an angular measurement
NOTE You can only specify the direction as an

angular measurement before the pile is
first positioned.

a. Select the Direction by Angles option.

b. Define the inclination of the pile from the
vertical.

c. Define the azimuth (the horizontal angle
measured clocwise about the positive
global Z direction.

d. If necessary, define the rotation about the
longitudinal axis of the pile.

NOTE Since the pile is only checked for
axial capacity, the rotation angle
has no effect on the pile checks.
However, you can define the
rotation to vary how Tekla
Structural Designer displays the
moment and shear force values
of the pile.

For example:
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To create an inclined pile of 45 degrees in
positive X, define the angles as follows:
inclination = 45 degrees, azimuth = 90
degrees

To create an inclined pile of 30 degrees in
negative Y, define the angles as follows:
inclination = 30 degrees, azimuth =
0.0 degrees

8.4 Design mat foundations

Design or check all mats in the model

1. On the Foundations tab, click  Design Mats. 

Tekla Structural Designer designs or checks all mats in the model
according to their auto design settings.

Check all mats in a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the scene view.

3. In the context menu, select  Check Slabs. 

Tekla Structural Designer checks all slab items (including mat foundations)
in the floor regardless of their autodesign settings.

Design all mats in a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the scene view.

3. In the context menu, select Design Slabs. Tekla Structural Designer
designs all slab items (including mat foundations) in the floor regardless
of their autodesign settings.

Check an individual mat
1. Hover the mouse pointer over the mat that you want to check.

2. Right-click the mat.
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3. In the context menu that appears, select  Check Panel. 

Tekla Structural Designer displays the results of the check in a new dialog
box.

Design an individual mat

1. Hover the mouse pointer over the mat that you want to design.

2. Right-click the mat.

3. In the context menu that appears, select Design Member. 

Tekla Structural Designer displays the results of the design in a new dialog
box.

See also

Mat foundation design workflow (US customary units) (page 1608)

Mat foundation design workflow (metric units) (page 1594)

Piled mat foundation design workflow (US customary units) (page 1622)

Piled mat foundation design workflow (metric units) (page 1633)

Apply user defined utilization ratios (page 786)

Create and design foundations 847 Design mat foundations



9 Review models

By selecting the Review view regime, you are able to graphically display the
design status of members, slabs, foundations and connections. In the same
view you can interrogate or modify a variety of model parameters and
properties.

In addition, by clicking  Tabular Data from the toolbar, you can open a
Review Data view, from where you can display tables of Sway/Drift Results,
Design Summaries and Material Lists.

TIP The Review view opens automatically at the end of the structure design process,

but you can access it at any time by clicking the  icon in the Status bar

9.1 Review designs
By graphically reviewing the design status and ratios you are able to quickly
assess the design efficiency.

Click the links below to find out more:

• Set the design type to review (page 848)

• Review member design (page 849)

• Review foundation and pile design (page 850)

• Review slab and mat design (page 851)

• Design review filters (page 853)
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Set the design type to review
You can set a specific design type to focus on when reviewing the member,
foundation, or slab designs.

The available design type options are Static, RSA, and Combined (i.e. Static and
RSA together).

To set the design type, do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Type list, select the desired design type.

• Static

• RSA

• Combined

See also

Review member design (page 849)

Review foundation and pile design (page 850)

Review slab and mat design (page 851)

Design review filters (page 853)

Review member design

Review member design status
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Design group, click Status. 

Color codes display the design status of each member.

Tekla Structural Designer uses the following classifications:

Status Description
Pass The member has passed all design

checks.
Fail The member has failed one or more

design checks.
Warning Although the member has passed the

design checks, one or more warnings
have been issued. Review the
warnings before deciding if you need
to take further action.
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Status Description
Error The member currently cannot be

designed because an error has
occurred.

Beyond Scope The member cannot be designed
because its design is beyond the
scope of Tekla Structural Designer.

Unknown The member has not been designed.

Review member design ratios
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Design group, click Ratio. 

Color codes display the design ratio of each member. N/A is assigned to
members that have no ratio or whose ration is smaller than the lowest
band. N/A also indicates members that either are beyond scope or have
yet to be designed.

Review member depth ratios
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Design group, click Depth Ratio. 

All steel and concrete beams are color coded to indicate their span to
depth utilization ratios.

See also

Design review filters (page 853)

Review design summary tabular results (page 898)

Review foundation and pile design

Review foundation or pile status
1. Open a view and change the view regime (page 280) to Review View.

2. Go to the Review ribbon.

3. Either in the Foundations group or the Piles group, click Status. 

Color codes display the design status of each foundation or pile.

Tekla Structural Designer uses the following classifications:
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Status Description
Pass The foundation or pile has passed all

design checks.
Fail The foundation or pile has failed one

or more design checks.
Warning Although the foundation or pile has

passed the design checks, one or
more warnings have been issued.
Review the warnings before deciding
if you need to take further action.

Error The foundation or pile currently
cannot be designed because an error
has occurred.

Beyond Scope The foundation or pile cannot be
designed because its design is
beyond the scope of Tekla Structural
Designer.

Unknown The foundation or pile has not been
designed.

Review foundation or pile ratios
1. Open a view and change the view regime (page 280) to Review View.

2. Go to the Review ribbon.

3. Either in the Foundations group or the Piles group, click Ratio. 

Color codes display the design ratio of each foundation or pile. N/A is
assigned to members that have no ratio or whose ration is smaller than
the lowest band. N/A also indicates foundations and piles that are either
beyond scope or have yet to be designed.

See also

Design review filters (page 853)

Review design summary tabular results (page 898)

Review slab and mat design

Review slab and mat design status
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Slab/Mat Design group, click Status. 
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Color codes display the design status of each slab and mat.

Tekla Structural Designer uses the following classifications:

Status Description
Pass The slab item has passed all design

checks.
Fail The slab item has failed one or more

design checks.
Warning Although the slab item has passed

the design checks, one or more
warnings have been issued. Review
the warnings before deciding if you
need to take further action.

Error The slab item currently cannot be
designed because an error has
occurred.

Beyond Scope The slab item cannot be designed
because its design is beyond the
scope of Tekla Structural Designer.

Unknown The slab item has not been designed.

Review slab and mat design ratios
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, in the Slab/Mat Design group, click Ratio. 

Color codes display the design ratio of each slab item. N/A is assigned to
members that have no ratio or whose ration is smaller than the lowest
band. N/A also indicates slab items that are either beyond scope or have
yet to be designed.

Filter slab and mat design information
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click the list in the Slab/Mat Design group.

3. In the list that appears, select one of the following filtering options
according to your needs: 

Filter Description
Overall The governing Top X, Top Y, Bottom X,

Bottom Y, or span depth result is
displayed.

Reinforcement The governing Top X, Top Y, Bottom X,
or Bottom Y result is displayed.

Review models 852 Review designs



Filter Description
Top X The result is only displayed for top

reinforcement in the X direction.
Top Y The result is only displayed for top

reinforcement in the Y direction.
Bottom X The result is only displayed for

bottom reinforcement in the X
direction.

Bottom Y The result is only displayed for
bottom reinforcement in the Y
direction.

Span Depth The span to depth result is displayed.
Bearing Pressure The bearing pressure result is

displayed.

See also

Design review filters (page 853)

Review design summary tabular results (page 898)

Design review filters
Design review filters help the user to focus on specific results.

The filters are displayed in the Properties window when Status or Ratio are
selected from any group on the Review ribbon.

The following filter types are available and can be used individually or in
combination:

• Status filter

• Utilization ratio filter

• Entity type filter

TIP These filters can be particularly useful when working with large models.

Working with the Status filter
The Status filter is always active in the Properties window when Status is
selected from the Review ribbon.
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All entities are assigned a design status from the below list:

• Pass - The entity has passed all design checks.

• Warning - Although the entity has passed the design checks, one or more
warnings have been issued. Review the warnings before deciding if you
need to take further action.

• Fail - The entity has failed one or more design checks.

• Error - The entity currently cannot be designed because an error has
occurred.

• Beyond Scope - The entity cannot be designed because its design is
beyond the scope of Tekla Structural Designer.

• Unknown - The entity has not been designed.

In the above model the legend indicates that two members are failing and
another has a warning but their locations are not immediately apparent.
Deselecting a status in the Properties window causes entities of that status to
be hidden in the Review View, so in this instance deselecting the Pass status
helps to focus on where the problems are occurring.
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By also selecting Ghost excluded the filtered results can be displayed in
relation to the rest of the model.
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If required, you can also apply the Status filter when investigating ratios. This
is achieved as follows:

1. From the Review ribbon select Ratio

2. Select Manual filters in the Properties window.

The Status filter group is displayed.

3. Select Active and choose the statuses by which to filter the display of
ratios.

The result is that ratios are then only displayed for those members in the
chosen Status filter categories.
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Working with the Utilization ratio filter
All entities that have been designed are assigned a utilization ratio. The
Utilization ratio filter allows you to display only those entities within a given
utilization range.

This filter is always active in the Properties window when Ratio is selected
from the Review ribbon.
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Initially entities with any ratio are displayed, but by selecting upper and/or
lower limits, entities outside the defined range are hidden in the Review View.
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By selecting Ghost excluded the filtered results can be displayed in relation to
the rest of the model.
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If required, you can also apply the Utilization ratio filter when investigating
statuses. This is achieved as follows:

1. From the Review ribbon select Status

2. Select Manual filters in the Properties window.

The Utilization ratio filter group is displayed.

3. Select Active and set the upper and/or lower limits by which to filter the
display.

The result is that statuses are then only displayed for those members
within the specified utilization ratio limits.
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Working with the Entity type filter
Unless they have been unselected in Scene Content, all relevant entity types
are initially displayed when either Status or Ratio are selected from the
Review ribbon.

You can use the Entity type filter to focus on specific types only, it is made
active as follows:

1. Select Manual filters in the Properties window

The Entity type filter group is displayed.

2. Select Active

A list of designable entity types is displayed in the Properties window.

Deselecting an entity type from the list causes entities of that type to either be
hidden in the Review View, or displayed as ghosted if Ghost excluded is
selected.

NOTE Clicking 'All' toggles between all entity types being selected, or
unselected.

Example:
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The below view shows slab status at a particular level. Initially, the Entity type
filter is not active and as a result the slab, slab patch, and punching check
statuses are all displayed making interpretation difficult. Note that a Fail is
reported, but it is not immediately apparent where it is.

By activating the Entity type filter you can investigate the status for specific
entity types. The below view is filtered for patches only, which are all passing.
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The below view is filtered for punching checks only and clearly reveals where
the Fail occurs.
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9.2 Review model properties (show/alter state)
The Show/Alter State group of commands on the Review toolbar allow you
to graphically review and modify various model properties. For each of the
commands, entities are color coded in accordance with a legend, and the
entity color changes to reflect any changes as they are made.

Those Show/Alter State commands that can be accessed directly from the
toolbar are as follows:

• Auto/Check Design (page 865) - to graphically review or modify
autodesign settings of a member or slab

• Diaphragm On/Off - to graphically review or modify diaphragm settings

• Fixed/Pinned (page 867) - to graphically review or modify member end
fixities

• BIM Status (page 867) - to graphically assess the BIM Status, and also to
exclude members and panels from the import/export process

• Slab / Foundation Reinforcement - to graphically review and edit or
rationalize panel, patch or foundation reinforcement

• Section/Material Grade (page 870) - to graphically copy section sizes, or,
(by changing the Attribute), material grades (page 870)
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• Copy Properties (page 871) - to copy a specified element parameter (such
as web openings, shear connectors, or transverse reinforcement) from a
source member to valid target members.

• Report Filter (page 871) - to graphically review and modify report filters

• Sub Structures (page 872) - to graphically review and modify sub
structures

• Concrete Beam Flanges (page 872) - to graphically set whether flange are
considered

• Column Splices (page 872) - to graphically review and modify splice
positions within steel columns.

• Property Sets - to graphically review or apply property sets to members,
slab items and roof panels.

• UDA - to graphically review and modify the values of user defined
attributes that have been attached to the model.

• Show/Alter State (page 873) - to review and modify various model
properties

Modify autodesign settings
You can graphically modify autodesign settings of members and slabs from a
Review View.

To modify the autodesign settings of a member or slab, do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. In the Properties window, select the appropriate mode.

4. Do one of the following:

• Click an individual entity to modify its auto design setting.

• Hold down the left mouse button and drag a box from left to right to
modify the auto design setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the auto design setting of all members within the box or cut by
the box.
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Review and modify diaphragm settings
The Diaphragm On/Off command on the Review tab allows you to select
whether the slab items, roof panels, and nodes in the model are included

Review the diaphragm settings
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or

b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

Modify the diaphragm settings of slab items or roofs
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or

b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

3. In the Properties window, set Entity type to Slab Item or Roof.

4. Do one of the following:

• Click an individual slab item or roof panel to switch between including
and excluding the element from the diaphragm.

• Hold down the left mouse button and drag a box from left to right to
switch between including and excluding slab items and roof panels
within the box from the diaphragm.

• Hold down the left mouse button and drag a box from right to left to
switch between including and excluding slab items and roof panels
within the box or cut by the box from the diaphragm.

Include or remove solver nodes from the diaphragm
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or
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b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

3. In the Properties window, set Entity type to Solver Node.

4. Do one of the following:

• Click an individual slab item or roof panel to switch between including
and excluding the element from the diaphragm.

• Hold down the left mouse button and drag a box to switch between
including and excluding the nodes within the box in diaphragm.

Modify end fixity
The Fixed / Pinned command allows you to graphically review and modify the
end fixity of all members in the model.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Fixed / Pinned.

3. Go to the Properties window.

4. In the Attribute list, ensure that Fixed / Pinned is selected.

5. With the Mode set as Toggle, do one of the following:

• Click an individual member to switch its end fixity between the valid
end fixity types.

• Hold down the left mouse button and drag a box from left to right to
alter the fixity settings of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
alter the fixity settings of all members within the box or cut by the box.

6. Alternatively, with the Mode set as Set On, select the FixityType required
and then click an individual member, or drag a box, as above to apply the
chosen fixity. 

NOTE If the end fixity of a member is labeled Cantilever, or N/A, the
end fixity at end 1 of the element is different from the fixity at end
2. You can only edit a mixed end fixity by right-clicking on the
member and editing its properties in the Properties dialog.
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Modify BIM status
The BIM Status command allows you to graphically modify the BIM status and
to exclude members and panels from the BIM import or export process.

To include or exclude members and panels from the BIM process, do the
following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click BIM Status.

3. Do one of the following:

• Click an individual member or panel once to exclude it or twice to re-
include it.

• Hold down the left mouse button and drag a box from left to right to
modify the exclude setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the exclude setting of all members within the box or cut by the
box.

Copy or modify slab and foundation reinforcement
You can graphically review and modify the bar/mesh size and spacing applied
in each layer and direction for slab items, mats, patches and isolated
foundations. Tekla Structural Designer also allows you to copy reinforcement
from one slab item, mat, patch or isolated foundation to another.

TIP If you open two Review Views side by side, you can then use the first one to
modify the reinforcement while displaying the design status in the second one.
This way, each change you make to the reinforcement immediately updates the
design status.

Copy reinforcement
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. Ensure that auto design is set off for the slab items and patches that you
want to modify.

4. On the Review tab, click Slab / Foundation Reinforcement.
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5. Go to the Properties window.

6. Set Entity type to either Slab Item, Slab Patch or Isolated Foundation,
depending on the reinforcement that you want to copy.

7. In Reinforcement Direction, select the direction that you want to modify.

8. In Surface, select the slab layer that you want to modify.

9. Click the slab item or patch whose reinforcement you want to copy.

10. Click the slab items or patches to which you want to copy the
reinforcement. 

The slab reinforcement is copied to the selected slab items or patches.

TIP To ensure that the updated reinforcement is sufficient, in the
Slab/Mat Design group, click Status.

Modify reinforcement
1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. Ensure that auto design is set off for the slab items and patches that you
want to modify.

4. On the Review tab, click Slab / Foundation Reinforcement.

5. Go to the Properties window.

6. Set Entity type to either Slab Item, Slab Patch or Isolated Foundation,
depending on the reinforcement that you want to modify.

7. In Reinforcement Direction, select the direction that you want to modify.

8. In Surface, select the slab layer that you want to modify.

9. If you want to modify bars, in Bar Parameters, select the properties that
you want to modify.

10. In Apply, select the bar properties that you want to apply to the slab.

11. Click the slab item or patch whose reinforcement you want to update. 

TIP To ensure that the updated reinforcement is sufficient, in the
Slab/Mat Design group, click Status.
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Copy section sizes
If necessary, you can graphically copy the section size applied to a member to
other members in the model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Section.

5. Set Mode to Copy.

6. In Material type, select the desired material type. 

NOTE You can use a characteristic filter to reduce the elements
displayed in the model.

7. In the model, click the element from which you want to copy a section
size.

8. Click the elements to which you want to copy the section size. 

The section size is copied to the selected elements.

Copy material grades
If necessary, you can graphically review the material grade applied to the
members in your model. Tekla Structural Designer also allows you to copy the
grade of one member to another member with the same material type . For
more information, see the following paragraphs.

RESTRICTION You can only copy material grades to and from steel, cold
formed, cold rolled, concrete, or timber members.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Material Grade.

5. In Material Type, select the desired material type. 

TIP If necessary, use a characteristic filter to reduce the elements
displayed in the Review View.

6. Set Mode to Copy.

Review models 870 Review model properties (show/alter state)



7. Click the element whose grade you want to copy.

8. Click the elements to which you want to copy the grade. 

The material grade is copied to the selected elements.

Copy properties
The Copy Properties command allows you to graphically copy a specified
element parameter (such as web openings, shear connectors, or transverse
reinforcement) from a source member to other valid target members. To copy
properties from one member to another, see the following instructions.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Copy Properties.

3. Go to the Properties window.

4. In the Attribute list, select the parameter that you want to copy.

5. In the model, click the member from which you want to copy the
parameter.

6. Do one of the following:

• Click an individual member to which you want to copy the parameter.

• Hold down the left mouse button and drag a box around multiple
members to which you want to copy the parameter.

Tekla Structural Designer copies the parameter to the selected members.

Review and modify member filters
The Report Filter command allows you to graphically review and modify
report filters that you have defined for the members in your model. The
Report Filter command remains unavailable until you have defined a member
filter.

TIP To define a report filter, do the following:

1. Go to the Report tab.

2. In the Filters group, click Members.

3. Define the member filter according to your needs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Report Filter.

3. Do one of the following:
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• Click an individual member to switch between including and excluding
the member from the selected member filter.

• Hold down the left mouse button and drag a box from left to right to
switch between including and excluding the members within the box
from the selected member filter.

• Hold down the left mouse button and drag a box from right to left to
switch between including and excluding the members within the box
or cut by the box from the selected member filter.

Review sub structures
The Sub Structures command allows you to graphically create, review and
modify sub structures for modeling purposes. The command can be especially
useful in large models, as individual sub structures can then be differentiated
by color and worked on in separate views.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Sub Structures. 

The elements in the model are color coded based on whether they belong
to sub structures.

See also

Manage sub structures (page 1031)

Review concrete beam flanges
The Concrete Beam Flanges command allows you to graphically review the
flanges of concrete beams. See detailed instructions on how to review conrete
beam flanges in the following paragraphs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Concrete Beam Flanges. 

Each concrete beam is color coded to indicate if its flanges are considered
and flange widths determined.

Use of beam flanges

Review and modify column splice positions
The Column Splices command allows you to graphically review and modify
splice positions within steel columns. For detailed instructions on how to
review and modify splice positions, see the following paragraphs.
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1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Column Splices. 

All potential splice locations are color coded to indicate if they are on or
off.

3. Do one of the following:

• Click a potential splice location to alter its setting between on or off.

• In a 2D view, hold down the left mouse button and drag a box to alter
the setting of multiple splices simultaneously.

Review and apply property sets
The command provides a means to graphically review or apply property sets
to entities.

• Review where property sets have been applied (page 1024)

• Apply property sets to existing entities (page 1023)

Copy or modify user-defined attributes
If necessary, you can graphically review and modify the values of attributes
that have been attached to the model.

Show/alter state
The Show/Alter State commands allow you to efficiently review and modify
various model properties. For each of the commands, entities are color coded
in accordance with a legend, and the entity color changes to reflect any
changes as they are made.

In the Properties window, you can use filters for most Show/Alter State
commands. The filters allow you to control both the visibility of entities by
their current setting and their adjustability by their type and characteristic.
Inactive but visible entities are shaded a light transparent grey whose opacity
you can also control, if necessary.

To access the Show/Alter State commands, do the following:

1. Open a Review view.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. Choose the command required from the Attribute list:

Option Description
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Active (page 875) set single span members to be active/inactive

All properties (page 871) copy all properties between members

Assume cracked (page 875) set concrete members as either cracked or
uncracked

Autodesign (page 865) review or modify autodesign settings

BIM Status (page 867) modify BIM status, or exclude members/panels
from BIM import/export

Bracing/Braced (page 878) modify slenderness settings in each direction for
concrete columns and walls

Cantilever end (page 878) mark beam and column ends as cantilevers

Deflection Limits (page 879) review and copy specified deflection limits
between steel beams

Diaphragm (page 865) select the slab items, roof panels, and nodes to
be included in diaphragms

Drift check review check status, or specify members to be
checked

Fixed/Pinned (page 867) review and modify member end fixity

Gravity only (page 880) review and modify the gravity only setting of
beams and columns

Material Grade (page 870) review and copy the material grade between
members

Punch check position (page 880) modify assumed punching shear check positions

Copy quick connector layout (page 881) copy the connector layout from one beam to
others

Restraints review and modify lateral restraint settings of
steel beams, columns, trusses and portal frames

Rotational stiffness (page 890) review and modify rotational stiffness settings of
beam ends

Section (page 870) review and copy section sizes between members

SFRS Type and Direction review or modify SFRS type and direction

Shear Connectors (page 891) copy shear connector properties between
composite beams

Size Constraints review and copy specified size constraints for
steel beams, columns, and braces

SidePlates (page 892) review the status and locations where SidePlate
connections have been applied to steel beams

Stud auto layout (page 893) modify the stud auto layout setting of composite
beams

Sway check review check status, or specify members to be
checked

Transverse reinforcement (page 894) modify the transverse reinforcement of
composite beams

UDA (page 873) review and modify user defined attributes
applied to members

User defined U/R review and modify user defined utilization ratios

Web Openings (page 896) copy web opening properties between members

Westok Openings (page 896) copy westok opening properties between
members

Wind drift review check status, specify members to be
checked and set the limit

TIP You can use Ctrl + A as a shortcut to quickly scroll the Attribute list.
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Modify active / inactive settings
Initially all members are active. If a member is set inactive it does not
participate in the analysis but any load applied to (or decomposed) to it is still
accounted for.

Only single span beams, braces, analysis elements, purlins and rails have the
potential to be inactive. They each therefore have an Active setting in the
properties which defaults to 'on', but can be unchecked. In the Review View
these members are color coded allowing the same setting to be toggled
graphically.

NOTE Members cannot be inactive if:

• They are multi-span

• They support another member (active or inactive)

To modify the active setting of a member graphically do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State .

3. Go to the Properties window.

4. In the Attribute list select Active. 

Members are color coded according to their active setting.

5. In the Properties window, select the appropriate mode.

6. Do one of the following:

• Click an individual entity to modify its active setting.

• Hold down the left mouse button and drag a box from left to right to
modify the active setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the active setting of all members within the box or cut by the
box.

Modify assumed cracked settings
You can graphically review and modify the assumed cracked setting of the
concrete beams, columns and walls in a Review View using Show/Alter State -
Assume cracked.

Set or toggle assumed cracked settings

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.
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4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to one of the following:

• Set cracked - click or box around concrete member(s) to set to
cracked.

• Set uncracked- click or box around concrete member(s) to set to
uncracked.

• Toggle - click or box around concrete member(s) to toggle between
cracked or uncracked.

The member color coding updates to reflect the cracked or uncracked
status.

Review Wall Stress

NOTE The following limitations and assumptions apply to Review Wall
Stress

1. Only meshed wall panels are considered, mid-pier walls are
excluded.

2. The analysis type specified in Design Settings>Analysis
determines which set of analysis results are used for the review.

3. For the above analysis type, the loadcases and combinations
considered are those from the last performed building analysis
of that type.

• This gives you the flexibility to review the stresses for a subset
of loadcases/combinations if required.

• By running Analyse All you can ensure all active gravity, lateral
and seismic (not seismic RSA) combinations have been
considered.

• Stresses are available for seismic but not for seismic RSA
combinations - these are beyond scope. (Review Wall
Stress is more particularly aimed at determining the
cracked status of panels under wind loading).

4. Chasedown results are not considered.

5. Axial load reductions are always taken into account.

6. The maximum stress value from all nodes for all analysed cases/
combinations is reported in a tooltip for each panel. This value is
used to determine if the stress threshold has been exceeded.

• The reinforcement content in the panel is not considered in
determining the stress value.

7. The loading droplist in the status bar does not filter the status for
individual cases/combinations.
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To review/update the cracked status of all wall panels to be compatible with
the stress levels for the loadcases/ combinations that have been analysed,
proceed as follows:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Review Wall Stress.

6. Check the yellow command prompt to confirm which analysis type is
being used for the review, (this will be the type currently specified in
Design Settings>Analysis).

7. Set the Result type to control which factors to use in combinations for
the review.

• Strength factors, or

• Service factors

8. Set the Stress type to be considered.

• Max tension - Y, or

• In-plane tension - Y

9. Set the Stress threshold above which walls should crack. The existing
cracked/uncracked status of each panel is displayed, along with an
indiation of whether the stress threshold has been exceeded.

10. To make panel status compatible with the stress threshold for one or
more panels:

a. click an individual panel, or

b. box around multiple panels, or

c. to make all panels compatible, click  then click the Auto update
button 

Panel status is made compatible, i.e.

• If uncracked and the stress threshold has been exceeded, the status is
changed to cracked.

• If cracked and the stress threshold has not been exceeded, the status
is changed to uncracked.

See also

Concrete member cracked or uncracked status (page 1286)
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Modify slenderness settings
The Braced/Bracing command provides a means to graphically review and
modify the slenderness settings in each direction for concrete columns and
walls.

To modify slenderness settings, do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Braced/Bracing.

5. Select the direction under consideration. 

Members are color coded according to their slenderness setting in the
selected direction.

6. Do one of the following:

• Click an individual column or wall to modify its slenderness setting
between braced and bracing.

• Hold down the left mouse button and drag a box from left to right to
modify the slenderness setting of all concrete columns and walls
within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the slenderness setting of all concrete columns and walls
within the box or cut by the box.

Apply cantilever ends
The Cantilever end command allows you to graphically apply cantilever ends
where required to beams and columns.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Fixed / Pinned.

3. Go to the Properties window.

4. In the Attribute list, select Cantilever end.

5. Set Mode to Set On, Set Off, or Toggle as required.

6. Do one of the following:

• Click an individual member end to set/unset a cantilever end as per
the Mode.

• Hold down the left mouse button and drag a box from left to right to
alter the cantilever end settings of all members entirely within the box.
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• Hold down the left mouse button and drag a box from right to left to
alter the cantilever end settings of all members within the box or cut
by the box.

Review and copy deflection limits
You can graphically review specified deflection limits and copy the limits from
one steel beam to others.

Review deflection limits

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Deflection Limits.

5. Set Mode to Review.

6. Set Load type to the load type that you want to review.

Copy deflection limits

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Deflection Limits.

5. Set Mode to Copy.

6. In the model, click the beam from which you want to copy the deflection
limits.

7. Click the beam to which you want to copy the deflection limits. 

The deflection limits are copied to the selected beam.

8. Continue copying the limits by clicking the desired beams or press Esc to
finish.

Review and modify drift checks
You can graphically review drift check results and set the members to be
checked for columns and walls.

Review drift checks

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.
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4. In the Attribute list, select Drift check.

5. Set Mode to Review.

Set drift checks on or off

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Drift check.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Modify gravity only settings
If necessary, you can review and modify the gravity only setting of the beams
and columns in your model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Gravity only. 

All members are color coded to indicate their gravity only setting.

5. Do one of the following:

• Click a steel beam or column to set its gravity only setting on or off.

• Hold down the left mouse button and drag a box from left to right to
set on or off the gravity only setting of all steel beams and columns
within the box.

• Hold down the left mouse button and drag a box from right to left to
set on or off the gravity only setting of all steel beams and columns
within the box or cut by the box.
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Modify punching shear check position
If necessary, you can graphically modify the assumed punching shear check
position. This allows you to determine the loaded perimeter when the
perimeter is close to a free edge.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Punch check position.

5. To change the punching shear check position, do one of the following:

To Do this
Switch the punching shear check position
between Edge Z and Internal

• Click the Z edge of a punching check item.

Switch the punching shear check position
between Edge Y and Internal

• Click the Y edge of a punching check item.

Switch the punching shear check position
between Corner, Edge Z, Edge Y and Internal

• Click a corner of a punching check item.

NOTE Clicking an internal punching check item does not change the
punching shear check position.

TIP You can also box around multiple punching check item to switch
their position. Do one of the following:

• Hold down the left mouse button and drag a box from left to
right to switch the position setting of all punch check items
within the box.

• Hold down the left mouse button and drag a box from right to
left to switch the position setting of all punch check items within
the box or cut by the box.

Copy quick connector layout
You can graphically copy the connector layout from one beam to another. For
more information, see the following paragraphs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Quick Connector Layout.

5. Click on the beam with the layout that you want to copy (must be valid). 

The composite beams in the model are color coded to indicate the source
and valid targets.
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6. To select the beams to apply the layout to, do one of the following:

• Click an individual valid target beam.

• Hold down the left mouse button and drag a box from left to right to
totally enclose the target beams.

• Hold down the left mouse button and drag a box from right to left to
select target beams within the box or cut by the box.

The connector layout is copied from the source to the target beam(s).

Review and modify restraints
By selecting the Restraints attribute in Show/Alter State you can graphically
review and modify continous and discrete restraints for beams, columns,
trusses and portal frames.

TIP Graphical editing of restraints will typically be more effective than the alternative
of opening the Properties dialog box for each member individually.

Review restraints

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.

5. Set Mode to Review. For details of the restraint type choices etc. that are
presented in Review mode, see the Options overview topics below.

6. Set the Continuous box as required:

• Checked: shows continuous restraints, each sub-member being colour
coded in accordance with the legend.

• Unchecked: shows discrete restraints, each internal node at which
other members connect being colour coded in accordance with the
legend.

7. Set the Restraint Type that you want to review.

8. Set the Entity type that you want to review.

Toggle restraints

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.
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5. Set Mode to Toggle. For details of the restraint type choices etc. that are
presented in Toggle mode, see the Options overview topics below.

6. Set the Entity type that you want to modify.

7. Leave the Continuous box checked to set continuous restraints along
sub-members, or uncheck it to set discrete restraints at those points
where other members connect.

8. Set the Restraint Type as required.

9. In the model:

• click the member at the location where want to toggle the restraint.

• drag a box around multiple members to toggle the restraint at all valid
locations within the box.

The type of restraint at the selected location(s) changes to the next
rerstraintr type shown in the legend. (Simply click again as necessary until
the desired restraint type has been applied.)

10. Continue toggling the restraints by clicking the desired members or press
Esc to finish.

Set restraints

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.

5. Set Mode to Set. For details of the restraint type choices etc. that are
presented in Set mode, see the Options overview topics below.

6. Set the Entity type that you want to modify.

7. Leave the Continuous box checked to set continuous restraints along
sub-members, or uncheck it to set discrete restraints at those points
where other members connect.

8. Set the Restraint Type as required.

9. Set the Restraint as required.

10. In the model:

• click the member at the location where want to set the restraint.

• drag a box around multiple members to set the same restraint at all
valid locations within the box.

11. Continue setting the checks by clicking/boxing the desired members or
press Esc to finish.
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Options overview (US headcode)

The restraint options displayed in the Properties window depend on the
Entity type filter. When this is set to either Beam, Column, or Truss Top/
Bottom Member, the options are:

Command or
option

Description

[M]ode • Review - sub-members/discrete points of
restraint are color coded to indicate their
restraint settings

• Toggle - clicking sub-members/discrete
points of restraint toggles the applicable
restraints.

• Set - clicking sub-members/discrete points
of restraint sets the selected restraint.

Continuous • Checked - enables the review/setting of
sub-member continuous restraints

• Unchecked - enables the review/setting of
discrete restraints at those points where
other members connect.

Restraint Type The restraint type determines which page(s)
of properties are being edited.

• LTB - enables the review/setting of the
check-boxes located on the Restraints
(LTB) property page.

• Compression - enables the review/setting
of the check-boxes located on the
Restraints (Comp) property page.

• LTB & Compression Out of Plane -
enables the simultaneous review/setting
of check-boxes on both the the Restraints
(LTB) and Restraints (Comp) property
pages.

Restraint When in Set Mode, this setting determines
which check-boxes on the selected restraint
property page are checked and un-checked.
For LTB restraint types (and Entity type Beam
or Truss):

• Top - Top flange check-box is checked,
Bottom flange check-box is unchecked.

• Bottom - Top flange check-box is
unchecked, Bottom flange check-box is
checked.
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Command or
option

Description

• Top and Bottom - both check-boxes are
checked.

• Unrestrained - both check-boxes are
unchecked.

For LTB restraint types (and Entity Type
Column):

• Face A - Face A check-box is checked, Face
C check-box is unchecked.

• Face C - Face A check-box is unchecked,
Face C check-box is checked.

• Face A & C - both check-boxes are
checked.

• Unrestrained - both check-boxes are
unchecked.

For Compression restraint types:

• Out of Plane - Out of plane check-box is
checked, In plane check-box is unchecked.

• In Plane - In plane check-box is checked,
Out of plane check-box is unchecked.

• Out of Plane & In Plane - both check-
boxes are checked.

• Unrestrained - both check-boxes are
unchecked.

 For LTB & Compression Out of Plane
restraint type:

• Top & Bottom & Out of Plane - Top
flange, Bottom flange, and Out of Plane
are checked.

• Top & Out of Plane - Top flange and Out
of Plane are checked, Bottom flange is
unchecked.

• Bottom & Out of Plane - Bottom flange
and Out of Plane are checked, Top flange
is unchecked.

• Unrestrained - Top flange, Bottom flange,
and Out of Plane are checked.
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Command or
option

Description

NOTE For each of the above, the In Plane
check-box is unaffected, retaining its
existing setting.

Options overview (other head codes)

The restraint options displayed in the Properties window depend on the
Entity type filter. When this is set to either Beam, Column, or Truss Top/
Bottom Member, the options are:

Command or
option

Description

[M]ode • Review - sub-members/discrete points of
restraint are color coded to indicate their
restraint settings

• Toggle - clicking sub-members/discrete
points of restraint toggles the applicable
restraints.

• Set - clicking sub-members/discrete points
of restraint sets the selected restraint.

Continuous • Checked - enables the review/setting of
sub-member continuous restraints

• Unchecked - enables the review/setting of
discrete restraints at those points where
other members connect.

Restraint Type The restraint type determines which page(s)
of properties are being edited.

• Lateral - enables the review/setting of the
check-boxes located on the Lateral
restraints property page.

• Strut - enables the review/setting of the
check-boxes located on the Strut
restraints property page

• Lateral & Strut Minor - enables the
simultaneous review/setting of check-
boxes on both the the Lateral restraints
and Strut restraints property pages.

Restraint When in Set Mode, this setting determines
which check-boxes on the selected restraint
property page are checked and un-checked.
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Command or
option

Description

For Lateral restraint types (and Entity type
Beam or Truss):

• Top - Top flange check-box is checked,
Bottom flange check-box is unchecked.

• Bottom - Top flange check-box is
unchecked, Bottom flange check-box is
checked.

• Top and Bottom - both check-boxes are
checked.

• Unrestrained - both check-boxes are
unchecked.

For Lateral restraint types (and Entity Type
Column):

• Face A - Face A check-box is checked, Face
C check-box is unchecked.

• Face C - Face A check-box is unchecked,
Face C check-box is checked.

• Face A & C - both check-boxes are
checked.

• Unrestrained - both check-boxes are
unchecked.

For Strut restraint types:

• Major - Major check-box is checked, Minor
check-box is unchecked.

• Minor - Minor check-box is checked, Major
check-box is unchecked.

• Major and Minor - both check-boxes are
checked.

• Unrestrained - both check-boxes are
unchecked.

 For Lateral & Strut Minor restraint type:

• Top & Bottom & Minor - Top flange,
Bottom flange, and Minor are checked.

• Top & Minor - Top flange and Minor are
checked, Bottom flange is unchecked.

• Bottom & Minor - Bottom flange and
Minor are checked, Top flange is
unchecked.
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Command or
option

Description

• Unrestrained - Top flange, Bottom flange,
and Minor are checked.

NOTE For each of the above, the Major
check-box is unaffected, retaining its
existing setting.

Portal Frame options (US headcode)

The restraint options displayed in the Properties window when the Entity
type filter is set to Portal Frame are:

Command or
option

Description

[M]ode • Review - discrete points of restraint are
color coded to indicate their restraint
settings

• Toggle - clicking discrete points of
restraint toggles the applicable restraints.

• Set - clicking discrete points of restraint
sets the selected restraint.

Restraint When in Set Mode, this setting determines
which check-boxes on the restraint property
pages are checked and un-checked.

Rafters:

• Torsional - Top flange, Bottom flange, and
Out of Plane are checked.

• Outer - Top flange is checked, Bottom
flange is unchecked.

• Inner - Top flange is unchecked, Bottom
flange is checked.

• Unrestrained - Top flange, Bottom flange,
and Out of Plane are unchecked.

Columns:

• Torsional - Face A, Face C, and Out of
Plane are checked.

• Outer - Face A is checked, Face C is
unchecked.

• Inner - Face A is unchecked, Face C is
checked.
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Command or
option

Description

• Unrestrained - Face A, Face C, and Out of
Plane are unchecked.

NOTE For each of the above, any checkbox
not specifically mentioned retains its
existing setting.

Portal frames options (other head codes)

The restraint options displayed in the Properties window when the Entity
type filter is set to Portal Frame are:

Command or
option

Description

[M]ode • Review - discrete points of restraint are
color coded to indicate their restraint
settings

• Toggle - clicking discrete points of
restraint toggles the applicable restraints.

• Set - clicking discrete points of restraint
sets the selected restraint.

Restraint When in Set Mode, this setting determines
which check-boxes on the restraint property
pages are checked and un-checked.

Rafters:

• Torsional - Top flange, Bottom flange, and
Minor are checked.

• Outer - Top flange is checked, Bottom
flange is unchecked.

• Inner - Top flange is unchecked, Bottom
flange is checked.

• Unrestrained - Top flange, Bottom flange,
and Minor are unchecked.

Columns:

• Torsional - Face A, Face C, and Minor are
checked.

• Outer - Face A is checked, Face C is
unchecked.

• Inner - Face A is unchecked, Face C is
checked.
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Command or
option

Description

• Unrestrained - Face A, Face C, and Minor
are unchecked.

NOTE For each of the above, any checkbox
not specifically mentioned retains its
existing setting.

Related video

Show/Alter State Restraints

Apply rotational stiffness to a beam end
The Rotational stiffness command allows you to graphically apply partially
fixity/linear springs to the ends of beams.

Related video

Automatic modelling of partial fixity

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Fixed / Pinned.

3. Go to the Properties window.

4. In the Attribute list, select Rotational stiffness.

5. Set Mode to Set On.

6. Set Direction to Major, or Minor as required.

7. Set Rotational stiffness to Partially fixed, or Spring linear as required.

8. If Partially fixed, set the percentage fixity value; or if Spring linear set
the spring stiffness value as required.

9. To apply the new setting do one of the following:

• Click an individual beam end.

• Hold down the left mouse button and drag a box from left to right to
apply to all beam ends entirely within the box.

• Hold down the left mouse button and drag a box from right to left to
apply to both ends of all beams within the box or cut by the box.
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Review and modify SFRS settings
If necessary, you can graphically review and modify the the types and
directions of seismic force resisting systems (SFRS) in the model. For more
information, see the following paragraphs.

Review SFRS type and direction settings

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select SFRS. 

Members and walls are color coded according to their SFRS type and
direction settings.

Modify SFRS type & direction settings

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select SFRS. 

Members and walls are color coded according to their SFRS direction
setting.

5. Set Mode to one of the following:

• Update Type & Direction: includes a member in the selected SFRS
type & direction.

• Remove from SFRS: removes the member from SFRS.

6. Click the desired member. 

Depending on the set mode, Tekla Structural Designer includes the
member in the SFRS type & direction, or removes the member from SFRS.

Copy shear connectors
If necessary, you can copy the composite beam shear connector properties
from a source beam to other composite beams. Do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Shear Connectors.

5. In the model, click the composite beam from which you want to copy the
shear connector properties.
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6. Click the composite beams to which you want to copy the shear connect
properties. 

The properties are copied to the selected beams.

Modify SidePlates
The SidePlates command allows you to graphically review and modify the
SidePlate connection status.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click SidePlates.

3. Do one of the following:

• Click on the first half of a beam to reset end 1, the second half to reset
end 2 and the middle to reset both ends simultaneously.

• Hold down the left mouse button and drag a box from right to left to
reset all the beam ends within the box or cut by the box.

See also

SidePlate connections (page 825)

Review and copy size constraints
If necessary, you can graphically review specified size constraints for steel
beams, columns, and braces, and copy the constraints from one steel member
to others. For more information, see the following paragraphs.

Review size constraints

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Size Constraints.

5. Set Mode to Review.

6. In Size constraint, select the size constraint that you want to review.

Copy size constraints

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Size Constraints.
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5. Set Mode to Copy. 

TIP Select the By constraint type option if you want to only copy an
individual constraint type.

6. In the model, click the member from which you want to copy the size
constraints.

7. Click the member to which you want to copy the size constraints.

8. Continue copying the size constraints by clicking the desired members or
press Esc to finish.

Modify stud auto layout
If necessary, you can graphically modify the stud auto layout setting of
composite beams in the model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Stud auto layout. 

The composite beams in the model are color coded according to their
auto layout setting.

5. Do one of the following:

• Click an individual composite beam to alter its auto layout setting.

• Hold down the left mouse button and drag a box from left to right to
alter the auto layout setting of all composite beams within the box.

• Hold down the left mouse button and drag a box from right to left to
alter the auto design setting of all composite beams within the box or
cut by the box.

Review and modify sway checks
You can graphically review sway check results and set the members to be
checked for columns and walls.

Review sway checks

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Sway check.

5. Set Mode to Review.
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Set sway checks on or off

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Sway check.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Copy transverse reinforcement
If necessary, you can copy beam transverse reinforcement from one
composite beam to others in your model. Do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Transverse reinforcement. 

The composite beams in the model are color coded based on whether you
can copy transverse reinforcement properties from them.

5. Click the composite beam from which you want to copy transverse
reinforcement properties.

6. Click the composite beams to which you want to copy the transverse
reinforcement properties. 

The properties are copied to the selected beams.

Review and modify user defined U/R
From a Review View you can graphically review user defined utilization ratios,
set the members to which they are applied, and set whether they apply to
autodesign alone, or both autodesign and check.

Review user defined U/R

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.
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3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

Apply a user defined U/R for autodesign only

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

5. Set Mode to Apply to Autodesign.

6. Select Set limit ratio.

7. Specify the required Ratio limit

8. If required, set Entity type and Material to make the command easier to
apply.

9. In the model, click those column/wall stacks, beam spans, or objects for
which you want to apply the user defined U/R.

10. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

Apply a user defined U/R for autodesign and check

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

5. Set Mode to Apply to Autodesign+Check.

6. Select Set limit ratio.

7. Specify the required Ratio limit

8. If required, set Entity type and Material to make the command easier to
apply.

9. In the model, click those column/wall stacks, beam spans, or objects for
which you want to apply the user defined U/R.

10. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

Turn off user defined U/R

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.
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4. In the Attribute list, select User defined U/R.

5. Set Mode to Set Off.

6. If required, set Entity type and Material to make the command easier to
apply.

7. In the model, click those column/wall stacks, beam spans, or objects for
which you want to turn off user defined U/R.

8. Continue by clicking the desired stacks/spans/objects or press Esc to
finish.

See also

Apply user defined utilization ratios (page 786)

Copy web openings
If necessary, you can copy web opening properties from one member to
others. Do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Web Openings. 

The members in the model are color coded based on whether you can
copy web opening properties from them.

5. In the model, click the member from which you want to copy web opening
properties.

6. Click the members to which you want to copy the web opening properties.

The properties are copied to the selected members.

Copy westok openings
If necessary, you can copy westok opening properties from one member in
your model to others. Do the following:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Westok Openings. 

The members in the model are color coded based on whether you can
copy westok opening properties from them.

5. In the model, click the member from which you want to copy westok
opening properties.
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6. Click the members to which you want to copy the westok opening
properties. 

The properties are copied to the selected members.

Review and modify wind drift checks
You can graphically review wind drift check results, set the members to be
checked and set the check limits for columns and walls.

Review wind drift checks

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Review.

Set wind drift checks on or off

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Set wind drift checks on and set the ratio limit

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Set On.

6. Select Set limit ratio.

7. Specify the required Wind drift ratio limit
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8. In the model, click the column or wall for which you want to set the limit.

9. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

9.3 Review tabular data
The Tabular Data command allows you to view design summaries, sway &
drift results, material lists, connection resistances and more in tabular views.
Tabular data can be filtered, sorted and exported to Excel.

• Review design summary tabular results (page 898)

• Review sway check tabular results (page 900)

• Review story shear tabular results (page 900)

• Review drift check tabular results (page 901)

• Review wind drift check tabular results (page 902)

• Review connection resistance tabular results (page 817)

• Review material list tabular results (page 902)

• Review floored area tabular results (page 929)

• Filter tabular data (page 929)

• Export tabular results to Excel (page 930)

Review design summary tabular results
To review a tabular design summary:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Design Summary

4. In the Result Type group, select the analysis type for which the design
summary is required.

5. In the Material Type group, select the material.
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The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

6. In the Characteristic group, select the required characteristic.

The available selections in the Construction group are reduced to those
appropriate to the selected characteristic.

7. If applicable, in the Construction group, select the construction.

The available selections in the Fabrication group are reduced to those
appropriate to the selected construction.

8. In the Fabrication group, select the fabrication.

The tabular design summary is displayed for every entity of the selected
material and type in the structure.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 929)
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See also

Export tabular results to Excel (page 930)

Review member design (page 849)

Review sway check tabular results
For those stacks to which the check has been applied, the elastic critical load
factor is calculated in both directions.

NOTE Sway results are not relevant to models that use the ACI/AISC head
code.

To review tabular sway check results:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Sway

4. In the other groups of the Review Data ribbon, make the necessary
selections to filter the results.

TIP If there are a lot of columns in the building - in order to quickly
determine the smallest elastic critical load factor in each direction,
simply click the αDir1 header until the columns are arranged in increasing
order, then repeat for αDir2 .

See also

Review and modify sway checks (page 893)

The sway check (page 1152)

Review story shear tabular results
To create a tabular floored area summary:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Inter-story Shear or Cumulative Story Shear as required.
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A table of story shears is displayed.

See also

Inter-story shear and cumulative story shear (page 901)

Inter-story shear and cumulative story shear
The Inter-story Shear (also known as Floor Forces) table displays the sum of
the lateral forces applied at each level in the structure.

Cumulative story shears are calculated by summing the floor forces from the
top to the bottom of the structure, consequently they should get bigger as you
move down.
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Review drift check tabular results

NOTE Drift results are only relevant to models that use the ACI/AISC head
code.

To review tabular drift check results:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Drift

4. In the other groups of the Review Data ribbon, make the necessary
selections to filter the results.

See also

Review and modify drift checks (page 879)

The drift check (page 1154)

Review wind drift check tabular results
To review tabular wind drift check results:

1. Open a view and change the view regime (page 280) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Wind Drift

4. In the other groups of the Review Data ribbon, make the necessary
selections to filter the results.

See also

Review and modify wind drift checks (page 897)

The wind drift check (page 1156)
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Review material list tabular results
The material content of the model can be readily assessed in the form of a
Material List. This can be created and viewed either in a tabular data view or a
report, according to your needs.

• Material List tabular data view:

• created for a specific material and entity type

• displayed on screen (not suitable for direct printing)

• can be sorted in ascending/descending order of a column by clicking a
column heading

• row content can be located within a 3D view by double-clicking a row

• can be exported to a spreadsheet

• Material List report:

• created for multiple materials and entity types

• displayed in a format suitable for printing

• can be exported to a spreadsheet

Two levels of content can be generated:

• Summary Only - this is the default level and is very condensed, for
example:

• total quantities only for each beam/ column section size

• total quantities for each slab

• total weight of reinforcement (by mass, and by mass/unit volume)

• Detailed - this is a longer report, for example:

• quantities for each span/ stack/ panel for each concrete beam /
column / wall

• quantities for each section size of a given length for beams and
columns in other materials

• quantities for each slab item

• quantities for individual reinforcement bar/mesh types

The topics in the section all relate to the tabular data view. To find out how to
create a material list report, see: Material Listing report (page 959)

Create material list tabular results
To create a material list as tabular data:

1. Open a view and change the view regime (page 280) to Review View.
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2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Material List

4. In the Material Type group, select the material.

The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

NOTE To find out exactly what summary and detailed level output is
produced for each material type and characteristic, see:

• Steel material lists (page 907)

• Concrete material lists (page 913)

• Timber material lists (page 924)

• Cold formed material lists (page 926)

• General material lists (page 927)

5. In the Characteristic group, select the required characteristic.

The available selections in the Construction group are reduced to those
appropriate to the selected characteristic.

6. If applicable, in the Construction group, select the construction.
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The available selections in the Fabrication group are reduced to those
appropriate to the selected construction.

7. In the Fabrication group, select the fabrication.

The available selections in the Content group are reduced to those
appropriate to the selected fabrication.

8. In the Content group, select the content.

9. If you have selected Members in the Content group, you have the option
to create a summary or a detailed report by selecting/unselecting
Summary Only in the View Type group.

The tabular material list is displayed for every entity of the selected
material and type in the structure.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 929)

See also:

• Steel material lists (page 907)
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• Concrete material lists (page 913)

• Timber material lists (page 924)

• Cold formed material lists (page 926)

• General material lists (page 927)

Locate material list rows in a 3D view
Double-clicking on a specific row in the material list tabular data view locates
where the row content is in the model by highlighting it in a 3D view.

TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.
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Export material list to Excel
1. Create the material list and ensure that it contains the necessary

information.

2. On the Review Data ribbon tab, click Excel.

3. Click Yes to confirm exporting the report. 

The material list opens in Excel

Material lists for steel

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

• Composite beam reports also include the number of connectors, the
transverse reinforcement associated with the beam (at detailed level only),
and the weight of reinforcement

Construction Fabrication Content View Type Description
Composite • Rolled

• Plated

• Westok
Plated

• Fabsec
Plated

• DELTABEA
M

Members Summary One row for
each size:

size, grade,
number (of
that size), no.
of connectors,
total length,
mass, surface
area,
reinforcement

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length), no. of
connectors,
length, mass,
surface area,
reinforcement
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Construction Fabrication Content View Type Description
Loose Bars Detailed One row for

each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Westok
Cellular

Members Summary One row for
each size:

size, grade,
number (of
that size), no.
of connectors,
total length,
gross mass,
net mass,
gross surface
area, net
surface area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length), no. of
connectors,
length, gross
mass, net
mass, gross
surface area,
net surface
area

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Review models 908 Review tabular data



Construction Fabrication Content View Type Description
Mesh Mesh One row for

each type:

type, unit
mass, total
area, total
mass

Non-
composite

• Rolled

• Plated

• Westok
Plated

• Fabsec
Plated

• DELTABEA
M

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

Westok
Cellular

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
gross mass,
net mass,
gross surface
area, net
surface area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, gross
mass, net
mass, gross
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Construction Fabrication Content View Type Description
surface area,
net surface
area

Columns, Braces, Joists

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristi
c

Fabrication Content View Type Description

Columns • Rolled

• Plated

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

• Concrete
Filled

• Concrete
Encased

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
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Characteristi
c

Fabrication Content View Type Description

length),
length, mass

Encase/Fill Detailed One row for
each size:

size, grade,
number (of
that size),
length, mass

Braces Rolled Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

Joists N/A Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass
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Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type Description
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Portal Frames

Characteristic Content View Type
Portal Frames Members Detailed

Trusses

Characteristic Content View Type
Trusses Members Detailed
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Material lists for concrete

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column. This can be useful for example when wanting to sort
members by how much reinforcement they contain.

Beams and Columns

NOTE • Summary reports provide total quantities for each section size

• Detailed reports provide quantities on a span/stack basis

• When group design is active this reduces to every detailing group
span/stack

• Reinforcement running between spans/stacks is shared

• No additional detailing allowance has been applied

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristi
c

Fabrication Content View Type Description

Beams Cast-in-place Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each span:

Group/
Member ref.,
section
geometry,
size, grade,
number (of
that ref),
length, mass,
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Characteristi
c

Fabrication Content View Type Description

surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each span:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume
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Characteristi
c

Fabrication Content View Type Description

Post-
tensioned

Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each span:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume

Columns Cast-in-place Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
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Characteristi
c

Fabrication Content View Type Description

mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each stack:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume
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Walls

NOTE • Summary reports provide total quantities for each wall

• Detailed reports provide quantities on a wall panel basis

• Reinforcement running between panels is shared

• No additional detailing allowance has been applied

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristi
c

Fabrication Content View Type Description

Walls Cast-in-place Members Summary One row for
each wall:

reference,
gross mass,
mass, gross
surface area,
surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each panel:

Member
reference,
gross mass,
mass, gross
surface area,
surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass
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Characteristi
c

Fabrication Content View Type Description

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each wall:

reference,
gross mass,
mass, gross
surface area,
surface area,
volume

Detailed One row for
each panel:

Member
reference,
gross mass,
mass, gross
surface area,
surface area,
volume

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis
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• Patch and punching reinforcement is approximately distributed by sharing
it equally between slab items it touches - it is not split based on covered
areas

• Reinforcement allows for laps at the slab item boundary

• An approximate user defined additional detailing allowance (specified in
Design Settings for cast-in-place slabs) is applied to all reinforcement
defined in any slab type.

• Punching reinforcement weight is approximated (based on ACI guidance)

• Precast and post-tensioned slabs are not designed, but the reinforcement
that is specified in the slab properties is reported. The post-tensioned
tendon information is not reported and must be allowed for in some
other way.

Construction Fabrication Content View Type Description
Composite N/A Members Summary One row for

each slab:

level, slab,
depth,
manufacturer,
reference,
gauge, grade,
mass, gross
surface area,
net surface
area, volume,
reinforcement

Detailed One row for
each slab
item:

level, slab,
depth,
manufacturer,
reference,
gauge, grade,
mass, gross
surface area,
net surface
area, volume,
reinforcement

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
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Construction Fabrication Content View Type Description
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Non-
composite

Cast-in-place Members Summary One row for
each slab:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Detailed One row for
each slab
item:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
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Construction Fabrication Content View Type Description
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Precast Members Summary One row for
each slab:

level, slab,
depth,
manufacturer,
reference,
unit depth,
topping,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement

Detailed One row for
each slab
item:

level, slab,
depth,
manufacturer,
reference,
unit depth,
topping,
grade, mass,
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Construction Fabrication Content View Type Description
gross surface
area, net
surface area,
volume,
reinforcement

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Post
Tensioned

Members Summary One row for
each slab:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Detailed One row for
each slab
item:

level, slab,
type, depth,
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Construction Fabrication Content View Type Description
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Punching checks

NOTE The weight of punching shear rails is approximated based on ACI guidance.

Content View Type Description
Stud Rails Detailed One row for each rail ref:

ref., diameter,stud
height, studs per rail,
stud spacing, rail length,
total no. of rails, approx.
mass
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Pad Bases, Pile Caps and Piles

NOTE • Reports provide quantities for each individual base

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristic Content View Type Description
• Pad Bases

• Pile Caps

Members Detailed One row for each
base:

member
reference, grade,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for each
type:

type, unit mass,
total length, total
mass

Mesh Detailed One row for each
type:

type, unit mass,
total area, total
mass

Piles Members Detailed One row for each
pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Material lists for timber

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.
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Beams, Columns, Braces

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristic View Type Description
• Beams

• Columns

• Braces

Summary One row for each size:

size, grade, number (of
that size), total length,
mass

Detailed One row for each size &
length:

size, grade, number (of
that size & length),
length, mass

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type Description
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Trusses

Characteristic Content View Type
Trusses Members Detailed

Material lists for cold formed

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams, Columns, Braces

Characteristic Content View Type Description
• Beams

• Columns

• Braces

Members Summary One row for each
size:

size, grade,
number (of that
size), total length,
mass, surface
area

Detailed One row for each
size & length:

size, grade,
number (of that
size & length),
length, mass,
surface area
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Trusses

Characteristic Content View Type
Trusses Members Detailed

Material lists for general materials

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams, Columns, Braces

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristic Content View Type Description
• Beams

• Columns

• Braces

Members Summary One row for each
size:

size, grade,
number (of that
size), total length,
mass, surface
area

Detailed One row for each
size & length:

size, grade,
number (of that
size & length),
length, mass,
surface area
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Walls

Characteristic Content View Type Description
Walls Members Summary One row for each

wall:

reference, gross
mass, mass, gross
surface area,
surface area,
volume

Detailed One row for each
wall:

reference, gross
mass, mass, gross
surface area,
surface area,
volume

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type  
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Review floored area tabular results
To create a tabular floored area summary:

1. If necessary, change the view regime (page 280) to a Review View.

2. On the Review ribbon tab, click Tabular Data. 

A Review Data tab opens on the ribbon and a Review Data View is
displayed.

3. On the Review Data ribbon tab, in the list in the View Type group, select
Floored Area.

A table of floored areas is displayed.

Filter tabular data
You can apply model filters to enable selective display of tabular data. The
filters available depend on the view type displayed.

Create and apply filters
1. In the Filters group of the Review Data tab, select the desired filter type. 

The Select filter items list opens.

2. In the Select filter items list, select the necessary options to define the
filter requirements.

3. Click OK. 

Tekla Structural Designer applies the filter.
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Edit filters

NOTE If a filter type is not applicable for the current tabular data view type, it
will be unavailable.

1. On the Review Data tab, click either Filter Items... 

The Select filter items list opens.

2. In the Select filter items list, select the necessary options to define the
filter requirements.

3. Click OK. 

Tekla Structural Designer applies the filter.

Export tabular results to Excel
1. Create the tabular data view and ensure that it contains the necessary

information.

2. On the Review Data ribbon tab, click Excel.

3. Click Yes to confirm exporting the report. 

The tabular data opens in Excel
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10 Calculate slab deflections

In Tekla Structural Designer you can choose to adopt a rigorous approach to
slab deflection calculation using iterative cracked section analysis.

NOTE Tekla Structural Designer's iterative cracked section analysis for slab
deflections is only available for the Eurocode and ACI/AISC Head Code.

• To begin, see Get started with slab deflection analysis (page 931)

• To define event sequences in Tekla Structural Designer, see Work with
event sequences (page 932).

• To set up the deflection checks and place check lines, see Work with check
lines (page 934).

• To perform the analysis, see Run a slab deflection analysis (page 936)

• To investigate the results, see Slab deflection results and reports
(page 937).

Related video

Rigorous Slab Deflection Design (ACI)

Rigorous Slab Deflection (Eurocode)

10.1 Get started with slab deflection analysis
Two different ways of checking slab deflections in Tekla Structural Designer
are available. Either deemed-to-satisfy checks, or a rigorous theoretical
deflection estimation. These are introduced in the topic Slab deflection
methods (page 1382).

If you decide to adopt the latter approach the video links at the bottom of this
page are a good start point, and the Rigorous slab deflection workflow
(page 1384) topic also provides an overview of the steps required.
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Many topics are then discussed in more detail in the Slab deflection handbook
(page 1381), which also provides Tutorial worked examples for you to
download and work through.

Related video

Rigorous Slab Deflection Design (ACI)

Rigorous Slab Deflection (Eurocode)

10.2 Work with event sequences
Event sequences are edited in the (page 2410).

Add an event to the end of the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Click Add to Add the Event as the last event in the sequence.

4. Name the new event and specify the event parameters according to your
needs. If you want the same parameters to apply to custom events,
ensure the Update custom event sequences box is selected.

5. Click OK.

Insert an event within the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Select the event above which you want to insert the new event.

4. Click Insert to insert the event.

5. Name the new event and specify the event parameters according to your
needs. If you want the same parameters to apply to custom events,
ensure the Update custom event sequences box is selected.

6. Click OK.
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Re-order events in the event sequence
You can Add, Insert, Remove and Re-Order Events from the Model Event
Sequence page.

1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. In the Drawing Variant list, select the Event you want to move.

4. ClickMove Up or Move Down until the Event is in the required position.

5. Click OK.

Remove an event from the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Select the event which you want to remove.

4. Click Remove to remove the event.

5. Click OK.

Edit event parameters
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page, or specific custom event sub
page as required.

3. Edit the event parameters according to your needs. If editing the Model
Event Sequence and you want the same parameters to apply to custom
events, ensure the Update custom event sequences box is selected.

4. Click OK.

Edit event loadcases
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page, or specific custom event sub
page as required.
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3. In the left hand pane, expand the Event Sequence if required so that you
can select the Event. 

The available and included loadcases are displayed.

4. Move loadcases between the available and included lists as required. If
editing the Model Event Sequence and you want the same loadcases to
apply to custom events, ensure the Update custom event sequences
box is selected.

5. Click OK.

Create a custom event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Event Sequences sub page.

3. Click Add to add a new Custom Event.

4. In the right hand pane click on the event name to rename it.

5. In the left hand pane click on the event name in order to define the event
parameters in the sequence.

6. Click OK.

Apply a custom event sequence to a submodel
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Submodels sub page. 

The table displays the event sequence assigned to each submodel.

3. Use the droplist to change the Event Sequence assigned to a specific
submodel as required.

4. Click OK.

10.3 Work with check lines
User defined Check Lines can be placed across 2D element meshes, They are
similar to 2D results strips, (but with zero width and different properties).
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From these check lines, deflection results are determined from the shell/plate/
membrane nodal analysis results - these can then be checked against
specified limits for slab design purposes.

Engineering judgment is required when positioning the check lines to ensure
worst case deflections are obtained.

Create the deflection checks to be applied to check lines
1. On the Slab Deflection tab, click Deflection Checks 

The Slab Deflection Check Catalogue (page 2425) is displayed, containing
any checks that have been defined.

2. Click Add 

A new check is created in the table.

3. Select the name in order to give it a more descriptive title.

4. Choose the check Type: (Total, Instantaneous, or Differential).

a. If the Type is Differential, select the Start Event from the droplist.

5. Select the Event to check from the droplist.

6. Enter the Deflection Limit to be checked.

7. Select Use in new Check Lines if you want this check to be performed in
each check line that is created.

Create a check line
Check lines can only be created while in the Slab Deflections View regime.

1. Open a 2D view of the FE mesh where the check line is to be placed.

2. On the Slab Deflection tab, click Create 

The Check Line properties are displayed in the Properties window.

3. Adjust the properties to specify:

a. The number of stations

b. The upper and lower Flat Zone Reductions

c. Up to 6 deflection checks to be performed (these can either be
selected from the predefined Deflection Checks Catalogue, or a new
check can be defined)

4. Click a point where the strip is to start.

5. Click a 2nd point where the strip is to end. (Neither start or end points
have to match nodes in the mesh.) 

A check line is created between the points that you identified.

Calculate slab deflections 935 Work with check lines



6. Either continue to place further check lines, or if done, press Esc to exit.

Delete a check line
To be able to delete a check line you must first ensure that Slab Deflection
Check Lines are switched on in Scene Content.

1. Open a view displaying the check lines to be deleted.

2. Click or press Delete

3. Click on the check lines to be deleted.

10.4 Run a slab deflection analysis
The same basic analysis process is followed irrespective of whether the
current level (sub-model), a selected level, or all slabs in the model are
analyzed.

In simple terms, events are considered in sequence.

For each event:

• An iterative cracked section analysis including long term effects determines
the deflection at the end of the event.

• An additional analysis using the determined state of cracking along with
short term cracked properties is undertaken to calculate the total
instantaneous deflection associated with the event.

• The state of cracking is carried forward to the next event as the starting
point.

To run the analysis for specific or all sub models see the following instructions.

Run a slab deflection analysis for the current sub model
To analyze a specific sub model:

1. Open a view of the required sub model from the Structure Tree in the
Project Workspace.

2. On the Slab Deflection tab, click Analyze Current At the end of the
analysis the active sub model view switches into a Slab Deflections View
regime and the Results group is available on the ribbon - ready for
reviewing the results graphically.

Run a slab deflection analysis for all sub models
To analyze all sub models:
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1. On the Slab Deflection tab, click Analyze All At the end of the analysis
the active view switches into a Slab Deflections View regime and the
Results group is available on the ribbon - ready for reviewing the results
graphically.

Run a slab deflection analysis for selected sub models
To analyze selected sub models:

1. On the Slab Deflection tab, click Analyze Selected At the end of the
analysis the active view switches into a Slab Deflections View regime and
the Results group is available on the ribbon - ready for reviewing the
results graphically.

10.5 Slab deflection results and reports
Click the links below to find out more:

• Display slab deflection analysis results (page 937)

• Display check line results (page 939)

• Display slab deflection status and utilization (page 940)

• Slab deflection optimization (page 942)

• Slab Deflection Reports

• Slab Reinforcement (page 868)

Display slab deflection analysis results
Once a slab deflection analysis has been performed analysis results can be
reviewed for the chosen level (sub-model), or the entire structure - dependent
upon your chosen analysis.

The following results are available for display in the Slab Deflections View
regime by making appropriate selections from the Results group of the Slab
Deflection ribbon.

• Deflections.

• Extent of Cracking at any load event.

• Relative Stiffness in a particular result direction for any specified event.

• Effective Reinforcement for a chosen result direction for each FE
element.

Calculate slab deflections 937 Slab deflection results and reports



Display deflection contours
Three deflection types are available for review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End of
Event).

For further details, see: Interrogating slab deflection calculations
(page 1408)

• Instantaneous deflection (not actually needed for TR 58).

• This is the deflection when the entire event loading is applied to a
version of the model using the established extent of cracking along with
short term analysis properties.

• US codes require an assessment of the instantaneous deflection
associated with the imposed load only. This is achieved by adding extra
events at the same time as the final event where only the required
imposed load is applied.

To display deflection contours:

1. From the Slab Deflection ribbon Results group Result list select
Deflections

2. Then from the same group:

a. Make your selection from the Result Direction list

b. Make your selection (Instantaneous, Total, or Differential) from the 
Result Type list

3. From the Results group select the Event, and if viewing differential
deflections also select the Start Event. 

NOTE Hover the cursor over a specific solver node in order to see the
nodal displacement at that location displayed in a tooltip.

Display extent of cracking
1. From the Slab Deflection ribbon Results group Result list select Extent

of Cracking

2. Make your selection from the Result Direction list

3. From the Results group select the Event. 

NOTE Hover the cursor over a specific solver element in order to see the
detailed cracking calculation parameters for that element
displayed in a tooltip.
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Display relative stiffness
1. From the Slab Deflection ribbon Results group Result list select Relative

Stiffness

2. Make your selection from the Result Direction list

3. From the Results group select the Event. 

NOTE Hover the cursor over a specific solver element in order to see the
detailed relative stiffness calculation parameters for that element
displayed in a tooltip.

Display effective reinforcement
1. From the Slab Deflection ribbon Results group Result list select

Effective Reinforcement

2. Make your selection from the Result Direction list 

NOTE Hover the cursor over a specific solver element in order to see the
detailed effective reinforcement calculation parameters for that
element displayed in a tooltip.

Display check line results
Once a slab deflection analysis has been performed, the Check Line results are
available for display in the Slab Deflections View regime.

Display deflections along all check lines
1. From the Slab Deflection ribbon Check Lines group click Deflections 

The deflected shape of each check line and an accompanying legend is
displayed in the current view.

For clarity you may want to switch off other results to obtain a clearer
view.

Display detailed deflections and average slopes along an individual
check Line
1. Right click on the check line you want to view and select Open deflections

check view from the context menu that is displayed.

2. Select the Result Type and the Event from the Loading Analysis toolbar. 

The deflections and average slopes are displayed in a deflections view.
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Display check line status and utilization
Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio

Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check lines
are automatically re-checked so you will obtain instant feedback on status and
utilization.

To view check line status or utilization:

1. From the Slab Deflection ribbon Check Lines group

• Click Status

• Click Utilization

Color codes are used to graphically display the status or utilization of each
Check Line.

Display slab deflection status and utilization
Once a slab deflection analysis has been performed, the Slab deflection status
and utilization are available for display in the Slab Deflections View regime.

Display slab deflection status
1. From the Slab Deflection ribbon Slab Deflection group click Status 

Color codes are used to graphically display the status of each slab item.
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In the screenshot below;

• No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so the
slab reports Unknown as no checks have been performed

• One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.

• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, all other slab items Fail.

Display slab deflection utilization
1. From the Slab Deflection ribbon Slab Deflection group click Utilization 

Color codes are used to graphically display the utilization of each slab
item.

Calculate slab deflections 941 Slab deflection results and reports



The worst utilization from all associated check lines is displayed.

Slab deflection optimization
If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

View slab deflection reports
A Slab Deflection Check Lines report can be generated for multiple check lines
from the Reports toolbar. The same report can also be generated for
individual check lines from the right click menu.
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View an individual check line report
1. Right click on the check line you want the report for and select Report for

Member from the context menu that is displayed. 

A report is displayed consisting of a defection check summary table.

NOTE Optionally the report can be configured to include a picture
showing the Check Line location within the slab, (by clicking
Member Report on the Reports ribbon and choosing the Slab
Deflection Check Line as the Member Type.)

View all/multiple check line reports
1. From the Report tab click Model Report... 

A report is displayed consisting of a defection check summary table.

2. Create a report that includes the Slab Deflection Check Lines chapter
(located under Concrete>Slab/Mat Design per Plane).

3. Apply Model filters to the report as required.

View an effective modulus report
A slab Effective Modulus Report can be exported to Excel for an individual slab
panel, or all panels.

1. Right click on a slab panel and select Export Eff. Modulus Report to
Excel from the context menu that is displayed.

2. Choose whether to export for the current slab item, or all slab items from
the sub menu that is displayed. 

The report opens in Excel, (assuming Excel is installed).
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11 Create reports and drawings

Having designed your model in Tekla Structural Designer you can then output
the results in the form of reports and/or drawings.

11.1 Create and modify reports
You can tailor a wide range of different reports according to your needs by
using the Report toolbar.

NOTE Initially, only the Contents group and Filters group are displayed on
the Report toolbar. Only when a report is displayed and the Report
View is active, do the Appearance group, Navigation group, and
Export group become available.

Report terminology
The following terms are used to described specific aspects of the report
creation process in Tekla Structural Designer.

Model reports
Model reports are used to set up the printed output for either the entire
structure or a part of it. Model reports are configured by selecting specific
output categories (referred to as chapters) in a list of all the available output
categories. You can include entire chapters, or just the headings within the
chapter you require.

The combination of selected chapters is referred to as the report structure. If
necessary, you can apply filters to individual headings in the report structure
to limit the output that is produced.

Model report chapters include:
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• Structure:

Structure data (under headings such as Loadcases or Wind Data).

• Analysis:

Analysis model properties and results

• Concrete, Steel, Timber, Cold Formed, Cold Rolled, and General Material:

Member reports for each different member types. Each member report
can be configured to contain as much or as little output as needed. You can
also decide to include design summary tables for the members that Tekla
Structural Designer can design.

• Beam End Forces, Bracing Forces, and Foundation Reactions:

Chapters for specific sets of analysis results.

• Picture:

A 3D view of the entire structure. Applying model filters also allows you to
view a picture of selected sub structures, frames, or levels. If necessary,
you can also include applied loads in the picture by applying a load filter.

• View:

The current display in any 2D or 3D view can be saved as a view
configuration, and then, included in the model report as a View chapter.

• Analysis Diagram:

A 3D diagram of the entire structure. Applying model filters also allows you
to view a picture of selected sub structures, frames, or levels. If necessary,
you can also display the analysis results by applying an analysis method
filter.

• Material Listing:

Tabulated quantities of materials.

• Revision History:

The revision history that has been recorded in the Project Wiki.

Member reports
Member reports are only output as part of a created model report or by right-
clicking on an individual member and selecting Report for Member.

Member report chapters include:

• Picture:

The 3D view that you receive by right-clicking a member and selecting
Open [element name] view.

• Drawing:

The DXF file that you receive by right-clicking a member and selecting
Generate Detailing Drawing...
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• Loading:

The table that you receive by right-clicking a member and selecting Show
Member Loading.

• Different force diagrams and Deflected Shape Diagram:

The diagrams that you receive by right-clicking a member and selecting
Open Load Analysis View.

Active model report
The active model report is the default report displayed in the list on the left
corner of the Report toolbar, unless another report view is already active.

To specify the active model report, do the following:

1. On the Report tab, click Model Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select the desired report.

3. Click >> Active.

Active member report
The active member report is the report that is generated when you right-click
a member in a 2D or 3D view and select Report for Member.

To specify the active model report, do the following:

1. On the Report tab, click Member Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select the desired report.

3. Click >> Active.

Active and inactive chapters
In the Report Contents dialog box, each chapter in the report structure is
marked as either active or inactive. Only the chapters that are marked as active
are included in the report that you generate.

Report filters
You can use filters to limit the amount of output in the report.

Tekla Structural Designer offers the following filters for different data types:

• Model filters:

If necessary, you can filter the report for selected levels, frames, or planes.
You can also filter certain data types for selected beams, columns, or walls.
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If you have applied user-defined attributes to your model, you can also use
them to filter the report output.

• Loading filters:

If necessary, you can filter the report for selected loadcases and
combinations.

Available styles
A number of sample reports are available in the Available Styles list of the
Report Contents dialog box. The reports serve as templates and can be
modified to suit the model in question. If you cannot find a report that can be
customized to meet your needs, you can add further reports to the list by
clicking Add.

If you start a new project, the same default reports are available. However,
they are reset to the default report structures. It is not currently possible to
save customized reports from the Report Contents dialog box to apply them
to other projects.

Create reports
Tekla Structural Designer allows you to create two kinds of reports: you can
either create a report based on the entire model or an individual member in
the model.

Configure and display model reports
To create model reports and display them, see the following instructions.

Configure a model report

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. Select the report:

• To select an existing report, click the report name in the Available
Styles list.

• To add a report, click Add and type the report name in the Active
Style field.

3. Review the report structure and modify it (page 950) according to your
needs.

4. To limit the output to selected levels, frames, planes, or sub structures,
apply a model filter (page 951). 

Create reports and drawings 947 Create and modify reports



TIP You can further limit the output of Loadcases and Combinations
sub chapters by applying a loading filter (page 951).

5. If you have created specific view configurations for the model and want to
include them in the report, include a separate View chapter for each view
configuration.

6. If the report structure includes any member chapters (such as beams,
columns, or walls), select an appropriate member report style for each
member chapter.

7. Click OK. 

NOTE If you have included a drawing in the report structure, specify
appropriate settings for the drawing as follows:

a. Right-click the drawing in the report structure.

b. Click Settings...

c. Define the drawing settings according to your needs.

d. Click OK.

Display a model report

1. In the list on the far left of the Report tab, select the report that you want
to view.

2. On the Report tab, click Show Report. 

Tekla Structural Designer displays the report in a new window. If the
report contains loading analysis views of individual members (such as
force diagrams or pictures), the views are displayed for each member type
according to the selected member report style.

See also

Export reports (page 957)

Print reports (page 957)

Format reports (page 952)

Configure and display member reports
To create member reports, see the following instructions.

Configure a member report

1. On the Report tab, click Member Report... 

The Report Contents dialog box opens.

2. In the Member Type list, select the desired member.
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3. Select the report:

• To select an existing report, click the report name in the Available
Styles list.

• To add a report, click Add and type the report name in the Active
Style field.

4. Review the report structure and modify it (page 950) according to your
needs.

5. To control the level of output, modify the report structure (page 953) or
loading filters according to your needs.

6. Click OK. 

NOTE If you have included a drawing in the report structure, specify
appropriate settings for the drawing as follows:

a. Right-click the drawing in the report structure.

b. Click Settings...

c. Define the drawing settings according to your needs.

d. Click OK.

Display a member report

1. Ensure that you have selected and activated the member report style
(page 949).

2. Hover the mouse pointer over the desired member.

3. Once the outline of the member is high-lighted, right-click the member.

4. In the context menu, select Report for Member. 

Tekla Structural Designer opens a report for the selected member in a
new window.

See also

Format reports (page 952)

Export reports (page 957)

Select the member report style
Different member report styles produce different levels and types of output
both in model reports and member reports. To select the member report
style, see the following instructions.
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Select the member report style used in a model report

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. Select the desired report type.

3. Right-click the member chapter in the report structure.

4. In the context-menu, go to Style.

5. Click the desired member report style.

Select the member report style used in an individual member report

1. On the Report tab, click Member Report... 

The Report Contents dialog box opens.

2. In the Member Type list, select the desired member.

3. In the Available Styles list, select the desired member report style.

4. Click >> Active.

See also

Configure and display member reports (page 948)

Configure and display model reports (page 947)

Format reports (page 952)

Export reports (page 957)

Modify the report structure
Once you have selected the report type, you can modify the report structure
according to your needs. For more information, see the following instructions.

To aid the report structuring process, an option is provided to display the
structure as either a Flat, or a Hierarchical layout.

1. According to your needs, click either Model Report... or Member
Report... 

The Report Contents dialog box opens.

2. In the Report Contents dialog box, do one or more of the following:

• To include chapters and options in the report, drag them from the left
column to the right column.

• To remove unwanted chapters and options permanently from the
report, drag them from the right column to the left column.

• To exclude a specific chapter from the report but maintain the current
report structure, right-click the chapter and clear the Active option.

Create reports and drawings 950 Create and modify reports



• To re-arrange the report order, drag and drop chapters within the right
column.

• To apply a filter to a chapter, right-click the desired chapter. For more
information, see Filter reports (page 951).

TIP In View Mode, you can select if you want to display the structure as
flat or hierarchical.

3. Click OK.

See also

Configure and display member reports (page 948)

Filter reports
Tekla Structural Designer contains two main categories of filters that you can
apply to chapters in the report structure. The categories are model filters and
loading filters. For more information, see the following paragraphs.

You can apply model filters to enable selective output based on selected:

• Levels

• Frames

• Planes

• Groups

• Members

• Trusses

• Portal frames

• UDAs

Using loading filters enables selective output based on selected:

• Load cases

• Combinations

• Envelopes

See also

Configure and display model reports (page 947)

Create filters
1. In the Filters group of the Report tab, select the desired filter type. 

The Edit filters dialog box opens.
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2. Click Add.

3. Type a name for the new filter.

4. In the Selected items list, select the necessary options to define the filter
requirements.

5. Click OK. 

Tekla Structural Designer creates the filter. You can now apply the filter to
a specific report.

TIP If you create a member filter, you can later review and modify it
graphically by clicking Report Filter on the Review tab.

Apply filters

NOTE If a filter type is not applicable for the selected chapter, it will be
unavailable.

1. On the Report tab, click either Model Report... or Member Report... 

The Report Contents dialog box opens.

2. Select the report that you want to filter. 

In the right column, any chapters that can be filtered are displayed in blue
text.

3. Right-click a chapter.

4. In the context menu, select the desired filter type and filter name. 

TIP If you cannot find an appropriate filter, do the following:

a. In the context menu, go to the filter type and click Edit\New...

b. In the Select filter dialog box, click Add.

c. Type the name of the filter in the Active filter field.

d. In the Selected items list, select the necessary options to define
the filter requirements.

e. Click OK.

5. Click OK. 

Tekla Structural Designer applies the filter to the selected report chapter.
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Format reports
Tekla Structural Designer allows you to customize the appearance of reports in
a number of ways. You can, for example, configure paragraphs styles and
tables, and adjust header and footer information.

Adjust and apply report settings
Report settings allow you to modify the appearance of reports. You can adjust,
for example, paragraph styles, page margins and numbering, tables, and
headers or footers.

1. On the Report tab, click Settings. 

The Settings dialog box opens.

2. In the Settings dialog box, do one or more of the following to adjust the
report settings:

To Do this
Customize the paragraph styles in the different
areas of the report

a. Go to the Styles page.

b. Adjust the settings according to your
needs.

Adjust the page margin width, page numbering,
and margin frame

• Go to the Page Options page.

• Adjust the settings according to your needs.

Adjust the appearance of tables • Go to the Table Options page.

• Adjust the settings according to your needs.

Define whether headers and footers are
displayed, adjust image width and paragraph
spacing, and control page breaks

• Go to the Document Options page.

• Adjust the settings according to your needs.

Adjust the appearance of fonts used in pictures
and force diagrams

• Go to the Picture Fonts page.

• Adjust the settings according to your needs.

3. Click OK. 

Provided that you adjusted the report settings of an active settings set,
the new report settings are applied to the report.

See also

Report settings (page 2394)

Adjust report headers and footers
Tekla Structural Designer provides you with default page header and footer
layouts for your reports. However, you can also create, use and save different
layouts according to your needs.

Enter company details in the header

1. On the Report tab, create the desired report and click Show Report. 

The report is displayed.
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2. On the Report tab, click Edit Header. 

The Document headers/footers dialog box opens.

3. Go to the Headers page.

4. In the Available layouts list, select an existing layout that contains an
Address cell.

5. Go to the Fields page.

6. In the Available fields list, select Address.

7. In the list on the right, select the necessary company details and click <<
to include them in the report.

8. To define the text displayed in each included field, select the field in the
left Available fields list and type the desired text in the Displayed value
field.

9. To insert the company logo in the header, select Company Logo in the
left Available fields list and click ... to browse to the desired image. 

TIP • Large logos are automatically resized to within the column width
in which they are placed. However, using smaller images in PNG
format saves memory and speeds up exporting reports.

• To include more images in the header, click Add Image Field,
type a name for the field and selected the desired image.

10. Click OK. 

The company details are displayed in the report header.

Enter project-specific details in the header

1. On the Home tab, click Project Wiki. 

The Project Wiki dialog box opens.

2. On the Project Summary page, type the project details in the available
fields.

3. Click OK. 

The project details are saved.

NOTE When you go back to the Report tab, remember to update the
report to display the project details in the header.

Create a new header or footer layout

1. On the Report tab, create the desired report and click Show Report. 

The report is displayed.
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2. On the Report tab, click Edit Header. 

The Document headers/footers dialog box opens.

3. According to your needs, go to the Headers or Footers page.

4. In the Available layouts section, click New.

5. Type a name for the new layout in the Name field.

6. According to your needs, do some of the following to adjust the header
layout:

To Do this
Remove an existing field and create an empty
shell

a. Hover the mouse pointer over the field in
the Current layout section until the field
name is highlighted.

b. Click the field that you want to remove it
and replace it with an empty cell.

Place a field into an empty cell or replace an
existing field

• Hold down the left mouse button and drag
the field from the Available fields list into
the desired cell.

Merge cells • Hold down the left mouse button and drag
over the cells that you want to merge.

NOTE To unjoin previously merged cells, right-
click the merged cell and in the context
menu, select Unjoin.

Modify the field alignment within a shell a. Right-click the required cell in the layout.

b. In the context menu, set the horizontal and
vertical alignment options as required.

Insert or remove rows or columns or change
their alignment

a. Right-click the layout.

b. In the context menu, select the desired
command.

Change column type, width and alignment in the
layout

a. Under the Current layout section, click
Edit...

b. Adjust the column properties according to
your needs.

c. Click OK.

7. Click OK. 

The new layout is created.

Navigate reports
Use the Report Index to quickly navigate to a specific section in a report.
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You can also use the buttons in the Navigation group of the Report toolbar to
move through the report pages.

Navigation using the Report Index
Open a report view then:

1. In the Navigation group of the Report toolbar, select Report Index 

The Report Index tab is displayed in the Project Workspace.

2. Click the Report Index tab in the Project Workspace.

3. Click on a specific heading or sub heading Report Index to move to that
section in the report.

Navigation buttons in the Report toolbar
Open a report view then:

• Click  to move to the first page

• Click  to move to the previous page

• Click  to move to the next page

• Click  to move to the last page

• Click  to open the Report Index in the Project Workspace
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Export reports
Tekla Structural Designer allows you to export your reports to PDF format,
Microsoft Word, Excel, and Tekla Tedds. For detailed instructions, see the
following paragraphs.

Export a report to PDF
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click PDF.

3. Click Yes to confirm exporting the report. 

The report opens as a PDF file.

Export a report to Microsoft Word
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Word.

3. Click Yes to confirm exporting the report. 

The report opens in Microsoft Word.

Export a report to Excel
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Excel.

3. Click Yes to confirm exporting the report. 

The report opens in Excel

Export a report to Tekla Tedds
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Tedds.

3. Click Yes to confirm exporting the report. 

The report opens in Tekla Tedds

Print reports
To print any reports that you require, see the following instructions.

1. Create the report and click Show Report. 

Tekla Structural Designer displays the report.
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2. On the File menu, go to Print --> Print...

3. Adjust the printing settings according to your needs.

4. Click OK.

Example reports
Tekla Structural Designer provides a number of standard reports that are
installed by default. Even though the standard reports may not match your
exact requirements, they can often serve as templates that you can modify
according to your needs.

Solver model data report
By default, the report contains a picture of the model and the following tables
of analysis model input data:

• Nodes

• Node support details

• Elements

• Element members

• Element properties

• Contains to PDF

To display a solver model data report, do the following:

1. In the list on the left side of the Report toolbar, select Solver Model Data.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Building loading report
By default, the report contains a picture of the model and the following tables
of loading related input data:

• Action codes

• Resistance codes

• Combinations

• Wind data

To display a building loading report, do the following:

1. In the list on the left side of the Report toolbar, select Building Loading.
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2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Building analysis checks report
By default this report contains the following tables:

• Load case summary

• Analysis drift results

• Analysis sway results

To display the building analysis checks report, do the following:

1. In the list on the left side of the Report toolbar, select Building Analysis
Checks.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Building design report
By default, the report contains the design results for the building at a
summary level.

To display a building design report, do the following:

1. In the list on the left side of the Report toolbar, select Building Design.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Material listing report
To configure and then display a material listing report, do the following:

1. On the Report ribbon, select Material Listing from the list in the
Contents group.

2. Click Model Report... 

The Report Contents dialog box opens.

3. The default report is created for all materials and entity types in the
model and includes all associated properties. If required you can
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configure which materials/entity types are to be included in the report
and also choose to exclude properties that you don't require. This is done
as follows:

a. Right-click on the Material Listing chapter in the Report Structure
and choose Options from the context menu.

b. Uncheck those materials/entity types and any properties that you
don't want to include in the report.

4. The default report is created for the whole structure. If required you can
configure a filter to limit the report to selected floor levels only, or other
criteria as follows:

a. right-click on the Material Listing chapter once again and choose
Model Filter > Edit/New

b. Click Add
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c. Select the type of filter

d. Select the items to be included

e. Click OK

5. To choose between a summary or detailed report, right-click on the
Material Listing chapter once again and choose Settings

• Uncheck Show summary only for a detailed report

• Leave it checked for a summary report

NOTE To find out exactly what summary and detailed level output is
produced for each material type and characteristic, see:

• Steel material lists (page 907)

• Concrete material lists (page 913)

• Timber material lists (page 924)

• Cold formed material lists (page 926)

• General material lists (page 927)

6. Click OK to close the settings dialog.

7. Click OK to close the Report Contents dialog. The report is displayed
according to the configuration choices that you have applied.

Beam end forces report
The report is typically generated for steel or timber beams in order to provide
connection design forces in one of the following configurations:

• End 1/End 2:

6 forces are output in the support's local co-ordinate system for the
selected load cases, combinations, or envelopes. For each end of each
beam span, a single row of data is output for load cases, combinations, or
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envelopes in the selected loading filter (Fx, Fy, Fz, Mx, My, Mz). Select this
option if you intend to design the connections at both ends of each beam
independently.

• End 1/End 2 + Coincident:

For each end of each beam span, a separate row is output for each load
case, combination, or envelope according to the applied loading filter for
the maximum and the minimum of each of the 6 forces that are output. In
addition, the report contains the coincident forces in the other directions.

Up to 12 rows of data can be output for a load case, combination, or
envelope as follows:

• maximum: Fx (+ coincident Fy, Fz, Mx, My, Mz)

• minimum: Fx (+ coincident Fy, Fz, Mx, My, Mz)

• maximum: Fy (+ coincident Fx, Fz, Mx, My, Mz)

• minimum: Fy (+ coincident Fx, Fz, Mx, My, Mz)

• maximum: Fz (+ coincident Fx, Fy, Mx, My, Mz)

• minimum: Fz (+ coincident Fx, Fy, Mx, My, Mz)

• maximum: Mx (+ coincident Fx, Fy, Fz, My, Mz)

• minimum: Mx (+ coincident Fx, Fy, Fz, My, Mz)

• maximum: My (+ coincident Fx, Fy, Fz, Mx, Mz)

• minimum: My (+ coincident Fx, Fy, Fz, Mx, Mz)

• maximum: Mz (+ coincident Fx, Fy, Fz, Mx, My)

• minimum: Mz (+ coincident Fx, Fy, Fz, Mx, My)

The load case, combination, or envelope names in which the maximum or
minimum values occur are also reported.

• Higher End Only:

For each beam span, two rows of data are output for the chosen loading
filter: maximum (end 1, end 2): Fx, Fy, Fz, Mx, My, Mz; minimum (end 1, end
2): Fx, Fy, Fz, Mx, My, Mz. This configuration does not contain load case,
combination, or envelope names because they could vary for each of the 6
values.

• Higher End Only + Coincident (initial default option):

A separate row is output for the maximum and the minimum of each of the
6 forces, along with the coincident forces in the other directions. For each
beam span, up to 12 rows of data can be output for the applied loading
filter as follows:

• maximum (end 1, end 2): Fx (+ coincident Fy, Fz, Mx, My, Mz)

• minimum (end 1, end 2): Fx (+ coincident Fy, Fz, Mx, My, Mz)

• maximum (end 1, end 2): Fy (+ coincident Fx, Fz, Mx, My, Mz)
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• minimum (end 1, end 2): Fy (+ coincident Fx, Fz, Mx, My, Mz)

• maximum (end 1, end 2): Fz (+ coincident Fx, Fy, Mx, My, Mz)

• minimum (end 1, end 2): Fz (+ coincident Fx, Fy, Mx, My, Mz)

• maximum (end 1, end 2): Mx (+ coincident Fx, Fy, Fz, My, Mz)

• minimum (end 1, end 2): Mx (+ coincident Fx, Fy, Fz, My, Mz)

• maximum (end 1, end 2): My (+ coincident Fx, Fy, Fz, Mx, Mz)

• minimum (end 1, end 2): My (+ coincident Fx, Fy, Fz, Mx, Mz)

• maximum (end 1, end 2): Mz (+ coincident Fx, Fy, Fz, Mx, My)

• minimum (end 1, end 2): Mz (+ coincident Fx, Fy, Fz, Mx, My)

The load case, combination, or envelope names in which the maximum or
minimum values occur are also reported.

TIP To change the default beam end forces report configuration, do the
following:

1. On the Report tab, click Model Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select Beam End Forces.

3. In the Chapters and Options list, expand the Member End Forces
group.

4. Hold down the left mouse button and drag the desired
configurations into the report structure.

5. Click OK.

To display a beam end forces report, do the following:

1. In the list on the left side of the Report toolbar, select Beam End Forces.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Bracing forces report
Tekla Structural Designer provides the bracing design force data for all load
cases and combinations in steel buildings.

To display a bracing forces report:

1. In the list on the left side of the Report toolbar, select Bracing Forces.

2. Click Show Report. 
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TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Foundation reactions report
The report summarizes the foundation design forces and is available in two
different configurations:

• Foundation Reactions (initial default option):

6 forces are output in the support's local co-ordinate system for the
selected load cases, combinations, or envelopes.

• Foundation Reactions + Coincident

The maximum and minimum value of each of the 6 forces in the support's
local co-ordinate system are output for the selected loading type. In
addition, the report contains the coincident forces that exist in the other
directions for the loading type in which the maximum or minimum value
occurs. The maximum values are highlighted in red, whereas the minimum
values are highlighted in blue.

NOTE The table for the Foundation Reactions + Coincident option never
contains more than 12 rows, irrespective of the number of
selected load cases or combinations.

To display a foundation reactions report, do the following:

1. In the list on the left side of the Report toolbar, select Foundation
Reactions.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

In addition to model and loading filters, you can also reconfigure
settings for each of the two configurations. These settings provide
options for:

• choosing strength or service factors

• choosing to display all rows, or non-zero rows only

• excluding reactions from columns assigned to cores

• excluding reactions from walls assigned to cores

Seismic design report
By default, the report contain the following tables:
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• Seismic loading summary

• Analysis seismic drift results

To display a seismic design report, do the following:

1. In the list on the left side of the Report toolbar, select Seismic Design.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

Member design report
By default, the report contains the design results for each member at a
summary level.

To display a member design report, do the following:

1. In the list on the left side of the Report toolbar, select Member Design
Calcs.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report.

See also

Configure and display member reports (page 948)

11.2 Create drawings
You can create drawings of individual levels and frames by using the
commands on the Draw toolbar. As for single-member drawings, they are
created by right-clicking the desired object and selecting the correct option in
the context menu that appears. In addition, you can create drawings in
batches using the Drawing Management... commands.

Drawing categories
In Tekla Structural Designer there are five main drawing categories. Each of
the categories contains different drawing variants, and each variant has a
number of specific options that allows you to configure their appearance. In
addition, each variant contains a set number of drawing layers that are
switched on and off according to the selected layer configuration. The
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appearance of each layer is controlled by the layer style. Drawing options,
drawing layers, and layer styles can be managed in drawing settings.

See the different drawing categories and variants in the following table:

Category Drawing variant Description
Planar drawings General arrangement General arrangement

(GA) of 2D levels and
frames.

Foundation reactions GA that also contains
support reactions in
order to assist
foundation design.

Loading plan GA that also contains
applied loads for the
selected load case.

Beam end forces GA that also contains
forces at the ends of
steel beams in order to
assist steel connection
design.

Column splice loads Frame GA that also
contains the splice loads
at splice locations in
steel columns in order to
assist steel connection
design.

Member details Concrete beam detail Beam reinforcement in
elevation and section for
each span. If necessary,
you can also include a
reinforcement quantity
table.

Concrete column detail Column reinforcement
in elevation and section.
If necessary, you can
also include a
reinforcement quantity
table.

Concrete wall detail Wall reinforcement in
elevation and section. If
necessary, you can also
include a reinforcement
quantity table.

Non-concrete beam
detail

Individual details for
non-concrete beams.
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Category Drawing variant Description
Non-concrete column
detail

Individual details for
non-concrete columns.

Concrete member
schedules

Concrete beam schedule Tabular data created by
building, by floor, or by
selected beams. The
information shown in
the schedule is based on
the design groups.

Concrete column
schedule

A table containing cross
sections through each
stack for the selected
columns. If necessary,
you can also include a
reinforcement quantity
table.

Concrete wall schedule A table containing cross
sections through each
stack for the selected
walls. If necessary, you
can also include a
reinforcement quantity
table.

Slabs and mats Slab/mat layout Slab item, patch and
punching shear
reinforcement
requirements. If
necessary, you can also
include a reinforcement
quantity table for the
reinforcement displayed
with an added detailing
allowance.

Punching check detail Punching shear
reinforcement details for
individual punching
check locations.

Foundations Isolated foundation
detail

Individual foundation
details in plan. If
necessary, you can also
include the detail in
cross section and a
reinforcement quantity
table.

Foundation layout GA at foundation level
displaying isolated
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Category Drawing variant Description
bases, pile layouts, and
mats. If necessary, you
can also include isolated
foundation details, a
reinforcement quantity
table, and an isolated
foundation schedule.

Adjust and apply drawing settings
To adjust the drawing settings of the current project or set them as default
settings for future projects, see the following instructions.

Adjust drawing settings in the current project
1. On the Draw toolbar, click Settings 

The Model Settings dialog box opens.

2. Review and modify the drawing settings according to your needs.

3. Do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes to the selected settings set, click Save...

• To revert to the drawing settings specified in the selected settings set,
click Load...

Adjust drawing settings in future projects
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to the Drawings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. Review and modify the drawing settings according to your needs.

5. To save the settings as defaults for future projects that use the selected
settings set, click OK.

See also

Drawing settings (page 2352)
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Create drawing scales
You can only create new drawing scales by accessing the Settings dialog box
via the Home tab. For more information on creating scales, see the following
instructions.

1. On the Home toolbar, click Settings.

2. Go to the Drawings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. In the Drawing Variant list, select the drawing category that you want to
configure.

5. Type the desired scale in the Scale field.

6. Click Add. 

The new scale is added to the Available Styles list.

7. Click OK. 

TIP If necessary, you can also adjust the distance between independent
drawing blocks by typing a value in the Minimum Text Block
Spacing field. However, note that if the value is too great, text labels
can end up far from the objects to which they refer.

Create, modify, or delete layer configurations
Layer configurations control which layers are displayed when the drawing is
created. Tekla Structural Designer contains several default layer configurations
that you can modify. If necessary, you can also create your own layer
configurations.

Create a new layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose layer
configurations you want to modify.

4. Click Add.

5. Name the new layer configuration.

6. Select or clear the layers according to your needs.

7. Click OK.

Create reports and drawings 969 Create drawings



Modify a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Available Configurations list, select the configuration that you
want to modify.

4. Select or clear the layers according to your needs.

5. Click OK.

Copy a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose properties
you want to copy.

4. In the Available Configurations list, select the configuration that you
want to copy properties from.

5. Click Add copy... 

The Copy Drawing Item dialog box opens.

6. Select the properties that you want to copy.

7. Name the copy.

8. Select or clear the layers according to your needs.

9. Click OK.

Delete a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose layer
configurations you want to modify.

4. In the Available Configurations list, select the configuration that you
want to remove.

5. Click Remove. 

The selected layer configuration is deleted for the selected drawing
category.

6. Click OK.
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Create, modify, or delete layer styles
Drawing styles control how a drawing is displayed, for example, what line
types, fonts, and colors are used. Tekla Structural Designer contains several
default layer styles that you can modify. If necessary, you can also create your
own layer styles.

Create a new layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. Click Add. 

A new layer style is added to the Available Styles list.

5. Name the new layer style.

6. Adjust the layer properties according to your needs.

7. Click OK.

Modify an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Available Styles list, select the layer style that you want to modify.

4. Adjust the layer properties according to your needs.

5. Click OK.

Copy an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. In the Available Styles list, select the layer style that you want to copy
properties from.

5. Click Add copy... 

The Copy Drawing Item dialog box opens.
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6. Select the drawing item that you want to copy.

7. Click OK.

8. Name the copied layer style.

9. Adjust the layer properties according to your needs.

10. Click OK.

Delete an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. In the Available Styles list, select the layer style that you want to delete.

5. Click Delete. 

The selected layer configuration is deleted for the selected drawing
category.

6. Click OK.

Create planar drawings
Planar drawings cover general arrangement drawings, beam end force
drawings, column splice load drawings, foundation reaction drawings and
loading plan drawings.

NOTE Before you create a drawing, ensure that the current drawing options meet
your needs by doing the following:

1. On the Draw toolbar, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Options.

3. Click the drawing type whose options you want to review or adjust.

4. Adjust the drawing options according to your needs.

5. Click OK.

Create general arrangement drawings
General arrangement drawings display 2D levels and frames, and can only be
created in 2D views. To create general arrangement drawings, do the
following:
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1. Open a 2D view displaying the part of the model that you want to include
in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. On the Draw toolbar, click General Arrangement. 

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

See also

Create drawing scales (page 968)

Create beam end force drawings
Beam end force drawings are general arrangement drawings that also contain
support reactions. They are typically created to assist connection design in
steel structures and can only be created in 2D views. To create beam end force
drawings, do the following:

NOTE Beam end forces are not displayed for concrete beams.

1. Open a 2D results view displaying the part of the model that you want to
include in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. In the Loading list, select the load case or combination that you want to
display.

3. On the Draw toolbar, click Beam End Forces. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:
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• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

See also

Create drawing scales (page 968)

Create column splice load drawings
Column splice drawings are general arrangement drawings that also contain
applied loads for the selected load case. Column splice drawings are typically
created to assist connection design in steel structures. To create column splice
load drawings, do the following:

NOTE Column splice loads are not relevant in concrete structures, and
therefore, they are not displayed for concrete beams.

1. Open a frame view containing the steel frame for which you want to see
the column splice loads.

2. On the Status bar, click  Results View.

3. In the Loading list, select the load case or combination that you want to
display.

4. On the Draw toolbar, click Column Splice Loads. 

TIP If the Column Splice Loads command is not active, ensure that the
current view is displayed in 2D.

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 

The drawing opens in an available DXF application.
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See also

Create drawing scales (page 968)

Create foundation reaction drawings
Foundation reaction drawings are general arrangement drawings that also
contain support reactions in order to assist foundation design. Foundation
reaction drawings can only be created in 2D results views. To create
foundation reaction drawings, do the following:

1. Open a 2D results view displaying the part of the model that you want to
include in the drawing. 

Typically, the part is be the base construction level.

2. In the Loading list, select the load case or combination that you want to
display.

3. On the Draw toolbar, click Foundation Reactions. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

See also

Create drawing scales (page 968)

Create loading plan drawings
Loading plan drawings are general arrangement drawings that also contain
applied loads for the selected load case. Loading plan drawings can only be
created in 2D scene views. To create loading plan drawings, do the following:

1. Open a 2D view displaying the part of the model that you want to include
in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. In the Loading list, select the load case or combination that you want to
display.
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3. On the Draw toolbar, click Loading Plan. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

See also

Create drawing scales (page 968)

Create member detail drawings
Member detail drawings include concrete beam detail drawings, concrete
column detail drawings, concrete wall detail drawings, non-concrete beam
detail drawings and non-concrete column detail drawings. For instructions on
how to create different member detail drawings, see the following paragraphs.

NOTE Before you create a drawing, ensure that the current drawing options meet
your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Options --> Member Details.

3. Click the drawing type whose options you want to review or adjust.

4. Adjust the drawing options according to your needs.

5. Click OK.

See also

Create drawing scales (page 968)
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Create concrete beam detail drawings
Concrete beam drawings display the beam reinforcement in elevation and
section for each span. If necessary, you can also include a reinforcement
quantity table.

1. Hover the mouse pointer over the beam that you want to detail.

2. When the desired beam is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create concrete column detail drawings
Concrete column drawings display the column reinforcement in elevation and
section. If necessary, you can also include a reinforcement quantity table.

1. Hover the mouse pointer over the column that you want to detail.

2. When the desired column is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.
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Create concrete wall detail drawings
Concrete wall details drawings display the wall reinforcement in elevation and
section. If necessary, you can also include a reinforcement quantity table.

1. Hover the mouse pointer over the wall that you want to detail.

2. When the desired wall is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create non-concrete beam detail drawings
Non-concrete beam detail drawings display individual steel beam details.

1. Hover the mouse pointer over the beam that you want to detail.

2. When the desired beam is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.
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Create non-concrete column details drawings
Non-concrete column detail drawings display individual steel beam details.

1. Hover the mouse pointer over the column that you want to detail.

2. When the desired column is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create slab and mat drawings
Slab and mat drawings refer to slab and mat layout drawings and punching
shear check detail drawings. Slab and mat detail drawings are used to convey
slab reinforcement and patch reinforcement requirements, and contain a
quantity table for the reinforcement displayed with a detailing allowance
added. Punching check detail drawings display an individual check detail in,
and also contain the option to display the reinforcement quantities table.

See also

Create drawing scales (page 968)

Create slab or mat layout drawings
1. Open a 2D scene view displaying the slabs or mats that you want to

include in the drawing.

2. On the Draw tab, click Slab/Mat Detailing. 

NOTE If the Slab/Mat Detailing command is not active, ensure that you
are in a 2D scene view.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.
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4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

Create punching shear check detail drawings
1. Hover the mouse pointer over the punching shear check item that you

want to detail.

2. When the desired punching shear check item is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create foundation drawings
Foundation drawings refer to isolated foundation detail drawings and
foundation layout drawings. Isolated foundation detail drawings display an
individual foundation detail in plan. If necessary, you can also display the
detail in cross section and a reinforcement quantity table. As for foundation
layout drawings, they display the piling layout and the layout of isolated
foundations. If necessary, you can also display isolated foundation details, a
reinforcement quatity table, an isolated foundation schedule, and a pile
location table.

See also

Create drawing scales (page 968)
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Create isolated foundation detail drawings

NOTE Before you create a base cap detail drawing, ensure that the current
drawing options meet your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Options --> Isolated Foundation Detail.

3. Adjust the drawing options on the Content and Isolated
Foundation Detail sub pages according to your needs.

4. Click OK.

1. Hover the mouse pointer over the base cap or pile cap that you want to
detail.

2. When the desired base cap or pile cap is highlighter, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create foundation layout drawings
1. Open a 2D scene view displaying the piles, bases or pile caps that you

want to include in the drawing.

2. On the Draw tab, click Foundation Layout. 

NOTE If the command is not active, ensure that you are in a 2D scene
view displayed in 2D.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.
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5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

Create concrete member schedule drawings
Concrete member schedule drawings include concrete beam schedules,
concrete column schedules and concrete wall schedules. In beam schedule
drawings, the reinforcement is listed on a span by span basis, and contractors
or specialist detailing firms can use the information to produce the necessary
bar bending schedules. As for concrete column schedule drawings, they
display a cross section through each stack of the selected columns, and if
necessary, allow you to include a reinforcement quantity table. Concrete wall
schedule drawings display a cross section through each stack of the selected
walls, and if necessary, also allow you to include a reinforcement quantity
table

NOTE Before you create a schedule drawing, ensure that the current drawing
options meet your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Options.

3. Adjust the drawing options on the sub pages according to your needs.

4. Click OK.

See also

Create drawing scales (page 968)

Create concrete beam schedule drawings
You can create beam schedule drawings by building, by floor or by selected
beams. The information shown in the schedule is based on the different
design groups. Beam schedule drawings are created in dxf format even
though they do not include graphical information, so that you can add them to
beam detail drawings.

1. Open a 2D scene view of a part displaying the beams that you want to
include in a schedule. The part can be, for example, a construction level,
frame, or sub model.
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2. On the Draw tab, click Beam Schedule. 

NOTE If the Beam Schedule command is not active, ensure that you are
in a 2D scene view that is displayed in 2D.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

Create concrete column schedule drawings
1. Open a 3D view or a frame view displaying the columns that you want to

include in the schedule.

2. On the Draw tab, click Column Schedule. 

The Select column schedule content dialog box opens.

3. Select the columns to be included and click OK. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Create concrete wall schedule drawings
1. Open a 3D view or a frame view displaying the walls that you want to

include in the schedule.
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2. On the Draw tab, click Wall Schedule. 

The Select wall schedule content dialog box opens.

3. Select the walls to be included and click OK. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

Manage drawings in batches
Although you can create individual drawings according to your needs, creating
a batch of drawings at once is often more efficient, especially when working
with larger models.

The Drawing Management... command on the Draw tab allows you to:

• Select the drawing variant that you want to manage.

• Either add a drawing sheet manually or generate a series of drawing
sheets.

• Select the frames, levels, or members for which you want to create
drawings.

• Arrange the drawings on the drawing sheet either in a linear or a grid
arrangement.

• Select the load cases or combinations for load-dependent drawing variants.

• Create drawing revisions.

• View the revision history of drawings.

• Reset reinforcement marks on concrete detail drawings in order to remove
gaps in the bar mark numbering.

Create or generate drawings in batches
To create multiple drawings easily or to automatically generate concrete detail
drawings, see the following instructions:
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See also

Specify the drawing layout (page 985)

Specify the loading for load-dependent drawings (page 986)

View drawings (page 987)

Review drawings (page 987)

Reset reinforcement marks in concrete detail drawings (page 986)

Create new drawings manually

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. Click Add. 

A new drawing appears in the Available Drawings list.

4. Name the new drawing.

5. Click Content... 

The Drawing Content dialog box opens.

6. Drag the items that you want to include in the drawing from the left
column to the right column.

7. Click OK.

Generate concrete beam and column detail drawings

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Drawing Variant list, select either Concrete Beam Detail or
Concrete Column Detail.

3. Click Generate. 

New drawings are created with automatically generated content. One
drawing contains typical beams or columns, wheras additional drawings
can contain any ungrouped beams or columns.

4. If necessary, click the available drawings to rename them, and type a new
name.

Specify the drawing layout
To specify the layout of the drawings that you have created, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.
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2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Layout... 

The Drawing Layout dialog box opens.

5. Define the direction and arrangement of the layout.

6. Click OK.

See also

Specify the loading for load-dependent drawings (page 986)

Specify the loading for load-dependent drawings
To specify the loading for load-dependent drawings, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Loading... 

The Select loading dialog box opens.

5. Select the desired load cases and combinations.

6. Click OK.

See also

Create or generate drawings in batches (page 984)

Reset reinforcement marks in concrete detail drawings
Each bar geometry used in the model has an associated reinforcement mark.
However, if a model is designed and some of the bars fall out of use, the mark
assignment is still retained. As a result, there may be gaps in the marks and
marks starting at high numbers. To avoid this, you can reset all the
reinforcement marks in the model. Do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Drawing Variant list, select either Concrete Beam Detail or
Concrete Column Detail.

3. Click Reset ALL Marks. 

All reinforcement marks are reset.
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See also

Create or generate drawings in batches (page 984)

View drawings
To view the drawings that you have created in the Drawing Management
dialog box, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click View Drawing... 

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 

The drawing opens in an available DXF application.

See also

Create or generate drawings in batches (page 984)

Review drawings
To apply a revision to a drawing, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Create Revision... 

The Create Drawing Revision dialog box opens.

5. Name the revision and type a revision note.
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6. Click OK. 

The drawings open in an available DXF tool.

See also

View the revision history of drawings (page 988)

View the revision history of drawings
To view the formerly applied revisions to a drawing, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click History... 

The Drawing History dialog box opens and allows you to view the
revision history of the selected drawing.

See also

Review drawings (page 987)

Manage schedule drawings in batches
Although you can create individual schedule drawings according to your
needs, creating a batch of schedule drawings at once is also possible. For
more information, see the following instructions.

The Schedule Management... command on the Draw tab allows you to:

• Select the drawing variant that you want to manage.

• Create new drawing sheets.

• Select the members that you want to include in the drawing.

• Arrange the drawing layout.

• Create drawing revisions.

• Reset reinforcement marks in order to remove gaps in the bar mark
numbering.

Create new schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.
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2. In the Available Styles list, select the desired drawing category.

3. Click Add. 

A new drawing appears in the Available Drawings list.

4. Name the new drawing.

5. Click Content... 

The Drawing Content dialog box opens.

6. Drag the items that you want to include in the drawing from the left
column to the right column.

7. Click OK.

Specify the schedule drawing layout
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. Click Layout... 

The Drawing Layout dialog box opens.

3. Define the direction and arrangement of the layout.

4. Click OK.

View schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click View Drawing... 

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 

The drawing opens in an available DXF application.
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Reset reinforcement marks in schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Drawing Variant list, select Concrete Beam Schedule, Concrete
Column Schedule, or Concrete Wall Schedule.

3. Click Reset ALL Marks. 

All reinforcement marks are reset.

Review schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Create Revision... 

The Create Drawing Revision dialog box opens.

5. Name the revision and type a revision note.

6. Click OK. 

The drawings open in an available DXF tool.

View the revision history of schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click History... 

The Drawing History dialog box opens and allows you to view the
revision history of the selected drawing.
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12Manage models

Click the links below to find out more various model management tasks:

• Define and modify head codes and design codes (page 992)

• Define and modify units (page 993)

• Manage object references (page 995)

• Create and manage user-defined attributes (page 1026)

• Manage settings sets (page 1000)

• Manage material databases (page 1004)

• Manage properties and property sets (page 1021)

• Manage sub structures (page 1031)

• Working with large models (page 1037)

See also

Model Settings (page 2263)

12.1 Apply and manage model settings
To apply and manage the various defaults and settings that apply to the
current project, see the following instructions.

1. On the Home tab, click Model Settings.

2. Adjust the Model Settings (page 2263) according to your needs.

3. After adjusting the settings, do one of the following:

To Do this
Apply the changes to the current project • Click OK.

Save the changes back to the active settings set
for future use

• Click Save...

Cancel the changes • Click Cancel.
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Revert to the model settings specified in the
active settings set

• Click Load...

NOTE Clicking Load... loads all of the model
settings from the active settings set, not
only those specified on the current page
of the Model Settings dialog box.

Analysis options and design options are
not loaded.

See also

Define and modify head codes and design codes (page 992)

Define and modify units (page 993)

Manage object references (page 995)

Create and manage user-defined attributes (page 1026)

Define and modify head codes and design codes
Tekla Structural Designer allows you to select from a range of international
design codes of practice. Each new project initially adopts the codes that have
been specified in the active settings set. However, you can also change the
codes in the middle of a project.

See also

Design code settings (page 2264)

Change design codes in an existing project

WARNING If you change the head code in an existing project, the following
will occur in the model:

• Some materials, steel sections, studs, decks and
reinforcement may require re-selecting in the model to make
them consistent with the new head code/unit system.

• Wind loading (if any) and wall/roof panel properties will be
deleted. The wind wizard will need rerunning, wall/roof panel
properties need resetting and the wind load cases will need
recreating.

• Seismic loading (if any) will be deleted. The seismic wizard will
need re-running.

• All combinations will be deleted.
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1. On the Home tab, click Model Settings. 

The Settings dialog box opens.

2. Go to Design Codes.

3. Select the head code as required. 

The head code controls which action and resistance codes are available
for selection.

4. Set the action and resistance codes according to your needs.

5. Click OK.

Define default design codes for new projects

1. On the Home tab, click Settings. 

The Settings dialog box opens.

2. Select a suitable settings set, and click >> Active to make it active.

3. Go to Design Codes.

4. Check that the head code is set as required. 

The head code controls which action and resistance codes are available
for selection.

5. Set the action and resistance codes according to your needs.

6. Click OK. 

Tekla Structural Designer retains the selected codes to apply them for
each new project until you decide to modify them.

7. To use the set design codes in a new project, on the Home tab, click 
New. A new project opens with its design codes, (and all of its other
model settings) copied from the active settings set.

Define and modify units
Tekla Structural Designer allows you to switch between Metric and US
customary units. Furthermore, you can select the units which you want to use
in the selected unit system. For example, if you use US customary units, you
can input forces in either kip or lb, and lengths in feet, inches, or feet and
inches.
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Change units and unit precision in an existing project

1. On the Home tab, click Model Settings. 

The Model Settings dialog box opens.

2. Go to Units.

3. Select the unit system.

4. Set the units and unit precision that you want Tekla Structural Designer to
use.

5. Click OK. 

NOTE The length unit can be set appropriate for the type of dimension
being input:

• Fine Dimension units are used for defining stud spacings,
section size constraints, and other typically small distances.

• Dimension units are used for defining grid spacings,
positioning members, positioning load locations, and so on.
They are also used to control the accuracy of any measured
dimension lines that you apply to the model.

• Deflection units are used for reporting deflection results.

• Distance units are used for defining large dimensions.

Once you have set the units according to your needs, Tekla Structural Designer
will then expect input in the same format.

Example

If the Dimension units are set to ft, in fract.:

• To input a dimension of two feet, six and one quarter inches, you need to
type 2' 6 1/4"

• To input a series of irregular grid lines in the grid wizard at spacings of
fifteen feet, followed by three spacings of twenty feet, six and one half
inches, followed by one spacing of fifteen feet, you need to type
15',3*20' 6 1/2",15'

Define the default units and unit precision for new projects

1. On the Home tab, click Settings. 

The Settings dialog box opens.

2. Select a suitable settings set, and click >> Active to make the set active.

3. Go to Units.
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4. Select the unit system.

5. Set the units and unit precision that you want Tekla Structural Designer to
use. 

NOTE The length unit can be set appropriate for the type of dimension
being input:

• Fine Dimension units are used for defining stud spacings,
section size constraints, and other typically small distances.

• Dimension units are used for defining grid spacings,
positioning members, positioning load locations, and so on.
They are also used to control the accuracy of any measured
dimension lines that you apply to the model.

• Deflection units are used for reporting deflection results.

• Distance units are used for defining large dimensions.

6. Click OK.

7. To use the set units in a new project, on the Home tab, click New. A
new project opens with its units, (and all of its other model settings)
copied from the active settings set.

Once you have set the units according to your needs, Tekla Structural Designer
will then expect input in the same format.

Example

If the Dimension units are set to ft, in fract.:

• To input a dimension of two feet, six and one quarter inches, you need to
type 2' 6 1/4"

• To input a series of irregular grid lines in the grid wizard at spacings of
fifteen feet, followed by three spacings of twenty feet, six and one half
inches, followed by one spacing of fifteen feet, you need to type
15',3*20' 6 1/2",15'

Manage object references
Tekla Structural Designer contains a flexible object referencing system that is
specifically designed considering the use of multiple materials within the same
model.

You can define the object references to meet your needs on the References
page of the Settings dialog box.
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See also

Object reference settings (page 2266)

Basics of object reference formats

Object reference formats are user definable. Each object type has its own
reference format that has been built using individual components. You can
customize the reference format by adding or removing components as
required.

See some of the typical components in the following table:

Icon Item Further information
Material Fully user-definable text.

For example:

• S for Steel

• C for Concrete
Characteris
tic

Fully user-definable text.

For example:

• B for Beam

• C for Column
Start Level
Reference

Not applicable

End Level
Reference
Start Point
Reference

Grid or construction point reference.

The start and end reference points P1 and P2
work from the grids that you define, and from
the construction points that have been created
automatically when you place members that do
not lie between existing points.

NOTE When reference points are constructed
using two grid reference points, you
must always use a separator.

For example, type A/11 to avoid
confusion with A1 and 1.

End Point
Reference

Direction Applies for beams only.
Count Tekla Structural Designer keeps a separate

count for each level for each object type.
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Icon Item Further information

NOTE Tekla Structural Designer does not keep
a count by material. For example, steel
beams and concrete beams are
included in the same count on a level.

If the direction prefix is specified, Tekla
Structural Designer keeps separate
counts for each direction. Direction 1 is
defined as objects falling within ± 45
degrees of the horizontal, and Direction
2 ± 45 degrees of the vertical of the
global axis.

Not applicable Reinforcem
ent > Bar
Layer:

• T1

• T2

• B1

• B2

• T1 is the top surface reinforcement in the 1st
(outer) layer.

• T2 is the top surface reinforcement in the
2nd (inner) layer.

• B1 is the bottom surface reinforcement in
the 1st (outer) layer.

• B2 is the bottom surface reinforcement in
the 2nd (inner) layer.

Reinforcem
ent > Bar
Size

Not applicable

Reinforcem
ent >
Center
Spacing

The center spacing between bars.

Reinforcem
ent >
Detailing
prefix

An item that is typically added in front of the bar
size.

Custom
text

Fixed text that you can include at any position
within the reference.

For example:

• Block C
Separators

• backslas
h

• dash

• slash

Optional items that you can place between
items.
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Icon Item Further information
• space

• times

Note that:

• When you create objects of a certain type, the default references from the
active settings set are applied.

• You can modify the syntax of the reference format at any time. Objects
created after the changes will adopt the new format.

• Once objects have been created, you can edit their references on an object-
by-object basis, so that they can be further individualized.

• For members, the object reference does not include the group reference,
geometric shape, and section size as part of the reference descriptor.
Instead, options are provided in the Scene Content settings and the GA
drawing's control to show the information.

Modify reference formats and texts in an existing project
1. On the Home tab, click Model Settings. 

The Model Settings dialog box opens.

2. Go to References.

3. Adjust the way in which the references are applied.

4. Click OK.

Modify the reference format syntax of an object type
1. Go to References --> Formats .

2. Click the ... button on the right side of the desired reference format.

3. Do one of the following:

To Do this
Add an extra item to the reference format • Click Add... and select the desired item.

The selected item appears at the end of the
reference format.

Re-order the items in the reference format a. Select the item you want to move.

b. Drag the item to reposition it.

Add custom text to the reference format a. Click Add... and select Custom Text.

b. Drag the new component to the desired
position.

c. Click the Custom Text component to edit
it.

d. Type the desired text in the box.

e. Click Set.
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Remove an item from the reference format a. Select the item you want to remove.

b. Drag the item outside the Edit Reference
Format dialog box.

4. Click OK.

Change the text used for the materials and characteristics in the
reference format
1. Go to References --> Texts .

2. According to your needs, go to the Characteristics or Materials tab.

3. Modify the desired text according to your needs.

4. Click OK.

Renumber members
You can use the Renumber command to simultaneously renumber all
member types in the model whose reference format includes the count item.

Member types are initially numbered in the order in which they are created.
Renumbering makes the members easier to find in the model and on
drawings.

By default, the Renumber command works from the lowest plane or level
upwards. The count starts at 1 and continues sequentially.

NOTE To change the renumbering direction and the starting value, go to
Model Settings --> References --> General .

1. On the Structure tab of Project Workspace, right-click the Members
branch.

2. In the context menu, select Renumber. 

Tekla Structural Designer automatically renumbers all members in the
model that include a count in their reference format.

Renumber slabs
You can use the Renumber command to simultaneously renumber all slab
items in the model.

Slab items are initially numbered in the order in which they are created.
Renumbering makes them easier to find in the model and on drawings.

By default, the Renumber command works from the lowest plane or level
upwards. The count starts at 1 and continues sequentially.

NOTE To change the renumbering direction and the starting value, go to
Model Settings --> References --> General .
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1. On the Structure tab of Project Workspace, right-click the Slabs branch.

2. In the context menu, select Renumber. 

Tekla Structural Designer automatically renumbers all slab items in the
number.

Adjust the default references to be applied to new projects
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select a suitable settings set in the list, and click >> Active to make it
active.

4. Go to References.

5. Adjust the way in which the references are applied to each of the object
types in your projects.

6. Click OK.

7. To start a new project using the new references, on the Home tab, click
New.

12.2 Manage settings sets
The first time Tekla Structural Designer is run after installation you are
required to select a country or region. Based on this selection, Tekla Structural
Designer creates an initial settings set (the 'active' set), containing defaults for
design codes, units, and sections, and settings for drawings, schedules, and
reports.

You can edit the settings in this set and also create new sets, but only one set
can be designated the 'active' settings set.

Each new project takes a copy of the 'active' settings set to form its own
independent model settings.

Model settings can then be edited as required without affecting the active
settings set.

Add a new settings set
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.
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3. Click Add Copy.

4. In the Settings dialog box, modify the settings for the new settings sets.

5. Click OK to save the settings to the new settings set.

Import a settings set for a different region
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Click Import...

4. Select the region for which you want to import the settings.

5. Click OK.

NOTE To use these settings in your new projects, you will need to make this
the active set (page 1002).

Edit the content of a settings set
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set you want to edit.

4. In the Settings dialog box, modify the settings according to your needs.
For example:

• Modify the font used to display results in the Results Viewer.

• Modify the appearance of reports.

• Set the units that you want to use, and set the desired precision for the
units.

• Set the design codes that you want.

• Set default section sizes for each of the member types.

• Set if confirmations are required for specific actions.

• Set element references.

• Modify the appearance of schedules.

• Modify drawing types and styles.

• Modify the colors used in 2D and 3D views.
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5. Click OK to save the settings to the selected settings set.

Change the active settings set
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set required from the drop list.

4. To make the set a default set for new projects, click >> Active.

5. Click OK.

Delete a settings set
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the set you want to delete.

4. Click Remove.

Load settings from the active settings set to the current
project
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Ensure that the required settings set is active. If it is not, click >> Active.

4. Click OK.

5. Open the dialog that contains the settings to be updated.

• On the Home tab, click Model Settings.

• On the Analyze tab, click Options.

• On the Design tab, click Options.
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• On the Draw tab, click Edit...

6. Click Load... 

A confirmation dialog appears.

7. To update the model settings to match the active settings set, click Yes.

Save settings from the current project to the active settings
set
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Ensure that the settings set is active. If it is not, click >> Active.

4. Click OK.

5. Open the dialog that contains the settings to be saved.

• On the Home tab, click Model Settings.

• On the Analyze tab, click Options.

• On the Design tab, click Options.

• On the Draw tab, click Edit...

6. Click Save... 

A confirmation dialog appears.

7. To update the active settings set to match the current settings, click Yes.

Copy a settings set from one computer to another
In order to apply consistent settings on a company wide basis, the xml file of
the appropriate settings set should be manually copied to other computers.

1. On the computer containing the settings set, go to the Home tab and click

Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.
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3. Click Open Folder.

4. Select the xml file of the settings set, and manually transfer it to the
Settings folder on each destination computer.

5. To view and use the new settings set, restart Tekla Structural Designer on
the destination computers.

See also

Settings set settings (page 2386)

12.3 Manage material databases
Material databases contain an extensive range of sections, materials,
reinforcement, decking, and connectors for each head code and country. The
initial data in the material databases is protected, so that standard items
cannot be accidently edited or deleted. However, you can add user data from
other sources or suppliers, if needed. All user data is fully editable. You can
view the protected data and manage the user data from the Materials dialog
(page 2418).

• Add, modify and delete user-defined sections (page 1004)

• Manage design section orders (page 1006)

• Add simple connection resistances to the database (page 1009)

• Add material properties from the model to a material database (page 1016)

• Add materials for a head code (page 1016)

• Timber property assumptions (page 1021)

• Upgrade material databases (page 1020)

Add, modify and delete user-defined sections
A user defined section can take the form of a custom, or a compound section,
a compound section being one that comprises of 2 chords or more connected
by battens or lattice or welded.

See also

The Sections dialog box (page 2423)
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Add a user-defined custom or compound section to the material
database
1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. Click Add...

6. Enter values for each of the requested variables.

7. Click OK.

The new section size is now displayed in the Item pane.

Modify a user-defined custom or compound section in the material
database
1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. In the Item pane on the right, select the desired section size.

6. Click Edit...

7. Modify the section properties according to your needs.

8. Click OK.
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Delete a user-defined custom or compound section from the database

NOTE Only user-defined sections, marked with *, can be deleted.

1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. In the Item pane on the right, select the desired section size.

6. Click Delete. 

A confirmation dialog appears.

7. To delete the section, click Yes.

Manage design section orders
A design section order is a list of sections you wish to consider for design
when the Autodesign property is checked.

The design process commences by starting with the first section in the chosen
order file. Any section that fails any of the design conditions is rejected and the
design process is then repeated for the next available section in the list.

On completion of the design process, the first satisfactory section from the
section designation list is assigned to the member.

View the list of sections in a design section order
You can view the list of sections in a design section order, by following the
steps below.

1. Edit the properties of the member.

2. Click the Design section order drop list and select <New\Edit...>

3. Choose a section order from the available list and then click Edit...

The sections contained within the chosen order file appear in the Sections in
use list on the right of the page.

Manage models 1006 Manage material databases



Specify that a section in the list should not be considered for design
You can control which sections in a design order list are considered by
following the procedure below.

Only checked sections within the list are considered during the design process.
Uncheck a section and it will no longer be considered.

WARNING Limiting the choice of sections by unchecking a section within an
order file is a global change that affects ALL projects, (not just the
currently open one). It is typically used to eliminate unavailable or
non-preferred sections from the design process. If design
requirements for an individual member require section sizes to
be constrained, (due to, for example depth restrictions), then the
choice of sections should be limited instead by using Size
Constraints, (as these only affect the current member).

Sort the listed sections by a different property
You can sort a design section order list by following the steps below.

While viewing the list of sections:

1. Click Criteria... to open a dialog for selecting the sort critera.

2. Select a property from the Available Criteria list and click Add.

3. Choose the order for sorting (Ascending, or Descending).

4. Add further criteria as required.

5. Click OK to close the dialog.

6. Click Sort to re-order by the chosen criteria.

7. Having sorted, if you don't want to subsequently move individual sections
up or down the list, check Keep sorted to de-activate Move Up and Move
Down.

NOTE Changing the order of sections within an order file is a global change
that affects ALL projects, (not just the currently open one).

Specify that a section is non-preferred
Some sections might be more expensive or difficult to obtain; you might
therefore want other sections to be chosen in preference to them, (whilst still
keeping them available).

You can achieve this by moving the "non-preferred" sections further down the
design order list.

To move a section up or down the list:

1. If Keep sorted is checked, you must uncheck it in order to activate Move
Up and Move Down.
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2. Highlight the section in the Sections in use list and then click Move Down
or Move Down to promote or demote it.

NOTE Changing the order of sections within an order file is a global change
that affects ALL projects, (not just the currently open one).

Reset a design section order back to the original default
If you have made changes to a design order list, the following steps you
through resetting the order file to the original default values.

1. Edit the properties of the member.

2. Click the Design section order drop list and select <New\Edit...>

3. In the Select a Section Order dialog, highlight the section order that you
want to reset.

4. Click Reset

The highlighted design section order is reset to its default settings.

NOTE The Reset button is only displayed for the pre-installed section orders.
(User defined section orders can be deleted but not reset.)

Create a new Design section order
If you want to create a completely new design section order you can do so as
follows:

1. Edit the properties of a member.

2. Click the Design section order drop list and select <New\Edit...>

3. In the Select a Section Order dialog, click Add...

4. Enter a unique name for the new design section order.

5. Select the Country and the Section Group required.

6. Either click Add All to add all the available sections, or highlight just the
sections you require and click Add Selected. 

NOTE When adding selected sections you can use the Top, Bottom,
Above Selected, Below Selected options to specify where they
appear in the list. However, these options are ineffective if you
have a sort criteria specified and the Keep sorted box is checked.

7. Sort individual sections in the Sections in use list, using Move Up or
Move Down, as required. 

8. When the list of sections in use is as you want it, click OK

The new design section order appears on the list of available section orders.
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Add simple connection resistances to the database
The materials database contains pre-defined connection types with pre-
defined resistances for steel beams to Eurocode1 and US2 head codes.

In addition, you can specify user-defined connection types and user-defined
resistances for any head code and save them to the section database. Once
defined, these can then be used to Check simple connection resistance
(page 809) across all projects.
1The Eurocode resistances are derived from SCI publication P358 and make use of
UK NA values for partial safety factors, regardless of the Eurocode Country setting.
2 The US resistances are derived from AISC publication Steel Construction Manual
14th Ed and are only given when US Customary units are selected. Separate
resistances are given for LRFD and ASD.

Pre-defined connection types and resistances
For Eurocodes:

With the Member Type set to Simple Beam, three pre-defined connection types
are available for S355 and S275 grades:

• Fin Plates,

• Full Depth End Plates

• Partial Depth End Plates

These have connection resistance values defined for UB and UKB section
beams. The bolts considered are all size M20, of property class 8.8, and
ordinary or flowdrill type. The plates considered are all S275 grade. Fin Plates
and Partial Depth End Plates have resistances defined for beams with 0, 1 or 2
notches, while the resistances for Full Depth End Plates assume no notches.
Fin Plates have resistances for 1 or 2 vertical lines of bolts.

For US (ACI/AISC) and US Customary units:

With the Member Type set to Simple Beam, and the steel grade set to 'Any'
one pre-defined connection type is available:

• Single Plate

Single Plates have connection resistance values defined for W section beams
of any Fy value. The bolts considered are sizes 3/4 in, 7/8 in and 1 in, from
Group A, with thread condition N, in standard holes. The plates considered are
all of Fy 36 ksi, with thickness ranging from 1/4 in to 9/16 in. Single Plates have
resistances defined for beams with no coping and top flange coping only. All
resistances assume 1 vertical line of bolts only.

In addition, two further Simple Beam connection types are available for the 50
ksi grade:
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• All-Bolted Dbl Angle,

• Shear End-Plate

These have connection resistance values defined for W section beams, and for
Single Plates with W section beams of Fy 50 ksi. The bolts considered are sizes
3/4 in, 7/8 in and 1 in, from Group A, with thread condition N, in standard
holes. The plates and angles considered are all of Fy 36 ksi, with thickness
ranging from 1/4 in to 9/16 in. All-Bolted Double Angles have resistances
defined for beams with no coping and top flange coping only, while the
resistances for Shear End-Plates assume no coping. All resistances assume 1
vertical line of bolts only.

NOTE The pre-defined connection types and resistances can be reviewed in
the Connection Resistance dialog (page 2399).

Add user-defined connection types
1. Open the Connection Resistance dialog (page 2399)

2. Under Connection Types, click Add... 

An Add Connection Type dialog appropriate to the current headcode is
displayed.
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3. In the Name box enter a name for the Connection Type. 

If you want to create a Connection Type with a number of variations of
Grade, Notches or Bolt Lines then it is important to enter exactly the same
Name each time - e.g. the database will recognise “CT1” and “CT 1” as
separate Types simply because of the space in the second name. This has
an effect when viewing results in tabular data or reports, where Tekla
Structural Designer carries out an optimisation process to find the first
passing resistance based on the name of the Connection Type and the
number of Bolt Lines and Bolt Rows assigned to that name

NOTE It is possible to use the same Name as one of the pre-defined
Types and it will be recognised in the optimisation process as
essentially being the same Connection Type

4. In the Note box enter any descriptive text you would like to see displayed
in the dialog’s Info box.
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5. Select a Grade or, with US codes, an Fy value. 

Note that subgrades like S355 J0 are ignored e.g. a Connection Type with
S355 Grade assigned will have its resistances applied to beams or braces
of Grade S355 J0, S355 J2, etc.

6. Select # Notches and # Bolt Lines or, with US codes, select Coping, # Bolt
Lines, Bolt Diameter and Thickness (of plate or angle leg).

7. Select the section lists that you will want to define resistances for (this list
can be added to later on if required, in the Edit Connection Type dialog).

8. Click OK 

NOTE OK is not active until a Name has been defined. After clicking OK
‘Hide undefined values’ becomes automatically un-ticked and
resistance values can be entered against the required sections. If
no resistance values are assigned at this stage for at least one
section in a selected Section List, then that List will become de-
selected and have to be re-selected later on.

You are now able to add user-defined connection resistances to the
database against the required sections for this connection type.

Edit user-defined connection types
1. Open the Connection Resistance dialog (page 2399)

2. Under Connection Types, click Edit... 

An Edit Connection Type dialog appropriate to the current headcode is
displayed.

3. Edit the values as required.

4. Click OK

Add user-defined connection resistances
User-defined connection resistances can be added to the database for existing
connection types as follows:

1. If it is not already displayed, open the Connection Resistance dialog
(page 2399)

2. If necessary, use the filters at the top of the dialog until the required
connection is displayed in the Connection Types list.

3. Select the connection in the Connection Types list. The sections are listed
in the Resistances table, along with the bolt rows and resistance values for
the selected connection type.

NOTE If no sections are listed uncheck Hide undefined values.
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4. Select the section type in the Section List.
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5. Resistance values can be entered directly in the table. Alternatively, select
a particular section in the table and click Edit.... This displays the Edit
resistances dialog which allows you to adjust the bolt rows count or to
Add multiples of the same section size with more than one bolt row
count. The bolt row counts can be entered in any order and then use Sort
to number from lowest to highest. Use the Edit resistances dialog also to
Delete data rows if no longer required in your database.
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NOTE Connection resistances are made active as the values are entered.

Related video
Predefined connection resistance database for Eurocode and AISC

Add material properties from the model to a material
database
When you define a member, its material properties are initially read from the
appropriate material database. However, subsequently, the material
properties are held with the member itself. This means that you can open and
run the model on another computer, even if it does not have a matching
material in its database.

When a mismatch between the model's material data and the material
database arises, you are not required to add the missing properties to the
database. It may however be beneficial to do so if you anticipate that you will
need to re-use the property in question in new models.

1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to Model.

3. Select the desired objects in the Material data objects in model list.

4. Click Add to Database.

Add materials for a head code
Engineers may need to design using local sections, materials, and
reinforcement. These may not be listed in the materials databases for the
current head code. However, you can add materials to the material database
manually, if necessary.

WARNING If you add data to a material database, you are responsible for
both its accuracy and applicability to the selected design had
code.
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Add a material grade for a head code
1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to the Material page.

3. Select the required head code.

4. Select the required material type.

5. If the required grade is not listed for the selected head code, click Add... 

The Add Grade dialog opens.

6. Type in the grade properties.

7. Click OK to return the Materials dialog box 

The new grade is shown in the list of available grades.

8. To make the new grade the default grade for the material in the selected
head code, select the grade and click >> Default.

Add a reinforcement class for a head code
1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Go to the Reinforcement page.

3. Select the required head code.

4. Select the country to assign the reinforcement to.

5. Select the required type and rib type.

6. If the required class of reinforcement is not listed for the selected head
code, click Add... 

The New Reinforcement Class dialog opens.

7. Type in the reinforcement class properties.

8. Click OK to return the Materials dialog box 

The new class is shown in the list of available grades.

9. To make the new class the default class for the combination of the
selected head code and country, select the class and click >> Default.
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Add new reinforcement sizes
When you have created a new reinforcement class, the class does not contain
any specified bar sizes. Therefore, you must add the sizes you intend to use.

1. On the Reinforcement page, click Add... on the right side of the
Available sizes list. 

The New Reinforcement Bar Size dialog opens.

2. Type in the properties of the first bar size.

3. Repeat steps 1 and 2 for all bar sizes that you require.

4. When you are finished, click Close.

Specify the bar size range to be applied in auto design
After the new reinforcement has been added to the materials database, you
can specify the minimum and maximum bar sizes that should apply to the
different concrete members when they are auto-designed.

1. On the Design tab, click Options.

2. Go to the Concrete page.

3. Locate the reinforcement of each of the following: 

• Beam

• Column

• Wall

• Slab --> Slab on Beams

• Slab --> Flat Slab

• Punching Shear

• Foundations --> Pad Base

• Foundations --> Pile Cap

• Foundations --> Mat Foundations

4. For each of the above, select the country to which the new reinforcement
is registered.

5. For each of the above, select the minimum and maximum bar sizes that
apply to auto design.

The new design options now apply to the current project. If you want them to
apply to new projects as well, save the changes back to the active set.
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Change default design sections for a different head code
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to the Section Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the Section Defaults page, click the currently displayed
section for a member to change it. 

The Select Section dialog box opens.

5. Select the required country.

6. Select the shape in the Page pane on the left.

7. Select the section size in the Item pane on the right.

8. Click Select. 

The default section has now been updated.

9. Repeat steps 4–8 for all the sections that you want to update.

The new default sections will be applied to new models, provided that the
settings set that you modified is the active settings set.

Change default design section orders for a head code
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to the Section Order Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the page, click the currently displayed section for a
member to change it. 

The Select a Section Order dialog box opens.

5. Select the required country. 

NOTE If there are no section orders listed for the selected country, they
do not yet exist for the current head code. However, you can still
create section orders can still be created by using the Import...
feature.

6. Highlight an available section order in the list and click Select. 

The section order has now been updated.

7. Repeat the steps 4–6 for other members that you want to change.

The new section order will be applied to new models, provided that the
settings set that you modified is the active settings set.
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Create new section orders for a head code
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to the Section Order Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the page, click the currently displayed section for a
member to change it. 

The Select a Section Order dialog box opens.

5. Click Export... and save the section order as an XML file.

6. Close the Select a Section Order dialog box.

7. On the Section Order Defaults page, select the settings set that was
originally being modified.

8. In the table, click the section order that you want to change.

9. Select the required country.

10. Click Import... and select the XML file that you just created.

11. Select the imported file by clicking Select.

12. Repeat steps 4–11 for other member types as needed.

Upgrade material databases
The installed material databases each have their own database version. You
can see the version number separately on each page of the Materials dialog
box.

The original data in each of the material databases is system data, and it
cannot be edited. The version number relates specifically to this system data.

From time to time, new system data may become available through an update.
When this happens, an Upgrade button is displayed next to the current
database version on the relevant page of the Materials dialog box. You then
have the choice to either upgrade the database or retain the old version.

NOTE Updating the database version does not cause you to lose any user
data you may have added to the old version, because the user data is
automatically copied back in to the new database.

In certain circumstances, an inconsistency can arise between the user data in a
model and the installed databases. The inconsistencies can be identified and
resolved on the Model page of the Materials dialog box, either by updating
the model data, or by updating the material databases.
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1. On the Home toolbar, click Materials. 

The Materials dialog box opens.

2. Click the Upgrade button next to the current database version number.

Timber property assumptions
The engineer shall verify that the properties of the selected grades are those
that are characteristic of the material, are obtained from up-to-date
manufacturer’s data and are applicable to the analysis model. Analysis
Modification Factors must also be confirmed to be correct.

Head Code Eurocode

The following assumptions have been made:

• Loading will be perpendicular to the wide faces of the laminations (bending
about the major axis).

• Moisture content of the sections will be less than 15% - analysis
modification factors may need to be applied if this is not the case.

• The glulam grade being used complies with the characteristic properties
outlined in BS EN 14080:2013.

• The engineer has verified that the Eanalysis value of the member is suitable
for the particular application.

• The section and strength class are compatible.

Head Code ACI/AISC

The following assumptions have been made:

• The moisture content of the structural composite lumber or glulam section
is less than 16% and the temperature remains below 100°F - analysis
modification factors may need to be applied if this is not the case.

• The glulam section will be loaded perpendicular to the wide faces of the
laminations (bending about the x-x axis).

• The glulam grade being used complies with the characteristic properties
outlined in AWC NDS supplement 2018.

• The engineer has verified that the Eanalysis value of the member is suitable
for the particular application.

• The section and strength class are compatible.
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12.4 Manage properties and property sets
When you create a new entity, default properties for it are displayed in the
Properties window, these can be edited as required before the entity is
placed.

Provided the properties are saved to a property set, they can be applied to
similar entities elsewhere in the current model.

Property sets can also be transferred between models.

In this section we show you how to:

• Save properties to and recall properties from property sets (page 1022)

• Apply property sets to existing entities (page 1023)

• Review where property sets have been applied (page 1024)

• Transfer property sets between models (page 1025)

• Delete property sets (page 1025)

See also

Modify the properties of entities or model objects (page 360)

Save properties to and recall properties from property sets
Saving properties to property sets allows you to re-use them elsewhere.

Save properties from the Properties window to a new property set

NOTE You can only save properties in the Properties window to a property
set when there are no entities selected. This ensures that each
property in the property set has an unique entry.

1. From the Model, Design, or Foundations ribbon tab, click the entity type
whose properties you want to save as a property set. 

The list on the top of the Properties window now reads <unsaved set>.

2. Specify the properties according to your needs.

3. Click the Save... button on the top right corner of the Properties window. 

The Add property set dialog box opens.

4. Name the property set.

5. Click OK.
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Save the properties of an existing entity to a named property set
1. Hover the mouse pointer over the desired entity until it becomes

highlighted.

2. Right-click the entity.

3. In the context menu select Create property set... (and if the entity is a
beam or column or wall, select the span or stack required). 

The Add property set dialog box opens.

4. Name the property set.

5. Click OK.

Recall a previously saved property set to the Properties Window
Provided that you have previously saved a property set, you can recall it again
later in the Properties window, if it is applicable to the current command.

1. From the Model, Design, or Foundations ribbon tab, click the desired
entity type. 

The properties applicable to the selected entity type are displayed in the
Properties window.

2. Click the list on the top of the Properties window.

3. In the list, select the desired property set.

Apply property sets to existing entities
You can apply a property set to existing entities in a Structural View, but if
you want to make a lot of changes property sets can be applied more easily
from a Review View.

Apply a property set to an individual entity in a Structural View
1. Hover the mouse pointer over the entity until it becomes highlighted.

2. Right-click the entity.

3. In the context menu, select Apply Property Set... 

The Select property set to apply dialog box opens.

4. Select the desired property set.
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5. Click OK.

The property set is only applied to the individual entity that you right-click,
even if multiple entities were selected. To apply a property set to multiple
entities, see the following topic.

Apply a property set to multiple members in a Structural View
1. Select the entities that you want to update.

2. Ensure that the list on top of the Properties window shows the correct
entity type.

3. On the top right corner of the Properties window, click Apply...

4. Select the desired property set.

5. Click OK.

The property set is now applied to all of the selected entities, provided that
they are of the same type.

Apply a property set in a Review View
1. Open a Review View

2. On the Review tab, click Property Sets.

3. In the Properties window, do all of the following:

a. Set Review/Update to Apply property set.

b. Select the entity type. 

NOTE Only those entity types that already have property sets saved
will be listed.

c. If the Member entity type was selected, you will also need to select
the characteristic.

d. Select the property set that you want to apply.

4. In the Review View, click the entities to which you want to apply the
property set.

Review where property sets have been applied
To graphically review where property sets have been applied, see the following
instructions.

1. Open a Review View

2. On the Review tab, click Property Sets.

3. In the Properties window, set Review/Update as Review All.
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4. Still in the Properties window, select the entity type that you want to
review. 

NOTE Only those entity types that already have property sets saved will
be listed.

Entities of the selected type are color-coded to indicate where property
sets have been applied.

Transfer property sets between models
Once property sets have been saved, they can be exported from the current
model and then imported into another Tekla Structural Designer model.

Export property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to export.

3. Click Export...

4. Save the properties as a .tsps file.

Import property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to import.

3. Click Import...

4. Select the .tsps file that contains the required property sets.

5. Click Open. 

The imported property sets are now listed in the Manage Property Sets
dialog.
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Delete property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to delete.

3. Click Delete.

4. Click OK.

12.5 Create and manage user-defined attributes
You can define user-defined attributes (UDAs) to save miscellaneous data to
files, individual members and panels.

User-defined attributes are flexible, and you can use them for a variety of
purposes. For example, you can:

• Apply descriptive labels, such as construction phases.

• Record paint specifications.

• Attach office documents, pictures, or other associated files.

• Link to design files from other applications.

• Filter material lists and member design reports for specific attributes.

Attaching files as attributes

When a file is attached as an attribute, you can embed it within the Tekla
Structural Designer file. When embedded, the attached file is included when
the model is transferred to another computer.

NOTE The embedded file only gets attached to the Tekla Structural Designer
file when the model is saved using Save or Save As.

This means that the embedded files are not attached when you use
Save Model Only. Similarly, if you have to revert to an autosaved
version of the model, the embedded files will not be attached.

Transferring attributes

Attributes are transferred when models are exported to Tekla Structures and
Revit. In the current release, attributes are not yet included for Tekla Structural
Designer drawings.

Manage models 1026 Create and manage user-defined attributes



UDA definitions and values

Example UDA definitions are included in the default settings sets. You can
easily modify the definitions according to your needs. You can modify the
definitions that apply to the current model in Model Settings.

You can attach specific UDA values to members and panels according to your
needs.

Once a UDA value exists, it can also be assigned to or removed from members
graphically by using the Review View.

See also

User-defined attribute settings (page 2274)

Create attribute definitions (page 1027)

Attach UDA values to members and panels (page 1028)

Apply attribute filters to material lists and reports (page 1030)

Create attribute definitions
You can create and modify attribute definitions according to your needs. The
attributes are defined either in the Model Settings dialog box or in the 
Settings dialog box, depending on whether you want the to the attributes be
applied to the current model or new models.

Create attribute definitions in the current model

1. On the Home tab, click Model Settings. 

The Model Settings dialog opens.

2. Go to the User Defined Attributes page.

3. Click Add.

4. Define the following properties: 

• Name

• Type

• Source

• Values (value choices that apply when the source is value list)

NOTE The order in which UDAs are listed in the replicates the order in
which the UDAs are listed in the Model Settings dialog.

Use the Move Up and Move Down buttons to reorder the UDAs.
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Create attribute definitions for new models
1. On the Home toolbar, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set to which you want the attributes to apply.

4. Go to the User Defined Attributes page.

5. Define the following properties: 

• Name

• Type

• Source

• Values (value choices that apply when the source is value list)

NOTE The order in which UDAs are listed in the replicates the order in
which the UDAs are listed in the Model Settings dialog.

Use the Move Up and Move Down buttons to reorder the UDAs.

Attach UDA values to members and panels
You can attach office documents, pictures, or other files to the members and
panels of your model. When you attach files to members and panels, they are
embedded in the file. The embedded files will also be included in the model if
the model is transferred to another computer.

See also

Create attribute definitions (page 1027)

Attach a UDA value using the Properties Window
1. Select the members or panels to which you want to attach attributes. 

NOTE If the selection contains different member types, select the first
member type in the list at the top of the Properties window.

2. In the Properties window, under UDA, define the value for each attribute
that you want to attach.
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3. If the attribute is a file, select the Embedded option to save the file inside
the model. 

Only embedded files are automatically transferred when the model is
copied to another computer.

TIP For multi-span beams and multi-stack columns or walls, you can
attach separate UDAs to individual spans or stacks.

4. Repeat steps 1-3 for additional member types.

Attach an existing UDA value in the Review View

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Set On or Toggle.

3. In the Properties window, select the attribute.

4. In the Properties window, select a value for the selected attribute. 

NOTE You can use some additional settings in the Properties window to
control which members and panels are displayed in the Review
View.

• Under Filter, you can use the Show and Entity type to select
which attribute values and entities are displayed.

• Select the Color for other values box to display members
that have an other value of the selected attribute.

5. Click the desired members to add the UDA value. 

TIP To remove the UDA value:

• If the [M]ode is set to Set On, change it to Set Off.

• If the [M]ode is set to Toggle, click the selected members again.

Graphically review the attached UDA values

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Review.

3. In the Properties window, select the attribute that you want to review. 

The members or panels are color-coded to represent the different values
of the selected attribute.
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Open a file that has been attached as a UDA

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Review.

3. In the Properties window, select the attribute that you want to review.

4. Click the member or panel to which the file is attached. 

Provided that the extension has been associated with an appropriate
application, the application opens and displays the file.

Apply attribute filters to material lists and reports
User-defined attributes (UDAs) allow you to filter material lists and member
design reports for specific attributes. For more detailed information, see the
following paragraphs.

See also

Create attribute definitions (page 1027)

Attach UDA values to members and panels (page 1028)

Material list settings (page 2269)

Apply an attribute filter to material list review data
1. On the Review tab, click Tabular Data.

2. In the View Type list, select Material List.

3. In the Filter list, select Selected UDAs. 

The Select filter items dialog box opens.

4. Select the required attribute values.

5. Click OK.

Apply an attribute filter to a report
1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. In the Available Styles list, select the report.

3. In the Report Structure list, right-click the chapter or sub-heading that
you want to filter.

4. In the context menu, select Model Filter --> Edit\New... 

The Select filter dialog box opens.

5. Click Add.
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6. In the Filter properties list, select Selected UDAS.

7. In the Selected items list, select the attribute values.

8. Click OK.

12.6 Manage sub structures
Sub structures are saved user-defined selection groups of any objects which
can be of any size and mix of object types, materials etc. They can be viewed in
isolation and used as filters for many areas of program operation. Using sub
structures has multiple productivity benefits throughout the Tekla Structural
Designer workflow, from model organization and editing through to results
review, design and output.

NOTE In Tekla Structural Designer the term sub structure is specifically used to refer
to a collection of elements, either above or below ground level. It is not being
used to refer to that part of the structure below ground level (e.g. basements
and foundations).

Sub structure characteristics
The basic characteristics of Tekla Structural Designer sub structures are:

• Elements can be a part of more than one sub structure.

• Not every element has to be in a sub structure.

• Deleting a sub structure does not delete the elements within it.

• Sub structures are distinct from, and should not be confused with sub
models (page 661).

• Sub structures themselves are never analyzed.

• Sub structure groups are simply collections of other sub structures.

Create a sub structure
1. To create a sub structure from a Structural View

1. In the scene view, click or box around the members that you wan to
include in the sub structure.

2. Right click and from the context menu select Add to Sub Structure...

3. In the left hand pane of the dialog, all the selected objects are listed with
on/off check boxes

Manage models 1031 Manage sub structures



a. Uncheck any objects that you don't want to be included in the sub
structure.

4. In the left hand pane of the dialog, choose an existing or new
substructure, and if new, enter the sub structure name.

5. Click OK

2. To create a sub structure from the Project Workspace

6. In the Project Workspace open the Structure tree.

7. Expand the Sub Structures branch.

8. Right-click the Sub Structures sub branch, then in the context menu,
select Create Sub Structure.

9. Review the sub structure properties in the Properties window.

10. In the Name field, type the name of the sub structure.

11. Select the color of the sub structure.

12. In the 3D view, click or box around the members that you want to include
in the sub structure.

13. Press [Esc] when complete.

3. To create a sub structure from a Review View

14. On the status bar at the bottom of the window, click Review View.

15. On the Review tab, click Sub Structures.

16. Go to the Properties window.

17. Set Review/Update to Update Selected.

18. Set Update Sub Structure to - - New - -.

19. In the Name field, type the name of the sub structure.

20. Select the color of the sub structure.

21. In the review view, click or box around the members that you want to
include in the sub structure.

22. Press [Esc] when complete.

Edit a sub structure
1. To edit a sub structure from the Project Workspace

1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.
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3. Right-click the sub structure that you want to add to, or remove from.

4. in the context menu, select Edit.

5. Skip to step 7 below.

2. To edit a sub structure from a Review View

6. On the status bar at the bottom of the window, click Review View.

7. On the Review tab, click Sub Structures.

8. Go to the Properties window.

9. Set Review/Update to Update Selected.

10. In Update Sub Structure, select the sub structure that you want to
modify.

11. In Selection Mode, select how you want to modify the structure.

12. In the review view, click or box around the members that you want to
modify.

Delete a sub structure

NOTE Deleting a sub structure only removes the association between the
selected group of members - the members themselves are not
deleted.

1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.

3. Right-click the sub structure that you want to delete.

4. in the context menu, select Delete.

Rename a sub structure
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.

3. Right-click the sub structure that you want to rename.

4. in the context menu, select Rename.

5. Enter the new name as required.
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Review sub structures

1. On the status bar at the bottom of the window, click Review View.

2. On the Review tab, click Sub Structures.

3. Go to the Properties window.

4. Set Review/Update to Review All. 

Tekla Structural Designer displays each sub structure in a different color.

Create a sub structure group
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch.

3. Right-click the Sub Structure Groups sub branch.

4. In the context menu, select Create Sub Structure Group.

5. Select the sub structures to be included in the sub structure group.

6. In the Properties window.

a. In the User name field, type the name of the sub structure group.

b. Select the color of the sub structure group.

Open a 3D view of a sub structure
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch.

3. Double-click the sub structure. 

Tekla Structural Designer opens a 3D view of the selected sub structure.

TIP To open a solver view of the sub structure, right-click the sub
structure, and select Open solver view.

4. Once the view has opened, a  (Ghosted) button is displayed in the
bottom right corner. Clicking this button toggles the display to either show
just the sub structure, or the sub structure with a 'Ghosted On' view of the
rest of the model.
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Use Ghosted to see the view in the context of the whole
model

You can toggle Ghosted on and off using the  button.

NOTE The  Ghosted button is displayed in in the bottom corner of Sub Structure
and Sub-model Views. It is also displayed in Level, Frame, and Slope Views
when they have been toggled into 3D (via the 2D/3D toggle button).

• Ghosted off: the view is displayed in isolation.

• Ghosted on: the view is displayed in the context of the whole structure.
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Related video

Ghosted Structure view

Related information

Related videos

How do I use Sub structures?

Sub Structure enhancements

See also

Check all members and walls in a sub structure (page 782)

Design all slab items in a sub structure (page 799)

Check all slab items in a sub structure (page 797)
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12.7 Working with large models
Although bigger models will typically need more RAM, you should note that it
is the volume of model data and results data created during analysis and
design that generates the demand for RAM, so by controlling the volume of
data you are able to influence the speed of solution.

Your modelling and design choices can affect the volume of data produced;
some of the more significant of these choices are discussed below:

Don't mesh concrete slabs in 3D Analysis

Meshing is not necessary in 3D Analysis for traditional Beam and Slab models
as these can use FE decomposition instead.

It is also not necessarily required for Flat Slab models, however, it does
become required if you have a transfer slab. It is not critical unless the slab is
part of the lateral resistance system.

By default the Mesh 2-way slabs in 3D analysis option that controls this is not
checked at any level; you should only check it at a given level when you have
good reason to do so.

Using coarser shell meshing in large models

You should review and consider adjusting the mesh parameters as the
defaults can often be conservative.

• Using coarser mesh parameters has no impact on sway or modal
frequencies.

• If you are not concentrating on slab design you can use very coarse
meshes.

Ultimately it is your responsibility to be comfortable with the level of mesh
refinement applied to the model. However we would definitely recommend
using a courser mesh during design development and then perhaps consider
refining a bit more at final design stage.

Using coarser semi-rigid diaphragm meshing in large models

If you have employed semi-rigid diaphragms and are experiencing
performance issues you should review and consider adjusting the semi-rigid
mesh parameters.

It has been observed that using refined semi-rigid meshes generally has
negligible impact on results and only has the effect of slowing down analysis
and increasing memory requirements. It is suggested that the default mesh
parameters may be more refined that is actually necessary.

Limit the number of load cases and combinations

You can control the number of combinations created when running the
Combination Generator.
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In particular you should consider limiting the number of wind load cases and
combinations.

Also:

• Don't add wind loading during the initial design development.

• Don't activate pattern load cases and combinations until you need to,
probably only at the final design stage.

Alternative design approach for large models

For large models, rather than running Design All you may be able to save time
by running Analyse All instead and then run a selective design, such as:

• Design by level

• Design by frame

• Design by group

• Design by sub-structure

• Design by member

Effective use of Auto Design

Although for the first design run you might choose to use select bars starting
from Minima, on subsequent runs it is generally more efficient to use select
bars starting from Current; this will run a check on the current steel provision
and if inadequate, it will automatically re-select new steel bars to pass the
design.

Check Design can also be very effective - you can turn off the Autodesign and
then manually deal with any fails.

Design members for FE chasedown analysis results

This is set in the design options for concrete and by default it is checked on for
beams, columns and walls. However in a traditional Beam and Slab model it
may not actually be necessary; it is generally not critical unless you have some
unusual transfer level challenge. In large models you should therefore
consider unchecking it.

Re-design columns (or beams) using previous analysis results

If you change the size of a member you can try out its design without being
forced to re-analyse.

Basically you can make any edit you want that does not change the number of
stacks in a column, (or spans in a beam); although the analysis results will be
marked as out of date, you can still do a design for the changed member
based on the old analysis results.

So using the list below as examples design can still be done in all the cases
noted:

1. Changing column (or beam) size but retaining shape - designs ok (but see
3 and 4).
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2. Changing column (or beam) shape - designs ok (but see 3 and 4).

3. Making column (or beam) smaller so that previously attached members
no longer attach - this changes number of stacks - design beyond scope.

4. Making column (or beam) larger so that previously un-attached members
now attach - this changes number of stacks (spans) - design beyond
scope.

5. Adding / editing / deleting beams that attach to a column - design remains
possible up to the point that it affects number of stacks - OK

6. Adding / editing / deleting flat slabs that attach to a column - design
remains possible up to the point that it affects number of stacks - OK

7. Adding / deleting stacks or levels (or editing level properties) - Adjusting
Levels designs ok because number of stacks is the same. If you add or
remove stacks then design is beyond scope.

Model organisation

Tekla Structural Designer has a number of features for organising the model
than can each be used to increase efficiency:

• Grouping - one design is applied to all members in the group.

• Sub-structures - allow you to focus on specific areas of interest.

• Duplicate levels - generally save modelling time and reduce the volume of
data.

When using duplicate levels, you can achieve further efficiency by designing
slabs for a fine mesh at one level only, and then check the slabs at duplicates
of the level using a courser mesh result.

NOTE Because meshing parameters are "sub model", rather than "level" based, to
achieve this you would set coarse mesh parameters in the structure settings
but then override them for an individual sub model.

Our general advice for duplicate levels is:

• For preliminary design set a coarse mesh for entire structure

• For final design where there are a lot of duplicate levels

• possibly refine the mesh used for the entire structure a little

• but for each set of duplicate levels, select one and adjust the relevant
sub-model parameters to get a finer mesh.

Model complexity

Do not model every little architectural detail - especially not things like small
holes in slabs and walls.

Design Options

Take control (get it right at the beginning!)
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13 Engineers Handbooks

The Engineer's Handbooks provide wider guidance on specific areas of the
program, for example, the workflows necessary to achieve specific design
objectives.

We recommend you familiarize yourself with the Engineer's Handbook topics
from the list below that are relevant to the types of structure you work with:

• Wind modeling handbook (page 1040)

• Stability and imperfections handbook (page 1133)

• Static analysis and design handbook (page 1159)

• Seismic analysis and design handbook (page 1186)

• Steel member design handbook (page 1203)

• Concrete member design handbook (page 1274)

• Precast member design handbook (page 1527)

• Timber member design handbook (page 1564)

• Foundation design handbook (page 1580)

• Sustainability and Tekla Structural Designer (page 1643)

• Analysis verification examples (page 1645)

13.1 Wind modeling handbook
Wind loading can be modeled in Tekla Structural Designer in a variety of ways:

• The Wind Model method (page 1041) requires you to first 'clothe' the
structure in wind and roof panels and then run the Wind Wizard to create
wind zone loads that are subsequently decomposed to the structure during
analysis.

• By manually applying wind loads you avoid the requirement to construct a
wind model. For this approach, loads can either be applied directly to the
structure as Panel, Member, or Structure loads; or they can be applied as
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simple wind (page 1119) loads, which are subsequently decomposed to the
structure during analysis.

• For tall buildings you may require the assistance of wind specialists to
perform wind tunnel testing (page 1130). The information they supply can
then be imported in the form of diaphragm loads.

NOTE The Wind Model method is not currently available for the AS:1170.2 wind
code variant.

Click the links below to find out more:

• Use of a wind model to create wind loads (page 1041)

• Simple wind and manually applied wind loads (page 1119)

• Wind tunnel testing and diaphragm loads (page 1130)

Use of a wind model to create wind loads
The Wind Model method requires you to first 'clothe' the structure in wind
and roof panels and then run the Wind Wizard.... The wizard creates wind
zone loads that are subsequently decomposed to the structure during
analysis.

• Overview of the wind model method (page 1041)

• ASCE 7 Wind wizard (page 1044)

• EC1991 1-4 Wind wizard (page 1059)

• BS6399-2 Wind wizard (page 1083)

• IS 875 (Part 3) Wind Wizard (page 1100)

• Wind model loadcases (page 1104)

NOTE The Wind Model method is not currently available for the AS:1170.2 wind
code variant.

Overview of the wind model method
This guide provides an outline of the basic steps required to use the wind
model method.

The basic steps required to undertake the wind model method are as follows:

Clothe the structure in wind wall and roof panels

The Wind Model calculations depend on the geometry and inter-connectivity
of the wall panels and roof panels that envelope the building. You must
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therefore define the model together with its wall and roof panels before you
run the Wind Wizard....

NOTE You can, should you wish, use Tekla Structural Designer purely for wind
assessment - by setting up a model consisting only of wall panels and roof
panels (no members). Tekla Structural Designercan then determine the wind
loading on the building envelope.

In order to get the best results you should ensure that you define the largest
possible sizes for the wind wall and roof panels. You may compromise the
results if you define many small panels rather than one large one. (The
calculation of the reference height in particular can be unconservative.)

Applying Wall Panels

A single wall panel is determined to be a single planar surface. The outward
face is vitally important for determining the wind direction relative to the wall,
that is windward or leeward.

It is recommended that you check the outward faces are as you intend by
ensuring they are all shaded in the same colour (the one assigned to 'Wind
Wall - Front' in Settings > Scene). The inward faces will all be shaded in a
different colour. To correct any mistakes, choose the Edit --> Reverse
command and then click once on a wall panel to switch its direction. Note that
connected wall panels are checked to ensure that the normal directions are
consistent whenever automatic zoning is carried out, for example at the end of
the Wind Wizard.... If there is a problem it is indicated on the Project
Workspace --> Wind tab, with affected panels being marked.

Once a wall panel has been placed the following additional panel properties
can be specified:

• Rotation angle - defines the span direction, 0° is horizontal and 90° is
vertical.

• Is a parapet wall - you can indicate whether the wall panel is a parapet or
not.

NOTE If a building face comprises a parapet above a wall, you should not
attempt to model this as a single wall panel. It should be input as
an upper and lower panel, with the upper panel being set as a
parapet.

• Gap - (Head Codes: EC and BS only) where the gap to the adjacent building
is not consistent due to the shapes of the buildings it is up to you to decide
whether to specify the average or worst-case gap. The default gap is 1000
m which effectively give no funnelling. A zero gap value explicitly means
ignore funnelling, for example where this building and the adjacent one are
sheltered by upwind buildings

• Solidity - (Head Codes: EC and BS only) If you set the wall panel as a
parapet, then you also need to indicate the Solidity of the parapet. (Wall
panels that are not parapets automatically adopt a solidarity of 1.0).
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• Decompose to - for wall panels that are not parapets, you can indicate
how the wall load is decomposed on to supporting members. See Wind
model load decomposition (page 1109)

To set this information as you require, select the wall panels and then use the
Properties Window to make changes.

Applying Roof Panels

A single roof panel is determined to be a single planar surface. The orientation
of a roof panel is automatically determined when placed based upon the slope
vector - the line of maximum roof slope.

Initially the roof type is set to 'Default'. This is interpreted as Flat if the roof
slope < 5 degrees, otherwise it is interpreted as Monopitch. You should select
the roof panel and then use the Properties Window to adjust the roof type as
necessary for all other situations (i.e. For Duopitch, Hip Main, Hip Gable or
Mansard).

The span direction is also set in the Properties Window, this is defined as an
angle, where 0° is parallel to the X axis and 90° is parallel to the Y axis.

Perform the gravity design

We recommend that you perform an analysis and design at this stage for the
gravity loading only, but this is not essential.

Run the wind wizard

Once the model has been 'clothed' in wall panels and roof panels, the Wind
Wizard (located on the Load toolbar) guides you through the process of
intelligently 'applying' wind to the resulting building envelope.

The wizard uses databases where appropriate (depending on the wind code)
to determine the appropriate wind details for your structure location.

Having defined the wind directions in which you are interested, on completion
of the wizard the appropriate wind zones on the roofs and walls of your
structure are automatically calculated.

Related topics

EC1991 1-4 Wind wizard (page 1059)

ASCE 7 Wind wizard (page 1044)

BS6399-2 Wind wizard (page 1083)

IS 875 (Part 3) Wind Wizard (page 1100)
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Review the wind zones

The resulting wind model is accessed from the Project Workspace Wind tab.
Wind Views can also be opened as required for each wind direction.

From here, you can set the type of each roof to achieve the correct zoning, and
can then tailor the zoning to account for particular features in more detail, if
you so require.

Define the wind loadcases

The Wind Loadcases dialog (located on the Load toolbar) can then be used to
automatically define standard wind loadcases for you based on the usual
internal pressure coefficients, or you can define the loadcase information
yourself. In both cases the appropriate wind pressures are calculated on each
zone.

NOTE It is assumed that the wind loads are developed to assess the overall stability
of the structure and for member design. The wind loads have not been
specifically developed for the design of cladding and fixings.

Related topics

Wind model loadcases (page 1104)

Review wind zone loads

Wind zones can be graphically displayed for each wind direction from the
appropriate Wind View. Once the wind loadcases have been created you can
also display the wind pressures and zone loads for each loadcase.

Combine the wind loadcases into design combinations

Combine the wind loadcases into design combinations in the usual way.

Perform the static design

Run a static design from the Design toolbar.

ASCE 7 Wind wizard
This topic will discuss in detail the Wind wizard when using ASCE7

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to ASCE7.

Once the wall and roof panels are in place, you use the Wind Wizard on the
Load toolbar to define sufficient site information to calculate the velocity
pressures for the required wind directions and heights around the building.

NOTE Unless explicitly noted otherwise, all clauses, figures and tables referred to in
the topics in this section are from ASCE 7-10. References (page 1118) 1.
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Topics in this section

Scope (ASCE7 Wind Wizard) (page 1045)

Limitations (ASCE7 Wind Wizard) (page 1045)

Choice of Method (ASCE7 Wind Wizard) (page 1047)

Low Rise Buildings - Geometry (ASCE7 Wind Wizard) (page 1049)

Rigid Buildings of All Heights - Geometry (ASCE7 Wind Wizard) (page 1051)

Basic Wind Data (ASCE7 Wind Wizard) (page 1053)

Results (ASCE7 Wind Wizard) (page 1055)

Wind Zones - ASCE7 Low Rise Building Method (page 1055)

Wind Zones - ASCE7 All Heights Method (page 1056)

Scope (ASCE7 Wind Wizard)

The scope of ASCE7-10 Wind Wizard encompasses:

• Choice of method:

• ASCE/SEI 7-10 - Directional Procedure Part 1 - Rigid Buildings of All
Heights

• ASCE/SEI 7-10 - Envelope Procedure Part 1 - Low-Rise Buildings

• The input of appropriate basic wind data is your responsibility.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or pitched roof depending on the slope), you are able to specify the type in
more detail e.g. monoslope / mansard etc.

• Wherever possible the wind parameters are determined for you but
conservatively, you are able to override the values should you wish to.

• Given the above, zoning is semi-automatic, with full graphical feedback.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

• There may be situations when you perceive a need to manually define
loads that cannot be determined automatically. You can do this by defining
additional wind load cases to contain these loads and then include these
with the relevant system generated loads in design combinations in the
normal way.

Limitations (ASCE7 Wind Wizard)
This page discusses the limitations to the wind wizard.
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Throughout the development of the Wind Wizard extensive reference has
been made to the References (page 1118) and we consider it advisable that
you are fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:

Geometry

The shape of the building must lie within the shapes that are valid according to
ASCE7-10 Clauses 27.1.2 and 28.1.2:

• It should be a regular shaped building or structure

• It should not have response characteristics making it subject to across-
wind loading, vortex shedding, instability due to galloping or flutter; or
have a site location for which channelling effects or buffeting in the wake of
upwind obstructions warrant special consideration.

Although the software will generate wind loads for many situations - it is up to
you to accept that the loads generated are suitable according to ASCE7-10.

Other documented limitations include:

• Buildings must be enclosed or partially enclosed.

• Open sided buildings are not considered.

• Only rigid buildings are considered, not flexible buildings.

• Zones and load cases are not generated for components and cladding.

• You will need to establish and enter the wind data yourself.

• Roof types must be set manually.

• Barrel-vault and domed roofs are not considered.

• Parapets and free-standing canopies are not considered.

• Roof Overhangs are not explicitly handled.

• There is no special handling for Multi-Bay roofs as they are not covered
explicitly in ASCE 7-10.

• There is no special handling for troughed roofs as they are not covered
explicitly in ASCE 7-10.

Loaded area

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.
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Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.

• Orthogonal wind directions at the definition of the user.

Design wind load

The design wind load is not explicitly checked to ensure it is greater than the
minimum of 16 psf - (as per Clause 27.4.7 for the Directional method, or 28.4.4
for the Envelope procedure.)

However, the average wind pressure for each of Windward, Leeward and Side
directions is provided for you to manually check this is satisfied.

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind load cases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Choice of Method (ASCE7 Wind Wizard)

You can choose between:

• Directional Procedure Part 1 - Rigid Buildings of All Heights (Chapter 27)

• Envelope Procedure Part 1 - Low-Rise Buildings (Chapter 28)

Envelope Procedure Part 1 - Low-Rise Buildings (Chapter 28)

The Low-Rise Building method is explicitly limited to buildings where the mean
roof height does not exceed the least horizontal dimension and is less than or
equal to 60 ft, (ASCE7-10 Clause 26.2). It is implied that the method should
only be used for simple rectangular box-shaped buildings, however, you are
given the final responsibility for determining the applicability of this method to
your model.

Failure to comply with any of the following conditions will explicitly prevent
access to this method:

• There must be 4 walls which must be connected sequentially and form a
"simple" quadrilateral in plan form, (all internal corners between 82.5° and
97.5°).

• Each wall must be almost vertical (>80°)
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• Each wall must either have 4 sides, forming a "simple" quadrilateral in
elevation, or 5 sides forming a convex shape, (allowing for gable ends of
buildings).

• The roof system must be one of the following:-

• Single quadrilateral roof with type "Flat"

NOTE Where a building has a single roof with a low slope, (e.g. 2°), the
default will be "Pitched", but if you consider the building
suitable for the Low-Rise method, you can force the roof type to
"Flat" rather than "Monoslope".

• Two quadrilateral "Pitched" roofs which must have a single edge in
common. The roofs must face in opposite directions and have similar
slopes, (less than 3° difference).

• Two quadrilateral "Hip Main" roofs which must have a single edge in
common and either 1 or 2 hip gable roofs which must be triangular. The
"Hip Main" roofs must face in opposite directions and have similar
slopes, (less than 3° difference).

• In particular, the Low-Rise Method is not allowed with Monoslope or
multi-span roofs.

Next

Depending on whether you choose the Low-Rise or the Rigid Buildings
method, clicking Next takes you to either the Low rise building - Geometry
page, or the Rigid building of all heights - Geometry page.
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Low Rise Buildings - Geometry (ASCE7 Wind Wizard)

The following geometry items are required for the Low Rise Buildings method.
You can override calculated dimensions using your engineering judgement.

Property/Buttons Description
Property  
Ground level If for some reason, the level 0.0 feet

in the Tekla Structural Designer
model does not correspond to the
ground level, e.g. you have used a site
datum rather than a building datum,
then this field allows you to set the
appropriate value so that the
reference heights for the wind can be
calculated correctly. The default is
zero. The allowed maximum is the
minimum wall or roof height.
Changing the value in this field will
cause the Mean Roof Height to be
recalculated, unless you have chosen
to override that dimension.

Orientation of Longitudinal Direction
relative to axes (Figure 28.4-1)

This information is required to control
the orientation of the Transverse and
Longitudinal directions, and thus the
Tekla Structural Designer Wind
Directions. For simple roof shapes,
ASCE7- 10 Wind Wizard will calculate a
default value as below.

• Single flat roof - orient along
longest side,

• 2 Duopitch roofs - orient along
common edge,

• 2 Hip Main roofs - orient along
common edge.

• Changing the value in this field will
cause either or both of the
Longitudinal and Transverse
Dimensions to be recalculated,
unless you have chosen to
override them.

Roof Angle The field is always visible, even if
there are no roof panels in your
model. It is calculated as follows:

• No roof panels - θ = 0°.
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Property/Buttons Description
• Else - use maximum angle for all

roof panels in the model.

You are able to override the
calculated value by checking the box;
The limits are 0° to 80°.

Mean Roof Height, h (Clause 26.2) The field is calculated as follows:

• No roof panels -h is maximum
reference height for walls,

• Else if θ <=10° - use maximum
eaves height, (h e), for all roof
panels in the model, (see Figure
28.4-1)

• Else - use maximum Mean Roof
height, (h), for all roof panels in
the model.

In the example below, h = (hu + hl)/2 -
g

h is limited to a maximum of 60 ft or
the Least Horizontal Dimension,
whichever is lower. You are able to
override the calculated value by
checking the box.

Longitudinal and Transverse
Dimensions (Clause 26.3 and Figure
28.4-1)

These are similar to the Overall
building X dimension and overall
building Y dimension (Clause 26.3) for
the Rigid Buildings of All Heights
Method.

These dimensions are calculated from
the smallest enclosing rectangle
(considered over all roof and walls
only), relative to the given orientation
of the Longitudinal Direction. You are
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Property/Buttons Description
able to override each calculated value
by checking its box. These values will
then be used to derive the L and B
dimensions for each wind direction.

For Longitudinal Wind Directions, L =
Longitudinal Dimension, B =
Transverse Dimension.

For Transverse directions, L =
Transverse Dimension, B =
Longitudinal Dimension.

Buttons  
Next Clicking Next takes you to the Basic

wind data page.

Rigid Buildings of All Heights - Geometry (ASCE7 Wind Wizard)

The following geometry items are required for this method. You can override
calculated dimensions using your engineering judgement.

Property/Buttons Description
Property  
Ground Level in Model (Ignore Wind
Below)

If for some reason, the level 0.0 feet
in the Tekla Structural Designer
model does not correspond to the
ground level, for example you have
used a site datum rather than a
building datum, then this field allows
you to set the appropriate value so
that the reference heights for the
wind can be calculated correctly. The
default is zero. The allowed maximum
is the minimum wall or roof height.
Changing the value in this field will
cause the Mean Roof Height to be
recalculated, unless you have chosen
to override that dimension.

Orientation of Principal Axes This is similar to the Orientation of
Longitudinal Direction relative to axes
(Figure 28.4-1) (page 1049) for Low-
Rise Buildings. Although there is no
need to distinguish between the
Longitudinal and Transverse axes for
this method, the wind X axis will be
aligned to this direction with the Y
axis at right angles. The vortex view
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Property/Buttons Description
will be slightly different to the Low-
Rise one to reflect that.

Due to the potential complexity of the
model, the Wind Wizard... will only
attempt to determine the correct
angle for the axes if the building is
also suitable for Low Rise, otherwise
zero is used as the default.

Mean Roof Height, h (Clause 26.2) For this method, the actual reference
height is only be used for the
pressure on windward walls. For all
other walls, and roofs, a single height
is used to determine the pressure for
each direction.

By default, the height is calculated as
for Low-Rise Buildings except that
there is no single value of θ, so the
eaves height is only used if all the
roof angles are <= 10°. You are able
to override the calculated value by
checking the box.

Level of Highest Opening in Building,
zi (Clause 27.4.1)

For this method, qi is evaluated at
height h for all cases except for
positive internal pressure in partially
enclosed buildings, where it should
be evaluated at the level of the
highest opening. However, the clause
allows h to be used even for this case,
so the default is for the box to be
checked and the level to be
automatically updated as the Mean
Roof Height changes.

Overall Building X Dimension and
Overall Building Y Dimension (Clause
26.3)

These dimensions are calculated from
the smallest enclosing rectangle
(considered over all roof and walls
only), relative to the given orientation
of the Principal Axes - see figure
below. You are able to override each
calculated value by checking its box.
These values will then be used to
derive the L and B dimensions for
each wind direction.

For X Axis, L = X Dimension, B = Y
Dimension.
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Property/Buttons Description
For Y Axis, L = Y Dimension, B = X
Dimension:

Design Pressure Factor (Figure 27.4.8
and Clause 27.4.6)

This defaults to 75%, but the
commentary suggests that this may
not cover all cases so you are allowed
to change it. A single factor is used for
all Torsional loadcases.

Eccentricity (Figure 27.4.8 and Clause
27.4.6)

This defaults to 15% but again, the
commentary suggests that this may
not cover all cases so you are allowed
to change it. A single factor is used for
all Torsional loadcases.

Buttons  
Next Clicking Next takes you to the Basic

wind data page.

Basic Wind Data (ASCE7 Wind Wizard)

Once the geometry has been confirmed, (for either method), you are then
required to enter the basic wind data. The only difference between the two
methods is that the Gust Effect Factor field is only shown for the All Heights
Method.

Property/
Buttons

Description

Property  
Basic Wind
Speed (Clause
26.5.1)

A strictly positive value is required with 90mph being the
default.

Hurricane-Prone
Region (Clause
26.2)

The default is cleared, i.e. region not prone to hurricanes.
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Property/
Buttons

Description

Directionality
Factor, Kd
(Clause 26.6, and
Table 26.6-1)

The default is 0.85, range 0.85 to 1.0 inclusive.

NOTE There is no cross-checking to ensure that the
model has met the load combination criteria. If
that does not apply, then it is your own
responsibility to enter the correct value of 1.0.

Enclosure
Classification
(Clause 26.10)

Options are "Enclosed" and "Partially Enclosed" with
default being "Enclosed".

NOTE "Open" structures are not handled in the current
version of the program

Gust Effect
Factor (Clause
26.9.1)

This will only be shown for the All Heights Method. The
default value is 0.85.

Principal Axes There are always four directions shown for principal axes,
being based on the Orientation of the Longitudinal
Direction or Principal Axes depending on the method. You
are not able to add, delete or modify any direction.

Exposure
Category (Clause
26.7.3)

Options are "B", "C" or "D" with default being "B".

Topographic
Feature (Clause
26.8 and Figure
26.8-1)

Options are as follows, with the default being "None":

• "None" - no feature, i.e. Kzt = 1.0.

• "2D Ridge"

• "2D Escarp" - 2D Escarpment

• "3D Hill" - 3D Axisymmetrical Hill
Crest Height, H
(Figure 26.8-1)

Height of the hill or escarpment relative to the upwind
terrain.

The behaviour of this field depends on the Feature type as
follows:

• "2D Ridge" - non-zero values allowed, (negative
indicates a valley).

• "2D Escarp" - strictly positive values allowed

• "3D Hill" - strictly positive values allowed
Crest Length, Lh
(Figure 26.8-1)

Distance upwind of crest to where the difference in ground
elevation is half the height of the hill or escarpment.
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Property/
Buttons

Description

Distance to
Crest, x (Figure
26.8-1)

Distance upwind or downwind from the crest to the
building site.

The value may be positive to indicate downwind, or
negative to indicate upwind.

Buttons  
Next Clicking Next takes you to the Results page.

Results (ASCE7 Wind Wizard)

The final page of the Wind Wizard is a summary of the velocity pressure
results for the principal axes. You are able to use the Details... button to
obtain additional information, including the values of intermediate factors
used in the calculations.

Finishing the Wind Wizard

When you click Finish, the Wind Wizard... generates the wind zones for the
entire building for each of the specified wind directions.

Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 1045) have been encountered.

Related topics

Wind Zones - ASCE7 Low Rise Building Method (page 1055)

Wind Zones - ASCE7 All Heights Method (page 1056)

Wind Zones - ASCE7 Low Rise Building Method

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Wind Directions

Eight zone directions evenly spaced at 45 degree intervals about the
longitudinal direction are defined as follows:

• Long (B) 1 - (longitudinal direction + 22.5°, uses data for +X' principal axis)

• Trans (A) 1 - (longitudinal direction + 67.5°, uses data for +Y' principal axis)

• Trans (A) 1 - (longitudinal direction + 112.5°, uses data for +Y' principal axis)

• Long (B) 4 - (longitudinal direction + 157.5°, uses data for -X' principal axis)

• Long (B) 3 - (longitudinal direction + 202.5°, uses data for -X' principal axis)
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• Trans (A) 3 - (longitudinal direction + 247.5°, uses data for -Y' principal axis)

• Trans (A) 2 - (longitudinal direction + 292.5°, uses data for -Y' principal axis)

• Long (B) 2 - (longitudinal direction + 337.5°, uses data for +X' principal axis)

These enable the modeling of two sets of zones per principal axis with the
correct reference corner in each case.

Wall Zones

The Wind Wizard automatically generates wall zones, where possible, for each
Direction of MWFRS Being Designed and Reference Corner in accordance with
Figure 28.4-1.

Roof Zones

The Wind Wizard... automatically generates roof zones, where possible, for
each Direction of MWFRS Being Designed and Reference Corner in accordance
with Figure 28.4-1.

For flat roofs and for MWFRS parallel to the ridge line we assume Note 8 is not
applicable.

Where Note 7 applies, we assume the dimension to the zone 2/3 boundary is
measured horizontally.

Automatic Zoning

Automatic zoning only applies to all triangular roof panels and quadrilateral
roof panels that are not concave, that is that all of the internal angles < 180°.

Wind Zones - ASCE7 All Heights Method

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Wind Directions

Eight zone directions evenly spaced at 45 degree intervals starting from the
longitudinal direction are defined as follows:

• +X - (longitudinal direction, uses qz for 1st principal axis)

• +X+Y - (longitudinal direction + 45°, uses qz for 1st and 2nd principal axes)

• +Y - (longitudinal direction + 90°, uses qz for 2nd principal axis)

• -X+Y - (longitudinal direction + 135°, uses qz for 2nd and 3rd principal axes)

• -X - (longitudinal direction + 180°, uses qz for 3rd principal axis)

• -X-Y - (longitudinal direction + 225°, uses qz for 3rd and 4th principal axes)
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• -Y - (longitudinal direction + 270°, uses qz for 4th principal axis)

• +X-Y - (longitudinal direction + 315°, uses qz for 1st principal axis)

The 4 directions +X,+Y,-X,-Y enable the modeling of design wind load cases 1
and 2 from Figure 27.4-8. The 4 intermediate directions +X+Y etc. enable the
modeling of load cases 3 and 4.

Wall Zones

The Wind Wizard... automatically generates wall zones, where possible, in
accordance with Figure 27.4-1.

Windward Walls are split horizontally over intermediate heights. Zones are
labelled with a 'W' followed by the height at top of zone rounded to nearest
foot (or meter if using metric units). Each zone uses the same Cp, (0.8 from
Wall Cp table in Figure 27.4-1), but a different velocity pressure, qz, z being
determined at the top of the zone.

Complex wall shapes are dealt with by splitting zones intelligently as illustrated
below:
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Leeward walls have a single zone, 'L', using a Wall Cp from the table in Figure
27.4-1, with interpolation for L/B. The velocity pressure, qh is used for all such
zones.

Side walls have a single zone, 'S', using the same Cp, (-0.7 from the Wall Cp
table in Figure 27.4-1). A single velocity pressure, qh is used for all such zones.

Skew Walls

There is no guidance in ASCE7-10 for walls not orthogonal to the principal
axes. However, the Wind Wizard... will apply zones in those cases and it is
your responsibility to check the wind loads adopted.

Roof Zones

The Wind Wizard... automatically generates Windward and Leeward roof
zones ('W' and 'L' respectively, where possible, in accordance with Figure
27.4-1. This is possible for Windward and Leeward roof panels with θ >= 10°,
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because there is only one zone. However, for θ < 10° and Side roof panels,
automatic zoning will not be carried out for all cases.

Negative and positive values of Cp are determined for each zone from the Roof
Cp table in Figure 27.4-1.

For non-principal axis directions, it is assumed that roof loads are not required
and so special zones are created, named "Zero". Such zones will result in zero
loading on the relevant roof panels. However, if the you choose to do so you
can change these to non-standard zones and enter coefficients to force loads
to be applied.

When calculating the area reduction factor we use the slope area not the plan
area.

Mansard roofs are not automatically detected, i.e. it is your responsibility to
set the Roof Type manually. Generally, Mansard roofs are handled exactly the
same as if they are:

• Flat (for slope < 0.1°)

• Pitched (for slope >= 0.1°)

There is no guidance on what to do with other multipitch roofs, so they are
treated as pitched roofs, whether they have been flagged as Mansard or not.

Side roofs are split into to 4 zones depending on the size of the roof. See the
Roof Cp table in Figure 27.4-1.

• Zone 1 - 0 to h/2, interpolating between 2 values for h/L if necessary.

• NOTE Upper value for interpolation can be reduced linearly with the
sloped area of this zone, (see ** in Figure 27.4-1).

• Zone 2 - h/2 to h, interpolate between -0.9 and -0.7 for h/L if necessary

• Zone 3 - h to 2h, interpolate between -0.5 and -0.7 for h/L if necessary

• Zone 4 - > 2h, interpolate between -0.3 and -0.7 for h/L if necessary

Automatic Zoning

Automatic zoning will apply to all Windward and Leeward roof panels with θ >
10°, because there is only one zone. However, for θ < 10° and Side roof panels,
automatic zoning will not be carried out for all cases.

EC1991 1-4 Wind wizard
This topic will discuss in detail the Wind wizard when using the Eurocode BS
EN1991-1-4

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to BS EN 1991-1-4.

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the peak wind velocity and
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velocity pressures for the required wind directions and heights around the
building, (that is the Reference Heights (ze and zi) for each wall panel or roof
panel).

The wind velocity calculations are automated, with the data source for the
calculations being either:

• Input directly for the worst case,

• Input directly for each direction,

• taken directly from the BREVe database which is based upon the Ordnance
Survey data of Great Britain (only available for users working to the UK or
Ireland National Annex).

Topics in this section

Design Codes and References (page 1060)

Scope (Eurocode EC1991-1-4 Wind wizard) (page 1060)

Limitations (EC1991-1-4 Wind wizard) (page 1061)

Using the EC1991-1-4 Wind wizard (page 1064)

Using the EC1991 1-4 Wind Wizard with BREVe data (page 1070)

EC1991 1-4 Wind Zones (page 1078)

Design Codes and References

Unless explicitly stated all calculations in the EC1991 1-4 Wind Wizard are in
accordance with the relevant sections of EC EN1991 1-4 (Ref. 3) (page 1118)
and the chosen National Annex. It is essential that you have a copy of the code
and National Annex with you while assessing wind on any structure.

We would recommend having the following books to hand when using the
software:

• Designers' Guide to EN 1991-1-4. Euro Code 1 : Actions on Structures,
General Actions Part 1-4 : Wind actions. (Ref. 6) (page 1118)

• Wind Loading - a practical guide to BS 6399-2 Wind Loads on buildings.
(Ref. 7) (page 1118)

In addition, you may find the following book useful:

• Background information to the National Annex to BS EN 1991-1-4 and
additional guidance. PD 6688 - 1-4:2009. (Ref. 5) (page 1118)

• Unless explicitly noted otherwise, all clauses, figures and tables referred to
in this section of the handbook are from EC EN1991 1-4. (Ref. 3)
(page 1118)

Scope (Eurocode EC1991-1-4 Wind wizard)

There is no guidance in the standard for anything other than a cuboid
building. In order to develop a tool for engineers, we have extended this
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capability to address non-rectilinear buildings. It is therefore the user's
responsibility to ensure that the wind loading generated by the software
meets the needs of any building with a shape that is beyond the scope of BS
EN 1991-1-4:2005.

The scope of EN1991 1-4 Wind wizard encompasses:

• Enveloping the building with wall panels and roof panels is undertaken in
Tekla Structural Designer in the normal manner. There is only limited
validation of the envelope defined (for example connected wall panels
must have consistent normal directions). The onus is on you to model the
building shape as completely and as accurately as you determine
necessary.

• Basic Wind Velocity and Peak Velocity Pressure is determined.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or monopitch roof depending on the slope), you are able to specify the
type in more detail e.g. multi-bay, monopitch / duopitch etc.).

• The main wind parameters, are calculated for you but conservatively, (for
example Crosswind Breadth, b, is determined for the enclosing rectangle of
the whole building). Wherever possible other parameters are determined
conservatively, but you are able to override the values should you need to.

• Given the above, zoning is semi-automatic, (not attempted for roofs with
more than 4 sides which are defaulted to single conservative coefficient),
with full graphical feedback.

• The software follows the UK NA (Ref. 3) (page 1118) recommendation that
BS6399 roof zones and coefficients are used, including Mansard, Multipitch
and Multibay roofs.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

Limitations (EC1991-1-4 Wind wizard)
This page discusses the limitations to the wind wizard.

Throughout the development of the Wind wizard extensive reference has been
made to the References (page 1118) and we consider it advisable that you are
fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:
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Geometry

WARNING You should seek specialist advice for building shapes that are not
covered by the Standard - BS EN 1991-1-4:2005.

• EC1 1-4 does not treat downwind re-entrant corners as special cases - see
BS6399 Clause 2.4.3.1 c). So, they are ignored in the software and no
warnings are given.

• EC1 1-4 does not handle stepped profiles, or inset storeys - see BS6399
clauses 2.4.4.2 and 2.5.1.7. Hence the software does not handle them
automatically, but does generate warnings if such cases are detected - so
you can manually edit the zones according to your engineering judgement.

• Open sided buildings are beyond scope.

• Free standing walls and sign boards are not considered.

• Canopies are not considered.

• Exposed members are not considered, for example lattices, trusses......

• Barrel-vault roofs and domes are not considered

• Dominant Faces are not explicitly handled - Clause 7.2.9 (5). However, you
can use Table 17 to calculate the necessary Cpi value or values and
manually apply to a loadcase or individual zone loads.

Loaded areas

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.

Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.

• Orthogonal wind directions at the definition of the user.

Overall loads

• Lack of correlation of pressures between the windward and leeward sides.
For Overall loadcases, the software automatically reduces the windward
and leeward wall pressures only. EC1 1-4 and the UK NA both suggest that
the reduction "may" be applied to roofs as well.

• Division by Parts rule for "slender" buildings -Clause 7.2.2 and Figure 7.4 -
not applied.
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• Friction Forces - Clause 5.3 (3), equation 5.7 and Clause 7.5.

During the "Update Zones" process, checks are performed to see if the
effects can be disregarded, (Clause 5.3 (4)), and a 'Friction needed' warning
is generated if not. When they cannot be disregarded you will need to
manually model the friction forces as lateral loads in a separate loadcase
and include them in your combinations.

Beneficial loads

• Asymmetric and Counteracting Pressures and Forces - Clause 7.1.2 and
NA.2.23. Beneficial loads are not automatically removed - instead you are
able to flag individual loads to be reduced to zero.

Singapore National Annex - Minimum horizontal loads

• The Foreword to the Singapore National Annex to EN 1991-1-4 Wind
Actions has a minimum horizontal load requirement (1.5% characteristic
dead weight). Therefore if this National Annex has been applied, it is the
users responsibility to check that this requirement has been met (by
ensuring that the horizontal component of the factored wind load is
greater).

Finland National Annex

• We do not consider thermal inversions for buildings > 100m tall

Norway National Annex

• We do not consider the transition zones between changes in terrain
category.

Wind loading on wall panels

Automatic zoning applies to all wall panels subject to the limitations described
below:

• Vertical Walls on rectangular buildings -Clause 7.2.2 - the assumption for
wall wind forces is that the building is rectangular or close to being
rectangular.

• Wall panels that are more than 15° from the vertical are outside the scope.

• Internal Wells are not covered by EC1 1-4 and in any case are not
automatically identified but you can manually edit the zones to apply the
roof coefficient or otherwise as you see fit - see BS6399 Clause 2.4.3.2a.

• EC1 1-4 does not specify how to treat recesses in side walls - see BS6399
clauses 2.4.3.2 b) and 2.4.3.3 and 3.3.1.5. So, they are ignored but warnings
are given.
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Wind loading on roof panels

• Automatic zoning only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, i.e. all of the internal angles
< 180°

• Special care should be taken for winds blowing on duopitch with slopes
that differ by more than 5°. If the wind is blowing on the steeper slope (that
is that the less steep slope is downwind of ridge), the downwind slope
should be set to be a flat roof with mansard at eaves for this wind
direction.

• Mansard and Multipitch Roofs are not detected automatically, although
certain special cases can be handled if you set the appropriate type
manually - see EC1991 1-4 Wind Zones.

• BS 6399 Table 8 curved and mansard eaves - zones start from edge of
horizontal roof.

• Roof Overhangs are not explicitly handled. It is suggested that you should
define two separate roof panels - one forming the overhang and the other
covering the inside of the building. For a small overhang, you can then
manually define Cpi values to be the same as Cpe for the adjacent wall
panel, (Clause 7.2.1 (3)). Reference 6 (page 1118), p45, implies that larger
overhangs can be manually handled by using BS6399, Clauses 2.5.9.3 and
2.6.3, i.e. standard external coefficients for the top surface and Table 18 for
the internal coefficients.

NOTE The only slight issue here is that there are two sets of edge zones
which will occupy a slightly larger area than strictly necessary.

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind load cases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Using the EC1991-1-4 Wind wizard
This section runs through each page of the wizard and discusses the various
options.

Engineers Handbooks 1064 Wind modeling handbook



Data Source page

You can choose to enter one set of Worst-Case data or different values for
each direction to be considered.

TIP Additional options are provided for using BREVe data when working to
the UK or Ireland National Annex. For further details see: Using the
EC1991 1-4 Wind Wizard with BREVe data (page 1070).

The remaining choices on the Data Source page are:

Property Description
Consider
Orography

If you select this check box, then the orographic data, (manually
entered), is used to determine the Orography Factor co as clause
A.3. When calculating calt, the altitude of the upwind base of the
orographic feature is used for each wind direction considered.
Otherwise the orographic data is ignored, co is 1.0 for all heights
and calt is the same for all directions, using the Site Altitude.

Consider
Tall
Neighbouri
ng
Structures

If the conditions in clause A.4 are met, then the wind loads need
to be based on height zn, see equation (A.14). With this box
checked, you are able to enter sufficient data to check if this
applies. If applicable, then zn will be used as the reference
height for all wall panels and roof panels in the model.

NOTE If working to the Sweden NA, Tall Neighbouring
Structures are not considered.

Consider
Obstruction
s

With this box checked, the obstruction data, (either defaulted by
BREVe depending on the roughness category for the site or
entered manually), is used to determine the Displacement
Height, hdis as (A15) in clause A.5. Otherwise the obstructions
are ignored and hdis is taken as zero.

NOTE If working to the Sweden NA, Obstructions are not
considered.

Next Clicking Next takes you to the Basic data page below.

Basic data page

This page is used you to define the site details.

Property Description
Air density You need to enter air density at the site.
Ground
level

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level, for
example a site datum may have been used rather than a
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Property Description
building datum, then this field allows you to set the appropriate
value so that the reference heights can be calculated correctly.

Fundament
al Basic
Wind
Velocity -
Clause 4.2
and NA.2.4

Reference should be made to the National Annex being worked
to when determining an appropriate basic wind speed.

Season
Factor,
cseason

Valid range 0.01 to 10.0 - default 1.0.

Probability
Factor,
cprob

Valid range 0.01 to 10.0 - default 1.0.

Default
Height for
Internal
Pressure
(zi)

Clause 7.2.9 (7) implies that all internal pressures should be
calculated using a single reference height, (zi), defaulting to the
height of the structure. Leaving Use Building Height checked
ensures that the value is automatically updated if the geometry
of wall panels or roof panels changes.

Peak
Factor, kp
(Sweden
NA only)

The Peak Factor was introduced by the Swedish EC NA (EK11)
update.

Using the default value (3.0) is the equivalent of the old
calculation method prior to the update.

Region
(Norway NA
only)

A Region is needed (Area 1, Area 2 or Area 3) representing three
different height zones in the country.

Site
Altitude
(Norway NA
only)

You need to enter the basic altitude that you want to use for the
site directly. This is the altitude of your model's base.

Next Depending on whether you chose worst case data, or data for
each direction on the Data Source page, clicking Next either
takes you to the Roughness and Obstructions (Worst case)
page or the Roughness and Obstructions (Data for each
Direction) page.
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Roughness and Obstructions (Worst case) page

If you select the Worst Case Data Source, then the next page of the Wizard
allows you to enter the data for ground roughness and obstructions yourself.

Property Description
Terrain
Category

Reference should be made to the National Annex being worked
to when determining an appropriate Terrain Category.

Depending on the terrain category selected and National Annex
being worked to, you may also be required to enter some of the
following data:

• Average height of upwind buildings,

• Upwind spacing of surrounding buildings,

• Upwind distance from sea to site,

• Upwind distance from edge of town to site.
Next Depending on your selections on the Data Source page, clicking

Next either takes you to the Orography (Worst Case) page, the
Tall Neighbouring Structure page, or the Results page.

Roughness and Obstructions (Data for each Direction) page

If you select the Other - Data for each Direction Data Source, then the next
page of the Wizard allows you to enter the data for ground roughness and
obstructions yourself. However, most of the data is then dependent on the
wind direction, so you must also make your choice of wind directions on this
page.

Property Description
Direction Initially there are 4 orthogonal wind directions relative to the

Tekla Structural Designer axes, (not geographical North), but
you are able to update these using the Dir. buttons and / or
changing the direction value as required. (Note: Minimum 1°
difference between directions). At least one direction must be
defined.

Each row of the grid operates in a similar manner to the
relevant fields of the Roughness and Obstructions (Worst
case) page.

Next Depending on your selections on the Data Source page, clicking
Next either takes you to Orography (Data for each Direction)
page, the Tall Neighbouring Structure page, or the Results
page.
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Orography (Worst Case) page

If Consider Orography was checked, then the next page of the Wizard for the
Worst Case Data Source allows you to enter the data for Orography.

Property Description
Orographic
Feature
(Clause A.3)

Options are:

• None - no feature, i.e. co = 1.0.

• 2D Escarp - Cliffs and Escarpments,

• 3D Hill - Hills and Ridges.
Altitude of
Upwind
Base of
Feature, A

This value is used to calculate Calt instead of the Site Altitude
because the Orography is significant.

NOTE Calt will be calculated at ze for each wall and roof panel,
not zs.

Effective
Crest
Height, H
(Figures A.2
& A.3)

Effective height of the feature.

Length of
Upwind
Slope, Lu
(Figures A.2
& A.3)

Actual length of the upwind slope in the wind direction.

Length of
Downwind
Slope, Ld
(Figures A.2
& A.3)

Actual length of the downwind slope in the wind direction.

Horizontal
Distance to
Crest, x
(Figures A.2
& A.3)

Distance upwind or downwind from the crest to the building
site.

Orography
factor, co(z)
and
Turbulence
factor, kl
(Norway NA
only)

When working to the Norway NA you are not required to enter
the above factors; instead you enter the orography factor and
turbulence factor directly for the defined 3D or 2D orographic
feature.

Next If on the Data Source page you chose to consider tall
neighbouring structures, clicking Next takes you to the Tall
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Property Description
Neighbouring Structure page , otherwise it takes you to the
Results page.

Orography (Data for each Direction) page

The wind directions defined on the previous page are maintained and you are
not able to update them.

Property Description
 Each row of the grid operates in a similar manner to the

relevant fields of the Orography (BREVe) page (page 1075) page.
Next If on the Data Source page you chose to consider tall

neighbouring structures, clicking Next takes you to the Tall
Neighbouring Structure page , otherwise it takes you to the
Results page.

Tall Neighbouring Structure page

For all methods, if Consider Tall Neighbouring Structure was checked, the
penultimate page allows you to determine if tall neighbouring structures affect
the design of this structure. (Clause A.4)

Otherwise, the wizard will proceed directly to the Results page and the actual
heights of wall and roof panels are used throughout.

The parameters, Height of Tall Neighbour, hhigh, Largest Horizontal Dimension
of Tall Neighbour, dlarge and Distance to Tall Neighbour, x are all as described
on Figure A.4 of the code.

Property Description
Average
Height of
Neighbours
, have
(Figure A.4)

The default is calculated from the BREVe data or the values
entered for the Roughness & Obstructions. If Override
calculated dimension is cleared, then the value will be updated
whenever the wizard is run, otherwise the user-value is used.

Height of
this
structure,
hlow (Figure
A.4)

The field is for information only - difference between top of
highest wall / roof panel and ground level in the model.

Next Click Next to go to the Results page.
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Results page

The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

Initially there are 4 orthogonal wind directions relative to the Tekla Structural
Designer axes, (not geographical North), but except for the Other - Data for
Each Direction method, you are able to update this using the Dir. buttons
and / or changing the direction value as required. (Note : Minimum 1°
difference between directions). At least one direction must be defined.

You are able to use the <<Details>> button to obtain additional information,
including the values of intermediate factors used in the calculations.

Property Description
Other -
Worst Case
Data

The calculation of qp is very similar to the BREVe Method, (see
above), except that the worst case data has been entered by
you, and this page allows you to enter your own values for Cdir.

As there is no data for each 30° sector, the Vortex view only
shows the Peak Velocity Pressures calculated for each reference
height for each direction.

Other -
Data for
each
Direction

The calculation of qp is very similar to the BREVe Method, (see
above), except that the data has been entered by you for each
direction only so a direct calculation can be performed instead
of taking the worst case over a range of sectors. Also this page
allows you to enter your own values for Cdir.

As there is no data for each 30° sector, the Vortex view only
shows the Peak Velocity Pressures calculated for each reference
height for each direction.

Finishing
the Wind
Wizard

When you click Finish, the Wind Wizard generates the wind
zones for the entire building for each of the specified wind
directions.

NOTE Before moving on you should take a moment to inspect
the Wind Model status on the Project Workspace>
Status tab, in order to check that no Limitations
(page 1061) have been encountered.

Using the EC1991 1-4 Wind Wizard with BREVe data
This page steps you through the EC1991-1-4 Wind wizard when using BREVe
data

NOTE This option is only available when either the UK or Ireland National
Annex has been selected.
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Data Source (BREVe) page

Assuming you choose to specify the site data using BREVe Grid Ref data the
remaining choices on the Data Source page are:

Property/
Buttons

Description

Property  
Consider
Orography

If you select this check box, then the orographic data,
(either recovered by BREVe for the site or manually
entered), is used to determine the Orography Factor co as
clause A.3. When calculating calt, the altitude of the upwind
base of the orographic feature is used for each wind
direction considered. Otherwise the orographic data is
ignored, co is 1.0 for all heights and calt is the same for all
directions, using the Site Altitude.

Consider Tall
Neighbouring
Structures

If the conditions in clause A.4 are met, then the wind loads
need to be based on height zn, see equation (A.14). With
this box checked, you are able to enter sufficient data to
check if this applies. If applicable, then zn will be used as
the reference height for all wall panels and roof panels in
the model.

Consider
Obstructions

With this box checked, the obstruction data, (either
defaulted by BREVe depending on the roughness category
for the site or entered manually), is used to determine the
Displacement Height, hdis as (A15) in clause A.5. Otherwise
the obstructions are ignored and hdis is taken as zero.

Buttons  
Next If you have chosen to use BREVe Grid Ref data, clicking

Next takes you to the BREVe location page , otherwise it
takes you to the Basic Data page.

BREVe location page

Property/
Buttons

Description

Property  
Grid Ref. This shows the grid reference of the site which you have

picked through BREVe, irrespective of the method you use
to define the site location.

Orientation of
building known

If you know the orientation of the building with respect to
North, then you can define this information by checking
this box. You can then define a value which relates the
building direction axes of your Tekla Structural Designer
model to geographic north.
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Property/
Buttons

Description

Orientation of
North

The orientation of North is defined using the same
convention as is applied to the orientation of the Building
Direction Arrows.

This can best be understood by reference to a couple of
examples:

In the first example the building axes are aligned in the
default directions (Dir 1 = 0° = Global X), and the
orientation of North has been set to 315°.

The resulting relation between the building axes and North
is as shown below:

In the second example the building direction has been
input with Dir 1 = 30° and the orientation of North has
been set to 250°

In this case the building axes are related to North as
shown below:
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Property/
Buttons

Description

Buttons  
 Using BREVe, there are 2 methods available for you to

define the site location:
Site By Ref... You can define the grid reference of the site.

You define this either as a national grid reference, or by
specifying the Easting and Northing information for the
site. There are several Internet based tools available which
allow you to determine the Ordnance Survey grid
reference from a postcode or given location, for example
www.streetmap.co.uk or www.multimap.co.uk

Site By Map... You can pick the site from a Land / Town Map,

• You can pick the site from a Orography Map.

• You can pick the site from a ground roughness Category
Map,

The site data is analysed fully by BREVe. Parameters are
either set automatically but conservatively (Safe
parameters within a 1 km square).

Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
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Property/
Buttons

Description

Next Click Next to move to the Basic Data (BREVe) page.

Basic Data (BREVe) page
This page allows you to review the site details taken from the BREVe database.

Property/
Buttons

Description

Property  
Site Altitude, A The basic site altitude of your model's base.
Air Density Air density at the site.
Ground Level If for some reason, the level 0.0m in the Tekla Structural

Designer model does not correspond to the ground level,
for example a site datum may have been used rather than
a building datum, then this field allows you to set the
appropriate value so that the reference heights can be
calculated correctly.

Fundamental
Basic Wind
Velocity (vb,map) -
Clause 4.2 and
NA.2.4

The value required is defined as "the characteristic 10
minutes mean wind velocity, irrespective of wind direction
and time of year, at 10m above ground level in open
country terrain with low vegetation such as grass and
isolated obstacles with separations of at least 20 obstacle
heights", but is the value before the altitude correction is
applied. (Valid range 1.0 to 1000 m/s).

Season Factor,
cseason

Valid range 0.01 to 10.0 - default 1.0.

Probability
Factor, cprob

Valid range 0.01 to 10.0 - default 1.0.

Default Height
for Internal
Pressure (zi)

Clause 7.2.9 (7) implies that all internal pressures should
be calculated using a single reference height, (zi),
defaulting to the height of the structure. Leaving Use
Building Height checked ensures that the value is
automatically updated if the geometry of wall panels or
roof panels changes.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Roughness and Obstructions

(BREVe) page.
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Roughness and Obstructions (BREVe) page
This page of the Wizard automatically defaults the data for ground roughness
and obstructions for you.

Property/
Buttons

Description

Property  
Terrain Category Options available are:

• Sea - this setting is for sites where the distance to sea is
between 0 and 1 km, not for offshore sites. As the
worst case must be for wind blowing across the sea,
there is no need to specify data for upwind buildings or
distance in town.

• Country - the worst case must be for wind blowing
across open ground, there is no need to specify data
for upwind buildings or distance in town,

• Town - for this category you need to specify data for
upwind buildings and distance to the edge of the town,
so the relevant fields are active. If you want to ignore
obstructions, then you need to enter a zero value for
have For this category, the Upwind distance from edge
of town to site cannot be greater than the Upwind
distance from sea to site.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Orography (BREVe) page.

Orography (BREVe) page

NOTE When using Breve Data you should really leave it up to the system as
to whether orography is significant or not. If you chose not to consider
orography, the actual factor is not applied; however the site data is
still displayed to allow you to check that your decision to ignore it is
reasonable.

Property/
Buttons

Description

Property  
Orographic
Feature (Clause
A.3)

Options available are:

• None - no feature, i.e. co = 1.0.

• 2D Escarp - Cliffs and Escarpments,
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Property/
Buttons

Description

• 3D Hill - Hills and Ridges.
Altitude of
Upwind Base of
Feature, A

This value is used to calculate Calt instead of the Site
Altitude because the Orography is significant.

NOTE Calt will be calculated at ze for each wall and roof
panel, not zs.

Effective Crest
Height, H
(Figures A.2 &
A.3)

Effective height of the feature.

Length of
Upwind Slope, Lu
(Figures A.2 &
A.3)

Actual length of the upwind slope in the wind direction.

Length of
Downwind
Slope, Ld (Figures
A.2 & A.3)

Actual length of the downwind slope in the wind direction.

Horizontal
Distance to
Crest, x (Figures
A.2 & A.3)

Distance upwind or downwind from the crest to the
building site.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next If on the Data Source page you chose to consider tall

neighbouring structures, clicking Next takes you to the
Tall Neighbouring Structure, otherwise it takes you to
the Results (BREVe) page.

Tall Neighbouring Structure page

For all methods, if Consider Tall Neighbouring Structure was checked, the
penultimate page allows you to determine if tall neighbouring structures affect
the design of this structure. (Clause A.4)

Otherwise, the wizard will proceed directly to the Results page and the actual
heights of wall and roof panels are used throughout.

The parameters, Height of Tall Neighbour, hhigh, Largest Horizontal Dimension
of Tall Neighbour, dlarge and Distance to Tall Neighbour, x are all as described
on Figure A.4 of the code.
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Property/
Buttons

Description

Property  
Average Height
of Neighbours,
have (Figure A.4)

The default is calculated from the BREVe data or the values
entered for the Roughness & Obstructions. If Override
calculated dimension is cleared, then the value will be
updated whenever the wizard is run, otherwise the user-
value is used.

Height of this
structure, hlow
(Figure A.4)

The field is for information only - difference between top
of highest wall / roof panel and ground level in the model.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to got to the Results (BREVe) page.

Results (BREVe) page
The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

Initially there are 4 orthogonal wind directions relative to the Tekla Structural
Designer axes, (not geographical North), but you are able to update this using
the Dir. buttons and / or changing the direction value as required. (Note:
Minimum 1° difference between directions). At least one direction must be
defined.

You are able to use the <<Details...>> button to obtain additional information,
including the values of intermediate factors used in the calculations.

BREVe Data

BREVe determines the parameters required to calculate qp(z) for each height
in the building at 30° intervals, (0° to 330°).

For each required wind direction the worst case qp is used for each height,
based on splitting the difference to the next direction, with a maximum of ±45
degrees. Within these ranges qp is not interpolated.

Theoretically, it is possible for a quadrant to use different 30° directions for
each height, so the critical wind direction is not displayed in the summary.

The Vortex view shows the Peak Velocity Pressures calculated for each
reference height for each 30° sector.

Finishing the Wind Wizard
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When you click Finish, the Wind Wizard generates the wind zones for the
entire building for each of the specified wind directions.

Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 1061) have been encountered.

EC1991 1-4 Wind Zones
Enter a short description of your topic here (optional).

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Basic Geometry

The basic building geometry is assessed as follows:

• Reference Height (ze) - is taken as the difference between highest point on
wall or roof panel and ground level.

• Wall height (h) - is taken as the difference between highest and lowest
points on the wall panel.

These definitions apply to wall panels without parapets and the actual
parapets. Wall panels with parapets above them will take their highest
point from the parapet. See the diagram below.
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• Roof height (h) - as ze - taken as the difference between highest point on
wall or roof panel and ground level. This definition does not handle the
upper roof of inset storey but is conservative.

• The Building Breadth, b is calculated from the smallest enclosing rectangle
around the whole building (considered over all roof and wall panels only)
for the given direction. You can override the calculated value in case the
Tekla Structural Designer model does not include the whole building.
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Wall Zones

Wall Type

We assess each wall panel to determine if it is a windward, leeward or side
wall. We classify the type of wall dependent on q:

• θ ≤ 60 deg - Windward,

• θ ≥ 120 deg - Leeward,

• Other walls are classed as Side.

Windward walls Windward walls have a single zone and Table 7.1 is used
with interpolation for h/d.

Leeward walls Leeward walls have a single zone and Table 7.1 is used
with interpolation for h/d.

Side walls In all cases, side walls have the relevant number of zones
from Figure 7.5 and Table 7.1 is used.

There is no guidance in the standard for Irregular
Flushed Faces, Recesses and Downwind Re-entrant
Corners that are covered in BS6399. However, it is
reasonable to automatically detect Irregular Flushed
Faces and process them as described in BS6399 Clause
2.4.4.1 and Figure 14. The program also detects potential
Recesses but only generates a warning and no special
handling occurs. Downwind re-entrant corners are
conservatively ignored.

Engineers Handbooks 1080 Wind modeling handbook



Parapets Parapets are assessed for return corners and then
classified as windward, windward oblique, leeward or
leeward oblique dependent on q.

Depending on the classification, parapets will either have
a single zone, or up to seven zones (determined by
extrapolation from Figure 7.19). Table 7.9 is used with
interpolation for Solidity and l/h.

NOTE An "r" suffix on zone name indicates return
corners have been detected.

Side Parapets are Special Zero zones, i.e. no nett
pressure.

Roof Zones

Roof zones are automatically generated where possible for each wind
direction. In essence each roof panel is assessed in its own right based on its
properties. The interconnectivity of touching roof panels is not generally
considered.

NOTE The Advisory note on page 34 of the UK NA is followed so that zones
and coefficients are generated according to BS6399.

Direction

Internally the roof slope vector (line of maximum slope) is determined from
the normal vector, with its direction always giving a positive slope angle, i.e.
the roof slope vector must always point up the slope.

We calculate the angle between the wind direction and projection of roof slope
vector onto horizontal plane ( q in range -180° to +180°).

Scaling Dimension, e

The scaling dimension e = min(b, 2h)

Automatic Zoning

Automatic zoning normally only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, that is that all of the internal
angles < 180°. However, additionally, it only applies to Hip Gable roofs if they
are triangular, and Hip Main roofs if they are quadrilateral. Further, Downwind
Slope Hip Gables must not have 2 upwind corners.
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Dimensions All zone dimensions are specified in plan.
Flat Roofs See BS 6399 Clause 2.5.1, Figure 16 and Table 8.
Monopitch Roofs See BS 6399 Clause 2.5.2.3, Figure 19 and Table 9.
Duopitch Roofs See BS 6399 Clause 2.5.2.4, Figure 20 and Table 10.
Hip Gable See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Hip Main See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Mansard Roofs If you manually set the connected roof types to

Mansard, then the program will correctly identify the
special cases in BS6399 Figures 17c, 22a and 22b, and
use the correct tables and values. See BS 6399
Clauses 2.5.1.6.2 & 2.5.4

Multi-bay Roofs We allow you to interpret BS 6399 Clause 2.5.5 and
Figure 23 as you think appropriate and manually
define the roof types and sub-types accordingly. You
also have the ability to manually set the multi-bay
position for each roof panel for each wind direction:

• Not Multi-Bay - for this wind direction
(conservative default),

• Upwind Bay - first bay of many for this wind
direction,

• Second Bay - for this wind direction,

• Third or more Bay - for this wind direction.

Where the reduction applies, the values of all
coefficients are reduced according to Table 12.

Non-Automatic Zoning

Where automatic zoning does not apply, the system creates a single zone
covering the entire roof as follows:
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• Hip Gable - B for upwind, B for downwind, D for side,

• Flat - B,

• Monopitch - B,

• Duopitch - B for upwind, A for downwind, B for side,

• Hip Gable - B for upwind, B for downwind, D for side,

• Hip Main - B for upwind, A for downwind, D for side.

BS6399-2 Wind wizard
This topic will discuss in detail the Wind wizard when using the British
Standard BS 6399-2.

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to BS 6399-2.

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the effective wind speeds and
dynamic pressures for the required wind directions and heights around the
building, (that is the Reference Height (Hr) for each wall panel or roof panel).

The wind speed calculations are automated, the data source for the
calculations is either:

• taken directly from the BREVe database, which is based upon the Ordnance
Survey data of Great Britain,

• input directly.

It should be noted that BS6399-2:1997 recommends that the Standard Method
requires assessment of orthogonal load cases for wind directions normal to
the faces of the building. The wizard permits you to create wind load for any
wind direction and thus it is up to you to create those loads for the directions
most appropriate to your structure.

Topics in this section

Design Codes and References (page 1083)

Scope (BS6399-2 Wind wizard) (page 1084)

Limitations (BS6399-2 Wind wizard) (page 1085)

Using the BS6399-2 Wind Wizard with BREVe data (page 1087)

Using the BS6399-2 Wind Wizard with other data (page 1091)

Results page (BS6399-2 Wind Wizard) (page 1094)

BS6399-2 Wind Zones (page 1096)

Engineers Handbooks 1083 Wind modeling handbook



Design Codes and References

Unless explicitly stated all calculations in the BS 6399-2 Wind Modeller are in
accordance with the relevant sections BS 6399-2:1997 incorporating
Amendment 1 and corrigendum No. 1. (Ref. 4) (page 1118) It is essential that
you have a copy of this code with you while assessing wind on any structure.

Your attention is particularly drawn to BS6399-2:1997 - Clause 1.1. For
building shapes which are not covered by the Standard you will need to
seek specialist advice.

We would recommend having the following books to hand when using the
software:

• Wind Loading - a practical guide to BS 6399-2 Wind Loads on buildings.
(Ref. 7) (page 1118)

• Wind and Loads on buildings: Guide to Evaluating Design Wind Loads to
BS6399-2:1997. (Ref. 8) (page 1118)

Unless explicitly noted otherwise, all clauses, figures and tables referred to in
this handbook are from reference 4 (page 1118).

Scope (BS6399-2 Wind wizard)

In the main, BS6399-2:1997 addresses rectilinear buildings. In order to develop
a tool for engineers, we have extended this capability to address non-
rectilinear buildings using the standard method. For more information, please
refer to reference 7 (page 1118) (section 2.5.3.2.4, page 82 and 2.5.4.3.3 pages
89-90).

The scope of BS 6399-2 Wind Modeller encompasses:

• Enveloping the building with wall panels and roof panels is undertaken in
Tekla Structural Designer in the normal manner. There is only limited
validation of the envelope defined (for example connected wall panels
must have consistent normal directions). The onus is on you to model the
building shape as completely and as accurately as you determine
necessary.

• Choice of method:

• BS6399-2:1997 - Standard Method - Standard effective wind speeds
with standard pressure coefficients,

• BS6399-2:1997 - Hybrid Method - Directional effective wind speeds with
standard pressure coefficients.

• Basic Wind Speed and Dynamic pressure is determined.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or monopitch roof depending on the slope), you are able to specify the
type in more detail e.g. multi-bay, monopitch / duopitch etc.).

• The main wind parameters, are calculated for you but conservatively, (for
example Crosswind Breadth, B, is determined for the enclosing rectangle of
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the whole building). Wherever possible other parameters are determined
conservatively, but you are able to override the values should you need to.

• Given the above, zoning is semi-automatic, (not attempted for roofs with
more than 4 sides which are defaulted to single conservative coefficient),
with full graphical feedback.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

Limitations (BS6399-2 Wind wizard)
This page discusses the limitations to the wind wizard.

Throughout the development of the Wind Modeler extensive reference has
been made to the References (page 1118) and we consider it advisable that
you are fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:

Geometry

DANGER You should seek specialist advice for building shapes that are not
covered by the Standard - see Clause 1.1 of BS6399-2:1997.

• Open sided buildings are beyond scope.

• Free standing walls and sign boards are not considered.

• Parapets and free-standing canopies are not considered.

• Exposed members are not considered, for example lattices, trusses......

• Barrel-vault roofs and domes are not considered.

• Dominant Openings are not explicitly handled - Clause 2.6.2. However, you
can use Table 17 to calculate the necessary Cpi values and manually apply
to a loadcase or individual zone loads.

Loaded areas

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.

Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.
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• Orthogonal wind directions at the definition of the user.

Beneficial loads

• No automatic reduction is made for beneficial load. When you edit the
Zone Load Data for a wind direction, having generated wind load cases,
there is an option to allow for beneficial loads.

Wind loading on wall panels

Automatic zoning applies to all wall panels subject to the limitations described
below:

• Wall panels that are more than 15° from the vertical are outside the scope -
Clause 2.4.1.5.

• The inset storey clause 2.4.4.2 b) is not implemented. You can edit the
zones manually according to your engineering judgement to include zone E
if you consider this necessary.

• Wall panels of internal wells are not automatically identified - Clause
2.4.3.2a. You can manually edit the zones to apply the roof coefficient to
the wall panels.

Wind loading on roof panels

• Automatic zoning only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, i.e. all of the internal angles
< 180°

• The inset storey clauses 2.5.1.7 a) and b) are not implemented. In clause a)
the software sets Hr and H equal conservatively. You are obviously able to
edit the zones manually according to your engineering judgement to
include the further zones indicated in Figure 18 should you consider this
necessary.

• It should be noted that in Table 8 for curved and mansard eaves, the zones
start from edge of horizontal roof and not from the edge of the feature.

• Special care should be taken for winds blowing on duopitch with slopes
that differ by more than 5°. If the wind is blowing on the steeper slope (that
is that the less steep slope is downwind of ridge), the downwind slope
should be set to be a flat roof with mansard at eaves for this wind
direction.

• Mansard and Multipitch Roofs are not detected automatically, However,
you can manually apply the relevant roof type, apex type and bay position
parameters for each appropriate wind direction to match the requirements
of Figure 22 and Figure 23 - see BS6399-2 Wind Zones.

• Roof Overhangs are not explicitly handled. It is suggested that you should
define two separate roof panels - one forming the overhang and the other
covering the inside of the building. You can then define Cpi values manually
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to either have the same coefficient as the adjacent wall, (Clause 2.5.8.2
Small Overhangs), or as an open sided building (Clause 2.6.3).

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind load cases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Using the BS6399-2 Wind Wizard with BREVe data
Using the BS6399-2 Wind Wizard with BREVe data

Method page

This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/
Buttons

Description

Property  
 There are two calculation methods available:
Standard Uses standard effective wind speeds with standard

pressure coefficients,
Hybrid Uses directional effective wind speeds with standard

pressure coefficients.
  
 Assuming you have are going to specify the site data using

BREVe Grid Ref data there are two options for the source
of the wind data:

• BREVe - UK National Grid Ref.

• BREVe - Irish Grid Ref
Buttons  
Next If BREVe is the data source, clicking Next takes you to the

BREVe location page; if Other is the data source clicking
Next takes you to the Other Location page.

BREVe location page

This page allows you to define the location of the site using the BREVe
database, and to define various options to be considered in the wind analysis.
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Once you have retrieved the data for a site from the BREVe database you can
edit these to take account of your local knowledge of the site.

Property/
Buttons

Description

Property  
Grid Ref. This shows the grid reference of the site which you have

picked through BREVe, irrespective of the method you use
to define the site location.

Site Altitude, A You are able to override the altitude determined by BREVe
by entering a value directly here.

Air Density You need to enter air density at the site.
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level,
for example you have used a site datum rather than a
building datum, then this field allows you to set the
appropriate value so that the reference heights for the
wind can be calculated correctly.

Orientation of
building known

If you know the orientation of the building with respect to
North, then you can define this information by checking
this box. You can then define a value which relates the
building direction axes of your Tekla Structural Designer
model to geographic north.

If you want to use the Hybrid method, then you must know
and define the building orientation.

For the Standard method, the orientation is not essential.
If you don't define the building's orientation then North is
not shown in graphics views and all the Sd values are set to
1.0.

Orientation of
North

The orientation of North is defined using the same
convention as is applied to the orientation of the Building
Direction Arrows.

This can best be understood by reference to a couple of
examples:

In the first example the building axes are aligned in the
default directions (Dir 1 = 0° = Global X), and the
orientation of North has been set to 315°.

The resulting relation between the building axes and North
is as shown below:
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Property/
Buttons

Description

In the second example the building direction has been
input with Dir 1 = 30° and the orientation of North has
been set to 250°

In this case the building axes are related to North as
shown below:
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Property/
Buttons

Description

Consider
Topography

If you select this check box, then BREVe uses the
topographic data it recovers for the site and determines
the Altitude Factor Sa in accordance with Clause 2.2.2.2.3.
Otherwise the topographic data is ignored and Sa is
calculated in accordance with Clause 2.2.2.2.2.

NOTE In theory the topography could be significant for
some directions and not for others.

Consider
Obstructions

With this box checked, BREVe uses the obstruction data it
recovers for the site and determines the Effective Height
He as defined in Clause 1.7.3.3. Otherwise the obstructions
are ignored and He is taken as Hr - see Clause 1.7.3.2.

Buttons  
 Using BREVe, there are 2 methods available for you to

define the site location:
Site By Ref... You can define the grid reference of the site.

You define this either as a national grid reference, or by
specifying the Easting and Northing information for the
site. There are several Internet based tools available which
allow you to determine the Ordnance Survey grid
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Property/
Buttons

Description

reference from a postcode or given location, for example
www.streetmap.co.uk or www.multimap.co.uk

Site By Map... You can pick the site from a Land / Town Map,

• You can pick the site from a Orography Map.

• You can pick the site from a ground roughness Category
Map,

The site data is analysed fully by BREVe. Parameters are
either set automatically but conservatively (Safe
parameters within a 1 km square).

Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 1094).

Using the BS6399-2 Wind Wizard with other data
This section runs through the wizard when "other data" is specified.

Method page

This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/
Buttons

Description

Property  
 There are two calculation methods available:
Standard Uses standard effective wind speeds with standard

pressure coefficients,
Hybrid Uses directional effective wind speeds with standard

pressure coefficients.
  
 The remaining topics in this section assume you have

chosen to enter the site data manually (Other).
Buttons  
Next Assuming Other is the data source, clicking Next takes you

to the Other Location page.
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Other location page

This page allows you to define the site details when information is not
available from the BREVe database, for instance if it is located outside of the
UK.

Property/
Buttons

Description

Property  
Site Altitude You are able to override the altitude determined by BREVe

by entering a value directly here.
Air Density You need to enter air density at the site.
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level,
for example you have used a site datum rather than a
building datum, then this field allows you to set the
appropriate value so that the reference heights for the
wind can be calculated correctly.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Other Standard Wind data

page, or if the Hybrid method was selected to the Other
Hybrid Wind data page.

Other Standard Wind data page

If you select the Standard Method and Other Data Source, then the next page
of the Wizard allows you to enter the wind data yourself.

Property/
Buttons

Description

Property  
Basic Wind
Speed

You need to enter the basic wind speed at the site.

Ground
Roughness

The following settings are available:

• Sea - this setting is for sites where the distance to sea is
between 0 and 1 km, (see Clause 1.7.2), it is not for
offshore sites.,

• Country - the worst case must be for wind blowing
across open ground, there is no need to specify data
for upwind buildings or distance in town,

• Town - for this category you need to specify data for
upwind buildings and distance to the edge of the town,
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Property/
Buttons

Description

so the relevant fields are active. If you want to ignore
obstructions, then you need to enter a zero value for Ho
For this category, the 'Upwind distance from edge of
town to site' cannot be greater than the 'Upwind
distance from sea to site'.

Consider
Topography /
Altitude Factor,
Sa

When this box is checked, you need to use your own
topographic data and determine the Altitude Factor Sa in
accordance with Clause 2.2.2.2.3. Otherwise Sa is
calculated in accordance with Clause 2.2.2.2.2 and you are
not able to override it.

Season factor You need to enter the season factor (default 1.0).
Probability
factor

You need to enter the probability factor (default 1.0).

Buttons  
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 1094).

Other Hydrid Wind data page

If you select the Hybrid Method and Other Data Source then the next page of
the Wizard allows you to enter the data for ground roughness and
obstructions yourself. However, most of the data is then dependent on the
wind direction, so you must also make your choice of wind directions on this
page.

Property/
Buttons

Description

Property  
Direction Initially there are 4 orthogonal wind directions relative to

the Tekla Structural Designer axes, (not geographical
North), but you are able to update these using the Dir.
buttons and / or changing the direction value as required.
(Note: Minimum 1° difference between directions). At least
one direction must be defined.

Each row of the grid operates in a similar manner to the
relevant fields of the Other Standard Wind data page

Consider
Topography /
Altitude Factor,
Sa

Reference 8 (section 4.10, page 26) essentially
recommends using the Standard Method approach to
topography even for the Hybrid Method. So, when
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Property/
Buttons

Description

calculating the Terrain and Building Factor, Sb, we ignore
the effects of topography, that is we take Sh = 0.

When the box is checked, you need to use your own
topographic data and determine the Altitude Factors Sa as
defined in Clause 2.2.2.2.3. Otherwise Sa is calculated as
defined in Clause 2.2.2.2.2 and you are not able to override
it.

NOTE In theory the topography could be significant for
some directions and not for others.

Season factor You need to enter the season factor (default 1.0).
Probability
factor

You need to enter the probability factor (default 1.0).

Buttons  
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 1094).

Results page (BS6399-2 Wind Wizard)
The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

This is the start of your topic.

BREVe Standard Method

Initially this method creates 4 orthogonal wind directions relative to the Tekla
Structural Designer axes, (not geographical North). Except for the Hybrid
Method with Other Data, you can update the wind directions either by using
the 'Dir.' buttons or by changing the direction value as required.

Separately, for each relevant parameter of the Standard Method, BREVe
determines the worst case over all its 30° sectors. If the orientation of the
building is not known, then Sd is taken as 1.0 for all directions. Otherwise we
determine the worst case Sd for each direction. You cannot override the
system value in either case.

The worst case Sd is based on splitting the difference to the next direction,
with a minimum of ±15° and maximum of ±45°. Within these ranges Sd is
interpolated.

For each reference height in the model, we then calculate the site wind speed
(Vs using equation 8) and thus the effective wind speed (Ve using equation 12)
and the dynamic pressure (qs using equation 1) for each direction. When
calculating actual loads on walls and roofs, we use the qs value for the relevant
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reference height, but the Results page only shows the maximum values for
each direction.

The Vortex view shows the effective wind speed calculated for each reference
height for each 30° sector. Since a single worst case value is used for each
parameter, the speeds for different sectors only differ due to Sd provided that
the orientation of the building is known.

BREVe Hybrid Method

In this case, BREVe uses the directional method to determine the parameters
required to calculate Vs using equation 8, for each height in the building at 30°
intervals, (0° to 330°) taking the diagonal dimension `a' as the default 5.0m.
(The size effect factor is applied when determining individual loads). We then
use equation 27 to determine Ve and equation 16 for qs.

For each required wind direction the worst case Ve is used for each height,
based on splitting the difference to the next direction, with a maximum of ±45
degrees. Within these ranges Ve is not interpolated.

Theoretically, it is possible for a quadrant to use different 30° directions for
each height, so the critical wind direction is not displayed in the summary.

The Vortex view shows the effective wind speed calculated for each reference
height for each 30° sector.

Other Standard Method

The calculation of Ve and qs are very similar to the BREVe Standard Method,
(see above), except that the worst case data has been entered by you, and this
page allows you to enter your own values for Sd.

As there is no data for each 30° sector, the Vortex view only shows the
effective wind speed calculated for each reference height for each direction.

Other Hybrid Method

The calculation of Ve and qs are be very similar to the BREVe Hybrid Method,
(see above), except that the data has been entered by you for each direction
only so a direct calculation can be performed instead of taking the worst case
over a range of sectors. Also this page allows you to enter your own values for
Sd.

As there is no data for each 30° sector, the Vortex view only shows the
effective wind speed calculated for each reference height for each direction.

Finishing the Wind Wizard

When you click Finish, the Wind Wizard generates the wind zones for the
entire building for each of the specified wind directions.
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Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 1085) have been encountered.

BS6399-2 Wind Zones

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Basic Geometry

The basic building geometry is assessed as follows:

• Reference Height (Hr) - is taken as the difference between highest point on
wall or roof panel and ground level.

• Wall height (H) - is taken as the difference between highest and lowest
points on the wall panel.

These definitions apply to wall panels without parapets and the actual
parapets. Wall panels with parapets above them will take their highest
point from the parapet. See the diagram below.
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• Roof height (H) - is taken as the difference between highest point on wall or
roof panel and ground level. This definition does not handle the upper roof
of inset storey but is conservative and only affects the scaling dimension, b
- see Clause 2.5.1.7.

• The Building Breadth, B is calculated from the smallest enclosing rectangle
around the whole building (considered over all roof and wall panels only)
for the given direction. You can override the calculated value in case the
Tekla Structural Designer model does not include the whole building.
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Wall Zones

Wall Type

We assess each wall panel to determine if it is a windward, leeward or side
wall. We classify the type of wall dependent on q:

• θ ≤ 60 deg - Windward,

• θ ≥ 120 deg - Leeward,

• Other walls are classed as Side.

Windward walls Windward walls have a single zone and Table 5 is used
with interpolation for D/H.

Leeward walls Leeward walls have a single zone and Table 5 is used.
Side walls Side walls are assessed for recesses (narrow or wide),

irregular flushed faces, downwind re-entrant corners. In
all cases, side walls have the relevant number of zones.
Table 5 is used.

Roof Zones

Roof zones are automatically generated where possible for each wind
direction. In essence each roof panel is assessed in its own right based on its
properties. The interconnectivity of touching roof panels is not generally
considered.

Direction

Internally the roof slope vector (line of maximum slope) is determined from
the normal vector, with its direction always giving a positive slope angle, i.e.
the roof slope vector must always point up the slope.

We calculate the angle between the wind direction and projection of roof slope
vector onto horizontal plane ( q in range -180° to +180°).

Automatic Zoning

Automatic zoning normally only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, that is that all of the internal
angles < 180°. However, additionally, it only applies to Hip Gable roofs if they
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are triangular, and Hip Main roofs if they are quadrilateral. Further, Downwind
Slope Hip Gables must not have 2 upwind corners.

Dimensions All zone dimensions are specified in plan.
Flat Roofs See BS 6399 Clause 2.5.1, Figure 16 and Table 8.
Monopitch Roofs See BS 6399 Clause 2.5.2.3, Figure 19 and Table 9.
Duopitch Roofs See BS 6399 Clause 2.5.2.4, Figure 20 and Table 10.
Hip Gable See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Hip Main See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Mansard Roofs If you manually set the connected roof types to

Mansard, then the program will correctly identify the
special cases in BS6399 Figures 17c, 22a and 22b, and
use the correct tables and values. See BS 6399
Clauses 2.5.1.6.2 & 2.5.4

Multi-bay Roofs We allow you to interpret BS 6399 Clause 2.5.5 and
Figure 23 as you think appropriate and manually
define the roof types and sub-types accordingly. You
also have the ability to manually set the multi-bay
position for each roof panel for each wind direction:

• Not Multi-Bay - for this wind direction
(conservative default),

• Upwind Bay - first bay of many for this wind
direction,

• Second Bay - for this wind direction,

• Third or more Bay - for this wind direction.

Where the reduction applies, the values of all
coefficients are reduced according to Table 12.

Non-Automatic Zoning
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Where automatic zoning does not apply, the system creates a single zone
covering the entire roof as follows:

• Flat - B,

• Monopitch - B,

• Duopitch - B for upwind, A for downwind, B for side,

• Hip Gable - B for upwind, B for downwind, D for side,

• Hip Main - B for upwind, A for downwind, D for side.

IS 875 (Part 3) Wind Wizard
This topic discusses the wind wizard when using the IS 875 (Part 3) code.

To access this configuration of the Wind Wizard... the Wind Loading Code has
to be set to IS 875 (Part 3).

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the effective wind speeds and
dynamic pressures for the required wind directions and heights around the
building.

The wizard permits you to create wind load for any wind direction, it is up to
you to create those loads for the directions most appropriate to your
structure.

Unless explicitly stated all calculations in the IS 875 (Part 3) Wind Modeller are
in accordance with the relevant sections of IS:875 (Part 3) - 1987 Second
Revision, Reaffirmed 2003 and including Amendments 1, 2 and 3.

Wind Options page
This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/Buttons Description
Property  
Data Source The wind velocity calculations are automated, the data

source for the calculations is either:

• Input directly for the worst case,

• Input directly for each direction.
Consider
Topography

When this box is checked, you will be asked to enter
your own topographic data later in the Wizard.

Buttons  
Next Click Next to go to the Basic Data page.
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Basic Data page

Property/Buttons Description
Property  
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground
level, for example you have used a site datum rather
than a building datum, then this field allows you to set
the appropriate value so that the reference heights for
the wind can be calculated correctly. This field also gives
the lowest level to which wind load is applied in the
structure.

Orientation IS 875 defines the zones assuming the longest principal
axis of the building is in the Tekla Structural Designer
global Y direction. Due to the potential complexity of the
model, Tekla Structural Designer will not attempt to
determine the correct angle for the axes, (i.e. default is
zero) but you are able to enter a more appropriate
value.

NOTE The convention for Wind Directions is: wind
along global +X is 0 degrees; along global +Y is
90 ; along global -X is 180 ; along global -Y is
270.

Building Height
Exposed to Wind

Calculated from difference between Ground Level and
max level of roof and wind wall panels in the model,
with 'override calculated' option to permit user editing.

Building Width and
Building Length

The smallest bounding rectangle is determined
(considered over all roof and walls only), relative to the
given orientation. The building length defaults to the
maximum and the width to the minimum of the two
dimensions. The 'override calculated' options permit
user editing.

Building Type The following options are available:

• Temporary

• Low hazard to life

• All general buildings

• Important buildings
Building Class This is determined as follows:

• A if max(Building Height Exposed to Wind, Building
Width and Building Length) < 20m

• B if max(Building Height Exposed to Wind, Building
Width and Building Length) 50m

Engineers Handbooks 1101 Wind modeling handbook



Property/Buttons Description
• C if max(Building Height Exposed to Wind, Building

Width and Building Length) > 50m
Basic Wind Speed You need to enter the basic wind speed at the site.
Probability factor The value of the probability factor is determined from

the following table (Table 1):

 Basic Wind Speed
Buil
ding
Typ
e

33 39 44 47 50 55

Tem
por
ary

0.82 0.76 0.73 0.71 0.70 0.67

Low
haz
ard

0.94 0.92 0.91 0.90 0.90 0.89

All
gen
eral

1.00 1.00 1.00 1.00 1.00 1.00

Imp
orta
nt

1.05 1.06 1.07 1.07 1.08 1.08

Buttons  
Next Click Next to go to the Terrain page.

Terrain page
The next page of the Wizard allows you to enter the terrain data.

Property/Buttons Description
Property  
Terrain Category • Category 1 = Exposed open terrain few obstructions

(Default)

• Category 2 = Open terrain scattered obstructions

• Category 3 = Terrain with numerous closely spaced
obstructions

• Category 4 = Terrain with numerous large high
closely spaced obstructions

Fetch a distance The velocity profile for a given terrain category does not
develop to full height immediately and in this release
Tekla Structural Designer only deals with a single terrain
profile so you are warned if the velocity profile has not
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Property/Buttons Description
developed over the fill height of the building for the
defined fetch.

Buttons  
Next Click Next to go to the Topography page.

Topography page
If Consider Topography was checked, then the next page of the Wizard allows
you to enter the topography data.

Property/Buttons Description
Property • None - no feature (default)

• 2D Escarp - Cliffs and Escarpments

• 3D Hill - Hills and Ridges
Feature Height, Z Effective height of the feature.
Site dist from crest,
X

Distance upwind or downwind from the crest to the
building site (-ve = upwind).

Site height above
mean ground level,
H

Height above mean ground level.

Upwind Slope
Length, L

Actual length of the upwind slope in the wind direction.

Downwind Slope
Length

Actual length of the downwind slope in the wind
direction.

Buttons  
Next Click Next to go to the Results page.

Results page
The final page of the Wizard is a summary of the results.

The final page of the Wizard is a summary of the results.

Vz max = Vb x k1 x k2 x k3 (m/s)

pz max = 0.6 x Vz max2 (N/m2)

The above is for the highest point in the building only.

Property/Buttons Description
Buttons  
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Property/Buttons Description
Finish When you click Finish, the Wind Wizard... generates the

wind zones for the entire building for each of the
specified wind directions.

Before moving on you should take a moment to inspect
the Wind Model status on the Project Workspace>
Status tab, in order to check that no issues have been
encountered.

Wind model loadcases
This topic discusses the creation of wind load cases following the Wind
Wizard... command.

You control the creation of appropriate wind loadcases manually. It is not
practical to determine them automatically. The creation of wind loadcases is

achieved via the Load tab, Wind Loadcases command, which opens the
Wind Loadcases dialog.

NOTE The Wind Loadcases dialog is only available once a valid Wind Model has
been created using the Wind Wizard...

The Auto button within the Wind Loadcases dialog automatically generates
wind loadcases. Alternatively, you can create loadcases manually using the
Add button.

NOTE The Auto button is greyed out and hence unavailable, if wind
loadcases have already been defined. These would need to be deleted
to use the Auto button again.

You then specify which direction the loadcase will be created for and set
default values for all the zone loads generated in the loadcase.

Once generated, these loadcases are standard load cases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases for design.
This ensures that the number of load combinations to be considered are
minimized. Use the Delete button to remove wind loadcases you do not wish
to consider.

Creating loadcases for the Low Rise Buildings method

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
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Wind Loadcases manually. This is achieved via the Wind Loadcases dialog
(accessed from the Load tab).

The Auto button on the dialog provides various options to control the number
of loadcases before they are generated (its intention being to prevent
generation of very large numbers of loadcases). Alternatively you can create
loadcases manually using the Add button.

You then specify which direction the loadcase will be created for and set
default values for all the zone loads generated in the loadcase.

Once generated these loadcases are standard load cases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases for design.
This ensures that the number of load combinations to be considered are
minimized. Use the Delete button to remove wind loadcases you do not wish
to consider.

Adding wind loadcases

By clicking the Add button you are able to generate loadcases one at a time.

• The loadcase name is auto generated from the other input parameters, but
it can be edited if required.

• The direction the loadcase will be created for is selected from the droplist.

• The internal pressure coefficient is entered directly.

NOTE Depending on the wind code you have selected, the default is the
negative value depending on the Enclosure Classification from:

• AISC 7-16: Table 26.13-1, p271

• AISC 7-10: Figure 26.11-1, p201

• AISC 7-05: Figure 6-5, p47

• You are able to flag if it is a Torsional Loadcase or not: when flagged,
reduced pressure loads are applied to parts of the standard zones (by
applying a net pressure factor of 25%).

• You are able to flag if roof loads are to be generated for the loadcase or
not.

Auto generating wind loadcases

By clicking the Auto button you are able to control the total number of
loadcases generated.

Up to 4 loadcases can be generated for each direction, using positive and
negative GCpi derived from the Enclosure Classification, (see Figure 26.11-1,
p201). If a direction is included, but neither +ve GCpi or -ve GCpi have been
checked, then that is interpreted as a loadcase with GCpi of zero. You are also
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given the option to include the torsional loadcases or not, (default not), but it
is assumed that Roof loads are required.

By clicking OK the loadcases are generated, but you can then make any
changes required before clicking OK once more to close the Wind Loadcases
dialog.

Creating loadcases for the All Heights method

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
Wind Loadcases manually. This is achieved via the Wind Loadcases dialog
(accessed from the Load tab).

The Auto button on the dialog provides various options to control the number
of loadcases before they are generated (its intention being to prevent
generation of very large numbers of loadcases). Alternatively you can create
loadcases manually using the Add button.

You then specify which direction the loadcase will be created for and set
default values for all the zone loads generated in the loadcase.

Once generated these loadcases are standard load cases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases so that the
number of load combinations that need to be considered can be minimized.

Adding wind loadcases

By clicking the Add button you are able to generate loadcases one at a time.

• The loadcase name is auto generated from the other input parameters, but
it can be edited if required.

• The direction the loadcase will be created for is selected from the droplist.

• The internal pressure coefficient is entered directly.

NOTE Depending on the wind code you have selected, the default is the
negative value depending on the Enclosure Classification from:

• AISC 7-16: Table 26.13-1, p271

• AISC 7-10: Figure 26.11-1, p201

• AISC 7-05: Figure 6-5, p47

• You are able to flag if it is a Torsional Loadcase or not: when flagged,
reduced pressure loads are applied to parts of the standard zones (by
applying a net pressure factor of 25%).

• For torsional loadcases, you are able to flag if positive or negative
eccentricity is applied.
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• You are able to flag if loads are to be created for roof zones or not.

NOTE This option is provided to allow for the following note, (depending
on the wind code you have selected):

• AISC 7-16: Figure 27.3-1, Note 7, p276

• AISC 7-10: Figure 27.4-1, Note 9, p207

• AISC 7-05: Figure 6-6, Note 9, p49

• If loads are created for roof zones, you are able to flag if positive or
negative pressure coefficients are to be used for roof zones.

Auto generating wind loadcases

By clicking the Auto button you are able to control the total number of
loadcases generated.

Up to 8 loadcases can be generated for each direction. You may choose
positive and/or negative GCpi derived from the Enclosure Classification, (see
Figure 26.11-1, p201). If you include a direction, but have not checked either
+ve GCpi or -ve GCpi, then that is interpreted as a loadcase with GCpi of zero.
Similarly you may choose positive and/or negative Cp values for roof zones -
checking neither indicates Roof Loads to be ignored for this direction.
Torsional loadcases will not be included by default, but can be added with
positive or negative eccentricity.

By clicking OK the loadcases are generated, but you can then make any
changes required before clicking OK once more to close the Wind Loadcases
dialog.

Creating loadcases EC1991 1-4

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
Wind Loadcases manually. This is achieved via the Wind Loadcases dialog box
(accessed from the Load toolbar).

The Auto button on the dialog creates a default set of loadcases in each of the
directions, i.e.

• -0.3 for Cpi with -ve roof Cpe; not Overall

• -0.3 for Cpi with +ve roof Cpe; not Overall

• +0.2 for Cpi with -ve roof Cpe; not Overall

• +0.2 for Cpi with +ve roof Cpe; not Overall

• Overall with zero for Cpi; -ve roof Cpe

Alternatively you can create loadcases manually using the Add button. You
then specify which direction the loadcase will be created for and set default
values for all the zone loads generated in the loadcase.
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Once generated these loadcases are standard load cases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases so that the
number of load combinations that need to be considered can be minimized.
Use the Delete button to remove wind loadcases you do not wish to consider.

Wind loadcases dialog

As well as specifying which direction the loadcase will be created for, this
dialog allows you to set default values for all the zone loads generated in the
loadcase.

Item Description
Fields  
Structur
al Factor
-
Automat
ically
calculate
seperate
cs and cd
factors

The UK NA states that the Structural Factor, cscd may be
separated into a size factor cs and a dynamic factor cd,
i.e. it is still acceptable to apply Clause 6.2 (1) a) to d) and
set cscd = 1, or use Annex D. Where Structural Factor -
Automatically calculate separate cs and cd factors is
checked, cd is calculated using Figure NA.9 and cs using
Table NA.3.

NOTE The option to automatically calculate cc and cd is
not available for other National Annexes.

Structur
al
damping

The δs value is used to determine the dynamic factor cd.
It is only visible if the Separate Factors box is checked.
See Table F.2.

Name The loadcase name is auto generated from the other
input parameters, but it can be edited if required.

Directio
n

The direction the loadcase will be created for is selected
from the droplist.

Overall You are able to flag if the loadcase is to be specifically
used for examining the overall behaviour of the
structure by checking this box.

NOTE It may be necessary for you to create a second
copy of the loadcase with this check box cleared
if the loadcase is also used for designing
elements.

b+h When designing elements, (beams, columns, braces etc),
Table NA.3 in the UK NA implies that b and h should be
the width and height respectively of an element. Due to
the nature of the loads in the program, it is not practical
to do this automatically, and so you should specify a
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Item Description
value to be used in the loads generated for this loadcase
(default 5.0m).

If separate factors are not to be used, (i.e. use combined
cscd), then this value is redundant.

If separate factors are to be used, but Overall is checked
on the row, then the b+h cell is marked inactive. In this
case, for each wall and roof, the program calculates b+h
using b & h from the zone properties for the relevant
wind direction.

Use +ve
Cpe

Where 2 sets of coefficients are given in a table for roof
zones, this field indicates if the negative or positive Cpe
value is to be used.

Cpi Default Internal Pressure Coefficient (-0.3, 0.0, +0.2 or
other value) - to be calculated by you from Clause 7.2.9.

Buttons  
Add Click this button to add a single wind loadcase.
Delete Click this button to delete a wind loadcase.
Auto Click this button to create a default set of loadcases in

each of the directions.

Wind model load decomposition
The following topics will discuss the decomposition that occurs when
considering wind load applied to your model.

• Roof panel load decomposition (page 1109)

• Wall panel load decomposition (page 1111)

• Alternative wind load decomposition methods for complex models
(page 1115)

Roof panel load decomposition
This topic will discuss the decomposition that occurs when considering wind
load applied to roof panels.

Roof panel load decomposition

The direction of the one way decomposition of the wind zone loads to roof
members is determined by the span direction (i.e. rotation angle) of the roof
panel.

All types of elements within the roof panel plane (except bracing) are
considered during the load decomposition.
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Zone loads on roof.

Roof panel decomposition (rotation angle 0 degrees)
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Roof panel decomposition (rotation angle 90 degrees)

Wall panel load decomposition
This topic will discuss the decomposition that occurs when considering wind
load applied to wall panels.

Decomposition options

Wind zone loads are decomposed on to the structure according to the
Decompose to wall panel property. The available options are:

• Members

• Nodes (default)

• Rigid Diaphragms

To demonstrate the effect of the different Decompose to values, consider a
braced steel frame clad in wind wall panels as shown below:
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For wind direction 0, the wind model produces Zone loads as follows:

The topics below illustrate how the zone loads shown above are decomposed
using the three different Decompose to values.

Decompose to Members

Decomposition to members is similar to the roof panel decomposition, the
span direction of the wind wall panel determines the direction of the one way
decomposition.

All element types within the wind wall plane are considered with the exception
of bracing members.

Decomposition to members allows the generation of UDL's on portal
stanchions and gable posts without the need to model side rails.

For the model shown above, choosing Decompose to Members produces the
following load decomposition:
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Decomposition to Members (rotation angle 0 degrees)

Decomposition to Members (rotation angle 90 degrees)

Decompose to Nodes

Decomposition to nodes is the default setting and results in nodal loads on
the supporting members. This setting is typically appropriate to avoid lateral
loads on simple beams.

All element types within the wind wall plane are considered with the exception
of bracing members.

The initial decomposition is the same as for members, with the direction of the
one way decomposition being specified by the span direction of the panel. A
second decomposition stage is then undertaken to convert the member loads
to nodal loads:
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• Full/partial UDLs and VDLs on elements (lengths of beams/columns
between nodes) are distributed back to nodes as if the elements were
simply supported at either end.

• The final nodal load is the sum of all incoming element loads.

For the model shown above, choosing Decompose to Nodes produces the
following load decomposition:

collapse

Decomposition to Nodes (rotation angle 0 degrees)

Decomposition to Nodes (rotation angle 90 degrees)

NOTE In the example above, when the rotation angle is 0 degrees, some of
the nodal loads are applied directly to supports.
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Decompose to Rigid Diaphragms

Decomposition to rigid diaphragms does not consider the span direction of
the wall panel (so the rotation angle is irrelevant).

It is particularly useful for flat-slab structures, as the alternative Decompose
to Member or Node decomposition methods require supporting members
that may not exist in the model.

NOTE All rigid diaphragms within the wind wall height are considered for
decomposition irrespective of whether they are physically connected
to the wind wall.

For the model shown above, choosing Decompose to Rigid Diaphagm
produces the following load decomposition:

Decomposition to Diaphragms - each Zone load is decomposed as a separate
point load on the diaphragm

Validation of Panels set to Rigid Diaphragm Decomposition

The following validation checks are performed on wind wall panels set to
Decompose to Rigid Diaphragms:

• Each panel must be rectangular

• The top level of every wall panel must align with a rigid diaphragm

• Each panel may be sub-divided into zones, but only by horizontal lines

• Unlike for Decompose to Member or Node, each wall panel does not
need to have supporting members along its edges.
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Alternative wind load decomposition methods for complex models
This topic discusses alternative methods of wind decomposition on complex
models.

For complex models the placement of wind walls required by the Wind model
method can be a time consuming operation.

In such situations (provided the model has suitable rigid diaphragms), the
following alternatives offer quicker and simpler ways to apply approximate
wind loads:

• Use engineering judgement to clothe the structure with an arrangement of
simplified wind wall panels around its bounding box, set the wind walls to
decompose to rigid diaphragms, and proceed with the Wind model method

• Do not apply wind walls. Alternatively consider the application of manual
wind loads.

See also

Simplified wind wall panels (page 1116)

Simplified wind wall panels
This topic demonstrates the simplified wind wall panel approach.

In theory, because wind walls set to Decompose to Rigid Diaphragms don't
have to physically connect to the diaphragms, even a very complex model
could be clothed with just four simplified wind walls defined along its
bounding box, as illustrated below:

Complex model
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Simplified wind walls around the "bounding box"

Zone loads for the simplified wind wall model
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Zone loads decomposed to rigid diaphragms

Such an approach could be used to rapidly establish approximate wind loads
(based on the rectangular building envelope) which could then be refined at a
later stage if necessary.

NOTE If this method is adopted you are strongly advised to review the wind zones
that are formed, and the resulting decomposed loads to ensure they meet
your expectations - it will not give good results for all models.

If the decomposed loads produced by the above approach are not
satisfactory, you might decide to take greater control by applying the loads
manually.
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Simple wind and manually applied wind loads
This approach provides a quick method of applying wind to the structure
without requiring you to create a wind model.

Simple Wind loads can be created which are then decomposed to
diaphragms, or you could apply wind loads directly as panel, member, or
nodal loads.

Click the links below to find out more:

• Simple wind overview (page 1119)

• Limitations of wind decomposition to diaphragms (page 1123)

Simple wind overview
Each simple wind load is defined as an area load over a defined width and
height.

In the two storey example shown below, a 1kN/m2 load is applied over the full
22.5m width and 6m height of the building.
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• The load defaults to being uniform over the full height (as shown above),
but levels can be inserted to cater for a stepped loading profile if required.
The inserted levels do not have to coincide with actual building levels.

• The top of the load should align with a rigid diaphragm - if not a validation
error is generated - this is to ensure the loading is distributed as correctly
as possible.

• During decomposition an imaginary 'bounding box' is formed around the
building - only the load width within the building profile is considered for
decomposition.

• Load within the bounding box that hits the structure (the blue shaded area
above) is decomposed to point loads on rigid diaphragms only - it does not
get decomposed to semi-rigid diaphragms.

• All rigid diaphragms on the top or bottom level or anywhere in-between
are considered, with the area load being divided between the levels before
it is decomposed. In the example the area load is split between 1st and 2nd
floor levels so that a total of 22kN is to be decomposed above and 90kN
below.
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• The load is then decomposed to the diaphragms at each level in proportion
to the width of each diaphragm. Each load being applied as a nodal load in
the direction of the simple wind load at the mid point of the projected load.

• If there are no suitable diaphragms on the top level, the load is applied at
the next level down.

• Similarly if the 'Ignore diaphragms on lowest level' box is checked on the
Simple Wind Loading dialog or there are no suitable diaphragms on the
bottom level, the load is applied at the next level up.

NOTE If for some reason there are diaphragms at the ground level, then you
may decide to check the 'Ignore diaphragms on lowest level' box in
order to ensure no load is lost directly to the foundations.

Situations where rigid diaphrams are ignored

If the projected width of a rigid diaphragm in the direction that the load is
acting is less than 5% of the simple wind load width it is assumed to be
ineffective.

In the below example, at first floor level the width of the diaphragm
perpendicular to the load exceeds the width of the load, so the diaphragm is
effective.
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This changes at roof level, as the width of the diaphragm is now significantly
smaller than the width of the load. If the diaphragm width is less than 5% of
the load width, the diaphragm is ignored.
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Furthermore, as this is the only diaphragm at the top level you would be
prevented from applying the load, as a "Top level of Simple Wind Load must
align with a rigid diaphragm" error message would be displayed.

A workaround would be to reduce the top level of the simple wind load so that
it hits a diaphragm at a lower floor of sufficient width, as shown below.
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Limitations of wind decomposition to diaphragms
Certain building shapes need extra consideration if simple wind loads have
been applied, or if wind loads have been applied to wall panels set to
decompose to diaphragms.

As illustrated by the following examples, buildings containing discrete towers
(and thus containing disconnected rigid diaphragms) are a particular concern.

Wind load perpendicular to disconnected diaphragms

In this example wind load is to be applied in the Global Y direction,
perpendicular to the disconnected diaphragms that exist in the highlighted
slabs at the second floor level shown below.

An issue arises when the wind load is applied as an area load that has to be
decomposed to both diaphragms. This could happen when the load is applied
either via a Simple Wind load, or a wind wall panel:
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Irrespective of the method used to apply it, the area load within the building
profile is shared between levels prior to decomposition.

The load is then decomposed to the diaphragms at each level in proportion
to the width of each diaphragm.

In this case because both diaphragms the second floor level are of equal
width, the load is shared equally between them. This is not satisfactory as
more of the load should have been applied to the left hand diaphragm in this
case.
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The workaround varies according to the method of loading, but basically
involves replacing the original load with separate loads in each bay:
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In both the above cases, the load is then decomposed as originally intended.
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Wind load parallel to disconnected diaphragms

In this example although the two blocks are now the same height, another
issue arises when the wind load is applied in the Global X direction, i.e. parallel
to the disconnected diaphragms at the second floor level:

The issue arises because one diaphragm is ‘hidden’ from the applied load by
the other diaphragm. The issue occurs irrespective of whether the load is
applied via a Simple Wind load, or a wind wall panel:
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The area load within the building profile is first shared between levels prior to
decomposition.

At the second floor level, instead of all the load being decomposed to the
diaphragm facing the wind; because it is decomposed in proportion to the
width of each diaphragm at that level, it ends up being shared equally to
both.
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To avoid the load being shared equally:

• if using wind wall panels - you would need to decompose to members or
nodes instead of to diaphragms

• if using Simple Wind loads - there is no workaround, you would have to
manually input the loads as diaphragm loads instead.

Wind tunnel testing and diaphragm loads
Tekla Structural Designer permits the easy flow of information required for
wind tunnel testing of tall structures.

This includes:

1. The information out from Tekla Structural Designer to the wind specialists

2. The relevant results from wind specialists back into Tekla Structural
Designer

Click the links below to find out more:

• Wind tunnel testing overview (page 1130)

• Exporting wind tunnel data workflow (page 1131)

• Using imported wind tunnel information (page 1133)
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Wind tunnel testing overview
There are four steps required in the process of using Tekla Structural Designer
design within the process of wind tunnel testing.

1. Tekla Structural Designer creates a “Tekla Structural Designer - Wind
Tunnel Report” from a vibration analysis to be used by the wind
specialists.

See: Exporting wind tunnel data workflow (page 1131)

2. The “Tekla Structural Designer - Wind Tunnel Report” is sent to the wind
specialists who undertake the wind tunnel tests. At the end of the tests,
they create a “Wind Tunnel - Load Report” which they send back to the
structural designer.

3. The designer manipulates the “Wind Tunnel - Load Report” to generate 24
loadcases with FDir1, FDir2 & MZ loads applied to the centres of mass of the
rigid diaphragms at each floor/level.

See: Using imported wind tunnel information (page 1133)

4. The 24 wind loadcases are combined in regular combinations to be
included as part of the design process in Tekla Structural Designer

Exporting wind tunnel data workflow
Once the model has been created and had loads applied in Tekla Structural
Designer, the basic workflow for generating and exporting wind tunnel data is
described below.

Display the Wind Tunnel Data ribbon

The workflow is initiated by clicking Wind Tunnel on the Analyze ribbon.

• This enables the Wind Tunnel Data ribbon below:

• You can work through this from left to right...
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Add modal mass combinations

1. On the Wind Tunnel Data tab, click  Add. 

The Loading dialog (page 531) opens on the Combinations page with a
new Modal Mass class of combination added in the left hand pane.

2. Rename the combination as required.

3. Select the load cases that you want to add in the combination, and click >>

4. On the Applied mass tab, set the directions to be considered, and if
necessary, specify the level below which mass can be ignored.

5. Click OK to save the mass combination. 

Tekla Structural Designer adds the mass combination to the list of
combinations in the Loading list.

Review the modal analysis settings

1. On the Wind Tunnel Data tab, click Settings 

The Analysis Settings dialog opens on the 1st Order Modal (page 2281)
page.

2. Select the total number of modes to be calculated.

3. Review and modify the other analysis settings according to your needs.

Run a modal analysis

1. On the Wind Tunnel Data tab, click Run Modal Analysis. 

Tekla Structural Designer analyzes the model.

Review the results

After modal analysis the following results are available and can be reviewed as
tabular data:

• Masses, Center of Mass, and Mass Moment of Inertia by level,

• Modal Frequencies,

• Mode shape by level

Mode shapes can also be displayed graphically (page 691) if required by
switching to a Results View.

Export the report

To export all the tabular results that can be viewed in the Wind Tunnel Data
View, click Export full report.

Alternatively, you can export just the tabular results that are displayed in the
current view by clicking Export current view.
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Using imported wind tunnel information
The Tekla Structural Designer workflow for importing and using the wind
tunnel information provided by wind specialists is as follows:

Create loadcases for the diaphragm loads

The wind tunnel report typically contains 24 loadcases with FDir1, FDir2 & MZ
loads applied to the centres of mass of the rigid diaphragms at each floor/
level.

Before the loads can be imported from the report, the engineer has to
manually create wind loadcases to hold them.

Apply the diaphragm loads in each loadcase

Diaphragm loads can either be pasted into Tekla Structural Designer or
entered manually.

NOTE Diaphragm loads can only be pasted at floors/levels with one or more
horizontal rigid or semi rigid diaphragm.

See: Diaphragm loads and diaphragm load tables (page 546)

Create load combinations

Load combinations are created manually. The Wind Tunnel loadcases behave
as any other "Wind" type loadcase when being used in combinations.

Analysis and design

A standard analysis and design process is followed, in which:

• the graphical analysis results for wind tunnel loadcases and combinations
being shown in exactly the same way as for any other wind type loadcases
and combination,

• wind tunnel loadcases are used in drift checks in the same way as other
wind type loadcases,

• wind tunnel loadcases are used in design combinations in the same way as
other wind type loadcases.

13.2 Stability and imperfections handbook
This handbook introduces you to the following topics:

• The four sources of stability requirements that may need to be considered,
see Overview of stability requirements (page 1134).
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• Choosing the correct analysis type for your model and head code, see
Allowing for global second-order effects (page 1138).

• Catering for global imperfections, see Allowing for global imperfections
(page 1149).

• Catering for member imperfections, see Allowing for member
imperfections (page 1151).

Overview of stability requirements
The analysis and design process has to allow for the differences between a
theoretical mathematical model of a building and a more realistic
representation. For example, buildings are not truly vertical when first built
nor do they remain so when subject to load. These are called stability
requirements and are from four sources:

1. Global second-order (P-∆) effects to allow for deformation of the
structure under load,

2. Member second-order (P-δ) effects to allow for deformation of the
members under load,

3. Global imperfections due to the structure not being built plumb and
square,

4. Member imperfections due to initial lack of straightness of the member.

There are various methods of allowing for each of these and they can be
different for steel and concrete. There is also some variation based on country
code.
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Global second-order (P-∆) effects
If gravity loads are applied to the deflected shape of a structure the load P
applied at eccentricity ∆ generates additional forces.

Provided the deflection is small:

• Structure is 'Non-sway'

• Second order effects can be ignored.

At some level these effects are no longer ignorable:

• Structure is 'Sway sensitive'

• And you have to do something to account for the second order effects.

NOTE The terminology: 'Non-sway' and 'Sway sensitive' can vary between codes.

Related concept

Allowing for global second-order effects (page 1138)
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Member second-order (P-δ) effects
Under load members will deform between their ends:

• Member curvature introduces a displacement δ between the member
ends.

• The member axial loads applied at eccentricity δ generates additional
forces.

In concrete structures:

• Where deflections are small :

• Member is 'Short' or 'Stocky' or 'Non-Slender'

• member second order effects are considered ignorable

• At some level they are no longer ignorable:

• Member is 'Slender'

• effects must be catered for in the design calculations

In steel structures: these effects are intrinsically allowed for in the design
equations.

NOTE The terminology: 'Short' , 'Stocky' and 'Non-slender' can vary between codes.

When must global and member second order effects be considered?
Depending on the building's overall sway classification and each member's
slenderness, global and member effects must be considered as follows:

Member Effects Global Effects
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Non-sway Sway
Short Member A C
Slender Member B D

A - All second order effects can be ignored

B - Global effects can be ignored - member effects must be considered

C - Global effects must be considered - member effects can be ignored

D - Global effects must be considered - member effects must be considered

NOTE REMEMBER - every structure and every member has 2 directions!

Global imperfections
When the design code requires it you need to account for some degree of
inclination (slope); typically in the range 0.2 to 0.5%

The codes allow you to cater for this in different ways:

• You could build multiple analysis models that are inclined

• You could have a single analysis model where you apply Equivalent
Horizontal Forces [Eurocodes] / Notional Loads [AISC/ACI] / Notional
Horizontal Forces [AUS/BS/IS] that will induce the same effect. Basically this
means applying horizontal forces = 0.2 to 0.5% of the vertical forces in any
combination.

In Tekla Structural Designer we use the second option.
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NOTE Global Imperfections apply regardless of whether the structure is 'Non-sway'
or 'Sway sensitive'.

Related concept

Allowing for global imperfections (page 1149)

Member imperfections
Member Imperfections apply regardless of whether members are slender or
not. They are normally dealt with as part of the member design.

Related concept

Allowing for member imperfections (page 1151)

Allowing for global second-order effects
The type of analysis required to meet stability requirements and the checks
performed will vary depending on the head code and material.

Choice of analysis type (ACI/AISC)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of two analysis types. These are,

• First-order analysis (not suitable for the final design of steel structures),

• Second-order analysis.

For steel structures: - Unless a number of specific criteria can be met, it is
essential that your final design utilizes second-order analysis. However,
second order analysis can be more sensitive to parts of your model that lack
stiffness. For this reason it is recommended that you initially use first-order
analysis to obtain sections and an overall building performance with which
you are satisfied before switching to second-order analysis.

For concrete structures: - By choosing second-order analysis the global
second-order effects are automatically catered for. However, if you determine
that the structure is non-sway (see When should a concrete building be
classed as non-sway? (page 1138)) you may instead opt for the design to be
based on the first order analysis.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. It is therefore important that appropriate member type
specific modification factors have been specified - see Use of Modification
Factors (page 1149).
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When should a concrete building be classed as non-sway?

ACI 318-11 clause 10.10.5.2 states that a story can be considered as non-sway
when the stability index Q is less than or equal to 0.05. (Basically, second order
effects can be ignored below this value.)

Tekla Structural Designer does not report Q directly, but the Drift report does
calculate an indicative stability coefficient (Δ2/Δ1) which is effectively the same
as a moment magnifier.

From ACI Eq. (10-20):

Moment magnifier, δs = 1/(1-Q)

Equating this to the stability coefficient gives

1/(1-Q) = (Δ2/Δ1)

1-Q = 1/(Δ2/Δ1)

Q = 1 - 1/(Δ2/Δ1)

For Q < 0.05

1 - 1/(Δ2/Δ1) < 0.05

(Δ2/Δ1) < 1/0.95

(Δ2/Δ1) < 1.0526

Therefore, if the Drift report determines an indicative stability coefficient
(Δ2/Δ1) less than 1.05 it can be assumed non-sway; whereas if greater than this
value a second-order analysis is required.

NOTE The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. It is therefore important that appropriate member type
specific modification factors have been specified - see Use of Modification
Factors (page 1149).

Choice of analysis type (BS)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of three analysis types. These are,

• First-order (Elastic) analysis,

• Amplified forces (kamp) method (uses first-order analysis),

• Second-order analysis.
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First-order (Elastic) analysis

For both steel and concrete, first-order analysis is only acceptable providing
second order effects are small enough to be ignored - see: A practical
approach to setting the analysis type (page 1141) below.

Amplified forces (kamp) method

Both steel and concrete can use the amplified forces method to determine
second-order effects although for steel this does have restrictions on use
(regular frameworks with λcr > 4).

If the amplified forces method is selected you must also indicate which
formula to use for determining the amplification factor,

If the structure is clad and if the stiffening effect of cladding is not taken into
account explicitly:

kamp = λcr/(1.15λcr - 1.5)

If the structure is unclad or clad with a direct allowance made for the stiffening
effect:

kamp = λcr/(λcr - 1)

During the design process for both steel and concrete members, the member
end forces from the analysis of the lateral loadcases are amplified by the
'appropriate' value of kamp. Since the analysis is first-order this is carried out as
part of summing the load effects from each loadcase (multiplied by their
appropriate load factor given in the design combination). The 'appropriate'
value is the worse of kamp,Dir1 and kamp,Dir2 based on the worst value of λcr for
all stacks in the building.

The kamp results are summarised for each column in both directions. These
can be viewed as follows:

1. Open a Review View, and select Tabular Data from the Review toolbar.

2. Select 'kamp' from the View Type drop list on the Review toolbar.

3. The kamp results in both directions are tabulated for each column in the
building.

Second-order analysis

Full second-order analysis is not restricted to regular frameworks, but requires
λcr > 2.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. This is a significant issue for both the amplified forces
method and second-order analysis. It is therefore important that appropriate
member type specific modification factors have been specified - see Use of
Modification Factors (page 1149).
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A practical approach to setting the analysis type

Unless λcr is greater than 10 (in which case second-order effects can be
ignored), it is essential that your final design utilizes one of the second-order
analysis approaches. During the initial sizing process you may however choose
to run a first-order analysis. Proceeding in this way you can obtain sections
and an overall building performance with which you are satisfied, before
switching to P-∆ analysis.

Note: If the rigorous second-order (P-∆) analysis approach is used during the
initial sizing process, you may find that it can be more sensitive to parts of
your model that lack stiffness.

The following approach to setting the analysis type is suggested:

1. On the Analysis page of the Design Options dialog, initially set the analysis
type to First-order analysis.

2. Perform Design All (Gravity) using first-order analysis in order to size
members for the gravity loads.

3. Once the members are adequately sized for the gravity combinations
obtain a figure for the building's elastic critical load factor, λcr (See: How
do I assess the worst elastic critical load factor... (page 1142))

4. If the λcr that has been determined is greater than 10 you can continue to
perform Design All (Static) with the analysis type set to First-order
analysis.

5. If λcr is less than 10 you will need to proceed with one of the second-order
approaches - and if it is very low (i.e. less than 2.0) some remodelling is
required:

• Either, refine the design until λcr is greater than 2.0 to make the
structure suitable for a final design using the full second-order
approach, (which is the only method permitted if the structure
contains non-linear members such as tension only braces - see below),

• Or, in order to use the amplified forces (kamp) approach, refine the
design further until λcr is greater than 4.0.

6. When a suitable λcr has been achieved change the analysis type to the full
second-order, or the amplified forces method as appropriate. (If the kamp
approach is selected you must also indicate which formula to use for
determining the amplification factor, This will depend on whether the
structure is clad or not and if the cladding is taken into account explicitly
or not.)

7. With the analysis type still set to the full second-order, or the kamp
approach perform Design All (Static).

If you use the kamp approach be aware that BS5950-1:2000 classes certain
structures outside the scope of this method. e.g. tied portals, or structures
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containing tension only braces. For such structures, you would need to ensure
that λcr is greater than 2.0, and use the full second-order analysis approach for
the static design.

How do I assess the worst elastic critical load factor for the building?

To determine the sway sensitivity for the building as a whole, the worst stack
(storey) in the worst column throughout the building in both directions has to
be identified - this can be done as follows:

1. On completion of the analysis, open a Review View and select Tabular
Data from the Review toolbar.

2. Select 'Sway' from the View Type drop list on the Review toolbar.

3. The elastic critical load factor in both directions ( (λDir1 & (λDir2) is
tabulated for each column in the building.

4. Make a note of the smallest λ value from all of the columns in either
direction.

NOTE If there are a lot of columns in the building - in order to quickly determine the
smallest elastic critical load factor in each direction, simply click the λDir1
header until the columns are arranged in increasing order of λDir1, then
repeat for λDir2.

In BS 5950-1:2000 a building can be considered as 'non-sway' when λcr ≥ 10
else it is 'sway sensitive' and (global) second-order effects must be taken into
account.

Note however that you are not restricted in your choice of analysis type
irrespective of the value of λcr (it is your call, although we will warn you about
it).

How is the elastic critical load factor calculated?

In order to determine whether a building is 'non-sway' or 'sway sensitive',
Tekla Structural Designer calculates the elastic critical buckling load factor, λcr.
It is calculated in the same manner for steel and concrete. The approach
adopted is that for each loadcase containing gravity loads (Dead, Imposed,
Roof Imposed, Snow) a set of Notional Horizontal Forces (NHF) are
determined. It uses 0.5% of the vertical load at the column node applied
horizontally in two orthogonal directions separately (Direction 1 and Direction
2). From a first order analysis of the NHF loadcases the deflection at each
storey node in every column is determined for both Direction 1 and Direction
2. The difference in deflection between the top and bottom of a given storey
(storey drift) for all the loadcases in a particular combination along with the
height of that storey provides a value of λcr for that combination as follows,

λcr =h/(200 * δs)

Where
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h= the storey height

δs =the storey drift in the appropriate direction (1 or 2) for the particular
column under the current combination of loads.

NOTE Within each column's properties, a facility is provided to exclude particular
column stacks from the sway check calculations to avoid spurious results
associated with very small stack lengths.

Choice of analysis type (Eurocode)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of three analysis types. These are,

• First-order (Elastic) analysis,

• Amplified forces (kamp) method (uses first-order analysis),

• Second-order analysis.

First-order (Elastic) analysis

For both steel and concrete, first-order analysis is only acceptable providing
second order effects are small enough to be ignored - see: A practical
approach to setting the analysis type (page 1144) below.

Amplified forces (kamp) method

Both steel and concrete can use the amplified forces method to determine
second-order effects although for steel this does have restrictions on use
(basically regular frameworks with αcr > 3 - see Validity of the amplified forces
method (page 1144) below). Full second-order analysis is preferred for
steelwork and since it is not precluded by EC2 it can be used for concrete.

The amplified forces method is described differently in EC3 compared to EC2,
whilst the presentations are different, they are both based on the amplifier,
kamp given as,

kamp = 1/(1 - 1/αcr)

During the design process for both steel and concrete members, the member
end forces from the analysis of the lateral loadcases are amplified by the
'appropriate' value of kamp. Since the analysis is first-order this is carried out as
part of summing the load effects from each loadcase (multiplied by their
appropriate load factor given in the design combination). The 'appropriate'
value is the worse of kamp,Dir1 and kamp,Dir2 based on the worst value of αcr for
all stacks in the building.

The kamp results are summarised for each column in both directions. These
can be viewed as follows:

1. Open a Review View, and select Tabular Data from the Review toolbar.
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2. Select 'kamp' from the View Type drop list on the Review toolbar.

3. The kamp results in both directions are tabulated for each column in the
building.

NOTE The amplified forces method is not recommended for non-linear structures -
a full second-order analysis should be performed instead.

Validity of the amplified forces method

EC3 Clause 5.2.2 (6)B lists limitations on the applicability of the Amp. Forces
method. It is therefore your responsibility when selecting this method to
ensure all of the following:

• all storeys have a similar distribution of vertical load

• all storeys have a similar distribution of horizontal load

• all storeys have a similar distribution of frame stiffness with respect to the
applied storey shear forces

Also according to clause 5.2.1 (4)B limitation:

• roof slope shallow - not steeper than 1:2 (26 degs)

• axial compression in beams or rafters - Ncr / Ned <= 11.1

Second-order analysis

Full second-order analysis is more widely applicable for steelwork structures
and since it is not precluded by EC2 it can be used for concrete.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. This is a significant issue for both the amplified forces
method and second-order analysis. It is therefore important that appropriate
member type specific modification factors have been specified - see Use of
Modification Factors (page 1149)

A practical approach to setting the analysis type

Unless αcr is greater than 10 (in which case second-order effects can be
ignored), it is essential that your final design utilizes one of the second-order
analysis approaches. During the initial sizing process you may however choose
to run a first-order analysis. Proceeding in this way you can obtain sections
and an overall building performance with which you are satisfied, before
switching to one of the P-∆ analysis methods.

The following approach to setting the analysis type is suggested:

1. On the Analysis page of the Design Options dialog, initially set the analysis
type to First-order analysis.

2. Perform Design All (Gravity) using first-order analysis in order to size
members for the gravity loads.
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3. Once the members are adequately sized for the gravity combinations
obtain a figure for the building's elastic critical load factor, αcr (See: How
do I assess the worst elastic critical load factor... (page 1146))

4. If the αcr that has been determined is greater than 10 you can continue to
perform Design All (Static) with the analysis type set to First-order
analysis.

5. If αcr is less than 10 you will need to proceed with one of the second-order
approaches - and if it is very low (i.e. less than 2.0) some remodelling is
required:

• Either, refine the design until αcr is greater than 2.0 to make the
structure suitable for a final design using the full second-order
approach, (which is the only method permitted if the structure
contains non-linear members such as tension only braces),

• Or, in order to use the amplified forces approach, refine the design
further until αcr is greater than 3.0.

6. When a suitable αcr has been achieved change the analysis type to the full
second-order, or the amplified forces method as appropriate.

7. With the analysis type still set to the full second-order, or the amplified
forces method, perform Design All (Static).

NOTE If full second-order analysis is used during the initial sizing process, you may
find that it can be more sensitive to parts of your model that lack stiffness.

NOTE If you use the 'Second-order analysis - Amp. forces method' be aware that EC3
classes certain structures outside of its scope (see Validity of the amplified
forces method (page 1144)). Such structures would need to be refined during
gravity sizing until the elastic critical load factor is at least greater than 2.0, so
that the full second-order approach can be used for the full design.

When should a building be classed as sway sensitive?

Susceptibility to second order effects is a general characteristic and is not
material specific, it has just been presented differently in EC3 and EC2:

• In EC3 a building can be considered as 'non-sway' when the elastic critical
load factor αcr ≥ 10, else the building is 'sway sensitive' and (global) second-
order effects must be taken into account.

• In EC2 the definition is slightly different - it does not use the terms 'non-
sway' and 'sway sensitive'. Rather it simply defines when second-order
effects are small enough to be ignored. The principle is given in Clause
5.8.2 (6) which states that they can be ignored if they are less than 10% of
the corresponding first order effects. Because of the way in which the
amplification factor, kamp is calculated the change point is at an αcr of 11
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not 10. (see: Derivation of the kamp formula for concrete structures
(page 1147)).

However, the intent is the same in both cases and so in Tekla Structural
Designer αcr ≥ 10 is taken as the change point. In any event, you are not
restricted in your choice of analysis type irrespective of the value of αcr (it is
your call, although we will warn you about it)

How do I assess the worst elastic critical load factor for the building?

To determine the sway sensitivity for the building as a whole, the worst stack
(storey) in the worst column throughout the building in both directions has to
be identified - this can be done as follows:

1. On completion of the analysis, open a Review View and select Tabular
Data from the Review toolbar.

2. Select 'Sway' from the View Type drop list on the Review toolbar.

3. The elastic critical load factor in both directions (αDir1 & αDir2) is tabulated
for each column in the building.

4. Make a note of the smallest elastic critical load factor from all of the
columns in either direction - this is the αcr value for your building.

NOTE If there are a lot of columns in the building - in order to quickly determine the
smallest elastic critical load factor in each direction, simply click the αDir1
header until the columns are arranged in increasing order of αDir1, then
repeat for αDir2.

Having determined an αcr for your building, you then use it when deciding
which is the most appropriate analysis type for design.

How is the elastic critical load factor calculated?

The elastic critical load factor, αcr is calculated in the same manner for steel
and concrete. The approach adopted is that for each loadcase containing
gravity loads (Dead, Imposed, Roof Imposed, Snow) a set of Equivalent
Horizontal Forces (EHF) are determined. These consist of 0.5% of the vertical
load at each column node applied horizontally in two orthogonal directions
separately (Direction 1 and Direction 2). From a first order analysis of the EHF
loadcases the deflection at each storey node in every column is determined
for both Direction 1 and Direction 2. The difference in deflection between the
top and bottom of a given storey (storey drift) for all the loadcases in a
particular combination along with the height of that storey provides a value of
αcr for that combination as follows,

αcr = h/(200 * δEHF)

Where

h = the storey height
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δEHF = the storey drift in the appropriate direction (1 or 2) for the particular
column under the current combination of loads

NOTE Within each column's properties, a facility is provided to exclude particular
column stacks from the sway check calculations to avoid spurious results
associated with very small stack lengths.

Derivation of the kamp formula for concrete structures

EC2 provides two specific approaches to determine the change point below
which second-order effects are small enough to be ignored:

The first specific approach is contained in Clause 5.8.3.3 which provides a
pass/fail criterion to check whether the global second-order effects may be
ignored. It is given as,

FVEd = k1 * ns/(ns + 1.6) * S(Ecd * Ic)/L2

where

FVEd = the total vertical load (on 'braced' and 'bracing' members)

k1 = a factor that allows for cracking in the concrete of the LLRS and is a
Nationally Determined Parameter (NDP)

* ns = number of storeys

Ecd = the design value of the modulus of elasticity of the concrete

Ic = the second moment of area of the uncracked bracing members

L = the total height of the building

However, the above approach has a number of restrictions in its application
and as a result it is not applied in Tekla Structural Designer.

The second specific approach is given in Annex H.

The method given in Annex H.1.2 is the background for the more limited
method given in Clause 5.8.3.3 as described above, but it does not apply
where there is significant shear deformation in the LLRS e.g. for shear walls
with significant openings, hence again it is not considered in Tekla Structural
Designer.

Instead, recourse is made to determining the level of second-order effect
using Annex H.2. Using this approach, by rearranging Equation H.8 it is
possible to provide a 'stability coefficient' 1/αcr which can be applied as the
change point between non-sway and sway sensitive structures.

FHEd = FH0Ed /(1-FH1Ed/FH0Ed) Equation H.8

Where:

FH1Ed = fictitious horizontal force, giving the same bending moments as vertical
load NVEd acting on the deformed structure, with deformation caused by FH0Ed
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(first order deformation), and calculated with nominal stiffness values
according to 5.8.7.2

Considering how this definition of FH1Ed might apply to an imaginary cantilever
of height, h, we arrive at:

1. The moment due to FH1Ed is the same as that due to the vertical load NVEd,
so:

FH1Ed * h = NVEd * δ

which can be rearranged to:

FH1Ed = (NVEd * δ)/h

2. Substituting for FH1Ed in Equation H.8, we have:

FHEd = FH0Ed /(1 - (NVEd * δ)/(FH0Ed * h)

3. By defining kamp = FHEd/FH0Ed the above can be rearranged to:

kamp = 1/(1 - (NVEd * δ)/(FH0Ed * h)

4. Now, the EC3 Equation 5.2 for the elastic critical buckling load is:

αcr = HEd/VEd * h/δHEd

which, when re-expressed in the terminology used in H.2 becomes:

αcr = FH0Ed /NVEd * h/δHEd

and when further rearranged becomes:

1/αcr = (NVEd *δHEd)/(FH0Ed * h)

5. Hence 1/αcr can be substituted into the above equation for kamp so that we
arrive at the more well-known formula for amplification:

kamp = 1/(1 - 1/αcr)
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NOTE Strictly, the watershed for concrete structures should be at a kamp factor of 1.1
(amplification of no more than 10% due to second-order effects). Setting kamp
to be 1.1 and rearranging gives αcr ≥ 11 i.e. a stability coefficient ≤ 0.0909 not
0.1

NOTE It is important to note that the resulting values of αcr and kamp are very
dependent upon the analysis properties that are used and the you therefore
need to carefully consider the modification factors you choose to apply via the
Analysis Options.

Use of modification factors
The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. Consequently design codes can require that analysis stiffness
adjustment factors are applied (as the appropriate properties to use in
analysis are load and time dependent).

These modification factors can be applied for each of the different materials
from the Modification Factors page of the Analysis Options dialog. (which is
located on the Analyse toolbar).

For non-concrete members it is also possible that you will want to apply an
adjustment to material properties for various other investigations. One
suggested example is the assessment of structures subject to corrosion.
Another classic requirement in this regard relates to torsion, it is common
engineering practice to assume that if it will work without assuming any
torsional strength, then torsion can be ignored.

Allowing for global imperfections
These are typically represented by the application of Notional Loads \
Equivalent Horizontal Forces.

Allowing for global imperfections (ACI/AISC)
Steel code

Steelwork design to AISC 360-10 requires an allowance for global
imperfections. Columns are assumed to be out of plumb by some amount and
this is replicated by applying Notional Loads, (NL), in the analysis. The
requirements are given in Clause C2.2b and the value of NL is given as 0.2%.
However, to accommodate the requirements of Clause C2.3 an additional 0.1%
has been included - so that the actual NL used is 0.3%.
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Concrete code

For concrete design to ACI 318-11 there are no requirements. However, given
that a building can use mixed materials, (and even for an entirely concrete
building), you have the choice to include the NLs via the combinations. By
default these are to the AISC requirements - i.e. 0.3%

Allowing for global imperfections (Eurocode)
The formula to calculate the global imperfections (using EHFs) is the same for
both steel and concrete, see : EC2 Cl 5.3.2 (3) a) and EC3 Cl 5.2 (5)

φ = φ0 αh αm

Where:

φ0 is the basic value of inclination.

αh is the reduction factor for length or height : αh= 2/√h ; 2/3 ≤ αh ≤ 1

h is the length or height of the structure.

When height = 9m the maximum reduction of 2/3 will apply.

αm is the reduction factor for number of members (EC2) or columns in a row
(EC3), : αm= √(0.5(1+1/m))

m is the number of vertical members contributing to the total effect (EC2), or is
the number of columns in a row including only those columns which carry a
vertical load not less than 50% of the average value of the column in the plane
considered (EC3).

m = 1 5 10 1000
αm = 1 0.775 0.742 0.707

Guidance on how to count 'm' is vague and varied - however as demonstrated
above, once you get above 5 or 10 it starts to make very little difference.

In Tekla Structural Designer the allowance is applied in the same manner for
steel and concrete - being controlled in Model Settings as shown below:

Engineers Handbooks 1150 Stability and imperfections handbook



It does require some user intervention to provide structure height and
number of columns to consider. These user inputs cause adjustment of the
default value of imperfection of 0.5% of the vertical load and this can be a
different adjustment in the two orthogonal directions (Direction 1 and
Direction 2). For example, the adjustment factor might give an EHF of 0.4% in
the X-direction and 0.3% in the Y-direction.

Allowing for global imperfections (BS)
Steel code

BS5950 requires up to 0.5% of vertical loading.

Concrete code

BS8110 does not have a requirement (minimum lateral load is not the same
thing).

Allowing for member imperfections

Allowing for member imperfections (ACI/AISC)
Steel code

AISC indicates that these are inherently catered for in the strut design.

Concrete code

For concrete design to ACI 318-11 there are no requirements.
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Allowing for member imperfections (Eurocode)
Steel code

For steel structures designed to EC3, member imperfections are intrinsically
included in the design routines for all members (beams, columns, braces).
Apart from one explicit requirement, carrying out the design is all that is
necessary.

The explicit requirement is from Clause 5.3.2 (6) in which member
imperfection should be included as part of the analysis when the frame is
sway sensitive and the axial force in members with moment connections is
above a certain limit. If this situation arises Tekla Structural Designer issues a
warning.

Concrete code

For concrete structures designed to EC2, explicit calculations which consider
an imperfection effect are carried out as part of the design.

In Tekla Structural Designer this is achieved by adding an additional moment
to the analysis results before starting design.

Allowing for member imperfections (BS)
Steel code

BS5950 inherently caters for member imperfections in the strut design curves.

Concrete code

BS8110 does not have a requirement (minimum eccentricity is not the same
thing).

The sway check

NOTE The sway check is not relevant to models that use the ACI/AISC head code.

By default the sway check is applied to all columns (of all materials), and all
walls.

Sway check design options
In Design Settings > Sway & Drift Checks, there is a Merge short stacks
option (default Off) that applies to the check as follows:

• With the setting Off, the check considers all stacks of all columns/walls
apart from those that have been manually excluded.

• With the setting On, any stacks that are less than the limit specified are
merged with the stack below, and the check is performed on the merged
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stack length. The check is not performed on single stack columns/walls that
are less than this limit

Manually exclude an entire column or wall or an individual column
stack or wall panel from the check
An entire column/wall can be excluded from the check by unselecting Sway/
Seismic drift checks located under All stacks/panels>Sway and drift checks in
the column/wall properties window.

Similarly an individual stack/panel can be excluded from the check by
unselecting Sway/Seismic drift checks located under Sway and drift checks
for the specific stack/panel in the column/wall properties window.

Manually adjust automatically determined stack lengths
Columns are divided into stacks and walls are divided into panels at floor
levels where members or slabs connect to the column/wall. For the purposes
of Sway/Drift, Wind Drift and Seismic Drift checks only you can override the
default stack/panel divisions by merging a stack/panel with a lower stack/
panel. The length of the combined stack/panel is then used in the checks.

In order to do this you would have to select Merge with stack below located
under Sway and Drift Checks for the specific stack/panel in the column/wall
properties window.

Perform sway checks
The checks are performed either by running Analyse All (Static) from the
Analyse ribbon, or by running any of the Design (Gravity), or Design (Static)
commands from the Design ribbon.

NOTE For non-linear models with Tension Only bracing it is essential that the 'X
Brace' pattern is used to input the braces as brace pairs rather than creating
them individually. For linear analysis one of the braces in a brace pair is
automatically inactivated, ensuring that the model's lateral stiffness, and
hence lateral drift, is reasonably correct. If braces are input individually this
will not be the case.

For those stacks to which the check has been applied, the storey drift in each
direction (i.e. the difference between top and bottom deflection of the stack) is
calculated, and from this the elastic critical load factor is determined.

Review sway checks
For those stacks to which the check has been applied the elastic critical load
factor is calculated in both directions, and the building's overall sway check
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status is displayed in the Design branch of the Status Tree in the Project
Workspace.

• Any column in this branch with a warning status can be double clicked on
in order to highlight it in amber in the current view.

• Double click on the Sway main heading in order to highlight all columns
with warnings in amber

NOTE Sway warnings remain highlighted in the current view until you press Esc to
clear the highlight.

In addition to viewing the summary in the Project Workspace, the sway checks
can be interrogated in a variety of ways:

• To display sway values on the structure, see Display sway drift and story
shear (page 676)

• To review/modify the checks graphically, see Review and modify sway
checks (page 893)

• To review the detailed checks in a table, see Review sway check tabular
results (page 900)

Report sway checks
If required, the sway results table can be included in printed output by adding
the Analysis>Sway chapter to your model report.

The drift check

NOTE The drift check is only relevant to models that use the ACI/AISC head
code.

By default the drift check is applied to all columns (of all materials), and all
walls.

Drift check design options
In Design Settings > Drift Checks, there is a Merge short stacks option
(default Off) that applies to the check as follows:

• With the setting Off, the check considers all stacks of all columns/walls
apart from those that have been manually excluded.

• With the setting On, any stacks that are less than the limit specified are
merged with the stack below, and the check is performed on the merged
stack length. The check is not performed on single stack columns/walls that
are less than this limit.
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Manually exclude an entire column or wall or an individual column
stack or wall panel from the check
An entire column/wall can be excluded from the check by unselecting Drift/
Seismic drift checks located under All stacks/panels>Drift Checks in the
column/wall properties window.

Similarly an individual stack/panel can be excluded from the check by
unselecting Drift/Seismic drift checks located under Drift Checks for the
specific stack/panel in the column/wall properties window.

Manually adjust automatically determined stack lengths
Columns are divided into stacks and walls are divided into panels at floor
levels where members or slabs connect to the column/wall. For the purposes
of Sway/Drift, Wind Drift and Seismic Drift checks only you can override the
default stack/panel divisions by merging a stack/panel with a lower stack/
panel. The length of the combined stack/panel is then used in the checks.

In order to do this you would have to select Merge with stack below located
under Drift Checks for the specific stack/panel in the column/wall properties
window.

Perform drift checks
The checks are performed either by running Analyze All (Static) from the
Analyze ribbon, or by running any of the Design (Gravity), or Design (Static)
commands from the Design ribbon.

NOTE For non-linear models with Tension Only bracing it is essential that the 'X
Brace' pattern is used to input the braces as brace pairs rather than creating
them individually. For linear analysis one of the braces in a brace pair is
automatically inactivated, ensuring that the model's lateral stiffness, and
hence lateral drift, is reasonably correct. If braces are input individually this
will not be the case.

For those stacks to which the check has been applied, the storey drift in each
direction (i.e. the difference between top and bottom deflection of the stack) is
calculated, and from this the stability coefficient is determined.

Review drift checks
The building's overall drift check status is then displayed in the Design branch
of the Status Tree in the Project Workspace.

• Any column in this branch with a warning status can be double clicked on
in order to highlight it in amber in the current view.

• Double click on the Drift main heading in order to highlight all columns
with warnings in amber
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NOTE Drift warnings remain highlighted in the current view until you press Esc to
clear the highlight.

In addition to viewing the summary in the Project Workspace, the drift checks
can be interrogated in a couple of ways:

• To review/modify the checks graphically, see Review and modify drift
checks (page 879)

• To review the detailed checks in a Review Data table, see Review drift check
tabular results (page 901)

In the Review Data table, for those stacks to which the check has been applied,
stability coefficients in both directions (RatioDir1,RatioDir2) are calculated as:

Stability coefficient = Δ2/Δ1

Where

Δ2= second order drift

Δ1= first order drift

A Warning status is displayed against any stack in which the ratio exceeds 1.71
and a Beyond Scope status is applied if it exceeds 2.85 (as this indicates the
structure lacks stiffness in whole or in part).

TIP If there are a lot of columns in the building - in order to quickly determine the
biggest coefficient in each direction, simply click the RatioDir1 header until the
columns are arranged in increasing order, then repeat for RatioDir2.

Stability coefficients can only be calculated accurately by performing a second
order analysis, however indicative values can still be displayed when only a
first order analysis has been performed. These are determined from the
column's elastic critical load factor, λ:

(Δ2/Δ1) = 1/(1- 1/λ)

Approximate second order drift:

Δ2= Δ1/(1- 1/λ)

Report drift checks
If required, the drift results table can be included in printed output by adding
the Analysis>Drift chapter to your model report.

The wind drift check
The Wind Drift check is performed during the structure static design and also
when any 3D analysis is run in isolation. If a sub-set of combinations are
considered for analysis then only those combinations are considered in the
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drift checks, (allowing engineers working on larger structures to investigate
and optimize the lateral load resisting systems more rapidly).

The check is performed for (wind) combinations using the combination SLS
(Service Level) factors - (which can be < 1.0).

By default the check is applied to all columns (of all materials) and all walls.

Wind drift check design options
In Design Settings > Sway & Drift Checks, there is a 'Check wind cases only'
option (default On) that applies to the check as follows:

• With the setting On, the Wind Drift check only considers the effects of the
wind load case(s) in wind combinations.

• With the setting Off, the check considers the effects of all load cases in
wind combinations (which would include drift induced by gravity loads).

On the same page of the Design Options there is also a Merge short stacks
option (default Off) that applies to the check as follows:

• With the setting Off, the check considers all stacks of all columns/walls
apart from those that have been manually excluded.

• With the setting On, any stacks that are less than the limit specified are
merged with the stack below, and the check is performed on the merged
stack length. The check is not performed on single stack columns/walls that
are less than this limit

Manually exclude an entire column or wall or an individual column
stack or wall panel from the check
An entire column/wall can be excluded from the check by unselecting Wind
Drift check located under All stacks/panels>Sway and Drift Checks in the
column/wall properties window.

Similarly an individual stack/panel can be excluded from the check by
unselecting Wind Drift check located under Sway and Drift Checks for the
specific stack/panel in the column/wall properties window.

Manually adjust the automatically determined stack lengths
Columns are divided into stacks and walls are divided into panels at floor
levels where members or slabs connect to the column/wall. For the purposes
of Sway/Drift, Wind Drift and Seismic Drift checks only you can override the
default stack/panel divisions by merging a stack/panel with a lower stack/
panel. The length of the combined stack/panel is then used in the checks.

In order to do this you would have to select Merge with stack below located
under Sway and Drift Checks for the specific stack/panel in the column/wall
properties window.
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Wind drift calculations
For those stacks to which the check has been applied, the lateral drift in each
direction (i.e. the difference between top and bottom deflection of the stack) is
determined for each wind load case and wind service combination. This drift is
then compared against a user-defined limit (the default is 1/300 of the story
height, in line with Eurocode 3 recommendations, but you are free to specify a
limit of your choice). Different limits can be applied to different stacks if
required.

The checks are performed using results from a 1st order linear analysis (with
no Reduced stiffness factor), which are generated by running any of the
Design (Gravity), or Design (Static) commands from the Design ribbon.

NOTE For non-linear models with Tension Only bracing it is essential that the 'X
Brace' pattern is used to input the braces as brace pairs rather than creating
them individually. For linear analysis one of the braces in a brace pair is
automatically inactivated, ensuring that the model's lateral stiffness, and
hence lateral drift, is reasonably correct. If braces are input individually this
will not be the case.

Review wind drift checks
Any stack failures are flagged in the Design - Wind Drift branch of the Status
Tree in the Project Workspace.

• Double clicking on a failing column in this list causes it to be highlighted in
red in the current view.

• Double clicking on the Wind Drift heading at the top of the list causes all
failing columns to be highlighted in red

NOTE Wind drift failures remain highlighted in the current view until you press Esc
to clear the highlight.

In addition to viewing the summary in the Project Workspace, the wind drift
checks can be interrogated in a variety of ways:

• To display wind drift values on the structure, see Display sway drift and
story shear (page 676)

• To review/modify the checks graphically, see Review and modify wind drift
checks (page 897)

• To review the detailed checks in a table, see Review wind drift check
tabular results (page 902)
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Report wind drift checks
If required, the wind drift results table can be included in printed output by
adding the Analysis> Wind Drift chapter to your model report.

NOTE The Wind Drift chapter has a Settings option that can be used to dramatically
reduce the number of report pages. By default all columns and walls are
output, but you can specify instead the most critical 'XX' columns and walls,
(where 'XX' is a number of your choice).

The same Settings option also allows you to choose between reporting only
the critcal stack/all stacks, and reporting only the critical combination/all
combinations.

The seismic drift check
Seismic drift is assessed on a floor to floor horizontal deflection basis and
there are limits for acceptability of a structure.

The building's overall seismic drift status is displayed in the Design branch of
the Status Tree in the Project Workspace.

Full details for all columns are presented in a table accessed from the Review
ribbon.

These details can be included in printed output by adding the Analysis>Seismic
Drift chapter to your model report.

Overall displacement
By expanding the Design branch of the Project Workspace Status Tree, you are
able to review the maximum positive and negative overall displacement
results from the 3D Analysis for both Strength and Service combinations.

Displacements can also be viewed graphically in the Results View by using the
buttons on the Deflections group.

13.3 Static analysis and design handbook

NOTE The aim of this handbook is describe the processes that occur when running
one of the combined analysis and design commands, i.e:

• Design Steel (Gravity), Design Concrete (Gravity), Design All (Gravity)

• Design Steel (Static), Design Concrete (Static), Design All (Static)
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You can find the following information in this handbook:

• Overview of the combined analysis and design processes (page 1160)

• 3D pre analysis processes (page 1166)

• 3D analysis (page 1173)

• Grillage chasedown analysis (page 1174)

• FE chasedown analysis (page 1174)

• Reasons for performing chasedown analyses (page 1175)

• Overview of stability requirements (page 1134)

• Member design stage of the combined analysis and design process...
(page 1182)

• Features of the three analysis types used for static design... (page 1184)

Overview of the combined analysis and design processes

Overview of Design Steel (Gravity)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.
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Process Description

4 Member
design
stage
(page 1182)

Steel members are designed or checked for active gravity
combinations only.

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.

Overview of Design Steel (Static)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

4 Member
design
stage
(page 1182)

Steel members are designed or checked for all active static
combinations.

5 Stability
checks

Sway (page 1152)/Drift (page 1154) checks and Wind Drift
(page 1156) checks are performed for all columns and walls,
(apart from any that have been manually excluded from the
check
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Overview of Design Concrete (Gravity)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.

4 FE
chasedown
analysis
(page 1174)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 1174)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.
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Process Description

6 Member
design
stage
(page 1182)

Concrete members and concrete walls are designed or
checked for active gravity combinations only.

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.

Overview of Design Concrete (Static)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.

4 FE
chasedown
analysis
(page 1174)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.
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Process Description

5 Grillage
chasedown
analysis
(page 1174)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 1182)

Concrete members and concrete walls are designed or
checked for active gravity combinations only.

7 Stability
checks

Sway (page 1152)/Drift (page 1154) checks and Wind Drift
(page 1156) checks are performed for all columns and walls,
(apart from any that have been manually excluded from the
check

Overview of Design All (Gravity)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model, with an
option to mesh floors.

4 FE
chasedown
analysis
(page 1174)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 1174)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
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Process Description

Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 1182)

All steel and concrete members and all concrete walls are
designed or checked for all active gravity combinations.

NOTE Concrete slab design is not performed

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.

7 Stability
checks

Sway (page 1152)/Drift (page 1154) checks and Wind Drift
(page 1156) checks are performed for all columns and walls,
(apart from any that have been manually excluded from the
check

Overview of Design All (Static)

St
e
p

Process Description

1 Model
validation
(page 512)

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 1166)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 1173)

A traditional frame analysis of the entire 3D model, with an
option to mesh floors.

4 FE
chasedown
analysis
(page 1174)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 1174)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
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Process Description

those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 1182)

All steel and concrete members and all concrete walls are
designed or checked for all active static combinations.

NOTE Concrete slab design is not performed

7 Stability
checks

Sway (page 1152)/Drift (page 1154) checks and Wind Drift
(page 1156) checks are performed for all columns and walls,
(apart from any that have been manually excluded from the
check

3D pre analysis processes
Pre-Analysis consists of a number of processes, such as:

• Decomposing slab and wall loads

• Preparing loadcases and combinations

• Meshing and diaphragms

• First-order gravity analysis

• Resolving vertical loads for application of global imperfections

• Generation of pattern loading

The actual pre-analysis processes performed will vary depending on the
specific model that has been defined.

Overview of slab load decomposition
Decomposition of slab loads on to supporting members is automatically
performed where necessary during pre-analysis.

Decomposition is not just performed for beam and slab models, the program
may also need to decompose flat slab loads onto supporting columns and
walls.

NOTE In Tekla Structural Designer the term "Decomposed Loads" refers to the
loading on beams, columns, and walls that comes from slabs
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Whether load decomposition is performed or not will depend on the analysis
model, the slab properties and the Mesh 2-way slabs in 3D Analysis setting
as follows:

Decomposi
tion

method
specified in

Slab
properties

3D Analysis and Grillage chasedown
models

FE chasedown
model

Two-way Mesh 2-way slabs in 3D Analysis option
not selected (default):

• loads on two-way slabs decomposed
prior to analysis

• it is not
necessary to
decompose
the loads on
two-way slabs
prior to
analysis

Mesh 2-way slabs in 3D Analysis option
selected:

• it is not necessary to decompose the
loads on two-way slabs prior to analysis

One-way • loads on two-way slabs decomposed
prior to analysis

• loads on two-
way slabs
decomposed
prior to
analysis

Potential Load Decomposition Methods

Traditionally a "tributary area" (sometimes called "yield line") loading approach
would have been adopted to determine the decomposed loads, but this has
limitations when dealing with complex geometry such as:

• Slabs not supported on all edges

• Complex panel shapes

• Panels with openings

Also the "tributary area" approach can only approximately handle point, line,
and patch loads (by converting them to area loads).

Because of these limitations the "tributary area" method is not used in Tekla
Structural Designer - instead a method referred to as FE Decomposition is
applied instead. This is based on finite element analysis.

FE Decomposition Model

The FE decomposition model can be demonstrated using the following two-
way slab on beams example.
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For this type of structure:

• A separate FE decomposition model is created for every floor (or sloped
plane).

• Beam column and wall nodes in each FE decomposition model (shown
selected in pink below) are all rigidly supported.
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• Each FE decomposition model is analysed and the reactions at the rigidly
supported nodes are turned back into VDLs along beams and walls, and point
loads on columns.

A Common Question

So if the slabs have to be meshed for the FE decomposition during pre-
analysis, why not do away with decomposition entirely and just mesh the slabs
when performing 3D analysis of the entire model instead?

Because this gives results that you don't like....

In the first run of the model below the slabs are left unmeshed, this requires
the loads on the two-way slabs to be FE decomposed prior to analysis. The
bending moments from the resulting 3D Analysis are as shown, (max hogging
-198, max sagging 165):
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The above results can be compared against a second run of the model in
which the 2-way slabs are set to be meshed in the 3D analysis. FE
decomposition is no longer required and the bending moments from the
resulting 3D Analysis are as shown, (max hogging -89, max sagging 82)
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In this second run, because the slabs are included in the 3D analysis model,
some of the load is being transferred directly to the supporting columns and
walls via the slabs themselves. While this is not wrong, it goes against the
engineer's expectation - which would be to design the beams on the basis that
they transfer all the load to the supporting members.

Overview of global imperfections
Equivalent notional horizontal loads are determined and applied during pre-
analysis to cater for global imperfections (additional second order effects due
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to the structure not being built plumb and square). These loads are also used
in seismic design to establish the base shears.

Following a first-order analysis of all gravity loadcases, the forces at the nodes
at the top/bottom of each column stack/wall panel are resolved vertically. A
proportion of the vertical load is determined which gives the value of the
horizontal load at each point. The proportion is code dependent.

These horizontal loads are applied to the nodes in a particular direction
(Direction 1 or Direction 2 or both) as specified in an individual design
combination.

Overview of load reductions
Live load reductions are established during pre-analysis for use in subsequent
column and wall design, and when the head code is set to ACI/AISC - beam
design also.

• For head codes other than ACI/AISC, the level of live load reduction to
consider for beams can be set manually in the beam properties. This is
especially useful for more economic design of transfer beams supporting a
number of floors.

Reductions are only applied to those live load cases that have had the
Reductions box checked in the Loading dialog.

The reduction percentage to be applied is specified in Model Settings. This
percentage can differ depending on the number of floors being supported.

NOTE Reductions are not applied to inclined columns (only vertical ones).

To cater for additional floors that are carried but that have not been included
in the model an Assume extra floors supported value can be specified in the
column and wall properties.

The methodology for live load reduction differs between national codes of
practice:

Head Code: EC or BS

Levels can be designated either as "to be" or "not to be" included in the
determination of the load reductions through Count floor as supported check
boxes for each level in the column and wall properties. This feature enables
what appears to be a roof to be counted as a floor, or conversely allows a
mezzanine floor to be excluded from the number of floors considered for any
particular column or wall. The moments from fixed ended beams framing into
a column or wall are never reduced.

Head Code: ACI/AISC

Before undertaking member design, Live and Roof Live loads are multiplied by
a reduction factor R for roof live loads and other live loads independently. This
reduced load is then used in combination to create design forces. The
reduction factor is related to the tributary area of load carried by the particular
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member and also the KLL factor, where KLL comes from Table 4-2 in ASCE7-05/
ASCE7-10.

Essentially:

• Interior and exterior cols (no cantilever slabs) KLL = 4

• Edge and interior beams (no cantilever slabs) KLL = 2

• Interior beams (with cantilever slabs) KLL = 2

• Cantilever beams KLL = 1

• Edge cols (with cantilever slabs) KLL = 3

• Corner cols (with cantilever slabs) KLL = 2

• Edge beams (with cantilever slabs) KLL = 1

As it is not possible to assess where cantilever slabs are and what they are
attached to - you are able to change the KLL factor for all column/wall stacks
and beam spans as required in the Properties Window.

The default settings are:

• Columns/walls = 4

• Beams = 2

• Cantilevers = 1

Head Code: AS

Before undertaking member design, imposed loads are multiplied by a
reduction factor ψa.

This reduced load is then used in combination to create design forces. The
reduction factor is related to the tributary area of load carried by the particular
member.

Overview of pattern loading
If combinations of pattern load exist then the pattern loading is automatically
generated prior to analysis. See: Manage load patterns (page 527)

3D analysis
A traditional frame analysis of the complete structure is always the first
analysis that Tekla Structural Designerperforms in any combined analysis and
design. This analysis generates a first set of results for the design of beams,
columns and walls.

First Order or Second Order Analysis?

You can control whether a first, or a second order 3D Analysis is run by making
the appropriate selection on the Analysis page of the Design Options dialog.
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The actual options that are presented will vary depending on the design code
being worked to.

Linear or Non Linear Analysis?

The choice of linear or non-linear analysis is made automatically:

• if the model has entirely linear properties a linear analysis is performed,

• else if any non-linear properties are detected a non-linear analysis is
performed.

Grillage chasedown analysis
We know from experience that 3D Analysis on its own does not give the gravity
results engineers have traditionally used or want - staged construction
analysis reduces but doesn't resolve this. Therefore, Design All (Static) will also
automatically undertake a grillage chasedown analysis provided concrete
members exist anywhere in the model (beams, columns, or walls).

The Solver Model used for Grillage Chasedown (page 725) emulates a
traditional analysis and establishes an alternative second set of design forces
for beams, columns and walls.

See also

Accounting for lateral loading in chasedown results (page 1182)

FE chasedown analysis
The Solver Model used for FE Chasedown (page 725) is generated as part of
the combined analysis and design process if the model contains flat slabs, or
two way spanning slabs on beams - the results from this analysis being
required for the design of these slabs.

By default the same results are also used to generate a third set of design
forces for the cast-in-place beams, columns and walls. (Whether the results
are used for this purpose is controlled by a setting under Design > Settings >
Concrete > Cast-in-place > Beam, Column, Wall > General Parameters).

A significant consideration when opting to design for the FE chasedown results
is that the slabs will tend to carry a significant proportion of the load direct to
the columns.

Consequently, for beam design in particular, it is unlikely that an FE
chasedown could result in a more critical set of design forces than would be
already catered for by the Grillage chasedown.

NOTE If duplicate levels have been specified in the Construction Levels dialog
separate sub models are created and analyzed for the source and every
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duplicate level. This ensures that the increasing load carried by the vertical
members in the lower sub models is catered for. In turn this can cause small
differences in the analysis results (and consequently the design) for these sub
models.

See also

Accounting for lateral loading in chasedown results (page 1182)

Reasons for performing chasedown analyses
As the 3D Analysis determines a set of design forces which can then be used
to design the members - why does Design (All) then carry on and do other
"Chasedown" analyses?

The answer relates to expectation of results - in particular with regard to the
following:

• Sway Effects under pure gravity loading

• Transfer beam designs

• Differential axial deformation
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Sway Effects under pure gravity loading
Consider this 8 storey model, when you click Design All, grillage and FE
chasedown solver models are created in addition to the 3D Analysis model.

The Identified end frame below is resisting the sway - the design moments
shown would be given by any analysis software.

It is an extreme example - but this result does not fit with traditional
engineering expectation
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The 3D Analysis results (below left) can be compared with those from Grillage
Chasedown (below right).
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The Grillage Chasedown results are more in line with expectation:

• -ve moment at LH end

• Similar moment profile at every level

Another example of why chasedown is wanted follows below....

Transfer beam designs
Focus on the transfer beam in the highlighted frame.

At first glance the results look ok, but lets look more closely...

The 3D Analysis results (below left) can be compared with those from Grillage
Chasedown (below right).

Engineers Handbooks 1178 Static analysis and design handbook



• 3D Analysis - frame deflects and loads are shared according to stiffness.

• Grillage chasedown - loads are collected floor by floor and then applied to
the transfer beam - much higher moment in the transfer beam. Once again
this is more in line with traditional expectation.

A third example of why chasedown is wanted follows below....

Differential axial deformation (axial shortening)
In this case a two span beam sits on walls at each end and a column in the
center.

3D Analysis Results:
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• Column is more highly stressed than walls and deflects downwards
shedding load back to the walls.

• You end up with completely different moment profiles on beams that
would traditionally be considered and designed as identical.

Grillage chasedown Results:
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• the sub-models at each level are almost identical and you get very similar
results over the height of the building.

Findings from the above examples
• Grillage chasedown emulates a more traditional design style where

continuous beams or sub-frames are considered in isolation.

• The 3 examples show where 3D Analysis gives results that are not liked
(based on traditional design expectation).

• But once you start to think about it you may conclude that actually, the 3D
Analysis result should not be ignored.
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• By running Design All each analysis type is performed and members are
simultaneously designed for each set of results.

NOTE Deliberately extreme examples have been used to illustrate these effects and
in real models the differences between the sets of results might not be as
dramatic.

Accounting for lateral loading in chasedown results
It is important to note that the chasedown analysis procedure is only valid for
gravity loads. The chasedown analysis results for any lateral loading case
(wind / EHF) or from the direct analysis of any combination that includes a
lateral loading case are not valid.

Therefore in order to generate the design forces mentioned above, the
chasedown analysis results are merged with the 3D building analysis
combination results as follows:

1. Start with the building analysis combination result

2. Identify all gravity cases used in the combination and the relevant load
factor

3. For each included gravity loadcase:

a. Subtract the 1st order linear building analysis result multiplied by the
relevant load factor

b. Add the chasedown result multiplied by the relevant load factor

4. For results with Imposed load reduction, subtract the relevant % of the
chasedown result for each reducible loadcase.

Following this procedure means that chasedown analysis of lateral loading
cases or combinations is not required.

NOTE This procedure is only applied to beam, column, and wall-line results, but not
to 2D nodal results. For this reason it is not possible to calculate or display 2D
element chasedown results for combinations that include lateral load cases.

See also

Select entities (page 350)

Member design stage of the combined analysis and design
process
The final step in the Design All (Static) process is member design for all
members for all available sets of design forces.

Steel Member Design Forces
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The 3D Analysis results are the only results set used in steel member design.

Concrete Member Design Forces

Up to three sets of analysis results will exist for concrete member design as
follows:

• 3D Analysis results will always be used to design all beams, columns and
walls.

• Grillage Chasedown results will exist for gravity loadcases if the model
contains any concrete beams, in which case they will also be used to design
all beams, columns and walls.

• FE Chasedown results for gravity loadcases will also exist if the model
contains 2-way spanning slabs.

Concrete beams can be designed for this set of results by checking the
'Design Beams for FE Chasedown analysis results' box under Design >
Design Options > Concrete > Beam > General Parameters

Columns and walls can also be designed for this set of results by checking
similar boxes on their respective General Parameters pages.

Reset Autodesign

On completion of your chosen design process, the original member design
mode assigned to each member can either be retained or updated. (For
example, you might typically reset auto-designed steel members into check
mode if they have a pass status.) The action that is taken is controlled via
Design Options > Autodesign.

Design Review
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On completion of the Design All (Static) process the Review View and Review
toolbar open automatically.

In this view a color coded version of the model is displayed so that the pass/
fail status and utilization ratio of each beam, column and wall can be reviewed
graphically. Various other parameters can also be graphically interrogated
and/or modified.

See also

Accounting for lateral loading in chasedown results (page 1182)

Features of the three analysis types used for static design
The following table can be used to compare the features of the three analysis
types used in the static design process.

Feature 3D Analysis Grillage
Chasedown

FE Chasedown

Examples / When
useful?

Gravity and
Lateral analysis
(Notional/Wind/
Seismic)

“Beam & Slab”
buildings

Flat slab and
“Beam & Slab”
buildings

Special Features • Pattern
loading

• Automatic EC2
sway
sensitivity
assessment
and sway
amplification

• Automatically
centralised
analysis wires
(improved
rigid offsets /
rigid zones)

• Option to
mesh slabs in
the 3D analysis

• Mimics
traditional
design
approach (sub-
frame analysis)

• Pattern
loading

• Mimics
traditional
design
approach
(isolated floor
analysis)

• Slab Pattern
loading

Benefits • Member
Design
considers sway
and
differential
axial

Member design
based on
traditional sub
frame is
considered
simultaneously

• Member
design based
on traditional
sub frame is
considered
simultaneously
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Feature 3D Analysis Grillage
Chasedown

FE Chasedown

deformation
effects.

• Caters for
slabs that
contribute to
the lateral load
resisting
system

with that for 3D
Analysis

with that for
3D Analysis

• Irregular slab
panel design
automatically
catered for

Analysis Model 3D model of
entire building:

• either meshed
2-way slabs,

• or, slab loads
decomposed
to beams

series of 3D sub
models:

• all column and
wall stacks
immediately
above and
below the sub-
model

• either meshed
2-way slabs,

• or, slab loads
decomposed
to beams

series of 3D sub
models:

• all column and
wall stacks
immediately
above and
below the sub-
model

• all 2-way slabs
meshed

Analysis Method Whole model in
one pass

Each sub model
sequentially from
top to bottom –
chasing member
loads down

Each sub model
sequentially from
top to bottom –
chasing member
loads down

Analysis Type • First order

• First order -
Kamp

• Second order -
P-D

First order First order

Supports External supports
as defined by the
user

Ends of members
above/below each
sub model are
automatically
supported

Ends of members
above/below each
sub model are
automatically
supported

Loading Gravity and
Lateral Loads

Gravity Loads only Gravity Loads only

Forces for design
RC Slab Yes– All Combs No forces Yes – All Gravity

load cases
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Feature 3D Analysis Grillage
Chasedown

FE Chasedown

RC Beam Yes– All Combs Yes – All Gravity
load cases

Optional – All
Gravity load cases

RC Column Yes– All Combs Yes – All Gravity
load cases

Optional – All
Gravity load cases

RC Wall Yes– All Combs Yes – All Gravity
load cases

Optional – All
Gravity load cases

Steel/Composite
Members

Yes – All Combs
except patterns

Not required Not required

Foundation
design

Yes – All Combs
except patterns

Yes – All Gravity
load cases

Yes – All Gravity
load cases

See also

3D analysis (page 1173)

Grillage chasedown analysis (page 1174)

FE chasedown analysis (page 1174)

Reasons for performing chasedown analyses (page 1175)

13.4 Seismic analysis and design handbook
You can find the following information in this handbook:

• Introduction to seismic analysis and design (page 1186)

• Limitations of Seismic Design (page 1194)

• Seismic force resisting systems (page 1196)

• Seismic design methods (page 1199)

See also

Apply seismic loads (page 577)

Introduction to seismic analysis and design
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Definitions
The actual method applied to a specific beam will depend upon whether it is
required to support sensitive finishes.

Various terms used in Tekla Structural Designer's seismic processes are
described below:

Code Spectra

The spectra specified in a country's loading and design codes for use in ELF
and RSA analysis.

Site Specific Spectra

User defined spectra for ELF and RSA which are required for locations which
use another country's loading and design codes where the code spectra are
not relevant.

Base Shear Combination

Also referred to as the Effective Seismic Weight Combination (ASCE7/UBC) or
the Seismic Inertia Combination (Eurocode). This combination is used for
modal analysis, and in the calculation of base shears, during the Seismic
Analysis Process. This combination is created and modified by the Seismic
Wizard only.

RSA Seismic Combinations

These combinations are created by the Combination Generator at the end of
the Seismic Wizard, but can also be modified in the standard Combination
dialog. They consist of 3 kinds of loadcases: Static, RSA Seismic and RSA
Torsion. The Base Shear Combination is not included in this category of
combination.

Static Loadcase

Standard loadcases, e.g. "Self weight - excluding slabs", "Dead", etc., and
derived cases for NHF/EHF, but no patterns.

RSA Seismic Loadcase

Two loadcases, i.e. "Seismic Dir1" and "Seismic Dir2", which cannot be edited.
These are created at the end of the Seismic Wizard. being derived from
information supplied in the Seismic Wizard and the results of the modal
analysis. No actual loads are available for graphical display.

RSA Torsion Loadcase

These cases can be generated by the Seismic Wizard and are regenerated
whenever RSA Seismic Combinations are modified.

Fundamental Period (T)

Separately for Dir 1 & Dir 2, this is either defined in the Seismic Wizard, (user
value or calculated), or determined in the modal analysis for the Base Shear
Combination.

Level Seismic Weight
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For each relevant level, this is the sum of the vertical forces in nodes on that
level, for the Base Shear Combination.

Effective Seismic Weight

This is the sum of the level seismic weights for all relevant levels for the Base
Shear Combination.

Seismic Base Shear

The base shear is calculated separately for Dir 1 & Dir 2, for the Base Shear
Combination.

NOTE In Tekla Structural Designer the base shear is displayed when you Review
story shear tabular results (page 900) for Cumulative Story Shear

Square root of Summation of Square (SRSS)

The SRSS formula for combining modes in RSA is as follows:

λ = Absolute value of combined "response"

λk = "response" value for Relevant Mode k

n = Number of Relevant Modes

Complete Quadratic Combination (CQC)

The CQC formula for combining modes in RSA is as follows:

λ = Absolute value of combined "response"

λi = "response" value for Relevant Mode i

λj = "response" value for Relevant Mode j

n = Number of Relevant Modes

ρij = Cross modal coefficient for i & j
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Cross Modal Coefficient

This co-efficient is used in the CQC method for combining modes in RSA.

ζ = modal damping ratio

IBC/ASCE assumed = 5% (ASCE Figs 22-1 to 6)

EC8 assumed = 5% where q accounts for the damping in various materials
being different to 5% (EC8 Cl 3.2.2.5)

IS codes the user can define the level of damping and this is accounted for in
the above equation.

β = Frequency ratio = ωi / ωj

ωi = Frequency for Relevant Mode i

ωj = Frequency for Relevant Mode j

Overview
All seismic codes work in a similar manner from the loading view point with
relatively minor differences in terminology and methodology.

It is worth noting at the start that seismic analysis determines a set of forces
for which it is expected (statistically) that if those forces are designed for and
other design precautions taken (additional seismic design) then in the event of
an earthquake the structure may well suffer extensive damage but will not
collapse and for some categories of building should actually remain
serviceable.

In Tekla Structural Designer a seismic wizard gathers all the information
together to setup the requirements for a seismic analysis.

From this information a number of things are determined:

• If working to ASCE7 - the seismic design category (SDC) for the building -
giving amongst other things the permissible type of analysis

• The Base Shear Combination to determine the seismic base shear in the
building

• The natural frequencies of the building in two horizontal directions

• The combination of the gravity and other lateral forces with the seismic
load cases

Earthquakes load a building by a random cyclic acceleration and deceleration
of the foundations. These are in both horizontal directions (Dir1 and Dir2) but
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can also be in a vertical direction too. This ground acceleration excites the
building in its natural and higher frequencies.

As a result if the building is:

• In an area of low seismic acceleration, low in height and poses limited risk
to life then a gross approximation can be used in analysis - assuming a % of
gravity loading is applied horizontally to the building to represent the
earthquake (US codes 1%, Australian codes 10%).

• In an area of moderate to low seismic acceleration, medium to low in
height and does not house a significant number of people - the
predominant mode excited is the 1st mode. An equivalent lateral force
(ELF) approximation can be used that applies static horizontal loading
distributed up the building to mimic the shape of the 1st mode of vibration
in a static analysis.

• Anything else, in an area of high acceleration, tall in height and could be
holding many people or be critical post-earthquake then a "more
representative" analysis method of Response Spectrum Analysis (RSA)
should be used. This analysis is based upon a modal analysis considering
all mode shapes in the two horizontal directions in which typically 90% of
the structure's mass is mobilized.

The results from the chosen method of seismic analysis are used in
combination with other gravity and lateral load cases to design both normal
members and those members in seismic force resisting systems (SFRS). These
latter members need additional design and detailing rules to ensure they
resist the seismic forces that they subjected to during an earthquake. If
working to ASCE7, the extent of these rules are determined by the SDC noted
above (the higher the demand, the ‘better’ the SFRS that will be required).

NOTE The additional design and detailing requirements of “seismic” design are only
supported in Tekla Structural Designer for the ACI/AISC and the Indian Head
Codes.

Seismic Wizard
In Tekla Structural Designer the Seismic Wizard sets up the information
required for seismic analysis - the main parameters to be input being:

• Ground acceleration - strength of the earthquake

• The Importance Level (or Importance Class) of the building - the use to
which the building is being put - typically

• I= very minor, farm and temporary buildings,

• II= general buildings occupied by people,

• III = buildings occupied by a large number of people

• IV = critical buildings with a post-disaster function eg hospitals, police
stations, fire stations and buildings along access route to them)
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• The ground conditions upon which the building is founded (typically Hard
Rock, Rock, Shallow soil, Deep Soil, Very Soft Soil)

• Building height - for low buildings the first mode is totally dominant in
taller buildings other modes become significant

• Plan and vertical irregularities in the building

From this input the Seismic Wizard determines the seismic design category for
ASCE7, and also the elastic design response spectrum to be used for the
building.

Additionally the Wizard sets up the Base Shear Combination - the combination
of loads likely to be acting on the building when the earthquake strikes.

Vertical and Horizontal Irregularities
There are typically 5 types of horizontal irregularity and 5 types of vertical
irregularity - all are defined to pick up structures that have lateral framing
systems and shapes in plan that will preclude the structure naturally
developing a simple first mode of vibration. Since this is a basic assumption of
ELF - the presence of these irregularities may preclude the use of ELF.

Torsion
When a structure's center of mass at a level does not align with the position of
the center of rigidity then torsion is introduced in the structure at that level
when an earthquake excites the structure. To account for this, there are three
types of torsion potentially applied to levels with non-flexible diaphragms
during a seismic analysis

• Inherent torsion - in a 3D analysis when the center of mass and center of
rigidity at a level do not align, this is taken account of automatically

• Accidental torsion - to allow for the "miss positioning" of loads in a
structure, an additional eccentricity of usually 5% of the structure's width in
all relevant directions - this is accounted for with a torsion load case in the
analysis

• Amplified accidental torsion - structures with certain SDCs and certain
horizontal irregularities require an amplified accidental torsion to allow for
extra effects

Modal Analysis
Using the Base Shear Combination, a modal analysis is run for two purposes:

• the natural frequencies of the building in two directions are determined to
assist with the calculation of the seismic base shear that in turn is used to
determine the distribution of applied loads up the building for an ELF
analysis
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• the frequencies and mode shapes of the building are determined that need
to be included in an RSA analysis so that typically 90% of the mass in the
building is mobilised during the RSA analysis

% of Gravity Load Method
The % of gravity load method is used as a means of a gross approximation of
the earthquake and is only used in situations where seismic effects are
considered to be low. This load case is combined with the relevant load factor
with other gravity and lateral load cases to determine the design forces and
moments to be considered in conventional design.

NOTE This method is not applicable when working to Eurocodes.

Equivalent Lateral Force Method
The ELF method assumes that the first mode shape is the predominant
response of the structure to the earthquake.

Based on the natural frequency and the Base Shear Combination, a total base
shear on the structure is determined and this is then set up as a series of
forces up the structure at each level (in the shape of an inverted triangle) and
these deflect the structure in an approximation to the shape of the first mode.

The resulting seismic load cases are combined with the correct combination
factors with the other gravity and lateral load cases in the seismic
combinations to give the design forces and moments which are used in both
the conventional design of all steel and concrete members, and the seismic
design of any steel or concrete members that have been identified as part of a
seismic force resisting system.

Response Spectrum Analysis Method
The RSA method uses a set of vibration modes that together ensure that the
mass participation is typically 90% in the structure in a particular direction.

The response of the structure is the combination of many modes that
correspond to the "harmonics". For each mode, a response is read from the
design spectrum, based on the modal frequency and the modal mass, and
they are then combined to provide an estimate of the total response of the
structure.

Combination methods include the following:

• Square root of Summation of Square (SRSS)

• Complete Quadratic Combination (CQC) - a method that is an
improvement on SRSS for closely spaced modes

As a result of the combination methods (SRSS and CQC), the resulting seismic
load cases are without sign and so they are applied with the correct
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combination factors both + and - around the "static" results of the other
gravity and lateral load cases in the seismic combinations to give the design
forces and moments which are used in both the conventional design of all
steel and concrete members, and the seismic design of any steel or concrete
members that have been identified as part of a seismic force resisting system.

Summary of RSA Seismic Analysis Processes

RSA Seismic Analysis (1st or 2nd order) is run as a stand-alone analysis from
the Analyze tab, or as part of the Design (RSA) process. In the latter, the use of
1st order or 2nd order is set for the static analysis is set via Design Settings >
Analysis.

The process consists of the following steps:

St
ep

Process Description

1 Model
Validation

Run to detect any design issues which might exist.

This is similar to standard model validation but also
checks:

• Base Shear Combination must exist

• At least one RSA Seismic Combination must exist
including at least one RSA Seismic Loadcase.

2 Modal
Analysis

A 1st order modal analysis for the Seismic Inertia
Combination only, which returns the standard results for
that analysis type, but also the fundamental periods for
directions 1 & 2.

3 Pre-Analysis
for Seismic

Performs calculations for RSA Torsion Loadcases.

The seismic weight and seismic torque are both
calculated at this stage.

4 Static Analysis 1st Order Linear or 2nd Order Linear analysis is
performed for all RSA Seismic Combinations and all their
relevant loadcases, i.e. this includes Static Loadcases, but
does not include RSA Seismic and RSA Torsion
Loadcases.

5 RSA Analysis A set of results is generated for a sub-set of vibration
modes for each RSA Seismic Loadcase.

6 Accidental
Torsion
Analysis

Analysis of any RSA Torsion Loadcases that exist.
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Seismic Drift
Seismic drift is assessed on a floor to floor horizontal deflection basis and
there are limits for acceptability of a structure.

When working to the ASCE7 code, the engineer can directly define the shear
demand / capacity ratio (beta) for columns and walls. The default value of 1.0
could be over-conservative. This option is located in the “Seismic” group of
member properties, and can be set separately for 'Direction 1' and 'Direction
2' and for each stack/panel, as shown in the picture below.

• The setting is applicable to all years of the ASCE7 code and has the
following default and limits: Default = 1; Min = 0.001; Max = 10.

The building's overall seismic drift status is displayed in the Design branch of
the Status Tree in the Project Workspace.

Full details for all columns are presented in a table accessed from the Review
ribbon.

These details can be included in printed output by adding the Analysis>Seismic
Drift chapter to your model report.

Design Coefficients and Factors (ASCE7/UBC)
Typically three factors are determined based on the lateral force resisting
systems in the structure and which account approximately for the inelastic
response that occurs during the earthquake which is not accounted for
directly in the analysis.

• The response modification coefficient which affects the seismic base shear.

• The overstrength factor accounts for the reinforcement steel yielding
overstrength and is utilized in the concrete beam and column capacity
calculations.

• The deflection amplification factor which is used in the calculation of
seismic drift.
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Limitations of Seismic Design
The following limitations apply:

• Where seismic design and detailing is required this is only supported in
Tekla Structural Designer for the ACI/AISC and Indian Head Codes.

• It is up to the user to assess whether framing is split horizontally or
vertically, whether system specific requirements need to be assessed - like
mixed system moment frames, whether diaphragms are rigid or flexible -
in all instances, the user will need to make the necessary adjustments for
the situation in hand. The software does not handle these situations
automatically.

• Linear modal analysis with non-linear element properties - currently the
modal analysis is limited to a linear model so all non-linear elements are
set to be linear.

• ELF can be run as 1st or 2nd order analyses, however if the Fundamental
Period is determined using modal analysis the modal analysis is always run
as 1st order.

• The RSA analysis itself is a 1st order linear process. For the 2nd Order RSA
Seismic analysis, the peak responses are enveloped around the static
results for 2nd Order Linear Analysis. Thus when the analysis is set to 2nd
order in Design Options, in real terms the results are actually RSA Seismic +
2nd Order.

• Structures with linear members and supports are run using linear analyses.
Structures with non-linear supports and /or members are run as non-linear
in ELF but linear in modal and RSA.

• We do not consider any of the standard methods for structurally
accommodating seismic actions - e.g. base isolators, damping systems

• We do not consider more accurate methods of analysis like time history
analysis. As a result there are some situations with very tall buildings and
very irregular buildings that Tekla Structural Designer does not cater for.

• Diaphragms - rigid and semi-rigid diaphragms (meshed floors) are available
and it is the user's responsibility to ensure they are modelled suitably. Rigid
diaphragms are only allowed in limited circumstances and, so called,
'flexible diaphragms' can be modelled as semi-rigid diaphragms with
extremely low stiffness. Force transfer into and out of the diaphragm is not
checked.

• Collector elements - no checks included.

• Non-structural elements - no checks included.

Specific limitations of steel seismic design

• Coincident V & A braces giving X type are beyond scope

• Various other requirements not checked

• e.g. V & A braces are restrained at their intersection
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• e.g. tension braces resist between 30% and 70% of total horizontal force

• e.g. forces in restraining members not checked

• Connections are not designed

A specific limitation of RC seismic design

• While checks can be done in both directions they are direction specific
where applicable - there are no biaxial checks.

Seismic force resisting systems

Available SFRS types
The seismic design requirements for a particular member are based upon
which Seismic Force Resisting System (SFRS) the member forms part. Hence, in
Tekla Structural Designer you can set appropriate members as part of one of
the following systems:

SFRS types included for steel members

Moment Frame Systems

• Special Moment Frames (SMF)

• Intermediate Moment Frames (IMF)

• Ordinary Moment Frames (OMF)

Braced Frame and Shear Wall Systems

• Ordinary Concentrically Braced Frames (OCBF)

• Special Concentrically Braced Frames (SCBF)

• Special Concentrically Braced Frames (SCBF)

Other Seismic Frame Type

• Not specified - this is a 'catch all' for all other types- but no seismic design
performed.

SFRS types available for concrete members

Moment Frame Systems

• Special Moment Frames (SMF) - limited design.

• Intermediate Moment Frames (IMF)

• Ordinary Moment Frames (OMF)

Walls

• Special reinforced concrete structural wall - limited design

• Intermediate precast structural wall - no seismic design performed
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• Ordinary reinforced concrete structural wall

Other Seismic Frame Type

• Not specified - this is a 'catch all' for all other types- but no seismic design
performed.

SFRS types excluded

Everything else

• e.g. Eccentrically Braced Frames

Members allowed in the SFRS
The following member types are allowed to be part of a SFRS in Tekla
Structural Designer

• Steel columns

• Steel beams

• Steel braces

• Concrete columns

• Concrete beams

• Concrete walls

The following member types are not allowed to be part of a SFRS in Tekla
Structural Designer

• Any timber, cold-formed, general

• All other “Characteristics”, e.g. steel joists, truss members, purlins

• Composite members

• Plated, Westok, Fabsec, concrete filled, concrete encased – selectable but
no design (i.e. only rolled)

Assigning members to the SFRS
The choice of members to be part of a SFRS is entirely the engineer’s
responsibility.

• It is expected that all members in a frame are assigned to the SFRS.

• The assigned members should be specified to act in building Direction 1 or
Direction 2

Special Moment Frames - assigning connection types at steel beam
ends
For SFRS comprising of steel SMF it is necessary to ensure that the beams fail
before the columns. To this end, an assessment of plastic moment capacity is
made at each floor. The moment capacity is dependent upon the position of
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the plastic hinge, typically (dcol + dbeam)/2. These locations can be selected
appropriate to each beam end either in the beam properties.

Options are provided as follows:

• Plastic hinge position at start

• Plastic hinge position at end

Either, (dcol + dbeam)/2 (default)

or, dcol /2 + L

L = 0 (default)

Validation of the SFRS
There is only a small amount of validity checking for an SFRS that can be
performed automatically; it remains in large part the user’s responsibility to
ensure that each SFRS is defined appropriately.

The following validation conditions are however detected:

1. Any A or V brace in a Seismic Force Resisting System must have the A or V
as vertically released. A warning is provided in validation if this is not the
case.

2. X type bracing is defined as more than one V or inverted V (A) type brace
pair on the beam. When more than one A or V brace pair is detected, the
additional checks required by AISC 341-05 and AISC 341-10 given in
Section 8.3 are out of scope. This situation is not detected during
validation, but it is identified in the seismic design, so that the beam is
given a “beyond scope” status.

3. The use of K braces is not allowed in AISC 341. An error is provided in
validation.

4. Tension only braces were permitted to the 05 version but had no
additional requirements. In the 10 version they are only are allowed for
OCBF. Thus, an error is provided in validation when a tension only brace is
set as part of a SCBF and the code is the 10 version. (The same validation
is also applied to compression only braces.)

5. If seismic loadcases are included in combinations and there is not at least
one member assigned to each of Direction 1 and Direction 2 then a
warning is issued.

Auto design of SFRS members
All SFRS members can be auto-designed to the conventional design
requirements both for seismic and non-seismic combinations;

During the automatic design procedure, besides the conventional auto-design,
and for seismic combination results only:
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• Steel members in the SFRS are checked for seismic provisions;

• Normal weight reinforced concrete members in the SFRS are auto-
designed for seismic provisions

Seismic design methods
To design members and walls for the results of a seismic analysis:

• For geographic regions categorised as “low seismicity” it is acceptable to
assume “ductility class low” applies. Under these conditions the seismic
analysis results can be fed into “conventional” design, see Seismic analysis
and conventional design (page 1199)

• Certain conditions (e.g. “high seismicity”) necessitate that a “seismic” design
is performed - additional design and detailing requirements have to be
applied in this situation, see Seismic analysis and seismic design
(page 1200)

NOTE The additional design and detailing requirements of “seismic”
design are only supported in Tekla Structural Designer for the ACI/
AISC and the Indian Head Codes.

Seismic analysis and conventional design

ELF seismic analysis and conventional design

The overall modelling, analysis and conventional design process using the ELF
method is summarised as follows:

1. Modelling

• No additional seismic modelling requirements

• There is no need to assign members to a SFRS

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if required

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select ELF method of analysis (note some vertical or horizontal
irregularities can prevent the use of this method

d. Set up the relevant seismic combinations

3. Static Design

Run the Design (Static):
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• the results of the ELF seismic combinations are fed into the design and
considered in the same way as other combinations.

4. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

RSA seismic analysis and conventional design

The overall modelling, analysis and conventional design process using the RSA
method is summarised as follows:

1. Modelling

• No additional seismic modelling requirements

• There is no need to assign members to a SFRS

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select RSA method of analysis

d. Set up the relevant seismic combinations

3. Static Design

Run the Design (Static):

• Results of the static combinations are fed into conventional design.

4. RSA Seismic Design

Run the Design (RSA):

• Results of the RSA seismic combinations are fed into conventional
design and considered in the same way as the static combinations.

• No additional seismic design is required

5. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

See also

Seismic wizard in detail (page 579)

Seismic analysis and design handbook (page 1186)
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Seismic analysis and seismic design

NOTE The additional design and detailing requirements of “seismic” design are only
supported in Tekla Structural Designer for the ACI/AISC and the Indian Head
Codes.

These requirements vary depending upon the 'sophistication' of the SFRS. For
example OMF have less stringent requirements than SMF.

ELF seismic analysis and seismic design

The overall modelling, analysis and seismic design process using the ELF
method is summarised as follows:

1. Modelling

Identify the primary seismic members, i.e. those members that are part of
the seismic force resisting system, and assign them an SFRS direction and
SFRS type.

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select ELF method of analysis (note some vertical or horizontal
irregularities can prevent the use of this method.

d. Set up a modal mass combination

e. Set up the relevant seismic combinations

3. Static Design

Run Design (Static) to:

a. Conventionally design all members for all non-seismic (gravity and
lateral) combinations

b. Conventionally design all members for all seismic combinations in the
same way as the other combinations.

c. Perform additional seismic design for the seismic combinations for
those members assigned to a SFRS

4. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked
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RSA seismic analysis and seismic design

The overall modelling, analysis and seismic design process using the RSA
method is summarised as follows:

1. Modelling

Identify the primary seismic members, i.e. those members that are part of
the seismic force resisting system, and assign them an SFRS direction and
SFRS type. These members will be designed and detailed according to the
seismic provisions.

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select RSA method of analysis

d. Set up a modal mass combination

e. Set up the relevant seismic RSA combinations

3. Static Design

Run the Design (Static) to:

• Conventionally design all members for all non-seismic (gravity and
lateral) combinations .

4. Modal Analysis

At this point it is recommended that you run a 1st order modal analysis in
order to confirm the model converges on a solution, (until it is able to do
so, it is pointless proceeding with a full RSA Seismic Design).

5. RSA Seismic Design

Run the Design (RSA) to:

a. Conventionally design all members for all RSA seismic combinations
in the same way as the other combinations.

b. Perform additional seismic design for the RSA seismic combinations
for those members assigned to a SFRS

6. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

See also

Seismic wizard in detail (page 579)

Seismic analysis and design handbook (page 1186)
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13.5 Steel member design handbook
To get started with designing steel structures in Tekla Structural Designer see:

• Combined analysis and design choices for steel structures (page 1203)

• Steel member autodesign (page 1205)

• Steel member design groups (page 1206)

• Steel beam design (page 1208)

• Composite beam design (page 1224)

• Steel column design (page 1249)

• Steel brace design (page 1262)

• Steel joist design (page 1265)

• Steel truss design (page 1270)

• Portal frame design (page 1274)

Combined analysis and design choices for steel structures

Gravity design
For many steel structures a separate gravity design is not necessary and you
can simply proceed directly to a Static design (page 1204).

In some circumstances however, you may find it preferable to adopt a two-
stage workflow in which gravity members are sized prior to the full design.

The benefits of this are:

• For larger models it can significantly speed up the analysis and design time

• If lateral resisting systems are not modeled, then mechanisms can result
and the analysis may not find a solution. Since these lateral resisting
systems are perhaps unknown early in the project (or insufficient systems
have been provided), running a gravity design has the added benefit of
automatically fixing column nodes (not attached to a diaphragm)
horizontally, which stabilizes the model.

The gravity design stage enables you to design all members (and hence size
those members with the Autodesign property checked), for only the active
gravity combinations (this will include the Construction Stage combination). As
an example, beams within a rigid floor diaphragm are unaffected by lateral
load, and hence they can be sized using only the gravity combinations.

Gravity design is initiated by clicking Design Steel (Gravity).
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After the gravity design has been completed, by default all steel members are
reset to check design mode.

You may then decide to reset certain members to auto design e.g. columns
and beams in 'moment frames', columns and braces in vertical or horizontal
braced bays. In such cases, when the full static design is performed member
'pre-sizing' will take place and for members resisting lateral loads the new
section size will be used if it is larger than that which resulted from the gravity
design.

Static design
Full static design is initiated by clicking Design Steel (Static) or Design All
(Static) on the Design toolbar.

All beams, columns and braces that do not have the Gravity only property
checked, are designed or checked for all active combinations; Gravity only
design members are designed or checked for the active gravity combinations
only.

As part of the full design process a 3D Analysis is performed, for which you
must select (via Design Options) the analysis type. The choice of analysis type
will depend on the code being designed to.

Designing individual members for gravity only
By default, when a full static design is run, all members are designed for both
gravity and lateral combinations.

You can however tell Tekla Structural Designer to only consider gravity
combinations for the design of specific members. This is achieved by checking
Gravity only in an individual member's properties, i.e.

• Gravity only checked - designed for gravity combinations only

• Gravity only unchecked - designed for all combinations types: gravity,
lateral and seismic

Setting columns that do not help resist lateral loads to be designed for gravity
loads only, will reduce the overall design time.

Engineering judgement will be required when identifying members as being
'gravity only'.

For example:

• if an inclined braced member connects to a beam, axial force in the brace
(from both gravity and lateral loads) puts the beam into bending and
therefore the beam should be designed for both gravity and lateral loads.

• potentially, beams in a sloping roof would also need to be designed for
both gravity and lateral load

Engineers Handbooks 1204 Steel member design handbook



NOTE If a composite beam is identified as being designed for both gravity and
lateral combinations, they are only designed for gravity loads acting through
the web only. Minor axis bending and axial loads are not considered. Hence a
warning is provided, if the ignored loads exceed a preset limit.

Steel member autodesign
The design mode for each member is specified in its properties.

• When Autodesign is not selected (i.e. check mode), you assign your
desired section size to the member and Tekla Structural Designer
determines if the section is sufficient.

• When Autodesign is selected the section type to be used is specified from
a Design Section Order and Tekla Structural Designer attempts to
automatically determine a suitable section.

The following controls can be applied to further limit the sections
considered:

• Size constraints (page 1205)

• Design section orders (page 1006)

NOTE If a member type has been set to be designed using Design groups,
then if at least one member of the group is set to autodesign, the
whole group will be automatically designed.

Size constraints
When undertaking an Autodesign, the Size Constraints property allows you to
ensure that the sections proposed by Tekla Structural Designer match any
particular size constraints you may have.

For instance:

• Minimum width - you may want to ensure a minimum flange width to
satisfy bearing requirements for any supported beams. To achieve this, you
would enter a value as the Minimum width, and Tekla Structural Designer
would not consider sections with flanges less than the specified minimum
width for the design of the beam.

• Maximum depth - you may want to ensure that the maximum beam depth
is specified to ensure that it fits within a floor zone. To achieve this, you
would enter a value as the Maximum depth and Tekla Structural Designer
would not consider sections with depths greater than the specified value
for the design of the beam.
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• Max span/depth ratio (beams only) - you may want to set a max span/
depth ratio limit above which autodesign will reject sections that are of
insufficient depth.

• The depth is taken as the depth from the section properties - for single
and double angles this is the vertical leg length.

• Limit is not applied to any member which has rotation.

NOTE Size constraints only work when undertaking an Autodesign

Applying a size constraint to an element
You can control which sections in a design order list are considered, by
following the procedure below.

1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand All spans/stacks or the individual span/stack as required to reveal
Size Constraints

3. Expand Size Constraints and set the Max depth, Min depth, Max width,
Min width, or Apply max/span/depth ratio as required.

When an Autodesign is performed, the section selected from the section
order list will fall within any size constraint limits set.

Steel member design groups

Why use steel design groups?
Steel members are not automatically placed into design groups. They are
however, automatically put into groups, primarily for editing purposes. In this
way, individual groups can be selected and displayed graphically so that their
properties can be changed as a group in the properties window.

If required, grouping can also (optionally) be utilized in order to design steel
member types according to their groups.

In order to use grouping for this second purpose, you should first ensure that
your groups are configured so that each group only contains those members
that you intend to eventually have the same section size applied.

NOTE Grouped design is optional and can be activated if required, via Design
Options> Design Groups

NOTE A fixed set of rules are initially used to determine the automatic member
grouping: for example beams are designated as either direction 1 or
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direction 2, are of a similar span, material grade and construction type,
columns have the same number of stacks etc. You can manually edit
groups.

What happens in the group design process?
When the option to design a specific steel member type using groups is
checked, for that member type:

• In each design group the first member to be designed is selected
arbitrarily. A full design is carried out on this member and the section size
so obtained is copied to all other members in the group.

• These other members are then checked one by one to verify that the
section size is adequate for each and if this proves not to be the case, it is
increased as necessary and the revised section size is copied to all
members in the group.

• This process continues until all members in the group have been
satisfactorily checked.

• A final check design is then carried out on each group member. During this
process peak and individual utilizations are established.

NOTE When performing the design of a group of composite beams the changes in
section size may mean that for some beams the existing stud layout will no
longer remain adequate. To ensure the safe and rational design of the studs,
the stud design routine is re-run at the end of the group design for all beams
with the stud auto-layout active in the beam properties.

Steel design group requirements
Steel member design groups are formed according to the following rules:

Member type Design group rules
Steel beam • A beam element may only be in one design group

• All beam elements in the group must have the
same Construction/Fabrication i.e. Non-composite
Rolled,

• All beam elements in the group must have the
same material properties

Automatic grouping uses the following rules to
automatically generate the groups, however, when
manually editing the groups these are not enforced:

• All beam elements in the group are of a similar
span.
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Member type Design group rules
• All beam elements have a similar direction i.e.

beams are grouped as Direction 1 or 2 if they lie +/-
45 degrees to the directional axis

Steel column • A column element may only be in one design group

• All column elements in the group must have the
same Construction/Fabrication i.e. Non-composite
Rolled,

• All column elements in the group must have the
same material properties

• All column elements in the group must have the
same number of stacks

Group management
Automatic Grouping

Steel members are grouped automatically.

In Model Settings the user defined Maximum length variation is used to
control whether elements are sufficiently similar to be considered equivalent
for automatic grouping purposes.

Manual/Interactive Grouping

It is recommended that you manually edit the groups for steel members, since
members can be placed into any group without the need for similar span
lengths or directional requirements. For example, edge beams, primary
beams, secondary beams etc. could have different span length and directions,
and be placed into the same design group using manual editing.

NOTE A member can only be placed into a single design group.

To manually reassign a member to a different group, locate it in the Project
Workspace,Groups taband drag it to a different group

NOTE A cross will appear if the element does not meet the Group requirements.

Regroup ALL Model Members

If you have made changes in Design Options that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Steel beam design
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Click the following links to find out more:

• Steel beam overview (page 1209)

• Steel beam fabrication (page 1210)

• Steel beam restraints (page 1216)

• Deflection limits (page 1216)

• Camber (page 1217)

• Instability factor (page 1217)

• Beam web openings (page 1218)

• Steel beam torsion (page 1223)

Steel beam overview
Tekla Structural Designer will design steel beams for an international range of
doubly symmetric I-sections, C-sections, rectangular and square hollow
sections, single angles, double angles and tees for many different countries
and also for many specific manufacturers. Plated beam design is also available
for some head codes.

Steel beams are designed using a set of design forces obtained from 3D
Analysis. (Grillage Chasedown Analysis and FE Chasedown Analysis results are
not required.)

In addition to major axis bending, minor axis bending and axial loads are also
considered.

In its simplest form a steel non-composite beam can be a cantilever, or a
single member between supports to which it is pinned.

It can also be a continuous beam consisting of multiple members that do not,
with the exception of the remote ends, transfer moment to the rest of the
structure. Each span of a continuous beam can be of different section size,
type and grade.

At the remote ends of the beam there are a number of options for the end
fixity depending upon to what the end of the beam is connected. These are:

• Free end

• Moment connection

• Pin connection

• Fully fixed

• Partially fixed (% of 4EI/L)

• Partially fixed (linear spring)

The beam may have incoming beams providing restraint and may or may not
be continuously restrained over any length between restraints.
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Steel beam fabrication

Fabrication types summary - all head codes

The fabrication types that can be designed as non-composite steel beams in
Tekla Structural Designer are dependent on the design code.

Refer to the following table for details.

Rolled Plated Westok
cellular

Westok
plated

FABSEC DELTABEA
M

AISC Yes Yes No No No No
Eurocode Yes Yes Yes Yes No No
BS Yes Yes Yes Yes No No
IS Yes Yes No No No No
AS Yes Yes No Yes No No

Plated beams - AISC head code

When the Fabrication type is set to Plated, only Plated Beams can be
designed to the AISC 360-05, 360-10 and 360-16. While one plated section has
been provided as a default, you can define (and save) your own plated
sections by clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new design
section order can be created (page 1008) specifically for plated sections once
these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• Only parallel flange sections can be used.

Plated beams - Eurocode head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to Eurocodes. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for plated
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - BS head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to BS 5950. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for plated
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - Indian head code

When the Fabrication type is set to Plated, a range of steel compound sections
can be designed to the Indian design code.
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The section shapes supported are:

• Rolled Channels back to back

• Rolled Channels toe to toe

• Doubled rolled I sections

• Doubled rolled I sections with plates

The scope of design of these compound sections includes both beams and
columns and autodesign.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for
compound sections once these have been added to the sections
database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• High Shear case with minor axis moment is beyond scope.
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• Design of the lacing or battening system is beyond scope.

• Only parallel flange sections can be used.

Plated beams - Australian head code

When the Fabrication type is set to Plated, only welded doubly symmetric I-
section beams can be designed to the Australian code.

A pre-defined range of these is available from the Welded Beams page of the
Select Section dialog - these can be both checked and autodesigned.

NOTE Autodesign requires a Design section order to be specified, the Welded
Beams design section order is provided for this purpose.

While you can add to the range of welded beams the Select Section dialog by
clicking the Add... button, any such user-defined beams can only be analyzed,
but are not designed.

Plated beams available on other pages of the Select Section dialog can be
analyzed, but are not designed.
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Steel beam restraints
Each beam may have incoming beams providing restraint and may or may not
be continuously restrained over any length between restraints.

Conditions of restraint can be defined in- and out-of-plane for compression
(strut) buckling and top and bottom flange for lateral torsional buckling (LTB).
The effective lengths used in the buckling checks depend on the type of
restraint, particularly at supports.

In all cases, the program sets the default effective length to 1.0L, it does not
attempt to adjust the effective length (between supports for example) in any
way. You are expected to adjust the effective length factor (up or down) as
necessary. Any compression or LTB effective length can take the type
“Continuous” to indicate that it is continuously restrained over that length.

LTB and Compression restraints

LTB and Compression restraints are determined from the incoming members
described within the Tekla Structural Designer model.

The default assumption is that an incoming member connecting to either side
of the beam provides lateral restraint to the top flange only, and compression
restraint about the minor axis. An incoming member connecting from above
or below doesn't provide lateral restraint but provides compression restraint
about the major axis.

By right-clicking a member to edit its properties in the Property dialog, you are
then able to edit the restraints. You can indicate also continuously restrained
sub-beams and edit length factors.

Note that the same level of restraint editing is not provided in the Properties
Window (although it does allow you to independently set both the top and
bottom flanges as continuously restrained for the entire member length via
the Top/Bottom flange cont. rest. properties).

TIP As an alternative to using the Steel Beam Property dialog, restraint settings for
steel beams can be easily reviewed and adjusted graphically via Review View >
Show/ Alter State. For more details see: Review and modify restraints

Torsion restraints

Torsion restraints are currently displayed in the Property dialog for
information only. In design the beam is treated as unrestrained against
warping and restrained against torsion.

Continuously Restrained Flanges

In the Properties Window you can independently set both the top and bottom
flanges as continuously restrained. By setting ‘Top flange cont. rest.’ and/or
‘Bottom flange cont. rest.’ to ‘Yes’ the relevant buckling checks are not
performed during the design process.
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Deflection limits
Serviceability criteria often control the design of normal composite beams.
This is because they are usually designed to be as shallow as possible for a
given span.

Deflection Limits allow you to control the amount of deflection in both
composite beams and steel beams by applying either a relative or absolute
limit to the deflection under different loading conditions.

A typical application of these settings might be:

• not to apply any deflection limit to the slab loads, as this deflection can be
handled through camber,

• to apply the relative span/over limit for live load deflection, to meet code
requirements,

• possibly, to apply an absolute limit to the post composite deflection to
ensure the overall deflection is not too large.

Camber
Camber is primarily used to counteract the effects of dead load on the
deflection of a beam. This is particularly useful in long span composite
construction where the self-weight of the concrete is cambered out. It also
ensures little, if any, concrete over pour occurs when placing the concrete.

The amount of camber can be specified either:

• As a value

• As a proportion of span

• As a proportion of dead load deflection

• If this option is selected, the engineer should identify the combination
to be used for the calculations by selecting Camber adjacent to the
appropriate gravity combination on the Loading combination dialog
page.

• If no combination is selected then the first gravity combination in the
combination list is used.

In the latter case, if 100% of the dead load deflection is cambered out, it is also
possible to include a proportion of the live load deflection if required.

A lower limit can be set below which the calculated camber is not applied, this
ensures that impractical levels of camber are not specified.

Instability factor
Long members in a model that have axial force in them can be unstable
during second-order analysis because their individual elastic critical buckling
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load factor is lower than the elastic critical buckling load factor of the building
as a whole and is less than 1.0.

However, often such members, for example the rafters in a portal frame, are
stable in design because, for example, there are many smaller members or
sheeting, that restrain the member in reality. They fail in the analysis because
it is too resource intensive to model all the individual restraining members in
the model which would also add unwanted clutter.

To prevent or to reduce the incidence of such failures during the analysis a
multiplier can be applied to the minor axis inertia of these members which
caters for the effect of the restraining members.

This multiplier can be applied to steel beams, composite beams and steel
columns. It is defined in the properties window by selecting Prevent out of
plane instability and then entering a suitable value in the Instability factor
field.

NOTE This multiplier is applied to prevent unwanted behaviour in the analysis
model. While the analysis results may be affected by this adjustment, there is
no amplification of the minor axis inertia in the design of the member.

Beam web openings
You cannot currently automatically design sections with web openings, you
must perform the design first to get a section size, and then add and check the
openings. This gives you complete control of the design process, since you can
add appropriate and cost effective levels of stiffening if required, or can
choose a different beam with a stronger web in order to reduce or remove any
stiffening requirement.

When openings are added they can be defined as rectangular or circular and
can be stiffened on one, or on both sides.

Openings cannot be defined from the Properties Window, they can only be
defined from the Properties Dialog, (by right-clicking on the member and
selecting Edit...)

For guidance in relation to a specific head code, see:

• Beam web openings to AISC (page 1218)

• Beam web openings to SCI P355 (page 1219)

• Beam web openings to SCI P068 (page 1222)

Beam web openings to AISC

Web Opening design limitations

• Simple beams only (single span, pin ended). Although web openings can be
defined on multi-span beams design is beyond scope.

• Cantilevers are excluded.
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• Curved beams are excluded.

• Haunched and tapered members are excluded.

• Section type: rolled symmetrical compact I sections.

• Plated sections are excluded.

• Steel yield strength is limited to 65 ksi

• Web opening placement and sizes: Opening depth is limited to 70 percent
of beam depth. There are also two control parameters which dictate the
dimensions of the opening, one being the aspect ratio, ao/ho, of the
opening and the other being the opening parameter po. Both should meet
the required limits.

• Multiple openings. Checks are performed to ensure that openings are
spaced far enough apart so that design expressions for individual openings
may be used.

• Openings cannot be placed closer than the section height to a support.

• Openings can be defined as rectangular or circular; circular openings are
designed as equivalent rectangular openings.

• Openings can be reinforced on one side or both sides but always top or
bottom, but no checks are performed on the reinforcement and its welds.

• No concentrated loads should be placed above an opening. If there is a
point load above the opening then that combination gets a Beyond Scope
status, (but only if the concentrated load is greater than 25% of the shear
strength of the two tee sections).

• The nearest concentrated load should be placed at least d/2 from the edge
of the opening.

• A check is performed to determine whether bearing stiffeners are
necessary, if so these are not designed but a warning is shown.

• ASD design i.e. LRFD only.

NOTE For details of the web opening design checks performed see Web openings
(Beams: AISC 360) (page 1678)

Beam web openings to SCI P355

NOTE When the Head Code has been set to Eurocode, Tekla Structural Designer
adopts the following approach to web openings which is specific to the UK
National Annex.

As each web opening is added it is checked against certain geometric and
proximity recommendations taken from Table 2.1 of SCI Publication P355 (see
below).

Guidance on size and positioning of openings
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The following general guidance on size and positioning of openings is taken
from Table 2.1 Section 2.6 of the SCI Publication P355

NOTE These geometric limits should normally be observed when providing
openings in the webs of beams. It should be noted that these limits relate
specifically to composite beams and caution should be used in applying these
limits to non-composite beams.

Parameter Limit
Circular Opening Rectangular Opening

Max. depth of opening: <= 0.8h <= 0.7h
Min. depth of Tee, >= tf +30 mm >= 0.1h

Min. depth of Top Tee: As above As above and >= 0.1 lo

if unstiffened
Max. ratio of depth of
Tees: hb/ht

hb/ht

<= 3

> = 0.5

<=2

>= 1

Max. unstiffened
opening length, lo

Max. stiffened opening
length, lo

-

-

-

-

<= 1.5 ho high shear*

<= 2.5 ho low shear

<= 2.5 ho high shear*

<= 4 ho low shear

Min. width of web post:

- Low shear regions

-High shear regions

>= 0.3h o

>= 0.4h o

>= 0.5 lo

>= lo

Corner radius of
rectangular openings:

- ro >= 2 tw

but ro >= 15 mm

Min. width of end post,
se:

>= 0.5 ho >= lo

and >= h
Min. horizontal distance
to point load:

- no stiffeners

- with stiffeners

>= 0.5 h

>= 0.25 ho

>= h

>= 0.5 ho

* A high shear region is where the design shear force is greater than half the
maximum value of design shear force acting on the beam.

Symbols used in the above table:

h = overall depth of steel section

ho = depth of opening [diameter for circular openings]
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ht = overall depth of upper Tee [including flange]

hb = overall depth of lower Tee [including flange]

lo = (clear) length of opening [diameter for circular openings]

se = width of end post [minimum clear distance between opening and support]

tf = thickness of flange

tw = thickness of web

ro = corner radius of opening

In addition, the following fundamental geometric requirements must be
satisfied.

do <= 0.8*h for circular openings

do <= 0.7*h for rectangular openings

do < 2 * (doc - tt - rt)

do < 2 * (h - doc - tb - rb)

d2 < doc - do/2 - tt- ts/2

d2 < h - tb- doc - do - ts/2

lo < 2 * Lc

lo < 2 * (L - Lc)

Ls < 2 * Lc

Ls < 2 * (L - Lc)

where

dt= the depth of the web of the upper tee section measured from the
underside of the top flange

doc = the distance to the centre line of the opening from the top of the steel
section

d2 = the distance from the edge of the opening to the centre line of the
stiffener

ts = thickness of stiffener [constrained to be the same top and bottom]

tt = the thickness of the top flange of the steel section

tb = the thickness of the bottom flange of the steel section

rt = root radius at the top of the steel section

rb = root radius at the bottom of the steel section

Lc = the distance to the centre line of the opening from the left hand support

L = the span of the beam
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NOTE Dimensional checks - The program does not check that openings are
positioned in the best position (between 1/5 and 1/3 length for udls and in a
low shear zone for point loads). This is because for anything other than
simple loading the best position becomes a question of engineering judgment
or is pre-defined by the service runs.

NOTE Adjustment to deflections - The calculated deflections are adjusted to allow
for the web openings

Beam web openings to SCI P068

As each web opening is added it is checked against certain geometric and
proximity recommendations taken from SCI Publication P068.

Guidance on size and positioning of openings

We advise you to comply with the following positional recommendations for
web openings:

• Web openings are designed using the bending moment and vertical shear
values at the side of the opening where the moment is lower,

• Openings should preferably be positioned at the mid-height of the section.
If not, the depth of the upper and lower sections of web should differ by
not more than a factor of two,

• Openings should not be located closer to the support than two times the
beam depth or 10% of the span whichever is the greater,

• The best location for any opening is between 1/5 and 1/3 of the span from
a support in uniformly loaded beams, or in lower shear zone of beams
subject to point loads,

• Openings should be not less than the beam depth, D, apart,

• Unstiffened openings should not generally be deeper than 0.6D or longer
than 1.5D,

• Stiffened openings should not generally be deeper than 0.7D or longer
than 2D,

• Point loads should not be applied at less than D from the side of the
adjacent opening.

NOTE Dimensional checks - The program does not check that openings are
positioned in the best position (between 1/5 and 1/3 length for udls and in a
low shear zone for point loads). This is because for anything other than
simple loading the best position becomes a question of engineering judgment
or is pre-defined by the service runs.

NOTE Adjustment to deflections - The calculated deflections are adjusted to allow
for the web openings
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Steel beam torsion
Torsion can only be checked to the AISC or Eurocode head code and only
under the following conditions:

• Section geometry

• doubly symmetric rolled I-sections

• closed RHS/SHS/CHS sections (steel and cold formed)

• closed HSS sections

• pinned

• single span beams

• applied torsion moment

• no web openings

If any of the above conditions are contravened the check is beyond scope.

Only a check design is performed, (no auto-design for torsion).

The procedure and scope are different for Open sections (I’s) vs closed
sections (HSS’s)

• Open Sections:

• Torsion design and angle rotation check will be carried out for applied
torsion forces only. “Inherent” torsion is not checked

• Closed Sections

• “Inherent” torsion and/or physically applied torsion loads checked

• Angle of rotation check carried out for applied forces only

Fire check (Eurocode only)
The mechanical resistance of a steel beam in case of fire can be checked in
accordance with EN 1993 & national annex for the UK, Ireland, Singapore,
Malaysia, Sweden, Norway, Finland or the recommended Eurocode values.

The fire check is activated via the beam properties, after which the user is
required to specify:

• Load reduction factor for fire

• Required time of fire exposure

• Exposure

• Protected, or unprotected

• If the protected option is selected, the engineer is then required to
specify the fire protection material details.
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The time interval for critical temperature iteration is specified in Design
Settings, for both 'unprotected' and 'protected' situations.

The check compares the design shear force against the design resistance at
the required time of fire exposure.

For the scope of the check and the limitations that apply, see: Fire resistance
check (Beams: EC3 Eurocode) (page 1901)

Composite beam design
Click the following links to find out more:

• Composite beam overview (page 1224)

• Composite beam loading (page 1225)

• Composite beam fabrication (page 1226)

• Composite floor construction (page 1229)

• Precast concrete planks (Eurocode only) (page 1236)

• Concrete slab (page 1239)

• Metal deck (page 1239)

• Stud strength (page 1239)

• Connector layout (page 1240)

• Composite beam restraints (page 1247)

• Composite beam natural frequency (page 1247)

• Composite beam transverse reinforcement (page 1248)

• Allow non-composite design (page 1249)

• Deflection limits (page 1216)

• Camber (page 1217)

• Instability factor (page 1217)

• Beam web openings (page 1218)

Composite beam overview
Composite beams are designed using a set of design forces obtained from 3D
Analysis. (Grillage Chasedown Analysis and FE Chasedown Analysis results are
not required.)

The beams must be simply supported, single span unpropped structural steel
beams.

The following are beyond scope:
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• continuous or fixed ended composite beams,

• composite sections formed from hollow rolled sections,

• composite sections where the concrete slab bears on the bottom flange,

• the use of fibre reinforcement.

Beams are designed for gravity loads acting through the web only. Minor axis
bending and axial loads are not considered.

NOTE If either minor axis bending or axial loads exist which exceed a limit below
which they can be ignored, a warning is given in the beam design summary.

Profiled steel sheeting can be perpendicular, parallel and at any angle in
between relative to the supporting beam web.

Tekla Structural Designer will determine the size of beam which:

• acting alone is able to carry the forces and moments resulting from the
Construction Stage,

• acting compositely with the slab using profile steel decking (with full or
partial interaction) is able to carry the forces and moments at Composite
Stage,

• acting compositely with the slab using profile steel decking (with full or
partial interaction) is able to provide acceptable deflections, service
stresses and natural frequency results.

Alternatively you may give the size of a beam and Tekla Structural Designer
will then determine whether it is able to carry the previously mentioned forces
and moments and satisfy the Serviceability requirements.

An auto-layout feature can be used for stud placement which caters for both
uniform and non-uniform layouts.

Composite beam loading
All loads must be positive since the beam is considered as simply supported
and no negative moment effects are accommodated.

Construction stage loading

You define these loads into one or more loadcases as required.

The loadcase defined for construction stage slab wet concrete has a Slab wet
loadcase type specifically reserved it. Clicking the Calc Automatically check box
enables this to be automatically calculated based on the wet density of
concrete and the area of slab supported. An allowance for ponding can
optionally be included by specifying it directly in the composite slab
properties.

If you uncheck Automatic Loading, this loadcase is initially empty - it is
therefore important that you edit this loadcase and define directly the load in
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the beam due to the self weight of the wet concrete. If you do not do this then
you effectively would be designing the beam on the assumption that it is
propped at construction stage.

It is usual to define a loadcase for Live construction loads in order to account
for heaping of the wet concrete etc.

Having created the loadcases to be used at construction stage, you then
include them, together with the appropriate factors in the dedicated
Construction stage design combination. You can include or exclude the self-
weight of the beam from this combination and you can define the load factors
that apply to the self weight and to each loadcase in the combination.

NOTE You should include the construction stage slab wet concrete loadcase in the
Construction stage combination, it cannot be placed in any other combination
since it’s loads relate to the slab in its wet state. Conversely, you cannot
include the Slab self weight loadcase in the Construction stage combination,
since it’s loads relate to the slab in its dry state. The loads in the Construction
stage combination should relate to the slab in its wet state and any other
loads that may be imposed during construction.

NOTE TIP: If you give any additional construction stage loadcases a suitable title you
will be able to identify them easily when you are creating the Construction
stage combination.

Composite stage loading

You define the composite stage loads into one or more loadcases which you
then include, together with the appropriate factors in the design combinations
you create. You can include or exclude the self-weight of the steel beam from
any combination and you can define the load factors that apply to the beam
self weight and to each loadcase in the combination.

The Slab self weight loadcase is reserved for the self weight of the dry concrete
in the slab. Clicking the Automatic Loading check box enables this to be
automatically calculated based on the dry density of concrete and the area of
slab supported. An allowance for ponding can optionally be included by
specifying it directly in the composite slab properties.

If you uncheck Automatic Loading, the Slab self weight loadcase is initially
empty - it is therefore important that you edit this loadcase and define directly
the load in the beam due to the self weight of the dry concrete. For each other
loadcase you create you specify the type of loads it contains – Dead, Live or
Wind.

For each load that you add to an Live loadcase you can specify the percentage
of the load which is to be considered as acting long-term (and by inference
that which acts only on a short-term basis).

All loads in Dead loadcases are considered to be entirely long-term while
those in Wind loadcases are considered entirely short-term.
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Composite beam fabrication

Fabrication types summary - all head codes

The fabrication types that can be designed as composite steel beams in Tekla
Structural Designer are dependent on the design code.

Refer to the following table for details.

 Rolled Plated Westok
cellular

Westok
plated

FABSEC DELTABE
AM

AISC Yes No No No No No
Eurocode Yes Yes Yes Yes No No
BS Yes Yes Yes Yes No No
IS N/A - Design of composite beams to IS codes is currently beyond

scope
AS N/A - Design of composite beams to AS codes is currently beyond

scope

Plated beams - Eurocode head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to Eurocodes. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for plated
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - BS head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to BS 5950. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for plated
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Composite floor construction

Deck Type, Angle and Condition

The deck type and angle used in the beam design are determined from the
properties of an adjacent slab item. If there are multiple adjacent slab items
with different properties, it is the users responsibility to indicate which one
governs.

• When specifying the slab item properties you will find that a wide range of
profiled metal decks have been included for manufacturers from many
countries. PC Planks are also available, but only for the EC Head Code.
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• The slab item’s rotation angle relative to the global X axis is used to set the
profiled metal deck as spanning at any angle between 0° (parallel) and 90°
(perpendicular) to the direction of span of the steel beam.

The beam’s “condition” is:

• restricted to internal if it has composite slabs attached along its full length
on both sides,

• restricted to edge if it has no composite slabs on one side,

• defaulted to edge (but editable) if it has composite slabs on both sides but
not along the full length.

Shear connector type

The shear connection between the concrete slab and the steel beam is
achieved by using shear studs.

NOTE The use of channel connectors or Hilti™ connectors is currently beyond the
program scope.

Head Code: Eurocode, BS

19mm diameter studs with 100 and 125 nominal height (95 and 120 as welded
height) are offered. 22mm diameter studs are also offered but only for precast
plank decks. Studs do not have a given capacity as their resistance is derived.

Effective width used in the design - Head Code: ACI/AISC

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, be for each composite beam as per Section I3.1a (360-05/-10).

For each side of the beam, it is taken as the smaller of:

• beam span/8 – span taken as the center to center of supports
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• one half of the distance to the center line of the adjacent beam

• the distance to the edge of the slab

Although the program calculates be, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgement may
sometimes be required.

For example consider the beam highlighted below:

The program calculates the effective width as the sum of:

• to the right of the beam, be(right) = beam span/8

• to the left of the beam, be(left) = one half of the shortest distance to the
center line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Design > Settings > Composite beam - Update effective width prior
to design check is checked on

2. The floor construction properties will then display an Override effective
width option.
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a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.

b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.

Effective width used in the design - Head Code: Eurocode

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, beff, for each composite beam as per Clause 5.4.1.2 of EC4.

Unless hollowcore units are used, it is taken as the smaller of:

• Secondary beams: the spacing of the beams, or beam span/4

• Primary beams (conservatively): 80% of the spacing of beams, or beam
span/4

• Edge beams: half of above values, as appropriate, plus any projection of
the slab beyond the centreline of the beam.

For hollowcore precast plank units only, we calculate the effective width for
each side of the beam as the minimum of:

• Assumed concrete fill (500 mm) + recommended gap

• beam span/8 – span taken as the center to center of supports

• one half of the distance to the center line of the adjacent beam

• the distance to the edge of the slab

These effective breadths are used in both strength and serviceability
calculations.
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Although the program calculates beff, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgement may
sometimes be required.

For example consider the beam highlighted below:

The program calculates the effective width as the sum of:

• to the right of the beam, beff(right) = beam span/8

• to the left of the beam, beff(left) = one half of the shortest distance to the
center line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Design > Settings > Composite beam - Update effective width prior
to design check is checked on

2. The floor construction properties will then display an Override effective
width option.

a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.
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b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.

Effective width used in the design - Head Code: BS

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, be, for each composite beam as per section 4.6 of BS 5950 : Part 3 :
Section 3.1 : 1990.

For each side of the beam, it is taken as the smaller of:

• beam span/8 – span taken as the centre to centre of supports

• one half of the distance to the centre line of the adjacent beam (for slabs
spanning perpendicular)

• 40% of the distance to the centre line of the adjacent beam (for slabs
spanning parallel)

• the distance to the edge of the slab

Although the program calculates be, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgement may
sometimes be required.

For example consider the beam highlighted below:
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The program calculates the effective width as the sum of:

• to the right of the beam, be(right) = beam span/8

• to the left of the beam, be(left) = one half of the shortest distance to the
centre line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Design > Settings > Composite beam - Update effective width prior
to design check is checked on

2. The floor construction properties will then display an Override effective
width option.

a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.

b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.
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Precast concrete planks (Eurocode only)

NOTE The design of composite beams with precast concrete planks is only available
for Eurocodes. It is not currently supported for other Head Codes.

General limitations and assumptions

The following limitations and assumptions apply to the use of precast concrete
planks:

Cross-section classification is restricted to Classes 1 & 2.

As per normal composite beams there is no requirement to check for
transverse force as it is assumed there are no loads or support conditions that
would necessitate this.

A balanced condition is assumed during the construction stage and the top
flange of the beam is treated as laterally restrained in construction. This
condition should be evaluated against the particular application, if it is not
suitable then it should be cleared.

Both hollow core units and solid planks are assumed to act compositely only
with perpendicular secondary beams and not primary beams parallel to the
span of the PC units. Beams neither parallel nor perpendicular to the PC slab
are termed angled and are also designed non-compositely.

Precast unit

Design of the precast units themselves is not carried out. It is assumed that
the application and loading conditions of the particular precast unit is justified
before design of the composite beam is carried out.

The ability to model slab openings is not restricted. The effect an opening has
on the behaviour of the precast plank is however, not taken into account and
the engineer should verify this to be safe.

P401 restricts the design of composite beams with precast concrete units to
the following:

• Hollow core units with circular or circular elongated openings along their
length (150mm – 260mm deep). It is assumed all hollow core units
modelled will have circular or circular elongated cores. Cores with other
cross-sectional geometries may need additional design and verification,
this is beyond the scope of SCI P401

• Solid precast planks (75mm – 100mm deep)

• Downstand beams

Deeper units can be chosen than the sizes stated above, however design will
not be carried out.

It is assumed that the concrete infill does not contribute to the overall weight
of the slab.
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If a solid slab is chosen, the contribution of the precast slab is ignored in
resistance and stiffness calculations.

If a hollow core unit is chosen, the contribution of the concrete topping is
ignored in resistance and stiffness calculations.

Steel Beam

The following applies to steel beam sections:

• Minimum flange width

• Internal beam - 220mm for shop-welded and 235 for site welded shear
connectors.

• Edge beam – 2 * (6 * stud diameter)

These recommendations can be reduced by decreasing the bearing -
special provisions must be made after consultation with both the precast
manufacturer and the steelwork providers*

• Web openings are ignored in design*

• No significant point loads are applied to the composite beam*

• Beam must not behave as a cantilever

• For solid precast units only the topping is to be included as the joints
between the units may not be in good contact

• For hollow core units only the precast plank will be taken into account
during design

• A warning is issued in this case and subsequent design is carried out
assuming that the engineer has justified the particular condition as safe.

Bearing

A default bearing of 75mm minimum is used. This can be reduced but the
engineer must consult the precast manufacturer and steelwork provider. The
minimum flange width is therefore also reduced.

Concrete properties

Overall properties of the slab should be specified. It is up to the engineer to
decide those that govern the overall slab (PC plank + topping). It is these
properties that are used to carry out design calculations and slab self-weight.

Loading

Slab self-weight

The concrete infill in the hollow cores is not taken into account in the
calculation of the overall weight of the slab.

Where either no topping or structural topping is used, both dry and wet
overall self-weight is calculated from the self-weight of the precast unit plus
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any topping. Where a non-structural topping is used, the engineer is expected
to input the overall self-weight of the slab themselves.

Significant Point Loads

Significant point loads are beyond the scope of design in SCI P401. A warning
is issued if a significant point load is present on the composite beam.
Subsequent design calculations are carried out assuming the point load has
no effect on the composite behaviour of the beam. The engineer must carry
out additional hand calculations to justify this assumption is safe.

Shear Connectors

19mm and 22mm diameter shear studs are allowed in composite design with
precast planks.

Should the engineer choose to place shear connectors in pairs, no
dimensional check is carried out. It is assumed that the engineer has justified
their use in pairs.

Longitudinal Shear

It is assumed the shear force is divided equally between the two sides of the
beam flange.

The factors that influence the longitudinal shear capacity of your composite
beam are:

• Concrete strength, slab depth and slab width – you cannot change these
independently for the longitudinal shear check, since they apply equally to
the entire composite beam design,

• The areas of Transverse and Other reinforcement which you provide in
your beam

Transverse

Transverse reinforcement is designed to ensure VEd ≤ VRd. Additional
reinforcement to that detailed in design may be required for other purposes.

Refer to SCI P401 for recommended minimum bar sizes and spacing of
transverse reinforcement. In the case of a solid slab, the additional mesh is
ignored in transverse reinforcement calculations as only either mesh or loose
bars can be chosen. Additional mesh, however, can be applied to the slab
reinforcement – see “Other”.

It is possible to increase the maximum spacing of transverse reinforcement
from that shown in SCI P401 Table 3.1, however it must be noted that this is
being done under the engineer’s own judgement.

EN 1992-1-1, 6.2.4 is used to determine the design resistance VRd to the
longitudinal shear at the potential failure surface a-a (shown in Figure 4.7 in
SCI P401). Failure surface b-b however is not checked in design.

Refer to SCI P401 for recommendations on the detailing of transverse
reinforcement and minimum bar length.
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Other

Any “other” slab reinforcement in the topping applied to a hollow core unit is
ignored in design.

Composite Moment of Inertia

When determining the moment of inertia of a composite section with a hollow
core unit, the section is taken as a solid slab (i.e. hollow cores aren’t taken into
account).

For stiffness calculations the concrete below the neutral axis is considered as it
will contribute some stiffness. However when carrying out resistance
calculations, this concrete is ignored.

Concrete slab

NOTE While you can define concrete slabs in both normal and lightweight concrete,
design using lightweight slabs is only available for the Eurocode.

Eurocode

Warnings are issued in the design if you do not comply with the following
constraints:

• Normal weight concrete range C20/25 - C60/75 - See EN 1994-1-1:2004
Clause 3.1(2),

• Lightweight concrete range LC20/22 - LC60/66 - See EN 1994-1-1:2004
Clause 3.1(2),

• Minimum density for lightweight concrete 1750 kg/m3 - see EN
1994-1-1:2004 Clause 6.6.3.1(1).

Metal deck
Minimum lap distance

The position and attachment of the decking is taken into account in the
longitudinal shear resistance calculations.

The applied longitudinal shear force is calculated at the center-line of the
beam, and at the position of the lap (if known). If the position of the lap is not
known, then the default value of 0mm should be used (that is the lap is at the
center-line of the beam) as this is the worst case scenario.

Stud strength
The stud properties you can choose from are appropriate to the stud source.

All types of stud may be positioned in a range of patterns.
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Stud groups - Head Code ACI/AISC

You can allow group sizes of 1, 2, 3 or 4 studs - any group sizes that you don't
want to be considered can be excluded.

For example, if you do not set up groups with 3 or 4 studs, then in auto-design
the program will only try to achieve a successful design with a maximum of 2
studs in a group.

For each group that you allow you must enter the 'Set distance emid to' - as
either >= 2in or < 2in and you also specify the pattern to be adopted (e.g.
along the beam, across the beam, or staggered).

Stud groups - Head Code Eurocode or BS

You can allow group sizes of 1 or 2 studs - any group sizes that you don't want
to be considered can be excluded.

For example, if you do not set up groups with 2 studs, then in auto-design the
program will only try to achieve a successful design with a maximum of 1 stud
in a group.

For groups with 2 studs you must specify the pattern to be adopted (e.g. along
the beam, across the beam, or staggered).

NOTE It is up to you to check that a particular pattern fits within the confines of the
rib and beam flange since Tekla Structural Designer will draw it (and use it in
design) anyway.

Optimize shear interaction

If you choose the option to optimize the shear interaction, then Tekla
Structural Designer will progressively reduce the number of studs either until
the minimum number of studs to resist the applied moment is found, until the
minimum allowable interaction ratio is reached or until the minimum spacing
requirements are reached. This results in partial shear connection.

Connector layout
When running in Auto-design mode you may not want to specify the stud
layout at the start of the design process. To work in this way check Auto-layout
to have the program automatically control how the stud design will proceed.
When the beam is subsequently designed Auto-layout invokes an automatic
calculation of the required number of studs, which is optimized to provide an
efficient design.

NOTE 'Auto layout' can actually be checked regardless of whether you are auto
designing the beam size or checking it. The combination of 'Check' design with
'Auto layout' of studs can be used to assist you to rationalize your designs e.g.
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to force a beam to be the same size as others in the building but have Tekla
Structural Designer determine the most efficient layout of studs.

You may choose to perform the initial design with Auto-layout checked and
then refine the spacing with Auto-layout cleared if the spacing is not exactly as
you require. This may arise if for instance the theoretical design needs to be
marginally adjusted for practical reasons on site.

Auto-layout for perpendicular decks

For perpendicular decks, the Auto-layout dialog provides two options for
laying out the studs:

• Uniform

• Non-uniform

Uniform

The Uniform option forces placement in ribs at the same uniform spacing
along the whole length of the beam.

Whether the stud groups are placed in every rib (as shown above), alternate
ribs, or every third rib etc. can be controlled by adjusting the limits you set for
Minimum group spacing ( ) x rib and Maximum group spacing ( ) x rib.

The number of studs in each group will be the same along the whole length of
the beam, this number can be controlled by adjusting the limits you set on the
Stud strength page.

NOTE Example:

If you set Minimum group spacing 2 x rib and Maximum group spacing 3 x rib,
then the program will only attempt to achieve a solution with studs placed in
alternate ribs, or studs placed in every third rib. It will not consider a solution
in which studs are placed in every rib.

Additionally, if on the Studs - Strength page, you have allowed groups of 1
stud and 2 studs; then if 1 stud per group proves to be insufficient the
program will then consider 2 studs per group.

Non-uniform

If optimization has been checked (see Optimize shear interaction (page 1239))
studs are placed at suitable rib intervals (every rib, alternate ribs, every third
rib etc.), in order to achieve sufficient interaction without falling below the
minimum allowed by the code.

Engineers Handbooks 1241 Steel member design handbook



NOTE The optimum and minimum amounts of shear connection are defaulted to
50% and 25% respectively. These can be adjusted if required.

If optimization has not been checked, studs are placed at suitable rib intervals
in order to achieve 100% interaction.

Knowing the number of studs necessary to achieve the required level of
interaction, it is possible that placement at a given rib interval could result in a
shortfall; the program will attempt to accommodate this by working in from
the ends, (as shown in the example below). If every rib is occupied and there is
still a shortfall, the remainder are 'doubled-up', by working in from the ends
once more.

In this example the point of maximum moment occurs one third of the way
along the span, this results in an asymmetric layout. If you prefer to avoid such
arrangements you can select Adjust layout to ensure symmetrical about
centerline. A redesign would then result in the symmetric layout shown below.

For both Uniform and Non-uniform layouts, if the minimum level of interaction
cannot be achieved this is indicated on the design summary thus: “Not able to
design stud layout”.

Auto-layout for parallel decks

For parallel decks, the Auto-layout again provides Uniform and Non-uniform
layout options, but the way these work is slightly different.

Uniform

The Uniform option forces placement at a uniform spacing along the whole
length of the beam. The spacing adopted will be within the limits you set for
Minimum group spacing distance and Maximum group spacing distance. If the
point of maximum moment does not occur at mid span, the resulting layout
will still be symmetric.

The number of studs in each group will be the same along the whole length of
the beam, this number can be controlled by adjusting the limits you set on the
Stud strength page.
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Non-uniform

If optimization has been checked (see Optimize shear interaction (page 1239))
studs are placed at a suitable spacing in order to achieve sufficient interaction
without falling below the minimum allowed by the code.

If optimization has not been checked, studs are placed at a suitable spacing in
order to achieve 100% interaction.

If the point of maximum moment does not occur at mid span, the resulting
non-uniform layout can be asymmetric as shown below.

For both Uniform and Non-uniform layouts, if the minimum level of interaction
cannot be achieved this is indicated on the design summary thus: “Not able to
design stud layout”.

Manual Stud Layout

You may prefer to manually define/adjust the group spacing along the beam.
This can be achieved by unchecking Auto layout.

NOTE If you specify the stud spacing manually, then it is most important to note:

• the resulting design may not be the optimal design possible for the beam,
or

• composite design may not be possible for the stud spacing which you
have specified.

To generate groups of studs at regular intervals along the whole beam use the
Quick layout facility. Alternatively, if you require to explicitly define the stud
layout to be adopted for discrete lengths along the beam use the Layout table.

Manual layout for Perpendicular decks

For perpendicular decks, the dialog for manual layouts is as shown:
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To use Quick layout, proceed in one of two ways:

• Choose to position groups in either every rib, or alternate ribs, then specify
the number of studs required in the group and click Generate.

• Alternatively: specify the total number of studs, then when you generate, if
the number specified is greater than the number of ribs, one will be placed
in every rib and the remainder will be 'doubled-up' in the ribs at each end
starting from the supports. Similarly if the number specified is less than the
number of ribs, but greater than the number of alternate ribs, one will be
placed in every alternate rib and the remainder will be placed in the empty
ribs. Limits of 600mm or 4 x overall slab depth, (whichever is less), are
considered.

To use the Layout table:

• For each segment you should define the following parameters: No. of
connectors in length and No. of connectors in group; Group spacing x rib.
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Your input for these parameters is used to automatically determine Distance
end 2 - this latter parameter cannot be adjusted directly, hence it is dimmed.

• If required click Insert to divide the beam into additional segments.
(Similarly Delete will remove segments). You can then specify a different
stud layout for each segment.

• We would advise that having entered No. of studs in length, group and
spacing and ignoring Distance ends 1 and 2 you click Update, this will
automatically fill in the missing fields.
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Manual layout for Parallel decks

For parallel decks, the dialog for manual layouts is as shown:

To use Quick layout, proceed in one of two ways:

• Choose to position groups at a set repeat distance, then specify the
number of studs required in the group and click Generate.
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• Alternatively: specify the total number of studs, then click Generate - the
program calculates the repeat distance automatically, subject to the code
limits.

To use the Layout table:

• The preferred method is to choose the option Spacing distance automatic,
in which case you can adjust the No. of connectors in length and No. of
connectors in group. Alternatively you could choose the option Number in
length automatic and then adjust No. of connectors in group and Group
spacing dist.

• If required click Insert to divide the beam into additional segments.
(Similarly Delete will remove segments). You can then specify Distance end
1 for each new segment and it’s own stud layout.

Composite beam restraints
You can independently set both the top and bottom flanges of a composite
beam as continuously restrained in the Properties window.

When the beam is initially created the decking direction is unknown until the
beam is actually placed and the floor slab and direction are also created.
Hence defaults are provided for each eventuality.

The defaults are:

• for perpendicular decks the deck restrains the beam top flange

• for parallel decks the deck does NOT restrain the beam top flange

• for precast decks the deck restrains the beam top flange

• for all decks the deck does NOT restrain the beam bottom flange

By setting the top flange as continuously restrained and/or the bottom flange
as continuously restrained the relevant buckling checks are not performed
during the design process.

When not continuously restrained, LTB and Compression restraints are
determined from the incoming members described within the Tekla Structural
Designer model. The buckling checks are based on these.

By right-clicking a member to edit its properties in the Property dialog, you
are then able to edit the restraints. You can indicate continuously restrained
sub-beams and also edit length factors.

For composite beams the buckling checks are only performed at construction
stage as at composite stage they are always assumed to be fully restrained.

TIP Restraint settings for composite beams can be easily reviewed and adjusted
graphically via Review View > Show/ Alter State. For more details see: Review and
modify restraints
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Composite beam natural frequency
A natural frequency check can optionally be requested. When activated a
simple (design model) approach is taken based on uniform loading and pin
supports. This fairly simple calculation is provided to the designer for
information only. The calculation can be too coarse particularly for long span
beams and does not consider the response side of the behaviour i.e. the
reaction of the building occupants to any particular limiting value for the floor
system under consideration. In such cases the designer has the option to
perform a 1st order modal analysis.

Composite beam transverse reinforcement
This reinforcement is be provided specifically to resist longitudinal shear.

Since the profile metal decking can be perpendicular, parallel or at any other
angle to the supporting beam the following assumptions have been made:

• if you use single bars they are always assumed to be at 90° to the span of
the beam,

• if you use mesh then it is assumed to be laid so that the main bars are at
90° to the span of the beam.

The reinforcement you specify is assumed to be placed at a position in the
depth of the slab where it is able to contribute to the longitudinal shear
resistance

Automatic transverse shear reinforcement design

It is possible to automatically design the amount of transverse shear
reinforcement for each beam. This is achieved in Tekla Structural Designer by
checking the Auto-select option on the Transverse reinforcement tab of the
Composite Beam Properties.

NOTE The Auto-select option for designing transverse shear reinforcement is only
available when the beam is in auto-design mode.

If you are checking a beam, then you must specify the transverse shear
reinforcement that you will provide, and then check out this arrangement.

The auto-selected bars can be tied into the stud group spacing by checking the
Bar spacing as a multiple of stud spacing option. Alternatively, the spacing can
be controlled directly by the user.
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Bar spacing as a multiple of stud spacing

When the option Bar spacing as a multiple of stud spacing is checked, the
Transverse Reinforcement tab provides the user with controls on the bar size
and the multiples of stud spacing.

These can be used to achieve a selection of say, 12mm diameter bars at 2
times the stud spacing, with a slightly greater area than a less preferable
16mm diameter bars at 4 times the stud spacing.

Controlling the bar spacing directly

When the option Bar spacing as a multiple of stud spacing is not checked, the
Transverse Reinforcement tab provides the user with direct control on the bar
size and the bar spacing.

Allow non-composite design
Typically, at the outset you will know which beams are to be non-composite
and which are to be composite and you will have specified the construction
type accordingly. However, circumstances can arise in which a beam initially
intended to be composite proves to be ineffective. Examples might be:

• very small beams,

• beams with a significant point load close to a support,

• beams where the deck is at a shallow angle to the beam, hence the stud
spacing is impractical,

• beams where, for a variety of reasons, it is not possible to provide an
adequate number of studs, and

• edge beams, where the advantages of composite design (e.g. reduced
depth) are not so clear

Where Tekla Structural Designer is unable to find a section size which works
compositely, you can ask for a non-composite design for the same loading.
You will find that this facility is particularly useful when you right-click a key
beam in the model in order to perform an individual member design.

To invoke non-composite design

1. Select the composite beam(s) as required.

2. In the Properties Window select Allow non-composite design

Steel column design
Click the following links to find out more:

• Steel column overview (page 1250)

• Simple columns (page 1251)
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• Steel column fabrication (page 1251)

• Steel column restraints (page 1255)

• Steel column connection eccentricity moments (page 1256)

• Splice and splice offset (page 1261)

• Steel column web openings (page 1262)

• Instability factor (page 1217)

Steel column overview
Tekla Structural Designer allows you to analyse and design a structural steel
column which can have moment or simple connections with incoming
members, and which can have fixity applied at the base. The column can have
incoming beams which may also be capable of providing restraint, and may
have splices along its length at which the section size may vary. You are
responsible for designing the splices appropriately.

In its simplest form a steel column can be a single pin ended member between
construction levels that are designated as floors.

More typically it will be continuous past one or more floor levels, the whole
forming one single entity typically from base to roof.

Steel columns that share moments with steel beams form part of a rigid
moment resisting frame.

In all cases you are responsible for setting the effective lengths to be used
appropriate to the provided restraint conditions. All defaults are set to 1.0L.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
considered.)

If working to either AISC or Eurocodes, the design will take into consideration
additional moments resulting from the eccentricity of pinned beam end
connections. If working to other head codes, while the eccentricity moments
are calculated, they are not used in the design.

Steel member orientation

Tekla Structural Designer considers member orientation when displaying
analysis results. Therefore, to apply the sign convention correctly, you need to
know which is the end 1 and which is the end 2 of the member. For columns
you also need to be able to identify the four faces: A, B, C & D.

If you select the Direction option for a member in Scene Content, Tekla
Structural Designer displays a direction arrow the member which points points
from end 1 to end 2 of the member. For columns the direction is always from
bottom to the top and the arrow is always drawn adjacent to Face A. Looking
down from the top of a column, Face B, C, and D then follow in the clockwise
direction.
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Simple columns
A steel column can be designated as a `simple column' - in which case specific
design rules are required.

A simple column should not have any applied loading in its length.

Simple columns are subject to axial forces and moments due to eccentricity of
beam reactions.

In order to prevent end fixity moments you would have to manually pin the
ends of the column.

NOTE The simple column design rules have not yet been implemented in
Tekla Structural Designer: such columns are thus classed as “beyond
scope” when designed.

Steel column fabrication

Fabrication types summary - all head codes

The steel column fabrication types that can currently be designed in Tekla
Structural Designer are dependent on the design code, and also the
construction type specified in the column properties - refer to the following
table for details.

Construction: Non-composite column

Rolled Plated Concrete filled Concrete
encased

AISC Yes No No No
Eurocode Yes No No No
BS Yes No No No
IS Yes Yes No No
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AS Yes Yes No No

Construction: Composite column

Rolled Plated

AISC No No
Eurocode No No
BS No No
IS No No
AS No No

Plated columns - Indian head code

When the Fabrication type is set to Plated, a range of steel compound sections
can be designed to the Indian design code.

The section shapes supported are:

• Rolled Channels back to back

• Rolled Channels toe to toe

• Doubled rolled I sections
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• Doubled rolled I sections with plates

The scope of design of these compound sections includes both beams and
columns and autodesign.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created (page 1008) specifically for
compound sections once these have been added to the sections
database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• High Shear case with minor axis moment is beyond scope.

• Design of the lacing or battening system is beyond scope.

• Only parallel flange sections can be used.

Plated columns - Australian head code

When the Fabrication type is set to Plated, only welded doubly symmetric I-
section columns can be designed to the Australian code.

A pre-defined range of these is available from the Welded Columns page of
the Select Section dialog - these can be both checked and autodesigned.

NOTE Autodesign requires a Design section order to be specified, the Welded
Columns design section order is provided for this purpose.

While you can add to the range of welded columns in the Select Section dialog
by clicking the Add... button, any such user-defined columns can only be
analyzed, but are not designed.

Plated columns available on other pages of the Select Section dialog can be
analyzed, but are not designed.
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Composite, concrete filled, and concrete encased steel columns

Whilst composite columns, concrete filled hollow sections and concrete
encased sections can be specified in Tekla Structural Designer they are not
designed.

For composite columns and concrete filled hollow sections, the analysis uses
the bare steel inertia and not the ‘effective composite inertia’. This is
conservative as the lower stiffness of the bare section will promote more
second-order effects. On the other hand for concrete encased columns Tekla
Structural Designer takes into account the encasement based on the size
specified by the user.

When working to the US head code: AISC 360-16, sub-section I1.5 deals with
the calculation of stiffness for concrete filled hollow sections and concrete
encased sections used in the Direct Analysis Method (DAM). In accordance
with C2.3, Tekla Structural Designer takes account of the standard stiffness
adjustment factor of 0.8 with τb set to 1.0 given the additional notional load of
0.1% is also applied. I1.5 requires these types of member to take τb as 0.8
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when considering the flexural stiffness. The user can achieve this for concrete
encased columns by adjusting the Modification Factors in the Analysis Settings
(page 2278). (For composite columns and concrete filled hollow sections which
both use the bare steel stiffness, no adjustment is required).

Steel column restraints
Restraints to flexural and torsional buckling are determined from the incoming
members that connect to the column. The buckling checks are based on these
restraints.

Restraints are considered effective on a particular plane providing they are
within ±45° to the local coordinate axis system.

In all cases Tekla Structural Designer sets the default unrestrained length
factor between restraints to 1.0.

You have the control to set any unrestrained length to be continuously
restrained over that length - when set in this way the relevant buckling check is
not performed during the design process.

NOTE The Steel Column Properties window only allows you to set entire
stacks as either continuously restrained or unrestrained. In order to
specify restraints between the incoming members within each stack it
is necessary to open the Steel Column Property dialog instead.

TIP As an alternative to using the Steel Column Property dialog, restraint
settings for steel columns can be easily reviewed and adjusted
graphically via Review View > Show/ Alter State. For more details see:
Review and modify restraints

Lateral torsional buckling (LTB):

• Members framing into either Face A or C are by default assumed to provide
full LTB restraint. You therefore need to consider whether or not your
particular configuration of incoming members is capable of providing this
level of LTB restraint. If necessary you can edit the default restraint
provision by selecting the Face A override and/or Face C override
checkboxes as appropriate.

NOTE Face A can be identified graphically, from which the other faces
follow, see: Steel member orientation (page 1250)

Compression/Strut buckling:

• Members framing into either Face A or C will by default provide restraint
against major axis compression buckling. Members framing into either
Face B or D will by default provide restraint against minor axis compression
buckling. You can remove these default restraints if required by selecting
the Major override and/or Minor override checkboxes.
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Steel column connection eccentricity moments

Overview

Nominal eccentricity moments that arise from beam end reactions are
considered in Tekla Structural Designer's steel column design.

These moments do not come directly from the global analysis but instead are
calculated at the ‘load analysis’ post-processing stage as follows:

• At each level the eccentricity of each connection is taken as half the depth
of the supporting column, plus an additional user defined offset from the
column face.

• At each level the pinned beam end reactions connecting to the column at
each face are determined.

• If braces also connect to the same face, the force in the brace will also be
taken into consideration if the "Include force in eccentricity moment" brace
release property is checked for the appropriate end of the brace.

• Taking the beam end reactions (and brace forces if included) on opposite
faces multiplied by their connection eccentricities, resultant eccentricity
moments are determined.

• These moments are then distributed above and below the level based on
the column stiffnesses.

NOTE The eccentricity moments are typically assumed not to be transferred
beyond the level at which they are applied.

Patterning of eccentricity moments

The eccentricity moments resulting from live loads can be patterned if
required to account for the likelihood that the load is not present on all spans
simultaneously.
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When eccentricity moment patterning is enabled you must then indicate which
of the live cases are to be patterned, (you may for example decide not to
pattern storage loads.)

For those live cases with patterning enabled, five patterns are considered.
These are:

Pattern 0 is for the full live load at all positions i.e. no patterning - this gives the
maximum axial force in any one stack with (usually) lower eccentricity
moment.

Patterns 1 to 4 are ‘true’ patterns switching live load ‘on’ and ‘off at each pair of
positions around the column in order to generate the maximum live
eccentricity moments about the major and minor axes of the column.

NOTE The same pattern is applied at the top and bottom of the stack, so for
example it is not possible to have P1 at the top and P4 at the bottom.

Design

NOTE Patterned eccentricity moments are only considered in the design for the
AISC or Eurocode head codes. If working to other head codes, while the
patterned eccentricity moments are calculated, only the fully loaded pattern
(P0) is used in the design.

In general, eccentricity moments are only added to the 'real' moments at the
ends of each stack and are only added if they make the design worse.

If you have elected to pattern live eccentricity moments these are considered
in conjunction with the eccentricity moments from other types of load, and
with the 'real' moments.

• As the eccentricity moments are considered localised to each floor the full
axial force from other floors is maintained. The axial force at the level
under consideration will be slightly reduced with patterning enabled as the
live floor loading will not be present on all sides simultaneously.

• Since it is not known whether a reduced axial force with more eccentricity
moment is a worse case than full axial and a lower (or even zero, in the
balanced case) eccentricity moment, the design loops through all patterns
in order to consider each eventuality.

• The patterned eccentricity moments are considered in all design checks
apart from 'Shear', (which is unaffected).
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• To keep the design details to a manageable level, results for every pattern
are not listed; the pattern which produces the governing design forces is
listed in the check combination and location tree and details heading, (as
shown below).

Define connection eccentricity values

The eccentricities at each level are defined in the column properties and a
different eccentricity can be applied to each face.

As long as the option to apply eccentricity at a face is checked, the total
eccentricity at that face is taken as half the dimension of the supporting
column, plus the additional eccentricity from the face as specified in the
Properties window shown above.

If you uncheck the option to apply eccentricity at a face the end reaction on
that face is applied axially.
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NOTE Face A can be identified graphically, from which the other faces follow, see:
Steel member orientation (page 1250)

Pattern eccentricity moments for live loadcases

Patterning can be switched on for specific live loadcases in a two-step process
as follows:

1. From the Home ribbon:

a. Click Model Settings > Loading > General

b. Select Use patterning of eccentricity moments for steel columns

c. Click OK

2. From the Loadcases page of the Loading dialog:

a. Select a live loadcase that you want to be patterned

b. Select Pattern Eccentricity Moments for Steel Columns

c. When patterning has been selected for each of the required
loadcases, click OK

Review connection eccentricity moments

Because eccentricity moments do not come directly from the global analysis
they cannot be displayed graphically in a Results View, they can only be
displayed on a column by column basis by opening a Load Analysis View
(page 716).

With a Load Analysis View open and the required loadcase or combination
selected in the Loading list, you then select the Major, or Minor direction in
the Loading Analysis ribbon.
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The 'real' moments are displayed as a shaded diagram using solid lines, the
eccentricity moments as an unshaded using dashed lines:

The red marker line can be set to a specified distance in the Properties
window to allow the real and ecc. moment values above and below the line to
be displayed.

Displaying patterned eccentricity moments

When you select a patterned live loadcase a Show ecc. moment pattern box
will become available in the Properties window.

After selecting Show ecc. moment pattern you can then click Ecc. moment
pattern in order to select the pattern to display from the droplist.
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Splice and splice offset
Splices are allowed at floor levels only and must be placed at changes of angle
between two adjacent stacks and at changes of section size or type. A
validation error will result if this is not the case. The splice can be given an
offset from the floor level - the default of 500mm is considered not to be
structurally significant.

You must detail the splice to resist the applied forces and moments. The detail
should provide continuity of stiffness and strength. Splices given considerable
offset should be designed to take account of the P-d moment (also known as
moment induced by strut action) at the position as well as the forces from the
analysis.

NOTE To remind you of the above requirement the following warning is
issued when splice loads are exported to BIM as part of the analysis
results: "The loads given do not include any additional moment due to
member buckling." A similar warning is also issued when splice loads
are included in reports. This is an explicit requirement in the British
Standards (Clause 6.1.8.2 of BS 5950-1), although as the same
engineering principle applies the world over, we issue it for all head
codes.

Each lift (length between splices) of a general column can be of different
section size and grade. Different section types within the same column are not
allowed due to the particularly complex design routines that general columns
require. You are responsible for guaranteeing that the splice detail ensures
that the assumptions in the analysis model are achieved and that any
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difference in the size of section between lifts can be accommodated
practically.

Steel column web openings

NOTE In the current release of the program the design or checking of columns with
web openings is “Beyond Scope”

You can define rectangular or circular openings and these can be stiffened on
one, or on both sides.

Web openings can be added to a column by a 'Quick-layout' process or
manually.

The 'Quick-layout' process, which is activated using the check box on the Web
openings dialog page, adds web openings which meet certain geometric and
proximity recommendations (taken from Table 2.1 of SCI Publication P355 if
the Head Code is set to Eurocode, or taken from SCI Publication P068 if the
Head Code is set to BS). The openings so created are the maximum depth
spaced at the minimum centers recommended for the section size.

Web openings can also be defined manually. With Quick-layout cleared, the
`Add' button adds a new line to the web openings grid to allow the geometric
properties of the web opening to be defined.

Steel brace design

Steel brace overview
Tekla Structural Designer allows you to analyze and design a steel member
with pinned end connections for axial compression and tension.

Steel braces can be specified as rolled I-sections, C-sections, T-sections,
rectangular, square and circular hollow sections, angles, double angles, and
flat sections.

NOTE If working to the US head code, a brace specified as a flat section can
only be analyzed, but design is beyond scope.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
required.)

Applied loading

The following points should be noted:

• Loads for the brace are derived from the building model.

• Element loads cannot be applied directly to the brace itself.
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• Live and Roof Live load reductions are not applied.

• Moments due to self weight loading are ignored.

Design Forces

The design forces for strength checks are obtained from an analysis of the
entire structure. Braces can be subject to axial compression or tension, but will
not be subject to major and minor axis bending.

Input method for A and V Braces
A and V Braces should be modeled using special tools which can be found on
the 'Steel Brace' drop list in the 'Steel' section on the 'Model' tab.

Although it is also possible to model the exact same brace arrangement using
individual elements created using the simple 'Steel Brace' command, it is
important to note that whilst the Notional Loads \ EHFs (Equivalent Horizontal
Forces) calculated for models built using the A or V Brace tools are correct, this
is not the case when the A or V braces are built up out of individual brace
members. In this latter case, elements of the vertical loads that are supported
by the bracing system are 'lost' and are not included in the Notional Load \
EHF calculations with the result that the calculated Notional Loads \ EHFs are
not correct.

Steel brace in compression
Effective length factors are defined for each axis of buckling.

• Effective length factor y-y

• Effective length factor z-z

NOTE If designing to British Standards, see Steel brace in compression - BS
5950-1:2000 (page 1263)

Steel brace in tension
The net area of the section is required for tension checks. This can be specified
either as:

• Percentage value

• Effective net area

NOTE If designing to British Standards, see Steel brace in tension - BS 5950-1:2000
(page 1264)
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Steel brace in compression - BS 5950-1:2000
If either an Angle (single or double) or Channel or Tee section has been
selected as the brace member then a 'Connection at each end' property box
appears which allows selection of an appropriate Clause from Table 25 of the
BS code to describe the connection type.

The default Clauses from Table 25 are as follows:

Single Angle 4.7.10.2a
Double Angle 4.7.10.3d
Channel 4.7.10.4b
Tee 4.7.10.5b

Notes:

1. Clauses 4.7.10.2b, 4.7.10.2c, 4.7.10.3b, 4.7.10.3c, 4.7.10.3d and 4.7.10.3e
only apply to Bolted connections so in these cases 'Bolted' should be
selected in the 'Connection' property box. ('Bolted' is the default
connection.)

2. For Angle (single and double), Channel and Tee sections the Effective
Length Factors will be auto-completed according to the connection Clause
selected but these Factors can be changed if required. For Angle (single
and double) sections the length Lv-v is always assumed to be L/3 and the
Effective Length Factor v-v will act on this Lv-v.

3. For single Angle sections the longer leg is assumed to be the connected
element unless 'Short attached' is checked on the Size page of the dialog.

4. For double unequal Angle sections, whichever leg is not the back-to-back
leg is assumed to be the connected element when connection Clauses
4.7.10.3a and 4.7.10.3b are selected, and vice versa with Clauses 4.7.10.3c,
4.7.10.3d and 4.7.10.3e

Steel brace in tension - BS 5950-1:2000
Brace tension capacity is calculated according to section type as follows:

A. Hollow sections (CHS, RHS, SHS): Gross area capacity
B. Angle, Channel, Tee sections: Reduced effective net area capacity

(Clauses 4.6.3.1 and 4.6.3.2)
C. I/H and any other sections: Effective net area capacity (Clause

4.6.1)

Notes:

1. For section types B and C listed above, an Effective net area (Ae) should be
entered either as a percentage of the gross area (Ag) or as an absolute
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value. The default is to use 100% of Ag, and an absolute value cannot be
used if autodesign is also selected.

2. The 'Geometry' property needs to be selected manually if autodesign is
also selected, otherwise the 'Geometry' property does not appear visible.

Steel joist design

Steel joist design overview
Steel joists, (or bar joists), are a specific type of members used in the United
States. They are simply supported secondary members that do not support
any other members - they only support loaded areas, i.e. slab and roof loads.
Steel joists are constrained to standard types specified by the US Steel Joist
Institute, and standardized in terms of span, depth and load carrying capacity.

In Tekla Structural Designer steel joist design is performed in accordance with
the 44th Edition of the Steel Joist Institute (SJI) specification, which uses a
similar approach to that embodied in AISC 360-05/10/16 LRFD and ASD.

Standard types

Steel joists are constrained to standard types specified by the Steel Joist
Institute. They are standardized in terms of span, depth and load carrying
capacity. There are four standard types of steel joist available in Tekla
Structural Designer.

• K series joists - parallel chord steel joists (2 variations; rod or angle webs) -
depths 8" to 30" with spans up to 60ft.

• Including 2.5 K series joist substitutes - a depth of 2.5in, intended to be
used for spans up to 10ft.

• KCS series joists - K series adapted and specially designed for constant
moment/shear along length (position of point loads become irrelevant).

• LH series joists - long span joists - depths 18" to 48" for clear spans up to
96ft.

• DLH series joists - deep long span joists - depths 52" to 120" for clear spans
up to 240ft.

Special Joists

"SP" suffixes can be added to K, LH and DLH Series joists. Special Joists can
handle 'non-uniform' loading situations. They will attract loads and participate
in the 3D structural analysis, but they cannot be checked or designed.

Joist Girders

These are provided as an option to support steel joists. They will attract loads
and participate in the 3D structural analysis, but they cannot be checked or
designed.
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Assumptions and limitations
The following assumptions and limitations currently apply to the design of
steel joists in Tekla Structural Designer:

• All steel joists are considered as simply supported members.

• Steel joists cannot be released axially.

• Cantilevered joists cannot be defined.

• Joist Girders are able to support other joists and brace members, other
joists are only able to support brace members.

• Joist inertia and area values are taken directly from the Steel Joist Institute
tables, with the exception of Joist Girders for which you must provide the
relevant data.

• For all joist types. any resulting load, other then those in the major axis,
that exceeds the user specified Ignore Forces Below setting on Design
Options is reported as a Warning in the results viewer along with the type
and value of force detected.

• Design is currently beyond scope for SP joists and Joist Girders.

• For all steel joists, it is assumed that the top chord is sufficiently braced
against lateral torsional buckling.

• There is no restriction on the minimum span for which a joist can be
defined even though due to their open web nature joists can be almost
impossible to fabricate for very small spans. The user should check the
suitability of using such a joist in these situations.

• For steel joists which support a generic concrete slab, it is assumed that the
minimum concrete slab thickness of 2 inches (50mm) is present. (SJI Steel
Joist Specification 5.9.2). This is not checked by Tekla Structural Designer.

• In design, the user is expected to refer to the bridging requirements in the
SJI Specification and decide the appropriate details for the relevant
scenario. This is not checked by Tekla Structural Designer.

• ‘Non uniform’ loads are accommodated by KCS joists. E.g. parapet snow
drift load, partition walls. If no KCS joists can be found then SP joists can be
used for these loads but these are not designed/checked.

• Top chord extensions used as eaves and awnings are not designed.

• Camber of the joists is not shown in the graphics nor handled by Tekla
Structural Designer.

• The design and specification of the joist seats (regular or sloping) is not
handled by Tekla Structural Designer.

• Double joist configurations cannot be defined in Tekla Structural Designer.
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• The design does not consider the minimum bearing requirements for K,
KCS, LH or DLH joists – these are the responsibility of the designer/
engineer.

• Customisation of KCS joists to accommodate any applied concentrated
loads is not considered byTekla Structural Designer.

• Loadings for accessories to the joist are not included in the standard load
tables. An allowance for this should be included by the designer in the
loading of the model.

• Steel joists are not designed for composite action and when supported by
conventional composite a validation warning is issued. Composite Joists, CJ
Series, cannot be defined in Tekla Structural Designer.

• Moment connections at steel joist ends are not allowed.

• Duct openings are stated in the standard Steel Joist Tables for standard
panel sizes. Actual spacing and layout of the duct arrangements are
beyond the scope of Tekla Structural Designer.

• Fire resistance requirements are not designed nor checked in Tekla
Structural Designer, the designer must ensure suitable compliance.

• There is no design for net uplift currently although uplift can exist in a
combination provided it is overcome by other gravity loads. The designer
should ensure that any uplift due to Wind loads is accurate as the current
version of the Wind Wizard does not determine wind forces for
‘Components and Cladding’.

• Sloping joists are permitted providing the loading is normal to the joist and
the span will be taken as the sloped length. However, joists with sloping
top chords are not allowed.

• SJI allows grades other than 50 ksi [345 MPa] to be used but the Safe Load
Table values are based on 50 ksi [345 MPa]. Tekla Structural Designer
defaults to Grade A992 – 50, it is the user's responsibility to check the
suitability of this or any other grade they wish to use. No adjustment is
made for higher or lower grades and this is entirely the designer’s call.

Loading
The loads on the joist are from ‘one-way’ load decomposition. The joist is
analyzed as a pin ended beam, only loads in the plane of the web are
considered.

Joist Girders should only be used to support steel joists, and should therefore
have regularly spaced point loads of similar magnitude along their length. As
they are not designed or checked various types of loading could be present, so
the user should verify that they have been used appropriately.

Steel Joists are essentially used to support full length uniformly distributed
loads, however it is acceptable for the joist to be designed to support other
load configurations. This requires the loading pattern on the joist to be
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assessed and classified into one of the following loading types: Uniform (or
near uniform), Equivalent Uniform, or Non-Uniform.

The classification of loading type is made in accordance with the following
methods:

Loading
Type

Method

Uniform • No concentrated (point) loads are allowed.

• Loads must be (member) Full UDL, UDL, VDL or Trapezoidal
Load acting in the Major or Global Z directions.

• Loads must be applied over the full length of the beam.

• A percentage load tolerance is calculated and provided this is
less than the uniform load tolerance specified in Design
Settings, then the load combination is classified as ‘Uniform’.

Equivalent
Uniform

• Determine the position of the point of zero shear relative to
the centre span point of the joist.

• If the point of zero shear is located outside the maximum
eccentricity of zero shear limit specified in Design Settings,
then the procedure is ended and the load combination is
classified as ‘Non-uniform’.

• If the point of zero shear is located within the maximum
eccentricity of zero shear limit then an ‘Equivalent Uniform’
load is established.

• The equivalent uniform load is then used to calculate
maximum shear force, bending moment and deflection. The
percentage variation of these values to the actual values from
the beam analysis is then calculated and compared with the
equivalent load tolerance limit specified in Design Settings.

Non-
Uniform

• All loads not qualifying as ‘Uniform’ or ‘Equivalent Uniform’ to
the above methods are considered as ‘Non-uniform’.

NOTE It is possible for an individual loadcase e.g. Live to be
classified as ‘Non-uniform’ which when combined with
other loads becomes ‘Equivalent uniform’. Thus, when
designing for strength (comparing with the ‘black value’ in
the SJI Tables) the loading is valid whereas when checking
the deflection (comparing with the ‘red value’ in the SJI
tables) the service design could be invalid (Fail).

Concentrated Loads

All joists supporting concentrated loads require special treatment by the
manufacturer/fabricator even if the loading configuration can be configured as
‘Uniform’ or ‘Equivalent Uniform’ since the joist design usually presumes that
all concentrated loads are applied at panel points. It is common practice for
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“field installed members” to be located at all concentrated loads not occurring
at panel points as illustrated below.

In Tekla Structural Designer concentrated loads on K, LH and DLH joists are
limited to the maximum sum of concentrated loads limit specified in Design
Settings. This value is unfactored and in the event that the sum of all
unfactored point loads in all loadcases within a combination exceeds this
value, the relevant load combination is classified as ‘Non-uniform’.

Uplift

If (net) uplift is detected for a combination no design is performed for it and a
warning message is displayed.

NOTE If uplift exists in a loadcase but is ‘overcome’ by positive loading in another
loadcase then the design is valid and no warning is displayed.

Joist member reports
Joist design results can be viewed on the screen and incorporated into
member design reports. Joists are also included in material listing reports.

The member design report for steel joists is configurable, but limited to the
following chapters:

Chapter Content
Picture

Drawing
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Chapter Content
Loading

Design Summary

Design Calculations

Steel truss design

Steel truss design overview
In Tekla Structural Designer although trusses can be defined in any material,
design is restricted to steel and cold formed truss members only.

The Truss Wizard provides a wide range of standard truss shapes and
configurations. This covers most practical layouts of truss. However, you can
also modify a standard truss to produce one of slightly different configuration
or manually ‘stick build’ your own truss from truss members if it is an unusual
layout.

Trusses created by the Truss Wizard will comprise a mix of the following truss
member types:

• Truss member top

• Truss member bottom

• Truss member side

• Truss internal
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These are shown in two of the standard configurations below:

Solver elements are created directly between the member insertion points -
they do not take into account major and minor snap points, or any offsets that
might have been specified in the member properties. Consequently, all
intersecting members ‘node’ at the same point – i.e. all internals meet along
the set out line of the chords; this assumes that set out lines are coincident
with the centroidal axes. Therefore, no in–plane eccentricities are considered
in the analysis and design of the trusses.

A wide range of section types can be defined that includes all the common
rolled sections. There is no restriction on the type and size of sections that can
be connected within the truss. The practicality and efficiency of connections
between members is your responsibility. A 'beyond scope' status is issued if a
section type has been applied that cannot be checked for a given design
condition.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
required.)

The design checks performed depend on the truss member types as follows:
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• Truss member top and bottom - these are continuous members with
axial force and bending principally in the plane of the truss. They are
designed as beams (page 1208) for all internal forces (axial, major and
minor axis bending and shear) depending upon the section type used.
Where tension exists in a chord member, the tension capacity is based on
the effective net area.

• Truss internal - these are restricted to be pin ended, and are designed to
the appropriate clauses for tension and compression members. Primary
bending moments due to self weight and secondary moments due to
eccentricity of their connections are ignored. Effective lengths for
compression and effective net area for bolted and welded connections can
be taken into account via the properties of the truss members.

• Truss member side - depending on the truss type selected in the Truss
Wizard these will either default to pin ended or fully fixed. If pin ended, the
design checks are the same as for Truss internal. If fully fixed at both ends
(as in the case of a Vierendeel truss), the design checks are the same as for
Truss member top and bottom.

NOTE If a (pin ended) side is intersected by another truss member then it
is still designed for axial force only, but a warning is issued
indicating the forces that have been ignored.

For top and bottom chords, conditions of restraint can be defined in and out-
of-plane for strut buckling and, top and bottom flange for lateral torsional
buckling (LTB). It is upon these that the buckling checks are based. Incoming
members are identified by the program and sensible default values for
whether these provide restraint or not are set up (see Assumptions and
Limitations (page 1272)). Restraint cannot be added where no incoming
member exists but full control of the effective length factors is provided. In all
cases Tekla Structural Designer sets the default effective length to 1.0L, it does
not attempt to adjust the effective length (between supports for example) in
any way. You are expected to adjust the effective length factor (up or down) as
necessary. You can also indicate chord sub-beams to be continuously
restrained over their length where appropriate.

NOTE Effective length factors and continuous sub-beam restraints are edited by
right clicking on individual chords and selecting Edit chord reference from the
context menu - these can then be specified from the respective lateral and
strut restraint pages of the Properties dialog. Continuous sub-beam restraints
can also be edited in Show/Alter State > Restraints, as can restraint of
internals to chord (defaults to in-plane only for strut and unrestrained for
LTB).

Results of your truss design can be viewed on the screen and incorporated
into a report. Truss members are listed as a separate type in the Material
Listing report.
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Assumptions and Limitations
Limitations

The following limitations apply:

• Web openings, plated sections including Fabsec beams (with or without
openings) and Westok beams cannot be used as truss members

• Chord members cannot be placed vertically

• The arch member of a bowstring truss is drawn and designed as a series of
facets and not as one continuous curved member

• Truss internals cannot be loaded directly and no loads from floors and
roofs are decomposed to them - sides can be loaded, but forces other than
axial are then ignored in the design if the pinned ends are not removed.

• Truss chords are not by default excluded from diaphragm action within a
floor slab, but they can be deliberately excluded if required. See: https://
teklastructuraldesigner.support.tekla.com/support-article/2816265

Assumptions - Restraints

• In both top and bottom chords the node points are assumed not to have
incoming out of plane members unless you define such members in the
model. Hence, at these positions only in-plane strut buckling restraint is
assumed as a default. You can of course change these.

• In a top chord any incoming members not at node points are assumed to
provide the following LTB and strut restraints,

• • incoming members at 90 degrees (± 45 degrees) to the plane of the
truss i.e. horizontal for a truss in the vertical plane, top and bottom
flange restraint for LTB and out-of plane strut buckling restraint,

• incoming members at 0 degrees (± 45 degrees) i.e. vertical for a truss in
the vertical plane, no LTB restraint and in-plane strut buckling restraint.

• In a bottom chord any incoming members not at node points are assumed
to provide the following LTB and strut restraints,

• incoming members at 90 degrees (± 45 degrees) to the plane of the
truss i.e. horizontal for a truss in the vertical plane, top and bottom
flange restraint for LTB and out of-plane strut buckling restraint,

• incoming members at 0 degrees (± 45 degrees) i.e. vertical for a truss in
the vertical plane, no LTB restraint and in-plane strut buckling restraint.

• Lateral restraints to the top or bottom flange of a chord are assumed to be
capable of resisting restraint forces not less than those specified in the
relevent section(s) of the design code.

• In all cases, for all member characteristics it is assumed that you will make
a rational and ‘correct’ choice for the effective lengths between restraints
The default value for the effective length factor of 1.0 may be neither correct
nor safe.
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Portal frame design
If portal frames are modelled and designed in Tekla Structural Designer they
will be designed elastically for the forces determined from the 3D analysis, in
the same manner as other steel beams and columns.

A more economic design can be obtained by exporting individual frames to
Tekla Portal Frame Designer. This industry leading portal frame software
performs an elastic-plastic analysis and design and undertakes member
stability checks to EC3 or BS5950. Once designed, the resulting sections can
then be returned to the Tekla Structural Designer model.

NOTE Tekla Portal Frame Designer is a separately purchasable product.

See also

Export to Tekla Portal Frame Designer (page 319)

13.6 Concrete member and slab design handbook
To get started with designing concrete members in Tekla Structural Designer
see:

• Concrete member design workflow (page 1274)

• Concrete member autodesign (page 1280)

• Concrete member design and detailing groups (page 1281)

• Concrete member cracked or uncracked status (page 1286)

• Concrete beam design properties (page 1289)

• Concrete column design aspects (page 1300)

• Concrete wall design aspects (page 1306)

• Interactive concrete member design (page 1310)

To get started with designing concrete slabs, see:

• Concrete slab design (page 1354)

For guidance to help reduce the overall design time, see

• Working with large models (page 1037)

Concrete member design workflow
The following example illustrates the typical process to analyze and design all
the beams, columns and walls in a concrete structure.
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Set up pattern loading
By default, only beam loads, and slab loads that have been decomposed on to
beams, are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.
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Set all beams columns and walls into autodesign mode
For the first pass, in order to get an efficient design at the outset, it is
suggested that you set all members to "autodesign" with the option to select
bars starting from Minima.

Related concept

The autodesign process for concrete members (page 1280)

Review beam and column design groups
Provided that the concrete beam and column options are checked in Design
Settings > Design Groups, the design groups shown in the Groups tab of the
Project Workspace will be applied in the beam and column autodesign
processes.

Groups will initially have been established for members sharing the same
geometry, but you should consider reviewing and amending them if required.
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Review beam, column and wall design parameters and reinforcement
settings
The member design parameters and reinforcement settings should be
carefully considered prior to running the design.

Perform the concrete design
By running Design Concrete (Static) from the Design ribbon, you effectively
combine analysis and design (with the exception of slab design) into a single
automated process.

Up to three separate analyses are automatically performed in order to
generate the design forces required for the concrete beam, column, and wall
design:

• 3D Analysis

• Grillage chasedown analysis

• FE chasedown analysis

NOTE The sets of forces established from the FE chasedown analysis are considered
by default for the design of each concrete member type. They can however be
switched off should you decide that they are not required. The control for
doing this for beams is located in Design Settings > Concrete > Beam >
General Parameters. A similar control is provided for columns and walls also.

Engineers Handbooks 1277 Concrete member and slab design handbook



NOTE Reinforcement is designed, but member sizes are not changed during the
design process.

Review stability issues
Issues relating to stability will be flagged in the Design branch of the Project
Workspace Status tab. They can also be review graphically from Show/Alter
State in the Review View.

Tabular results can be investigated from the Review View by clicking Tabular
Data in the ribbon and then selecting the required View Type.
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Review the design status and ratios
You can display the Design Status and Ratios from the Review View in order to
determine if any remodelling is required.

In this example a number of members are not heavily loaded so you could
consider resizing or designing them interactively.

If you make any changes, to see their effect simply re-run Design Concrete
(Static) once more.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer.
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Print calculations
Create a model report that includes the member design calculations that have
been performed. (The default Member Design Calcs report includes these
along with design calculations for other member types in the model).

Concrete member autodesign
The design mode for each member is specified in its properties.

Autodesign (concrete beam)

• When Autodesign is selected an iterative procedure is used to select
longitudinal bars for each bending design region on the beam, both top
and bottom. Similarly an iterative procedure is used to select links/stirrups
for each shear design region on the beam.

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

NOTE If concrete beams have been set to be designed using Design and detailing
groups (concrete) (page 1281), then if at least one member of the group is set
to autodesign the whole group will be auto-designed.

Rationalization of Reinforcement

The Auto-design process returns a set of information about the reinforcement
to be provided in each design region of the beam. The number and size of the
longitudinal bars in the top and bottom of the beam is given as well as the
size, number and spacing of the shear links/stirrups.

This information is then "rationalized" to give an arrangement of longitudinal
reinforcement that provides a solution for the beam as a whole whilst still
meeting the requirements of the individual design regions.

The rationalization process is carried out separately for the longitudinal bars in
the top of the beam and those in the bottom of the beam.

The arrangement of shear links/stirrups is not rationalized. These can vary in
size, spacing and number from region to region without having any impact on
adjoining regions.

Autodesign (concrete column)
• When Autodesign is selected an iterative procedure is used to design both

the longitudinal bars and links. This applies the spacing maximisation
method which attempts to return a solution with the largest possible
longitudinal bar spacing and largest possible link/tie spacing.
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• For rectangular, circular and parallelogram sections, if a single layer of
reinforcement is not sufficient, autodesign will attempt a two layer
solution. For circular sections, if a second layer is required you can control
the minimum layer spacing via Design Settings (a larger spacing will be
used if needed).

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

NOTE If concrete columns have been set to be designed using Design and detailing
groups (concrete) (page 1281), then if at least one member of the group is set
to autodesign the whole group will be auto-designed.

Autodesign (concrete wall)
• When Autodesign is selected an iterative procedure is used to determine

the reinforcement. A spacing maximisation method is applied for both
longitudinal bars and links/ties. This attempts to return a solution with the
largest possible longitudinal bar spacing and largest possible link/tie
spacing.

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

Select bars starting from
This option appears for concrete members when Autodesign is selected. It sets
the autodesign start point for both longitudinal bars and links/stirrups/ties.

The options are:

• Minima (default)

• Current bars

Selecting Minima removes the current arrangement and begins with the
minimum allowed bar size from the selection order.

NOTE When a member is in check mode, it can still be autodesigned "on the fly" by
choosing Design Member from the right-click menu. In this case it uses the
Select bars starting from option currently assigned to the member for
autodesign. (This property is hidden when in check mode, but can be
confirmed if required by switching the member back to Autodesign mode.)

Concrete member design and detailing groups
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Why use concrete design and detailing groups?
Concrete beams and columns and isolated foundations are put into groups for
two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design and detailing purposes - to standardise designs, reduce
processing time, and reduce the volume of output created.

In a manual process, the Engineer might select a number of sufficiently similar
members to form a "design group" to carry out a single design that is
sufficient for all members in the group. Using this single set of design results,
they would then create sub-groups of the members in the design group to
produce a set of output details for each of these sub-groups.

In Tekla Structural Designer, concrete design groups are analogous to the
manually created design groups described above. Concrete detailing groups
are analogous to the sub-groups.

A fixed set of rules are used to automatically determine member groups: for
example beams must be of similar spans, columns must have the same
number of stacks, bases must be of similar lengths in X and Y, and similar
depths etc. The same rules also constrain manual group editing.

NOTE Grouped design and detailing is optional and can be deactivated if required:

From the Design tab, click Settings> Design Groups, then select or unselect
the member types to be designed in groups.

What happens in the group design process?
When the option to design a specific concrete member type using groups is
checked, for that member type:

• In each design group the first member to be designed is selected
arbitrarily. A full design is carried out on this member and the
reinforcement so obtained is copied to all other members in the group.

• These other members are then checked one by one to verify that the
reinforcement is adequate for each and if this proves not to be the case, it
is increased as necessary and the revised reinforcement is copied to all
members in the group.

• This process continues until all members in the group have been
satisfactorily checked.

• A final check design is then carried out on each group member. During this
process peak and individual utilizations are established.
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Concrete design group requirements
Concrete member design groups are formed according to the following rules:

Member type Design group rules
Concrete beam • A beam element may be in only one design group.

• Design groups may be formed from single span or
multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• For each individual span all beam elements in the
group must have an identical cross section, including
flange width where appropriate, and span length.

• All beam elements in the group must have identical
material properties and nominal cover.

• All beam elements in the group must be co-linear or
be non-co-linear with identical degrees of non-co-
linearity between spans.

Concrete column • A column element may be in only one design group.

• All column elements in the group must have an
identical number of stacks.

• For each individual stack all column elements in the
group must have an identical cross section, and stack
length.

• All column elements in the group must have identical
material properties and nominal cover.

Pad base • A pad base may be in only one design group.

• Each base in the group must have an identical cross
section and depth.

• Each base in the group must have identical
eccentricities in X and Y.

• Each base in the group must have identical material
properties and nominal cover.

Pile cap • A pile cap may be in only one design group.

• Each pile cap in the group must have an identical
cross section and depth.

• Each pile cap in the group must have identical
eccentricities in X and Y.

• Each pile cap in the group must have identical
material properties and nominal cover
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Detailing group requirements
Each parent design group is sub-divided into one or more detailing groups.

Although there can be a "1 to 1" relationship between a design group and a
detailing group, in practice there will often be a "1 to many" relationship as
each design group is likely to require several detailing groups to allow for
differences in the connected geometry.

Detailing groups are formed for the different concrete member types based
on the following rules:

Member type Design group rules
Concrete beam • A detailing group may be associated with only one

parent design group.

• A beam element may be in only one detailing group.

• Detailing groups may be formed from single span or
multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• The cross section, including flange width where
appropriate, span length and material properties in
span

• "i" of all beam elements in the group must be
identical .

• All beam elements in the group must have identical
plan offsets.

• All beam elements in the group must be co-linear or
be non-co-linear with identical degrees of non-co-
linearity between spans.

• All beam elements in the group must have identical
inclinations.

• The support types and sizes, including the attached
structure above and below the beam element, must
be identical in all beam elements in the group
however different support types and sizes in
individual multi-span continuous beams are
acceptable i.e. support i in beam element j must be
identical to support i in all other beam elements in the
group but supports i and i+1 in beam element j may
be different.

Concrete column • A detailing group may be associated with only one
parent design group,

• A column may only be in one detailing group,
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Member type Design group rules
• All columns in the detailing group must have an

identical number of stacks,

• All columns in the group must have an identical cross-
section, rotation and alignment/snap levels/offsets in
stack 'i'. In a multi-stack column, the cross-section may
be different in each stack, i.e. the cross-section in span
'i' may be different to that in span 'j'.

• Stack 'i' and stack 'i+1' must be co-linear for all
columns, OR must be non-co-linear with an identical
degree of non-co-linearity for all columns. The exact
inclination must be the same for stack 'i' in all
columns.

• At every level each column is considered to be either
"internal" or "external" (depending on if it has beams
framing into it on all four sides, or not). These settings
do not have to be identical for columns to be in the
same group, but only if you have selected the option:
Provide ties through floor depth for internal columns
in Design Options > Concrete > Column > Detailing
Options.

Pad base • A detailing group may be associated with only one
parent design group.

• A base may be in only one detailing group.

• The attached column cross-section above the base
must be identical for all bases in the group however
different support types are acceptable.

Pile cap • A detailing group may be associated with only one
parent design group.

• A pile cap may be in only one detailing group.

• The attached column cross-section above the base
must be identical for all pile caps in the group
however different support types are acceptable.

Group management
Automatic Grouping

Concrete beams and columns are grouped automatically.

In Model Settings > Grouping the user defined Maximum length variation is
used to control whether elements are sufficiently similar to be considered
equivalent for grouping purposes.

Manual/Interactive Grouping
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After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

Detailing groups cannot be edited manually.

NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup ALL Model Members

If you have made changes in Design Settings that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Model Editing and Group Validity Checks

When new beam elements are created when a "split" or "join" command is run
the resulting beam elements are automatically placed in existing design and
detailing groups [or new groups created].

Concrete member cracked or uncracked status
Assuming concrete sections are cracked has a direct affect on analysis -
smaller Modification Factors (page 2290) are applied to cracked sections,
(typically a cracked member is assumed to have half the stiffness of an
uncracked member), causing an increase in deflection. Indirectly the design
can also be affected because the sway/drift sensitivity calculations are also
influenced by this assumption.

The Assume cracked setting in the member properties is used to specify the
cracked/uncracked status of individual concrete beam spans, column stacks
and wall panels. While it can be set directly in the member properties, it can
also be set or toggled graphically (page 875) in a Show/Alter State Review View.
For meshed walls a Review Wall Stress (page 876) feature is provided to speed
up this process.

Wall cracked properties
For engineers investigating the sway characteristics of taller buildings the
cracked/uncracked status of walls is a complex topic of critical importance.

A couple of challenges faced by engineers are:

1. If using general stiffness adjustments - what are the realistic adjustment
values for cracked and uncracked panels?
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2. How can the cracked/uncracked status of wall panels be easily
determined?

Tekla Structural Designer provides a Review Wall Stress (page 876) feature in
Show/Alter State to significantly assist with the latter task for meshed panels.
This graphically displays the current cracked/uncracked status of each panel
and indicates in which panels the stress threshold has and has not been
exceeded. It then allows you to update the cracked status to be compatible
with the threshold.

Use of the Review Wall Stress feature requires a degree of engineering
judgement - you will need to make your own choices with regard to:

• strength or service level stress?

• basing the stress threshold on max instead of in-plane stress contours?

• whether the panel cracks for any level of stress, or could a higher threshold
be considered?

You will also need to be familiar with the limitations and assumptions
(page 876) that apply.

Workflow for reviewing wall cracked properties
To determine an appropriate cracked status for wall panels, you could adjust
the following basic workflow to suit your needs:

1. Analyze the model to determine some initial stresses.

2. Open a Review View and click Show/Alter State.

3. In the Show/Alter State Properties window:

• Set the Attribute to Assume cracked

• Set the [M]ode to Review Wall Stress (page 876)

• Set the Result type to Strength or Service as you deem appropriate.
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• Set the Stress type to In-plane tension - Y or Max tension - Y as you
deem appropriate.

NOTE If using In-plane tension - Y contours:

• these give an average stress through the thickness of the
wall and therefore exclude local stress concentrations that
exist as a result of out of plane bending

• (engineers often choose to ignore out of plane bending
when considering the overall cracked status of panels)

• Enter the Stress threshold that you want to work to.

In the below example, the most likely likely scenario where everything was
initially set as cracked is shown; in lower panels this is a correct setting, in
the higher ones they could be changed to uncracked.

4. By hovering the cursor over an individual panel a tooltip is displayed. This
reports the maximum stress value from all nodes in the panel and the
case/combination in which it occurs. This value is used to determine if the
stress threshold has been exceeded.

NOTE To investigate reported stresses in more detail you might choose
to open a Results View to Display 2D results (page 677) of tension
stress contours for specific envelopes or combinations.

5. At this point you could choose to manually set or toggle the cracked/
uncracked status (page 875) of the individual panels, however Auto
update provides a quicker way to make all panels compatible.

6. To make all panels automatically compatible:

Engineers Handbooks 1288 Concrete member and slab design handbook



• Click  to expose the Auto update button.

• Click the Auto update button 

Each panel is updated as follows:

• uncracked panels in which the stress threshold has been not exceeded
are unaffected,

• uncracked panels in which the stress threshold has been exceeded are
set to cracked,

• cracked panels in which the stress threshold has been exceeded are
unaffected,

• cracked panels in which the stress threshold has not been exceeded
are set to uncracked.

7. Reanalyze the model to take into account the revised cracked/uncracked
properties.

8. Review the results once more and make further adjustments if required.

See also

Modify assumed cracked settings (page 875)

Concrete beam design aspects

Concrete type
While you can apply both normal and lightweight (LW) concrete in the beam
properties, beam design using lightweight concrete is only available for
Eurocodes.

When using other Head Codes beams can only be designed using normal
weight concrete.

LW density classes and grades
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6 Density classes (1.0, 1.2 ….. 2.0) are available and 15 default grades are
provided; 5 in each of the density classes: 1.6, 1.8 and 2.0.

• For example the grade name “LWAC30/37-DC1.8” denotes; LWAC =
Lightweight aggregate concrete; 30/37 = Strength class; DC1.8 = density
class.

• Custom LW grades can be added for which note that new LW-specific
property η1 must be specified.

NOTE LW grades can be reviewed, edited and applied via Review View > Show/Alter
State Material Grade Attribute.

Deflection control (ACI/AISC)
Tekla Structural Designer implements both a simplified, and also a more
rigorous method for controlling deflection.

The actual method applied to a specific beam will depend upon whether it is
required to support sensitive finishes.

When the rigorous method is applied, immediate short-term deflections, and
also long-term deflections resulting from creep and shrinkage of flexural
members are considered.

Structure supporting sensitive finishes

Any beam that supports or is attached to partitions or other constructions
likely be damaged by large deflections should be identified as such by
selecting Structure supporting sensitive finishes under the Design Control
heading in the beam properties.

The deflection method applied to the beam depends on this setting as follows:

• beams not required to support sensitive finishes adopt the simplified
method.

• beams required to support sensitive finishes adopt the rigorous method.

The simplified method

For those beams that have not being chosen to support sensitive finishes,
deflection is controlled by the simplified method of limiting the span to depth
ratio.

This check can be satisfied by providing a total beam depth which exceeds
hmin, (where hmin depends on the clear span and beam end conditions).

If this check is not satisfied the beam is then rechecked by the rigorous
method.

The rigorous method

For beams that do not meet minimum thickness requirements determined by
the simplified method, or that support sensitive finishes, deflections should be
calculated by rigorous method.
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The parameters listed below directly affect the rigorous calculation method
and hence require consideration:

1. Does the beam support sensitive finishes?

• If the Structure supporting sensitive finishes beam property (located
under the Design Control heading) is cleared the simplified method
may suffice in which case rigorous calculations are not required.

2. Can the beam flanges be taken into account?

• Selecting Consider flanges (located under the Design Control heading)
can assist in reducing the calculated deflections.

3. Does the beam contain compression steel?

• In the current release of the program it has been assumed that the
beam always contains compression steel for the rigorous method
deflection calculations.

4. 4. Are the deflection limits appropriate?

• These limits are editable in the beam properties, the default ratios
being span/360 for live load, and span/480 for total load affecting
sensitive finishes.

• The default span\over limits tend to produce conservative results.

• You are also given the flexibility to specify absolute deflection limits as
an alternative, or in addition to the above span\over limits.

5. Is the long term deflection period correctly specified?

• The default value is 5 years, but this can be edited via Design Options >
Beam > General Parameters

6. Is the time at which brittle finishes are introduced correctly specified?

• The default value is 1 month, but this can be edited via Design Options
> Beam > General Parameters

7. Are the percentages of dead load applied prior to brittle finishes and long
term live load correctly specified?

• The deflection check takes account of these percentages, (defaulting to
50% of dead load applied prior to brittle finishes and 33% of long term
live load). You are able to adjust each of these by selecting the
loadcase name from the left hand side of the Loadcases dialog and
then adjusting the value.

Deflection control (AS 3600)
Tekla Structural Designer controls deflections either by limiting span to depth
ratios, or by applying the simplified method. The choice of method being set
via Design Options > Concrete > Beam > General Parameters.

The simplified method
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In the simplified deflection calculation procedure actual short-term deflection
is calculated using the mean value of modulus of elasticity of concrete at
appropriate age (Ecj) and an effective second moment of area of member (Ief).

When the simplified method is applied, the shrinkage parameters that are
required are specified on the Design Options > Concrete > Beam > General
Parameters page.

Limiting span to depth ratios method

The deflection of reinforced concrete beams is not directly calculated and the
serviceability of the beam is measured by comparing the calculated limiting
effective span/effective depth ratio (Lef/d)

Structure supporting sensitive finishes

Any beam that supports or is attached to partitions or other constructions
likely be damaged by large deflections should be identified as such by
selecting Calculate deflection after installation of finishes under the
Design Limits heading in the beam properties.

When this option has been selected an additional span\over or absolute limit
can be specified and checked against in the beam properties.

• beams not required to support sensitive finishes adopt the simplified
method.

• beams required to support sensitive finishes adopt the rigorous method.

Parameters affecting deflection

The parameters listed below directly affect the deflection calculations and
hence require consideration:

1. 1. Increase reinforcement if deflection check fails

• If this beam property (located under the Design Control heading) is
cleared and the check fails, then the failure is simply recorded in the
results

• If it is checked, then the area of tension reinforcement provided is
automatically increased until the check passes, or it becomes
impossible to add more reinforcement.

2. Consider flanges

• Checking this beam property (located under the Design Control
heading) can assist in satisfying the deflection check.

Deflection control (Eurocode BS and IS)
Tekla Structural Designer controls deflection by comparing the calculated
limiting span/effective depth ratio L/d to the maximum allowable value (L/
d)max

The parameters listed below directly affect the deflection calculations and
hence require consideration:
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1. Increase reinforcement if deflection check fails

• If this beam property (located under the Design Control heading) is
cleared and the check fails, then the failure is simply recorded in the
results

If it is checked, then the area of tension reinforcement provided is
automatically increased until the check passes, or it becomes impossible
to add more reinforcement.

2. Structure supporting sensitive finishes (Eurocode only)

• This beam property (located under the Design Control heading, and on
by default) is used to control the value of the f2 parameter used in the
deflection check. When unchecked f2 will be taken as 1.0.

3. Consider flanges

• Checking this beam property (located under the Design Control
heading) can assist in satisfying the deflection check.

Ignore lateral instability (Eurocode)
This option (located under the Design Control heading) allows you to consider
or ignore lateral instability for slender spans to EC2 clause 5.9(1) (off by
default). When the option is checked on the slender span check is excluded
from design.

Consider flanges
Flanged beam properties can be specified under the Design Control heading in
the beam properties, by selecting Consider Flanges.

Typically, flanged beams can be either "T" shaped with a slab on both sides of
the beam or "Γ" shaped with a slab on only one side of the beam.

The characteristic behaviour of flanged beams which can be made use of in
design is the fact that the major axis bending resistance of the member is
enhanced by the presence of adjoining concrete slabs which serve to increase
the area of the compression zone activated during major axis bending.

This effectively raises the position of the neutral axis thereby increasing the
lever arm of the longitudinal tension reinforcement and reducing the quantity
of reinforcement required.

Related concept

Flanged concrete beams (page 1297)
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Design parameters (Eurocode only)
Located under the Design parameters heading in the beam properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio

The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Nominal cover
In the beam properties, the nominal concrete cover is the distance between
the surface of the reinforcement closest to the nearest concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement - longitudinal bar patterns
Under the reinforcement heading in the beam properties, there are three
Standard Patterns available for top reinforcement, SPT1, SPT2 and SPT3 and two
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Standard Patterns available for bottom reinforcement, SPB1 & SPB2 as
illustrated in the figures below.

Standard Patterns of Top Reinforcement

The bars used in the Standard Top Patterns are:

(1) Straight bar extending to approximately 25% or 33% of each span (end
points of this bar are determined by the design region settings)

(2) Straight bar extending to approximately 10% of each span (end points of
this bar are determined by the design region settings) - if required by the
design

(3) Double cranked bar lapped with bar (1)

(5) Straight bar running approximately from face to face of beam supports

(6) Single cranked bar running from center span to center span with the option
to merge bars if they are the same size and number to extend the bar over
several spans

(12) Bob bar

(13) Bob bar

Standard Patterns of Bottom Reinforcement
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The bars used in the Standard Bottom Patterns are:

(4) Bar with a bob at each end

(7) Straight bar with a length approximately 70% of span - if required by the
design

(8) Single cranked bar extending over several spans or over one span only and
lapped within a support - with bob if it continues over an end span.

(9) Straight bar

(10) Straight bar running approximately from face to face of beam supports

(11) Straight bar

(14) Bob bar

Modified versions of the above standard patterns are applied for use in single
spans and in cantilever spans where no backspan beam is present.

For short span beams, it becomes uneconomic and impractical to lap bars in
beams. These facts coupled with the anchorage lengths that are required
make the use of multiple design regions for the longitudinal reinforcement
unnecessary. To cater for this a short span beam length can be defined in
Design Options > Beam > Reinforcement Settings and the bar patterns
adopted for such short spans are as shown below:

Standard Patterns of Reinforcement for Short Span Beams
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Flanged concrete beams

Consider flanges

Flanged beam properties can be specified under the Design Control heading in
beam properties, by selecting Consider Flanges.

Typically, flanged beams can be either "T" shaped with a slab on both sides of
the beam or "Γ" shaped with a slab on only one side of the beam.

The characteristic behaviour of flanged beams which can be made use of in
design is the fact that the major axis bending resistance of the member is
enhanced by the presence of adjoining concrete slabs which serve to increase
the area of the compression zone activated during major axis bending.

This effectively raises the position of the neutral axis thereby increasing the
lever arm of the longitudinal tension reinforcement and reducing the quantity
of reinforcement required.

Validation of slabs for use in the flange effective width calculations

If a slab is present (and provided that a user defined flange has not been
specified), the program automatically validates the slab as a potential
candidate for being a beam flange using a number of criteria, the main ones
being;

• the slab can be on one or both sides of the beam but

• it must extend for a distance ≥ the slab depth from the vertical face of the
beam and

• it must extend for the full span length of the beam

• the slab must be a reinforced concrete slab

• if there are slabs on both sides of the beam, they may be of different depths
and these depths may vary along the length of the beam
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The effective width of any valid slab on each side of the beam, b eff,i, is
calculated and the results that are appropriate at the mid-span length point
are displayed along with the flange depth, under Design control in the Beam
Property dialog.

NOTE When automatically calculated, the flange width and depth are only displayed
in the Beam Property dialog and not in the Beam Properties window,
(because the width and depth could vary if multiple beams were to be
selected).

Include flanges in analysis

Selecting this option allows the flanged beam section properties to be
considered in the analysis, stiffening the beam and reducing the deflection.

Consider as isolated (ACI/AISC)

ACI 318 clause 8.12.4 states:

"Isolated beams, in which the T-shape is used to provide a flange for additional
compression area shall have a flange thickness not less than one-half the
width of web and an effective flange width no more than four times the width
of web."

When the Consider flanges check box is selected, an Isolated Beam check
box is displayed to control whether or not the above code limit is applied.
When the check is performed, if the flange geometry does not meet the above
requirements the flanges are ignored.

NOTE Our understanding is that while this limit usually applies to precast beams, it
is not usually applied to in-situ construction. Therefore, by the default the
Isolated Beam check box is cleared, which means that the above check is not
performed.

Effective Width of flanges (ACI/AISC)

For ACI 318-08 and ACI 318-11

For "T" shaped flanged beams the effective flange width, b eff, is given by :

beff = MIN(L/4, 16*hf + bw, b1 + b2 + bw) - Owi

For beams with slab one side only, the effective flange width, b eff is given by :

beff = MIN(L/12+ bw, 6*hf + bw, bi + bw) - Owi

where

L = span length

IF construction is continuous:

= distance of center-to-center of supports

ELSE
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= MAX(clear span + h, distance between centers of supports)

bi = 0.5 * the clear distance between the vertical faces of the supports for the
valid concrete slab on side i of the beam or from the vertical face of the beam
to the centerline of any supporting steel beam

Owi = the user specified allowance for an opening

For ACI 318-14

All limits on the flange width apply to the overhangs on each side of the beam.
It is also clarified in this version that the clear span should be used in these
calculations.

beff,i = MIN(ln/8, 8*hf , bi) - Owi

Effective Width of flanges (Eurocode)

The effective width of the compression flange is based on L0, the distance
between points of zero bending moment.

For flanged beams the following values of L0 are to be used;

For a simply supported beam L0 = L

For a continuous beam, the value of L0 may be obtained using the following
simplified rules;

End span of a continuous beam with a pinned end support L0 = 0.85*L

End span of a continuous beam with a fixed end support L0 = 0.70*L

Internal span of a continuous beam L0 = 0.70*L

where

L = the clear length of the span under consideration

The effective flange width, beff, is given by;

beff = bw + ∑beff,i

where

beff,i = the effective width of the flange on side i of the beam

= MIN[0.2*L0, bi,(0.2*bi + 0.1*L0)] - Ow i

where

L0 = the distance between points of zero moment as defined above

bi = 0.5 * the clear distance between the vertical faces of the supports for the
valid concrete slab on side i of the beam or from the vertical face of the beam
to the centreline of any supporting steel beam

bw = the width of the beam

Owi = the user specified allowance for an opening
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NOTE If the slab thickness varies on each side of the beam, the thinner value is used
in calculating the beam properties.

The above calculation for beff is also used for "Γ" beams with a slab on only
one side although in this case, b1 or b2 as appropriate is = 0.

Concrete column design aspects

Concrete type
While you can apply both normal and lightweight concrete in the column
properties, column design using lightweight concrete is currently beyond
scope.

Apply rigid zones
Unless you have chosen not to apply them, rigid zones are created at concrete
column/beam connections.

In most situations in order to get an efficient design you would want rigid
zones to be applied. You can however choose not to consider them by
checking the Rigid zones not applied option that is provided in Model Settings,
this will deactivate them throughout the model. You can also selectively
deactivate rigid zones at specific column/beam connections by unchecking the
Apply rigid zones option that is provided in the column properties under the
Design control heading.

• For example, you might choose not to apply them if you encounter
problems with short members and rigid zones which cannot be overcome
by modifying the physical model.

• When rigid zones are not applied, the positions of releases in analysis
model are affected, and member start and end points for design are also
adjusted.

The Apply rigid zones setting is located under the Design control heading in
the column properties.

Design parameters (Eurocode only)
Located under the Design parameters heading in the column properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio
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The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.

Confinement reinforcement
Located under the Confinement reinforcement heading in the column
properties, the Provide support regions setting determines the way each
stack is divided into regions for the purpose of designing the confinement
reinforcement.

• Checked - confinement reinforcement is designed separately in three
regions.
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• Cleared - the same confinement reinforcement is designed for the whole
stack.

Slenderness
Located under the Slenderness heading in the column properties, the
significant parameter within the slenderness criteria is a choice of how the
column is contributing to the stability of the structure.

• bracing - provides lateral stability to the structure.

• braced - considered to be braced by other stabilizing members.

The second slenderness parameter is the effective length factor, which is
either input directly by choosing the User input value option, or it is
calculated in accordance with the requirements of the selected design code.

Stiffness
The stiffness settings affect the calculation of clear height, also referred to as
the unsupported or unrestrained length (depending on the head code being
worked to) which is the clear dimension between the restraining beams at the
bottom of the stack and the restraining beams at the top of the stack. The
unsupported length may be different in each direction.

Effective concrete beams

An effective concrete beam is one which provides stiffness at a restraint
position. A concrete beam is only considered effective if it is "fixed" at the
position where it joins to the column. Concrete beams are only effective in a
direction if they are within 45° of that direction, and therefore no concrete
beam can be effective in both directions. A concrete beam is only effective if
its angle to the horizontal is 45° or less.

A concrete beam only restrains the end of the stack if it is within the depth of
the stack section from the end of the stack, and if its centre is nearer to this
end of the stack than the far end. Therefore, at a node at a stack join, if the top
of the beam is below the node by a dimension greater than the depth of the
stack below the node, it is not considered. Similarly, if the bottom of the beam
is above the node by a dimension greater than the depth of the stack above
the node, it is not considered.

Effective flat slabs/other types of slab

When determining the unsupported length, if no effective beams are found at
the end of a stack, Tekla Structural Designer considers whether there is a flat
slab restraining the stack at that end. The Use slab for calculation... upper/
lower, major/minor options, (which are located under the Stiffness heading in
the column properties), are used to indicate whether any such slab should be
considered as a restraint.

If there are no effective beams and there is no flat slab, the program looks for
any other type of slab panel at that end. If a panel is found, then provided it

Engineers Handbooks 1302 Concrete member and slab design handbook



has the Include in diaphragm property selected, it acts as a restraint at the
position, in the same way as a flat slab.

A flat slab or any other type of slab panel only restrains the end of the stack if
it is within half the slab depth from the end of the stack, and if its centre is
nearer to this end of the stack than the far end.

If, at an end of the stack, no effective beams, flat slab or other slab panel that
acts as a restraint is found, then the unsupported length includes the stack
beyond this restraint, and the same rules apply for finding the end of the
unsupported length at the end of the next stack (and so on). If there is no
stack beyond this restraint (i.e. this is the end of the column), the unsupported
length ends at the end of the column.

Sway/Drift Checks
By default all stacks of all columns are taken into account in the sway/drift,
wind drift and seismic drift checks.

Located under the Sway and drift checks heading in the column properties,
these parameters provides a facility to exclude particular column stacks from
these calculations to avoid spurious results associated with very small stack
lengths. You can either clear the check box located under 'All Stacks' to
exclude the entire column, or you can exclude a particular stack by clearing
the check box located under that stack only.

Nominal cover
In the column properties, the nominal concrete cover is the distance between
the surface of the reinforcement closest to the nearest concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement
The type and grade of vertical and confinement reinforcement to be
considered for the design are specified under the Reinforcement heading in
the column properties.

Where possible bars are arranged in a single layer:
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Using a 2nd layer of reinforcement

• In Autodesign: for rectangular, circular and parallelogram sections, if a
single layer of reinforcement is not sufficient, design will attempt a two
layer solution.

• Rectangular and parallelogram sections: a second layer is added in line
with the first bar along the adjacent length.

NOTE At least 2 intermediate bars are needed in each direction for a
2nd layer to be added.
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• Circular sections: if a second layer is required you can control the
minimum layer spacing via Design Settings (a larger spacing will be used
if needed).
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• A link is added along the second layer for all 3 section shapes.

• In Interactive Design: you can choose to toggle the second layer on or off in
the Interactive Design dialog.

• When using a 2nd layer, design checks are unchanged, except for the
addition of a layer spacing check for circular sections.

Concrete wall design aspects

Concrete type
While you can apply both normal and lightweight concrete in the wall
properties, wall design using lightweight concrete is currently beyond scope.

End 1 and End 2 extensions
Wall extensions (End 1/End 2) can be applied in the wall properties in order to
remove physical overlaps with adjoining walls and columns without
compromising the integrity of the underlying analysis model.

Negative extensions can be created automatically where appropriate.
Extensions can also be defined manually if required, in which case they can be
input with either positive or negative values:

• A positive extension extends the wall length beyond its insertion point.

• A negative extension trims the wall back from the insertion point.

Although the length of the wall used in the analysis model (Lwall) is unchanged,
the wall length that is used in the design, quantity reporting and drawings
changes to Lwall,d

Reinforcement layers
Either one or two layers of reinforcement can be specified in the wall
properties.

Design parameters (Eurocode only)
Located under the Design parameters heading in the wall properties, the
following parameters relating to shrinkage and creep can be specified for
individual walls.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio
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The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.

Sway/Drift Checks
By default all panels of all walls are taken into account in the sway/drift , wind
drift and seismic drift checks.

Located under the Sway and drift checks heading in the wall properties, these
parameters provides a facility to exclude particular wall panels from these
calculations to avoid spurious results associated with very small stack lengths.
You can either clear the check box located under 'All panels' to exclude the
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entire wall, or you can exclude a particular panel by clearing the check box
located under that panel only.

Confinement reinforcement
Located under the Confinement reinforcement heading in the wall properties,
the Provide support regions setting determines the way each panel is divided
into regions for the purpose of designing the confinement reinforcement.

• Checked - confinement reinforcement is designed separately in three
regions.

• Cleared - the same confinement reinforcement is designed for the whole
panel.

Slenderness
Located under the Slenderness heading in the wall properties, the significant
parameter within the slenderness criteria is a choice of how the wall is
contributing to the stability of the structure.

• bracing - provides lateral stability to the structure.

• braced - considered to be braced by other stabilizing members.

The second slenderness parameter is the effective length factor, which is
either input directly by choosing the User input value option, or it is
calculated in accordance with the requirements of the selected design code.

Stiffness
The stiffness settings affect the calculation of clear height, also referred to as
the unsupported or unrestrained length (depending on the head code being
worked to) which is the clear dimension between the restraining beams at the
bottom of the panel and the restraining beams at the top of the panel. The
unsupported length may be different in each direction.

Effective Concrete Beams

An effective concrete beam is one which provides stiffness at a restraint
position. A concrete beam is only considered effective if it is "fixed" at the
position where it joins to the wall. Concrete beams are only effective in a
direction if they are within 45° of that direction, and therefore no concrete
beam can be effective in both directions. A concrete beam is only effective if
its angle to the horizontal is 45° or less.

A concrete beam only restrains the end of the panel if it is within the depth of
the panel section from the end of the stack, and if its centre is nearer to this
end of the panel than the far end. Therefore, at a node at a panel join, if the
top of the beam is below the node by a dimension greater than the depth of
the panel below the node, it is not considered. Similarly, if the bottom of the
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beam is above the node by a dimension greater than the depth of the panel
above the node, it is not considered.

Effective flat slabs/other types of slab

When determining the unsupported length, if no effective beams are found at
the end of a panel, Tekla Structural Designer considers whether there is a flat
slab restraining the panel at that end. The Use slab for calculation... upper/
lower, major/minor options, (which are located under the Stiffness heading in
the wall properties), are used to indicate whether any such slab should be
considered as a restraint.

If there are no effective beams and there is no flat slab, the program looks for
any other type of slab panel at that end. If a panel is found, then provided it
has the Include in diaphragm property selected, it acts as a restraint at the
position, in the same way as a flat slab.

A flat slab or any other type of slab panel only restrains the end of the panel if
it is within half the slab depth from the end of the panel, and if its centre is
nearer to this end of the panel than the far end.

If, at an end of the panel, no effective beams, flat slab or other slab panel that
acts as a restraint is found, then the unsupported length includes the panel
beyond this restraint, and the same rules apply for finding the end of the
unsupported length at the end of the next panel (and so on). If there is no
panel beyond this restraint (i.e. this is the end of the wall), the unsupported
length ends at the end of the wall.

Nominal cover
Nominal concrete cover is specified in the wall properties.

For walls, it is measured as follows:

• For 1 layer of reinforcement, the vertical bar is on the centre-line of the
wall thickness, the face of the horizontal bar is closest to the critical
concrete face.

• For 2 layers of reinforcement, the horizontal bars are placed outside the
vertical bars at each face.

The nominal concrete cover is measured to the face of the horizontal bar or
any link/confinement transverse reinforcement that may be present.

Reinforcement
Under the Reinforcement heading in the wall properties, the Reinforcement
layers, Form and Include end zones properties can be combined as required in
order to obtain a range of reinforcement patterns, e.g:

• Single layer, using mesh reinforcement

• Two layers, using mesh reinforcement

• Single layer, using loose bars
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• Two layers, using loose bars

• End zones, with a single layer of mesh in the mid zone

• End zones, with two layers of mesh in the mid zone

• End zones, with a single layer of loose bars in the mid zone

• End zones, with two layers of loose bars in the mid zone

Interactive concrete member design
The combined analysis and design processes, Design Concrete (Static),
Design All (Static) etc. are complemented by the program's interactive
member design facilities. These allow you to interact with the concrete
member designs to override the results arising from the auto-design process.

The following interactive member designs are provided:

• Interactive concrete beam design (page 1310)

• Interactive concrete column design (page 1315)

• Interactive concrete wall design (page 1335)

Generally you are advised to perform interactive member designs only after
the Design All process has been carried out. In this way multiple analysis
models will have been considered to arrive at the forces being designed for.

The Interactive design dialogs display a limited selection of the relevant critical
design results including bar details and allow you to make changes to the
number, size and spacing (for links/ties only) of the selected bars.

After making changes, you are able to see the effect on the displayed results -
you then have the option of canceling or accepting the changes.

Interactive concrete beam design

Opening the Interactive Beam Design Dialog

The Interactive Beam Design dialog (page 1311) can be opened from any of
the 2D or 3D Views as follows:

1. Right-click the member you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Beam Design dialog is displayed.

3. Interactively adjust the reinforcement as required until the design is
satisfactory.
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Changing the bar pattern used in the Interactive Beam Design Dialog

The interactive dialog can be opened from any of the 2D or 3D Views as
follows:

1. If the Interactive Beam Design Dialog is open, click Cancel to close it.

2. If necessary, re-select the beam to be designed.

3. Change the Top and Bottom longitudinal bar pattern in the Properties
Window as required.

4. Hover the cursor over the beam until its outline is highlighted, then right-
click.

5. From the context menu select Interactive Design...

The Interactive Beam Design Dialog opens and reinforcement is automatically
re-selected for the beam based on the new bar pattern.

Interactive Beam Design dialog
The Interactive Beam Design dialog shows the current reinforcement and
check results for each beam span in the selected beam line. When any of the
editable fields are changed, the checks are re-run and the results are updated;
enabling you to quickly see the effect of each change you make to the
reinforcement.

To display the dialog:

1. Right click on an existing concrete beam.

2. In the context menu, select Interactive Design....

The dialog content is described below.
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1. Beam/span summary pane

The top row in this pane shows the beam line summary, consisting of the
overall utilization ratio and design status.

Subsequent rows show the design status of each span and associated
utilization ratio.

• To design a particular span, click on the corresponding row for that span in
the summary pane.
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2. Longitudinal Bars tab

1. Span Summary: Displays the design status of the selected span and the
associated utilization ratio.

2. Bar Selection Tables: Used for editing the longitudinal bars into the
beam.

• Each row in the table is labeled with a specific “bar number” (taken
from the standard patterns applied to the beam in the Properties
Window); these represent bar locations within the beam.

• Two different bar sizes can be defined in each row, the only restriction
being that the second bar must always be smaller than the first.

• The number of bars of each size is defined using the Count field.
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• When bars are joined to the adjacent span, changing those bars within
this span has the effect of changing those bars in the adjacent span, as
they are effectively the same bar. (This is only done when the spans
are "matching" in terms of their alignment and dimensions.)

3. Bar Pattern Layout: a schematic diagram representing the top and
bottom patterns assigned to the beam.

4. Design Summary Table: Displays critical results for each of the design
regions from all combinations:

• Area of reinforcement required, As,reqd

• Area of reinforcement provided, As,prov

• Reinforcement area utilization ratio

• Smallest clear spacing between bars

• Minimum required reinforcement area, As,min

5. Additional checks: Side bar, deflection and cover check results are
displayed below the design summary table.

3. Links/Stirrups tab

1. Link/Stirrup Selection Table: Specifies the number of link/stirrup legs,
size and spacing in each of the regions.

2. Optimise Button : This calculates the optimum length of the central
region given the reinforcement that you have selected. The button is not
be visible when the beam is in a design group with other beams, and is
also not visible when the span is a cantilever.

3. Link/Stirrup Design Summary Table: Displays the most critical result
from all combinations:

Engineers Handbooks 1314 Concrete member and slab design handbook



• Region length

• Link/Stirrup area over spacing required for shear, Asw,reqd/s

• Link/Stirrup area over spacing required for torsion, Aswt,reqd/s

• Link/Stirrup area provided, Asw,prov

• Link/Stirrup utilization ratio

4. Buttons: (See separate section below.)

Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

See also

Interactive concrete member design (page 1310)

Interactive concrete column design

Opening the Interactive Column Design Dialog

The Interactive Column Design dialog (page 1327) can be opened from any of
the 2D or 3D Views as follows:

1. Right-click the member you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Column Design dialog is displayed.

3. Click on an individual stack in the Column/stack summary pane
(page 1328).

4. Interactively adjust the reinforcement as required for the chosen stack
until the design is satisfactory.
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Arranging bars in the Interactive Column Design Dialog

The way in which bars are arranged depends on the column shape.

In circular columns, bars are arranged simply by modifying the bar size and
count fields.

In rectangular columns bars are arranged as described below.

Principal bars exist at fixed locations; they are labeled with numbers in the
cross-section, as shown above. You can only change the principal bar sizes, not
their locations.

Intermediate bars are the unnumbered bars in the cross-section. You can
change both their size and number. They are defined in the bar location table
by reference to the principal bars between which they lie.
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A count of "1" for each intermediate length in the bar location table indicates
that a single intermediate bar is positioned between each of the principal bars.

If the count is increased to "2" for Int. length 1-2, but reduced to "0" for Int.
length 2-3, the following arrangement is achieved. (Two intermediate bars are
positioned between principal bars 1 and 2, but there are now no intermediate
bars between principal bars 2 and 3.)

Note that Int. lengths 3-4 and 4-5 are adjusted automatically in the table to
match.

Link / Tie arrangements in rectangular and parallelogram sections have the
following basic options:

• Single links/ties,

• Double links/ties,

• Triple links/ties,

• Cross links/ties.

Tie bars are used with these arrangements. Link/Tie arrangements in other
section shapes use standard link/tie positions with additional tie bars where
required.
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Using a 2nd layer of bars

It is sometimes not possible to find a solution using a single-layer of
reinforcement - (a problem more common in hi-rise structures with large
columns in lower stacks).

Selecting the Use 2nd layer option in the interactive design provides you with
more flexibility to find a solution in these cases.

A 2nd layer can be applied to rectangular/parallelogram and circular sections.

Rectangular/parallelogram: a second layer in line with the first bar along the
adjacent length

• At least 2 intermediate bars are needed in each direction

A link is added along the second layer for all 3 section shapes.
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When using a 2nd layer, design checks are unchanged, except for the addition
of a layer spacing check for circular sections.

Column interaction diagrams (US customary units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual columns by accessing the interactive design. There are
two types of interaction diagrams: "axial force-moment interaction diagrams"
and "moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Column axial force-moment interaction diagram

The column axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

In general, the envelope will only be symmetrical for symmetrically reinforced
rectangular and circular sections.

Column moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a column.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force. The design process for biaxial bending is as follows:

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
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Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - meaning the corner of the column near
bar 4 is at the top and the point near bar 2 is at the bottom. The linear strain
distribution between these points is then used to calculate the stress in each
bar.

If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Column interaction diagrams (metric units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual columns by accessing the interactive design. There are
two types of interaction diagrams: "axial force-moment interaction diagrams"
and "moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Column axial force-moment interaction diagram

The column axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
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in that direction) are shown in the same colour, a different colour being used
for each of the two directions.

The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

In general, the envelope will only be symmetrical for symmetrically reinforced
rectangular and circular sections.

Column moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
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many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.

The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a column.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force. The design process for biaxial bending is as follows:

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
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Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - meaning the corner of the column near
bar 4 is at the top and the point near bar 2 is at the bottom. The linear strain
distribution between these points is then used to calculate the stress in each
bar.

If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Defining additional column design cases for user defined forces

Additional design cases can be specified in order to for example design for
results from Post Tensioning analysis programs. These additional forces are
entered per selected stack on the Additional Design Cases page of the dialog.
Any number of design cases can be added and are checked alongside regular
combinations.

1. In the Interactive Column Dialog, select Additional Design Cases
(page 1333) tab.

2. Click Design Cases to open a dialog in which to add the cases (these
belong to the model, so appear for all column stacks and wall panels).

3. Click OK to close the Additional Design Cases dialog.

4. Make relevant cases Active in the current stack.

5. Enter the loading for the Active cases.

6. Repeat 4 and 5 for all column stacks where appropriate.

The additional loading cases are now always checked whenever the regular
combinations are checked.

Interactive Column Design dialog
The Interactive Column Design dialog shows the current reinforcement and
check results for each stack in the selected column. When any of the editable
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fields are changed, the checks are re-run and the results are updated; enabling
you to quickly see the effect of each change you make to the reinforcement.

To display the dialog:

1. Right click on an existing concrete column.

2. In the context menu, select Interactive Design....

The dialog content is described below.

1. Column/stack summary pane

The top row in this pane shows the column summary, consisting of the overall
utilization ratio and design status.

• With this row selected you can edit the section size and grade for all stacks
simultaneously.

Subsequent rows show the design status of each stack and associated
utilization ratio.

• To design a particular stack, click on the corresponding row in the
summary pane.
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2. Longitudinal tab

All straight-edged cross sections have “Principal” bars located at shear tie
corners. Between these, evenly spaced identical “Intermediate” bars can be
located. Circular sections have 6 or more evenly spaced bars around the edge
of the section.

1. Longitudinal Bars:

• Principal bar size: Used to change the size of all principal bars.

• Use 2nd layer: Check the box to allow a second bar layer if
required.

• Spacing: For circular sections the user can control the layer
spacing.

• Intermediate bar size: (Not displayed for circular columns) Used to
change the size of all intermediate bars.

2. Bar Location Table: Used for adding intermediate bars into the cross-
section:

• Int. length - identifies the edge along which the bars are positioned

• Count - for changing the number of intermediate bars along the length
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• Ctr spacing - the centerline spacing for the current number of bars
along the length

• Status - indicates when the maximum bar spacing limit has been
exceeded. (When the minimum bar spacing limit is exceeded this is
displayed elsewhere in the Design Summary Table).

3. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

4. Section Droplist: Used for changing the section size for the current stack.

NOTE If the droplist is used to change the section shape an autodesign
is performed.

5. Concrete Droplist: Used for changing the concrete grade for the current
stack.

6. Confinement status : This status is determined based on the
requirements for bars being tied.

7. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Tie locations

• Section dimensions

• Principal bar labels
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3. Links/Ties tab

1. Links:

• Use support region links/ties : Select to design support regions for
the links/ties.

• Link/Tie spacing : Specifies the link/tie spacing (if support regions are
applied two different spacings can be specified)

• Link/Tie size: Used to change the size of link/tiebars (all must have the
same size).

2. Link/Tie Design Summary Table: Displays the most critical result from all
combinations:

• Region length

• Link/Stirrup area over spacing required, major

• Link/Stirrup area over spacing required, minor

• Link/Tie area over spacing provided

• Link/Tie utilization ratio
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3. Section Droplist: Used for changing the section size for the current stack.

NOTE If the droplist is used to change the section shape an autodesign
is performed.

4. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions

• Principal bar labels

4. Interaction Diagram tab

1. N-M Interaction diagram : Top, mid fifth and bottom moment results for
each analysis type are plotted on the diagram for each combination

• The curves for bending about the major axis are shown in red

• The curves for bending about the minor axis are shown in blue

Engineers Handbooks 1332 Concrete member and slab design handbook



2. M-M Interaction diagram : The diagram is different for each value of
axial force. Initially the diagram at the axial force of the critical
combination is drawn - this is the combination with the highest MEd / Mres
ratio.

3. Parameters: Select the analysis method, combination, and position for
which the diagrams are displayed.

• Set Critical button: If you have changed the parameters for which the
diagrams are displayed, you can click this button in order to revert
back to the critical parameters.

4. Design Forces: The design forces applicable for the selected parameters.

5. Additional Design Cases tab

This tab can be used for example to design for results from Post Tensioning
analysis programs.

1. Design cases...button: Click to open a dialog in which to add any
additional design cases.

The design case names defined here are available to all columns and walls
in the model.
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The Active box in this dialog is used to control which design cases are
considered (for the entire model).

After clicking OK you are then able to specify the design case design
forces in the Design cases table.

2. Design cases table: Each design case added via the Design cases...
button appears in the table, but only those that were marked as active
(for the entire model) are then available to have design forces applied.

In order to apply the design case design forces to a given stack you must:

• Select the required stack in the stack summary

• Click the Active box for the design case

• Enter the design forces

3. Design Moment Factors... button: Offers three potential “Design
Moment” adjustments for each direction:

• Set an imperfection eccentricity allowance (Eurocode only). This is
added to the analysis moment.

• Apply an amplification factor to allow for Second Order Effects (could
also be considered as a way to introduce an extra factor of safety).

• Apply a minimum moment check in one or both directions (the
calculation of this is specific to the Head Code set and is a function of
the section dimension “h” in the direction considered).

When applied, the resulting adjusted design moment is automatically
calculated and displayed in the dialog.

The adjustment values and options can be applied to individual Cases and
also quickly in a single operation to all Active Cases (those with “Active”
option checked on) as shown below:
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6. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Autodesign Stack Performs an autodesign reselecting
bars for the current stack

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

Copy Opens a new dialog enabling the
selective coping of section/concrete
grade/reinforcement from the
selected stack to other stacks in the
same column.

See also

Interactive concrete member design (page 1310)

Interactive concrete wall design

Opening the Interactive Wall Design Dialog

The Interactive Wall Design dialog (page 1345) can be opened from any of the
2D or 3D Views as follows:

1. Right-click the wall you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Wall Design dialog is displayed.

3. Click on an individual panel in the wall/panel summary pane (page 1345).

4. Interactively adjust the reinforcement as required until the panel design is
satisfactory.

Wall interaction diagrams (US customary units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual walls by accessing the interactive design. There are two
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types of interaction diagrams: "axial force-moment interaction diagrams" and
"moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Wall axial force-moment interaction diagram

The wall axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

Wall moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a wall. The wall major and minor
axes follow the same convention as columns - the major axis is perpendicular
to the length (on plan) of the wall as shown.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force.

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - The linear strain distribution between the
top and bottom points is then used to calculate the stress in each bar.
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If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Wall interaction diagrams (metric units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual walls by accessing the interactive design. There are two
types of interaction diagrams: "axial force-moment interaction diagrams" and
"moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Wall axial force-moment interaction diagram

The wall axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

Wall moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a wall. The wall major and minor
axes follow the same convention as columns - the major axis is perpendicular
to the length (on plan) of the wall as shown.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force.

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - The linear strain distribution between the
top and bottom points is then used to calculate the stress in each bar.
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If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Defining additional wall design cases for user defined forces

Additional design cases can be specified typically in order to for example
design for results from Post Tensioning analysis programs. These additional
forces are entered per selected panel on the Additional Design Cases page of
the dialog. Any number of design cases can be added and are checked
alongside regular combinations.

1. In the Interactive Wall Dialog, select Additional Design Cases (page 1352)
tab.

2. Click Design Cases to open a dialog in which to add the cases (these
belong to the model, so appear for all column stacks and wall panels).

3. Click OK to close the Additional Design Cases dialog.

4. Make relevant cases Active in the current stack.

5. Enter the loading for the Active cases.

6. Repeat 4 and 5 for all wall panels where appropriate.

The additional loading cases are always checked whenever the regular
combinations are checked.

NOTE Additional design cases can also be set up directly from Result Lines
in order to facilitate local section design around openings - see the
following topic.

Using result lines for local section design around openings

Interactive design of local sections around/between openings is possible using
Result Lines.

The design is performed either as a column or wall section (as specified by the
user), using those design forces determined along the lengths cut by the result
lines. Engineering judgement is therefore required when positioning the lines
to ensure suitable design forces are obtained.

For further details of the process, see: Manage, display and design result lines
(page 688)
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Related video

Interactive design using Result lines

Interactive Wall Design dialog
The Interactive Wall Design dialog shows the current reinforcement and
check results for each panel in the selected wall. When any of the editable
fields are changed, the checks are re-run and the results are updated; enabling
you to quickly see the effect of each change you make to the reinforcement.

To display the dialog:

1. Right click on an existing concrete beam.

2. In the context menu, select Interactive Design....

The dialog content is described below.

1. Wall/panel summary pane

The top row in this pane shows the Wall summary, consisting of the overall
utilization ratio and design status.

• With this row selected you can edit the thickness and grade for all stacks
simultaneously.

Subsequent rows show the design status of each panel and associated
utilization ratio.

• To design a particular panel, click on the corresponding row for the panel
in the summary pane.
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2. Longitudinal tab (no end-zones)

Use end-zones : With this box unchecked end-zones are not used.

1. Panel: Used for adding either one or two layers of bars in the panel.

• Number of layers - (1, or 2)

• If Reinforcement type = loose bars

• Number of rows - the number of bars in each layer

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers (measured
centre to centre)

• If Reinforcement type = mesh

• Mesh size - specifies the mesh size to be checked
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• End row vertical bar size - specifies the vertical bar size at the ends
of the mesh

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers (measured
centre to centre)

2. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

3. Thickness: Used for changing the thickness of the current panel.

4. Concrete Droplist: Used for changing the concrete grade for the current
panel.

5. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions
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2. Longitudinal tab (with end-zones)

Use end-zones : With this box checked end-zones are used.

1. End-zones: Used for adding bars in the end-zones.

• Length - length of each end-zone

• Number of rows - the number of loose bars in each end-zone

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers in the end-
zone (measured centre to centre)
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2. Mid-zone: Used for adding either one or two layers of bars in the panel
between the end-zones.

• Number of layers - (1, or 2)

• If Reinforcement type = loose bars

• Number of rows - the number of bars in each layer

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• If Reinforcement type = mesh

• Mesh size - specifies the mesh size to be checked

• End row vertical bar size - specifies the vertical bar size at the ends
of the mesh

3. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

4. Thickness: Used for changing the thickness of the current panel.

5. Concrete Droplist: Used for changing the concrete grade for the current
panel.

6. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions
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3. Lateral tab

1. Panel:

• Use links/ties : Select to specify links/ties.

• Link/Tie size: Used to change the size of link/ties (all must have the
same size).

• Horizontal bar size: Used to specify the size of horizontal bars.

• Horizontal bar spacing: Used to specify the vertical spacing of
horizontal bars.

2. Use support region links/ties: Select to design support regions for the
links/ties.

NOTE Only displayed provided Use links/ties box is also checked.

• Link/Tie spacing : Specifies the link/tie spacing (if support regions are
applied two different spacings can be specified)

3. Link/Tie Design Summary Table: Displays the most critical result from all
combinations:

• Link/Tie area over spacing required, major

• Link/Tie area over spacing provided, major

• Link/Tie utilization ratio, majo
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• Link/Tie area over spacing required, mino

• Link/Tie area over spacing required, mino

• Link/Tie utilization ratio, minor

4. Horizontal Reinforcement Summary Table: The table displays the
horizontal bar spacing and reinforcement ratios.

5. Thickness: Used for changing the thickness of the current panel.

6. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions

4. Interaction Diagrams tab

1. N-M Interaction diagram : Top, mid fifth and bottom moment results for
each analysis type are plotted on the diagram for each combination

• The curves for bending about the major axis are shown in red

• The curves for bending about the minor axis are shown in blue
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2. M-M Interaction diagram : The diagram is different for each value of
axial force. Initially the diagram at the axial force of the critical
combination is drawn - this is the combination with the highest MEd / Mres
ratio.

3. Parameters: Select the analysis method, combination, and position for
which the diagrams are displayed.

• Set Critical button: If you have changed the parameters for which the
diagrams are displayed, you can click this button in order to revert
back to the critical parameters.

4. Design Forces: The design forces applicable for the selected parameters.

5. Additional Design Cases tab

This tab can be used for example to design for results from Post Tensioning
analysis programs.

1. Design cases...button: Click to open a dialog in which to add any
additional design cases.

The design case names defined here are available to all columns and walls
in the model.
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The Active box in this dialog is used to control which design cases are
considered (for the entire model).

After clicking OK you are then able to specify the design case design
forces in the Design cases table.

2. Design cases table: Each design case added via the Design cases...
button appears in the table, but only those that were marked as active
(for the entire model) are then available to have design forces applied.

In order to apply the design case design forces to a given panel you must:

• Select the required panel in the panel summary

• Click the Active box for the design case

• Enter the design forces

3. Design Moment Factors... button: Offers three potential “Design
Moment” adjustments for each direction:

• Set an imperfection eccentricity allowance (Eurocode only). This is
added to the analysis moment.

• Apply an amplification factor to allow for Second Order Effects (could
also be considered as a way to introduce an extra factor of safety).

• Apply a minimum moment check in one or both directions (the
calculation of this is specific to the Head Code set and is a function of
the section dimension “h” in the direction considered).

When applied, the resulting adjusted design moment is automatically
calculated and displayed in the dialog.

The adjustment values and options can be applied to individual Cases and
also quickly in a single operation to all Active Cases (those with “Active”
option checked on) as shown below:
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6. Buttons

Button/option Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Autodesign Panel Performs an autodesign reselecting
bars for the current panel

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

Copy Opens a new dialog enabling the
selective coping of wall thickness/
concrete grade/reinforcement from
the selected panel to other panels in
the same wall.

7. Suspend Checking option

By default this option is unselected and checks are made after every edit. For
large structures with many combinations interactive checking takes time which
can be frustrating if you want to make several changes.

When this option is selected, checking is suspended. (The option also changes
to red to highlight that this is the case).

Checks are only carried out and results updated when the option is unselected
once more.

See also

Interactive concrete member design (page 1310)

Concrete slab design
To get familiar with the concrete slab design processes. click the following
links:

• Flat slab design workflow (page 1355)

• Slab on beams design workflow (page 1367)

• Concrete slab design aspects (page 1373)
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Flat slab design workflow
A simple flat slab model as shown below is used in order to demonstrate the
techniques involved in the slab design process.

Note that there is a transfer level at the first floor:
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Set up pattern loading

If necessary you should consider manually splitting and joining slab panels to
facilitate management of the pattern loading process.

By default, only beam loads, and slab loads that have been decomposed on to
beams, are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.

Establish slab design moments

Analysis is required to establish the moments to be used in the slab design -
this analysis is automatically performed when either Analyze All, Design
Concrete or Design All are run.

Typically these moments are taken from the FE chasedown model results - as
each floor is analyzed individually this method mimics the traditional design
approach.

If you have elected to mesh 2-way slabs in the analysis, the 3D Analysis model
results will also be considered.
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NOTE It is NOT suggested that it should be standard practice to mesh 2-way slabs,
for slabs that are not needed to participate in the lateral load analysis it is
better not to mesh in 3D, however: - you may choose to mesh them to cater
for the possibility of un-braced flat slab design. - more likely, you may do so to
deal with significant transfer slabs - e.g. a shear wall supported by a slab,
(there is no need to create a system of fictitious beams).

Consider simple (linear) deflection (US customary units)

Approximate slab deflections can be obtained by reviewing the 2D deflection
contours for the FE Chasedown results in the Results View, (typically by
opening a separate Level view of each floor).

NOTE Deflection results for combinations should be viewed based on "service"
rather than "strength" factors - in this way the applied stiffness adjustments
do not need to account for load factors.

NOTE For Flat Slab panels - Deflection checks are not performed automatically. In
practice flat slab models are often irregular, so some degree of engineering
judgement will be required.

If the Head Code you are working to prevents you from running a Rigorous
Deflection Check you can still use a "Deemed-to-Satisfy" method to assess
deflections utilizing slab strips as outlined below:
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1. With the level view displayed in 2D, click Create Strip and create a strip
between supports.

2. To display the strip results right-click the strip and choose Open Load
Analysis View. The maximum deflection and span of the strip are both
reported.

In this example there is a requirement to limit total deflection to span/240

Taking the span as the length of the slab strip: 288in

Deflection limit: 288/240 = 1.2 in

Actual deflection: 0.9 in - the check passes

The initial check was performed taking the diagonal across a slab panel.
Checks should also be made between the horizontal and vertical spans. More
generally, check the max deflection occurring along a straight line between
any two support points.
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Consider simple (linear) deflection (metric units)

Approximate slab deflections can be obtained by reviewing the 2D deflection
contours for the FE Chasedown results in the Results View, (typically by
opening a separate Level view of each floor).

NOTE Deflection results for combinations should be viewed based on "service"
rather than "strength" factors - in this way the applied stiffness adjustments
do not need to account for load factors.
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NOTE For Flat Slab panels - Deflection checks are not performed automatically. In
practice flat slab models are often irregular, so some degree of engineering
judgement will be required.

If the Head Code you are working to prevents you from running a Rigorous
Deflection Check you can still use a "Deemed-to-Satisfy" method to assess
deflections utilizing slab strips as outlined below:
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1. With the level view displayed in 2D, click Create Strip and create a strip
between supports.

2. To display the strip results right-click the strip and choose Open Load
Analysis View. The maximum deflection and span of the strip are both
reported.

In this example there is a requirement to limit total deflection to span/250

Taking the span as the length of the slab strip: 7317mm

Deflection limit: 7317/250 = 29mm

Actual deflection: 22mm - the check passes

The initial check was performed taking the diagonal across a slab panel.
Checks should also be made between the horizontal and vertical spans. More
generally, check the max deflection occurring along a straight line between
any two support points.
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Select a Level, or sub-model

In models with distinct floor levels you should use 2D Views to work on the
floor design one level at a time. Occasionally the "3D geometry" of a model
may make it less easy to distinguish between individual floors, in which case it
may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check slabs
and patches: this saves time as only the slabs and patches in the current level
are considered. Running Design Slabs or Design Patches from the Design
ribbon will take longer as it considers all the slabs and patches in the model.

Add patches

This is an interactive process - requiring a certain amount of engineering
judgement.

Typically you should expect to work on this one floor at a time, (making use of
multiple views when creating patches as discussed below).

It is suggested that you add patches in the Results View while looking at
relevant moment contours - For example you might (after selecting the FE
chasedown result type) have Mx moments on in one view on the left and My
moments in a second view on the right, as below:
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By doing this, it is possible to see how patches extend over the peaks.

Typically, at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this should
be reviewed/resolved at the patch design optimization stage.

In a "slab on beam" situation, you may want to add beam and wall patches to
cover the full extent of non-zero top bending moments. By doing so you can
then set the top reinforcement in the slab panels to none and the panel design
should still pass.

Design panels

NOTE Panel design is dependent on the areas of patches (patch areas which are
excluded from panel design) - hence patches should be added before panels
are designed.

To design multiple slab panels, either:

• From the Design ribbon run Design Slabs in order to design or check all the
panels in the model - by default newly created panels will all be in "auto-
design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Slabs or Check Slabs. Working in this way restricts the design
or checking to the slab panels in the current view. This will be a much
faster option on large buildings and avoids time being wasted designing
slab panels at levels where patches have not yet been set up.

NOTE When accessed from the right-click menu, these commands operate as
follows:
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- Design Slabs will re-design slabs (potentially picking new reinforcement)
regardless of the current autodesign setting.

- Check Slabs will check the current reinforcement in slabs regardless of the
current autodesign setting.

Review/optimize panel design

Once again it is suggested that you use split Review Views to examine the
results as indicated below.

In this example a number of members are not heavily loaded so you could
consider resizing or designing them interactively.

The view on the left shows Slab Design Status, the view on the right shows
Slab Reinforcement in the panels. Note that the tool tip indicates all panel/
patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a flat slab, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to).

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.
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Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches

Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Design ribbon run Design Patches in order to design or check all
the patches in the model - by default newly created patches will all be in
"auto-design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Patches will re-design the patches (potentially picking new
reinforcement) regardless of the current autodesign setting.

- Check Patches will check the current reinforcement in the patches regardless
of the current autodesign setting.

Review/optimize patch design

At this stage the patch sizes can be reviewed:

• Beam patches - can the width be adjusted (minimized)

• Wall patches - can the width be adjusted (minimized)

• Column patches - Is the size reasonable - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.
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• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the slab reinforcement to be matched (if the slab has
H12-200, then in the patch don't add H12-125, swap to H16-200 - then
there will be alternate bars at 100 crs in this strip of the patch.

Add and run punching checks

Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added over the entire floor, or structure by windowing
it. You can then select any check and review the properties assigned to it.
Internal/edge/corner locations are automatically determined (with a user
override if you require). Once added click Design Punching Shear and the
checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the slab

NOTE In order to see the punching check status in the Review View you might need
to first switch off Slab Items and Slab Patches in Scene Content.

Rigorous deflection check

In Tekla Structural Designer you can choose to adopt a rigorous approach to
slab deflection calculation using iterative cracked section analysis. For futher
details, see: Calculate slab deflections (page 931)
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Create drawings and quantity estimations

Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations

Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

See also

Apply user defined utilization ratios (page 786)

Slab on beams design workflow
A simple slab on beam model as shown below is used in order to demonstrate
the techniques involved in the slab design process.

Note that not all the slab panels are rectangular.
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Set up pattern loading

By default, only beam loads, and slab loads that have been decomposed on to
beams are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.

Establish slab design moments

Analysis is required to establish the moments to be used in the slab design -
this analysis is automatically performed when either Analyze All, Design
Concrete or Design All are run.

Typically these moments are taken from the FE chasedown model results - as
each floor is analyzed individually this method mimics the traditional design
approach.

If you have elected to mesh 2-way slabs in the analysis, the 3D Analysis model
results will also be considered.

NOTE It is NOT suggested that it should be standard practice to mesh 2-way slabs,
for slabs that are not needed to participate in the lateral load analysis it is
better not to mesh in 3D, however: - you may choose to mesh them to cater
for the possibility of un-braced flat slab design. - more likely, you may do so to
deal with significant transfer slabs - e.g. a shear wall supported by a slab,
(there is no need to create a system of fictitious beams).

Select a Level

In models with distinct floor levels you should use 2D Views to work on the
floor design one level at a time. Occasionally the "3D geometry" of a model
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may make it less easy to distinguish between individual floors, in which case it
may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check slabs
and patches: this saves time as only the slabs and patches in the current level
are considered. Running Design Slabs or Design Patches from the Design
ribbon will take longer as it considers all the slabs and patches in the model.

Add beam and wall top patches

You may optionally want to add beam and wall "top surface" patches to cover
the full extent of non-zero top bending moments. By doing so you can then set
the top reinforcement in the slab panels to none and the panel design should
still pass.

This is an interactive process - requiring a certain amount of engineering
judgement.

Typically you should expect to work on this one floor at a time, (making use of
multiple views when creating beam patches as discussed below).

It is suggested that you add patches in the Results View while looking at
relevant moment contours - For example you might (after selecting the FE
chasedown result type) have Mdx top moments on in one view on the left and
Mdy top moments in a second view on the right, as below
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By doing this, it is possible to see how patches extend over the moment
contours.

It is suggested that at the initial patch creation stage you should make the
patches a reasonable size and not be concerned if they are a bit too big - as
this should be reviewed/resolved at the patch design optimization stage.

Design panels

NOTE Slab on beams panel design takes account of any beam or wall patches (by
excluding the patch areas from panel design) - hence patches should be
added before panels are designed.

To design multiple slab panels, either:

• From the Design ribbon run Design Slabs in order to design or check all the
panels in the model - by default newly created panels will all be in "auto-
design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Slabs or Check Slabs. Working in this way restricts the design
or checking to the slab panels in the current view. This will be a much
faster option on large buildings and avoids time being wasted designing
slab panels at levels where patches have not yet been set up.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Slabs will re-design slabs (potentially picking new reinforcement)
regardless of the current autodesign setting.

- Check Slabs will check the current reinforcement in slabs regardless of the
current autodesign setting.
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Review/optimize panel design

It is suggested that you use split Review Views to examine the results as
indicated below.

The view on left shows Slab Design Status, (with slab patches turned off in
Scene Content to assist clarity), the view on right shows Slab Reinforcement in
the panels. Note that the tool tip indicates all panel/patch reinforcement as
you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a slab, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to).

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:
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• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

• If the span-effective depth check is failing, review the panel properties to
confirm that edge categories are set correctly, (and if the panel shape is
irregular consider whether it is being suitably idealized as a rectangular
panel). See: Slab on beam idealized panels (page 1378)

Design beam and wall patches

Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design any beam or
wall patches that you may have defined.

To do this, either:

• From the Design ribbon run Design Patches in order to design or check all
the patches in the model - by default newly created patches will all be in
"auto-design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Patches will re-design the patches (potentially picking new
reinforcement) regardless of the current autodesign setting.

- Check Patches will check the current reinforcement in the patches regardless
of the current autodesign setting.

Review/optimize patch design

At this stage the patch sizes can be reviewed:

• Beam patches - can the width be adjusted (minimized)

• Wall patches - can the width be adjusted (minimized)

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement.
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Create drawings and quantity estimations

Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations

Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

See also

Apply user defined utilization ratios (page 786)

Concrete slab design aspects

Concrete type

While you can apply both normal and lightweight (LW) concrete in the slab
properties, slab design using lightweight concrete is only available for
Eurocodes.

When using other Head Codes slabs can only be designed using normal weight
concrete.

LW density classes and grades

6 Density classes (1.0, 1.2 ….. 2.0) are available and 15 default grades are
provided; 5 in each of the density classes: 1.6, 1.8 and 2.0.

• For example the grade name “LWAC30/37-DC1.8” denotes; LWAC =
Lightweight aggregate concrete; 30/37 = Strength class; DC1.8 = density
class.

• Custom LW grades can be added for which note that new LW-specific
property η1 must be specified.

NOTE LW grades can be reviewed, edited and applied via Review View > Show/Alter
State Material Grade Attribute.

How the load decomposition method affects slab design

Only slabs that have been specified with two-way load decomposition are
designed.

One-way load decomposition in Tekla Structural Designer is a simple
procedure that does not determine slab design forces. When a slab's
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decomposition is set as one-way it is assumed that it is some form of precast
slab (presumably designed by safe load tables).

• A flat slab panel always uses two-way load decomposition.

• A slab on beams panel can either be specified to use one-way or two-way
decomposition - however if it is specified as one-way it cannot then be
designed in Tekla Structural Designer.

It should be noted that any in-situ slab is capable of two-way decomposition:

• When a slab is set as two-way it will only effectively span in 2 directions if
its proportions and support conditions mean that there will be a two-way
effect.

• For example - If a slab that has a span of 6 units in one direction and 50
units in the other is set to two-way decomposition, then although it is two-
way the FE analysis will still inherently take the load one-way.

Two-way spanning slab panel design moments

When a slab panel is specified with two-way decomposition, a general FE
based approach is used to determine the design moments. If you have elected
to mesh 2-way slabs in the analysis, the 3D Analysis results are also
considered:

• The worst design moment (per unit width) is found in each direction of the
slab - if the design moment is zero in one of the directions then the
analysis has shown that the slab is effectively spanning one-way and the
supplied reinforcement in this secondary direction will be selected to suit
the minimum requirements of secondary reinforcement.

• Note that this FE based approach inherently caters for point loads, line
loads, openings, etc and for the possibility of variable adjacent span
lengths in a continuous "1-way" slab (and of course it can still be applied to
the simple case of a "1-way" slab with a uniform UDL applied and uniform
span lengths).

Alignment of slab panel reinforcement

X direction reinforcement is aligned to the panel span, which is determined by
the slab's rotation angle property. Y direction reinforcement is always
perpendicular to the X direction reinforcement.

For further details, see: Rotation angle for panels (page 1380)

Slab panel reinforcement

In a slab you have two surfaces: Top (T) and Bottom (B).

Engineers Handbooks 1374 Concrete member and slab design handbook



In each surface you have two layers of steel in orthogonal directions - X
direction steel and Y direction steel. Layer 1 is the outside layer - the one
closest to the surface. Layer 2 is the inside layer. Which direction is the outer
layer is controlled by this slab panel setting: Outside layer in X direction.

Any of the four layers can be set to "none" if required.

Slab patch reinforcement

Additional rectangular reinforcement patches can be applied to slab panels:

• column patch - at column stack heads

• beam patch - along beams

• wall patch - along walls

• panel patch - at the panel centre

• typically positioned centrally - but not restricted to this location and also
not restricted to existing purely within one panel

• can also be positioned under loads

These patches are either in the top or the bottom of the slab and may or may
not have reinforcement defined in them. If no reinforcement is defined then
the background reinforcement is used. If patch reinforcement is defined then
it will either be used on its own, or if you select the "Combine with Panel
Reinforcement" option, the sum of the background + patch reinforcement will
be used. Note that this option is only selectable when the "Align to Panel
Reinforcement" option is also selected since combining in this way would only
be valid provided the reinforcement is reasonably aligned. Choosing the
reinforcement to be combined also forces the "Cover as Panel" option to be
selected as the program assumes the reinforcement to be in a single layer. If
the reinforcement is not combined you can specify the cover to the patch
reinforcement by turning off the "Cover as Panel" option.

Note that patches may overlap on the plan view, and there is no restriction on
this, even patches relating to the same layer of reinforcement are allowed to
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overlap. This situation is handled conservatively during design by simply
ignoring the overlap.

Each patch manages reinforcement and the reinforcement design using a
number of slab design strips. Some key points to bear in mind considering
patch design are:

• A patch only manages data in the top or the bottom layers of a slab, not
both.

• There can be up to 3 design strips in each direction of a patch

• There is no requirement to have design strips in both directions - there can
be one design strip in one direction and none in the other.

• Within any strip there might be patch reinforcement to consider but note
that:

• The underlying panel reinforcement can be none

• The added patch reinforcement can be none.

• If there is patch reinforcement to consider this can be considered instead
of, or in addition to, relevant slab reinforcement

Slab patch strip design

For the strip designs within each patch it is necessary to establish which bar
layer is to be designed and work out if and how the patch reinforcement
combines with the panel reinforcement.
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As shown above there are 2 distinct options:

1. Patch aligned to panel

2. Patch NOT aligned to panel:

In both cases the reinforcement that is determined for use in the design
checks is some combination of the panel and patch reinforcement. Expanding
upon this the cases considered are:

Patch aligned to panel:

1. Patch reinforcement type = NONE then the panel reinforcement is used
for all layers

2. Combine with Panel Reinforcement = No Then the patch reinforcement is
used in the patch surface and the panel reinforcement is used in the
opposite surface.
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3. Combine with Panel Reinforcement = YES Then the patch reinforcement is
combined with panel reinforcement and used in the patch surface and the
panel reinforcement is used in the opposite surface.

Patch NOT aligned to panel:

Patch reinforcement is used in the surface to which the patch applies.
Reinforcement in the other surface is taken from the panel using the most
aligned possibility.

Patches to both surfaces

As stated above, patch reinforcement is only ever used in the surface to which
a patch applies, reinforcement in the other surface is taken from the panel.

In rare situations you may have separate patches on both surfaces; in which
case you would want the patch reinforcement from the top patch to be
considered on the top surface and patch reinforcement from the bottom
patch to be considered on the bottom surface.

In this specific situation, for both patches the other surface doesn't necessarily
need to be designed to only consider reinforcement in the panel; you can
avoid this by selecting the patch property Consider patch surface moments
only.

Span effective depth checks for irregular shaped panels

Only slabs that have been specified with two-way load decomposition are
designed.

In order to perform span - effective depth checks for irregular shaped beam
and slab panels, they have to be converted to idealized four sided rectangular
panels.

For further details, see: Slab on beam idealized panels (page 1378)

Slab on beam idealized panels

Only slabs that have been specified with two-way load decomposition are
designed.

In order to perform span - effective depth checks for irregular shaped beam
and slab panels, they have to be converted to idealized four sided rectangular
panels.

To do this, the enclosing lengths of the panel in X and Y are first determined,
(local X being defined by the panel rotation angle):

Lx-enc = maximum overall length of the panel measured parallel to local X

Ly-enc = maximum overall length of the panel measured perpendicular to
local X

A user specified adjustment ratio is then applied to these lengths to determine
the adjusted lengths. Conservatively the adjustment ratio defaults to 1.0 in
both directions.
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In situations where the panel does not have 4 sides, (such as the one shown
below), some engineering judgement might be required when deciding on
appropriate values of the adjustment ratios in each direction.

The resulting idealized panel with dimensions in X and Y is illustrated below:.

Edge Category
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For the span-effective depth check, the edge categories in each direction have
to be manually assigned to the idealized slab panel. The three edge categories
being:

• Unsupported

• Continuous Support

• Dis-continuous Support (default)

Rotation angle for panels
The rotation angle in the panel properties is used to control the orientation of
the panel span. For reinforced slabs the X direction reinforcement is aligned to
the span.

Panels defined by a level

When the rotation angle = 0

• Span direction aligns with global X

When the rotation angle = 90

• Span direction aligns with global Y

Panels defined by a frame

When the rotation angle = 0

• Span direction is horizontal

When the rotation angle = 90

• Span direction is vertical

Panels defined by a sloped plane

NOTE In a sloped plane positive Y is always aligned to the up-slope direction, so that
positive X is always perpendicular to the slope.

When the rotation angle = 0

• Span direction aligns with X direction of the slope (i.e. perpendicular to the
slope, as shown below)
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When the rotation angle = 90

• Span direction aligns with Y direction of slope (i.e. parallel to the slope, as
shown below)
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13.7 Slab deflection handbook
This handbook provides an overview of how iterative cracked section analysis
is applied in Tekla Structural Designer for the purpose of obtaining a better
estimate of slab deflections.

NOTE Tekla Structural Designer's iterative cracked section analysis for slab
deflections is only available for the Eurocode and ACI/AISC Head Code.

• Slab deflection methods (page 1382)

• Rigorous slab deflection workflow (page 1384)

• Factors that affect rigorous slab deflection estimates (page 1385)

• Event sequences (page 1393)

• Slab deflection analysis sequence (page 1406)

• Total, differential, and instantaneous deflection types (page 1407)

• Slab deflection calculations in depth (page 1408)

• Check lines (page 1421)

• Slab deflection status and utilization (page 1424)

• Slab deflection example (Eurocode) (page 1426)

• Slab deflection example (ACI) (page 1462)

Related video

Rigorous Slab Deflection (Eurocode)

Rigorous Slab Deflection Design (ACI)

Slab deflection methods
Concrete is considered a durable and economic material for floors systems.
However, reinforced concrete slabs deflect. The magnitude of the deflection is
more complicated for concrete as deflection increases with time. It’s long term
behavior is characterized by cracking caused by flexure, shrinkage and creep.
If this is not taken into consideration by allowing adequate tolerances to glass
facades and internal partitions for example then problems can arise.

Tekla Structural Designer provides two alternative methods for checking
deflections. Either:

• Deemed-to-satisfy checks, or

• A rigorous theoretical deflection estimation using iterative cracked section
analysis
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Deemed-to-Satisfy Checks
A couple of deemed-to-satisfy checks are presented here.

1. The use of a limiting span-to-depth ratio (L/d) method. This method is
assumed to ‘be adequate for avoiding deflection problems in normal
circumstances’. It can only be considered as a rough deflection estimate
and is not intended to predict how much a member will actually deflect.
Total deflection is expected to be < span / 250 (Eurocode) or < span / 250
(US) and deflection affecting sensitive finishes is expected to be < span /
500 (Eurocode) or < span / 480 (US)

2. A linear analysis with adjusted analysis properties.

It is important to appreciate that these deemed-to-satisfy methods do not
predict actual deflections even though the linear analysis method provides a
total deflection that can be checked against the span / 250 (Eurocode) or <
span / 250 (US) limit mentioned above.

When normal deflection limits do not apply, for example, due to stricter usage
limits, glazed cladding systems or where a faster pace of construction is
applied then the ‘deemed-to-satisfy’ checks are no longer applicable - the
alternative is a rigorous deflection estimation which is the primary topic for
this guide.

See also

• Deemed to satisfy slab deflection checks example (Eurocode) (page 1427)

• Deemed to satisfy slab deflection checks example (ACI) (page 1463)

Rigorous theoretical deflection estimation
The rigorous theoretical deflection assessment takes into account cracking,
creep and shrinkage over time.

In the UK, rigorous deflection estimation is taken to mean deflection
estimation in accordance with the Concrete Society Technical Report 58.

The principle of assessing deflections rigorously involves assessing the
curvatures induced by both load and shrinkage, adding them together and
then the total curvature is translated into a deflection.

The Technical Report discusses the importance of construction events. Total
deflection at the end of every event comprises:

• An instantaneous deflection which is influenced by the extent of cracking

• An additional accumulated creep deflection

• An additional accumulated shrinkage deflection.

Once these totals are known, differential deflections between any two events
can be calculated.

The Technical Report gives detailed guidance on some very complex looking
calculations - it all seems very “rigorous”. However, we must not lose sight that
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the material - Concrete is a very variable material. Furthermore, how
accurately can we really predict input parameters such as event loads and
timings? The report advises that deflection accuracy can only be considered an
estimate in the range +15 to -30%.

In the US, the basic approach described in ACI 318 has a similar approach to
cracking, interpolating between the fully cracked and the uncracked states,
(although it doesn’t recognize the reduction in tension stiffening). For creep
and shrinkage, in ACI 318 there is a single multiplier for the deflection
calculated from the cracked flexural rigidity. There are additionally two ACI
Committees 435 and 209 which go into more detail about creep and shrinkage
calculations. The US user can therefore either adopt the basic ACI 318
approach, or, take on board the ACI Committee 435 & 209 guidance. In special
situations the TR58 approach could even be considered.

Expectations - It is incorrect to think that rigorous methods will provide
greater economy. i.e. by allowing the engineer to reduce slab thickness or the
quantity of reinforcement. The end result is greatly influenced by the various
input parameters which each can impact on the deflection.

See also

• Rigorous slab deflection workflow (page 1384)

• Rigorous slab deflection analysis example (Eurocode) (page 1430)

• Rigorous slab deflection analysis examples (ACI) (page 1465)

Rigorous slab deflection workflow
You perform rigorous slab deflection analysis in Tekla Structural Designer
from the Slab Deflection toolbar.

The suggested workflow is as follows:

1. Define the slab loading event sequences (page 1393).

2. Run a slab deflection analysis (page 936) and review deflections for the
final load event.

You can analyze the current or selected level (sub-model) or choose to
analyze every slab in the model. Obviously your choice has an effect on
the time necessary to undertake the iterative slab deflection analysis.

3. Define the slab deflection checks via the Slab Deflection Check
Catalogue and then place Check lines (page 1421) as required.

4. Graphically review the Slab deflection status and utilization (page 1424).

5. Make adjustments as necessary until the status passes. For more
information, see Slab deflection optimization (page 942).
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NOTE A reasonable level of slab reinforcement should be established prior to
running the Slab Deflection Analysis as this will have a significant impact on
the deflection calculations.

Factors that affect rigorous slab deflection estimates
Many input parameters have an impact on the rigorous deflection estimates.
These include:

• Level of Restraint

• Concrete properties

• Stiffness adjustments

• Allowance for shrinkage effects

• Event sequence parameters

• and even the assumed analysis properties of connected columns and walls

Some of the key factors are described below, these vary depend on the head
code being worked to.

Quasi-permanent load factors (EC2)
An accurate prediction of deflection requires a realistic assessment of the
loading. To the Eurocodes long term loads are termed quasi-permanent and a
ψ2 factor is applied to the imposed load which varies based on the use of the
structure. These are dealt with when defining the imposed load case.
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Beta coefficient (EC2)
This property is set in the Event Sequence dialog.
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Beta relates to the duration of the load and tension stiffening effects.

NOTE Tension stiffening occurs when the concrete is not fully cracked -
because there is still concrete in the tension zone that transfers some
tensile forces, the stiffness is greater than that of the fully cracked
stiffness (and less than the uncracked stiffness).

Due to phenomena such as increased cracking or local bond failure, tension
stiffening effects reduce over time - Beta is used to account for these, (see EC2
Clause 7.4.3 and TR58).

• For loads with a short duration, and for cyclic loads, Beta should be set to
1.0.

• For loads with a long duration, Beta should be set to 0.5.

NOTE In Tekla Structural Designer, Beta defaults to 1.0 where the start event
time is <= 30 days and 0.5 if >30 days, but may be changed for any
event.
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Since these phenomena are irreversible, it is not recommended that Events
have a value of Beta greater than that set for any previous Event and a
warning will be issued if you do this.

However, there are circumstances where you may wish to have a value of
Beta=0.5 in the earlier events, and Beta=1.0 in a later Event. For example, TR58
suggests that Beta=1.0 be used for the variable part of imposed load (if you
wish to consider that at all).

In this case the analysis will permit you to enter these values. However,
because the reduction in tension stiffening is carried forward and is
irreversible in the analysis, caution is advised.

To explain this issue more fully, the impact of choosing Beta=1.0 at a later
event, for different extents of cracking, is explored below.

Consider 3 possible configurations of a model, where:

1. There are many elements that are uncracked at the end of earlier events.
For a later event where the duration is short (which implies you should set
Beta=1), setting Beta=0.5 could lead to an overestimation of incremental
cracking, and subsequently overestimation of deflection.

2. There are many elements that are cracked in an earlier event, for which
you have chosen Beta=0.5. For a later event where the duration is short
(which implies you should set Beta=1), if cracking increases in that Event,
setting Beta=1.0 could lead to an underestimate of incremental cracking,
and subsequently an underestimate of deflection for this later event.

3. The majority of cracking occurs in an earlier event, for which Beta=0.5, if
cracking does not increase in a later Event, the value of Beta in that later
Event will have minimal impact on deflection. To ascertain whether the
cracking increases, you may run separate analyses, with values of
Beta=0.5 & 1.0, and compare the results.

In summary, it is prudent to consider whether cracking is likely to increase in
later events for which you wish to set Beta=1.0.

However, it is likely that you will observe minimal difference between the total
deflection estimates, and that other assumed values will be of much greater
significance.

It is straightforward to run the analysis with different values of Beta to
determine whether this is the case.

Restraint type (EC2)
This property is located under the Deflection parameters heading in the slab
item Properties Window.
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NOTE The Restraint type is actually a property of the parent slab, so if you
change it for one slab item it will also be updated for all other slab
items in the same slab.

The value to adopt is a matter of judgment - for guidance on this refer to EC2
cl 7.4.3(4) and TR58

Changing the value will affect tensile strength (fct) and hence cracking
moment.

Restraint constant (ACI)
This property is located under the Deflection parameters heading in the slab
item Properties Window.
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NOTE The Restraint constant is actually a property of the parent slab, so if
you change it for one slab item it will also be updated for all other slab
items in the same slab.

For US customary units, restraint constant values from ACI 435 are:

• For situations with significant restraint - 4.0

• For insignificant restraint - 7.5

The default is conservatively set to 4.0.

The allowable input range is between 1 and 10 and is a user specified value by
the engineer.

The restraint constant is used to determine the Modulus of Rupture, fr =
“restraint constant” x λ x √(fc’)

Where:

fc’ = specified compressive strength (psi)

λ = 1.0 (for normal weight concrete)

Concrete Properties (Eurocode)
The concrete properties that exist as a property of the individual slabs defined
in the model are very important. Stiffness is variable and is aggregate
dependent. The Cement class can also affect deflection.
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The elastic deformation of concrete largely depends on its composition
(especially the aggregates). For C35/45 concrete, Eurocode 1992-1-1:2004
Table 3.1 provides a modulus of elasticity, E of 34GPa (34000 N/mm2) as a mid
range value using quartzite aggregate. For different aggregates this can range
between -30% and +20%.

What is the correct E value for your concrete?

If you know the value, you should set up a new material grade and assign it to
the elements in the model. It may, however, be easier when assessing the
impact, to use the stiffness adjustment option, for details of which see the
Stiffness Adjustments section below.

Concrete Properties (ACI)
The concrete properties that exist as a property of the individual slabs defined
in the model are very important. Stiffness is variable and is aggregate
dependent.
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What is the correct E value for your concrete?

If you know the value, you should set up a new material grade and assign it to
the elements in the model. It may, however, be easier when assessing the
impact, to use the stiffness adjustment option, for details of which see the
Stiffness Adjustments section below.

Stiffness Adjustments
The relative stiffness of the interconnecting elements will play a role in the
force distribution and hence the deflection results.

For existing models the values can be reviewed and amended by clicking
Settings > Modification Factors on the Slab Deflection ribbon. These are user
defined values with assumed defaults.

As mentioned in the above Concrete Properties (Eurocode) and Concrete
Properties (ACI) sections, an alternative to assessing the impact of a different
grade could be to alter the Modification Factors specified for flat slab E and G
values. i.e. Concrete material property of slab = 34000 N/mm2. What impact
would using a value of 32000 N/mm2 make? Flat slab stiffness adjustment =
32000/34000 = 0.9412

Shrinkage
Shrinkage is the strain in hardened concrete that can occur due to moisture
loss.

Shrinkage is taken into consideration by making an overall adjustment to the
total deflection. This approach is in line with many other software products.
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The adjustment is specified in the Slab Deflection Settings dialog.

We recommend an allowance with an upper limit of 30%. The default is set as
0.25 (25%).

Event sequences
An Event sequence defines all the construction stage events that slabs in a sub
model will go through starting from the day the slabs are cast.

By default a model event sequence is initially applied to all sub models in the
structure; if required custom event sequences can also be defined to override
the model event sequence for specific sub models.

NOTE Event sequences are NOT structure event sequences, i.e. they do not
describe all the events starting from the first day of the overall
construction.

Click the links below to find out more:

• Construction stage events (page 1393)

• A typical model event sequence (page 1394)

• Custom event sequences (page 1402)

• Understanding event sequence deflections (page 1405)

See also

Work with event sequences (page 932)

Construction stage events
An Event Sequence defines all the construction stage events that slabs in a sub
model will go through starting from the day the slabs are cast.

Deflection is very dependant on the extent of cracking. Once the slab has
cracked then it is assumed to remain cracked. The tensile stress of concrete
varies with time so careful consideration of load events are required so
predicted stresses can be compared with allowable at the appropriate age.
Propping loads from slabs being cast above are acknowledged to be significant
early loading events which will cause cracking.

In addition to the Final load event, construction stages that could be
considered are:

1. Striking

2. Casting the floor above
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NOTE Propping loads from casting slabs above have an impact on already struck slabs -
dependant upon the extent of back-propping adopted.

Extract from How to design reinforced concrete flat slabs using Finite Element Analysis,
The Concrete Centre - Figure 2

3. Adding Partitions

4. Finishes

A typical model event sequence
Let us consider a multi-storey building where the slab layout is the same on
each level.
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If we think about the slab model event sequence that occurs for the slab at
level 1 it could be something like this:

1. Strike and backprop slab (slab carries it's own weight)

2. Cast Slab above (slab carries a proportion of the weight of slab above - the
proportion is dependent on the number of levels of backpropping and
there is also some debate about the efficiency of load sharing between
the supporting levels. In this example we will assume 2 levels of propping
and that the level directly below supports 60% and level 2 below supports
40%.)
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3. Strike and backprop slab above (slab above now carries its own weight)

4. Cast slab 2 above (slab carries a proportion of the weight of the slab 2
above)

5. Strike and backprop slab 2 above (slab 2 above now carries its own
weight)
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6. If propping extends through 3 levels then there can be events for casting
and striking the slab 3 above. In this example, the propping is removed
and used two levels above.

7. Additional load from finishes (in particular from sensitive finishes)
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8. Start of occupation.

9. Final Load Event

A special note about the Final load event - It is perfectly ok to have multiple
events at the same final time, you should not separate these events by a small
number of days.

The view shown below is a graphical representation of the above but in this
case is recognising 3 levels of backpropping
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Extract from How to design reinforced concrete flat slabs using Finite Element
Analysis, The Concrete Centre - Figure 2

This sort of event sequence can be described within the Event Sequences
dialog as shown below.

NOTE Some of the event parameters vary between headcodes, so both the
ACI and Eurocode versions of the dialog are shown.

Model Event Sequence ACI (US Imperial units)
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Model Event Sequence Eurocode (metric)
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Note the increased slab self weight when casting slab 1 above and slab 2
above where an additional 60% and 40% of the slab weight is being supported
respectively. This is defined in the On submodel % column.

A slab model event loading sequence for any other internal slab i.e. level 2
would be identical to that described above.
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If we now consider the uppermost slab - the roof.

• Is the slab event sequence for the roof any different?

• Can we use the slab model event sequence above for the roof?

The event sequences for casting any slabs above are not required, since there
is no need to make an allowance for additional propping loads. This means
that a different event sequence is necessary to deal with the roof. In Tekla
Structural Designer differences in event sequences are dealt with using a
Custom Event Sequence.

Technically, we could deal with the propping events in one of two ways.

1. Delete the event

2. Keep the event, but adjust the included slab self weight to allow only for
the roof load as the previous event. i.e the event has no change in load to
that of the previous load event.

In Tekla Structural Designer, we must deal with the change using method 2
above. This is due to the way Tekla Structural Designer deals with Custom
event sequences (page 1402).

See also

Custom event sequences (page 1402)

Custom event sequences
Custom event sequences are required to deal with different slab loading
sequences, such as for the roof slab and special cases like transfer slabs.

A custom event sequence can be created via the Add button on the Event
Sequences page (highlighted below).

Once it has been added and given a name you can then edit the Custom event
sequence by selecting it in the list.
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Editing a custom event sequence

When first added, a Custom Event Sequence is identical to the Model Event
Sequence. It therefore needs to be edited to achieve the required slab loading
sequence.

In the screenshot below, to create a custom event sequence for the roof we
have edited the slab self weight load in the Cast slab 1 above and Cast slab 2
above events to 100% i.e. it is only supporting the roof slab self weight and not
any extra propping load from any slabs above.

Custom Event Sequence ACI (US Imperial units)

Custom Event Sequence Eurocode (metric)

Engineers Handbooks 1403 Slab deflection handbook



It should be noted that it is not possible to Add, Insert, Remove or change the
order of Custom event sequences. It is also not possible to alter any item that
is greyed out within the table. This includes events and loadcases. You can,
however, edit the Load start time, Number of Exposed faces, Construction
loads and the % of load to apply in the combinations (and if working to ACI:
Ultimate Creep and Aging Coefficients; or if working to Eurocodes: Beta,
Temperature, Relative Humidity). This could mean that careful consideration
of the slab model event sequence is necessary to ensure any necessary events
are included.
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Assigning a custom event sequence to a submodel

When first added, a Custom Event Sequence is identical to the Model Event
Sequence. It therefore needs to be edited to achieve the required slab loading
sequence.

You can assign different event sequences to different submodels (slabs) using
the Submodels page of the Load Event Sequence.

In the screenshot below, the slab model event sequence is assigned to all
slabs, except the roof, which has its own custom event sequence defined.

Hence, when you run a rigorous slab deflection estimate on a selected slab, it
runs the Load Event Sequence specified on the Submodel page above.

Understanding event sequence deflections
The model described in A typical model event sequence (page 1394) consists 3
identical levels and then a roof level with different loading applied. To cater for
this a Custom Event Sequence has been applied to the roof submodel.

When you run Slab Deflection > Analyse All for this model, 4 sub-models are
dealt with one after the other:

• Each one considers 9 events

• Each one does an iterative cracked section analysis at every one of these
events

• assume say, average of 20 iterations in each cracked section analysis

• That's 180 analyses for each sub-model - over 700 analyses for the
whole structure.

• There is an additional instantaneous analysis for each event.

After analysis the deflections can be reviewed for individual events. The view
below shows the deflections for Event 4 “Cast slab 2 above”.
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Event 4 ends when the slab is 27 days old. The view above is the deflection
estimate when each of the slabs are this age. These things don't happen at the
same time but it's a very convenient way to display things.

Initially, this has the potential to be confusing, however it should be easy to
understand provided you remember that:

• Event Sequences are “Slab Event Sequences”. They describe the events a
slab goes through where Day 0 = the day the slab is cast.

• Event Sequences are NOT structure event sequences. They do not describe
the all the events starting on day 1 of the overall construction.

Slab deflection analysis sequence
The same basic process is followed irrespective of whether the current level
(sub-model), a selected level, or all slabs in the model are analyzed.

In simple terms, events are considered in sequence.

For each event:

• An iterative cracked section analysis including long term effects determines
the deflection at the end of the event.

• An additional analysis using the determined state of cracking along with
short term cracked properties is undertaken to calculate the total
instantaneous deflection associated with the event.

• The state of cracking is carried forward to the next event as the starting
point.

Engineers Handbooks 1406 Slab deflection handbook



Having run a Slab Deflection Analysis the following analysis results are then
available to review for either the chosen level (sub-model) or the entire
structure dependent upon your chosen analysis

• Deflections (page 1407) - Three deflection types are available: Total,
Differential, and Instantaneous.

• Extent of Cracking (page 1411) - You can also review contours to display the
extent of cracking at any load event.

• Relative Stiffness (page 1413) - You can also review the relative stiffness in
a particular result direction for any specified event.

• Effective Reinforcement (page 1415) - You can also review the area of
effective reinforcement for a chosen result direction for each FE element.

Total, differential, and instantaneous deflection types
Once the slab deflection analysis has been run, three deflection types are
available for review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End of
Event).

• Instantaneous deflection (not actually needed for TR 58).

• This is the deflection when the entire event loading is applied to a
version of the model using the established extent of cracking along with
short term analysis properties.

• US codes require an assessment of the instantaneous deflection
associated with the imposed load only. This is achieved by adding extra
events at the same time as the final event where only the required
imposed load is applied.

Understanding differential deflections

When looking at differential deflections it is important to appreciate that an
event is not a single point in time, it is a time period which has different
deflections at the start and the end - so it is logical that there can be a
differential deflection for a single event.

To clarify the selections requested in the ribbon:

• Start Event defines the start of the start event

• Event defines the end of the event

Therefore, if you specify the same event as the start and the end event, you
will still see a differential deflection.

To clarify further, consider the scenario below:

• Event 1 - Construction loading
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• Event 2 - Application of Sensitive Finishes

• Event 3 - Application of Additional Finishes

• Event 4 - Occupation (all loading with live load set at long term factor)

• Event 5 - Final loading event (as above with live load set at 100%)

To determine the maximum differential deflection relevant to the application
of sensitive finishes you would define this as the deflection between Events 2
and 5 (Start of Event 2 to End of Event 5). If you opted to pick Events 1 and 5
you would get an un-conservative deflection reported since the effect of
construction loading is also considered.

Slab deflection calculations in depth

Interrogating slab deflection calculations
Tekla Structural Designer's Slab Deflection Analysis is not a "black box" - the
calculated results are all exposed for interrogation as required.

Several different Results views are available: Deflection, Extent of Cracking,
Relative Stiffness and Effective Reinforcement. There is also a Composite
modulus report available for each slab.

To help pull all the results together, the items noted above are tied together in
the following way:

1. Every element is part of a slab item. Each slab item can have different
effective concrete properties.

The best way to understand this is to look at the summary of information
from the Composite Modulus report for each event and consider things
like:

• Adjusted event times due to temperature and cement class

• Adjusted creep properties due to the number of exposed faces

• Incremental loading factors

• The Composite Modulus Calculation

2. Every shell element can have different Effective Reinforcement:

• This is determined automatically

• The Effective Reinforcement results view allows you to confirm the
values used.

3. Cracking and Stiffness Calculations for each event:
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• This is dependent upon the effective concrete properties, effective
reinforcement, and the forces that develop

• So this calculation is unique for each direction of each shell for each
event.

• The stiffness of cracked sections is dependent on the degree of cracking
- so the procedure is iterative (force -> stiffness -> new force, etc)

• At the converged conclusion of this you can see (and check):

- the extent of cracking via the Extent of Cracking results view

- the stiffnesses determined via the Relative Stiffness results view

Composite creep
Design codes typically provide a way of calculating an effective creep modulus
at time, t for a constant load/stress applied at time t0. Typically this is
presented as ϕ(t, t0).

An effective Young's Modulus is then calculated as Ec, eff (t, t0) = Ec,28 / [ 1 + ϕ(t,
t0) ]

However, codes typically do not give guidance on how to deal with a loading
history where loads vary over the time period being considered.

Technical Report 58 introduces guidance on this topic and proposes a method
by which the loading history can be taken into account. (Reference Section
8.4.1, equation 8.37 and also the example on page 36):

Where:

n = event under consideration

wi = incremental load in event i (= load in event i - load in event (i-1)) (note that
this will be a negative value when load is removed)

Eeff,i = Ec, eff (tend,n, ti) (i.e. covers period from start of event i to end of event n)

The above is logical when you consider a single member subjected to a
constant loading arrangement that is increased or decreased at each event.
However, when you consider an entire slab with many panels receiving
different loading increments in different events it does not seem reasonable
to consider all the panels together. Two examples of this are:

1. Why should the addition of cladding loads affect internal panels to the
same extent as edge panels?

2. In a transfer slab why should panels that don't support columns be
affected to the same extent as those which do?
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The aim of TR58 is clear, in that loading on a span/panel is taken as an
indication of stress. What this fails to consider is that loading on another span/
panel can also induce stress (although in most situations this will be a
secondary effect). It is also clear that you do not actually need "loads", you just
need "relative loads" or some other measure of the relative work done in each
event. With this in mind a more general approach has been developed where
the relative "work done" by each panel is determined by considering the strain
energy in each event:

1. Calculate total strain energy 'Q0' for each Slab Item for a unit load case

• 'Q0' = sum of 2D Element strain energies

2. For each Load Event 'i'

• Calculate incremental strain energy 'Qi' 'Qi' = sum of incremental 2D
Element strain energies

• Calculate equivalent incremental load factor 'λi

' λi = Qi / Q0

3. Ecomp can be established from the equation below where "incremental
work done" replaces "incremental load" in the TR58 equation.

There is an array of intermediate values which lie behind the calculation of the
composite modulus, Ecomp for each slab item, for each event. The composite
modulus calculation is provided as an excel spreadsheet report.

You can either generate a report for a chosen slab, selected slabs or all slabs,
dependant upon your selection method.

• To obtain slab modulus reports for all slab items, right click anywhere in a
scene view and choose Export Eff. Modulus report to Excel > For all slab
items

• To obtain slab modulus reports for selected slab items, select the slabs in
the structure view regime, right click anywhere in the scene view and
choose Export Eff. Modulus report to Excel > For selected slab items

• To obtain slab modulus reports for a chosen slab items, right click a slab
panel in the structure view regime and choose Export Eff. Modulus report
to Excel > For current slab items

A typical composite modulus report for a slab panel is shown below.
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It should be noted that Tekla Structural Designer takes into account the
cement class when determining the temperature adjusted age of loading so
minor variations will occur.

The effective modulus is used in determining the properties for each load
event.

Extent of cracking
The effective modulus, and the effective reinforcement are used to determine
the cracked or uncracked state of each shell for each event, for each direction.

Eurocode 2 provides an expression that predicts the behavior between the
cracked and uncracked states. This expression uses a Distribution factor, ζ
that apportions the behavior between a fully-cracked state (±1.0) and an
uncracked state (0) for interpolating the stiffness when a state of partial
cracking exists.

ζ = 1 - ß (Mcr / M)2

Where:

• ß is a user defined value specified in the Event Sequences and is either: 1.0
for single short-term loading 0.5 for sustained loads or many cycles of
repeated loading

• Mcr is the hogging (positive) or sagging (negative) cracking moment.

• Ma(+|-) is the relevant Wood-Armer moment in the direction for which the
display is shown (X or Y). This is calculated from Mx, My & Mxy in the usual
way, when determining the extent of cracking for a shell element for each
iteration for each Event.

If you view Extent of Cracking results for a chosen result direction and cycle
through the events you will see each of the FE elements shaded to indicate the
extent of cracking.

At the first sign of cracking, Mcr > Ma. If you hover over an FE element the
tooltip provides some intermediate calculation results to verify this
distribution factor.
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The tooltip shows the applied moment for the Event in question, rather than
the worst moment of all Events up to and including the one being looked at -
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this allows engineers to deduce that a greater level of cracking was caused by
an earlier Event.

Relative stiffness
The tooltip provides detailed information on the relative stiffness calculations.
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The tooltip lists:

• Ec28 : Edb*1.05*stiffness adjustment factor. (Where Edb = the short term
modulus from the concrete materials database). The stiffness adjustment
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factor used is determined from the Slab Deflection ribbon > Settings >,
Modification Factors page. Provided for information - not directly used in
any analysis.

• Ec28+As : the short term modulus including for reinforcement. Provided for
information - not directly used in any analysis.

• EST(i) : the short term modulus used in the instantaneous analysis (i.e.
includes area of reinforcement and cracking if cracking has occurred) for
the selected event.

• ELT,C(i) : the modulus used in the final iteration of long term deflection
estimation (i.e. includes area of reinforcement and cracking if cracking has
occurred, and effective creep) for the selected event.

• ELT,C&S(i) : ELT,C(i) with further adjustment to allow for effect of shrinkage (=
ELT,C / multiplier) for the selected event. The shrinkage multiplier to
determine the shrinkage contribution is determined for the chosen event
based upon the ratio of the maximum panel Z deflection (including
shrinkage) / total Z deflection (excluding shrinkage). This provides an
indication of the overall effective stiffness adjustment. Provided for
information - not directly used in any analysis.

Based on the modulus, E defined above, a number of ratios are provided in
the tooltip for the chosen result direction.

• Short Term Uncracked = Ec28+As / Ec28

• Short Term + Cracking = EST / Ec28

• Creep + Cracking = ELT,C / Ec28

• Creep + Cracking + Shrinkage = ELT,C&S / Ec28

Effective reinforcement
Effective reinforcement for each shell element is also required for the
determination of the shell's effective properties at the end of each load event.

The effective reinforcement used in the property calculations are reported to
you in the 4 layers for every shell element. The information is provided as a
color coded shell display from minimum to maximum reinforcement area.
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If you hover over a shell the tooltip provides the following information:

• Axt : X Top Effective Reinforcement.
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• Dxt : Distance from the section centroid to the center of X top
reinforcement.

• Axb : X Bottom Effective Reinforcement.

• Dxb : Distance from the section centroid to the center of X bottom
reinforcement.

• Ayt : Y Top Effective Reinforcement.

• Dyt : Distance from the section centroid to the center of Y top
reinforcement.

• Ayb : Y Bottom Effective Reinforcement.

• Dyb : Distance from the section centroid to the center of Y bottom
reinforcement.

Shrinkage allowance
Shrinkage is the strain in hardened concrete that can occur due to moisture
loss.

• Eurocode 2 provides a method to estimate shrinkage strains and
curvatures based on exposed surface area, member size, relative humidity
and reinforcement quantity and position.

• Asymmetry of reinforcement leads to curvature which leads to deflection. It
is estimated this effect can contribute up to 30% to the long-term
deflection.

• Technical Report 58 provides a theoretical method of estimating the
additional shrinkage deflection effect in the analysis

At this time the TR58 method has not been implemented within Tekla
Structural Designer. Shrinkage is taken into consideration using a multiplier,
by making an overall adjustment to the total deflection (excluding shrinkage)
in line with simpler adjustment proposals of the ACI code. This approach is in
line with many other software products.

The simplest ACI approach makes an allowance for all long term effects (creep
and shrinkage) by using an adjustment factor. This is based on the graph
below and also provides some specific values.
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Time Multiplier for long-term deflections
5 years or more 2.0
12 months 1.4
6 months 1.2
3 months 1.0

Note that we said shrinkage effects and not creep and shrinkage. Creep is
dealt with rigorously in Tekla Structural Designer so we need to ascertain the
proportional effect of shrinkage only. ACI 435 provides some indication of the
separate contribution of creep and shrinkage.

Table 4.1 - Multipliers recommended by different authors

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

Engineers Handbooks 1418 Slab deflection handbook



Comparing the different sources the ratio of shrinkage is as follows:

• Sbarounis 1.2 / 5 = 24%

• Branson 1 / 4 = 25%

• Graham and Scanlon 1 / 3.5 = 28%

(ignore higher modulus of rupture because reduced values are considered
automatically in the cracked section analysis).

The above provides a shrinkage ratio of between 24% and 28%. Hence we
recommend a value of between 20%-30% is used. A 25% default is provided
via the Slab deflection ribbon > Options dialog and the Creep and Shrinkage
page.

The total deflection due to shrinkage effect is determined based on an
identified “Total Shrinkage Event” towards the end of the event sequence. The
event sequence with the latest load start time is used for calculating the
shrinkage adjustment. If multiple events exist with the latest load start time
then the first one is considered.

A special note about the Final load event - It is perfectly ok to have multiple
events at the same final time, you should not separate these events by a small
number of days.

Using this “total shrinkage effect” we can then assign a proportion of the total
shrinkage to each event.

With reference to earlier versions of ACI 435 (1966) on which the values in the
graph above are based, additional values for 1 month and 3 years can be
obtained. This follows the case where As’ = 0 (because compression steel is
allowed for differently in the code). By comparison with the graph above, we
can see closely matched values.

Duration of
loading

Factor F

 As' = 0 As' = 0.5As As' = As
1 month 0.58 0.42 0.27
3 months 0.95 0.77 0.55
6 months 1.17 0.95 0.69
1 year 1.42 1.08 0.78
3 years 1.78 1.18 0.81
5 years 1.95 1.21 0.82

The values we have adopted for considering shrinkage effects are as tabulated
below. The final column provides the proportion of the total shrinkage at a
given time.
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Time Long Term Effects
Factor

Proportion of Total
Shrinkage

0 0 0.00
1 month 0.6 0.30
3 months 1 0.50
6 months 1.2 0.60
1 year 1.4 0.70
3 years 1.8 0.90
5 years and above 2 1.00

From the above, for any event, the end of event time is used to calculate a
“Proportion of total shrinkage” using linear interpolation between the values
discussed in the table above.

Deflection calculations on the Z deformation are then adjusted to account for
shrinkage effects.

As an example, let’s assume the following event sequence.

• Event 1 = 7 days, Event 2 = 10 days, Event 3 = 17 days, Event 4 = 20 days,
Event 5 = 27 days, Event 6 = 2 months, Event 7 = 6 months, Event 8 = 1 year
and Event 9 = 70 years

Assuming a shrinkage factor of 25% (user defined input value), a basic
multiplier can be determined = 1/(1-25%) = 1.333

Event 9 Final event at 70 years analysis deflection (excluding shrinkage) =
32.4mm

Therefore, the Total deflection (including shrinkage) = 32.4 x 1.333 = 43.2 mm

Total Deflection from shrinkage alone is 43.2 - 32.4 = 10.8 mm

We can now apportion this deflection due to shrinkage, to each event based
upon the event time and a proportion value.

i.e.

At 0 days proportion of total shrinkage is 0, At 1 month proportion is 0.3.
Therefore using linear interpolation between these values;

• Event 1 (7 days) Shrinkage multiplier = 0.3 * 7/30 = 0.07

• Event 2 (10 days) Shrinkage multiplier = 0.3 * 10/30 = 0.1

• Event 3 (17 days) Shrinkage multiplier = 0.3 * 17/30 = 0.17

• Event 4 (20 days) Shrinkage multiplier = 0.3 * 20/30 = 0.2

• Event 5 (27 days) Shrinkage multiplier = 0.3 * 27/30 = 0.27

At 1 month proportion of total shrinkage is 0.3, At 3 month proportion is 0.5.
Therefore using linear interpolation

• Event 6 (2 months) Shrinkage multiplier = 0.4
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At 6 month proportion of total shrinkage is 0.6

• Event 7 (6 months) Shrinkage Multiplier = 0.6

At 1 year proportion of total shrinkage is 0.7

• Event 8 (1 year) Shrinkage Multiplier = 0.7

At 70 years proportion of total shrinkage is 1.0

• Event 9 (70 years) Shrinkage Multiplier = 1.0

The Shrinkage deflection that occurs at each event is then the total shrinkage
10.8 mm x the shrinkage multiplier calculated above.

• Event 1 (7 days) Shrinkage = 0.07 x 10.8 = 0.76 mm

• Event 2 (10 days) Shrinkage = 0.1 x 10.8 = 1.08 mm

• Event 3 (17 days) Shrinkage = 0.17 x 10.8 = 1.84 mm

• Event 4 (20 days) Shrinkage = 0.2 x 10.8 = 2.16 mm

• Event 5 (27 days) Shrinkage = 0.27 x 10.8 = 2.92 mm

• Event 6 (2 months) Shrinkage = 0.4 x 10.8 = 4.32 mm

• Event 7 (6 months) Shrinkage = 0.6 x 10.8 = 6.48 mm

• Event 8 (1 year) Shrinkage = 0.7 x 10.8 = 7.56 mm

• Event 9 (70 years) Shrinkage = 1.0 x 10.8 = 10.8 mm

For each event, the total deflection (including shrinkage) reported in the Slab
deflection view regime and the tooltips is the event analysis deflection
(excluding shrinkage) + the proportion calculated above using the shrinkage
multiplier.

Check lines
Check lines - a unique feature inTekla Structural Designer - provide a practical
way to automate deflection checking and reduce the possibility of errors.

Each check line defines a line along which deflection checks are required.
Multiple check lines can be created and each line can have several different
deflection checks performed (against either a total, instantaneous, or
differential deflection limit).

Whilst the check lines have to initially be positioned using engineering
judgment, once they are in place they provide an instantaneous means to
evaluate revised deflections following changes to the model parameters and
re-analysis.

Assessing slab deflections without check lines would be quite an arduous task,
since deflection limits are of the form (span / fixed value) and the spans can
vary on an irregular slab, hence the permissible limit would also vary.
Furthermore, you may wish to check total or differential deflections at or
between different load events. Would the critical location be obvious?
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Setting up the checks in advance (via the slab deflection check
catalogue)
The deflection checks to be performed for the check lines are set up in the
Slab Deflection Check Catalogue (page 2425) before the check lines are
positioned.

Each check in the catalogue is specified as a Total, Differential or
Instantaneous deflection limit that is checked for a specified event, (or in the
case of a Differential check between the start of an event and the end of an
event).

Related task Create the deflection checks to be applied to check lines
(page 935)

Application of check lines
The application of check lines is an iterative activity. They should be created at
all locations where you deem deflection checks to be required.

Check lines can only be created in a 2D view. If the Create command is greyed
out ensure you switch to a 2D view.

When you click Create, the Properties Window automatically includes those
slab deflection checks from the Slab Deflection Check Catalogue where "Use in
new Check Lines" was checked. Note that a maximum of six checks can be
assigned to a single check line; if you require more than six checks, then
multiple check lines can be applied at the same location.

You can add further checks from the catalogue or add new checks directly
from the Properties Window.

You can also edit the "Use in New Check Lines" option in the catalogue prior to
running the Create command to change the default checks automatically
assigned to each new check line.

Related task Create a check line (page 935)

Displaying check line results
The Check Line deflection can be overlayed on the slab by using the
Deflections command in the ribbon, it is perhaps easier to visualize if you
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switch the view to a 3D view of the slab using the 2D/3D toggle button in the
bottom right of the window.

You can also right click on a check line and open the deflections check view.
This displays a cut line through the slab, showing the deflected shape with the
maximum and minimum deflection values. Beneath this it also draws the
average slopes between maximum and minimum points and reports the
average slope ratios.

The above deflection check view is controlled from the Loading Analysis ribbon
which has droplists to enable you choose the Result Type (Total,
Instantaneous, or Differential) and the Event(s).

The average slope ratios (for the appropriate result type/event) are checked
against the deflection limits that have requested for the check line.

Doing the checks this way inherently deals with offset peak deflections (non-
uniform load) and also cantilevers.

Related task Display check line results (page 939)
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Check line reports
A tabulated report is available for each check line which itemizes each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

You can also generate a Slab deflection check line report for the entire
structure, selected level, planes or sub structures via the Model Report
command on the Report ribbon.

Related task View slab deflection reports (page 942)

Slab deflection status and utilization
The status and the utilization can be graphically displayed for both Check lines
and slabs.

Check lines Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical utilization ratio

Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check lines
are automatically re-checked so you will obtain instant feedback on status and
utilization.

Related task: Display check line status and utilization (page 939)

Slab Deflection Status and Utilization

Slab deflection status is determined for each slab item as the worst status
from all associated check lines detected within the slab item or touching the
slab item boundary.
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In the above status view:

1. No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so the
slab reports Unknown as no checks have been performed

2. One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.

3. A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, all other slab items
Fail.

Slab deflection utilization is similarly determined for each slab item as the
worst utilization from all associated check lines.
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Related task: Display slab deflection status and utilization (page 940)

Slab deflection example (Eurocode)
In the following exercise slab deflections will be checked for the tutorial model
shown below.

It is a simple multi-bay flat slab structure on an 8m square grid of columns.
The slabs have been sized based on deemed-to-satisfy rules taken from
“Economic Concrete Frame Elements to Eurocode 2 - The Concrete Society”.
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Geometry:

• 8m grid

• 285 thick C30/37 slab

• 400 square columns

Loading:

• Finishes - 1.5kN/m2

• Imposed - 5.0kN/m2

• Perimeter Cladding - 10.0kN/m

Deemed to satisfy checks (page 1427) provide one method of checking,
however the main focus of the exercise will be to investigate rigorous slab
deflection checks (page 1430).

Deemed to satisfy slab deflection checks example (Eurocode)
A simple way to assess slab deflection in Tekla Structural Designer is to run a
linear analysis using adjusted analysis properties, and then check the resulting
deflections by manually determining critical spans.
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Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection EC.tsmd

Perform Linear Analysis

1. From the Analyze toolbar, click Analyze All (Static)

2. Open a view of the Typical floor level

3. Switch to the Results View

4. From the Results toolbar, review 2D deflections for the FE chase-down
analysis for the load combination 1, service load results 
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Identify critical check locations

We can see that the maximum reported deflection is 38.9mm, occurring in the
middle of a corner bay. This should be assessed by taking the slab span
diagonally across the bay.

NOTE In 'real world' flat slabs some engineering judgment might be required when
assessing which deflections and span lengths require checking.

Guidance exists in How to Design Concrete Structures using Eurocode 2, The
Concrete Centre, Figure 9

In our example, taking the diagonal dimension across the columns, the
deemed-to-satisfy span / 250 rule provides a deflection of [√(80002+80002)] /
250 = 45.3mm.

This compares favorably.

NOTE Remember, the method does not predict actual deflections. The total
deflection is simply expected to be less than span / 250.

Concrete properties used in the analysis

The Tekla Structural Designer deflection result is completely dependent upon
the concrete elastic modulus used in the analysis which is adjusted by a
modification factor to consider such things as creep, cracking and shrinkage.

The modification factor is set from the Settings dialog on the Analyze ribbon.
As shown below, for the FE chase-down analysis of flat slabs this defaults to
0.2.
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Rigorous slab deflection analysis example (Eurocode)
There are many input parameters that will have an impact on the rigorous
deflection estimates and would therefore need to be considered. For details
see: Factors that affect rigorous slab deflection estimates (page 1385)

For this exercise, initially it will be assumed that the default settings have
already been reviewed and set as required.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection EC.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)
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2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Review the Model Event Sequence

To review the model event sequence:

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence 

This has already been setup for this example as shown below:

Deflections to the end of each of the above event periods will be
calculated by the analysis.
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3. Click OK to close the dialog.

Perform Iterative Slab Deflection Analysis

To establish some initial results (with all parameters left as default values) you
could just click Analyse All from the Slab Deflection toolbar, however, in a real
model rather than analysing all levels at once, it can be more efficient to work
on just the current level, or a selected level. Obviously considering just a single
level reduces the time necessary to undertake the iterative slab deflection
analysis.

1. Open a 2D plan view of the level Typical floor

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

Review Deflections for Events

Deflections can be reviewed for each event by making selections from the
Event droplist in the ribbon.

You are able to review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End of
Event).

• Instantaneous deflection (not actually needed for TR 58).

The image below shows total deflection contours for the final load event.

Engineers Handbooks 1432 Slab deflection handbook



NOTE To see the image as shown, you may need to adjust some of the
selections in Scene Content, for example Slab Patches should be de-
selected.

As a comparison with the simple approach earlier (39.7mm), the Total
deflection at the final load event for the chosen location is 35.2mm.
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NOTE In the above contour plot the deflections are not exactly symmetrical -
this is because reinforcement is in the outer layer in the Y direction
making the slab stiffer in that direction.

Total deflections to the end of each of the event periods in the Event Sequence
are available and could also be displayed as required.

In the Event Sequence there is an event for “Sensitive Finishes added” - we
shall now show differential deflection between this and the final event.

1. From the Slab Deflection toolbar, change the Result Type to Differential

2. Select the Start Event as Sensitive Finishes added

3. Select the Event as Final load event 

The 2D view now displays the differential deflections between “Sensitive
Finishes added” and the final event.
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Review Other Results

In addition to the deflections you can display the extent of cracking at any load
event.

You can also review the relative stiffness in a particular result direction for any
specified event.

You can also review the area of effective reinforcement for a chosen result
direction for each FE element.

1. Select the Result as Extent of Cracking, and then:

a. Select the Result Direction as X,

b. Select the Result Type as Total,

c. Select the Event as Propping removed,

The extent of cracking for the Propping removed load event is displayed.
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2. Select the Result as Relative Stiffness, and then:

a. Select the Result Direction as X - Creep + Cracking + Shrinkage,

The relative stiffness for the Propping removed load event is displayed.
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3. Select the Result as Effective Reinforcement, and then:

a. Select the Result Direction as X Top,

The effective reinforcement for the X Top direction is displayed.
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NOTE When you hover over any FE element in the slab deflection view
regime - values are provided within the tooltip.
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Define Check Line Deflection Checks

Check lines have to initially be positioned using engineering judgment.

The deflection checks associated with each check line are selected from a
predefined Deflection Check Catalogue. This is viewed by clicking Deflection
Checks in the ribbon.

You can add new checks to the catalogue as required.

1. From the Slab Deflection toolbar, click Deflection Checks 

Whilst three checks have been defined above, only two of these have
been set to be used in new Check Lines:

• Sensitive finishes will check the differential deflections from when the
sensitive finishes are applied to the final load event against a
deflection limit of 1/500

• Total will check the total deflections to the final load event against a
deflection limit of 1/250

2. Click OK to close the dialog.

Place Check Lines

NOTE Check lines can only be created in a 2D view.

We will define several check lines in this example:

1. Ensure you are in the Typical floor 2D plan view and if necessary change:

a. the Result back to Deflections,

b. the Result Type to Total,

c. the Event to Final load event

2. Click Create 

NOTE When you click Create, the Properties Window automatically
includes the slab deflection checks from the catalogue for which
“Use in new Check Lines” was checked.
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3. To place the check line at approximately mid-span between grid lines 4-5
from grid line A to E:

a. Pick the start point to the left of grid line A as shown: 

b. Pick the end point to the right of grid line E as shown: 

c. Press Esc to end the command.

4. Right click on the check line and choose Open deflections check view
from the context menu. 
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The deflection results along the length of the check line are displayed.

The Slab Deflection toolbar allows you to specify the total (as shown
above), or differential or instantaneous results for the selected events.
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Tekla Structural Designer then draws average slopes between maximum
and minimum points.

If we return to the original deemed-to-satisfy check - this was performed
diagonally between columns in bottom right corner panel of the slab - we
will now revisit this using a check line.

5. Create a check line running diagonally between columns in bottom right
corner panel (from D/1 to E/2) where the peak deflection occurs. 

6. Right click to open the deflections check view for the new check line. 

A total deflection limit of Span / 250 is the same as saying that the average
slope between points of maximum and minimum deflection = 1 / 125. In
the view above the average slope between these points is 1 / 155, i.e. less
than the limit.

Doing the checks this way inherently deals with offset peak deflections
(non-uniform load) and also cantilevers.
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Generate Check Line Reports

A tabulated report is available for each check line which itemises each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

1. Return to the Typical floor 2D view, right click on the diagonal check line
and select Report for Member 

As previously noted, the slope above is reported as 1:155 which is not less
than the allowable slope limit of 1:125 and hence a Pass.

If you click within the Load Analysis Deflection view, the ribbon changes to
allow you to display deflection results and slopes for the Result Type -
Total or Instantaneous for a chosen event, or Differential between chosen
events.

2. Switch to the Load Analysis Deflection view for the diagonal check line.

3. From the Slab Deflection toolbar, change the Result type to Differential
and check deflection and slopes between theSensitive finishes added
and Final load event. 

We can add as many check lines to the model as we consider appropriate.
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4. Return to the Typical floor 2D view.

5. Add three further check lines using the default deflection checks in the
catalogue as follows:

a. along grid line 1, from A/1 to E/1

b. along grid line B, from B/1 to B/5

c. half way between grid line A and B, starting at grid line 1 and finishing
at grid line 5

6. Press Esc to end the command. 

If you select each Check Line in turn you are able to edit the deflection
checks associated with it in the Properties Window.
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7. Select the check along grid line that runs along grid line 1 and ensure that
it also has a Check #3 defined as Cladding. 

Review Check Line Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio.

1. Click on the Typical floor 2D view to make it active.

2. To make it easier to see the check lines, change the Result droplist from
Deflections to None.

3. Click Status in the Check Lines group of the ribbon to see the pass/fail
status graphically displayed for each check line. 
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TIP You can also hover over a check line and the tooltip displays the
utilization and pass/fall status.

4. Click Utilization in the Check Lines group to show the critical utilization
for each check line and investigate the tooltip results. 
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Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check
lines are automatically re-checked so you will obtain instant feedback on
status and utilization

Review Slab Status and Utilization

Every check line is associated with at least one slab item. If all checks lines
associated with the slab item pass then the slab item passes.

Both the Status and the Utilization can be reviewed.
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1. Click Status in the Slab Deflections group of the ribbon to see the pass/
fail status of each slab. 

• No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so
the slab reports Unknown as no checks have been performed.

• One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.
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• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, the slab items Fail
where the check lines runs along A/1-E/1.

2. Click Utilization in the Slab Deflections group to show the Utilization of
each slab item. 

This is the worst utilization from all associated check lines.
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Optimization

If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

The analysis is extremely quick and since everything is contained within one
model file, it allows “What If” scenarios to be considered to find the optimum
solution.

In this exercise we will start by looking at the impact of adjusting the
reinforcement.

1. Highlight the check line running along grid line B and make a note of its
utilization. 

TIP Press the tab key if necessary to highlight the check line when it is
directly under the mouse cursor.

2. Click Slab Reinforcement in the Show/Alter State group to show the
existing reinforcement.

3. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change the Reinforcement Direction to BarsY to see the bars in that
direction
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4. Click on one of the corner slab panels to select H16 150 as the
reinforcement to be applied. 

5. Click on the eight slab panels currently showing H16 bars at 175 spacings
to change them to the 150 spacings. 
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6. Change the Reinforcement Direction to BarsX to see the bars in that
direction.

7. Edit the same 8 panels in exactly the same way, so that the bars in X
match the bars in Y.

8. Click Analyse Current to update the results

9. Click Utilization in the Check Lines group to show the critical utilization
for each check line once again.

10. Investigate the tooltip results 
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You should find that although some utilizations have reduced, the line
along grid line B is still failing. At this point you could begin to look at the
impact of the various other input parameters. For now, we will adjust the
concrete grade of the typical floor slab group from C30/37 to C35/45.

11. Right click slab SI 4 between D-E/1-2 on the typical floor level and choose
Edit.... from the context menu. 
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NOTE Editing a slab item via the right click context menu updates the
parent slab properties, not just the individual slab item. Hence
any changes will be applied to all the slab items in S 1.

12. On the Slab concrete page of the dialog, change the Concrete Strength to
C35/45 and click OK 

To update the check line results we need to re-run the analysis. A
chasedown analysis is automatically performed as part of the slab
deflection analysis, however, it should be borne in mind that some edits
could affect the element design i.e. reducing the concrete slab thickness
would result in an increase to the required reinforcement and hence a
Design Concrete (Static), Slab or patch design may be required again.

13. Click Analyse Current again to update the results.

14. Review the Check Lines Status. 
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The check line with the more onerous Cladding deflection limit is still
failing, but we can clearly see improvements in the results. It has reduced
from a Utilization ratio of 1.538 to 1.262.
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In fact, to obtain a Pass we would have needed to increase the concrete
grade to C45/55.

NOTE For the purpose of this exercise, as the cladding check is not a
code requirement we will simply disable it before proceeding to
generate the model report.

15. Select the check line along grid 1 and then in the Properties window,
reset Check #3 to None.

Generate Model report

A Slab Deflection Check Lines model report can be created for the selected
Model Filter (entire structure, level, plane or sub structure). This lists all the
check lines for the chosen model filter. To help identify the check lines in the
report it is sensible to include a saved picture of the scene view displaying
check lines and their associated reference within the report.

1. In Scene Content, switch on the Text display for the Slab Deflection
Checks. 

TIP The check line references can be customised using the Name
property for each individual check line.
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2. Right click in the Typical floor 2D view and choose Save View
Configuration... from the context menu, then specify a name. 

This saved view can be included in the Check line report.

3. On the Report ribbon, click Model Report...

4. Click Add and provide a Name “Check Line Report” for the report.

5. In Chapters and Options, drag View to the Report Structure area

6. In Chapters and Options, drag Concrete>Slab/Mat Design per
Plane>Slab Deflection Check Lines to the Report Structure area 
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7. In the Report Structure, expand Concrete> Slab/Mat Design per Plane>
Slab Deflection Check Lines and right click, Model Filter> Edit/New 

8. In the Filter dialog, click Add and select Selected levels and ensure a check
against Typical floor 
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9. Click OK to return to the Report Contents dialog.

10. In the Report Structure, right click View, then choose Settings...

11. Select the Slab Deflection view you created earlier 

Engineers Handbooks 1460 Slab deflection handbook



12. Click OK to return to the Report Contents dialog

13. Click OK to exit and save the report. 

A report structure called Check Line Report has now been saved that
contains a view and the check lines.

14. To display the report.

a. Use the Select drop list in the ribbon to select “Check Line Report”

b. Click the Show Report command to open the report.
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Slab deflection example (ACI)
In the following exercises deflections will be checked for the two story multi-
bay flat slab tutorial model shown below.

Geometry:

• Bay centers 26’ 3”

• Floor to Floor spacing 9’ 10”

• Slab thickness 11 ¼ “, concrete grade 4500 psi

• 18” x 18” columns, concrete grade 4500 psi

• Analysis stiffness adjustment factors in accordance with ACI code guidance

Loading:

• Dead area load 30 psf

• Live area load 105 psf

• Cladding perimeter load 0.7klf

Deemed to satisfy checks (page 1463) provide one method of checking,
however the main focus of these exercises will be to investigate rigorous slab
deflection analysis (page 1465) and check lines (page 1501) as the method of
checking.

Deemed to satisfy slab deflection checks example (ACI)
A simple way to assess slab deflection in Tekla Structural Designer is to run a
linear analysis using adjusted analysis properties, and then check the resulting
deflections by manually determining critical spans.
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Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI.tsmd

Perform Linear Analysis

1. From the Analyze toolbar, click Analyze All (Static)

2. Open a view of the Typical floor level

3. Switch to the Results View

4. From the Results toolbar, review 2D deflections for the FE chase-down
analysis for the load combination 1, service load results 

Identify critical check locations

We can see that the maximum reported deflection is 1.1in, occurring in the
middle of a corner bay. This should be assessed by taking the slab span
diagonally across the bay.

NOTE In 'real world' flat slabs engineering judgment will be required to assess which
deflections and span lengths require checking.
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The deflection at the identified location now needs to be checked against a
limiting span-to-depth ratio which we will assume for this example can be
taken as span /240.

Taking the diagonal dimension across the columns, the deemed-to-satisfy
span / 240 rule provides a deflection of [√(26' 3"2+26' 3"2)] / 240 = 1.8in.

This compares unfavorably.

NOTE Remember, the method does not predict actual deflections. The total
deflection is simply expected to be less than span / 240.

Concrete properties used in the analysis

The Tekla Structural Designer deflection result is completely dependent upon
the concrete elastic modulus used in the analysis which is adjusted by a
modification factor to consider such things as creep, cracking and shrinkage.

The modification factor is set from the Settings dialog on the Analyze ribbon.
As shown below, for the FE chase-down analysis of flat slabs this defaults to
0.25.
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Rigorous slab deflection analysis examples (ACI)
Three alternative methods of allowing for creep and shrinkage in the analysis
are investigated.

• Slab Deflection Property Choices (page 1466)

• Method 1: Simplified Event Sequence + Simplified Combined Creep and
Shrinkage Allowance (page 1468)

• Method 2: Simplified Event Sequence + Rigorous Creep and Shrinkage
Allowance (page 1480)

• Method 3: Detailed Event Sequence + Rigorous Creep and Shrinkage
Allowance (page 1487)

• Observations on the Different Methods (page 1496)

• Use of check lines to check deflections (page 1501)

Slab Deflection Property Choices

Aging Coefficient - User Defined or Automatic?

Tekla Structural Designer calculates a modulus of elasticity for each load event
which accommodates both creep and aging.

The Aging, Creep and Shrinkage page on the Slab Deflection Settings dialog
allows you to choose the method for this.

• Automatic - the modulus of elasticity used in the analysis (termed the
composite modulus) is calculated rigorously according to the procedure
defined in the Concrete Society Technical Report 58. This requires an early
age event history to be defined by way of a detailed event sequence.

• User defined - the modulus of elasticity used in the analysis is calculated in
accordance with ACI 435 Equation 3.33c:

Ēc(t, t0) = Ec (t, t0) / ( 1+ χ Ct)

Where:
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• The aging coefficient χ must be specified in the event sequence. The
recommended value is 0.8. This is a user specified value.

• The creep coefficient Ct required in the above equation is automatically
determined by Tekla Structural Designer using equation A-18 from ACI
209 taking account of shape and size effects.

The equation for Ct is [(ti-t0) / (26 e(0.36 x V/S)) + (ti-t0)] x Cui

Where:

• For a slab the volume to exposed surface ratio V/S is taken as h/n where
h is the slab thickness and n is the number of exposed surfaces. If n is
set to zero then the creep coefficient is taken as zero thus eliminating
creep from the analysis properties.

• Start of first event, t0

• End time of event under consideration, ti

• The Ultimate Creep coefficient, Cu must be specified in the event
sequence. In normal conditions the recommended value from ACI 435R
page 55 is Cu = 2.35. A different value can be specified according to
guidance in ACI 209 if desired.

Shrinkage Allowance, or Combined Creep and Shrinkage Allowance?

When creep effects are included in the analysis, the Allowance for Shrinkage
Effects multiplier can be set at a value which caters for shrinkage only.
Alternatively you can increase the multiplier to allow for both creep and
shrinkage, provided that you ensure that creep is not also accounted for in the
analysis.

When using the latter approach it is important to ensure that the Aging
coefficient is set to User defined.
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Restraint Constant - Significant or Insignificant Restraint?

For each of the three methods considered in this example the Restraint
constant (ACI) (page 1389) will be varied in order to model different restraint
assumptions.

Restraint constant values from ACI 435 are:

• For situations with significant restraint - 4.0

• For insignificant restraint - 7.5

This will allow us to compare deflections estimations based on the assumption
of significant restraint against those assuming insignificant restraint.

Method 1: Simplified Event Sequence + Simplified Combined Creep and
Shrinkage Allowance

In this approach the simplest method suggested in ACI 318 is emulated. All
creep and shrinkage effects are introduced as a single amplification factor and
a cracked section analysis is run on a simplified event sequence without
addressing the possibility of early age loading.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Simplified Event Sequence.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Set up the Simplified Combined Creep and Shrinkage Allowance (ignoring ACI 435)

You can increase the Allowance for Shrinkage Effects multiplier to allow for
both creep and shrinkage based on the multipliers from ACI 435 Table 4.1.

Using the ACI code recommendation (highlighted in the below table),
multipliers are immediate 1.0, creep and shrinkage 2.0. Total = 3.0.

Thus a creep and shrinkage contribution = 2.0/3.0 = 0.66 is to be applied which
equates to 66% of the total deflection.

Table 4.1 - Multipliers recommended by different authors
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Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

When using this approach:

• The automatic procedure using Technical Report 58 is not considered - this
is ensured by setting the Aging coefficient to User defined.

• Creep is not also accounted for in the analysis - it can be excluded by
setting the Number of Exposed Faces to Zero in the event sequence.

1. To adopt the above ACI 318 Code multipliers for simplified creep and
shrinkage:

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Aging Coefficient is set to User defined and the Allowance
for shrinkage effects in total deflection is set to 0.66. 

The above factor allows for both creep and shrinkage, (i.e. creep and
shrinkage effects will account for 66% of the total deflection).

4. Click OK to close the dialog.

2. To exclude additional creep effects from the analysis

As creep is already being catered for by the amplification factor, we have
to exclude additional creep effects from the analysis. This can be done by
setting the number of exposed faces in each event to zero as follows:
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5. From the Slab Deflection toolbar, click Event Sequences

6. Click Model Event Sequence

7. For each listed event in the model sequence, ensure the Number of
Exposed Faces is set to 0. 

If the number of faces = 0 then the creep coefficient Ct = 0 . See: Aging
Coefficient - User Defined or Automatic? (page 1466)

Review the Individual Events in the Model Event Sequence

A simplified event sequence has been defined that does not include any
construction stage propping events.

Various guidance documents discuss slab deflection analysis without
addressing the possibility of significant early age loading events such as
propping loads.

An early start event should always be created since time is measured from this
start event. In this example we have assumed a start event of 10 days and
allowed self weight only.
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You will also note that:

• Each event has a load start time. The Final load event is set to the normal
ACI requirement of 5 years.

• ACI requires that instantaneous deflection due to live loads only should be
considered based upon a span/360 limit. To account for instantaneous
deflection due to live load only, an end event has been included with the
same load start time as the preceding event but only including live load.

• Ultimate Creep Coefficient, Cu is set with the default value of 2.350. This
value can be set separately for each event.

• Aging Coefficient is set at the default value of 0.8. This value can be set
separately for each event. It may be more logical to set higher values for
the earlier event times, however, if your primary concern is differential
deflection between later events then it will be conservative to use the same
value everywhere.

• Number of exposed Faces is set to 0 - this has been done to exclude
additional creep effects from the analysis, (as explained in the previous
section).
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Discussion:

• You need to think about the accumulation of deflection through time and
hence the checks that you ultimately wish to consider.

• As an example, if you are interested in differential deflection between the
final load event and the start of finishes (deflection at end of event 1), if you
underestimate deflection to the end of event 1 then this check becomes
more onerous.

• Is it reasonable to assume no construction load and no self weight from
finishes during this period?

• How much load is reasonable to assume at this starting event is ultimately
the responsibility of the engineer.

1. After reviewing the Event Sequence, click OK to close the dialog.

Set up the Restraint Constant

The modulus of rupture is set using the Restraint Constant slab deflection
parameter. Since we are using the ACI code multipliers from Table 4.1 above
this should be set to 7.5.

1. To specify an appropriate restraint constant

1. Open the Structure 3D view

2. Select all the slab items in the model and via the Properties Window,
ensure the Restraint Constant is set to 7.5 
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Perform Iterative Slab Deflection Analysis

To establish some initial results:

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections for the events 

Deflections can be reviewed for each event by making selections from the
Event droplist in the ribbon. You are able to review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End
of Event).

• Instantaneous deflection.

The Total deflection at the final load event for the chosen location is 1.3”
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TIP If slab patches are obscuring the above deflection contours, these
can be switched in Scene Content.

Consider the Sustained Load Multiplier Effect from ACI 435

ACI 435 Clause 4.3.4.2 needs to be reviewed carefully at this stage, as this
suggests that the above deflection estimation is unconservative.

• It states that if the restraint stresses are expected to be insignificant, (so
that the restraint constant is set at 7.5) then:

Engineers Handbooks 1474 Slab deflection handbook



• “the multiplier for sustained-load deflection should be increased from 2 to
4, as recommended by Sbarounis (1984) and Graham and Scanlon
[1986(b)]”

Table 4.1 - Multipliers recommended by different authors

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

Hence the combined creep and shrinkage contribution = 4.0/5.0 = 0.8 (i.e.
80% of the total deflection).

• Alternatively, if the restraint stresses are likely to have a significant effect
then Clause 4.3.4.2 states that:

• a reduced restraint constant of 4 can be used, along with a long-term
sustained-load multiplier of 2.5.

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

In this case the combined creep and shrinkage contribution should be
reduced to 2.5/3.5 = 0.714 (i.e. 71.4% of the total deflection).

1. To adopt the ACI 435 recommendation for insignificant restraint
stresses:

1. From the Slab Deflection toolbar, click Settings

Engineers Handbooks 1475 Slab deflection handbook



2. In the dialog, click Aging, Creep & Shrinkage

3. Increase the Allowance for shrinkage effects in total deflection to 0.8
then click OK

4. From the Slab Deflection toolbar, click Analyze Current 

Using this value, the revised deflection prediction increases to 2.2”

2. To adopt the ACI 435 recommendation when restraint stresses are
expected to be significant:

5. Open the Structure 3D view

6. Select all the slabs in the model and via the Properties Window, adjust the
Restraint Constant to 4.0 
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7. From the Slab Deflection toolbar, click Settings

8. In the dialog, click Aging, Creep & Shrinkage

9. Change the Allowance for shrinkage effects in total deflection to 0.714
then click OK

10. Return to the St.1 (1) 2D view.

11. From the Slab Deflection toolbar, click Analyze Current 

Using this value, the revised deflection prediction increases further to 3.1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.

2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel > For the current slab item 
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We can see from the report that the short term composite modulus, Ec is
used.

Summary of Results

Using the Simplified event sequence + simplified combined creep and
shrinkage allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Assumed Creep
and Shrinkage

combined
allowance %

Total deflection

(Final load
event)

ACI 318 (ignoring
ACI 435)

7.5 66% 1.3”

ACI 435 (simple
approach -
insignificant
restraint)

7.5 80% 2.2”

ACI 435 (simple
approach -
significant
restraint)

4.0 71.4% 3.1”

Next steps

• In Method 2 (page 1480) we will re-use the same model, but edit the
simplified event sequence so that creep is considered in the cracked
section analysis. The multiplier will also be edited so that it only considers
shrinkage effects.

• In Method 3 (page 1487) a modified version of the model using a detailed
event sequence is investigated.

• Having obtained results for all three methods, observations on the
different methods (page 1496) are discussed.
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• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 1501) and an output report is
generated.

Method 2: Simplified Event Sequence + Rigorous Creep and Shrinkage Allowance

In Method 1 (page 1468) we used a simplified event sequence (without
addressing the possibility of early age loading), to see how a single multiplier
can be applied to allow for the combined effects of creep and shrinkage.

In Method 2 we will re-use the same model, but edit the previous simplified
event sequence so that creep is considered in the cracked section analysis.
The multiplier will also be edited so that it only considers shrinkage effects.

Download and open the tutorial model (if required)

NOTE If you are reusing the model from the Method 1 (page 1468) exercise
you can skip this step.

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Simplified Event Sequence.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Set up the rigorous creep and shrinkage allowance

In this method the Allowance for Shrinkage Effects multiplier is set to allow
for shrinkage only.

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Aging Coefficient is set to User defined and the Allowance
for shrinkage effects in total deflection is set to 0.25. 
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The above factor allows for shrinkage only.

Refer to Shrinkage allowance (page 1417) for an explanation of where this
value comes from.

4. Click OK to close the dialog.

Edit the Event Sequence to ensure that creep is accounted for in the analysis

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence

3. Ensure that the Number of Exposed Faces is set to 2 for each event. 

The creep coefficient Ct will be calculated based on this, thus affecting the
modulus of elasticity used in the analysis. For further details of this
calculation, see: Aging Coefficient - User Defined or Automatic?
(page 1466)
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Review the Restraint Constant

1.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, ensure
the Restraint Constant is set to 4.0 

Perform Iterative Slab Deflection Analysis

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections. 

The predicted deflection estimate is 1.5” (using a Restraint Constant of
4.0).
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Adjust the Restraint Constant and Re-analyze

Initially the Restraint Constant was set assuming significant restraint; we will
now investigate the effect of assuming insignificant restraint.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, change
the Restraint Constant to 7.5 
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3. Return to the St.1 (1) 2D view.

4. From the Slab Deflection toolbar, click Analyze Current 

With these settings the total deflection predicted at 5 years reduces to 1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.

2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel>For the current slab item 
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Comparing this report to the report obtained when using the simplified
creep and shrinkage allowance (page 1478), we can see a difference in the
value of the Composite Modulus Ec used. In this method, the age of
concrete is taken into account.

To verify the result, consider Event 2, 3 and 4 where the event ends at
1825 days:

• Start event t0 = 10 days, Event being considered, ti = 1825 days

• Time between events (ti-t0) = 1825-10 = 1815 days

• Modulus of Elasticity, E for 4500 psi concrete grade = 4000 ksi (from
Material database)

• Assumed Ultimate Creep Coefficient, Cu = 2.35

• Assumed Aging coefficient χ = 0.8. This is typically in the range 0.7 to
0.9

• Slab depth, d = 11 ¼ in

• Number of exposed faces, h = 2.

Ct = [(ti-t0) / ( 26 e(0.36 x d/h) ) + (ti-t0)] x Cui = [1815 / (26 e(0.36 x 11 ¼ / 2) +
1815] x 2.35 = 2.1199

Thus

Ēc = (t, t0) = Ec (t, t0) / (1 + χ Ct)

For event 2, 3 and 4, Composite Modulus, Ec = 4000 / (1 + 0.8 x 2.1199)
= 1484 ksi
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Summary of Results

Using the Simplified event sequence plus rigorous creep plus shrinkage
allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

ACI 435 (creep
included in
analysis)

4.0 Cu = 2.35,

h = 2

and χ = 0.8

25% 1.5”

ACI 435 (creep
included in
analysis)

7.5 Cu = 2.35,

h = 2

and χ = 0.8

25% 1.0”

Next steps

• In Method 3 (page 1487) a modified version of the model using a detailed
event sequence is investigated.

• Having obtained results for all three methods, observations on the
different methods (page 1496) are discussed.

• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 1501) and an output report is
generated.

Method 3: Detailed Event Sequence + Rigorous Creep and Shrinkage Allowance

In this approach, a detailed event sequence has been defined which includes
propping loads at early events to create an overall load history. Creep is
considered rigorously alongside this load history by setting the Aging
coefficient to Automatic. This means that an effective composite modulus
value to the end of each event is calculated in accordance with the Concrete
Society Technical Report 58.

NOTE The aging coefficient method should only be set to Automatic when
defining a detailed event sequence that includes a realistic
assessment of early propping load events.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Detailed Event Sequence.tsmd
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Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Review the Detailed Event Sequence

1. To display the Event Sequence

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence 

A detailed event sequence has already been created:
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You will note that:

• Ultimate Creep Coefficient, Cu set at 2.35 for this example

• Number of exposed faces, h set at 2 for this example

• Construction load assumed set at 10.4 psf in this example

• Propping load % assumed during early age propping events 160% and
140% assumed.
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Set up Rigorous Creep

This method requires that the Aging coefficient is set to Automatic. Creep is
then considered automatically as part of the analysis for each event sequence.

A user defined allowance for Shrinkage effects in the total deflection is also
specified.

1. To specify the multiplier for shrinkage effects only but also consider
creep in the analysis

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Allowance for shrinkage effects in total deflection is set to
0.25, and the Aging Coefficient is set to Automatic 

Review the Restraint Constant

1.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, ensure
the Restraint Constant is set to 4.0 
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Perform Iterative Slab Deflection Analysis

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections. 

The predicted deflection estimate is 1.5” (using a Restraint Constant of
4.0).
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Adjust the Restraint Constant and Re-analyze

Initially the Restraint Constant was set assuming significant restraint; we will
now investigate the effect of assuming insignificant restraint.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, change
the Restraint Constant to 7.5 
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3. Return to the St.1 (1) 2D view.

4. From the Slab Deflection toolbar, click Analyze Current 

With these settings the total deflection predicted at 5 years reduces to 1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.

Engineers Handbooks 1494 Slab deflection handbook



2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel>For the current slab item 

Comparing this report to the report for the more simplified ACI “rigorous”
approach to creep (page 1485) undertaken earlier.

• ACI composite modulus calculation for the Final Load Event = 1484 ksi
(also verified by hand calculation earlier)

• TR58 composite modulus calculation for the Final Load Event = 1531
ksi

• These values compare favorably.

Note, however, that if we compared event 5 above where the composite
modulus, Ec = 1284 ksi using the ACI method, we can establish the aging
coefficient as:

Ec = E / (1 + X * Ct)

1284 = 4000 / (1 + χ x 2.1199)

χ = [(4000 / 1284) - 1] / 2.1199 = 0.9978

This increased aging coefficient occurs due to the significant propping
loads at early events, which creates an overall load history that is almost
equivalent to constant loading.

Summary of Results

Using the Detailed event sequence plus rigorous creep and shrinkage
allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

ACI 435 (creep
included in
analysis)

4.0 Cu = 2.35, h =
2 and χ =
automatic

25% 1.5”
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Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

based on
TR58

ACI 435 (creep
included in
analysis)

7.5 Cu = 2.35, h =
2 and χ =
automatic
based on
TR58

25% 1.0”

Next steps

• Having obtained results for all three methods, observations on the
different methods (page 1496) are discussed.

• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 1501) and an output report is
generated.

Observations on the Different Methods

Combined Table of Results

Approach Restraint
Constant

for
Modulus

of
Rupture

Creep
approac

h

Assumed
Creep
and

Shrinkag
e

combine
d

allowanc
e %

Assumed
Shrinkag

e %

Total
deflectio

n

(Final
load

event)

Method
1:
Simplified
Event
Sequence
+
Simplified
Combine
d Creep
and
Shrinkage
Allowanc
e

ACI 318
(ignoring
ACI 435)

7.5  66%  1.3”

ACI 435
(simple
approach
-
insignifica
nt
restraint)

7.5  80%  2.2”

ACI 435
(simple
approach

4.0  71.4%  3.1”
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Approach Restraint
Constant

for
Modulus

of
Rupture

Creep
approac

h

Assumed
Creep
and

Shrinkag
e

combine
d

allowanc
e %

Assumed
Shrinkag

e %

Total
deflectio

n

(Final
load

event)

-
significan
t
restraint)

Method
2:
Simplifie
d Event
Sequenc
e +
Rigorous
Creep +
Shrinkag
e
Allowanc
e

ACI 435
(creep
included
in
analysis)

4.0 Cu = 2.35,
h = 2 and
χ = 0.8

25% 1.5”

7.5 Cu = 2.35,
h = 2 and
χ = 0.8

 25% 1.0”

Method
3:
Detailed
Event
Sequence
+
Rigorous
Creep +
Shrinkage
Allowanc
e

ACI 435
(creep
included
in
analysis)

4.0 Cu = 2.35,
h = 2 and
χ =
automati
c based
on TR58

 25% 1.5”

7.5 Cu = 2.35,
h = 2 and
χ =
automati
c based
on TR58

 25% 1.0”

Discussion

When the guidance in ACI 435 about the use of a combined allowance for
creep and shrinkage is taken into account, the simplified approach using a
combined creep and shrinkage multiplier seems to determine very
conservative deflection estimations.

Looking at table 4.1 in ACI 435, it is clear that the creep contribution is the
most significant part of the overall deflection estimate. It is also the area
where there seems to be greatest variation in opinion on the contribution
level.
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The creep contribution can be dealt with more rigorously by including it in the
analysis. So rather than using a short term E value and then amplifying the
result to account for creep, the analysis at the end of each event uses an
effective E value which includes for creep up to that point. This impacts on the
analysis properties of every shell in the FE analysis and even on the extent of
cracking.

It is suggested that when the creep is included in the analysis the use of a
modulus of rupture which assumes low restraint (restraint constant = 7.5) be
used cautiously.

The option to calculate the effective E value based on some UK guidance in
TR58 makes little difference in this example. It should be borne in mind that
the aging coefficient χ is user defined and 0.8 is just a default for “normal”
situations. In situations such as a transfer slab where load will accrue more
slowly over time 0.8 is likely to be conservative and it may be of interest to
consider the TR58 alternative.

Overall, it is expected that most engineers would use the settings highlighted
in bold in the table above as a default starting point and then make
refinements if necessary.

Extent of Cracking

It is clear from the Combined Table of Results, that the Restraint Constant
and hence the Modulus of Rupture has a huge impact on the predicted
deflections. This is due to the impact the modulus of rupture has on the extent
of cracking that develops. This is illustrated below where the extent of cracking
for the final load event is displayed for the Method 2 model.

Extent of cracking resulting from a restraint constant of 4.0
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You can clearly see the majority of the slabs have cracked where the restraint
constant is 4.0.

Extent of cracking resulting from a restraint constant of 7.5
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The majority of the slabs remain uncracked where the restraint constant is 7.5.
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Next steps

• Using results from one of the methods, deflection checks are performed
using check lines (page 1501) and an output report is generated.

Use of check lines to check deflections (ACI)

Once the input parameters have been set as required to allow for creep and
shrinkage, and the analysis has been performed, check lines can then be
placed in order to check the deflections.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Check Lines.tsmd

Define Check Line Deflection Checks

Check lines have to initially be positioned using engineering judgment.

The deflection checks associated with each check line are selected from a
predefined Deflection Check Catalogue. This is viewed by clicking Deflection
Checks in the ribbon.

You can add new checks to the catalogue as required.

1. From the Slab Deflection ribbon, click Deflection Checks 

Whilst four checks have been defined above, only three of these have
been set to be used in new Check Lines. The more onerous cladding check
which does not come from code requirements is not applied by default:

• Sensitive finishes will check the differential deflections from when the
sensitive finishes are applied to the final load event against a
deflection limit of 1/480

• Total will check the total deflections to the final load event against a
deflection limit of 1/240
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• Live load only will check the instantaneous deflections for the live
load only event against a deflection limit of 1/360

2. Click OK to close the dialog.

Place Check Lines

We will define two check lines in this example:

1. Open the St.1 (1) 2D plan view 

NOTE When the 2D plan view is being viewed in 3D as above, the Create
button on the Slab Deflection toolbar is grayed out.

2. Click  in the bottom right corner of the view to toggle the view until it is
displayed in 2D. 
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3. From the Slab Deflection toolbar, ensure the Results are set as above:

a. Result - Deflections,

b. Result Direction - Z,

c. Result Type - Total,

d. Event - Final load event

4. Click Create 

NOTE Check lines can only be created in a 2D view.

NOTE When you click Create, the Properties Window automatically
includes the slab deflection checks from the catalogue for which
“Use in new Check Lines” was checked.
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5. To place a check line running diagonally between columns in bottom right
corner panel where the peak deflection occurs:

a. Pick the start point as grid line intersection D/1.

b. Pick the end point as grid line intersection E/2.

Before creating a second check line, in the Properties Window add a check
#3, by selecting Cladding from the droplist.
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6. Create the second check line along grid line 1.

a. Pick the start point as grid line intersection A/1.

b. Pick the end point as grid line intersection E/1.

7. Create the third check line along grid line B.

a. Pick the start point as grid line intersection B/1.

b. Pick the end point as grid line intersection B/5.
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8. Create the final check line mid-way between grid lines 4-5 from grid line A
to E.

a. Pick the start point approximately as shown: 
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b. Pick the end point approximately as shown: 
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9. Press Esc to end the command. 

NOTE In a real model you can add as many check lines to the model as
you consider appropriate.

10. Right click on the diagonal check line and from the context menu select
Open deflections check view. 
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The ribbon allows you to specify the total (as shown above), or differential
or instantaneous results for the selected events. Tekla Structural Designer
then draws average slopes between maximum and minimum points.

A total deflection limit of Span / 240 is the same as saying that the average
slope between points of maximum and minimum deflection = 1 / 120. In
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the view above the average slope between these points is 1 / 138, so the
check passes.

Doing the checks this way inherently deals with offset peak deflections
(non-uniform load) and also cantilevers.

11. Click within the Deflection load analysis view and change the Result type
to Differential and check deflection and slopes between the Finishes
added and Final load event. The resulting differential deflection is as
shown: 

For the Sensitive Finishes check of differential deflection between finishes
added and the final load limit had a limit of Span / 480, which is the same
as saying that the average slope between points of maximum and
minimum deflection = 1 / 240. In the view above the average slope
between these points is 1 / 194, so this check fails.

Generate Check Line Reports

A tabulated report is available for each check line which itemizes each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

1. Return to the St.1 (1) 2D view, right click on the diagonal check line and
select Report for Member 
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As previously stated, the Sensitive Finishes check fails since the slope for
differential deflection is reported as 1:206 which is greater than the
allowable slope limit of 1:240.

Review Check Line Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio.

1. Click on the St.1 (1) 2D 2D view to make it active.

2. To make it easier to see the check lines, change the Result droplist from
Deflections to None.

3. Click Status in the Check Lines group of the ribbon to see the pass/fail
status graphically displayed for each check line. 
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TIP You can also hover over a check line and the tooltip displays the
utilization and pass/fall status.

4. Click Utilization in the Check Lines group to show the critical utilization
for each check line and investigate the tooltip results. 
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Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check
lines are automatically re-checked so you will obtain instant feedback on
status and utilization

Review Slab Status and Utilization

Every check line is associated with at least one slab item. If all checks lines
associated with the slab item pass then the slab item passes.

Both the Status and the Utilization can be reviewed.

1. Click Status in the Slab Deflections group of the ribbon to see the pass/
fail status of each slab. 
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• No check lines cross the majority of the slab items so they currently
have a status of Unknown.

• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, the 4 slab items
crossed by the horizontal check line Fail.

• One slab item is being crossed (only just, in one corner) by the passing
diagonal check line, this is the only slab to have a pass status.

2. Click Utilization in the Slab Deflections group to show the Utilization of
each slab item. 
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This is the worst utilization from all associated check lines.

Optimization

If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

The analysis is extremely quick and since everything is contained within one
model file, it allows “What If” scenarios to be considered to find the optimum
solution.

In this exercise we will start by looking at the impact of adjusting the
reinforcement.
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1. Click Slab Reinforcement in the Show/Alter State group to show the
existing reinforcement. 

2. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change the Reinforcement Direction to BarsY to see the bars in that
direction
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3. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change Apply to User Bars

d. Change Bar size to 7

e. Change Bar spacing to 6in

Engineers Handbooks 1517 Slab deflection handbook



4. Click on each panel to apply the new reinforcement. 

5. Repeat the above process to apply the same bars in the X reinforcement
direction also.

6. Click Analyze Current to update the results

Engineers Handbooks 1518 Slab deflection handbook



7. Click Utilization in the Check Lines group to show the critical utilization
for each check line once again.

8. Investigate the tooltip results 

We can clearly see improvements in the results, however the check line
along grid 1 with the more onerous Cladding deflection limit is still failing.

At this point in a real model you could begin to look at the impact of the
various other input parameters, such as changing the concrete grade.

For the purpose of this exercise, and as the cladding check is not a code
requirement, we will simply disable it, as follows:

9. Select the check line along grid 1

10. In the Properties window, reset Check #4 to None. 
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11. Click Analyze Current to update the results

12. Click Status in the Check Lines group. All of the check lines should now
pass.
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Generate Model report

A Slab Deflection Check Lines model report can be created for the selected
Model Filter (entire structure, level, plane or sub structure). This lists all the
check lines for the chosen model filter. To help identify the check lines in the
report it is sensible to include a saved picture of the scene view displaying
check lines and their associated reference within the report.

1. In Scene Content, switch on the Text display for the Slab Deflection
Checks. 
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TIP The check line references can be customized using the Name
property for each individual check line.

2. Right click in the Typical floor 2D view and choose Save View
Configuration... from the context menu, then specify a name. 
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This saved view can be included in the Check line report.

3. On the Report ribbon, click Model Report...

4. Click Add and provide a Name “Check Line Report” for the report.

5. In Chapters and Options, drag View to the Report Structure area

6. In the Report Structure, right click View, then choose Settings...

7. Select the Slab Deflection view you created earlier 
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8. Click OK to return to the Report Contents dialog

9. In Chapters and Options, drag Concrete>Slab/Mat Design per
Plane>Slab Deflection Check Lines to the Report Structure area 
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10. In the Report Structure, expand Concrete> Slab/Mat Design per Plane>
Slab Deflection Check Lines and right click, Model Filter> Edit/New 

11. In the Filter dialog, click Add and select Selected levels and ensure a check
against St. 1 (1) 
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12. Click OK to return to the Report Contents dialog.

13. Click OK to exit and save the report. 

A report structure called Check Line Report has now been saved that
contains a view and the check lines.

14. To display the report.

a. Use the Select drop list in the ribbon to select Check Line Report

b. Click Show Report to open the report.
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13.8 Precast member design handbook
Precast structures can be modelled and analysed in Tekla Structural Designer.
Precast beams and columns can then be designed, provided that you have
access to a licence of Telka Tedds.

This handbook describes the workflow required in Tekla Structural Designer
for running the Telka Tedds precast calculations.

NOTE The following limitations apply:

• Only design of normal weight precast concrete beams and columns to
Eurocodes is supported.

• Design of precast concrete slabs and walls is beyond scope for all head
codes.

• The process is only applicable to precast structures that don't make use of
in-situ structural toppings.

• Precast construction which adopts a more hybrid construction
involving the use of in-situ toppings exceeds the limitations of the
Tekla Tedds calculations and should therefore be considered beyond
scope.

The following topics are covered:

• Precast member design workflow (page 1528)

• Precast member design groups (page 1538)

• Precast beam design (page 1540)

• Precast column design (page 1554)

• Precast column connection eccentricity moments (page 1558)

• Precast member design commands (page 1563)

Related video

Precast modelling, analysis and design using Tekla Tedds

Precast member design workflow
The basic workflow for precast design in Tekla Structural Designer is described
in the sections below:

Related video

Precast modelling, analysis and design using Tekla Tedds
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Configure precast beam and column design settings
Specific precast beam design settings (page 2320) and precast column design
settings (page 2322) that apply to all the beams and columns in the model
should be specified prior to running the designs.

These are set on the repective Concrete>Precast pages of the Design
Settings dialog.

By ensuring the defaults are set correctly you can avoid having to manually set
the values in each Tedds precast calculation as it is run.

You still have control within individual calculations to adjust these settings on
a member by member or group basis.
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Define and place precast members
To place precast members, simply use the Concrete Column > Precast, or
Concrete Beam > Precast commands on the Model tab.

An alternative to this would be to use the Concrete Column > Column, or
Concrete Beam > Beam commands and to subsequently change the
Fabrication parameter to be Precast.

Configure precast groups
Customizable member groups are created automatically. You can choose
whether to utilize them for design purposes via the Design Groups page of
the Design Settings dialog.
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Using precast member design groups (page 1538) can help speed the overall
design process, particularly so in the case of medium to large size models.

• An envelope of group design forces is passed to a single Tedds calculation.

• User can manipulate design options, member size, material etc.

• Any changes are applied to each member in group.

• Each individual member of group is checked against individual loads
without any further user interaction.

The initial precast member design groups can be reviewed from the Groups
tab of the Project Workspace - you can move members into new groups as
required.

Set the Tedds results output level
You can choose the output level for the Tedds precast calculations in advance
by clicking Home > Settings > Report > Tedds Reports

By ensuring this is set correctly beforehand you can avoid having to manually
set the level in each Tedds precast calculation as it is run.

The setting applies to all Tedds linked calculations (precast and timber).
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Establish design forces by running the analysis
Precast members can only be designed provided a set of analysis results exist.
These can be generated from the Analyze ribbon by running Analyze All
(Static) (page 626).

A design force envelope is established, and all critical load combinations are
considered in one Tedds calculation.

Provided load combinations have been created, once analysis has been
performed the Design using Tekla Tedds options become available.

Design using Tekla Tedds

NOTE We recommend that the Tekla Structural Designer model is developed as
much as possible prior to considering the design of the precast members.
This should ensure that the correct distribution of forces is carried through
into the Tekla Tedds calculations.

Design a Selection

To design several precast members or groups in one go:

1. Select the precast members you want to design.

2. Right click and select Design using Tekla Tedds> Selection (page 2260)

3. Design the selected members.

NOTE If grouped design is active, a single grouped design is performed
for each group included in the selection using critical design
forces established from all members in the group (irrespective of
whther ot not they were included in the selection). At the end of
the process all members in each designed group are checked,
(irrespective of whether or not they were included in the
selection).

4. When changes are made to the model, you can check if the existing
sections are still sufficient by by running

5. Check In Tedds (page 2182) from the Design tab.

NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data
(page 2247) from the right-click context menu.
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Design a group

If you have activated concrete member design groups, each group can be
designed as follows:

1. Highlight any member in the group, right click and select Design using
Tekla Tedds> Group (page 2259)

This design gathers the analysis results for all members in the group and
collates them in to one design. (In effect assuming that all the worst case
loads are happening on one member simultaneously.)

2. Design the selected member for these loads.

3. Click Finish.

If the section size was changed during the design, all members of the
group will be updated to the new section. If the reinforcement data was
changed this is also copied to all group members.

Irrespective of whether the section or reinforcement has been changed or
not, all members in the group are then automatically checked against only
the loads that they see individually. A pass fail status and utilization ratio
is calculated accordingly for each one.

4. In the Review View, review the utilization ratios (page 850) for all members
in the group - if these all indicate an efficient design, the process can stop
at this point.

NOTE For columns in particular, the envelope of design forces applied
to members of the group can be overly conservative - e.g. if some
columns are loaded about one axis, and some loaded about the
other, they are all designed as if loaded about both axes.

5. If a group member has a lower than desired utilization, right click on it
and select Design using Tekla Tedds> Member (page 2258)

6. In the Review View, review the resulting utilizations for the group
members - note that some of might now fail.

7. Using the new utilizations to better inform you choice, add extra groups
(page 268) as necessary and re-allocate the members between the
groups.

8. Run Design using Tekla Tedds> Group (page 2259) for one member in
each of the new groups.

9. Iterate the process, starting from step 5 above.

10. When changes are made to the model, you can check if the existing
designs are still sufficient by by running Check In Tedds (page 2182) from
the Design tab. Alternatively you can check groups individually by running
Check using Tekla Tedds> Group (page 2245) for one member in each
group.
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NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data
(page 2247) from the right-click context menu.

Ungrouped Design

If you have elected not to make use of design groups, each member can be
designed individually as follows:

1. Highlight the member, right click and select Design using Tekla Tedds>
Member (page 2258)

2. Design the selected member.

3. Continue to design additional members in the same way as required.

4. When changes are made to the model, you can check if the existing
sections are still sufficient by by running Check In Tedds (page 2182) from
the Design tab.

NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data
(page 2247) from the right-click context menu.

Design model

If you want to design every precast (and timber) member in the model in one
go:

1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.

3. In the context menu, select Design using Tekla Tedds > Model

At the end of the process the status and utilization of each member is
displayed in a Review View.

Check the design after changes
If changes are made to the model you can run a 'check' design to determine if
the existing sections are still sufficient. A check is quicker to perform than a
design because the Tedds calculation runs in the background without having
to display the Tedds calculation dialog.

The updated utilizations can then be reviewed in a Review View.
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Check the whole model

To check all the existing Tedds member designs,

1. Click Check In Tedds (page 2182) from the Design tab.

This reruns all the Tedds calculations in the background using the latest
analysis results.

Check a selection

To check several members or groups in one go,

1. Select the members or groups you want to check.

2. Right click and select Check using Tekla Tedds> Selection

The Tedds calculations for the selected members or groups run in the
background using the latest analysis results.

Check a member

To check a single member,

1. Highlight the member you want to check.

2. Right click and select Check using Tekla Tedds> Member

The Tedds calculations for the selected member runs in the background
using the latest analysis results.

The updated status and utilization are displayed in the member tooltip.

Check a group

To check a member group,

1. Highlight a member in the group you want to check.

2. Right click and select Check using Tekla Tedds> Group

• The Tedds calculations for the selected group run in the background
using the group critical design forces.

• All members in the group are then checked against their individual
design forces.

Output the calculations
The Tekla Tedds design results are returned to the Tekla Structural Designer
model.

At this stage you can display member design status and utilization ratios
(page 849) from a Review View.
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You can also display the design status tabular results (page 898).
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Detailed Tekla Tedds calculations for precast members do not exist within
Tekla Structural Designer itself, instead they are available by exporting to Tekla
Tedds (page 324).
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Precast member design groups

NOTE The use of suitable design groups for precast members is recommended.
Using design groups will help speed the overall design process and allow for
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identical reinforcement amounts to be provided for each element within the
group.

Why use precast design groups?
Precast beams and columns are put into groups for two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design - to standardise designs, reduce processing time, and reduce
the volume of output created.

A fixed set of rules are used to automatically determine member groups: for
example beams must be of similar spans, columns must have the same
number of stacks. Members in all member groups must be of similar lengths
and cross-section.

NOTE Although precast members are automatically grouped for ease of editing, the
use of groups for design is optional and can be deactivated if required: From
the Design tab, click Settings> Design Groups, then select or unselect concrete
beams and/or concrete columns as required.

Activating precast member design groups
Precast beam and column design groups are activated as follows:

1. From the Design tab, click Settings> Design Groups

2. Select concrete beams and/or concrete columns to activate precast beam
and/or precast column design groups.

Group management
Automatic Grouping

Precast beams and columns are grouped automatically according to a fixed
set of requirements.

In Model Settings > Grouping the user defined maximum length variation is
used to control whether elements are sufficiently similar to be considered
equivalent for grouping purposes.

Manual/Interactive Grouping

After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

See: Manage groups in the Project Workspace (page 267)

Engineers Handbooks 1539 Precast member design handbook



NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup ALL Model Members

If you have made changes in Design Settings that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Precast design group requirements
Precast member design groups are formed according to the following rules:

Member type Design group rules
Precast beam • A beam element may be in only one design group.

• Design groups may be formed from single span or
multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• For each individual span all beam elements in the
group must have an identical cross section, including
flange width where appropriate, and span length.

• All beam elements in the group must have identical
material properties.

Precast column • A column element may be in only one design group.

• All column elements in the group must have an
identical number of stacks.

• For each individual stack all column elements in the
group must have an identical cross section, and stack
length.

• All column elements in the group must have identical
material properties.

Precast beam design
Specific aspects of the precast beam design workflow in Tekla Structural
Designer are described below:
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Section shapes
The following section shapes can be used within the Tekla Structural Designer
- Tekla Tedds workflow.

• Rectangular

• L-Section

• Inverted L-Section

• T-Section

• Inverted T-Section

Beam arrangement
The Tekla Tedds calculations have no concept of the model geometry within
Tekla Structural Designer and so there are no limitations on the design of
curved beams in both major and minor axes. Continuous beams, cantilevered
beams etc. are similarly supported by the workflow.

Concrete type
While you can apply both normal and lightweight concrete in the beam
properties, precast beam design using lightweight concrete is currently
beyond scope.

Nominal cover
The default nominal top, bottom and side cover values set in Design Settings>
Precast> Beam> Reinforcement Settings are automatically passed through
to the Tekla Tedds calculation. The nominal concrete cover is the distance
between the surface of the reinforcement closest to the concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement - longitudinal bar patterns

NOTE The reinforcement regions are considered to be the extent of the effective
reinforcement. Anchorage and anchorage lengths are not considered in
precast beam design within Tekla Tedds.

In Design Settings> Precast> Beam there is a one Standard Pattern available
for top longitudunal reinforcement, Precast Top 1, and one Standard Pattern
available for bottom longitudunal reinforcement, Precast Bottom 1 as
illustrated in the figures below.

Standard Pattern of Top Reinforcement - Precast Top 1

Pinned span settings are applied to all spans with Fixity end 1 and 2 set to Pin.
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NOTE As shown above, the concept of continuity bars in pinned spans can be
catered for by enabling Bar (12). When enabled, the end region length is
allowed to be 0%.

Cantilever span settings are applied to all spans with cantilever selected.
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Continuous span settings apply to all other spans.
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Standard Pattern of Bottom Reinforcement - Precast Bottom 1

Pinned span settings are applied to all spans with Fixity end 1 and 2 set to Pin.
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NOTE As shown above, the concept of continuity bars in pinned spans can be
catered for by enabling Bar (14).

Cantilever span settings are applied to all spans with cantilever selected.
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Continuous span settings apply to all other spans.
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Design sections
An individual design section is created for each length of beam with similar
reinforcement definitions. Each design section is then designed for the
maximum forces in that region of similar reinforcement.

The numbers of design sections and their locations are determined by
aggregating the different regions specified in the Design Settings> Precast>
Beam: Top Longitudinal Bar Pattern, Bottom Longitudinal Bar Pattern
and Link Settings.

Example: The default Precast Top 1 and Precast Bottom 1 longitudinal bar
patterns for a Pinned Span are adopted without any continuity bars added as
follows:
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• Precast Top 1: single region 100% of the beam span.

• Precast Bottom 1: B1 and B3 regions set as 15% of the beam span.

• Default Link Settings are also adopted: S1 and S3 regions set as 25% of
the beam span.

For a pinned single span precast beam, different region boundaries would
therefore exist at 15%, 25%, 75% and 85% of the span.

Consequently, when the span is designed in Tekla Tedds, 5 design sections
would be created:
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• s1 - positioned half way along the first bottom span region (7.5% of the
span)

• s2 - positioned half way between the first and second region boundaries
(20% of the span)

• s3 - positioned half way along the second and third region boundaries (50%
of the span)

• s4 - positioned half way between the third and forth region boundaries
(80% of the span)

• s5 - positioned half way along the last bottom span region (92.5% of the
span)

NOTE In this example the first design section lies in the B1 bottom span region, so
the positive design moment at s1 would be the maximum that occurs within
B1; the second, third and forth design sections all lie in B2, so the positive
design moment at s2, s3 and s4 would be the maximum that occurs within B2.

The engineer can of course adjust the standard bar patterns in the Tekla
Structural Designer design settings to suit their requirements.

For instance, if in this example the Precast Bottom 1 pinned span pattern
were to be amended so that B1 and B3 regions were set as 25% of the span;
because the bottom and link regions would then coincide, region boundaries
would only exist at 25% and 75% of the span.

Consequently, when the span is designed in Tekla Tedds, only 3 design
sections would be required:

• s1 - positioned half way along the first region (12.5% of the span)
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• s2 - positioned half way between the first and second region boundaries
(50% of the span)

• s3 - positioned half way along the last region (75% of the span)

NOTE In the above elevation diagrams:

• A black section mark indicates the selected design section is
passing the design criteria.

• Grey section marks indicate unselected design sections which are
passing.

• A red section mark would indicate a design section which is failing.

Default reinforcement in the Tekla Tedds calculation
Regardless of beam shape and size imported from Tekla Structural Designer,
the reinforcement in each beam member is always defaulted to the same
values Tekla Tedds calculation.

This default reinforcement is:

• Top: 2x 16 dia bars

• Bottom: 3x 16 dia bars

• Shear: 2 legs of 8 dia bars at 250 cross centres

NOTE The Tekla Tedds calculation contains some limitations to the error
trapping when it comes to maximum reinforcement values. Although
the main bars in both the top and bottom of the beam have a check
allocated to prevent unrealistic distances being entered, the shear
links have no such limitation.

The engineer is expected to use their own knowledge to place in shear
link values and distances which are both realistic and constructible.
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NOTE The Tekla Tedds calculation contains some limitations to the section
diagram. It may be noted that the diagram is never altered if the
number of shear legs is increased from the default value of 2 legs. It
should be noted that shear link legs are indicative only within Tekla
Tedds and in reality there are a variety of ways that reinforcement can
be detailed. The Tekla Tedds calculation therefore chooses to omit
additional shear reinforcement in the section diagram and to flag it
instead in the notes and the calculations.

Lifting checks
Lifting checks are disabled by default. This has been done to ensure a rapid
design of grouped beams can take place. If lifting checks are required then
simply enable the switch within the Design Options dialog within the Tekla
Tedds calculation.

NOTE The lifting check for beam members makes allowance for
reinforcement for both bending and shear checks.

Analysis forces transferred from Tekla Structural Designer
The following values in the Tekla Tedds calculation are populated from the
Tekla Structural Designer model.

• Positive moment

• Positive design moment

• Positive quasi-permanent moment

• Redistribution ratio

• Negative moment

• Positive design moment

• Negative quasi-permanent moment

• Redistribution ratio

• Shear

• Maximum Design shear force

• Design shear force

• Torsion

• Design torsional moment

NOTE Minor axis forces (as defined in Design > Settings > Design Forces) are not
used in the design of the member. Where minor axis forces are present within
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a beam, a warning is displayed within the process dialog of Tekla Structural
Designer.

Other precast beam properties
The following properties which are common to both cast-in-place and precast
beams, are not transferred to the Tekla Tedds calculation, but still require
consideration as they will impact the analysis in Tekla Structural Designer.

• Concrete member cracked or uncracked status (page 1286)

• Design parameters (page 1293)

Precast column design
Specific aspects of the precast column design workflow in Tekla Structural
Designer are described below:

NOTE The current Tekla Tedds calculation makes no allowance for any shear checks.

Section shapes
Whist a variety of different section shapes can be defined in Tekla Structural
Designer, the Tekla Tedds calculation only supports the design of rectangular
and circular column sections.

Concrete type
While you can apply both normal and lightweight concrete in the column
properties, column design using lightweight concrete is currently beyond
scope.

Nominal cover
The default nominal cover value set in Design Settings> Precast> Column>
Reinforcement Settings is automatically passed through to the Tekla Tedds
calculation. The nominal concrete cover is the distance between the surface of
the reinforcement closest to the concrete surface (including links and surface
reinforcement where relevant) and the nearest concrete surface.
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Reinforcement
Default reinforcement in the Tekla Tedds calculation

Regardless of the column size imported from Tekla Structural Designer, the
initial default reinforcement for all stacks in the Tekla Tedds calculation is as
follows:

• Rectangular columns: a 2x3 formation of 25mm dia rebars with 8mm shear
links.

• Circular columns: 6x 25mm dia rebars with 8mm shear links.
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NOTE Tekla Tedds has no concept of multiple stack columns and Tekla
Structural Designer has to associate separate Tekla Tedds calculations
with each stack. It is the responsibility of the engineer to ensure that
rebar on adjacent stacks are of appropriate quantities and sizes to
ensure correct detailing can take place at the construction stage. It
should be noted that Tekla Structural Designer does not hold any
reinforcement information relating to precast members.
Reinforcement is completely managed by the Tekla Tedds
calculations.

The maximum number of bars which can be entered in either direction for
rectangular columns is 10. For circular columns, the maximum total number of
bars is 20. Please note that these restrictions will have an effect on the
maximum allowable column size for the design workflow.

There is a basic minimum distance calculation within the Tekla Tedds
document relating to bar amounts to avoid unrealistic values of rebar from
being selected. This amount is to be the minimum of:

• K1 x bar dia

• 20mm

• k2 x max aggregate size

NOTE For values of coefficients k1 and k2, refer to clause 8.2 of the
Eurocode.

The number of link legs shown in the Tekla Tedds calculation will increase or
decrease depending on the number of reinforcing bars assigned within the
document.
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NOTE The link legs are displayed to indicate required confinement
reinforcement for vertical bars in compression, but have no effect on
the overall design process.

Lifting Checks and Splice Design
Lifting checks and splice checks are disabled by default. This has been done to
ensure a rapid design of grouped columns can take place. If these checks are
required then simply enable the switches within the Design Options dialog
within the Tekla Tedds calculation.

NOTE The lifting check is performed against the unreinforced area of the
column, hence there is no input for the shear link centres within the
calculation. (Bending checks (for splice design) do include
reinforcement allowances within the design process.)

Analysis forces transferred from Tekla Structural Designer
The following values in the Tekla Tedds calculation are populated from the
Tekla Structural Designer model.

• Axial load, 1st case (Max value)

• Axial load, 2nd case (Min value)

• Where tension exists in the column, the lowest compression value is
populated into this parameter and the tension value ignored. A warning
will be displayed in the process log within Tekla Structural Designer.
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• Moment about y axis at top

• Moment about z axis at top

• Moment about y axis at bottom

• Moment about z axis at bottom

NOTE Tekla Structural Designer populates values from all design combinations. For
columns subjected to low axial loading, the moment capacity will not be as
high as a column subjected to larger axial loading. Low axial load and high
moment can easily be a critical combination for concrete column design.

Other precast column properties
The following properties which are common to both cast-in-place and precast
columns, are not transferred to the Tekla Tedds calculation, but require
consideration as they impact the overall performance of the model.

• Concrete member cracked or uncracked status (page 1286)

• Design parameters (page 1300)

• Stiffness (page 1302)

• Sway/Drift Checks (page 1303)

Precast column connection eccentricity moments

Overview
Nominal eccentricity moments arise in precast columns due to the reactions
from pin ended beams being applied at eccentricities to the column centerline.
The eccentricity moments are calculated for all headcodes, and can be
interrogated in the Load Analysis View.

If working to Eurocodes, these eccentricity moments are also taken into
account when precast columns are transferred to Tedds for design.

These moments do not come directly from the global analysis but instead are
calculated at the ‘load analysis’ post-processing stage as follows:

• At each level the eccentricity of each connection is specified as a user
defined offset from the column face. If rigid zones are not being used this
is increased by half the depth of the supporting column.

• At each level the pinned beam end reactions connecting to the column at
each face are determined.

• If braces also connect to the same face, the force in the brace will also be
taken into consideration if the "Include force in eccentricity moment" brace
release property is checked for the appropriate end of the brace.
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• Taking the beam end reactions (and brace forces if included) on opposite
faces multiplied by their connection eccentricities, resultant eccentricity
moments are determined.

• These moments are then distributed above and below the level based on
the column stiffnesses.

NOTE The eccentricity moments are typically assumed not to be transferred
beyond the level at which they are applied.

Patterning of eccentricity moments

The eccentricity moments resulting from live loads can be patterned if
required to account for the likelihood that the load is not present on all spans
simultaneously.

When eccentricity moment patterning is enabled you must then indicate which
of the live cases are to be patterned, (you may for example decide not to
pattern storage loads.)

For those live cases with patterning enabled, five patterns are considered.
These are:

Pattern 0 is for the full live load at all positions i.e. no patterning - this gives the
maximum axial force in any one stack with (usually) lower eccentricity
moment.

Patterns 1 to 4 are ‘true’ patterns switching live load ‘on’ and ‘off at each pair of
positions around the column in order to generate the maximum live
eccentricity moments about the major and minor axes of the column.
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NOTE The same pattern is applied at the top and bottom of the stack, so for
example it is not possible to have P1 at the top and P4 at the bottom.

Design to Eurocodes

In general, eccentricity moments are only added to the 'real' moments at the
ends of each stack and are only added if they make the design worse.

If you have elected to pattern live eccentricity moments these are considered
in conjunction with the eccentricity moments from other types of load, and
with the 'real' moments.

• As the eccentricity moments are considered localised to each floor the full
axial force from other floors is maintained. The axial force at the level
under consideration will be slightly reduced with patterning enabled as the
live floor loading will not be present on all sides simultaneously.

Define connection eccentricity values
The eccentricities at each level are defined in the column properties and a
different eccentricity can be applied to each face.

If you uncheck the option to apply eccentricity at a face the end reaction on
that face is applied axially.

NOTE Face A can be identified graphically, from which the other faces follow, see:
Steel member orientation (page 1250)
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Pattern eccentricity moments for live loadcases
Patterning can be switched on for specific live loadcases in a two-step process
as follows:

1. From the Home ribbon:

a. Click Model Settings > Loading > General

b. Select Use patterning of eccentricity moments for precast
columns

c. Click OK

2. From the Loadcases page of the Loading dialog:

a. Select a live loadcase that you want to be patterned

b. Select Pattern Ecc. Moments for Precast Columns

c. When patterning has been selected for each of the required
loadcases, click OK

Review connection eccentricity moments
Because eccentricity moments do not come directly from the global analysis
they cannot be displayed graphically in a Results View, they can only be
displayed on a column by column basis by opening a Load Analysis View
(page 716).

With a Load Analysis View open and the required loadcase or combination
selected in the Loading list, you then select the Major, or Minor direction in
the Loading Analysis ribbon.

The 'real' moments are displayed as a shaded diagram using solid lines, the
eccentricity moments as an unshaded using dashed lines:
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The red marker line can be set to a specified distance in the Properties
window to allow the real and ecc. moment values above and below the line to
be displayed.

Displaying patterned eccentricity moments

When you select a patterned live loadcase a Show ecc. moment pattern box
will become available in the Properties window.

After selecting Show ecc. moment pattern you can then click Ecc. moment
pattern in order to select the pattern to display from the droplist.
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Precast member design commands
By right clicking over the required member in a view or appropriate branch of
the Project Workspace, the following interoperative design commands can be
accessed:

• Design using Tekla Tedds (page 2255)

• Check using Tekla Tedds (page 2242)

• Export to Tekla Tedds (page 324)

• Clear Tekla Tedds Data (page 2247)

NOTE Initially only Design using Tekla Tedds (page 2255) command is shown, but
once this has been run the other commands then become available.

Each of the above offers a sub-menu of choices, depending on context:

• > Model

• > Member

• > Group

• > Selection

• > <Substructure name>

NOTE Check using Tekla Tedds (page 2242) > Model is repeated on the Design

ribbon tab as  Check in Tedds (page 2182)
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13.9 Timber member design handbook
Timber structures can be modelled and analyzed in Tekla Structural Designer.
If a licence of Tekla Tedds is available, timber beams, columns and braces can
then also be designed.

NOTE The following limitations and assumptions apply:

• The user should ensure the locale is set correctly in Tekla Tedds before
attempting to run the design from Tekla Structural Designer.

• Design is supported for NDS LRFD, NDS ASD, base Eurocode, and the
following Eurocode National Annexes: UK; Ireland; Norway; Finland;
Sweden.

• If the Singapore or Malaysia Eurocode National Annex is selected, the
calculation will adopt base Eurocode recommended values.

• All timber sections should be consistent with the Timber property
assumptions (page 1021) appropriate to the selected head code.

• If working to the NDS code, size classifications taken from the NDS
supplement 'Design Values for Wood Construction' are used in the Tedds
calculation to distinguish which grades are valid for particular timber
species. The same classification rules are not implemented in Tekla
Structural Designer itself. Therefore, after a member has been designed in
Tedds, if the member size or grade is subsequently changed in Tekla
Structural Designer the associated Tedds calculation is deleted, so that the
member cannot be checked and a redesign is required.

• Column design: If designing a multi-stack column the user must indicate a
splice in the stack properties before running the design if a change in
cross section is required between stacks. If a splice has not been specified
the change in section size will not be correctly returned to the Tekla
Structural Designer model.

The following topics are covered in this handbook:

• Timber member design workflow (page 1564)

• Timber member design groups (page 1577)

• Timber member design commands (page 1580)

Timber member design workflow
The essentials of design of timber members using Tekla Tedds can be thought
of as being very similar to Interactive concrete member design (page 1310)
within the program:

• Just like the concrete beam/ column/ wall interactive design dialog, the
Tedds Timber member design calculation interface lists the design forces
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and settings for a selected member/ group, populated from the model and
analysis, the design pass/fail status and individual check results and
utilization ratios. You can make changes in the interface - such as to section
size and/ or grade - and immediately see the design results for these. All
the data you input and changes you make are updated to and stored in the
model. You can then re-analyze and run a check on all designed members
to ensure the design results are up to date. You can perform design and
analysis loops as necessary so that all members are passing, and to cater
for any other changes to the model or loading.

• Design Groups (page 1577) work in a similar manner also - these are
automatically created for Timber members and listed in the Project
Workspace Groups Tree. The resulting groups can be reviewed and
customized as necessary. Group design is enabled by default ( in Design
Settings > Design Groups > Timber Beams/ Columns/ Braces) and can
be run both via the model and from the Groups Tree.

Key aspects of the Tedds integrated timber design process and workflow in
Tekla Structural Designer are:

Set the timber design code
The timber design code is set from the Home ribbon by clicking Model
Settings > Design Codes > Resistance Codes.

• If working to US codes, there are two different methods, ASD or LRFD to
choose from and also a choice of code year to apply. The design forces
consider only the selected design method.

• If working to Eurocodes, the timber design code will be applied with a
national annex that is appropriate to the head code that has been selected.

The selected design code is automatically applied in all Tedds timber member
designs.

Define and place timber members
To place timber members, select the appropriate member type from the
Timber group on the Model ribbon, ensure the values in the Properties
window are as required and then pick the points to locate the members in
position.

Note the following with regard to the properties:
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• Section shapes - When defining a timber model in Tekla Structural
Designer it may appear that the range of timber sections is somewhat
limited. This is because Tekla Structural Designer doesn't currently have a
facility to specify timber sections by simply inputting a breadth and depth.
Instead you have to select the required size from Tekla Structural
Designer's database of timber sections.

While this might seem to be a significant limitation, it is actually not too
great an issue, because the Tedds timber calculation allows you to override
the original size to input the breadth and depth you require. Then when
the member data is transferred back from Tedds to Tekla Structural
Designer the new size is automatically added to the timber section
database.

Once the new section is in the section database it becomes available for
future Tekla Structural Designer models also.

• Timber fabrication and grade - You can specify timber, glulam, or
structural composite lumber fabrication types.

Initially the grade must be selected from the existing grades in the Tekla
Structural Designer materials database, although if the grade is changed in
the the Tedds timber calculation, when the member data is transferred
back from Tedds to Tekla Structural Designer the new grade is
automatically added to the materials database.

NOTE If a situation arises such that the material properties in the
programs don’t align, Tedds ignores unmatched data and selects
calculation defaults.

• Multi-stack columns - splices should be specified in the stack properties
when the column is being defined if a change in cross section is required
between stacks. If a splice has not been specified before the column is
designed in Tedds the change in section size will not be correctly returned
to the Tekla Structural Designer model.

Create load combinations and set load duration/time effect factors
Loads are applied in the standard manner. Once load combinations have been
created you should review their load duration/ time effect factors.

These factors are set on the Timber design tab on the Combinations page of
the Loading dialog once you have selected an individual combination from the
list in the dialog. The value is set automatically according to the constituent
loadcases.

• ASD combination:
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• LRFD combination:

• Eurocode combination:
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You have control to adjust the default value on a combination by combination
basis.

NOTE The actual factor that gets applied in the Tedds calculation will be the one that
is associated with the worst case load combination.

Configure timber design settings
Certain timber design settings which apply to the entire building can be
specified on the (page 2347).

• If working to US codes:

• If working to Eurocodes:
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By ensuring the defaults are set correctly you can avoid having to manually set
the values in each Tedds timber calculation as it is run.

You still have control within individual calculations to adjust these settings on
a member by member or group basis.

NOTE Tedds data is retained from one run of the design to the next unless changes
are made in Tekla Structural Designer that force the Tedds calculation data to
be re-established.

If you change timber design settings after a member has already been
designed you would need to manually clear the Tedds data from the design in
order to have it use the revised design settings. To do this highlight the
member, right-click and select Clear Tekla Tedds Data (page 2247) from the
context menu.

Configure timber groups
When timber members are placed in the model, to make editing easier they
are automatically grouped according to a set of rules (page 1579).

These initial groups can be reviewed from the Groups tab of the Project
Workspace - you can add new groups (page 268) and move members
between groups (page 269) as required.

Groups are not only useful for editing, they can (optionally) be activated for
design purposes also. There are a number of reasons why you would choose
to do this.

• Why use timber design groups? (page 1577)

• Activating timber member design groups (page 1577)
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Set the Tedds results output level
You can choose the output level for the Tedds timber calculations in advance
by clicking Home > Settings > Report > Tedds Reports

By ensuring this is set correctly beforehand you can avoid having to manually
set the level in each Tedds timber calculation as it is run.

The setting applies to all Tedds linked calculations (precast and timber).

Establish design forces by running the analysis
Timber members can only be designed provided a set of analysis results exist.
These can be generated from the Analyze ribbon by running Analyze All
(Static) (page 626).

A design force envelope is established, which if designing to the US head code
considers the selected design method (ASD or LRFD) only.

All critical load combinations are considered in one Tedds calculation.

Provided load combinations have been created, once analysis has been
performed the Design using Tekla Tedds options become available.

Design using Tekla Tedds
After Analysis, Design or Check using Tekla Tedds can be initiated from both
the Project Workspace and any graphical view of the model:

You can right-click over any individual member in the Project Workspace, or
make a graphical selection, then right-click to open the context menu listing
the Tekla Tedds design options. You can then select Design of the Member,
Group or Selection as appropriate. Design of a Selection can also be used for
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example to design all members of a truss - which can be selected with one
click - in one operation.

• Design a selection (page 1572)

• Design a group (page 1573)

• Design a grouped member (page 1575)

• Design an ungrouped member (page 1575)

• Design model (page 1576)

Check the design after changes
If changes are made to the model you can run a 'check' design to determine if
the existing sections are still sufficient. A check is quicker to perform than a
design because the Tedds calculation runs in the background without having
to display the Tedds calculation dialog.

You can check the whole model from the Design tab, or right-click over any
individual member in the Project Workspace, or you can make a graphical
selection, then right-click to open the context menu listing the Tekla Tedds
design options as shown below. You can then select Design of the Member,
Group or Selection as appropriate.

• Check model (page 1576)

• Check a selection (page 1576)

• Check a member (page 1576)

• Check a group (page 1577)

The updated utilizations can then be reviewed in a Review View.

Output the calculations
The Tekla Tedds design results are returned to the Tekla Structural Designer
model.

At this stage you can display member design status and utilization ratios
(page 849) from a Review View:
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You can also display the design status tabular results (page 898):

Detailed Tekla Tedds calculations for timber members do not exist within
Tekla Structural Designer itself, instead they are available by exporting to Tekla
Tedds (page 324).

Design timber members using Tekla Tedds

Design a selection

To design several timber members or groups in one go:

1. Select all the timber members you want to design.
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2. Right click and select Design using Tekla Tedds> Selection (page 2255)

Tekla Structural Designer highlights the first member or group in the
selection and a Tedds dialog opens displaying the design forces at the
member's first design section.

NOTE If grouped design is active, a single grouped design is performed
for each group included in the selection using critical design
forces established from all members in the group (irrespective of
whether or not they were included in the selection). At the end of
the process all members in each designed group are checked,
(irrespective of whether or not they were included in the
selection).

3. Using the results preview, design the member's first design section for its
critical design forces, then if there is a second section design that also.

4. When all sections are satisfactory, click Finish.

Tekla Structural Designer highlights the next member or group in the
selection and the Tedds dialog re-opens to allow it to be designed.

Continue in the same way until all the selected members/groups have
been designed.

NOTE If a section is changed during the design to a size that does not
exist in Tekla Structural Designer's Timber Section database, it will
be automatically added to the local section database that exists
for the current model only.

Design a group
If you have activated timber member design groups, each group can be
designed as follows:

1. In the Project Workspace, click Groups tab.

2. In the Design tree, expand Timber Beams, Timber Columns, or Timber
Braces as required. 

NOTE When designing timber brace pairs, the groups for these are
always located under Timber Braces and not Timber X Braces, A
Braces, V Braces, K Braces. These latter groups are used for
editing purposes only, but not design.

3. In the Design tree, right-click the timber member group you want to
design.

a. It can be useful at this point to click Select in visible views to confirm
all the group members.

4. In the context menu, select Design using Tekla Tedds> Group (page 2255).
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This design gathers the analysis results for all members in the group and
collates them into one set of critical design forces. (In effect assuming that
all the worst case loads are happening on one member simultaneously.)

5. Using the results preview, design the first design section in the group for
its critical design forces, then if there is a second section design that also.

6. When all sections are satisfactory, click Finish. 

If the section size was changed during the design, all members of the
group are updated to the new section.

Irrespective of whether the section has been changed or not, all members
in the group are then automatically checked against only the loads that
they see individually. A pass fail status and utilization ratio is calculated
accordingly for each one.

7. In the Review View, review the utilization ratios (page 850) for all members
in the group - if these indicate an efficient design, the design can stop at
this point. 
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NOTE For columns in particular, the envelope of critical design forces
applied to members of the group can be overly conservative - e.g.
if some columns are loaded about one axis, and some loaded
about the other, they are all designed as if loaded about both
axes.

If the utilizations indicate the existing grouping is not very efficient, you can
investigate alternative grouping arrangements by adding extra groups
(page 268) as necessary and re-allocating members between the groups
(page 269). You might also consider individually designing grouped members
(as described below) when optimizing the groups.

Design a grouped member

If after running a grouped design some group members have a lower than
desired utilization, you can re-design them individually to investigate the effect
optimizing them would have on the rest of the group.

1. Highlight a group member which has a lower than desired utilization, right
click and select Design using Tekla Tedds> Member (page 2255)

The analysis results of the selected member are used to establish the set
of critical design forces.

2. Optimize the design of the member for its forces.

3. Click Finish.

4. If the section size was changed during the design, all members of the
group are updated to the new section and checked against only the loads
that they see individually.

5. In the Review View, review the new utilizations for the group members -
note that some of the group might now be failing.

6. Using the new utilizations to better inform you choice, add extra groups
(page 268) as necessary and re-allocating members between the groups
(page 269).

7. Run Design using Tekla Tedds> Group (page 2255) for each of the new
groups.

8. Iterate the process as necessary until the groups are fully optimized.

Design an ungrouped member

If you have elected not to make use of design groups, each member can be
designed individually as follows:

1. Highlight the member, right click and select Design using Tekla Tedds>
Member (page 2255)

2. Tekla Structural Designer highlights the member and a Tedds dialog
opens displaying the design forces at the member's first design section.
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3. Using the results preview, design the member's first design section for its
critical design forces, then if there is a second section design that also.

4. When all sections are satisfactory, click Finish.

5. If the section size was changed during the design, it is updated to the new
section in the Tekla Structural Designer model.

6. The member status and utilization are displayed in the member tooltip.

Design model

If you want to design every timber (and precast) member in the model in one
go:

1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.

3. In the context menu, select Design using Tekla Tedds > Model

At the end of the process the status and utilization of each member is
displayed in a Review View.

Check timber members using Tekla Tedds

Check model

To check all the existing Tedds member designs,

1. Click Check In Tedds (page 2182) from the Design tab.

This reruns all the Tedds calculations in the background using the latest
analysis results.

Check a selection

To check several members or groups in one go,

1. Select the members or groups you want to check.

2. Right click and select Check using Tekla Tedds> Selection

The Tedds calculations for the selected members or groups run in the
background using the latest analysis results.

Check a member

To check a single member,

1. Highlight the member you want to check.

2. Right click and select Check using Tekla Tedds> Member

The Tedds calculations for the selected member runs in the background
using the latest analysis results.

The updated status and utilization are displayed in the member tooltip.
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Check a group

To check a member group,

1. Highlight a member in the group you want to check.

2. Right click and select Check using Tekla Tedds> Group

• The Tedds calculations for the selected group run in the background
using the group critical design forces.

• All members in the group are then checked against their individual
design forces.

Timber member design groups

Why use timber design groups?
Timber beams, columns and braces are put into groups for two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design -

a. to standardize designs,

b. to reduce the volume of output created,

c. to speed up the design process, particularly so in the case of medium
to large size models.

When groups are used for design:

• An envelope of group design forces is passed to a single Tedds calculation.

• User can manipulate design options, member size, material etc.

• Any changes are applied to each member in group.

• Each individual member of group is checked against individual loads
without any further user interaction.

NOTE Although timber members are automatically grouped for ease of editing, the
use of groups for design is optional and can be deactivated if required: From
the Design tab, click Settings> Design Groups, then select or unselect the
member types to be designed in groups.

Activating timber member design groups
Timber beam, column and brace design groups are activated as follows:

1. From the Design tab, click Settings> Design Groups
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2. Select Timber Beams, Timber Columns, Timber Braces as required. 

Group management
Automatic Grouping

Timber beams, columns and braces are grouped automatically according to a
fixed set of requirements, including section size, grade, and member length.

In Model Settings > Grouping the user defined maximum length variation is
used to control whether elements are of sufficiently similar length to be
considered equivalent for grouping purposes.

Manual/Interactive Grouping

After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

See: Manage groups in the Project Workspace (page 267)

NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
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then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup Members

If you have made changes in the model that impact on grouping of a specific
member type, you can update the affected groups from the Groups tab of the
Project Workspace by right-clicking Timber Beams, Timber Columns, or
Timber Braces as required and selecting Regroup Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Regroup ALL Model Members

If you have made changes in the model that impact on grouping, you can
update all affected groups accordingly from the Groups tab of the Project
Workspace, by clicking Re-group ALL Model Members. (Located at the top of
the Groups tab.)

NOTE Any manually applied grouping will be lost if you elect to re-group!

Timber design group requirements
Timber member design groups are formed according to the following rules:

Member type Design group rules
Timber beam • A beam may be in only one design group.

• All beams in the group must have an identical cross
section.

• All beams in the group must have an identical grade.

• All beams in the group must have an identical number
of spans.

• Individual span lengths must be the same across the
group.

Timber column • A column may be in only one design group.

• All columns in the group must have an identical cross
section.

• All columns in the group must have an identical grade.

• All columns in the group must have an identical
number of stacks.

• Any splices must be located in the same stacks for all
columns of the group.

• Individual stack lengths must be the same across the
group.
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Member type Design group rules
Timber brace • A brace may be in only one design group.

• All braces in the group must have an identical cross
section.

• All braces in the group must have an identical grade.

• All braces in the group must have an identical span
length.

Timber member design commands
By right clicking over the required member in a view or appropriate branch of
the Project Workspace, the following interoperative commands can be
accessed:

• Design using Tekla Tedds (page 2255)

• Check using Tekla Tedds (page 2242)

• Export to Tekla Tedds (page 324)

• Clear Tekla Tedds Data (page 2247)

NOTE Initially only Design using Tekla Tedds (page 2255) command is shown, but
once this has been run the other commands then become available.

Each of the above offers a sub-menu of choices, depending on context:

• > Model

• > Member

• > Group

• > Selection

• > <Substructure name>

NOTE Check using Tekla Tedds (page 2242) > Model is repeated on the Design

ribbon tab as  Check in Tedds (page 2182)

13.10 Foundation design handbook
This handbook contains information relevant to the design of foundations in
Tekla Structural Designer.

You can find the following information in this handbook:

• Pad base design workflow (page 1581)

Engineers Handbooks 1580 Foundation design handbook



• Pile cap design workflow (page 1587)

• Pad base, strip base and pile cap design forces (page 1593)

• Mat foundation design workflow (US customary units) (page 1608)

• Mat foundation design workflow (metric units) (page 1594)

• Piled mat foundation design workflow (US customary units) (page 1622)

• Piled mat foundation design workflow (metric units) (page 1633)

• Concrete slab design aspects (page 1373)

Pad base design workflow
The small concrete building model shown below will be used to demonstrate
the pad base design process.

The model has already been designed prior to placing the bases.
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Apply pad bases under supported columns
Pad bases can only be placed under, and be loaded by supported columns;
strip bases can only be placed under and be loaded by supported walls.

NOTE If a ground beam is attached to the same support, loading from the beam will
also be considered in the base design.

At this stage, as you are not aware of the individual base size and depth
requirements; you can simply choose to place the bases where required,
accepting the default size/depth offered.

Auto-size pad bases individually for loads carried
To obtain an idea of the range of potential sizes, bases should initially be
designed individually for their respective loads, as follows:

1. Access Design Groups page of the Design Settings dialog box to ensure
that group design is turned off for Isolated Foundations.
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2. Select the bases to be auto-sized and in the Properties Window and
choose to auto-design both the size and depth; In this way the program
establishes suitable base dimensions for you.

Similarly, the reinforcement can be set to be auto-designed in the same
manner.

3. From the Foundations tab click Design Pad Bases.

Each base will be sized accordingly (any that are not in auto-design mode
will simply be checked).

4. With the auto-design options cleared, you can then adjust individual base
dimensions and re-check if required (by right-clicking the base that has
been edited and choosing Check Member).

The site boundary may impose restrictions on the positioning of an
isolated foundation relative to the column/wall it supports. This restriction
may result in a requirement for an offset base, this can be achieved by
specifying the eccentricity required in the base properties.

NOTE The overall auto-design procedure is summarized as follows:

1. Bearing Design: - increase size
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2. Bending Design: - increase reinforcement - If max allowable
reinforcement is reached then increase depth, set reinforcement back to
start point, and go back to step 1.

3. Shear Design - increase depth, set reinforcement back to start point, and
go back to step 1

4. Punching Shear Design - increase depth, set reinforcement back to start
point, and go back to step 1

5. Sliding Checks - increase depth, set reinforcement back to start point,
and go back to step 1

6. Uplift Checks - increase size, set reinforcement back to start point, and
go back to step 1

At every stage, if the max allowable depth is reached the design fails.

Apply grouping to rationalize pad base sizes

NOTE Grouping can only be applied to pad bases - not to strip bases.

Once pad bases have been sized individually, the designs can be rationalized
by activating grouping, in order to obtain one design per group sufficient for
all bases within the group.

This is done as follows:

1. Select a base that you want to be in a particular group.

2. In the Properties Window, ensure it is set to auto-design.

3. Right-click the same base and from the context menu choose Create
Property Set...

4. Select all the other bases that you want to be in the same group.
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5. In the Properties Window, click Apply... to apply the property set you have
just created to the selected bases.

NOTE Ensure you click Apply... from the Properties Window and not
from the right-click menu, otherwise the properties will only be
applied to the last base selected.

6. From the Groups page of the Project Workspace, right-click Pad Bases
(under the Design branch) and choose Regroup Members - this will put
those bases that share similar properties into the same group.

7. Open Design Settings dialog box, and from the Design Groups page
select the option to design isolated foundations using groups.
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8. Click Design Pad Bases - the results obtained will reflect the grouping that
has been applied.

Review/optimize base design
In the Review View you can examine the design efficiency by switching from
Foundations Status to Foundations Ratio. Note that the tool tip also indicates
the base size and status as you hover over any base.

If the selections are unacceptable you may need to review the settings in
Design Options> Concrete> Foundations.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
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eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the concrete pad base design calculations
that have been performed. (The default Building Design report includes these
along with design calculations for other member types in the model).

See also

Apply user defined utilization ratios (page 786)

Pile cap design workflow
The small concrete building model shown below will be used to demonstrate
the pile cap design process.
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The model has already been designed prior to placing the pile caps.

Apply pile caps under supported columns
Before a pile cap can be placed the Pile Type Catalogue must contain at least
one pile type.

Pile caps can only be placed under and be loaded by supported columns.

NOTE If a ground beam is attached to the same support, loading from the beam will
also be considered in the pile cap design.

At this stage, as you are not aware of the individual pile cap size and depth
requirements; you can simply choose to place pile caps where required,
accepting the default size/depth offered.
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Auto-size pile caps individually for loads carried
To obtain an idea of the range of potential sizes, pile caps should initially be
designed individually for their respective loads

Note that when piles are auto-designed the outcome will depend on the auto-
design method selected; the pile cap size will either be based on the minimum
number of piles required, or on the minimum pile capacity.

To individually size the pile caps:

1. In the Design Settings dialog box got to Concrete> Foundations>
Isolated Foundations > Piles to choose the pile auto-design method
required: (minimize pile capacity, or minimize number of piles).

2. Access Design Groups page of the Design Settings dialog box to ensure
that group design is turned off for Isolated Foundations.

3. Select the pile caps to be auto-sized and then in the Properties Window
choose to auto-design both the piles and depth; In this way the program
will establish suitable pile cap dimensions for you.

Similarly, the reinforcement can be set to be auto-designed in the same
manner.

4. From the Foundations tab, click Design Pile Caps and all the pile caps set
in auto-design mode will be sized accordingly. (Those not in auto-design
mode will simply be checked). Similarly the piles beneath the pile caps will
either be designed (if pile auto-design mode is enabled) or checked.
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At any point you can switch to a user defined arrangement, modify the pile cap
configuration and have the design re-checked.

One example where you might choose a user defined arrangement is where
the site boundary imposes restrictions on the positioning of the pile cap
relative to the column/wall it supports. Switching to a user defined
arrangement allows you to specify an eccentricity and create an offset pile cap.

NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Apply grouping to rationalize pile cap sizes
Once pile caps have been sized individually, the designs can be rationalized by
activating grouping, in order to obtain one design per group sufficient for all
pile caps within the group.

This is done as follows:

1. Select a pile cap that you want to be in a particular group.

2. In the Properties Window, ensure it is set to auto-design.

3. Right-click the same pile cap and from the context menu choose Create
Property Set...

4. Select all the other pile caps that you want to be in the same group.

NOTE When applied moments are significant, be cautious when
grouping pile caps where auto-design has initially determined
different principal directions.
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5. In the Properties Window, click Apply... to apply the property set you have
just created to the selected pile caps.

NOTE Ensure you click Apply... from the Properties Window and not
from the right-click menu, otherwise the properties will only be
applied to the last pile cap selected.

6. From the Groups page of the Project Workspace, right-click Pile Caps
(under the Design branch) and choose Regroup Members - this will put
those pile caps that share similar properties into the same group.

7. Open the Design Settings dialog box, and from the Design Groups page
select the option to design isolated foundations using groups.
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8. Click Design Pile Caps - the results obtained will reflect the grouping that
has been applied.

Review/optimize pile cap design
In the Review View you can graphically examine the pile cap design status &
efficiency by switching between Foundations Status and Foundations Ratio.
Note that the tool tip also indicates the base size and status as you hover over
any base.

Similarly you can graphically examine the pile design status & efficiency by
switching between Piles Status and Piles Ratio.

If the selections are unacceptable you may need to review the settings in
Design Options> Concrete> Foundations.

Design results can be examined in more detail by selecting Tabular Data and
setting the View Type to Design Summary. By selecting the Pile Caps or Piles as
the Characteristic (and the appropriate material) the full results for each pile
cap or pile can be examined.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
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eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer.

Print calculations
Create a model report that includes the concrete pile cap design calculations
that have been performed. (The default Building Design report includes these
along with design calculations for other member types in the model).

See also

Apply user defined utilization ratios (page 786)

Pad base, strip base and pile cap design forces
Forces acting on supports

The following forces and moments on the supports are determined from the
analysis of the active load combinations:

• Vertical force in direction Z

• Horizontal forces in directions Y and X

• Moments around X and Y axis

NOTE A torsional moment around the Z axis is also determined, but the base/pile
cap is not designed for this in the current release.

Foundation self weight

The foundation self-weight is automatically calculated and applied as an added
load, Fswt

Soil self weight
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The surcharge depth and soil unit weight that have been specified in the base/
pile cap properties are used to determine the soil self weight. This is applied as
an added load, Fsoil

NOTE In the current release, horizontal pressure caused by soil is not considered.

Additional surcharge loads

For isolated foundations user can apply additional surcharge loads: acting in
the global Z direction.

• Permanent (dead) surcharge load

• Variable (live) surcharge load

Design Forces

To obtain the design forces, the loads due to foundation self weight, soil self
weight and additional surcharge are added to the forces acting on the
supports.

These design forces (axial load and bi-axial shear and moment) are then
applied to the base/pile cap at the foundation level.

NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Mat foundation design workflow (metric units)
The small concrete building model shown below will be used to demonstrate
the process for modeling and designing a mat foundation.
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For mat foundations the overall procedure is basically the same as that for flat
slabs, with the exception that an extra check for mat bearing pressure is
required.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

Determine the soil parameters
Unless you are going to define discreet piled supports, the mat will need to be
supported on ground bearing springs. When these are activated you have
then to also specify:

• Allowable bearing pressures

• Ground stiffness type (Linear, or non linear spring)

• Linear ground stiffness, or,

• Non-linear ground stiffness (+/-) and tension/compression limits

• Horizontal support

Allowable bearing pressures
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When using ground bearing springs, a check is performed as part of the
design process to ensure the allowable bearing pressure you enter is not
exceeded.

Ground stiffness type

Both linear and non-linear ground springs can be defined, although in the
majority of cases it is suggested that linear springs should suffice.

When linear spring are applied:

• Allowable bearing pressures are checked

• Uplift (tension) is checked

• If no problems then linear springs are sufficient

When non-linear springs are applied:

• You can have compression only

• And also capped compression

• Either way analysis takes longer

Ground stiffness

You are required to enter an appropriate stiffness for the soil conditions on
site.

The actual value entered is your responsibility, but as a guide the table below1

illustrates the potential range of values that might be considered.

Material Lower Limit (kN/m3) Upper Limit (kN/m3)
Loose Sand 4,800 16,000
Medium
Dense Sand

9,600 80,000

Dense Sand 64,000 128,000
Clayey
Medium
Dense Sand

32,000 80,000

Silty Medium
Dense Sand

24,000 48,000

Clayey Soil
(qa<200kPa)

12,000 24,000

Clayey Soil
(200<qa<800
kPa)

24,000 48,000

Clayey Soil
(qa>800kPa)

48,000 200,000

1. Reference: "Foundation Analysis and Design", Joseph E. Bowles, 1995
(Table 9-1)
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Horizontal support

The degree of horizontal support provided by the ground springs can be set
as:

• Fixed

• Free

• Spring (default 20% of vertical spring stiffness)

If set to "Free" a mechanism will result unless you provide additional discreet
supports.

Determine the remaining mat properties
You are required to manually specify the Reduce live loads by mat property.
This could vary for individual mat panels, depending on the columns and walls
attached to each panel, and the number of floors they are supporting.

If using an "area" method of mat creation you will also need to specify the
amount of slab overhang.

The remaining properties are then similar to those used to define a typical
concrete flat slab.

In this example the minimum area method is used to create a mat with the
following properties:

• Imposed loads reduced by 30%

• Default overhang

• Mat thickness 600mm

• Ground bearing springs used

• Default allowable bearing pressures

• Default linear spring properties

Create the mat
To create the mat:

1. Choose the method, (e.g. Minimum Area)

2. Enter the mat properties, (see above)

3. Click on those columns (or walls) that define its perimeter,

4. Either press <Enter>, or re-click on one of the selected columns to
complete the mat definition.
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NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

Enable soil structure interaction
When not supported by a mat, columns and walls typically have supports at
their bases.

When a mat is introduced these supports must be removed - as the mat
now supports the whole building on ground bearing springs. Consequently
adding a mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of "soil structure interaction" (or
support settlement). In the past this has often been ignored, even though
design codes suggest that it should be considered.

If you want to include design for situation without support settlement then
you need to think about the workflow sequence or use runs with differing
ground stiffness assumptions.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the mat has been placed it is worth running a validation check from the
Model ribbon at this stage - specifically to check for potential conflicting
supports.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the bearing pressures and the moments to be
used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Design
All (Static), and any seismic RSA combinations by running Design All (RSA).
These processes will also recheck all the member designs taking account of
the effects of soil structure interaction.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs supported on ground
bearing springs.

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE In a large model, if you anticipate several analysis might be required to
determine the size of mat required, you might find it more efficient to just run
the analyses that are required from the Analyze ribbon then re-run the
member design at a later stage.
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Check foundation bearing pressure and deformations
You can check the mat bearing pressure and 2D deflection contours from the
Results View for each of the analysis types that have been performed before
commencing the detailed design.
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By viewing the 2D deflection results for combinations based on "service"
rather than "strength" factors the stiffness adjustments that you apply (via
Analysis Options> Modification Factors> Concrete) do not need to account for
load factors.

The default stiffness adjustments are dependent on the design code. For
design to EC2 the default adjustment factor applied is 0.2. For design to ACI
the default adjustment factor applied is 0.25.

Re-perform member design
Depending on the steps that have been taken to establish the mat size, at this
point the design condition reported in the Status Bar for the members will
either be "Valid" or "Out of Date".

Unless the status is "Valid" you should recheck the member designs (taking
into account the effects of soil structure interaction) by clicking Design All
(Static) from the Design toolbar.

NOTE Similarly if an RSA design has previously been performed, but is now out of
date Design All (RSA) should be re-run.

If any concrete members now fail, you can switch them back into Autodesign
mode, (ensuring Select bars starting from is set to Current rather than Minima)
and then design again. This ensures that the bars that were satisfactory for the
original design are only ever increased not reduced.

Open an appropriate view in which to design the mat
In models with mats at distinct floor levels you should use 2D Views to work
on the mat design one level at a time. Occasionally the "3D geometry" of a
model may make it less easy to distinguish between individual floors, in which
case it may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check mats
and patches: this saves time as only the mats and patches in the current level
are considered. Running Design Mats or Design Patches from the Foundation
ribbon may take longer as it considers all the mats and patches in the model.
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Add patches
This is an interactive process - requiring a certain amount of engineering
judgement.

When placing patches under walls you can choose to place a single patch
along the wall, an internal patch under the middle, or end patches at the wall
ends (as shown above).

Typically at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this will be
reviewed/resolved at the patch design optimization stage.

NOTE Whilst the command to add Patches appears on both the Foundations and
Design ribbons, the former defaults to creating patches on the bottom
surface, the latter to the top surface. For mats the Foundations ribbon default
will generally be correct.

Design mats

NOTE Mat design is dependent on the areas of patches (patch areas which are
excluded from mat design) - hence patches should be added before mats are
designed.

To design multiple mats, either:
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• From the Foundations ribbon run Design Mats in order to design or check
all the mats in the model (each according to their own autodesign setting),
or,

• If you have created mats at multiple levels you may prefer to work on one
level at a time. To do this, open a 2D View of the level to be designed then
right-click and choose either Design Slabs or Check Slabs.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Slabs will re-design slabs and mats (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Slabs will check the current reinforcement in slabs and
mats regardless of the current autodesign setting.

Review/optimize mat design
It is suggested that you use split Review Views to examine the results. You
could arrange one view to show Mat Design Status, and then a second view to
show Slab Reinforcement in the panels. Note that the tool tip indicates all
panel/patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a mat, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to.)

NOTE Auto-design will select the smallest allowable bars at the minimum centres
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.
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• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches
Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Foundations ribbon run Design Patches in order to design or
check all the foundation patches in the model - by default newly created
patches will all be in auto-design mode - so reinforcement is selected
automatically, or,

• In the 2D View of the level which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Patches will re-design the patches (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Patches will check the current reinforcement in the
patches regardless of the current autodesign setting.

Review/optimize patch design
At this stage the patch sizes can be reviewed:

• Wall patches - can the width be adjusted (minimized)?

• Column patches - Is the size reasonable? - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardise
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the mat reinforcement to be matched (if the mat has
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H12-200, then in the patch don't add H12-125, swap to H16-200 - then
there will be alternate bars at 100 crs in this strip of the patch.

Add and run punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:
Create punching shear checks (page 801)

You can then select any check and review the properties assigned to it.
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Once added click Design Punching Shear. See: Design and check punching
shear (page 803)

The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet
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• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

Engineers Handbooks 1608 Foundation design handbook



Mat foundation design workflow (US customary units)
The small concrete building model shown below will be used to demonstrate
the process for modeling and designing a mat foundation.

For mat foundations the overall procedure is basically the same as that for flat
slabs, with the exception that an extra check for mat bearing pressure is
required.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

Determine the soil parameters
Unless you are going to define discreet piled supports, the mat will need to be
supported on ground bearing springs. When these are activated you have
then to also specify:

• Allowable bearing pressures

• Ground stiffness type (Linear, or non linear spring)

• Linear ground stiffness, or,

• Non-linear ground stiffness (+/-) and tension/compression limits

• Horizontal support

Allowable bearing pressures
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When using ground bearing springs, a check is performed as part of the
design process to ensure the allowable bearing pressure you enter is not
exceeded.

Ground stiffness type

Both linear and non-linear ground springs can be defined, although in the
majority of cases it is suggested that linear springs should suffice.

When linear springs are applied:

• Allowable bearing pressures are checked

• Uplift (tension) is checked

• If no problems then linear springs are sufficient

When non-linear springs are applied:

• You can have compression only

• And also capped compression

• Either way analysis takes longer

Ground stiffness

You are required to enter an appropriate stiffness for the soil conditions on
site.

The actual value entered is your responsibility, but as a guide the table below1

illustrates the potential range of values that might be considered.

Material Lower Limit Upper Limit
 (kN/m3) (kip/ft2/ft)

approx.
(kN/m3) (kip/ft2/ft)

approx.
Loose Sand 4,800 31 16,000 102
Medium
Dense Sand

9,600 61 80,000 509

Dense Sand 64,000 407 128,000 815
Clayey
Medium
Dense Sand

32,000 204 80,000 509

Silty Medium
Dense Sand

24,000 153 48,000 306

Clayey Soil
(qa<200kPa)

12,000 76 24,000 153

Clayey Soil
(200<qa<800k
Pa)

24,000 153 48,000 306

Clayey Soil
(qa>800kPa)

48,000 306 200,000 1273
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1. Reference: "Foundation Analysis and Design", Joseph E. Bowles, 1995
(Table 9-1)

Horizontal support

The degree of horizontal support provided by the ground springs can be set
as:

• Fixed

• Free

• Spring (default 20% of vertical spring stiffness)

If set to "Free" a mechanism will result unless you provide additional discreet
supports.

Determine the remaining mat properties
You are required to manually specify the Reduce live loads by mat property.
This could vary for individual mat panels, depending on the columns and walls
attached to each panel, and the number of floors they are supporting.

If using an "area" method of mat creation you will also need to specify the
amount of slab overhang.

The remaining properties are then similar to those used to define a typical
concrete flat slab.

In this example the minimum area method is used to create a mat with the
following properties:

• Live loads reduced by 30%

• Overhang, 20in.

• Mat thickness, 24in.

• Ground springs used

• Default allowable bearing pressures

• Default linear spring properties

Create the mat
To create the mat:

1. Choose the method, (e.g. Minimum Area)

2. Enter the mat properties, (see above)

3. Click on those columns (or walls) that define its perimeter,

4. Either press <Enter>, or re-click on one of the selected columns to
complete the mat definition.
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NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

Enable soil structure interaction
When not supported by a mat, columns and walls typically have supports at
their bases.

When a mat is introduced these supports must be removed - as the mat
now supports the whole building on ground bearing springs. Consequently
adding a mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of "soil structure interaction" (or
support settlement). In the past this has often been ignored, even though
design codes suggest that it should be considered.

If you want to include design for situation without support settlement then
you need to think about the workflow sequence or use runs with differing
ground stiffness assumptions.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the mat has been placed it is worth running a validation check from the
Model ribbon at this stage - specifically to check for potential conflicting
supports.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the bearing pressures and the moments to be
used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Design
All (Static), and any seismic RSA combinations by running Design All (RSA).
These processes will also recheck all the member designs taking account of
the effects of soil structure interaction.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs supported on ground
bearing springs.

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE In a large model, if you anticipate several analysis might be required to
determine the size of mat required, you might find it more efficient to just run
the analyses that are required from the Analyze ribbon then re-run the
member design at a later stage.
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Check foundation bearing pressure and deformations
You can check the mat bearing pressure and 2D deflection contours from the
Results View for each of the analysis types that have been performed before
commencing the detailed design.

By viewing the 2D deflection results for combinations based on "service"
rather than "strength" factors the stiffness adjustments that you apply (via
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Analysis Options> Modification Factors> Concrete) do not need to account for
load factors.

For the above analysis Tekla Structural Designer default stiffness adjustment
factors were used, the default factor for foundation mats being 0.2 for both
ACI and EC2 design codes.

Re-perform member design
Depending on the steps that have been taken to establish the mat size, at this
point the design condition reported in the Status Bar for the members will
either be "Valid" or "Out of Date".

Unless the status is "Valid" you should recheck the member designs (taking
into account the effects of soil structure interaction) by clicking Design All
(Static) from the Design toolbar.

NOTE Similarly if an RSA design has previously been performed, but is now out of
date Design All (RSA) should be re-run.

If any concrete members now fail, you can switch them back into Autodesign
mode, (ensuring Select bars starting from is set to Current rather than Minima)
and then design again. This ensures that the bars that were satisfactory for the
original design are only ever increased not reduced.

Open an appropriate view in which to design the mat
In models with mats at distinct floor levels you should use 2D Views to work
on the mat design one level at a time. Occasionally the "3D geometry" of a
model may make it less easy to distinguish between individual floors, in which
case it may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check mats
and patches: this saves time as only the mats and patches in the current level
are considered. Running Design Mats or Design Patches from the Foundation
ribbon may take longer as it considers all the mats and patches in the model.
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Add patches
This is an interactive process - requiring a certain amount of engineering
judgement.

When placing patches under walls you can choose to place a single patch
along the wall, an internal patch under the middle, or end patches at the wall
ends (as shown above).

Typically at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this will be
reviewed/resolved at the patch design optimization stage.

NOTE Whilst the command to add Patches appears on both the Foundations and
Design ribbons, the former defaults to creating patches on the bottom
surface, the latter to the top surface. For mats the Foundations ribbon default
will generally be correct.

Design mats

NOTE Mat design is dependent on the areas of patches (patch areas which are
excluded from mat design) - hence patches should be added before mats are
designed.

To design multiple mats, either:
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• From the Foundations ribbon run Design Mats in order to design or check
all the mats in the model (each according to their own autodesign setting),
or,

• If you have created mats at multiple levels you may prefer to work on one
level at a time. To do this, open a 2D View of the level to be designed then
right-click and choose either Design Slabs or Check Slabs.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Slabs will re-design slabs and mats (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Slabs will check the current reinforcement in slabs and
mats regardless of the current autodesign setting.

Review/optimize mat design
It is suggested that you use split Review Views to examine the results. You
could arrange one view to show Mat Design Status, and then a second view to
show Slab Reinforcement in the panels. Note that the tool tip indicates all
panel/patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 3 size bars are selected and you would just never use anything less than
a 4 size bar in a mat, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to.)

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
6".

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

Engineers Handbooks 1618 Foundation design handbook



• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches
Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Foundations ribbon run Design Patches in order to design or
check all the foundation patches in the model - by default newly created
patches will all be in auto-design mode - so reinforcement is selected
automatically, or,

• In the 2D View of the level which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Patches will re-design the patches (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Patches will check the current reinforcement in the
patches regardless of the current autodesign setting.

Review/optimize patch design
At this stage the patch sizes can be reviewed:

• Wall patches - can the width be adjusted (minimized)?

• Column patches - Is the size reasonable? - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the mat reinforcement to be matched (if the mat has
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size 4 at 8in, then in the patch don't add size 4 at 5in, swap to size 5 at 8in -
then there will be alternate bars at 4in crs in this strip of the patch.

Add and run punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:
Create punching shear checks (page 801)

You can then select any check and review the properties assigned to it.
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Once added click Design Punching Shear. See: Design and check punching
shear (page 803)

The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet
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• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).
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Piled mat foundation design workflow (US customary units)
The following example illustrates the typical process to model and design piles
in a piled mat foundation.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

In order to retain the existing reinforcement design all members should be set
to check mode. Alternatively you might choose to "check and increase" the
reinforcement instead, (by leaving members in autodesign mode with the
option to select bars starting from current.)

Create the mat
As piled mats are typically designed on the basis that they are supported on
the piles alone, in most situations you would generally clear Use Ground
Bearing Springs (under Soil Parameters in the mat properties.)

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

In this example the minimum area method is used to create a mat with:

• An overhang of 40in.

• Mat thickness 24in.

• The Use Ground Bearing Springs option cleared
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Define the pile catalogue
The pile catalogue should be created prior to placing piles in the mat. You are
required to define the pile properties in the catalogue manually.

In this example it is assumed this structure is stable horizontally so that the
pile type horizontal restraint is left as Fixed.

NOTE In Tekla Structural Designer the only properties that directly influence the pile
design are the compressive and tensile capacity and the horizontal and
vertical stiffness.

Add piles to the mat
Although piles can be added individually, it is often more efficient to add
multiple piles at regular spacings in the form of a pile array.

These can either be placed vertically or on an incline if required.

A preview of the array is displayed making it easier to adjust the array
properties before placing the layout.
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After piles have been placed as an array, you are then free to edit individual
pile positions, or delete them as required.
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Remove existing column and wall supports
When not supported by a mat, columns and walls typically have supports at
their bases.

When a piled mat is introduced these supports must be removed - as the
mat now supports the whole building on pile springs. Consequently adding
a piled mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of support settlement. In the past this
has often been ignored, even though design codes suggest that it should be
considered.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the piles have been placed it is worth running a validation check from
the Model ribbon to check for potential conflicting supports.

Before the mat was placed the structure would have required supports
underneath columns and walls for it to be designed. As support is now being
provided by the piles the member supports are no longer required and should
therefore be removed.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the axial forces in the piles and the moments
to be used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Analyze
All (Static), and any seismic RSA combinations by running 1st or 2nd Order RSA
Seismic.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs, either supported on
ground bearing springs, or on discreet piled supports, (or a combination of
both).

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE Analyze All is run in preference to Design All at this stage because member
design is influenced by, and should therefore follow after the piled raft
design.

Perform the pile design
The piles are checked (and the mat is designed) by running Design Mats from
the Foundations ribbon.

NOTE The pile types/sizes are not changed during this process
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Review the pile design status and ratios
You can display the Pile Status and Pile Ratios from the Review View in order
to determine if any remodeling of piles is required.

In this example a number of piles are not heavily loaded so you could consider
deleting some of them, or switching the pile type that has been applied.

If you make any changes, to see their effect simply re-run Analyse All followed
by Design Mats once more.
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At any stage if you reapply a pile array to a mat any previously existing piles in
the mat are removed.

Add and run pile punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:
Create punching shear checks (page 801)

You can then select any check and review the properties assigned to it.

Once added you can then design and check them individually, if required.
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Or you can run all the checks in one go from the Foundations ribbon, by
clicking Design Punching Shear. See: Design and check punching shear
(page 803)
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The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Key aspects of the check performed are:

• Punching shear resistance is assumed to be provided by the concrete alone
- there is no option to add specific punching shear reinforcement in the
form of studs and rails (as there is for column punching checks, including
those supported by mats).

• The check considers 3D Building Analysis, FE Chase-Down and Grillage
Chase-Down results for all active gravity, wind, seismic and RSA load
combinations.
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• The check considers only a single pile - not a pair - and only vertical shear
not moment (as piles are modeled a pinned spring supports without
moment fixity).

• Just as for punching checks of columns supported by piled mats, all loading
and reactions (from ground bearing springs) within the punching perimeter
are considered.

• There is an additional pile-specific Design setting to use the pile capacity in
the punching check in Design Settings > Concrete > Cast-in-place >
Foundations > Mat Foundations > Piles (default Off).

Perform the mat design
The Design of the mat itself is described in the Mat foundation design
workflow (US customary units) (page 1608) topic.

Piled mat foundation design workflow (metric units)
The following example illustrates the typical process to model and design piles
in a piled mat foundation.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

In order to retain the existing reinforcement design all members should be set
to check mode. Alternatively you might choose to "check and increase" the
reinforcement instead, (by leaving members in autodesign mode with the
option to select bars starting from current.)

Create the mat
As piled mats are typically designed on the basis that they are supported on
the piles alone, in most situations you would generally clear Use Ground
Bearing Springs (under Soil Parameters in the mat properties.)

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

In this example the minimum area method is used to create a mat with:

• An overhang of 1.0m

• Mat thickness 600mm

• The Use Ground Bearing Springs option cleared
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Define the pile catalogue
The pile catalogue should be created prior to placing piles in the mat. You are
required to define the pile properties in the catalogue manually.

In this example it is assumed this structure is stable horizontally so that the
pile type horizontal restraint is left as Fixed.

NOTE In Tekla Structural Designer the only properties that directly influence the pile
design are the compressive and tensile capacity and the horizontal and
vertical stiffness.

Add piles to the mat
Although piles can be added individually, it is often more efficient to add
multiple piles at regular spacings in the form of a pile array.

These can either be placed vertically or on an incline if required.

A preview of the array is displayed making it easier to adjust the array
properties before placing the layout.
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After piles have been placed as an array, you are then free to edit individual
pile positions, or delete them as required.
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Remove existing column and wall supports
When not supported by a mat, columns and walls typically have supports at
their bases.

When a piled mat is introduced these supports must be removed - as the
mat now supports the whole building on pile springs. Consequently adding
a piled mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of support settlement. In the past this
has often been ignored, even though design codes suggest that it should be
considered.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the piles have been placed it is worth running a validation check from
the Model ribbon to check for potential conflicting supports.

Before the mat was placed the structure would have required supports
underneath columns and walls for it to be designed. As support is now being
provided by the piles the member supports are no longer required and should
therefore be removed.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the axial forces in the piles and the moments
to be used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Analyze
All (Static), and any seismic RSA combinations by running 1st or 2nd Order RSA
Seismic.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs, either supported on
ground bearing springs, or on discreet piled supports, (or a combination of
both).

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE Analyze All is run in preference to Design All at this stage because member
design is influenced by, and should therefore follow after the piled raft
design.

Perform the pile design
The piles are checked (and the mat is designed) by running Design Mats from
the Foundations ribbon.

NOTE The pile types/sizes are not changed during this process
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NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Review the pile design status and ratios
You can display the Pile Status and Pile Ratios from the Review View in order
to determine if any remodeling of piles is required.

In this example a number of piles are not heavily loaded so you could consider
deleting some of them, or switching the pile type that has been applied.

If you make any changes, to see their effect simply re-run Analyse All followed
by Design Mats once more.
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At any stage if you reapply a pile array to a mat any previously existing piles in
the mat are removed.

Add and run pile punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:
Create punching shear checks (page 801)

You can then select any check and review the properties assigned to it.

Once added you can then design and check them individually, if required.
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Or you can run all the checks in one go from the Foundations ribbon, by
clicking Design Punching Shear. See: Design and check punching shear
(page 803)
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The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Key aspects of the check performed are:

• Punching shear resistance is assumed to be provided by the concrete alone
- there is no option to add specific punching shear reinforcement in the
form of studs and rails (as there is for column punching checks, including
those supported by mats).

• The check considers 3D Building Analysis, FE Chase-Down and Grillage
Chase-Down results for all active gravity, wind, seismic and RSA load
combinations.

• The check considers only a single pile - not a pair - and only vertical shear
not moment (as piles are modeled a pinned spring supports without
moment fixity).
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• Just as for punching checks of columns supported by piled mats, all loading
and reactions (from ground bearing springs) within the punching perimeter
are considered.

• There is an additional pile-specific Design setting to use the pile capacity in
the punching check in Design Settings > Concrete > Cast-in-place >
Foundations > Mat Foundations > Piles (default Off).

Perform the mat design
The Design of the mat itself is described in the Mat foundation design
workflow (metric units) (page 1594) topic.

13.11 Sustainability and Tekla Structural Designer
Click the link below to find out about the carbon impact of structures and how
Tekla Structural Designer helps engineers to assess this for their projects:

• Measuring the carbon impact of a structure (page 1643)

See also

Export to One Click LCA (page 341)

Measuring the carbon impact of a structure

Global impact of construction industry
According to The Institution of Structural Engineers (IStructE):

• Buildings and construction account for about 40% of energy related CO2
emissions

• Manufacture and disposal of materials used in structures accounts for
about 11% of all greenhouse gas emissions

• Analysis suggests that inefficiency in material use of up to 50% is common

Typical emissions at each stage of the structure's life
In order to reduce carbon emissions it is first necessary to measure them. This
can be done in different ways - in the UK for example by using BS EN 159781

the life cycle of the structure can be split into four stages as shown below, and
the emissions assessed at each stage.
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The distribution of emissions at each stage breaks down in approximately in
these proportions:

Stage Typical distribution of emissions
Product Stage 50%
Construction Stage 5%
Use Stage 43%
End-of-Life Stage 2%

It can be seen that the largest portion of emissions occurs at the Product
Stage, and this is the stage that can be targeted by Tekla Structural Designer to
make savings.

1. BS EN 15978:2011: Sustainability of construction works. Assessment of
environmental performance of buildings. Calculation method. London: BSI,
2011

Measuring Product Stage Carbon
In the UK, the Product Stage is split into modules A1-A3, which are:

• Raw material extraction

• Transport of raw materials to manufacturing facilities

• Manufacture

The carbon impact of materials used in manufacture can then be measured by
using an Embodied Carbon Factor (ECF).
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This factor is specific to each material and is multiplied by the quantity of that
material in order to give a quantity of CO2 emitted in the Product Stage.

Many construction materials have standard ECF values that the engineer can
use, and in addition manufacturers may also provide third-party verified
Environmental Product Declarations (EPDs) which can be used when the
engineer knows exactly which manufacturer the material will be sourced from.

Reporting and export of embodied carbon data
Tekla Structural Designer enables model material data to be exported to One
Click LCA (page 341), which:

• is a widely used cloud-based software for life-cycle assessment and the
calculation of embodied carbon.

• complies with a large number of standards including BREEAM and LEED.

• includes a huge database of generic and manufacturer-specific
Environmental Product Declarations (EPDs)

The data can either be exported to a spreadsheet, or directly to the One Click
LCA service, from where the environmental impact of the design can be
reviewed and reports can be created.

NOTE The One Click LCA service can only be used if you have a One Click LCA
account.

This feature enables the Engineer to quickly and easily determine the
embodied carbon for the part of a project they are responsible for. This also
helps them to develop and compare different scheme options. For a selected
scheme they can then track progress as they make refinements to drive down
the carbon impact.

See also

Export to One Click LCA (page 341)

13.12 Analysis verification examples

A small number of verification examples are included in this section. Our full
automatic test suite for the Solver contains many hundreds of examples which
are run and verified every time the Solver is enhanced. These verification
examples use SI units unless otherwise stated.

1st order linear - Simple cantilever
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Problem definition

A 4 long cantilever is subjected to a tip load of 20,000.

Assumptions

Flexural and shear deformations are included.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Support
Reaction

-P 20,000 20,000 0%

Support
Moment

PL -80,000 -80,000 0%

Tip Deflection -0.0519 -0.0519 0%

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted by beam theory.

1st order linear - Simply supported square slab

Problem definition

Calculate the mid span deflection of an 8x8 simply supported slab of 0.1
thickness under self-weight only. Take material properties E=2x1011,
G=7.7x1010 and ρ=7849.
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Assumptions

A regular triangular finite element mesh is used with sufficient subdivision.
Flexural and shear deformation is included, and the material is assumed to be
isotropic.

Key results

The mid-span deformation is calculated using Navier's Method.

Result Theoretical
value

Comparison
1

Solver value % error

Mid-span
deflection

7.002x10-3 6.990x10-3 7.031x10-3 0.43%

Mid-span
Moment

23616 23708 23649 0.14%
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Conclusion

An acceptable match is observed between the theoretical values and the
solver results. An acceptable match is also observed between the solver
results and those obtained independently.

1st order linear - 3D truss

Problem definition

Three truss members with equal and uniform EA support an applied load of
-50 applied at the coordinate (4, 2, 6). The start of each truss member is fixed
and are located at (0, 0, 0), (8, 0, 0) and (0, 6, 0) respectively. Calculate the axial
force in each element.
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Key results

The results for this problem are compared against those published by Beer
and Johnston, and against another independent analysis package.

Result Beer and
Johnston

Comparison 1 Solver
value

% error

(0, 0, 0) - (4, 2, -6) 10.4 10.4 10.4 0.00 %
(8, 0, 0) - (4, 2, -6) 31.2 31.2 31.2 0.00 %
(0, 6, 0) - (4, 2, -6) 22.9 22.9 22.9 0.00 %

Conclusion

An exact match is observed between the values reported by the solver and
those reported by Beer and Johnston.

1st order linear - Thermal load on simply supported beam

Problem definition

Determine the deflection, U, due to thermal expansion at the roller support
due to a temperature increase of 5. The beam is made of a material with a
thermal expansion coefficient of 1.0 x 10-5.

Assumptions

The roller pin is assumed to be frictionless.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Translation at
roller

5x10-4 5x10-4 0%

Conclusion

An exact match is shown between the theoretical result and the solver result.
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1st order nonlinear - Simple cantilever

Problem definition

A 4 long cantilever is subjected to a tip load of 20,000.

Assumptions

Flexural and shear deformations are included.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Support
Reaction

-P 20,000 20,000 0 %

Support
Moment

-PL -80,000 -80,000 0 %

Tip Deflection  -0.0519 -0.0519 0 %

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted by beam theory.

1st order nonlinear - Nonlinear supports

Problem definition

A 10 long continuous beam is simply supported by three translational springs
as shown. All springs have a maximum resistance force of 500. Calculate the
reaction forces and deflection at each support.
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Assumptions

Axial and shear deformations are ignored.

Key results

Result Comparison 1 Solver value
LHS Reaction 250 250
Centre Reaction 500 500
RHS Reaction 250 250
LHS Displacement -0.025 -0.025
Centre Displacement -0.797 -0.797
RHS Displacement -0.025 -0.025

Conclusion

An exact match is shown between the solver and the independent analysis
package.

1st order nonlinear - Displacement loading of a plane frame

Problem definition

Calculate the reaction forces of the plane moment frame shown below with
the applied displacement U.
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Assumptions

All elements are constant and equal EI. Axial and shear deformations are
ignored; to achieve the former - analytically the cross sectional area was
increased by a factor of 100,000 to make axial deformation negligible.

Key results

Results were compared with two other independent analysis packages.

Result Comparison 1 Comparison 2 Solver value
LHS Vertical
Reaction

6.293 6.293 6.293

LHS Moment
Reaction

-906.250 -906.250 -906.250

RHS Vertical
Reaction

-6.293 -6.293 -6.293

Conclusion

An exact match is shown between the solver and the two independent analysis
packages.

2nd order linear - simple cantilever
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Problem definition

A 10 long cantilever is subjected to a lateral tip load of 45 and an axial tip load
of 4000.

Assumptions

Shear deformations are ignored. Results are independent of cross section
area; therefore any reasonable value can be used. Second order effects from
stress stiffening are included, but those caused by update of geometry are
not. The beam is modelled with only one finite element, (if more elements had
been used the result would converge on a more exact value).

Key results

Results were compared with an independent analysis package.

Result Comparison Solver value
Tip Deflection -0.1677 -0.1677
Base Moment Reaction -1121 -1121

Conclusion

An exact match is observed between the values reported by the solver and the
values reported in “Comparison”.

2nd order linear - Simply supported beam

Problem definition

Determine the mid-span deflection and moment of the simply supported
beam under transverse and tensile axial load.
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Assumptions

Shear deformations are excluded. Results are independent of cross section
area; therefore any reasonable value can be used. The number of internal
nodes varies from 0-9.

Key results

The theoretical value for deflection and moment are calculated as:

Where U is a variable calculated:

No. internal
nodes

Solver
deflection

Solver
deflection %

Solver
moment

Solver
moment %

1 -0.116 0.734 % -0.901 8.631 %
3 -0.115 0.023 % -0.984 0.266 %
5 -0.115 0.004 % -0.986 0.042 %
7 -0.115 0.001 % -0.986 0.013 %
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No. internal
nodes

Solver
deflection

Solver
deflection %

Solver
moment

Solver
moment %

9 -0.115 0 % -0.986 0.005 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.

Reference

Timoshenko. S. 1956. Strength of Materials, Part II, Advanced Theory and
Problems. 3rd Edition. D. Van Nostrand Co., Inc. New York, NY.

2nd order nonlinear - Tension only cross brace

Problem definition

Calculate the axial forces of the elements a-e shown in the 5x5 pin jointed
plane frame shown below. Elements d and e can resist tensile forces only.

Assumptions

All elements are constant and equal EA. A smaller value of EA will increase the
influence of second order effects, whereas a larger value will decrease the
influence.

Key results

Under the applied loading element e becomes inactive. The theoretical
formulas presented below are obtained using basic statics. Note that a

Engineers Handbooks 1655 Analysis verification examples



positive value indicates tension. These results assume no 2nd order effects;
this requires the value of EA to be sufficiently large to make the 2nd order
effect negligible.

Result Theoretical
formula

Theoretical
value

Solver value % Error

a 0 0 0 0
b -P -100 -100 0
c -P -100 -100 0
d 141.42 141.42 0

e 0 0 0 0

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted using statics. A 1st order nonlinear analysis can be used, with
any section sizes, to confirm this result without second order effects.

2nd order nonlinear - Compression only element

Problem definition

Calculate the reaction forces for the compression only structure shown below.

Assumptions

All elements are constant and equal EA, and can resist only compressive forces

Key results

Under the applied loading the element on the left becomes inactive, therefore
all applied loading is resisted by the support on the right.

Result Theoretical
formula

Theoretical
value

Solver value

LHS Reaction 0 0 0
RHS Reaction -P -1000 -1000
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Conclusion

An exact match is observed between the values reported by the solver and the
theoretical values.

1st order modal - Simply supported beam

Problem definition

Determine the fundamental frequency of a 10 long simply supported beam
with uniform EI and mass per unit length equal to 1.0.

Assumptions

Shear deformations are excluded. The number of internal nodes varies from
0-5. Consistent mass is assumed.

Key results

The theoretical value for the fundamental frequency is calculated as:

Where m is the total mass of the beam.

No. internal nodes Solver value % error
0 1.0955 10.995 %
1 0.9909 0.395 %
2 0.9878 0.081 %
3 0.9872 0.026 %
4 0.9871 0.011 %
5 0.9870 0.005 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.
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1st order modal - Bathe and Wilson eignenvalue problem

Problem definition

A 2D plane frame structure has 10 equal bays each measuring 6.096m wide
and 9 stories 3.048m tall. The column bases are fully fixed. All beams and
columns are the same section, which have a constant mass/unit length equal
to 1.438. Calculate the first three natural frequencies (in Hz) of the structure
under self-weight.

Assumptions

Shear deformations are excluded. Each beam/column is represented by one
finite element. Consistent mass is assumed.

Key results

The results for this problem are compared with those published by Bathe and
Wilson and against an independent analysis package.

Mode Bathe and
Wilson

Comparison Solver value

1 0.122 0.122 0.122
2 0.374 0.374 0.375
3 0.648 0.648 0.652

Conclusion

The results show a good comparison with the original published results and
against the other analysis packages.

References

Bathe, K.J. and E.L. Wilson. 1972. Large Eigen Values in Dynamic Analysis. Journal
of the Engineering Mechanics Division. ASCE Vol. 98, No. EM6. Proc. Paper
9433. December.
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2nd order buckling - Euler strut buckling

Problem definition

A 10 long simply supported beam is subjected to an axial tip load of P.

Assumptions

Shear deformations are excluded. The number of internal nodes varies from
0-5.

Key results

The theoretical value for the first buckling mode is calculated using the Euler
strut buckling formula:

With P = -1.0 the following buckling factors are obtained

No. internal nodes Solver value % error
0 12.000 21.59 %
1 9.944 0.75 %
2 9.885 0.16 %
3 9.875 0.05 %
4 9.872 0.02 %
5 9.871 0.01 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.

2nd order buckling - Plane frame

Problem definition

Calculate the buckling factor of the moment frame shown below.
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Assumptions

All elements are constant and equal EI. Axial deformations are ignored; to
achieve this the cross section area is set to 1000. The number of elements per
member is varied between 0 and 5.

Key results

The theoretical buckling load is calculated by

where

Which can be solved using Newtons method and five iterations

No. internal nodes/
members

Solver value % error

0 6.243 0.17 %
1 6.243 0.01 %
2 6.242 0.00 %
3 6.242 0.00 %
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No. internal nodes/
members

Solver value % error

4 6.242 0.00 %
5 6.242 0.00 %

Conclusion

A good match is shown between the solver and theory. The discrepancy
decreases as the level of discretization is increased.

References

Timoshenko, S. and J. M. Gere. 1961. Theory of Elastic Stability. 2nd Edition.
McGraw-Hill Book Company.
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14Design codes reference

This section contains reference information relating to the action and
resistance codes supported by Tekla Structural Designer.

• US codes (page 1662)

• Eurocodes (page 1863)

• British Standards (page 2007)

• Australian Standards (page 2048)

14.1 US codes
• Loading (ASCE7) (page 1662)

• Steel design to AISC 360 ASD and LRFD (page 1669)

• Steel seismic design to AISC 341 (page 1703)

• Concrete design to ACI 318 (page 1729)

• Vibration of floors to DG11 (page 1843)

Loading (ASCE7)
These topics provide a general overview of how loadcases and combinations
are created in Tekla Structural Designer when the head code is set to United
States(ACI/AISC). The ASCE7 Combination Generator is also described.

The following topics are covered:

• Load cases (ASCE7) (page 1663)

• Patterning of live loads (ASCE7) (page 1666)

• Combinations (ASCE7) (page 1666)
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Load cases (ASCE7)

• Loadcase types (ASCE7) (page 1663)

• Self weight (ASCE7) (page 1663)

• Live and roof live loads (ASCE7) (page 1664)

• Wind loads (ASCE7) (page 1665)

Loadcase types (ASCE7)

The following load case types can be created:

Type Calculated
automaticall

y

Include in
the

combination
generator

Live load
reductions

Pattern load

self weight
(beams,
columns and
walls)

yes/no yes/no N/A N/A

slab wet yes/no N/A N/A N/A
slab dry yes/no yes/no N/A N/A
dead N/A yes/no N/A N/A
live N/A yes/no yes/no yes/no
roof live N/A yes/no yes/no N/A
wind N/A yes/no N/A N/A
snow N/A yes/no N/A N/A
snow drift N/A yes/no N/A N/A
temperature N/A N/A N/A N/A
settlement N/A N/A N/A N/A
seismic N/A yes N/A N/A

As shown above, self weight loads can all be determined automatically.
However, other gravity load cases need to be applied manually as you build
the structure.

Self weight (ASCE7)

Self weight - excluding slabs loadcase

Tekla Structural Designer automatically calculates the self weight of the
structural beams/columns for you. The Self weight - excluding slabs loadcase
is pre-defined for this purpose. It's loadcase type is fixed as “Selfweight”. It
cannot be edited and by default it is added to each new load combination.
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Self weight of concrete slabs

Tekla Structural Designer expects the wet and dry weight of concrete slab to
be defined in separate loadcases. This is required to ensure that members are
designed for the correct loads at construction stage and post construction
stage.

The Slab self weight loadcase is pre-defined for the dry weight of concrete
post construction stage, its loadcase type is fixed as “Slab Dry”.

There is no pre-defined loadcase for the wet weight of concrete slab at
construction stage, but if you require it for the design of any composite beams
in the model the loadcase type should be set to “Slab Wet”.

Tekla Structural Designercan automatically calculate the above weights for you
taking into account the slab thickness, the shape of the deck profile and
wet/dry concrete densities. It does not explicitly take account of the weight of
any reinforcement but will include the weight of decking. Simply click the Calc
Automatically check box when you create each loadcase. When calculated in
this way you can’t add extra loads of your own into the loadcase.

If you normally make an allowance for ponding in your slab weight
calculations, Tekla Structural Designer can also do this for you. After selecting
the composite slabs, you are able to review the slab item properties - you will
find two ways to add an allowance for ponding (under the slab parameters
heading). These are:

• as a value, by specifying the average increased thickness of slab

• or, as a percentage of total volume.

Using either of these methods the additional load is added as a uniform load
over the whole area of slab.

Live and roof live loads (ASCE7)

Live load reductions

Reductions can be applied to roof live and live loads to take account of the
unlikelihood of the whole building being loaded with its full design live load.
The reduction is calculated based on total floor area supported by the design
member. Roof live and live load types each have their own reductions applied
in accordance with either Section 4.8 and 4.9 of ASCE 7-05, or Section 4.7 and
4.8 of ASCE 7-10 as appropriate.

Due to the complications associated with live load reduction when considering
beams at an angle to the vertical or horizontal, reductions are only applied to:

• Horizontal steel beams with vertical webs (major axis horizontal) which are
set to be “gravity only” pin ended only

• Columns of any material

• Concrete walls, mid-pier or meshed
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Live load reduction factor

The live load reduction factor, R is calculated as follows:

R = (0.25 + 15 / Sqrt(KLL*AT)) - where R
<= 1.0

US-units

R = (0.25 + 4.57 / Sqrt(KLL*AT)) metric-units

KLL comes from Table 4-2 in ASCE7-05/ASCE7-10. Essentially:

Interior and exterior cols (no
cantilever slabs)

KLL= 4

Edge and interior beams (no
cantilever slabs)

KLL= 2

Interior beams (with cantilever slabs) KLL= 2

Cantilever beams KLL= 1

Edge cols (with cantilever slabs) KLL= 3

Corner cols (with cantilever slabs) KLL= 2

Edge beams (with cantilever slabs) KLL= 1

 
For all beams and column stacks
supporting one floor

R ≥ 0.5

For all column stacks supporting two
or more floors

R ≥ 0.4

NOTE As it is not possible to automatically assess where cantilever slabs are
and what they are attached to - the KLL factor can be manually
specified for individual columns, wall stacks and beam spans.

Roof live load reduction factor

The roof live load reduction factor is calculated as follows:

R = R1 * R2  

where    
R1 = 1.2 - 0.001 * AT , where 1.0 ≥ R1 ≥ 0.6 US-units

 = 1.2 - 0.011 * AT metric-units

R2 = 1.0 (conservatively assumes roofs < 18 degs)  

Wind loads (ASCE7)
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The ASCE7 Wind wizard...

NOTE The Wind Wizard is fully described in the Wind Modeling Engineer’s
Handbook.

The Wind Wizard assesses wind loading on your building structure via a
choice of methods:

• Directional Procedure Part 1 - Rigid Buildings of All Heights (Chapter 27)

• Envelope Procedure Part 1 - Low-Rise Buildings (Chapter 28)

Wind load cases can then be generated and combined with other actions due
to dead and imposed loads in accordance with Section 2.3.2 of ASCE7-10

In order to run the Wind Wizard the following assumptions/limitations exist:

• The shape of the building meets the limitations allowed for in the code.

• It must be a rigid structure.

• The structure must be either enclosed or partially enclosed.

• Parapets and roof overhangs are not explicitly dealt with.

Simple wind loading

If use of the Wind Wizard is not appropriate for your structure then wind
loads can be applied via element or structure loads instead.

Patterning of live loads (ASCE7)

ASCE7 pattern loading for LRFD combinations is as follows:

Code class Load
combination

Loaded spans Unloaded spans

LRFD 1.2D + 1.6L +
0.5Lr

1.2D + 1.6L + 0.5Lr 1.2D + 0.5Lr

Combinations (ASCE7)

Once your load cases have been generated as required, you then combine
them into load combinations; these can either be created manually, by clicking
Add... - or with the assistance of the Combinations Generator, by clicking
Generate...

Application of notional loads in combinations (ASCE7)
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Notional loads are applied to the structure in the building directions 1 and 2 as
follows:

• NL Dir1+

• NL Dir1-

• NL Dir2+

• NL Dir2-

When you run the the Combinations Generator you are required to select the
NL directions to add, and the factors to be applied as part of the process.
Alternatively, you can set up the combinations manually and apply notional
loads and factors to each as required.

Combination generator (ASCE7)
Accessed via the Generate... command, this automatically sets up
combinations for both strength and serviceability.

NOTE Temperature and settlement load case types are not included in the
Generate... command - these need to be added manually.

Combination generator - Combinations

The first page of the generator lists suggested ASD and LRFD combinations
(with appropriate factors).

The “Generate” check boxes are used to select those combinations to be
considered.

Combination generator - Service

This page indicates which combinations are to be checked for serviceability
and the service factors applied.

Combination generator - NL

The last page is used to set up the notional loads. You can specify NL’s and
factors in each of four directions. For each direction selected a separate NL
combination will be generated.

Any combination with wind in is automatically greyed.

Click Finish to see the list of generated combinations.

Combination classes (ASCE7)
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Having created your combinations you classify them as: Construction Stage,
Gravity, Lateral, Seismic or Modal Mass.

NOTE If generated via the Combinations generator they are classified for
you automatically.

Then (where applicable) you indicate whether they are to be checked for
strength or service conditions, or both. You also have the option to make any
of the combinations inactive.

Construction stage combination (ASCE7)

A Construction Stage load combination is only required for the purpose of
designing any composite beams within the model. It is distinguished from
other combinations by setting its “Class” to Construction Stage. Typically this
combination would include a loadcase of type “Slab Wet”, (not “Slab Dry”),
other loadcases being included in the combination as required.

NOTE The Slab Wet loadcase type should not be included in any other
combination.

Gravity combination (ASCE7)

These combinations are considered in both the Gravity Sizing and Full Design
processes.

They are used in the Gravity Sizing processes as follows:

• Design Concrete (Gravity) - concrete members in the structure are
automatically sized (or checked) for the gravity combinations

• Design Steel (Gravity) - steel members in the structure are automatically
sized (or checked) for the gravity combinations.

• Design All (Gravity) - all members in the structure are automatically sized
(or checked) for the gravity combinations.

They are also used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the gravity combinations.

• Design Steel (All) - steel members in the structure are automatically sized
(or checked) for the gravity combinations.

• Design All (All) - all members in the structure are automatically sized (or
checked) for the gravity combinations.

Lateral combinations (ASCE7)

These combinations are not used in the Gravity Sizing processes.

They are used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the lateral combinations.
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• Design Steel (All) - steel members in the structure which have not been set
as Gravity Only are automatically sized (or checked) for the lateral
combinations.

• Design All (All) - all concrete members and all steel members which have
not been set as Gravity Only are automatically sized (or checked) for the
lateral combinations.

Seismic combinations (ACSE7)

These combinations are only considered during the Full Design process. They
are not used in the Gravity Sizing process.

Modal mass combinations (ASCE7)

For modal analysis, you are required to set up specific “modal mass”
combinations. Provided these combinations are active they are always run
through the modal analysis.

NOTE It is always assumed that all loads in the load cases in the combination
are converted to mass for modal analysis. You are permitted to add
lumped mass directly to the model.

Steel design to AISC 360 ASD and LRFD

Tekla Structural Designer designs steel and composite members to a range of
international codes. This reference guide specifically describes the design
methods applied when the AISC 360 ASD or AISC 360 LRFD resistance codes
are selected.

General

Seismic design (AISC 360)

All “Gravity Only Design” members are designed as per the normal AISC
Specification rules for the seismic load combinations.

Additional design rules are required for seismic combinations. These are as
per the AISC Seismic Provisions (AISC 341-05) (Ref. 9), (AISC 341-10) (Ref. 10) or
(AISC 341-16) (Ref. 11). These additional design rules ONLY apply to members
in Seismic Load Resisting Systems. These rules are applied as follows:

• If SDC = A - no additional requirements

• If SDC = D, E or F, apply rules for AISC 341

For each of X and Y directions:
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• If SDC = B or C and R <=3 - no additional requirements

• If SDC = B or C and R > 3, apply rules for AISC 341

Deflection checks (AISC 360)

Relative and Absolute Deflections

Tekla Structural Designer calculates both relative and absolute deflections.
Relative deflections measure the internal displacement occurring within the
length of the member and take no account of the support settlements or
rotations, whereas absolute deflections are concerned with deflection of the
structure as a whole. The absolute deflections are the ones displayed in the
structure deflection graphics. The difference between relative and absolute
deflections is illustrated in the cantilever beam example below.

Relative deflections are given in the member analysis results graphics and are
the ones used in the member design.

Steel grade (AISC 360)
The steel grade can be chosen from the standard range for the USA or from an
international range. User defined grades can also be added.

WARNING For composite beams, the upper limit for the steel grade is
defined in the AISC Specification as 75 ksi (525 MPa) - see I1.2
(360-05) or I1.3 (360-10, 360-16). If you add a grade higher than
this and apply to a composite beam all the design checks will be
flagged as beyond scope.

WARNING For non-composite beams, the upper limit for the steel grade is
defined in the AISC 360 Commentary A3.1a as 100 ksi (690 MPa).
If you add a grade higher than this and apply to a non-composite
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member (rolled or built-up) all the design checks will be flagged
as beyond scope.

The elastic modulus of steel for use in design is defined in the AISC
Specification as E = 29,000 ksi

Steel beam design to AISC 360

• Design method (Beams: AISC 360) (page 1671)

• Steel beam limitations and assumptions (Beams: AISC 360) (page 1671)

• Section classification (Beams: AISC 360) (page 1673)

• D2. Axial tension (Beams: AISC 360) (page 1673)

• E. Axial compression (Beams: AISC 360) (page 1673)

• G2. Shear strength (Beams: AISC 360) (page 1674)

• F2. Flexure (Beams: AISC 360) (page 1674)

• H1. Combined forces (Beams: AISC 360) (page 1675)

• DG9. Torsion (Beams: AISC 360) (page 1676)

• Web openings (Beams: AISC 360) (page 1678)

• Seismic design rules (Beams: AISC 360) (page 1680)

Design method (Beams: AISC 360)

Either a load and resistance factor design (LRFD) or an allowable strength
design (ASD) can be performed to determine the adequacy of the section for
each condition.

The design method employed is consistent with the design parameters
specified in the relevant chapters of the AISC Specification and associated
'Commentary', unless specifically noted otherwise. As the 2005 (Ref.1), 2010
(Ref. 2) and 2016 (Ref. 3) versions are all supported, where clauses are specific
to a particular version these are indicated as (360-05), (360-10), or (360-16) as
appropriate.

A basic knowledge of the design methods for beams in accordance with the
specification is assumed.

Steel beam limitations and assumptions (Beams: AISC 360)

The following general limitations apply:

• Continuous beams (more than one span) must be co-linear in the plane of
the web within a small tolerance (sloping in elevation is allowed),
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• Rolled doubly symmetric prismatic sections, doubly symmetric hollow
sections, channel sections are fully designed, plated beams are also fully
designed

• Single angles, double angles and tees are designed, but additional
limitations apply, (see Angle and tee limitations)

• Design of beams with web openings is beyond scope.

The following additional limitations apply for plated beams:

• Double and single symmetric I-sections allowed

• Single or multi-span allowed, including cantilever spans

• Design for axial force (tension or compression) or flexure (major or minor)
or any combination of these

• Non-composite only

• Flanges and web all have same grade steel

• No design of curved beams (plan or elevation)

• No auto design

• No torsion design

• No seismic design

The following assumptions apply:

• All supports are considered to provide torsional restraint, that is lateral
restraint to both flanges. This cannot be changed. It is assumed that a
beam that is continuous through the web of a supporting beam or column
together with its substantial moment resisting end plate connections is
able to provide such restraint.

• If, at the support, the beam over sails the supporting beam or column then
the detail is assumed to be such that the bottom flange of the beam is well
connected to the supporting member and, as a minimum, has torsional
stiffeners provided at the support.

• In the Tekla Structural Designer model, when not at supports, coincident
restraints to both flanges are assumed when one or more members frame
into the web of the beam at a particular position and the cardinal point of
the centre-line model of the beam lies in the web. Otherwise, only a top
flange or bottom flange restraint is assumed. Should you judge the actual
restraint provided by the in-coming members to be different from to what
has been assumed, you have the flexibility to edit the restraints as
required.

• Intermediate lateral restraints to the top or bottom flange are assumed to
be capable of transferring the restraining forces back to an appropriate
system of bracing or suitably rigid part of the structure.

• It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints for compression buckling. The default
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value for the effective length factor of 1.0 may be neither correct nor
safe.

Section classification (Beams: AISC 360)

Cross-section classification is determined using Table B4.1 (360-05), or Tables
B4.1a+B4.1b (360-10).

At every cross section there are two classifications for each element in the
section (flange or web) - one for axial compression and one for bending
(flexure).

If axial compression does not exist (0kip or tension), the axial classification is
not applicable. If bending is not present about both axes then the flexure
classification is not applicable.

For axial compression the web and flanges are classified as either Compact or
Slender and the worst of the two is the resultant axial classification.

For bending both the web and flange are classified as Compact, Non compact
or Slender and the worst of the two is the resultant flexural classification.

The classification of the section must normally be Compact or Non compact,
however sections which are classified as Slender will be allowed if they are
subject to axial load only.

Classification for plated beams

Since built-up (plated) beams allow for asymmetric sections, the general
approach in flexure classification for all built-up beams is:

• under major bending the compression flange is classified (both flanges are
classified if double curvature exists, and the worst case is reported)

• under minor bending both flanges are classified

• under biaxial bending, major and minor bending are considered
independently and the worst case is reported

D2. Axial tension (Beams: AISC 360)

If axial tension exists, tensile yielding and rupture checks are performed at the
point of maximum tension in accordance with Equations D2.1 and D2.2.

NOTE In the rupture check the net area Ae is assumed to equal the gross
area Ag.

A warning is issued if the slenderness ratio L/r exceeds 300.

E. Axial compression (Beams: AISC 360)
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If axial compression exists, the member is assessed for Flexural Buckling and
for Torsional and Flexural Torsional buckling.

The compressive strength is determined in accordance with Equations E3.1
and E4.1. For double angles these equations are subject to the modifications
of Section E6.

The member length or member sub lengths between braces are checked for:

• Flexural buckling about major axis - for each unbraced length between
adjacent points of major axis lateral brace and or torsional brace.

• Flexural buckling about minor axis - for each unbraced length between
adjacent points of minor axis lateral brace and or torsional brace.

• Torsional and flexural torsional buckling - for each unbraced length
between adjacent points of torsional brace (this check is not applied to
hollow sections.)

For any unbraced length, the required compressive force Pr is taken as the
maximum compressive force in the relevant length.

A warning is issued if the slenderness ratio KL/r exceeds 200.

G2. Shear strength (Beams: AISC 360)

Shear checks are performed at the point of maximum shear in accordance
with Section G2.

Plated beams only

Since built-up (plated) beams allow for asymmetric sections, under minor
shear the web shear coefficient, Cv is calculated for each flange separately and
Equation G2-1 taken as:

Vn = 0.6 * Fy * (Aw,top * Cv,top + Aw,btm * Cv,btm)

F2. Flexure (Beams: AISC 360)

The member is assessed for Flexure in accordance with Section F2 to F10 (as
appropriate).

The following checks are potentially required:

About the x axis - within the LTB braced length

• Yielding

• Compression flange local buckling

• Web local buckling

• Local buckling

• Lateral torsional buckling (only required for I and C sections)

About the y axis in the LTB braced length
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• Yielding

• Flange local buckling

• Web local buckling

• Local buckling

You can switch off the lateral torsional buckling checks for any unbraced
length by indicating the length is continuously braced. If you use this option
you must be able to provide justification that the unbraced length is
adequately braced against lateral torsional buckling.

When the checks are required Tekla Structural Designer assumes a top flange
(but not bottom flange) brace is provided at the position of each incoming
beam. You can add or remove these braces if they don't reflect the actual
brace provided by the incoming section. Each unbraced length which is not
defined as being continuously braced is then checked in accordance with
Section F2.

Plated beams only

The following additional checks apply about the x axis:

• Compression flange yielding

• Tension flange yielding

The approach to evaluating the web plastification factors, Rpc and Rpt in
Section F4.2 and F4.4 of 360-10, has been adopted for 360-05 also i.e. the ratio
Iyc/Iy is considered as well as hc/tw but note the following:

• under 360-05, Iyc is taken as the minimum inertia about the y axis of top
and bottom flange (regardless which flange is in compression)

• under 360-10, Iyc is taken as the inertia about the y axis of the compression
flange being considered

For flange local buckling about the y axis Equation F6-2 is used for both double
and single symmetric sections, but in the latter case the more slender of the
two flanges is assessed i.e. the higher λ value will be used.

H1. Combined forces (Beams: AISC 360)

Members subject to axial tension or compression and flexure about one or
both axes are assessed in accordance with Section H1.

Plated beams only

For built-up (plated) beams a Proportioning Limit check applies. In AISC 360-05
and 360-10 this is detailed within the chapter on design for flexure (section
F13.2). Load combinations which result in major axis bending on a built-up
(plated) beam cause this check to be made. Any load combination which fails
the Proportioning Limit check is considered as Beyond Scope for Combined
Forces (regardless of whether any axial force is compressive or tensile).
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DG9. Torsion (Beams: AISC 360)
Torsion design is carried out according to AISC design guide 9 (DG9), AISC
360-05 and AISC 360-10 for single span, pin ended steel beams with open and
closed section types as follows:

Open sections (I- symmetric rolled)

• A torsion design and an angle rotation check can be carried out for applied
torsion forces only

Closed sections (HSS only)

• •An angle of rotation check can be carried out for applied forces only

Torsion design - loading (Beams: AISC 360)
For design of open sections (i.e. rolled I sections in the current release) torsion
design is carried out for “applied torsion loading” only and in accordance with
those cases in Appendix B of DG9 with torsion fixed and warping free member
ends (i.e. cases 3, 4 and 5 of DG9, with some extension for partial UDL and
VDL).

Applied torsion loading

Tekla Structural Designer defines “applied torsion loading” as:

• A force that is manually applied by the User using the Member Loading in
the Load ribbon, (as shown below)

• Or a force that is induced from a moment connection between primary and
secondary beams, or a cantilever beam (as shown below, with bending and
torsion moment diagrams).
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Angle of rotation check (Beams: AISC 360)

I symmetric & HSS section

A torsion rotation check is optionally carried out based on the applied torsion
loading only.

The check is applied by selecting “Apply rotation limit” (located in the steel
beam properties under the Torsion heading). The default limit is also set in the
steel beam properties as 2° but can be adjusted to suit.

Torsion design general checks (Beams: AISC 360)

1. Auto design is not carried out in the current release, only check design
(and check design is only carried out if the “check for torsion” flag is set to
on in the Edit dialog or Properties Window)

2. Lateral restraint amplification factor (in accordance with section 4.7.3 of
DG9):

a. It is assumed lateral displacement and twist are not restrained at any
load point. Therefore, in accordance with section 4.7.3 of DG9, σby
and σw will always be amplified in the presence of torsion.

b. To avoid a negative value, Tekla Structural Designer applies a lower
limit of 0.001ksi OR N/mm2 to the denominator of the amplification
factor,
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(ɸFcr
e - σbx)

c. Fcr
e = Fcr,bx

d. Amplification factor = 1.0 when σbx = 0.0

3. Both major and minor axis shear buckling are checked if loaded in the
relevant axis. A warning is issued if the buckling limit defined in AISC Sect
G2 is exceeded. Torsion design will, however, be continued - the engineer
is expected to deem if the shear buckling condition is safe.

4. Torsion shear stresses:

a. A cross-section check is carried out at points of interest taken from
the load analysis diagram.

5. Combined forces and torsion:

a. HSS - sections

1. A cross-section check is carried out at points of interest taken
from the load analysis diagrams as well as 10th positions along
the member. In cases where the final utilization ratio approaches
1.0 we strongly recommend the engineer considers other
locations, where a more critical location than that chosen in Tekla
Structural Designer may exist.

b. I symmetric

1. We take the most critical axial stress value across all axial strut
lengths to determine Fcr,a

2. We take the most critical major bending stress value across all
LTB lengths to determine Fcr,bx

3. In ASD design checks, the value used for Fcr,a and Fcr,bx is Fcr /
1.67 since Fa and Fb used in DG9 relate to the 1989 ASD
Specification where this factor was effectively already taken into
account.

Web openings (Beams: AISC 360)

Circular openings as an equivalent rectangle

Each circular opening is replaced by equivalent rectangular opening, the
dimensions of this equivalent rectangle for use in all subsequent calculations
are:

• do' = 0.9 * opening diameter

• lo = 0.45 * opening diameter

Web opening design checks

Common design checks for both composite and non-composite beams
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The following design checks are carried out at each opening for both
composite and steel beams:

• Section and opening dimension limit check including the spacing of
multiple openings if applicable.

• Classification check. Non-compact sections are beyond scope.

• Moment-shear interaction check. First the maximum pure flexural and
shear strength is calculated following the guidelines of the Design Guide
for the currently selected edition of the headcode. Then the direct formulas
(3-5a and 3-5b) are used to calculate design shear and bending strength.

• Deflection calculation. As deflection calculations are headcode
independent, for simplicity a single approach is used irrespective of the
headcode selected.

Additional design checks for non-composite beams or composite beams
at construction stage

The following additional design checks are carried out at each opening only for
non-composite beams or composite beams at construction stage.

• Lateral torsional buckling. The 'standard' lateral torsional buckling check
is run but the torsional constant is multiplied by a reduction factor
according to the design guide. Strength over the openings should not be
the governing UR.

• Buckling of tee-shaped compression zone. The tee which is in
compression is investigated as an axially loaded column following the
procedures of selected headcode. For unreinforced members this is not
required when the aspect ratio of the tee is less than or equal to 4. For
reinforced openings, this check is only required for large openings in
regions of high moment.

Additional design checks for composite beams at composite stage

The following additional design checks are carried out at each opening only for
composite beams at composite stage.

• Slab reinforcement check. The check of minimum transverse and
longitudinal slab reinforcement ratio to prevent cracking of the slab in the
vicinity of the web opening.

• Number of shear connectors above the opening. To limit the effect of
bridging a minimum of two studs per foot is applied to the total number of
studs. If this criterion is already satisfied by normal stud requirements,
additional studs are not needed. A warning is shown when this criteria is
not met.

Deflections

The simplified rules in DG2 are for limited cases and therefore have not been
implemented. Instead Tekla Structural Designer uses a first principles
approach as per Eurocodes.
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The deflection of a beam with web openings will be greater than that of the
same beam without openings. This is due to two effects:

• the reduction in the beam inertia at the positions of openings due to
primary bending of the beam,

• the local deformations at the openings due to Vierendeel effects. This has
two components - that due to shear deformation and that due to local
bending of the upper and lower tee sections at the opening.

The primary bending deflection is established by 'discretising' the member
and using a numerical integration technique based on 'Engineer's Bending
Theory' - M/I = E/R = σ/y. In this way the discrete elements that incorporate all
or part of an opening will contribute more to the total deflection.

The component of deflection due to the local deformations around the
opening is established using a similar process to that used for cellular beams
which is in turn based on the method for castellated beams given in the SCI
publication, “Design of castellated beams. For use with BS 5950 and BS 449".

The method works by applying a 'unit point load' at the position where the
deflection is required and using a 'virtual work technique to estimate the
deflection at that position.

For each opening, the deflection due to shear deformation, δs, and that due to
local bending, δbt, is calculated for the upper and lower tee sections at the
opening. These are summed for all openings and added to the result at the
desired position from the numerical integration of primary bending deflection.

Note that in the original source document on castellated sections, there are
two additional components to the deflection. These are due to bending and
shear deformation of the web post. For castellated beams and cellular beams
where the openings are very close together these effects are important and
can be significant. For normal beams the openings are likely to be placed a
reasonable distance apart. Thus in many cases these two effects will not be
significant. They are not calculated for such beams but in the event that the
openings are placed close together a warning is given.

Seismic design rules (Beams: AISC 360)

Additional design rules are required for seismic combinations. These are as
per the AISC Seismic Provisions (AISC 341-05) (Ref. 9). These additional design
rules ONLY apply to members in Seismic Load Resisting Systems.

See Assumptions & limitations of the seismic provisions (AISC 341-05) for a list
of the assumptions and limitations that apply with respect to the application
of these rules to Tekla Structural Designer models.

The rules applied depend upon the seismic load resisting system as defined in
the AISC Seismic Provisions and are listed below:

For a moment resisting frame

9. Special Moment Frame (SMF)
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• 9.4a. Classification

• 9.8. Max spacing of bracing

10. Intermediate Moment Frame (IMF)

• 10.4a. Classification

• 10.8. Max spacing of bracing

11. Ordinary Moment Frame (OMF)

• 11.4. Classification

Moment resisting frame with a truss component

12. Special Truss Moment Frame (STMF) 1- Beyond Scope

For a braced frame

13. Special Concentrically Braced Frames (SCBF)

• 13.2d. Classification

• 13.4a.(2). Max lat brace spacing

• 13.4a. V and inverted V type

14. Ordinary Concentrically Braced Frames (OCBF)

• 14.2. Classification

• 14.3. Beams with V and inverted V type

• Beams (not columns with no K braces)

• 14.2.(2). Max lat brace spacing

15. Eccentrically Braced Frames (EBF) - Beyond Scope

Buckling resistant braced frame

16. Buckling Restrained Braced Frames (BRBF) - Beyond Scope

Frames containing composite beams

• Composite Special Concentrically Braced Frames (C-SCBF) - Beyond Scope

• Composite Ordinary Braced Frames (C-OBF) - Beyond Scope

• Composite Eccentrically Braced Frames (C-EBF) - Beyond Scope

Composite beam design to AISC 360

• Design method (Composite beams: AISC 360) (page 1682)

• Serviceability limit state (SLS) (Composite beams: AISC 360) (page 1682)

• Construction stage (Composite beams: AISC 360) (page 1684)
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• Composite stage (Composite beams: AISC 360) (page 1685)

Design method (Composite beams: AISC 360)

Either a load and resistance factor design (LRFD) or an allowable strength
design (ASD) can be performed to determine the adequacy of the section for
each condition.

The design method employed is consistent with the design parameters for
simple composite beams as specified in Chapter I of the AISC Specification and
associated 'Commentary', unless specifically noted otherwise. As the 2005
(Ref. 1), 2010 (Ref. 2) and 2016 (Ref. 3) versions are all supported, where
clauses are specific to a particular version these are indicated as (360-05),
(360-10), or (360-16) as appropriate.

A basic knowledge of the design methods for composite beams in accordance
with the specification is assumed.

Serviceability limit state (SLS) (Composite beams: AISC 360)

Section properties (SLS)

In the calculation of the gross moment of inertia of the composite section the
steel deck is ignored as is any concrete in tension. The concrete is converted
into an equivalent steel section using an effective modular ratio based on the
proportions of long and short term loads which are relevant to the particular
calculation. Two alternative approaches are given - see p.16.1-308 in the 2005
Commentary, or p.16.1-353 in the 2010 Commentary for obtaining these
properties.

One (the 'traditional method') calculates the gross uncracked inertia of the
transformed section but uses 75% of the resulting value in the determination
of deflections. The other uses a given formula to determine a 'lower-bound'
inertia. While studies have shown that the simple application of a reduction
factor (0.75) is more onerous than the lower-bound solution, the simpler
'traditional method' is the approach adopted in Tekla Structural Designer.

Tekla Structural Designer therefore calculates the deflection for the beam
based on the properties as tabulated below.

Loadcase type Properties used
self-weight bare beam
Slab Dry bare beam
Dead composite properties calculated using

the modular ratio for long term
loads[1]

Live, Roof Live composite properties calculated using
the effective modular ratio[2]
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Loadcase type Properties used
appropriate to the long term load
percentage for each load.

Wind, Snow, Earthquake composite properties calculated using
the modular ratio for short term
loads

Total loads these are calculated from the
individual loadcase loads as detailed
above.

[1]The long term modulus is taken as the short term value divided by a factor
(for shrinkage and creep), entered in the Slab properties.

nS = the short term modular ratio = Es/Ec

nL = the long term modular ratio = (Es/Ec) * kn

[2]The effective modular ratio, nE is based on the percentage of load which is
considered long term. These calculations are repeated for each individual load
in a loadcase. The effective modular ratio is given by,

nE = nS + ρL * (nL – nS)

ρL = the proportion of the load which is long term

The calculated Slab Dry, Live and Total load deflections (where necessary
adjusted for the effect of partial interaction) are checked against the limits you
specify.

NOTE All the beam deflections calculated above are “relative” deflections.
For an illustration of the difference between relative and absolute
deflection see Deflection checks.

Stress checks (SLS)

The Commentary (Section I3.1, paragraph 2 of the 2005 version, Section I3.2,
of the 2010 version) suggests that where deflection controls the size of the
beam then either it should be ensured that the beam is elastic at serviceability
loading or that the inelastic deformations are taken into account. Tekla
Structural Designer adopts the former approach. This is confirmed by checking
that yield in the beam and crushing in the concrete do not occur at
serviceability loading i.e. a service stress check. If they are found to fail,
suggesting inelasticity at serviceability loading, then a warning will appear on
the deflections page and the service stress results are available to view.

Tekla Structural Designer calculates the worst stresses in the extreme fibres of
the steel and the concrete at serviceability limit state for each load taking into
account the proportion which is long term and that which is short term. These
stresses are then summed algebraically. The partial safety factors for loads are
taken as those provided by you for the service condition on the Design
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Combinations page. The stress checks assume that full interaction exists
between the steel and the concrete at serviceability state.

Natural frequency checks (SLS)

The calculation of the natural frequency of a composite beam can be complex
and is dependent upon the support conditions, the load profile and the
properties of the composite section. In reality the vibration of a composite
beam is never in isolation – the whole floor system (including the slabs and
other adjacent beams) will vibrate in various modes and at various
frequencies.

A simple (design model) approach is taken based on uniform loading and pin
supports. This fairly simple calculation is provided to the designer for
information only. The calculation can be too coarse particularly for long span
beams and does not consider the response side of the behavior i.e. the
reaction of the building occupants to any particular limiting value for the floor
system under consideration. In such cases the designer will have the option to
perform a Floor vibration analysis within the Tekla Structural Designer
application.

Simplified approach

The natural frequency is determined from,

NF = 0.18 * √(g/ΔNF)

Where:

• ΔNF = the maximum static instantaneous deflection (in inches) that would
occur under the effects of Slab Dry loading, and the proportion of dead
loads and live loads specified by the user (as specified on the Natural
Frequency page of the Design Wizard). It is based upon the composite
inertia but not modified for the effects of partial interaction.

• g = the acceleration due to gravity (386.4 in/s2)

• Factor of increased dynamic stiffness of concrete flange (default 1.35)

This is not given in the AISC Specification but is taken from Chapter 3 of Steel
Design Guide Series 11. Floor Vibrations due to Human Activity. (Ref. 6) Its
formulation is derived from the first mode of vibration of a simply supported
beam subject to a udl.

Construction stage (Composite beams: AISC 360)

At construction stage the beam is acting alone before composite action is
achieved and is unshored.

When you design or check a beam for construction stage loading the following
checks are carried out in accordance with the relevant chapters of the AISC
Specification, consistent with the approach (i.e. LRFD or ASD) used at the
composite stage.
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Section classification (Composite beams: AISC 360)
Cross-section classification is determined using Table B4.1 (360-05), or Tables
B4.1a+B4.1b (360-10) and must be compact or non compact. Sections which
are classified as slender are beyond the scope of Tekla Structural Designer.

Shear strength - I3.1b (360-05), I4.2 (360-10) (Composite beams: AISC 360)
Shear checks are performed at the point of maximum shear based upon the
properties of the steel section alone in accordance with Section G2.

Strength during construction - I3.1c (360-05), I3.1b (360-10) (Composite beams: AISC 360)

Flexure

Checks are performed at the point of maximum moment along the beam
based upon the properties of the steel section alone in accordance with
Section F2.

Lateral torsional buckling checks

When the forms are attached to the top flange then full lateral restraint can be
assumed, irrespective of the angle of the deck. In this case you should indicate
the beam is continuously braced.

In other cases any incoming beams will be automatically identified.

Each sub-length which is not defined as being continuously braced is checked
in accordance with Section F2.

Deflection checks (Composite beams: AISC 360)

Relative deflections are used in the composite beam design. (See: Deflection
checks (page 1670))

The following deflections are calculated for the loads specified in the
construction stage load combination:

• the Dead load deflections i.e. those due to the beam self weight, the Slab
Wet loads and any other included dead loads,

• the live load deflections i.e. those due to construction live loads,

• the Total load deflection i.e. the sum of the previous items.

The loads are taken as acting on the steel beam alone.

The “Service Factor” (default 1.0), specified against each load case in the
construction combination is applied when calculating the above deflections.

If requested by the user, the total load deflection is compared with either a
span-over limit or an absolute value. The initial default limit is span/200, (as
per CC.1.1 of ASCE 7-05 (Ref. 7) or ASCE 7-10 (Ref. 8)).
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Composite stage (Composite beams: AISC 360)
Tekla Structural Designer performs all checks for the composite stage
condition in accordance with Section I3 unless specifically noted otherwise.

Equivalent steel section (Composite beams: AISC 360)
An equivalent steel section is determined for use in the composite stage
calculations by removing the fillet while maintaining the full area of the
section. This approach reduces the number of change points in the
calculations while maintaining optimum section properties.

Shear strength - I3.1b (360-05), I4.2 (360-10) (Composite beams: AISC 360)
Shear checks are performed at the point of maximum shear in accordance
with Section G2 for the maximum required shear strength, Vr, at the
composite stage. The shear check is performed on the bare beam alone at the
composite stage ignoring any contribution from the concrete slab.

Strength of composite beams with shear connectors - I3.2 (Composite beams: AISC 360)

Section classification

For section classification purposes the true section is used. Tekla Structural
Designer classifies the section in accordance with Section I3.2a. Only the web
of the section is classified - the bottom flange is in tension and so cannot
buckle locally and it is assumed that the top flange is sufficiently braced by the
composite slab.

The classification of the web must be compact so that plastic stress blocks can
be used.

Flexure

Checks are performed at the point of maximum moment and the position of
application of each point load as well as all other points of interest along the
beam. Flexure is calculated in accordance with Section I3.2 (360-05/-10). Since
the flexural strength at all point loads is checked then this will inherently
satisfy Section I3.2d (6) (360-05) or Section I8.2c (360-10) which require that
“the number of shear connectors placed between any concentrated load and
the nearest point of zero moment shall be sufficient to develop the maximum
required flexural strength at the concentrated load point”.

During the selection process, in auto design mode point loads are taken to be
“significant” if they provide more than 10% of the total shear on the beam. For
the final configuration and for check mode all point loads are checked for
flexure.

Shear connectors (Composite beams: AISC 360)
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Tekla Structural Designer checks shear connectors to Section I1-3 (360-05), or
Section I8 (360-10).

The nominal strength of headed stud shear connectors in a solid slab or a
composite slab is determined in accordance with Section I3.2d (360-05), or
Section I3.2d with shear connector strength from I8.2a (360-10).

Ribs perpendicular

The reduction factor Rp is taken as,

• 0.6 for any number of studs and emid-ht < 2 in

• 0.75 for any number of studs and emid-ht >= 2 in

In Tekla Structural Designer you are therefore not required to input the actual
value of emid-ht instead you simply indicate if it is less than 2 in.

Ribs parallel

Rp = 0.75 in all cases

Ribs at other angles

Where the ribs are at an angle θr to the beam there is no guidance in the AISC
Specification. The approach adopted by Tekla Structural Designer is to apply a
geometric adjustment of the reduction factors Rg and Rp which for the
purposes of this adjustment are combined into one “k” factor. The combined
reduction factor is calculated for perpendicular and parallel separately and
then adjusted as shown below.

ks = k1 * sin2θr + k2 * cos2θr

Where:

ks = the adjusted value of the combined reduction factor Rg * Rp

k1 = the value of the combined reduction factor Rg * Rp for ribs perpendicular

k2 = the value of the combined reduction factor Rg * Rp for ribs parallel

Degree of shear connection

For efficient design the number of studs should be minimized. If the number
provided has an overall capacity greater than the capacity of the concrete
flange or steel beam (whichever is the lesser) then this is full shear connection.
Anything less than this, is partial shear connection. There are, however, limits
on the amount of partial interaction that are recommended by the AISC
Specification – see note “3” (p.16.1-311 of the 2005 Commentary, or p.16.1-356
of the 2010 Commentary).

For all beams, the number of connectors required for full shear connection is,

Ns = (min(Ts, (Cc1 + Cc2)))/Qn rounded up to the next group size above

Where:
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Ts = the tensile yield strength of the steel section

Cc1 = the strength of the concrete flange above the ribs

Cc2 = strength of the concrete in the ribs (zero for perpendicular decks)

Qn = the nominal strength of an individual shear connector

The degree of partial shear connection is given by,

Int = Na * Qn / (min((Cc1 + Cc2), Ts))

Where:

Na = the number of shear connectors provided from the nearer point of
support to the position under consideration

The degree of partial shear connection is checked at the point of maximum
bending moment or the position of a point load if at that position the
maximum utilization ratio occurs.

To determine the status of the check Tekla Structural Designer applies the
following rules:

• If the partial interaction ratio at the position of maximum moment is less
than the absolute minimum interaction ratio (default 25%), then this
generates a FAIL status,

• If the partial interaction ratio at the position of maximum utilization ratio
when this is at a different position to the maximum moment, is less than
the absolute minimum interaction ratio, then this generates a WARNING
status,

• If the partial interaction ratio at the position of maximum moment, or
maximum utilization ratio if this is different, is greater than the absolute
minimum interaction ratio, then this generates a PASS status,

• If the partial interaction ratio at any point load position that is not the
maximum utilization ratio is less than the absolute minimum interaction
ratio, then this does not affect the status in any way.

• If the partial interaction ratio at any position is less than the advisory
minimum interaction ratio (default 50%) then this is given for information
only and does not affect the status in any way.

Dimensional requirements

The dimensional limits given below are either recommendations or code
limits:

• the nominal rib height of the profiled deck, hr should be not greater than 3
in

• the mean width of the ribs of the profiled sheet, wr should be not less than
2 in (for re-entrant decks the “mean” is taken as the minimum opening at
the top of the rib)
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• the nominal diameter of stud connectors, dsc should be not greater than ¾
in

• the height of the stud after welding, Hs should be at least 1½ in greater
than the nominal rib height of the profiled deck – see Section I3.2c(b)
(360-05), or Section I3.2c(2) (360-10).

• the total depth of the composite slab, dcs should not be less than 3¾ in

• the thickness of concrete above the main flat surface of the top of the ribs
of the sheeting, dcs - hr should not be less than 2 in

• concrete cover, dcs – Hs over the connector should not be less than ½ in –
see Section I3.2c(b) (360-05), or Section I3.2c(2) (360-10).

• the longitudinal spacing should not exceed the lesser of 36 in or 8 * the
slab depth, dcs (see Section 6.2.6.2 of Structural Steel Designer's Handbook.
Second Edition (Ref. 5))

• where studs are spaced at greater than 18 in centers puddle welds or other
appropriate means are required to ensure anchorage of deck – see Section
I3.2c (360-05), or Section I3.2c(4) (360-10).

• the clear distance between the edge of a connector and the edge of the
steel beam flange should be not less than ¾ in (as universal good practice).

• Section I8.2d of the AISC Specification (360-10) requires that the minimum
edge distance from the center of an anchor to a free edge in the direction
of the shear force shall be 8 in for normal weight concrete and 10 in for
lightweight concrete. This requirement will apply only in a limited number
of configurations and therefore is not checked.

• the spacing of connectors in the direction of shear i.e. along the beam
should be not less than, 6 * the stud diameter

• the spacing of connectors transverse to direction of shear i.e. across the
beam should be not less than 4 * the stud diameter except for the
condition given in the next item

• where rows of studs are staggered, the minimum transverse spacing
between longitudinal lines of studs should be not less than 3 * the stud
diameter with the amount of stagger such that the diagonal distance
between studs on adjacent longitudinal lines is not less than 4 * the stud
diameter

• the stud connector diameter should not exceed 2.5 times the flange
thickness unless located directly over the web.

NOTE You should confirm that the chosen configuration of decking and
studs meet those dimensional requirements that you deem
appropriate.
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Steel column design to AISC 360

• Design method (Columns: AISC 360) (page 1690)

• Section classification (Columns: AISC 360) (page 1690)

• D2. Axial tension (Columns: AISC 360) (page 1691)

• E. Axial compression (Columns: AISC 360) (page 1691)

• G2. Shear strength (Columns: AISC 360) (page 1691)

• F2. Flexure (Columns: AISC 360) (page 1691)

• H1. Combined forces (Columns: AISC 360) (page 1692)

• Seismic design rules (Columns: AISC 360) (page 1692)

Design method (Columns: AISC 360)

Either a load and resistance factor design (LRFD) or an allowable strength
design (ASD) can be performed to determine the adequacy of the section for
each condition.

The design method employed is consistent with the design parameters
specified in the relevant chapters of the AISC Specification and associated
'Commentary', unless specifically noted otherwise. As the 2005 (Ref. 1), 2010
(Ref. 2) and 2016 (Ref. 3) versions are all supported, where clauses are specific
to a particular version these are indicated as (360-05), (360-10), or (360-16) as
appropriate. A basic knowledge of the design methods for columns in
accordance with the specification is assumed.

Section classification (Columns: AISC 360)

Cross-section classification is determined using Table B4.1 (360-05), or Tables
B4.1a+B4.1b (360-10).

At every cross section there are two classifications for each element in the
section (flange or web) - one for axial compression and one for bending
(flexure).

If axial compression does not exist (0kip or tension), the axial classification is
NA. If bending is not present about both axes then the flexure classification is
NA.

For axial compression the web and flanges are classified as either Compact or
Slender and the worst of the two is the resultant axial classification.

For bending both the web and flange are classified as Compact, Non compact
or Slender and the worst of the two is the resultant flexural classification.
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The classification of the section must normally be Compact or Non compact,
however sections which are classified as Slender will be allowed if they are
subject to axial load only.

All unacceptable classifications are either failed in check mode or rejected in
design mode.

D2. Axial tension (Columns: AISC 360)

If axial tension exists, tensile yielding and rupture checks are performed at the
point of maximum tension in accordance with Equations D2.1 and D2.2.

NOTE In the rupture check the net area Ae is assumed to equal the gross
area Ag.

A warning is also issued if the slenderness ratio L/r exceeds 300.

E. Axial compression (Columns: AISC 360)

If axial compression exists, the member is assessed for Flexural buckling and
for Torsional and flexural torsional buckling. The compressive strength is
determined in accordance with Equations E3.1 and E4.1. For double angles
these equations are subject to the modifications of Section E6.

The member length or member sub lengths between braces are checked for:

• Flexural buckling about major axis - for each sub-length between adjacent
points of major axis lateral bracing and or torsional bracing.

• Flexural buckling about minor axis - for each sub-length between adjacent
points of minor axis lateral bracing and or torsional bracing.

• Torsional and flexural torsional buckling - for each sub-length between
adjacent points of torsional bracing (this check is not applied to hollow
sections.)

For any sub-length, the required compressive force Pr is taken as the
maximum compressive force in the relevant sub-length.

A warning is also issued if the slenderness ratio KL/r exceeds 200.

G2. Shear strength (Columns: AISC 360)
Shear checks are performed for the absolute value of shear force normal to
the x-x axis and normal to the y-y axis, Fvx and Fvy, at the point under
consideration in accordance with Section G2.

F2. Flexure (Columns: AISC 360)
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The member is assessed for Flexure in accordance with section F2. The
following checks are potentially required:

About the x axis - within the LTB sub-length

• Yielding

• Compression flange local buckling

• Web local buckling

• Local buckling

• Lateral Torsional Buckling (only required for I and C sections)

About the y axis in the LTB sub-length

• Yielding

• Compression flange local buckling

• Web local buckling

• Local buckling

The lateral torsional buckling checks can be switched off for any sub-length by
indicating the length is continuously braced. If you use this option you must be
able to provide justification that the sub-length is adequately braced against
lateral torsional buckling.

When the checks are required you can set the effective length of each sub-
beam (the portion of the beam between one brace and the next) either by
giving factors to apply to the physical length of the beam, or by entering the
effective length that you want to use.

H1. Combined forces (Columns: AISC 360)
Members subject to axial tension or compression and flexure about one or
both axes are assessed in accordance with section H1.

Seismic design rules (Columns: AISC 360)

Additional design rules are required for seismic combinations. These are as
per the AISC Seismic Provisions (AISC 341-05) (Ref. 9). These additional design
rules ONLY apply to members in Seismic Load Resisting Systems.

See Assumptions & limitations of the seismic provisions (AISC 341-05) for a list
of the assumptions and limitations that apply with respect to the application
of these rules to Tekla Structural Designer models.

The rules applied depend upon the seismic load resisting system as defined in
the AISC Seismic Provisions and are listed below:

For a moment resisting frame

9. Special Moment Frame (SMF)

• 9.4a. Classification
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• 9.4. Column strength check

• 9.6. Column/beam moment ratio

10. Intermediate Moment Frame (IMF) • 10.4a. Classification

• 10.4. Column strength

11. Ordinary Moment Frame (OMF)

• 11.4. Classification

• 11.4. Column strength check

Moment resisting frame with a truss component

12. Special Truss Moment Frame (STMF) 1- Beyond Scope

For a braced frame

13. Special Concentrically Braced Frames (SCBF)

• 13.2d. Classification

• 13.2b. Column strength check

14. Ordinary Concentrically Braced Frames (OCBF)

• 14.2. Classification

• 14.2. Column strength check

15. Eccentrically Braced Frames (EBF) - Beyond Scope

Buckling resistant braced frame

16. Buckling Restrained Braced Frames (BRBF) - Beyond Scope

Frames containing composite beams

Composite Special Concentrically Braced Frames (C-SCBF) - Beyond Scope

Composite Ordinary Braced Frames (C-OBF) - Beyond Scope

Composite Eccentrically Braced Frames (C-EBF) - Beyond Scope

Steel brace design to AISC 360

• Design method (Braces: AISC 360) (page 1693)

• Section classification (Braces: AISC 360) (page 1694)

• D2. Axial tension (Braces: AISC 360) (page 1694)

• E. Axial compression (Braces: AISC 360) (page 1694)

• Seismic design rules (Braces: AISC 360) (page 1695)

Design method (Braces: AISC 360)
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Tekla Structural Designer allows you to analyze and design a member with
pinned end connections for axial compression, tension and seismic design
forces.

Either a load and resistance factor design (LRFD) or an allowable strength
design (ASD) can be performed to determine the adequacy of the section for
each condition.

The design method employed is consistent with the design parameters
specified in the relevant chapters of the AISC Specification and associated
'Commentary', unless specifically noted otherwise. As the 2005 (Ref. 1), 2010
(Ref. 2) and 2016 (Ref. 3) versions are all supported, where clauses are specific
to a particular version these are indicated as (360-05), (360-10), or (360-16) as
appropriate.

A basic knowledge of the design methods for braces in accordance with the
specification is assumed.

Section classification (Braces: AISC 360)
Cross-section classification is determined using Table B4.1 (360-05), or Tables
B4.1a+B4.1b (360-10).

D2. Axial tension (Braces: AISC 360)

If axial tension exists, tensile yielding and rupture checks are performed at the
point of maximum tension in accordance with Eqns D2.1 and D2.2.

A warning is also issued if the slenderness ratio L/r exceeds 300.

E. Axial compression (Braces: AISC 360)

If axial compression exists, the member is assessed for Flexural Buckling and
for Torsional and Flexural Torsional buckling. The compressive strength is
determined in accordance with Eqns E3.1 and E4.1. For double angles these
equations are subject to the modifications of Section E6.

The member length or member sub lengths between braces are checked for:

• Flexural buckling about major axis - for each braced length between
adjacent points of major axis lateral bracing and or torsional bracing.

• Flexural buckling about minor axis - for each braced length between
adjacent points of minor axis lateral bracing and or torsional bracing.

• Torsional and flexural torsional buckling - for each braced length between
adjacent points of torsional bracing (this check is not applied to hollow
sections.)

For any braced length, the required compressive force Pr is taken as the
maximum compressive force in the relevant length.

A warning is also issued if the slenderness ratio KL/r exceeds 200.
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Seismic design rules (Braces: AISC 360)

Additional design rules are required for seismic combinations. These are as
per the AISC Seismic Provisions (AISC 341-05) (Ref. 9). These additional design
rules ONLY apply to members in Seismic Load Resisting Systems.

See Assumptions & limitations of the seismic provisions (AISC 341-05) for a list
of the assumptions and limitations that apply with respect to the application
of these rules to Tekla Structural Designer models.

The rules applied depend upon the seismic load resisting system as defined in
the AISC Seismic Provisions and are listed below:

For a braced frame

13. Special Concentrically Braced Frames (SCBF)

• 13.2d. Classification

• 13.2b. brace required strength

• 13.2a. brace slenderness limit

• 13.2e. built up members - double angles

14. Ordinary Concentrically Braced Frames (OCBF)

• 14.2. Classification

• 14.2. Bracing members, V or A braces

15. Eccentrically Braced Frames (EBF) - Beyond Scope

Buckling resistant braced frame

16. Buckling Restrained Braced Frames (BRBF) - Beyond Scope

Frames containing composite beams

Composite Special Concentrically Braced Frames (C-SCBF) - Beyond Scope

Composite Ordinary Braced Frames (C-OBF) - Beyond Scope

Composite Eccentrically Braced Frames (C-EBF) - Beyond Scope

Truss member design to AISC 360

• Design method (Trusses: AISC 360) (page 1695)

• Design checks (Trusses: AISC 360) (page 1696)

Design method (Trusses: AISC 360)
Unless explicitly stated all truss calculations will adopt either a load and
resistance factor design (LRFD) or an allowable strength design (ASD) as

Design codes reference 1695 US codes



consistent with the design parameters as specified in the AISC Specification
and associated Commentary.

Design checks (Trusses: AISC 360)

Truss members can either be defined manually, or the process can be
automated using the Truss Wizard. Irrespective of the method used, the
resulting Truss members will be one of four types:

• Internal

• Side

• Bottom

• Top

Depending on the type, different design procedures are adopted.

Internal and side truss members

The design checks for internal and side truss members are the same as those
for braces. With the exception that seismic forces are not designed for. See:
Steel brace design to AISC 360 (page 1693)

Top and bottom truss members

The design checks for top and bottom truss members are the same as those
for beams. With the exception that seismic forces are not designed for. See:
Steel beam design to AISC 360 (page 1671)

Steel single, double angle and tee section design to AISC 360

• Design method (Angles and tees: AISC 360) (page 1696)

• Angle and tee limitations (AISC 360) (page 1697)

• Section axes (Angles and tees: AISC 360) (page 1697)

• Design procedure for single angles (Angles and tees: AISC 360) (page 1698)

• Design procedure for tee sections (Angles and tees: AISC 360) (page 1700)

• Design procedure for double angles (Angles and tees: AISC 360)
(page 1701)

• Deflection of single angles (Angles and tees: AISC 360) (page 1702)

Design method (Angles and tees: AISC 360)

Either a load and resistance factor design (LRFD) or an allowable strength
design (ASD) can be performed to determine the adequacy of the section for
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each condition. The design method adopted is dictated by the member
characteristic type:

Beam, Truss member top, or Truss member bottom:

• Member is designed for axial tension, compression, shear, bending and
combined forces

• This is consistent with the method detailed in Steel beam design to AISC
360

Brace, Truss internal, or Truss member side:

• Member is designed for axial tension, compression and compression
buckling only

• This is consistent with the method detailed in Steel brace design to AISC
360

A basic knowledge of the design method for angles and tees in accordance
with the specification is assumed.

NOTE For tees, single angles, and double angles - specific additional Angle
and tee limitations apply to the above design methods.

NOTE When modelling a double angle, the Compression property 'a'
(distance between connectors), has to be manually set (either in
Compression section of the Properties window or on the
Compression tab of the Properties dialog box). Refer to AISC 360
section E6 for further information.

Angle and tee limitations (AISC 360)

• All sections and in particular single angles are assumed to be effectively
loaded through the shear center such that no additional torsion moments
are developed. In addition no direct allowance is made for 'destabilizing
loads'.

• Design excludes bending of the outstand leg of single and double angles
loaded eccentrically e.g. supporting masonry.

Section axes (Angles and tees: AISC 360)

For all sections:

• x-x is the axis parallel to the flanges

• y-y is the axis perpendicular to the flanges

• for Single Angles and Double Angles

• y-y parallel to long side (leg) - single angles
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• y-y parallel to long side (leg) - double angles with long leg back to
back

• y-y parallel to short side (leg) - double angles with short leg back to
back

• w-w is the major principal axis for single angles

• z-z is the minor principal axis for single angles

Design procedure for single angles (Angles and tees: AISC 360)

Single angles with continuous lateral-torsional restraint along the length are
permitted to be designed on the basis of geometric axis (x, y) bending.

Single angles without continuous lateral-torsional restraint along the length
are designed using the provision for principal axis (w, z) bending except
where the provision for bending about geometric axis is permitted.

Geometric axis bending permitted:

• If single angles without continuous lateral torsional restraint and legs of
angles are equal and there is no axial compression and bending about one
of the geometric axis only

NOTE Design on the basis of geometric axis bending should also be
permitted if single angles without continuous lateral torsional
restraint but with lateral torsional restraint at the point of maximum
moment only and legs of angles are equal and there is no axial
compression and bending about one of the geometric axis only.
However this is beyond scope of the current release of the program.

Geometric axis design

1. Nominal flexural strength Mnx – about X axis (major geometric axis)

2. Nominal flexural strength Mny – about Y axis (minor geometric axis)

Check:

IF LRFD

a. Mrx ≤ φb * Mnx , where φb = 0.9

b. Mry ≤ φb * Mny , where φb = 0.9

IF ASD

Mrx ≤ Mnx /Ωb , where Ωb = 1.67

Mry ≤ Mny /Ωb , where Ωb = 1.67

Principal axis design

1. Required flexural strength Mrw – about W axis

2. Required flexural strength Mrz – about Z axis
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3. Nominal flexural strength Mnw – about W axis (major principal bending
axis)

4. Nominal flexural strength Mnz – about Z axis (minor principal bending
axis)

Check:

IF LRFD

a. Mrw ≤ φb * Mnw , where φb = 0.9

b. Mrz ≤ φb * Mnz , where φb = 0.9

IF ASD

a. Mrw ≤ Mnw /Ωb , where Ωb = 1.67

b. Mrz ≤ Mnz /Ωb , where Ωb = 1.67

The principal axes moments are calculated from the following formulas for
both LRFD and ASD:

Mrw = Mrx cosα + Mry sinα

Mrz = -Mrx sinα + Mry cosα

In the case of biaxial bending, or bending and axial force the combined stress
ratio must be checked using the provisions of AISC, section H2.

For the three points of the angle A, B, C the combined ratio check should be
performed.

Single Equal Angles - Sign of Moments
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Single Unequal Angles - Sign of Moments

If the interaction of stresses at each point is seen to be less than 1.0 the
member is adequate to carry the required load.

Check:1

Abs (fra / Fca + frbw / Fcbw + frbz / Fcbz) ≤ 1.0

NOTE In axial tension when the sum of the moment ratios about the major
and minor axis bending is greater or equal to 0 then the axial stress
ratio is taken as 0.0 in order to give conservative results and the axial
stress ratio is renamed “effective”.

Design procedure for tee sections (Angles and tees: AISC 360)

The nominal flexural strength Mn is the lowest value obtained according to the
limit states of yielding (plastic moment), lateral-torsional buckling and leg local
buckling.

Mnx = Min {Mnx,Yield, Mnx,LTB, Mnx,LLB}

In the case of biaxial bending, or bending and axial force the combined stress
ratio must be checked using the provisions of AISC, section H2.

The applied loads are

• Pr Axial

• Mrx Bending in x axis

• Mry Bending in y axis

Check:1

Abs (fra / Fca + frbzx / Fcbx + frby / Fcby) ≤ 1.0

Design codes reference 1700 US codes



Tees - Critical Points A, B & C

Design procedure for double angles (Angles and tees: AISC 360)

The nominal flexural strength Mn is the lowest value obtained according to the
limit states of yielding (plastic moment), lateral-torsional buckling and leg local
buckling.

Mnx = Min {Mnx,Yield, Mnx,LTB, Mnx,LLB}

NOTE For the local buckling check of double angles the provisions of the
2010 code are used. In the 05 code, section F9.3 states Flange local
Buckling of Tees and does not refer to double angles.

In the case of biaxial bending, or bending and axial force the combined stress
ratio must be checked using the provisions of AISC, section H2. The applied
loads are

• Pr Axial

• Mrx Bending in x axis

• Mry Bending in y axis

Check:[1] Abs (fra / Fca + frbw / Fcbx + frby / Fcby) ≤ 1.0
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Double Angles - Critical Points A, B & C

Deflection of single angles (Angles and tees: AISC 360)

If a single angle is continuously restrained the major geometric moment and
major geometric section properties are used in the general equation
governing the beam deflection.

However, because single angle geometric axes are not coincident with the
principal axes; a different procedure is required if the angle is not
continuously restrained, the procedure being as follows:

1. External loads are transposed from the geometric axes to the principal
axes.

2. The deflection equations are used to calculate deflections in the principal
axes.

3. These principal axis deflections are then transposed to geometric axes
again.

Single Angle Deflections (continuously restrained, unrestrained)
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Steel seismic design to AISC 341

Additional seismic provisions are required to be applied to members that are
part of the seismic force resisting system (SFRS) of a structure. These
provisions are applied in addition to any standard requirements for structural
steel buildings as per AISC 360. The seismic provisions are contained in AISC
341. Tekla Structural Designer covers non-seismic steel design to AISC 360-05,
AISC 360-10 and AISC 360-016. The purpose of this guide is to describe the
matching seismic design requirements contained in AISC 341-05, AISC 341-10
and AISC 341-16.

• Criteria assumed to be met (page 1704)

• Design philosophy (page 1708)

• Changes introduced in AISC 341-16 (page 1708)

• Common seismic requirements (page 1709)

• Seismic checks - Beams (page 1714)
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• Seismic checks - Columns (page 1718)

• Seismic checks - Braces (page 1725)

• References (page 1729)

Criteria assumed to be met (Seismic: AISC 341)
Seismic design in the current release of Tekla Structural Designer covers only
those checks detailed in later sections and presupposes certain criteria are
met e.g. that lateral braces to beams are sufficiently strong. These
presuppositions are noted below.

Common

AISC 341-16 and AISC 341-10

• Column bases are assumed to comply with the requirements of D2.6.

• Steel material grades used in particular members and SFRS type are
assumed to comply with A3.1.

AISC 341-05

• Column bases are assumed to comply with the requirements of 8.5.

• Steel material grades used in particular members and SFRS type are
assumed to comply with 6.1.

OMF

AISC 341-16 and AISC 341-10

• Beam to column connections used in the SFRS are assumed to satisfy the
requirements of E1.6.

AISC 341-05

• Beam to column connections used in the SFRS are assumed to satisfy the
requirements of 11.2.

• Continuity plates are assumed to comply with the requirements of 11.5.

• As per 11.9 column splices are assumed to comply with the requirements
of 8.4a.

IMF

AISC 341-16 and AISC 341-10

• The lateral braces themselves will not be designed to meet the additional
criteria of D1.2a & c - it is assumed that the user will check this
independently.
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• The position of lateral braces will not be checked for the location of points
of concentrated force or positions of plastic hinge per D1.2c.

• The protected zone is assumed to comply with E2.5c.

• Connections used in the SFRS are assumed to satisfy the requirements of
E2.6.

AISC 341-05

• Beam to column connections used in the SFRS are assumed to satisfy the
requirements of 10.2.

• Panel zones in beam to column connections used in the SFRS are assumed
to satisfy the requirements of 10.3.

• Continuity plates are assumed to comply with the requirements of 10.5.

• The lateral braces themselves will not be designed to meet the additional
criteria of 10.8 - it is assumed that the user will check this independently.

• The position of lateral braces will not be checked for the location of points
of concentrated force or positions of plastic hinge per 10.8.

• As per 10.9 column splices are assumed to comply with the requirements
of 8.4a.

SMF

AISC 341-16 and AISC 341-10

• The lateral braces themselves will not be designed to meet the additional
criteria of D1.2b & c - it is assumed that the user will check this
independently.

• The position of lateral braces will not be checked for the location of points
of concentrated force or positions of plastic hinge per D1.2c.

• Beam column connections are always assumed braced as per E3.4c(1).

• The protected zone is assumed to comply with E3.5c.

• Connections used in the SFRS are assumed to satisfy the requirements of
E3.6.

AISC 341-05

• Beam to column connections used in the SFRS are assumed to satisfy the
requirements of 9.2.

• Panel zones in beam to column connections used in the SFRS are assumed
to satisfy the requirements of 9.3.

• Continuity plates are assumed to comply with the requirements of 9.5.

• Beam column connections are always assumed braced as per 9.7a.

• The lateral braces themselves will not be designed to meet the additional
criteria of 9.8 - it is assumed that the user will check this independently.
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• The position of lateral braces will not be checked for the location of points
of concentrated force or positions of plastic hinge per 9.8.

• Column splices are assumed to comply with the requirements of 9.9 whilst
those not part of the SFRS are assumed to comply with 8.4b

OCBF

AISC 341-16 and AISC 341-10

• Column splices are assumed to comply with D2.5.

• It is assumed that the beams in OCBF are continuous between columns in
accordance with F1.4a.

• It is assumed that the user will ensure that the ends of V and A braces are
vertically released so that they provide no support for dead and live loads
as per F1.4a (1).

• It is assumed that the user will apply the relevant lateral restraint at
position of V/A braces or establish that the beam has sufficient out of plane
strength and stiffness to ensure stability in order to comply with F1.4a (2).

• K braces are not permitted for OCBF in accordance with F1.4b.

• Coincident V and A braces giving X type braced frames are out of scope for
additional beam checks required by AISC 341-10 F1.4a.

• Bracing connections in the SFRS are assumed to satisfy the requirements
of F1.6.

• OCBF above seismic isolation systems are currently beyond scope

AISC 341-05

• Column splices are assumed to comply with 8.4a. Column splices in
columns not part of the SFRS are assumed to comply with 8.4b.

• It is assumed that the beams in OCBF are continuous between columns in
accordance with 14.3.

• It is assumed that the user will ensure that the ends of V and A braces are
vertically released so that they provide no support for dead and live loads
as per 14.3 (1).

• Lateral braces are not designed to meet the additional criteria in 14.3 (2) - it
is assumed that the user will check this independently.

• It is assumed that the user will apply the relevant lateral restraint at
position of V/A braces or establish that the beam has sufficient out of plane
strength and stiffness to ensure stability in order to comply with 14.3 (2).

• K braces are currently beyond scope for OCBF.

• Coincident V and A braces giving X type braced frames are out of scope for
additional beam checks required by AISC 341-05 14.3.
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• Bracing connections in the SFRS are assumed to satisfy the requirements
of 14.4.

• OCBF above seismic isolation systems are currently beyond scope

SCBF

AISC 341-16 and AISC 341-10

• Column splices are assumed to comply with D2.5.

• Coincident V and A braces giving X type braced frames are out of scope for
additional beam checks required by AISC 341-10 F2.3a.

• It is assumed that the force resisted by tension braces is between 30% and
70% of the total horizontal force along the line of braces as per F2.4a.

• It is assumed that the beams in SCBF are continuous between columns in
accordance with F2.4b (1).

• It is assumed that the user will apply the relevant lateral restraint at
position of V/A braces or establish that the beam has sufficient out of plane
strength and stiffness to ensure stability in order to comply with F2.4b (2).

• K braces are not permitted for SCBF in accordance with F2.4c.

• Tension only braces are not permitted for SCBF in accordance with F2.4d.

• Bracing connections in the SFRS are assumed to satisfy the requirements
of F2.5b.

• The protected zone is assumed to comply with F2.5c

AISC 341-05

• It is assumed that the force resisted by tension braces is between 30% and
70% of the total horizontal force along the line of braces as per 13.2c.

• Bracing connections in the SFRS are assumed to satisfy the requirements
of 13.3.

• It is assumed that the user will ensure that the ends of V and A braces are
vertically released so that they provide no support for dead and live loads
as per 13.4a (1).

• It is assumed that the beams in SCBF are continuous between columns in
accordance with 13.4a (2).

• Lateral braces are not designed to meet the additional criteria in 13.4a (2) -
it is assumed that the user will check this independently.

• It is assumed that the user will apply the relevant lateral restraint at
position of V/A braces or establish that the beam has sufficient out of plane
strength and stiffness to ensure stability in order to comply with 13.4a.

• K braces are not permitted for SCBF in accordance with 13.4b.

• Coincident V and A braces giving X type braced frames are out of scope for
additional beam checks required by AISC 341-05 13.4.
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• Column splices are assumed to comply with 13.5. Column splices in
columns not part of the SFRS are assumed to comply with 8.4b.

• The protected zone is assumed to comply with 13.6.

Design philosophy (Seismic: AISC 341)

All members are designed as per the normal AISC Specification rules for the
seismic load combinations.

Additional design rules are required for seismic combinations. These are as
per the AISC Seismic Provisions (AISC 341-05) (Ref. 3) or (AISC 341-10) (Ref. 4).
These rules are applied as follows:

• If SDC = A - no additional requirements

• If SDC = D, E or F, apply rules for AISC 341

For each of Direction 1 and Direction 2:

• If SDC = B or C and R ≤ 3 - no additional requirements

• If SDC = B or C and R > 3, apply rules for AISC 341

Where requirements are necessary then they apply only to the members of
the SFRS and are only checked for the seismic combinations.

Changes introduced in AISC 341-16 (Seismic AISC 341)

Design is available to AISC 341-05, AISC 341-10 and AISC 341-16. The changes
between the 10 and 16 versions, as implemented in Tekla Structural Designer
are listed below.

Column required strength (D1.4a) (applies to all SFRS)

• Only for ‘overstrength seismic load’

• Previously called ‘amplified seismic load’

• Capacity analysis’ now omitted

OCBF and V&A braces (F1.4a)

• Tension yield strength/amplified seismic + post buckling strength has been
replaced by overstrength seismic load + post buckling strength

OCBF and beam design (F1.5c)

• New requirement, beams in SFRS are now designed for overstrength
seismic load
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SMF Moment ratio (E3.4a) - strong column weak beam

• Enhanced plastic moment capacity of beams 1.1 Ry Fy Z has been replaced
by maximum probable moment, Cpr/αs Ry Fy Z. Cpr from AISC 358-16

Common seismic requirements (Seismic: AISC 341)

Required strength

The required strength (including overstrength effects) for a member should be
determined from:

The expected yield stress Ry x Fy

The expected tensile strength Rt x Fu

Grade Fy Ry Rt

A36 36 1.5 1.2
A53B 35 1.6 1.2
A500B 42 1.4 1.3
A500B 46 1.4 1.3
A500C 46 1.4 1.3
A500C 50 1.4 1.3
A501 36 1.4 1.3
A529 50 1.2 1.2
A529 55 1.1 1.2
A572 42 1.3 1.0[1]

A572 50 1.1 1.1
A572 55 1.1 1.1
A913 50 1.1 1.1
A913 60 1.1 1.1
A913 65 1.1 1.1
A992 50 1.1 1.1

[1]This value is 1.1 in AISC 341-05.
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AISC 341-16 and AISC 341-10 seismic classification - all members

When required by the seismic checks, the classification of elements of the
cross section for various member types is as follows.

Compiled from Table D1.1 of AISC 341-10

Section Element Width
thickness
ratio

Application λhd – highly
ductile

λmd –
moderately
ductile

I (rolled) Flange bf/(2 * tf) Beams,
Columns,
Braces

0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

 Web h/tw Braces 1.49 * √
(E/Fy)

1.49 * √
(E/Fy)

 Web h/tw Columns,
Beams

LRFD - Ca =
Pu/(ɸc *
FyAg)

ɸc = 0.9

ASD - Ca = c
* Pa/(Fy *
Ag)

Ωc = 1.67

Ca ≤ 0.125

2.45 * √
(E/Fy) * (1 -
0.93 * Ca)
but for SMF
only ≤ 2.45
* √(E/Fy)

Ca > 0.125

0.77 * √
(E/Fy) x
(2.93 - Ca)
but ≥ 1.49 *
√(E/Fy)

LRFD - Ca =
Pu/(ɸc *
FyAg)

ɸc = 0.9

ASD - Ca = c
* Pa/(Fy *
Ag)

Ωc = 1.67

Ca ≤ 0.125

3.76 * √
(E/Fy) * (1 -
2.75 * Ca)
but for IMF
only ≤ 3.76
* √(E/Fy)

Ca > 0.125

1.12 * √
(E/Fy) x
(2.33 - Ca)
but ≥ 1.49 *
√(E/Fy)

RHS and
SHS

Walls (bf - 3 * t)/t
and (d -3 *
t)/t

Braces 0.55 * √
(E/Fy)

0.64 * √
(E/Fy)

RHS and
SHS

Walls (bf - 3 * t)/t
and (d- 3 *
t)/t

Columns 0.55 * √
(E/Fy)

1.12 * √
(E/Fy)
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CHS  D/t Braces 0.038 * E/Fy 0.044 * E/Fy

CHS  D/t Columns 0.038 * E/Fy 0.07 * E/Fy

C (rolled) Flange bf/tf Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

 Web h/tw Braces 1.49 * √
(E/Fy)

1.49 * √
(E/Fy)

Tees Flange bf/(2 * tf) Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

 Stem d/tw Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

Angles Both legs L1/t and
L2/t

Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

Double
angles

Outstand
leg – legs in
continuous
contact

L1/t (long
leg B to B)
or L2/t
(short leg B
to B)

Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

Double
angles

Both legs –
legs
separated

L1/t and
L2/t

Braces 0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

In the above table the terms have their usual meaning as follows:

• bf = width of flange and for RHS width of shorter side

• tf = thickness of flange of I/H, channel or Tee

• h = height of web inside flanges (d – 2 * tf) of I/H or channel

• tw = thickness of web

• d = depth of SHS and for RHS depth of longer side

• t = thickness of hollow section RHS, SHS, CHS

• D = diameter of CHS

• L1 = Short leg (from root to toe) of single angle

• L2 = Long leg (from root to toe) of single angle

• E = modulus of elasticity of steel – 29000 ksi

• Fy = minimum yield stress

• Pu = required axial strength using LRFD (seismic) combinations

• Pa = required axial strength using ASD (seismic) combinations

• Ag = gross area of section

Design codes reference 1711 US codes



AISC 341-05 seismic classification - all members

When required by the seismic checks, the classification of elements of the
cross section for various member types is as follows.

Compiled from I-8-1 of AISC 341-05 and Table B4.1 of AISC 360-05.

Section Element Width
thickness
ratio

Application λps –
seismically
compact

λps –
convention
ally
compact

I (rolled) Flange bf/(2 * tf) Beams,
Columns[1],
Braces

0.30 * √
(E/Fy)

0.38 * √
(E/Fy)

 Web h/tw Columns[2],
Beams,
Braces

LRFD - Ca =
Pu/(ɸc *
FyAg)

ɸc = 0.9

ASD - Ca = c
* Pa/(Fy *
Ag)

Ωc = 1.67

Ca ≤ 0.125

3.14 * √
(E/Fy) * (1 -
1.54 * Ca)
but for SMF
only ≤ 2.45
* √(E/Fy)

Ca > 0.125

1.12 * √
(E/Fy) *
(2.33 - Ca)
but ≥ 1.49 *
√(E/Fy)

3.76 * √
(E/Fy)

RHS and
SHS

Walls (bf-3t)/t and
(d-3t)/t

Columns,
Braces

0.64 * √
(E/Fy)

1.12 * √
(E/Fy)

CHS  D/t Columns,
Braces

0.044 * E/Fy 0.070 * E/Fy

C (rolled) Flange bf/tf Braces 0.30 * √
(E/Fy)

N/A
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 Web h/tw Braces LRFD - Ca =
Pu/(ɸc *
FyAg)

ɸc = 0.9

ASD - Ca = c
* Pa/(Fy *
Ag)

Ωc = 1.67

Ca ≤ 0.125

3.14 * √
(E/Fy) * (1 -
1.54 * Ca)

Ca > 0.125

1.12 * √
(E/Fy) *
(2.33 - Ca)
but ≥ 1.49 *
√(E/Fy)

N/A

Tees Flange bf/(2 * tf) Braces 0.30 * √
(E/Fy)

N/A

 Stem d/tw Braces 0.30 * √
(E/Fy)

N/A

Angles Both legs L1/t and
L2/t

Braces 0.30 * √
(E/Fy)

N/A

Double
angles

Outstand
leg – legs in
continuous
contact

L1/t (long
leg B to B)
or L2/t
(short leg B
to B)

Braces 0.30 * √
(E/Fy)

N/A

Double
angles

Both legs –
legs
separated

L1/t and
L2/t

Braces 0.30 * √
(E/Fy)

N/A

Note 1: The relaxation on the compactness limit for columns in SMF as per
note “b” to Table I-8-1 is not taken into account.

Note 2: These limits are not modified by Note [j] to Table I-8-1 i.e. this
dispensation is not taken into account.

In the above table the terms have their usual meaning as follows:

• bf = width of flange and for RHS width of shorter side

• tf = thickness of flange of I/H, channel or Tee
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• h = height of web inside flanges (d – 2 * tf) of I/H or channel

• tw = thickness of web

• d = depth of SHS and for RHS depth of longer side

• t = thickness of hollow section RHS, SHS, CHS

• D = diameter of CHS

• L1 = Short leg (from root to toe) of single angle

• L2 = Long leg (from root to toe) of single angle

• E = modulus of elasticity of steel – 29000 ksi

• Fy = minimum yield stress

• Pu = required axial strength using LRFD (seismic) combinations

• Pa = required axial strength using ASD (seismic) combinations

• Ag = gross area of section

Seismic checks - Beams (Seismic: AISC 341)

Classification
In all cases if the given “width to thickness ratio” is less than or equal to the
given limit, then the seismic classification is satisfied.

AISC 341-16 and AISC 341-10

Beams in OMF and OCBF – No additional requirements.

Beams in IMF and SCBF – Beams must satisfy the requirements of clause
D1.1b for “moderately ductile” members.

Beams in SMF – Beams must satisfy the requirements of clause D1.1b for
“highly ductile” members.

The loading conditions affect the seismic classification in the following way,

• Axial tension only – no classification required.

• Any other loading condition – the appropriate rules in the section
classification table are applied.

See: AISC 341-16 and AISC 341-10 seismic classification - all members
(page 1709)

AISC 341-05

Beams in OMF, SCBF and OCBF – No additional requirements.

Beams in IMF – Beams must satisfy clause 8.2a i.e. the requirements for
Compact sections to AISC 360-05 in Table B4.1.

Beams in SMF – Beams must satisfy clause 8.2b for “seismically compact”
sections.
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The loading conditions affect the seismic classification in the following way,

• Axial tension – no classification required.

• Major axis bending only – applies to beams in SMF only.

• Any other loading condition – apply appropriate rules in the section
classification table.

See: AISC 341-05 seismic classification - all members (page 1711)

Stability bracing

AISC 341-16 and AISC 341-10

Beams in certain SFRS frame types must be provided with “stability bracing” to
restrain lateral torsional buckling. There are two “levels” of requirement; one
for ‘Moderately ductile members and one for “Highly ductile members”. The
use of these depends upon the SFRS frame type as defined below.

Beams in OMF and OCBF – No additional requirements.

Beams in IMF and SCBF – Beams must satisfy clause D1.2a for “moderately
ductile” members. For SCBF this only applies in the presence of V or A braces.

Beams in SMF – Beams must satisfy clause D1.2b for “highly ductile” members

Moderately Ductile

Beams shall be braced per D1.2a for moderately ductile members, i.e.
maximum spacing per D1.2a(3)

Lpd = 0.17 x (E/Fy) x ry

The design condition is,

Lb ≤ Lpd

Lb = the laterally unbraced length of the compression flange taken as the
beam length between locations where both the top flange and bottom flange
are restrained for LTB.

Highly Ductile

Beams shall be braced per D1.2b for highly ductile members, i.e. maximum
spacing,

Lpd = 0.086 x (E/Fy) x ry

The design condition is,

Lb ≤ Lpd

NOTE In both cases:
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- The position of lateral braces is not checked for the location of points
of concentrated force or positions of plastic hinge

- Lateral braces are not designed to meet the additional criteria for
strength and stiffness.

AISC 341-05

OCBF and SCBF

Reference AISC 341-05 14.3 (2) and 13.4a (2) respectively.

For doubly symmetric I sections,

Lpd = (0.12 + 0.076 x (M1/M2)) x (E/Fy) x ry

Where

M1 = the smaller moment at end of unbraced length – min(abs(Ma), abs(Mb))

M2 = the larger moment at end of unbraced length – max(abs(Ma), abs(Mb))

NOTE Lateral braces are assumed to meet the strength and stiffness
requirements of Equations A-6-7 and A-6-8 of AISC 360-05, Appendix
6.

NOTE Lateral braces are assumed to be provided at the intersection of the
V/A brace and the beam or the beam has sufficient stiffness to satisfy
the criteria in the “User Note” to AISC 341-05, 13.4a. In both cases the
program assumes this intersection to be a braced point (with both
flanges braced).

OMF

Reference AISC 341-05 11.8 – no additional requirements.

IMF

Reference AISC 341-05 10.8.

Max spacing of coincident restraints along top and bottom flange, continuous
bracing is included while determining unbraced length for each flange,

Lpd = 0.17 x (E/Fy) x ry

The design condition is,

Lb ≤ Lpd

Lb = the laterally unbraced length of the compression flange taken as the
beam length between locations where both the top flange and bottom flange
are restrained for LTB.

NOTE The position of lateral braces are not checked for the location of
points of concentrated force or positions of plastic hinge.
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NOTE Lateral braces are not designed to meet the additional criteria for
strength and stiffness.

SMF

Reference AISC 341-05 9.8.

Max spacing of coincident restraints along the top and bottom flange,
continuous bracing is included while determining the unbraced length for
each flange,

Lpd = 0.086 x (E/Fy) x ry

The design condition is,

Lb ≤ Lpd

Lb = the laterally unbraced length of the compression flange taken as the
beam length between locations where both the top flange and bottom flange
are restrained for LTB.

NOTE The position of lateral braces are not checked for the location of
points of concentrated force or positions of plastic hinge.

NOTE Lateral braces are not designed to meet the additional criteria for
strength and stiffness.

Design for brace forces in SCBF and OCBF
In both variants of the code the beams in SCBF and OCBF that are configured
with “V” or “A” braces are required to resist a “push-pull” force generated by
the brace pair. In general terms the compression brace is assumed to retain a
percentage of its resistance post-buckling and the tension brace is assumed to
have a level of defined “overstrength”.

NOTE In meeting the requirements of F1.4 and F2.3, the design of beams is
separated into two distinct approaches – those beams with V&A
braces at mid-span and those with diagonal braces at their ends.
Clearly, frames that are braced using V&A braces have to meet both
requirements e.g. in chevron systems but each is checked individually
and this is believed to be conservative.

AISC 341-16 and AISC 341-10, V and A braces

OCBF

Reference AISC 341-10 F1.4a.
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NOTE The tension yield strength/amplified seismic + post buckling strength
in AISC 341-10 is replaced by overstrength seismic load + post
buckling strength in AISC 341-16.

NOTE The lower bound on the force in the tension brace, “The maximum
force that can be developed by the system”, according to F1.4a (1) (i)
(c) is not applied.

SCBF

Reference AISC 341-10 F2.3.

AISC 341-16 and AISC 341-10, all other braces

OCBF

No requirements.

SCBF

Reference AISC 341-10 F2.3.

The expected tension strength, the expected compression strength and the
expected post buckling strength are determined in the same way as for V and
A braces.

AISC 341-05, V and A braces

OCBF and SCBF

Reference AISC 341-05 14.3 and 13.4a respectively.

Seismic checks - Columns (Seismic: AISC 341)

Classification
In all cases if the given “width to thickness ratio” is less than or equal to the
given limit, then the seismic classification is satisfied.

AISC 341-16 and AISC 341-10

Columns in OMF and OCBF – No additional requirements.

Columns in IMF – Columns must satisfy the requirements of clause D1.1b for
“moderately ductile” members.

Columns in SMF and SCBF – Columns must satisfy the requirements of clause
D1.1b for “highly ductile” members.

The loading conditions affect the seismic classification in the following way,

• Axial tension only – no classification required.
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• Any other loading condition – the appropriate rules in the section
classification table are applied.

See: AISC 341-16 and AISC 341-10 seismic classification - all members
(page 1709)

AISC 341-05

Columns in OMF and OCBF – No additional requirements.

Columns in IMF – Columns must satisfy clause 8.2a i.e. the requirements for
Compact sections to AISC 360-05 in Table B4.1.

Columns in SMF and SCBF – Columns must satisfy Clause 8.2b for “seismically
compact” sections.

The loading conditions affect the seismic classification in the following way,

• Axial tension – no classification required.

• Any other loading condition – the appropriate rules in the section
classification table are applied.

See: AISC 341-05 seismic classification - all members (page 1711)

AISC 341-16, D1.4a Required strength

This check consists of two analyzes of the column - one that uses the
'amplified seismic load' and a second that uses a 'capacity analysis' as an
upper bound. The moments and shears in the column are ignored and the
column is designed for axial load only.

NOTE While applying the column strength requirements of D1.4a, it is
assumed that there are no loads applied to the column between
locations of lateral support. Therefore applied moments are ignored
and only the axial strength is considered as permitted in AISC 341-10
D1.4a(2).

NOTE While applying the column strength requirements of D1.4a (2), the
upper limit on the required strength with respect to overturning uplift
as per D1.4a (2) (b) is not applied.

Overstrength seismic load

Pamp, the required axial strength (either tension or compression) including the
“overstrength seismic load” is given by,

Pamp = Pr + fE/ρ * PE * (Ωo - ρ)

Where;

Pr = the axial force (-ve for tension and +ve for compression) determined from
the analysis of the seismic load combination (LRFD or ASD). This may be the
result of a first or second order analysis.

Design codes reference 1719 US codes



PE = the axial force (-ve for tension and +ve for compression) determined from
the analysis of the seismic load case(s) associated with the seismic load
combination.

fE = the strength load factor associated with the seismic load in the seismic
load combination (base combination factor x ρ) (for example, 0.683 in the ASD
combination, D + 0.75 L + 0.75 Lr + 0.683 E).

ρ = the redundancy factor, ρ1 when the column is assigned to Direction 1 and
r2 when the column is assigned to Direction 2 (from the Seismic Wizard).

Ωo = the overstrength factor, Ωo1 when the column is assigned to Direction 1
and Ωo2 when the column is assigned to Direction 2 (from the Seismic
Wizard...).

NOTE The axial force from the load combination including the amplified
seismic loads is calculated by swapping out the component due to the
seismic loadcase Eh = ρ QE and replacing it with the amplified seismic
load, Emh = ΩE QE.

Design condition

For each stack, the required axial strength, Pr is compared with the nominal
axial strength, Pn, i.e. the design condition is,

Pr ≤ ɸ x Pn (LRFD) or Pn/Ω (ASD)

Where

Pn = the nominal axial strength in tension or compression as appropriate to
the sign of Pr

ɸ = the resistance factor for tension or compression as appropriate

Ω = the safety factor for tension or compression as appropriate

AISC 341-10, D1.4a Required strength

This check consists of two analyzes of the column - one that uses the
'amplified seismic load' and a second that uses a 'capacity analysis' as an
upper bound. The moments and shears in the column are ignored and the
column is designed for axial load only.

NOTE While applying the column strength requirements of D1.4a, it is
assumed that there are no loads applied to the column between
locations of lateral support. Therefore applied moments are ignored
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and only the axial strength is considered as permitted in AISC 341-10
D1.4a(2).

NOTE While applying the column strength requirements of D1.4a (2), the
upper limit on the required strength with respect to overturning uplift
as per D1.4a (2) (b) is not applied.

Amplified seismic load

Pamp, the required axial strength (either tension or compression) including the
“amplified seismic load” is given by,

Pamp = Pr + fE/ρ * PE * (Ωo - ρ)

Where;

Pr = the axial force (-ve for tension and +ve for compression) determined from
the analysis of the seismic load combination (LRFD or ASD). This may be the
result of a first or second order analysis.

PE = the axial force (-ve for tension and +ve for compression) determined from
the analysis of the seismic load case(s) associated with the seismic load
combination.

fE = the strength load factor associated with the seismic load in the seismic
load combination (base combination factor x ρ) (for example, 0.683 in the ASD
combination, D + 0.75 L + 0.75 Lr + 0.683 E).

ρ = the redundancy factor, ρ1 when the column is assigned to Direction 1 and
r2 when the column is assigned to Direction 2 (from the Seismic Wizard).

Ωo = the overstrength factor, Ωo1 when the column is assigned to Direction 1
and Ωo2 when the column is assigned to Direction 2 (from the Seismic
Wizard...).

NOTE The axial force from the load combination including the amplified
seismic loads is calculated by swapping out the component due to the
seismic loadcase Eh = ρ QE and replacing it with the amplified seismic
load, Emh = ΩE QE.

Capacity analysis

At any level on a column there can be SFRS members and non-SFRS members.
The principle of this check is that the former might be operating at their
“capacity” in an earthquake and so they are likely to apply more force to the
column than the global analysis would indicate. “Capacity” in this context also
includes the possibility that the material is stronger than its specified yield
(typical).

The capacity calculation involves establishing the capacities of the incoming
SFRS members at each node (level) in the column – these might be zero if
there are only non-SFRS members at that level. The capacities so determined
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are then resolved into the local x-axis of the column. The capacities are
calculated for beams and braces only, not the columns themselves.

The end result of the capacity analysis is that for each stack there is an axial
force, Pcap which can be compression or tension. This will be included in the
results and used in this design check to D1.4a but will only govern if smaller
than that from the “Amplified seismic load” analysis.

Design condition

For each stack, the required axial strength, Pr (the smaller of Pcap or Pamp) is
compared with the nominal axial strength, Pn, i.e. the design condition is,

Pr ≤ ɸ x Pn (LRFD) or Pn/Ω (ASD)

Where

Pn = the nominal axial strength in tension or compression as appropriate to
the sign of Pr

ɸ = the resistance factor for tension or compression as appropriate

Ω = the safety factor for tension or compression as appropriate

AISC 341-16 and -10, E3.4a Moment ratio

At each level in a column where an SMF beam connects into the strong axis of
the column (i.e. into the flange), a check is performed for each seismic
combination to ensure that the plastic moment capacity of the column is
greater than the plastic moment capacity of the incoming beams.

The design condition is,

∑ Mpcol / ∑ Mpbeam > 1.0

NOTE The exceptions in E3.4a (a) and (b) are ignored and the check is
performed for all SMFs.

NOTE Beam column connections are always assumed braced as per E3.4c (1)

NOTE All beams with pinned connections are excluded in this calculation.
Any beam with a moment connection into the web of the column is
ignored even if they are assigned to a SMF. On the other hand, any
beam with a moment connection to the column flange is included in
the calculation even if they are not assigned to a SMF.

NOTE The additional moment due to shear amplification from the location
of the plastic hinge to the column centre line (Muv and Mav) is
calculated from two components,

1. the shear inferred by the moment at the plastic hinge position
based on the expected flexural strength of the beam,
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2. the shear force in the beam at the plastic hinge position from the
factored gravity loads in the current seismic combination.

No account of angle of incoming members is taken into account in this
calculation.)

AISC 341-16 and -10, F2.3 Analysis
This check applies to SCBF type frames only, the procedure being similar to
that for 'Column Strength' to D1.4a.

NOTE The approach taken to the “capacity analysis” per F2.3 assumes that
the SCBF is reasonably isolated. That is, the influence of the remainder
of the structure due to the braces operating at their capacity does not
adversely affect the required strength.

Design condition

Moments in the column are permitted to be ignored as per F2.3 (1) and so
only the axial check (compression or tension) is required.

For each stack, the required axial strength, Pr, is compared with the nominal
axial strength, Pn, i.e. the design condition is,

Pr ≤ ɸ x Pn (LRFD) or Pn/Ω (ASD)

Where Pr = the required axial strength, Pcap

Pn = the nominal axial strength in tension or compression as appropriate to
the sign of Pr

ɸ = the resistance factor for tension or compression as appropriate

Ω = the safety factor for tension or compression as appropriate

NOTE While applying the column strength requirements of F2.3 (i) and (ii), it
is assumed that there are no loads applied to the column between
locations of lateral support. Therefore applied moments are ignored
and only the axial strength is considered as permitted in AISC 341-10
F2.3 (1).

NOTE While applying the column strength requirements of F2.3 (i) and (ii),
the upper limits on the required strength per F2.3 (2) (a), (b) and (c)
are not applied.

NOTE It is assumed that braces do not carry significant gravity forces and
therefore a separate analysis with braces omitted, in order to enhance
the column gravity forces, is not carried out. [Ref. NEHRP Seismic
Design Technical Brief No. 8].
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AISC 341-05, 8.3 Required strength

The calculations for this check are exactly the same as those for the AISC
341-10, D1.4a Required Strength check except that they are only performed
when the required axial force exceeds a certain limit as described below.

Pr > 0.4 x ɸc x Pn (LRFD)

Pr > 0.4 x Pn / Ωc (ASD)

Where

ɸc = 0.90

Ωc = 1.67

Pn = the nominal axial strength of the stack in compression or tension as
appropriate to the sign of Pr

Either,

Pr = Pu

= the maximum axial force in the stack from the current (LRFD) seismic
combination

Or,

Pr = Pa

= the maximum axial force in the stack from the current (ASD) seismic
combination

NOTE While applying the column strength requirements of 8.3, the upper
limit on the required strength with respect to overturning uplift as per
8.3 (2) (b) is not applied.

AISC 341-05, 9.6 Moment ratio

At each level in a column where an SMF beam connects into the strong axis of
the column (i.e. into the flange), a check is made to ensure that for each
seismic combination the plastic moment capacity of the column is greater
than the plastic moment capacity of the incoming beams. The calculations for
this check are exactly the same as those for the AISC 341-10, E3.4a Moment
Ratio check.

NOTE The exceptions in 9.6 (a) and (b) are ignored and the check is
performed for all SMFs.

NOTE All beams with pinned connections are excluded in this calculation.
Any beam with a moment connection into the web of the column is
ignored even if they are assigned to a SMF. On the other hand, any
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beam with a moment connection to the column flange is included in
the calculation even if they are not assigned to a SMF.

NOTE The additional moment due to shear amplification from the location
of the plastic hinge to the column centre line (Muv and Mav) is
calculated from two components,

(i) the shear inferred by the moment at the plastic hinge position
based on the expected flexural strength of the beam,

(ii) the shear force in the beam at the plastic hinge position from the
factored gravity loads in the current seismic combination. No account
of angle of incoming members is taken into account in this calculation.

Seismic checks - Braces (Seismic: AISC 341)

Classification
In all cases if the given “width to thickness ratio” is less than or equal to the
given limit, then the seismic classification is satisfied.

AISC 341-16 and AISC 341-10

Braces in OCBF – As per Clause F1.5a, braces must satisfy the requirements of
clause D1.1b for “moderately ductile” members.

Braces in SCBF – As per Clause F2.5a, braces must satisfy the requirements of
clause D1.1b for “highly ductile” members.

See: AISC 341-16 and AISC 341-10 seismic classification - all members
(page 1709)

AISC 341-05

Braces in OCBF – As per Clause 14.2, braces must satisfy the requirements of
clause 8.2b for 'seismically compact' members.

Braces in SCBF – As per Clause 13.2d, braces must satisfy clause 8.2b for
“seismically compact” sections.

See: AISC 341-05 seismic classification - all members (page 1711)

Slenderness

AISC 341-16 and AISC 341-10

OCBF

In OCBF for V and A braces only, the design condition is checked for both
major and minor axis as per F1.5b,

KL/r ≤ 4 * SQRT[E/Fy]

Where
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K = the effective length factor for the relevant axis

L = the system length of the brace

r = the radius of gyration of the brace for the relevant direction

E = modulus of elasticity of steel – 29000 ksi

Fy = minimum yield stress.

SCBF

For all braces in SCBF the design condition for both minor and major axis is
checked as per F2.5b (1),

KL/r ≤ 200

Where

K = the effective length factor for the relevant axis

L = the system length of the brace

r = the radius of gyration of the brace for the relevant direction.

For built-up braces i.e. double angles the requirements for interconnection are
checked as per F2.5b (2). The minimum number of connectors required by this
clause is two and thus the maximum interconnection slenderness of the
individual angles is based on a buckling length of one third of the system
length, (which is conservative).

Thus,

a/ri ≤ 0.4 * MAX[KL/r]

Where

a = the sub-length of the member between interconnections = taken as L/3

ri = the minimum radius of gyration of the individual angle, taken as rz

NOTE While checking the minimum slenderness of individual elements in
built-up members to F2.5b (2), It is assumed the minimum number of
shear connectors is provided i.e. two. The shear strength of the
connectors is NOT checked against the tensile strength of each
element.

NOTE The brace net area is NOT checked against the brace gross area as per
F2.5b (3) and where this might be an issue suitable reinforcement is
assumed to be provided.

AISC 341-05

OCBF

For V and A braces in OCBF the design condition for both minor and major axis
is checked as per 14.2,

KL/r ≤ 4 * SQRT[E/Fy]
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Where

K = the effective length factor for the relevant axis

L = the system length of the brace

r = the radius of gyration of the brace for the relevant direction.

SCBF

For all braces in SCBF there is a three stage design condition and both minor
and major axis are checked as per 13.2a,

KL/r ≤ 4 * SQRT[E/Fy] PASS

KL/r > 200 FAIL

ELSE WARNING

“Brace slenderness satisfies, 4√(E/Fy) < KL/r ≤ 200. The available strength of the
associated column is NOT checked as per 13.2a."

Where all variables are as given above.

For built-up braces i.e. double angles the requirements for interconnection are
checked as per 13.2e. The minimum number of connectors required by this
clause is two and thus the maximum interconnection slenderness of the
individual angles is based on a buckling length of one third of the system
length, (this will be conservative). Thus,

a/ri ≤ 0.4 * MAX[KL/r]

Where

a = the sub-length of the member between interconnections = taken as L/3

ri = the minimum radius of gyration of the individual angle, taken as rz

NOTE While checking the minimum slenderness of individual elements in
built-up members to 13.2e, it is assumed the minimum number of
shear connectors is provided i.e. two. The shear strength of the
connectors is NOT checked against the tensile strength of each
element.

NOTE The brace net area is NOT checked against the brace gross area and
where this might be an issue suitable reinforcement is assumed to be
provided.

Brace strength

AISC 341-16 and AISC 341-10

OCBF

No additional requirements.

SCBF
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Where the effective net area is less than the gross area the provisions of F2.5b
(3) apply. This is more aimed at gusset plate connections where the cross
section of the brace is reduced. The effective net area is specified by the user
as a percentage or actual area.

The design condition should be (!),

ɸt * Fu * Ae ≥ Ry * Fy * Ag LRFD

Fu * Ae / Ωt ≥ Ry * Fy * Ag / 1.5 ASD

Where,

ɸt = resistance factor for tension

Ωt = safety factor for tension

Fu = specified minimum tensile strength of steel

Fy = specified minimum yields stress of steel

Ae = effective area of brace (user input)

Ag = gross area of brace

Ry = the overstrength factor – see Section.

Note that for 50 ksi steel this will always fail but providing there is no
reduction in area the brace is expected to yield. The Commentary in AISC 341
Comm. F2.5b indicates:

“Where there is no reduction in the section, or where the section is reinforced
so that the effective net section is at least as great as the brace gross section,
this requirement does not apply. The purpose of the requirement is to prevent
net section fracture prior to significant ductility; having no reduction in the
section is deemed sufficient to ensure this behavior.”

Consequently the design condition in Tekla Structural Designer is presented as
follows, and considers the effective net area provided, Ae.prov, and the effective
net area required, Ae.reqd, to satisfy F2.5b (3),

Ae.reqd = MAX[Ag, (Ry * Fy * Ag/(Fu * ɸt)] LRFD

Ae.reqd = MAX[Ag, (Ry * Fy Ag * Ωt/(Fu * 1.5)] ASD

The design condition then becomes,

Ae.reqd ≤ Ae.prov

AISC 341-05

OCBF

No additional requirements.

SCBF
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The calculations for this check are exactly the same as those for the AISC
341-10 check.

NOTE The brace required strength to 13.2b is NOT limited to the "maximum
load effect" as per 13.2b (b).

References (AISC 341)

1. American Institute of Steel Construction. ANSI/AISC 360-05
Specification for structural steel buildings. AISC, 2005.

2. American Institute of Steel Construction. ANSI/AISC 360-10
Specification for structural steel buildings. AISC, 2010.

3. American Institute of Steel Construction. ANSI/AISC 360-16
Specification for structural steel buildings. AISC, 2016.

4. American Institute of Steel Construction. ANSI/AISC 341-05 Seismic
Provisions for Structural Steel Buildings. AISC, 2006.

5. American Institute of Steel Construction. ANSI/AISC 341-10 Seismic
Provisions for Structural Steel Buildings. AISC, 2010.

6. American Institute of Steel Construction. ANSI/AISC 341-16 Seismic
Provisions for Structural Steel Buildings. AISC, 2016.

Concrete design to ACI 318

When the Tekla Structural Designer head code is set to United States (ACI/
AISC), you have the option to specify the Concrete Design Resistance Code as
ACI 318 and the year as 2008, 2011 or 2014. If you are using US Customary
Units the design is then performed in accordance with either ACI 318-08 (Ref.
1) (page 1843), ACI 318-11 (Ref. 3) (page 1843), or ACI 318-14 (Ref. 5)
(page 1843). Design can also be performed for metric units in accordance with
ACI 318M-08 (Ref. 2) (page 1843), ACI 318M-11 (Ref. 4) (page 1843), or ACI
318M-14 (Ref. 6) (page 1843)

Unless explicitly noted otherwise, all clauses, figures and tables used in the
Reference Guides are from ACI 318-11, these have not yet been updated to
reflect the new clause numbering in ACI 318-14.

The following topics are covered:

• Limitations (concrete members: ACI 318) (page 1730)

• Concrete beam design to ACI 318 (page 1731)

• Concrete column design to ACI 318 (page 1772)

• Concrete wall design to ACI 318 (page 1803)

• Concrete slab design to ACI 318 (page 1827)
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• Pad and strip base design to ACI 318 (page 1827)

• Pile cap design to ACI 318 (page 1838)

• Seismic Design to ACI 318 (page 1840)

Limitations (concrete members: ACI 318)

The following general exclusions apply.

the current release will not:

• design members in lightweight concrete

• design members with coated reinforcement

• design members with stainless steel

• design prestressed concrete

• Consider fire resistance [you are however given full control of the
minimum cover dimension to the reinforcement and are therefore able to
take due account of fire resistance requirements],

• design structures subject to very aggressive exposure

• design watertight structures

• design multi-stack reinforcement lifts for columns/walls

• design beams as “deep beams” - beams classified as “deep” are designed
as if they are regular beams and a warning is displayed.

NOTE Deep beams according to ACI 318 are:

(a) Members with clear spans equal to or less than 4 times overall
member depth

(b) Members with concentrated loads within twice the member
depth from the support

material limitations for concrete:

• for structural concrete compressive strength of concrete fc' shall not be
less than 17 MPa (2500psi)

• durability requirements are not implemented

material limitations for reinforcement:

• the values of specified yield strength of reinforcement; fy and fyt used in
calculations shall not exceed 550 MPa (80000psi)

• specified yield strength of non-prestressed reinforcement; fy and fyt shall
not exceed 420 MPa (60 000 psi) in design of shear or torsion
reinforcement

• wire reinforcement design is not implemented
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Cover to Reinforcement (ACI 318)

The nominal concrete cover is the distance between the surface of the
reinforcement closest to the nearest concrete surface (including ties and
surface reinforcement where relevant) and the nearest concrete surface.

You are required to set a minimum value for the nominal cover, cnom, u for
each member in the member properties.

These values are then checked against the nominal limiting cover, cnom,lim

If cnom,u < cnom,lim then a warning is displayed in the calculations.

Concrete beam design to ACI 318

The following topics are covered:

• Cover to Reinforcement (ACI 318) (page 1731)

• Slender beams (ACI 318) (page 1733)

• Design parameters for longitudinal bars (ACI 318) (page 1733)

• Side skin reinforcement in beams (ACI 318) (page 1737)

• Effective depth of section (concrete beam: ACI 318) (page 1737)

• Design for bending for rectangular sections (beams and slabs: ACI 318)
(page 1738)

• Design for bending for flanged sections (beams: ACI 318) (page 1741)
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• Shear strength (beams: ACI 318) (page 1742)

• Minimum area of shear reinforcement (beams: ACI 318) (page 1745)

• Spacing of shear reinforcement (beams: ACI 318) (page 1746)

• Deflection check (beams: ACI 318) (page 1747)

• Seismic design and detailing (beams: ACI 318) (page 1748)

See also

Limitations (concrete members: ACI 318) (page 1730)

Seismic Design to ACI 318 (page 1840)

Limitations (concrete beam: ACI 318)

The following general exclusions apply.

the current release will not:

• design beams as “deep beams” - beams classified as “deep” are designed
as if they are regular beams and a warning is displayed.

NOTE Deep beams according to ACI 318 are:

(a) Members with clear spans equal to or less than 4 times overall
member depth

(b) Members with concentrated loads within twice the member
depth from the support

• design beams in lightweight concrete

• design beams with coated reinforcement

• design beams with stainless steel

• design prestressed concrete

• design structures subject to very aggressive exposure

• design watertight structures

material limitations for concrete:

• for structural concrete compressive strength of concrete fc' shall not be
less than 17 MPa (2500psi)

• durability requirements are not implemented

material limitations for reinforcement:

• the values of specified yield strength of reinforcement; fy and fyt used in
calculations shall not exceed 550 MPa (80000psi)
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• specified yield strength of non-prestressed reinforcement; fy and fyt shall
not exceed 420 MPa (60 000 psi) in design of shear or torsion
reinforcement

• wire reinforcement design is not implemented

Slender beams (ACI 318)

Spacing of lateral supports for a beam shall not exceed 50*b1

In the program the lateral supports are taken as the distance between the
faces of the supports, and for simplification, b is taken as the web width bw

If the above check fails then a 'Slender span' warning is displayed.

Effects of lateral eccentricity of load are considered in determining spacing of
lateral supports.

Design parameters for longitudinal bars (ACI 318)

For each of these parameters, any user defined limits (as specified on the
appropriate Reinforcement Settings page within Design Options) are
considered in addition to any ACI code recommendations.

Minimum and maximum diameter of reinforcement

IF torsional reinforcement is required, there shall be at least one longitudinal
bar in every corner of the stirrups. Longitudinal bars shall have a diameter at
least 0.042 times the stirrup spacing, but not less than 9 mm (3/8 in).

The maximum diameters of reinforcement to be used in the various locations
is set by the user.

Standard hooks for stirrups and ties are limited to No.8 bars, db=25mm (1.0in.)
and smaller.

And the 90-degree hook with 6db extension is further limited to No. 5,
db=16mm (0.625in.) bars and smaller.

For primary reinforcement there is no limit on bar size.

Minimum distance between bars

The minimum clear horizontal distance between individual parallel bars, s
cl,min, is given by;

scl,min ≥ MAX [db, 25 mm] metric-units

scl,min ≥ MAX [db, 1in] US-units

1 ACI 318-08 and ACI 318-11 Section 10.4
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IF the above check fails then a Warning is displayed.

Where parallel reinforcement is placed in two or more layers, bars in the
upper layers shall be placed directly above the bars in the bottom layer with
clear distance between layers not less than 25mm (1in.).

Maximum spacing of tension bars

The spacing of reinforcement closest to the tension face, s is given by;1

s  
 
≤
  

MIN[380mm*280
MPa/fs-2.5*cc,
300mm*(280MPa/
fs)]

 
m
e
t
r
i
c
-
u
n
i
t
s

s  
 
≤
  

MIN[15in*40000p
si/fs-2.5*cc,
12in*(40000psi/
fs)]

 
U
S
-
u
n
i
t
s

where

cc   =  the least distance from
surface of reinforcement
to the tension face

fs   =  calculated stress in
reinforcement at service
load; it shall be
permitted to take

   =  (2/3)*fy*(As,reqd/As,prov)

IF the above check fails then a Warning is displayed

IF torsional reinforcement is required:

the longitudinal reinforcement required for torsion shall be distributed around
the perimeter of the closed stirrups with maximum spacing of 300mm (12 in.)2

Minimum area of beam reinforcement

The minimum area of longitudinal tension reinforcement, A s,min, is given by;3

1 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 10.6.4
2 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 10.5.6.2
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As,min ≥ MAX[ (f'c0.5/(4*fy))*bw*d, 1.4MPa*bw*d/ fy ] metric-units

As,min ≥ MAX[ (3* f'c0.5/(fy)*bw*d, 200Psi*bw*d/ fy ] US-units

where

f'c   =  specified compressive
strength of concrete

fy   =  specified yield strength
of reinforcement

b w   =  web width; for statically
determinate members
with a flange in tension

bw = MIN(2*bw, beff) 1

d   =  distance from extreme
compression fiber to
centroid of longitudinal
compression
reinforcement

1: Assumption; the member is statically
determinate in design

The above equation is used wherever reinforcement is needed, except where
such reinforcement is at least one-third greater than that required by analysis,
in which case As,min not required.

Minimum area of slab reinforcement

For ACI 318-08 and ACI 318-115

For structural slabs of uniform thickness the minimum area of tensile
reinforcement in the direction of the span is:

For US-units:

IF Grade 40 to 50 deformed bars are used

As,min,reqd ≥ b*h*0.0020

IF Grade 50 to 60 deformed bars or welted wire reinforcement are used

As,min,reqd ≥ b*h*0.0018

For metric units:

IF Grade 280 to 350 deformed bars are used

As,min,reqd ≥ b*h*0.0020

IF Grade 350 to 420 deformed bars or welted wire reinforcement are used

3 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 10.5.1
5 ACI 318-08 and ACI 318-11 and ACI 318M-11 Section 7.12.2.1 and 10.5.4

Design codes reference 1735 US codes



As,min,reqd ≥ b*h*0.0018

IF yield stress exceeding 420 MPa

As,min,reqd ≥ b*h* [MAX(0.0014 , 0.0018*420/fy)]

Maximum area of reinforcement

Net tensile strain in extreme layer of longitudinal tension steel, εt should not
be less than 0.004;

εt  
≥ 

0.004

As

,m

ax

 
≤ 

0.85*(f'c / fy)*β1*bw*d*[0.003/(0.003+0.004)] 1

  
≤ 

0.85*(f'c / fy)*β1*bw*d*(3/7)

1: Notes on ACI 318-08 Chap. 6 Section
10.3.5

where

Ag  
 
=
  

the gross area of the concrete section

β1  
 
=
  

stress block depth factor 1

metric units   
  

 
=
  

0.85   

for f`c ≤ 28MPa

  
 
=
  

0.85 - 0.05 *[(f'c -
28MPa)/7MPa]

  

for 28MPa < f`c <
55MPa

  
 
=
  

0.65   

for f`c ≥ 55MPa

US-units   
  

 
=
  

0.85   

for f`c ≤ 4000 psi

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 10.2.7.3
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=
  

0.85 - 0.05 *[(f'c -
4ksi)/1ksi]

  

for 4000 psi < f`c
< 8000psi

  
 
=
  

0.65   

for f`c ≥ 8000 psi

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 10.2.7.3

Side skin reinforcement in beams (ACI 318)

Where h of a beam or joist exceeds 900mm (36 in.), longitudinal skin (side)
reinforcement is uniformly distributed along both side faces of the member.

The code requires that skin reinforcement shall extend for a distance h/2 from
the tension face. Regardless of this in the current release of Tekla Structural
Designer the skin reinforcement is provided to the full height of the beam.

Effective depth of section (concrete beam: ACI 318)

For the design of the longitudinal tension reinforcement, the effective depth of
a section, d is defined as the distance from the extreme concrete fiber in
compression to the center of gravity of the longitudinal tension reinforcement.

For the design of the longitudinal compression reinforcement, the effective
depth in compression, d2 is defined as the distance from the extreme fiber in
compression to the center of gravity of the longitudinal compression
reinforcement.
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Design for bending for rectangular sections (beams and slabs: ACI 318)

Determine if compression reinforcement is needed

Nominal strength coefficient of resistance is given;1

Rn   =  Mu / (φ*b*d2)

where  
Mu   =  factored moment at

section
d   =  depth to tension

reinforcement
b   =  width of the

compression face of the
member

φ   =  strength reduction
factor1

   =  0.9 (corresponds to the
tension-controlled limit)

1: ACI 318-08 and ACI 318-11 Section 9.3

1 Notes on ACI 318-08 Chap 7.
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IF Rn  
 
≤
  

Rnt THEN
compression
reinforcement is
not required.

IF Rn  
 
>
  

Rnt THEN
compression
reinforcement is
required.

where   
Rnt  

 
=
  

Limit value for tension controlled
sections without compression
reinforcement for different concrete
strength classes1

  
 
=
  

ωt *(1-0.59 ωt)*
f`c

 

f`c  
 
=
  

compressive
strength of
concrete

 

ωt  
 
=
  

0.319*b1  

β1  
 
=
  

stress block depth factor 2

metric units   
  

 
=
  

0.85 for f`c ≤ 28MPa

  
 
=
  

0.85 - 0.05 *[(f'c -
28MPa)/7MPa]

for 28MPa < f`c <
55MPa

  
 
=
  

0.65 for f`c ≥ 55MPa

US-units   
  

 
=
  

0.85 for f`c ≤ 4000 psi

1: Notes on ACI 318-08 Section 10.3.4
2: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 10.2.7.3
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=
  

0.85 - 0.05 *[(f'c -
4ksi)/1ksi]

for 4000 psi < f`c
< 8000psi

  
 
=
  

0.65 for f`c ≥ 8000 psi

1: Notes on ACI 318-08 Section 10.3.4
2: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 10.2.7.3

Compression reinforcement is not required

The tension reinforcement ratio is given by;

ρ = 0.85*f`c/fy * [1-(1- 2*Rn/√(0.85*f`c))] ≤ ρt = 0.319*b1*f`c / fy

where

fy = yield strength of reinforcement

The area of tension reinforcement required is then given by;

As = ρ*b*d

The area of compression reinforcement required is then given by;

As` = Mn`/[(d-d`)* fs`]

where

Mn` = Mn-Mnt

= (Mu/φ)-Mnt

Mnt = nominal moment resisted by the concrete section5

= Rn*b*d2

The area of tension reinforcement required is then given by6;

As = As`* fs`/fy + ρ*b*d

where

fs` = MIN[Es*(εu*(c-d`)/c) , fy ]

ρ = ρt*(dt/d)

ρt = 0.319*b1*f`c / fy

εu = 0.0037

c = 0.375*dt

5 Notes on ACI 318-08 Section 10.3.4
6 Notes on ACI 318-08 Chap. 7
7 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 10.2.3
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Design for bending for flanged sections (beams: ACI 318)

IF hf < 0.5*bw THEN treat the beam as rectangular1

where

bw = web width

Depth of the equivalent stress block is given 2;

a = ρ*d*fy/ (0.85*f’c) (= 1.18*ω*d)

where

ρ = 0.85*f’c/fy * [1-(1- 2*Rn/√(0.85*f’c)]

Rn = (Mu/φ) / (beff*d2) assumption φ = 0.9

IF a ≤ hf THEN the rectangular compression block is wholly in the depth of the
flange and the section can be designed as a rectangular section with tension
reinforcement only by setting b = beff and checking the φ-factor as followed;

IF (a/β1)/d < 0.375 THEN φ=0.9 (section tension controlled)

IF 0.375 > (a/β1)/d < 0.600 THEN φ=0.7 + (εt -0.002 *(200/3)

IF (a/β1)/d > 0.6 THEN φ=0.65 (section comp. controlled)

where

εt = [(d*β1)/a-1]*0.003

IF a > hf THEN the rectangular compression block extends into the rib of the
flanged section and the following design method is to be used;

Required reinforcement is given;

Asf = 0.85* f`c*(beff-b)*hf / fy

Nominal moment strength of flange;

Mnf = [Asf*fy(d-hf /2)]

Required nominal moment strength to be carried by the beam web is given;

Mnw = Mu - Mnf

Can be written as;

Mnw = Mu - [(0.85* f`c*(beff-b)*hf / fy)*fy(d-hf /2)] = Mu - [(0.85* f`c*(beff-
b)*hf)*(d-hf /2)]

Reinforcement Asw required to develop the moment strength to be carried by
the web;

Asw = ωw* f`c*b*d / fy

1 ACI 318-08 and ACI 318-11 Section 8.12.4
2 Notes on ACI 318-08 Section 7 (1)
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where

ωw = ρ*fy / f`c = 0.85*f`c/fy * [1-(1- 2*(Mnw / (b*d2))/√(0.85*f`c)] * fy / fc`

Can be written as;

Asw = b*d*0.85*f`c/fy*[1-(1- 2*(Mnw / (b*d2))/√(0.85*f`c)]

Total required reinforcement is given;

As = Asf + Asw

Check to see if the section is tension-controlled;

IF

ρw ≤ ρt section is tension- controlled (φ=0.9)

ELSE add compression reinforcement where

ρw = ωw f`c/ fy ρt = 0.319* β1* f`c/ fy

Can be simplified as;

ωw ≤ 0.319* β1 section is tension-controlled (φ=0.9)

ELSE add compression reinforcement

Shear strength (beams: ACI 318)

Determine shear strength provided by the concrete1;

Members subject to axial compression not applied at this stage

φVc  
 
=
 
 

φ*0.17*λ* √(f`c)*bw*d metric-units

  
 
=
 
 

φ*2*λ*√(f`c)*bw*d US-units

where    
φ  

 
=

0.75 for shear1

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 9.3.2.3
2: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 8.6.1
3: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 11.1.2.1

1 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.2.1.1
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λ  
 
=
 
 

1.0 for normal weight concrete2

f` c0.5  
 
=
 
 

square root of specified compressive strength of concrete3

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 9.3.2.3
2: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 8.6.1
3: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 11.1.2.1

NOTE If the structure is defined as a joist construction Vc shall be permitted
to be 10% more than that specified in above5.

IF

Vu - φVc  
≤ 

φ*0.66*√(f`c)*bw*d1 metric-units

  
 
=
 
 

φ*8*√(f`c)*bw*d US-units

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 11.4.7.9

where

Vu  
 
=
 
 

the maximum design shear force acting anywhere on the beam

THEN the shear design process can proceed.

ELSE the shear design process FAILS since the section size or strength of the
concrete is inadequate for shear. No further shear calculations are carried out
in the region under consideration and the user is warned accordingly.

The design shear capacity of the minimum area of shear links actually
provided, Vs,min is given by7;

5 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.1.2.1
7 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.7.2
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Vs,min = (Av,min/s)*φ*d*fyt

where

Av,min is the area of shear reinforcement provided to meet the minimum
requirements.

For each beam determine the following;

Vu,maxL = the maximum vertical shear force at the face of the left hand support

Vu,dL = the vertical shear force at a distance dL from the face of the left hand
support

Vu,maxR = the maximum vertical shear force at the face of the right hand
support

Vu,dR = the vertical shear force at a distance dR from the face of the right hand
support

Vu,S2L = the maximum vertical shear force at the extreme left of region S2

Vu,S2R = the maximum vertical shear force at the extreme right of region S2

where

dL = the minimum effective depth of the beam in regions T1 and B1

dR = the minimum effective depth of the beam in regions T5 and B3

In any region, i;

IF

Vu,i ≤ Vs,min + φVc

where

Vu,i = the maximum shear in region i from the above routines

OR

The structure is defined as a joist construction8.

THEN

Minimum shear reinforcement shall be used;

And the nominal shear strength is given;

φVn = φVc + Vs,min 9

ELSE

Vu,i > Vs,min+ φVc

THEN shear links are required in the region.

The area of shear reinforcement required is then given10;

8 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.6.1 - Terms (d) and (e) not applied.
9 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.1
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metric-units;

(Av /s)Si = MAX[(Vu- φ*Vc)/ (φ*fyt*d), 0.062* f`c0.5 *bw /fyt, 0.35Pa*bw/fyt]

US-units;

((Av /s)Si = MAX[(Vu- φ*Vc)/ (φ*fyt*d), 0.75* f`c0.5 *bw /fyt, 50psi*bw/fyt]

Vs = ((Av/s)*φ*d*fyt

IF

Vs ≤ 0.66*f’c0.5*bw*d11 (metric -units) 8*f’c0.5*bw*d (US-units)

THEN the shear design process passes.

And the nominal shear strength is given;

φVn = φVc + Vs

ELSE the shear design process FAILS since the section size or strength of the
concrete is inadequate for shear.

Minimum area of shear reinforcement (beams: ACI 318)

The minimum area of shear reinforcement required, Av,min is given by1;

 
 Av,min  

 
=
 
 

MAX (0.062* f`c
0.5 *bw*s/ fyt , 0.35MPa*bw*s/ fyt,

Av,min,u)
metric-
units

   
 
=
 
 

MAX (0.75* f`c
0.5 *bw*s/ fyt , 50psi*bw*s/ fyt, Av,min,u) US-units

 where   
 
 s  

 
=
 
 

the spacing of the shear reinforcement along the
longitudinal axis of the beam

 

 
 fyt  

 
=
 
 

yield strength of transverse reinforcement  

 
 Av,min,

u

 
 
=
 
 

the total minimum area of the shear reinforcement
calculated from data supplied by the user i.e. maximum

 

10 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.6.3
11 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.7.9
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spacing across the beam, minimum link diameter and
number of legs.

i.e. maximum spacing across the beam, minimum link
diameter and number of legs

Spacing of shear reinforcement (beams: ACI 318)

For Longitudinal spacing, s between the legs of shear reinforcement is given
by1;

IF

Vu - φ*Vc ≤ φ*0.33* f`c
0.5 *bw*d metric-units

φ*4* f`c
0.5 *bw*d US-units

THEN

smin,u ≤ s ≤ MIN[0.5*d, 600mm (24in.), smax,u]

ELSE

smin,u ≤ s ≤ MIN[0.25*d, 300mm (12in.), smax,u]

where

smax,u = the maximum longitudinal spacing specified by the user

smin,u = the minimum longitudinal spacing specified by the user

Moreover IF compression reinforcement is required the compression
reinforcement shall be enclosed by ties2. This is an additional limit, not an
alternative.

Vertical spacing of ties is then given by3;

s ≤ MIN(16*db, 48*db,w, bw, h)

where

db = the nominal diameter of the bar

db,w = the nominal diameter of the link reinforcement

NOTE Unlike other design codes, ACI 318 does not specify a limit for
maximum spacing of link legs across a beam. However, attention is
drawn to an ACI Structural Journal Technical Paper - “Shear
Reinforcement Spacing in Wide Members”, which suggests a limit of
around "d".

1 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.6.3
1 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 11.4.5
2 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 7.11.1
3 ACI 318-08, ACI 318-11, ACI 318M-08 and ACI 318M-11 Section 7.10.5.2
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Deflection check (beams: ACI 318)

Deflection checks are divided between two deflection types: Immediate short-
term deflections and long-term deflections which are resulting from creep and
shrinkage of flexural members.

Two methods are given for controlling deflections:

1. By limiting span to depth ratio

For beams provision of a minimum overall thickness (min. total depth) as
required by the following table satisfies the requirements of the code for
members not supporting or attached to partitions or other construction likely
be damaged by large deflections.

Support Conditions Minimum thickness, ht

Simply Supported ln/16

One end continuous ln/18.5

Both ends continuous ln/2126

Cantilever ln/8

If h  
 
≥
 
 

hmin the design passes and no further calculations are
required

where

h  
 
=
 
 

overall height of member

hmin  
 
=
 
 

ht * fy,mod

ht  
 
=
 
 

minimum thickness from above table

ln  
 
=
 
 

clear span length

fy,mod  
 
=
 
 

0.4 + fy / 700 MPa metric-units

Design codes reference 1747 US codes



  
 
=
 
 

0.4 + fy / 100000 psi US-units

If the deflection check fails the rigorous method below is used.

2. By calculating deflections using the rigorous method

For beams that do not meet minimum thickness requirements above, or that
support or are attached to partitions or other constructions likely be damaged
by large deflections, deflections are calculated by following method.

1. Firstly, the beam’s cracked section moment of inertia, Icr is calculated.

2. Then the cracking moment Mcr is calculated.

3. The Long Term Deflection Period is read from the user specified value in
Design settings. - 3 months to 5 years (default value: 5 years).

4. The Time at which brittle finishes are introduced is read from the user
specified value in Design settings. - 1 month to 6 month (default value: 1
month).

5. For each loadcase with type = "dead", the % of load applied prior to
sensitive finishes is read from the user specified value in the loadcase
dialog (default value: 50%).

6. For each loadcase with type = “imposed”, the % of load which is long term
is read from the user specified value in the loadcase dialog (default value:
33%).

7. For each span in the element the critical gravity combination is
determined from the analysis. The combination reporting the max relative
deflection is the one considered in the deflection check.

8. The maximum deflections for the different situations below can then be
determined:

• Dead load deflection (Δi)d

• Dead and live load deflection (Δi)dlive

• Live load deflection (Δi)live

• Sustained load deflection (Δi)sus

• Total load deflection(Δi)tot

• Deflection affecting sensitive finishes (Δi)af

The check passes if the calculated deflections are less than the deflection
limits specified in the beam properties.

Seismic design and detailing (beams: ACI 318)

For overall limitations and assumptions, see:
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• Limitations (beams seismic: ACI 318) (page 1749)

For beam design in moment resisting frames, see:

• General requirements (beams seismic: ACI 318) (page 1761)

• Flexural requirements (beams seismic: ACI 318) (page 1763)

• Transverse reinforcement (beams seismic: ACI 318) (page 1766)

For beams not part of a SFRS, see:

• Requirements when in SDC D - F (beams seismic: ACI 318) (page 1770)

• Seismic cantilevers (beams seismic: ACI 318) (page 1770)

For seismic detailing, see:

• Flexural reinforcement (beams seismic: ACI 318) (page 1771)

• Confinement reinforcement for ductility (beams seismic: ACI 318)
(page 1771)

See also

Seismic Design to ACI 318 (page 1840)

Limitations (beams seismic: ACI 318)

The following limitations and assumptions apply.

• Seismic design is only performed for beams marked as part of a Seismic
Force Resisting System and for seismic cantilevers.

• Requirements for beams particularly in the case of members not part of
any SFRS when in Seismic Design Categories D through F are not
considered in the current release.

• The design and detailing requirements of members part of Special Moment
Frames is beyond scope (some checks are implemented but only due to
their existence in lower toughness systems).

NOTE A full list of the code checks that have and have not been
implemented is provided in the table below.

• Seismic design checks are mostly based on capacity design obtained from
the main reinforcement provided. This can lead to an over-design of
structural members if the designer does not take steps to minimize excess
capacity.

• Beam seismic design and detailing in the current release is based on the
beam rectangular section and takes under consideration the beam
reinforcement only. In particular cases allowances for the slab presence
and reinforcement might be required on top of the current design.
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• Seismic design and detailing requirements for structural diaphragms
according to ACI318-11 sections 21.3.6 and 21.11 are not considered in the
current release.

ACI 318 Seismic Code Checks for beams that have been implemented in
Tekla Structural Designer

Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.1.4.2 Minimum
required
compress
ive
strength
of
concrete

SMF - - -

21.1.4.3 Maximu
m
allowed
compress
ive
strength
of light-
weight
concrete

SMF - - -

21.1.5.2 Maximu
m
allowed
steel
characteri
stic yield
strength
of
longitudi
nal
reinforce
ment

SMF - - -

21.1.5.5 Maximu
m
allowed
longitudi
nal
reinforce
ment
yield
strength
used in
the

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

calculatio
n of
transvers
e
reinforce
ment

21.1.6.2 Mechanic
al Splices
within
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.1.6.2 Mechanic
al Splices
outside
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.1.7.1 Welded
Splices
within
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.1.7.2 Welding
of
stirrups

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

or other
elements
to
longitudi
nal reinf.
required
by design

21.2.2 Minimum
number
of bars at
top/
bottom
faces
continuo
us
througho
ut

OMF - - -

21.2.2 Minimum
number
of bars at
top/
bottom
faces
continuo
us
througho
ut

IMF - - -

21.3.2 Maximu
m
allowed
factored
axial
force

IMF - - -

21.3.3.1 Minimum
Design
shear
force

IMF - - -

21.3.4.1 Minimum
+ve
requirem
ent
(moment
strength/
steel) at a
joint face

IMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.3.4.1 Minimum
moment
strength
anywhere
on a
beam

IMF - - -

21.3.4.2 Type of
transvers
e
reinforce
ment in
confinem
ent
regions
(hook/
extension
)

IMF - - -

21.3.4.2 Length of
support
regions
measure
d from
the face
of the
joint

IMF - - -

21.3.4.2 Maximu
m hoop
spacing in
support
regions

IMF - - -

21.3.4.2 Maximu
m
distance
between
first hoop
and joint
face in
support
regions

IMF - - -

21.3.4.3 Maximu
m hoop
spacing
outside
confinem

IMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

ent
regions

21.5 Beams of
Special
Moment
Frames
will frame
into
columns
of SMF

SMF - - -

21.5.1.1 Maximu
m
allowed
factored
axial
force

SMF - - -

21.5.1.2 Maximu
m
allowed
effective
depth

SMF - - -

21.5.1.3 Maximu
m
allowed
width

SMF - - -

21.5.1.4 Maximu
m
allowed
width

SMF - - -

21.5.2.1 Minimum
number
of bars at
top/
bottom
faces
continuo
us
througho
ut

SMF - - -

21.5.2.1 Minimum
allowed
area of
reinforce
ment at

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

top/
bottom
face
througho
ut

21.5.2.1 Maximu
m
allowed
area of
reinforce
ment:
Max steel
ratio at
top/
bottom/
side face
of the
beam,
ρmax

SMF - - -

21.5.2.2 Minimum
+ve
requirem
ent
(moment
strength /
steel) at a
joint face

SMF - - -

21.5.2.2 Minimum
moment
strength
anywhere
on a
beam

SMF - - -

21.5.2.3 Lap splice
location
restrictio
ns

SMF - - -

21.5.2.3 Lap Splice
transvers
e
reinforce
ment
type

SMF - - -

21.5.2.3 Maximu
m

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

allowed
hoop
spacing
at lap
splices

21.5.3.1 Length of
support
regions
measure
d from
the face
of the
joint

SMF - - -

21.5.3.1 Non-
reversing
plastic
hinges:
Flexural
Yield
region
size
(centered
)

SMF - - -

21.5.3.2 Maximu
m hoop
spacing in
support
regions

SMF - - -

21.5.3.2 Maximu
m
distance
between
first hoop
and joint
face in
support
regions

SMF - - -

21.5.3.2 Non-
reversing
plastic
hinges:
Maximu
m
horizonta

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

l center
spacing

21.5.3.3 Maximu
m
allowed
spacing
of
flexural
reinforcin
g bars

SMF - - -

21.5.3.3 Maximu
m
allowed
lateral
link leg
spacing in
confinem
ent
regions

SMF - - -

21.5.3.4 Maximu
m hoop
spacing
outside
confinem
ent
regions

SMF - - -

21.5.3.6 Type of
transvers
e
reinforce
ment in
confinem
ent
regions
(hook/
extension
)

SMF - - -

21.5.3.6 Type of
transvers
e
reinforce
ment in
beam
sections
that

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

extend
laterally
beyond
the
column
core
(hook/
extension
)

21.5.4.1 Minimum
Design
shear
force

SMF - - -

21.5.4.2 Unreinfor
ced
concrete
shear
resistanc
e at
confinem
ent
regions

SMF - - -

21.7.2.1 Stress in
the beam
flexural
tensile
reinforce
ment at
joints
face for
joint
shear
calculatio
n

SMF - - -

21.7.2.2 Tension
anchorag
e length
of beam
long.
Reinf. at
external
joints
(beyond
column

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

inner
face)

21.7.2.3 Maximu
m
longitudi
nal
reinforce
ment bar
size

SMF - - -

- Minimum
beam
depth at
a joint
where it
contribut
es to joint
shear

SMF - - -

21.7.3.3 Spacing
of
confinem
ent reinf.
for
longitudi
nal bars
of beams
outside
the
column
core

SMF - - -

21.7.3.3 Maximu
m
distance
between
link legs
in beam
sections
that
extend
laterally
beyond
the
column
core

SMF - - -

21.7.5.1 Develop
ment

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

length for
beam
longitudi
nal bars
with a
standard
90° hook

21.7.5.2 Develop
ment
length for
beam
longitudi
nal
straight
bars

SMF - - -

21.7.5.4 Develop
ment
length for
epoxy-
coated or
zinc and
epoxy
dual-
coated
beam
longitudi
nal bars

SMF - - -

21.8.2 Minimum
distance
from joint
face for
beam
reinf.
mechanic
al splices
in ductile
connectio
ns

SMF - - -

21.8.2 Minimum
nominal
shear
strength
of ductile
connectio
ns

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.8.3 Minimum
nominal
strength
of the
strong
connectio
n

SMF - - -

ASCE7/10
12.4.4

Extra
design
loads for
horizonta
l
cantilever
s

- - - -

NOTE • For further details of the checks that have been implemented, see:
General requirements (beams seismic: ACI 318) (page 1761),
Flexural reinforcement (beams seismic: ACI 318) (page 1771),
Transverse reinforcement (beams seismic: ACI 318) (page 1766) or
consult the respective clause reference in the code.

• Most of the requirements will be fulfilled through automatic
design. In some cases specific design options will need to be set by
the user.

• Additional requirements may apply to members that are not part
of the SFRS when in SDC’s D, E or F

• Confinement regions: - support regions; - Probable flexural yield
regions; - Lap splice regions.

General requirements (beams seismic: ACI 318)

Maximum allowed factored axial force

Flexural elements with high axial loading values under any load combination
are handled in the seismic design and detailing as compressive members.

If SFRS Type = Ordinary Moment Frame, then no axial compression limit
applies.

If SFRS Type = Intermediate Moment Frame or SFRS Type = Special Moment
Frame

  Pmax  
 
=
  

Ag * f’c / 10

 where  
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 Pmax  
 
=
  

Maximum allowed
compression
value on the
member

 Ag  
 
=
  

Gross area of the
concrete section

 f’c  
 
=
  

specified
compressive
strength of
concrete

The check passes if;

  Pu  
 
≥ 

Pmax

 where  
 Pu  

 
=
  

Maximum
factored
compressive axial
force anywhere in
the span
considering all
load
combinations

Maximum allowed effective depth

The maximum allowed effective depth of a beam part of a Special Moment
Frame is proportional to its clear span length to limit the overloading of the
adjacent joints and columns.

If SFRS Type = Special Moment Frame

 
 d

 
 
≤
 
 

dmax

 where  

 d

 
 
=
 
 

Distance between the extreme compression fiber and the
longitudinal tension reinforcement centroid

 dmax

 
 
=
 
 

Maximum allowed distance between the extreme compression
fiber and the longitudinal tension reinforcement centroid

 dmax
 
 0.25 * ln
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=
 
 

 where  

 ln

 
 
=
 
 

Length of the clear span measured from face-to-face of
supports

Minimum allowed width

Beams part of Special Moment Frames in buildings subjected to earthquake
effects have a minimum width limit for their web.

If SFRS Type = Special Moment Frame

 
 bw  

 
≥ 

bw,min  

 where   
 bw  

 
=
 
 

Beam web width  

 bw,min  
 
=
 
 

Minimum allowed beam web width

   
 
=
 
 

MAX( 0.3 * h, 250 mm) Metric-units

   
 
=
 
 

MAX( 0.3 * h, 10 in) US-units

 where   
 h  

 
=
 
 

Overall depth of the concrete section

Maximum allowed width

Despite not being advisable, beams in Special Moment Frames are allowed to
be wider than the supporting columns up to a fixed limit.

NOTE The maximum lateral extension of a beam on each side of the joining
column is beyond scope in the current release of Tekla Structural
Designer.
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Flexural requirements (beams seismic: ACI 318)

Minimum number of bars

The minimum allowed number of bars continuous along the beam span is
required to be checked in the layers closest to the top and bottom faces of any
beam in the SFRS.

The number of bars should be ≥ 2.

Maximum allowed bar size

This applies to end regions of beams where the beam reinforcement extends
into the column core. The required development length of reinforcement bars
extending into the column core restricts the minimum size of the column and
vice-versa.

If SFRS Type = Special Moment Frame

“Anchorage requirements at the joint of special moment frames limit the
maximum bar size at each end of the beam”

Minimum flexural strength

The minimum area of top and bottom steel required at any section of a beam
part of a Moment Resisting Frame needs to comply with flexural strength
requirements when considering earthquake effects.

Note that no seismic design requirements apply to beams that are part of
Ordinary Moment Frames. All other Moment Resisting Frame types have
minimum longitudinal moment requirements.

Minimum allowed area of reinforcement

The minimum allowed area of steel throughout the bottom and top faces of a
beam part of a Special Moment Frame is limited as per ACI 318-11 equation
(10-3).

Maximum allowed area of reinforcement

For the purpose of increasing the ductility response of beams in Special
Moment Frames the area of reinforcement both at the top and bottom faces is
limited.

If SFRS Type = Special Moment Frame

 
 (As- and As

+)
 
 
≤
 
 

As,max = 0.025 * bw * d

 where  
 
 As  

 
=
 
 

Area of non-prestressed longitudinal tension
reinforcement
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 bw  

 
=
 
 

Beam web width

 
 d  

 
=
 
 

Distance from extreme compression fiber to centroid
of longitudinal tension reinforcement

No other Moment Resisting Frame type has a maximum area of steel
requirement.

Maximum allowed center spacing of longitudinal bars

Limitations on the longitudinal bar spacing apply to beams part of Special
Moment Frames.

If SFRS Type = Special Moment Frame, then the maximum allowed center
spacing is checked for confinement regions as follows:

 
 scr,max  

 
=
 
 

350 mm Metric-units

 
 As  

 
=
 
 

14 in. US-units

 where   
 
 scr,max  

 
=
 
 

maximum allowed center spacing

Non-reversing plastic hinges

Non-reversing plastic hinges are regions along the span of the beam where
flexural yielding is likely to occur.

NOTE Non-reversing plastic hinges are beyond scope in the current release
of Tekla Structural Designer.

Splices

Restrictions apply to the locations of reinforcement lap splices along the span
of a beam part of Special Moment Frames.

Strength design of mechanical splices and restrictions to the use of welded
splices as required by ACI318-11 apply to Special Moment Frames.
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NOTE These restrictions are not implemented in the current release of Tekla
Structural Designer.

Transverse reinforcement (beams seismic: ACI 318)

Seismic requirements relating to transverse reinforcement take into account
properties, strengths and outcomes which are shear related ignoring any
reinforcement intended to deal with torsional effects.

Design shear force

The design shear force for members subjected to earthquake effects is
obtained by consideration of the minimum required shear strength of the
member. The required nominal shear strength of a flexural member part of a
Moment Resisting Frame is checked considering the sum of shears resultant
from the moment strengths due to reverse curvature bending acting at each
end of the beam and from the tributary factored gravity loads.

Beams are checked for shear in three regions:

• Left region, S1;

• Central region, S2;

• Right region, S3.

Shear design is performed considering the Major axis shear force only. Shear
Force in the minor axis is checked against the ignorable threshold.

If SFRS Type = Ordinary Moment Frame, then no shear seismic check applies.

If SFRS Type = Intermediate Moment Frame

 
 Ve  

 
=
 
 

ɸMIN(Ve,Mn+Ve,gravity,Ve,2E)

 where  
 ɸ  

 
=
 
 

Strength reduction factor = 1.0

 Ve  
 
=
 
 

Minimum design shear force for load combinations including
earthquake effects

 Ve,gravit

y

 
 
=
 
 

Shear due to factored gravity loads from seismic combinations
(including vertical earthquake effects) retaining the sign from
analysis

 Ve,2E  
 Maximum shear resultant from seismic combinations,

withdoubled earthquake effect [i.e.: Ve.non-seismic + Ve.E x 2]

Design codes reference 1766 US codes



=
 
 

 Ve,Mn  
 
=
 
 

Maximum shear associated with the development of reversed
curvature bending due to nominal resisting moments at both
ends of the member, considering both the clockwise and
counter-clockwise cases

If SFRS Type = Special Moment Frame

 
 Ve  

 
=
 
 

ɸ(Ve,Mpr+Ve,gravity)

 where  
 ɸ  

 
=
 
 

Strength reduction factor = 1.0

 Ve  
 
=
 
 

Minimum design shear force for load combinations including
earthquake effects

 Ve,gravit

y

 
 
=
 
 

Shear due to factored gravity loads from seismic combinations
(including vertical earthquake effects) retaining the sign from
analysis

 Ve,Mpr  
 
=
 
 

Maximum shear associated with the development of reversed
curvature bending due to the probable flexural moment
strength for both the clockwise and counter-clockwise
situations, at both ends of the member

Maximum hoop spacing

The maximum allowed horizontal center spacing of hoops in confinement
regions of beams is limited by ACI 318 depending on the type of Seismic Force
Resisting System considered.

NOTE This check is performed for support regions only, it is beyond scope in
the current release of Tekla Structural Designer for other confinement
regions.

NOTE Non-reversing plastic hinge regions along the span have the same
requirements as support regions, but these are beyond scope in the
current release of Tekla Structural Designer.

For Support Regions:

If SFRS Type = Special Moment Frame
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The maximum allowed center hoop spacing in support regions, scr,max,sup is
calculated as follows:

According to ACI318-081:

 
 scr,max,sup  

 
=
 
 

MIN(d/4, 8 * db,smallest, 24 * db,w, 300mm) Metric-
units

 scr,max,sup  
 
=
 
 

MIN(d/4, 8 * db,smallest, 24 * db,w, 12 in.) US-units

According to ACI318-111:

 
 scr,max,sup  

 
=
 
 

MIN(d/4, 6* db,smallest, 150 mm) Metric-
units

 scr,max,sup  
 
=
 
 

MIN(d/4, 6 * db,smallest, 6 in.) US-units

 
 where  

 d  
 
=
 
 

Distance from extreme compression fiber to centroid of
longitudinal tension reinforcement

 db,smalles

t

 
 
=
 
 

Smallest longitudinal reinforcement bar diameter

 db,w  
 
=
 
 

Link (hoop) diameter

If SFRS Type = Intermediate Moment Frame

The maximum allowed center hoop spacing in support regions, scr,max,sup is
calculated as follows:

 
 scr,max,sup  

 
=
 
 

MIN(d/4, 8* db,smallest, 24 * db,w, 300mm) Metric-
units

1 ACI318-08 Section 21.5.3.2. This requirement has changed from ACI318-08 to ACI318-11
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 scr,max,sup  
 
=
 
 

MIN(d/4, 8 * db,smallest, 24 * db,w, 12 in.) US-units

 
 where  

 d  
 
=
 
 

Distance from extreme compression fiber to centroid of
longitudinal tension reinforcement

 db,smalles

t

 
 
=
 
 

Smallest longitudinal reinforcement bar diameter

 db,w  
 
=
 
 

Link (hoop) diameter

For Span Regions:

If SFRS Type = Special Moment Frame, or Intermediate Moment Frame

The maximum allowed hoops spacing outside confinement regions, scr,max,span
is calculated as follows:

 
 scr,max,span  

 
=
 
 

d/2

Maximum allowed lateral link leg spacing

The clear spacing between link legs at right angles to the span is limited in
confinement reinforcement regions of members part of Special Moment
Frames only.
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NOTE This check is performed for support regions only, it is beyond scope in
the current release of Tekla Structural Designer for other confinement
regions.

Requirements when in SDC D - F (beams seismic: ACI 318)

When designing members for earthquake effects, beams not part of the SFRS
when in Seismic Design Categories D through F are required to be designed
with seismic provisions all the same.

NOTE With the exception of seismic cantilevers, the design of these
members for seismic provisions is beyond scope in the current
release of Tekla Structural Designer.

Seismic cantilevers (beams seismic: ACI 318)

Horizontal cantilever structural members in structures assigned to Seismic
Design Category D, E or F are required to be designed to the applicable load
combinations plus an isolated minimum net upward force of 0.2* times the
dead load.

If a cantilever beam has been marked as a seismic cantilever, then provided
the seismic design category = D, E or F the minimum design moment at the
restrained end is checked as follows:

Calculate minimum positive design moment:

 
 Mmin

+
 
=
 

0.2 * Me,dead-

 where  
 Mmin+  

=
 

Minimum positive design bending moment at the restrained
end.
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 Me,dea

d-
 
=
 

Critical negative bending moment at the restrained end due to
dead loads only obtained for the considered seismic
combination.

Check the minimum design moment at the restrained end:

 
 Mu+  

≥ 
Mmin+

 where  
 Mu+  

=
 

Critical negative bending moment at the restrained end due to
dead loads only obtained for the considered seismic
combination.

If the check fails the region is designed for Mu+ = Mmin+

Flexural reinforcement (beams seismic: ACI 318)

Longitudinal reinforcement at the top and bottom faces of a beam in any
Moment Resisting Frame are required to have at least two continuous steel
bars along the span for structural integrity and constructability purposes.

Anchorage

Longitudinal reinforcement terminated at a column in beams that are part of
Special Moment Frames shall be anchored within the element confined core
for a length measured from the critical section at the element's face.

Tekla Structural Designer performs the calculation steps for the required
development length at the supports of bars in tension for both the case where
straight bars are used and where hooks are provided.

Lap Splices

Specific seismic requirements apply only to lap splices in flexural members
that are part of Special Moment Frames.

For beams that are part of Special Moment Frames lap splices are not allowed
to be located:

• Within joints or within a distance of twice the members depth from the
face of a joint

• Within regions where flexural yielding is likely to occur.

NOTE The latter requirement to avoid lap splices in regions where flexural
yielding is likely to occur is beyond scope in the current release of
Tekla Structural Designer

Confinement reinforcement for ductility (beams seismic: ACI 318)

Reinforcement Type
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Confinement reinforcement should consist of hoops, i.e. closed or
continuously wound ties with a seismic hook at each end.

Detailing Regions

Confinement reinforcement is required to be provided over the following
confinement regions in beams that are part of Intermediate and Special
Moment Frames. This is not a requirement for beams that are part of Ordinary
Moment Frames

• Support regions: These are probable flexural yielding regions flexural
yielding regions next to beam-column joints

NOTE Beam-wall moment frames are beyond scope in the current
release of Tekla Structural Designer.

• Non-reversing plastic hinge regions: These are probable flexural yielding
regions outside support regions.

NOTE Non-reversing plastic hinge regions are not identified in the
current release of Tekla Structural Designer.

• Lap splices: Over the full length of lap splices in members that are part of
Special Moment Frames

Concrete column design to ACI 318

The following topics are covered:

• Cover to Reinforcement (ACI 318) (page 1731)

• Design parameters for longitudinal bars (concrete column: ACI 318)
(page 1773)

• Ultimate Axial Load Limit (column and wall:ACI 318) (page 1773)

• Effective length calculations (column and wall:ACI 318) (page 1774)

• Column stack and wall panel classification (column and wall:ACI 318)
(page 1775)

• Design Moment Calculations (column and wall: ACI 318) (page 1777)

• Design for combined axial and bending (column and wall:ACI 318)
(page 1779)

• Design parameters for shear (column and wall:ACI 318) (page 1780)

• Column confinement (column and wall:ACI 318) (page 1780)

• Seismic design and detailing (columns: ACI 318) (page 1780)
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See also

Limitations (concrete members: ACI 318) (page 1730)

Seismic Design to ACI 318 (page 1840)

Design parameters for longitudinal bars (concrete column: ACI 318)

For some of the longitudinal reinforcement design parameters, additional user
defined limits can be applied - where this is the case minimum and maximum
values are specified in Design Options > Column > Reinforcement Layout.

Minimum Longitudinal Bar Spacing

For design to ACI ;

minimum clear
distance

 
 
≥
 
 

MAX (1.5 * longitudinal db , 1.5in.,
1.33*hagg)

US units

minimum clear
distance

 
 
≥
 
 

MAX (1.5 * longitudinal db , 40mm,
1.33*hagg)

metric
units

where

d b   =  bar diameter

h agg   =  aggregate size

Maximum Longitudinal Bar Spacing

You are given control over this value by specifying an upper limit in Design
Options > Column > Reinforcement Layout.

Minimum Longitudinal Total Steel Area

For design to ACI;

1% * column area

Maximum Longitudinal Total Steel Area

For design to ACI;

8% * column area

Ultimate Axial Load Limit (column and wall:ACI 318)

The strength of a column under truly concentric axial load is

Pno   =  0.85*f'c*(Ag - Ast) + fy*Ast
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For nonprestressed compression members with tie reinforcement,

φPnmax   =  0.80*φ*[0.85*f’c*(Ag -
Ast) + fy*Ast]

Effective length calculations (column and wall:ACI 318)

Unsupported Length

The unsupported length, lu, of a column is the clear distance between lateral
supports.

If, at an end of the compression member (stack), no effective beams, flat slab
or slab on beams to include is found, then the clear height includes the
(compression member) stack beyond this restraint, and the same rules apply
for finding the end of the clear height at the end of the next stack (and so on).
If there is no stack beyond this restraint (i.e. this is the end of the column), the
clear height ends at the end of the column.

Effective Length

The effective length, le is calculated automatically from ACI R10.10.1. You have
the ability to override the calculated value.

Tekla Structural Designer will impose the following limits for stacks that are
designated as braced:

0.5 ≤ le / lu ≤ 1

When both ends of an unbraced compression member are hinged (pinned), a
“Beyond Scope” warning is displayed.

The effective length of the stack (compression member) is given by:

le = k * lu

The program uses the bottom end of the stack (compression member) as end
1 and the top as end 2.

Any beams framing into the end of the compression member (stack) within 45
degrees of the axis being considered are said to be restraining beams for the
stack in that direction. No adjustment is made to the restraint provided by the
beam for the angle (i.e. the full value of “E * I / l” is used for all beams within 45
degrees of the axis).

A beam is to be considered as a restraining beam in the direction considered
if:

-45° < β ≤ 45°

where

β is the angle from the axis in the direction considered to the beam, measured
anti-clockwise when viewed from above (i.e. back along the length of the stack
from the end towards the start).
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Fixed Column Base

Since in practical structures there is no such thing as a truly fixed end, Tekla
Structural Designer limits ψ ≥ 0.20. This being the practical lower limit
suggested in “RC Mechanics” by McGregor and Wright.

Pinned Column End

In any situation where the end of a column anywhere in the structure is
pinned, ψ = 1000. (This being the upper limit on ψ that is imposed by Tekla
Structural Designer.)

No Effective Beams Found

If no effective beams are found to restrain the end of the stack in the direction
in question, then the program will consider whether there is a flat slab
restraining the stack at this end. If a flat slab is found it will either be
considered as a restraint, or not, in each direction at each end of the stack -
this is controlled by checking the option Use slab for calculation... located as a
Stiffness setting in the column properties.

If there are no effective beams and there is no flat slab (or any flat slab is not
to be considered), then the program will look for a slab on beams. If a slab on
beams is found, this acts as a restraint at the position. Slabs on beams will
only be considered if the “Use slab for calculation...” option is selected, as is
the case for flat slabs.

If no beams and no flat slab or slab on beams is found, then the program will
look for the far end of the stack on the other side of the joint, and look at the
restraints there, and so on until a restraint with an effective beam, flat slab or
slab on beams to be considered is found.

If the stack is restrained by a flat slab, then the slab will be considered to act as
a beam in this direction - note that it is one beam in the direction and NOT a
beam on each side of the column. The beam's length is taken as four times its
width.

If the stack is restrained by a slab on beams, this will have a zero contribution
to the stiffness. This thoretically has the effect of setting ψ = infinity, though it
is limited to 1000 in Tekla Structural Designer before being used in the
calculations.

If the stack is an end stack and there are no supports, beams, flat slabs or
slabs on beams considered to restrain the stack at this end in the direction,
the end is therefore free in this direction and ψ = 1000.

Column stack and wall panel classification (column and wall:ACI 318)

Slenderness ratio

For columns: The slenderness ratio, k lu/r, of the restrained length (note: not
necessarily the stack length – it will be longer if there is no restraint at either
end of the stack) about each axis is calculated as follows:
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(k lu/r)y = k *luy /(√(ly / Ag))

(k lu/r)z = k* luz/(√(Iz / Ag))

where

slenderness ratio = k*lu/r

k is an effective length factor

luy is the unsupported column length in respect of major axis (y axis)

luz is the unsupported column length in respect of minor axis (z axis)

ry is the radius of gyration of the column in the y-direction

rz is the radius of gyration of the column in the z-direction

Iy is the second moment of area of the stack section about the major axis (y
axis)

Iz is the second moment of area of the stack section about the major axis (z
axis)

Ag is the cross-sectional area of the stack section

For unbraced columns

IF (k lu/r)y ≤ 22

THEN slenderness can be neglected and column can be designed as short
column

ELSE, column is considered as slender

IF (k lu/r)z ≤ 22

THEN slenderness can be neglected and column can be designed as short
column

ELSE, column is considered as slender

For braced columns

IF (k lu/r)y ≤ MIN((34-12*M1/M2), 40)

THEN slenderness can be neglected and column can be designed as short
column

ELSE, column is considered as slender

IF (k lu/r)z ≤ MIN((34-12*M1/M2), 40)

THEN slenderness can be neglected and column can be designed as short
column

ELSE, column is considered as slender

where

M1 = the smaller factored end moment on the column, to be taken as positive
if member is bent in single curvature and negative if bent in double curvature
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= MIN [ABS(Mtop), ABS(Mbot)]

M2 = the larger factored end moment on the column always taken as positive

= MAX [ABS(Mtop), ABS(Mbot)]

Design Moment Calculations (column and wall: ACI 318)

For each combination and for each analysis model (Building Analysis, Grillage
Analysis, FE Analysis) the end moments about the two local member axes,
'major' and 'minor' are established. From these and the local load profile, the
moments and axial force at any position in the member can be established.
These moments will be from a first-order or second-order analysis at user
choice - (in making the choice, the value of the 'stability index', Q should be
taken into account).

Note that M2 and M1 are the end moments with M2 being the larger numeric
value.

Step 1, minimum moment

Calculate the minimum moment due to non-concentric axial force in each of
the two directions from,

Mmin  
 
=
  

Pu*(0.6+0.03*h)]
in

 
 
 
 
(
U
S
 
u
n
i
t
s
)

  
 
=
  

Pu*(15+0.03*h)]
mm

 
 
 
 
(
m
e
t
r
i
c
 
u
n
i
t
s
)
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where

h   =  The major dimension of
the column in the
direction under
consideration

Pu   =  The max compression
force at any design
position in the stack
under consideration. If
stack is in tension set to
zero

Step 2 - member slenderness

It is determined whether the member is slender or not. Note that in the
determination for braced columns M1 and M2 are always the end moments
even if lateral loading is present.

Step 3 - non-slender column

Calculate the design moment at the top, bottom and mid-fifth of the column in
each direction taking into account if lateral loads are “significant”, or “not
significant”.

As the column is non-slender no further calculations are required to establish
design moments.

Step 4 - slender member amplifier

Calculate the “amplifier” due to buckling about each of the major and minor
axes excluding the uniform moment factor which is dealt with separately,

kns   =  1/(1 - (Pu / (0.75*Pc))) ≥
zero

where

Pc  
 
=
  

The critical buckling load

  
 
=
  

π²*(EI)/(k*lu)²  

where EI can be computed by Eq. (10-14) or Eq (10-15)

Step 5 - uniform moment factor

For lateral loads that are “not significant”,
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 Cm  
 
=
 
 

0.6 + 0.4
*(M1 / M2)
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Else

 Cm  
 
=
 
 

1.0

Step 6 - moment magnifier

Calculate the moment magnifier from Equ. 10.12 as,

dns   =  MAX [Cm * kns, 1.0]

Step 7 - amplified minimum moment

Calculate the amplified minimum moment as,

Mmin_amp   =  Mmin * kns

Step 8 - design moments

Calculate the design moment at the top, bottom and mid-fifth of the column in
each direction taking into account if lateral loads are “significant”, or “not
significant”.

Design for combined axial and bending (column and wall:ACI 318)

Tekla Structural Designer designs the column for an applied axial force and
applied bending about one or both axes of the section. In the case of bi-axial
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bending, a resultant moment is created for the combination of the applied
moments.

√
(M2

majo

r

 
 
+
 
 

M2
minor

)

 
 
/
 
 
 

√
(M2

majo

r,res

 
 
+
 
 

M2
minor

,res)

 
 
≤
 
 

1.0

Where   
Mmajor

  =  Moment about the
major axis

Mminor
  =  Moment about the

minor axis
Mmajor,res

  =  Moment of resistance
about the major axis

Mminor,res
  =  Moment of resistance

about the minor axis

Design parameters for shear (column and wall:ACI 318)

For some of the shear design parameters, additional user defined limits can
be applied - where this is the case minimum and maximum values are
specified in Design Options > Column > Reinforcement Layout.

Minimum Shear Link Diameter

For Ties, minimum shear reinforcement size

IF maximum longitudinal bar ≤ 1.27 in. (32.3mm)

shear reinforcement diameter = 0.375 in. (9.5mm)

Minimum shear reinforcement diameter = 0.50 in. (12.7mm)

Maximum Span Region Shear Link Spacing

Controlled by seismic detailing requirements.

Maximum Support Region Shear Link Spacing

Controlled by seismic detailing requirements.

Column confinement (column and wall:ACI 318)

The ACI requirement is that every alternate longitudinal bar should be
restrained by a link corner or bar tie, and no bar should have more than 6"
(150 mm) clear distance from a restrained bar.
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Seismic design and detailing (columns: ACI 318)

For overall limitations and assumptions, see:

• Limitations and assumptions (columns seismic: ACI 318) (page 1781)

For column design in moment resiting frames, see:

• General requirements (columns seismic: ACI 318) (page 1794)

• Flexural requirements (columns seismic: ACI 318) (page 1796)

• Transverse reinforcement (columns seismic: ACI 318) (page 1799)

For seismic detailing, see:

• Flexural reinforcement (columns seismic: ACI 318) (page 1802)

• Confinement reinforcement for ductility (columns seismic: ACI 318)
(page 1803)

See also

Seismic Design to ACI 318 (page 1840)

Limitations and assumptions (columns seismic: ACI 318)

The following limitations and assumptions apply.

• Seismic design is only performed for columns marked as part of a Seismic
Force Resisting System.

• Requirements for columns particularly in the case of members not part of
any SFRS when in Seismic Design Categories D through F are not
considered in the current release.

• The design and detailing requirements of members part of Special Moment
Frames is beyond scope (some checks are implemented but only due to
their existence in lower toughness systems).

NOTE A full list of the code checks that have and have not been
implemented is provided in the table below.

• No height limitations apply to Seismic Force Resisting Systems in the form
of Moment Resisting Frames according to ASCE7-10, Table 12.2-1.

• The use of spiral reinforcement as well as all seismic design checks and
related assumptions are not considered due to the fact that this type of
reinforcement is not currently available in Tekla Structural Designer.

• The Seismic Force Resisting System set by the user in each direction
through the Seismic Wizard for analysis purposes is not checked for
applicability against the allowed types of the resultant Seismic Design
Category. This is a user responsibility.
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• Seismic design checks are mostly based on capacity design obtained from
the main reinforcement provided. This can lead to an over-design of
structural members if the designer is not careful enough to minimize
excess capacity, especially in columns considering the weak beam - strong
column philosophy.

ACI 318 Seismic Code Checks for columns that have been implemented in
Tekla Structural Designer

Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.1.4.2 Minimum
required
compress
ive
strength
of
concrete

SMF - - -

21.1.4.3 Maximu
m
allowed
compress
ive
strength
of light-
weight
concrete

SMF - - -

21.1.5.2 Maximu
m
allowed
steel
characteri
stic yield
strength
of
longitudi
nal
reinforce
ment

SMF - - -

21.1.5.4 Maximu
m yield
strength
of
transvers
e
reinforce
ment in
confinem

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

ent
regions of
columns

21.1.5.5 Maximu
m
allowed
longitudi
nal
reinforce
ment
yield
strength
used in
the
calculatio
n of
transvers
e
reinforce
ment

SMF - - -

21.1.5.5 Maximu
m
allowed
characteri
stic yield
strength
of shear
reinforce
ment

SMF - - -

21.2.3 Design
shear
force
(page 
1799)

OMF - - -

21.3.2 Minimum
factored
axial
force
(page 
1794)

IMF - - -

21.3.3.2 Design
shear
force
(page 
1799)

IMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.3.5.2 Minimum
Support
Region
size
(confine
ment
reinforce
ment
applies)

IMF - - -

21.3.5.2 Maximu
m
allowed
center
hoop
spacing
(page 
1799) in
confinem
ent
regions

IMF - - -

21.3.5.3 First
hoop
placing
distance
from face
of joint in
support
regions

IMF - - -

21.3.5.3 First
hoop
placing
distance
from face
of joint in
support
regions

SMF - - -

21.3.5.5 Minimum
depth of
column
transvers
e
reinforce
ment into
the joint

IMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.3.5.5 Minimum
area of
column
rectangul
ar
transvers
e
reinforce
ment

IMF - - -

21.3.5.5 Minimum
depth of
column
transvers
e
reinforce
ment into
the joint

SMF - - -

21.3.5.5 Minimum
volumetri
c ratio /
area of
column
spiral or
circular
transvers
e
reinforce
ment

IMF - - -

21.3.5.6 Length of
confinem
ent
region
when
inside
footings,
mats or
pile caps

IMF - - -

21.3.5.6 Length of
confinem
ent
region for
columns
supportin
g/above
discontin

IMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

uous stiff
members
(walls)

21.6.1 Minimum
factored
axial
force
(page 
1794)

SMF - - -

21.6.1.1 Minimum
overall
dimensio
n

SMF - - -

21.6.1.2 Minimum
shortest
dimensio
n to
perpendi
cular
dimensio
n ratio

SMF - - -

21.6.2.2/2
1.6.2.3

Minimum
flexural
strength
(page 
1796)

SMF - - -

21.6.3.1 Minimum
allowed
area of
reinforce
ment

SMF - - -

21.6.3.1 Maximu
m
allowed
area of
reinforce
ment
(page 
1802)

SMF - - -

21.6.3.2 Minimum
allowed
number
of bars in
columns

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

with
circular
hoops

21.6.3.3 Lap splice
allowed
locations

SMF - - -

21.6.3.3 Mechanic
al Splices
within
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.6.3.3 Mechanic
al Splices
outside
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.6.3.3 Welded
Splices
within
twice the
member
depth
from
column/
beam
face or
yielding
regions

SMF - - -

21.6.3.3 Welding
of
stirrups

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

or other
elements
to
longitudi
nal reinf.
required
by design

21.6.3.3 Minimum
lap splice
length

SMF - - -

21.6.4.1 Minimum
Support
Region
size
(confine
ment
reinforce
ment
applies)

SMF - - -

21.6.4.1 Minimum
length of
confinem
ent
region at
other
flexural
yielding
sections

SMF - - -

21.6.4.2 Type of
confinem
ent
reinforce
ment
(hook/
extension
)

SMF - - -

21.6.4.2 Maximu
m
allowed
cross
section
center
link leg
spacing in
confinem

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

ent
regions

21.6.4.3 Maximu
m
allowed
center
hoop
spacing
(page 
1799) in
confinem
ent
regions

SMF - - -

21.6.4.3 Maximu
m hoop
spacing
at lap
Splices
(page 
1796)

SMF - - -

21.6.4.4a) Minimum
volumetri
c ratio /
area of
spiral or
circular
confinem
ent
reinforce
ment

SMF - - -

21.6.4.4b) Minimum
area of
rectangul
ar
confinem
ent
reinforce
ment

SMF - - -

21.6.4.5 Maximu
m center
link/
stirrup
spacing in
non
special

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

transvers
e reinf.
regions

21.6.4.6 Length of
confinem
ent
region
when
inside
footings,
mats or
pile caps

SMF - - -

21.6.4.6 Length of
confinem
ent
region for
columns
supportin
g/above
discontin
uous stiff
members
(walls)

SMF - - -

21.6.4.7 Spacing
of
transvers
e
reinforce
ment for
non-
structural
extension
s

SMF - - -

21.6.5.1 Design
shear
force
(page 
1799)

SMF - - -

21.6.5.2 Unreinfor
ced Shear
resistanc
e at
confinem
ent
regions

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.7.3.1 Minimum
volumetri
c ratio /
area of
column
spiral or
circular
transvers
e
reinforce
ment

SMF - - -

21.7.3.1 Minimum
area of
column
rectangul
ar
transvers
e
reinforce
ment

SMF - - -

21.7.3.1 Type of
column
transvers
e
reinforce
ment
(hook/
extension
)

SMF - - -

21.7.3.1 Maximu
m
allowed
column
cross
section
center
link leg
spacing

SMF - - -

21.7.3.1 Maximu
m
allowed
center
hoop
spacing

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

(page 
1799)

21.7.3.1 Spacing
of
column
transvers
e
reinforce
ment for
non-
structural
extension
s

SMF - - -

21.7.3.2 Minimum
column
transvers
e
reinf.with
beams in
all
directions
≥ 3/4 the
column’s
width

SMF - - -

21.7.4.1 Maximu
m
nominal
shear
strength
for joints
confined
by beams
on all
four faces

SMF - - -

21.7.4.1 Maximu
m
nominal
shear
strength
for joints
confined
by beams
on three
faces or
two

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

opposite
faces

21.7.4.1 Maximu
m
nominal
shear
strength
for joints
not
confined
by beams

SMF - - -

21.8.3 Minimum
nominal
strength
of the
strong
connectio
n for
column-
to-
column
connectio
ns

SMF - - -

21.8.3 Minimum
nominal
moment
strength
of the
strong
connectio
n for
column-
to-
column
connectio
ns

SMF - - -

21.8.3 Minimum
nominal
shear
strength
of the
strong
connectio
n for
column-

SMF - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

to-
column
connectio
ns

NOTE • For further details of the checks that have been implemented, see:
General requirements (columns seismic: ACI 318) (page 1794),
Flexural reinforcement (columns seismic: ACI 318) (page 1802),
Transverse reinforcement (columns seismic: ACI 318) (page 1799),
or consult the respective clause reference in the code.

• Most of the requirements will be fulfilled through automatic
design. In some cases specific design options will need to be set by
the user.

• Additional requirements may apply to members that are not part
of the SFRS when in SDC’s D, E or F

• Confinement regions: - support regions; - Probable flexural yield
regions; - Lap splice regions.

General requirements (columns seismic: ACI 318)

End Fixity

Reinforced concrete columns assigned to Moment Resisting Frames have their
end fixities at the base of the building limited to:

• Fixed base;

• Pinned base;

• Spring base (foundation flexibility).

Minimum factored axial force

Members experiencing axial compression forces higher than the minimum
threshold in the code from any of the load combinations are required to be
checked for flexural strength and to consider flexural detailing within the
strong column - weak beam design philosophy according to their assigned
SFRS type.

If SFRS Type = Ordinary Moment Frame, then no No axial compression load
requirement applies.

If SFRS Type = Intermediate Moment Frame, or Special Moment Frame

 
 Pmin  

 
=
 
 

Ag * f’c / 10
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 where  
 Pmin  

 
=
 
 

Minimum required axial compression

 Ag  
 
=
 
 

Gross area of the concrete section

 f’c  
 
=
 
 

Specified compressive strength of concrete

The check passes and the member is designed for seismic provisions as a
compressive member if Pu > Pmin

 
 where  

 Pu  
 
=
 
 

Largest factored compressive axial force at the top of the stack
from any load combination.

NOTE This check is no longer required in ACI 318-14.

Maximum recommended axial force

ACI 318 allows for the maximum design axial load to be as high as
0.8*ɸ*Pn,max, where Pn,max is the maximum compression resistance of the
section composed of concrete and steel. However in the event of a severe
earthquake a full height beam yielding mechanism could occur inducing
higher compression strain on the columns than the one predicted by elastic
design.

Good practice recommends that the maximum compressive strain in a column
part of a Special Moment Frame should remain below the balanced value.

NOTE The current release of Tekla Structural Designer does not check if the
compressive strain is below the balanced point.

Minimum cross-section dimension

ACI 318 limits the shortest cross-sectional dimension of a column that is part
of a Special Moment Frame to a lower fixed value in any direction measured in
a straight line passing through the section centroid and also to a fraction of
the length of the perpendicular dimension.
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If designing to ACI 318-14, there is an additional limit of half the height of the
deepest beam connecting at the joint.

These minimum dimension restrictions are calculated and applied accordingly
when the column that is part of a Special Moment Frame.

Flexural requirements (columns seismic: ACI 318)

Minimum flexural strength

Columns that are part of Special Moment Frames are required by ACI 318 to
have a minimum amount of flexural strength depending on the connecting
beams flexural capacities so as to promote the formation of beam yielding
mechanisms in the case of an earthquake. This is done by establishing a ratio
between the beam and column moment strengths in the moment resisting
frame direction.

The design of the main reinforcement in a column is done for the top, middle
and bottom region of the stack and moment capacity is calculated for the
factored axial force in each region for the Major and Minor directions.

If SFRS Type = Special Moment Frame then flexural strength checks are
performed at the joints:

 
 Σ Mnc,l  

 
=
 
 

Mnc,l,bot + Mnc,l,top

 Σ Mnc,r  
 
=
 
 

Mnc,r,bot + Mnc,r,top

   
 where  
    
 Σ Mnc,l , Σ

Mnc,r

 
 
=
 
 

Sum of the Nominal Flexural Strengths of the columns
framing into the joint in the relevant direction.

    
 Mnc,l,bot,

Mnc,r,bot

 
 
=
 
 

Nominal Moment Strength of the stack below the joint
obtained for the axial force value consistent with the
minimum Nominal Moment Strength respectively for the
left and right sway cases.

    
 Mnc,l,top,

Mnc,r,top

 
 
=
 
 

Nominal Moment Strength of the stack above converging
on the same joint for the axial force value consistent with
the minimum Nominal Moment Strength respectively for
the left and right sway cases.
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The sum of the beam strengths are obtained as follows:

 
 Σ Mnb,l  

 
=
 
 

Mnb,l- + Mnb,l+

 Σ Mnb,r  
 
=
 
 

Mnb,r- + Mnb,r+

   
 where  
    
 Σ Mnb,l , Σ

Mnb,r

 
 
=
 
 

Sum of the Nominal Flexural Strengths of the beams
framing into the joint in the relevant direction.

    
 Mnb,l- , Mnb,r-  

 
=
 
 

Nominal Moment Strength at the joint from the beam on
the left from current reinforcement arrangement
respectively for the left and right sway cases.

    
 Mnb,l+ ,

Mnb,r+
 
 
=
 
 

Nominal Moment Strength at the joint from the beam on
the right from current reinforcement arrangement
respectively for the left and right sway cases.

The minimum strength ratio between columns and beams in both left and
right sway cases is checked as follows:

 
 Σ Mnc,l  

 
≥
 
 

6/5 * Σ Mnb,l

 Σ Mnc,r  
 
≥
 
 

6/5 * Σ Mnb,r

Maximum allowed area of reinforcement

The maximum area of longitudinal reinforcement in columns part of Special
Moment Frames is limited as follows.

If SFRS Type = Special Moment Frame

Then calculate maximum area of steel, As,max as follows:
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 As,max  

 
=
 
 

0.06 * Ag

   
 
 where  

    
 
 As,max  

 
=
 
 

Maximum allowed area of reinforcement

 
 Ag  

 
=
 
 

Gross area of the concrete section.

Maximum allowed longitudinal bar center spacing

Limitations on the longitudinal bar spacing emerge from the code requirement
for maximum allowed cross-section center link spacing of the confinement
reinforcement due to the method of link leg distribution across the column
section.

If SFRS Type = Special Moment Frame

Then check maximum longitudinal reinforcement bar distance, scr,max as
follows:

 
 scr,max  

 
=
 
 

350 mm Metric-units

 scr,max  
 
=
 
 

14 in US-units

NOTE In ACI 318-14, scr,max is limited to 200mm for non-circular columns
with, Pu > 0.3*Ag*fc OR fc > 70 MPa (10,000 psi).

Non-reversing plastic hinges

Non-reversing plastic hinges are regions along the stack of the column where
flexural yielding is likely to occur.

NOTE Non-reversing plastic hinges are beyond scope in the current release
of Tekla Structural Designer.
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Splices

Columns that are part of Special Moment Frames have restrictions on the
allowed locations of lap splices.

Strength design of mechanical splices and restrictions to the use of welded
splices as required by ACI 318-11 apply to Special Moment Frames

NOTE These restrictions are not implemented in the current release of Tekla
Structural Designer.

Transverse reinforcement (columns seismic: ACI 318)

Joint shear strength

The calculation of joint shear strength is a requirement of ACI 318 for joints of
Special Moment Frames and it is obtained by considering both the free body
diagram of the column and of the joint. The stress in the beam's tensile
reinforcement at the joint's face is assumed as at least η *fy by considering the
probable moment strengths of framing beams.

The calculation is performed on the following basis:

• Probable Moment Strengths are obtained from beams in the same
direction as the column's considered direction

• Whether beams in the column SFRS Direction are included in the SFRS or
not

• At the top region of stack only

• For both sway right and sway left cases

• Beams with pinned connection are ignored

• Axial stress in beams is assumed to be zero

• Contribution of the slab longitudinal reinforcement in the beam effective
flange width is recommended to be considered, but remains beyond scope
in the current release.

Design shear force

The Design Shear Force of a member subjected to flexure as well as axial
loading part of a Moment Resisting Frame is checked taking into consideration
the shear from the moment strengths of the connected flexural members due
to reverse curvature bending.

• Shear design for columns is done for the entire stack as a single region and
checked for the minimum requirements from the design code.

• The design is performed independently for both the orthogonal directions.
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Minimum area of transverse reinforcement

For columns that are part of Special Moment Frames, the minimum area of
transverse reinforcement required in confinement regions of a column is
obtained as below:

NOTE For Special Moment Frames the amount of confinement
reinforcement in joints with beams on all 4 sides wider than ¾ of the
column width is allowed to be reduced to half and the spacing to be
relaxed within the depth of the shallowest member - this is beyond
scope in the current release of Tekla Structural Designer.

NOTE Non-reversing plastic hinge regions along the span have the same
requirements as support regions - Non-reversing plastic hinge regions
are beyond scope in the current release of Tekla Structural Designer.

For circular columns:

ρs  
 
=
 
 

MAX[ 0.12 * (f’c / fyt) , 0.45 * [(Ag / Ach)-1] * (f’c / fyt)]

where  
ρs  

 
=
 
 

ratio of volume of circular reinforcement to total volume of
confined concrete core.

f’c  
 
=
 
 

Specified compressive strength of concrete.

fyt  
 
=
 
 

Specified yield strength of transverse reinforcement.

Ag  
 
=
 
 

Gross area of concrete section.

Ach  
 
=
 
 

Area of concrete member section measured to the outside of the
transverse reinforcement.

For other supported column geometries

ACI
318-11

  

Design codes reference 1800 US codes



Ash  
 
=
 
 

MAX[0.3 * s * bc * (f’c / fyt) * [(Ag / Ach)-1] , 0.09 * s * bc * (f’c /
fyt)]

ACI
318-14

  

Ash  
 
=
 
 

MAX[0.3 * s * bc * (f’c / fyt) * [(Ag / Ach)-1] , 0.09 * s * bc * (f’c /
fyt),

0.2 * kf * kn * (Pu /(MIN[fyt , 700MPa] * Ach)]

where  
Ash  

 
=
 
 

total cross-section of transverse reinforcement, including
cross-ties, within spacing s and perpendicular to dimension
bc.

s  
 
=
 
 

Center to center spacing of transverse reinforcement along
the region's height.

bc  
 
=
 
 

Cross section dimension of the member core measured to
the outside of the transverse reinforcement and in the
direction perpendicular to the considered reinforcement link
legs.

Ag  
 
=
 
 

Gross area of concrete section.

Ach  
 
=
 
 

Area of concrete member section measured to the outside of
the transverse reinforcement.

Support regions of columns belonging to any other Moment Resisting Frame
type have the minimum area of transverse reinforcement as per conventional
design requirements.

Maximum allowed center hoop spacing

The maximum allowed horizontal center spacing of hoops in confinement
regions of columns part of Moment Resisting Frames is limited as below.

If SFRS Type = Ordinary Moment Frame:

• No spacing requirement applies to support regions when designing for
seismic provisions.

If SFRS Type = Special Moment Frame and the region is a support region:

scr,max,s

up

 
=MIN[6*db,smallest, 0.25*MIN(c1, c2), 100 mm ≤ 100+((350 –

hx)/3) ≤ 150 mm]
metric
units
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scr,max,s

up

 
=
 

MIN[6*db,smallest, 0.25*MIN(c1, c2), 4 in. ≤ 4+((14 -
hx)/3) ≤ 6 in.]

US
units

   
where   
db,smalle

st

 
=
 

Smallest longitudinal reinforcement bar diameter  

c1  
=
 

Rectangular or equivalent rectangular column dimension in the
direction of the span for which moments are being considered

c2  
=
 

Dimension of the column perpendicular to c1

hx  
=
 

Maximum center-to-center horizontal spacing of crossties at any
face of the column

If SFRS Type = Special Moment Frame and the region is not a support region:

scr,max,span  
=
 

MIN[6 * db,smallest, 150 mm] metric units

scr,max,span  
=
 

MIN[6 * db,smallest, 6 in.] US units

If SFRS Type = Intermediate Moment Frame and the region is a support region:

scr,max,su

p

 
=
 

MIN[8*db,smallest, 24 *db,w , 1/2 * MIN(c1, c2), 300
mm]

metric units

scr,max,su

p

 
=
 

MIN[8*db,smallest, 24 **db,w , 1/2 * MIN(c1, c2), 12
in.]

US units

   
where   
db,w  

=
 

= Link (hoop) diameter  

If SFRS Type = Intermediate Moment Frame and the region is not a support
region:

• No spacing requirement applies beyond the conventional design
requirements.

Flexural reinforcement (columns seismic: ACI 318)

Development Length at the Foundation

Columns that are part of Special Moment Frames shall have their longitudinal
reinforcement extended into supporting footings, foundation mats or pile
caps for a length not less than the full development length in tension.
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Lap Splices

Specific seismic requirements apply only to lap splices in compressive
members that are part of Special Moment Frames.

For columns that are part of Special Moment Frames:

• lap splices are only allowed at the center half of the column

• lap splices regions should be properly confined - hoop spacing should not
exceed the maximum allowed hoop spacing

NOTE Both of these requirements are beyond scope in the current release
of Tekla Structural Designer.

Confinement reinforcement for ductility (columns seismic: ACI 318)

Reinforcement Type

Confinement reinforcement in columns at regions where provided should
consist of hoops, i.e. closed or continuously wound ties with a seismic hook at
each end.

NOTE Confinement reinforcement in the form of spiral reinforcement is
beyond scope in the current release of Tekla Structural Designer.

Detailing Regions

Confinement reinforcement is required to be provided over three types of
regions along reinforced concrete columns that are part of Intermediate
Moment Frames and Special Moment Frames:

• Support regions: These are probable flexural yielding regions at the top
and bottom of the stack next to column-beam joints;

• Non-reversing plastic hinge regions: These are probable flexural yielding
regions outside support regions.

NOTE Non-reversing plastic hinge regions are not identified in the
current release of Tekla Structural Designer.

• Lap splices: Confinement reinforcement in the form of hoops is required to
be provided over the length of lap splices in reinforced concrete columns
part of Special Moment Frames

NOTE The requirement for hoop spacing not to exceed the maximum
allowed hoop spacing at lap splices is beyond scope in the current
release of Tekla Structural Designer.
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Concrete wall design to ACI 318

The following topics are covered:

• Cover to Reinforcement (ACI 318) (page 1731)

• Design parameters for vertical bars (concrete wall: ACI 318) (page 1804)

• Design parameters for horizontal bars (concrete wall: ACI 318) (page 1806)

• Ultimate Axial Load Limit (column and wall:ACI 318) (page 1773)

• Effective length calculations (column and wall:ACI 318) (page 1774)

• Column stack and wall panel classification (column and wall:ACI 318)
(page 1775)

• Design Moment Calculations (column and wall: ACI 318) (page 1777)

• Design for combined axial and bending (column and wall:ACI 318)
(page 1779)

• Design for in plane shear (walls:ACI 318) (page 1807)

• Column confinement (column and wall:ACI 318) (page 1780)

• Seismic design (walls: ACI 318) (page 1807)

See also

Limitations (concrete members: ACI 318) (page 1730)

Seismic Design to ACI 318 (page 1840)

Design parameters for vertical bars (concrete wall: ACI 318)

For some of the longitudinal reinforcement design parameters, additional user
defined limits can be applied - where this is the case minimum and maximum
values are specified in Design Options > Wall > Reinforcement Layout.

Minimum and Maximum Vertical Bar Diameter

There are no code provisions, but user defined limits can be applied to the
minimum and maximum bar diameters - specified in Design Options > Wall >
Reinforcement Layout

Minimum and Maximum Vertical Loose Bar Spacing

Limiting minimum horizontal spacing of the vertical bars, sv,lim,min is controlled
by the diameters of the 2 adjacent bars and aggregate size1.

sv,lim,min  
 
=
 
 

0.5*(dbv,i + dbv,(i + 1)) + cgap

1 Clause 7.6.3
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where

cgap  
 
=
 
 

min. clear distance bet. bars

  
 
=
 
 

max (1.5*dbv,i , 1.5*dbv,(i+1), 1.33*
hagg, 1.5 in.)

US units

  
 
=
 
 

max (1.5*dbv,i , 1.5*dbv,(i+1), 1.33*
hagg, 38mm)

metric units

where   
dbv,i and dbv,(i+1)  

 
=
 
 

the diameters of the two adjacent vertical bars

hagg  
 
=
 
 

aggregate size  

Limiting maximum horizontal spacing of the vertical bars, sv,lim,max is
controlled by the wall thickness.

sv,lim,m

ax

 
 
=
 
 

min (3*hw, 18 in.) US units

  
 
=
 
 

min (3*hw, 450mm) metric units

You are given control over these values by specifying minimum and maximum
spacing limits in Design Options > Wall > Reinforcement Layout.

Minimum and Maximum Reinforcement Area

The code provisions which control the vertical reinforcement area are,

• Limiting minimum ratio of vertical reinforcement area to gross concrete
area, rv,lim,min

• Limiting maximum ratio of vertical reinforcement area to gross concrete
area, rv,lim,max

The controlling values are:

IF dbv ≤ No. 5 (No. 16) with fy ≥ 60,000 psi (420 MPa) OR WWR ≤ W31 or D31
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then ρv,lim,min = 0.0012 else 0.0015 for all other deformed bars

Total minimum area of vertical reinforcement, As,min = ρv,lim,min*Acg

Total maximum area of vertical reinforcement, As,max = ρv,lim,max*Acg = 0.08*Acg

where Acg = Gross area of the concrete wall.

Where 2 layers are specified, this should be distributed equally to each face.

You are given further control over the minimum and maximum reinforcement
ratio values via user limits in Design Options > Wall > Reinforcement Layout.
These will be used if they are more onerous than the code limits.

Design parameters for horizontal bars (concrete wall: ACI 318)

For some of the horizontal bar parameters, additional user defined limits can
be applied - where this is the case minimum and maximum values are
specified in Design Options > Wall > Reinforcement Layout

Minimum and Maximum Reinforcement Area

The code provisions which control the horizontal reinforcement area are,

• Limiting minimum ratio of horizontal reinforcement area to gross concrete
area, rh,lim,min

• Limiting maximum ratio of horizontal reinforcement area to gross concrete
area, rh,lim,max

The controlling values are:

IF dbv ≤ No. 5 (No. 16) with fy ≥ 60,000 psi (420 MPa) OR WWR ≤ W31 or D31

THEN ρh,lim,min = 0.002 ELSE 0.0025 for all other deformed bars

Total minimum area of horizontal reinforcement, As,min = ρh,lim,min*Acg

Total maximum area of vertical reinforcement, As,max = ρh,lim,max*Acg =
0.08*Acg

where Acg= Gross area of the concrete wall.

You can select a minimum ratio which will be the start point for the design in
Design Options > Wall > Reinforcement Layout.

Minimum and Maximum Horizontal Bar Spacing

This is identical in principle to min vertical bar spacing.

Minimum and Maximum Confinement Bar Spacing

There are Code provisions that control the maximum spacing:

The recommended values are,

Limiting maximum transverse spacing, sw,lim,max = min (16*dbv , 48*dbw , hw)
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Design for in plane shear (walls:ACI 318)

In the plane of the wall the factored shear must be equal to or less than the
design shear strength of the wall

Vu   ≤  ΦVn

The design shear strength of the wall is equal to the design shear strength of
the concrete plus that of the shear reinforcing

Vu   ≤  ΦVc + ΦVs

The shear strength, Vn, may not be taken greater than 10 * √f’c * h * d.

Vn  
 
≤
  

10 * √f’c * h * d US units

Vn  
 
≤
  

0.83 * √f’c * h * d metric units

where

h   =  wall thickness
d   =  0.8 * lw
lw   =  length of the wall

Out of plane the shear design calculations are the same whether the design
element is a column or a wall - see: Design parameters for shear (column and
wall:ACI 318) (page 1780)

Seismic design (walls: ACI 318)

Direction dependant seismic checks are performed in the in plane direction
only as this is the only direction in which shear walls are considered to act as
Seismic Force Resisting Systems.

Walls included in the SFRS as Ordinary Reinforced Concrete Structural Walls
(ORCSW) have no specific seismic design provisions according to ACI318-11.

For overall limitations and assumptions, see:

• Limitations and assumptions (walls seismic: ACI 318) (page 1808)

For seismic design, see:

• General requirements (walls seismic: ACI 318) (page 1824)
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See also

Seismic Design to ACI 318 (page 1840)

Limitations and assumptions (walls seismic: ACI 318)

The following limitations and assumptions apply.

• For design purposes Tekla Structural Designer recognizes walls as isolated
elements and as such the influence of flanges from adjacent walls are not
to be considered when fulfilling seismic design requirements in those
elements. Requirements of ACI318-11 section 21.9.5.2 and section
21.9.6.4(b) do not apply.

• Additional requirements for wall piers not part of any SFRS when in Seismic
Design Categories D through F are not considered in the current release.

• Design and/or detailing requirements of Special Reinforced Concrete
Structural Walls is beyond scope (some checks are implemented but only
due to their existence in lower toughness systems).

• The use of spiral reinforcement as well as all seismic design checks and
related assumptions are not considered due to the fact that this type of
reinforcement is not currently available in Tekla Structural Designer.

• Special boundary elements in walls are directly linked with wall end-zones
in Tekla Structural Designer. The current settings do not allow for end-
zones of width different from the width of the wall itself.

• The Seismic Force Resisting System set by the user in each direction
through the Seismic Wizard for analysis purposes is not checked for
applicability against the allowed types from the resultant Seismic Design
Category. This is user responsibility.

• Seismic design checks are mostly based on capacity design obtained from
the main reinforcement provided. This can lead to an over-design of
structural members if the designer is not careful enough to minimize
excess capacity.

• The seismic design requirements for end-zone reinforcement are beyond
scope in the current release.

• Construction joints are beyond scope in the current release.

• Seismic design provisions specific for beam-wall frames are beyond scope
in the current release.

• Seismic design of walls with openings is beyond scope in the current
release.

• Seismic design of wall piers is beyond scope in the current release.

• Seismic design of coupling beams is beyond scope in the current release.

• Seismic detailing requirements apply to Special Reinforced Concrete
Structural Walls these are beyond scope in the current release.
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• NOTE A full list of the code checks that have and have not been
implemented is provided in the table below.

ACI 318 Seismic Code Checks for walls that have been implemented in
Tekla Structural Designer

Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.1.4.2 Minimum
required
compress
ive
strength
of
concrete

SRCSW - - -

21.1.4.3 Maximu
m
allowed
compress
ive
strength
of light-
weight
concrete

SRCSW - - -

21.1.5.2 Maximu
m
allowed
steel
characteri
stic yield
strength
of
longitudi
nal
reinforce
ment

SRCSW - - -

21.1.5.4 Maximu
m yield
strength
of
transvers
e
reinforce
ment in
confinem
ent

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

regions of
columns

21.1.5.5 Maximu
m
allowed
longitudi
nal
reinforce
ment
yield
strength
used in
the
calculatio
n of
transvers
e
reinforce
ment

SRCSW - - -

21.1.6.1a) Mechanic
al Splices
outside
twice the
member
depth
from
column/
beam
face or
yielding
regions

SRCSW - - -

21.1.6.1b) Mechanic
al Splices
within
twice the
member
depth
from
column/
beam
face or
yielding
regions

SRCSW - - -

21.1.7.1 Welded
Splices

SRCSW - - -

Design codes reference 1810 US codes



Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

within
twice the
member
depth
from
column/
beam
face or
yielding
regions

21.1.7.2 Welding
of
stirrups
or other
elements
to
longitudi
nal reinf.
required
by design

SRCSW - - -

21.12.2.3 Confinem
ent reinf.:
Length
inside
footing
when
Special
Boundary
Element
is within
half the
foundatio
n depth
from the
footing
edge

SRCSW - - -

21.4.3 Minimum
yield
strength
of
connectio
n not
designed
to yield

IPCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.4.4/21.
9.8

Design of
wall piers
as
columns
(lw/bw ≤
2.5)

SRCSW - - -

21.9.2.1 Minimum
reinforce
ment
ratio in
each of
the wall
plane
orthogon
al
directions

SRCSW - - -

21.9.2.1 Maximu
m
allowed
center
spacing

SRCSW - - -

21.9.2.2 Minimum
number
of
reinforce
ment
layers
(page 
1824)

SRCSW - - -

21.9.2.3a) Minimum
discontin
uous
vertical
bar
extension

SRCSW - - -

21.9.2.3a) Develop
ment
length at
locations
where
flexural
yielding is
likely to
occur

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.9.2.3c) Minimum
yield
strength
for
developm
ent
length
and lap
splices

SRCSW - - -

21.9.3 Factored
shear
force at
any
section
from
lateral
load
analysis

SRCSW - - -

21.9.4.1 Maximu
m
nominal
shear
strength

SRCSW - - -

21.9.4.3 Reinforce
ment in
wall
plane
provided
in both
directions

SRCSW - - -

21.9.4.3 Minimum
in plane
reinforce
ment
ratios
(page 
1824)

SRCSW - - -

21.9.4.4 Maximu
m wall
segment
combined
nominal
shear
strength

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.9.4.4/2
1.9.4.5

Maximu
m
individual
vertical or
horizonta
l wall
segment
or
coupling
beam
shear
strength

SRCSW - - -

21.9.5.2 Effective
width of
flanged
wall
sections

SRCSW - - -

21.9.6.3 Minimum
extreme
fiber
compress
ive stress
to require
Special
Boundary
Elements

SRCSW - - -

21.9.6.3 Minimum
stress to
discontin
ue
Special
Boundary
Element

SRCSW - - -

21.9.6.4(a
)

Minimum
length of
end-zone
towards
the
center of
the cross-
section
when
Special
Boundary
Elements

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

are
required

21.9.6.4(b
)

Minimum
length of
end-zone
towards
the
center of
the cross-
section in
flanged
sections
with
Special
Boundary
Elements

SRCSW - - -

- Minimum
width of
end-zone
with
special
boundary
elements

SRCSW - - -

21.9.6.4(c
)

Special
confining
reinforce
ment
type
(hook/
extension
)

SRCSW - - -

21.9.6.4c) Confining
reinf.:
Maximu
m
spacing
allowed
between
cross ties

SRCSW - - -

21.9.6.4c) Confining
reinf.:
Maximu
m
allowed
longitudi

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

nal center
link
spacing

21.9.6.4c) Confinem
ent reinf.:
Minimum
volumetri
c ratio /
area of
spiral or
circular
reinforce
ment

SRCSW - - -

21.9.6.4c) Confinem
ent
Reinf.:
Minimum
area of
rectangul
ar
transvers
e
reinforce
ment

SRCSW - - -

21.9.6.4d) Confining
reinf.:
Length of
region
inside
footings,
mats or
pile caps,
ld

SRCSW - - -

21.9.6.4d) Confining
reinf.:
Length of
region
into
support

SRCSW - - -

21.9.6.4e) Develop
ment /
anchorag
e of
horizonta
l

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

reinforce
ment
with
boundary
elements

21.9.6.5a) Ordinary
Boundary
Confinem
ent
region
length -
towards
the
center of
the cross-
section -
at an end
where
special
boundary
elements
are not
required

SRCSW - - -

21.9.6.5a) Maximu
m
spacing
allowed
between
cross ties
in high
compress
ion
confinem
ent reinf.
at a
boundary
where
special
boundary
elements
are not
required

SRCSW - - -

21.9.6.5a) Maximu
m long.
center
spacing

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

of high
compress
ion
confinem
ent
reinforce
ment at
an end
where
special
boundary
elements
are not
required

21.9.6.5a) Maximu
m
spacing
allowed
between
cross ties
or legs of
hoops

SRCSW - - -

21.9.6.5b) Design
shear
threshold
for
ignoring
the need
of
engaging
horizonta
l bars at
the ends
with
standard
hooks

SRCSW - - -

21.9.7.1 Minimum
value of
aspect
ratio
(ln/h) to
consider
diagonal
reinf.

SRCSW - - -

Design codes reference 1818 US codes



Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

21.9.7.2 Maximu
m shear
allowed
before
consideri
ng
diagonal
reinf.

SRCSW - - -

21.9.7.4a) Nominal
Shear
Strength
of a
coupling
beam

SRCSW - - -

21.9.7.4b) Minimum
number
of bars to
be
provided
along
each
diagonal

SRCSW - - -

21.9.7.4b) Minimum
length of
diagonal
bars
embedde
d into the
wall

SRCSW - - -

21.9.7.4c) Minimum
breadth
of the
concrete
core
measure
d to the
external
face of
the
confining
reinforce
ment

SRCSW - - -

21.9.7.4c) Minimum
dimensio
n of the

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

concrete
core in
any
direction
than not
the
parallel to
bw,
measure
d to the
external
face of
the
confining
reinf.

21.9.7.4c) Special
confining
reinforce
ment
(hook/
extension
)

SRCSW - - -

21.9.7.4c) Confining
reinf.:
Maximu
m
allowed
center
link
spacing

SRCSW - - -

21.9.7.4c) Confining
reinf.:
Minimum
volumetri
c ratio /
area of
spiral or
circular
reinf.

SRCSW - - -

21.9.7.4c) Confining
Reinf.:
Minimum
area of
rectangul
ar

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

transvers
e reinf.

21.9.7.4c) Minimum
allowed
total area
of the
additional
longitudi
nal
reinforce
ment

SRCSW - - -

21.9.7.4c) Maximu
m
allowed
spacing
between
the
additional
longitudi
nal bars

SRCSW - - -

21.9.7.4c) Minimum
allowed
area of
the
additional
transvers
e
reinforce
ment

SRCSW - - -

21.9.7.4c) Maximu
m
allowed
spacing
between
the
additional
transvers
e bars

SRCSW - - -

21.9.8.1a) Design
shear
force
calculatio
n for wall
piers with
lw/bw >

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

2.5 and
not
designed
as
columns

21.9.8.1b) Nominal
shear
strength
and
distribute
d shear
reinforce
ment

SRCSW - - -

21.9.8.1c) Reinforce
ment
type
requirem
ent for
wall piers
with lw/bw
> 2.5 and
not
designed
as
columns

SRCSW - - -

21.9.8.1d) Maximu
m
allowed
vertical
spacing
of
transvers
e
reinforce
ment.
Wall piers
with

lw/bw >
2.5 and
not
designed
as
columns

SRCSW - - -

21.9.8.1e) Length of
the

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

transvers
e reinf.
region
above
and
below the
wall pier.
Wall piers
with lw/bw
> 2.5 and
not
designed
as
columns

21.9.8.1f) Consider
boundary
elements

SRCSW - - -

21.9.8.2 Horizonta
l reinf. In
adjacent
walls
when wall
pier is at
the edge
of a wall

SRCSW - - -

ASCE7/10
- 12.2.1

Limiting
Height
(page 
1824)

SRCSW - - -

ASCE7/10
- 12.2.1

Limiting
Height
(page 
1824)

IPCSW - - -

R21.9.1 Vertical
Segment
Classificat
ion
(page 
1824):
Condition
s for wall
segments
to require
specific

SRCSW - - -
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Code Ref. Require
ment

SFRS SDC A SDC A SDC B SDC D,E,F

wall pier
design

NOTE • For further details of the checks that have been implemented, see:
General requirements (walls seismic: ACI 318) (page 1824), or
consult the respective clause reference in the code.

• Most of the requirements will be fulfilled through automatic
design. In some cases specific design options will need to be set by
the user.

• Additional requirements may apply to members that are not part
of the SFRS when in SDC’s D, E or F

• Confinement regions: - support regions; - Probable flexural yield
regions; - Lap splice regions.

General requirements (walls seismic: ACI 318)

Maximum recommended axial force

As to impose the wall ductile behaviour axial force values are recommended
to be kept low in the design of Special Reinforced Concrete Structural Walls
resisting earthquake effects. The maximum axial force value in walls is
recommended to be kept below the balanced point. Compression controlled
walls should be avoided.

NOTE The current release of Tekla Structural Designer does not check if the
axial force is below the balanced point.

Limiting Height

Buildings in which Special Reinforced Concrete Structural walls compose the
SFRS in any of the main directions should have their height limited. Where
dual systems of SRCSW and Moment Frames resisting at least 25% of the total
shear exist there are no height restrictions.

NOTE The current release of Tekla Structural Designer does not check the
maximum allowed building height based on Seismic Design Category.

Vertical Segment Classification

Isolated vertical segments within a wall - wall with openings - can be classified
as wall segments or wall piers. For Special Reinforced Structural Walls and
depending on the classification of the segment the governing design
provisions can be split into provisions for walls and provisions for wall piers.
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NOTE This is beyond scope in the current release of Tekla Structural
Designer.

Mid-zone Reinforcement

Vertical and horizontal bars in mid-zones of Special Reinforced Concrete
Structural Walls are designed according to the requirements of the following
sections.

Minimum number of reinforcement layers

The minimum number of reinforcement layers allowed to be used in a Special
Reinforced Concrete Structural Wall is governed by the amount of in-plane
shear sustained by the wall

If the wall thickness bw is greater than 250mm (10 in.) then at least two
curtains of reinforcement are required.

If the wall thickness bw is less than 250mm (10 in.) and the SFRS Type = Special
Reinforced Concrete Structural Wall, then the minimum number of layers is
dependent on the maximum shear force in the panel (ACI 318-11); or the
maximum shear force and wall geometry (ACI 318-14). This is checked
accordingly.

Additionally, reinforcement is required to be provided in both of the
orthogonal directions in the wall plane - This requirement is automatically met
as Tekla Structural Designer does not design walls with reinforcement in only
one of the orthogonal directions in wall plane.

Minimum in plane reinforcement ratios

The minimum reinforcement ratio required in each of the orthogonal direction
in the wall plane is dependent on the maximum panel factored shear force
from analysis for seismic combinations and calculated as follows:

NOTE Grouped bars reinforcing the edges of the walls (end-zones) are not
considered for the purpose of calculating reinforcement ratios.

IF SFRS Type = Special Reinforced Concrete Structural Wall then the maximum
factored shear force at the panel is checked:

 
 If Vu  

 
>
 
 

Vu,lim

 where  
 Vu  

 
=
 
 

Maximum factored shear force in the wall panel
obtained from the analysis for seismic
combinations.
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 Vu,lim  
 
=
 
 

Minimum factored shear force in the wall above
which horizontal and vertical main reinforcement
minimum ratios need to be checked.

 Mnc,l,top,
Mnc,r,top

 
 
=
 
 

Nominal Moment Strength of the stack above
converging on the same joint for the axial force
value consistent with the minimum Nominal
Moment Strength respectively for the left and right
sway cases.

Then a check for minimum reinforcement ratio in each orthogonal direction
on the wall plane is performed as follows:

 
 ρl  

 
≥
 
 

ρmin

 ρt  
 
≥
 
 

ρmin

 where  
 ρl, ρt  

 
=
 
 

Respectively the ratio of area of distributed vertical and
horizontal reinforcement to gross concrete area perpendicular
to each of those reinforcements.

 ρmin  
 
=
 
 

Minimum allowed ratio of reinforcement in the wall plane =
0.0025.

Else if Vu  
 
≤
 
 

Vu,lim

ρl and ρt are allowed to be taken as the wall design conventional values.

Depending on the overall dimensions of a wall the vertical reinforcement ratio,
ρl in Special Reinforced Concrete Structural Walls is limited to be of the same
value or larger than the horizontal reinforcement ratio, ρt

End-zone Reinforcement

NOTE The seismic design requirements for end zone reinforcement are
beyond scope in the current release of Tekla Structural Designer.

Shear Strength

Minimum shear strength
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The basic design requirement for shear reinforcement in a wall is to have the
reduced shear strength higher or the same as the maximum factored shear
force at the considered section resultant from earthquake combinations.
Some level of over-strength is expected when designing to multiple load
combinations.

IF SFRS Type = Special Reinforced Concrete Structural Wall then the following
check for shear strength is performed:

 
 ɸVn  

 
≥
 
 

Vu

 where  
 ɸ  

 
=
 
 

Strength reduction factor. For purposes of checking the
nominal shear strength = 0.6

 Vn  
 
=
 
 

Maximum nominal shear strength at the considered panel.

 Vu  
 
=
 
 

Maximum factored shear force in the wall panel obtained
from the analysis for seismic combinations.

Concrete slab design to ACI 318

The following topics are covered:

• Cover to Reinforcement (ACI 318) (page 1731)

• Design parameters for longitudinal bars (ACI 318) (page 1733)

• Design for bending for rectangular sections (beams and slabs: ACI 318)
(page 1738)

Pad and strip base design to ACI 318

The following topics are covered:

• Checks performed (pad and strip base:ACI 318) (page 1828)

• Foundation Bearing Capacity (pad and strip base:ACI 318) (page 1828)

• Design for shear (pad and strip base:ACI 318) (page 1832)

• Check for transfer forces at column base (pad and strip base:ACI 318)
(page 1832)

Design codes reference 1827 US codes



• Check for transfer of horizontal forces by shear friction (pad and strip
base:ACI 318) (page 1834)

• Design for bending for rectangular sections (beams and slabs: ACI 318)
(page 1738)

• Check for overturning forces (pad and strip base:ACI 318) (page 1834)

• Check for sliding (pad and strip base:ACI 318) (page 1834)

• Check for uplift (pad and strip base:ACI 318) (page 1835)

• Checks for limiting parameters (pad and strip base: ACI 318) (page 1836)

Checks performed (pad and strip base:ACI 318)

The checks performed for both directions are:

• Max soil bearing pressure must not exceed allowable bearing pressure.

• Provided steel must be greater than As(min) for both vertical directions.

• Provided bar spacing must be inside the limiting spacing

• Provided bar size must be inside the limiting sizes

• Check for bending moment capacity

• Check for shear capacity - wide beam action at 'd' from column face

• Punching check at 'd/2' from column face - two-way action

• Check for transfer of forces at column base

• Check for transfer of horizontal forces by shear friction theory

• Check for overturning forces - not in the current release

• Check for sliding

• Check for uplift

Foundation Bearing Capacity (pad and strip base:ACI 318)

Check for Pad Base Bearing Capacity

Bearing capacity calculations are done using service (soil) -combinations.

Total base reaction:

T   =  Fswt + Fsoil + Fdl,sur + Fll,sur
- P

Moment about X axis:

M x,c   =  Mx,sup - P * ey - tftg *F
y,sup

Moment about Y axis:
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M y,c   =  M y,sup + P * ex + tftg *F
x,sup

Where:

Lx  
 
=
  

Length of
foundation in X-
direction

 

Ly  
 
=
  

Length of
foundation in Y-
direction

 

Af  
 
=
  

L x * L y =
Foundation area

 

tftg  
 
=
  

Depth of
foundation

 

Ds  
 
=
  

Depth of soil
above the
foundation

 

lx  
 
=
  

Length of column/
wall in X-direction

 

ly  
 
=
  

Length of column/
wall in Y-direction

 

Ac  
 
=
  

cross section of
the column/wall
segment

 

ex  
 
=
  

eccentricity in X
direction

 

ey  
 
=
  

eccentricity in Y
direction

 

ρc  
 
=
  

density of
concrete

 

ρs  
 
=
  

density of soil  

Fswt  
 
=
  

Af * tftg * ρc =
foundation self-
weight
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Fsoil  
 
=
  

(Af - Ac)*Ds* ρs =
soil self-weight

 

Fdl,sur  
 
=
  

(Af - Ac)*scdl =
Dead load from
surcharge

 

Fll,sur  
 
=
  

(Af - Ac)*scll = Live
load from
surcharge

 

scdl  
 
=
  

Surcharge in dead
load case

 

scdl  
 
=
  

Surcharge in live
load case

 

P  
 
=
  

axial load acting
on support in
service
combinations

 

Mx,sup  
 
=
  

Moment acting on
support around X-
axis in service
comb.

 

My,sup  
 
=
  

Moment acting on
support around Y-
axis in service
comb.

 

A c  
 
=
  

cross section of
the column/wall

 

F x,sup  
 
=
  

Horizontal force
acting on support
X-direction in
service comb.

 

F y,sup  
 
=
  

Horizontal force
acting on support
Y-direction in
service comb.

 

Eccentricity of base reaction in X-direction:

eTx   =  My,c / T

Eccentricity of base reaction in Y-direction:

eTy  = Mx,c / T
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If abs(eTx) / Lx + abs(eTy) / Ly ≤ 0.167

Then base reaction acts within kern distance - no loss of contact in X-direction,
and:

Pad base pressures:

q1   =  T/Af – 6* My,c / (Lx*Af) +
6* Mx,c / (Ly*Af)

q2   =  T/Af – 6* My,c / (Lx*Af) -
6* Mx,c / (Ly*Af)

q3   =  T/Af + 6* My,c / (Lx*Af +
6* Mx,c / (Ly*Af)

q4   =  T/Af + 6* My,c / (Lx*Af - 6*
Mx,c / (Ly*Af)

Max base pressure:

qmax  
 
=
 
 

max (q1, q2, q3, q4)

Else base reaction acts outside kern distance - loss of contact.

In this case the pressure calculations are more complex - in Tekla Structural
Designer these are done using sets of equations presented in an article by
Kenneth E. Wilson published in the Journal of Bridge Engineering in 1997

Check for Strip Base Bearing Capacity

The principles used in the strip base bearing capacity calculations are similar
to those for pad foundations. Only the direction X is checked (around Y-axis)
using segment widths.

If abs(eTx) / Lx ≤ 0.167

Then - no loss of contact, and:

max base pressures for segment:

qmax   =  T/Af + max[- 6* My,c /
(Lx*Af) , 6*My,c / (Lx*Af)]

Else - loss of contact and

max base pressures for segment:

qmax   =  2*T/[3* Ly* (Lx /2 -
abs(eTx))]
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where

Ly = segment width

Design for shear (pad and strip base:ACI 318)

Pad base shear design check

The nominal shear strength of the concrete in beam action, is given by1

vn   =  2*λ*MIN(√(f`c),
100psi)*d

   =  0.17*λ*MIN(√
(f`c) ,8.3MPa)*d

where

λ   =  modification factor
related to the density of
the concrete

λ   =  1.0 for normal weight
concrete

If

vu   ≤  Φshear*vn

Then the foundation thickness is adequate for shear -

Utilization ratio is then;

U-ratio   =  max [ vu / (Φshear*vn) ]

Else the check has failed, the foundation thickness is inadequate.

NOTE If the thickness is inadequate and the auto-design footing depth
option is active then the foundation thickness gets increased.

Strip base shear design check

The principle of the strip base shear design check is similar to that for the pad
base. Only the direction X is checked (around Y-axis) using segment widths.

Check for transfer forces at column base (pad and strip base:ACI 318)

This check applies when a concrete column is attached to the foundation.

Determinate the bearing strength of the column:

1 ACI 318-08 Sections 11.1.2 and 11.2.1.1 Eqn (11-3)
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Φ*Pnb,c  
 
=
 
 

Φbearing (0.85*f’c * Ac)

If   
Φ*Pnb,c  

 
<
 
 

- Pu

Then check fails
Else determinate the bearing strength of the footing:
Φ*Pnb,f  

 
=
 
 

min [√(A2/Ac), 2] * Φbearing (0.85*f’c * Ac)

where for rectangular columns:
A2  

 
=
 
 

min {Lx , 2tftg + lx+ min [(Lx-lx)/2 - abs(ex), 2tftg]} *
min {Ly , 2tftg + ly + min [(Ly-ly)/2 - abs(ey), 2tftg]}

NOTE Circular columns are treated as square members with the same area.

If

Φ*Pnb,f  
 
<
 
 

- Pu

Then check fails

Required min. area of dowel bars between column and footing is then:1

As,min  
 
=
 
 

0.005*Ac

Currently dowel bars are not designed.
The area of the provided column reinforcement As,prov,column is the same as
the provided reinforcement of starter/dowel bars.
If   
As,min  

 
>
 
 

As,prov,column

Then check fails
1: ACI 318-08 Section 15.8.2.1
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Check for transfer of horizontal forces by shear friction (pad and strip base:ACI
318)

This check applies when a concrete column is attached to the foundation.

Determinate if the shear-friction design method applicable1:

When surface is not intentionally roughened (conservative assumption)

If Vu ≤ Φshear * Ac min(0.2*f’c , 800psi) for US units

 Vu ≤ Φshear * Ac min(0.2*f’c , 5.5MPa) for metric units

 where  
 Vu = max[abs(Fy,sup,u) , abs(Fx,sup,u)]

Then maximum shear transfer is permitted at the base of the column.

Required area of dowel reinforcement:

Avf   =  Vu / (fy * Φshear*μ)

where

μ = 0.6 when concrete not intentionally roughened (assumption)

μ = 1.0 when concrete intentionally roughened

μ = 1.4 when concrete placed monolithically

Currently dowel bars are not designed.

The area of the provided column reinforcement As,prov,column is the same as
the provided reinforcement of starter/dowel bars.

If

Avf   >  As,prov,column

Then check fails

Check for overturning forces (pad and strip base:ACI 318)

NOTE Checks for overturning forces are beyond scope in the current release
of Tekla Structural Designer.

1 ACI 318-08 Section 15.8.2.1
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Check for sliding (pad and strip base:ACI 318)

The check for sliding is carried out for pad foundations only.

If there is no horizontal force acting on foundation check for sliding is not
required.

Resultant Force on foundation:

Hd = √[(Fx,sup)2 + (Fy,sup)2]

Resultant Force Angle αHd = tan-1 [(Fy,sup / Fx,sup)]

where

Fx,sup = horizontal force acting on support in X-dir. (from analysis)

Fy,sup = horizontal force acting on support in Y-dir. (from analysis)

Resistance to sliding due to base friction:

Hfriction = [-P + Fswt] * tanδ

where

δ = design base friction – user input

Passive pressure coefficient:

Kp = (1+sinΦ’) / (1-sinΦ’)

where

Φ’ = design shear strength of soil – user input

Passive resistance of soil in X direction:

Hxpas = 0.5*Kp*(h2 +2*h*hsoil)*Lx* ρsoil

Passive resistance of soil in Y direction:

Hypas = 0.5*Kp*(h2 +2*h*hsoil)*Ly* ρsoil

Resultant Passive Resistance:

Hres,pas = abs(Hxpas*cos αHd) + abs(Hypas*sin αHd)

Total resistance to sliding:

RHd = (Hfriction + Hres,pas) / 1.5

If

RHd ≥ Hd

The check for stability against sliding passes
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Check for uplift (pad and strip base:ACI 318)

For combinations producing tension at the support, the tension value is
compared to the stabilizing loads and checked against a factor of safety (FOS).

Auto-design can automatically increment the base size to achieve a passing
status.

The FOS considered for the uplift check is specified under Design Options >
Concrete > Foundations > Isolated Foundations > General Parameters (default
value = 1.50).

Checks for limiting parameters (pad and strip base: ACI 318)

Limiting reinforcement parameters are specified in Design Options >
Foundations > Isolated Foundations > Reinforcement Layout

Limits on bar size and reinforcement quantities

For structural foundations of uniform thickness the minimum areaof tensile
reinforcement shall be:

For metric units:

IF Grade 280 to 350 deformed bars are used

As,min,reqd   ≥  b*h*0.0020

IF Grade 350 to 420 deformed bars or welted wire reinforcement are used

As,min,reqd   ≥  b*h*0.0018

IF yield stress exceeds 420 MPa

As,min,reqd   ≥  b*h* [MAX(0.0014 ,
0.0018*420/fy)]

For US-units:

IF Grade 40 to 50 deformed bars are used

As,min,reqd   ≥  b*h*0.0020

IF Grade 50 to 60 deformed bars or welted wire reinforcement are used

As,min,reqd   ≥  b*h*0.0018

IF yield stress exceeds 60000 psi

As,min,reqd   ≥  b*h*[MAX(0.0014 ,
0.0018*60000/fy)]

where   
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b   =  unit width

The maximum area of tensile reinforcement shall be:

As,ma
x

 
 
≤
 
 

0.85*(f`c/fy)*β1*b*d*(3/7)

where   
Ag  

 
=
 
 

the gross area of the concrete section

V  
 
=
 
 

stress block depth factor1

1: ACI 318-08, ACI 318-11, ACI 318M-08 and
ACI 318M-11 Section 10.2.7.3

metric-units

β1  
 
=
 
 

0.85 for f`c ≤ 28Mpa

  
 
=
 
 

0.85 – 0.05 *[(f'c – 28MPa)/7MPa] for 28MPa < f`c < 55Mpa

  
 
=
 
 

0.65 for f`c ≥ 55MPa

US-units

β1  
 
=
 
 

min(max(0.85 - 0.05 ´ (f'c - 4 ksi) / 1ksi, 0.65), 0.85)

  
 
=
 
 

0.85 for f`c ≤ 4000 psi

  
 
=
 
 

0.85 – 0.05 *[(f'c – 4ksi)/1ksi] for 4000 psi < f`c < 8000psi
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=
 
 

0.65 for f`c ≥ 8000 psi

Pile cap design to ACI 318

The forces acting on a pile cap are applied to the foundation at the foundation
level. The foundation can take axial load and bi-axial shear and moment.

Pile cap design is divided between pile design (pile capacity check) and
structural design of the pile cap which includes bending, shear and punching
shear design checks.

Pile capacity (ACI 318)

The pile capacity is compared to the axial service load acting on pile:

Pile capacity passes if:

Rc   ≥  Pn ≥ - Rt

Where:
Rc   =  Pile compression

capacity (service)
Rt   =  Pile tension capacity

(service)
Pn   =  Pile load

Design for bending (pile cap:ACI 318)

The pile cap is treated as a beam in bending, where the critical bending
moments for the design for the bottom reinforcement are taken at the face of
the column.

The basic design method is identical to that for beams - see:Design for
bending for rectangular sections (beams and slabs: ACI 318) (page 1738)

Shear design (pile cap: ACI 318)

Pile shear capacity passes if:

vsu   ≤  Φ vc

and
vsu,d   ≤  Φ vc,d
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for both sides and directions.

Refer to CRSI Design Handbook 2002 - Chapter 13, page 13-18…13-21

Checks for limiting parameters (pile cap: ACI 318)

Limiting reinforcement parameters are specified in Design Options >
Foundations > Isolated Foundations > Reinforcement Layout

Check for distance of pile cap overhang

The check passes if:

min ei  
 
>
 
 

min (emin , emin,user)   

where:   
emin  

 
=
 
 

MAX[230mm, 380mm - 0.5
* lp]

when Rc ≤ 534 kN Metric

emin  
 
=
 
 

MAX[9in, 15in - 0.5 * lp] when Rc ≤ 120 kips US
Customary

     
emin  

 
=
 
 

MAX[230mm, 530mm - 0.5
* lp]

when 534 kN < Rc ≤
1068 kN

Metric

emin  
 
=
 
 

MAX[9in, 21in - 0.5 * lp] when 120 kips < Rc ≤
240 kips

US
Customary

     
emin  

 
=
 
 

MAX[230mm, 685mm - 0.5
* lp]

when 1068 kN < Rc ≤
1779 kN

Metric

emin  
 
=
 
 

MAX[9in, 27in - 0.5 * lp] when 240 kips < Rc ≤
400 kips

US
Customary

     
emin  

 
=
 
 

MAX[230mm, 760mm - 0.5
* lp]

when Rc > 1779 kN Metric
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emin  
 
=
 
 

MAX[9in, 30in - 0.5 * lp] when Rc > 400 kips US
Customary

     
lp  

 
=
 
 

least width/diameter of the pile

Check for minimum pile spacing

Check center to center spacing “s” between piles “i” and “j” in a pile group:

The check passes if:

If sij > min(smin , smin,user)

where

smin,user = user input

smin = max (least width of the pile + 0.6m , 0.9m) for metric units

smin = max (least width of the pile + 2ft. , 3 ft) for US customary units1

Check for maximum pile spacing

Check center to center maximum spacing “s” between piles “i” and “j” in a pile
group:

The check passes if:

If sij < smax,user

smax,user = user input

Other checks

The remaining checks are identical to those for pad bases.

See: Pad Base and Strip Footing Design - Checks for limiting parameters (pad
and strip base: ACI 318) (page 1836).

Seismic Design to ACI 318

Reinforced concrete structures in buildings subjected to earthquake effects
are designed elastically to the strains and displacements both from static and
dynamic forces which they are subjected to. It is recognised that during an
earthquake the building and its structural elements are very likely to be
exposed to displacements well into their inelastic range and special
precautions need to be taken as to increase the strength of critical sections in

1 CRSI – Design handbook page 13-18
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members which contribute to the building's lateral resistance while also
contributing to the ductile behaviour of the building in order to allow for the
dissipation of induced stresses.

In the case of reinforced concrete structures, particular design and detailing
requirements (provisions) need to be fulfilled beyond the conventional design
of the elements as to provide them with ductile response capabilities. Such
requirements are mainly addressed to structural elements part of structural
systems built for the purpose of resisting seismic lateral forces - Seismic Force
Resisting Systems [SFRS]. Seismic provisions also apply to reinforced concrete
elements not part of the SFRS when the building is assigned to a higher
Seismic Design Category - SDC D, E or F.

The seismic design checks and detailing requirements of reinforced concrete
members in Tekla Structural Designer are based mainly on ACI318, Chapter 21
- Earthquake-Resisting Structures.

Seismic Force Resisting Systems

The level of design and detailing required of members that are part of a
seismic resisting structural system can differ depending on the amount of
toughness they are intended to provide to the building. ACI318-11 groups the
main structural systems into "Ordinary", "Intermediate" and "Special" groups.
Different types of structural systems have limitations to their application in
each of the Seismic Design Categories.

Structural System Allowed in SDC
Ordinary Moment Frames A, B
Ordinary Cast in Place Structural
Walls

A, B, C

Intermediate Moment Frames A, B, C
Intermediate Precast Walls A, B, C
Special Moment frames A, B, C, D, E, F
Special Structural Walls (Precast / Cast
in Place)

A, B, C, D, E, F

As the current release of Tekla Structural Designer does not fully include the
design requirements for all the Seismic Force Resisting Systems, SFRS types
have been classified as included or excluded from the member design.

Members in included SFRS types are fully covered for seismic design
provisions while those in excluded types are covered to a limited extent only.

• Seismic Force Resisting Systems included in the design:

• Intermediate Moment Frames

• Ordinary Moment Frames

• Ordinary Reinforced Concrete Structural Walls

• Seismic Resisting Systems excluded from the design:
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• Special Moment Frames

• Special Reinforced Concrete Structural Walls

• Intermediate Precast Structural Walls

Consequently the current release of Tekla Structural Designer can be said to
consider the design requirements for each of the Seismic Design Categories as
follows:

Seismic Design Category Seismic Requirements
SDC A N/A
SDC B Considered
SDC C Considered
SDC D, E, F Not Considered

Materials

Additional seismic material requirements apply to:

• concrete beams and columns assigned to a Special Moment Frame SFRS

• concrete walls assigned as Special Reinforced Concrete Structural Walls

Concrete Compressive Strength

The requirements for compressive strength of concrete are limited:

Minimum
compressive
strength of
normal weight
concrete

f'c  
 
=
  

21 MPa (3,000 psi)

Maximum
compressive
strength of
lightweight
concrete

f'c  
 
=
  

35 MPa (5,000 psi)

Reinforcement Steel

Reinforcement steel shall comply with ASTM 706(M), Grade 420 (60,000 psi).

(fy)actual - (fy)specified   ≤  125 MPa (18,000 psi)

(fu)actual / (fy)actual   ≥  1.25

where,

(fy)actual   =  Actual yielding strength
of the reinforcement
based on mill tests, MPa
(psi)

Design codes reference 1842 US codes



(fy)specified   =  Specified yield strength
of reinforcement, MPa
(psi)

(fu)actual   =  Actual ultimate tensile
strength of the
reinforcement, MPa (psi)

Reinforcement Characteristic Yield Strength

Requirements for the characteristic yield strength of the reinforcement steel
are:

• Maximum allowed characteristic yield strength of longitudinal
reinforcement: fy = 420 MPa (Grade 60 - 60,000 psi);

• Maximum allowed characteristic yield strength of shear reinforcement: fyt =
420 MPa (Grade 60 - 60,000 psi);

References ACI 318

1. American Concrete Institute. Building Code Requirements for Structural
Concrete (ACI 318-08) and Commentary. ACI 2008.

2. American Concrete Institute. Building Code Requirements for Structural
Concrete (ACI 318M-08) and Commentary. ACI 2008.

3. American Concrete Institute. Building Code Requirements for Structural
Concrete (ACI 318-11) and Commentary. ACI 2011.

4. American Concrete Institute. Metric Building Code Requirements for
Structural Concrete (ACI 318M-11) and Commentary. ACI 2011.

5. American Concrete Institute. Building Code Requirements for Structural
Concrete (ACI 318-14) and Commentary. ACI 2014.

6. American Concrete Institute. Metric Building Code Requirements for
Structural Concrete (ACI 318M-14) and Commentary. ACI 2014.

Vibration of floors to DG11
These topics describe the DG11 floor vibration calculations that can be
performed in Tekla Structural Designer.

The following topics are covered:

• Introduction to DG11 floor vibration (page 1844)

• Scope of DG11 floor vibration (page 1844)

• Limitations and Assumptions of DG11 floor vibration (page 1845)

• Design philosophy of DG11 floor vibration (page 1846)
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• Design for walking excitation DG11 (page 1849)

• Sensitive use analysis DG11 (page 1855)

• Input requirements for DG11 floor vibration (page 1859)

Introduction to DG11 floor vibration
This handbook describes the DG11 floor vibration calculations that can be
performed in Tekla Structural Designer.

With the advent of long span floors, multiple openings in webs, minimum floor
depth zones etc. the vibration response of floors in multi-storey buildings
under normal occupancy has increasingly become of concern to clients and
their Engineers and Architects.

Detailed guidance on the subject is available through the AISC Steel Design
Guide Series 11: Vibrations of Steel-Framed Structural Systems Due to Human
Activity Second Edition, otherwise referred to as DG11. (page 1863)

This handbook describes the method for the assessment of floor vibration in
accordance with DG11 that has been adopted in Tekla Structural Designer. The
method seeks to establish, with reasonable accuracy, the response of the floor
to dynamic excitation expected in offices of normal occupancy. This excitation
is almost solely based on occupants walking. With appropriate design criteria,
the approach is likely to be equally applicable to sectors other than offices.

The existing solution to checking this type of criterion - a simple calculation of
the natural frequency of an individual beam - is felt in many cases to be
insufficiently accurate. More importantly, such calculations do not consider
two important factors,

• the natural frequency is only the 'response side' of the equation. The
'action' side of the equation is also important i.e. the dynamic excitation -
this is the activity that might cause an adverse response from the floor.
Walking, dancing and machine vibration are all on the 'action' side of the
equation and are all very different in their potential effect.

• the natural frequency of an isolated beam is exactly that and takes no
account of the influence (good or bad) of the surrounding floor
components. In particular, with composite floors, the slabs will force other
beams to restrict or sympathize with the beam under consideration.

The culmination of the calculations carried out by Tekla Structural Designer is
the calculation of the peak acceleration of the floor system due to walking
excitation expressed as a fraction of the acceleration of gravity.

Scope of DG11 floor vibration
The reference upon which Tekla Structural Designer's floor vibration check is
based is the main limiting factor with regard to scope. This publication is AISC
Steel Design Guide Series 11: Vibrations of Steel-Framed Structural Systems
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Due to Human Activity Second Edition, otherwise referred to as DG11.
(page 1863)

You are able to define an area on a particular floor level that is to be subject to
the vibration response analysis and design. The layout of beams in real multi-
story buildings can be of almost any configuration. The methodology
adopted in DG11 is only applicable to regular structures which by and
large have to be created from rectilinear grids. It is your responsibility to
make an appropriate selection of the beams etc. that are to be the basic
components of the idealized case.

As you proceed through the input making your selections, Tekla Structural
Designer will, where it is possible to do so, interrogate the underlying model
and retrieve the appropriate data. Once all the data has been assembled, you
are then able to perform the check, after which a detailed set of results will be
available for review. If you are unhappy with the outcome of your choices you
can close the results window and make alternative selections by editing the
Floor Vibration Check item properties.

Limitations and Assumptions of DG11 floor vibration
The scope is primarily defined by the DG11 (page 1863) but the following
additional limitations and assumptions should be noted.

• The design guidance is based on composite floors acting compositely with
the steel beams. It is unclear whether the design approach is directly
applicable to non-composite construction.

• In DG11, if the slab is attached to the supporting member, the construction
can be classed as composite for the purpose of carrying out a vibration
analysis even in the absence of shear connectors. Tekla Structural Designer
does not define such construction as composite and therefore will only
class truly composite construction as composite.

• For simplicity and to avoid the necessity of Tekla Structural Designer having
to identify all the beams in the area selected for vibration assessment, the
component of the unit mass from the self-weight of the beams is ignored.
This will lead to a slight inaccuracy in the participating mass that is
conservative (more mass is advantageous). Note, however, that beam self-
weight is included in the calculation of beam deflection but only when the
self-weight loadcase is included in the load combination.

• Cantilever beams are excluded from the analysis.

• In DG11, if a beam or girder is moment connected to a column, its natural
frequency can be enhanced because of the flexural restraint offered by the
columns. Tekla Structural Designer does not incorporate this feature.

• Shear deflection in beams and girders is included in the analysis carried
out by Tekla Structural Designer.

• Precast slabs are excluded.
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Design philosophy of DG11 floor vibration

General

The Engineer ensures the safety of building occupants by satisfying all design
criteria at the Ultimate Limit State. Similarly, the health of building occupants is
partly taken care of when deflection limits at the Serviceability Limit State are
satisfied (although this Limit State does have other purposes than simply the
health of occupants).

However, for floors that are subject to cyclic or sudden loading, it is the human
perception of motion that could cause the performance of a floor to be found
unsatisfactory. Such perception is usually related to acceleration levels. In
most practical building structures, the reaction of the occupants to floor
acceleration varies between irritation and a feeling of insecurity. This is based
on the instinctive human perception that motion in a 'solid' building indicates
inadequacy or imminent failure.

The working environment also affects the perception of motion. For busy
environments, where the occupant is surrounded by the activity that is
producing the vibrations, the perception of motion is reduced. In contrast, for
quieter environments (such as laboratories and residential dwellings), where
the source of vibration is unseen, the perception of motion is significantly
heightened.

The design philosophy to ensure that the potential for such human response
is minimized, has a number of facets,

• the dynamic excitation causing the vibration i.e. the disturbing force
profile, which is force and time dependent. For the sorts of building and
occupancy considered here, this is the act of walking.

• the acceptance criteria. This depends upon the type of environment. As
discussed above this, in turn, depends upon the involvement of the
occupant in the generation of the vibration and also on the nature of the
occupancy. The latter is important for laboratories carrying out delicate
work, or operating theaters, for example.

• the provided performance. This is the "resonance response function" and
is dependent on the system natural frequency and, more importantly, the
participating mass. This function is expressed as a ratio of the floor
acceleration to the acceleration of gravity.

Dynamic excitation

In a classical spring-mass system that includes a (viscous) damper, when a
simple force is applied to the mass to extend (or contract) the spring, the mass
moves up and down (oscillates). This movement is significant at first but
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eventually reduces to zero due to the resistance offered by the damper. In a
floor system in a building,

• the mass is the self-weight of the floor and any other loading that is
present for the majority of the time that the occupants could be exposed to
vibration effects,

• the spring is the stiffness of the floor system, which will have a number of
different component beams (joists and girders) and the floor slab,

• the damper is provided by a number of elements that are able to absorb
energy from the free vibration of the system. There will be energy
absorbed,

• within connections, since they behave 'better' than the ideal that is
assumed

• from losses due to the unsymmetrical nature of real buildings e.g. grid
layout, and dispersion of loads from furnishings and contents

• from components such as partitions that are out-of-plane of the
vibration and interfere with the 'mode'.

The determination of the contribution of each of these components as they
affect real floor systems is given in detail in later sections. These describe the
'response' side of the floor system. In order to establish the required
performance of the system the 'input' must also be defined i.e. that event,
events or continuum that is the 'dynamic excitation'.

In the simple example described at the start of this section the 'input' was
simply a force that caused a displacement to the system and was then
released. This might be equivalent to a person jumping off a chair onto the
floor. However, in the context of the concerns over the vibration of floors, it is
not this sort of input that is of interest. The main concern is the excitation of
the floor brought about by walking.

Unlike the simple example, walking produces loading that is cyclic. This loading
can be idealized into a series of sine curves of load against time. Each curve is
an exact multiple of the walking frequency called harmonics. When one of
these harmonics of the cyclic loading coincides with the natural frequency of
the floor system then resonance is set up. The consequence of resonance that
is detected, and may disturb occupants, is the associated peak acceleration.
The peak acceleration due to walking is estimated by selecting the lowest
harmonic for which the forcing frequency can match a natural frequency of
the floor and is dependent upon the applied force (a constant = 0.29kN [65lb]
for floors), the mass of the system (the self-weight of the floor plate plus other
loading that could be considered as permanent), and the amount of damping
in the system (the damping ratio, β).

Hence, the dynamic excitation of a floor is dependent upon the forcing
function due to walking and its relationship to the natural frequency of the
floor system. It is the level of the peak acceleration that this generates that is
particularly important in determining the performance of the floor.
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Acceptance criteria for human comfort

The required performance of a floor system is very dependent upon the
potential response of humans. Human response is a very complex subject
since there is no such thing as a 'standard human'. The perception of vibration
will differ from person to person, their body mass varies significantly and the
body's reaction will depend upon age, gender etc. The human response has
been studied and the acceptance criterion adopted by DG11 was developed
using the acceleration limits as recommended by ISO 2631-2, 1989 adjusted
for intended occupancy.

The accelerations acceptable for different use of buildings are described using
the 'base' limits. Multiplying factors are used to increase the base acceleration
limit according to the intended use of the building. The target acceleration
ratio of the floor under consideration is given in DG11 guidance as,

• ao/g = 0.5% for offices, residences, churches, schools and quiet areas

• ao/g = 1.5% for shopping malls

You should choose a required acceleration ratio based on both engineering
judgement and the advice given in DG11.

A separate acceleration ratio limit for high frequency floors (i.e. those floors
with fundamental frequency, fn, in the range 9 < fn <= 15 Hz) also needs to be
defined by the Engineer, again based on engineering judgement and with
reference to DG11 figure 2-1

Design for walking excitation

The start point is the calculation of the natural frequency of the floor system.
The fundamental floor frequency, fn, is evaluated using the Dunkerley
relationship for the combined mode.

In accordance with the guidance given at Section 4.1 of DG11, an advisory
Warning is displayed when the fundamental frequency of the floor system, fn,
is < 3.0 Hz.

Next the 'Equivalent Panel Weight' is required. This is dependent upon the
physical size of the floor plate selected and an effective width and/or length.

The calculation requires the 'damping ratio' - this is a user input.

The damping ratio, the effective panel weight, the fundamental frequency of
the floor and the constant excitation force are used to calculate the peak
acceleration ratio, ap/g.

The design condition is simply,

ap/g ≤ ao/g

For floors with high fundamental frequencies, when the calculated value of fn
is in the range 9 Hz < fn ≤ 15 Hz, then an equivalent sinusoidal peak
acceleration, aESPA, is checked against the separate acceleration ratio limit for
high frequency floors.
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Design for walking excitation DG11

Floor slab

Slab Properties

For composite slabs the transformed moment of inertia per unit width of the
slab, Ds, is calculated from,

Ds  
=
 

de
3 /(12*n)  

 mm4/mm in
metric units

Ds  
=
 

12*de
3/(12*n)  

 ins4/ft in US
Customary
units

Where    
de  

 
=
  

effective depth of slab taken as slab
depth less one half depth of steel
decking (mm or inches)

n  
 
=
  

dynamic modular
ratio

 

  
 
=
  

Es /(1.35*Ec )  

Es  
 
=
  

the steel modulus
(N/mm2 or ksi)

 

Ec  
 
=
  

the concrete
modulus (N/mm2

or ksi)

 

For generic slabs, the transformed moment of inertia per unit width is to be
provided by the user.

Beam panel mode

Beam Panel Mode Deflection

The beam panel mode deflection, Δj, is the maximum simply supported
deflection of the beam or joist calculated using,

Δj   =  5 * ((w*b)+wswt ) * Lj
4 /

(384*Es *Isj)

where   
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w   =  unit supported weight
(psi or N/mm2 )

b   =  beam or joist spacing (in
or mm)

wswt   =  beam or joist self weight
(zero unless self weight
loadcase in combination)
(pli or N/mm)

Lj   =  span of beam or joist (in
or mm)

Es   =  steel modulus (psi or
N/mm2 )

Isj   =  the inertia of the beam
or joist from the
database (in4 or mm4)

Beam Panel Mode Frequency

The beam panel mode fundamental frequency, fj, is given by,

fj   =  0.18*√(g/Δj) Hz

Where  
g   =  the acceleration of

gravity
Δj   =  the maximum simply

supported deflection of
the beam or joist
calculated as above.

Beam Panel Mode Effective Weight

The effective panel weight for the beam panel mode, Wj, is given by,

Wj   =  kj *w*Bj *Lj

Where   
kj   =  beam continuity factor

   =  1.0 generally but 1.5
where beams are
continuous over
supports and an
adjacent span is > 0.7*Lj

w   =  unit supported weight
(see Data Derived from
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Tekla Structural
Designer (page 1859))

Bj   =  the effective width of the
beam panel

   =  Cj *(Ds /Dj )0.25 *Lj but ≤
(2/3)*FW

Lj   =  the span of the beam

and   
Cj   =  effective width

coefficient for beam
   =  2.0 generally but 1.0 for

beams parallel to
interior edge

Ds   =  transformed moment of
inertia of slab per unit
width as above

Dj   =  transformed moment of
inertia of beam per unit
width

   =  Ij /S

S   =  beam spacing
FW   =  floor width
   =  ng *Lg

ng   =  number of bays in the
direction of the girder
span.

Lg   =  the span of the girder

Girder panel mode

Girder Panel Mode Deflection

The girder panel mode deflection, Δg, is the maximum girder deflection
derived from the analysis model.

NOTE As Δg is taken directly from load analysis there is no need for any adjustment
to the girder deflection, as suggested in DG11 section 3.1, when there is only
one supported beam.

Girder Panel Mode Frequency

The girder panel mode fundamental frequency, fg, is given by,

fg   =  0.18*√(g/Δg) Hz
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Where  
g   =  the acceleration of

gravity
Δg   =  the maximum simply

supported deflection of
the girder derived from
the analysis model.

Girder Panel Mode Effective Weight

The effective panel weight for the girder panel mode, Wg, is given by,

Wg   =  kg * w *Bg * Lg

W
h
e
r
e

  

k
g

  =  girder continuity factor

   =  1.0 generally but 1.5 where girders
are continuous over supports and an
adjacent span is > 0.7*Lg

w   =  unit supported weight (see Data
Derived from Tekla Structural
Designer (page 1859))

B
g

  =  the effective width of the girder panel

For the general case,

Bg   =  Cg *(Dj /Dg)0.25 *Lg but ≤
(2/3)*FL

If the girder is an interior edge girder as specified by the user,

Bg   =  Lj*(2/3)

Where   
Lg   =  the span of the girder

Cg   =  effective width
coefficient for beam

   =  1.8 generally but 1.6 for
girders supporting joists
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connected to the girder
flange (joist seats)

Dj   =  transformed moment of
inertia of beam per unit
width as above

Dg   =  transformed moment of
inertia of girder per unit
width

   =  Ig/Lj generally but

   =  2*( Ig/Lj) for edge girders

FL   =  floor length
   =  nj *L j
nj   =  number of bays in the

direction of the beam
span.

If the girder supports beams with unequal spans, say Lj1 and Lj2, the average
beam span length Lav = (Lj1+Lj2)/2 should replace Lj in the above equation for
Dg. The user should confirm the value to be used in such circumstances.

Combined panel mode

There are three possible conditions is to be checked for the combined mode.

If Lg/Bj > 1.0, the combined equivalent panel weight, Wcomb, is given by,

Wcomb   =  (Δj/(Δj+Δ g))*Wj + (Δg/(Δj
+Δg))*Wg

   
The floor fundamental frequency, fcomb, is given by

   
fcomb   =  0.18*√g/(Δj+Δg)

   
If 0.5 ≤ Lg/Bj ≤ 1.0, the combined equivalent panel weight, Wcomb, is given by,

   
Wcomb   =  (Δj/(Δj+Δ gred))*Wj +

(Δgred /(Δj+ Δgred))*Wg

   
The floor fundamental frequency, fcomb, is given by

   
fcomb   =  0.18*√g/(Δj+ Δgred)
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Where   
Δgred   =  (Lg/Bj)* Δg

   
If Lg/Bj < 0.5, the combined equivalent panel weight, Wcomb, is given by,

   
Wcomb   =  (Δj/(Δj+Δ gred))*Wj +

(Δgred /(Δj+ Δgred))*Wg

   
The floor fundamental frequency, fcomb, is given by

   
fcomb   =  0.18*√g/(Δj+ Δgred)

   
Where   
Δgred   =  0.5* Δg

In addition, if Lj/Lg < 0.5, then the peak acceleration ratio is separately checked
for the beam panel mode and for the combined panel mode as above.

Evaluation

The peak acceleration ratio, ap/g, is evaluated for each fn in turn (with its
associated W), and is given by,

ap/g   =  MAX[100*P0*e(-0.35*fn)/
(β*W)] %

where

fn   =  fj, fg, fcomb

W   =  the value of Wj, Wg or
Wcomb appropriate to fn

P0   =  constant force equal to
0.290 kN [65lb]

β   =  damping ratio

The acceleration limit, ao/g, is a user input and leads to the final design
condition,

ap/g   ≤  ao/g

NOTE The ‘fundamental frequency of the floor’ output in the results is the fn
associated with the MAX peak acceleration ratio (and not just the MIN fn).
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High Frequency Floors

For floor systems having a natural frequency greater than 9 Hz (but ≤ 15 Hz ),
the equivalent sinusoidal peak acceleration ratio, aESPA/g, is given by

aESPA/g  
 
=
  

MAX[100*(154 /
W)*(fstep

1.43/
fn

0.3)*{[1-
e(-4*π*h*β)]/
(h*π*β)}0.5] %

US-units

  
 
=
  

MAX[100*(686 /
W)*(fstep

1.43/
fn

0.3)*{[1-
e(-4*π*h*β)]/
(h*π*β)}0.5] %

metric-units

where

W   =  the value of Wj, Wg or
Wcomb appropriate to fn

fstep   =  footstep frequency Hz

fn   =  fundamental frequency
of the floor

h   =  the harmonic matching
fn

   =  5 for 9 Hz < fn ≤ 11 Hz

   =  6 for 11 Hz < fn ≤ 13.2 Hz

   =  7 for 13.2 Hz < fn ≤ 15 Hz

β   =  damping ratio

NOTE The aESPA/g equation assumes a bodyweight value of 168 lbs [0.75 kN] as
indicated in DG11.

The acceleration limit for high frequency floors is a user input and leads to the
final design condition,

aESPA/g    ≤  acceleration limit for
high frequency floors

Sensitive use analysis DG11
The vibration check calculations can be performed for sensitive equipment &
occupancy if required.
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These calculations make use of Chapter 6 of DG11 2nd Edition (2016) with
revisions and errata of 27 July 2018. They only cover ⅓ octave spectral velocity
and acceleration.

For these calculations the mode shape factors ɸE and ɸW are taken as 1.0. i.e. it
is conservatively assumed that the walker and sensitive equipment or
sensitive occupant are both at mid-bay.

Use Case - Sensitive Equipment

If walking speed = Very Slow ,

fstep  
=
 

1.25 Hz  
 [Table 6-1]

V1/3  
=
 

(250 * 106) / (β
* W) *
(fstep

2.43 / fn
1.8)

* (1 -
e-2*π*β*fn /

fstep)

 
 [Eqn 6-3a]

A1/3/g  
=
 

(100 * 4.2) / (β
* W) *
(fstep

2.43 / fn
0.8)

* (1 -
e-2*π*β*fn /

fstep)

 
 [Eqn 6-8a]

Else if walking speed = Slow , or Moderate or Fast

fstep , fL , fU and γ as appropriate to selected
walking speed

 
 [Table 6-1]

If fn ≤ fL

V1/3  
=
 

(175 * 106) / (β
* W * fn

0.5) *
(e-γ*fn)

 
 [Eqn 6-3b]1

A1/3/g  
=
 

(100 * 6.4) / (β
* W) * (e-γ*fn)

 
 [Eqn 6-8b]1

If fn ≥ fU

V1/3  
=
 

(250 * 106) / (β
* W) *
(fstep

2.43 / fn
1.8)

* (1 -

 
 [Eqn 6-3b]2
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e-2*π*β*fn /

fstep)
A1/3/g  

=
 

(100 * 4.2) / (β
* W) *
(fstep

2.43 / fn
0.8)

* (1 -
e-2*π*β*fn /

fstep)

 
 [Eqn 6-8b]2

Else if fL < fn < fU

For V1/3

1. evaluate [Eqn 6-3b]1 with fn = fL , then

2. evaluate [Eqn 6-3b]2 with fn = fU , then

3. linear interpolate for actual fn

For A1/3/ g

1. evaluate [Eqn 6-8b]1 with fn = fL , then

2. evaluate [Eqn 6-8b]2 with fn = fU , then

3. linear interpolate for actual fn

Use Case - Sensitive Occupancy

NOTE DG11 2nd Edn does not provide explicit ⅓ octave spectral Acceleration
equations for Sensitive Occupancy, so in Tekla Structural Designer
these equations have been derived from the ⅓ octave spectral
Acceleration equations for Sensitive Equipment by ‘modifying’ them
by factors 200/250 (for very slow walking) and 120/175 (for other
walking speeds).

These modification factors are derived from consideration of the
differences between ⅓ octave spectral Velocity equations for Sensitive
Equipment and Sensitive Occupancy, which are given explicitly in
DG11 2nd Edn.

If walking speed = Very Slow ,

fstep  
=
 

1.25 Hz  
 [Table 6-1]

V1/3  
=
 

(200 * 106) / (β
* W) *
(fstep

2.43 / fn
1.8)

* (1 -
e-2*π*β*fn /

fstep)

 [Eqn 6-9a]
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A1/3/g  
=
 

(200/250)*(10
0 * 4.2) / (β *
W) * (fstep

2.43 /
fn

0.8) * (1 -
e-2*π*β*fn /

fstep)

 [Eqn 6-8a]
modified

Else if walking speed = Slow , or Moderate or Fast

fstep , fL , fU and γ as appropriate to selected
walking speed

 
 [Table 6-1]

If fn ≤ fL

V1/3  
=
 

(120 * 106) / (β
* W * fn

0.5) *
(e-γ*fn)

 
 [Eqn 6-9b]1

A1/3/g  
=
 

(120/175)*(10
0 * 6.4) / (β *
W) * (e-γ*fn)

 [Eqn 6-8b]1

modified

If fn ≥ fU

V1/3  
=
 

(200 * 106) / (β
* W) *
(fstep

2.43 / fn
1.8)

* (1 -
e-2*π*β*fn /

fstep)

 
 [Eqn 6-9b]2

A1/3/g  
=
 

(200/250)*(10
0 * 4.2) / (β *
W) * (fstep

2.43 /
fn

0.8) * (1 -
e-2*π*β*fn /

fstep)

 [Eqn 6-8b]2

modified

Else if fL < fn < fU

For V1/3

1. evaluate [Eqn 6-9b]1 with fn = fL, then

2. evaluate [Eqn 6-9b]2 with fn = fU , then

3. linear interpolate for actual fn
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For A1/3/ g

1. evaluate [Eqn 6-8b]1 modified with fn = fL , then

2. evaluate [Eqn 6-8b]2 modified with n = fU , then

3. linear interpolate for actual fn

Input requirements for DG11 floor vibration

General

The simplified method for the analysis of the vibration of floors given in the
AISC Publication DG11, on which on which the Tekla Structural Designer check
is based, is only applicable to regular structures which, by and large, are
created from rectilinear grids.

Of course the floor layouts of 'real' multi-storey buildings are rarely uniform
and Tekla Structural Designer therefore provides you with the opportunity to
select the more irregular floor areas to be assessed with grids that are other
than rectilinear.

In so far as the selection of the beams and girders to be used in the analysis is
concerned, only beams or girders with Non-Composite, Steel Joist or
Composite attributes are valid for selection and, within these confines, the
user should be able to:

• select a single beam or girder

• select a girder span as critical plus an adjoining span (in a two or three
span configuration)

In all cases, and subject to the above restrictions, which beams and girders
from the selected area of floor are chosen is entirely at your discretion and
under your judgement, but it is expected that the beams and girders chosen
will be those that are typical, common or the worst case. Irrespective,Tekla
Structural Designer will take these beams as those that form the idealized
floor layout. There is no validation on what the you select (although there is
some validation on which beams and girders are selectable i.e. those which
have no slab for part of their length, those from angle sections, those with no
adjoining span when a 2-span configuration is chosen, and those with no
adjoining span at both ends when a 3-span configuration is chosen will not be
selectable).

Data Derived from Tekla Structural Designer

Note that, where appropriate, the derived data is for each design combination
under SLS loads only.

Unit supported weight

The unit supported weight is used to establish the 'effective panel weight' -
that is the weight of the floor and its permanent loading that has to be set in
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motion during vibration of the floor. It is taken as the slab self-weight (and to
be accurate, the beam self-weight), other permanent 'Dead' loads and the
proportion of the 'Live' loads (expressed as a percentage) that can be
considered as permanent.

The unit supported weight is obtained by summing all the loads (or the
appropriate percentage in the case of live loads) that act over or in the
selected area. This includes any blanket, area, line and spot loads that are
present within the selected area. The component of any of these load types
that lie outside of the selected area are ignored. Nodal loads directly on
columns are also ignored. The total load is then divided by the area selected.

The slab self-weight will usually be in the Slab Dry loadcase - note that in the
case of composite slabs this includes the weight of decking. The beam self-
weight is in a separate protected loadcase. For simplicity this component of
the unit supported weight is ignored. This leads to a slight inaccuracy in the
participating mass that is conservative (more mass is advantageous).

Note that the use of live load reductions has no effect on the floor vibration
check.

Slab data

If there are more than one set of slab attributes in the selected area then you
have to choose which of these it is appropriate to use. From the designated
slab attributes the following information/data is obtained,

• the transformed inertia in mm4 per mm width [in4/ft].

• the short-term modular ratio for normal or lightweight concrete as
appropriate.

If the designated slab attributes are for a 'generic' slab, then you are asked for
the transformed inertia and the dynamic modular ratio.

Beam data

When these are non-composite beams, the inertia is obtained from the
sections database. When these beams are of composite construction the
inertia is the gross, uncracked composite inertia based on the dynamic
modular ratio that is required. Steel joist inertias from the database are
assumed to be 'gross' inertias of the chords and are editable. Following
guidance contained in AISC Steel Design Guide 11 (page 1863), section 3.5, the
gross steel joist inertia is factored by quantity Cr and displayed as the
'effective' inertia in the results viewer. Cr is derived from the following
formulas,

For joists with angle web members:

Cr  
=
 

0.90*(1 -
e-0.28(L/D))2.8  

≤
 
0
.
9
 

valid for 6 ≤
L/D
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For joists with rod web members:

Cr  
=
 

0.721 +
0.00725*(L/D)  

≤
 
0
.
9
 

valid for 10 ≤
L/D

Where   
L  = Joist span
D  = Joist nominal depth

NOTE There is no guidance in DG11 what to do if L/D < 6 for angle web members or
L/D < 10 for rod web members. Therefore, in these cases Tekla Structural
Designer calculates Cr with L/D = 6 (angle) or L/D = 10 (rod).

The span of the critical/base beam and the adjoining beams is required.

The deflection of the critical beam under the permanent loads is required. To
calculate this value, the deflection under the Dead loads and the appropriate
percentage of the Live load deflection is summed.

Girder data

The same data is required as that for the beams.

Floor plate data

The dimensions of the floor plate in the idealized cases are defined in one
direction by the number of beam bays and in the orthogonal direction by the
number of girder bays. In practice, given that the idealized case may not
attain, the floorplate dimensions are derived from the slab items you select as
participating in the mass.

User Input Data

Secondary Beam Spacing

You must confirm the spacing of the secondary beams - an average value
when the spacing is non-uniform.

Permanent Live Loads

You are required to specify the proportion of the permanent live loads that are
to be used in the vibration analysis as a percentage of the live load.

Beam Continuity Factor

This has a value of either 1.0 or 1.5 and you are offered the choice when a two
or three span beam configuration is selected. The default value is 1.0.

Girder Continuity Factor
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This has a value of either 1.0 or 1.5 and you are offered the choice when a two
or three span girder window is selected. The default value is 1.0.

This factor is not generally applicable for girders as they usually frame directly
into columns and this potential increase in the effective panel weight does not
apply under those circumstances.

Beam and Girder location

You are required to specify whether the beam and the girder under
consideration is an "internal" location or an "internal edge" location. This
information is required to set the constants that are used in calculating the
effective widths of the beam and girder panel modes.

Number of bays used to establish effective panel weight

You are required to specify the number of bays in the direction of the beam
span, nj, and the number of bays in the direction of the girder span, ng, that
are to be used to establish the effective panel weight. The number of bays
ranges from 1 to 4 for both directions.

Damping ratio

Floors do not vibrate as a free mass but have some damping i.e. dissipation of
the energy in the system. Values of the damping ratio for individual
components, βi are recommended in DG11 as,

Recommended Component Damping Values
Component Ratio of Actual Damping-to-Critical Damping, βi

Structural
System

0.01

Ceiling and
ductwork

0.01

Electronic
office fit-out

0.005

Paper office fit
out

0.01

Churches,
schools and
malls

0.0

Lightly
furnished
quiet spaces

0.005

Full-height dry
wall partitions
in bay

0.02 to 0.05*

*Depending on the number of partitions in the bay and their location; near
the center of the bay provides more damping.

Design codes reference 1862 US codes



For example, a floor with ceiling and ductwork supporting an electronic office
area has β = Σβi = 0.01 (floor) + 0.01 (ceiling and ductwork) + 0.005 (electronic
office area) = 0.025, or 2.5% critical damping.

Since an even higher damping ratio might be justified for storage floors for
example, a range of up to 10% is offered.

Acceleration limit

You must enter acceleration limits appropriate to the floor under
consideration, one limit for floors with frequencies in the range 3-9 Hz and a
separate limit for High Frequency floors (in the range 9-15 Hz). These limits will
be based on your engineering judgement and the advice given in DG11 - which
gives a range of values between 0.5% and 5.0% depending on structural form
(for building floors see the table below).

Table 4-1. Recommended Tolerance Limits for Building Floors
Occupancy Acceleration Limit

ao/g x 100%
Offices, residences, churches, schools
and quiet areas

0.5%

Shopping Malls 1.5%

Footstep frequency

You should enter the footstep frequency to be used if a high frequency floor is
detected. The range being 1.2 Hz to 2.2 Hz.

Sensitive use

You have to specify the Use case and walking speed if this analysis is
performed. See: Sensitive use analysis DG11 (page 1855)

Vibration of floors to DG11 references
1. AISC Steel Design Guide Series.11: Vibrations of Steel-Framed Structural

Systems Due to Human Activity Second Edition (2016) with revisions and
errata of 27 July 2018.

14.2 Eurocodes
• Loading (Eurocode) (page 1864)

• Steel design to EC3 and EC4 (Eurocode) (page 1886)

• Concrete design to EC2 (Eurocode) (page 1935)

• Vibration of floors to SCI P354 (page 1989)
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Loading (Eurocode)
This handbook provides a general overview of how loadcases and
combinations are created in Tekla Structural Designer when the head code is
set to the base Eurocode, or Eurocode with a specific National Annex applied.
The Eurocode Combination generator is also described.

The following topics are covered:

• Nationally Determined Parameters (NDP's) (Eurocode) (page 1864)

• Load cases (Eurocode) (page 1871)

• Combinations (Eurocode) (page 1875)

• Minimum lateral load requirements of the Singapore National Annex
(Eurocode) (page 1882)

Nationally Determined Parameters (NDP's) (Eurocode)
The Eurocode has differing NDP’s for the Eurocode (Base) and for each of
Eurocode (UK), Eurocode (Irish) etc. These are defined in the relevant country's
National Annex.

Gamma (γ) factors and psi (Ψ) factors for each National Annex are listed
below:

Combination gamma factors

Factor EC
Base
Value

UK
Value

Irish
Value

Singap
ore

Value

Malay
sia

Value

Finlan
d

Value

Norwa
y

Value

Swede
n

Value
EQU combs
γGj,sup 1.10 1.10 1.10 1.10 1.10 1.10kFl 1.2 1.1γd

γGj,inf 0.9 0.9 0.9 0.9 0.9 0.9 0.9 0.9

γQ (fav) 1.5 1.5 1.5 1.5 1.5 1.5kFl 1.5 1.5γd

STR combs
γGj,sup 1.35 1.35 1.35 1.35 1.35 1.35kFl 1.35 1.35γd

γGj,inf 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0

γQ (fav) 1.5 1.5 1.5 1.5 1.5 1.5kFl 1.5 1.5γd

ξ 0.85 0.925 0.85 0.925 0.925 0.85 0.89 0.89
GEO combs
γGj,sup 1.0 1.0 1.0 1.0 1.0 1.0kFl 1.0 1.1γd

γGj,inf 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0

γQ 1.3 1.3 1.3 1.3 1.3 1.3kFl 1.3 1.4γd
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The kFl factor used in the Finnish National Annex is set by specifying an
appropriate Consequence Class in the Structure Properties (accessed via the
Project Workspace).

• CC3 (high consequence for loss of human life or economic social or
environmental consequences very great)

• CC2 (medium consequence for loss of human life or economic social or
environmental consequences considerable)

• CC1 (Low consequence for loss of human life, economic, social or
environmental consequences small or negligible)

The γd factor used in the Swedish National Annex is set by specifying an
appropriate Reliability Class in the Structure Properties (accessed via the
Project Workspace).

• RC3 (major risk of serious personal injury)

• RC2 (some risk of serious personal injury)

• RC1 (minor risk of serious personal injury)

psi factors

UK, Ireland, Singapore Malaysia

Fac
tor

EC Base
value

UK value Irish value Singapore
value

Malaysia
value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

Cat
ego
ry
A -
im
pos
ed
do
me
stic
/
resi
de
nti
al

0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3

Cat
ego
ry
B -
im
pos
ed

0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3

Design codes reference 1865 Eurocodes



Fac
tor

EC Base
value

UK value Irish value Singapore
value

Malaysia
value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

offi
ce
Cat
ego
ry
C -
im
pos
ed
con
gre
gati
on

0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6

Cat
ego
ry
D-
im
pos
ed
sho
ppi
ng

0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6

Cat
ego
ry
E-
im
pos
ed
sto
rag
e

1.0 0.9 0.8 1.0 0.9 0.8 1.0 0.9 0.8 1.0 0.9 0.8 1.0 0.9 0.8

Cat
ego
ry
H-
im
pos
ed
roo
fs

0 0 0 0.7 0 0 0.6 0 0 0.7 0 0 0.7 0 0

Sn
ow

0.5 0.2 0 0.5 0.2 0 0.5 0.2 0 0.5 0.2 0 0.5 0.2 0
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Fac
tor

EC Base
value

UK value Irish value Singapore
value

Malaysia
value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

Loa
ds
<
100
0m
Sn
ow
Loa
ds
>
100
0m

Sn
ow
sk ≥
2.7
5
kN/
m2

Sn
ow
≥ 2
kN/
m2

ie
loa
ds

(2 ≤
sk <
3
kN/
m2)

0.7 0.5 0.2 0.5 0.2 0 0.5 0.2 0 0.5 0.2 0 0.5 0.2 0

Ice
Loa
ds

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Wi
nd
Loa
ds

0.6 0.2 0 0.5 0.2 0 0.6 0.2 0 0.5 0.2 0 0.5 0.2 0

The
rm
al

0.6 0.5 0 0.6 0.5 0 0.6 0.5 0 0.6 0.5 0 0.6 0.5 0
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Fac
tor

EC Base
value

UK value Irish value Singapore
value

Malaysia
value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

Loa
ds

Nordic Countries

Fact
or

EC Base value Finish value Norwegian
value

Swedish value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

Cate
gory
A -
imp
osed
dom
estic
/
resi
dent
ial

0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3

Cate
gory
B -
imp
osed
offic
e

0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3 0.7 0.5 0.3

Cate
gory
C -
imp
osed
cong
rega
tion

0.7 0.7 0.6 0.7 0.7 0.3 0.7 0.7 0.6 0.7 0.7 0.6

Cate
gory
D-
imp
osed
sho
ppin
g

0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6 0.7 0.7 0.6
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Fact
or

EC Base value Finish value Norwegian
value

Swedish value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

Cate
gory
E-
imp
osed
stor
age

1.0 0.9 0.8 1.0 0.9 0.8 1.0 0.9 0.8 1.0 0.9 0.8

Cate
gory
H-
imp
osed
roof
s

0 0 0 0 0 0 0 0 0 0 0 0

Sno
w
Loa
ds

(<
100
0m)

(1 ≤
sk <
2
kN/
m2)

0.5 0.2 0 0.7 0.4 0.2 0.7 0.5 0.2 0.6 0.3 0.1

Sno
w
Loa
ds >
100
0m

Sno
w sk
≥
2.75
kN/
m2

Sno
w ≥
2

0.7 0.5 0.2 0.7 0.5 0.2 0 0 0 0.7 0.4 0.2
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Fact
or

EC Base value Finish value Norwegian
value

Swedish value

 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2 Ψ0 Ψ1 Ψ2

kN/
m2

ie
load
s

(2 ≤
sk <
3
kN/
m2)
Sno
w
Loa
ds ≥
3kN/
m2

0 0 0 0 0 0 0 0 0 0.8 0.6 0.2

Ice
Loa
ds

0 0 0 0.7 0.3 0 0 0 0 0 0 0

Win
d
Loa
ds

0.6 0.2 0 0.6 0.2 0 0.6 0.2 0 0.3 0.2 0

Ther
mal
Loa
ds

0.6 0.5 0 0.6 0.5 0 0.6 0.5 0 0.6 0.5 0

Seismic phi (Ψ) factors

Nordic countries

An additional phi (Ψ) factor for Seismic design - from BS EN 1998-1 Table 4.2 is
required for creation of the Seismic Inertia Combination. This is defined with
each new imposed or roof imposed loadcase - alongside the psi factors for
each of the load types.

Category Default
for

 Factor φ from BS EN 1998-1 Table 4.2

   EC No
Finnish
NA so use
EC

Norwegia
n

No
Swedish
NA so use
EC
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Category Default
for

 Factor φ from BS EN 1998-1 Table 4.2

A - C Roof
Imposed

Roofs 1.0 1.0 1.0 1.0

A - C Imposed
= A, B, C

Stories
with
correlate
d
occupanci
es

0.8 0.8 1.0 0.8

A - C  Stories
independ
ently
occupied

0.5 0.5 1.0 0.5

D - F Imposed
= D, E

D-F and
Archives

1.0 1.0 1.0 1.0

Load cases (Eurocode)

• Loadcase types (Eurocode) (page 1871)

• Self weight (Eurocode) (page 1872)

• Imposed and roof imposed loads (Eurocode ) (page 1873)

• Imposed load reduction (Eurocode) (page 1873)

• Snow and snow drift loads (Eurocode) (page 1874)

• Wind loads (Eurocode) (page 1874)

Loadcase types (Eurocode)

The following load case types can be created:

Loadcase
yype

Calculated
automaticall

y

Include in
the

Combination
Generator

Imposed load
reductions

Pattern load

self weight
(beams,
columns and
walls)

yes/no yes/no N/A N/A

slab wet yes/no N/A N/A N/A
slab dry yes/no yes/no N/A N/A
dead N/A yes/no N/A N/A
imposed N/A yes/no yes/no yes/no
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Loadcase
yype

Calculated
automaticall

y

Include in
the

Combination
Generator

Imposed load
reductions

Pattern load

roof imposed N/A yes/no N/A N/A
wind N/A yes/no N/A N/A
snow N/A yes/no N/A N/A
snow drift N/A yes/no N/A N/A
temperature N/A N/A N/A N/A
settlement N/A N/A N/A N/A
seismic N/A yes N/A N/A

As shown above, self weight loads can all be determined automatically.
However, other gravity load cases have to be applied manually as you build
the structure.

Self weight (Eurocode)

Self weight - excluding slabs loadcase

Tekla Structural Designer automatically calculates the self weight of the
structural beams/columns for you. The Self weight - excluding slabs loadcase
is pre-defined for this purpose. Its loadcase type is fixed as “Selfweight”. It
cannot be edited and by default it is added to each new load combination.

Self weight of concrete slabs

Tekla Structural Designer expects the wet and dry weight of concrete slab to
be defined in separate loadcases. This is required to ensure that members are
designed for the correct loads at construction stage and post construction
stage.

The Slab self weight loadcase is pre-defined for the dry weight of concrete
post construction stage, its loadcase type is fixed as “Slab Dry”.

There is no pre-defined loadcase for the wet weight of concrete slab at
construction stage, but if you require it for the design of any composite beams
in the model the loadcase type should be set to “Slab Wet”.

Tekla Structural Designercan automatically calculate the above weights for you
taking into account the slab thickness, the shape of the deck profile and
wet/dry concrete densities. It does not explicitly take account of the weight of
any reinforcement but will include the weight of decking. Simply click the Calc
Automatically check box when you create each loadcase. When calculated in
this way you can’t add extra loads of your own into the loadcase.

If you normally make an allowance for ponding in your slab weight
calculations, Tekla Structural Designer can also do this for you. After selecting
the composite slabs, you are able to review the slab item properties - you will
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find two ways to add an allowance for ponding (under the slab parameters
heading). These are:

• as a value, by specifying the average increased thickness of slab

• or, as a percentage of total volume.

Using either of these methods the additional load is added as a uniform load
over the whole area of slab.

Imposed and roof imposed loads (Eurocode )

Definition of psi factors for imposed load cases

In the Loadcase dialog when an imposed loadcase is selected, you are able to
select the Category of imposed load as follows - default Category B - office:

• Category A - domestic/residential

• Category B - office

• Category C - congregation

• Category D - shopping

• Category E - storage

The default values of Ψ0, Ψ1 and Ψ2 vary depending on the category selected
and also with the National Annex being worked to. The values can be edited if
required. See “psi factors”

Definition of psi factors for roof imposed load cases

Roof imposed loads are not categorised so the default values of Ψ0, Ψ1 and Ψ2
only vary depending on the National Annex being worked to. Again, the values
can be edited if required.

Imposed load reduction (Eurocode)

Reductions can be applied to imposed loads to take account of the
unlikelihood of the whole building being loaded with its full design imposed
load. Reductions can not however be applied to roof imposed loads.

NOTE If the imposed load is considered as an accompanying action (i.e. a Ψ
factor is applied to the imposed load case in a combination) then as
stated in the Base Eurocode cl 3.3.2, the imposed load reduction
should not be applied at the same time.

Imposed loads are only automatically reduced on:

• Columns of any material

• Concrete walls, mid-pier or meshed

The method used for determining the reductions is dependant on the National
Annex:
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• In the Base Eurocode a formula is given in cl 6.3.1.2(11), this is also used if
the Irish, Finish, Norwegian, Swedish or Singaporean National Annex is
selected.

• In the UK, and Malaysia the NA permits an alternative method of reduction
using NA 2.6.

Although the code allows for imposed load reductions to be applied to floors,
Tekla Structural Designer does not implement this automatically. For steel
beams, concrete beams, slabs and mats it is however possible to define the
level of imposed load reduction manually via the beam/slab item properties.

This is particularly relevant for the design of transfer beams/slabs:

• The imposed load reduction for beams, slabs and mats is intended to work
with loads applied from columns acting on the beam or slab when the slab
is acting in transfer or for a mat foundation supporting a column. (The
theory being that if you want to design the columns for the reduced axial
load, you should also design the supporting member for the reduced axial
load applied by the column.)

• The engineer would need to work out the reduction of the axial load in the
column and apply this as a the reduction percentage, i.e. if the raw axial
load in the column is 100kN and the reduced load is 60kN, the reduction is
40%. You would than apply the 40% reduction to the transfer beam/slab or
mat as well.

• The reduction is not applied to loads for analysis - it is a post-analysis
process which does not affect the analysis results. It does not get applied
solely to the imposed load applied directly to the beam or slab panel, but
instead is applied to the design moment used in the beam/slab or mat
design process.

Snow and snow drift loads (Eurocode)

Definition of psi factors for snow and snow drift load cases

In the Loadcase dialog when a snow, snow drift, or ice loadcase is selected, the
default values of Ψ0, Ψ1 and Ψ2 are displayed. These vary depending on the
National Annex being worked to. The values can be edited if required. See “psi
factors”

NOTE Snow drift loads are considered to be accidental load cases and are
combined in the Accidental combinations.

Wind loads (Eurocode)

EC1-4 Wind wizard...

NOTE The Wind Wizard... used for automatic wind loadcase generation is
fully explained in the Wind Modelling Engineer’s Handbook.
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The Wind Wizard is run to create a series of static forces that are combined
with other actions due to dead and imposed loads in accordance with BS EN
1990.

The following assumptions/limitations exist:

• The shape of the building meets the limitations allowed for in the code.

• It must be a rigid structure.

• The structure must be either enclosed or partially enclosed.

• Parapets and roof overhangs are not explicitly dealt with.

Simple wind loading

If use of the Wind Wizard... is not appropriate for your structure then wind
loads can be applied via element or structure loads instead.

Definition of psi factors for wind load cases

In the Loadcase dialog when a wind loadcase is selected, the default values of
Ψ0, Ψ1 and Ψ2 are displayed. These vary depending on the National Annex
being worked to. The values can be edited if required. See “psi factors”.

Combinations (Eurocode)

Once your load cases have been generated as required, you then combine
them into load combinations; these can either be created manually, by clicking
Add... - or with the assistance of the Combinations Generator, by clicking
Generate...

• Manually defined combinations (Eurocode) (page 1875)

• Nationally Determined Parameters (NDP's) (Eurocode) (page 1864)

• Equivalent horizontal forces (EHF) (Eurocode) (page 1876)

• Combination generator (Eurocode) (page 1877)

• Combination classes (Eurocode) (page 1880)

NOTE The Foreword to the Singapore National Annex to EN 1991-1-4 Wind
Actions has a minimum horizontal load requirement (1.5%
characteristic dead weight). Therefore if this National Annex has been
applied, we are assuming that the wind load applied in manually
defined combinations, or via the combination generator, satisfies this
minimum horizontal load requirement. See: Minimum lateral load
requirements of the Singapore National Annex (page 1882)
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Manually defined combinations (Eurocode)

As you build up combinations manually, the combination factors are
automatically adjusted as load cases are added and removed from the
combination.

If you add/remove a load case type from a combination - the factors are
defaulted as follows:

• 'Self weight' - default Strength factor = 1.35, default Service factor = 1.0

• 'Slab Dry' - default Strength factor = 1.35, default Service factor = 1.0

• 'Dead' - default Strength factor = 1.35, default Service factor = 1.0

• 'Imposed'- default Strength factor = 1.5, default Service factor = 1.0

• 'Roof Imposed'- default Strength factor = 1.5, default Service factor = 1.0

• With an Imposed load case

• 'Wind' - default Strength factor = 0.75, default Service factor = 0.5

• 'Snow' - default Strength factor = 0.75, default Service factor = 0.5

• With No Imposed load case

• 'Wind' - default Strength factor = 1.5, default Service factor = 1.0

• With Wind load case

• 'Snow' - default Strength factor = 0.75, default Service factor = 0.5

• With no Wind load case

• 'Snow' - default Strength factor = 1.5, default Service factor = 1.0

• 'Snow drift'- default Strength factor = 1.0, default Service factor = 1.0

• 'Temperature'- default Strength factor = 1.0, default Service factor = 1.0

• ‘Settlement'- default Strength factor = 1.0, default Service factor = 1.0

Equivalent horizontal forces (EHF) (Eurocode)

EHFs are used to represent frame imperfections. The Eurocode requires they
are applied to all combinations. (Lateral wind combinations therefore should
also have EHFs applied).

EHFs are automatically derived from the factored load cases within the current
combination. They are applied in the analysis as a horizontal force at each
beam column intersection as a specified percentage of the vertical load in the
column at the column/beam intersection.

Settings that control the EHF percentage can be adjusted from Home -->
Model Settings --> EHF . (The default settings conservatively result in 0.5%
EHF in both directions).

EHFs are applied to the structure in the building directions 1 and 2 as follows:

• EHF Dir1+
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• EHF Dir1-

• EHF Dir2+

• EHF Dir2-

Combination generator (Eurocode)
The Combination generator is accessed via the Generate... button. This
automatically sets up combinations for both strength and serviceability.

Combination generator - Initial Parameters

At the start of the generator, you need to define certain parameters so that
the correct combinations are created - these are described below:

Combination for design of structural members (STR)

You can chose between:

• Table A1.2(B) - Eq 6.10, or

• Table A1.2(B) - Eq 6.10,a&b

Eq 6.10 is always equal to or more conservative than either 6.10a or 6.10b. The
most economic combination of 6.10a or b will depend on if permanent actions
are greater than 4.5 times the variable actions (except for storage loads).

Include GEO combinations - Table A1.2(C) - Eq 6.10

You should check this option in order to create the GEO combinations
required for foundation design.

Include Accidental combinations - Table A2.5 Eq 6.11a&b

If you have defined an accidental load type such as Snow drift you should
check this option for the correct load combinations to be generated.

NOTE The Combinations Generator refers to the relevant National Annex
when determining the g factors to apply in the above combinations, as
they may vary from the Base Eurocode values.

Include Seismic combinations - Table A2.5 Eq 6.12a&b

If you have defined seismic loads you should check this option for the correct
load combinations to be generated.

NOTE Temperature and settlement load case types not included in the
Generator at all - these have to be added manually.

Combination generator - Combinations

The second page of the generator lists the combinations applicable (with
appropriate factors) for the selections made on the first page. Any factors in
bold will be multiplied by the relevant psi factors for that load case.

The type of structure chosen on the previous page affects which combinations
default to being generated.
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The combination names are automatically generated as per the table below:

No. BS EN 1990 State
and eqn

Type Load
combination

1 Str – 6.10 Gravity Str1 - ƔGJ,supD +
ƔQI + ƔQRI

2 “ “ Str2 - ƔGJ,supD +
ƔQΨ0I + ƔQS

3 “ Lateral (EHF) Str3.n -ƔGJ,supD +
ƔQI + ƔQRI + EHF

4 “ “ Str4.n - ƔGJ,supD +
ƔQI + ƔQΨ0S + EHF

5 “ “ Str5.n - ƔGJ,supD +
ƔQΨ0I + ƔQS + EHF

6 “ Lateral (Wind) Str6.n - ƔGJ,supD +
ƔQI + ƔQΨ0S +
ƔQΨ0W + EHF

7 “ “ Str7.n - ƔGJ,supD +
ƔQΨ0I + ƔQS +
ƔQΨ0W + EHF

8 “ “ Str8.n - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0S +
ƔQW + EHF

9 “ Uplift Str9.n - ƔGJ,infD +
ƔQW + EHF

    
1 Str – 6.10a&b Gravity Str1 - ƔGJ,supD +

ƔQΨ0I + ƔQΨ0RI

2 “ “ Str2 - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0S

3 “ “ Str3 - ξƔGJ,supD +
ƔQΨ0I + ƔQRI

4 “ “ Str4 - ξƔGJ,supD +
ƔQΨ0I + ƔQS

5 “ Lateral (EHF) Str5.n - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0RI +
EHF

6 “ “ Str6.n - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0S +
EHF
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No. BS EN 1990 State
and eqn

Type Load
combination

7 “ “ Str7.n - ξƔGJ,supD +
ƔQI + ƔQRI + EHF

8 “ “ Str8.n - ξƔGJ,supD +
ƔQI + ƔQΨ0S + EHF

9 “ “ Str9.n - ξƔGJ,supD +
ƔQΨ0I + ƔQS + EHF

10 “ Lateral (Wind) Str10.n - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0S +
ƔQΨ0W + EHF

11 “ “ Str11.n - ξƔGJ,supD +
ƔQI + ƔQΨ0S +
ƔQΨ0W + EHF

12 “ “ Str12.n - ξƔGJ,supD +
ƔQΨ0I + ƔQS +
ƔQΨ0W + EHF

13 “ “ Str13.n - ξƔGJ,supD +
ƔQΨ0I + ƔQΨ0S +
ƔQW + EHF

14 “ Uplift Str14.n - ƔGJ,infD +
ƔQW + EHF

    
1 Geo - 6.10 Lateral (EHF) Geo1.n - ƔGJ,supD +

ƔQI + ƔQRI + EHF

2 “ “ Geo2.n - ƔGJ,supD +
ƔQI + ƔQΨ0S + EHF

3 “ “ Geo3.n - ƔGJ,supD +
ƔQΨ0I + ƔQS + EHF

4 “ Lateral (Wind) Geo4.n - ƔGJ,supD +
ƔQI + ƔQΨ0W +
ƔQΨ0S + EHF

5 “ “ Geo5.n - ƔGJ,supD +
ƔQΨ0I + ƔQS +
ƔQΨ0W + EHF

6 “ “ Geo6.n - ƔGJ,supD +
ƔQΨ0I + ƔQΨ0S +
ƔQW + EHF
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No. BS EN 1990 State
and eqn

Type Load
combination

7 “ Uplift Geo7.n - ƔGJ,infD +
ƔQ,1W + EHF

    
1 Acc 6.11 Lateral (EHF) Acc1.n - G + Ad +

Ψ1I + EHF

2 “ Lateral (Wind) Acc2.n - G + Ad +
Ψ2I + Ψ1W + EHF

 Seis 6.12 Seismic Seis.n - G + AEd +
Ψ2RI + Ψ2S + EHF

   Seis.n - G + AEd +
EHF

NOTE If working to the Swedish NA (EK11), although shown in the above
table, variable actions are no longer considered in Tekla Structural
Designer combinations of actions based on equation 6.10a

Combination Generator - Service Factors

This page indicates which combinations are to be checked for serviceability
and the factors applied.

Combination Generator - Wind/EHF Directions

This page is used to select which EHF direction goes with each combination
containing a specific wind load case.

All wind load cases are listed vertically, and the four EHF options (+Dir1, -Dir1,
+Dir2, -Dir2) are each displayed with a factor (default 1.000).

By default (on first entry), none of the directions are set for any wind load
case. You are required to set at least one for every wind load case and can set
two, three or all four if you wish- these are then used when generating the
combinations.

Combination Generator - EHF

The last page is used to set up the equivalent horizontal forces. You can
specify EHF’s and factors in each of four directions.

For each direction selected a separate EHF combination will be generated. Any
combination with wind in is automatically greyed as all the required
information has already been set via the previous page.

Click Finish to see the list of generated combinations.

Combination classes (Eurocode)
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Having created your combinations you classify them as: Construction Stage,
Gravity, Lateral, Seismic, or Modal Mass.

NOTE If generated via the Combinations generator they are classified for
you automatically.

Then (where applicable) you indicate whether they are to be checked for
strength or service conditions, or both. You also have the option to make any
of the combinations inactive.

Construction stage combination (Eurocode)

A Construction Stage load combination is only required for the purpose of
designing any composite beams within the model. It is distinguished from
other combinations by setting its “Class” to Construction Stage.

Typically this combination would include a loadcase of type “Slab Wet”, (not
“Slab Dry”), other loadcases being included in the combination as required.

If you add/remove a load case type from this combination - the factors are
defaulted as follows:

• Self weight - default Strength factor = 1.35, default Service factor = 1.0

• Slab Wet - default Strength factor = 1.35, default Service factor = 1.0

• Dead - default Strength factor = 1.35, default Service factor = 1.0

• Imposed - default Strength factor = 1.5, default Service factor = 1.0

NOTE The Slab Wet loadcase type should not be included in any other
combination.

Gravity combination (Eurocode)

These combinations are considered in both the Gravity Sizing and Full Design
processes.

They are used in the Gravity Sizing processes as follows:

• Design Concrete (Gravity) - concrete members in the structure are
automatically sized (or checked) for the gravity combinations

• Design Steel (Gravity) - steel members in the structure are automatically
sized (or checked) for the gravity combinations.

• Design All (Gravity) - all members in the structure are automatically sized
(or checked) for the gravity combinations.

They are also used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the gravity combinations.

• Design Steel (All) - steel members in the structure are automatically sized
(or checked) for the gravity combinations.
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• Design All (All) - all members in the structure are automatically sized (or
checked) for the gravity combinations.

Quasi Permanent SLS Gravity Combination

In order to cater for the quasi-permanent SLS load combination, a gravity
combination is permitted to have two SLS sets of factors. The quasi permanent
combination is only used for the spacing of reinforcement calculation for RC
beams (and nothing else).

Lateral combinations (Eurocodes)

These combinations are not used in the Gravity Sizing processes.

They are used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the lateral combinations.

• Design Steel (All) - steel members in the structure which have not been set
as Gravity Only are automatically sized (or checked) for the lateral
combinations.

• Design All (All) - all concrete members and all steel members which have
not been set as Gravity Only are automatically sized (or checked) for the
lateral combinations.

Seismic Combinations (Eurocode)

NOTE Although included in this documentation, these are only available for
use in regions where seismic design is required.

These combinations are only considered during the Full Design process. They
are not used in the Gravity Sizing process.

Modal mass combinations (Eurocode)

For modal analysis, you are required to set up specific “modal mass”
combinations. Provided these combinations are active they are always run
through the modal analysis.

NOTE It is always assumed that all loads in the load cases in the combination
are converted to mass for modal analysis. You are permitted to add
lumped mass directly to the model.

Minimum lateral load requirements of the Singapore National Annex
(Eurocode)

The foreword to the “Singapore National Annex to EN 1991-1-4 Wind Actions”
states:
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• “For continuation of an established design philosophy, all buildings should
be capable of resisting, as a minimum, a design ultimate horizontal load
applied at each floor or roof level simultaneously equal to 1.5% of the
characteristic dead weight of the structure between mid-height of the
storey below and either mid-height of the storey above or roof surface. The
design ultimate wind load should not be taken as less than this value when
considering load combinations.”

In Tekla Structural Designer this requirement can be met by applying lateral
loads at each floor level equal to 1.5% of the dead load at that level; these can
then be designed for if they exceed the design ultimate wind load.

The checking procedure to be followed can be summarised as:

1. Establish the minimum lateral load to be resisted.

2. Compare the horizontal reaction this produces against that of the existing
wind load.

3. If the minimum lateral load is greater than the wind load it must be
designed for as necessary in up to four directions (+/- Dir 1, +/- Dir 2); if it
is less, then no further action is required.

The checking procedure in detail

NOTE EN1994 requires all wind combinations to include EHFs - Settings that
control the magnitude of EHFs can be adjusted from Home > Model
Settings > EHF. (The default settings conservatively result in 0.5% EHF
in both directions). It is recommended that these settings are
reviewed prior to undertaking the procedure described below.
(Otherwise, if the EHF settings are subsequently changed, both the
wind load combinations, and the factors applied to the minimum
lateral load combinations are affected and consequently steps 2 and 3
of the checking procedure would have to be repeated.)

Step 1. Establish the minimum lateral load to be resisted

This can be determined as follows:

1. Create a special “characteristic dead loads” combination which only
comprises the total dead weight of the structure and no EHFs. Make this
combination “Active”, but leave “Strength” and “Service” unchecked.

2. From the Analyse menu run 1st Order Linear for all combinations.

3. From the Project Workspace Loading tab, select the “characteristic dead
loads” combination and make a note of the total vertical reaction.
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In the example shown above the vertical reaction = 28245 kN

4. Calculate 1.5% of this value – this is the minimum lateral load to be
resisted.

Hmin = 0.015 * 28245 = 423.7kN

Step 2. Compare the minimum lateral load against the wind load

1. Still in the Project Workspace Loading tab, click on each of the wind load
combinations and compare their lateral reactions against Hmin

2. If Hmin is greater than the maximum lateral reaction from all of the wind
combinations, this indicates that the minimum lateral load governs and
consequently you must ensure that the building is designed for this
condition. (If it is not, then minimum lateral load does not govern and no
further action is required.)

Step 3. Create (and design for) the minimum lateral load design
combinations

Assuming that the above comparison has established that the minimum
lateral load governs, you will have to create minimum lateral load
combinations in each of four directions (+/- Dir 1, +/- Dir 2) as follows:
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1. Copy the existing dead and imposed only combination to create a new
combination named “Minimum Lateral Loads (Dir 1+)”

2. Ensure the new combination includes EHF in (Dir 1+) only

3. The EHF strength factor has to be adjusted to generate Hmin laterally - to
do this:

• From the Analyze menu run 1st Order Linear for this new
combination.

• Record the total horizontal load on the structure, (H1).

In the example shown above the total horizontal load, H1 = 207.8kN

• Calculate the EHF strength factor required as the ratio: Hmin/H1

EHF strength factor = 423.7/ 207.8 = 2.04

4. Create a second minimum lateral load combination, “Minimum Lateral
Loads (Dir 1-)”, this is similar to the first, using the same adjusted EHF
strength factor, but with the EHF (Dir1+) loadcase replaced by EHF(Dir1-)

5. Repeat the above process to create similar minimum lateral load
combinations in direction 2.

6. Run Design All (Static) to design the model for all combinations.
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Steel design to EC3 and EC4 (Eurocode)

Tekla Structural Designer designs steel members and composite members to a
range of international codes. This reference guide specifically describes the
design methods applied in the software when the BS EN 1993-1-1:2005 (Ref.1)
and BS EN 1994-1-1:2004 (Ref. 4) codes are selected.

Within the remainder of this handbook BS EN 1993-1-1:2005 and BS EN
1994-1-1:2004 are referred to as EC3 and EC4 respectively.

Unless explicitly noted otherwise, all clauses, figures and tables referred to are
from EC3; apart from the Composite Beam section, within which references
are to EC4 unless stated.

Basic principles (EC3 Eurocode)
This section covers definitions, convention for members axis and deflection
checks.

Definitions (EC3 Eurocode)

The following terms are relevant when using Tekla Structural Designer to
design to the Eurocodes.

National Annex (NA)

Safety factors in the Eurocodes are recommended values and may be altered
by the national annex of each member state.

Tekla Structural Designer currently has the following EC3 national annex
options available:

• EC3 Europe

• EC3 UK NA

• EC3 Ireland NA

• EC3 Ireland NA

• EC3 Malaysia NA

• EC3 Singapore NA

You can select the desired National Annex as appropriate, in which case the
nationally determined parameters are automatically applied (see next section),
or if you choose EC3 Europe, the Eurocode recommended values are applied.
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Nationally Determined Parameters (NDP’s)

NDP’s are choices of values, classes or alternative methods contained in a
National Annex that can be applied in place of the base Eurocode, EC3 Europe.

Partial Factors for Buildings

The partial factors γM for buildings as described in clause 6.1(1) Note 2B
should be applied to the various characteristic values of resistance as follows:

• resistance of cross-sections irrespective of class: γM0

• resistance of members to instability assessed by member checks: γM1

• resistance of cross-sections in tension to fracture: γM2

Depending on your choice of National Annex the above partial factors for
buildings are set as follows:

Factor EC3 Base
value

UK Ireland Malaysia Singapore

γM0 1.00 1.00 1.00 1.00 1.00

γM1 1.00 1.00 1.00 1.00 1.00

γM2 1.25 1.10* 1.25 1.20 1.10

NOTE - for connection design BS EN1991-1-8 - γM2 = 1.25

Convention for member axes (EC3 Eurocode)
The sign convention for member axes when designing to Eurocodes is as
shown below.
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Section axes - (x is into the page along the centroidal axis of the member).

Deflection checks (EC3 Eurocode)

Relative and Absolute Deflections

Tekla Structural Designer calculates both relative and absolute deflections.
Relative deflections measure the internal displacement occurring within the
length of the member and take no account of the support settlements or
rotations, whereas absolute deflections are concerned with deflection of the
structure as a whole. The absolute deflections are the ones displayed in the
structure deflection graphics. The difference between relative and absolute
deflections is illustrated in the cantilever beam example below.
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Relative deflections are given in the member analysis results graphics and are
the ones used in the member design.

Steel beam deflections

Deflections of steel beams in design are calculated from first order linear
results since these are SLS deflections that are compared with standard limits
such as span/360. This means that the effects of any non-linearity such as a
continuous beam sitting on sinking supports i.e. non-linear springs are not
taken into account in design. If these springs are linear this is not an issue.

Steel beam design to EC3 (Eurocode)

Design method (Beams: EC3 Eurocode)

Unless explicitly stated all calculations are in accordance with the relevant
sections of EC3 (Ref. 1) and any associated National Annex. A basic knowledge
of the design methods for beams in accordance with the code is assumed.

Steel beam limitations and assumptions (Beam: EC3 Eurocode)

The following limitations apply:

• Continuous beams (more than one span) must be co-linear in the plane of
the web within a small tolerance (sloping in elevation is allowed),

• Rolled doubly symmetric prismatic sections (i.e. I- and H-sections), doubly
symmetric hollow sections (i.e. SHS, RHS and CHS), and channel sections
are fully designed,

• Single angles, double angles and tees are designed, but certain checks are
beyond scope, (see Angle and Tee Limitations)

• Plated beams are fully designed provided the section type is either “Plated
Beam” or “Plated Column”.
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• All other plated section types (“Rolled I Sections with Plates”, “Double Rolled
I Sections” etc.) are analyzed only but not designed,

• Fabsec beams (with or without openings) are excluded.

The following assumptions apply:

• All supports are considered to provide torsional restraint, that is lateral
restraint to both flanges. This cannot be changed. It is assumed that a
beam that is continuous through the web of a supporting beam or column
together with its substantial moment resisting end plate connections is
able to provide such restraint.

• If, at the support, the beam oversails the supporting beam or column then
the detail is assumed to be such that the bottom flange of the beam is well
connected to the supporting member and, as a minimum, has torsional
stiffeners provided at the support.

• In the Tekla Structural Designermodel, when not at supports, coincident
restraints to both flanges are assumed when one or more members frame
into the web of the beam at a particular position and the cardinal point of
the centre-line model of the beam lies in the web. Otherwise, only a top
flange or bottom flange restraint is assumed. Should you judge the actual
restraint provided by the in-coming members to be different from to what
has been assumed, you have the flexibility to edit the restraints as
required.

• Intermediate lateral restraints to the top or bottom flange are assumed to
be capable of transferring the restraining forces back to an appropriate
system of bracing or suitably rigid part of the structure.

• It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints for both LTB and compression
buckling. The default value for the effective length factor of 1.0 may be
neither correct nor safe.

Ultimate Limit State - Strength (Beams: EC3 Eurocode)
The strength checks relate to a particular point on the member and are carried
out at regular intervals along the member and at “points of interest”.

Classification (Beams: EC3 Eurocode)

General

The classification of the cross section is in accordance with EC3 Cl. 5.5 Table
5.2

A steel non-composite beam can be classified as:

• Plastic Class = 1

• Compact Class = 2

• Semi-compact Class = 3
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• Slender Class = 4

Class 4 sections are unacceptable and are either failed in check mode or
rejected in design mode.

Implementation of the below clauses is as follows:

• Classification is determined using clause 5.5.2 (6) and not 5.5.2 (7).

• Clause 5.5.2 (9) is not implemented as clause (10) asks for the full
classification to be used for buckling resistance.

• Clause 5.5.2 (11) is not implemented.

• Clause 5.5.2 (12) is not implemented.

The note at the end of clause 5.5.2 is not implemented. A brief study by CSC
(UK) Ltd of UK rolled UBs and UCs showed that flange induced buckling in
normal rolled sections is not a concern. No study was undertaken for plated
sections.

Hollow sections

The classification rules for SHS and RHS relate to “hot-finished hollow sections”
and “cold-formed hollow sections”.

Shear capacity (Beams: EC3 Eurocode)

Major and minor axis shear

Checks are performed according to clause 6.2.6 (1) for the absolute value of
shear force normal to each axis at the point under consideration.The following
points should be noted:

• No account is taken of fastener holes in the flange or web - see 6.2.6 (7)

• Shear is not combined with torsion and thus the resistance is not reduced as
per 6.2.6 (8)

Web Shear buckling

Shear web buckling design applies to rolled and plated I/H sections only.

National Annex dependency

Plates with unstiffened webs are checked for shear web buckling where:

hw/tw > 72 ε/η

where

ε = √ (235 / fw

η is NA dependant and is defined in the table below:
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National Annex η Applicable to
Eurocode value 1.20 Up to and including

S460, else use η = 1.00
UK 1.00 All steel grades
Irish 1.00 All steel grades
Malaysia 1.00 All steel grades
Singapore 1.00 All steel grades

Contribution from flanges

When the flange resistance is not fully utilized in resisting the bending
moment (MEd <Mf,Rd), the contribution from the flanges is taken as:

Vbf,Rd = (bf t2
f fyf) / (c γM1) * (1-(MEd/Mf,Rd)2)

where

• bf and tf are taken for the flange which provides the least axial resistance

• bf is not taken as larger than 15εtf on each side of the web

• Mf,Rd is the moment of resistance of the cross section consisting of the
effective area of the flanges only

• c = a (0.25 + 1.6bf tf
2 fyf / t hw

2 fyfw)

• a is the distance between stiffeners

As we are only designing for the case where no stiffeners are being used, a →
∞ therefore c → ∞ so Vbf,Rd→ 0.

Contribution from the web

The contribution from the web is taken as:

Vbw,Rd = (xw fyw hw t) / (√3γM1)

xw ≤ η

Design resistance

The design resistance for shear is taken as:

Vb,Rd= Vbw,Rd + Vbf,Rd ≤ η (fyw hw t) / (√3γM1)

Influence of shear

According to 7.1 of EN 1993-1-5 provided VEd ≤ 0.5 Vbw,Rd the design resistance
to bending moment and axial force does not need to be reduced to allow for
shear force.

In Tekla Structural Designer VEd is restricted to 0.5 Vbw,Rd, values above this are
deemed beyond scope.

This restriction is only applicable if hw/tw > 72 ε/η

Assumptions
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The following points should be noted:

• Non-rigid end post is a more conservative approach than a rigid end post.

• Physical support conditions can be taken as equivalent to "transverse
stiffeners at supports only".

• It is assumed there is negligible contribution to the design shear force VEd
from shear from torque

• All hole cut outs are small in accordance to section EN 1993-1-5:2006 2.3

• As the case being designed for is where no stiffeners are being used, a → ∞
therefore c → ∞ so Vbf,Rd→ 0.

• If a grade of steel is used other than S335, S355 and S460, η will be taken
as 1.00 regardless of National Annex.

Moment capacity (Beams: EC3 Eurocode)
Major and minor axis bending checks are performed in accordance with
Section 6.2.5.

Major axis bending

For the low shear case the calculation uses equation 6.13 for class 1 and 2
cross sections and equation 6.14 for class 3 cross sections. In the high shear
case equation 6.29 is used for class 1 and 2 cross sections and equation 6.14
for class 3 cross sections. Where the high shear condition applies, the moment
capacity calculation is made less complicated by conservatively adopting a
simplified shear area.

Minor axis bending

For the low shear case the calculation uses equation 6.13 for class 1 and 2
cross sections and equation 6.14 for class 3 cross sections. High shear in the
minor axis is beyond the current program scope.

NOTE Fastener holes in the flange or web are not accounted for in the
calculations.

Axial capacity (Beam: EC3 Eurocode)

Axial Tension

Checks are performed according to equation 6.5

Implementation of the below clauses is as follows:

• Clause 6.2.3 (3) - is not considered

Clause 6.2.3 (4) - is not considered

• Clause 6.2.3 (5) - is not considered

• Eqn 6.7 is not considered for steel non-composite beams.
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Axial Compression

Checks are performed according to equation 6.9.

Combined bending and axial capacity (Beams: EC3 Eurocode)

The combined bending and axial capacity check covers the interaction of axial
load and bending to Clause 6.2.9 appropriate to the type (for example - doubly
symmetric) and classification of the section, and provided there is no high
shear present.

If high shear is present only on the major axis (i.e. parallel to the web) of a
doubly symmetric rolled or plated I section, in combination with uniaxial major
bending and axial compression or tension, then the combined bending and
axial capacity check will be carried out to the EC3 design rules described in a
research paper by Goczek and Supel.1

All other high shear conditions, including the presence of shear web buckling
or class 4 sections, are given a Beyond Scope status.

Class 1 and 2 cross sections (with low shear)

Equation 6.41 is applied. Note that in these calculations the combined effects
of axial load and bending are assessed - clause 6.2.9 (4) is not considered.

Also note that the current "reduced plastic moduli" approach that is used in
the published tables is adopted and not the approximate method given in
clause 6.2.9.1(5). The latter is less conservative than the current approach at
low levels of 'n'.

Class 3 cross sections (with low shear)

Equation 6.42 is applied.
1 ‘Resistance of steel cross-sections subjected to bending, shear and axial forces’ by
Jerzy Goczek and Lukasz Supel, Engineering Structures 70 (2014) 271-277, Elsevier.

Ultimate limit state - Buckling (Beams: EC3 Eurocode)

NOTE Classification for buckling checks - For rolled I sections, RHS and SHS
classification varies along the member length due to the section forces
changing along the member length - for combined buckling, the worst
classification of the whole member should be used. In theory it should
be the worst classification in the “check length” considered for
buckling. However, the “check lengths” for lateral torsional buckling,
minor axis strut buckling and major axis strut buckling can all be
different. It is simpler and conservative therefore to use the worst
classification in the entire member length.

Compression buckling (Beams: EC3)
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Beams must be checked to ensure adequate resistance to buckling about both
the major and minor axes and they must also be checked in the torsional
mode over an associated buckling length. Since the axial force can vary
throughout the beam and the buckling lengths in the two planes do not
necessarily coincide, all buckling modes must be checked. There may be
circumstances where it would not be safe to assume that the combined
buckling check will always govern (see below).

NOTE A warning message will be given in the compression buckling check
results whenever (major or minor axis) high shear is present in a load
combination. “HIgh shear is assumed not to affect buckling design. This
assumption should be verified by the Engineer.”

Effective lengths

In all cases Tekla Structural Designer sets the default effective length to 1.0L, it
does not attempt to adjust the effective length in any way. Different values can
apply in the major and minor axis. It is your responsibility to adjust the value
from 1.0 where you believe it to be justified.

NOTE It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints. The default value for the effective
length factor of 1.0L may be neither correct nor safe.

Coincident restraint points in the major and minor axis define the 'check
length' for torsional and torsional flexural buckling (which also has an effective
length factor but is assumed to be 1.0L and cannot be changed).

All intermediate major and minor restraints in a cantilever span are ignored.

Any major or minor strut buckling 'check length' can take the type 'Continuous'
to indicate that it is continuously restrained over that length. There is no
facility for specifying torsional or torsional flexural buckling 'check lengths' as
'Continuous'.

There is no guidance in EC3 on the values to be used for effective length
factors for beam-columns.

There is no guidance in EC3 on the values to be used for effective length
factors for beam-columns.

Compression resistance

The relevant buckling resistances are calculated from Equation 6.47.

These consist of the flexural buckling resistance about both the major and
minor axis i.e. Nb,y,Rd and Nb,z,Rd over the buckling lengths Lyy and Lzz and
where required the buckling resistance in the torsional or flexural-torsional
modes, Nb,x,Rd.

The elastic critical buckling load, Ncr for flexural buckling about major and
minor axes is taken from standard texts. The elastic critical buckling loads for
torsional, Ncr.T and for torsional flexural buckling, Ncr.TF are taken from the

Design codes reference 1895 Eurocodes



NCCI “Critical axial load for torsional and torsional flexural buckling modes”
available free to download at www.steel-ncci.co.uk.

All section types are checked for flexural buckling. It is only hollow sections
that do not need to be checked for torsional and torsional-flexural buckling.

Lateral torsional buckling (Beams: EC3)

Lateral torsional buckling checks are required between supports, or LTB
restraints on a flange which is in bending compression, for all lengths that are
not continuously restrained.

NOTE A warning message will be given in the lateral torsional buckling check
results whenever (major or minor axis) high shear is present in a load
combination. “HIgh shear is assumed not to affect buckling design. This
assumption should be verified by the Engineer.”

Note that coincident LTB restraints (i.e. top & bottom flange) are the
equivalent of a support and will define one end of a 'check length' for both
flanges regardless of whether a particular flange is in compression or tension
at the coincident restraint position. However, note also that in a cantilever all
intermediate restraints are ignored.

Tekla Structural Designer allows you to 'switch off' LTB checks for either or
both flanges by specifying that the entire length between start and end of the
beam span is continuously restrained against lateral torsional buckling. If you
use this option you must be able to provide justification that the beam is
adequately restrained against lateral torsional buckling.

All intermediate LTB restraints in a cantilever span are ignored.

When the checks are required you can set the effective LTB length of each
'check length' by giving factors to apply to the physical length of the beam. Any
individual 'check length' less than the full span length can be continuously
restrained in which case no LTB check will be carried out for that 'check length'
provided all segments of the 'check length' have been marked as Continuous.
Each 'check length' which is not defined as being continuously restrained for
its whole length is checked in accordance with clause 6.3.2.3.

The formula for elastic critical buckling moment, Mcr is taken from standard
texts. The moment factor C1 that is part of the standard formula has been
derived analytically.

LTB does not need to be checked for the following sections:

• circular and square hollow sections,

• equal and unequal flanged I/H sections loaded in the minor axis only.

Effective lengths

The value of effective length factor is entirely the choice of the engineer. The
default value is 1.0. There is no specific factor for destabilizing loads - so you
will have to adjust the 'normal' effective length factor to allow for such effects.
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Combined buckling (Beams: EC3 Eurocode)

Combined buckling in Tekla Structural Designer is limited to doubly symmetric
sections (I, H, CHS, SHS, RHS). In the context of combined buckling, beams are
assumed to be dominated by moment with axial force.

NOTE A warning message will be given in the combined buckling check
results whenever (major or minor axis) high shear is present in a load
combination. “HIgh shear is assumed not to affect buckling design. This
assumption should be verified by the Engineer.”

Restraints are treated as described previously and summarized as follows:

• Each span is assumed to be fully supported at its ends (i.e LTB, y-y and z-z
restraint) - this cannot be changed.

• Tension flange LTB restraints are ignored unless they are coincident (see
next point).

• Coincident top and bottom flange restraints are considered as 'torsional'
restraints i.e. as good as the supports.

• All intermediate LTB and strut restraints in a cantilever span are ignored.

For each span of the beam, the design process is driven from the standpoint
of the individual LTB lengths i.e. the LTB lengths and the y-y lengths that are
associated with each LTB length and the z-z lengths associated with the y-y
length. Thus a 'hierarchy' is formed - see the “Design Control (page 1898)”
section below for details. Both Equation 6.61 and Equation 6.62 are evaluated
recognizing that the combined buckling check is carried out for both the top
flange and the bottom flange.

Effective lengths

In all cases Tekla Structural Designer sets the default effective length to 1.0L, it
does not attempt to adjust the effective length in any way. Different values can
apply in the major and minor axis. It is your responsibility to adjust the value
from 1.0 where you believe it to be justified.

NOTE It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints. The default value for the effective
length factor of 1.0L may be neither correct nor safe.

Combined buckling resistance

Equations 6.61 and 6.62 are used to determine the combined buckling
resistance.

With regard to these equations the following should be noted:

• The “k” factors used in these equations are determined from Annex B only,
and reported as follows:
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• kyy is reported as components k’yy and Cmy where k’yy is simply the Annex
B term for kyy with Cmy excluded

• kyz is reported as k’yz, a multiple of k’zz (see below)

• kzy is reported as k’zy, a multiple of k’yy (see above), but only for members
not susceptible to torsional deformations (i.e. SHS and CHS sections at all
times, and I or H sections which have both flanges continuously restrained
for LTB). For members which are susceptible to torsional deformations kzy
is reported per Table B.2 (i.e. with CmLT included)

• kzy,LT1 is a factor reported for columns only and is the Table B.2 term for kzy
with CmLT set to 1.0

• kzz is reported as components k’zz and Cmz where k’zz is simply the Annex B
term for kzz with Cmz excluded.

• The note to Table B.3 that Cm should be limited to 0.9 is not applied.

WARNING Danger. Equations 6.61 and 6.62 are limited to doubly symmetric
sections and do not consider torsional or torsional flexural
buckling. Should either of these buckling modes govern the
compression buckling check, you should consider very
carefully whether the calculations provided by Tekla
Structural Designer for combined buckling can be considered
valid.

Design control (Beams: EC3 Eurocode)

Principles

There are multiple check lengths to deal with (LTB, y-y buckling and z-z
buckling) all of which can be contained within or overlapped by their
associated lengths. Consequently, a 'hierarchy' of checks is defined. In the
approach taken the LTB segment length is taken as the driver and the other
lengths whether overlapping or contained by this segment are mapped to it.

Design example

The following example illustrates how the checks are applied to I- and H-
sections with equal flanges.
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The beam (span) is 10.2 m long and has torsional restraints at each end. The
top flange is restrained out-of-plane at 0.7m, 4.2m and 6.6 m – these provide
restraint to the top flange for LTB and to the beam as a whole for out-of-plane
strut buckling. The bottom flange has one restraint at mid-span and this
restrains the bottom flange for LTB and the beam as a whole for in-plane strut
buckling. (This is probably difficult to achieve in practice but is useful for
illustration purposes.)

Note that the top flange LTB restraints and z-z restraints are coincident in this
example but will not always be coincident.

Tekla Structural Designeridentifies the following lengths and checks. (in this
example all the effective length factors are assumed to be 1.0 for simplicity.)

LTB Segment Equation In-plane strut
segment

Out-of-plane
strut segment

length (m)  length (m) length (m)
Top flange

0 – 4.2

(first restraint
ignored since top
flange is in
tension at this
point)

6.61 0 – 5.1 0 – 0.7
6.62 0 – 5.1 0 – 0.7
6.61 0 – 5.1 0.7- 4.2
6.62 0 – 5.1 0.7- 4.2

Top flange

4.2 – 6.6

6.61 0 – 5.1 4.2 – 6.6
6.62 0 – 5.1 4.2 - 6.6
6.61 5.1 - 10.2 4.2 - 6.6
6.62 5.1 - 10.2 4.2 - 6.6
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LTB Segment Equation In-plane strut
segment

Out-of-plane
strut segment

Top flange

6.6 - 10.2

6.61 5.1 - 10.2 6.6 - 10.2
6.62 5.1 -10.2 6.6 - 10.2

Bottom flange

0 – 10.2

6.61 0 – 5.1 0 – 0.7
6.62 0 – 5.1 0 – 0.7
6.61 0 – 5.1 0.7- 4.2
6.62 0 – 5.1 0.7- 4.2
6.61 0 – 5.1 4.2 - 6.6
6.62 0 – 5.1 4.2 - 6.6
6.61 5.1 - 10.2 4.2 - 6.6
6.62 5.1 - 10.2 4.2 - 6.6
6.61 5.1 - 10.2 6.6 - 10.2
6.62 5.1 - 10.2 6.6 - 10.2

Torsion (Beams: EC3 Eurocode)
Torsion design is carried out on request according to SCI P385, but only for
single span, pin ended steel and cold formed beams with open and closed
section types.

Open sections (I- symmetric rolled)

A torsion design and an angle rotation check can be carried out for applied
torsion forces only.

The following should be noted with regard to the torsion design:

• Axial force is not taken into account

• It is assumed that load is applied at the shear center. The effect of
stabilizing/destabilizing loads is not considered.

Closed sections (HSS only)

An angle of rotation check can be carried out for applied forces only.

Angle of rotation check

The angle of rotation check is optionally carried out based on the applied
torsion loading only.

The check is applied by selecting “Apply rotation limit” (located in the steel
beam properties under the Torsion heading). The default limit is also set in the
steel beam properties as 2° but can be adjusted to suit.

Natural frequency checks (SLS) (Beams: EC4 Eurocode)
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Tekla Structural Designer calculates the approximate natural frequency of the
beam based on the simplified formula published in the Design Guide on the
vibration of floors (Ref. 6) which states that Natural frequency = 18 / √ δ

In line with the calculation of natural frequency of 18 / √ δ for a pin ended
beam with applied UDL, we calculate δ as the maximum static instantaneous
deflection based upon the composite inertia (using the short term modular
ratio) but not modified for the effects of partial interaction as:

δ = %max δself+slab + %max δother dead + %max δlive

The engineer can specify:

• Percentage self wt + slab deflection (default 100%)

• Percentage other dead deflection (default 100%)

• Percentage live load deflection (default 10%)

• Factor of increased dynamic stiffness of concrete flange (default 1.1)

Fire resistance check (Beams: EC3 Eurocode)

Scope

This check determines the mechanical resistance of a steel beam subjected to
major axis bending in case of fire during the required time of exposure in
accordance with EN 1993 & national annex for the UK, Ireland, Singapore,
Malaysia, Sweden, Norway, Finland or the recommended Eurocode values.

The check can be applied to non-composite, simply supported rolled steel
beams, which:

• may be unprotected (bare steel) or protected,

• may be exposed on 3 (under a slab) or 4 sides.

The check is applied for gravity load combinations only.

Temperature domain verification uses the Critical temperature method as
described in EN 1993-1-2, Cl 4.2.4

Limitations and assumptions

The following limitations and assumptions apply:

• The calculation is limited to a restrained single-span beam in bending.

• As per EN 1993-1-2, Cl 4.1(3) simple calculation models are simplified
design methods for individual members, which are based on conservative
assumptions.

• According to EN 1991-1-2 Cl.3.1 (10) the standard temperature-time curve
is used to calculate gas temperature –curve as described in EN 1991-1-2
Cl.3.2.1.

• The calculation considers that shear buckling resistance according to
section 5 of EN1993-1 can be ignored so it doesn’t check it as per cl.6.2.6(6)
EN 1993-1-1.
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• A conservative approach has been taken regarding the fire moment
resistance of the steel beam at time t so it’s limited to the ultimate moment
capacity of the beam.

• The effects of indirect actions are not considered. These actions, such as
internal forces and moments induced in the structure by deformations and
restrained thermal expansion, do not need to be considered when the fire
safety is based on the standard –temperature time curve.

• The shadow effect caused by local shielding is not taken into account,
therefore the shadow effect factor is conservatively taken as 1.

• For Malaysia & Ireland check is as per UK NA.

• Fire protection properties (self weight of fire protection material) are not
considered for loading and analysis.

Web openings (Beams: EC3 Eurocode)

Circular openings as an equivalent rectangle

Each circular opening is replaced by equivalent rectangular opening, the
dimensions of this equivalent rectangle for use in all subsequent calculations
are:

• do'= 0.9*opening diameter

• lo = 0.45*opening diameter

Properties of tee sections

When web openings have been added, the properties of the tee sections
above and below each opening are calculated in accordance with Section 3.3.1
of SCI P355 (Ref. 8) and Appendix B of the joint CIRIA/SCI Publication P068 (Ref.
9). The bending moment resistance is calculated separately for each of the
four corners of each opening.

Design

The following calculations are performed where required for web openings:

• Axial resistance of tee sections

• Classification of section at opening

• Vertical shear resistance

• Vierendeel bending resistance

• Web post horizontal shear resistance

• Web post bending resistance

• Web post buckling resistance

• Lateral torsional buckling

• Deflections
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Deflections

The deflection of a beam with web openings will be greater than that of the
same beam without openings. This is due to two effects,

• the reduction in the beam inertia at the positions of openings due to
primary bending of the beam,

• the local deformations at the openings due to Vierendeel effects. This has
two components - that due to shear deformation and that due to local
bending of the upper and lower tee sections at the opening.

The primary bending deflection is established by 'discretising' the member
and using a numerical integration technique based on 'Engineer's Bending
Theory' - M/I = E/R = σ/y. In this way the discrete elements that incorporate all
or part of an opening will contribute more to the total deflection.

The component of deflection due to the local deformations around the
opening is established using a similar process to that used for cellular beams
which is in turn based on the method for castellated beams given in the SCI
publication, “Design of castellated beams. For use with BS 5950 and BS 449".

The method works by applying a 'unit point load' at the position where the
deflection is required and using a 'virtual work technique to estimate the
deflection at that position.

For each opening, the deflection due to shear deformation, δs, and that due to
local bending, δbt, is calculated for the upper and lower tee sections at the
opening. These are summed for all openings and added to the result at the
desired position from the numerical integration of primary bending deflection.

Note that in the original source document on castellated sections, there are
two additional components to the deflection. These are due to bending and
shear deformation of the web post. For castellated beams and cellular beams
where the openings are very close together these effects are important and
can be significant. For normal beams the openings are likely to be placed a
reasonable distance apart. Thus in many cases these two effects will not be
significant. They are not calculated for such beams but in the event that the
openings are placed close together a warning is given.

Composite beam design to EC4 (Eurocode)

Design method (Composite beams: EC4 Eurocode)

The construction stage calculations are performed in accordance with the
relevant sections of EC3 (Ref. 1) and the associated UK (Ref. 2) or Irish (Ref. 3)
National Annex.

The composite stage design adopts a limit state approach consistent with the
design parameters for simple and continuous composite beams as specified in
EC4 (Ref. 4) and the associated UK (Ref. 5) or Irish National Annex.
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Unless explicitly noted otherwise, all clauses, figures and tables referred to are
from EC4.

A basic knowledge of EC3 and the design methods for composite beams in EC4
is assumed.

Overview (Composite beams: EC4 Eurocode)

Construction stage design checks (Composite beams: EC4)

When you design or check a beam for the construction stage (the beam is
acting alone before composite action is achieved) the following conditions are
examined in accordance with EC3:

• section classification (EC3 Table 5.2),

• major axis shear capacity (EC3 clause 6.2.6 (1)),

• web shear buckling (EC3 clause 6.2.6 (6)),

• moment capacity:

• EC3 Equation 6.13 for the low shear condition,

• EC3 Equation 6.29 for the high shear condition,

• lateral torsional buckling resistance (EC3 clause 6.3.2.3),

NOTE This condition is only checked in those cases where the profile
decking does not provide adequate restraint to the beam.

• construction stage total load deflection check.

Composite stage design checks

When you design or check a beam for the composite stage (the beam and
concrete act together, with shear interaction being achieved by appropriate
shear connectors) the following Ultimate limit state and Serviceability limit
state conditions are examined in accordance with EC4, unless specifically
noted otherwise.

Ultimate limit state checks

• section classification - the classification system defined in EC3 clause 5.5.2
applies to cross-sections of composite beams,

• vertical shear capacity in accordance with EC3 clause 6.2.6,

• longitudinal shear capacity allowing for the profiled metal decking,
transverse reinforcement and other reinforcement which has been
defined,

• number of shear connectors required (EC4 clause 6.6.1.3 (5)) between the
point of maximum moment and the end of the beam, or from and between
the positions of significant point loads,

• moment capacity,
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• web openings.

Serviceability limit state checks

• service stresses - although there is no requirement to check these in EC4
for buildings (EC4 clause 7.2.2), concrete and steel top/bottom flange
stresses are calculated but only reported if the stress limit is exceeded.

• deflections,

• self-weight,

• SLAB loadcase,

• dead load,

• imposed load,

• total deflections,

• natural frequency check.

Profiled metal decking (Composite beams: EC4 Eurocode

You may define the profiled metal decking to span at any angle between 0°
(parallel) and 90° (perpendicular) to the direction of span of the steel beam.
You can also specify the attachment of the decking for parallel, perpendicular
and angled conditions.

Where you specify that the direction of span of the profiled metal decking to
that of the steel beam is ≥ 45°, thenTekla Structural Designer assumes it is not
necessary to check the beam for lateral torsional buckling during construction
stage.

Where you specify that the direction of span of the profiled metal decking to
that of the steel beam is < 45°, then you are given the opportunity to check the
steel beam for lateral torsional buckling at the construction stage.

NOTE This check is not mandatory in all instances. For a particular profile,
gauge and fixing condition etc. you might be able to prove that the
profiled metal decking is able to provide a sufficient restraining action
to the steel beam until the concrete hardens. If this is so, then you can
specify that the whole beam (or a part of it) is continuously restrained.
Where you request to check the beam for lateral torsional buckling
during construction then this is carried out in accordance with the
requirements of EC3.

Where you specify that the direction of span of the profiled metal decking and
that of the steel beam are parallel, you again have the same opportunity to
either check the steel beam for lateral torsional buckling at the construction
stage, or to set it as continuously restrained.

Concrete slab (Composite beams: EC4 Eurocode)
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You can define concrete slabs in both normal and lightweight concrete.

Warnings are issued in the design if you do not comply with the following
constraints:

• Normal weight concrete range C20/25 - C60/75 - See EN 1994-1-1:2004
Clause 3.1(2),

• Lightweight concrete range LC20/22 - LC60/66 - See EN 1994-1-1:2004
Clause 3.1(2),

• Minimum density for lightweight concrete 1750 kg/m3 - see EN
1994-1-1:2004 Clause 6.6.3.1(1).

Precast concrete planks (Composite beams: EC4 Eurocode)

The design of composite beams with precast concrete planks is carried out in
accordance with the guidance given in SCI P401. The design basis in P401 is, in
general, in accordance with Eurocode 4, supplemented by NCCI derived test
data where applicable.

As the implications of applying NCCI PN002 or SCI P405 to composite beams
with PC planks have not being considered in the first release, only pure EC
design will be carried out regardless of whether apply NCCI PN002 is selected
or not.

Where a choice has been made the condition of the most common application
has been taken: shop welded, hollow core unit with partial interaction.

Construction stage design (Composite beams: EC4 Eurocode)
All checks are performed for this condition in accordance with EC3.

Section classification (Composite beams: EC4 Eurocode)

Cross-section classification is determined using EC3 Table 5.2.

At construction stage the classification of the section must be Class 1, Class 2
or Class 3.

Sections which are classified as Class 4 are beyond scope.

NOTE Clause 5.5.2 (6) is implemented, not the alternative 5.5.2 (7).

Clause 5.5.2 (11) is not implemented.

Clause 5.5.2 (12) is not implemented.

Member strength checks (Composite beams: EC4 Eurocode)
Member strength checks are performed at the point of maximum moment,
the point of maximum shear, the position of application of each point load,
and at all other “points of interest” along the beam.
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Shear capacity

Shear capacity is determined in accordance with EC3 clause 6.2.6 (1). Where
the applied shear force exceeds 50% of the capacity of the section, the high
shear condition applies to the bending moment capacity checks (see below).

The following points should be noted:

• No account is taken of fastener holes in the flange or web - see EC3 6.2.6
(7)

• Shear is not combined with torsion and thus the resistance is not reduced
as per EC3 6.2.6(8)

Web Shear buckling

See: Steel Beam Design to EC3 - Web shear buckling

Bending moment capacity

For low shear this is calculated to EC3 Equation 6.13. In the high shear case
Equation 6.29 is used. Where the high shear condition applies, the moment
capacity calculation is made less complicated by conservatively adopting a
simplified shear area.

Lateral torsional buckling checks (Composite beams: EC4 Eurocode)

You can switch off lateral torsional buckling checks by specifying that the
entire length between the supports is continuously restrained.

If you use this option you must be able to provide justification that the beam is
adequately restrained against lateral torsional buckling during construction.

When the checks are required you can position restraints at any point within
the length of the main beam and can set the effective length of each sub-
beam (the portion of the beam between one restraint and the next) either by
giving factors to apply to the physical length of the beam, or by entering the
effective length that you want to use. Each sub-beam which is not defined as
being continuously restrained is checked in accordance with EC3 clause
6.3.2.3.

Deflection checks (Composite beams: EC4 Eurocode)

Tekla Structural Designer calculates relative deflections. (see: Deflection
checks (page 1888))

The following deflections are calculated for the loads specified in the
construction stage load combination:

• the dead load deflections i.e. those due to the beam self weight, the Slab
Wet loads and any other included dead loads,

• the imposed load deflections i.e. those due to construction live loads,

• the total load deflection i.e. the sum of the previous items.
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The loads are taken as acting on the steel beam alone.

The “Service Factor” (default 1.0), specified against each load case in the
construction combination is applied when calculating the above deflections.

If requested by the user, the total load deflection is compared with either a
span-over limit or an absolute value The initial default limit is span/200.

NOTE Adjustment to deflections. If web openings have been defined, the
calculated deflections are adjusted accordingly. See: Web openings
(page 1915)

Composite stage design (Composite beam: EC4 Eurocode)
Tekla Structural Designer performs all checks for the composite stage
condition in accordance with EC4 unless specifically noted otherwise.

Equivalent steel section - Ultimate limit state (ULS) (Composite beams: EC4 Eurocode)
An equivalent steel section is determined for use in the composite stage
calculations by removing the root radii whilst maintaining the full area of the
section. This approach reduces the number of change points in the
calculations while maintaining optimum section properties.

Section classification (ULS) (Composite beams: EC4 Eurocode)

Tekla Structural Designer classifies the section in accordance with the
requirements of EC3, 5.5.2 except where specifically modified by those of EC4.

A composite section is classified according to the highest (least favorable) class
of its steel elements in compression. The compression flange and the web are
therefore both classified and the least favorable is taken as that for the whole
section.

Flanges of any class that are fully attached to a concrete flange are assumed to
be Class 1. The requirements for maximum stud spacing according to clause
6.6.5.5 (2) are checked and you are warned if these are not satisfied.

There are a small number of sections which fail to meet Class 2 at the
composite stage. Although EC4 covers the design of such members they are
not allowed in this release ofTekla Structural Designer.

Member strength checks (ULS) (Composite beams: EC4 Eurocode)

It is assumed that there are no loads or support conditions that require the
web to be checked for transverse force. (clause 6.5)

Member strength checks are performed at the point of maximum moment,
the point of maximum shear, the position of application of each point load,
and at all other points of interest along the beam.
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Shear capacity (Vertical)

The resistance to vertical shear, VRd, is taken as the resistance of the structural
steel section, Vpl,a,Rd. The contribution of the concrete slab is neglected in this
calculation.

The shear check is performed in accordance with EC3, 6.2.6.

Moment capacity

For full shear connection the plastic resistance moment is determined in
accordance with clause 6.2.1.2. For the partial shear connection clause 6.2.1.3
is adopted.

In these calculations the steel section is idealized to one without a root radius
so that the position of the plastic neutral axis of the composite section can be
determined correctly as it moves from the flange into the web.

Where the vertical shear force, VEd, exceeds half the shear resistance, VRd, a (1-
ρ) factor is applied to reduce the design strength of the web - as per clause
6.2.2.4.

Shear capacity (Longitudinal)

The design condition to be checked is: vEd ≤ vRd where:

vEd = design longitudinal shear stress

vRd = design longitudinal shear strength (resistance)

vEd is evaluated at all relevant locations along the beam and the maximum
value adopted.

vRd is evaluated taking account of the deck continuity, its orientation and the
provided reinforcement.

This approach uses the “truss analogy” from EC2. (See Figure 6.7 of EC2).

In these calculations, two planes are assumed for an internal beam, and one
for an edge beam. Only the concrete above the deck is used in the
calculations.

The values of vRd based on the concrete “strut” and the reinforcement “tie” are
calculated. The final value of vRd adopted is then taken as the minimum of
these two values.

The angle of the strut is minimised to minimise the required amount of
reinforcement - this angle must lie between 26.5 and 45 degrees.

In the calculations of vRd the areas used for the reinforcement are as shown in
the following table.

Decking angle Reinforcement type Area used
perpendicular transverse that of the single bars

defined or for mesh the
area of the main wires[1]
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Decking angle Reinforcement type Area used
other that of the single bars

defined or for mesh the
area of the main wires[1]

parallel transverse that of the single bars
defined or for mesh the
area of the main wires[1]

other single bars have no
contribution, for mesh
the area of the minor
wires[2]

[1]These are the bars that are referred to as longitudinal wires in BS 4483: 1998
Table 1.
[2]These are the bars that are referred to as transverse wires in BS 4483: 1998
Table 1.

If the decking spans at some intermediate angle (θr) between these two
extremes then the program calculates:

• the longitudinal shear resistance as if the sheeting were perpendicular,
vRd,perp,

• the longitudinal shear resistance as if the sheeting were parallel, vRd,par,

• then the modified longitudinal shear resistance is calculated from these
using the relationship, vRd,perpsin2(θr) + vRd,parcos2(θr).

Minimum area of transverse reinforcement (Composite beams: EC4 Eurocode)
The minimum area of transverse reinforcement is checked in accordance with
clause 6.6.6.3.

Shear connectors (ULS) (Composite beams: EC4 Eurocode)

Dimensional requirements

Various limitations on the use of studs are given in the code.

The following conditions in particular are drawn to your attention:

Parameter Rule Clause/Comment
Spacing Ductile connectors may

be spaced uniformly
over length between
critical cross-sections if:

- All critical cross-
sections are Class 1 or 2

6.6.1.3(3) - not checked
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Parameter Rule Clause/Comment
- The degree of shear
connection, h is within
the range given by
6.6.1.2

and

- the plastic resistance
moment of the
composite section does
not exceed 2.5 times the
plastic resistance
moment of the steel
member alone.

Edge Distance eD ≥ 20 mm 6.6.5.6(2) - not checked

eD ≤ 9 * tf*sqrt(235/fy) 6.6.5.5(2) - applies if
bare steel beam flange is
Class 3 or 4 - not
checked

Location If it cannot be located in
the center of trough,
place alternately either
side of the trough
throughout the span

6.6.5.8(3) - not checked

Cover The value from EC2
Table 4.4 less 5mm, or
20mm whichever is the
greater.

6.6.5.2(2) - not checked

The program does not check that the calculated stud layout can be fitted in the
rib of the deck.

Design resistance of the shear connectors

For ribs parallel to the beam the design resistance is determined in
accordance with clause 6.6.4.1. The reduction factor, kl is obtained from
Equation 6.22. For ribs perpendicular to the beam, clause 6.6.4.2 is adopted.

The reduction factor, kt is obtained from Equation 6.23.

The factor kt should not be taken greater than the appropriate value of kt,max
from the following table:
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No of stud
connectors per

rib

Thickness of
sheet,

t mm

Studs with ≤ 20
mm and welded
through profiled
steel sheeting,

kt,max

Profiled sheeting
with holes and

studs with d = 19
or 22 mm,

kt,max
nr = 1 ≤ 1.0 0.85 0.75

> 1.0 1.00 0.75
nr = 2 ≤ 1.0 0.70 0.60

> 1.0 0.80 0.60

NOTE Only the first column of values of kt.max is used from the above table
since the technique of leaving holes in the deck so that studs can be
welded directly to the beam is not used.

For cases where the ribs run at an angle, θr the reduction factor is calculated
as:

kt * sin2 θr + kl * cos2θr

Stud optimization is a useful facility since there is often some over
conservatism in a design due to the discrete changes in the size of the section.

If you choose the option to optimize the shear studs, then Tekla Structural
Designer will progressively reduce the number of studs either until the
minimum number of studs to resist the applied moment is found, until the
minimum allowable interaction ratio is reached or until the minimum spacing
requirements are reached. This results in partial shear connection.

The program can also automatically layout groups of 1 or 2 studs with
constraints that you specify.

The degree of shear connection is checked at the point of maximum bending
moment or the position of a point load if at that position the maximum
utilization ratio occurs.

NOTE During the selection process, in auto design mode point load positions
are taken to be “significant” (i.e. considered as positions at which the
maximum utilization could occur) if they provide more than 10% of
the total shear on the beam. For the final configuration and for check
mode all point load positions are checked.

To determine if the degree of shear connection is acceptable Tekla Structural
Designer applies the following rules:

• If the degree of shear connection at the point of maximum moment is less
than the minimum permissible shear connection, then this generates a
FAIL status,

• If the point of maximum utilization ratio occurs at a point that is not the
maximum moment position and the degree of shear connection is less
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than the minimum permissible shear connection, then this generates a
WARNING status,

• If the degree of shear connection at any other point load is less than the
minimum permissible shear connection, then this does not affect the
status in any way.

Lateral torsional buckling checks (ULS) (Composite beams: EC4 Eurocode)
The concrete slab is assumed to be laterally stable and hence there is no
requirement to check lateral torsional buckling at the composite stage. (Clause
6.4.1).

Section properties - serviceability limit state (SLS) (Composite beams: EC4 Eurocode)

A value of the short term elastic (secant) modulus, Ecm is defaulted in Tekla
Structural Designer for the selected grade of concrete. The long term elastic
modulus is determined by dividing the short term value by a user defined
factor - default 3.0. The elastic section properties of the composite section are
then calculated using these values as appropriate (see the table below).

This approach is used as a substitute for the approach given in EC4 Equation
5.6 in which a knowledge of the creep coefficient, ɸt, and the creep multiplier,
ΨL is required. It is envisaged that you will make use of EN 1992-1-1 (Ref. 6)
when establishing the appropriate value for the factor.

EN 1994-1-1, clause 7.3.1.(8) states that the effect on deflection due to
curvature imposed by restrained drying shrinkage may be neglected when the
ratio of the span to the overall beam depth is not greater than 20. This relates
to normal weight concrete. Tekla Structural Designer makes no specific
allowance for shrinkage curvature but does provide you with a Warning when
the span to overall depth exceeds 20 irrespective of whether the concrete is
normal weight or lightweight. Where you consider allowance should be made,
it is suggested that you include this as part of the 'factor' described above.

Tekla Structural Designer calculates the deflection for the beam based on the
following properties:

Loadcase type Properties used
self-weight bare beam
Slab dry bare beam
Dead composite properties calculated using

the long term elastic modulus
Live composite properties calculated using

the effective elastic modulus
appropriate to the long term load
percentage for each load. The
deflections for all loads in the
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Loadcase type Properties used
loadcase are calculated using the
principle of superposition.

Wind composite properties calculated using
the short term elastic modulus

Total loads these are calculated from the
individual loadcase loads as detailed
above again using the principle of
superposition

Deflection checks (SLS) (Composite beams: EC4 Eurocode)

Tekla Structural Designercalculates relative deflections. (see: Deflection checks
(page 1888)).

The composite stage deflections are calculated in one of two ways depending
upon the previous and expected future load history:

• the deflections due to all loads in the Slab dry loadcase and the self-weight
of the beam are calculated based on the inertia of the steel beam alone
(these deflections are not modified for the effects of partial interaction).

NOTE It is the Slab dry deflection alone which is compared with the limit,
if any, specified for the Slab loadcase deflection.

• the deflections for all loads in the other loadcases of the Design
combination will be based on the inertia of the composite section allowing
for the proportions of the particular load that are long or short term (see
above). When necessary these will be modified to include the effects of
partial interaction.

NOTE Tekla Structural Designerreports the deflection due to imposed
loads alone (allowing for long and short term effects). It also
reports the deflection for the SLAB loadcase, as this is useful for
pre-cambering the beam. The beam Self-weight, Dead and Total
deflections are also given to allow you to be sure that no
component of the deflection is excessive.

NOTE Adjustment to deflections. If web openings have been defined, the
calculated deflections are adjusted accordingly. See: Web Openings
(page 1915)

Stress checks (SLS) (Composite beams: EC4 Eurocode)

There is no requirement to check service stresses in EC4 for buildings (clause
7.2.2). However, since the deflection calculations are based on elastic analysis
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then at service loads it is logical to ensure that there is no plasticity at this load
level.

Tekla Structural Designer calculates the worst stresses in the extreme fibers of
the steel and the concrete at serviceability limit state for each load taking into
account the proportion which is long term and that which is short term. These
stresses are then summed algebraically. Factors of 1.00 are used on each
loadcase in the design combination (you cannot amend these). The stress
checks assume that full interaction exists between the steel and the concrete
at serviceability state. The stresses are not reported unless the stress limit is
exceeded, in which case a warning message is displayed.

Cracking of concrete (SLS) (Composite beams: EC4 Eurocode)

Clause 7.4.1(4) simply supported beams in unpropped construction, requires a
minimum amount of longitudinal reinforcement over an internal support. This
is not checked by Tekla Structural Designer as it is considered a detailing
requirement.

Web openings (Composite beams: EC4 Eurocode)

Circular openings as an equivalent rectangle

Each circular opening is replaced by equivalent rectangular opening, the
dimensions of this equivalent rectangle for use in all subsequent calculations
are:

do'= 0.9 * opening diameter

lo = 0.45 * opening diameter

Properties of tee sections

When web openings have been added, the properties of the tee sections
above and below each opening are calculated in accordance with Section 3.3.1
of SCI P355 (Ref. 8) and Appendix B of the joint CIRIA/SCI Publication P068 (Ref.
9). The bending moment resistance is calculated separately for each of the
four corners of each opening.

Design at construction stage

The following calculations are performed where required for web openings:

• Axial resistance of tee sections

• Classification of section at opening

• Vertical shear resistance

• Vierendeel bending resistance

• Web post horizontal shear resistance

• Web post bending resistance

• Web post buckling resistance
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• Lateral torsional buckling

• Deflections

Design at composite stage

The following calculations are performed where required for web openings:

• Axial resistance of concrete flange

• Vertical shear resistance of the concrete flange

• Global bending action - axial load resistance

• Classification of section at opening

• Vertical shear resistance

• Moment transferred by local composite action

• Vierendeel bending resistance

• Web post horizontal shear resistance

• Web post bending resistance

• Web post buckling resistance

• Deflections

Deflections

The deflection of a beam with web openings will be greater than that of the
same beam without openings. This is due to two effects,

• the reduction in the beam inertia at the positions of openings due to
primary bending of the beam,

• the local deformations at the openings due to vierendeel effects. This has
two components - that due to shear deformation and that due to local
bending of the upper and lower tee sections at the opening.

The primary bending deflection is established by 'discretising' the member
and using a numerical integration technique based on 'Engineer's Bending
Theory' - M/I = E/R = σ/y. In this way the discrete elements that incorporate all
or part of an opening will contribute more to the total deflection.

The component of deflection due to the local deformations around the
opening is established using a similar process to that used for cellular beams
which is in turn based on the method for castellated beams given in the SCI
publication, “Design of castellated beams. For use with BS 5950 and BS 449".

The method works by applying a 'unit point load' at the position where the
deflection is required and using a 'virtual work technique to estimate the
deflection at that position.

For each opening, the deflection due to shear deformation, δs, and that due to
local bending, δbt, is calculated for the upper and lower tee sections at the
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opening. These are summed for all openings and added to the result at the
desired position from the numerical integration of primary bending deflection.

Note that in the original source document on castellated sections, there are
two additional components to the deflection. These are due to bending and
shear deformation of the web post. For castellated beams and cellular beams
where the openings are very close together these effects are important and
can be significant. For normal beams the openings are likely to be placed a
reasonable distance apart. Thus in many cases these two effects will not be
significant. They are not calculated for such beams but in the event that the
openings are placed close together a warning is given.

Precast concrete planks

The effect of web openings on composite beams with PC planks is not within
the scope of SCI P401. Web openings can be modeled but are ignored in both
design at Construction stage and design at Composite stage when a PC plank
is used. Design will be carried out treating the steel beam as one with no web
openings.

Application of NCCI PN002 to Partial Shear Connection (Composite beams: EC4
Eurocode)

An Apply NCCI PN002 check box is available on the Stud strength page of the
Beam Properties. When this option is selected Tekla Structural Designer
calculates partial shear limits described in PN002 for edge beams and SCI
P405 for internal beams.

It should be noted that to obtain the benefits of this NCCI,

• for all deck types and orientation the design live load (γq qk) is limited to 9
kN/m2

• for all deck types and orientation the beam should be “unpropped” at the
construction stage (this is a general assumption in Tekla Structural
Designer for all composite beams).

• for perpendicular trapezoidal decks the studs should be placed on the
“favorable” side or in the central position.

• for perpendicular trapezoidal decks the reinforcement is assumed to be
above the head of the stud. Consequently, a reduction is made to the stud
resistance in accordance with NCCI PN001.

• for limits of maximum longitudinal stud spacing the relevant NCCI must be
satisfied.

• for slab the nominal total depth must not exceed 180mm (depth of
concrete over the decking must not exceed 100mm)

• for all deck profiles the nominal height (to shoulder) must not exceed
80mm (applies to SCI P405 only)

It is the user's responsibility to ensure compliance with the above since the
program makes no check on these items.
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For perpendicular trapezoidal decks the reduction in stud resistance to which
point 4 above refers, will be conservative if the reinforcement is placed in a
more favorable (lower) position. Even though the NCCI is relevant to the UK
this option is also available for all EC head-codes in Tekla Structural Designer.

More information is given in the PN001, PN002 and SCI P405 on www.steel-
ncci.co.uk and on http://www.steelbiz.org/

Steel column design to EC3 (Eurocode)

Design method (Columns: EC3 Eurocode)

Unless explicitly stated all steel column calculations in Tekla Structural
Designerare in accordance with the relevant sections of EC3 (Ref. 1) and the
associated National Annex.

A full range of strength, buckling and serviceability checks are carried out.

NOTE A sway assessment is also performed. This can optionally be de-
activated for those columns for which it would be inappropriate, by
unchecking the Alpha Crit Check box on the Column Properties dialog.

Simple columns (Columns: EC3 Eurocode)

A general column could be designated as a “simple column” to indicate that it
does not have any applied loading in its length. Simplified design rules exist
for such columns as they are only subject to axial forces and moments due to
eccentricity of beam reactions, (moments due to frame action or due to
member loading are assumed not to occur).

NOTE The simple column design rules have not yet been implemented in
Tekla Structural Designer: such columns are thus classed as “beyond
scope” when they are designed.

Ultimate limit state strength (Columns: EC3 Eurocode)
Strength checks relate to a particular point on the member and are carried out
at 5th points and “points of interest”, (i.e. positions such as maximum
moment, maximum axial etc.)

Classification (Columns: EC3 Eurocode)

The classification of the cross section is in accordance with Table 5.2. General
columns can be classified as:

• Plastic Class = 1
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• Compact Class = 2

• Semi-compact Class = 3

• Slender Class = 4

Class 4 sections are not allowed.

Implementation of the below clauses is as follows:

• Classification is determined using 5.5.2 (6) and not 5.5.2 (7).

• 5.5.2 (9) is not implemented as clause (10) asks for the full classification to
be used for buckling resistance.

• 5.5.2 (11) is not implemented.

• 5.5.2 (12) is not implemented. A brief study of UK rolled UBs and UCs
showed that flange induced buckling in normal rolled sections is not a
concern.

Axial capacity (Columns: EC3 Eurocode)

The axial tension and compression capacity checks are performed according
to clause 6.2.3 and clause 6.2.4 respectively.

The following points should be noted:

• Clause 6.2.3 (3) - is not considered

• Clause 6.2.3 (4) - is not considered

• Clause 6.2.3 (5) - is not considered

Shear capacity (Columns: EC3 Eurocode)

The shear check is performed at the point under consideration according to
clause 6.2.6(1):

• for the absolute value of shear force normal to the y-y axis, Vy,Ed, and

• for the absolute value of shear force normal to the z-z axis, Vz,Ed

The following points should be noted:

• No account is taken of fastener holes in the flange or web - see 6.2.6 (7)

• Shear is not combined with torsion and thus the resistance is not reduced
as per 6.2.6 (8)

Shear buckling

When the web slenderness exceeds 72ε shear buckling can occur in rolled
sections. Tekla Structural Designer designs for shear web buckling with
accordance to EN 1993-1-5:2006.

The following should however, be noted:

Design codes reference 1919 Eurocodes



• The approach to design assumes a non-rigid end post, this is more
conservative than the design that takes the approach assuming a rigid end
post.

• Physical support conditions have been assumed to be equivalent to
“transverse stiffeners at supports only”.

• All hole cut outs must be small in accordance to section EN 1993-1-5:2006
2.3

• If a grade of steel was to be used other than S335, S355 and S460 η will be
taken as 1.00 regardless of National Annex.

As we are only designing for the case where no stiffeners are being used, a →
∞ therefore c → ∞ so Vbf,Rd → 0, where Vbf,Rd is the contribution from the
flange - see 5.4(1)

The design assumes negligible contribution to the design shear force VEd from
shear from torque, therefore VEd is restricted to 0.5 Vbw,Rd . Tekla Structural
Designer will warn you if this limit is exceeded - see 7.1(1)

Moment capacity (Columns: EC3 Eurocode)

The moment capacity check is performed at the point under consideration
according to clause 6.2.5(1):

• for the moment about the y-y axis, My,Ed, and

• for the moment about the z-z axis, Mz,Ed

The moment capacity can be influenced by the magnitude of the shear force
(“low shear” and “high shear” conditions). Where the high shear condition
applies, the moment capacity calculation is made less complicated by
conservatively adopting a simplified shear area.

The maximum absolute shear to either side of a point of interest is used to
determine the moment capacity for that direction.

High shear condition about y-y axis

The treatment of high shear is axis dependent. In this release for CHS, if high
shear is present, the moment capacity check about the y-y axis is Beyond
Scope.

High shear condition about z-z axis

For rolled sections in this release, if high shear is present normal to the z-z axis
then the moment capacity check about the z-z axis is Beyond Scope.

For hollow sections, there is greater potential for the section to be used to
resist the principal moments in its minor axis. Of course for CHS and SHS
there is no major or minor axis and so preventing high shear arbitrarily on one
of the two principal axes does not make sense. Nevertheless, if high shear is
present normal to the z-z axis then in this release the moment capacity about
the z-z axis is not calculated, the check is Beyond Scope.
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If high shear is present in one axis or both axes and axial load is also present,
the moment capacity check is given a Beyond Scope status.

If high shear and moment is present in both axes and there is no axial load
(“biaxial bending”) the moment capacity check is given a Beyond Scope status.

Combined bending and axial capacity (Columns: EC3 Eurocode)

The combined bending and axial capacity check covers the interaction of axial
load and bending to clause 6.2.9 appropriate to the type (for example – doubly
symmetric) and classification of the section.

If high shear is present in one axis or both axes and axial load is also present,
the cross-section capacity check is given a Beyond Scope status.

If high shear and moment is present in both axes and there is no axial load
(“biaxial bending”) the cross-section capacity check is given a Beyond Scope
status.

The following additional points should be noted:

the combined effects of axial load and bending are assessed and clause 6.2.9
(4) is not considered.

the current “reduced plastic moduli” approach in the published tables is used
and not the approximate method given in 6.2.9.1(5). The latter is less
conservative than the current approach at low levels of 'n'.

Ultimate limit state buckling (Columns: EC3 Eurocode)

NOTE Classification for buckling checks - For rolled I sections, RHS and SHS
classification varies along the member length due to the section forces
changing along the member length - for combined buckling, the worst
classification of the whole member (column stack) should be used. In
theory it should be the worst classification in the segment length
considered for buckling. However, the segment lengths for lateral
torsional buckling, minor axis strut buckling and major axis strut
buckling can all be different. It is simpler and conservative therefore to
use the worst classification in the entire member length (column
stack).

Compression buckling (Columns: EC3 Eurocode)
General columns must be checked to ensure adequate resistance to buckling
about both the major and minor axes and they must also be checked in the
torsional mode over an associated buckling length. Since the axial force can
vary throughout the column and the buckling lengths in the two planes do not
necessarily coincide, all buckling modes must be checked. There may be
circumstances where it would not be safe to assume that the combined
buckling check will always govern (see below).
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Restraints

Restraints to strut buckling are determined from the incoming members
described within Tekla Structural Designer. The buckling checks are based on
these.

Restraining members framing into either Face A or C will provide restraint to
major axis strut buckling. Members framing into either Face B or D will provide
restraint to minor axis strut buckling. Tekla Structural Designer determines the
strut buckling restraints but you can override these.

NOTE The program assumes that any member framing into the major or
minor axis of the column provides restraint against strut buckling in
the appropriate plane. If you believe that a certain restraint in a
particular direction is not effective then you can either override the
restraint or adjust the effective length to suit – to 2.0L for example.

Torsional and torsional flexural buckling restraint is only provided at points
restrained coincidentally against major and minor axis strut buckling.
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NOTE Provided a level is restrained coincidentally against major and minor
axis strut buckling, the program assumes that any member framing
into the appropriate faces provides restraint against torsional and
torsional flexural buckling at that level. There are a number of
practical conditions that could result in torsional restraint not being
provided at floor levels. At construction levels this is even more
possible given the likely type of incoming member and its associated
type of connection. You must consider the type of connection
between the incoming members and the column since these can have
a significant influence on the ability of the member to provide
restraint to one, none or both column flanges. For example, consider
a long fin plate connection for beams framing into the column web
where the beam stops outside the column flange tips to ease
detailing. The fin plate is very slender and the beam end is remote
from the column flanges such that it may not be able to provide any
restraint to torsional or torsional flexural buckling. The fact that a slab
is usually present may mitigate this. You are expected to override the
ineffective restraint.

Tekla Structural Designer always assumes full restraint at the base and at the
roof level when carrying out buckling design checks – you are warned on
validation if your restraint settings do not reflect this. Restraints are
considered effective on a particular plane providing they are within ±45° to the
local coordinate axis system.

Effective lengths

In all cases Tekla Structural Designer sets the default effective length to 1.0L, it
does not attempt to adjust the effective length in any way. You are expected to
adjust the strut buckling effective length factor (up or down) as necessary.
Different values can apply in the major and minor axis.

NOTE It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints. The default value for the effective
length factor of 1.0L may be neither correct nor safe.

The torsional and torsional flexural buckling effective length factor (1.0L) can
not be changed.

Any strut buckling effective length can take the type “Continuous” to indicate
that it is continuously restrained over that length. There is no facility for
specifying torsional, or torsional flexural buckling effective lengths as
“Continuous”.

There is no guidance in EC3 on the values to be used for effective length
factors for beam-columns.

For general columns - The minimum theoretical value of effective length
factor is 0.5 and the maximum is infinity for columns in rigid moment resisting
(RMR) frames. Practical values for simple columns are in the range 0.7 to 2.0
(see For simple columns below). In theory, values less than 1.0 can be chosen
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for non-sway frames or for sway frames in which the effects of sway are taken
into account using either the amplified forces method or P-Delta analysis.
However, EC3 states that when second-order effects are included in this way
then the design “may be based on a buckling length equal to the system
length” i.e. an effective length factor of 1.0. The program default of 1.0
matches this requirement but allows you flexibility for special situations.

One such situation might be in RMR frames where the principal moments due
to frame action preventing sway are in one plane of the frame. There will often
be little or no moment out-of-plane and so, if using the amplified forces
method, the amplification of these moments has little effect on the overall
design. Nevertheless the stability out-of-plane can still be compromised by the
lack of restraint due to sway sensitivity in that direction. In such cases a value
of greater then 1.0 (or substantially greater) may be required. Similarly, in
simple construction where only eccentricity moments exist, it is only the brace
forces that 'attract' any amplification. Thus for the column themselves the
reduced restraining effect of a sway sensitive structure may require effective
length factors greater than 1.0.

For Simple columns - There is no concept of simple columns in EC3 and
hence no information on effective lengths either. However, reference can be
made to the “NCCI” on the subject of simple construction but none of this
includes the clear guidance on effective lengths of simple columns that was
included as Table 22 in BS 5950-1: 2000. Again the program defaults the
effective length factor to 1.0

Compression resistance

The relevant buckling resistances are all calculated from Equation 6.47.

These consist of the flexural buckling resistance about both the major and
minor axis i.e. Nb,y,Rd and Nb,z,Rd over the buckling lengths Lyy and Lzz and
where required the buckling resistance in the torsional or flexural-torsional
modes, Nb,x,Rd.

All section types are checked for flexural buckling. It is only hollow sections
that do not need to be checked for torsional and torsional-flexural buckling.

Lateral torsional buckling (Columns: EC3 Eurocode)

Effective lengths

The value of effective length factor is entirely your choice. The default value is
1.0 and is editable for flanges A & C. Any individual segment (for either flange)
can be 'continuously restrained' in which case no lateral torsional buckling
(LTB) check is carried out for that flange over that segment.

For a level to be treated as torsional restraint it must have both A and C
restraint and also be restrained for compression buckling in both the major
and minor axis.

There is no specific factor for destabilizing loads - you can however adjust the
'normal' effective length factor to allow for such effects.
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Lateral torsional buckling resistance

The LTB resistance is calculated from Equation 6.55.

LTB does not need to be checked for the following sections:

• circular and square hollow sections,

• equal and unequal flanged I/H sections loaded in the minor axis only.

Combined buckling (Columns: EC3 Eurocode)

The column must be restrained laterally in two directions, and torsionally at
the top and bottom of the 'design length'. This equates to LTB restraint to
faces A and C and restraint to major and minor axis compression buckling all
being coincident. A design length is allowed to have intermediate restraint and
if the restraint requirements are not met at a particular floor then the design
length does not have to be between adjacent floors. Thus a stack can 'jump'
floors or sheeting rails can be attached. It is assumed that the restraints for
compression buckling are fully capable of forcing the buckled shape. Hence,
the compression buckling resistance is based on the restrained lengths whilst
the LTB resistance ignores the intermediate restraint and hence is based on
the full design length.

NOTE It is conservative to ignore the intermediate restraints in this latter
case.

Loading within the design length is allowed.

Effective lengths

Effective lengths for flexural (i.e. strut major and strut minor) and lateral
torsional buckling are as described in the appropriate section above.

Combined buckling resistance

The combined buckling resistance is checked in accordance with Equations
6.61 and 6.62. Both equations are evaluated at the ends of the design length
and, except for simple columns, at the position of maximum moment, if that
lies elsewhere.

Eccentricity moments due to beam end reactions are added to the “real”
moments due to frame action:

• in the first case the uniform moment factors are calculated from the real
moments and applied to the real moments. Eccentricity moments are only
added if they are more critical.

• in the second case all moments are “combined” and all uniform moment
factors are based on the combined moments and applied to them.

WARNING Equations 6.61 and 6.62 are limited to doubly symmetric sections
and do not consider torsional or torsional flexural buckling.
Should either of these buckling modes govern the compression
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buckling check, you should consider very carefully whether the
calculations provided by Tekla Structural Designer for combined
buckling can be considered valid.

Serviceability limit state (Columns: EC3 Eurocode)

The column is assessed for sway and the following values are reported for
each stack:

• Sway X and αcritx

• Sway Y and αcrity

• Sway X-Y

Depending on the reported αcrit the column is classified as Sway or Non sway
accordingly.

NOTE A sway assessment is only performed for the column if the Alpha Crit
Check box is checked on the Column Properties dialog. If very short
columns exist in the building model these can distort the overall sway
classification for the building. For this reason you may apply
engineering judgement to uncheck the Alpha Crit Check box for those
columns for which a sway assessment would be inappropriate.

Steel brace design to EC3 (Eurocode)

Design method

Unless explicitly stated all brace calculations are performed in accordance with
the relevant sections of BS EN 1993-1-1:2005 (Ref. 1) (herein abbreviated to
EC3) and the associated National Annex.

A basic knowledge of the design methods for braces in accordance with the
design code is assumed.

Classification

No classification is required for braces in tension.

Braces in compression are classified according to Table 5.2 as either: Class 1,
Class 2, Class 3 or Class 4.

Class 4 sections are not allowed.

Axial tension

An axial tension capacity check is performed according to clause 6.2.3.(1)

The following points should be noted:

• Clause 6.2.3 (3) - is not considered
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• Clause 6.2.3 (4) - is not considered

• Clause 6.2.3 (5) - is not considered

Axial compression

An axial compression capacity check is performed according clause 6.2.4.(1)

Compression buckling

If axial compression exists, the member is also assessed according to clause
6.3.1.1(1) for flexural buckling resistance about both the major and minor axis
i.e. Nb,y,Rd and Nb,z,Rd over the buckling lengths Lyy and Lzz and where required
the torsional, or flexural-torsional buckling resistance, Nb,x,Rd.

For single and double angles (both equal and unequal) there is also a
compression buckling check about the v-v axis, over the buckling length Lvv.
For single angles, Lvv is the system length L, while for double angles Lvv is L/3.

All section types are checked for flexural buckling. It is only hollow sections
that do not need to be checked for torsional and torsional-flexural buckling.

Different effective length factors can be applied for flexural buckling in the
major and minor axis. For single and double angles an effective length factor
can also be applied in the v-v axis. The default effective length is 1.0L in all 3
cases. You are expected to adjust the effective length factor (up or down) as
necessary.

The torsional and torsional flexural buckling effective length factor (1.0L) can
not be changed.

Steel single, double angle and tee section design to EC3 (Eurocode)

Design method (Angles and tees: EC3 Eurocode)

The EC3 (Ref. 1) design method adopted is dictated by the member
characteristic type:

• “Beam”, “Truss member top” or “Truss member bottom” characteristic:

• Member is designed for axial tension, compression, shear, bending and
combined forces - consistent with the method detailed in Steel Beam
Design to EC3 (page 1889)
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• “Brace”, “Truss internal” or “Truss member side” characteristic:

• Member is designed for axial tension, compression and compression
buckling only - consistent with the method detailed in Steel Brace
Design to EC3 (page 1926)

NOTE Additional Angle and tee limitations (page 1928)have to be considered
when designing these sections to the above design methods.

Angle and tee limitations (EC3 Eurocode)

In the current version when designing tees, single, and double angles to EC3,
the following checks remain beyond scope:

 Tee Angle Double angle
Classification ok ok ok
Axial tension ok ok ok
Axial compression ok ok ok
Shear ok ok ok
Buckling ok ok ok
Combined
strength

ok ok ok

LTB Beyond scope ok Beyond scope
Combined
buckling

Beyond scope Beyond scope Beyond scope

Deflection ok ok ok

In addition, the following limitations apply:

• All sections and in particular single angles are assumed to be effectively
loaded through the shear center such that no additional torsion moments
are developed. In addition no direct allowance is made for 'destabilizing
loads'.

• Design excludes bending of the outstand leg of single and double angles
loaded eccentrically e.g. supporting masonry.

• Conditions of restraint can be defined as top and bottom flange for lateral
torsional buckling LTB. It is upon these that the buckling checks will be
based. For the current release intermediate LTB restraints are omitted (i.e.
only fully restrained for LTB, or unrestrained).

• Single, double angles and tee sections subject to moment with high shear
are beyond scope.

Section axes (Angles and tees: EC3 Eurocode)
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For all sections:

• y-y is the axis parallel to the flanges (major axis)

• z-z is the axis perpendicular to the flanges (minor axis)

• for Single angles and Double angles

• z-z parallel to long side (leg) - single angles

• z-z parallel to long side (leg) - double angles with long leg back to back

• z-z parallel to short side (leg) - double angles with short leg back to back

• u-u is the major principal axis for single angles

• v-v is the minor principal axis for single angles

Single angles - Section axes

Design procedures (Angles and tees: EC3 Eurocode)

This section includes key notes and assumptions made for the EC3 (Ref. 1)
design of tees and angle sections.

Classification checks

For axial compression and bending both the web and flange (Leg 1 and Leg 2)
are classified as Class 1, Class 2, Class 3 or Class 4 and the worst of the two is
the resultant classification for that cross section.

The rules from Table 5.2 (sheet 2 of 3) of EC3 are used for tee sections. In
particular the rules of “Part subject to compression” are used to classify the
tee section since these are more conservative compared to the limits of “Part
subject to bending and compression”.
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For double angles and single angles the rules from Table 5.2 (sheet 3 of 3) of
EC3 are used.

NOTE Class 4 section classification is only allowed for tees, double angles
and single angles.

Axial tension check

Section 6.2.3 of EC3 is used for this design check.

Axial compression check

Section 6.2.4 of EC3 is used for this design check.

Effective length:

The value of effective length factor is entirely at the user’s choice. The default
value is generally 1.0 although for truss members, there are special settings
for the effective length depending upon the type of section and its position in
the truss.

Different values can apply in the major and minor axis. Coincident strut
restraint points in these two directions define the length for torsional and
torsional flexural buckling and this can also have an effective length factor
(this is assumed to be 1.0 and cannot be changed).

There is no guidance in EC3 on the values to be used for effective length
factors for beam-columns although Annex BB does contain some information
on the effective lengths to be used in trusses but not for single, double angles
and tees.

It is the responsibility of the user to adjust the value from 1.0 (for the effective
length factor) and to justify such a change on the compression page.

For tees:

Check:

1. the buckling length in the major axis – Use Lyy = L * major factor

2. the buckling length in the minor axis – Use Lzz = L * minor factor

3. the buckling length for the torsional mode – Use Lxx = 1.00 * minor factor

For single and double angles:

Check:

1. the buckling length in the major axis – Use Lyy = L * major factor

2. the buckling length in the minor axis – Use Lzz = L * minor factor

3. the buckling length for the torsional mode – Use Lxx =1.00 * L

a. Double angles – Check as single angle

1. Use Ly = Lyy/ 3

2. Use Lz = Lzz/ 3
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3. Use Lx = Lxx/ 3

b. Double angles – Check as double angle

4. the buckling length for the principal axis, v-v – Use Lvv = 1.00 * L

a. Double angles – Check as single angle

1. Use Lv = Lvv/3

For double angles for (4) & (3a) minor principal axis buckling & torsional
buckling respectively – half of the axial force and half of the double angle area
is used.

Shear check

Section 6.2.6 of EC3 is used for this design check.

Moment check

Section 6.2.5 of EC3 is used for this design check.

NOTE Tees, double angles and single angles are designed as Class 4.
Equation 6.15 is used for class 4 slender sections.

NOTE Tees, double angles and single angles subject to moment with high
shear are beyond scope.

Moment capacity for Class 4 slender sections:

Class 4 sections are designed as Class 3 effective sections.
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Hence, additional moments are induced in the member due to the shift of the
centroid of the effective cross-section compared to that of the gross section
when under axial compression only.

Thus:

ΔMEd,y = ey × NEd,max

ΔMEd,z = ez × NEd,max

Where:

NEd,max is the max compressive force in the span.

For tees and double angles ey = 0. Hence, total minor design moment = minor
design moment.

Where:

ey and ez = the shift of the centroid of the effective area Aeff relative to the
centre of gravity of the gross cross section

ey = abs(cynew – cy)

ez = abs(cznew – cz)

So finally, a total moment is obtained for which the moment design check is
performed:

Mtotal y = Abs(MEd,y) + Abs(ΔMEd,y)

Mtotal z = Abs(MEd,z) + Abs(ΔMEd,z)

Single angles - asymmetric sections:

Single angles with continuous lateral – torsional restraint along the length are
permitted to be designed on the basis of geometric axis (y, z) bending.

Single angles without continuous lateral – torsional restraint along the length
are designed using the provision for principal axis (u, v) bending since we
know that the principal axes do not coincide with the geometric ones.

ΔMu = ΔMy × cosϑ + ΔMz × sinϑ

ΔMv = -ΔMy × sinϑ + ΔMz × cosϑ

Note that when principal axis design is required for single angles and the
classification is Class 4, all moments are resolved into the principal axes (total
moment in the principal axes u-u and v-v).

Combined bending and axial check

Section 6.2.9 of EC3 is used for this design check.

For Class 3 - Equation 6.42 is applied:

Abs (NEd / A) + abs (My,Ed /Wel,min,y) + abs (Mz,Ed/Wel,min,z) ≤ fy / γM0

For Class 4 - Equation 6.43 is applied:
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Abs (NEd/Aeff) + (abs (My,Ed) + abs (ΔMy,Ed)) / Weff,min,y + abs (Mz,Ed) + abs
(ΔMz,Ed)) / Weff,min,z ≤ fy / γM0

Note that total moments are used when the section classification is Class 4.

For Class 4 cross section capacity - Equation 6.44 is applied.

Lateral torsional buckling check

NOTE LTB check for tees and double angles is currently beyond scope.

EC3 is completely silent on LTB check for asymmetric sections such as single
angles and mono-symmetric sections such as double angles and tees.

Hence we follow the approach of the Blue Book (Ref. 10 (page 1934)):

Firstly we calculate the equivalent slenderness coefficient (φ) (From Blue book)
and the equivalent slenderness λLT (BS approach).

Then we find the non-dimensional slenderness  in order to follow the EC
design approach.

Conservatively we have taken: 

NOTE All intermediate LTB restraints for single angles, double angles and
tees are ignored.

Combined buckling check

In the current version this check is beyond scope for single angles, double
angles and tees.

Deflection of single angles (Eurocode)

If a single angle is continuously restrained the major geometric moment and
major geometric section properties are used in the general equation
governing the beam deflection.
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Single angle deflections (continuously restrained, unrestrained)

However, because single angle geometric axes are not coincident with the
principal axes; a different procedure is required if the angle is not
continuously restrained, the procedure being as follows:

1. External loads are transposed from the geometric axes to the principal
axes.

2. The deflection equations are used to calculate deflections in the principal
axes.

3. These principal axis deflections are then transposed to geometric axes
again.

References to EC3 and EC4 (Eurocode)

1. British Standards Institution. BS EN 1993-1-1:2005. Eurocode 3: Design
of steel structures – Part 1-1: General rules and rules for buildings. BSI
2005.

2. British Standards Institution. NA to BS EN 1993-1-1:2005. UK National
Annex to Eurocode 3: Design of steel structures – Part 1-1: General rules
and rules for buildings. BSI 2005.

3. National Standards Authority of Ireland. I.S EN 1993-1-1 National
Annex. Irish National Annex (informative) to Eurocode 3: Design of steel
structures – Part 1-1: General rules and rules for buildings. NSAI 2007.

4. British Standards Institution. BS EN 1994-1-1:2004. Eurocode 4: Design
of composite steel and concrete structures - Part 1-1: General rules and
rules for buildings. BSI 2005.

5. British Standards Institution. NA to BS EN 1994-1-1:2004. UK National
Annex to Eurocode 4: Design of composite steel and concrete structures -
Part 1-1: General rules and rules for buildings. BSI 2005.

6. British Standards Institution. BS EN 1992-1-1:2004. Eurocode 2: Design
of concrete structures. General rules and rules for buildings. BSI 2004.
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7. The Steel Construction Institute. Publication 076. Design Guide on the
Vibration of Floors. SCI 1989.

8. The Steel Construction Institute. Publication P355. Design of Composite
Beams with Large Web Openings. SCI 2011.

9. The Steel Construction Institute. Publication 068. Design for openings in
the webs of composite beams. SCI 1987.

10. The Steel Construction Institute and The British Constructional
Steelwork Association Ltd. Publication P363. Steel Building Design:
Design Data. SCI and BCSA 2009.

Concrete design to EC2 (Eurocode)

Tekla Structural Designer designs reinforced concrete members to a range of
international codes. This reference guide specifically describes the design
methods applied in the software when BS EN 1992-1-1:2004 (Ref. 1)
(page 1989) is selected.

Unless explicitly noted otherwise, all clauses, figures and tables referred to are
from BS EN 1992-1-1:2004

Within the remainder of this guide BS EN 1992-1-1:2004 is referred to as EC2.

General parameters (EC2)

Shrinkage and Creep

The following design parameters can be specified individually as part of each
member's properties set.

Permanent Load Ratio

This is the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,
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SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all
members - you are advised to consider if this is appropriate and
adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.

Reinforcement Anchorage Length Parameters

Max. Bond Quality Coefficient

Acceptable input range 0.5 to 1.0

In the bond stress calculation (Cl 8.4.2), the bond quality coefficient η1 can be
either 1.0 or 0.7 depending on section depth. Where 0.7 is used the bond
strength is reduced and laps are extended.

Specifying a maximum of 1.0 for the Bond Quality Coefficient allows the
coefficient to vary between 0.7 and 1.0 as required, hence lap lengths will vary
accordingly.

Some users may prefer to specify a maximum of 0.7 (which actually fixes the
coefficient at 0.7), the effect is to standardise on the use of extended lap
lengths throughout. Further conservatism can be introduced in all lap lengths
by using a value as low as 0.5.

Plain Bars Bond Quality Modifier

Acceptable input range 0.1 to 1.0

In the EC2 Cl 8.4.2 bond stress calculation, there is no factor relating to the rib
type of reinforcement, and no guidance on what adjustments if any should be
made for plain bars.

In Tekla Structural Designer a factor "T" has been introduced (as in BS8110) to
allow for this adjustment. It is the users responsibility to enter a suitable value
for plain bars. (Until further guidance becomes available, we would suggest
that as per BS8110 a value of 0.5 would be reasonable.)

Type-1 Bars Bond Quality Modifier

Acceptable input range 0.1 to 1.0
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In the EC2 Cl 8.4.2 bond stress calculation, there is no factor relating to the rib
type of reinforcement, and no guidance on what adjustments if any should be
made for Type 1 bars.

In Tekla Structural Designer a factor "T" has been introduced (as in BS8110) to
allow for this adjustment. It is the users responsibility to enter a suitable value
for Type 1 bars. (Until further guidance becomes available, we would suggest
that as per BS8110 a value of 0.8 would be reasonable.)

Concrete beam design to EC2 (Eurocode)

The topics in this section describe how the software applies BS EN
1992-1-1:2004 (Ref. 1) (page 1989) to the design of reinforced concrete beams.

Limitations (concrete beam: EC2)

The following general exclusions apply:

• Seismic design,

• Consideration of fire resistance. [You are however given full control of the
minimum cover dimension to the reinforcement and are therefore able to
take due account of fire resistance requirements.]

• Openings in the beam web.

• Bundled bars.

• Design for minor axis bending and shear.

• Design for axial forces.

In addition, for beams classified as "deep beams":

• all beams with a ratio of 1.5 < span/overall depth ≤ 3.0 are designed but
with an appropriate Warning

• beams with a ratio of span/overall depth ≤ 1.5 are Beyond Scope

Slender beams (concrete beam: EC2)

Second order effects associated with lateral instability may be ignored if
beams are within the geometric limits given by the following;

L0t ≤ 50*bcomp/(h/bcomp)1/3

and

h/bcomp ≤ 2 .5

where

L 0t = the distance between torsional restraints, which in Tekla Structural
Designer is taken as the distance between the faces of the
supports
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h = the total overall depth of the beam at the centre of L 0t

b comp = the width of the compression flange of the beam ( = b w for
rectangular sections and b eff for flanged beams)

If either of the above checks fail then a Warning is displayed.

Cover to reinforcement (concrete beam: EC2)

The nominal concrete cover is the distance between the surface of the
reinforcement closest to the nearest concrete surface (including links and
surface reinforcement where relevant) and the nearest concrete surface.

You are required to set a minimum value for the nominal cover, c nom, u, for
the top, bottom, sides and ends of each beam in the beam properties.

These values are then checked against the nominal limiting cover, cnom,lim
which depends on the diameter of the reinforcement plus an allowance for
deviation, Δcdev (specified in Design Options > Beam > General Parameters).

Generally, the allowance for deviation, Δcdev is a NDP.1 The recommended
value is 10mm, but under strict controls it can be reduced to 5mm.

If cnom,u < cnom,lim then a warning is displayed in the calculations.

1 BS EN 1992-1-1:2004 cl 4.4.1.3 (1)P
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Design parameters for longitudinal bars (EC2)

For each of these parameters, any user defined limits (as specified on the
appropriate Reinforcement Settings page within Design Options) are
considered in addition to the EC2 or NA recommendations.

Minimum diameter of reinforcement for pad and strip bases

For design in accordance with EC2 Recommendations;

φmin   =  8 mm

For design in accordance with UK NA, Irish NA and Malaysian NA;

φmin   =  8 mm

For design in accordance with Singapore NA;

φmin   =  10 mm

Maximum diameter of reinforcement

At Section 8.8 of BS EN 1992-1-8:2004, additional rules are specified when
"large diameter bars" are used in the design. A large diameter bar is defined
as being a bar with a diameter larger than φlarge where φlarge is an NDP value.

For design in accordance with EC2 Recommendations;

φlarge   =  32 mm

For design in accordance with UK NA, Irish NA, Malaysian NA and Singapore
NA;

φlarge   =  40 mm

In the current release the provisions of Section 8.8 are not implemented. If the
design results in a bar size with φ > φlarge then a warning is displayed.

NOTE Clause 7.3.3 (2) indicates that cracking can be controlled either by
restricting the bar diameter or the max spacing. Tekla Structural
Designer adopts the latter approach using Table 7.3N - therefore the
maximum bar diameters specified in Table 7.2N are not checked.

Minimum distance between bars

The minimum clear horizontal distance between individual parallel bars, s
cl,min, is given by;1

1 BS EN 1992-1-1:2004 Section 8.2(2)
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scl,min   ≥  MAX [k1*φ, dg+k2,
scl,u,min, 20 mm]

where

k1   =  the appropriate NDP

k2   =  the appropriate NDP

dg   =  the maximum size of
aggregate

φ   =  the maximum diameter
of adjacent bars, φi and
φj

scl,u,min   =  user specified minimum
clear distance between
bars

NOTE To allow you to make decisions regarding access for concrete
compaction or size of aggregate, a value for the minimum clear
distance between bars can be specified on the appropriate
Reinforcement Settings page within Design Options - separate values
being set for bars in the top of a beam and for those in the bottom of
a beam.

The minimum clear vertical distance between horizontal layers of parallel bars,
scl,min, is given by;

scl,min   ≥   MAX[k1*φ, dg+k2, 20
mm]

For design in accordance with UK NA,EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

k1   =   1.0

k2   =   5.0 mm

Maximum spacing of tension bars

The maximum centre to centre bar spacing for crack control, s cr,max, is
dependent on the maximum allowable crack width, wmax, specified in the
beam properties from a menu of values which are: 0.20mm, 0.30mm or
0.40mm with a default value of 0.30mm.

The service stress in the reinforcement, σs, is given by;

σs   =  (As,reqd/As,prov)*(fyk/γs)*R
PL
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where

As,reqd   =  area of reinforcement
required for the
maximum design
Ultimate Limit State
moment, MEd

As,prov   =  area of reinforcement
provided

RPL   =  permanent load ratio

In the beam properties you are required to supply a value for the permanent
load ratio, RPL. A default of 0.65 has been assumed, but you are advised to
consider if this is appropriate and adjust as necessary.

The maximum allowable centre to centre bar spacing, scr,max, is then obtained
from table 7.3N (shown below) by looking up the calculated value of the
service stress in the reinforcement, σs, using interpolation between values of
σs

Steel Service
Stress,

σs (N/mm2)

Max Allowable bar Spacing, scr,max

wmax = 0.40 mm wmax = 0.30 mm wmax = 0.20 mm

≤ 160 300 300 200
200 300 250 150
240 250 200 100
280 200 150 50
320 150 100 Warning
360 100 50 Warning
>360 Warning Warning Warning

Maximum spacing of tension bars (slabs not exceeding 200mm)

In accordance with clause 7.3.3(1) of EC2 for slabs not exceeding 200mm in
overall depth and not subjected to significant axial tension the maximum limit
on centre to centre bar spacing is governed by clause 9.3 only and there is no
need to perform specific checks on the bar spacings to control cracking. These
limits are applied to all slabs and then the additional limit in the next section
are applied to slabs greater than 200mm thick.

From clause 9.3 the maximum limit on bar spacings can be somewhat
subjective so these limits will be user definable with conservative defaults as
follows :-

Principal bars (NDP) (cl. 9.3.1.1(3))

smax = 2h but ≤ 250mm
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Secondary bars (NDP) (cl. 9.3.1.1(3))

smax = 3h but ≤ 400mm

Bars are classed as secondary if both the following are true:

1. The design moment for bars in this direction is lower than the design
moment for bars in the other direction.

2. The calculated reinforcement requirement based on the design moment
is less than the minimum reinforcement requirement.

Minimum area of reinforcement

The minimum area of longitudinal tension reinforcement, A s,min, is given by;2

As,min   ≥  MAX[kmin1*bw*d*(fctm/
fyk), kmin2*bw*d]

where

k min1   =  the appropriate NDP
value

k min2   =  the appropriate NDP
value

f ctm   =  mean value of the axial
tensile strength of the
concrete

f yk   =  characteristic yield
strength of the
reinforcement

For design in accordance with UK NA,EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

k min1   =  0.26

k min2   =  0.0013

NOTE Note that there is no requirement to have a minimum area of
compression reinforcement.

The minimum area of longitudinal tension reinforcement for crack control,
As,min,cr is given by;3

As,min,cr   ≥  0.4*k*fctm*Act/σs

2 BS EN 1992-1-1:2004 Section 9.2.1.1(1)
3 BS EN 1992-1-1:2004 Section 7.3.2(2)
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where

k   =  1.0 when h ≤ 300
  0.65 when h ≥ 800
fctm   =  mean value of axial

tensile strength of
concrete

  0.30*fck (2/3) for concrete
grades ≤ C50/60

  2.12*ln(1+((fck+8)/10))
for concrete grades >
C50/60

σs   =  the interpolated
reinforcement service
stress from appropriate
for the bar spacing of
the reinforcement
provided

Act   =  area of concrete in
tension just before
formation of first crack

   =  b*y where y = the
distance of the Elastic
NA from bottom of
beam

The minimum area of longitudinal tension reinforcement required, As,min,reqd,
is then given by;

As,min,reqd   ≥  MAX (As,min, As,min,cr)

Maximum area of reinforcement

The maximum area of longitudinal tension reinforcement, A st,max, is given by;4

Ast,max   ≤   kmax*Ac

The maximum area of longitudinal compression reinforcement, Asc,max, is
given by;

Asc,max   ≤   kmax*Ac

where

4 BS EN 1992-1-1:2004 Section 9.2.1.1(3)
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k max   =  the appropriate NDP
value

A c   =  the cross sectional area
of the beam

   =  h*b w

For design in accordance with UK NA,EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

kmax   =  0.04

       

Side reinforcement (concrete beam: EC2)

To control cracking in beams with a total depth ≥ 1000 mm, side bars are
provided in the side faces of the beam as per BS EN 1992-1-1:2004 Section
7.3.3(3).

Effective depth of section (concrete beam: EC2)

For the design of the longitudinal tension reinforcement, the effective depth of
a section, d is defined as the distance from the extreme concrete fibre in
compression to the centre of gravity of the longitudinal tension reinforcement.

For the design of the longitudinal compression reinforcement, the effective
depth in compression, d2 is defined as the distance from the extreme fibre in
compression to the centre of gravity of the longitudinal compression
reinforcement.
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Design for bending for rectangular sections (beams and slabs: EC2)

Calculate the value of K from;

K = MEd/(fck*bw*d2)

Then calculate the limiting value of K, known as K' from;

K' = (2*η*αcc /γC)*(1 - λ*(δ - k1)/(2*k2))*( λ*(δ - k1)/(2*k2)) for fck ≤ 50 N/mm2

K' = (2*η*αcc /γC)*(1 - λ*(δ - k3)/(2*k4))*( λ*(δ - k3)/(2*k4)) for fck > 50 N/mm2

where

k i = moment redistribution factors

δ = moment redistribution ratio ( = 1.0 in the current
release)

γ C = the NDP partial safety factor for concrete

α cc = coefficient to take account of long term effects on
compressive strength of concrete

λ = 1. 8 for fck ≤ 50 N/mm2

 = 1. 8-(fck-50)/400 for 50 < fck ≤ 90 N/mm2

η = 1. 0 for fck ≤ 50 N/mm

 = 1. 0-(fck-50)/200 for 50 < fck ≤ 90 N/mm2
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For design in accordance with UK NA, Irish NA, Malaysian NA and Singapore
NA;

γC = 1.5

αcc = 0.85

For design in accordance with EC2 Recommendations;

γC = 1.5

αcc = 1.0

IF K ≤ K' THEN compression reinforcement is not required.

Calculate the lever arm, z from;

z = MIN(0.5*d*[1 + (1 - 2*K/(η*αcc/γC))0.5], 0.95*d)

The area of tension reinforcement required is then given by;

Ast,reqd = MEd/(fyd*z)

where

fyd = fyk/γS

γS = the NDP partial safety factor for reinforcement

The depth to the neutral axis, xu is given by;

xu = 2*(d-z)/λ

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

γS = 1.15

IF K > K' THEN compression reinforcement is required.

Calculate the depth to the neutral axis from;

xu = d*(δ-k1)/k2 for fck ≤ 50 N/mm2

xu = d*(δ-k3)/k4 for fck > 50 N/mm2

Calculate the stress in the reinforcement from;

fsc = MIN(Es*εcu3*(1-(d2/xu), fyd)

where

d2= the distance from the extreme fibre in compression to the c of g of the
compression reinforcement

Calculate the limiting bending strength, M' from;

M' =K'*fck*bw*d2

Calculate the lever arm from;

z = 0.5*d*[1 + (1 - 2*K'/(η*αcc/γC))0.5]
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The area of compression reinforcement required, As2,reqd is given by;

As2,reqd = (MEd-M')/(fsc*(d-d2))

The area of tension reinforcement required, Ast,reqd is given by;

Ast,reqd = M'/(fyd*z) + As2,reqd*fsc/fyd

Design for bending for flanged sections (concrete beam: EC2)

IF hf < 0.1*d THEN treat the beam as rectangular.

hf = MIN(hf,side1, hf,side2)

where

hf,sidei = the depth of the slab on side " i" of the beam

Calculate the value of K from;

K = MEd/(fck*beff*d2)

Calculate the lever arm, z from;

z = MIN(0.5*d*[1 + (1 - 2*K/(η*αcc/γC))0.5], 0.95*d)

Calculate the depth of the rectangular stress block, λ*x from;

λ*x = 2*(d-z)

IF λ*x ≤ h f THEN the rectangular compression block is wholly in the depth of
the flange and the section can be designed as a rectangular section by setting
bw = beff.

IF λ*x > h f THEN the rectangular compression block extends into the rib of
the flanged section and the following design method is to be used.

The design bending strength of the flange, Mf is given by;

Mf = fcd*hf*(beff-bw)*(d-0.5*h f)

The area of reinforcement required to provide this bending strength, Asf,reqd is
given by;

Asf,reqd = Mf/(fyd*(d-0.5*hf))

The remaining design moment, (MEd-Mf) is then taken by the rectangular beam
section.

Calculate the value of K from;

K = (MEd-Mf)/(fck*bw*d2)

Then calculate the limiting value of K, known as K' from;

K' = (2*η*αcc /γC)*(1 - λ*(δ - k1)/(2*k2))*( λ*(δ - k1)/(2*k2)) for fck ≤ 50 N/mm2

K' = (2*η*αcc /γC)*(1 - λ*(δ - k3)/(2*k4))*( λ*(δ - k3)/(2*k4)) for fck > 50 N/mm2
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IF K ≤ K' THEN compression reinforcement is not required.

Calculate the lever arm, z from;

z = MIN(0.5*d*[1 + (1 - 2*K/(η*αcc/γC))0.5], 0.95*d)

The area of tension reinforcement required is then given by;

Asr,reqd = (MEd-Mf)/(fyd*z)

The total area of tension reinforcement required, Ast,reqd is then given by;

Ast,reqd = Asf,reqd+Asr,reqd

The depth to the neutral axis, xu is given by;

xu = 2*(d-z)/λ

IF K > K' THEN compression reinforcement is required.

Calculate the depth to the neutral axis from;

xu = d*(δ-k1)/k2 for fck ≤ 50 N/mm2

xu = d*(δ-k3)/k4 for fck > 50 N/mm2

Calculate the stress in the reinforcement from;

fsc = MAX(Es*εcu3*(1-(d2/xu), fyd)

where

d2 = the distance from the extreme fibre in compression to the c of g of the
compression reinforcement

Calculate the limiting bending strength, M' from;

M' =K'*fck*bw*d2

Calculate the lever arm from;

z = 0.5*d*[1 + (1 - 2*K'/(η*αcc/γC))0.5]

The area of compression reinforcement required, As2,reqd is given by;

As2,reqd = (MEd-Mf-M')/(fsc*(d-d2))

The area of tension reinforcement required, Asr,reqd is given by;

Asr,reqd = M'/(fyd*z) + As2,reqd*fsc/fyd

The total area of tension reinforcement required, Ast,reqd is then given by;

Ast,reqd = Asf,reqd+Asr,reqd
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Design shear resistance (concrete beam: EC2)

The design value of the shear resistance of a concrete section with vertical
shear reinforcement, VRd,max is given by;

VRd,max = 0.9*αcw*bw*d*ν1*fcwd/(cotθ + tanθ)

where

θ = MIN {θmax, MAX[0.5*sin-1[2*VEd,max/( αcw*bw*0.9*d*ν1*fcwd)], θmin]}

fcwd
1= αccw*fck/γC

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

αcw = 1.0 (assuming no axial load in the beam)

αccw = 1.0

γC = 1.5

ν1 = 0.6*(1 - (fck/250)) f ck in N/mm2

The limits of θ are given by 1 ≤ cotθ ≤ 2.5 which gives;

θmax = tan-11

θmin = tan-1(0.4)

IF VEd,max > VRd,max

where

VEd,max = the maximum design shear force acting anywhere on the beam

THEN the shear design process FAILS since the section size is inadequate for
shear (the compression strut has failed at the maximum allowable angle).

The design shear capacity of the minimum area of shear links actually
provided, Vnom is given by2;

Vnom = (Asw,min,prov /sl ) * 0.9 * d * fywd * cotθ

where

Asw,min, prov is the area of shear reinforcement provided to meet the minimum
requirements.

fywd = fywk/γS

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA the limiting values of θ are given by;

1 ≤ cotθ ≤ 2.5

1 Eqn (3.15) BS EN 1992-1-1:2004 Section 3.1.6(1)P
2 BS EN 1992-1-1:2004 Section 6.2.3(3) Eqn (6.8)

Design codes reference 1949 Eurocodes



and: γS = 1.15

The maximum possible value for the shear resistance provided by this area of
shear reinforcement will be when the angle of the compression strut is the
minimum value i.e. cotθ = 2.5 and therefore Vnom can be simplified to;

Vnom = (Asw,min,prov/sl) * 2.25 * d * fywd

In any region, i;

IF

VEd,i > Vnom

where

VEd,i = the maximum shear in region i

THEN shear links are required in the region.

For designed shear links in shear region Si, first calculate the angle of the
compression strut from;

θSi = MIN{θmax, MAX[0.5*sin-1[2*VEd,Si /( αcw*bw*0.9*d*ν1*fcd)], θmin]}

The area of links required in shear region Si is then given by;

(Asw,reqd/s)Si = VEd,Si/(0.9*d*fywd*cotθSi)

where

VEd,Si = the maximum shear force in shear region Si

Minimum area of shear reinforcement (concrete beam: EC2)

The minimum area of shear reinforcement required, Asw,min is given by1;

Asw,min = MAX[sl*ρw,min*bw, Asw,min,u]

where

sl = the spacing of the shear reinforcement along the longitudinal axis of the
beam

Asw,min,u = the total minimum area of the shear reinforcement calculated from
data supplied i.e. maximum spacing across the beam, minimum link diameter
and number of legs

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

ρw,min = (0.08*√(fck))/fyk

1 BS EN 1992-1-1:2004 Section 9.2.2(5) Eqn (9.4)
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Spacing of shear reinforcement (concrete beam: EC2)

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA the longitudinal spacing, sl between the
legs of shear reinforcement is given by;

sl,min,u ≤ sl ≤ MIN[0.75*d, sl,max,u]

where

sl,max,u = the maximum longitudinal spacing specified

sl,min,u = the minimum longitudinal spacing specified

If compression reinforcement is required for bending, for design in
accordance with UK NA, EC2 Recommendations, Irish NA, Malaysian NA
and Singapore NA the longitudinal spacing, sl between the legs of shear
reinforcement is given by;

sl,min,u ≤ sl ≤ MIN{MIN[0.75*d, 15*Φcomp] , sl,max,u}

where

Φcomp = the minimum diameter of the compression reinforcement

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA the transverse spacing, st between the legs
of shear reinforcement is given by;

st ≤ MIN[0.75*d, 600, st,max,u]

where

st,max,u = the maximum link leg spacing across the beam
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Shear between flanges and web of flanged beams (concrete beam: EC2)

The shear strength of the interface between the flanges and the web of a
flanged beam is checked and, if necessary, transverse reinforcement is
provided as shown in the diagram below.1

Additional tension reinforcement (concrete beam: EC2)

In BS EN 1992-1-1:2004, the method of designing for vertical shear is based on
a truss analogy with a diagonal strut acting at an angle θ. This strut action
means that there must be a tension force developed in the longitudinal
reinforcement which is additional to that arising from bending action.

To resist this tension force, an area of reinforcement additional to that
required to resist bending is required.

The total area of longitudinal tension reinforcement in each of the regions
then becomes;

Astt,reqd,i = Ast,reqd,i + Aswa,reqd,i

where

Ast,reqd,i = the area of longitudinal reinforcement required to resist bending as
appropriate in region " i"

Aswa,reqd,i = the area of longitudinal reinforcement required to resist the
additional tension force from vertical shear in region " i"

1 BS EN 1992-1-1:2001 Section 6.2.4
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Design values of shear resistance and torsional resistance moment (Concrete
beam: EC2)

The design value of the shear resistance of a concrete section with vertical
shear reinforcement, VRd,max is given by;

VRd,max = 0.9*αcw*bw*d*ν1*fcwd/(cotθ + tanθ)

where

θ = MIN{θmax, MAX[0.5*sin-1[2*VEd,max/( αcw*bw*0.9*d*ν1*fcwd)], θmin]}

fcwd = αccw*fck/γC

The maximum design value of the torsional resistance moment, ΤRd,max is
given by;

ΤRd,max = 2*ν1*αccw*fcwd*Ak*t ef*sinθ*cosθ

where

Ak = (h-tef)*(bw-tef)

and

tef = MAX(A/u, 2*(h-do))1

where

A = h*bw

u = the outer circumference of the cross-section

= 2*(h+bw)

do = the effective depth of the outer layer of longitudinal reinforcement

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

αcw = 1.0

αccw = 1.0

γC = 1.5

ν1 = 0.6*(1 - fck/250) fck in N/mm2

The limits of θ are given by 1 ≤ cotθ ≤ 2.5 which gives;

θmax = tan-11

θmin = tan-1(0.4)

The design value of the torsional resistance moment of a concrete section with
no shear reinforcement, ΤRd,c is given by2;

Eqn (3.15) BS EN 1992-1-1:2004 Section 3.1.6(1)P
1 BS EN 1992-1-1:2004 Section 6.3.2(1)
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ΤRd,c = 2*Ak*tef*fctd

where

fctd = the design tensile strength of the concrete

= αct*fctk,0.05/γC

If the maximum torsional moment acting on the beam, TEd,max is less than the
ignorable torque limit then no further calculations are necessary.

Otherwise:

If (ΤEd,max,i/ΤRd,max) + (VEd,max,i/VRd,max) ≤ 1.0

then the torsion design process can proceed.

ELSE the torsion design FAILS since the section size is inadequate for torsion.

Additional reinforcement for torsion (Concrete beam: EC2)

The design value of the shear resistance of a concrete section with no shear
reinforcement, VRd,c is given by;1

VRd,c = νmin * bw * d

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

CRd,c = 0.18/γC

γC = 1.5

νmin = 0.035 * k1.5 * fck 0.5

where

k = MIN(1 + √(200/d), 2.0) d in mm

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA;

αct = 1.0

γC = 1.5

If (ΤEd,max/ΤRd,c) + (VEd,max/VRd,c) ≤ 1.0

THEN no additional longitudinal reinforcement for torsion is required.

IF (ΤEd,max/ΤRd,c) + (VEd,max/VRd,c) > 1.0

THEN additional longitudinal reinforcement for torsion, A slT,reqd is required in
some or all regions.

2 BS EN 1992-1-1:2004 Eqn (6.26) with τt,i = fctd

1 The design value of the shear resistance is calculated ignoring the longitudinal reinforcement as it is not known if this
reinforcement is adequately anchored beyond the point under consideration. This is a conservative approach.
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The additional longitudinal reinforcement is given by;

AslT,reqd = (ΤEd * uk* cotθ)/(2 * Ak * fyd)

where

uk = 2*((h-tef)+(bw-tef))

This reinforcement is in addition to that required for bending and tension
arising from vertical shear and it is distributed in each of the four faces of the
beam in proportion to the length of the face of the cross-section.

The area of the additional link reinforcement that is required to resist torsion
is given by;

Aswt/s = (ΤEd)/(2 * Ak * 0.9 * fywd* cotθ) per leg

Deflection check (beam and slab: EC2)

The deflection of reinforced concrete beams is not directly calculated and the
serviceability of the beam is measured by comparing the calculated limiting
span/effective depth ratio L/d to the maximum allowable values as given by;1

IF ρ ≤ ρ0

(L/d)max = Kss*f1*f2*(11+1.5*(fck) 1/2*(ρ0/ρ)+3.2*(fck)1/2*(( ρ0/
ρ)-1)3/2)*(500*Ast,prov/(fyk*A st,reqd))

IF ρ > ρ0

(L/d)max = Kss*f1*f2*(11+1.5*(fck) 1/2*(ρ0/(ρ-ρ'))+(1/12)*(fck)1/2*( ρ'/
ρ0)1/2)*(500*Ast,prov/(fyk*A st,reqd))

where

ρ = the designed tension reinforcement ratio at mid-span
(or at support for cantilevers) required to resist
bending

 = A st.reqd /(b w *d) for rectangular beams

 = A st,reqd /(b eff *d) for flanged beams

ρ' = the designed compression reinforcement ratio at mid-
span (or at support for cantilevers) required to resist
bending

 = A s2,reqd /(b w *d) for rectangular beams
1: This definition of effective length will
return conservative results when the
width of the support is greater than the
depth of the beam - see BS EN
1992-1-1:2004 Section 5.3.2.2(1)

1 BS EN 1992-1-1:2004 Section 7.4.2
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 = A s2,reqd /(b eff *d) for flanged beams

A st,reqd = the designed area of tension reinforcement at mid-
span (or at support for cantilevers) required to resist
bending

A st,prov = MIN(the area of tension reinforcement provided at
mid-span (or at support for cantilevers), f 3 *A st,reqd )

A s2,reqd = the designed area of compression reinforcement at
mid-span (or at support for cantilevers) required to
resist bending

f 1 = 1. 0 for rectangular beams

 = 1. 0 for flanged beams with beff/bw ≤ 3.0

 = 1. 8 for flanged beams with beff/bw > 3.0

f 2 = 1. 0 IF Leff ≤ 7 m

 = 7/L eff IF L eff > 7 m with L eff in metre units

L eff = the length of the beam between the centre of its
supports1

f 3 = an NDP factor as given below

K ss = the structural system factor which is an NDP and is
given below

1: This definition of effective length will
return conservative results when the
width of the support is greater than the
depth of the beam - see BS EN
1992-1-1:2004 Section 5.3.2.2(1)

For design in accordance with EC2 Recommendations the NDP value of f3 is
given by3;

f3 = 1.5

For design in accordance with UK NA, Irish NA, Malaysian NA and Singapore
NA the NDP value of f3 is given by4;

f3 = 1.5

For design in accordance with UK NA, EC2 Recommendations, Irish NA,
Malaysian NA and Singapore NA the NDP value of Kss is given by the
following table:

Span Detail LH End Fixity RH End Fixity Kss

LH End Span Fixed Fixed 1.3

3 BS EN 1992-1-1:2004 is silent on the recommended value to use therefore adopt 1.5 since if f3 is greater than 1.5 no benefit arises.
4 For Irish NA refer to Table NA.3 and for other others refer to Table NA.5
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Span Detail LH End Fixity RH End Fixity Kss

Fixed Pinned 1.0
Pinned Fixed 1.3
Pinned Pinned 1.0

Internal Span Fixed Fixed 1.5
Fixed Pinned 1.3
Pinned Fixed 1.3
Pinned Pinned 1.0

RH End Span Fixed Fixed 1.3
Fixed Pinned 1.3
Pinned Fixed 1.0
Pinned Pinned 1.0

Cantilever   0.4

Concrete column design to EC2 (Eurocode)

The topics in this section describe how the software applies BS EN
1992-1-1:2004 (Ref. 1) (page 1989) to the design of reinforced concrete
columns.

Limitations (Concrete column: EC2)

The longitudinal and transverse reinforcement requirements of clause 9.5 are
applied to all columns, including columns where the larger dimension is
greater than 4 times the smaller dimension - this is conservative.

The following general exclusions also apply:

• Seismic design,

• Consideration of fire resistance. [You are however given full control of the
minimum cover dimension to the reinforcement and are therefore able to
take due account of fire resistance requirements.],

• Chamfers,

• Multi-stack reinforcement lifts.

Design codes reference 1957 Eurocodes



Cover to Reinforcement (Concrete column: EC2)

The nominal concrete cover is the distance between the surface of the
reinforcement closest to the nearest concrete surface (including links and
surface reinforcement where relevant) and the nearest concrete surface.

You are required to set a minimum value for the nominal cover, c nom, u, for
each column in the column properties.

These values are then checked against the nominal limiting cover, cnom,lim
which depends on the diameter of the reinforcement plus an allowance for
deviation, Δcdev (specified in Design Options > Column > General Parameters).

Generally, the allowance for deviation, Δcdev is a NDP. The recommended value
is 10mm, but under strict controls it can be reduced to 5mm.

If cnom,u < cnom,lim then a warning is displayed in the calculations.

Design parameters for longitudinal bars (concrete column: EC2)

For some of the longitudinal reinforcement design parameters, additional user
defined limits can be applied - where this is the case minimum and maximum
values are specified in Design Options > Column > Reinforcement Layout.

Minimum Longitudinal Bar Diameter

For design in accordance with EC2 Recommendations;

φlong,min = 8mm

BS EN 1992-1-1:2004 cl 4.4.1.3 (1)P
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For design in accordance with Malaysian NA;

φlong,min = 10m

For design in accordance with UK NA, Irish NA and Singapore NA;

φlong,min = 12mm

Minimum Longitudinal Bar Spacing

For design to1 EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

scl,min ≥ MAX[ maximum longitudinal bar diameter, 20mm, dg + 5mm ]

Where dg is the maximum aggregate size.

Maximum Longitudinal Bar Spacing

You are given control over this value by specifying an upper limit in Design
Options > Column > Reinforcement Layout.

Minimum Longitudinal Total Steel Area

For design to2 EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

If NEd >= 0 (i.e. compression)

Asl,min = MAX[ (0.1 * NEd) / fyd, 0.2% * column area ]

Else

Asl,min = 0.45% * column area

NOTE It has been decided that in the tension case, in the absence of clear
guidance by EC2, it is responsible and conservative to adopt the 0.45%
used by BS8110.

Maximum Longitudinal Total Steel Area

For design to3 EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

Asl,max = 4% * column area (8% in lap regions)

Long Term Compressive Strength Factor

For design in accordance with4 UK NA, Irish NA, Malaysian NA and
Singapore NA;

1 BS EN 1992-1-1:2004 Section 8.2
2 BS EN 1992-1-1:2004 Section 9.5.2(2)
3 BS EN 1992-1-1:2004 Section 9.5.2(3)
4 BS EN 1992-1-1:2004 Section 3.1.6(1)
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αcc = 0.85

For design in accordance with EC2 Recommendations;

αcc = 1.0

Design Concrete Compressive Strength for Shear

For design to4 EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

fcd = αcc* fck /γC

Ultimate axial load limit (column and wall: EC2)

This limit is when the section is under pure compression (i.e. no moment is
applied). It is observed that for non-symmetric arrangements, applying a small
moment in one direction may increase the maximum axial load that can be
applied to a section because the peak of the N-M interaction diagram is shifted
away from the N-axis (i.e. the zero moment line). Checking that the axial load
does not exceed the ultimate axial load limit of the section ensures that there
is always a positive moment limit and a negative moment limit for the applied
axial load for the section.

The ultimate axial load limit of the section, assuming a rectangular stress
distribution, is calculated from:

Nmax = (RF * Ac * fcd * η) + ∑(As,i * fs,i)

Given that,

Ac = A - ∑As,i

fs,i = εc * Es,i

Where

RF is the concrete design reduction factor, (this is a fixed value of 0.9 which
cannot be changed)

A is the overall area of the section,

A c is the area of concrete in the section,

As.i is the area of bar i,

fcd is the design compressive strength of the concrete,

η is a reduction factor for the design compressive strength for high strength
concrete for the rectangular stress distribution,

εc is the strain in the concrete at reaching the maximum strength,

fs,i is the stress in bar i when the concrete reaches the maximum strength,

Es,i is the modulus of elasticity of the steel used in bar i.

4 BS EN 1992-1-1:2004 Section 3.1.6(1)
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NOTE The concrete design reduction factor RF originates from EC2 section
3.1.7(3): "Note: If the width of the compression zone decreases in the
direction of the extreme compression fibre, the value ηfcd should be
reduced by 10%"

In Tekla Structural Designer the RF factor is applied in both the axial-
moment interaction check and the ultimate axial resistance check
(even though there is no extreme compression fibre in this latter
calculation) so that the ultimate axial resistance matches the peak
position of the interaction diagram - its inclusion creates a
conservative result.

Effective length calculations (column and wall:EC2)

Clear Height

The clear height is the clear dimension between the restraining beams at the
bottom of the stack and the restraining beams at the top of the stack. The
clear height may be different in each direction.

If, at an end of the stack, no effective beams or flat slab to include are found,
then the clear height includes the stack beyond this restraint, and the same
rules apply for finding the end of the clear height at the end of the next stack
(and so on).

Effective Length

The effective length, l0 is calculated automatically - you also have the ability to
override the calculated value.

From EC2, cl. 5.8.3.2, the equations for calculating the effective length are as
follows.

For stacks designated as "braced", the effective length is given by1:

l0 = 0.5 * l * √(1 + (k1 / (0.45 + k1))) * √(1 + (k2 / (0.45 + k2)))

In addition Tekla Structural Designer imposes the following limits for stacks
that are designated as braced:

5 ≤ l0 / l ≤ 1

For stacks designated as "bracing", the effective length is the larger of1:

l0 = l * √(1 + (10 * k1 * k2 / (k1 + k2)))

Or

l0 = l * (1 + (k1 / (1 + k1))) * (1 + (k2 / (1 + k2)))

Where

1 BS EN 1992-1-1:2004 Section 5.8.3.2(3)
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k 1 and k 2 are the relative flexibilities of rotational restraints at ends 1 and 2
respectively, in the direction under consideration. Which way the ends are
numbered is irrelevant to the result. The program uses the bottom end of the
stack as end 1 and the top end as end 2.

The value of k, which may refer to either k 1 or k 2 depending on which end of
the stack is being examined, is defined by1:

k = (θ / M) * (E * I / l)

Where

M is the moment applied to the restraining members by the buckling member
or members,

θ is the rotation of the joint at the end of the stack considered for the bending
moment M,

(E * I / l) is the bending stiffness of the compression member or members
considered to be buckling.

It is recommended to take "θ / M" for the beams as "l / (2 * E * I)" .

The standard approximation 2 for "θ / M" is between "l / (4 * E * I)" and "l / (3 *
E * I)", so to allow for cracking the value is increased. Also, "E * I / l" is the sum
of the stiffness of column stacks joining at the connection.

The above equation then becomes:

k = ∑(E * I / l)cols / ∑(2 * E * I / l)beams

If there are any adjacent stacks beyond the joint at the end of the restrained
length under consideration, then it must be considered whether these
adjacent stacks are likely to contribute to the deflection or restrain it. If the
stiffness are similar then the stiffness of the adjacent stacks can be ignored,
and the guidance in PD6687 suggests that this range of similarity of stiffness
can be taken as 15% above or below the stiffness of the stack being designed.
Therefore:

If

1.85 ≤ ∑((E *I/ l)stacks beyond this joint) / (E * I/ l)stack under consideration ≤ 1.15

Then

∑(E * I / l)cols = (E * I / l)stack under consideration

Else

∑(E * I / l)cols = (E * I / l)stack under consideration + ∑(E * I / l)stacks beyond this joint

These stacks can be part of the same column length or another column length.

Note that as the restrained length may be multiple stacks, "E * I" for this stack
are the values for the stack being designed, and l is the restrained length. For

1 BS EN 1992-1-1:2004 Section 5.8.3.2(3)
2 PD 6687-1:2010 Section 2.11.2
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the stacks beyond the restraint, "E * I" are the values for the stack attached to
the restraint, and l is the restrained length that the stack exists within.

Any beams framing into the end of the stack within 45 degrees of the axis
being considered are said to be restraining beams for the stack in that
direction.

There is a lower limit 3 for the value of k:

k ≥ 0.1

Additionally, Tekla Structural Designer imposes an upper limit:

k ≤ 20

For bracing stacks, a warning is displayed when the calculated value of k
exceeds this limit.

Fixed Column Base

k = 0.1 for fixed bases in Tekla Structural Designer. There is no clear guidance
in EC2, but the Concrete Centre guidance suggests that this is suitable.

NOTE If you have set the bottom of the column to be "fixed" but the support
as "pinned". The program will always assume that the support is fixed
and therefore only ever consider the fixity applied to the column.

Pinned Column End

In any situation where the end of a column anywhere in the structure is
pinned, k = 20.

No Effective Beams Found

If no effective beams are found to restrain the end of the stack in the direction
in question, then the program will consider whether there is a flat slab
restraining the stack at this end. If a flat slab is found it will either be
considered as a restraint, or not, in each direction at each end of the stack -
this is controlled by checking the option Use slab for stiffness calculation...
located as a Stiffness setting in the column properties. If there are no effective
beams and there is no flat slab (or any flat slab is not to be considered), then
the program looks for the far end of the stack on the other side of the joint,
and look at the restraints there, and so on until a restraint with an effective
beam or flat slab to be considered is found.

If the stack is restrained by a flat slab, then the slab will be considered to act as
a beam in this direction - note that it is one beam in the direction and NOT a
beam on each side of the column.

If the stack is an end stack and there are no supports, beams or flat slabs
considered to restrain the stack at this end in the direction, the end is
therefore free in this direction and k = 20.

3 BS EN 1992-1-1:2004 Section 5.8.3.2(3)
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Column stack and wall panel classification (column and wall:EC2)

Slenderness ratio

For columns: the slenderness ratio, λ of the restrained length about each axis
is calculated as follows:

λ = l0 / i = l0 / √(I / A)

Where

l0 is the effective height of the stack,

i is the radius of gyration of the stack section about the axis under
consideration,

I is the second moment of area of the stack section about the axis,

A is the cross-sectional area of the stack section.

The slenderness ratio λ is then checked against the limiting slenderness ratio
λlim in each direction. If the slenderness is less than this limit, then the
member is short and slenderness effects are ignored, otherwise it is slender.

For walls: since the wall panel has a rectangular plan shape, the above
calculation can be simplified:

In-plane,

Slenderness, ly = l0,y / iy

Where

Radius of gyration, iy = lw/(12)0.5

l0,y is the effective length,

lw is the length of wall panel

Out-of-plane,

Slenderness, lz = l0,z / iz

Where

Radius of gyration, iz = hw/(12)0.5

l0,z is the effective length

hw is the thickness of wall panel

Limiting slenderness ratio

λlim = 20 * A * B * C / √n

Where

A = 1 / (1 + (0.2 * φef)) ≥ 0.7

B = √(1 + (2 * ω)) ≥ 1.1
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C = 1.7 - rm

Where

φef is the effective creep ratio,

ω = As * fyd / (Ac * fcd),

fyd is the design yield strength of the reinforcement,

fcd is the design compressive strength of the concrete,

As is the total area of longitudinal reinforcement,

n = NEd / (Ac * fcd),

NEd is the design axial force between restrained floor levels in this direction,

rm = M1.1 / M2.1

M1.1 and M2.1 are the first order moments at the ends of the stack about the
axis being considered, with |M2.1| ≥ |M1.1|.

If M1.1 and M2.1 cause tension in the same side of the stack then rm is positive
and C ≤ 1.7. If the converse is true then the stack is in double curvature, and it
follows that rm is negative and C > 1.7.

For braced stacks in which the first order moments arise only from transverse
loads (lateral loading is significant) or imperfections (Mimp.1 > |M2.1|), C must
be taken as 0.7,

For

bracing stacks, C must be taken as 0.7,

For restrained lengths encompassing more than one stack, C is taken as 0.7.

The effective creep ratio, φef, is derived as follows:

fcm = fck + 8 (N/mm2)

h0 = 2 * Ag / u

Where

u is the section perimeter in contact with the atmosphere (assumed to be the
full section perimeter),

Ag is the gross section area.

α1 = (35 / fcm)0.7

α2 = (35 / fcm)0.2

α3 = (35 / fcm)0.5

If fcm ≤ 35 N/mm2,

βH = (1.5 * (1 + (1.2 * RH))18 * h0) + 250 ≤ 1500
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Else,

βH = (1.5 * (1 + (1.2 * RH))18 * h0) + (250 * α3) ≤ 1500 * α3

Where

RH is the relative humidity, which is set under Design parameters in the
column properties.

βc( t , t0 ) = ((t - t0) / (βH + t - t0))0.3

βt0 = 1 / (0.1 + t0 0.2)

βfcm = 16.8 / √fcm

Where

t0 is the age of column loading and defaults to 14 days, if required it can be
changed under Design parameters in the column properties.

If fcm ≤ 35 N/mm2,

φRH = 1 + ((1 - (RH / 100)) / (0.1 * h0 1/3))

Else,

φRH = (1 + (((1 - (RH / 100)) / (0.1 * h0 1/3)) * α1)) * α2

Then,

φ0 = φRH * βfcm * βt0

φ( ∞ , t0) = φ0 * βc( ∞ , t0 )

If φ( ∞ , t0) ≤ 2 and λ < 75 and Mmax.1 / NEd ≥ h and ω ≥ 0.25,

φef = 0

Else

φef = φ( ∞, t0) * RPL

Where

Mmax.1 is the largest first order moment in the restrained length in this
direction,

NEd is the design axial force in the restrained length in this direction,

RPL is the permanent load ratio.

You are required to supply a value for the permanent load ratio which is
located under Design parameters in the column properties. A default of 0.65
has been assumed, but you are advised to consider if this is appropriate and
adjust as necessary.

Tekla Structural Designer assumes that t ∞ (t-infinity) is equal to 70 years
(25550 days).
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Pre-selection of Bracing Contribution

The significant parameter within the slenderness criteria is a choice of how a
wall, or column, is contributing to the stability of the structure.

In-plane direction, a wall is usually considered to be a bracing member. Out-of-
plane direction, a wall is usually considered to be braced by other stabilizing
members. These are the default settings but can be edited.

Overview of second order effects (concrete column: EC2)

For 'isolated' columns and walls, EN1992-1-1 (EC2) allows for second order
effects and member imperfections in a number of ways,

• It specifies a minimum level of member imperfection along with a
conservative value - see Clause 5.2 (7).

• It provides for the additional moment due to slenderness (member
buckling) using one of two methods. One method (the (Nominal) Stiffness
Method) increases the first-order moments in the column using an
amplifier based on the elastic critical buckling load of the member - see
Clause 5.8.7.3. The second method (the (Nominal) Curvature Method)
calculates the 'second-order' moment directly based on an adjustment to
the maximum predicted curvature that the column section can achieve at
failure in bending - see Clause 5.8.8.

• The impact of the slenderness is increased or decreased depending upon
the effective length factor for the member. For braced members this will be
≤ 1.0 and for unbraced (bracing) members it will be ≥ 1.0 see Clause 5.8.3.2.

Finally, EC2 also requires consideration of a minimum moment based on the
likelihood that the axial load cannot be fully concentric see Clause 6.1 (4).

Minimum moment (Clause 6.1 (4))

The minimum moment about each axis, Mmin is calculated. When using the
Curvature Method, M2 is added to the minimum moment. When using the
Stiffness Method M2 is calculated from Mmin x π2/(8(αcr - 1)) and added to Mmin.

If for any design combination and design position the minimum moment
including second-order moment is greater than the overall design moment
then the former is used when comparing the values on the locus of moment of
resistance. Note that the minimum might be governing about neither axis, one
axis or both axes.

Member imperfections (Clause 5.2 (7))

The imperfection moment is calculated using the eccentricity, ei = l0/400, and it
is conservatively assumed that it increases the first-order moments
irrespective of sign. In the case of the Stiffness Method the imperfection
moment is added before the moment magnifier is applied. It is applied to both
braced and bracing columns/walls.
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Curvature Method (Clause 5.8.8)

This method is only applied to symmetrical, rectangular and circular sections
and is equally applicable to columns and walls. The second-order moment, M2
(= NEd e2), is calculated but the resulting design moment is only used if it is less
than that calculated from the Stiffness Method. It is applied in the same
manner as that for the Stiffness Method to both braced and bracing columns.

Stiffness Method (Clause 5.8.7)

This method is applied to all columns and walls.

For braced columns the second-order moment M2 is calculated from:

M2 = Me.1 x π2 /(8 x (NB /NEd - 1))

Where,  
Me.1 = the maximum first-order moment in the mid-fifth

NB = the buckling load of the column based on nominal stiffness and
the effective length

 = π2 EI/l02

NEd = the maximum axial force in the design length

When a point of zero shear occurs inside the mid-fifth or does not exist in the
member length, the value of M2 is added algebraically to the first-order
moments at the ends but only if this increases the first-order moment. At the
mid-fifth position M2 is always "added" in such a way as to increase the first-
order mid-fifth moment.

When a point of zero shear occurs within the member length and is outside
the mid-fifth, the second-order moments is taken as the greater of that
calculated as above and that calculated as per Clause 5.8.7.3 (4) by multiplying
all first-order moments by the amplifier,

1/(1 - NEd/NB)

For bracing columns the second-order moments are calculated in the same
way as braced columns except that in the determination of the amplifier, the
buckling load is based on bracing effective lengths. These are greater than 1.0L
and hence produce more severe amplifiers.

Second-order analysis

When second-order analysis is selected then both braced and bracing columns
are treated the same as if first-order analysis were selected. If the second-
order analysis is either the amplified forces method or the rigorous method
then this approach will double count some of the global P-Δ effects in columns
that are determined as having significant lateral loads. Also, when it is a
rigorous second-order analysis there is some double counting of member P-δ
effects in both braced and bracing columns.
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Design moment calculations (column and wall:EC2)

For each combination and for each analysis model the end moments in the
two local member directions, "1" and "2" are established. From these and the
local load profile, the moment at any position and the maximum axial force in
the member can be established.

Step 1 - the amplifier

Calculate the "amplifier" due to buckling in each of Direction 1 and Direction 2
from Equ. 5.28 and Equ. 5.30 of EC2 as1,

k5.28 = 1 + π2 /(8*(NB /NEd - 1))

k5.30 = 1 + 1/(NB /NEd - 1)

Where

NB = the (Euler) buckling load in the appropriate direction

 = π2 EI/lo2

lo = the effective length in the appropriate direction which for
braced columns will be ≤ 1.0L and for unbraced columns ≥
1.0L

NEd = the maximum axial compressive force in the column length
under consideration (stack)

NOTE When NEd ≤ zero i.e. tension, k5.28 and k5.30 are 1.0.

Step 2 - minimum moment

Calculate the minimum moment due to non-concentric axial force in each of
the two directions from,

Mmin.1 =|NEd | * MAX(h/30, 20)

Where

h = the major dimension of the column in the appropriate direction
NEd = the maximum axial force (compression or tension) in the column

length under consideration (stack)

Step 3 - imperfection moment

Calculate the "first-order" and "second-order" imperfection moment in
Direction 1 and Direction 2 as,

1 Direction 1 and Direction 2 are referring here to the member local axes
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Mimp.

1

= NEd * ei

Mimp.

2

= Mimp.1 * k5.28

Where

Mimp.

1

= the "first-order" imperfection moment in a given direction

Mimp.

2

= the "second-order" imperfection moment in a given direction

ei = the effective length in the appropriate direction divided by 400

 = lo /400

NEd = the maximum axial compressive force in the column length under
consideration (stack)

NOTE When NEd ≤ zero i.e. tension, Mimp.1 and Mimp.2 are zero.

Step 4 - second-order moment, curvature method

For rectangular and circular sections the second-order moment, M2.curv, using
the Curvature Method is calculated for each direction.

M2.curv = NEd * e2

Where

e2 = the deflection due to the maximum curvature achievable with the
given axial force

 = (1/r) lo2 /c

NEd = the maximum axial compressive force in the column length under
consideration (stack)

NOTE When NEd ≤ zero i.e. tension, M2.curv is zero.

Step 5 - second-order moment, stiffness method

For all section shapes, the second-order moment, M2.stiff, using the Stiffness
Method is calculated in each direction based on the maximum first-order
moment in the mid-fifth of the column, Me.1, in the appropriate direction.

M2.stif

f

= Me.1 * ( π2 /(8*(NB /NEd - 1))
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Where

Me.1 = the maximum absolute moment in the mid-fifth of the column
length under consideration (stack) in the appropriate direction

NEd = the maximum axial compressive force in the column length under
consideration (stack)

NOTE When NEd ≤ zero i.e. tension, M2.stiff is zero.

Step 6 - lateral loading classification

For the current design combination, for each direction using the member
analysis routines, check for point(s) of zero shear within the column length. If
none exist or are within the mid-fifth of the column length then this design
case is designated as having lateral loads that are "not significant". Else the
lateral loads are considered as "significant".

Step 7 - design moment at top

Calculate the design moment at the top of the column in each direction (for
both braced and unbraced columns) taking into account if lateral loads are
"significant", or "not significant".

Step 8 - design moment at bottom

Calculate the design moment at the bottom of the column in each direction
(for both braced and unbraced columns) taking into account if lateral loads
that are "significant", or "not significant".

Step 9 - design moment in mid-fifth

Calculate the design moment in the mid-fifth of the column in each direction
(for both braced and unbraced columns) taking into account if lateral loads
that are "significant", or "not significant".

Design for combined axial and bending (column and wall:EC2)

Tekla Structural Designer designs the column for an applied axial force and
applied bending about one or both axes of the section. In the case of bi-axial
bending, a resultant moment is created for the combination of the applied
moments.
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Mmajor
  =  Moment about the

major axis
Mminor

  =  Moment about the
minor axis

Mmajor,res
  =  Moment of resistance

about the major axis
Mminor,res

  =  Moment of resistance
about the minor axis

Tekla Structural Designer adopts the above approach in preference to the
simplified method specified in equation 5.39 of EC2 as it has a wider range of
application.

Design parameters for shear (column and wall:EC2)

For some of the shear design parameters, additional user defined limits can
be applied - where this is the case minimum and maximum values are
specified in Design Options > Column > Reinforcement Layout.

Minimum Shear Link Diameter

φw,min = MAX[ 6mm, 0.25 * largest longitudinal bar diameter ]

Maximum Span Region Shear Link Spacing

For design to UK NA, Irish NA, Malaysian NA and Singapore NA: 1

φw,max = MIN[ 20 * smallest longitudinal bar diameter, lesser column
dimension, 400mm ]

NOTE For UK NA when concrete class > C50/60 there are separate
calculations in clause 9.5.3(3). These are not implemented but a
warning is displayed in this situation.

For design to EC2 Recommendations:

φw,max = MIN[ 20 * smallest longitudinal bar diameter, lesser column
dimension, 400mm ]

Support Region Shear Link Spacing

For support regions, the maximum link spacing is reduced by 40%. 2

1 BS EN 1992-1-1:2004 Section 9.5.3(3)
2 Maximum BS EN 1992-1-1:2004 Section 9.5.3(4)
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Long Term Compressive Strength Factor for Shear, αccw

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA: 3

αccw = 1.0

Design Concrete Compressive Strength for Shear, fcwd

For design to UK NA, Irish NA, Malaysian NA and Singapore NA:

fcwd = αccw * MIN (fck , 50) /γC

For design to EC2 Recommendations:

fcwd = αccw * fck /γC

Factor CRd,c 4

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA:

CRd,c = 0.18 / γC

Factor k1 5

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA:

k1 = 0.15

Cracked Concrete Reduction Factor, v

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA: 6

v = 0.6 * (1 - (fck / 250))

Cracked Concrete Reduction Factor, v1

For design to UK NA, Irish NA, Malaysian NA and Singapore NA: 7

v1 = v* (1 - (0.5 * cos(α))

α is the inclination of links.

Note that links in columns are always assumed to be at 90° to column
direction.

Therefore v1 = v

3 BS EN 1992-1-1:2004 Section 3.1.6(1)
4 BS EN 1992-1-1:2004 Section 6.2.2(1)
5 BS EN 1992-1-1:2004 Section 6.2.2(1
6 BS EN 1992-1-1:2004 Section 6.2.2(6)
7 BS EN 1992-1-1:2004 Section 6.2.3(3)
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For design to EC2 Recommendations:

v1 = v

Minimum Shear Reinforcement Ratio, ρw,min

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA: 8

0.08 * √(fck) / fyk

Maximum Angle of Compression Strut, θmax

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA: 9

cot(θ) = 1

θ = 45°

Minimum Angle of Compression Strut, θmin

For design to10 EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA:

cot(θ) = 2.5

θ = 21.8°

Angle of Compression Strut, θ

For design to UK NA, Irish NA, Malaysian NA and Singapore NA: 10

If NEd ≥ 0 i.e. compression

θ = 0.5 * arcsin(2 * vEd / (0.9 * αcw * v1 * fcwd))

else

cot(θ) = 1.25

θ = 38.7°

For design toEC2 Recommendations:

θ = 0.5 * arcsin(2 * vEd / (0.9 * αcw * v1 * fcwd))

Stress State Factor, αcw

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA:

If σcp ≤ 0

αcw = 1.0

8 BS EN 1992-1-1:2004 Section 9.2.2(5)
9 BS EN 1992-1-1:2004 Section 6.2.3(2)
10 clause 6.2.3(2)
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else if 0 < σcp ≤ 0.25 * fcd

αcw = 1.0 + (σcp / fcd)

else if 0.25 * fcd < σcp ≤ 0.5 * fcd

αcw = 1.25

else if 0.5 * fcd < σcp ≤ fcd

αcw = 2.5 * (1.0 - (σcp / fcd))

Minimum Shear Strength , vmin

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA: 11

035 * k1.5 * fck 0.5

Concrete wall design to EC2 (Eurocode)

The topics in this section describe how the software applies BS EN
1992-1-1:2004 (Ref. 1) (page 1989) to the design of reinforced concrete walls.

Limitations (Concrete wall: EC2)

The requirements of clause 9.6 are applied to all walls, irrespective of their
length to thickness ratio. (Isolated compression members with a length to
thickness ratio less than 4 should be defined as columns rather than walls.)

The following general exclusions also apply:

• Seismic design,

• Consideration of fire resistance. [You are however given full control of the
minimum cover dimension to the reinforcement and are therefore able to
take due account of fire resistance requirements.],

• Multi-stack reinforcement lifts.

Cover to Reinforcement (Concrete wall: EC2)

For 1 layer of reinforcement, the vertical bar is on the centre-line of the wall
thickness, the face of the horizontal bar is closest to the critical concrete face.

For 2 layers of reinforcement, the horizontal bars are placed outside the
vertical bars at each face.

The nominal concrete cover is measured to the face of the horizontal bar or
any link/confinement transverse reinforcement that may be present.

11 clause 6.2.2(1)
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You are required to set a minimum value for the nominal cover, c nom,u, for
each wall in the wall properties.

These values are then checked against the nominal limiting cover, cnom,lim
which depends on the diameter of the reinforcement plus an allowance for
deviation, Δcdev (specified in Design Options > Wall > General Parameters).

Generally, the allowance for deviation, Δcdev is a NDP . The recommended
value is 10mm, but under strict controls it can be reduced to 5mm.

If cnom,u < cnom,lim then a warning is displayed in the calculations.

Design Parameters for Vertical Bars (Concrete wall: EC2)

F or some of the vertical bar parameters, additional user defined limits can be
applied - where this is the case minimum and maximum values are specified
inDesign Options > Wall > Reinforcement Layout.

NOTE In the following, the concrete area is the gross area of the general
wall, or the gross area of the mid zone if one exists. For the end zone
the design criteria for a reinforced concrete column element applies.

Minimum Vertical Bar Diameter

For design in accordance with EC2 Recommendations;

φv,min = 8mm

For design in accordance with UK NA, Irish NA, Malaysian NA and Singapore
NA;

φv,min = 12mm

Minimum Vertical Bar Spacing

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

scl,min ≥ MAX[ maximum longitudinal bar diameter, 20mm, dg + 5mm ]

Where dg is the maximum aggregate size.

Maximum Vertical Bar Spacing

You are given control over this value by specifying an upper limit in Design
Options > Wall > Reinforcement Layout.

Minimum Reinforcement Area

Total minimum area of vertical reinforcement, As, min = ρv,min*Acg

BS EN 1992-1-1:2004 cl 4.4.1.3 (1)P

BS EN 1992-1-1:2004 Section 8.2
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Where

Acg = gross area of the concrete wall

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

ρv, min = 0.002

Where 2 layers are specified distributed equally to each face, this is a
minimum of 0.001*Acg placed at each face.

You are given control over the minimum reinforcement ratio value via a user
limit in Design Options > Wall > Reinforcement Layout (default 0.004).

For walls subjected to "predominantly out-of-plane bending", the minimum
area rules for "slabs" apply if they are more critical than the above, [ cl 9.3 and
reference to cl 9.2.1.1 (1) (2) and (3) ], so an additional check for any value of
minor axis bending is applied.

As,min = max [(2*0.26*fctm*lwp*d/fyk) , ( 2*0.0013*lwp*d) , ( ρv,min*Acg)]

This applies for the general wall length, or the mid zone if it exists.

For a general wall panel length, lwp = lw

Gross area of the wall, Acg = lw*hw

For a mid zone panel length, lwp = lmz

Gross area of the mid zone, Acg,mz = lmz*hw

Effective depth of the cross section, d, is the dimension of the extreme
concrete compression fibre to the centroid of reinforcement layer on the
tension side, which for a wall is the line of the vertical reinforcement.

It does not apply for the end zones, since these are subject to the minimum
reinforcement requirements as a column section.

Gross area of each end zone, Acg,ez = lez*hw

Length of each end zone, lez

Design Parameters for Horizontal Bars (Concrete wall: EC2)

For some of the horizontal bar parameters, additional user defined limits can
be applied - where this is the case minimum and maximum values are
specified in Design Options > Wall > Reinforcement Layout.

Minimum Horizontal Bar Diameter

The suggested minimum for design in accordance with EC2
Recommendations, UK NA, Irish NA, Malaysian NA and Singapore NA;

φh,min = 8mm

BS EN 1992-1-1:2004 Section 9.5.2(2)
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Minimum Horizontal Bar Spacing

For design to EC2 Recommendations, UK NA, Irish NA, Malaysian NA and
Singapore NA;

scl,min ≥ MAX[ maximum longitudinal bar diameter, 20mm, dg + 5mm ]

Where dg is the maximum aggregate size.

Maximum Horizontal Bar Spacing

To satisfy the slab condition if "predominantly out-of-plane bending";

Limiting maximum horizontal spacing, scr,max= min (3*hw , 400 mm)

You are given control over this value by specifying a user limit in Design
Options > Wall > Reinforcement Layout.

Concrete slab design to EC2 (Eurocode)

The topics in this section describe how the software applies BS EN
1992-1-1:2004 (Ref. 1) (page 1989) to the design of reinforced concrete slabs.

Pad and strip base design to EC2 (Eurocode)

The topics in this section describe how the software applies BS EN
1992-1-1:2004 (Ref. 1) (page 1989) to the design of pad and strip bases.

Checks performed (pad and strip base:EC2)

The checks performed for both directions are:

• EC7 - Max soil bearing pressure must not exceed allowable bearing
pressure.

• EC2 - Provided steel must be greater than As,min for both vertical
directions.

• EC2 - Provided bar spacing must be inside the limiting spacing

• EC2 - Provided bar size must be inside the limiting sizes

• EC2 - Check for bending moment capacity

• EC2 - Check for shear capacity

• EC2 - Punching check at column face

• EC2 - Punching check at critical perimeter

• EC7 - Check for overturning forces - not in the current release

• EC7 - Check for sliding

BS EN 1992-1-1:2004 Section 8.2
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• EC7 - Check for uplift

NOTE EC7 - Check for overturning forces are beyond scope of the current
release.

Foundation Bearing Capacity (pad and strip base:EC2)

Annex A of EC7 allows bearing capacity to be checked using two sets of partial
factors: A1 and A2.

In Tekla Structural Designer the bearing capacity check is performed on STR
load combinations using set A1 and on GEO load combinations using set A2.

Alternatively, an option is also provided to check a Presumed Bearing
Resistance in accordance with EN1997-1cl.6.5.2.4).

Check for Pad Base Bearing Capacity

Total vertical force:

F dz   =   γ G *(F swt + F soil + F
sur,G ) + γ Q * F sur,Q - F
z,sup

Moment about X axis:

M x,c   =   M x,sup +F z,sup * y 1 + h*F
y,sup

Moment about Y axis:

M y,c   =   M y,sup +F z,sup * x 1 + h*F
x,sup

Where:

L x  
 
=
 
 
 

Length of foundation in X-direction  

L y  
 
=
 
 
 

Length of foundation in Y-direction  

A  
 
=
 
 
 

L x * L y = Foundation area  

Design codes reference 1979 Eurocodes



h  
 
=
 
 
 

Depth of foundation  

h soil  
 
=
 
 
 

Depth of soil above the foundation  

l x  
 
=
 
 
 

Length of column/wall in X-direction  

l y  
 
=
 
 
 

Length of column/wall in Y-direction  

x 1  
 
=
 
 
 

Offset in X-axis. (Distance between centre of the pad
to the centre of the support in X-direction)

 

y 1  
 
=
 
 
 

Offset in Y-axis. (Distance between centre of the pad
to the centre of the support in Y-direction)

 

γ G  
 
=
 
 
 

1.35 = Permanent partial factor - unfavourable
action

when Set A1
used

  
 
=
 
 
 

1.0 = Permanent partial factor - unfavourable action when Set A2
used

γ Q  
 
=
 
 
 

1.5 = Variable partial factor - unfavourable action when Set A1
used

  
 
=
 
 
 

1.3 = Variable partial factor - unfavourable action when Set A2
used

Fswt  
 A * h * γ conc = foundation self-weight  
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=
 
 
 

Fsoil  
 
=
 
 
 

(A - A c )*h soil *γ soil = Unfactored load from soil  

γsoil  
 
=
 
 
 

Density of soil - user input  

Fsur,G  
 
=
 
 
 

(A - A c )*sc G = Unfactored load from surcharge for
permanent load case

 

Fsur,Q  
 
=
 
 
 

(A - A c )*sc Q = Unfactored load from surcharge for
variable load case

 

scG  
 
=
 
 
 

Surcharge in permanent load case - user input  

scQ  
 
=
 
 
 

Surcharge in variable load case - user input  

Ac  
 
=
 
 
 

cross section of the column/wall  

Fz,sup  
 
=
 
 
 

Vertical load acting on support in STR/GEO limit
states- (from analysis)

 

Mx,su

p

 
 
=
 
 
 

Moment acting on support around X-axis in
STR/GEO limit states- from analysis

 

My,su

p

 
 
=
 

Moment acting on support around Y-axis in
STR/GEO limit states - from analysis
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Fx,sup  
 
=
 
 
 

Horizontal force acting on support X-direction in
STR/GEO limit states - from analysis

 

Fy,sup  
 
=
 
 
 

Horizontal force acting on support Y-direction in
STR/GEO limit states - from analysis

 

Eccentricity in X-direction:

ex   =   My,c / F dz

Eccentricity in Y-direction:

ey   =   Mx,c / F dz

Uniform rectangular stress distribution method

Effective length in X-direction:

L'x  
 
=
 
 
 

Lx - 2ex when ex > 0

L'x  
 
=
 
 
 

Lx + 2ex when ex < 0

Effective length in Y-direction:

L'y  
 
=
 
 
 

Ly - 2ey when ey > 0

L'y  
 
=
 
 
 

Ly + 2ey when ey < 0

Design bearing pressure:

fdz  
 
=

Fdz / (L'x * L'y )
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Presumed bearing capacity method

If

abs(ex) / Lx + abs(ey) / Ly  
 
≤
 
 
 

1.167

Then Base reaction acts within middle third - no loss of contact and:

Pad base pressures:

q 1  
 
=
 
 
 

F dz /A - 6* M y,c / (L x *A) + 6* M x,c / (L y *A)

q 2  
 
=
 
 
 

F dz /A - 6* M y,c / (L x *A) - 6* M x,c / (L y *A)

q 3  
 
=
 
 
 

F dz /A + 6* M y,c / (L x *A) + 6* M x,c / (L y *A)

q 4  
 
=
 
 
 

F dz /A + 6* M y,c / (L x *A) - 6* M x,c / (L y *A)

Max base pressure:

q max  
 
=
 
 
 

max (q 1 , q 2 , q 3 , q 4 )

Else base reaction acts outside middle third - loss of contact.

In this case the pressure calculations are more complex - in Tekla Structural
Designer these are done using sets of equations presented in an article by
Kenneth E. Wilson published in the Journal of Bridge Engineering in 1997.
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NOTE Seismic combinations: The presumed bearing capacity method uses
SLS combinations in the bearing checks - however as there is no clear
Eurocode guidance on service factors for seismic combinations, in
Tekla Structural Designer they are not currently assigned. If using the
presumed bearing capacity method, to avoid the check being
performed for zero loading you are advised to consider which service
factors might be appropriate and update the seismic combinations
manually.

Check for Strip Base Bearing Capacity

The principles used in the strip base bearing capacity calculations are similar
to those for pad foundations. Only the direction X is checked (around Y-axis)
using segment widths.

Design bearing pressure:

f dz  
 
=
 
 
 

F dz / (L' x * L y )

Design for bending (pad and strip base:EC2)

Bending design calculations are performed for the STR load combinations.

For tension on the bottom face of the foundation, the design bending moment
may be taken as that at the face of the column or wall and may therefore be
less than the peak bending moment.

The bending capacity check follows the same basic principle as used for
beams, see: Design for bending for rectangular sections (beams and slabs:
EC2) (page 1945).

Design for shear (pad and strip base:EC2)

Pad base shear design check

Calculate tension reinforcement ratio (cl 6.2.2(1)):

ρl = min(Asl / (L*d), 0.02)

where

Asl = area of tension reinforcement

L = unit width of foundation in which A sl is provided

d = effective depth of reinforcement in direction
considered
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Fy,sup = Horizontal force acting on support Y-direction in
STR/GEO limit states - from analysis

Calculate k (cl. 6.2.2(1)):

k = min(1 + (200mm/d)1/2, 2.0)

Calc min shear strength (NDP) (cl. 6.2.2(1)):

vmin = 1.035k3/2fck 1/2 EC2
recommendations

vmin = 1.035k3/2fck 1/2 for UK, Irish,
Malaysian and
Singapore NA

Calculate resistance without shear reinforcement for X and Y directions (cl.
6.2.2(1)):

vRd.c,x = max(CRd.c * k * (100 N 2 /mm 4 *ρ l * f ck ) 1/3 ,v min )

vRd.c,y = max(CRd.c * k * (100 N 2 /mm 4 *ρ l * f ck ) 1/3 ,v min )

Maximum allowable shear resistance (cl. 6.2.2(6));

vRd,max = 1.5 *v * fcd

where

fcd =concrete design compressive strength

v =cracked concrete reduction factor

If applied design shear force is less than or equal to the shear resistance i.e vEd
≤ vRd = min (vRd,c , vRd,max) the foundation thickness is adequate for beam
shear.

Strip base shear design check

The principle of the strip base shear design check is similar to that for the pad
base. Only the direction X is checked (around Y-axis) using segment widths.

Check for sliding (pad and strip base:EC2)

The check for sliding is carried out for pad foundations only.

If there is no horizontal force acting on foundation check for sliding is not
required.

Sliding resistance (EC7 Section 6.5.3) - forces are defined from STR
combinations.

Horizontal Forces on foundation for each direction:
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Fdx = F x,sup

Fdy = F y,sup

where

Fx,sup = factored horizontal force
acting on support in X-
dir. (from analysis)

Fy,sup = factored horizontal force
acting on support in Y-
dir. (from analysis)

Horizontal force on foundation:

Hd = [abs(Fdx)2 + abs(Fdy)2]0.5

Sliding resistance verification (Section 6.5.3)

Sliding resistance (exp.6.3b and table A.5):

RH.d = [FzG,d + γGf * Fswt] *
tan(δk) / γR.h

where

δ k = factored horizontal
force acting on support
in X-dir.

γ R.h = 1.1 (set R2) EC7 recomm. and for Irish
and Malaysian NA

γ R.h = 1.0 (set R1) for UK, Singapore NA

γ Gf = 1.0 (permanent
favourable action)

F zG,d = Vertical load acting on
support in STR/GEO
limit states where
favourable actions
considered.

Check for uplift (pad and strip base:EC2)

For combinations producing tension at the support the tension value is
compared to the stabilizing loads. Auto-design can automatically increment
the base size to achieve a passing status.
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Pile cap design to EC2 (Eurocode)

The forces acting on a pile cap are applied to the foundation at the foundation
level. The foundation can take axial load and bi-axial shear and moment.

Pile cap design is divided between pile design (pile capacity check) and
structural design of the pile cap which includes bending, shear and punching
shear design checks.

Pile cap calculations are performed in accordance with BS EN 1992-1-1:2004
(Ref. 1) (page 1989).

Bottom reinforcement is designed to the Eurocode - (EC base, UK NA, Irish NA,
Singapore NA or Malaysia NA).

Pile capacity (pile cap:EC2)

Annex A of EC7 allows bearing capacity to be checked using two sets of partial
factors: A1 and A2.

In Tekla Structural Designer the bearing capacity check is performed on STR
load combinations using set A1 and on GEO load combinations using set A2.

Pile capacity passes if:

Rc,d ≥ Pn ≥ - R t,d
Whe
re:
Rc,d = Pile design compression resistance

Rt,d = Pile design tension resistance

Pn = Pile load

Design for bending (pile cap:EC2)

The pile cap is treated as a beam in bending, where the critical bending
moments for the design for the bottom reinforcement are taken at the face of
the column.

Bending design calculations are performed for the STR load combinations.

The bending capacity check follows the same basic principle as used for
beams, see: Design for bending for rectangular sections (beams and slabs:
EC2) (page 1945).

Design for shear (pile cap:EC2)

Shear design calculations are performed for the STR load combinations.

Determination of Design Shear Stress

Shear stress acting on side 1 in direction X vEd,x1 =ΣP n,1 / (d x *L y )
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Shear stress acting on side 2 in direction X vEd,x2 =ΣP n,2 / (d x *L y )

Shear stress acting on side 1 in direction Y vEd,y1 =ΣP n,1 / (d y *L x )

Shear stress acting on side 2 in direction Y vEd,y2 =ΣP n,2 / (d y *L x )

Maximum allowable shear resistance

vRd,max = 0.5 * v * fcd 1

where:

fcd = αcc * fck / γc

αcc = 1.0 (EC2); αcc = 0.85 (supported NAs)

γc = 1.5

v = 0.6 * [1 - (fck/250)]

Check for Shear

The shear capacity check procedure is identical to that for pad bases, see:
Design for shear (pad and strip base:EC2) (page 1984)

Checks for limiting parameters (pile cap:EC2)

Check for distance of pile cap overhang

Check pile edge distance "e" for pile "i" in a pile group for both directions:

The check passes if:

If min ei > emin,user

Check for minimum pile spacing

Check centre to centre spacing "s" between piles "i" and "j" in a pile group:

The check passes if:

If sij > smin,user

where

smin,user = user input

Check for maximum pile spacing

Check centre to centre maximum spacing "s" between piles "i" and "j" in a pile
group:

The check passes if:

If sij < smax,user

smax,user = user input

1 BS EN 1992-1-1:2004 Section 6.2.2(6)
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Other checks

The remaining checks are identical to those for pad bases, see: Design
parameters for longitudinal bars (EC2) (page 1938)

References EC2

1. British Standards Institution. BS EN 1992-1-1:2004. Eurocode 2: Design of
concrete structures. General rules and rules for buildings. BSI 2004.

2. British Standards Institution. NA to BS EN 1992-1-1:2004. Eurocode 2:
Design of concrete structures. General rules and rules for buildings. BSI
2005.

Vibration of floors to SCI P354
These topics describe the SCI P354 floor vibration calculations that can be
performed in Tekla Structural Designer.

The following topics are covered:

• Introduction to floor vibration (P354) (page 1989)

• Scope of floor vibration (P354) (page 1990)

• Limitations and Assumptions of floor vibration to P354 (page 1991)

• Design philosophy of P354 floor vibration (page 1991)

• Provided performance P354 floor vibration (page 1995)

• Input requirements for P354 floor vibration (page 2003)

Introduction to floor vibration (P354)
This handbook describes the SCI P354 floor vibration calculations that can be
performed in Tekla Structural Designer.

With the advent of long span floors, multiple openings in webs, minimum floor
depth zones etc. the vibration response of floors in multi-storey buildings
under normal occupancy has increasingly become of concern to clients and
their Engineers and Architects.

Detailed guidance on the subject is available through the SCI Publication P354
Design of Floors for Vibration: A New Approach (page 2006)

This handbook describes the method for the assessment of floor vibration in
accordance with P354 that has been adopted in Tekla Structural Designer. The
method seeks to establish, with reasonable accuracy, the response of the floor
to dynamic excitation expected in offices of normal occupancy. This excitation
is almost solely based on occupants walking. With appropriate design criteria,
the approach is likely to be equally applicable to sectors other than offices.
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The existing solution to checking this type of criterion - a simple calculation of
the natural frequency of an individual beam - is felt in many cases to be
insufficiently accurate. More importantly, such calculations do not consider
two important factors,

• the natural frequency is only the 'response side' of the equation. The
'action' side of the equation is also important i.e. the dynamic excitation -
this is the activity that might cause an adverse response from the floor.
Walking, dancing and machine vibration are all on the 'action' side of the
equation and are all very different in their potential effect.

• the natural frequency of an isolated beam is exactly that and takes no
account of the influence (good or bad) of the surrounding floor
components. In particular, with composite floors, the slabs will force other
beams to restrict or sympathize with the beam under consideration.

The culmination of the calculations carried out by Tekla Structural Designer is
a "Response Factor". It is important to note that this response factor,

• is not a truly real value of the response of the actual floor since the
complex nature of real building layouts are idealized into standard 'cases'.

• is compared with certain limits that have been recommended by industry
experts for a limited classification of building type. They are not arbitrary
but are not absolute either (cf. calculated deflection and deflection limits)

• is relatively insensitive. That is, a twofold change in the response factor will
only just be perceptible to the occupants (cf. logarithmic scale of sound
power levels, dbA).

• could be over-conservative particularly for those buildings where tight
requirements are imposed.

Notwithstanding the above, this approach is another tool at your disposal that
could enable you to spot a problem before the floor is built and prevent the
first steps of the client into his new building proving a disaster!

You should find that the check is simple to operate, but it will require you to
make choices that may be unfamiliar to you. The purpose of this handbook is
to assist you in becoming familiar with the requirements of the check and to
assist you in making reasonable judgments regarding the input required.

Scope of floor vibration (P354)
The reference upon which Tekla Structural Designer's floor vibration check is
based is the main limiting factor with regard to scope. This is SCI Publication
P354 (page 2006) There are no doubt many other texts that deal with vibration
problems in buildings, and indeed there is a British Standard dealing with the
evaluation of human exposure to vibration in buildings, BS 6472: 1992
(page 2006) . However this SCI publication has distilled this wider knowledge
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into readily usable design guidance that is specifically aimed at floors in multi-
storey buildings of normal occupancy.

You are able to define an area on a particular floor level that is to be subject to
the vibration response analysis and design. The layout of beams in real multi-
storey buildings can be of almost any configuration. The methodology
adopted in P354 is only applicable to regular structures which by and
large have to be created from rectilinear grids. It is your responsibility to
make an appropriate selection of the beams etc. that are to be the basic
components of the idealized case.

As you proceed through the input making your selections, Tekla Structural
Designer will, where it is possible to do so, interrogate the underlying model
and retrieve the appropriate data. Once all the data has been assembled, you
are then able to perform the check, after which a detailed set of results will be
available for review. If you are unhappy with the outcome of your choices you
can close the results window and make alternative selections by editing the
Floor Vibration Check item properties.

Limitations and Assumptions of floor vibration to P354
The scope is primarily defined by the reference design document (page 2006)
but the following additional limitations and assumptions should be noted.

• The design guidance is based on composite floors acting compositely with
the steel beams. It is unclear whether the design approach is directly
applicable to non-composite construction.

• For simplicity and to avoid the necessity of Tekla Structural Designer having
to identify all the beams in the area selected for vibration assessment, the
component of the unit mass from the self-weight of the beams is ignored.
This will lead to a slight inaccuracy in the participating mass that is
conservative (more mass is advantageous). Note, however, that beam self-
weight is included in the calculation of beam deflection but only when the
self-weight loadcase is included in the load combination.

• Cantilever beams are excluded from the analysis.

• Cold formed sections are excluded.

• Precast slabs are excluded.

Design philosophy of P354 floor vibration

General

The Engineer ensures the safety of building occupants by satisfying all design
criteria at the Ultimate Limit State. Similarly, the health of building occupants is
partly taken care of when deflection limits at the Serviceability Limit State are
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satisfied (although this Limit State does have other purposes than simply the
health of occupants).

However, for floors that are subject to cyclic or sudden loading, it is the human
perception of motion that could cause the performance of a floor to be found
unsatisfactory. Such perception is usually related to acceleration levels. In
most practical building structures, the reaction of the occupants to floor
acceleration varies between irritation and a feeling of insecurity. This is based
on the instinctive human perception that motion in a 'solid' building indicates
inadequacy or imminent failure.

The working environment also affects the perception of motion. For busy
environments, where the occupant is surrounded by the activity that is
producing the vibrations, the perception of motion is reduced. In contrast, for
quieter environments (such as laboratories and residential dwellings), where
the source of vibration is unseen, the perception of motion is significantly
heightened.

The design philosophy to ensure that the potential for such human response
is minimized, has a number of facets,

• the dynamic excitation causing the vibration i.e. the disturbing force
profile, which is force and time dependent. For the sorts of building and
occupancy considered here, this is the act of walking.

• the required performance. This depends upon the type of environment.
As discussed above this, in turn, depends upon the involvement of the
occupant in the generation of the vibration and also on the nature of the
occupancy. The latter is important for laboratories carrying out delicate
work, or operating theatres, for example.

• the provided performance. This is the "Response Factor" and is
dependent on the system natural frequency and, more importantly, the
participating mass. The latter is driven mainly by the selection of an area of
floor that is reasonable and appropriate.

Dynamic excitation

In a classical spring-mass system that includes a (viscous) damper, when a
simple force is applied to the mass to extend (or contract) the spring, the mass
moves up and down (oscillates). This movement is significant at first but
eventually reduces to zero due to the resistance offered by the damper. In a
floor system in a building,

• the mass is the self-weight of the floor and any other loading that is
present for the majority of the time that the occupants could be exposed to
vibration effects,

• the spring is the stiffness of the floor system, which will have a number of
different component beams (secondary and primary) and the floor slab,

• the damper is provided by a number of elements that are able to absorb
energy from the free vibration of the system. There will be energy
absorbed,
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• within connections, since they behave 'better' than the ideal that is
assumed

• from losses due to the unsymmetrical nature of real buildings e.g. grid
layout, and dispersion of loads from furnishings and contents

• from components such as partitions that are out-of-plane of the
vibration and interfere with the 'mode'.

The determination of the contribution of each of these components as they
affect real floor systems is given in detail in later sections. These describe the
'response' side of the floor system. In order to establish the required
performance of the system the 'input' must also be defined i.e. that event,
events or continuum that is the 'dynamic excitation'.

In the simple example described at the start of this section the 'input' was
simply a force that caused a displacement to the system and was then
released. This might be equivalent to a person jumping off a chair onto the
floor. However, in the context of the concerns over the vibration of floors, it is
not this sort of input that is of interest. The main concern is the excitation of
the floor brought about by walking.

Unlike the simple example, walking produces loading that is cyclic. This loading
can be idealized into a series of sine curves of load against time. Each curve is
an exact multiple of the walking frequency called harmonics. When one of
these harmonics of the cyclic loading coincides with the natural frequency of
the floor system then resonance is set up. The consequence of resonance that
is detected, and may disturb occupants, is the associated peak acceleration.
For the first harmonic, the peak acceleration is dependent upon the applied
force (the weight of one standard person multiplied by a factor, αn), the mass
of the system (the self-weight of the floor plate plus other loading that could
be considered as permanent), and the amount of damping in the system (the
damping ratio, ζ). The factor, αn, is known as a Fourier coefficient and links the
magnitude of the applied force in any harmonic of the walking function to the
weight of one standard person. It has been established experimentally for
different activities and different activity frequencies.

Hence, the dynamic excitation of a floor is dependent upon the forcing
function due to walking and its relationship to the natural frequency of the
floor system. It is the level of the peak acceleration that this generates that is
particularly important in determining the performance of the floor.

Required performance

The required performance of a floor system is very dependent upon the
potential response of humans. Human response is a very complex subject
since there is no such thing as a 'standard human'. The perception of vibration
will differ from person to person, their body mass varies significantly and the
body's reaction will depend upon age, gender etc. The human response has
been studied and the accepted wisdom is embodied in BS 6472: 1992, Guide
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to evaluation of human exposure to vibration in buildings (1 Hz to 80 Hz)
(page 2006)

It may be remembered that it is the acceleration of the floor system that the
human perceives. BS 6472: 1992 provides a series of curves one of which is
the 'base' limit of (vertical) acceleration against frequency (of the floor). Within
the practical range of frequencies dealt with, a single value of the 'base' limit
on acceleration is given as 0.005 m/s2. This single value holds

• down to 3 Hz but no floor should be allowed to have a system natural
frequency below this value anyway

• up to 10 Hz. Such a large value would be unusual but beyond that point
there is a simple linear relationship between the base limit of acceleration
and the natural frequency within an extended but just practical range.

The accelerations acceptable for different use of buildings are described using
the 'base' limits. Multiplying factors are used to increase the base acceleration
limit according to the intended use of the building. The multiplying factors are
referred to as 'response factors' in the SCI guidance. Thus the target
acceleration of the floor under consideration is the root mean square
acceleration multiplied by the response factor. This design condition is turned
on its head to give a 'provided response factor' that is then compared with the
'required response factor'. The required response factor is the measure of the
"Required performance" and is given in the SCI guidance as,

• R = 8 for a workshop

• R = 8 for a general office

• R = 2 for a residential building during day time use

You should choose a required response factor based on both engineering
judgement and the advice given in P354. In particular it may be noted that,
"changing R by a factor of 2 is equivalent only to the most marginal change to
human perception".

Provided performance

It is in establishing the provided performance that most of the design
calculations are required. The object of these calculations is to determine the
'required response factor'.

The start point is the calculation of the natural frequency of the floor system.
This is established from the individual component frequencies for each of two
possible shape modes, namely the Secondary Beam Mode and the Primary
Beam Mode. The natural frequencies of the individual components can be
adjusted to allow for boundary conditions e.g. two spans continuous. The
fundamental frequency, f0, is the lower value for the two modes considered. A
minimum natural frequency is given in SCI P354 of 3.0 Hz.

Next the 'modal mass' is required. This is dependent upon the physical size of
the floor plate selected and an effective width and/or length that is itself
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dependent on the natural frequency of the floor. The modal mass has by far
the largest influence on the response factor provided.

The 'Resonance Build-up Factor' makes allowance for the time it takes for
someone walking across the floor to begin to excite the floor - vibration is not
instantaneous upon the first footfall. This has an upper limit of 1.0 and can be
taken conservatively as 1.0. The calculation requires the 'damping ratio' - this
is a user input.

The resonance build-up factor, the damping ratio, the modal mass, and the
weight of a 'standard person' along with an appropriate Fourier coefficient are
used to calculate the peak acceleration.

The final determination of the response factor provided requires the 'root
mean square' acceleration. The rms acceleration has two formulations
depending upon the fundamental, system frequency. The response factor is a
very simple calculation.

The design condition is simply,

Rprov ≤ Rreqd

Provided performance P354 floor vibration

System frequency

Deflections

For the primary beam, the base maximum simply supported deflection, δPBSS,
is derived from the analysis model with no allowance for boundary conditions.

For the secondary beam, the base maximum simply supported deflection,
δSBSS, is derived from the analysis model and the maximum deflection for a
fixed end condition, δSBFE, is calculated from,

δSBFE = m*b*LSB
4 /(384*ES *ISB ) + m*b*LSB 2 /(24*G*Ay )

   
Wher
e

  

m = unit mass in kN/mm2

b = secondary beam spacing in mm
LSB = span of the secondary beam in mm

ISB = the inertia of the secondary beam in mm 4

ES = the steel modulus in kN/mm2

G = the steel shear modulus in kN/mm2

Ay = the major axis shear area in mm2
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For the slab, the base maximum deflection for a fixed end condition, δSlabFE, is
calculated from,

δ
SlabFE

= m*LSlab 4/(384*EC *ISlab)

Wher
e

  

m = unit mass in kN/mm 2

LSlab = span of the slab in mm

ISlab = the inertia of the slab in mm 4/mm

EC = the dynamic concrete slab modulus in kN/mm2

 = Es *1.1/αshort

These base, maximum simply supported deflections for both primary and
secondary beams, δ **SS, derived from the analysis model, can be adjusted to
cater for boundary conditions for 'two-span continuous' or 'three-span
continuous' cases to give δ barSS.

For 'two span continuous' the adjusted deflection is taken from P354 as,

δ
barSS

= MIN[(0.4 + kM /kS * (1 + 0.6 * LS 2/LM
2 ))/(1 + kM /kS ), 1.0] * δ**SS

Where  
kM = the 'stiffness' of the critical span selected by the user (primary or

secondary beam as appropriate)
 = IM /LM

kS = the stiffness of the adjoining span selected by the user (primary or
secondary beam as appropriate)

 = IS/LS

LM = the span of the critical span selected by the user (primary or
secondary beam as appropriate)

LS = the span pf the adjoining span selected by the user (primary or
secondary beam as appropriate)

IM = the inertia of the critical span selected by the user (primary or
secondary beam as appropriate)

IS = the inertia of the adjoining span selected by the user (primary or
secondary beam as appropriate)

For 'three span continuous' the adjusted deflection is taken from P354 as,

δ
barSS

= MIN[(0.6 + 2 * kM /k S * (1 + 1.2 * LS 2 /LM 2 ))/(3 + 2 * kM /k S ), 1.0] *
δ**SS
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Where  
kM = the 'stiffness' of the critical (middle) span selected by the user

(primary or secondary beam as appropriate)
 = IM /LM

kS = the stiffness of the adjoining (outer) span selected by the user
(primary or secondary beams as appropriate)

 = IS /LS

LM = the span of the critical (middle) span selected by the user (primary or
secondary beam as appropriate)

LS = the span of the adjoining (outer) span selected by the user (primary
or secondary beams as appropriate)

IM = the inertia of the critical (middle) span selected by the user (primary
or secondary beam as appropriate)

IS = the inertia of the adjoining (outer) span selected by the user (primary
or secondary beams as appropriate)

Secondary Beam Mode

In this mode the primary beams form nodal lines (zero deflection) about which
the secondary beams vibrate. The slab is assumed to be continuous over the
secondary beams so a fixed end condition is used.

δ
SBmode

= δ barSBSS + δ SlabFE

   
and   
   
fSBmod

e

= 18/ √ δ SBmode

Primary Beam Mode

In this mode the primary beams vibrate about the columns as simply
supported beams whilst the secondary beams and slabs are taken to be fixed
ended

δ
PBmode

= δbarPBSS + δSBFE + δSlabFE

   
and   
   
fPBmod

e

= 18/ √ δPBmode
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System Frequency

The natural frequency of the system, f0, is calculated from,

f0 = MIN{ fSBmode , fPBmode }

Limitations

The absolute minimum natural frequency of the floor system is limited to 3.0
Hz. Where the floor system frequency is below these limits the design fails.

Similarly, no single element within the floor structure should have a
fundamental frequency less than 3.0 Hz. Three additional checks are therefore
carried out and their results only published if there is a Fail. These checks are,

fPBSS =18/ √ δ PBSS must be ≥ 3 else the design Fails

 
fSBSS =18/ √ δ SBSS must be ≥ 3 else the design Fails

 
fSlabFE =18/ √ δSlabFE must be ≥ 3 else the design Fails

Modal mass

The 'modal mass' is the effective mass participating in the vibration of the
floor. In accordance with SCI P354, it is taken as the 'unit mass' multiplied by
the effective plan area of the floor participating in the motion as given by,

M = m * Leff * S

   
Wher
e

  

m = the unit mass in kg/m2

Leff = the effective floor length

S = the effective floor width

Wher
e

  

Leff = 09*(1.10)ny-1 *(E*ISB/(m*b*f0 2))0.25 but ≤ ny*Ly

Wh
ere

  

ny = number of bays ( ≤ 4) in the direction of the secondary beam span

EISB = dynamic flexural rigidity of the composite secondary beam (in Nm2

when m is in kg/m2)
b = floor beam spacing (in m)
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f0 = system, natural frequency from above

Ly = span of the secondary beam (in m)
   
and   
S = η*(1.15)nx-1 *( E*ISlab /(m* f0

2 ))0.25 but ≤ nx *Lx

W
h
e
r
e

  

n
x

=number of bays ( ≤ 4)
in the direction of the
primary beam span

E
I
S

l

a

b

=dynamic flexural
rigidity of the slab (in
Nm2 when m is in
kg/m2 ) system,

f
0

=natural frequency
from above

L
x

=span of the primary
beam (in m)

Wh
ere

 

η = frequency factor
 = 0.5 for f0 < 5 Hz

 = 21*f0 - 0.55 for 5 Hz ≤ f0 ≤ 6 Hz

 = 0.71 for f0 > 6 Hz
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Figure 1: Definition of variables used to establish effective modal mass

Mode Shape Factor

As previously described, there are two main mode shapes which relate to the
lowest frequencies - a secondary beam mode and a primary beam mode. The
lowest frequency of the two modes is used and the mode shape factors is
determined using the same mode.

There are two mode shape factors, μe at the point of excitation and μr at the
point of response.

If the response and excitation points are unknown, or if a general response for
the whole floor is required, μe and μr can conservatively be taken as 1.

Tekla Structural Designer will not calculate the values of these mode shape
factors, and will default to 1.0 but also gives you the option of providing values
to be used.

Resonance Build-up Factor

The 'resonance build-up factor' makes an allowance for the time it takes for
someone walking across the floor to begin to excite the floor - vibration is not
instantaneous upon the first footfall. Hence, a 'walking time' is required and is
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calculated from the 'walking distance' (see:Maximum corridor length) divided
by the 'walking velocity'.

First it is necessary to calculate the walking velocity as given by Equation 16 of
SCI P354,

V = 67*fp
2 - 4.83*fp + 4.5 for fp in the range 1.7 to

2.4 Hz

Wher
e

  

fp = the pace (walking) frequency supplied by the user

The resonance build-up factor is taken from Equation 37 of SCI P354,

ρ = 1 - e (-2*π*ζ Lp*fp /V)

Wher
e

  

ζ = the damping ratio
Lp = the walking distance

V = the walking velocity given above

Note that the resonance build-up factor has an upper bound of 1.0 and may,
conservatively be set to 1.0.

Resonance Acceleration

Low Frequency Floors

For system frequencies between 3 Hz and 10 Hz, the root mean square (rms)
acceleration is calculated from,

aw,rms = μe* μr* 0.1*Q*W*ρ/(2 * √2*M * ζ)

Where

μe &
μr

=mode shape factors  

Q =the person's weight taken as 745.6 N (76 kg)
M =the modal mass (kg)  
 =the damping ratio  
ρ =the resonance build-up factor
W =the appropriate code-defined weighting factor for the human

perception of vibrations, based on the fundamental frequency, f 0
 =f0 /5 for 2 ≤ f0 < 5
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 =1.0 for 5 ≤ f0 ≤ 16

 =16/f0 for f0 > 16

High Frequency Floors

For system frequencies greater than 10 Hz, the root mean square (rms)
acceleration is calculated from the following expression, which assumes that
the floor exhibits a transient response,

aw,rms = 2*π* μ e* μ r * 185*Q*W /(M*f0 0.3*700* √2)

Response Factor

The 'base curves' in BS 6472: 1992 are given in terms of root mean square
(rms) acceleration

The provided response factor is then calculated from,

Rprov = a w,rms /0.005

The 'required response factor', Rreqd, is a user input and leads to the final
design condition,

Rprov ≤ R reqd

In SCI P354 the recommended Response Factors derive from BS 6472: 1992,
where they are called 'Multiplying Factors' and are reproduced in SCI P354 as
Tables 5.2 and 5.3.

Vibration Dose Values

When the floor has a higher than acceptable response factor, the acceptability
of the floor may be assessed by considering the intermittent nature of the
dynamic forces. This is accomplished by carrying out a Vibration Dose Value
[VDV] analysis.

This method calculates the number of times an activity (for example walking
along a corridor) will take place during an exposure period, na, from,

na = (1/Ta )*(VDV/(0.68*a w,rms ))4

wher
e

  

Ta = the duration of the activity

 = L p/V if L p is known OR
 = value supplied by user if L p is not known
VDV = VDV value supplied by user, (default 0.4).
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Typical VDV values are shown below:

Vibration dose limits (m/s1.75) for z-axis vibration specified by BS 6472
Place Low probability

of adverse
comment

Adverse
comment
possible

Adverse
comment
probable

buildings 16 h day 0.2 to 0.4 0.4 to 0.8 0.8 to 1.6
buildings 8 h night 0.13 0.26 0.51

Input requirements for P354 floor vibration

General

The simplified method for the analysis of the vibration of floors given in the
SCI Publication P354, on which the Tekla Structural Designer check is based, is
only applicable to regular structures which, by and large, are created from
rectilinear grids.

Of course the floor layouts of 'real' multi-storey buildings are rarely uniform
and Tekla Structural Designer therefore provides you with the opportunity to
select the more irregular floor areas to be assessed with grids that are other
than rectilinear.

In so far as the selection of the beams to be used in the analysis is concerned,
only beams with Non-Composite or Composite attributes are valid for
selection and, within these confines, you are able to:

• select a single beam

• select a beam span as critical plus an adjoining span (in a two or three span
configuration)

In all cases, and subject to the above restrictions, which beams from the
selected area of floor are chosen is entirely at your discretion and under your
judgement, but it is expected that the beams chosen will be those that are
typical, common or the worst case. Irrespective, Tekla Structural Designer will
take these beams as those that form the idealized floor layout. There is no
validation on what the you select (although there is some validation on which
beams are selectable i.e. beams which have no slab for part of their length,
beams from angle sections, beams with no adjoining span when a 2-span
configuration is chosen, and beams with no adjoining span at both ends when
a 3-span configuration is chosen will not be selectable).

Data Derived from Tekla Structural Designer (P354)

Note that, where appropriate, the derived data is for each design combination
under SLS loads only.

Unit mass
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The unit mass in kg/m2 is used to establish the 'participating mass' of the floor
- that is the mass of floor and its permanent loading that has to be set in
motion during vibration of the floor. It is taken as the slab self-weight (and to
be accurate, the beam self-weight), other permanent 'Dead' loads and the
proportion of the 'Imposed' loads that can be considered as permanent. The
latter is usually taken as 10% and, whilst this is the default, the value is
editable since imposed storage loads, for example, would warrant a higher
value.

The unit mass is obtained by summing all the loads (or the appropriate
percentage in the case of imposed loads) that act over or in the selected area.
This includes any blanket, area, line and spot loads that are present within the
selected area. The component of any of these load types that lie outside of the
selected area are ignored. Nodal loads directly on columns are also ignored.
The total load is then divided by the area selected.

The slab self-weight will usually be in the Slab Dry loadcase - note that in the
case of composite slabs this includes the weight of decking. The beam self-
weight is in a separate protected loadcase. For simplicity this component of
the unit mass is ignored. This leads to a slight inaccuracy in the participating
mass that is conservative (more mass is advantageous).

Note that the use of imposed load reductions has no effect on the floor
vibration check.

Slab data

If there are more than one set of slab attributes in the selected area then you
have to choose which of these it is appropriate to use. From the designated
slab attributes the following information/data is obtained,

• the un-transformed inertia in c m 4 per metre width. For profiled decking this
takes account of the concrete in the troughs and is independent of the
direction of span of the decking.

• the short-term modular ratio for normal or lightweight concrete as
appropriate.

If the designated slab attributes are for a 'generic' slab, then you are asked for
the inertia and the dynamic modular ratio.

Secondary beam data

When these are non-composite beams, the inertia is obtained from the
sections database. When these beams are of composite construction the
inertia is the gross, uncracked composite inertia based on the dynamic
modular ratio that is required. Steel joist inertias from the database are
assumed to be 'gross' inertias of the chords and are editable. Following
guidance contained in AISC Steel Design Guide 11 (page 2006), section 3.6, the
gross steel joist inertia is factored by quantity Cr and displayed as the
'effective' inertia in the results viewer.

The span of the critical/base beam and the adjoining beams is required.

Design codes reference 2004 Eurocodes



The deflection of the critical beam under the permanent loads is required. To
calculate this value, the deflection under the Dead loads and the appropriate
percentage of the Imposed load deflection is summed.

Primary beam data

The same data is required as that for the secondary beams.

Floor plate data

The dimensions of the floor plate in the idealized cases are defined in one
direction by the number of secondary beam bays and in the orthogonal
direction by the number of primary beam bays. In practice, given that the
idealized case may not attain, the floorplate dimensions are derived from the
slab items you select as participating in the mass.

User Input Data (P354)

Secondary Beam Spacing

You must confirm the spacing of the secondary beams - an average value
when the spacing is non-uniform.

Proportion of Imposed Loads

You are required to specify the proportion of the imposed loads that is to be
used in the vibration analysis.

Number of bays used to establish Modal mass

You are required to specify the number of bays in the direction of the
secondary beam span, n y, and the number of bays in the direction of the
primary beam span, n x, that are to be used to establish the modal mass. The
number of bays ranges from 1 to 4 for both directions.

Mode Shape Factors

You are required to specify the mode shape factors, μe and μr, which are to be
used in the evaluation of the root mean square response acceleration. The
default value is 1.0 for both variables.

Damping ratio

Floors do not vibrate as a free mass but have some damping i.e. dissipation of
the energy in the system. Four values of damping ratio are recommended in
P354 as a percentage,

• 0.5%, for fully welded steel structures, e.g. staircases,

• 1.1%, for completely bare floors or floors where only a small amount of
furnishings are present,

• 3.0%, for normal, open-plan, well-furnished floors (the default),

• 4.5%, for a floor where the designer is confident that partitions will be
appropriately located to interrupt the relevant mode(s) of vibration i.e. the
partition lines are perpendicular to the main vibrating elements of the
critical mode shape.
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Since an even higher damping ratio might be justified for storage floors for
example, a range of up to 10% is offered.

Maximum corridor length

This is used in the calculation of the "Resonance Build-up Factor" that makes
an allowance for the time it takes for someone walking across the floor to
begin to excite the floor - vibration is not instantaneous upon the first footfall.
Hence, a "walking time" is required and is calculated from the "walking
distance" (maximum corridor length) divided by the "walking velocity".

The designer will often not know, reliably, the maximum corridor length. The
default is therefore taken as the longer of the floor plate dimensions.

If the designer does not wish to estimate the maximum corridor length or
accept the default, then the Resonance Build-up Factor can be set to 1.0 by
selecting Not known for the maximum corridor length. This sets the
Resonance Build-up Factor to 1.0.

Walking Pace

The walking frequency (pace) must be selected in the range 1.7 to 2.4 Hz. This
range is equivalent to a walking velocity of 2.5 to 5.7 mph (4.0 to 9.1 kph).
Walking velocities less than and greater than this are achievable - slow walking
1.0 to 1.5 mph (1.6 to 2.4 kph) or running 6.0 to 12.0 mph (9.6 to 19.2 kph).
However, the range of validity of the formula for calculating the walking
velocity is given as that quoted. Thus any consequent value outside of the
range 1.7 to 2.4 Hz is given a Warning that this is outside of the range given in
Equation 16 of SCI P354. The default value is 1.8 Hz.

Resonance build-up factor

This is calculated data and has an upper bound of 1.0. However, you are able
to specify that the calculations should use 1.0 perhaps because there is
insufficient information at the time to make a more accurate and reliable
estimate (see: Maximum corridor length). Setting the value to 1.0 is
conservative.

Required Response Factor

You must enter the response factor that you expect the floor to achieve. This
will be based on your engineering judgement and the advice given in P354.
Tables 5.2 and 5.3 of that publication give a range of values with the common
values being 2, 4, and 8.

Vibration Dose Value (VDV)

You have to specify the VDV value to be used if this analysis is performed (see:
Vibration Dose Values (page 1995)).

Vibration of floors to SCI P354 references
1. British Standards Institution. BS 6472: 1992 Guide to the evaluation of

human response to vibration in buildings (1Hz to 80 Hz). BSI 1992.
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2. The Steel Construction Institute. Design of Floors for Vibration: A New
Approach. SCI P354. 2007

3. AISC Steel Design Guide Series.11: Floor Vibrations Due to Human
Activity. AISC 2003 re-print.

14.3 British Standards
• Loading (British Standards) (page 2007)

• Steel design to BS 5950 (page 2013)

• Vibration of floors to SCI P354 (page 1989)

Loading (British Standards)
This handbook provides a general overview of how loadcases and
combinations are created in Tekla Structural Designer when a British
Standards (BS) head code is applied. The Combination Generator for BS
loading is also described.

Load cases (British Standards)

Loadcase types (British Standards)

The following load case types can be created:

Loadcase
Type

Calculated
Automaticall

y

Include in
the

Combination
Generator

Imposed
Load

Reductions

Pattern Load

self weight
(beams,
columns and
walls)

yes/no yes/noI N/A N/A

slab wet yes/no N/A N/A N/A
slab dry yes/no yes/no N/A N/A
dead N/A yes/no N/A N/A
imposed N/A yes/no yes/no yes/no
roof imposed N/A yes/no N/A N/A
wind N/A yes/no N/A N/A
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Loadcase
Type

Calculated
Automaticall

y

Include in
the

Combination
Generator

Imposed
Load

Reductions

Pattern Load

snow N/A yes/no N/A N/A
snow drift N/A yes/no N/A N/A
temperature N/A N/A N/A N/A
settlement N/A N/A N/A N/A
seismic N/A yes N/A N/A

As shown above, self weight loads can all be determined automatically.
However, other gravity load cases have to be applied manually as you build
the structure.

Self weight (British Standards)

Self weight - excluding slabs loadcase

Tekla Structural Designer automatically calculates the self weight of the
structural beams/columns for you. The Self weight - excluding slabs loadcase
is pre-defined for this purpose. Its loadcase type is fixed as “Selfweight”. It
cannot be edited and by default it is added to each new load combination.

Self weight of concrete slabs

Tekla Structural Designer expects the wet and dry weight of concrete slab to
be defined in separate loadcases. This is required to ensure that members are
designed for the correct loads at construction stage and post construction
stage.

The Slab self weight loadcase is pre-defined for the dry weight of concrete
post construction stage, its loadcase type is fixed as “Slab Dry”.

There is no pre-defined loadcase for the wet weight of concrete slab at
construction stage, but if you require it for the design of any composite beams
in the model the loadcase type should be set to “Slab Wet”.

Tekla Structural Designercan automatically calculate the above weights for you
taking into account the slab thickness, the shape of the deck profile and
wet/dry concrete densities. It does not explicitly take account of the weight of
any reinforcement but will include the weight of decking. Simply click the Calc
Automatically check box when you create each loadcase. When calculated in
this way you can’t add extra loads of your own into the loadcase.

If you normally make an allowance for ponding in your slab weight
calculations, Tekla Structural Designer can also do this for you. After selecting
the composite slabs, you are able to review the slab item properties - you will
find two ways to add an allowance for ponding (under the slab parameters
heading). These are:

• as a value, by specifying the average increased thickness of slab
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• or, as a percentage of total volume.

Using either of these methods the additional load is added as a uniform load
over the whole area of slab.

Imposed and roof imposed loads (British Standards)

Imposed load reductions

Reductions can be applied to imposed loads to take account of the
unlikelihood of the whole building being loaded with its full design imposed
load. Reductions can not however be applied to roof imposed loads.

Imposed loads are only automatically reduced on:

• Columns of any material

• Concrete walls, mid-pier or meshed

Tekla Structural Designer does not automatically apply imposed load
reductions to floors. For steel beams, concrete beams, slabs and mats it is
however possible to define the level of imposed load reduction manually via
the beam/slab item properties.

This is particularly relevant for the design of transfer beams/slabs:

• The imposed load reduction for beams, slabs and mats is intended to work
with loads applied from columns acting on the beam or slab when the slab
is acting in transfer or for a mat foundation supporting a column. (The
theory being that if you want to design the columns for the reduced axial
load, you should also design the supporting member for the reduced axial
load applied by the column.)

• The engineer would need to work out the reduction of the axial load in the
column and apply this as a the reduction percentage, i.e. if the raw axial
load in the column is 100kN and the reduced load is 60kN, the reduction is
40%. You would than apply the 40% reduction to the transfer beam/slab or
mat as well.

• The reduction is not applied to loads for analysis - it is a post-analysis
process which does not affect the analysis results. It does not get applied
solely to the imposed load applied directly to the beam or slab panel, but
instead is applied to the design moment used in the beam/slab or mat
design process.

Wind loads (British Standards)

The BS 6399-2 Wind wizard...

NOTE The Wind Wizard used for automatic wind loadcase generation is fully
described in the Wind Modelling Engineer’s Handbook.
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The Wind Wizard... is run to create a series of static forces that are combined
with other actions due to dead and imposed loads in accordance with
BS6399-2:1997.

The following assumptions/limitations exist:

• The shape of the building meets the limitations allowed for in the code.

• It must be a rigid structure.

• The structure must be either enclosed or partially enclosed.

• Parapets and roof overhangs are not explicitly dealt with.

For further information on the wind loading capabilities of Tekla Structural
Designer refer to the Wind Modelling Engineer’s Handbook.

Simple wind loading

If use of the Wind Wizard is not appropriate for your structure then wind
loads can be applied via element or structure loads instead.

Combinations (British Standards)

Once your load cases have been generated as required, you then combine
them into load combinations; these can either be created manually, by clicking
Add... - or with the assistance of the Combinations Generator, by clicking
Generate...

NOTE For the British Standard codes we are assuming that the wind load
applied in manually defined combinations, or via the combination
generator, satisfies the minimum horizontal load requirement
(BS5950 Cl 2.4.2.3 (1% of factored dead load) and BS8110 Cl 3.1.4.2
(1.5% characteristic dead weight)). If this is not the case, i.e. the wind
load is less than the minimum proportion of dead load specified in the
code, then you need to consider manually creating a minimum
horizontal load combination.

Manually defined combinations (British Standards)

As you build up combinations manually, the combination factors are
automatically adjusted as load cases are added and removed from the
combination.

Notional horizontal forces (NHFs) (British Standards)

NHF’s are automatically derived from the loadcases within the current
combination, their magnitude being calculated in accordance with BS5950 cl
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2.4.2.3 as 0.5% of the factored vertical load that passes through any beam/
column intersection in the structure.

NOTE BS8110 cl 3.1.4.2 has a requirement for notional horizontal load “NHL”
This does NOT equate to the NHF requirement described above. The
calculation of “NHL” as defined in BS8110 is beyond scope in the
current version of Tekla Structural Designer.

They are applied to the structure in the building directions 1 and 2 as follows:

• NHF Dir1+

• NHF Dir1-

• NHF Dir2+

• NHF Dir2-

The net result is that any combination is able to have up to 2 Notional Loads
applied within it - one from Dir1 (+ or -) and one from Dir2 (+ or -). Note
however, that Dir1+ can not be added with Dir1- (and similarly Dir2+ can not
be added with Dir2-).

Combination generator (British Standards)
Accessed via the Generate... command, this automatically sets up
combinations for both strength and serviceability.

Combination generator - Combinations

The first page of the generator lists the combinations applicable (with
appropriate strength factors).

The following basic load combinations are created:

• 1.4 (Dead) + 1.6 (Imposed or Snow)

• 1.2 (Dead) + 1.2 (Imposed or Snow) + 1.2 (Wind)

• 1.0 (Dead) + 1.4 (Wind)

NOTE Temperature and settlement load case types are not included in the
Generate... command - these need to be added manually.

The combination names are generated automatically.

Combination generator - Service

This page indicates which combinations are to be checked for serviceability
and the factors applied.

The following basic load combinations are created:

• 1.0 (Dead) + 1.0 (Live or Snow)

• 1.0 (Dead) + 0.8 (Live or Snow) + 0.8 (Wind)

• 1.0 (Dead) + 1.0 (Wind)
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Combination generator - NHF

The last page is used to set up the notional horizontal forces. You can specify
NHF’s and factors in each of four directions. For each direction selected, a
separate NHF combination will be generated.

Any combination with wind in is automatically greyed.

Click Finish to see the list of generated combinations.

Combination classes (British Standards)

Having created your combinations you classify them as: Construction Stage,
Gravity, Lateral, or Modal Mass.

NOTE If generated via the Combinations generator they are classified for
you automatically.

Then (where applicable) you indicate whether they are to be checked for
strength or service conditions, or both. You also have the option to make any
of the combinations inactive.

Construction stage combination (British Standards)

A Construction Stage load combination is only required for the purpose of
designing any composite beams within the model. It is distinguished from
other combinations by setting its “Class” to Construction Stage. Typically this
combination would include a loadcase of type “Slab Wet”, (not “Slab Dry”),
other loadcases being included in the combination as required.

NOTE The Slab Wet loadcase type should not be included in any other
combination.

Gravity combination (British Standards)

These combinations are considered in both the Gravity Sizing and Full Design
processes.

They are used in the Gravity Sizing processes as follows:

• Design Concrete (Gravity) - concrete members in the structure are
automatically sized (or checked) for the gravity combinations

• Design Steel (Gravity) - steel members in the structure are automatically
sized (or checked) for the gravity combinations.

• Design All (Gravity) - all members in the structure are automatically sized
(or checked) for the gravity combinations.

They are also used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the gravity combinations.
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• Design Steel (All) - steel members in the structure are automatically sized
(or checked) for the gravity combinations.

• Design All (All) - all members in the structure are automatically sized (or
checked) for the gravity combinations.

Lateral combinations (British Standards)

These combinations are not used in the Gravity Sizing processes.

They are used during the Full Design processes as follows:

• Design Concrete (All) - concrete members in the structure are automatically
sized (or checked) for the lateral combinations.

• Design Steel (All) - steel members in the structure which have not been set
as Gravity Only are automatically sized (or checked) for the lateral
combinations.

• Design All (All) - all concrete members and all steel members which have
not been set as Gravity Only are automatically sized (or checked) for the
lateral combinations.

Modal mass combinations (British Standards)

For modal analysis, you are required to set up specific “modal mass”
combinations. Provided these combinations are active they are always run
through the modal analysis.

NOTE It is always assumed that all loads in the load cases in the combination
are converted to mass for modal analysis. You are permitted to add
lumped mass directly to the model.

Steel design to BS 5950

Tekla Structural Designer designs steel members and composite members to a
range of international codes. This reference guide specifically describes the
design methods applied when the steel design and composite design
resistance codes are set as BS 5950-1 and BS 5950-3.1 respectively.

Unless explicitly noted otherwise, all clauses, figures and tables referred to are
from BS 5950-1:2000 (Ref. 2); apart from the Composite Beam section, within
which references are to BS 5950-3.1:2010 (Ref. 1) unless stated.

Basic principles (BS 5950)

Deflection checks

Tekla Structural Designer calculates both relative and absolute deflections.
Relative deflections measure the internal displacement occurring within the
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length of the member and take no account of the support settlements or
rotations, whereas absolute deflections are concerned with deflection of the
structure as a whole. The absolute deflections are the ones displayed in the
structure deflection graphics. The difference between relative and absolute
deflections is illustrated in the cantilever beam example below.

Relative deflections are given in the member analysis results graphics and are
the ones used in the member design.

Steel beam design to BS 5950

Design method (Beams: BS 5950)
Unless explicitly stated all calculations are in accordance with the relevant
sections of BS 5950-1:2000. You may find the handbook and commentary to
the Code of Practice published by the Steel Construction Institute useful.

Steel beam limitations and assumptions (Beams: BS 5950)

The following limitations apply:

• continuous beams (more than one span) must be co-linear in the plane of
the web within a small tolerance (sloping in elevation is allowed),

• rolled doubly symmetric prismatic sections (that is I- and H-sections),
doubly symmetric hollow sections (i.e. SHS, RHS and CHS), and channel
sections are fully designed,

• single angle, double angles and tees are designed, but certain checks are
beyond scope, (see Angle and tee limitations)

• plated beams are fully designed provided the section type is either “Plated
Beam” or “Plated Column”. All other plated section types (“Rolled I Sections
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with Plates”, “Double Rolled I Sections” etc.) are only analysed but not
designed.

• Fabsec beams (with or without openings) are excluded.

The following assumptions apply:

• All supports are considered to provide torsional restraint, that is lateral
restraint to both flanges. This cannot be changed. It is assumed that a
beam that is continuous through the web of a supporting beam or column
together with its substantial moment resisting end plate connections is
able to provide such restraint.

• If, at the support, the beam oversails the supporting beam or column then
the detail is assumed to be such that the bottom flange of the beam is well
connected to the supporting member and, as a minimum, has torsional
stiffeners provided at the support.

• In the Tekla Structural Designer model, when not at supports, coincident
restraints to both flanges are assumed when one or more members frame
into the web of the beam at a particular position and the cardinal point of
the centre-line model of the beam lies in the web. Otherwise, only a top
flange or bottom flange restraint is assumed. Should you judge the actual
restraint provided by the in-coming members to be different from to what
has been assumed, you have the flexibility to edit the restraints as
required.

• Intermediate lateral restraints to the top or bottom flange are assumed to
be capable of transferring the restraining forces back to an appropriate
system of bracing or suitably rigid part of the structure.

• It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints for both LTB and compression
buckling. The default value for the effective length factor of 1.0 may be
neither correct nor safe.

Ultimate limit state (strength) (Beams: BS 5950)

The checks relate to doubly symmetric prismatic sections (that is rolled I- and
H-sections), to singly symmetric sections i.e. channel sections and to doubly
symmetric hollow sections i.e. SHS, RHS and CHS. Other section types are not
currently covered.

The strength checks relate to a particular point on the member and are carried
at regular intervals along the member and at “points of interest”.

Classification (Beams: BS 5950)

General

The classification of the cross section is in accordance with BS 5950-1: 2000.

Steel beams can be classified as:

• Plastic Class = 1
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• Compact Class = 2

• Semi-compact Class = 3

• Slender Class = 4

Class 4 sections are only acceptable for angle and tee sections.

Sections with a Class 3 web can be taken as Class 2 sections (Effective Class 2)
providing the cross section is equilibrated to that described in Clause 3.5.6
where the section is given an “effective” plastic section modulus, Seff. For rolled
I and H sections in the UK, this gives no advantage in pure bending since the
web d/t is too small. Hence for beams there is likely to be little advantage in
using this approach since the axial loads are generally small, this classification
is therefore not implemented.

All unacceptable classifications are either failed in check mode or rejected in
design mode.

Hollow sections

The classification rules for SHS and RHS relate to “hot-finished hollow sections”
only (“cold-formed hollow sections” are not included in this release).

WARNING Important Note. The classification used to determine Mb is based
on the maximum axial compressive load in the relevant segment
length. Furthermore, the Code clearly states that this
classification should (only) be used to determine the moment
capacity and lateral torsional buckling resistance to Clause 4.2
and 4.3 for use in the interaction equations. Thus, when carrying
out the strength checks, the program determines the
classification at the point at which strength is being checked.

Shear capacity (Beams: BS 5950)
The shear check is performed according to BS 5950-1: 2000 Clause 4.2.3. for
the absolute value of shear force normal to the x-x axis (Fvx) and normal to the
y-y axis (Fvy), at the point under consideration.

Shear buckling

When the web slenderness exceeds 70ε shear buckling can occur in rolled
sections. There are very few standard rolled sections that breach this limit.
Tekla Structural Designer will warn you if this limit is exceeded, but will not
carry out any shear buckling checks.

Moment capacity (Beams: BS 5950)

The moment capacity check is performed according to BS 5950-1: 2000 Clause
4.2.5 for the moment about the x-x axis (Mx) and about the y-y axis (My), at the
point under consideration. The moment capacity can be influenced by the
magnitude of the shear force (“low shear” and “high shear” conditions). The
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maximum absolute shear to either side of a point load is examined to
determine the correct condition for the moment capacity in that direction.

NOTE Not all cases of high shear in two directions combined with moments
in two directions along with axial load are considered thoroughly by
BS 5950-1: 2000. The following approach is adopted by Tekla
Structural Designer:

• if high shear is present in one axis or both axes and axial load is
also present, the cross-section capacity check is given a Beyond
Scope status. The message associated with this status is “High
shear and axial load are present, additional hand calculations are
required for cross-section capacity to Annex H.3”. Tekla Structural
Designer does not perform any calculations for this condition.

• if high shear and moment is present in both axes and there is no
axial load (“biaxial bending”) the cross-section capacity check is
given a Beyond Scope status and the associated message is, “High
shear present normal to the y-y axis, no calculations are
performed for this condition.”

• if high shear is present normal to the y-y axis and there is no axial
load, the y-y moment check and the cross-section capacity check
are each given Beyond Scope statuses. The message associated
with this condition is, “High shear present normal to the y-y axis,
no calculations are performed for this condition.”

Axial capacity (Beams: BS 5950)

The axial capacity check is performed according to BS 5950-1: 2000 Clause
4.6.1 using the gross area and irrespective of whether the axial force is tensile
or compressive. This check is for axial compression capacity and axial tension
capacity. Compression resistance is a buckling check and as such is considered
under Compression Resistance.

Cross-section capacity (Beams: BS 5950)

The cross-section capacity check covers the interaction of axial load and
bending to clause 4.8.2 and 4.8.3.2 appropriate to the type (for example –
doubly symmetric) and classification of the section. Since the axial tension
capacity is not adjusted for the area of the net section then the formula in
clause 4.8.2.2 and 4.8.3.2 are the same and can be applied irrespective of
whether the axial load is compressive or tensile.

The Note in Moment capacity also applies here.

Ultimate limit state (buckling) (Beams: BS 5950)

Lateral torsional buckling resistance, clause 4.3 (Beams: BS 5950)
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For beams that are unrestrained over part or all of a span, a Lateral torsional
buckling (LTB) check is required either:

• in its own right, clause 4.3 check,

• as part of an Annex G check,

• as part of a combined buckling check to 4.8.3.3.1, 4.8.3.3.2 or 4.8.3.3.3, (see
Member buckling resistance, clause 4.8.3.3.1, Member buckling resistance,
clause 4.8.3.3.2 (page 2020), and Member buckling resistance, clause
4.8.3.3.3 (page 2021), respectively)

This check is not carried out under the following circumstances:

• when bending exists about the minor axis only,

• when the section is a CHS or SHS,

• when the section is an RHS that satisfies the limits given in Table 15 of BS
5950-1: 2000.

For sections in which LTB cannot occur (the latter two cases above) the value
of Mb for use in the combined buckling check is taken as the full moment
capacity, Mcx, not reduced for high shear in accordance with clause 4.8.3.3.3
(c), equation 2 (See Member buckling resistance, clause 4.8.3.3.3).

Effective lengths

The value of effective length factor is entirely at your choice. The default value
is 1.0 for “normal” loads and 1.2 for “destabilizing loads”. Different values can
apply in the major and minor axis.

Lateral torsional buckling resistance, Annex G (Beams: BS 5950)

This check is applicable to I- and H-sections with equal or unequal[1] flanges.

The definition of this check is the out-of-plane buckling resistance of a
member or segment that has a laterally unrestrained compression flange and
the other flange has intermediate lateral restraints at intervals. It is used
normally to check the members in portal frames in which only major axis
moment and axial load exist. Although not stated explicitly in BS 5950-1: 2000,
it is taken that the lateral torsional buckling moment of resistance, Mb, from
the Annex G check can be used in the interaction equations of clause 4.8.3.3
(combined buckling).

Since this is not explicit within BS 5950-1: 2000 a slight conservatism is
introduced. In a straightforward Annex G check the axial load is combined with
major axis moment. In this case both the slenderness for lateral torsional
buckling and the slenderness for compression buckling are modified to allow
for the improvement provided by the tension flange restraints (λLT replaced by
λTB and λ replaced by λTC). When performing a combined buckling check in
accordance with 4.8.3.3 the improvement is taken into account in determining
the buckling resistance moment but not in determining the compression
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resistance. If the incoming members truly only restrain the tension flange,
then you should switch off the minor axis strut restraint at these positions.

The original source research work for the codified approach in Annex G used
test specimens in which the tension flange was continuously restrained. When
a segment is not continuously restrained but is restrained at reasonably
frequent intervals it can be clearly argued that the approach holds true. With
only one or two restraints present then this is less clear. BS 5950-1: 2000 is
clear that there should be “at least one intermediate lateral restraint” (See
Annex G.1.1). Nevertheless, you are ultimately responsible for accepting the
adequacy of this approach.

For this check Tekla Structural Designer sets mt to 1.0 and calculates nt. The
calculated value of nt is based on Mmax being taken as the maximum of M1 to
M5, and not the true maximum moment value where this occurs elsewhere in
the length. The effect of this approach is likely to be small. If at any of points 1
- 5, R >1[2], then the status of the check is set to Beyond Scope.

Reference restraint axis distance, a

The reference restraint axis distance is measured between some reference
axis on the restrained member - usually the centroid - to the axis of restraint -
usually the centroid of the restraining member. The measurement is shown
diagramatically in Figure G.1 of BS 5950-1: 2000.

Tekla Structural Designer does not attempt to determine this value
automatically. Instead, by default, it uses half the depth of the restrained
section, and you can specify a value to be added to, or subtracted from, this at
each restraint point. You are responsible for specifying the appropriate
values for each restraint position. The default value of 0mm may be
neither correct nor safe.
[1] Unequal flanged sections are not currently included.
[2] Which could happen since R is based on Z and not S.

Compression resistance (Beams: BS 5950)
For most structures, all the members resisting axial compression need
checking to ensure adequate resistance to buckling about both the major- and
minor-axis. Since the axial force can vary throughout the member and the
buckling lengths in the two planes do not necessarily coincide, both are
checked. Because of the general nature of a beam, it may not always be safe
to assume that the combined buckling check will always govern. Hence the
compression resistance check is performed independently from the other
strength and buckling checks.

Effective lengths

The value of effective length factor is entirely at your choice. The default value
is 1.0 for “normal” loads and 1.2 for “destabilizing loads”. Different values can
apply in the major and minor axis.
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Beams are less affected by sway than columns but the effectiveness of the
incoming members to restrain the beam in both position and direction is
generally less than for columns. Hence, it is less likely that effective length
factors greater than 1.0 will be required but equally factors less than 1.0 may
not easily be justified. Nevertheless, it is your responsibility to adjust the value
from 1.0 and to justify such a change.

Please note that the requirements for slenderness limits in (for example l/r ≤
180) are no longer included in BS 5950-1: 2000. Consequently Tekla Structural
Designer does not carry out such checks. Accordingly, for lightly loaded
members you should ensure that the slenderness ratio is within reasonable
bounds to permit handling and erection and to provide a reasonable level of
robustness.

Member buckling resistance, clause 4.8.3.3.1 (Beams: BS 5950)

This check is used for channel sections. Such sections can be Class 1, 2 or 3
Plastic, Compact or Semi-compact (Class 4 Slender sections and Effective Class
2 sections are not allowed in this release).

Note that, whilst this check could be used for any section type dealt with in the
subsequent sections, the results can never be any better than the alternatives
but can be worse.

Two formula are provided in clause 4.8.3.3.1, both are checked; the second is
calculated twice – once for the top flange and once for the bottom flange.

See also the Important Note at the end of Member buckling resistance, clause
4.8.3.3.2.

Only one value of F is used, the worst anywhere in the length being checked. If
the axial load is tensile, then F is taken as zero.

If this check is invoked as part of an Annex G check, and thus Mb is governed
by Annex G, then mLT is taken as 1.0.

Member buckling resistance, clause 4.8.3.3.2 (Beams: BS 5950)

This check is used for Class 1, 2 and 3 Plastic, Compact and Semi-compact
rolled I- and H-sections with equal flanges (Class 4 Slender sections and
Effective Class 2 sections are not included in this release).

Three formula are provided in clause 4.8.3.3.2 (c) to cover the combined
effects of major and minor axis moment and axial force. These are used
irrespective of whether all three forces / moments exist. Clause 4.9 deals with
biaxial moment in the absence of axial force, clause 4.8.3.3.2 (c) can also be
used in such cases by setting the axial force to zero.

All three formula in clause 4.8.3.3.2 (c) are checked; the second is calculated
twice – once for each flange.
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Only one value of F is used, the worst anywhere in the length being checked. If
the axial load is tensile, then F is taken as zero.

WARNING Important Note. Clause 4.8.3.3.4 defines the various equivalent
uniform moment factors. The last three paragraphs deal with
modifications to these depending upon the method used to allow
for the effects of sway. This requires that for sway sensitive
frames the uniform moment factors, mx, my and mxy, should be
applied to the non-sway moments only. In this release there is no
mechanism to separate the sway and non-sway moments, Tekla
Structural Designer adopts a conservative approach and sets
these 'm' factors equal to 1.0 if the frame is sway sensitive (in
either direction). This is doubly conservative for sway-sensitive
unbraced frames since it is likely that all the loads in a design
combination and not just the lateral loads will be amplified. In
such a case, both the sway and non-sway moments are increased
by kamp and neither are reduced by the above “m” factors. The
calculation of mLT is unaffected by this approach, and thus if the
second equation of clause 4.8.3.3.2 (c) governs, then the results
are not affected.

Member buckling resistance, clause 4.8.3.3.3 (Beams: BS 5950)

This check is used for Class 1, 2 and 3 Plastic, Compact and Semi-compact
hollow sections (Class 4 Slender sections and Effective Class 2 sections are not
included in this release).

Four formula are provided in clause 4.8.3.3.3 (c) to cover the combined effects
of major and minor axis moment and axial force. These are used irrespective
of whether all three forces / moments exist. Clause 4.9 deals with biaxial
moment in the absence of axial force, clause 4.8.3.3.3 (c) can also be used in
such cases by setting the axial force to zero.

The second and third formula are mutually exclusive – that is the second is
used for CHS, SHS and for RHS when the limits contained in Table 15 are not
exceeded. On the other hand the third formula is used for those RHS that
exceed the limits given in Table 15. Thus only three formula are checked; the
first, second and fourth or the first, third and fourth. Either the second or third
(as appropriate) is calculated twice – once for each “flange”.

Only one value of F is used, the worst anywhere in the length being checked. If
the axial load is tensile, then F is taken as zero.

See also the Important Note at the end of Member buckling resistance, clause
4.8.3.3.2.

Natural frequency checks (SLS) (Beams: BS 5950)
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Tekla Structural Designer calculates the approximate natural frequency of the
beam based on the simplified formula published in the Design Guide on the
vibration of floors (Ref. 6) which states that Natural frequency = 18 / √ δ

In line with the calculation of natural frequency of 18 / √ δ for a pin ended
beam with applied UDL, we calculate δ as the maximum static instantaneous
deflection based upon the composite inertia (using the short term modular
ratio) but not modified for the effects of partial interaction as:

δ = %max δself+slab + %max δother dead + %max δlive

The engineer can specify:

• Percentage self wt + slab deflection (default 100%)

• Percentage other dead deflection (default 100%)

• Percentage live load deflection (default 10%)

• Factor of increased dynamic stiffness of concrete flange (default 1.1)

Web openings (Beams: BS 5950)

Circular openings as an equivalent rectangle

Each circular opening is replaced by equivalent rectangular opening, the
dimensions of this equivalent rectangle for use in all subsequent calculations
are:

• do' = 0.9 * opening diameter

• lo = 0.45 * opening diameter

Properties of tee sections

When web openings have been added, the properties of the tee sections
above and below each opening are calculated in accordance with Section 3.3.1
of SCI P355 (Ref. 10 (page 2047)) and Appendix B of the joint CIRIA/SCI
Publication P068 (Ref. 5 (page 2047)). The bending moment resistance is
calculated separately for each of the four corners of each opening.

Design

The following calculations are performed where required for web openings:

• Axial resistance of tee sections

• Classification of section at opening

• Vertical shear resistance

• Vierendeel bending resistance

• Web post horizontal shear resistance

• Web post bending resistance

• Web post buckling resistance

• Lateral torsional buckling
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• Deflections

Deflections

The deflection of a beam with web openings will be greater than that of the
same beam without openings. This is due to two effects,

• the reduction in the beam inertia at the positions of openings due to
primary bending of the beam,

• the local deformations at the openings due to Vierendeel effects. This has
two components - that due to shear deformation and that due to local
bending of the upper and lower tee sections at the opening.

The primary bending deflection is established by 'discretising' the member
and using a numerical integration technique based on 'Engineer's Bending
Theory' - M/I = E/R = σ/y. In this way the discrete elements that incorporate all
or part of an opening will contribute more to the total deflection.

The component of deflection due to the local deformations around the
opening is established using a similar process to that used for cellular beams
which is in turn based on the method for castellated beams given in the SCI
publication, “Design of castellated beams. For use with BS 5950 and BS 449".

The method works by applying a 'unit point load' at the position where the
deflection is required and using a 'virtual work technique to estimate the
deflection at that position.

For each opening, the deflection due to shear deformation, δs, and that due to
local bending, δbt, is calculated for the upper and lower tee sections at the
opening. These are summed for all openings and added to the result at the
desired position from the numerical integration of primary bending deflection.

Note that in the original source document on castellated sections, there are
two additional components to the deflection. These are due to bending and
shear deformation of the web post. For castellated beams and cellular beams
where the openings are very close together these effects are important and
can be significant. For normal beams the openings are likely to be placed a
reasonable distance apart. Thus in many cases these two effects will not be
significant. They are not calculated for such beams but in the event that the
openings are placed close together a warning is given.

Composite beam design to BS 5950

Design method (Composite beams: BS 5950)

Unless explicitly stated all calculations are in accordance with the relevant
sections of BS 5950-3.1:1990+A1:2010 (Ref. 1). You may find the handbook and
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commentary to the Code of Practice published by the Steel Construction
Institute (Ref. 3 and 4) useful.

Construction stage design checks

When you use Tekla Structural Designer to design or check a beam for the
construction stage (the beam is acting alone before composite action is
achieved) the following conditions are examined in accordance with BS
5950-1:2000:

• section classification (Clause 3.5.2),

• shear capacity (Clause 4.2.3),

• moment capacity:

• Clause 4.2.5.2 for the low shear condition,

• Clause 4.2.5.3 for the high shear condition,

• lateral torsional buckling resistance (Clause 4.3.6),

NOTE This condition is only checked in those cases where the profile
decking or precast concrete slab (at your request) does not
provide adequate restraint to the beam.

• web openings,

• Westok checks,

• Shear horizontal,

• Web post buckling,

• Vierendeel bending,

• construction stage total load deflection check.

Composite stage design checks

When you use Tekla Structural Designer to design or check a beam for the
composite stage (the beam and concrete act together, with shear interaction
being achieved by appropriate shear connectors) the following Ultimate Limit
State and Serviceability Limit State conditions are examined in accordance
with BS 5950 : Part 3 : Section 3.1 : 1990 (unless specifically noted otherwise).

Ultimate limit state checks

• section classification (Clause 4.5.2), depending on whether adequate
connection is achieved between the compression flange and the slab. The
section classification allows for the improvement of the classification of the
section if the appropriate conditions are met,

• vertical shear capacity (BS 5950-1:2000 - Clause 4.2.3),

• longitudinal shear capacity (Clause 5.6) allowing for the profiled metal
decking, transverse reinforcement and other reinforcement which has
been defined,
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• number of shear connectors required (Clause 5.4.7) between the point of
maximum moment and the end of the beam, or from and between the
positions of significant point loads,

• moment capacity:

• Clause 4.4.2 for the low shear condition,

• Clause 5.3.4 for the high shear condition,

• web openings.

Serviceability limit state checks

• service stresses (Clause 6.2),

• • concrete

• steel top flange and bottom flange

• deflections (Clause 6.1.2)

• self-weight

• SLAB loadcase,

• dead load,

• imposed load[1],

• total deflections,

natural frequency check (Clause 6.4).
[1] This is the only limit given in BS 5950 : Part 3 : Section 3.1 : 1990.

Construction stage design (Composite beams: BS 5950)

Tekla Structural Designer performs all checks for this condition in accordance
with BS 5950-1:2000 (Ref. 2)

Section classification (Composite beams: BS 5950)

Cross-section classification is determined using Table 11 and clause 3.5.

The classification of the section must be Plastic (Class 1), Compact (Class 2) or
Semi-compact (Class 3).

Sections which are classified as Slender (Class 4) are beyond the scope of Tekla
Structural Designer.

Member strength checks (Composite beams: BS 5950)
Member strength checks are performed at the point of maximum moment,
the point of maximum shear, the position of application of each point load,
and at each side of a web opening as well as all other points of interest along
the beam.
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Shear capacity

Shear capacity is determined in accordance with clause 4.2.3. Where the
applied shear force exceeds 60% of the capacity of the section, the high shear
condition applies to the bending moment capacity checks (see below).

Bending moment capacity

This is calculated to clause 4.2.5.2 (low shear at point) or clause 4.2.5.3 (high
shear at point) for plastic, compact and semi-compact sections.

Lateral torsional buckling checks (Composite beams: BS 5950)

BS 5950 : Part 3 : Section 3.1 : 1990 states that lateral torsional buckling checks
are not required when the angle between the direction of span of the beam
and that of the profile decking is greater than or equal to 45°.

When the angle is less than this, then lateral torsional buckling checks will
normally be required. Tekla Structural Designerallows you to switch off these
checks by specifying that the entire length between the supports is
continuously restrained against lateral torsional buckling.

If you use this option you must be able to provide justification that the beam is
adequately restrained against lateral torsional buckling during construction.

When the checks are required you can position restraints at any point within
the length of the main beam and can set the effective length of each sub-
beam (the portion of the beam between one restraint and the next) either by
giving factors to apply to the physical length of the beam, or by entering the
effective length that you want to use. Each sub-beam which is not defined as
being continuously restrained is checked in accordance with clause 4.3.8 and
Annex B of BS 5950-1:2000.

Deflection checks (Composite beams: BS 5950)

Tekla Structural Designer calculates relative deflections. (See: Deflection
checks)

The following deflections are calculated for the loads specified in the
construction stage load combination:

• the dead load deflections i.e. those due to the beam self weight, the Slab
Wet loads and any other included dead loads,

• the imposed load deflections i.e. those due to construction live loads,

• the total load deflection i.e. the sum of the previous items.

The loads are taken as acting on the steel beam alone.

The “Service Factor” (default 1.0), specified against each load case in the
construction combination is applied when calculating the above deflections.
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If requested by the user, the total load deflection is compared with either a
span-over limit or an absolute value The initial default limit is span/200.

NOTE Adjustment to deflections. If web openings have been defined, the
calculated deflections are adjusted accordingly. See: Web openings
(page 2022)

Composite stage design (Composite beams: BS 5950)
Tekla Structural Designer performs all checks for the composite stage
condition in accordance with BS 5950-3.1:1990+A1:2010 unless specifically
noted otherwise.

Equivalent steel section - Ultimate limit state (ULS) (Composite beams: BS 5950)
An equivalent steel section is determined for use in the composite stage
calculations by removing the root radii whilst maintaining the full area of the
section. This approach reduces the number of change points in the
calculations while maintaining optimum section properties.

Section classification (ULS) (Composite beams: BS 5950)

For section classification purposes the true section is used. Tekla Structural
Designer classifies the section in accordance with the requirements of BS
5950-1:2000 except where specifically modified by those of BS
5950-3.1:1990+A1:2010.

There are a small number of sections which fail to meet a classification of
compact at the composite stage. Although BS 5950-3.1:1990+A1:2010 covers
the design of such members they are not allowed in this release of Tekla
Structural Designer.

Member strength checks (ULS) (Composite beams: BS 5950)
Member strength checks are performed at the point of maximum moment,
the point of maximum shear, the position of application of each point load,
and at each side of a web opening as well as all other points of interest along
the beam.

Shear capacity (Vertical)

is determined in accordance with clause 4.2.3 of BS 5950-1:2000. Where the
applied shear force exceeds 50% of the capacity of the section, the high shear
condition applies to the bending moment capacity checks (see below).

Shear capacity (Longitudinal)

the longitudinal shear resistance of a unit length of the beam is calculated in
accordance with clause 5.6. You can set the position and attachment of the
decking and details of the reinforcement that you want to provide. Tekla
Structural Designer takes these into account during the calculations.
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The following assumptions are made:

• the applied longitudinal shear force is calculated at the centre-line of the
beam, and at the position of the lap (if known). If the position of the lap is
not known, then the default value of 0mm should be used (that is the lap is
at the centre-line of the beam) as this is the worst case scenario.

• the minimum concrete depth is assumed for calculating the area of
concrete when the profile decking and beam spans are parallel,

• the total concrete area is used when the profile decking and beam spans
are perpendicular,

• the overall depth of the slab is used for precast concrete slabs. that is the
topping is assumed to be structural and any voids or cores are ignored.

In the calculations of the longitudinal shear resistance on the beam centre-line
and at the lap, the areas used for the reinforcement are shown in the
following table.

Decking angle Reinforcement type Area used
perpendicular transverse that of the single bars

defined or for mesh the
area of the main wires[1]

other that of the single bars
defined or for mesh the
area of the main wires[1]

parallel transverse that of the single bars
defined or for mesh the
area of the main wires[1]

other single bars have no
contribution, for mesh
the area of the minor
wires[2]

[1]These are the bars that are referred to as longitudinal wires in BS 4483: 1998
Table 1
[2]These are the bars that are referred to as transverse wires in BS 4483: 1998
Table 1

If the decking spans at some intermediate angle (α) between these two
extremes then the program calculates:

• the longitudinal shear resistance as if the sheeting were perpendicular, v1,

• the longitudinal shear resistance as if the sheeting were parallel, v2,

• then the modified longitudinal shear resistance is calculated from these
using the relationship, v1sin2(α) + v2cos2(α).
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Moment capacity

for the low shear condition the plastic moment capacity is determined in
accordance with clause 4.4.2. For the high shear condition the approach given
in clause 5.3.4 is adopted.

The overall depth of the slab is used for precast concrete slabs. That is the
topping is assumed to be structural and any voids / cores are ignored.

In this calculation the steel section is idealized to one without a root radius so
that the position of the plastic neutral axis of the composite section can be
determined correctly as it moves from the flange into the web.

Shear connectors (ULS) (Composite beams: BS 5950)

Tekla Structural Designer checks shear connectors to clause 5.4.7. It calculates
the stud reduction factor based on the number of studs in a group.

Tekla Structural Designer always uses 2 * e (and not br) in the calculation of k
for perpendicular profiles, and always uses br for parallel cases.

For angled cases two values of k are calculated and summed in accordance
with clause 5.4.7.4. In this instance Tekla Structural Designer uses 2 * e for the
calculation of k1 and br for the calculation of k2.

WARNING Caution: The value of e (when used) can have a very significant
effect on the value of k. This can have a dramatic effect on the
number of studs required for a given beam size. Alternatively for
a fixed layout of studs this can have a significant effect on the
required beam size.

Optimize shear connection

Stud optimization is a useful facility since there is often some over
conservatism in a design due to the discrete changes in the size of the section.

If you choose the option to optimize the shear studs, then Tekla Structural
Designer will progressively reduce the number of studs either until the
minimum number of studs to resist the applied moment is found, until the
minimum allowable interaction ratio (for example 40% for beams with a span
less than 10 m) is reached or until the minimum spacing requirements are
reached. This results in partial shear connection.

The degree of shear connection is checked at the point of maximum bending
moment or the position of a point load if at that position the maximum
utilization ratio occurs.

NOTE During the selection process, in auto design mode point load positions
are taken to be “significant” (i.e. considered as positions at which the
maximum utilization could occur) if they provide more than 10% of
the total shear on the beam. For the final configuration and for check
mode all point load positions are checked.
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To determine if the degree of shear connection is acceptable Tekla Structural
Designer applies the following rules:

• If the degree of shear connection at the point of maximum moment is less
than the minimum permissible shear connection, then this generates a
FAIL status,

• If the point of maximum utilization ratio occurs at a point that is not the
maximum moment position and the degree of shear connection is less
than the minimum permissible shear connection, then this generates a
WARNING status,

• If the degree of shear connection at any other point load is less than the
minimum permissible shear connection, then this does not affect the
status in any way.

NOTE The percentage degree of shear connection is always calculated by the
program as a proportion of the maximum concrete force and not
simply Na/Np as in the code.

Section properties - serviceability limit state (SLS) (Composite beams: BS 5950)

BS 5950-3.1:1990+A1:2010 indicates that the Serviceability Limit State modular
ratio for all SLS calculations should be based upon an effective modular ratio
derived from the proportions of long term loading in the design combination
being considered.

Tekla Structural Designer therefore calculates the deflection for the beam
based on the properties as tabulated below.

Loadcase type Properties used
self-weight bare beam
Slab bare beam
Dead composite properties calculated using

the modular ratio for long term loads
Live composite properties calculated using

the effective modular ratio
appropriate to the long term load
percentage for each load. The
deflections for all loads in the
loadcase are calculated using the
principle of superposition.

Wind composite properties calculated using
the modular ratio for short term
loads

Total loads these are calculated from the
individual loadcase loads as detailed
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Loadcase type Properties used
above again using the principle of
superposition

Stress checks (SLS) (Composite beams: BS 5950)
Tekla Structural Designer calculates the worst stresses in the extreme fibres of
the steel and the concrete at serviceability limit state for each load taking into
account the proportion which is long term and that which is short term. These
stresses are then summed algebraically. Factors of 1.00 are used on each
loadcase in the design combination (you cannot amend these). The stress
checks assume that full interaction exists between the steel and the concrete
at serviceability state.

Deflection checks (SLS) (Composite beams: BS 5950)

Tekla Structural Designer calculates relative deflections. (See: Deflection
checks)

The composite stage deflections are calculated in one of two ways depending
upon the previous and expected future load history:

• the deflections due to all loads in the Slab Dry loadcase and the self-weight
of the beam are calculated based on the inertia of the steel beam alone
(these deflections will not be modified for the effects of partial interaction).

NOTE It is the Slab Dry deflection alone which is compared with the limit,
if any, specified for the Slab loadcase deflection. See: Web
openings (page 2022)

• the deflections for all loads in the other loadcases of the Design
Combination will be based on the inertia of the composite section allowing
for the proportions of the particular load that are long or short term (see
above). When necessary these will be modified to include the effects of
partial interaction in accordance with clause 6.1.4.

NOTE It is the deflection due to imposed loads alone (allowing for long
and short term effects) which is limited within the code. Tekla
Structural Designer also gives you the deflection for the Slab
loadcase which is useful for pre-cambering the beam. The beam
Self-weight, Dead and Total deflections are also given to allow you
to be sure that no component of the deflection is excessive.

NOTE Adjustment to deflections - If web openings have been defined, the
calculated deflections are adjusted accordingly.
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Web openings (Composite beams: BS 5950)

Circular openings as an equivalent rectangle

Each circular opening is replaced by equivalent rectangular opening, the
dimensions of this equivalent rectangle for use in all subsequent calculations
are:

do' = 0.9 * opening diameter

lo = 0.45 * opening diameter

Properties of tee sections

When web openings have been added, the properties of the tee sections
above and below each opening are calculated in accordance with Section 3.3.1
of SCI P355 (Ref. 10) and Appendix B of the joint CIRIA/SCI Publication P068
(Ref. 5). The bending moment resistance is calculated separately for each of
the four corners of each opening.

Design at construction stage

The following calculations are performed where required for web openings:

• Axial resistance of tee sections

• Classification of section at opening

• Vertical shear resistance

• Vierendeel bending resistance

• Web post horizontal shear resistance

• Web post bending resistance

• Web post buckling resistance

• Lateral torsional buckling

• Deflections

Design at composite stage

The following calculations are performed where required for web openings:

• Axial resistance of concrete flange

• Vertical shear resistance of the concrete flange

• Global bending action - axial load resistance

• Classification of section at opening

• Vertical shear resistance

• Moment transferred by local composite action

• Vierendeel bending resistance

• Web post horizontal shear resistance
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• Web post bending resistance

• Web post buckling resistance

• Deflections

Deflections

The deflection of a beam with web openings will be greater than that of the
same beam without openings. This is due to two effects,

• the reduction in the beam inertia at the positions of openings due to
primary bending of the beam,

• the local deformations at the openings due to Vierendeel effects. This has
two components - that due to shear deformation and that due to local
bending of the upper and lower tee sections at the opening.

The primary bending deflection is established by 'discretising' the member
and using a numerical integration technique based on 'Engineer's Bending
Theory' - M/I = E/R = σ/y. In this way the discrete elements that incorporate all
or part of an opening will contribute more to the total deflection.

The component of deflection due to the local deformations around the
opening is established using a similar process to that used for cellular beams
which is in turn based on the method for castellated beams given in the SCI
publication, “Design of castellated beams. For use with BS 5950 and BS 449".

The method works by applying a 'unit point load' at the position where the
deflection is required and using a 'virtual work technique to estimate the
deflection at that position.

For each opening, the deflection due to shear deformation, δs, and that due to
local bending, δbt, is calculated for the upper and lower tee sections at the
opening. These are summed for all openings and added to the result at the
desired position from the numerical integration of primary bending deflection.

Note that in the original source document on castellated sections, there are
two additional components to the deflection. These are due to bending and
shear deformation of the web post. For castellated beams and cellular beams
where the openings are very close together these effects are important and
can be significant. For normal beams the openings are likely to be placed a
reasonable distance apart. Thus in many cases these two effects will not be
significant. They are not calculated for such beams but in the event that the
openings are placed close together a warning is given.

Steel column design to BS 5950
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Design method (Columns: BS 5950)

Unless explicitly stated all calculations are in accordance with the relevant
sections of BS 5950-1: 2000. You may find the handbook and commentary to
the Code of Practice published by the Steel Construction Institute useful.

Ultimate limit state (strength) (Columns: BS 5950)

The checks relate to doubly symmetric prismatic sections i.e. rolled I- and H-
sections and to doubly symmetric hot-finished hollow sections i.e. SHS, RHS
and CHS. Other section types are not currently covered.

The strength checks relate to a particular point on the member and are carried
out at 5th points and “points of interest”, (i.e. positions such as maximum
moment, maximum axial etc.)

Classification (Columns: BS 5950)

General

The classification of the cross section is in accordance with BS 5950-1: 2000.

Steel columns can be classified as:

• Plastic Class = 1

• Compact Class = 2

• Semi-compact Class = 3

• Slender Class = 4

Class 4 sections are not allowed.

Sections with a Class 3 web can be taken as Class 2 sections (Effective Class 2)
providing the cross section is equilibrated to that described in Clause 3.5.6
where the section is given an “effective” plastic section modulus, Seff. This
approach is not adopted in the current version of Tekla Structural Designer.

All unacceptable classifications are either failed in check mode or rejected in
design mode.

Hollow sections

The classification rules for SHS and RHS relate to “hot-finished hollow sections”
only (“cold-formed hollow sections” are not included in this release).

WARNING important. The classification used to determine Mb is based on
the maximum axial compressive load in the relevant segment
length. Furthermore, the code clearly states that this
classification should (only) be used to determine the moment
capacity and lateral torsional buckling resistance to clause 4.2
and 4.3 for use in the interaction equations. Thus, when carrying
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out the strength checks, the program determines the
classification at the point at which strength is being checked.

Shear capacity (Columns: BS 5950)
The shear check is performed according to BS 5950-1: 2000 clause 4.2.3. for
the absolute value of shear force normal to the x-x axis and normal to the y-y
axis, Fvx and Fvy, at the point under consideration.

Shear buckling

When the web slenderness exceeds 70e shear buckling can occur in rolled
sections. There are very few standard rolled sections that breach this limit.
Tekla Structural Designerwill warn you if this limit is exceeded, but will not
carry out any shear buckling checks.

Moment capacity (Columns: BS 5950)
The moment capacity check is performed according to BS 5950-1: 2000 clause
4.2.5 for the moment about the x-x axis and about the y-y axis, Mx and My, at
the point under consideration. The moment capacity can be influenced by the
magnitude of the shear force (“low shear” and “high shear” conditions). The
maximum absolute shear to either side of a point of interest is used to
determine the moment capacity for that direction.

High shear condition about x-x axis

The treatment of high shear is axis dependent. In this release for CHS, if high
shear is present, the moment capacity about the x-x axis is not calculated, the
check is given a Beyond Scope status and an associated explanatory message.

High shear condition about y-y axis

For rolled sections in the current release, if high shear is present normal to the
y-y axis then the moment capacity about the y-y axis is not calculated, the
check is given a Beyond Scope status and an associated explanatory message.

For hollow sections, there is greater potential for the section to be used to
resist the principal moments in its minor axis. Of course for CHS and SHS
there is no major or minor axis and so preventing high shear arbitrarily on one
of the two principal axes does not make sense. Nevertheless, if high shear is
present normal to the y-y axis then in this release the moment capacity about
the y-y axis is not calculated, the check is given a Beyond Scope status and an
associated explanatory message.

Note

Not all cases of high shear in two directions combined with moments in two
directions along with axial load are considered thoroughly by BS 5950-1: 2000.
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The following approach is adopted by Tekla Structural Designer:

• if high shear is present in one axis or both axes and axial load is also
present, the cross-section capacity check is given a Beyond Scope status.
The message associated with this status is “High shear and axial load are
present, additional hand calculations are required for cross-section
capacity to Annex H.3”. Tekla Structural Designer does not perform any
calculations for this condition.

• if high shear and moment is present in both axes and there is no axial load
(“biaxial bending”) the cross-section capacity check is given a Beyond Scope
status and the associated message is, “High shear present normal to the y-
y axis, no calculations are performed for this condition.”

• if high shear is present normal to the y-y axis and there is no axial load, the
y-y moment check and the cross-section capacity check are each given
Beyond Scope statuses. The message associated with this condition is,
“High shear present normal to the y-y axis, no calculations are performed
for this condition.”

Axial capacity (Columns: BS 5950)

The axial capacity check is performed according to BS 5950-1: 2000 clause
4.6.1 using the gross area and irrespective of whether the axial force is tensile
or compressive. This check is for axial compression capacity and axial tension
capacity. Compression resistance is a buckling check and as such is considered
under Compression resistance.

Cross-section capacity (Columns: BS 5950)

The cross-section capacity check covers the interaction of axial load and
bending to clause 4.8.2 and 4.8.3.2 appropriate to the type (for example –
doubly symmetric) and classification of the section. Since the axial tension
capacity is not adjusted for the area of the net section then the formula in
clause 4.8.2.2 and 4.8.3.2 are the same and can be applied irrespective of
whether the axial load is compressive or tensile.

The Note in Moment capacity (page 2035)also applies here.

Ultimate limit state (buckling) (Columns: BS 5950)

Lateral torsional buckling resistance, Clause 4.3 (Columns: BS 5950)

For columns that are unrestrained over part or all of a span, a Lateral torsional
buckling (LTB) check is required either:

• in its own right, clause 4.3 check,

• as part of an Annex G check,
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• as part of a combined buckling check to clause 4.8.3.3.2 or 4.8.3.3.3, (See:
Member buckling resistance, Clause 4.8.3.3.2 (page 2039), and Member
buckling resistance, clause 4.8.3.3.3 (page 2039)).

This check is not carried out under the following circumstances:

• when bending exists about the minor axis only,

• when the section is a CHS or SHS,

• when the section is an RHS that satisfies the limits given in Table 15 of BS
5950-1: 2000.

For sections in which LTB cannot occur (the latter two cases above) the value
of Mb for use in the combined buckling check is taken as the full moment
capacity, Mcx, not reduced for high shear in accordance with clause 4.8.3.3.3
(c), equation 2 (See: Member buckling resistance, Clause 4.8.3.3.2 (page 2039)).

Destabilising loads are excluded from Tekla Structural Designer, this is justified
by the rarity of the necessity to apply such loads to a column. If such loads do
occur, then you can adjust the “normal” effective length to take this into
account although you can not achieve the code requirement to set mLT to 1.0.

Effective lengths

The value of effective length factor is entirely at your choice. The default value
is 1.0.

Lateral torsional buckling resistance, Annex G (Columns: BS 5950)

This check is applicable to I- and H-sections with equal or unequal[1] flanges.

The definition of this check is the out-of-plane buckling resistance of a
member or segment that has a laterally unrestrained compression flange and
the other flange has intermediate lateral restraints at intervals. It is used
normally to check the members in portal frames in which only major axis
moment and axial load exist. Although not stated explicitly in BS 5950-1: 2000,
it is taken that the lateral torsional buckling moment of resistance, Mb, from
the Annex G check can be used in the interaction equations of clause 4.8.3.3
(combined buckling).

Since this is not explicit within BS 5950-1: 2000 a slight conservatism is
introduced. In a straightforward Annex G check the axial load is combined with
major axis moment. In this case both the slenderness for lateral torsional
buckling and the slenderness for compression buckling are modified to allow
for the improvement provided by the tension flange restraints (λLT replaced by
λTB and λ replaced by λTC). When performing a combined buckling check in
accordance with 4.8.3.3 the improvement is taken into account in determining
the buckling resistance moment but not in determining the compression
resistance. If the incoming members truly only restrain the tension flange,
then you should switch off the minor axis strut restraint at these positions.

The original source research work for the codified approach in Annex G used
test specimens in which the tension flange was continuously restrained. When
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a segment is not continuously restrained but is restrained at reasonably
frequent intervals it can be clearly argued that the approach holds true. With
only one or two restraints present then this is less clear.BS 5950-1: 2000 is
clear that there should be “at least one intermediate lateral restraint” (See
Annex G.1.1). Nevertheless, you are ultimately responsible for accepting
the adequacy of this approach.

For this check Tekla Structural Designer sets mt to 1.0 and calculates nt. The
calculated value of nt is based on Mmax being taken as the maximum of M1 to
M5, and not the true maximum moment value where this occurs elsewhere in
the length. The effect of this approach is likely to be small. If at any of points 1
- 5, R >1 [2], then Tekla Structural Designer sets the status of the check to
Beyond Scope.

Reference restraint axis distance, a

The reference restraint axis distance is measured between some reference axis
on the restrained member - usually the centroid - to the axis of restraint -
usually the centroid of the restraining member. The measurement is shown
diagramatically in Figure G.1 of BS 5950-1: 2000.

Tekla Structural Designer does not attempt to determine this value
automatically, since such an approach is fraught with difficulty and requires
information from you which is only used for this check. Instead, by default,
Tekla Structural Designer uses half the depth of the restrained section, and
you can specify a value to be added to, or subtracted from, this at each
restraint point. You are responsible for specifying the appropriate values
for each restraint position. The default value of 0mm may be neither
correct nor safe.
[1]Unequal flanged sections are not currently included.
[2] Which could happen since R is based on Z and not S.

Compression resistance (Columns: BS 5950)

For most structures, all the members resisting axial compression need
checking to ensure adequate resistance to buckling about both the major- and
minor-axis. Since the axial force can vary throughout the member and the
buckling lengths in the two planes do not necessarily coincide, both are
checked. Because of the general nature of a column, it may not always be safe
to assume that the combined buckling check will always govern. Hence the
compression resistance check is performed independently from all other
strength and buckling checks.

Effective lengths

The value of effective length factor is entirely at your choice. The default value
is 1.0. Different values can apply in the major and minor axis.

The minimum theoretical value is 0.5 and the maximum infinity for columns in
rigid moment resisting (RMR) frames. Practical values for simple columns are
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in the range 0.7 to 2.0. Values less than 1.0 can be chosen for non-sway frames
or for sway frames in which the effects of sway are taken into account using
the amplified moments method. However, there is a caveat on the value of
effective length factor even when allowance is made for sway.

In particular for RMR frames, the principal moments due to frame action
preventing sway are in one plane of the frame. There will often be little or no
moment out-of-plane and so amplification of these moments has little effect.
Nevertheless the stability out-of-plane can still be compromised by the lack of
restraint due to sway sensitivity in that direction. In such cases a value of
greater then 1.0 (or substantially greater) may be required. Similarly, in simple
construction where only eccentricity moments exist, it is only the brace forces
that “attract” any amplification. Thus for the column themselves the reduced
restraining effect of a sway sensitive structure may require effective length
factors greater than 1.0 as given in Table 22 of BS 5950-1: 2000.

Member buckling resistance, Clause 4.8.3.3.2 (Columns: BS 5950)

This check is used for Class 1, 2 and 3 Plastic, Compact and Semi-compact
rolled I- and H-sections with equal flanges (Class 4 Slender sections and
Effective Class 2 sections are not included in this release).

Three formulae are provided in clause 4.8.3.3.2 (c) to cover the combined
effects of major and minor axis moment and axial force.These are used
irrespective of whether all three forces / moments exist. Clause 4.9 deals with
biaxial moment in the absence of axial force, clause 4.8.3.3.2 (c) can also be
used in such cases by setting the axial force to zero.

All three formulae in clause 4.8.3.3.2 (c) are checked; the second is calculated
twice – once for Face A and once for Face C.

Only one value of F is used, the worst anywhere in the length being checked. If
the axial load is tensile, then F is taken as zero.

Important Note

Clause 4.8.3.3.4 defines the various equivalent uniform moment factors. The
last three paragraphs deal with modifications to these depending upon the
method used to allow for the effects of sway. This requires that for sway
sensitive frames the uniform moment factors, mx, my and mxy, should be
applied to the non-sway moments only. In this release there is no mechanism
to separate the sway and non-sway moments, Tekla Structural Designer
adopts the only conservative approach and sets these “m” factors equal to 1.0
if the frame is sway sensitive (in either direction). This is doubly conservative
for sway-sensitive unbraced frames since it is likely that all the loads in a
design combination and not just the lateral loads will be amplified. In such a
case, both the sway and non-sway moments are increased by kamp and
neither are reduced by the above “m” factors. The calculation of mLT is
unaffected by this approach, and thus if the second equation of clause
4.8.3.3.2 (c) governs, then the results are not affected.
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Member buckling resistance, Clause 4.8.3.3.3 (Columns: BS 5950)

This check is used for Class 1, 2 and 3 Plastic, Compact and Semi-compact
hollow sections (Class 4 Slender sections and Effective Class 2 sections are not
included in this release).

Four formulae are provided in clause 4.8.3.3.3 (c) to cover the combined
effects of major and minor axis moment and axial force. These are used
irrespective of whether all three forces / moments exist. Clause 4.9 deals with
biaxial moment in the absence of axial force, clause 4.8.3.3.3 (c) can also be
used in such cases by setting the axial force to zero.

The second and third formulae are mutually exclusive – that is the second is
used for CHS, SHS and for RHS when the limits contained in Table 15 are not
exceeded. On the other hand the third formula is used for those RHS that
exceed the limits given in Table 15. Thus only three formulae are checked; the
first, second and fourth or the first, third and fourth. Either the second or third
(as appropriate) is calculated twice – once for Face C and once for Face A.

Only one value of F is used, the worst anywhere in the length being checked. If
the axial load is tensile, then F is taken as zero.

See also the Important Note at the end of Member buckling resistance,
Clause 4.8.3.3.2 (page 2039).

Serviceability limit state (Columns: BS 5950)

The column is assessed for sway and the following values are reported for
each stack:

• Sway X (mm) and λcritx

• Sway Y (mm) and λcrity

• Sway X-Y (mm)

Depending on the reported λcrit the column is classified as Sway or Non sway
accordingly.

NOTE A sway assessment is only performed for the column if the Lambda
Crit Check box is checked on the Column Properties dialog.

If very short columns exist in the building model these can distort the
overall sway classification for the building. For this reason you may
apply engineering judgement to uncheck the Lambda Crit Check box
for those columns for which a sway assessment would be
inappropriate

Steel brace design to BS 5950
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Design method

Unless explicitly stated all brace calculations are in accordance with the
relevant sections of BS 5950-1:2000 (Ref. 2).

A basic knowledge of the design methods for braces in accordance with the
design code is assumed.

Classification

No classification is required for braces in tension.

Braces in compression are classified according to Clause 3.5 as either: Class 1,
Class 2, Class 3 or Class 4.

Class 4 sections are not allowed.

Hollow sections

The classification rules for SHS and RHS relate to “hot-finished hollow sections”
only (“cold-formed hollow sections” are not included in this release).

Axial Tension

An axial tension capacity check is performed according to clause 4.6.

Axial compression

An axial compression capacity check is performed according clause 4.7.

Compression buckling

If axial compression exists, the member is also assessed according to clause
4.7 with all relevant sub-clauses.

The default effective length in each axis is 1.0L.

Steel single, double angle and tee section design to BS 5950

Design method (Angles and tees: BS 5950)

The design method adopted is dictated by the member characteristic type:

• “Beam”, “Truss member top” or “Truss member bottom” characteristic:

• Member is designed for axial tension, compression, shear, bending and
combined forces - consistent with the method detailed in Steel beam
design to BS 5950 (page 2014)

• “Brace”, “Truss internal” or “Truss member side” characteristic:
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• Member is designed for axial tension, compression and compression
buckling only - consistent with the method detailed in Steel brace
design to BS 5950

NOTE Additional Angle and tee limitations (page 2042) have to be considered
when designing these sections to the above design methods.

Angle and tee limitations (BS 5950)

In the current version when designing tees, single, and double angles to BS
5950, the following checks remain beyond scope:

 Tee Angle Double Angle
Classification ok ok ok
Axial tension ok ok ok
Axial compression ok ok ok
Shear ok ok ok
Bending ok ok ok
Combined
strength

ok ok ok

LTB ok ok Beyond scope
Combined
buckling

ok ok Beyond scope

Deflection ok ok ok

In addition, the following limitations apply:

• All sections are assumed to be effectively loaded through the shear centre
such that no additional torsion moments are developed. In addition no
direct allowance is made for 'destabilizing loads'.

• Design excludes bending of the outstand leg of double angles loaded
eccentrically e.g. supporting masonry.

• Conditions of restraint can be defined as top and bottom flange for lateral
torsional buckling. It is upon these that the buckling checks are based. For
the current release intermediate LTB restraints are omitted (i.e. only fully
restrained for LTB, or unrestrained).

• Double angles and tee sections subject to moment with high shear are
beyond scope.

Section axes (Angles and tees: BS 5950)

For all sections:

• x-x is the axis parallel to the flanges (major axis)
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• y-y is the axis perpendicular to the flanges (minor axis)

• for Single angles and Double angles

• y-y parallel to long side (leg) - single angles

• y-y parallel to long side (leg) - double angles with long leg back to back

• y-y parallel to short side (leg) - double angles with short leg back to back

• u-u is the major principal axis for single angles

• v-v is the minor principal axis for single angles

Single angles - Section axes

Design procedures (Angles and tees: BS 5950)

This section includes key notes and assumptions made for the British
Standard design of tees and angle sections.

Classification checks

For axial compression and bending both the web and flange (Leg 1 and Leg 2)
are classified as Class 1, Class 2, Class 3 or Class 4 and the worst of the two is
the resultant classification for that cross section.

The rules from Table 11 and 12 of BS 5950-1:2000 apply for the classification
of these sections.

NOTE Class 4 section classification is only allowed for tees, double angles
and single angles.

Axial tension check

Section 4.6 of BS 5950 is used for this design check.
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Axial compression check

Section 4.6 of BS 5950 is used for this design check.

Shear check

Section 4.2.3 of BS 5950 is used for this design check.

Moment check

Section 4.2.5 of BS 5950 is used for this design check.

NOTE Tees, single angles and double angles are designed as Class 4.

Moment capacity for Class 4 slender sections:

Class 4 sections are designed as Class 3 effective sections.

Hence, additional moments are induced in the member due to the shift of the
centroid of the effective cross-section compared to that of the gross section
when under axial compression only.

Thus:

ΔMEd,x = ex × Fc

ΔMEd,y = ey × Fc

Where:

Fc is the max compressive force in the span.

For tees and double angles ex = 0. Hence, total minor design moment = minor
design moment.

Where:
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ex and ey = the shift of the centroid of the effective area Aeff relative to the
centre of gravity of the gross cross section

ex = abs(cxnew – cx)

ey = abs(cynew – cy)

So finally, a total moment is obtained for which the moment design check is
performed:

Mtotal x = Abs(MEd,x) + Abs(ΔMEd,x)

Mtotal y = Abs(MEd,y) + Abs(ΔMEd,y)

Single angles - asymmetric sections:

Single angles with continuous lateral – torsional restraint along the length
are permitted to be designed on the basis of geometric axis (x, y) bending.

Single angles without continuous lateral – torsional restraint along the
length are designed using the provision for principal axis (u, v) bending since
we know that the principal axes do not coincide with the geometric ones.

ΔMu = ΔMx × cosϑ + ΔMy × sinϑ

ΔMv = -ΔMx × sinϑ + ΔMy × cosϑ

Note that when principal axis design is required for single angles and the
classification is Class 4, all moments are resolved into the principal axes (total
moment in the principal axes u-u and v-v).

NOTE Tees, single angles and double angles subject to moment with high
shear are beyond scope.

Combined bending and axial check

Section 4.8.3 of BS 5950 is used for this design check.

For Class 3:

Abs (Fc / AgPy) + abs (Mx,Ed /Mcx) + abs (My,Ed/Wel,min,y) ≤ 1.0

For Class 4:

Abs (Fc/Aeffpy) + (abs (Mx,Ed) + abs (ΔMx,Ed)) / Mcx + abs (My,Ed) + abs (ΔMy,Ed)) /
Mcy ≤ 1.0

Note that total moments are used when the section classification is Class 4.

Lateral torsional buckling check

Section 4.3 of BS 5950 is used for this design check.

NOTE This check is beyond scope for double angles.
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In the case of a beam with continuous lateral torsional restraint along its
length this check is not performed. The lateral torsional resistance is
considered adequate.

For beams that are unrestrained, a Lateral torsional buckling (LTB) check is
required, either:

• In its own right check for LTB, clause 4.3, and B2.8 for tee sections and
B.2.9 for angle sections in BS 5050-1: 2000.

• As part of combined buckling, clause 4.8 “Members with combined
moment and axial force”, 4.8.3.3, for single Angles I3 and I4 sections

This check is not performed when bending exists about the minor axis only

NOTE Conditions of restraint can be defined as top and bottom flange for
lateral torsional buckling. It is upon these that the buckling checks are
based. All intermediate LTB restraints for tees and single angles are
ignored.

Combined buckling check

NOTE This check is beyond scope for double angles.

Single angles:

Clause I.4 - For beam with continuous lateral torsional restraint or for equal
single angle sections with b/t ≤ 15ε a combined buckling check is performed
according to clause I.4.3 - the simplified method.

For any other case clause 4.8.3.3.1 is used with the moments being resolved
into the principal axes u-u and v-v. Two formula are provided in clause
4.8.3.3.1, both are checked

Tees:

Clause 4.8.3.3.1 is used. Two formula are provided in clause 4.8.3.3.1, both are
checked.

• If the axial load is tensile, then F is taken as zero

• Only one value of F is used, the worst anywhere in the length being
checked

• Class 4 slender sections are allowed

Deflection of single angles

If a single angle is continuously restrained the major geometric moment and
major geometric section properties are used in the general equation
governing the beam deflection.
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Single angle deflections (continuously restrained, unrestrained)

However, because single angle geometric axes are not coincident with the
principal axes; a different procedure is required if the angle is not
continuously restrained, the procedure being as follows:

1. External loads are transposed from the geometric axes to the principal
axes.

2. The deflection equations are used to calculate deflections in the principal
axes.

3. These principal axis deflections are then transposed to geometric axes
again.

References (BS 5950)

1. British Standards Institution. BS 5950-3.1:1990+A1:2010: Structural use
of steelwork in building . Design in composite construction. Code of
practice for design of simple and continuous composite beams. BSI 2010.

2. British Standards Institution. BS 5950 : Structural use of steelwork in
building; Part 1. Code of practice for design in simple and continuous
construction: hot rolled sections. BSI 2000.

3. The Steel Construction Institute. Publication 078. Commentary on BS
5950 : Part 3 : Section 3.1 : 1990. SCI 1989.

4. The Steel Construction Institute. Publication 055. Design of Composite
Slabs and Beams with Steel Decking. SCI 1989.

5. The Steel Construction Institute. Publication 068. Design for openings in
the webs of composite beams. SCI 1987.

6. The Steel Construction Institute. Publication 076. Design Guide on the
Vibration of Floors. SCI 1989.

7. The Steel Construction Institute. Publication 100. Design of Composite
and Non-Composite Cellular Beams. SCI 1990.
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8. The Steel Construction Institute. Joints in Steel Construction. Simple
Connections. SCI/BCSA 2002. Publication P212.

9. The Steel Construction Institute. Joints in Steel Construction. Moment
Connections. SCI/BCSA 1995. Publication P207.

10. The Steel Construction Institute. Publication P355. Design of Composite
Beams with Large Web Openings. SCI 2011.

14.4 Australian Standards
• Loading to AS/NZS 1170.0 and AS 1170.1 (Australian Standards) (page 2048)

• Steel design to AS 4100 (page 2052)

Loading to AS/NZS 1170.0 and AS 1170.1 (Australian
Standards)
This handbook provides a general overview of how loadcases and
combinations are created in Tekla Structural Designer when an Australian
Standards (AS) head code is applied. The Combination Generator for AS
loading is also described.

Load cases (Australian Standards)

Loadcases types (Australian Standards)

The following load case types can be created:

Loadcase
Type

Calculated
Automaticall

y

Include in
the

Combination
Generator

Imposed
Load

Reductions

Pattern Load

self weight
(beams,
columns and
walls)

yes/no yes/no N/A N/A

slab wet yes/no N/A N/A N/A
slab dry yes/no yes/no N/A N/A
dead N/A yes/no N/A N/A
imposed N/A yes/no yes/no yes/no
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Loadcase
Type

Calculated
Automaticall

y

Include in
the

Combination
Generator

Imposed
Load

Reductions

Pattern Load

roof imposed N/A yes/no N/A N/A
wind N/A yes/no N/A N/A
snow N/A yes/no N/A N/A
snow drift N/A yes/no N/A N/A
temperature N/A N/A N/A N/A
settlement N/A N/A N/A N/A

As shown above, self weight loads can all be determined automatically.
However, other gravity load cases have to be applied manually as you build
the structure.

Self weight (Australian Standards)

Self weight - excluding slabs loadcase

Tekla Structural Designer automatically calculates the self weight of the
structural beams/columns for you. The Self weight - excluding slabs loadcase
is pre-defined for this purpose. Its loadcase type is fixed as “Selfweight”. It
cannot be edited and by default it is added to each new load combination.

Self weight of concrete slabs

Tekla Structural Designer expects the wet and dry weight of concrete slab to
be defined in separate loadcases. This is required to ensure that members are
designed for the correct loads at construction stage and post construction
stage.

The Slab self weight loadcase is pre-defined for the dry weight of concrete
post construction stage, its loadcase type is fixed as “Slab Dry”.

There is no pre-defined loadcase for the wet weight of concrete slab at
construction stage, but if you require it for the design of any composite beams
in the model the loadcase type should be set to “Slab Wet”.

Tekla Structural Designercan automatically calculate the above weights for you
taking into account the slab thickness, the shape of the deck profile and
wet/dry concrete densities. It does not explicitly take account of the weight of
any reinforcement but will include the weight of decking. Simply click the Calc
Automatically check box when you create each loadcase. When calculated in
this way you can’t add extra loads of your own into the loadcase.

If you normally make an allowance for ponding in your slab weight
calculations, Tekla Structural Designer can also do this for you. After selecting
the composite slabs, you are able to review the slab item properties - you will
find two ways to add an allowance for ponding (under the slab parameters
heading). These are:
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• as a value, by specifying the average increased thickness of slab

• or, as a percentage of total volume.

Using either of these methods the additional load is added as a uniform load
over the whole area of slab.

Imposed and roof imposed loads (Australian Standards)

Imposed load reductions

Reductions can be applied to imposed loads to take account of the
unlikelihood of the whole building being loaded with its full design imposed
load. Reductions can not however, be applied to roof imposed loads.

Imposed loads are only automatically reduced on:

• Columns of any material

• Concrete walls, mid-pier or meshed

Tekla Structural Designer does not automatically apply imposed load
reductions to floors. For steel beams, concrete beams, slabs and mats it is
however possible to define the level of imposed load reduction manually via
the beam/slab item properties.

Wind loads (Australian Standards)

The AS 1170.2 Wind wizard...

NOTE The Wind Wizard is not included in this release.

Simple wind loading

Simple wind loads can be applied via element or structure loads.

Combinations (Australian Standards)

Once your load cases have been generated as required, you then combine
them into load combinations; these can either be created manually, by clicking
Add... - or with the assistance of the Combinations Generator (page 2051), by
clicking Generate...

Manually defined combinations (Austalian Standards)

As you build up combinations manually, the combination factors are
automatically adjusted as load cases are added and removed from the
combination.

Notional horizontal forces (NHFs) (Australian Standards)
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NHF’s are automatically derived from the loadcases within the current
combination, their magnitude being calculated as 0.2% of the factored vertical
load that passes through any beam/column intersection in the structure.

NOTE The values of the NHFs may vary for each load combination.

They are applied to the structure in the building directions 1 and 2 as follows:

• NHF Dir1+

• NHF Dir1-

• NHF Dir2+

• NHF Dir2-

The net result is that any combination is able to have up to 2 Notional Loads
applied within it - one from Dir1 (+ or -) and one from Dir2 (+ or -). Note
however, that Dir1+ can not be added with Dir1- (and similarly Dir2+ can not
be added with Dir2-).

Combination generator (Australian Standards)
Accessed via the Generate... command, this automatically sets up
combinations for both strength and serviceability.

Combination generator - Combinations

The first page of the generator lists the combinations applicable (with
appropriate strength factors).

The following basic load combinations are created:

• 1.35 (Permanent)

• 1.2 (Permanent) + 1.5 (Imposed)

• 1.2 (Permanent) + 1.5 (ΨI * Long-term Imposed)

• 1.2 (Permanent) + 1.0 (Wind) + 1.0 (ΨC * Imposed)

• 0.9 (Permanent) + 1.0 (Wind)

NOTE Temperature and settlement load case types are not included in the
Generate... command - these need to be added manually.

The combination names are generated automatically.

Combination generator - Service

This page indicates which combinations are to be checked for serviceability
and the factors applied.

The following basic load combinations are created:

• 1.0 (Permanent)

• 1.0 (ΨS * Imposed)
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• 1.0 (ΨI * Imposed)

• 1.0 (Wind)

Combination generator - NHF

The last page is used to set up the notional horizontal forces. You can specify
NHF’s and factors in each of four directions. For each direction selected, a
separate NHF combination will be generated.

Any combination with wind in is automatically greyed.

Click Finish to see the list of generated combinations.

Combination classes (Australian Standards)
Having created your combinations you classify them as either Gravity
combinations or Lateral combinations, and also (where applicable) indicate
whether they are to be checked for strength or service conditions, or both.

NOTE If generated via the Combinations Generator they are classified for
you automatically.

You also have the option to make any of the combinations inactive.

Steel design to AS 4100

Tekla Structural Designer designs steel members and composite members to a
range of international codes. This reference guide specifically describes the
design methods applied when the steel design and composite design
resistance codes are set as AS 4100 and AS 2327.1 respectively.

Unless explicitly noted otherwise, all clauses, figures and tables referred to are
from AS 4100-1998/Amdt 1-2012 (Ref. 1); apart from the Composite Beam
section, within which references are to AS 2327.1-2003 (Ref. 2) unless
otherwise stated.

Basic principles (AS 4100)

Deflection checks (AS 4100)

Relative and Absolute Deflections

Tekla Structural Designer calculates both relative and absolute deflections.
Relative deflections measure the internal displacement occurring within the
length of the member and take no account of the support settlements or
rotations, whereas absolute deflections are concerned with deflection of the
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structure as a whole. The absolute deflections are the ones displayed in the
structure deflection graphics. The difference between relative and absolute
deflections is illustrated in the cantilever beam example below.

Relative deflections are given in the member analysis results graphics and are
the ones used in the member design.

Steel beam design to AS 4100

Design method (Beams: AS 4100)

Unless explicitly stated all calculations are in accordance with the relevant
sections of AS 4100 (Ref. 1). You may find the Commentary (Ref. 3) to the
Standard published by Standards Australia International useful.

Steel beam limitations and assumptions (Beams: AS 4100)

The following limitations apply:

• continuous beams (more than one span) must be co-linear in the plane of
the web within a small tolerance (sloping in elevation is allowed),

• only doubly symmetric prismatic sections (that is rolled or plated I- and H-
sections) and channel sections are fully designed,

The following assumptions apply:

• All supports are considered to provide torsional restraint, that is lateral
restraint to both flanges. This cannot be changed. It is assumed that a
beam that is continuous through the web of a supporting beam or column
together with its substantial moment resisting end plate connections is
able to provide such restraint.

• If, at the support, the beam oversails the supporting beam or column then
the detail is assumed to be such that the bottom flange of the beam is well
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connected to the supporting member and, as a minimum, has torsional
stiffeners provided at the support.

• In the Tekla Structural Designer model, when not at supports, coincident
restraints to both flanges are assumed when one or more members frame
into the web of the beam at a particular position and the cardinal point of
the center-line model of the beam lies in the web. Otherwise, only a top
flange or bottom flange restraint is assumed. Should you judge the actual
restraint provided by the in-coming members to be different from to what
has been assumed, you have the flexibility to edit the restraints as
required.

• Intermediate lateral restraints to the top or bottom flange are assumed to
be capable of transferring the restraining forces back to an appropriate
system of bracing or suitably rigid part of the structure.

• It is assumed that you will make a rational and “correct” choice for the
effective lengths between restraints for both LTB and compression
buckling. The default value for the effective length factor of 1.0 may be
neither correct nor safe.

Ultimate limit state (strength) (Beams: AS 4100)

The checks relate to doubly symmetric prismatic sections (that is rolled and
welded I- and H-sections), to singly symmetric sections i.e. Channel sections,
and to doubly symmetric hollow sections i.e. CHS, RHS and SHS. Other section
types are not currently covered.

The strength checks relate to a particular point on the member and are carried
out at regular intervals along the member and at 'points of interest'.

Classification (Beams: AS 4100)

General

The classification of the cross section is in accordance with AS 4100. Beams
can be classified for flexure about either principal axis as:

• Compact

• Non-compact

• Slender

Slender sections about either axis will not be designed in Tekla Structural
Designer.

All unacceptable classifications are either failed in check mode or rejected in
design mode.

Shear capacity (Beams: AS 4100)

The shear check is performed according to AS 4100 Clause 5.11.
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For rolled and welded I- and H-sections, and for Channel sections, an
approximately uniform shear stress distribution is assumed when calculating
major axis shear capacity (to Clause 5.11.2). For these same sections a non-
uniform shear stress distribution is assumed when calculating minor axis
shear capacity (to Clause 5.11.3), with a shear stress ratio f*vm / f*va = 1.5

For hollow sections a non-uniform shear stress distribution is assumed when
calculating both major and minor axis shear capacity (to Clause 5.11.3). For a
CHS section the nominal shear yield capacity is taken per Clause 5.11.4, while
RHS and SHS sections assume a shear stress ratio f*vm / f*va = 3 * (2 * b + d) /
[2 * (3 * b + d)] for major axis shear capacity and f*vm / f*va = 3 * (2 * d + b) / [2
* (3 * d + b)] for minor axis shear capacity.

Shear buckling

For rolled and welded I- and H-sections, and for Channel sections, about the
major axis, and also for RHS and SHS sections about both axes, when the
shear panel depth to thickness ratio exceeds 82/√(fy/250) then the shear
buckling capacity will be calculated per Clause 5.11.5.1 assuming an
unstiffened shear panel.

Note that for rolled and welded I- and H-sections, and for channel sections, fy
will be taken as the yield strength of the web based on tw.

Moment capacity (Section) (Beams: AS 4100)

The (section) moment capacity check is performed according to AS 4100 clause
5.1 for the moment about the x-x axis (Mx) and about the y-y axis (My), at the
point under consideration.

For (member) moment capacity refer to the section Lateral torsional buckling
resistance (Member moment capacity).

Note that for all section types, the effective section modulus about the major
axis (Zex) will be based on the minimum slenderness ratio considering both
flange and web. Internally Tekla Structural Designer will calculate the
following:

• flange slenderness ratio, zf = (λey - λef) / ( λeyf - λepf)

• web slenderness ratio, zw = (λeyw - λew) / ( λeyw - λepw)

For sections which have flexure major class either Compact or Non-compact,
the effective section modulus about the major axis (Zex) will then be
calculated by:

• Zex = Zx + [MIN(zf, zw, 1.0) * (Zc - Zx)] where Zc = MIN(Sx, 1.5 * Zx)

Note that for Channel sections under minor axis bending:

• if there is single curvature with the flange tips in compression then Zey will
be based on ZeyR
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• if there is single curvature with the web in compression then Zey will be
based on ZeyL

• if there is double curvature then Zey will be based on the minimum of ZeyR
and ZeyL

Combined bending & shear capacity (Section) (Beams: AS 4100)

The combined bending & shear capacity check is performed according to AS
4100 clause 5.12.3, assuming bending is resisted by the whole of the cross-
section, for the coincident major shear and moment about the x-x axis (Mx)
and minor shear and moment about the y-y axis (My), at the point under
consideration.

Note that if the (section) moment capacity is found to be less than the design
moment then the combined bending & shear check will automatically be set as
Fail.

Axial capacity (Section) (Beams: AS 4100)

The (section) axial capacity check is performed according to AS 4100 clause 6.1
for axial compression, or clause 7.1 for axial tension, using the gross cross-
section area for An in both cases.

Note that member (axial compression) capacity is a buckling check and as such
is considered under the heading Compression buckling

Ultimate limit state (buckling) (Beams: AS 4100)

Lateral torsional buckling resistance (Member moment capacity) (Beams: AS 4100)

For beams with major axis bending, a Lateral torsional buckling (LTB) check is
required, except in the following circumstances:

• when the segment critical flange is continuously restrained for LTB, or

• when bending exists about the minor axis only, or

• when the section is a CHS, or

• when the segment length satisfies the relevant limit given in clause 5.3.2.4
of AS 4100

In the latter case, when calculating the limiting LTB length, the ratio βm will be
taken as -0.8 if the segment has major axis bending induced by transverse
load within its length, and the ratio of end moments otherwise.

The LTB resistance (member moment capacity) check is performed according
to AS 4100 clause 5.6

Note that the moment modification factor αm will be calculated from the
equation given in AS 4100 clause 5.6.1.1 (a) (iii) except for cantilevers, where
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αm will be 0.25 if the free end moment is greater than the ignore forces major
moment, and 1.0 otherwise.

The twist restraint factor kt will be determined by consideration of the LTB
cross-section restraints at either end of the segment, per Table 5.6.3(1) of AS
4100

The load height factor kl will default to 1.4 for a non-cantilever and 2.0 for a
cantilever.

The lateral rotation factor kr will default to 1.0.

Compression buckling resistance (Member capacity under axial compression) (Beams: AS
4100)

For most structures, all the members resisting axial compression need
checking to ensure adequate resistance to buckling about both the major and
minor axis. Since the axial force can vary throughout the member and the
strut buckling lengths in the two planes do not necessarily coincide, both axes
are checked. Because of the general nature of a beam-column, it may not
always be safe to assume that the combined actions check will always govern.
Hence the compression resistance check is performed independently from the
other strength and buckling checks.

The compression buckling resistance (member capacity under axial
compression) check is performed according to AS 4100 clause 6.3

The default value of effective length factor is 1.0. Different values can apply in
the major and minor axis. Beams are less affected by sway than columns but
the effectiveness of the incoming members to restrain the beam in both
position and direction is generally less than for columns. Hence, it is less likely
that effective length factors greater than 1.0 will be required but equally
factors less than 1.0 may not easily be justified. Nevertheless, it is your
responsibility to adjust the value from 1.0 and to justify such a change.

Combined actions resistance (Beams: AS 4100)

NOTE Important Note. Clause 8.2 of AS 4100 defines the design bending
moments to be used in the combined actions checks as either
amplified moments from a first order linear elastic analysis or the
moments resulting directly from a second order elastic analysis. Tekla
Structural Designer will not provide amplified moments from a first
order linear elastic analysis and you are expected to switch to second
order analysis to complete the design for combined actions.

Combined actions resistance - Section capacity (Beams: AS 4100)
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The combined actions section capacity check is performed according to AS
4100 clause 8.3

The higher tier equations will be used automatically if the conditions for their
use are met.

Note that if the design axial force exceeds the design axial section capacity
then the check will automatically be set as Fail.

In the section capacity check, the design forces are those which are coincident
at any one point along the member.

Combined actions resistance - Member capacity (Beams: AS 4100)

The combined actions member capacity check is performed according to AS
4100 clause 8.4

The higher tier equations will be used automatically if the conditions for their
use are met.

In the higher tier equation for Mi, the ratio βm will be based on the relevant
strut length; if the strut length has bending induced by transverse load within
its length then βm will be taken as -1.0, and the ratio of end moments
otherwise.

In the higher tier equation for Mox, the ratio βm will be based on the LTB
segment length, and taken as the ratio of end moments.

Note that if the design axial force exceeds the design axial member capacity
then the check will automatically be set as Fail.

In the member capacity check, the design forces are the maxima in the design
length being considered, where the design lengths are based on the major and
minor strut lengths within a loop of LTB lengths.

Therefore, since any one design length will comprise both major and minor
strut lengths, the design axial force for each design length will be taken as the
maximum axial compression or axial tension force from the major and minor
strut lengths considered together.

Since both axial compression and axial tension are to be considered, but make
use of different equations, then in cases where both axial forces exist within a
design length the compression equations and tension equations will both be
evaluated and the worst case of the two will be reported.

Note that in bi-axial bending cases, zero axial force will be treated as
compression.

Web openings (Beams: AS 4100)
The checks for beams with web openings are not included in this release.
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Serviceability limit state (Beams: AS 4100)
Beams are assessed for deflection. Only the total load deflection is active by
default, with a span/over value assigned of 250 per Table B1 of AS 4100.

Composite beam design to AS 2327.1
The design of composite beams is not included in this release.

Steel column design to AS 4100

Design method (Columns: AS 4100)

Unless explicitly stated all calculations are in accordance with the relevant
sections of AS 4100 (Ref. 1). You may find the Commentary (Ref. 3) to the
Standard published by Standards Australia International useful.

Ultimate limit state (strength) (Columns: AS 4100)

The checks relate to doubly symmetric prismatic sections (that is rolled and
welded I- and H-sections), to singly symmetric sections i.e. Channel sections,
and to doubly symmetric hollow sections i.e. CHS, RHS and SHS. Other section
types are not currently covered. The strength checks relate to a particular
point on the member and are carried out at regular intervals along the
member and at 'points of interest'.

Hollow sections

The checks for CHS, RHS and SHS relate to “hot-finished hollow sections” only -
“cold-formed hollow sections” are not included in this release.

Classification (Columns: AS 4100)

The flexural classification of the cross section is in accordance with AS 4100
Columns can be classified for flexure about either principal axis as:

• Compact

• Non-compact

• Slender

Slender sections about either axis will not be designed in Tekla Structural
Designer.

All unacceptable classifications are either failed in check mode or rejected in
design mode.
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Shear capacity (Columns: AS 4100)

The shear check is performed according to AS 4100 clause 5.11.

For rolled and welded I- and H-sections, and for channel sections, an
approximately uniform shear stress distribution is assumed when calculating
major axis shear capacity (to clause 5.11.2). For these same sections a non-
uniform shear stress distribution is assumed when calculating minor axis
shear capacity (to clause 5.11.3), with a shear stress ratio f*vm / f*va = 1.5

For hollow sections a non-uniform shear stress distribution is assumed when
calculating both major and minor axis shear capacity (to clause 5.11.3). For a
CHS section the nominal shear yield capacity is taken per clause 5.11.4, while
RHS and SHS sections assume a shear stress ratio f*vm / f*va = 3 * (2 * b + d) /
[2 * (3 * b + d)] for major axis shear capacity and f*vm / f*va = 3 * (2 * d + b) / [2
* (3 * d + b)] for minor axis shear capacity.

Shear buckling

For rolled and welded I- and H-sections, and for channel sections, about the
major axis, and also for RHS and SHS sections about both axes, when the
shear panel depth to thickness ratio exceeds 82/√(fy/250) then the shear
buckling capacity will be calculated per clause 5.11.5.1 assuming an
unstiffened shear panel.

Note that for rolled and welded I- and H-sections, and for channel sections, fy
will be taken as the yield strength of the web based on tw.

Moment capacity (section) (Columns: AS 4100)

The (section) moment capacity check is performed according to AS 4100 clause
5.1 for the moment about the x-x axis (Mx) and about the y-y axis (My), at the
point under consideration.

For (member) moment capacity refer to the section Lateral torsional buckling
resistance (Member moment capacity).

Note that for all section types, the effective section modulus about the major
axis (Zex) will be based on the minimum slenderness ratio considering both
flange and web. Internally Tekla Structural Designer will calculate the
following:

• flange slenderness ratio, zf = (λey - λef) / ( λeyf - λepf)

• web slenderness ratio, zw = (λeyw - λew) / ( λeyw - λepw)

For sections which have flexure major class either Compact or Non-compact,
the effective section modulus about the major axis (Zex) will then be calculated
by:

• Zex = Zx + [MIN(zf, zw, 1.0) * (Zc - Zx)] where Zc = MIN(Sx, 1.5 * Zx)
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Note that for Channel sections under minor axis bending:

• if there is single curvature with the flange tips in compression then Zey will
be based on ZeyR

• if there is single curvature with the web in compression then Zey will be
based on ZeyL

• if there is double curvature then Zey will be based on the minimum of ZeyR
and ZeyL

Eccentricity Moments

Eccentricity moment will be added algebraically to the coincident real moment
(at top or bottom of column stack) only if the resulting 'combined' moment
has a larger absolute magnitude than the absolute real moment alone.

The resulting 'combined' design moment (major and/or minor) will be that
used in moment capacity, combined bending & shear, LTB, and combined
actions checks.

Combined bending and shear capacity (section) (Columns: AS 4100)

The combined bending and shear capacity check is performed according to AS
4100 clause 5.12.3, assuming bending is resisted by the whole of the cross-
section, for the coincident major shear and moment about the x-x axis (Mx)
and minor shear and moment about the y-y axis (My), at the point under
consideration. The design moments may include eccentricity moments - see
Moment capacity (section): Eccentricity Moments.

Note that if the (section) moment capacity is found to be less than the design
moment then the combined bending and shear check will automatically be set
as Fail.

Axial capacity (section) (Columns: AS 4100)

The (section) axial capacity check is performed according to AS 4100 clause 6.1
for axial compression, or Clause 7.1 for axial tension, using the gross cross-
section area for An in both cases.

Note that member (axial compression) capacity is a buckling check and as such
is considered under the heading Compression buckling resistance (Member
capacity under axial compression).

Ultimate limit state (buckling) (Columns: AS 4100)

Lateral torsional buckling resistance (Member moment capacity) (Columns: AS 4100)
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For beams with major axis bending, a Lateral Torsional Buckling (LTB) check is
required, except in the following circumstances:

• when the segment critical flange is continuously restrained for LTB, or

• when bending exists about the minor axis only, or

• when the section is a CHS, or

• when the segment length satisfies the relevant limit given in clause 5.3.2.4
of AS 4100

In the latter case, when calculating the limiting LTB length, the ratio βm will be
taken as -0.8 if the segment has major axis bending induced by transverse
load within its length, and the ratio of end moments otherwise.

The LTB resistance (member moment capacity) check is performed according
to AS 4100 clause 5.6

Note that the moment modification factor αm will be calculated from the
equation given in AS 4100 clause 5.6.1.1 (a) (iii) except for cantilevers, where
αm will be 0.25 if the free end moment is greater than the ignore forces major
moment, and 1.0 otherwise.

The design moment may include eccentricity moment - see Moment Capacity
(Section): Eccentricity Moments - but note in particular that the ratio βm and
the moment modification factor αm will be based on real moments only.

The twist restraint factor kt will be determined by consideration of the LTB
cross-section restraints at either end of the segment, per Table 5.6.3(1) of AS
4100

The load height factor kl will default to 1.4 for a non-cantilever and 2.0 for a
cantilever.

The lateral rotation factor kr will default to 1.0.

Compression buckling resistance (Member capacity under axial compression) (Columns: AS
4100)

For most structures, all the members resisting axial compression need
checking to ensure adequate resistance to buckling about both the major and
minor axis. Since the axial force can vary throughout the member and the
strut buckling lengths in the two planes do not necessarily coincide, both axes
are checked. Because of the general nature of a beam-column, it may not
always be safe to assume that the combined actions check will always govern.
Hence the compression resistance check is performed independently from the
other strength and buckling checks.

The compression buckling resistance (member capacity under axial
compression) check is performed according to AS 4100 clause 6.3

The default value of effective length factor is 1.0 Different values can apply in
the major and minor axis. Beams are less affected by sway than columns but
the effectiveness of the incoming members to restrain the beam in both
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position and direction is generally less than for columns. Hence, it is less likely
that effective length factors greater than 1.0 will be required but equally
factors less than 1.0 may not easily be justified. Nevertheless, it is your
responsibility to adjust the value from 1.0 and to justify such a change.

Combined actions resistance (Columns: AS 4100)

NOTE important Note. Clause 8.2 of AS 4100 defines the design bending
moments to be used in the combined actions checks as either
amplified moments from a first order linear elastic analysis or the
moments resulting directly from a second order elastic analysis. Tekla
Structural Designer will not provide amplified moments from a first
order linear elastic analysis and you are expected to switch to second
order analysis to complete the design for combined actions.

Combined actions resistance - Section capacity (Columns: AS 4100)

The combined actions section capacity check is performed according to AS
4100 clause 8.3

The higher tier equations will be used automatically if the conditions for their
use are met.

Note that if the design axial force exceeds the design axial section capacity
then the check will automatically be set as Fail.

In the section capacity check, the design forces are those which are coincident
at any one point along the member.

Combined actions resistance - Member capacity (Columns: AS 4100)

The combined actions member capacity check is performed according to AS
4100 clause 8.4

The higher tier equations will be used automatically if the conditions for their
use are met.

In the higher tier equation for Mi, the ratio βm will be based on the relevant
strut length; if the strut length has bending induced by transverse load within
its length then βm will be taken as -1.0, and the ratio of end moments
otherwise.

In the higher tier equation for Mox, the ratio βm will be based on the LTB
segment length, and taken as the ratio of end moments, using real moments
only.

In the member capacity check, the design forces are the maxima in the design
length being considered, where the design lengths are based on the major and
minor strut lengths within a loop of LTB lengths.

Therefore, since any one design length will comprise both major and minor
strut lengths, the design axial force for each design length will be taken as the
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maximum axial compression or axial tension force from the major and minor
strut lengths considered together.

Note that if the design axial force exceeds the design axial member capacity
then the check will automatically be set as Fail.

Since both axial compression and axial tension are to be considered, but make
use of different equations, then in cases where both axial forces exist within a
design length the compression equations and tension equations will both be
evaluated and the worst case of the two will be reported.

Note that in bi-axial bending cases, zero axial force will be treated as
compression.

Serviceability limit state (Columns: AS 4100)

The column is assessed for sway and the following values are reported for
each stack:

• Sway X (mm) and λcritx

• Sway Y (mm) and λcrity

• Twist i.e. Sway X-Y (non-dimensional ratio)

Depending on the reported λcrit the column is classified as Sway or Non sway
accordingly.

NOTE A sway assessment is only performed for the column if the Lambda
Crit Check box is checked on the Column Properties dialog.

If very short columns exist in the building model these can distort the
overall sway classification for the building. For this reason you may
apply engineering judgement to uncheck the Lambda Crit Check box
for those columns for which a sway assessment would be
inappropriate

Steel brace design to AS 4100

Design method (Braces: AS4100)

Unless explicitly stated all brace calculations are in accordance with the
relevant sections of AS 4100 (Ref. 1).

A basic knowledge of the design methods for braces in accordance with the
design code is assumed.

Hollow sections

The checks for CHS, RHS and SHS relate to “hot-finished hollow sections” only -
“cold-formed hollow sections” are not included in this release.
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Classification (Braces: AS 4100)

No classification is required for braces.

Axial capacity (section) (Braces: AS 4100)

The (section) axial capacity check is performed according to AS 4100 clause 6.1
for axial compression, or clause 7.1 for axial tension, using the gross cross-
section area for An in both cases.

Note that member (axial compression) capacity is a buckling check and as such
is considered under the heading Compression Buckling.

Compression buckling resistance (Member capacity under axial compression)
(Braces: AS 4100)

The compression buckling resistance (member capacity under axial
compression) check is performed according to AS 4100 clause 6.3

The default effective length factor in each axis is 1.0

References (AS 4100)

1. Standards Australia International. AS 4100-1998/Amdt 1-2012: Steel
structures. SAI 2012.

2. Standards Australia International. AS 2327.1-2003: Composite
structures. Part 1: Simply supported beams. SAI 2003.

3. Standards Australia International. AS 4100 Supp1-1999: Steel
structures – Commentary. (Supplement to AS 4100-1998). SAI 1999.

4. Standards Australia International/Standards New Zealand. AS/NZS
1170.0:2002 (Including Amendments Nos.1,2,4 and 5). Structural design
actions. Part 0: General principles. SAI/NZS 2011.

5. Standards Australia International/Standards New Zealand. AS/NZS
1170.1:2002 (Including Amendments Nos.1 and 2). Structural design
actions. Part 1: Permanent, imposed and other actions. SAI/NZS 2009.

6. Standards Australia International/Standards New Zealand. AS/NZS
1170.2:2011 (Including Amendments Nos.1 and 2). Structural design
actions. Part 2: Wind actions. SAI/NZS 2012.

Design codes reference 2065 Australian Standards



15 Tekla Structural Designer
reference

This section contains reference information mainly on settings, options, and
sign conventions, but with with various other miscellaneous reference topics
included also.

• Properties (page 2066)

• Ribbon commands (page 2152)

• Settings (page 2263)

• Dialogs (page 2397)

15.1 Properties
This section describes properties of the main object types.

Structure geometric/analytical properties:

• Structure Properties (page 2067)

• Level Properties (page 2069)

• Frame Properties (page 2071)

• Slope Properties (page 2072)

• Sub Model Properties (page 2072)

Member properties:

• Beam properties (page 2073)

• Brace properties (page 2085)

• Column properties (page 2089)

• Concrete meshed and mid-pier wall properties (page 2098)

• Concrete core properties (page 2106)
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• Slab item properties (page 2114)

• Foundation mat properties (page 2120)

• Pad base strip base and pile cap properties (page 2125)

Other object properties:

• Bearing wall properties (page 2133)

• Shear only wall properties (page 2136)

• Wall Panel Properties (page 2138)

• Roof Panel Properties (page 2140)

• Slab/Mat overhang properties (page 2125)

• Support properties (page 2142)

• Patch properties (page 2145)

• Punching check properties (page 2147)

• Result strip properties (page 2152)

Structure Properties
Use the Structure properties to view or modify the basic properties of the
structure.

Property Description
Building
Direction
Rotation

Defines the building direction relative to the Global Axis System

The default (0 degrees) aligns the building direction 1 arrow with
the global X axis and the direction 2 arrow with the global Y axis.

Entering a positive value rotates the Building Direction arrows
clockwise about positive Global Z, a negative value rotates anti-
clockwise. The limiting values are +45 degrees and -45 degrees. (If
you enter larger values they will be capped at these limits).

The building direction arrows are always at 90 degs to each other.
Show
Building
Arrows

When shown, building direction arrows are displayed in all 2D
and 3D Views.

Building
Direction
Labels

The labels to be used for the building direction arrows.

The options are:

• Dir 1/2

• Dir H/V

• Dir X/Y
Conseque
nce class

Defines kFl used in strength combinations.
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Property Description
• CC3 - kFl = 1.1

• CC2 - kFl = 1.0

• CC1 - kFl = 0.9

NOTE Applies to Finland (Eurocode) head code only

Reliability
class

Defines γd used in strength combinations.

• RC3 - γFl = 1.0

• RC2 - γFl = 0.91

• RC1 - γFl = 0.83

NOTE Applies to Sweden (Eurocode) head code only

Shell
Mesh Size

Defines the shell mesh size for two way spanning slabs.

NOTE To optimize solution time consider using a coarser mesh
during design development before switching to a more
refined mesh at the final design stage.

Shell
Uniformit
y Factor

Defines the shell mesh uniformity for two way spanning slabs.
(100% = maximum uniformity).

Semi-Rigid
Mesh Size

Defines the mesh size for roof panels, and slabs when modeled
as semi-rigid diaphragms.

Semi-Rigid
Uniformit
y Factor

Defines the semi-rigid mesh uniformity for roof panels, and slabs
when modeled as semi-rigid diaphragms.

Semi-Rigid
Mesh
Type

Defines the semi-rigid mesh type for roof panels, and slabs when
modeled as semi-rigid diaphragms

The options are:

• QuadDominant

• QuadOnly

• Triangular
Wall Mesh
Horizontal
Size

Defines the horizontal mesh size for all meshed walls in the
model - but can be overridden in individual wall properties.

Wall Mesh
Vertical
Size

Defines the vertical mesh size for all meshed walls in the model -
but can be overridden in individual wall properties.
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Property Description
Wall Mesh
Type

Defines the mesh type for all meshed walls in the model, (but can
be overridden in individual wall properties):

The options are:

• Quad only

• Tri only

• Quad dominant

Level Properties
Use the Level properties to view or modify the basic properties of a level.

General
Level The height of the construction level above the base level
Floor By setting a construction level to be a Floor you are indicating

that it is a major level in the building. Floor levels are used to
determine items such as your inter story height and positions
from which column splices are laid out. If a level is not set to be a
floor then no live load reductions will be accounted for in the
beams at that level, or in the columns supporting that level.

There can certainly be a number of levels that are clearly floor
levels, but there could be many others that are not. For example
you create intermediate levels in order to define:

• half landing levels and stairs,

• K Bracing - you require a construction level for the
intermediate bracing connection points,

• steps in the building floor levels.

Where you define a level which is clearly not a floor, then you
should not check the floor box.

Type The level type can be:

• T.O.S = Top of Steel

• S.S.L = Structural Slab Level

• T.O.F = Top of Foundation

NOTE Slabs are modeled above the level when it is set to T.O.S
or T.O.F but below the level when it is set to S.S.L

Short
Name

Each construction level should be given a unique reference.
Typically this might be a storey number, 1, 2 , 3 etc.
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General
Long
Name

Each construction level can also be given a name to further assist
identification. 'First Floor', or 'Mezzanine' etc.

Name Automatically generated from the short and long name. By
default this will be used as the name in the Structure tree

Mesh 2-
way Slabs
in 3D
Analysis

• On = 2-way slabs are meshed in the 3D building analysis and
grillage chasedown analysis in addition to the FE chasedown
analysis.

• Off = 2-way slabs are only meshed in the FE chasedown
analysis.

NOTE The Sub Model in which the Level is contained
determines the mesh parameters that are applied.

Include in
Export

Determine whether Level should be included in CXL or IFC export.

• Floor Only - include only if defined as a Floor.

• Yes - always include.

• No - never include.

NOTE The lowest Level will always be exported.

Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting

Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
level

• Off = Grid & construction lines are always off for the specified
level, irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.
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General
Decompo
sition>
Keep
solver
model

Controls whether you will be able to review the solver model
used for load decomposition between analyses:

• On = the solver model is retained, you might choose to use
this setting if you need to investigate any validation warnings
that relate to load decomposition.

• Off (default) = the solver model is discarded immediately after
analysis has been performed.

Decomposition
Keep
solver
model

Controls whether you will be able to review the solver model
used for load decomposition between analyses:

• On = the solver model is retained, you might choose to use
this setting if you need to investigate any validation warnings
that relate to load decomposition.

• Off (default) = the solver model is discarded immediately after
analysis has been performed.

Frame Properties
Use the Frame properties to view or modify the basic properties of a frame.

Property Description
Name Automatically generated, but can be replaced by User name if

required.
Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting

Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
frame
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Property Description
• Off = Grid & construction lines are always off for the specified

frame irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.

Visible Controls whether the frame view can be opened or not.

Slope Properties
Use the Slope properties to view or modify the basic properties of a frame.

Property Description
Name Automatically generated, but can be replaced by User name if

required.
Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting

Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
slope

• Off = Grid & construction lines are always off for the specified
slope irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.

Visible Controls whether the slope view can be opened or not.

Sub Model Properties
Use the Sub Models properties to view or modify the selected sub model.
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Propert
y

Description

Override
model's

Select this check box in order to override the Structure
meshing properties in the current sub model.

Shell
Mesh
Size

Defines the shell mesh size for two way spanning slabs
in the sub model.

Shell
Uniformi
ty Factor

Defines the shell mesh uniformity factor for two way
spanning slabs in the sub model.

Slab
Mesh
Type

Defines the shell mesh type used in the sub model.

These options are:

• Quad only

• Tri only

• Quad dominant
Semi-
Rigid
Mesh
Size

Defines the semi-rigid mesh size when slabs are
modeled as semi-rigid diaphragms in the sub model.

Semi-
Rigid
Uniformi
ty Factor

Defines the semi-rigid uniformity factor when slabs are
modeled as semi-rigid diaphragms in the sub model.

Semi-
Rigid
Mesh
Type

Defines the semi-rigid mesh type when slabs are
modeled as semi-rigid diaphragms in the sub model.

The options are:

• Quad only

• Tri only

• Quad dominant

Beam properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See: Concrete member design and detailing groups
(page 1281) , Steel member design groups (page 1206)
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General
Plane Indicates the level or frame within which the member is

placed.
Characteristic Beam
Active Clearing this option makes single span beams inactive in

the analysis.

See: Inactive members (page 482)

NOTE Only displayed for single span members

Material type • Steel

• Concrete

• Timber

• General

• Cold formed

• Cold rolled
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 2110)

Autodesign See: Concrete member autodesign (page 1280), Steel
member autodesign (page 1205)

Design section
order

(steel only)

The design order file from which a section size will be
selected.

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 1006)

Select bars
starting from

(concrete only)

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

See: Concrete member autodesign (page 1280), Steel
member autodesign (page 1205)

Gravity only Controls whether the member is defined for gravity
combinations only, or gravity plus lateral:

• On = designed for gravity combinations only
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General
• Off = designed for gravity and lateral combinations

See: Designing individual members for gravity only
(page 1204)

Rotation Rotation of the member about its local x axis.

The default (Degrees0) aligns the major properties with the
global Z axis, (provided that the member has not been
specifically defined within an incline plane).

Global offset
end 1,

end 2

Can be used to model a physical offset with respect to the
global axes at one or both ends of the member, (exceptions
apply).

See: Member global offsets (page 422)
Major snap
level,

Minor snap
level

(not concrete)

Defines the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

(not concrete)

Used to offset the member from the snap point in the
major and minor axis.

Allow automatic
join end 1,

end 2

(concrete only)

When this check box is selected - the end in question will be
automatically joined to a suitable connecting concrete
beam end during design process or when the ‘Beam Lines’
command is run, (providing the Beam Lines limiting criteria
specified in Model Settings are met.)

All spans
Section The section size
Concrete type,

Grade/Class

While you can apply both normal and lightweight concrete,
wall design using lightweight concrete is currently beyond
scope.

Linearity • Straight

• Curved Major

• Curved Minor
Chord height This property is only displayed when ‘Linearity’ is curved

major or curved minor. It is the perpendicular distance
from the mid point of the chord baseline to the curve itself.

Maximum facet
error

This property is only displayed when ‘Linearity’ is curved
major or curved minor. It controls number of straight line
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elements that replace the curved member in the solver
model.

See: Analysis Model settings (page 2271)
Top flange cont.
rest.

(steel and
composite
beams only)

Define if the top flange is continuously restrained.

Alignment (concrete only)
Major snap
level,

Minor snap
level,

Define the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

Used to offset the member from the snap point in the
major and minor axis.

Releases
Free end 1,

end 2

When this check box is selected - defines a cantilever end.

Fixity end 1,

end 2

• Moment

• Pin

• Fully fixed

See: Beam releases (page 2084)
Axial load
release end 1,

end 2

Check one end only to define an axial release.

Torsional load
release end 1,

end 2

Check one end only to define a torsional release.

My stiffness
end 1, end 2

This property controls end fixity in the Major direction. It is
only displayed when ‘Fixity’ is Fully fixed, or Moment. The
choices are:

• Fixed (default)

• Spring linear

• Partially fixed
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Stiffness y end
1, end 2

When ‘My stiffness’ is set to Spring linear, this property
allows you to specify the major direction stiffness in terms
of a linear spring value.

When ‘My stiffness’ is set to Partially fixed, this property
allows you to specify the major direction stiffness as a
percentage of a fully fixed connection. (% of 4EI/L).

Mz stiffness end
1, end 2

This property controls end fixity in the Minor direction. It is
only displayed when ‘Fixity’ is Fully fixed. The choices are:

• Fixed (default)

• Spring linear

• Partially fixed
Stiffness z end
1, end 2

When ‘Mz stiffness’ is set to Spring linear, this property
allows you to specify the minor direction stiffness in terms
of a linear spring value.

When ‘Mz stiffness’ is set to Partially fixed, this property
allows you to specify the minor direction stiffness as a
percentage of a fully fixed connection. (% of 4EI/L).

Load reductions
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See: Overview of load reductions (page 1172)
Reduce
imposed loads
by

(All other Head
Codes)

This property is particularly applicable to the design of
transfer beams.

Although the percentage of imposed load reduction is not
determined automatically for beams, this property allows
you to specify the percentage manually.

It can be applied to all, or individual spans.

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

The reduced results are used in concrete beam design.

See: Overview of load reductions (page 1172)
Deflection limits (steel only)
Apply span
\factor

With this option checked, the limit can be defined as a
Relative span/factor.

Apply abs. limit With this option checked, the limit can be defined as
absolut value.
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Limit for
immediate live
load deflection,

Limit for total
deflection
affecting
sensitive
finishes

Calculate total
deflection at
design time

Calculate
deflection after
installation of
finishes

(ACI only)

These options control how the deflection is calculated.

Torsion (steel only)
Check for
torsion,

Apply rotational
limit

Used to specify if the member should be checked for
torsion, and also to apply a rotational limit if required.

See: Steel beam torsion (page 1223)

Camber (steel only)
Apply camber
to this beam

Used to specify a camber to the beam if required.

See: Camber (page 1217)
Natural frequency (non-composite and composite beams only)
Calculate
natural
frequency

For composite beams this is fixed to on (for EC and BS
headcodes only) and is utilized during autodesign. The
calculated natural frequency is displayed in the results
viewer.

Check natural
frequency
against
minimum

For composite beams this is fixed to on (for EC and BS
headcodes only). For non-composite beams it can be used
in conjunction with the 'Calulate natural frequency'
property to impose an optional 2-step control, ‘calculate’
and ‘check’, which allows for the natural frequency value to
be calculated (and displayed in Results Viewer) with or
without the check. While the US headcode has no
requirement for this check, it can still be requested if
required.

When performed, a simple (design model) approach is
taken based on uniform loading and pin supports. This
fairly simple calculation is provided to the designer for
information only. The calculation can be too coarse
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particularly for long span beams and does not consider the
response side of the behaviour i.e. the reaction of the
building occupants to any particular limiting value for the
floor system under consideration. In such cases the
designer has the option to perform a 1st Order Modal
Analysis.

See:

• Natural frequency checks (SLS) (Beams: EC4 Eurocode)
(page 1900)

• Natural frequency checks (SLS) (Beams: BS 5950)
(page 2021)

Minimum
natural
frequency

The minimum value against which the natural frequency is
checked (default 4Hz).

Include self
weight (beam &
slab)

Include other
dead loads

Include live
loads (US)

Include
imposed loads
(other
headcodes)

The engineer can specify the percentages of each of these
loads to be included in the calculation of the maximum
static instantaneous deflection, δ

Factor for
increased
dynamic
stiffness of the
concrete flange

For composite beams this factor is applied to the beam's
short term modular ratio

Effective width

Calculate
effective width

For composite beams the effective width can either be
entered directly or calculated from the geometry.

See:

• Effective width used in the design - Head Code: ACI/AISC
(page 1230)

• Effective width used in the design - Head Code:
Eurocode (page 1232)

• Effective width used in the design - Head Code: BS
(page 1234)

Size constraints (steel only)
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Max depth,

Min depth,

Max width,

Min width

Size Constraints are only applicable when Autodesign is
checked. They allow you to ensure that the sections that
Tekla Structural Designer proposes match any particular
size constraints you may have. For instance for a composite
beam you may want to ensure a minimum flange width of
150mm (6in). If so you would simply enter this value as the
Minimum width, and Tekla Structural Designer would not
consider sections with flanges less than this width for the
design of this beam.

See: Size constraints (page 1205)
Apply max
span/depth
ratio

Max span/
depth ratio

After setting a max span/depth ratio you can check the
'Apply' button for it to be considered by auto-design. During
design, only sections which satisfy the maximum ratio limit
will be selected.

The setting can also be reviewed and/ or copied via Review
View > Show/Alter State.

See: Size constraints (page 1205)
Instability factor (steel only)
Prevent out of
plane instability

Define if out of plane stability is prevented.

See: Instability factor (page 1217)
  
Design control (concrete only)
Structure
supporting
sensitive
finishes (ACI
and Eurocode
only)

Any beam that supports or is attached to partitions or other
constructions likely be damaged by large deflections should
be identified as such by selecting this property.
ACI - The deflection method applied to the beam depends
on this setting as follows:

• beams not required to support sensitive finishes adopt
the simplified method.

• beams required to support sensitive finishes adopt the
rigorous method.

Eurocode - The f2 parameter used in the deflection check
depends on this parameter as follows:

• When selected: f2 is calculated as MIN[1,7/Leff]

• When unselected: f2 will be taken as 1.0.
Increase
reinforcement if
deflection check
fails (Eurocode
BS and IS only)

Select in order to increase the reinforcement during the
auto-design process if the deflection check fails.
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Permissible
increase in
reinforcement

Specify the max percentage increase in reinforcement that
is allowed in order to satisfy the deflection check.

Consider
flanges

Select in order to consider flanges in the concrete beam
design calculations - once checked additional fields are
displayed for specifying an allowance for openings.

Flange dimensions can only be calculated by editing the
beam once it has been positioned and slabs have been
defined. (In this case a ‘Calculate flanges’ button is also
displayed, this can be clicked in order to automatically
calculate the flange dimensions based on the adjoining
slabs.)

See: Flanged concrete beams (page 1297)
Include flanges
in analysis NOTE This property is only displayed when the ‘Consider

flanges’ option has been selected.

Select this check box to use flanged beam properties when
the analysis is performed.

See: Flanged concrete beams (page 1297)
Isolated beam
(ACI only) NOTE This property is only displayed when the ‘Consider

flanges’ option has been selected.

Select this check box in order to apply ACI 318 clause 8.12.4.

When the check is performed, if the flange geometry does
not meet the requirements the flanges are ignored.

See: Flanged concrete beams (page 1297)
User defined
flange (left/
right)

NOTE This property is only displayed when ‘Include
flanges in analysis’ has been checked.

If you clear this check box the flange depth and the effective
flange width are determined automatically.

If you select the check box, two new properties are
displayed for defining ‘Flange width’ and ‘Flange depth’.

See: Flanged concrete beams (page 1297)
Ignore lateral
instability
(Eurocode only)

This option allows you to ignore lateral instability for
slender spans to EC2 clause 5.9(1).

• When selected: the slender span check is excluded from
design
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• When unselected (default): the slender span check is

included.
Assume cracked Assuming concrete sections are cracked has a direct affect

on the analysis; smaller Modification Factors are applied
to cracked sections causing an increase in deflection.
Indirectly the design can also be affected because the sway/
drift sensitivity calculations are also influenced by this
assumption.

Design parameters (concrete only)
Nominal cover
beam top edge,

bottom edge,

section side,

beam ends

The nominal concrete cover is the distance between the
surface of the reinforcement closest to the nearest concrete
surface (including links and surface reinforcement where
relevant) and the nearest concrete surface.Different values
of nominal cover can be specified to the beam edges, sides
and ends.

Seismic
In a seismic
force resisting
system

If this is the case, select the check box, and then specify the
SFRS direction and type.

NOTE Design of members in seismic force resisting
systems is only supported for the ACI/AISC Head
Code in the current release.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).
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Fire check (steel only, Eurocode only)
Check for fire
resistance NOTE This property is only displayed for non-composite,

simply supported rolled steel beams to Eurocodes.

On

• When the check is requested, the additional properties
shown below are required.

See: Fire check (Eurocode only) (page 1223)

Off

• no check is performed
Load reduction
factor

0.65, or user input value.

Required time
of fire exposure

R15, R30, R60, R90, or R120

Exposure Exposed on three, or four sides
Protected On

• When the protected option is selected, the following fire
protection material details are required:

• Shape - Contour, or Hollow encasement

• Thickness

• Thermal conductivity

• Specific heat

• Density

• The check is performed using the 'protected' time
interval for critical temperature iteration, as specified in
Design Settings

Off

• The check is performed using the 'unprotected' time
interval for critical temperature iteration, as specified in
Design Settings

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)
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Reinforcement (concrete beams only)
Rib type -
vertical, Class -
longitudinal

Specifies the longitudinal reinforcement properties

Rib type - link,
Class - link

Specifies the link properties.

Top longitudinal
bar pattern,

Bottom
longitudinal bar
pattern

Choose from standard patterns (which can be setup in
Design Options) to control the top and bottom bar
arrangement when the beam is auto-designed.

See: Concrete beam design aspects (page 1289)

Span 1, 2, 3 etc.
In a multi-span beam properties can be entered for a
specific span, over-riding those defined at the All spans
level.

Beam releases
Releases at the two ends of a beam span can be set as follows:

• Pin - Pinned to the support or supporting member. This means pinned
about the major and minor axes of the section but fixed torsionally.

• Fully fixed - with the following major (My), and minor (Mz) stiffness sub-
options to allow definition of partial fixity in each direction if required:

• Fixed - Encastré, all degrees of freedom fixed.

• Spring linear - allows you to specify a linear spring stiffness value.

• Partially fixed - allows you to specify partial fixity as a percentage of a
fully fixed connection (%4EI/L)

• Moment (pin Mz) - Major axis moment connection, and pinned about the
minor axis.

• Moment (pin My) - Minor axis moment connection, and pinned about the
major axis.

• Fully fixed (free end) - Denotes a cantilever end. It is achieved by selecting
Free end.

(In a single span beam this box can only be checked if the opposite end is
fully fixed.)

• Continuous - This setting is automatically applied when a continuous
beam is created and effectively creates a non-editable fully fixed
connection between the spans of the continuous member. The connection
can only be edited by splitting the beam.
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In addition to the above release options you are also able to apply a torsional
release at either end by checking the appropriate box. Similarly an axial
release can be applied to beams of all materials apart from concrete.

NOTE Moment (pin My) this (unusual) release type is not available in the Properties
Window and can only be specified as follows:

1. Right-click the beam to display the context menu.

2. Choose Edit

3. From the Beam Property Dialog open the Releases page.

4. Check the Mz and uncheck the My degree of freedom at the desired end as
required.

Brace properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See: Steel member design groups (page 1206)
Plane Indicates the level or frame within which the member is

placed.
Characteristic Brace
Active Clearing this option makes the brace inactive in the

analysis.

See: Inactive members (page 482)
Material type • Steel

• Timber

• General

• Cold formed
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 2110)

Autodesign See: Concrete member autodesign (page 1280), Steel
member autodesign (page 1205)

Design section
order

(steel only)

The design order file from which a section size will be
selected.
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General

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 1006)

Rotation Rotation of the member about its local x axis.
Alignment
Global offset
end 1,

end 2

Can be used to model a physical offset with respect to the
global axes at one or both ends of the member, (exceptions
apply).

See: Member global offsets (page 422)
Major snap
level,

Minor snap
level

Defines the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

Used to offset the member from the snap point in the
major and minor axis.

All spans
Section The section size
Grade The material grade
Connection • Bolted

• Welded
Compression only,

Tension only

Specify if the brace is compression
only, or tension only.

NOTE Tension only and
Compression only members
are non-linear elements and
therefore require non-linear
analysis. If linear analysis is
performed they will be
treated as linear elements

Relaxation factor Only displayed if the brace is tension
only (default 0.0).

Any value entered is not used unless
you also check the ‘Use relaxation
factors for tension only elements’ box
in Analysis Options.
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NOTE It is highly unlikely that you
would ever need to set a
specific release factor for an
individual brace.

See 1st order non-linear settings in:
Analysis Settings (page 2278)

Releases
Fixity end 1,

end 2

• Pinned

Torsional load release end 1,

end 2

Check one end only to define a
torsional release.

Vertical load release end 1,

end 2

A vertical load release can be applied
to the end of a V or A type brace pair
so that they don’t prop other
members against gravity loads, (you
are prevented from releasing single
braces, or other brace pairs in this
way).

Include force in eccentricity moment
end 1,

end 2

Eccentricity moments in steel and
precast columns as a result of beam
connection eccentricities do not also
consider the brace connection
eccentricities unless this property is
checked for the appropriate end of
the brace.

• When checked ON the brace axial
force is resolved into a vertical
force, multiplied by the connection
eccentricity, to obtain a
connection eccentricity moment.

• When checked OFF the brace axial
force does not contribute to the
total connection eccentricity
moment.

See:

• Steel column connection
eccentricity moments - overview
(page 1256)

• Precast column connection
eccentricity moments - overview
(page 1558)
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Load reductions
KLL

(Head Code ACI/AISC)

Specify the KLL factor in accordance
with Table 4-2 in ASCE7-05/ASCE7-10.

See: Overview of load reductions
(page 1172)

Reduce imposed loads by

(All other Head Codes)

Although the percentage of imposed
load reduction is not determined
automatically, this property allows
you to specify the percentage
manually.

• reducible loadcases are reduced

• combinations incorporating
reducible loadcases are reduced

See: Overview of load reductions
(page 1172)

Compression
Effectve length factor y-y,

z-z

 

Tension
Net area Specified as an effective net area or a

percentage value.
Size constraints (steel only)
Max depth,

Min depth,

Max width,

Min width

Size Constraints are only applicable
when Autodesign is checked. They
allow you to ensure that the sections
that Tekla Structural Designer
proposes match any particular size
constraints you may have.

Seismic
In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.
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Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Column properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See: Concrete member design and detailing groups
(page 1281) , Steel member design groups (page 1206)

Top Level Specifies the top level for the column.
Base Level Specifies the bottom level for the column.
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General
Plane Indicates the grid along which the wall is placed.
Characteristic Column
Material type • Steel

• Concrete

• Timber

• General

• Cold formed

• Cold rolled
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 2110)

Autodesign See: Concrete member autodesign (page 1280), Steel
member autodesign (page 1205)

Design section
order

(steel only)

The design order file from which a section size will be
selected.

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 1006)

Select bars
starting from

(concrete only)

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

See: Concrete member autodesign (page 1280), Steel
member autodesign (page 1205)

Gravity only Controls whether the member is defined for gravity
combinations only, or gravity plus lateral:

• On = designed for gravity combinations only

• Off = designed for gravity and lateral combinations

See: Designing individual members for gravity only
(page 1204)

Rotation Rotation of the column about its local x axis.

NOTE For a vertical column:
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General

• 0° - column local y aligns with global X

• 90° - column local y aligns with global Y

Assume extra
floors
supported

Enter the number of extra floors supported.

Simple column

(steel only)

See: Simple columns (page 1251)

All stacks
Section The section size
Concrete type,

Grade/Class

(Concrete columns only)

While you can apply both normal and
lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Alignment (concrete only)
Major snap level,

Minor snap level,

Define the major and minor
alignment of the member relative to
the insertion point.

Major offset,

Minor offset

Used to offset the member from the
snap point in the major and minor
axis.

Face A cont. rest.,

Face C cont. rest.

(steel only)

Indicates continuous restraint to Face
A and/or Face C.

See: Steel column restraints
(page 1255)

Releases
Fixity Top,

Fixity Bottom

• Pinned

• Fixed

• Moment (pin My)

• Moment (pin Mz)

See: Column releases (page 2097)
Axial load release top An axial (Fx) release is only allowed at

the top of the column.
Torsional load release top,

Torsional load release bottom

Check one end only to define a
torsional release.

Size constraints (steel only)
Max depth, Size Constraints are only applicable

when Autodesign is checked. They
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All stacks
Min depth,

Max width,

Min width

allow you to ensure that the sections
that Tekla Structural Designer
proposes match any particular size
constraints you may have.

Instability factor (steel only)
Prevent out of plane instability Define if out of plane stability is

prevented.

See: Instability factor (page 1217)
Design control (concrete only)
Assume cracked Assuming concrete sections are

cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
drift sensitivity calculations are also
influenced by this assumption.

Apply rigid zones Unless cleared, rigid zones are
automatically created at the
connection between the column and
any connecting beams.

Design parameters (Eurocode only)
Permanent load ratio option

Relative humidity (RH)

Age of loading

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Age of loading is the age at which
loading is applied.

See: Design parameters (Eurocode
only) (page 2096)

Confinement reinforcement (concrete only)
Provide support regions • Checked - confinement

reinforcement is designed separately
in three regions.

• Cleared - the same confinement
reinforcement is designed for the
whole stack.

Slenderness (concrete only)
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All stacks
Direction 1,

Direction 2

• Braced

• Bracing
Direction 1 effective length factor,

Direction 2 effective length factor

• Calculated

• User input value
Stiffness (concrete only)
Use slab for calculation upper, lower For the unrestrained length

calculation:

• if a slab exists at a panel end, it can
be ignored by unchecking the
relevant box.

• If no slab exists at that end, the
setting is redundant - in which case
the program considers the setting at
the remote end of the next panel
instead.

See: Stiffness (page 1300)
Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all columns are
taken into account in the calculation
to determine the sway sensitivity of
the building. The results of this
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular column stacks from
these calculations to avoid spurious
results associated with very small
stack lengths. You can either clear the
check box located under ‘All Stacks’ to
exclude the entire column, or you can
exclude a particular stack by clearing
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All stacks
the check box located under that
stack only.

Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Stacks’ to
exclude the entire column, or you can
exclude a particular stack by clearing
the check box located under that
stack only.

Nominal cover The nominal concrete cover is the
distance between the surface of the
reinforcement closest to the nearest
concrete surface (including links and
surface reinforcement where
relevant) and the nearest concrete
surface.

Seismic
In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.

Shear demand/shear capacity ratio in
Dir 1

Shear demand/shear capacity ratio in
Dir 2

(ASCE7 code only)

When working to the ASCE7, the
engineer can directly define the shear
demand / capacity ratio (beta) in each
direction. The default value of 1.0
could be over-conservative.

The setting is applicable to all years of
the ASCE7 code and has the following
default and limits: Default = 1; Min =
0.001; Max = 10.
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Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Reinforcement
Rib type -
vertical, Class -
vertical

Specifies the vertical reinforcement properties

Rib type - link/
confinement,
Class - link/
confinement

Specifies the link/confinement properties.

Stack 1, 2, 3 etc.
In a multi-stack column properties can be entered for a
specific stack, over-riding those defined at the All stacks
level.
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Stack 1, 2, 3 etc.
Splice,

Splice offset

Used to indicate a splice at the bottom of a stack, and the
offset above the floor level.

See: Splice and splice offset (page 1261)

Level 1, 2, 3 etc.
Load reductions
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See: Overview of load reductions (page 1172)
Count the floor
as being
supported

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Eccentricity (steel only)
Apply face A
eccentricity, etc.

See: Steel column connection eccentricity moments
(page 1256)

Design parameters (Eurocode only)
Located under the Design parameters heading in the column properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio

The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.
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When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.

Column releases
Releases in columns can be set as follows:

Moment Releases

• Pinned - Pinned to the adjacent stack and connecting members. This
means pinned about the major and minor axes of the section but fixed
torsionally.

• Fixed - fully fixed

• Moment (pin My) - Pinned about the y axis only

• Moment (pin Mz) - Pinned about the z axis only.

NOTE While Moment (pin My) and Moment (pin Mz) releases are less usual, for
continuous columns composed of two or more stacks, they have been
provided in response to customer feedback, to allow any/all column stacks to
be pinned in one direction whilst the other direction remains fixed.

When such a release is applied, a Warning status is issued in the Column
Property dialog. This is intentional and does not prevent analysis or design -
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as the Warning tooltip states, it is to prompt the engineer to consider the
connection details at this location in the column.

Translational releases

• Fy and Fz releases are prevented in all stacks i.e. no ‘roller’ connections.

• Fx (axial) release allowed at the top of the topmost stack only.

• Mx (torsional release allowed in all stacks.

Concrete meshed and mid-pier wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type • Meshed Shear Wall

• Mid-pier Shear Wall

NOTE Mid-pier shear walls must be rectangular in a
vertical plane. Meshed shear walls can be vertical
or sloping.

Fabrication Choice of:

• Cast-in-place

• Precast

NOTE Design of precast members is beyond scope in
the current release

Autodesign • Cleared - the specified reinforcement will be checked
during the design process.

• Checked - reinforcement will be designed during the
design process.

See: Concrete member autodesign (page 1280)
Select bars
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.
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General
• Current - the auto design commences from the current
bar arrangement.

See: Concrete member autodesign (page 1280)
Assume extra
floors
supported

Enter the number of extra floors supported.

Rotation

(mid-pier only)

• 0° - wall spans horizontally

• 90° - wall spans vertically
AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See: Overview of load reductions (page 1172)
Plane Indicates the grid along which the wall is placed.

All panels
Concrete type While you can apply both normal and

lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Grade The concrete grades that are available
here are set from the Materials
button on the Home ribbon.

Thickness The thickness of the wall.
Alignment Alignment of the wall:

• Front

• Back
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All panels
• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Assume cracked Assuming concrete sections are
cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
drift sensitivity calculations are also
influenced by this assumption.

End 1 extension The amount the wall is extended or
trimmed back from end 1.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 429)

End 2 extension The amount the wall is extended or
trimmed back from end 2.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 429)

Reinforcement Layers Number of layers of reinforcement to
be used in the wall:

• 1

• 2
Releases
Minor Top • Fixed

• Pinned
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All panels
• Continuous (incoming members
pinned)

NOTE The ‘Continuous’ option is
only available for FE meshed
walls.

Minor Bottom • Fixed

• Pinned

• Continuous (incoming members
pinned)

NOTE The ‘Continuous’ option is
only available for FE meshed
walls.

Design parameters
Permanent load ratio option

Relative humidity (RH)

Age of loading

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Age of loading is the age at which
loading is applied.

See: Design parameters (Eurocode
only) (page 2096)

Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all walls are
taken into account in the calculation
to determine the sway sensitivity of
the building. The results of this
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All panels
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular wall panels from
these calculations to avoid spurious
results associated with very small
panel lengths. You can either clear
the check box located under ‘All
Panels’ to exclude the entire wall, or
you can exclude a particular panel by
clearing the check box located under
that panel only.

Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Panels’ to
exclude the entire wall, or you can
exclude a particular stack by clearing
the check box located under that
panel only.

Confinement reinforcement
Provide support regions • Checked - confinement

reinforcement is designed separately
in three regions.

• Cleared - the same confinement
reinforcement is designed for the
whole stack.

Slenderness
Major

(Minor)

• Braced

• Bracing
Effective length factor direction Major

(Minor)

• Calculated

• User input value
Stiffness
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All panels
Use slab for calculation (upper major/
minor, lower major/minor)

For the unrestrained length
calculation:

• if a slab exists at a panel end, it can
be ignored by unchecking the
relevant box.

• If no slab exists at that end, the
setting is redundant - in which case
the program considers the setting at
the remote end of the next panel
instead.

See: Stiffness (page 1308)
Nominal cover The nominal concrete cover is the

distance between the surface of the
reinforcement closest to the nearest
concrete surface (including links and
surface reinforcement where
relevant) and the nearest concrete
surface.

Seismic
In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.

Shear demand/shear capacity ratio in
Dir 1

Shear demand/shear capacity ratio in
Dir 2

(ASCE7 code only)

When working to the ASCE7, the
engineer can directly define the shear
demand / capacity ratio (beta) in each
direction. The default value of 1.0
could be over-conservative.

The setting is applicable to all years of
the ASCE7 code and has the following
default and limits: Default = 1; Min =
0.001; Max = 10.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.
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Utilization ratio
Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

Wall support
Angles

(Fx/Fy/Fz,
Mx/My/Mz)

Used to specify the translational and rotational degrees of
freedom in which the support acts:

• Fixed - indicates the support is fixed in the specified
direction.

• Free - indicates the support is free to move, or has a
stiffness applied in the specified direction.

Translational
stiffnesses
(x/y/z)

Used to specify the translational stiffness applied in a
direction that is not fixed:

• Release

• Spring Linear

• Spring Non-linear
Rotational
stiffnesses
(x/y/z)

Used to specify the rotational stiffness applied in a direction
that is not fixed:

• Release

• Spring Linear

• Spring Non-linear

Reinforcement
Include end
zones

• Cleared - the wall is designed without end zones of
reinforcement

• Checked - the wall is designed with end zones of
reinforcement

Wall zone
Form, type class Specifies the wall zone reinforcement properties
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Reinforcement
End zone
Form, type class Specifies the end zone reinforcement properties (if end

zones have been requested).

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.

Count the floor as being supported
Top level

(Interediate
levels)

Base level

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.

Meshing (meshed walls only)
Override
Model’s

Select this check box to override the default wall mesh size
that is specified in the Structure properties.

Wall Mesh
Horizontal Size

Used to override the default wall horizontal mesh size
(1.000m).

Wall Mesh
Vertical Size

Used to override the default wall vertical mesh size
(1.000m).

Wall Mesh Type Available mesh types:

• Quad only

• Tri only

• Quad dominant

See: How meshed walls are represented in solver models
(page 750)
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UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Concrete core properties

General
Name The automatically generated name for the core.
User Name Can be used to override the automatically generated name

if required.
Rotation Defines the axis system for reporting the core results:

• Dir 1/2 - Main Building Directions

• Principal 1/2 - Major and minor local axis

• Angle - in Global Coordinate System

Level 1, Level 2 etc.
Centroid above,
Centroid below

Every core will have at least 2 core levels, with a core
section for each level. The centroids of the core sections are
reported above and below each level.

General wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type • Meshed Shear Wall
Material type • General
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General
Assume extra
floors
supported

Enter the number of extra floors supported.

AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Grade The grades that are available for

General materials are set from the
Materials button on the Home ribbon.

Thickness The thickness of the wall.
Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Assume cracked Assuming concrete sections are
cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
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All panels
drift sensitivity calculations are also
influenced by this assumption.

End 1 extension The amount the wall is extended or
trimmed back from end 1.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 429)

End 2 extension The amount the wall is extended or
trimmed back from end 2.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 429)

Releases
Minor Top • Fixed

• Pinned

• Continuous (incoming members
pinned)

Minor Bottom • Fixed

• Pinned

• Continuous (incoming members
pinned)

Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all walls are
taken into account in the calculation
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All panels
to determine the sway sensitivity of
the building. The results of this
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular wall panels from
these calculations to avoid spurious
results associated with very small
panel lengths. You can either clear
the check box located under ‘All
Panels’ to exclude the entire wall, or
you can exclude a particular panel by
clearing the check box located under
that panel only.

Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Panels’ to
exclude the entire wall, or you can
exclude a particular stack by clearing
the check box located under that
panel only.

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.

Count the floor as being supported
Top level

(Interediate
levels)

Base level

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.
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Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.

Meshing
Override
Model’s

Select this check box to override the default wall mesh size
that is specified in the Structure properties.

Wall Mesh
Horizontal Size

Used to override the default wall horizontal mesh size
(1.000m).

Wall Mesh
Vertical Size

Used to override the default wall vertical mesh size
(1.000m).

Wall Mesh Type Available mesh types:

• Quad only

• Tri only

• Quad dominant

See: How meshed walls are represented in solver models
(page 750)

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Member characteristic, construction and fabrication
properties
The following table lists the available permutations of characteristic,
construction and fabrication for each material type.

Mater
ial

Charact
eristic

Constructio
n

Fabrication Notes

Concr
ete

Beam Concrete
beam

Cast-in-place  
Post tensioned Not designed
Precast Not designed
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Mater
ial

Charact
eristic

Constructio
n

Fabrication Notes

Coupling
beam

Cast-in-place Coupling beams are the
only beams considered by
the Assisted core function.
As they may require
additional design checks
beyond those currently
made in the program they
are not designed.

Column Concrete
column

Cast-in-place  
Precast Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Steel Beam Non-
composite
beam

Rolled  
Plated  
Westok cellular  
Westok plated  
Fabsec Not designed

Composite
beam

Rolled  
Plated  
Westok cellular Not designed
Westok plated Not designed
Fabsec Not designed

Column Non-
composite
column

Rolled  
Plated  
Concrete filled Not designed
Concrete
encased

Not designed

Composite
column

Rolled Not designed
Plated Not designed

Brace Steel brace Rolled  
Steel
joist

Steel joist Steel joist Standard, Special or Girder
types

Gable
post

Steel gable
post

Rolled  

Parapet
post

Steel Parapet
post

Rolled  

Truss
member
top

Steel Truss
member top

Rolled  
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Mater
ial

Charact
eristic

Constructio
n

Fabrication Notes

Truss
member
bottom

Steel Truss
member
bottom

Rolled  

Truss
member
side

Steel Truss
member side

Rolled  

Truss
member
internal

Steel Truss
member
internal

Rolled  

Analysis
Element

Not
applicable

Not applicable Not designed

Cold
forme
d

Beam Cold formed
beam
member

Cold formed  

Column Cold formed
column
member

Cold formed  

Brace Cold formed
brace
member

Cold formed  

Gable
post

Steel gable
post

Cold formed  

Parapet
post

Steel Parapet
post

Cold formed  

Truss
member
top

Steel Truss
member top

Cold formed  

Truss
member
bottom

Steel Truss
member
bottom

Cold formed  

Truss
member
side

Steel Truss
member side

Cold formed  

Truss
member
internal

Steel Truss
member
internal

Cold formed  

Analysis
Element

Not
applicable

Not applicable Not designed

Cold
rolled

Beam Cold rolled
beam
member

Cold rolled Not designed
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Mater
ial

Charact
eristic

Constructio
n

Fabrication Notes

Column Cold rolled
column
member

Cold rolled Not designed

Eaves
beam

Eaves beam Cold rolled Not designed

Purlin Purlin Cold rolled Not designed
Rail Rail Cold rolled Not designed
Analysis
Element

Not
applicable

Not applicable Not designed

Timbe
r

Beam Timber
beam

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Column Timber
column

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Brace Timber brace Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Gable
post

Timber gable
post

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
member
top

Timber Truss
member top

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
member
bottom

Timber Truss
member
bottom

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed
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Mater
ial

Charact
eristic

Constructio
n

Fabrication Notes

Truss
member
side

Timber Truss
member side

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
member
internal

Timber Truss
member
internal

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Gener
al

Beam General
material
beam

Not applicable Not designed

Column General
material
column

Not applicable Not designed

Brace General
material
brace

Not applicable Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Slab item properties

General
Name The automatically generated name for the slab item.
User Name Can be used to override the automatically generated name

if required.
Rotation angle This property is used for the following where appropriate:

• Span direction for 1-way load decomposition

• To determine the 2D solver element local axes in the
solver model

Tekla Structural Designer reference 2114 Properties



General
• Bar direction for Slab on Beam and Flat Slabs.

Different angles can be specified for different panels within
the slab.

See: Rotation angle for panels (page 1380)
Include in
diaphragm

If this option is cleared, the slab item does not participate in
diaphragm action. All nodes linked to the mat item will be
able to displace independently of the diaphragm.

Override slab
depth

By default all panels in a slab adopt the same depth.
Checking this option allows the selected panel to have a
different depth and vertical offset.

Vertical offset Only available when ‘Override slab depth’ is checked.

A positive offset raises the slab panel surface, a negative
offset drops it.

NOTE Vertical offsets are not structurally significant

Auto-design For panels in Auto-design mode, As,prov is increased until
either a pass is achieved or the limiting reinforcement
parameter limits have been exceeded.

For panels not in Autodesign mode, the result will be a pass
or fail.

Select bars
starting from

This option controls the starting point for auto-design
procedures.

Plane Indicates the level at which the slab is placed.

Slab general
Name The automatically generated name for the mat item.
User Name Can be used to override the automatically generated name

if required.
Slab type • Precast

• Steel deck

• Timber deck

• Composite slab

• Foundation mat
Deck type The deck type depends on the slab type as follows:

• Precast concrete planks: Precast,

• Steel plate: Steel deck,

• Timber: Timber deck,

• Profiled metal decking: Composite slab,
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Slab general
• Reinforced concrete: Slab on beams, Flat slab,

Foundation mat

• Post tension: Slab on beams, Flat slab, Foundation mat
Decomposition Decomposition choices depend on the slab type as follows:

• One-way only: Precast, Timber deck, Composite slab

• One-way or two way: Steel deck, Slab on beams

• Two-way only: Flat slab, Foundation mat

Slab parameters
Slab properties(general)
Overall depth Specifies the slab thickness.
Diaphragm
option

Sets the default diaphragm action for all slab items within
the parent slab.

• Rigid

• Semi-rigid

• None
Slab properties (concrete slabs)
Concrete type • Normal

• Lightweight
Grade/Concrete
class

Specifies the concrete grade.

Concrete
aggregate type

Specifies the aggregate type.

Concrete
density class

For normal weight concrete only, specifies the density class.

Dry density Specifies the dry concrete density
Wet density Specifies the wet concrete density
Long term
elastic modulus
= Ecm divided
by...

composite slab
and precast
only)

Factor by which the short term elastic modulus is divided to
obtain the long term modulus .

Ponding
allowance

If required, choose either value or percentage and then
specify actual ponding allowance accordingly.
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Slab parameters
option, Ponding
allowance value

(composite slab
only)
Apply ponding
to construction
stage

(composite slab
only)

• On = ponding allowance applied at construction stage

Apply ponding
to composite
stage

(composite slab
only)

• On = ponding allowance applied at composite stage

Decking properties (where applicable)
Country,
Manufacturer,
Reference,
Gauge

Defines properties of decking (where applicable).

Reinforcement in slab for crack control or fire requirements

(composite slab, and precast with topping specified only)
Type, Rib type,
Mesh type
Class, Bar size

Defines reinforcement for crack control or fire
requirements

Topping details(precast only)
Topping • None

• Non-structural

• Structural
Depth Depth of topping when topping other than 'None' is

selected.
Design parameters (Head Code Eurocode)
Permanent load
ratio

You are required to supply a value for the permanent load
ratio parameter. A default of 0.65 has been assumed, but
you are advised to consider if this is appropriate and adjust
as necessary.

Maximum crack
width

• 0.2

• 0.3

• 0.4
Deflection parameters
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Slab parameters
Restraint
constant

(ACI only)

See: Restraint constant (ACI) (page 1389)

Restraint type

(Eurocode only)

See: Restraint type (EC2) (page 1388)

Cement class

(Eurocode only)

See: Concrete Properties (Eurocode) (page 1390)

Material properties
Modulus of
elasticity,
Poisson's ratio,
Shear moduls,
Coefficient of
thermal
expansion

Properties specific to timber and steel decks.

Design parameters
Adjustment
ratio direction
X ,Adjustment
ratio direction Y

(slab on beam
only)

These factors are applied to the enclosing lengths in X and Y
in order to manually adjust the X and Y direction span in the
span-effective depth check.

See Slab on beam idealized panels (page 1378)

Enclosing
length X,
Enclosing
length Y

(slab on beam
only)

The automatically calculated span length in the X direction,
and Y direction.

See Slab on beam idealized panels (page 1378)

Adjusted length
X, Adjusted
length X

(slab on beam
only)

The adjusted span lengths in the X and Y directions.

See Slab on beam idealized panels (page 1378)

Edge category
start X, Edge
category start Y

(slab on beam
only)

The assumed support condition at the start of the span in
the X direction, and Y direction.

See Slab on beam idealized panels (page 1378)
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Design parameters
Edge category
end X, Edge
category end Y

(slab on beam
only)

The assumed support condition at the end of the span in
the X direction, and Y direction.

See Slab on beam idealized panels (page 1378)

Average
stiffness ratio

(Slab on beam
ACI/AISC only)

In the current release of Tekla Structural Designerr the
average stiffness ratio is a user defined value. (Default value
= 1.0). The way in which the minimum thickness is
calculated directly depends on this value.

Live/Imposed load reduction
Reduce live/
imposed loads
by

This property is applicable for the design of transfer slabs
and mats.

Although the percentage of live load reduction is not
determined automatically, this property allows you to
specify the percentage manually.

It can be applied to an individual slab item - you don't have
to apply a single value throughout a slab or mat (this can be
important if you have discrete transfer panels within a large
slab area).

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

• The reduced results are used in slab design.

NOTE For mats, the bearing pressures are reduced as
well.

Reinforcement
 Slabs panels can potentially have 4 layers of background

reinforcement, (however any of the layers/directions can be
set to “none” if required).

Select/clear Outside layer in X direction as appropriate to
indicate if the outside layer is in the X or Y direction. (The
outside layer can be set differently for the top and bottom
bars if required.)

Utilization ratio
Apply (to
autodesign)

On
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Utilization ratio
• When an Autodesign is performed, the design will be

incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

All edges, Edge 1, Edge 2 etc.
Linear Uncheck in order to specify curved edges.
Curvature Defines the amount of curvature to all edges.

Only displayed when Linear is cleared.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

See also

Foundation mat properties (page 2120)

Foundation mat properties

General
Name The automatically generated name for the mat item.
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General
User Name Can be used to override the automatically generated name

if required.
Foundation
type

Mat

Rotation angle Specifies the orientation of reinforcement.

Different angles can be specified for different panels within
the mat.

See: Rotation angle for panels (page 1380)
Include in
diaphragm

If this option is cleared, the mat item does not participate in
diaphragm action. All nodes linked to the mat item will be
able to displace independently of the diaphragm.

Override slab
depth

By default all panels in a slab adopt the same depth.
Checking this option allows the selected panel to have a
different depth and vertical offset.

Vertical offset Only available when ‘Override slab depth’ is checked.

A positive offset raises the slab panel surface, a negative
offset drops it.

NOTE Vertical offsets are not structurally significant

Auto-design For panels in Auto-design mode, As,prov is increased until
either a pass is achieved or the limiting reinforcement
parameter limits have been exceeded.

For panels not in Autodesign mode, the result will be a pass
or fail.

Plane Indicates the level at which the mat is placed.

Slab general
Name The parent foundation mat name.
User Name Can be used to override the automatically generated name

if required.
Slab type Foundation mat
Deck type • Reinforced concrete

• Post tension

NOTE Design of post tensioned slabs is beyond scope in
the current release.

Decomposition Two-way
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Slab parameters
Slab properties
Overall depth Specifies the slab thickness.
Concrete type • Normal

• Lightweight
Grade/Concrete
class

Specifies the concrete grade.

Concrete
aggregate type

Specifies the aggregate type.

Concrete
density class

For normal weight concrete only, specifies the density class.

Dry density Specifies the dry concrete density
Wet density Specifies the wet concrete density
Diaphragm
option

Sets the default diaphragm action for all slab items within
the parent slab.

• Rigid

• Semi-rigid

• None
Design parameters (Head Code Eurocode)
Permanent load
ratio

You are required to supply a value for the permanent load
ratio parameter. A default of 0.65 has been assumed, but
you are advised to consider if this is appropriate and adjust
as necessary.

Maximum crack
width

• 0.2

• 0.3

• 0.4
Deflection parameters
Restraint
constant

See: Restraint constant (ACI) (page 1389)

Restraint type

(Eurocode only)

See: Restraint type (EC2) (page 1388)

Cement class

(Eurocode only)

See: Concrete Properties (Eurocode) (page 1390)

Soil parameters
Use Ground
Bearing Springs

Select to specify that the mat is ground bearing.

Allowable
Bearing
Pressure

The allowable bearing pressure is only required when the
‘Use Ground Bearing Springs’ option is selected.
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Slab parameters
Ground Stiffness The following properties are only displayed when the ‘Use
Ground Bearing Springs’ option is selected.
Type • Spring Linear

• Spring Non-Linear
Stiffness Only displayed when the Type is set to ‘Spring Linear’.
Stiffness -ve Only displayed when the Type is set to ‘Spring Non-Linear’.
Tension limit -
ve

Only displayed when the Type is set to ‘Spring Non-Linear’.

Stiffness +ve Only displayed when the Type is set to ‘Spring Non-Linear’.
Compression
limit +ve

Only displayed when the Type is set to ‘Spring Non-Linear’.

Horizontal
Support

• Fixed

• Free

• Spring
% of vertical
spring stiffness

This field is displayed when the Horizontal Support is set to
‘Spring’.

Live/Imposed load reduction
Reduce live/
imposed loads
by

This property is applicable for the design of transfer slabs
and mats.

Although the percentage of live load reduction is not
determined automatically, this property allows you to
specify the percentage manually.

It can be applied to an individual slab item - you don't have
to apply a single value throughout a slab or mat (this can be
important if you have discrete transfer panels within a large
slab area).

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

• The reduced results are used in slab design.

NOTE For mats, the bearing pressures are reduced as
well.
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Reinforcement
 Slabs panels can potentially have 4 layers of background

reinforcement, (however any of the layers/directions can be
set to “none” if required).

Select/clear Outside layer in X direction as appropriate to
indicate if the outside layer is in the X or Y direction. (The
outside layer can be set differently for the top and bottom
bars if required.)

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

All edges, Edge 1, Edge 2 etc.
Linear Uncheck in order to specify curved edges.
Curvature Defines the amount of curvature to all edges.

Only displayed when Linear is cleared.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)
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Slab/Mat overhang properties

General
LengthofBeam • When checked, the overhang is created by a single click

on a supporting beam along the the slab edge.

• When unchecked, the overhang is created by clicking
two points along the slab edge.

EdgeParallel • When checked, the overhang is created with a straight
edge.

• When unchecked, the overhang is created with a curved
edge.

Curvature Specifies the overhang curvature, (when EdgeParallel is
unchecked).

Tapered • When checked, the overhang varies in width. (Width1 to
Width2)

• When unchecked, the overhang is a constant width
(Width1).

Width1 The width at end 1 of the overhang.
Width2 The width at end 2 of the overhang, (when tapered).

Pad base strip base and pile cap properties

Property Description
General  
Foundation Type Isolated Pad Base (not editable).

Isolated Pile Cap (not editable).
Auto-design depth • When Autodesign is selected an

iterative procedure is used to
determine the depth. If the shear
design fails the depth is increased
until either the check passes, or the
maximum depth specified in Design
Options has been reached.

• When Autodesign is not selected (i.e.
check mode), the existing depth is
retained and Tekla Structural
Designer determines if it is sufficient.
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Property Description

NOTE In Design Options - if Isolated
Foundations have been set to
be designed using groups,
then if at least one base in
the group is set to have its
depth auto-designed the
whole group will have their
depth auto-designed.

NOTE When Design Member on the
right-click context menu is
used to design an individual
base, the depth will be
checked or designed
according to the auto-design
depth setting.

Auto-design size • When Autodesign is selected an
iterative procedure is used to
determine the base size. If the
bearing check fails the size is
increased until either the check
passes, or the maximum side length
specified in Design Options has been
reached.

• When Autodesign is not selected (i.e.
check mode), the existing size is
retained and Tekla Structural
Designer determines if it is sufficient.

NOTE In Design Options - if Isolated
Foundations have been set to
be designed using groups,
then if at least one base in
the group is set to have its
depth auto-designed the
whole group will have their
depth auto-designed.

NOTE When Design Member on the
right-click context menu is
used to design an individual
base, the size will be checked
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Property Description

or designed according to the
Auto-design size setting.

Auto-design piles

(Pile cap only)

Autodesign piles automatically
determines the quantity and size of
piles.

• Cleared - the specified number of
piles at their specified positions
will be checked during the design
process.

• Checked - the number of piles and
their positions under the pile cap
will automatically determined
during the design process.

When this check box is selected, the
actual procedure used will depend on
the Pile auto-design method that has
been specified in Design Options >
Concrete Foundations > Isolated
Foundations Piles

The Minimise number of piles
method commences by first selecting
the pile with the smallest load
capacity in the Pile Catalogue. Pile
positioning is attempted using the
user defined pile arrangements. If
one of the limitations is exceeded the
pile with the next smallest load
capacity in the catalogue is selected
and the process starts again. This is
repeated until the pile loading check
passes.

The Minimise pile capacity method
commences by first selecting the pile
with the smallest load capacity in the
Pile Catalogue. Pile positioning is
attempted using the user defined pile
arrangements. If one of the
limitations is exceeded one pile is
added to the pile group and the
process starts again. This is repeated
until the pile loading check passes.

Select size/depth starting from This option only appears when either
Autodesign depth or Autodesign size
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Property Description
is selected. It sets the autodesign
start point for the depth, or size, or
both.

The options are:

• Minima (default)

• Current

Selecting ‘Minima’ removes the
current depth/size and begins with
the minimum allowed depth/size
specified in Design Options.

For both options the auto-design
depth increment is that specified in
Design Options> Foundations Isolated
Foundations> Foundation Size

Autodesign reinforcement This setting applies to top and bottom
reinforcement, but reinforcement in
either location can still be set to none.

If enabled, auto-design of
reinforcement occurs after the base
size and depth have been established.

• When Autodesign reinforcement is
enabled an iterative procedure is
used to determine the
reinforcement. If the bending
design fails the reinforcement size
gets increased and spacing gets
decreased until these checks pass.
Iterations continue until either a
satisfactory bar configuration has
been achieved, or the maximum
bar size and minimum spacing
specified in Design Options has
been reached. At this point the
depth gets increased and the
above procedure is repeated.

NOTE If the smallest bar at
largest spacing is
insufficient then the next
bar size at max spacing is
used. If the largest bar is
reached the spacing gets
reduced and the smallest
bar is used. Then the bar
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Property Description
size gets increased until
the largest bar size
reached.

• When Autodesign reinforcement is
disabled (i.e. check mode), the
existing reinforcement provision is
retained and Tekla Structural
Designer determines if it is
sufficient.

NOTE In Design Options - if
Isolated Foundations have
been set to be designed
using groups, then if at
least one base in the
group is set to have its
depth auto-designed the
whole group will have
their reinforcement auto-
designed.

NOTE When Design Member on
the right-click context
menu is used to design an
individual base the
reinforcement is always
designed (irrespective of
the Autodesign
reinforcement setting).

Select bars starting from This option controls the starting point
for auto-design procedures and is
therefore only displayed if Autodesign
reinforcement is selected.

• Minima (default) - removes the
current arrangement and begins
with the minimum allowed bar
size specified in Design Options.

• Current - the auto design
commences from the current bar
arrangement.

Foundation Parameters  
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Property Description
Eccentricity in Y direction Specifies the eccentricity of the base

in the Y direction.

(For strip bases this is along the wall)
Eccentricity in X direction Specifies the eccentricity of the base

in the X direction.

(For strip bases this is across the wall)
Rotation angle Specifies the rotation of the base:

• Pad base: relative to that of the
support (which is controlled by the
rotation angle specified for
column).

• Strip base: the angle of the base
about global Z.

Shape

Pad base and pile cap only)

Specifies the base shape in plan:

• Square

• Rectangular
Length in Y direction (Pad base and
pile cap only)

Specifies the size of the pad in the Y
direction.

Length in X direction (Pad base and
pile cap only)

Specifies the size of the pad in the X
direction.

Width (Strip base only) Specifies the width of the base
Depth Specifies the depth of the base.
Concrete class The concrete grade.

The concrete grades that are available
are set from the Materials button on
the Home ribbon.

Use loaded area (Pad base only) Selecting this option allows you to
specify a user override of the
punching shear area - defined using
the Loaded Area Breadth and Loaded
Area Depth properties.

This feature can be used in both pad
bases and pile caps to, for example,
consider unmodeled base plates or
pedestals.

Sliding in Y prevented / Sliding in X
prevented (Pad base only)

If sliding is prevented by some other
means (e.g. if attached to a floor slab
in one or other direction) then this
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Property Description
can be indicated by selecting the
appropriate direction.

TIP If the direction is not clear make
the base non-rectangular so
that length in X and hence X-
direction is clearer.

Selecting this option sets the shear
force for the particular direction to
zero. This affects the sliding check,
but actually affects all checks because
there is no additional overturning
moment developed due to shear at
top of base.

Overturning about X prevented /
Overturning about Y prevented (Pad
base only)

This option only appears when the
Sliding in Y prevented / Sliding in X
preventedoption is selected. Selecting
this option indicates that overturning
is also prevented by some other
means for the selected direction,
which sets the support moment for
that direction to zero. This affects all
checks because there is no
overturning moment considered.

Permanent load ratio option
(Eurocode only)

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Maximum crack width • 0.2

• 0.3

• 0.4
Piles

(Pile cap only)

 

Pile type Pile types that have previously been
specified in the Pile Catalogue are
available for selection. You can
choose <New...> to add additional
types.

User defined arrangement Specifies the eccentricity of the pile
cap in the X direction.
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Property Description
Pile arrangement Opens the Pile arrangement dialog

for specifying the number of piles,
and spacing, pile type and principal
direction.

Number of piles Specifies the number of piles.
Principal direction Specifies the principal direction.
Pile spacing The dimension between pile centers.
Shape For three piles only, you can choose

to specify either a triangular. or
rectangular pile cap.

Reinforcement  
Type • Mesh

• Loose Bars

• None
Rib type (Head Code Eurocode, BS or
IS)

• Plain

• Type 1

• Type 2
Rib type (Head Code ACI) • Plain

• Deformed
Bar type The reinforcement grades that are

available here are set from the
Materials button on the Home ribbon.

Bar size, spacing, Mesh type etc. The actual reinforcement provided in
each of the layers is indicated here.

Top, Bottom, Side cover Nominal cover to reinforcement.
Soil Parameters  
Soil unit weight Soil unit weight
Characteristic friction angle Characteristic friction angle
Presumed bearing resistance (EC
Head Code)

The presumed bearing resistance is
only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is selected in
Design Options.

Surcharge  
Soil

Surcharge depth

Other permanent

Permanent surcharge load

Drop-list controls allow each
surcharge load to be assigned to a
specific load case.

The partial safety factors defined in
the design combinations for these
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Property Description
Other variable

Variable surcharge load

cases are then used for these loads in
all design calculations.

The assigned load cases are initially
set to “None” and must be user-
selected. Where no appropriate Dead
or Live load case exist in the model
and so no load case can be assigned,
zero partial factor values are used in
the calculations.

Design shear strength of soil angle
(ACI & BS Head Codes)

Design shear strength of soil angle

Allowable bearing capacity (ACI & BS
Head Codes)

Allowable bearing capacity

Bearing capacity A1 - STR (EC Head
Code)

Allowable bearing capacity A1.

Only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is unselected
in Design Options.

Bearing capacity A2 - GEO (EC Head
Code)

Allowable bearing capacity A2.

Only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is unselected
in Design Options.

UDA A customizable list of the attributes
that can be applied to individual
members and panels.

Bearing wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type Bearing Wall

NOTE Bearing walls must be rectangular in a vertical
plane.
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General
Material Type Choice of:

• Concrete

• Timber

• General
Assume extra
floors
supported

Enter the number of extra floors supported.

AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Concrete type While you can apply both normal and

lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Grade The grades available here are set
from the Materials button on the
Home ribbon.

NOTE The grade is only required to
specify the correct density to
be used in the wall self
weight calculation.

Thickness The thickness of the wall.
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All panels

NOTE The thickness is only required
for the wall self weight
calculation.

Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Wall support
Angles

(Fx/Fy/Fz,
Mx/My/Mz)

Used to specify the translational and rotational degrees of
freedom in which the support acts:

• Fixed - indicates the support is fixed in the specified
direction.

• Free - indicates the support is free to move, or has a
stiffness applied in the specified direction.

Translational
stiffnesses
(x/y/z)

Used to specify the translational stiffness applied in a
direction that is not fixed:

• Release

• Spring Linear

• Spring Non-linear
Rotational
stiffnesses
(x/y/z)

Used to specify the rotational stiffness applied in a direction
that is not fixed:

• Release

• Spring Linear

• Spring Non-linear

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.
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Count the floor as being supported
Top level

(Interediate
levels)

Base level

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Shear only wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type Shear Only Wall

NOTE Shear only walls must be rectangular in a vertical
plane.

Material Type Choice of:

• Concrete

• Timber
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General
• General

AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Grade The grades available here are set

from the Materials button on the
Home ribbon.

NOTE The grade is only required to
specify the correct density to
be used in the wall self
weight calculation.

Thickness The thickness of the wall.

NOTE The thickness is only required
for the wall self weight
calculation.

Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
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All panels
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Spring stiffness The stiffness to be used in the
analysis.

See: How shear only walls are
represented in solver models
(page 757)

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes
(page 1026)

Wall Panel Properties
Use theWall Panelproperties to view or modify the properties of a wall panel.

The  Wall Panel command is used to create a wall panel. Once created, the
panel properties can then be viewed or modified in the Properties Window:

Property Description
General  
Plane Describes the plane in which the panel was placed.
Rotation
angle

Describes the panel span direction as an angle, 0° is
horizontal and 90° is vertical.

Is a
parapet
wall

Check to indicate the panel is to be treated as a
parapet in the wind analysis.

See: Parapet wall panel load decomposition
(page 2139)

Ignore
local
moments
from
lareral
loading

This option is omly available when the “Is a parapet
wall” setting is selected. When checked, only a lateral
point load is applied to the top of a supporting
column.

See: Parapet wall panel load decomposition
(page 2139)
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Property Description
Gap Where the funneling gap to the adjacent building is not

consistent due to the shapes of the buildings it is up to
you to decide whether to specify the average or worst-
case gap. The default gap is 1000 m which effectively
give no funneling. A zero gap value explicitly means
ignore funneling, for example where this building and
the adjacent one are sheltered by upwind buildings.

Solidity If you indicate that the wall panel is a parapet, then
you also need to indicate the Solidity of the parapet.
(Walls that are not parapets automatically adopt a
solidarity of 1.0).

Status Indicates whether the panel is valid or not.
Decompo
se to

Loads can be set to be decomposed to:

• Members

• Nodes (Default)

• Rigid Diaphragms

NOTE The decompose to nodes option only applies
to those loads generated by the wind wizard.
It does not apply to those loads applied
directly to panels.

[+] UDA A customizable list of the attributes that can be
applied to individual members and panels.

Parapet wall panel load decomposition

For the special case of parapet wall panels spanning horizontally to parapet
posts supported by columns, the panel load is decomposed as a lateral point
load and point moment - which would be produced by a UDL on the post - to
the top of the supporting column.

In some circumstances the engineer may wish only the lateral load but not a
moment to be applied. This is catered for using the option “Ignore local
moments from lateral loading” which is available in the wind wall properties
only when the “Is a parapet wall” setting is checked on. When the “Ignore local
moments from lateral loading” setting is checked on, only a lateral point load
is applied to the top of a supporting column. No moment is applied.
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NOTE • The special decomposition of point loads - with or without a point
moment - to supporting columns only occurs when all the
following are true; the wind panel spans horizontally to parapet
posts, the “Is a parapet wall” setting is checked on for the wall
panel, the parapet post is supported by a column.

• In both the following cases a UDL will be decomposed to the
members onto which the parapet wind panel directly spans;

• The member supporting the parapet post is NOT a column.

• The member onto which the parapet wind panel spans is not a
parapet post (e.g. is an extended column or vertical beam).

Roof Panel Properties
Use the Roof Panel properties to view or modify the properties of a wall
panel.

The  Roof Panel command is used to create a roof panel. Once created, the
panel properties can then be viewed or modified in the Properties Window:

Property Description
General  
Plane Describes the level at which the panel was placed.
Rotation
angle

This value determines the following where appropriate:

• Span direction for 1-way load decomposition

• Orientation of semi-rigid 2D elements in the Solver Model
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Property Description
Include in
diaphragm

The options are:

• Checked

The roof panel is meshed to form a diaphragm of semi-rigid
2D elements.

• Unchecked (Default)

No diaphragm is defined on the roof panel.
Thickness Roof panel thickness

NOTE Only displayed if "Include in diaphragm" is checked

Youngs
Modulus

Youngs Modulus

NOTE Only displayed if "Include in diaphragm" is checked

Shear
Modulus

Shear Modulus

NOTE Only displayed if "Include in diaphragm" is checked

Temperatur
e coefficient

Temperature coefficient.

NOTE Only displayed if "Include in diaphragm" is checked

Divide
Stiffness by

Used to adjust the roof panel stiffness.

NOTE Only displayed if "Include in diaphragm" is checked

RoofType The options are:

• Default (Default)

• Flat

• Monopitch

• Duopitch

• Hip Gable

• Hip Main

• Mansard

NOTE The default option assigns the roof panel as flat (if the
slope < 5 deg) or Monopitch (if the slope is > 5 deg).
You can more accurately specify the roof panel by
choosing the appropriate option from the list.
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Property Description

NOTE If the RoofType is changed after the wind model has

already been established, you will need run 
Update Zones to reinstate the zoning.

[+] UDA Customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 1026)

Support properties
Use the Support properties to view or modify the properties of a support.

When a support is first created, it's properties are taken as those displayed in
the Properties window at that time.

You can either set the properties prior to placing the support, or select a
support in the model afterwards to review or modify its properties.

Property Description
General  
Name Automatically created name based on the grid point

location.

NOTE This property is only displayed when editing
an existing support

User Name You can enter a user name to replace the
automatically created name if required.

NOTE This property is only displayed when editing
an existing support

Plane Describes the level at which the support was placed.

NOTE This property is only displayed when editing
an existing support

3 Grid Points The options are:

• Checked

A user defined coordinate system is applied to the
support. (After clicking where you want to create
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Property Description
the support, the second click defines the x direction
and the third click defines the y direction.)

• Unchecked (Default)

Support properties are defined in accordance with
the global coordinate system.

NOTE This property is only displayed when creating a
new support

Fx, Fy, Fz The translational degrees of freedom can be set as
either Free, or Fixed in each direction.

Mx, My, Mz The rotational degrees of freedom can be set as either
Free, or Fixed in each direction.

Angles  
Inclination, Azimuth
and Rotation

When creating new supports, the angles are calculated
automatically depending on the placement method (3
Grid Points Checked/Unchecked).

When editing existing supports, the angles can be
edited in order to redefine the direction in which the
support acts.

Translational
stiffness x, y, and z

 

Type In order to define a translational spring in a particular
direction, the translational degree of freedom in the
same direction must first be set to Free. The available
types are:

• Release - (i.e. zero translational stiffness)

• Spring Linear

• Spring Non-linear
Stiffness The options are:

• Spring Linear

A single stiffness value is entered, which acts in
both the positive and negative directions.

• Spring Non-linear

Two stiffness values are entered, one to act in the
positive direction and a second to act in the
negative direction.

Fmax -ve and Fmax
+ve

For non-linear springs you are also able to define the
spring capacity in each direction. (Note that this must
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Property Description
always be entered as a positive value, for both +ve and
-ve directions).

Rotational stiffness
x, y, z

 

Type In order to define a rotational spring in a particular
direction, the rotational degree of freedom in the same
direction must first be set to Free. The available
options are:

• Release - (i.e. zero rotational stiffness)

• Spring Linear

• Spring Non-linear

• Nominally Pinned

• Nominally Free
Stiffness The options are:

• Spring Linear

A single stiffness value is entered, which acts in
both the positive and negative directions.

• Spring Non-linear

Two stiffness values are entered, one to act in the
positive direction and a second to act in the
negative direction.

Stiffness Percentage The options are:

• Nominally Pinned - 10%

(i.e. 10% * 4 EI/L)

• Nominally Fixed - 100%

(i.e. 100% * 4 EI/L)

NOTE In the above equations, L is the length from
the base of the column to the level of the next
column stack that is denoted as a floor, or it is
the distance to the top of the column if
shorter.

Fmax -ve and Fmax
+ve

For non-linear springs you are also able to define the
spring capacity in each direction. (Note that this must
always be entered as a positive value, for both +ve and
-ve directions).
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See also

Create supports (page 490)

Patch properties

General
Name The automatically generated name for the patch.
User Name Can be used to override the automatically generated name

if required.
Type • Column

• Beam

• Wall
Lx Specifies the size of the patch in the X direction.
Ly Specifies the size of the patch in the Y direction.
Associated Slab
Panel

Where a patch sits over more than one panel then an
automatic choice is made, but you are able to override this
if required by selecting one of the alternative panels from a
drop-down list.

Align to Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement is aligned with the background
reinforcement in the Associated Slab Panel.

Local X Angle The angle of the X axis reinforcement is only editable ifAlign
to Panel Reinforcement is cleared.

Surface Specifies the reinforcement to be associated with and
designed by the patch:

• Top or Bottom (cannot be both).
Autodesign This setting applies to all strips in both directions, but

reinforcement in either direction can still be set to none -
see below.

• Cleared - the specified reinforcement will be checked
during the design process.

• Checked - reinforcement will be designed during the
design process.

Select bars
starting from

This option controls the starting point for auto-design
procedures.

• Minima (default) - removes the current arrangement
and begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

Tekla Structural Designer reference 2145 Properties



General
Consider Strips This setting controls which strips are to be designed by the

patch.

• X

• Y

• X and Y
Consider patch
surface
moments only

Off (default)

• patch reinforcement is designed in the surface of the
slab at which the patch has been specified AND the slab
reinforcement is also checked in the opposite surface.

On

• patch reinforcement is designed in the surface of the
slab at which the patch has been specified, but the slab
reinforcement in the opposite surface is NOT checked.

NOTE The only situation when you might need to
activate this option is if the check of slab
reinforcement in the opposite surface fails but
another patch exists in the same location at that
face.(When the other patch is designed
additional reinforcement will be provided at that
surface, so this check is not required for the
original patch).

Strips in X, Strips in Y
Center, Left
and Right Strip

 

Width The left and right strip widths can be specified
independently: the center strip width is recalculated
accordingly and cannot be edited.

(By default the center strip covers half the panel, so that the
left and right strips each cover a quarter of the panel.)

Design Force • Average (of all the FE nodal values within the strip).

• Maximum (of all the FE nodal values within the strip).
Reinforcement  
Combine with
Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement takes into account any existing panel
reinforcement in the Associated Slab Panel that is in the
same alignment as the strip.

Cover as Panel When this check box is selected, the cover is set to be the
same as that in the Associated Slab Panel.
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Strips in X, Strips in Y
Outer Bar
Direction as
Panel

When this check box is selected, the outer bar direction is
set to be the same as that in the Associated Slab Panel.

When cleared, the outer bar direction can be set in X or Y.

Reinforcement
Combine with
Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement takes into account any existing panel
reinforcement in the Associated Slab Panel that is in the
same alignment as the strip.

Cover as Panel When this check box is selected, the cover is set to be the
same as that in the Associated Slab Panel.

Outer Bar
Direction as
Panel

When this check box is selected, the outer bar direction is
set to be the same as that in the Associated Slab Panel.

When cleared, the outer bar direction can be set in X or Y.
Reinforcement This setting is used to specify whether bars or mesh are to

be used in each direction.

• Mesh

• Bars XY

• Bars X

• Bars Y

• None

(If Mesh is selected an extra setting then allows you to
specify if main bars are in X or Y.)

Reinforcement in X, Reinforcement in Y, or Mesh
Bar Size,
spacing, Mesh
type etc.

The actual reinforcement provided in each of the strips is
indicated here.

Punching check properties

General
Tension
Reinforcement

This setting identifies the slab reinforcement to be used in
the punching check calculation.

• Top

• Bottom
Center The check location (not editable).
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General
Column Drop Indicates if the check considers a Column Drop (not

editable).
Beta - User limit

(Head Code
Eurocode)

When this check box is selected, a minimum value of Beta =
1.15 is applied to all internal columns.

User factor for
Vt

(Head Code BS)

When this check box is selected, the user factor for Vt is
applied.

u0 - user
reduction

Can be used to manually specify a reduction in the length of
the u0 perimeter to account for undefined openings.

u1 - user
reduction

Can be used to manually specify a reduction in the length of
the u1 perimeter to account for undefined openings.

Check Status
and Ratio

Indicates the status of the checks for each calculated
perimeter and the overall check ratio.

Loaded Perimeter
Length Indicates the length of the u0 Loaded Perimeter (not

editable).
Reduced length The reduced length of u0 after accounting for openings.
BEquiv, DEquiv,
BBound,
BBound,
Bounding
Perimeter

Refer to the Concrete Design Reference Guide for the
current Head Code for the appropriate definition of these
terms.

d Effective
Depth

Indicates the average effective depth to the tension
reinforcement (not editable).

d = (dy + dz) / 2

where dy and dz are the effective depths in the two
orthogonal directions.

There is a value of d for top steel and a different value for
bottom steel. Note this definition changes in the presence
of a drop panel.

This information is only available if the reinforcement is
known in each direction.

Slab Override When an override is applied the slabs in each direction can
be de-activated in the check. In this way the Loaded
Perimeter Position can be edited.

NOTE In the typical case of punching checks around a
column, the slab ‘y’ & ‘z’, ‘positive’ & ‘negative’ are
defined by the local axis system of the column. This
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Loaded Perimeter

can be displayed by displaying the Local Axes for
1D Elements in Scene Content.

Control Perimeter
Length Indicates the length of the u1 Control Perimeter (not

editable).
Reduced length The reduced length of u1 after accounting for openings.
[-] Design Input

(Head Code
Eurocode and
ACI)

 

Use
Reinforcement

Select this check box in order to apply a default punching
reinforcement arrangement that can then either be
checked, or used as the starting reinforcement for an auto-
design.

You would only choose to clear the check box when
specifying a new check if you want to perform an auto-
design but starting from Minima.

Reinforcement
type

In the current release only Stud reinforcement is
considered.

Arrangement
type

The options are:

• Orthogonal (default)

• Circular
Auto-design When run in Auto-design mode, the reinforcement is

increased until either a pass is achieved or the limiting
reinforcement parameter limits have been exceeded.

Select
reinforcement
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Auto-design is
‘on’.

• Minima - removes the current arrangement and begins
with the minimum allowed bar size.

• Current - auto-design commences from the current bar
arrangement.

Rib type Specifies the reinforcement rib type.
Grade The reinforcement grades that are available here are set

from the Materials button on the Home ribbon.
Bar size The reinforcement bar sizes that are available here are set

from the Materials button on the Home ribbon.
Spacing Defines the spacing between bars along each rail.
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Control Perimeter
Spacing from
column face

Defines the spacing of the first bar in each rail from the
column face.

Stud rails
spacing in Y
direction

Spacing between rails in the local Y direction.

Stud rails
spacing in Z
direction

Spacing between rails in the local Z direction.

Number of
diagonal stud
rails on one
corner

The number of stud rails adjacent to each corner of the
column.

(This property is only displayed when the ‘Arrangement
Type’ is Circular)

Number of
studs per
column face - Y
direction

The number of stud rails adjacent to the column face in the
local Y direction.

Number of
studs per
column face - Z
direction

The number of stud rails adjacent to the column face in the
local Z direction.

Number of
studs per rail

Number of studs on each rail.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 786)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).
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Design Input (Eurocode and ACI only)
Use
Reinforcement

Select this check box in order to apply a default punching
reinforcement arrangement that can then either be
checked, or used as the starting reinforcement for an auto-
design.

You would only choose to clear the check box when
specifying a new check if you want to perform an auto-
design but starting from Minima.

Reinforcement
type

In the current release only Stud reinforcement is
considered.

Arrangement
type

The options are:

• Orthogonal (default)

• Circular
Auto-design When run in Auto-design mode, the reinforcement is

increased until either a pass is achieved or the limiting
reinforcement parameter limits have been exceeded.

Select
reinforcement
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Auto-design is
‘on’.

• Minima - removes the current arrangement and begins
with the minimum allowed bar size.

• Current - auto-design commences from the current bar
arrangement.

Rib type Specifies the reinforcement rib type.
Grade The reinforcement grades that are available here are set

from the Materials button on the Home ribbon.
Bar size The reinforcement bar sizes that are available here are set

from the Materials button on the Home ribbon.
Spacing Defines the spacing between bars along each rail.
Spacing from
column face

Defines the spacing of the first bar in each rail from the
column face.

Stud rails
spacing in Y
direction

Spacing between rails in the local Y direction.

Stud rails
spacing in Z
direction

Spacing between rails in the local Z direction.

Number of
diagonal stud
rails on one
corner

The number of stud rails adjacent to each corner of the
column.

(This property is only displayed when the ‘Arrangement
Type’ is Circular)
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Design Input (Eurocode and ACI only)
Number of
studs per
column face - Y
direction

The number of stud rails adjacent to the column face in the
local Y direction.

Number of
studs per
column face - Z
direction

The number of stud rails adjacent to the column face in the
local Z direction.

Number of
studs per rail

Number of studs on each rail.

Result strip properties

General
Name The automatically generated name for the strip.
User Name Can be used to override the automatically generated name

if required.
  
Start Width The total strip width at the first point picked when creating

the strip.
End Width The total strip width at the second point picked when

creating the strip.
Result Type Determines how the strip result is calculated:

• Average

• Centreline

• Maximum
Number of
Stations

The number of stations per metre along the strip.

Number of
Points

The number of points per metre across the strip at each
station.

15.2 Ribbon commands
• Home ribbon (page 2217)

• BIM Integration ribbon (page 2207)

• Model ribbon (page 2222)
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• Edit ribbon (page 2211)

• Load ribbon (page 2218)

• Analyse ribbon (page 2203)

• Design ribbon (page 2208)

• Slab Deflection ribbon (page 2232)

• Foundations ribbon (page 2213)

• Report ribbon (page 2228)

• Draw ribbon (page 2211)

• Windows ribbon (page 2232)

Commands A - Z
A-Z listing of commands.

0-9

• 1st Order Linear - Runs a linear static analysis

• 1st Order Non-Linear - Runs a nonlinear analysis with loading applied in a
single step

• 1st Order RSA Seismic - Runs Modal Response Spectrum Analysis to
determine the peak response of the structure to earthquakes. Any
nonlinear springs or nonlinear elements present are constrained to act
linearly. For RSA Seismic Combinations, the peak responses are enveloped
around the static results for 1st Order Linear Analysis

• 1st Order Modal - Runs an unstressed modal analysis to determine the
structure's natural frequencies

• 2nd Order Linear - Runs a 2-stage P-Delta analysis

• 2nd Order Non-Linear - Runs a nonlinear analysis with loading applied in
a single step

• 2nd Order Buckling - Runs a linear buckling analysis to determine a
structure's susceptibility to buckling

• 2nd Order RSA Seismic - Runs Modal Response Spectrum Analysis to
determine the peak response of the structure to earthquakes. Any
nonlinear springs or nonlinear elements present are constrained to act
linearly. For RSA Seismic Combinations, the peak responses are enveloped
around the static results for 2nd Order Linear Analysis

• 3D DXF Import (page 2180) - Import a model from a 3D DXF File
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A

• ADAPT Export (page 2180) - Export a model to ADAPT

• Add Group (page 268)

• Analyse All - Performs a slab deflection analysis of all submodels
regardless of current view/selection

• Analyse All (Static) - Performs a full series of analyses that would be
carried out as part of 'Design All (Static)' but with no design. Includes all
relevant analyses. Analysis type (e.g. second-order non-linear) is the same
as set in the design settings

• Analyse Current - Performs a slab deflection analysis for the current sub
model

• Analyse Selected - Opens dialog allowing analysis of selected submodels.

• Area (page 2180) - Create a polygon area mat by selecting perimeter points
and including a defined overhang dimension

• Area Load (page 2180) - Applies an area load to any panel. Area loads
entirely cover an individual panel

• Autodesk Revit Export (page 2180) - Export the structural BIM model to
Autodesk Revit

B

• Bays (page 2180) - Create a mat by selecting bays bounded by grid lines

• Beam (page 2181) - Create a beam

• Beam End Forces - Create and save beam end forces drawing for an active
2D view for the currently selected loading

• Beam Lines (page 2181) - Joins existing concrete beams to make a
continuous concrete beam

• Beam Schedule - Configure and then create a concrete beam schedule for
members in an active 2D view

• Bearing Wall (page 2181) - Creates a bearing wall

• Brace (page 2181) - Create a brace

C

• Calalogue - Add and delete piles from your pile catalogue or edit their
properties (e.g. compression and tension capacity)

• Cellbeam Export (page 2181) - Export a beam to Westok Cellbeam

• Cellbeam Import (page 2181) - Import a beam from Westok Cellbeam
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• Check Floor Vibration (page 2181) - Perform all floor vibration checks in the
model

• Check Group (page 270)

• Check member (page 2238)

• Check model (page 2239)

• Check model patches (page 2239)

• Check panel (page 2240)

• Check plane (page 2240)

• Check plane patches (page 2241)

• Check plane slabs (page 2241)

• Check punching shear (page 2242)

• Check Punching Shear (panel) (page 804)

• Check member (page 2238)

• Check members (page 2239)

• Check model slabs (page 2240)

• Check sub structure

• Check sub structure slabs (page 797)

• Check wall (page 2246)

• Check walls (page 2247)

• Close - Close the model

• Cloud Export (page 2182) - Export the model to the cloud

• Column (page 2183) - Create a column

• Column Drop (page 2183) - Create a column drop

• Column Schedule - Configure and then create a concrete column schedule

• Column Splice Loads - Create and save steel column splice loads drawings
for an active 2D frame view for the currently selected loading

• Combination - Opens the Loading dialog at the Combinations page

• Construction Levels (page 2248) - Opens the Construction Levels dialog
(page 2402) allowing you to define the levels required in order to construct
your model

• Construction Line (page 2183) - Create a straight construction line between
two points

• Copy (page 2183) - Select items then copy

• Copy Loads (page 2182) - Copy between objects in the current case, or copy
from one case to another
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• Cores (page 2183) - Assign existing concrete members as part of a concrete
core

• Create Infills (page 2183) - Creates a pattern of infill members in the
selected bay

• Create new core (page 435)

• Create Sub Structure (page 1031)

• Create sub structure group (page 1034)

• Cutting Planes (page 2183) - Move/Activate/Deactivate planes to isolate a
smaller visible working area within the model

D

• Decomposition - Decompose loads from 1-way and 2-way slabs onto
supporting members.

• Decomposition (Wind Load) - Decompose the wind loads on to the
structure

• Deflection Checks - Opens the Slab Deflection Check Catalogue for
defining the default check requirements associated with Check Lines (also
associated with events)

• Delete (page 1033) - Delete Selected Items

• Delete Seismic - Delete all of the seismic data entered in the seismic
wizard along with the horizontal spectrum, seismic loadcases and seismic
load combinations

• Delete Snow - Deletes the snow model data previously defined using the
Snow Wizard

• Delete Wind - Deletes the wind model data previously defined using the
Wind Wizard

• Design All (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all members in the model based on
their individual 'auto-design' setting

• Design All (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all
members in the model based on their individual 'auto-design' setting

• Design All (RSA) (page 2185) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all
members in the model based on their individual 'auto-design' setting

• Design Concrete (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all concrete members in the model
based on their individual 'auto-design' setting

• Design Concrete (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all
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concrete members in the model based on their individual 'auto-design'
setting

• Design Concrete (RSA) (page 2184) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all
concrete members in the model based on their individual 'auto-design'
setting

• Design Connection (page 275)

• Design Group (page 270)

• Design Mats (page 2186) - Design ground bearing and piled mat
foundations for out-of-plane bending to all valid combinations based on
their individual 'auto-design' setting

• Design member (page 2248)

• Design members (page 2249)

• Design model (page 2250)

• Design model patches (page 2250)

• Design model slabs (page 2251)

• Design Pad Bases (page 2186) - Design pad bases to all valid combinations
based on their individual 'auto-design' settings

• Design panel (page 2251)

• Design Patches (page 2185) - Design slab patches for out-of-plane slab
bending to all valid combinations based on their individual 'auto-design'
setting

• Design Patches (page 2185) - Design slab patches for out-of-plane slab
bending to all valid combinations based on their individual 'auto-design'
setting

• Design Pile Caps (page 2186) - Design pile caps to all valid combinations
based on their individual 'auto-design' settings

• Design plane (page 2252)

• Design plane slabs (page 2253)

• Design plane patches (page 2252)

• Design Punching Shear (page 2185) - Check of all punching shear checks in
the model.

• Design Punching Shear (page 2185) - Perform a check or design (according
to individual autodesign settings) of all punching checks in the model

• Design punching shear (page 2253)

• Design Punching Shear (panel) (page 805)

• Design Slabs (page 2185) - Designs two-way concrete slabs for out-of-plane
bending to all valid combinations based on their individual 'auto-design'
setting
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• Design Steel (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all steel members in the model based
on their individual 'auto-design' setting

• Design Steel (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all steel
members in the model based on their individual 'auto-design' setting

• Design Steel (RSA) (page 2184) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all steel
members in the model based on their individual 'auto-design' setting

• Design sub structure (page 786)

• Design sub structure slabs (page 799)

• Design wall (page 2261)

• Design walls (page 2261)

• Dimension (page 2187) - Create dimensions between appropriate points
which can be included on drawings

• Dissociate (page 438)

• Drawing Management - Opens a dialog for the generation and laying out
of multiple drawings on to a single drawing sheet. The dialog can also be
used to manage drawing revisions

E

• Edit (page 275)

• Edit Footer - Open the document headers/footers dialog which can be
used to configure the layout and content of the page header and footers

• Edit Header - Open the document headers/footers dialog which can be
used to configure the layout and content of the page header and footers

• Element (page 2187) - Create analysis elements

• Envelope - Opens the Loading dialog at the Envelopes page

• Event Sequences - Submodel Event Sequences give access to override
aspects of the model event sequence on a submodel basis

• Export Connection to Tekla Connection Designer (page 275)

• Export Connection to IDEA StatiCa (page 345)

F

• Filters - Set up filters to be used when generating a new report

• Find (page 353) - Find and select objects by typing a part of their name
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• Foundation Layout - Create and save foundation layout drawing for an
active 2D view.

• Foundation Reactions - Create and save support reactions drawings for
an active 2D view for the currently selected loading

• Frame (page 2187) - Create a frame when in a 3D view (when a 2D view is
displayed, this is inactive). The drop list underneath can be used to delete
existing frames

• Free Points (page 2189) - Add, move, or delete points at specific co-
ordinates to facilitate creation of other objects.

• Full UDL (page 2189) - Applies a full length UDL load to members

G

• General Arrangement - Create and save general arrangement drawing for
an active 2D view

• Generate Detail Drawing... (page 976)

• Grid Line (page 2189) - Create a straight grid line between two points

• Groups Window - Open/close the groups tree window. Manage groups for
general design and reinforced concrete detailing. Review objects assigned
user defined attributes.

H, I, J

• Horizontal Spectrum - Display the horizontal spectrum generated by the
seismic wizard

• IFC Export (page 2189) - Export a physical representation of the structural
BIM model in IFC format

• Join (page 2189) - Joins members to make a longer continuous member

• Joist (page 2190) - Create a joist

L

• Level Load (page 2190) - Applies a level load to all slabs at the current level

• Line Load (page 2190) - Applies line load to any panel

• Loadcases - Opens the Loading dialog at the Loadcases page

• Load Groups - Opens the Loading dialog at the Groups page

• Loading Window - Open/close the loading tree window. This lists
loadcases and combinations in a hirearchical way, and allows to review and
delete applied loads and provides information and total load and reaction
summations for each load combination.
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• Loading Plan - Create and save loading information drawings for an active
2D view for the currently selected loading

• Local Drift Snow - Manually apply Local Drift Snow loads

M

• Mat Opening (page 2190) - Create an opening in a mat foundation

• Mat Overhang (page 2196) - Create an overhang at the edge of a mat

• Mat Split (page 2197) - Split mats into smaller panels for the purposes of
pattern loading and mat design

• Mat Join (page 2197) - Join mats to create larger panels for the purposes of
pattern loading and mat design

• Transfer property sets between models (page 1025) - Import, Export and
Delete property sets

• Manage View Configurations - Opens or deletes saved View
Configurations

• Measure (page 2190) - Measures the distance between any existing
construction points or intersection points

• Measure Angle (page 2190) - Measures angles between existing points in
2D Views

• Member Report - Create or edit the chapters and options (content) of
member reports

• Merge Planes (page 2190) - Merge two closely spaced planes

• Meshed Wall (page 2191) - Create a reinforced concrete shear wall
characterized analytically by a mesh of 2D solver elements located along
the wall insertion line and extending to all four corners

• Mesh Slabs - Slabs are meshed automatically for FE Load Decomposition,
FE Chasedown, and also if specified in the 3D Analysis. This command is
only used if you need to mesh slabs manually

• Mid-pier Wall (page 2192) - Create a reinforced concrete shear wall
characterized analytically by a single vertical pier object of identical
properties as the wall section, located at the centre of the wall and
extending from the top to the bottom level

• Minimum Area (page 2192) - Create a minimum polygon area mat under
selected objects (window to select all objects) including a defined overhang
dimension

• Mirror (page 2192) - Select items then mirror

• Model Report - Create or edit the chapters and options (content) of model
reports
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• Model Settings - Opens the Model Settings dialog (page 2422) to specify
settings for the current project

• Moment Load (page 2191) - Applies a Moment load to members

• Move (page 2191) - Select items then move

• Move Model (page 2191) - Moves the entire model to a new origin

• Move DXF Shadow (page 2191) - Move the dxf shadow to a new origin

N, O

• New (page 2192) - Create a new blank model

• Nodal Load (page 2192) - Applies a load to a node

• Open - Open a Tekla Structural Designer model

• Open view (page 2262)

• Open solver view (page 2262)

P

• Pad Base Column (page 2192) - Create a pad foundation under a column.
These can only be created at the column support node and are only valid
while both the member and the support exist

• Page Setup - Edit the paper size, orientation and margins

• Patch Column (page 2193) - Creates a localized slab reinforcement patch at
a slab-column connection

• Patch Load (page 2193) - Applies a patch load to any panel

• Perimeter Load (page 2193) - Applies a load around the external perimeter
of all slabs at a given level

• Pile (page 2193) - Create a pile under a mat foundation.

• Pile Array (page 2193) - Create a pile array under a mat foundation

• Pile Cap Column (page 2194) - Create a pile cap foundation under a
column. These can only be created at the column support node and are
only valid while both the member and the support exist

• Point Load (page 2194) - Applies a point load to any panel

• Polygon Load (page 2194) - Applies a polygonal load to any panel

• Point Load (page 2194)- Applies a Point load to members

• Portal Frame (page 2195) - Create a portal frame

• Process Window - Open/close the process window. This displays in a
sequence each step of the analysis and design of the model and their
statuses, as well as other useful information about program content.
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• Project - Wiki (page 2194) - Opens the Project Wiki dialog for recording
properties associated with the project

• Properties Window - Open/close the properties window. Input, review and
edit properties related to ribbon commands, tree view items and individual
or multiple objects selected in active views.

• Punching Check (page 2194) - Creates a punching check associated with the
punching object

R

• Rationalize (page 2195) - Open a dialog to remove unused grids, planes,
frames etc.

• Rectangular (page 2195) - Create a minimum rectangular area mat under
selected objects including a defined overhang dimension (window to select
all objects). Set the angle of the rectangle, or use absolute minimal area
option

• Regroup Members (page 268)

• Remove Group (page 270)

• Rename (page 1033)

• Rename Group (page 269)

• Renumber (page 999)

• Report Index - Open/close the report index window. This displays the
bookmarks for the active report view which can be used to locate and
display a specific section within it, and allows bookmarks to be easily
moved around the report.

• Reverse (page 2195) - Reverse Wall Panel Faces (inside becomes outside),
or Reverse Beam Directions

• Robot Export (page 2195) - Export the analysis model to Autodesk Robot

• Roof Panel (page 2196) - Create roof panels for distributing loads and/or
introducing diaphragm action

S

• Save - Save the model

• Save As - Saves the currently open model to a new name, or to a template

• Schedule Management - Opens a dialog for the generation of concrete
beam, column and wall schedules on drawing sheets. The dialog can also
be used to manage schedule revisions

• Scene Content - Open/close the scene content window. Manage by entity
the displayed content in the 2D and 3D scene views.
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• Seismic Wizard - Opens the Seismic wizard dialog for defining the
parameters required for determining the seismic loading and load cases on
the structure

• Select in visible views (page 2262)

• Set As Default Group (page 268)

• Settings (Design) - Opens the Design Settings dialog

• Settings (Drawing)- Opens the Drawing Settings dialog

• Settings (Report) - Change the report appearance

• Settings (Slab Deflection) - Open the slab deflection settings dialog

• Settlement Load (page 2196) - Applies a Settlement load (a translation or a
rotation) to a support.

• Show references... (page 2262)

• Show Report - Display the selected report style on the screen

• Simple Wind - Create a Simple Wind Load that will be applied to rigid
diaphragms

• Slab/Mat Detailing - Create and save slab or mat detailing drawings for an
active 2D view

• Slab Load (page 2196) - Applies a slab load to all slab panels that constitute
an individual slab.

• Slab on Beams (page 2196) - Create a slab

• Slab Opening (page 2196) - Create a rectangular or circular slab opening

• Slab Overhang (page 2196) - Create an overhang at the edge of a slab

• Slab Split (page 2197) - Split slab items into smaller panels for the purposes
of pattern loading and slab design

• Slab Join (page 2197) - Join slabs to create larger panels for the purposes of
pattern loading and slab design

• Sloped Plane (page 2197) - Create a sloped plane when in a 3D view (when
a 2D view is displayed, this is inactive). The droplist underneath can be
used to delete existing sloped planes

• Snow Wizard - Opens the Snow wizard dialog which is used to automate
snow loadcase generation

• Split (page 2198) - Splits existing continuous members

• Split Group (page 268)

• Strip (page 2198) - Create a strip of mat between selected points with a
defined width and end extension

• Strip Base Wall (page 2198) - Create a strip foundation under a concrete
shear wall. These can only be created at the supported level of the wall and
are only valid while the associated wall exists
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• Structural BIM Import (page 2198) - Import a model from a Neutral File

• STAAD Export (page 2198) - Export the analysis model to STAAD

• Status Window - Open/close the status tree window. This displays
information and statuses of modelling, stages of analyses, design and BIM.

• Structure Window - Open/close the structure tree window. This lists
structural and non-structural components present in the model grouped
by commonality in a hierarchical way, and allows for selective control over
objects in the structure.

• Support (page 2199) - Create additional supports underneath existing
members

T

• Tabular Data - Displays the analysis model data in spreadsheets for
review/editing

• TCD Export (page 2199) - Export connections to Tekla Connection Designer

• Tekla Structures Export (page 2199) - Export the structural BIM model to
Tekla Structures

• TEL File Import (page 2199) - Import a file that has been saved in the 'TEL'
file format.

• Temperature Load (page 2200) - Applies a temperature load (a global rise
in temperature) to individual elements/panels, selected elements/panels,
or to all elements/panels

• Torsion Full UDL (page 2201) - Applies a Torsion Full UDL to members

• Torsion UDL (page 2201) - Applies a Torsion UDL to members

• Torsion VDL (page 2201) - Applies a Torsion VDL to members.

• TPFD Export (page 2199) - Export portal frames to Tekla Portal Frame
Designer

• Trapezoidal Load (page 2201) - Applies a Trapezoidal load to members

• Truss (page 2200) - Runs the Truss Wizard to define a truss

U

• UDL (page 2201) - Applies a UDL load to members

• Uniform Snow - Manually apply Uniform Snow loads

• Update Connections (page 274)

• Update Patterns - If load patterns have been applied and the building
geometry or loading is subsequently modified, this command should be
run to ensure the load patterns reflect these changes
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• Update Snow Loads - Update Snow Loads

• Update Zones - Recalculates the zoning details

V, W

• Variable Patch Load (page 2202) - Applies variable patch load to any panel

• Variable Area Load (page 2202) - Applies a variable area load to any panel.
Area loads entirely cover an individual panel

• Vibration Check (page 2202)- Create a floor vibration check

• Walk (page 2203) - Walk through 3D views

• Wall Opening (page 2203) - Create a rectangular opening in an existing
meshed shear wall when in a Frame

• View

• Wall Panel (page 2202) - Create wall panels for distributing loads

• Wall Schedule - Configure and then create a concrete wall schedule

• Wind Loadcases - Opens the Wind Loadcases dialog for defining the
details of each wind loadcase

• Wind Window - Open/close the wind model tree window. This lists wind
directions and loadcases in a hierachical way, and offers information about
wind loadcases and pressure zone calculation status as well as control over
wind model directions.

• Wind Wizard - The Wind Wizard dialog is used for defining the information
that is required in order to calculate the wind loading on the structure

Ribbon commands
Descriptions of commands on the Ribbon.

Home tab

• New (page 2192) - Create a new blank model

• Open - Open a Tekla Structural Designer model

• Close - Close the model

• Save - Save the model

• Save As - Saves the currently open model to a new name, or to a template

• Project Wiki (page 2194) - Opens the Project Wiki dialog for recording
properties associated with the project

• Model Settings - Opens the Model Settings dialog (page 2422) to specify
settings for the current project
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• Transfer property sets between models (page 1025) - Import, Export and
Delete property sets

• Manage View Configurations - Opens or deletes saved View
Configurations

• Find (page 353) - Find and select objects by typing a part of their name

• Walk (page 2203) - Walk through 3D views

BIM Integration tab

• Structural BIM Import (page 2198) - Import a model from a Neutral File

• TEL File Import (page 2199) - Import a file that has been saved in the 'TEL'
file format

• 3D DXF Import (page 2180) - Import a model from a 3D DXF File

• Trimble Connect (page 2199) - Access Trimble's cloud-based project
collaboration tool

• Tekla Structures Export (page 2199) - Export the structural BIM model to
Tekla Structures

• TCD Export (page 2199) - Export connections to Tekla Connection Designer

• TPFD Export (page 2199) - Export portal frames to Tekla Portal Frame
Designer

• Autodesk Revit Export (page 2180) - Export the structural BIM model to
Autodesk Revit

• IFC Export (page 2189) - Export a physical representation of the structural
BIM model in IFC format

• Cellbeam Export (page 2181) - Export a beam to Westok Cellbeam

• Cellbeam Import (page 2181) - Import a beam from Westok Cellbeam

• FBEAM Export (page 330) - Export a beam to FBEAM

• FBEAM Import (page 330) - Import a beam from FBEAM

• ADAPT Export (page 2180) - Export a model to ADAPT

• STAAD Export (page 2198) - Export the analysis model to STAAD

• Robot Export (page 2195) - Export the analysis model to Autodesk Robot

• Cloud Export (page 2182) - Export the model to the cloud

Model tab

• Construction Levels (page 2248) - Opens the Construction Levels dialog
(page 2402) allowing you to define the levels required in order to construct
your model
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• Frame (page 2187) - Create a frame when in a 3D view (when a 2D view is
displayed, this is inactive). The drop list underneath can be used to delete
existing frames

• Sloped Plane (page 2197) - Create a sloped plane when in a 3D view (when
a 2D view is displayed, this is inactive). The droplist underneath can be
used to delete existing sloped planes

• Grid Line (page 2189) - Create a straight grid line between two points

• Construction Line (page 2183) - Create a straight construction line between
two points

• Column (page 2183) - Create a column

• Beam (page 2181) - Create a beam

• Brace (page 2181) - Create a brace

• Joist (page 2190) - Create a joist

• Truss (page 2200) - Runs the Truss Wizard to define a truss

• Portal Frame (page 2195) - Create a portal frame

• Meshed Wall (page 2191) - Create a reinforced concrete shear wall
characterized analytically by a mesh of 2D solver elements located along
the wall insertion line and extending to all four corners

• Mid-pier Wall (page 2192) - Create a reinforced concrete shear wall
characterized analytically by a single vertical pier object of identical
properties as the wall section, located at the centre of the wall and
extending from the top to the bottom level

• Wall Opening (page 2203) - Create a rectangular opening in an existing
meshed shear wall when in a Frame View

• Cores (page 2183) - Assign existing concrete members as part of a concrete
core

• Slab on Beams (page 2196) - Create a slab

• Slab Opening (page 2196) - Create a rectangular or circular slab opening

• Slab Overhang (page 2196) - Create an overhang at the edge of a slab

• Column Drop (page 2183) - Create a column drop

• Slab Split (page 2197) - Split slab items into smaller panels for the purposes
of pattern loading and slab design

• Slab Join (page 2197) - Join slabs to create larger panels for the purposes of
pattern loading and slab design

• Roof Panel (page 2196) - Create roof panels for distributing loads and/or
introducing diaphragm action

• Wall Panel (page 2202) - Create wall panels for distributing loads

• Support (page 2199) - Create additional supports underneath existing
members
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• Element (page 2187) - Create analysis elements

• Measure (page 2190) - Measures the distance between any existing
construction points or intersection points

• Measure Angle (page 2190) - Measures angles between existing points in
2D Views

• Dimension (page 2187) - Create dimensions between appropriate points
which can be included on drawings

• Bearing Wall (page 2181) - Creates a bearing wall

• Validate (page 2201) - Validate the structure for physical model issues.

Edit tab

• Copy (page 2183) - Select items then copy

• Copy Loads (page 2182) - Copy between objects in the current case, or copy
from one case to another

• Move (page 2191) - Select items then move

• Mirror (page 2192) - Select items then mirror

• Delete - Delete Selected Items

• Join (page 2189) - Joins members to make a longer continuous member

• Split (page 2198) - Splits existing continuous members

• Reverse (page 2195) - Reverse Wall Panel Faces (inside becomes outside),
or Reverse Beam Directions

• Beam Lines (page 2181) - Joins existing concrete beams to make a
continuous concrete beam

• Cutting Planes (page 2183) - Move/Activate/Deactivate planes to isolate a
smaller visible working area within the model

• Move Model (page 2191) - Moves the entire model to a new origin

• Rationalize (page 2195) - Open a dialog to remove unused grids, planes,
frames etc.

• Move DXF Shadow (page 2191) - Move the dxf shadow to a new origin

• Create Infills (page 2183) - Creates a pattern of infill members in the
selected bay

• Merge Planes (page 2190) - Merge two closely spaced planes

• Free Points (page 2189) - Add, move, or delete points at specific co-
ordinates to facilitate creation of other objects.
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Load tab

Structure

• Loadcases - Opens the Loading dialog at the Loadcases page

• Load Groups - Opens the Loading dialog at the Groups page

• Combination - Opens the Loading dialog at the Combinations page

• Envelope - Opens the Loading dialog at the Envelopes page

• Update Patterns - If load patterns have been applied and the building
geometry or loading is subsequently modified, this command should be
run to ensure the load patterns reflect these changes

Wind, Snow & Seismic

• Wind Wizard - The Wind Wizard dialog is used for defining the information
that is required in order to calculate the wind loading on the structure

• Update Zones - Recalculates the zoning details

• Wind Loadcases - Opens the Wind Loadcases dialog for defining the
details of each wind loadcase

• Delete Wind - Deletes the wind model data previously defined using the
Wind Wizard

• Decomposition (Wind Load) - Decompose the wind loads on to the
structure

• Simple Wind - Create a Simple Wind Load that will be applied to rigid
diaphragms

• Snow Wizard - Opens the Snow wizard dialog which is used to automate
snow loadcase generation

• Uniform Snow - Manually apply Uniform Snow loads

• Valley Snow - Manually apply Valley Snow loads

• Local Drift Snow - Manually apply Local Drift Snow loads

• Update Snow Loads - Update Snow Loads

• Delete Snow - Deletes the snow model data previously defined using the
Snow Wizard

• Seismic Wizard - Opens the Seismic wizard dialog for defining the
parameters required for determining the seismic loading and load cases on
the structure

• Horizontal Spectrum - Display the horizontal spectrum generated by the
seismic wizard

• Delete Seismic - Delete all of the seismic data entered in the seismic
wizard along with the horizontal spectrum, seismic loadcases and seismic
load combinations
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• Decomposition - Decompose loads from 1-way and 2-way slabs onto
supporting members.

Panel Loads

• Point Load (page 2194) - Applies a point load to any panel

• Line Load (page 2190) - Applies line load to any panel

• Patch Load (page 2193) - Applies a patch load to any panel

• Polygon Load (page 2194) - Applies a polygonal load to any panel

• Perimeter Load (page 2193) - Applies a load around the external perimeter
of all slabs at a given level

• Variable Patch Load (page 2202) - Applies variable patch load to any panel

• Area Load (page 2180) - Applies an area load to any panel. Area loads
entirely cover an individual panel

• Variable Area Load (page 2202) - Applies a variable area load to any panel.
Area loads entirely cover an individual panel

• Level Load (page 2190) - Applies a level load to all slabs at the current level

• Slab Load (page 2196) - Applies a slab load to all slab panels that constitute
an individual slab.

Member Loads

• Full UDL (page 2189) - Applies a full length UDL load to members

• UDL (page 2201) - Applies a UDL load to members

• VDL (page 2202) - Applies a VDL load to members

• Trapezoidal Load (page 2201) - Applies a Trapezoidal load to members

• Point Load (page 2194)- Applies a Point load to members

• Moment Load (page 2191) - Applies a Moment load to members

• Torsion Full UDL (page 2201) - Applies a Torsion Full UDL to members

• Torsion UDL (page 2201) - Applies a Torsion UDL to members

• Torsion VDL (page 2201) - Applies a Torsion VDL to members.

Structure Loads

• Diaphragm Load (page 547) - Applies a load to a rigid or semi-rigid
diaphragm

• Diaphragm Table (page 547) - Applies multiple diaphragm loads at multiple
levels

• Nodal Load (page 2192) - Applies a load to a node

• Temperature Load (page 2200) - Applies a temperature load (a global rise
in temperature) to individual elements/panels, selected elements/panels,
or to all elements/panels
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• Settlement Load (page 2196) - Applies a Settlement load (a translation or a
rotation) to a support.

Analyse tab

• 1st Order Linear (page 2178) - Runs a linear static analysis

• 1st Order Non-Linear (page 2178) - Runs a nonlinear analysis with loading
applied in a single step

• 1st Order Vibration (page 2178) - Runs an unstressed vibration analysis to
determine the structure's natural frequencies

• 2nd Order Linear (page 2179) - Runs a 2-stage P-Delta analysis

• 2nd Order Non-Linear (page 2179) - Runs a nonlinear analysis with loading
applied in a single step

• 2nd Order Buckling (page 2179) - Runs a linear buckling analysis to
determine a structure's susceptibility to buckling

• Analyze All (Static) (page 669) - Performs a full series of analyses that would
be carried out as part of 'Design All (Static)' but with no design. Includes all
relevant analyses. Analysis type (e.g. second-order non-linear) is the same
as set in the design settings

• 3D only (Static) (page 669) - Performs same analyses as 'Analyze All (Static)'
but excludes chasedowns. This can save time during scheme design, for
example while addressing overall stability, sway, drift, wind drift, etc.

• 1st Order RSA Seismic - Runs Modal Response Spectrum Analysis to
determine the peak response of the structure to earthquakes. Any
nonlinear springs or nonlinear elements present are constrained to act
linearly. For RSA Seismic Combinations, the peak responses are enveloped
around the static results for 1st Order Linear Analysis

• 2nd Order RSA Seismic - Runs Modal Response Spectrum Analysis to
determine the peak response of the structure to earthquakes. Any
nonlinear springs or nonlinear elements present are constrained to act
linearly. For RSA Seismic Combinations, the peak responses are enveloped
around the static results for 2nd Order Linear Analysis

• Model & Results - Displays the solver model data in spreadsheets for
review/editing

• Wind Tunnel - Displays the wind tunnel data tab, and wind model data in
spreadsheets for running modal analysis and reviewing the results

• Mesh Slabs - Slabs are meshed automatically for FE Load Decomposition,
FE Chasedown, and also if specified in the 3D Analysis. This command is
only used if you need to mesh slabs manually. After the operation the slab
mesh is automatically switched on in the scene content.
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Design tab

• Settings - Opens the Design Settings dialog

• Validate (page 2201) - Validates the model for design issues

• Design Steel (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all steel members in the model based
on their individual 'auto-design' setting

• Design Steel (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all steel
members in the model based on their individual 'auto-design' setting

• Design Steel (RSA) (page 2184) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all steel
members in the model based on their individual 'auto-design' setting

• Design Concrete (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all concrete members in the model
based on their individual 'auto-design' setting

• Design Concrete (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all
concrete members in the model based on their individual 'auto-design'
setting

• Design Concrete (RSA) (page 2184) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all
concrete members in the model based on their individual 'auto-design'
setting

• Design All (Gravity) (page 2184) - Performs an analysis for gravity
combinations only, and then designs all members in the model based on
their individual 'auto-design' setting

• Design All (Static) (page 2184) - Performs an analysis of all static
combinations (gravity, lateral, and ELF seismic), and then designs all
members in the model based on their individual 'auto-design' setting

• Design All (RSA) (page 2185) - Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF seismic), and then designs all
members in the model based on their individual 'auto-design' setting

• Design Slabs (page 2185) - Designs two-way concrete slabs for out-of-plane
bending to all valid combinations based on their individual 'auto-design'
setting

• Patch Column (page 2193) - Creates a localized slab reinforcement patch at
a slab-column connection

• Design Patches (page 2185) - Design slab patches for out-of-plane slab
bending to all valid combinations based on their individual 'auto-design'
setting

• Punching Check (page 2194) - Creates a punching check associated with the
punching object
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• Design Punching Shear (page 2185) - Perform a check or design (according
to individual autodesign settings) of all punching checks in the model

• Vibration Check (page 2202)- Create a floor vibration check

• Check Floor Vibration (page 2181) - Perform all floor vibration checks in the
model

• Check in Tedds (page 2182) - Checks all members where a linked Tedds
calculation has been created.

Slab Deflection tab

• Settings (Slab Deflection) - Open the slab deflection settings dialog

• Event Sequences - Submodel Event Sequences give access to override
aspects of the model event sequence on a submodel basis

• Deflection Checks - Opens the Slab Deflection Check Catalogue for
defining the default check requirements associated with Check Lines (also
associated with events)

• Analyse Current - Performs a slab deflection analysis for the current sub
model

• Analyse All - Performs a slab deflection analysis of all submodels
regardless of current view/selection

• Analyse Selected - Opens dialog allowing analysis of selected submodels.

Foundations tab

• Settings - Opens the Design Settings dialog

• Calalogue - Add and delete piles from your pile catalogue or edit their
properties (e.g. compression and tension capacity)

• Pad Base Column (page 2192) - Create a pad foundation under a column.
These can only be created at the column support node and are only valid
while both the member and the support exist

• Strip Base Wall (page 2198) - Create a strip foundation under a concrete
shear wall. These can only be created at the supported level of the wall and
are only valid while the associated wall exists

• Pile Cap Column (page 2194) - Create a pile cap foundation under a
column. These can only be created at the column support node and are
only valid while both the member and the support exist

• Design Pad Bases (page 2186) - Design pad bases to all valid combinations
based on their individual 'auto-design' settings

• Design Pile Caps (page 2186) - Design pile caps to all valid combinations
based on their individual 'auto-design' settings
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• Minimum Area (page 2192) - Create a minimum polygon area mat under
selected objects (window to select all objects) including a defined overhang
dimension

• Rectangular (page 2195) - Create a minimum rectangular area mat under
selected objects including a defined overhang dimension (window to select
all objects). Set the angle of the rectangle, or use absolute minimal area
option

• Strip (page 2198) - Create a strip of mat between selected points with a
defined width and end extension

• Area (page 2180) - Create a polygon area mat by selecting perimeter points
and including a defined overhang dimension

• Bays (page 2180) - Create a mat by selecting bays bounded by grid lines

• Mat Opening (page 2190) - Create an opening in a mat foundation

• Mat Overhang (page 2196) - Create an overhang at the edge of a mat

• Mat Split - Split mats into smaller panels for the purposes of pattern
loading and mat design

• Mat Join - Join mats to create larger panels for the purposes of pattern
loading and mat design

• Pile (page 2193) - Create a pile under a mat foundation.

• Pile Array (page 2193) - Create a pile array under a mat foundation

• Design Mats (page 2186) - Design ground bearing and piled mat
foundations for out-of-plane bending to all valid combinations based on
their individual 'auto-design' setting

• Design Patches (page 2185) - Design slab patches for out-of-plane slab
bending to all valid combinations based on their individual 'auto-design'
setting

• Punching Check (page 2194) - Creates a punching check associated with the
punching object

• Design Punching Shear (page 2185) - Check of all punching shear checks in
the model.

Report tab

• Model Report - Create or edit the chapters and options (content) of model
reports

• Member Report - Create or edit the chapters and options (content) of
member reports

• Show Report - Display the selected report style on the screen

• Filters - Set up filters to be used when generating a new report

• Settings - Change the report appearance
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• Page Setup - Edit the paper size, orientation and margins

• Edit Header - Open the document headers/footers dialog which can be
used to configure the layout and content of the page header and footers

• Edit Footer - Open the document headers/footers dialog which can be
used to configure the layout and content of the page header and footers

• Report Index - Display the report index window to allow you to jump to
specific chapters and options (content) within the report.

Draw tab

• Settings - Opens the Drawing Settings dialog

• Drawing Management - Opens a dialog for the generation and laying out
of multiple drawings on to a single drawing sheet. The dialog can also be
used to manage drawing revisions

• Schedule Management - Opens a dialog for the generation of concrete
beam, column and wall schedules on drawing sheets. The dialog can also
be used to manage schedule revisions

• Beam Schedule - Configure and then create a concrete beam schedule for
members in an active 2D view

• Column Schedule - Configure and then create a concrete column schedule

• Wall Schedule - Configure and then create a concrete wall schedule

• General Arrangement - Create and save general arrangement drawing for
an active 2D view

• Beam End Forces - Create and save beam end forces drawing for an active
2D view for the currently selected loading

• Column Splice Loads - Create and save steel column splice loads drawings
for an active 2D frame view for the currently selected loading

• Foundation Reactions - Create and save support reactions drawings for
an active 2D view for the currently selected loading

• Loading Plan - Create and save loading information drawings for an active
2D view for the currently selected loading

• Slab/Mat Detailing - Create and save slab or mat detailing drawings for an
active 2D view

• Foundation Layout - Create and save foundation layout drawing for an
active 2D view.

Windows tab

• Structure Window - Open/close the structure tree window. This lists
structural and non-structural components present in the model grouped
by commonality in a hierarchical way, and allows for selective control over
objects in the structure.
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• Groups Window - Open/close the groups tree window. Manage groups for
general design and reinforced concrete detailing. Review objects assigned
user defined attributes.

• Loading Window - Open/close the loading tree window. This lists
loadcases and combinations in a hirearchical way, and allows to review and
delete applied loads and provides information and total load and reaction
summations for each load combination.

• Report Index - Open/close the report index window. This displays the
bookmarks for the active report view which can be used to locate and
display a specific section within it, and allows bookmarks to be easily
moved around the report.

• Wind Window - Open/close the wind model tree window. This lists wind
directions and loadcases in a hierachical way, and offers information about
wind loadcases and pressure zone calculation status as well as control over
wind model directions.

• Status Window - Open/close the status tree window. This displays
information and statuses of modelling, stages of analyses, design and BIM.

• Properties Window - Open/close the properties window. Input, review and
edit properties related to ribbon commands, tree view items and individual
or multiple objects selected in active views.

• Scene Content - Open/close the scene content window. Manage by entity
the displayed content in the 2D and 3D scene views.

• Process Window - Open/close the process window. This displays in a
sequence each step of the analysis and design of the model and their
statuses, as well as other useful information about program content.

Review tab

• Type droplist - Filters status and ratio displays to show results for Static
designs, RSA designs or the Combined designs.

Design

• Status - Display member status.

• Ratio - Display member utilisation ratio.

• Depth Ratio - Display beam span to depth utilisation ratio.

Foundations

• Status - Display foundation status.

• Ratio - Display foundation utilisation ratio.

Piles

• Status - Display pile status.

• Ratio - Display pile utilisation ratio.
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Slab/Mat Design

• Status - Display slab/mat status.

• Ratio - Display slab/mat utilisation ratio.

• Slab/Mat droplist - Filters the status and ratio displays to show results for
the selected category.

• Status - Display connection status.

• Ratio - Display connection utilisation ratio.

Connections

• Status - Display connection status.

• Ratio - Display connection utilisation ratio.

Show/Alter State

• Auto/Check Design - Each member is color coded to indicate its
autodesign setting (On or Off). Clicking on a member toggles its setting.

• Diaphragm On/Off - Each slab panel and diaphragm node is color coded
to indicate its setting (Excluded or Included). Clicking on a slab or a
diaphragm node toggles its setting.

• Fixed/Pinned - Each member is color coded to indicate its end fixity setting
(N/A, Pinned, Fixed, Moment, Mixed, Cantilever). Clicking on a member
toggles its fixity setting between those that are applicable.

• BIM Status - Each member is color coded to indicate its BIM status.

• Slab Reinforcement - Use property grid to review and edit or rationalize
panel or patch reinforcement.

• Section Material/Grade - Each steel member is color coded to indicate its
section and grade. Clicking on a steel member updates its section and/or
grade to match what you have set in the Properties window.

• Copy Properties - Copy properties from one member to another. After
firstly selecting a parameter in the Properties window you are able to copy
it from a designated source member to valid target members.

• Report Filter - Only accessible once a Member filter has been defined.
Each member is color coded to indicate if it is included in the currently
selected filter. Clicking a member toggles its inclusion status.

• Sub Structures - Create selected sub-sets of the structure and use for
more focused editing, design, review and reporting purposes.

• Concrete Beam Flanges - Each concrete beam is color coded to indicate
its if flanges are considered and flange widths determined.

• Column Splices - Potential splice locations in steel columns are color
coded to indicate where splices exist.

• Property Sets - Graphically review and modify the property set assigned to
the elements by using the property grid. In a typical model you may wish to
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apply the same properties to similar model objects. This can be done
efficiently using property sets.

• UDA - Eraphically review and modify the attribute values assigned to the
elements by using the property grid. User defined attributes allow you to
save your own data to individual elements. These can be used to select
similar elements based upon their UDA group or filter report content
based on a UDA.

• Show/Alter State - The full range of options is available by selecting this
and using the attribute drop down in the property grid.

Design Data

• Tabular Data - Open the review data view in which all sorts of design
results and quantities information can be reviewed.

1st Order Linear (command)

Runs a linear static analysis.

This analysis type is suitable for structures where secondary effects are
negligible. Any nonlinear springs or nonlinear elements present are
constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: No

1st Order Non-linear (command)

Runs a nonlinear analysis with loading applied in a single step.

This analysis type is suitable for structures where secondary effects are
negligible and nonlinear springs/elements are present.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: Yes
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1st Order Modal (command)

Runs an unstressed modal analysis to determine the structure's natural
frequencies.

The structure is assumed to be in an unstressed state and nonlinear elements
are constrained to act linearly.

Nonlinearity Included:

• Geometric: No

• Material: No

2nd Order Buckling (command)

Runs a linear buckling analysis to determine a structure's susceptibility to
buckling.

The stressed state of the structure is determined from linear analysis;
therefore nonlinear elements are constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

2nd Order Linear (command)

Runs a 2-stage P-Delta analysis.

This analysis type is suitable for structures where secondary effects are of
comparable magnitude to primary effects. Any nonlinear springs or nonlinear
elements present are constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

2nd Order Non-linear (command)

Runs a nonlinear analysis with loading applied in a single step.

This analysis type is suitable for structures where secondary effects are of
comparable magnitude to primary effects and nonlinear springs/elements are
present.
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Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: Yes

3D DXF Import (command)

Import a model from a 3D DXF File.

See also:

• Import data from a 3D DXF file (page 308)

ADAPT Export (command)

Export a model to ADAPT.

See also:

• Export a model to ADAPT (page 335)

Area Load (command)

Applies an area load to any panel. Area loads entirely cover an individual
panel.

See also:

• Create area loads (page 543)

Area Mat (command)

Create a polygon area mat by selecting perimeter points and including a
defined overhang dimension.

See also:

• Create an area mat (page 843)

Autodesk Revit Export (command)

Export the structural BIM model to Autodesk Revit including synchronization
of model data if applicable.

See also:

• Export a model to Autodesk Revit Structure (page 327)
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Bays Mat (command)

Create a mat by selecting bays bounded by grid lines.

See also:

• Create a mat within bays (page 843)

Beam (command)

Create a rolled steel, concrete, timber, or cold formed beam.

Beam Lines (command)

Joins existing concrete beams to make a continuous concrete beam.

See also:

• Automatically join all concrete beams (page 505)

Bearing Wall (command)

Creates a wall which resists only axial forces and does not contribute to lateral
stability.

Brace (command)

Create a rolled steel, concrete, timber, or cold formed brace .

Cellbeam Export (command)

Export a beam to Westok Cellbeam

See also:

• Export to and import from Westok Cellbeam (page 329)

Cellbeam Import (command)

Import a beam from Westok Cellbeam

See also:

• Export to and import from Westok Cellbeam (page 329)

Check Floor Vibration (command)

Perform all floor vibration checks in the model.

See also:

• Check vibration for all floor vibration check items (page 809)
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Check in Tedds (command)

Command Description
Check in Tedds Located on the Design ribbon tab,

this command can be used after any
precast or timber members have
been initially designed. It is intended
for use where a general re-check for
all objects is required following
changes to the model which require a
reanalysis process (e.g. changing the
loading applied onto the model). The
command finds all members where a
linked Tekla Tedds calculation has
been created and performs a check
design for these members. This
command should ideally be used at
the end of the design cycle and
ensures that the previously designed
timber, or precast concrete elements
still meet the design criteria of the
model.

NOTE Check in Tedds does not
perform an analysis before
the check - it always uses the
latest existing set of analysis
results, (even if the analysis
status is 'Out of Date').

See also

Timber member design handbook (page 1564)

Precast member design handbook (page 1527)

Cloud Export (command)

Export to the Cloud.

See also:

• Export a model to the cloud (page 341)
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Copy Loads (command)

Copy between objects in the current case, or copy from one case to another.

See also:

• Copy loads (page 500)

Column (command)

Create a rolled steel, concrete, timber, or cold formed column.

Copy (command)

Select items then copy.

Selection can be filtered.

See also:

• Copy and rotate objects (page 495)

Column drop (command)

Create a column drop.

See also:

• Create column drops (page 459)

Construction Line (command)

Create a straight construction line between two points.

See also:

• Create and manage architectural grids and grid lines (page 370)

Cores (command)

Assign existing concrete members as part of a concrete core.

Cutting Planes (command)

Move/Activate/Deactivate planes to isolate a smaller visible working area
within the model.

See also:

• Manage cutting planes (page 507)
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Create Infills (command)

Creates a pattern of infill members in the selected bay.

See also:

• Create infill members (page 509)

Design Steel Gravity (command)

Performs an analysis for gravity combinations only, and then designs all steel
members in the model based on their individual 'auto-design' setting.

Design Steel Static (command)

Performs an analysis of all static combinations (gravity, lateral, and ELF
seismic), and then designs all steel members in the model based on their
individual 'auto-design' setting.

Design Steel RSA (command)

Performs an analysis of all RSA load combinations (gravity, lateral, and ELF
seismic), and then designs all steel members in the model based on their
individual 'auto-design' setting.

Design Concrete Gravity (command)

Performs an analysis for gravity combinations only, and then designs all
concrete members in the model based on their individual 'auto-design' setting.

Design Concrete Static (command)

Performs an analysis of all static combinations (gravity, lateral, and ELF
seismic), and then designs all concrete members in the model based on their
individual 'auto-design' setting.

Design Concrete RSA (command)

Performs an analysis of all RSA load combinations (gravity, lateral, and ELF
seismic), and then designs all concrete members in the model based on their
individual 'auto-design' setting.

Design All Gravity (command)

Performs an analysis for gravity combinations only, and then designs all
members in the model based on their individual 'auto-design' setting.
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Design All Static (command)

Performs an analysis of all static combinations (gravity, lateral, and ELF
seismic), and then designs all members in the model based on their individual
'auto-design' setting.

Design All RSA (command)

Performs an analysis of all RSA load combinations (gravity, lateral, and ELF
seismic), and then designs all members in the model based on their individual
'auto-design' setting.

Design Slabs (command)

Designs two-way concrete slabs for out-of-plane bending to all valid
combinations based on their individual 'auto-design' setting.

NOTE Design Slabs does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

Design Patches (command)

Design slab patches for out-of-plane slab bending to all valid combinations
based on their individual 'auto-design' setting.

NOTE Design Patches does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also:

• Design or check all patches in the model (page 800)

Design Punching Shear (command)

Depending on how it is accessed, this command will:

• Perform a check or design (according to individual autodesign settings) of
all punching checks in the model.

• Perform a check or design (according to individual autodesign settings) of
all punching checks in a level.

• Perform a check or design (according to individual autodesign settings) of
an individual punching shear check.
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NOTE Design Punching Shear does not perform an analysis before the
check - it always uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Design Mats (command)

Design ground bearing and piled mat foundations for out-of-plane bending to
all valid combinations based on their individual 'auto-design' setting.

NOTE Design Mats does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also:

• Design or check all mats in the model (page 846)

Design Pad Bases (command)

Design pad bases to all valid combinations based on their individual 'auto-
design' settings.

NOTE Design Pad Bases does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also:

• Design or check all pad bases and strip bases (page 840)

Design Pile Caps (command)

Design pile caps to all valid combinations based on their individual 'auto-
design' settings.

NOTE Design Pile Caps does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also:

• Design or check all pile caps (page 840)
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Diaphragm Load (command)

Applies a point load in Building Direction 1 and 2 and a torsion load at any
position within a rigid or semi-rigid diaphragm.

NOTE Diaphragm loads can only be applied in 2D views (not 3D)

Property Description
F, Dir 1 Point load in Building Direction 1
F, Dir 2 Point load in Building Direction 2
Mz Torsion load about Global Z
X Distance from origin in Global X
Y Distance from origin in Global Y

See also:

• Add a diaphragm load in a 2D view (page 547)

Dimension (command)

Create dimensions between appropriate points which can be included on
drawings.

Element (command)

Create analysis elements.

Frame (command)

Create a frame when in a 3D view (when a 2D view is displayed, this is
inactive). The drop list underneath can be used to delete existing frames.

Only those members that lie within the plane of the frame are displayed.

See also:

• Create a frame (page 386)
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Find (command)

Find and then select objects in the model by typing a part of their name.

Setting Description
Find In the Find box you can type any of the following, in whole, or in

part:

• An object 'Type'

• An object 'Name'

• An object 'Index'

As you type, any objects that match the criteria are listed in the
table below.

When the object(s) that you require are shown, click to highlight
them as follows:

• Single click to highlight a single object

• Ctrl+click to select multiple non-sequential rows

• Shift+click to select multiple sequential rows
Select Once the object(s) are highlighted, Select becomes available.

Click Select to zoom in and locate the object in the active view.

If the object doesn't exist in the active view a new view containing
the object will become active.

Ghost
unselecte
d

When clicking Select, it can be easy for the object being located
to be obscured from view by other objects. By leaving Ghost
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Setting Description
unselected checked this is avoided as all objects, other than
those being found are made semi-transparent.

Cutting
plane

Having clicked Select if you want to make the located object yet
easier to see, you can check the Cutting plane option. This
automatically applies a cutting plane perpendicular to the current
point of view which removes everything in the foreground of the
object(s) that have been located.

See also:

• Select using Find (page 353)

Free Points (command)

Add, move, or delete points at specific co-ordinates to facilitate creation of
other objects.

See also:

• Create and manage free points (page 511)

Full UDL (command)

Applies a full length UDL load to members.

See also:

• Create full-length UDLs (page 544)

Grid Line (command)

Create a straight grid line between two points.

See also:

• Create and manage architectural grids and grid lines (page 370)

IFC Export (command)

Export a physical representation of the structural BIM model in IFC format for
use in other products.

See also:

• Export a model to IFC (page 328)
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Join (command)

Joins members to make a longer continuous member.

See also:

• Join and split members (page 504)

Joist (command)

Create a joist.

Level Load (command)

Applies a level load to all slabs at the current level.

See also:

• Create level loads (page 543)

Line Load (command)

Applies line load to any panel.

NOTE Point Loads and Line loads can only be applied in 2D views (not 3D)

See also:

• Create line loads (page 539)

Mat Opening (command)

Create an opening in a mat foundation.

Active in 2D views.

See also:

• Create slab or mat openings (page 455)

Measure (command)

Measures the distance between any existing construction points or
intersection points.

Measure Angle (command)

Measures angles between existing points in 2D Views.
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Merge Planes (command)

Merge two closely spaced planes. Where possible, everything on the source
plane is moved to the destination plane.

See also:

• Merge planes (page 511)

Meshed Wall (command)

Create a reinforced concrete shear wall characterized analytically by a mesh of
2D solver elements located along the wall insertion line and extending to all
four corners. Non-rectangular and sloping wall geometry is allowed as well as
openings.

The type of 2D solver elements used is controlled from the structure
properties and can be overriden on a wall by wall basis in the individual wall
properties.

Moment Load (command)

Applies a Moment load to members.

See also:

• Create point loads and moment loads (page 545)

Move (command)

Select items then move.

Selection can be filtered.

See also:

• Move and rotate objects (page 495)

Move DXF Shadow (command)

Move the dxf shadow to a new origin.

See also:

• Move the model or the DXF shadow (page 508)

Move Model (command)

Moves the entire model to a new origin.

See also:

• Move the model or the DXF shadow (page 508)
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Mid-pier Wall (command)

Create a reinforced concrete shear wall characterized analytically by a single
vertical pier object of identical properties as the wall section, located at the
centre of the wall and extending from the top to the bottom level.

Mid-pier concrete shear wall restrictions:

• must be rectangular

• must be in a vertical plane

• openings are not allowed

Mirror (command)

Select items then mirror.

Selection can be filtered.

See also:

• Mirror objects to new locations (page 496)

Minimum Area Mat (command)

Create a minimum polygon area mat under selected objects (window to select
all objects) including a defined overhang dimension.

See also:

• Create a minimum area or rectangular mat (page 842)

New (command)

FROM ICON: Create a new blank project from scratch.

FROM DROPDOWN: Create a new project based on an existing template.

See also:

• Start a new project (page 243)

Nodal Load (command)

Applies a load to a node.

See also:

• Create nodal loads (page 554)
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Pad Base Column (command)

Create a pad foundation under a column. These can only be created at the
column support node and are only valid while both the member and the
support exist.

See also:

• Create pad base columns (page 836)

Patch Column (command)

Creates a localized slab reinforcement patch at a slab-column connection.

Defaults to top surface of slab.

See also:

• Create column patches (page 790)

Patch Load (command)

Applies a patch load to any panel.

NOTE Patch Loads can only be applied in 2D views (not 3D)

See also:

• Create patch loads (page 540)

Perimeter Load (command)

Applies a load around the external perimeter of all slabs at a given level .

See also:

• Create perimeter loads (page 541)

Pile (command)

Create a pile under a mat foundation.

See also:

• Place piles and pile arrays in mats (page 844)

Pile Array (command)

Create a pile array under a mat foundation.

See also:

• Place piles and pile arrays in mats (page 844)
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Pile Cap Column (command)

Create a pile cap foundation under a column. These can only be created at the
column support node and are only valid while both the member and the
support exist.

See also:

• Create pile caps (page 838)

Point Load [Member] (command)

Applies a Point load to members.

See also:

• Create point loads and moment loads (page 545)

Point Load [Panel] (command)

Applies a point load to any panel.

NOTE Point Loads and Line loads can only be applied in 2D views (not 3D)

See also:

• Create point loads (page 539)

Polygon Load (command)

Applies a polygonal load to any panel.

NOTE Polygon Loads can only be applied in 2D views (not 3D)

See also:

• Create polygonal loads (page 540)

Punching Check (command)

Creates a punching check associated with the punching object.

Project Wiki (command)

Opens the Project Wiki dialog which is used to record miscellaneous
properties associated with the project, and to record revisions.

See also:

• Modify project details (page 244)
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Portal Frame (command)

Create a portal frame.

To create the frame, you firstly define the two column base positions between
which the frame will lie. The base positions are restricted to lie on existing grid
points.

All other details of the portal frame are subsequently entered in the Portal
Frame dialog.

See also:

• Create portal frames (page 467)

Rationalize (command)

Open a dialog which allows you to:

• Remove unused sloped planes and frames

• Remove unused grid lines

• Remove unused construction lines

• Update all grid and construction lines to extend a short distance beyond
the point they are required

See also:

• Rationalize the model (page 509)

Rectangular Mat (command)

Create a minimum rectangular area mat under selected objects including a
defined overhang dimension (window to select all objects). Set the angle of the
rectangle, or use absolute minimal area option.

See also:

• Create a minimum area or rectangular mat (page 842)

Reverse (command)

Reverse Wall Panel Faces (inside becomes outside), or Reverse Beam
Directions.

See also:

• Reverse member axes and panel faces (page 506)
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Robot Export (command)

Export the analysis model to Autodesk Robot.

See also:

• Export a model to Autodesk Robot Structural Analysis (page 340)

Roof Panel (command)

Create roof panels for distributing loads and/or introducing diaphragm action.

Settlement Load (command)

Applies a Settlement load (a translation or a rotation) to a support.

See also:

• Create settlement loads (page 554)

Slab on Beams (command)

Create a slab on beams.

Slab Load (command)

Applies a slab load to all slab panels that constitute an individual slab.

See also:

• Create slab loads (page 543)

Slab/Mat Opening (command)

Create a rectangular or circular slab/mat opening.

Active in 2D views.

See also:

• Create slab or mat openings (page 455)

Slab/Mat Overhang (command)

Create an overhang at the edge of a slab.

Active in 2D views.

Command Properties
LengthofBeam • When checked, the overhang is created by a single click

on a supporting beam along the the slab edge.
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Command Properties
• When unchecked, the overhang is created by clicking

two points along the slab edge.
EdgeParallel • When checked, the overhang is created with a straight

edge.

• When unchecked, the overhang is created with a curved
edge.

Curvature Specifies the overhang curvature, (when EdgeParallel is
unchecked).

Tapered • When checked, the overhang varies in width. (Width1 to
Width2)

• When unchecked, the overhang is a constant width
(Width1).

Width1 The width at end 1 of the overhang.
Width2 The width at end 2 of the overhang, (when tapered).

See also:

• Add overhangs to existing slab or mat edges (page 457)

Slab/Mat Split (command)

Split slab items/mats into smaller panels for the purposes of pattern loading
and slab/mat design.

Active in 2D views.

See also:

• Split and join slabs and mats (page 462)

Slab/Mat Join (command)

Join slabs/mats to create larger panels for the purposes of pattern loading and
slab/mat design.

Active in 2D views.

See also:

• Split and join slabs and mats (page 462)
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Sloped Plane (command)

Create a sloped plane when in a 3D view (when a 2D view is displayed, this is
inactive). The droplist underneath can be used to delete existing sloped
planes.

A sloped plane is a 2D View of the model created in a sloped plane. It is
defined by selecting 3 existing grid points.

Because only those members that lie within the plane of the slope are
displayed, this type of view can be particularly useful for defining inclined
roofs and ramps.

See also:

• Create a slope (page 387)

Split (command)

Splits existing continuous members.

See also:

• Join and split members (page 504)

STAAD Export (command)

Export the analysis model to STAAD.

See also:

• Export a model to STAAD (page 339)

Strip Base Wall (command)

Create a strip foundation under a concrete shear wall. These can only be
created at the supported level of the wall and are only valid while the
associated wall exists.

See also:

• Create strip base walls (page 837)

Strip Mat (command)

Create a strip of mat between selected points with a defined width and end
extension

See also:

• Create a strip mat (page 843)
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Structural BIM Import (command)

Import a model from a Neutral File. (.cxl)

See also:

• Import a project from a Structural BIM Import file (page 301)

Support (command)

Create additional supports underneath existing members.

TCD Export (command)

Export connections to Tekla Connection Designer.

See also:

• Export to Tekla Connection Designer (page 318)

Tekla Structures Export (command)

Export the structural BIM model to Tekla Structures including synchronization
of model data if applicable.

See also:

• Export a model to Tekla Structures (page 318)

TEL File Import (command)

Create a design model by importing a file that has been saved in the 'TEL' file
format.

See also:

• Import a project from a TEL file (page 302)

TPFD Export (command)

Export portal frames to Tekla Portal Frame Designer.

See also:

• Export to Tekla Portal Frame Designer (page 319)
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Trimble Connect (command)

The Trimble Connect droplist on the BIM Integration tab gives a choice of 3
options:

• Trimble Connect: This opens the Trimble Connect Project Explorer, a dialog
that controls the flow of information between the Tekla Structural Designer
model and the Trimble Connect project.

NOTE Once opened, the Trimble Connect Project Explorer can either be
docked, or auto-hidden to a tab on the right of the interface as
required.

• Trimble Connect Web: This launches the in-browser web app. If the open
model is associated with a Trimble Connect project, the project itself is
opened, otherwise a default Trimble Connect page is opened.

• Trimble Connect for Windows: This launches the Windows application.
Again, if the open model is associated with a Trimble Connect project then
that project is opened.

NOTE The Tekla Structural Designer model can only be attached to a Trimble
Connect project from the Trimble Connect Project Explorer, and not
from the web or Windows apps. The model must be attached before
any information can move between Tekla Structural Designer and
Trimble Connect.

See also:

• Working collaboratively with Trimble Connect (page 310)

Truss (command)

Runs the Truss Wizard to define a steel, timber, or cold formed truss
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Temperature Load (command)

Create temperature loads on the model.

See also:

• Create temperature loads (page 554)

Torsion Full UDL (command)

Applies a Torsion Full UDL to members.

See also:

• Create full-length torsional UDLs (page 545)

Torsion UDL (command)

Applies a partial length Torsion UDL to members.

See also:

• Create partial-length torsional UDLs and VDLS (page 546)

Torsion VDL (command)

Applies a partial length Torsion VDL to members.

See also:

• Create partial-length torsional UDLs and VDLS (page 546)

Trapezoidal Load (command)

Applies a Trapezoidal load to members.

See also:

• Create trapezoidal loads (page 545)

UDL (command)

Applies a partial length UDL load to members.

See also:

• Create partial-length UDLs or VDLs (page 544)
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Validate (command)

Depending on the tab from which it has been run, this command will validate
the structure for:

• Physical model and design issues - if run from the Model tab, or the Quick
Access Toolbar.

• Design issues only - if run from the Design tab.

To see the results go to the Project Workspace and select Status > Validation

See also:

• Validate the model (page 512)

Variable Area Load (command)

Applies a variable area load to any panel. Area loads entirely cover an
individual panel.

See also:

• Create variable area loads (page 543)

Variable Patch Load (command)

Applies variable patch load to any panel.

NOTE Variable Patch Loads can only be applied in 2D views (not 3D)

See also:

• Create variable patch loads (page 542)

VDL (command)

Applies a partial length VDL load to members.

See also:

• Create partial-length UDLs or VDLs (page 544)

Vibration Check (command)

Create a floor vibration check.

See also:

• Create floor vibration check items (page 806)

Tekla Structural Designer reference 2202 Ribbon commands



Wall Panel (command)

Create wall panels for distributing loads.

Walk

Walk through 3D views.

Use the arrow keys to move back/forward/left/right.

Use Q/Z to move up/down.

To rotate click and drag the right mouse button.

See also:

• Walk through the model in a 3D view (page 350)

Wall Opening (command)

Creates a rectangular opening in an existing meshed shear wall when in a
Frame View. (Wall Opening is inactive in 3D Views and Level Views).

See also:

• Create door or window openings (page 432)

Shear Only Wall (command)

Creates a wall which resists only in-plane shear and has no out of plane
stiffness or load bearing resistance.

Analyse ribbon

Command Description
1st Order Linear - Runs a linear static analysis.

This analysis type is suitable for
structures where secondary effects
are negligible. Any nonlinear springs
or nonlinear elements present are
constrained to act linearly.

Loadcases and Combinations to be
considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No
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Command Description
• Material: No

See also: Run 1st order linear analysis
(page 664)

1st Order Non-linear - Runs a nonlinear analysis with
loading applied in a single step.

This analysis type is suitable for
structures where secondary effects
are negligible and nonlinear springs/
elements are present.

Loadcases and Combinations to be
considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: Yes

See also: Run a 1st order non-linear
analysis (page 665)

1st Order Modal Runs an unstressed modal analysis to
determine the structure's natural
frequencies.

The structure is assumed to be in an
unstressed state and nonlinear
elements are constrained to act
linearly.

Nonlinearity Included:

• Geometric: No

• Material: No

See also: Run a 1st order modal
analysis (page 665)

2nd Order Linear - Runs a 2-stage P-Delta analysis.

This analysis type is suitable for
structures where secondary effects
are of comparable magnitude to
primary effects. Any nonlinear springs
or nonlinear elements present are
constrained to act linearly.

Loadcases and Combinations to be
considered in the analysis can be pre-
selected.

Nonlinearity Included:
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Command Description
• Geometric: Yes

• Material: No

See also: Run a 2nd order linear
analysis (page 666)

2nd Order Non-linear - Runs a nonlinear analysis with
loading applied in a single step.

This analysis type is suitable for
structures where secondary effects
are of comparable magnitude to
primary effects and nonlinear
springs/elements are present.

Loadcases and Combinations to be
considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: Yes

See also: Run a 2nd order non-linear
analysis (page 666)

2nd Order Buckling - Runs a linear buckling analysis to
determine a structure's susceptibility
to buckling.

The stressed state of the structure is
determined from linear analysis;
therefore nonlinear elements are
constrained to act linearly.

Loadcases and Combinations to be
considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

See also: Run a 2nd order buckling
analysis (page 666)

Analyze All (Static) - Performs a full series of analyses
that would be carried out as part of
'Design All (Static)' but with no design.
Includes all relevant analyses.
Analysis type (e.g. second-order non-
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Command Description
linear) is the same as set in the design
settings.

See also: Run Analyze All (Static)
(page 669)

3D only (Static) - Performs same analyses as 'Analyze
All (Static)' but excludes chasedowns.
This can save time during scheme
design, for example while addressing
overall stability, sway, drift, wind drift,
etc.

See also: Run 3D only (Static)
(page 669)

1st Order RSA Seismic - Runs Modal Response Spectrum
Analysis to determine the peak
response of the structure to
earthquakes. Any nonlinear springs or
nonlinear elements present are
constrained to act linearly. For RSA
Seismic Combinations, the peak
responses are enveloped around the
static results for 1st Order Linear
Analysis.

2nd Order RSA Seismic - Runs Modal Response Spectrum
Analysis to determine the peak
response of the structure to
earthquakes. Any nonlinear springs or
nonlinear elements present are
constrained to act linearly. For RSA
Seismic Combinations, the peak
responses are enveloped around the
static results for 2nd Order Linear
Analysis.

Model & Results - Displays the analysis model data in
spreadsheets for review/editing.

Wind Tunnel - Displays the wind tunnel data tab,
and wind model data in spreadsheets
for running modal analysis and
reviewing the results.

Mesh Slabs - Slabs are meshed automatically for
FE Load Decomposition, FE
Chasedown, and also if specified in
the 3D Analysis. This command is only
used if you need to mesh slabs
manually. After the operation the slab
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Command Description
mesh is automatically switched on in
the scene content.

BIM Integration ribbon

Command Description

Structural BIM Import

Import a model from a Neutral File.

See also: Import a project from a
Structural BIM Import file (page 301)

TEL File Import Import a file that has been saved in
the 'TEL' file format.

See also: Import a project from a TEL
file (page 302)

3D DXF Import Import a model from a 3D DXF File.

See also: Import data from a 3D DXF
file (page 308)

Trimble Connect

Access Trimble's cloud-based project
collaboration tool.

See also: Trimble Connect (command)
(page 2199)

Tekla Structures Export

Export the structural BIM model to
Tekla Structures.

See also: Export a model to Tekla
Structures (page 318)

TCD Export Export connections to Tekla
Connection Designer.

See also: Export to Tekla Connection
Designer (page 318)

TPFD Export Export portal frames to Tekla Portal
Frame Designer.

See also: Export to Tekla Portal Frame
Designer (page 319)

Autodesk Revit Export
Export the structural BIM model to
Autodesk RevitSaves the currently
open model to a new name, or to a
template.

See also: Export a model to Autodesk
Revit Structure (page 327)
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IFC Export

Export a physical representation of
the structural BIM model in IFC
format.

See also: Export a model to IFC
(page 328)

Cellbeam Export Export a beam to Westok Cellbeam.

See also: Export to and import from
Westok Cellbeam (page 329)

Cellbeam Import Import a beam from Westok
Cellbeam.

See also: Export to and import from
Westok Cellbeam (page 329)

FBEAM Export Export a beam to FBEAM.

See also: Export to and import from
FBEAM (page 330)

FBEAM Import Import a beam from FBEAM.

See also: Export to and import from
FBEAM (page 330)

ADAPT Export Export a model to ADAPT.

See also: Export a model to ADAPT
(page 335)

STAAD Export Export the analysis model to STAAD.

See also: Export a model to STAAD
(page 339)

Robot Export Export the analysis model to
Autodesk Robot.

See also: Export a model to Autodesk
Robot Structural Analysis (page 340)

Cloud Export Export the model to the cloud.

See also: Export a model to the cloud
(page 341)

One Click LCA Export the material data to One Click
LCA.

See also: Export to One Click LCA
(page 341)
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Design ribbon

Command Description
Settings Opens the Design Settings dialog
Validate (page 2201) Validates the model for design issues.
Design Steel (Gravity) (page 2184) Performs an analysis for gravity

combinations only, and then designs
all steel members in the model based
on their individual 'auto-design'
setting.

Design Steel (Static) (page 2184) Performs an analysis of all static
combinations (gravity, lateral, and ELF
seismic), and then designs all steel
members in the model based on their
individual 'auto-design' setting.

Design Steel (RSA) (page 2184) Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF
seismic), and then designs all steel
members in the model based on their
individual 'auto-design' setting.

Design Concrete (Gravity)
(page 2184)

Performs an analysis for gravity
combinations only, and then designs
all concrete members in the model
based on their individual 'auto-design'
setting.

Design Concrete (Static) (page 2184) Performs an analysis of all static
combinations (gravity, lateral, and ELF
seismic), and then designs all
concrete members in the model
based on their individual 'auto-design'
setting.

Design Concrete (RSA) (page 2184) Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF
seismic), and then designs all
concrete members in the model
based on their individual 'auto-design'
setting.

Design All (Gravity) (page 2184) Performs an analysis for gravity
combinations only, and then designs
all members in the model based on
their individual 'auto-design' setting.

Design All (Static) (page 2184) Performs an analysis of all static
combinations (gravity, lateral, and ELF
seismic), and then designs all
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Command Description
members in the model based on their
individual 'auto-design' setting.

Design All (RSA) (page 2185) Performs an analysis of all RSA load
combinations (gravity, lateral, and ELF
seismic), and then designs all
members in the model based on their
individual 'auto-design' setting.

Design Slabs (page 2185) Designs two-way concrete slabs for
out-of-plane bending to all valid
combinations based on their
individual 'auto-design' setting.

Patch Column (page 2193) Creates a localized slab reinforcement
patch at a slab-column connection.

Design Patches (page 2185) Design slab patches for out-of-plane
slab bending to all valid combinations
based on their individual 'auto-design'
setting.

Punching Check (page 2194) Creates a punching check associated
with the punching object.

Design Punching Shear (page 2185) Perform a check or design (according
to individual autodesign settings) of
all punching checks in the model.

Vibration Check (page 2202) Create a floor vibration check.
Check Floor Vibration (page 2181) Perform all floor vibration checks in

the model.
Check in Tedds (page 2182) This command can be used after all

precast concrete members have been
initially designed. The command is
intended for use where a general re-
check for all objects is required
following changes to the model which
require a reanalysis process (e.g.
changing the loading applied onto the
model). The command finds all
members where a linked Tekla Tedds
calculation has been created and
performs a check design for these
members. This command should
ideally be used at the end of the
design cycle and ensures that the
previously designed precast concrete
elements still meet the design criteria
of the model.
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Draw ribbon

Command Description
Settings Opens the Drawing Settings dialog
Drawing Management Opens a dialog for the generation and

laying out of multiple drawings on to
a single drawing sheet. The dialog can
also be used to manage drawing
revisions

Schedule Management Opens a dialog for the generation of
concrete beam, column and wall
schedules on drawing sheets. The
dialog can also be used to manage
schedule revisions

Beam Schedule Configure and then create a concrete
beam schedule for members in an
active 2D view

Column Schedule Configure and then create a concrete
column schedule

Wall Schedule Configure and then create a concrete
wall schedule

General Arrangement Create and save general arrangement
drawing for an active 2D view

Beam End Forces Create and save beam end forces
drawing for an active 2D view for the
currently selected loading

Column Splice Loads Create and save steel column splice
loads drawings for an active 2D frame
view for the currently selected loading

Foundation Reactions Create and save support reactions
drawings for an active 2D view for the
currently selected loading

Loading Plan Create and save loading information
drawings for an active 2D view for the
currently selected loading

Slab/Mat Detailing Create and save slab or mat detailing
drawings for an active 2D view

Foundation Layout Create and save foundation layout
drawing for an active 2D view.
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Edit ribbon

Command Description
Copy Select items then copy.

See also: Copy and rotate objects
(page 495)

Copy Loads Copy between objects in the current
case, or copy from one case to
another.

See also: Copy loads (page 500)
Move Select items then move.

See also: Move and rotate objects
(page 495)

Mirror Select items then mirror.

See also: Mirror objects to new
locations (page 496)

Delete Delete Selected Items.
Join Joins members to make a longer

continuous member.

See also: Join and split members
(page 504)

Split Splits existing continuous members.

See also: Join and split members
(page 504)

Reverse Reverse Wall Panel Faces (inside
becomes outside), or Reverse Beam
Directions.

See also: Reverse member axes and
panel faces (page 506)

Beam Lines Joins existing concrete beams to
make a continuous concrete beam.

See also: Automatically join all
concrete beams (page 505)

Cutting Planes Move/Activate/Deactivate planes to
isolate a smaller visible working area
within the model.

See also: Manage cutting planes
(page 507)
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Command Description
Move Model Moves the entire model to a new

origin.

See also: Move the model or the DXF
shadow (page 508)

Rationalize Open a dialog to remove unused
grids, planes, frames etc.

See also: Rationalize the model
(page 509)

Move DXF Shadow Move the dxf shadow to a new origin.

See also: Move the model or the DXF
shadow (page 508)

Create Infills Creates a pattern of infill members in
the selected bay.

See also: Create infill members
(page 509)

Merge Planes Merge two closely spaced planes.

See also: Merge planes (page 511)
Free Points Add, move, or delete points at specific

co-ordinates to facilitate creation of
other objects.

See also: Create and manage free
points (page 511)

Foundations ribbon

Command Description
Settings - Opens the Design Settings dialog.
Calalogue - Add and delete piles from your pile

catalogue or edit their properties (e.g.
compression and tension capacity).

Pad Base Column - Create a pad foundation under a
column. These can only be created at
the column support node and are
only valid while both the member and
the support exist.

See also: Create pad base columns
(page 836)

Strip Base Wall - Create a strip foundation under a
concrete shear wall. These can only
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Command Description
be created at the supported level of
the wall and are only valid while the
associated wall exists.

See also: Create strip base walls
(page 837)

Pile Cap Column - Create a pile cap foundation under a
column. These can only be created at
the column support node and are
only valid while both the member and
the support exist.

See also: Create pile caps (page 838)
Design Pad Bases - Design pad bases to all valid

combinations based on their
individual 'auto-design' settings.

NOTE Design Pad Bases does not
perform an analysis before
the design - it always uses the
existing analysis results,
(even if the analysis status is
'Out of Date').

See also: Design or check all pad
bases and strip bases (page 840)

Design Pile Caps - Design pile caps to all valid
combinations based on their
individual 'auto-design' settings.

NOTE Design Pile Caps does not
perform an analysis before
the design - it always uses the
existing analysis results,
(even if the analysis status is
'Out of Date').

See also:Design or check all pile caps
(page 840)

Minimum Area - Create a minimum polygon area mat
under selected objects (window to
select all objects) including a defined
overhang dimension.

See also: Create mats (page 842)
Rectangular - Create a minimum rectangular area

mat under selected objects including
a defined overhang dimension
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Command Description
(window to select all objects). Set the
angle of the rectangle, or use
absolute minimal area option.

See also: Create mats (page 842)
Strip - Create a strip of mat between

selected points with a defined width
and end extension

Area - Create a polygon area mat by
selecting perimeter points and
including a defined overhang
dimension.

See also: Create mats (page 842)
Bays - Create a mat by selecting bays

bounded by grid lines.

See also: Create mats (page 842)
Mat Opening - Create an opening in a mat

foundation.

See also: Create slab or mat openings
(page 455)

Mat Overhang - Create an overhang at the edge of a
mat.

See also:

• Slab/Mat overhang properties
(page 2125)

• Add overhangs to existing slab or
mat edges (page 457)

Mat Split - Split mats into smaller panels for the
purposes of pattern loading and mat
design.

See also: Split and join slabs and mats
(page 462)

Mat Join - Join mats to create larger panels for
the purposes of pattern loading and
mat design.

See also: Split and join slabs and mats
(page 462)

Pile - Create a pile under a mat
foundation.

See also: Place an individual pile in a
mat (page 844)
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Command Description
Pile Array - Create a pile array under a mat

foundation.

See also: Place a pile array in a mat
(page 844)

Design Mats - Design ground bearing and piled
mat foundations for out-of-plane
bending to all valid combinations
based on their individual 'auto-design'
setting.

NOTE Design Mats does not
perform an analysis before
the design - it always uses the
existing analysis results,
(even if the analysis status is
'Out of Date').

See also: Design or check all mats in
the model (page 846)

Design Patches - Design slab patches for out-of-plane
slab bending to all valid combinations
based on their individual 'auto-design'
setting.

NOTE Design Patches does not
perform an analysis before
the design - it always uses the
existing analysis results,
(even if the analysis status is
'Out of Date').

See also: Design or check all patches
in the model (page 800)

Punching Check - Creates a punching check associated
with the punching object.

See also:
Design Punching Shear - Check of all punching shear checks

in the model.

NOTE Design Punching Shear does
not perform an analysis
before the check - it always
uses the existing analysis
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Command Description

results, (even if the analysis
status is 'Out of Date').

See also: Design and check punching
shear (page 803)

Home ribbon

Command Description

New

Create a new blank model.

See also: Start a new project
(page 243)

(droplist)

Create a new project based on an
existing template.

See also: Create a new project based
on a template (page 246)

Open

Open a Tekla Structural Designer
model.

Close

Close the model.

Save

Close the model.

Save As

Saves the currently open model to a
new name, or to a template.

Project Wiki

Opens the Project Wiki dialog for
recording properties associated with
the project, and to record revisions.

See also: Modify project details
(page 244)

Model Settings

Opens the Model Settings dialog
(page 2422) to specify settings for the
current project.
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Manage Property Sets

Import, Export and Delete property
sets.

See also: Transfer property sets
between models (page 1025)

Manage View Configurations

Opens or deletes saved View
Configurations.

Find

Find and select objects by typing a
part of their name.

See also: Select using Find (page 353)

Walk

Walk through 3D views.

See also: Walk through the model in a
3D view (page 350)

Load ribbon

Structure

Command Description
Loadcases Opens the Loading dialog at the

Loadcases page.

See also: Manage load cases
(page 514)

Load Groups Opens the Loading dialog at the
Groups page.

See also: Manage load groups
(page 516)

Combination Opens the Loading dialog at the
Combinations page.

See also: Manage load combinations
(page 518)

Envelope Opens the Loading dialog at the
Envelopes page.

See also: Manage envelopes
(page 527)

Update Patterns If load patterns have been applied
and the building geometry or loading
is subsequently modified, this
command should be run to ensure
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Command Description
the load patterns reflect these
changes.

See also: Manage load patterns
(page 527)

Wind, Snow & Seismic

Command Description
Wind Wizard The Wind Wizard dialog is used for

defining the information that is
required in order to calculate the
wind loading on the structure

Update Zones Recalculates the zoning details
Wind Loadcases Opens the Wind Loadcases dialog for

defining the details of each wind
loadcase

Delete Wind Deletes the wind model data
previously defined using the Wind
Wizard

Decomposition (Wind Load) Decompose the wind loads on to the
structure

Simple Wind Create a Simple Wind Load that will
be applied to rigid diaphragms

Snow Wizard Opens the Snow wizard dialog which
is used to automate snow loadcase
generation

Uniform Snow Manually apply Uniform Snow loads
Valley Snow Manually apply Valley Snow loads
Local Drift Snow Manually apply Local Drift Snow loads
Update Snow Loads Update Snow Loads
Delete Snow Deletes the snow model data

previously defined using the Snow
Wizard

Seismic Wizard Opens the Seismic wizard dialog for
defining the parameters required for
determining the seismic loading and
load cases on the structure

Horizontal Spectrum Display the horizontal spectrum
generated by the seismic wizard

Delete Seismic Delete all of the seismic data entered
in the seismic wizard along with the
horizontal spectrum, seismic
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loadcases and seismic load
combinations

Decomposition Decompose loads from 1-way and 2-
way slabs onto supporting members.

Panel Loads

Command Description
Level Load Applies a level load to all slabs at the

current level.

See also: Apply panel loads (page 538)
Slab Load Applies a slab load to all slab panels

that constitute an individual slab.

See also: Apply panel loads (page 538)
Area Load Applies an area load to any panel.

Area loads entirely cover an individual
panel.

See also: Apply panel loads (page 538)
Point Load Applies a point load to any panel.

Point Load is inactive in 3D Views.

See also: Apply panel loads (page 538)
Line Load Applies line load to any panel.

Line Load is inactive in 3D Views.

See also: Apply panel loads (page 538)
Patch Load Applies a patch load to any panel.

See also: Apply panel loads (page 538)
Polygon Load Applies a polygonal load to any panel.

See also: Apply panel loads (page 538)
Perimeter Load If load patterns have been applied

and the building geometry or loading
is subsequently modified, this
command should be run to ensure
the load patterns reflect these
changes.

See also: Apply panel loads (page 538)
Variable Patch Load Applies variable patch load to any

panel.

See also: Apply panel loads (page 538)
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Variable Area Load Applies a variable area load to any

panel. Area loads entirely cover an
individual panel.

See also: Apply panel loads (page 538)

Member Loads

Command Description
Full UDL Applies a full length UDL load to

members.

See also: Create full-length UDLs
(page 544)

UDL Applies a UDL load to members.

See also: Create partial-length UDLs
or VDLs (page 544)

VDL Applies a VDL load to members.

See also: Create partial-length UDLs
or VDLs (page 544)

Trapezoidal Load Applies a Trapezoidal load to
members.

See also: Create trapezoidal loads
(page 545)

Point Load Applies a Point load to members.

See also: Create point loads and
moment loads (page 545)

Moment Load Applies a Moment load to members.

See also: Create point loads and
moment loads (page 545)

Torsion Full UDL Applies a Torsion Full UDL to
members.

See also: Create full-length torsional
UDLs (page 545)

Torsion UDL Applies a Torsion UDL to members.

See also: Create partial-length
torsional UDLs and VDLS (page 546)

Torsion VDL Applies a Torsion VDL to members.

See also: Create partial-length
torsional UDLs and VDLS (page 546)
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Structure Loads

Command Description
Diaphragm Load - Applies a load to a rigid or semi-rigid

diaphragm.

See also: Add a diaphragm load in a
2D view (page 547)

Diaphragm Table - Applies loads to multiple rigid or
semi-rigid diaphragms.

See also: Add multiple loads using the
diaphragm load table (page 547)

Nodal Load - Applies a load to a node.

See also: Create nodal loads
(page 554)

Temperature Load - Applies a temperature load (a global
rise in temperature) to individual
elements/panels, selected elements/
panels, or to all elements/panels.

See also: Create temperature loads
(page 554)

Settlement Load - Applies a Settlement load (a
translation or a rotation) to a support.

See also: Create settlement loads
(page 554)

Model ribbon
A list of the commands accessible from the Model tab on the ribbon.

Levels Group

Command Description

Construction Levels (page 2248)

Opens the Construction Levels dialog
(page 2402) allowing you to define the
levels required in order to construct
your model.

Frame (page 2187)

Create a frame when in a 3D view
(when a 2D view is displayed, this is
inactive). Only those members that lie
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Command Description
within the plane of the frame are
displayed.

The drop list underneath can be used
to delete existing frames.

Sloped Plane (page 2197)

Create a sloped plane when in a 3D
view (when a 2D view is displayed,
this is inactive).

A sloped plane is a 2D View of the
model created in a sloped plane. It is
defined by selecting 3 existing grid
points.

Because only those members that lie
within the plane of the slope are
displayed, this type of view can be
particularly useful for defining
inclined roofs and ramps.

The droplist underneath can be used
to delete existing sloped planes.

Grid & Construction Lines Group

Command Description Note

Grid Line (page 2189)

Create a straight grid
line between two points.

The drop list underneath
can be used to create
grid lines in other ways.

Inactive in 3D Views.

Construction Line
(page 2183)

Create a straight
construction line
between two points.

The drop list underneath
can be used to create
construction lines in
other ways.

Inactive in 3D Views.
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Steel Group

Command Description

Column (page 2183)

Create a rolled steel columnn.

The drop list underneath can be used
to create columns of a specific
fabrication type.

Beam (page 2181)

Create a rolled steel beam.

The drop list underneath can be used
to create beams of a specific
fabrication type.

Brace (page 2181)

Create a rolled steel brace.

Joist (page 2190)

Create a joist.

Truss (page 2200)

Runs the Truss Wizard to define a
steel truss.

Portal Frame (page 2195)
Create a portal frame.

To create the frame, you firstly define
the two column base positions
between which the frame will lie. The
base positions are restricted to lie on
existing grid points.

All other details of the portal frame
are subsequently entered in the
Portal Frame dialog.

Concrete Group

Command Description

Column (page 2183)

Create a concrete columnn.

The drop list underneath can be used
to create columns of a specific
fabrication type.

Beam (page 2181)

Create a concrete beam.

The drop list underneath can be used
to create beams of a specific
fabrication type.
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Command Description

Meshed Wall (page 2191)

Create a reinforced concrete shear
wall characterized analytically by a
mesh of 2D solver elements located
along the wall insertion line and
extending to all four corners.

Non-rectangular and sloping wall
geometry is allowed as well as
openings.

The type of 2D solver elements used
is controlled from the structure
properties and can be overriden on a
wall by wall basis in the individual wall
properties.

Mid-pier Wall (page 2192) l

Create a reinforced concrete shear
wall characterized analytically by a
single vertical pier object of identical
properties as the wall section, located
at the centre of the wall and
extending from the top to the bottom
level.

Mid-pier concrete shear wall
restrictions:

• must be rectangular

• must be in a vertical plane

• openings are not allowed

Wall Opening (page 2203)

Create a rectangular opening in an
existing meshed shear wall when in a
Frame View.

Wall Opening is inactive in 3D Views
and Level Views.

Cores (page 2183)

Assign existing concrete members as
part of a concrete core.

Slabs Group

Command Description Note

Slab on Beams
(page 2196)

Create a slab.  
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Command Description Note

Slab Opening
(page 2196)

Create a rectangular or
circular slab opening.

Inactive in 3D Views.

Slab Overhang
(page 2196)

Create an overhang at
the edge of a slab.

Inactive in 3D Views.

Column Drop
(page 2183)

Create a column drop.  

Slab Split (page 2197)

Split slab items into
smaller panels for the
purposes of pattern
loading and slab design.

Inactive in 3D Views.

Slab Join (page 2197)

Join slabs to create
larger panels for the
purposes of pattern
loading and slab design.

Inactive in 3D Views.

Timber Group

Command Description

Column (page 2183)

Create a timber columnn.

The drop list underneath can be used
to create columns of a specific
fabrication type.

Beam (page 2181)

Create a timber beam.

The drop list underneath can be used
to create beams of a specific
fabrication type.

Brace (page 2181)

Create a timber brace.

Truss (page 2200)

Runs the Truss Wizard to define a
timber truss.
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Cold Formed Group

Command Description

Column (page 2183)

Create a cold formed columnn.

The drop list underneath can be used
to create columns of a specific
fabrication type.

Beam (page 2181)

Create a cold formed beam.

The drop list underneath can be used
to create beams of a specific
fabrication type.

Brace (page 2181)

Create a cold formed brace.

Truss (page 2200)

Runs the Truss Wizard to define a
cold formed truss.

Walls & Panels Group

Command Description

Bearing Wall (page 2181)

Creates a wall which resists only axial
forces and does not contribute to
lateral stability.

Shear Only Wall (page 2203)

Creates a wall which resists only in-
plane shear and has no out of plane
stiffness or load bearing resistance.

Roof Panel (page 2196)

Create roof panels for distributing
loads and/or introducing diaphragm
action.

Wall Panel (page 2202)

Create wall panels for distributing
loads.

Miscellaneous & Validate Group

Command Description

Support (page 2199)

Create additional supports
underneath existing members
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Command Description

Element (page 2187)

Create analysis elements.

Measure (page 2190) Measures the distance between any
existing construction points or
intersection points.

Measure Angle (page 2190) Measures angles between existing
points in 2D Views.

Dimension (page 2187) Create dimensions between
appropriate points which can be
included on drawings.

Validate (page 2201) Validate the structure for physical
model issues.

Report ribbon

Command Description
Select (droplist) - Select an existing report style in

order to either edit the content, or
show

Model Report - Create or edit the chapters and
options (content) of model reports

Member Report - Create or edit the chapters and
options (content) of member reports

Show Report - Display the selected report style on
the screen

Filters - Set up filters to be used when
generating a new report

Page display (Group) - Choose how to display report pages
Settings - Change the report appearance
Page Setup - Edit the paper size, orientation and

margins
Edit Header - Open the document headers/footers

dialog which can be used to configure
the layout and content of the page
header and footers

Edit Footer - Open the document headers/footers
dialog which can be used to configure
the layout and content of the page
header and footers

Tekla Structural Designer reference 2228 Ribbon commands



Command Description
Navigation(Group) - Use these buttons to navigate the

report
Report Index - Display the report index window to

allow you to jump to specific chapters
and options (content) within the
report.

Export (Group) - The report can be exported to PDF,
Word, Excel or Tedds

Upload Settings - Specify settings to control the PDF
upload to Trimble Connect.

See: Upload a model report
(page 314)

PDF Upload - Upload a PDF of the report to
Trimble Connect.

See: Upload a model report
(page 314)

Review ribbon

• Type droplist - Filters status and ratio displays to show results for Static
designs, RSA designs or the Combined designs.

Design

Command Description
Status - Display member status.
Ratio - Display member utilisation ratio.
Depth Ratio - Display beam span to depth

utilisation ratio.

Foundations

Command Description
Status - Display foundation status.
Ratio - Display foundation utilisation ratio.

Piles

Command Description
Status - Display pile status.
Ratio - Display pile utilisation ratio.
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Slab/Mat Design

Command Description
Status - Display slab/mat status.
Ratio - Display slab/mat utilisation ratio.
Slab/Mat droplist - Filters the status and ratio displays

to show results for the selected
category.

Status - Display connection status.
Ratio - Display connection utilisation ratio.

Connections

Command Description
Status - Display connection status.
Ratio - Display connection utilisation ratio.

Show/Alter State

Command Description
Auto/Check Design - Each member is color coded to

indicate its autodesign setting (On or
Off). Clicking on a member toggles its
setting.

Diaphragm On/Off - Each slab panel and diaphragm
node is color coded to indicate its
setting (Excluded or Included).
Clicking on a slab or a diaphragm
node toggles its setting.

Fixed/Pinned - Each member is color coded to
indicate its end fixity setting (N/A,
Pinned, Fixed, Moment, Mixed,
Cantilever). Clicking on a member
toggles its fixity setting between those
that are applicable.

BIM Status - Each member is color coded to
indicate its BIM status.

Slab/Foundation Reinforcement - Use property grid to review and edit
or rationalize panel or patch
reinforcement, or isolated foundation
reinforcement.

Section Material/Grade - Each steel member is color coded to
indicate its section and grade. Clicking
on a steel member updates its section
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Command Description
and/or grade to match what you have
set in the Properties window.

Copy Properties - Copy properties from one member
to another. After firstly selecting a
parameter in the Properties window
you are able to copy it from a
designated source member to valid
target members.

Report Filter - Only accessible once a Member filter
has been defined. Each member is
color coded to indicate if it is included
in the currently selected filter. Clicking
a member toggles its inclusion status.

Sub Structures - Create selected sub-sets of the
structure and use for more focused
editing, design, review and reporting
purposes.

Concrete Beam Flanges - Each concrete beam is color coded
to indicate its if flanges are
considered and flange widths
determined.

Column Splices - Potential splice locations in steel
columns are color coded to indicate
where splices exist.

Property Sets - Graphically review and modify the
property set assigned to the elements
by using the property grid. In a typical
model you may wish to apply the
same properties to similar model
objects. This can be done efficiently
using property sets.

UDA - Eraphically review and modify the
attribute values assigned to the
elements by using the property grid.
User defined attributes allow you to
save your own data to individual
elements. These can be used to select
similar elements based upon their
UDA group or filter report content
based on a UDA.

Show/Alter State - The full range of options is available
by selecting this and using the
attribute drop down in the property
grid.
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Design Data

Command Description
Tabular Data - Open the review data view in which

all sorts of design results and
quantities information can be
reviewed.

Slab Deflection ribbon

Command Description
Settings Open the slab deflection settings

dialog
Event Sequences - Submodel Event Sequences give

access to override aspects of the
model event sequence on a submodel
basis

Deflection Checks - Opens the Slab Deflection Check
Catalogue for defining the default
check requirements associated with
Check Lines (also associated with
events)

Analyse Current - Performs a slab deflection analysis
for the current sub model

Analyse All - Performs a slab deflection analysis
of all submodels regardless of current
view/selection

Analyse Selected - Opens dialog allowing analysis of
selected submodels.

Windows ribbon

Command Description
Structure Window - Open/close the structure tree

window. This lists structural and non-
structural components present in the
model grouped by commonality in a
hierarchical way, and allows for
selective control over objects in the
structure.
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Command Description
Groups Window - Open/close the groups tree window.

Manage groups for general design
and reinforced concrete detailing.
Review objects assigned user defined
attributes.

Loading Window - Open/close the loading tree window.
This lists loadcases and combinations
in a hirearchical way, and allows to
review and delete applied loads and
provides information and total load
and reaction summations for each
load combination.

Report Index - Open/close the report index
window. This displays the bookmarks
for the active report view which can
be used to locate and display a
specific section within it, and allows
bookmarks to be easily moved
around the report.

Wind Window - Open/close the wind model tree
window. This lists wind directions and
loadcases in a hierachical way, and
offers information about wind
loadcases and pressure zone
calculation status as well as control
over wind model directions.

Status Window - Open/close the status tree window.
This displays information and
statuses of modelling, stages of
analyses, design and BIM.

Properties Window - Open/close the properties window.
Input, review and edit properties
related to ribbon commands, tree
view items and individual or multiple
objects selected in active views.

Scene Content - Open/close the scene content
window. Manage by entity the
displayed content in the 2D and 3D
scene views.

Process Window - Open/close the process window.
This displays in a sequence each step
of the analysis and design of the
model and their statuses, as well as
other useful information about
program content.
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15.3 Project Workspace commands
This section lists the right click context menus commands accessible from the
tabs in the Project Workspace.

Structure tab - Structure

• Open view (page 2262)

• Open solver view (page 2262)

• Check model (page 2239)

• Design model (page 2250)

• Check model slabs (page 2240)

• Design model slabs (page 2251)

• Check model patches (page 2239)

• Design model patches (page 2250)

• Check punching shear (page 2242)

• Design punching shear (page 2253)

Structure tab - Levels

• Construction Levels (page 2248)

• Open view (page 2262)

• Open solver view (page 2262)

• Select in visible views (page 2262)

• Check plane (page 2240)

• Design plane (page 2252)

• Check plane slabs (page 2241)

• Design plane slabs (page 2253)

• Check plane patches (page 2241)

• Design plane patches (page 2252)

• Check punching shear (page 2242)

• Design punching shear (page 2253)
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Structure tab - Frames

• Open view (page 2262)

• Open solver view (page 2262)

• Select in visible views (page 2262)

• Check plane (page 2240)

• Design plane (page 2252)

• Show references... (page 2262)

Structure tab - Slopes

• Open view (page 2262)

• Open solver view (page 2262)

• Select in visible views (page 2262)

• Check plane (page 2240)

• Design plane (page 2252)

• Check plane slabs (page 2241)

• Design plane slabs (page 2253)

• Check plane patches (page 2241)

• Design plane patches (page 2252)

• Show references... (page 2262)

Structure tab - Architectural Grids

• Renumber (page 376)

Structure tab - Sub Models

• Sub Models (page 2263)

• Open view (page 2262)

• Open solver view (page 2262)
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Structure tab - Sub Structures

• Create Sub Structure (page 1031)

• Open view (page 2262)

• Open solver view (page 2262)

• Edit (page 1032)

• Delete (page 1033)

• Rename (page 1033)

• Check sub structure (page 782)

• Design sub structure (page 786)

• Check sub structure slabs (page 797)

• Design sub structure slabs (page 799)

• Create sub structure group (page 1034)

• Check using Tekla Tedds (page 2242)

• Design using Tekla Tedds (page 2255)

• Export to Tekla Tedds (page 324)

• Clear Tekla Tedds Data (page 2247)

Structure tab - Members

• Select in visible views (page 2262)

• Check members (page 2239)

• Design members (page 2249)

• Renumber (page 999)

• Edit (page 360)

• Open view (page 2262)

• Check member (page 2238)

• Design member (page 2248)

• Check using Tekla Tedds (page 2242)

• Design using Tekla Tedds (page 2255)

• Export to Tekla Tedds (page 324)

• Clear Tekla Tedds Data (page 2247)
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Structure tab - Walls

• Check walls (page 2247)

• Design walls (page 2261)

• Renumber (page 999)

• Edit (page 360)

• Select in visible views (page 2262)

• Check wall (page 2246)

• Design wall (page 2261)

Structure tab - Cores

• Create new core (page 435)

• Renumber (page 999)

• Open view (page 2262)

• Open solver view (page 2262)

• Edit (page 438)

• Dissociate (page 438)

• Select in visible views (page 2262)

• Check member (page 2238)

• Design member (page 2248)

Structure tab - Slabs

• Renumber (page 999)

• Check panel (page 2240)

• Design panel (page 2251)

• Check Punching Shear (panel) (page 804)

• Design Punching Shear (panel) (page 805)

• Edit (page 438)

• Select in visible views (page 2262)

Structure tab - Isolated Foundations

• Renumber (page 999)
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• Select in visible views (page 2262)

Groups tab

• Add Group (page 268)

• Set As Default Group (page 268)

• Rename Group (page 269)

• Remove Group (page 270)

• Split Group (page 268)

• Regroup Members (page 268)

• Check Group (page 270)

• Design Group (page 270)

• Check using Tekla Tedds (page 2242)

• Design using Tekla Tedds (page 2255)

• Export to Tekla Tedds (page 324)

• Clear Tekla Tedds Data (page 2247)

• Generate Detail Drawing... (page 976)

Connections tab

• Update Connections (page 274)

• Edit (page 275)

• Design Connection (page 275)

• Export Connection to Tekla Connection Designer (page 275)

• Export Connection to IDEA StatiCa (page 345)

• Select in visible views (page 2262)

Check member (command)

Command Description
Check member Performs a check of the selected

member and displays the results.
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NOTE Check member does not perform an analysis before the check - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Check an individual member, wall, or core (page 780)

Check members (command)

Command Description
Check members Checks all members in the selected

branch of the Project Workspace.

NOTE Check members does not perform an analysis before the check - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Check all members (page 781)

Check model (command)

Command Description
Check model Checks all members and walls in the

model.

NOTE Check model does not perform an analysis before the check - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Check all members and walls (page 781)

Check model patches (command)

Command Description
Check model patches Checks all patches in the model.
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NOTE Check model patches does not perform an analysis before the check
- it always uses the existing analysis results, (even if the analysis status
is 'Out of Date').

See also

Check all patches in the model (page 800)

Check model slabs (command)

Command Description
Check model slabs Checks all two-way concrete slabs in

the model for out of plane bending.

NOTE Check model slabs does not perform an analysis before the check - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Check all slab items (page 797)

Design model slabs (command) (page 2251)

Check panel (command)

Command Description
Check panel Performs a check of the selected

panel and displays the results.

NOTE Check panel does not perform an analysis before the check - it always
uses the existing analysis results, (even if the analysis status is 'Out of
Date').

See also

Check an individual slab item (page 796)
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Check plane (command)

Command Description
Check plane Checks all members in the selected

level, slope, or frame.

NOTE Check plane does not perform an analysis before the check - it always
uses the existing analysis results, (even if the analysis status is 'Out of
Date').

See also

Check all members in a level, slope, or frame (page 780)

Check plane patches (command)

Command Description
Check plane patches Checks all patches in the selected

level or slope.

NOTE Check plane patches does not perform an analysis before the check -
it always uses the existing analysis results, (even if the analysis status
is 'Out of Date').

See also

Check all patches on a single floor (page 800)

Design model patches (command) (page 2250)

Check plane slabs (command)

Command Description
Check plane slabs Checks all slabs in the selected level

or slope.

NOTE Check plane slabs does not perform an analysis before the check - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Check all slab items on a single floor (page 797)
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Design plane slabs (command) (page 2253)

Design model patches (command) (page 2250)

Check punching shear (command)

Command Description
Check punching shear If run from the Structure >

Structuretab

• Checks all punching shear checks
in the model.

If run from the Structure > Levels
tab

• Checks all punching shear checks
in the level.

NOTE Check Punching Shear does not perform an analysis before the
check - it always uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also

Design punching shear (command) (page 2253)

Check selection (command)

Command Description
Check selection Checks all members in the selection.

NOTE Check selection does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design selected members and walls (page 783)
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Check using Tekla Tedds
After Design using Tekla Tedds (page 2255) has been performed the following
menu options for checking in Tekla Tedds become available for timber and
precast members:

• Check using Tekla Tedds> Model

• Check using Tekla Tedds> Member

• Check using Tekla Tedds> Group

• Check using Tekla Tedds> Selection

• Check using Tekla Tedds> <Substructure name>

Where to find each check option
Check using Tekla Tedds> Model is displayed if:

• in the Groups Tree you right-click on Groups, Design, or Detailing

Check using Tekla Tedds> Member is displayed if:

• a precast or timber member, which has already been designed is
highlighted,

Check using Tekla Tedds> Group is displayed if:

• a precast or timber member, which has already been designed is
highlighted,

• group design is active for the highlighted member type,

• there is more than one member in the group to which the highlighted
member belongs.

Check using Tekla Tedds> Selection is displayed if:

• one or more precast or timber members, which have already been
designed are selected,

Check using Tekla Tedds> <Substructure name> is displayed if:

• in the Structure Tree you have right-clicked on a sub structure containing
precast or timber members which have already been designed.

Understanding each of the check options

Command Description
Check using Tekla Tedds > Model Launches Tekla Tedds within the

background (the user is not exposed
to the interface) and checks all
members in the model with the pre-
saved design data.
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Command Description
Check using Tekla Tedds > Member Launches Tekla Tedds within the

background (the user is not exposed
to the interface) and checks the
member with the pre-saved design
data. No other members in the
associated Design Group will be
checked.

Check using Tekla Tedds > Group Launches Tekla Tedds within the
background (the user is not exposed
to the interface) and checks each
member in the selected group with
the pre-saved design data.

Check using Tekla Tedds > Selection Launches Tekla Tedds within the
background (the user is not exposed
to the interface) and checks the
selected members with the pre-saved
design data.

Check using Tekla Tedds >
<Substructure name>

This extra option becomes available
when working in a sub structure -
Launches Tekla Tedds within the
background (the user is not exposed
to the interface) and checks the
selected sub structure members with
the pre-saved design data.

To check all timber or precast members in the model

NOTE This command is only available for those members that have already
been designed.

1. On the Design tab, click  Check in Tedds (page 2182). 

• Tekla Structural Designer checks all the existing Tekla Tedds design
calculations in the background for the current set of forces.

• The updated status of the members is shown in a Review View.

NOTE This command is also available in the Project Workspace by selecting
Check using Tekla Tedds > Model from the Group branch of the
Group tab.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').
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To check a timber or precast member

NOTE Check using Tekla Tedds is only available for those members that
have already been designed.

1. Hover the mouse pointer over the member to highlight it in a 2D or 3D
view.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the correct reference is shown in the Select Entity tooltip.

3. Right click and select Check using Tekla Tedds > Member

4. Tekla Structural Designer checks the existing Tekla Tedds precast design
calculation in the background for the current set of forces.

At the end of the process the status of the member(s) is shown in a Review
View.

NOTE You can also run Check using Tekla Tedds > Member by right-
clicking the member reference in the Structure Tree.

NOTE Design using Tekla Tedds > Member uses the existing analysis
results, (even if the analysis status is 'Out of Date').

To check a timber or precast member group

NOTE Check using Tekla Tedds is only available for those members that
have already been designed.

1. Hover the mouse pointer over a group member to highlight it in a 2D or
3D view.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the correct reference is shown in the Select Entity tooltip.

3. In the context menu, select Check using Tekla Tedds > Group 

• Tekla Structural Designer checks the existing Tekla Tedds design
calculations in the background for the current set of forces.

• The updated status of the group members is shown in a Review View.

To check selected timber or precast members

NOTE Check using Tekla Tedds is only available for those members that
have already been designed.

1. In the active view, drag a box to make your selection.
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2. Right-click, then in the context menu, select Check using Tekla Tedds >
Selection 

• Tekla Structural Designer checks the existing Tekla Tedds design
calculations in the background for the current set of forces.

• The updated status of the members is shown in a Review View.

NOTE The Check using Tekla Tedds > Selection command uses the existing
analysis results, (even if the analysis status is 'Out of Date').

To check timber or precast members in a sub structure

NOTE Check using Tekla Tedds is only available for those members that
have already been designed.

1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
check.

3. In the context menu, select Check using Tekla Tedds > <Sub structure
name> 

• Tekla Structural Designer checks the existing Tekla Tedds design
calculations in the background for the current set of forces.

• The updated status of the sub structure members is shown in a Review
View.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check wall (command)

Command Description
Check wall Performs a check of the selected wall

and displays the results.

NOTE Check wall does not perform an analysis before the check - it always
uses the existing analysis results, (even if the analysis status is 'Out of
Date').

See also

Check an individual member, wall, or core (page 780)
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Check walls (command)

Command Description
Check walls Checks all walls in the selected branch

of the Structure tree.

NOTE Check walls does not perform an analysis before the check - it always
uses the existing analysis results, (even if the analysis status is 'Out of
Date').

Clear Tekla Tedds Data (command)

Command Description
Clear Tekla Tedds Data Model

Clears all existing data from all the
associated Tekla Tedds calculations in
the model.

Member

Clears all existing data from the
associated Tekla Tedds calculation for
the highlighted member.

Group

Clears all existing data from the
associated Tekla Tedds calculation for
the group to which the highlighted
member belongs.

Selection

Clears all existing data from the
associated Tekla Tedds calculation for
the selected members.

<Substructure name>

This extra option becomes available
when working in a sub structure -
Clears all existing data from the
associated Tekla Tedds calculation for
the selected sub structure members.
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NOTE If you change the Design Settings or section shape, you would need to
clear the Tekla Tedds data from existing members in order for the
new settings to apply when the members are redesigned.

See also

Timber member design handbook (page 1564)

Precast member design handbook (page 1527)

Construction Levels (command)

To run: In the Project Workspace, select Structure > Levels, right-
click, and then select Construction Levels from the context
menu.

Usage: Opens the Construction Levels dialog (page 2402) allowing
you to define the levels required in order to construct your
model.

Design member (command)

Command Description
Design member • If the member is not in a design

group -

• Performs a design of the
selected member, then
displays the results.

• If the member is in a design group
(and design using groups is active)

• Performs a design of the
highlighted member for it's
own individual set of design
forces, then displays the
results,

• Updates all other members of
the group to use the same
design,

• Checks all other members of
the group.
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NOTE Design member always designs the member irrespective of its
autodesign setting.

NOTE Design member does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design an individual member, wall, or core (page 783)

Design members (command)

Command Description
Design members • If the member s are not in a design

group -

• Performs a check or design
(according to individual
autodesign settings) of the
selected members.

• If the members are in design groups
(and design using groups is active)

• Performs a check of those
members in the selection that
are in check mode.

• Performs a design of those
members in the selection that
are in autodesign mode (for
the group's set of design
forces), and:

• Updates all other members
of the same group to use
the same design,
(irrespective of whether
they are in the selection).

• Checks all other members
of the same group
(irrespective of whether
they are in the selection).
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NOTE Design members does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

NOTE This command requires at least one member in the branch to be in
auto-design mode.

See also

Design all members (page 784)

Design all members of a particular section or type (page 785)

Design model (command)

Command Description
Design model Performs a check or design (according

to individual autodesign settings) of
all members and walls in the model
according to individual autodesign
settings. This command requires at
least one member or wall to be in
auto-design mode.

NOTE Design model does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design all members and walls (page 785)

Design model patches (command)

Command Description
Design model patches Performs a check or design (according

to individual autodesign settings) of
all patches in the model according to
individual autodesign settings. This
command requires at least one patch
in the model to be in auto-design
mode.
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NOTE This command does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design or check all patches in the model (page 800)

Check model patches (command) (page 2239)

Design model slabs (command)

Command Description
Design model slabs Performs a check or design (according

to individual autodesign settings) of
all two-way concrete slabs in the
model for out of plane bending. This
command requires at least one slab
in the model to be in auto-design
mode.

NOTE Design model slabs does not perform an analysis before the design -
it always uses the existing analysis results, (even if the analysis status
is 'Out of Date').

See also

Design all slab items (page 798)

Check model slabs (command) (page 2240)

Design panel (command)

Command Description
Design panel Performs a check or design (according

to individual autodesign settings) of
the selected panel according to
individual autodesign settings, then
displays the results.

NOTE Design panel does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').
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See also

Design an individual slab item (page 798)

Design plane (command)

Command Description
Design plane Performs a check or design (according

to individual autodesign settings) of
all members in the plane according to
individual autodesign settings. This
command requires at least one
member in the model to be in auto-
design mode.

NOTE Design plane does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design all members in a level, slope, or frame (page 784)

Design plane patches (command)

Command Description
Design plane patches Performs a check or design (according

to individual autodesign settings) of
all patches in the plane according to
individual autodesign settings. This
command requires at least one patch
in the model to be in auto-design
mode.

NOTE This command does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design all patches on a single floor (page 801)

Check plane patches (command) (page 2241)
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Design plane slabs (command)

Command Description
Design plane slabs Performs a check or design (according

to individual autodesign settings) of
all slabs in the plane according to
individual autodesign settings. This
command requires at least one slab
in the plane to be in auto-design
mode.

NOTE This command does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design all slab items on a single floor (page 798)

Check plane slabs (command) (page 2241)

Check plane patches (command) (page 2241)

Design punching shear (command)

Command Description
Design Punching Shear If run from the Structure >

Structuretab

• Performs a check or design
(according to individual
autodesign settings) of all
punching checks in the model.

If run from the Structure > Levels
tab

• Performs a check or design
(according to individual
autodesign settings) of all
punching checks in the level.

NOTE Design Punching Shear does not perform an analysis before the
design - it always uses the existing analysis results, (even if the
analysis status is 'Out of Date').
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See also

Check punching shear (command) (page 2242)

Design selection (command)

Command Description
Design selection For those members in the selection

that are not in design groups:

• Performs a check or design
(according to individual
autodesign settings) of the
selected members.

For those members in the selection
that are in design groups (and
design using groups is active):

• Performs a check of those
members in the selection that are
in check mode.

• Performs a design of those
members in the selection that are
in autodesign mode (for the
group's set of design forces), and:

• Updates all other members of
the same group to use the
same design, (irrespective of
whether they are in the
selection).

• Checks all other members of
the same group (irrespective of
whether they are in the
selection).

NOTE Design selection does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

NOTE If only one member is in the selection, the command operates
differently, adopting the logic of the Design member (page 2248)
command instead.

See also

Design selected members and walls (page 782)
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Design using Tekla Tedds
After analysis has been performed the following menu options for designing in
Tekla Tedds become available for timber and precast members:

• Design using Tekla Tedds> Model

• Design using Tekla Tedds> Member

• Design using Tekla Tedds> Group

• Design using Tekla Tedds> Selection

• Design using Tekla Tedds> <Substructure name>

Where to find each design option
Design using Tekla Tedds> Model is displayed if:

• in the Groups Tree you right-click on Groups, Design, or Detailing

Design using Tekla Tedds> Member is displayed if:

• a precast or timber member is highlighted,

Design using Tekla Tedds> Group is displayed if:

• a precast or timber member is highlighted,

• group design is active for the highlighted member type,

• there is more than one member in the group to which the highlighted
member belongs

Design using Tekla Tedds> Selection is displayed if:

• one or more precast or timber members are selected,

Design using Tekla Tedds> <Substructure name> is displayed if:

• in the Structure Tree you have right-clicked on a sub structure containing
precast or timber members

Understanding each of the design options

Command Description
Design using Tekla Tedds > Model Launches Tekla Tedds and performs

interactive designs on all timber and
precast members in the model taking
into account group design settings.

Design using Tekla Tedds > Member • If group design is active - Launches
Tekla Tedds and performs an
interactive design on the selected
member. Member design uses the
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Command Description
critical forces in the selected
member only. All other members
remaining in the associated design
group will be check designed for
the assigned Tekla Tedds
properties and their individual
forces. (It should be noted that
some members may fail if the
critical member was not initially
selected for the design process.)
Section changes made within
Tekla Tedds are imported back
into the Tekla Structural Designer
model.

• If group design is inactive -
Launches Tekla Tedds and
performs an interactive design on
the selected member. Section
changes made within Tekla Tedds
are imported back into the Tekla
Structural Designer model.

Design using Tekla Tedds > Group Launches Tekla Tedds and performs
an interactive design on the selected
group. Group design uses the group
critical forces. This is followed by a
check design on each group member
for the assigned Tekla Tedds
properties and their individual forces.
Section changes made within Tekla
Tedds are imported back into the
Tekla Structural Designer model.

Design using Tekla Tedds >
Selection

• If group design is active - Launches
Tekla Tedds and performs an
interactive design for each group
in the selection, using group
critical forces. All members in the
associated design group (including
those that are not in the selection
will be check designed for the
assigned Tekla Tedds properties
and their individual forces. Section
changes made within Tekla Tedds
are imported back into the Tekla
Structural Designer model both
for selected members and
members in groups associated
with the selection.
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Command Description
• If group design is inactive -

Launches Tekla Tedds and
performs an interactive design for
each member in the selection
using the member's individual
critical forces. Section changes
made within Tekla Tedds are
imported back into the Tekla
Structural Designer model.

Design using Tekla Tedds >
<Substructure name>

This extra option becomes available
when working in a sub structure.

• If group design is active - Launches
Tekla Tedds and performs an
interactive design for each group
in the sub structure, using group
critical forces. All members in the
associated design group (including
those that are not in the sub
structure will be check designed
for the assigned Tekla Tedds
properties and their individual
forces. Section changes made
within Tekla Tedds are imported
back into the Tekla Structural
Designer model both for sub
structure members and members
in the same groups but not in the
sub structure.

• If group design is inactive -
Launches Tekla Tedds and
performs an interactive design for
each member in the sub structure
using the member's individual
critical forces. Section changes
made within Tekla Tedds are
imported back into the Tekla
Structural Designer model.

To design all timber and precast members
1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.
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3. In the context menu, select Design using Tekla Tedds > Model 

Tekla Structural Designer opens the Tekla Tedds design calculation to
allow the first design section (s1) in the first member to be designed for
forces at that section.

4. Adjust the parameters as required to achieve a satisfactory design, then
select the next design section (s2) from the Design section droplist. 

• Continue in the same way, adjusting parameters as necessary for each
design section until a satisfactory design is achieved for the whole
span/stack, then click Finish.

• If it is a multi-span/stack member, the Tekla Tedds design calculation
will re-open to allow the next span/stack to be designed.

• Continue the design in the same way, clicking Finish after each span/
stack, until the entire member has been designed.

5. If the member is in a group and group design is active, all other members
in the design group are then check designed for the assigned Tekla Tedds
properties and their individual forces.

6. Tekla Structural Designer opens the Tekla Tedds design calculation to
allow the next member to be designed. 

• Continue in the same way until all the members have been designed.

At the end of the process the status of the member(s) is shown in a Review
View.

NOTE Design using Tekla Tedds > Model uses the existing analysis results,
(even if the analysis status is 'Out of Date').

To design a timber or precast member
1. Hover the mouse pointer over the member to highlight it in a 2D or 3D

view.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the correct reference is shown in the Select Entity tooltip.

3. Right click and select Design using Tekla Tedds > Member 

Tekla Structural Designer opens the Tekla Tedds design calculation to
allow the first design section (s1) in the member to be designed for forces
at that section.

4. Adjust the parameters as required to achieve a satisfactory design, then
select the next design section (s2) from the Design section droplist. 

• Continue in the same way, adjusting parameters as necessary for each
design section until a satisfactory design is achieved for the whole
span/stack, then click Finish.
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• If it is a multi-span/stack member, the Tekla Tedds design calculation
will re-open to allow the next span/stack to be designed.

• Continue the design in the same way, clicking Finish after each span/
stack, until the entire member has been designed.

5. If the member is in a group and group design is active, all other members
in the design group are then check designed for the assigned Tekla Tedds
properties and their individual forces.

At the end of the process the status of the member(s) is shown in a Review
View.

NOTE You can also run Design using Tekla Tedds > Member by right-
clicking the member reference in the Structure Tree.

NOTE Design using Tekla Tedds > Member uses the existing analysis
results, (even if the analysis status is 'Out of Date').

To design a timber or precast member group
In grouped design, one member of the group is designed for the worst case
forces from all members in the group. The design is then copied to the other
group members and each member is checked. The status for each member is
then displayed in a Review View.

1. Hover the mouse pointer over a group member to highlight it in a 2D or
3D view.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the correct reference is shown in the Select Entity tooltip.

3. From the right-click menu, choose Design using Tekla Tedds > Group
Tekla Structural Designer collects the worst case forces from all members
in the group and then opens the Tekla Tedds precast design calculation to
allow the first design section (s1) in the selected member to be designed
for forces at that section.

4. Adjust the parameters as required to achieve a satisfactory design, then
select the next design section (s2) from the Design section droplist. 

• Continue in the same way, adjusting parameters as necessary for each
design section until a satisfactory design is achieved for the whole
span/stack, then click Finish.

5. If it is a multi-span/stack member, the Tekla Tedds design calculation will
re-open to allow the next span/stack to be designed. 

• Continue the design in the same way, clicking Finish after each span/
stack, until the entire member has been designed.

6. After the selected group member has been designed, a check is then
automatically performed on the remaining group members, resulting in
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an individual status and utilisation for each member in the group. The
status of the group members is displayed in a Review View.

To design selected timber or precast members
1. In the active view make your selection.

2. Right-click, then in the context menu, select Design using Tekla Tedds >
Selection 

• Tekla Structural Designer opens the Tekla Tedds design calculation to
allow the first design section (s1) in the first member of the selection to
be designed for forces at that section.

3. Adjust the parameters as required to achieve a satisfactory design, then
select the next design section (s2) from the Design section droplist. 

• Continue in the same way, adjusting parameters as necessary for each
design section until a satisfactory design is achieved for the whole
span/stack, then click Finish.

4. If it is a multi-span/stack member, the Tekla Tedds design calculation will
re-open to allow the next span/stack to be designed. 

• Continue the design in the same way, clicking Finish after each span/
stack, until the entire member has been designed.

5. Tekla Structural Designer re-opens the Tekla Tedds design calculation to
allow the next selected member to be designed.

6. Continue in the same way until all members in the selection have been
designed.

7. The status of the members is shown in a Review View.

NOTE The Design using Tekla Tedds > Selection command uses the
existing analysis results, (even if the analysis status is 'Out of Date').

To design timber or precast members in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
check.

3. In the context menu, select Design using Tekla Tedds > <Sub structure
name>

4. Adjust the parameters as required to achieve a satisfactory design, then
select the next design section (s2) from the Design section droplist. 

• Continue in the same way, adjusting parameters as necessary for each
design section until a satisfactory design is achieved for the whole
span/stack, then click Finish.
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5. If it is a multi-span/stack member, the Tekla Tedds design calculation will
re-open to allow the next span/stack to be designed. 

• Continue the design in the same way, clicking Finish after each span/
stack, until the entire member has been designed.

6. Tekla Structural Designer re-opens the Tekla Tedds design calculation to
allow the next member in the sub structure to be designed.

7. Continue in the same way until all members in the sub structure have
been designed.

8. The status of the members is shown in a Review View.

NOTE The Design using Tekla Tedds > <Sub structure name> command
uses the existing analysis results, (even if the analysis status is 'Out of
Date').

Design wall (command)

Command Description
Design wall Performs a check or design (according

to individual autodesign settings) of
the selected wall according to
individual autodesign settings, then
displays the results.

NOTE Design wall does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

See also

Design an individual member, wall, or core (page 783)

Design walls (command)

Command Description
Design walls Performs a check or design (according

to individual autodesign settings) of
all walls in the selected branch of the
Structure tree according to individual
autodesign settings. This command
requires at least one member in the
model to be in auto-design mode.
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NOTE Design walls does not perform an analysis before the design - it
always uses the existing analysis results, (even if the analysis status is
'Out of Date').

Open solver view (command)
The Open solver view command is accessible from various branches of the
Project WorkspaceStructure tree.

Opens the selected branch of the Structure tree in a Solver View regime, or, if
such a view already exists but is not active, it is made the active view.

See also

Open view (command) (page 2262)

Open view (command)
The Open view command is accessible from various branches of the Project
WorkspaceStructure tree.

Opens the selected branch of the Structure tree in a Structural View regime,
or, if such a view already exists but is not active, it is made the active view.

See also

Open solver view (command) (page 2262)

Select in visible views (command)
The Select in visible views command is accessible from various branches of
the Project WorkspaceStructure tree.

Selects all objects in the active view that are referenced in the selected branch
of the Structure tree.

Show references (command)
The Show references command is accessible from within the Frames and
Slopes branches of the Project WorkspaceStructure tree.

Opens a dialog listing all the objects that are referenced in the selected branch
of the Structure tree.

After selecting objects in the dialog, click the Select button.
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The objects are highlighted in the 3D Structural view and their properties
displayed in the Properties window.

TIP You can change the color used to highlight the selected objects if
required:

From the Home tab, click Settings > Scene > Colors > Selection and
change the Global - User color.

Sub Models (command)
The Sub Models command is accessible from the Sub Models branch of the
Project WorkspaceStructure tree.

Opens the Sub Models dialog (page 2438) allowing you to override the default
sub model divisions for the sub models generated during chasedown analysis.

15.4 Settings

Settings for the current project

Several dialogs are provided for controlling the various settings and options in
the current project:

• Model Settings dialog (page 2422)

• Analysis Settings dialog (page 2398)

• Design Settings dialog (page 2404)

• Slab Deflection Settings dialog (page 2440)

• Drawing Settings dialog (page 2405)

Settings for future projects

A single dialog is provided for defining all settings and options that are to be
applied to new projects:

• Settings dialog (page 2424)

Model Settings

Many (but not all) of the settings for the current project are accessed from the
Model Settings dialog (page 2422) on the Home tab.

• Design code settings (page 2264)
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• Unit settings (page 2265)

• Object reference settings (page 2266)

• Loading settings (page 2268)

• Grouping model settings (page 2269)

• Material list settings (page 2269)

• Beam line settings (page 2270)

• Analysis Model settings (page 2271)

• Validation settings (page 2273)

• Load reduction settings (page 2273)

• EHF settings (page 2274)

• User-defined attribute settings (page 2274)

• Graphics view settings (page 2275)

• Structural BIM settings (page 2276)

See also

Analysis Settings (page 2278)

Design Settings (page 2293)

Slab deflection settings (page 2348)

Drawing settings (page 2352)

Design code settings
The Design Codes page allows you to specify the head code and the
subsequent design codes that are applied:

• To the current project - when accessed from the  Model Settings
(page 2263)

• To new projects - when accessed from the  Settings dialog (page 2424)

Button, command, or option Description
Select the head code list Allows you to select the head code

that you want to apply. When you
select a head code in the list, the
Design Codes table automatically
updates.

WARNING If you change the head
code in an existing
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Button, command, or option Description

project, the following will
occur in the model:

• Some materials, steel
sections, studs, decks
and reinforcement
may require re-
selecting in the
model to make them
consistent with the
new head code/unit
system.

• Wind loading (if any)
and wall/roof panel
properties will be
deleted. The wind
wizard will need
rerunning, wall/roof
panel properties
need resetting and
the wind load cases
will need recreating.

• Seismic loading (if
any) will be deleted.
The seismic wizard
will need re-running.

• All combinations will
be deleted.

Design Codes table Displays the available action codes
and resistance codes, which are
dependent on the selected head
code. The lists within the Design
Codes table can be used to select
between available alternatives.

See also

Define and modify head codes and design codes (page 992)

Unit settings
The Units page allows you to specify the units, format and precision that are
applied
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• To the current project - when accessed from the  Model Settings
(page 2263)

• To new projects - when accessed from the  Settings dialog (page 2424)

Button, command, or option Description
System list Allows you to determine whether

metric or US customary units are
used.

Table of quantities Displays each quantity, its current
unit and its precision. You can modify
quantities by selecting them in the
table.

Settings list Displays and allows you to select the
units for the currently selected
quantity.

Precision list Displays and allows you to define the
precision of the currently selected
quantity.

Use for values lower than Allow you to define the values for
which Tekla Structural Designer
applies exponential formats.

or greater than or equal to

See also

Define and modify units (page 993)

Object reference settings
The References page and its subpages allow you to adjust different object
reference settings:

• To the current project - when accessed from the  Model Settings
(page 2263)

• To new projects - when accessed from the  Settings dialog (page 2424)

Button, command, or option Description
General subpage
Initial value in levels Allows you to specify the start

number (such as 1, 100, 1000) at each
construction level for object
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Button, command, or option Description
references that contain the Count
item.

Renumbering Direction Allows you to specify renumbering
directions that control how the
member numbering is applied when
you use the Renumber command.

Ignore letters I & O Allows you to ignore the letters I and
O in grid line names.

Initial number Allows you to specify the initial
number applied to the first grid lines.

Initial letter Allows you to specify the initial letter
applied to the first grid lines.

Naming style list Allows you to select a desired naming
style for grid lines.

Groups subpage

NOTE This subpage is only displayed in the Settings dialog box not in the
Model Settings dialog box.

Sub-group Name Allows you to specify the text used to
designate the group labelling.

This text forms the stem of the Design
Group and Detailing Group names
that are displayed on the Groups tab
of the Project Workspace. These
names are shown in the output
reports and drawings when grouped
design has been applied.

Formats subpage
Format table Lists each object type showing its

current reference format and allows
you to customize the formats.

NOTE To customize a object
reference format, click the
click the ... button in the Edit
column

Texts subpage
Characteristics table Allows you to specify the text used to

designate the characteristic for object
references that contain the
Characteristic item.
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Button, command, or option Description
Materials table Allows you to specify the text used to

designate the material for object
references that contain the Material
item.

See also

Manage object references (page 995)

Loading settings
The Loading page and its subpages allow you to adjust certain loading
settings:

• In the current project - when accessed from the  Model Settings
(page 2263)

• In new projects - when accessed from the  Settings dialog (page 2424)

General

Button, command, or option Description
Use load patterning for steel
beams

Allows you to select whether Tekla
Structural Designer applies load
patterns for steel beams.

Use patterning of eccentricity
moments for steel columns

Allows you to select whether Tekla
Structural Designer considers
patterned eccentricity moments in
the design of steel columns.

Pipework Operating & Testing
Content Loadcase Type

Allows you to select whether the
ancillary loadcases created for lines of
pipework are considered as Dead or
Live (Imposed).

Line/Area Ancillary Loading

Button, command, or option Description
Ancillary Type The loadcase names that will be

created when specific ancillary types
have been specified.

Dead/Empty Load The default Dead/Empty Load factors
applied for each type.
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Button, command, or option Description
Live (Imposed)/Content Load The default Live (Imposed)/Content

Load factors applied for each type.
Testing Content Load The default Testing Content Load

factors applied for each type.

Grouping model settings
The Grouping page in the Model Settings dialog box allows you to control the
tolerance applied when members are grouped in the current project.

Button, command, or option Description
Maximum edge length variation Allows for a tolerance to be applied to

the automatic grouping. A member
can only be included in an existing
group if its span length is within the
specified tolerance of the group's
(average) span length.

Maximum length variation Allows for a length tolerance to be
applied to the automatic grouping of
trusses. A truss can only be included
in an existing group if its span length
is within the specified tolerance of the
group's (average) span length.

Maximum height variation Allows for a height tolerance to be
applied to the automatic grouping of
trusses. A truss can only be included
in an existing group if its height is
within the specified tolerance of the
group's (average) height.

Material list settings
The Material List page allows you to specify settings affecting material lists:

• To the current project - when accessed from the  Model Settings
(page 2263)

• To new projects - when accessed from the  Settings dialog (page 2424)

Button, command, or option Description
Ignore openings with area less
than

Allows you to specify the size of
opening that can be considered small
enough to be ignored when
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determining the quantity of necessary
slab reinforcement.

See also

Apply attribute filters to material lists and reports (page 1030)

Beam line settings
The Beam Lines page allows you to control the parameters used for
continuous concrete beam formation:

• In the current project - when accessed from the  Model Settings
(page 2263)

• In new projects - when accessed from the  Settings dialog (page 2424)

NOTE The parameters are only used to control the automatic concrete beam
joining that occurs during the design process or when the Beam Lines
command is run. The parameters are not considered when members
are joined manually using the Join command.

Button, command, or option Description
Join pinned beam end Allows you to control whether joining

should occur or not if a pin is defined
at the end the last span of the first
beam or the start of the first span of
the second beam, the fixity at the end
in question changing from pinned to
continuous once joined. If the beam is
subsequently re-split at the same
location, the pin gets reinstated.

Limiting join angle in plan Specifies the limiting angle in plan to
be applied for joining beams. Only
beams meeting in plan at an angle
less than the specified value can be
joined. Where two beams start at the
end of the first, the one that has the
minimum angle is the one that gets
connected.

Limiting join angle in elevation Specifies the limiting angle in
elevation to be applied for joining
beams. Only beams meeting in
elevation at an angle less than the
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specified value can be joined. Where
two beams start at the end of the
first, the one that has the minimum
angle is the one that gets connected.

Minimum section overlap Allows you to apply a tolerance when
joining beams if they do not fully
overlap in section. You can use it to
prevent joining if there is very little
physical overlap between the beam
cross sections.

See also

Automatically join all concrete beams (page 505)

Analysis Model settings
On the Analysis Model page you can adjust certain rigid zone, curved beam,
and concrete column centerline settings:

• In the current project - when accessed from the  Model Settings
(page 2263)

• In new projects - when accessed from the  Settings dialog (page 2424)

Rigid Zones

Design codes allow engineers to assume parts of concrete beams or columns
are rigid, leading to more efficient designs.

NOTE Rigid zones should not be confused with rigid offsets, which are used
to ensure that the analysis model is properly connected. You can have
rigid offsets in the model even if rigid zones are turned off.

Button, command, or option Description
Percentage of rigidity Allows you to specify the extent of the

rigid zone created. The option has an
effect only if rigid zones are applied
(see below).

Rigid zones not applied Allows you to switch rigid zones on or
off. The option affects where releases
are applied in the analysis model and
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where members start and end for
design.

When rigid zones are not applied, the
design model corresponds to the
analysis model, whereas when they
are applied, the design model is
defined between the ends of the rigid
zones.

NOTE There is a significant difference between Rigid zones not applied and
rigid zones applied with 0% rigidity. The total elastic length of a
member will be the same in the two models, but the position of
releases and start or end of design members will be different.

Curved Beams

In the solver model, curved beams are replaced by a series of straight line
solver elements. The number of solver elements used being controlled by the
Maximum facet error that has been specified.

Button, command, or option Description
Maximum facet error For any given chord height, reducing

this value increases the number of
solver elements used to represent the
curve.

Column Centerlines

For concrete columns connected to a two-way slab, the column perimeter
shape is cut out of the slab 2D element mesh. Stiff analysis ‘rigid link’ elements
then connect the column centerline (where the column 1D elements are
located) to the 2D mesh nodes. In some circumstances - for example for L-
section columns of certain proportions - very short link elements could result,
which could cause validation errors or warnings and analysis solution
problems.

The following settings are provided in order to move the column centerline a
small distance where needed to avoid these problems.
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Automatically move column
centerlines when the smallest rigid
link is less than the error limit for
1D element length

This option is initially on by default.

The error limit used in this check is
specified in Validation settings
(page 2273)

Automatically move column
centerlines when the smallest rigid
link is less than the warning limit
for 1D element length

This option is initially off by default.

The warning limit used in this check is
specified in Validation settings
(page 2273)

Validation settings
The Validation page of the Model Settings dialog box allows you to control
the checks that are applied when the current model is validated.

Button, command, or option Description
Error limit for length Allows you to control when an error is

displayed when very short analysis
elements are detected.

Warning limit for length Allows you to control when a warning
is displayed when very short analysis
elements are detected.

Error limit for quality Allows you to control when an error is
displayed when poor quality 2D
elements are detected.

NOTE 2D element quality depends
on two things: skew and
aspect ratio. 0% is bad
quality: a squashed triangle
tends towards bad quality,
whereas 100% is perfect
quality, so an equilateral
triangle is perfect quality.

Warning limit for quality Allows you to control when a warning
is displayed when poor quality 2D
elements are detected.

Check for validation warnings Allows you to specify which model,
analysis, and design validation checks
are performed. If a box is cleared, the
validation check is not performed.
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Load reduction settings
The Load reductions page in the Model Settings dialog box allows you to
control the live load reductions.

Button, command, or option Description
Reduction percentage column The cells in this column allow you to

specify the reduction that is applied
for the number of floors carried.

See also

Activate reductions in live or imposed load cases (page 515)

EHF settings
The EHF page in the Model Settings dialog boxis used to control the
percentages of load used for the EHF calculations when working to Eurocodes.
The percentages are material independent, which means that the same
percentages are used for concrete and steel. The percentages vary depending
on the height of the structure and the number of columns in each direction.

Button, command, or option Description
Height of the structure Allows you to specify the effective

height of the structure to be used in
the EHF calculations.

Set Default Sets the height of the structure to the
highest construction level.

Number of columns in X direction In the Eurocode Cl 5.2(5) the
calculation of the reduction factor am
depends on the number of
contributing members, m.

Valid input for m in the X and Y
directions is any whole number from
1 to 1000. The default value is 1 which
results in am = 1.000. If a value of
1000 is entered then am would reduce
to 0.707.

Number of columns in Y direction

Global initial sway imperfections Displays the calculated alpha values
and phi percentages for the above
input.

See also

Display notional forces and seismic equivalent lateral forces (page 677)
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User-defined attribute settings
The User Defined Attributes page allows you to control the attributes that
are available:

• In the current project - when accessed from the  Model Settings
(page 2263)

• In new projects - when accessed from the  Settings dialog (page 2424)

You can add new attribute definitions, delete them, set a type for each
attribute, and adjust the acceptable values.

Button, command, or option Description
Name Displays and allows you to modify the

name of the attribute that will be
displayed in the UDA section of the
Properties window.

Type list Allows you to specify a type for the
option. The options are text, number,
and file.

Source list Allows you to restrict the allowable
input of the attribute, if necessary.
The two options are:

• Custom Value: Does not restrict
the allowable input.

• Value List: Restricts the allowable
input for an attribute to a pre-set
list.

Values Allows you to specify the allowable
attribute values when the source is
set to Value List.

Add Creates a blank row that allows you to
define a new attribute.

Delete Deletes the currently selected
attribute from the table.

Move Up Move the currently selected attributes
up or down in the table and in the
Properties window.

Move Down

See also

Create and manage user-defined attributes (page 1026)
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Graphics view settings
The Graphics View Settings page in the Model Settings dialog box allows
you to control the display of miscellaneous items in 2D and 3D views in the
current project.

Button, command, or option Description
Do not display values of storey
shear below

Allows you to limit the values of
storey shear for a new model. This
way, you can easily ignore the small
values of storey shear that might
otherwise detract you from the more
important storey shear values. The
storey shear values that are less than
the limiting value are not displayed in
the results view.

Show full pile length Allows you to select whether Tekla
Structural Designer displays the full
length of piles or a shorter pile length
that you can specify.

2x scale for steel columns Allows you to double the scale of steel
columns in 2D views in order to
simplify viewing the columns and
their orientation.

Structural BIM settings
The Structural BIM page and its subpages allow you to control the structural
BIM import and export processes:

• In the current project - when accessed from the  Model Settings
(page 2263)

• In new projects - when accessed from the  Settings dialog (page 2424)

Button, command, or option Description
Export --> Continuous Objects subpage
Separate objects for each stack Allows you to select which columns

are exported as separate objects.

NOTE Tekla Structural Designer
organizes rebar information
by stacks and spans. If you do
not export concrete
members as separate
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objects, no rebar information
is exported.

Separate objects for each span Allows you to select which beams or
other members are exported as
separate objects.

NOTE Tekla Structural Designer
organizes rebar information
by stacks and spans. If you do
not export concrete
members as separate
objects, no rebar information
is exported.

Separate objects for each panel Allows you to select which wall types
are exported as separate objects.

Export --> Reinforcement Information subpage
Concrete columns Allows you to select whether bar

marks are included in the exported
concrete column reinforcement
information.

Concrete beams Allows you to select whether bar
marks, link leg count, and region
length percentage are included in the
exported concrete beam
reinforcement information.

Export --> Mappings subpage
Materials --> Reset mappings for
Structural BIM export

Resets the mappings for Structural
BIM export of materials to the default
settings.

Decking --> Reset mappings for
Structural BIM export

Resets the mappings for Structural
BIM export of decking to the default
settings.

Import --> Settings subpage
Concrete beams --> Default "Allow
automatic join"

Allows you to control whether new
imported concrete beams are
automatically joined or not at the end
of the import.

NOTE If the BIM model contains
continuous beams as one
piece, you might want to
clear the option. After the
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import, you can change the
properties back, if necessary.

Steel columns --> Ignore splice
offsets in physical member
positions

Allows you to select whether splice
offsets are ignored when importing
physical member positions.

Import --> Mappings subpage
Materials --> Reset mappings for
'TEL' File import

Resets the mappings for TEL file
import of materials to the default
settings.

Materials --> Reset mappings for
Structural BIM import

Resets the mappings for Structural
BIM import of materials to the default
settings.

Decking --> Reset mappings for
Structural BIM import

Resets the mappings for Structural
BIM import of decking to the default
settings.

See also

Import a project from a Structural BIM Import file (page 301)

Analysis Settings
The Analysis Settings page and its subpages allow you to adjust the options
applied to the different analyses:

• In the current project - when accessed from the Analysis Settings dialog
(page 2398) on the Analyze tab.

• In new projects - when accessed from the Settings dialog (page 2424) on
the Home tab.

1st order non-linear settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 100.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default = 0.0001.
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Relative Default: ON.
Relaxation Factors Relaxation factors control an amount

of nominal compression tension-only
braces can undergo while remaining
active during analysis iteration. This
improves convergence for rare
problematic models/ loading
situations in which otherwise most or
all braces may experience
compression and become inactive,
causing instability and preventing
solution. When converged tension-
only braces will still have only either
zero or tension force. The process is
entirely automatic by default and it is
anticipated the factors will not require
manual editing for most
circumstances.

• Use relaxation factors for
tension only elements: Default =
cleared

• Minimum relaxation factor:
Default = 0.1

• Maximum relaxation factor:
Default = 0.5

If the model still fails to converge
when using relaxation factors,
expanding the allowable range (by
changing the above minimum and
maximum values) may produce
convergence.

NOTE Relaxation factors are not
activated by default, as it is
anticipated they will not be
required for the majority of
models. In addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.
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2nd order non-linear settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 100.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default = 0.0001.

Relative Default: ON.
Relaxation Factors Relaxation factors control an amount

of nominal compression tension-only
braces can undergo while remaining
active during analysis iteration. This
improves convergence for rare
problematic models/ loading
situations in which otherwise most or
all braces may experience
compression and become inactive,
causing instability and preventing
solution. When converged tension-
only braces will still have only either
zero or tension force. The process is
entirely automatic by default and it is
anticipated the factors will not require
manual editing for most
circumstances.

• Use relaxation factors for
tension only elements: Default =
cleared

• Minimum relaxation factor:
Default = 0.1

• Maximum relaxation factor:
Default = 0.5

If the model still fails to converge
when using relaxation factors,
expanding the allowable range (by
changing the above minimum and
maximum values) may produce
convergence.

NOTE Relaxation factors are not
activated by default, as it is
anticipated they will not be
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required for the majority of
models. In addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.

1st order modal settings

Button, command, or option Description
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Automatic (default option):
Initially uses the Subspace option
to find the lowest modes. If the
criteria (either mass or number of
modes) is not fulfilled, FEAST is
then automatically used to find
higher modes until the stopping
criteria is fulfilled.

• Jacobi: An iterative transformation
method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly
finding the lowest frequencies in
medium to large models.

• FEAST: uses the FEAST algorithm
to effectively calculate all the
eigenvalues within a specific
range. Suitable for any size
structure. For more information,
see: http://www.ecs.umass.edu/
~polizzi/feast/.

Mass Model Allows you to select how the mass
model of the analysis is displayed.
The options are:
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• Consistent

• Lumped
Mass reporting For users that wish to determine a

center of mass for each floor, the
Simple mass option is available to
simplify the calculation. A single value
of mass for each node is listed in the
Tabular Data for both the "Active
Masses by Node" & "Total Masses by
Node" view types.

The simple mass is calculated by
averaging the mass values in the
active directions.

NOTE It is recommended that the
simple mass option is used
only when the lumped mass
model is used.

Stopping Criteria Stopping criteria prevent analysis
continuing forever. If either of the
criteria (Maximum number of
modes or Stopping Frequency) are
met, the analysis will not look for any
more modes.

Modes Allows you to select one of the
following options:

• Automatic number of modes: If
the option is selected, you must
specify the mass participation
required in each direction. You can
optionally specify an initial
number of modes that should be
close to the actual number
required in order to speed up the
analysis process.

• Total number of modes: If
Automatic number of modes is
cleared, you can specify the total
number of modes required. The
default value is 10.

Jacobi Allows you to adjust the following
settings:
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• Maximum number of sweeps: A

sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
maximum number of sweeps
allowed.

• Sweep tolerance: At the end of
each sweep, values are checked
against the previous sweep
results. If the difference is less
than the tolerance specified here,
the result is converged, and the
analysis is complete.

Subspace Allows you to adjust the following
settings:

• Maximum number of iterations:
The number of iterations to
perform.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance specified here,
the result is converged, and the
analysis is complete.

FEAST Allows you to adjust the following
settings:

• Initial search range: Specifies the
initial range of values FEAST will
search for eigenvalues in.

• Overestimation multiplier:
Specifies the initial guess for the
subspace dimension within each
range; an overestimate of the
predicted number of modes in the
range.

• Maximum modes in range: The
maximum number of modes in
the range. If more modes are
found in a range, the range is split
into several smaller ranges.

• Minimum search range: When a
range is smaller than the value
specified here, it will no longer be
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split, even if the maximum
number of modes is greater than
that allowed.

2nd order buckling settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 1000.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default =
0.00001.

Maximum number of sweeps A sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
maximum number of sweeps
allowed. Default = 50.

Sweep tolerance At the end of each sweep, values are
checked against the previous sweeps
results. If the difference is less than
the tolerance determined here the
result is converged, and the analysis
is complete. Default = 1.0E-12.

Total number of modes Allows you to specify the total
number of modes required. Default =
10.

Show negative buckling factors Default = OFF.
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Jacobi: An iterative transformation
method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly

Tekla Structural Designer reference 2284 Settings



Button, command, or option Description
finding the lowest frequencies in
medium to large models.

• Automatic (default option): Tekla
Structural Designer determines
the most appropriate extraction
method for the structure.

1st order seismic settings

Button, command, or option Description
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Automatic (default option):
Initially uses the Subspace option
to find the lowest modes. If the
criteria (either mass, or number of
modes) is fulfilled, FEAST is then
automatically used to find higher
modes until the stopping criteria is
fulfilled.

• Jacobi: An iterative transformation
method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly
finding the lowest frequencies in
medium to large models.

• FEAST: uses the FEAST algorithm
to effectively calculate all the
eigenvalues within a specific
range. Suitable for any size
structure. For more information,
see: http://www.ecs.umass.edu/
~polizzi/feast/.

Mass Model Allows you to select how the mass
model of the analysis is displayed.
The options are:
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• Consistent

• Lumped
Mass reporting For users that wish to determine a

center of mass for each floor, the
Simple mass option is available to
simplify the calculation. A single value
of mass for each node is listed in the
Tabular Data for both the "Active
Masses by Node" & "Total Masses by
Node" view types.

The simple mass is calculated by
averaging the mass values in the
active directions.

NOTE It is recommended that the
simple mass option is used
only when the lumped mass
model is used.

Stopping Criteria Stopping criteria prevent analysis
continuing forever. If either of the
criteria (Maximum number of
modes or Stopping Frequency) are
met, the analysis will not look for any
more modes.

Modes Allows you to modify the following
options:

• Initial number of modes: In
order to speed up the analysis
process, you can specify an initial
number of modes you expect to
be required to achieve the
required participation. The value
specified here should be close to
the actual number required
because if you enter too few or
too many modes, the analysis may
take longer.

• Mass participation for RSA:
Allows you to specify the mass
participation required in each
direction. If this isn't achieved
before the stopping criteria apply,
the RSA analysis will still be
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performed, but a warning will be
issued.

• Min. Mass participation for RSA:
If the minimum participation isn't
achieved before the stopping
criteria apply, the RSA analysis is
not performed.

NOTE The options in Stopping
Criteria overrule both the
number of modes and mass
percentage.

Jacobi Allows you to adjust the following
settings:

• Maximum number of sweeps: A
sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
maximum number of sweeps
allowed.

• Sweep tolerance: At the end of
each sweep, values are checked
against the previous sweeps
results. If the difference is less
than the tolerance determined
here the result is converged, and
the analysis is complete.

Subspace Allows you to adjust the following
settings:

• Maximum number of iterations:
The number of iterations to
perform.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete.

FEAST Allows you to adjust the following
settings:
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• Initial search range: Specifies the

initial range of values FEAST will
search for eigenvalues in.

• Overestimation multiplier:
Specifies the initial guess for the
subspace dimension within each
range; an overestimate of the
predicted number of modes in the
range.

• Maximum modes in range: The
maximum number of modes in
the range. If more modes are
found in a range, the range is split
into several smaller ranges.

• Minimum search range: When a
range is smaller than the value
specified here, it will no longer be
split, even if the maximum
number of modes is greater than
that allowed.

Modal Combination Method To determine the representative
maximum response of interest for a
load case, the relevant values for each
relevant mode are combined by using
the modal combination method
specified here. Note that once modes
have been combined, the relative
signs are lost. The options are:

• Complete Quadratic
Combination (CQC): Suitable for
models where modes are closely
spaced or well spaced.

• Square Root of Summation of
Squares (SRSS): Suitable only for
models where modes are well
spaced.

Iterative cracked section analysis settings

Button, command, or option Description
Global Convergence Criteria Allows you to modify the following

options:
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• Maximum number of iterations:

The number of iterations to
perform. Default = 200.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.00100.

• Relative: Default: ON.

TIP To resolve global convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

Local Convergence Criteria Allows you to modify the following
options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 500.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.000001.

• Smoothing Parameter: A
property only available for the
Eurocode head code. Default =
0.005.

TIP To resolve local convergence
failures:
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• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

• If you are using the
Eurocode head code,
increase the value in
Smoothing Parameter.

Modification factors

Different factors can be applied for each of the different materials in the
model in order to adjust the following properties:

• E: Young's modulus

• G: Shear modulus

• Itorsion: Section inertia about local X

• Imajor: Section inertia about local Y

• Iminor - Section inertia about local Z

• Area: Section area in compression or tension

• Aparallel to minor: Section shear area in local Y

• Aparallel to major - Section shear area in local Z

• t: shell thickness (applicable to concrete only)

The factors also vary according to the member types, (and in the case of
concrete members whether they are cracked or not).

For concrete members in particular, design codes can require that analysis
stiffness adjustment factors are applied since the appropriate properties to
use in analysis are load and time dependent.

For various other investigations it is also possible that you will want to apply
an adjustment to material properties. One suggested example is the
assessment of structures subject to corrosion. Another classic requirement in
this regard relates to torsion, it is common engineering practice to assume
that if it will work without assuming any torsional strength, then torsion can be
ignored.

Although default modification factors for each material are provided in the
settings sets to reflect the design code being worked to, you should check that
these are appropriate for your particular analysis model.
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NOTE If you make changes to any of the modification factors, analysis must
be repeated.

Meshing settings
The meshing options can be adjusted in order to fine-tune the meshes that
are produced in slabs and walls. The default settings are generally
appropriate, but they could potentially be adjusted if 2D element quality
errors are being created during validation.

Composite steel beams settings

Button, command, or option Description
Inertia used for loading analysis list Allows you to specify the inertia to be

used in the global analysis of the
model for a composite steel beam:

• Steel beam (default option)

• Long term composite

• Short term composite

NOTE • If the model still fails to
converge when using
relaxation factors,
expanding the allowable
range (by changing the
above minimum and
maximum values) may
produce convergence.

• Relaxation factors are not
activated by default as it is
anticipated they will not
be required for the
majority of models. In
addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.

The inertia has different
effects on different head
codes:
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• US head code:

Long and short term
composite inertia only
apply to rolled symmetric
I sections without web
openings. For all other
sections, the standard
steel beam inertia is used
regardless of the analysis
option selected.

• EC head code:

Long and short term
composite inertia only
apply to:

• Symmetric I rolled
sections without web
openings

• I plated sections
without web openings

• Westok plated sections
without web openings

• Fabsec sections
without web openings

For all other sections, the
standard steel beam
inertia is used regardless
of the analysis option
selected.

• BS head code:

Long and short term
composite inertia only
apply to:

• Symmetric I rolled
sections without web
openings

• Asymmetric I rolled
sections without web
openings

• I plated sections
without web openings
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• Westok plated sections
without web openings

• Fabsec sections
without web openings

For all other sections, the
standard steel beam
inertia is used regardless
of the analysis option
selected.

• AUS and IS head codes:

Design of composite
beams is not currently
supported for the head
codes.

Design Settings
The Design Settings subpages allow you to control the design options
applied:

• to the current project - when accessed from the Design Settings dialog
(page 2404) on the Design tab.

• to new projects - when accessed from the Settings dialog (page 2424) on
the Home tab.

Design Settings contains the following subpages:

• Analysis (page 2294)

• General (page 2294)

• Concrete > Cast-in-place (page 2296)

• Concrete > Precast

• Composite Beams (page 2322)

• Design Forces (page 2323)

• Design Groups (page 2339)

• Autodesign (page 2340)

• Design Warnings (page 2341) (AISC/ASC only)

• Steel Joists (page 2345)

• Sway and Drift Checks (page 2346)

• Fire checks (page 2347)

Tekla Structural Designer reference 2293 Settings



Design Settings - General and Analysis

General design settings

Button, command, or option Description
Fix column nodes horizontally Allows you to automatically apply

lateral translational fixed supports to
column nodes for the 3D building
analysis performed during the gravity
design processes.

The option is useful at the early
design stage when lateral systems
have not been established. The
automatic lateral supports can
remove unwanted lateral
displacements that may prevent the
analysis from completing and
produce unrealistic forces.

NOTE The option does not apply to:

• The column nodes that
are in a rigid floor
diaphragm

• An analysis run as a
separate process

• The Analyze All (Static)
command

• The 3D building analysis
performed during any
Design (Static) command

Analysis settings

Button, command, or option Description
Analysis Allows you to select if a first or second

order 3D building analysis is
performed.

TIP For steel structures in particular
you should consider running a
first-order analysis for the initial
gravity design before switching
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Button, command, or option Description

to a second-order analysis for
the final design.

In addition, Solve lateral loadcases
in isolation if non-linear analysis is
required during design allows you to
try to solver lateral load cases in
isolation if non-linear analysis is
required. However, in non-linear
analysis, lateral load cases often fail
to solve or take a long time to
converge when considered in
isolation, especially for compression
only foundation mats. Therefore, we
recommend that you leave the option
cleared.

If you need to see the results for the
individual lateral load cases, you can
either run the analysis directly on the
Analyze tab, or select the option if
you know that the analysis does not
fail.

Stability coefficient tolerance

United States head code (ACI/AISC)
head code only

Stack height / ratio allows you to
adjust the value of deflection that can
safely be ignored. Selecting the option
prevents any small deflections from
causing erroneously high stability
coefficients in stability coefficient
calculations.

NOTE If the second order drift is
less than the tolerance
specified in Stack height /,
the stability coefficient value
is returned as N/A with a note
that states that the drift is
small enough to be ignored.

Reduced stiffness factor

United States head code (ACI/AISC)
head code only

This factor is only exposed once the
analysis is set to second-order.

It is applied to the stiffness (EI and EA)
of all steel members in addition to
any settings made on Analysis
Options, Modification Factors.
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Button, command, or option Description
For correct design to the AISC
Specification using the DAM, it should
be set to 0.8.

NOTE As an alternative to setting
the analysis to first-order to
explore the reason for any
second order analysis failure,
it is possible to alter this
factor. If you set it to a value
of say 10, this will stiffen both
the Modulus of elasticity (E)
and the shear modulus of
elasticity (G) by a factor of 10
in the second order analysis.
Although the results will not
be able to be used for a valid
design, it should now be
possible to run the analysis to
see which member might fail
a design and hence be the
cause of the analysis
instability. This factor can
then be reduced towards 0.8
for further investigation.

Design Settings - Concrete > Cast-in-place

General

Buttons, commands, or options Description
Limitation on concrete cylinder strength for shear/torsion design
(Eurocode only)
Normal weight concrete limit

Lightweight concrete limit

For shear/torsion design the cylinder
strength and its use in all derived
mechanical properties is limited (but
'overridable') for specific national
annexes.

Default national annex values of these
limits for normal weight/lightweight
respectively:

• UK, Eire, Singapore, Malaysia: 50/50

• Norway: 65/55
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Buttons, commands, or options Description
• EU, Finland, Sweden: 90/90 (no limit

stated)

NOTE Changing the headcode/settings
set does NOT update these values
automatically.

Reinforcement anchorage length parameters

(used in the calculation of the ultimate bond stress, from which anchorage
lengths are determined)
Plain Bars Bond Quality
Modifier

Default value 0.5.

Deformed Bars Bond Quality
Modifier

Default value 0.8. Only applies to the
Eurocode head code.

Type-1 Bars Bond Quality
Modifier

Default value 1.0. Only applies to the
Eurocode head code.

Type-2 Bars Bond Quality
Modifier

Default value is 1.0. Only applies to the
ACI headcode.

Beam

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Longitudinal bars Allows you to adjust the following settings

applied to longitudinal bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the longitudinal bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the longitudinal bar design
process.

• Minimum side bar size: Sets the
minimum allowable side bar size that
can be used in the longitudinal bar
design process.

• Minimum top steel clear spacing:
Sets the minimum allowable top steel
clear spacing that can be used in the
longitudinal bar design process.
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Buttons, commands, or options Description
• Minimum bottom steel clear

spacing: Sets the minimum allowable
bottom steel clear spacing that can be
used in the longitudinal bar design
process.

• Maximum tension steel spacing:
Sets the maximum allowable tension
steel spacing that can be used in the
longitudinal bar design process.

• Maximum compression steel
spacing: Sets the maximum allowable
compression steel spacing that can be
used in the longitudinal bar design
process.

• Use single bars when beam width
<=: Single bars are only permitted in
beams whose width is less than the
width specified.

• Steel overstrength factor: Sets the
value that accounts for the
reinforcement steel yielding
overstrength in seismic design. Only
applies to the ACI headcode.

Short span maximum length Spans smaller than the value set here are
treated as short spans. Support bars of
short spans are merged with the span
bars.

. . . . Detailing Settings

Buttons, commands, or options Description
Use same size bars in
multilayer arrangements

Allows you to use the same bar size in
each layer.

Use same number of bars in
each layer

Allows you to use the same number of
bars in each layer.

Cut length rounding increment Allows you to specify a value to which cut
lengths are rounded.

Merge identical longitudinal
bars if appropriate

Allows you to merge bars of the same
size, number, and position, provided that
the total length of the merged bar does
not exceed the max allowable bar length.

TIP The max bar length can be verified
on the Reinforcement page of the
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Materials dialog box. To do so, click
an available bar size and then, click
View...

NOTE Top bar patterns 1 and 2 do not
have any bars that you could
merge.

Extend top longitudinal
support bars symmetrically

Extends the support bars symmetrically to
both spans based on the larger effective
span length; but only if the spans vary by
less than the percentage specified.

Extend top longitudinal
support bars by anchorage
length

Adds anchorage lengths to the calculated
extension lengths.

Min anchorage length {value} x
dia

Allows you to control the minimum
anchorage length as a multiple of bar
diameter.

NOTE The option is only available for
the Eurocode headcode.

Min anchorage length of plain
bars {value} x dia

Allows you to control the minimum
anchorage length as a multiple of bar
diameter when the rib type is plain.

NOTE The option is only available for
the ACI headcode.

Extend top span bars to end
support

Extends the top span bars of the first and
last spans to the end supports.

Use 'U' bars at end support if
appropriate

Allows you to replace the top and bottom
bars at the end support region with 'U'
bars under certain conditions. The bars
that are joined or merged to create the 'U'
bars depend on the top and bottom
patterns selected for the beam.

The anchorage lengths for the resulting
'U' bars are taken as the lengths required
for the pair of bars that made the 'U' bar.

Select same bar size in support
region and in the span

Allows you to use the same bar size in the
support and span regions.
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Select symmetrical stirrup in
support region

Allows you to use the same stirrup
arrangement (bar size and spacing) in
both supports.

. . . . Top / Bottom Longitudinal Bar Pattern

Buttons, commands, or options Description
Longitudinal Bar Pattern Allows you to select a pattern to be

viewed and modified.
Longitudinal Default Pattern Allows you to select the pattern that is

applied to new beams when they are first
created.

NOTE The Longitudinal Default
Pattern option cannot be used to
change the pattern applied to
existing beams. Instead, you
should modify the beam
properties.

Continuous Span + Cantilever
(Backspan) tab

Allows you to define how the selected
longitudinal bar pattern is applied to
continuous spans and cantilever
backspans. An interactive diagram
updates to match the changes you make.

• Bars: Selected checkboxes that are
greyed out are mandatory for the
selected pattern. Other bars can
optionally be included in the pattern
according to your needs.

• Region fields: The regions in which
bars are applied are defined as a
percentage of the span length.

• Bar lapping: Select whether you want
to lap the bottom bars in the middle of
the support region (inside support) or
at the face of the support region
(outside support).

Single Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
single spans. An interactive diagram is
also displayed and updates to match the
changes you make.

Cantilever Allows you to define how the selected
longitudinal bar pattern is applied to
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Buttons, commands, or options Description
cantilevers. An interactive diagram
updates to match the changes you make.

. . . . Stirrup (Link) Settings

Buttons, commands, or options Description
Normal When considering shear, the design shear

checks are performed in each of 3 regions
S 1 , S 2, and S 3 as shown below. In each
region, the maximum vertical shear from
all load combinations is determined and
this maximum value used to determine
the shear reinforcement required in that
region.

• Region S1, Region S2, Region S3: The
regions are defined as fixed
proportions of the clear span of the
beam. By defining the extent of the S1
region, the other regions are
determined automatically.

• Stirrup Type: Select either open or
closed stirrups in the list.

Cantilever In cantilevers, the design shear checks are
performed in 2 regions S 1 and S 2 as
shown below.

Minimum bar size Sets the minimum allowable bar size that
can be used in the design process.

Maximum bar size Sets the maximum allowable bar size that
can be used in the design process.

Minimum spacing Sets the minimum allowable stirrup
spacing that can be used in the design
process.
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Maximum spacing Sets the maximum allowable stirrup

spacing that can be used in the design
process.

Spacing increment The designed stirrup spacings are
multiples of this value.

Maximum stirrup leg spacing
across beam

Allows you to determine if single stirrups,
double stirrups, or more are required,
depending on the width of the beam.

Use single outside stirrup Allows you to use a single outside link
with additional links added as required (as
per stirrup d shown dotted below).

Accept single leg internal
stirrup

Allows the use of single leg internal links
(as per stirrup c shown dotted below).

Optimize stirrup design regions
where possible

In this case in the central region S2, shear
reinforcement is provided to meet the
minimum of the code requirement or
user preference whilst in regions S1 and
S3, designed shear reinforcement is
required.

The position and length of region S2 is
determined from considerations of the
shear resistance of the concrete cross-
section and this then enables the lengths
of regions S1 and S3 to be determined.

. . . . General Parameters

Buttons, commands, or options Description
Partial fixity coefficient, β A coefficient applied to the maximum

positive moment in the beam span
(excluding support positions) to set a
user-defined minimum design moment
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for beam support regions. Allowable
range is 0.0 to 1.0. Default value is 0.25

NOTE The option is only available for
the ACI headcode.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Long term deflection period Allowable range is 3 to 60 months. Default
value is 60 months.

NOTE The option is only available for
the ACI headcode.

Time at which brittle finishes
are introduced

Allowance range is 1 to 6 months. Default
value is 1 month.

NOTE The option is only available for
the ACI headcode.

Design Beams for FE
Chasedown analysis results

Allows you to specify that the beams are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.
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Tolerance on rectilinearity The calculation of the effective width is

only carried out for concrete beams if
they lie within the tolerance on
rectilinearity set here. The default
tolerance is 15 degrees. At greater angles
you will be prompted to enter the
effective width manually.

Column

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Vertical bars Allows you to adjust the following settings

applied to vertical bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the vertical bar
design process.

• Maximum center spacing: Sets the
maximum value for bar spacing when
a column is set to auto design mode.
The exact spacing may be reduced to
meet the requirements of the design if
the design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the
concrete section area.
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• Maximum reinforcement ratio: Sets

the maximum allowable area of
reinforcement as a ratio of the
concrete section area.

• Steel overstrength factor: Sets the
value that accounts for the
reinforcement steel yielding
overstrength in seismic design.

Tie bars Allows you to adjust the following settings
applied to tie bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the tie bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the tie bar design process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the tie bar design
process.

• Maximum center spacing: Sets the
maximum value for bar spacing when
a column is set to auto design mode.
The exact spacing may be reduced to
meet the requirements of the design if
the design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

Multiple Layers For circular column sections only, if
autodesign requires a 2nd layer of
reinforcement you can control the layer
spacing. Autodesign will use a larger
spacing if needed - and it is checked in the
check results.

Aspect ratio change point Allows you to specify a value that
determines which rectangular sections
are considered to have a low aspect ratio
and which are considered to have a high
aspect ratio.
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Use double ties for low aspect
ratio

Allows you to use double ties where
applicable instead of single ties for
sections with a low aspect ratio.

Use double ties for high aspect
ratio

Allows you to use double ties where
applicable instead of single ties for
sections with a high aspect ratio.

Use triple ties for low aspect
ratio

Allows you to use triple ties where
applicable instead of double or single ties
for sections with a low aspect ratio.

Use cross ties for low aspect
ratio

Allows you to use cross ties where
applicable instead of triple, double or
single ties for sections with a low aspect
ratio.

. . . . Detailing Settings

Buttons, commands, or options Description
Cut length rounding increment Allows you to specify a value to which cut

lengths are rounded.
Kicker dimension Allows you to specify the height of column

kicker cast above the slab level.
Assumed foundation depth for
starter bars

Allows you to control the length of starter
bars at the base of the column in
drawings.

Join identical bars where
possible

Allows you to merge bars together only if
the bar size and layout in the current and
adjacent stack are identical and proving
that the max bar length is not exceeded.

Number of span region ties
required to use separate
regions

Allows you to specify the minimum
number of span region ties that are
necessary for a span region to be
indicated on the detail, and in
consequence, standardize the tie spacing
on the detail.

Provide ties through full
foundation depth

Allows you to draw ties through the full
depth of the foundation.

Foundation penetration depth
of ties

Allows you to specify the penetration
depth of ties into the foundation.

NOTE The option is only available in the
If the Provide ties through full
foundation depth option is
cleared.
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Provide ties through floor
depth for internal walls

For walls restrained by flat slabs: ties are
always provided through the floor depth
irrespective of this setting.

For walls restrained by beam and slab:
ties are always provided through the
beam depth for edge walls but are only
provided for internal walls when the
option is selected. When the option is
cleared, ties are provided up to the soffit
of the shallowest beam depth.

Tie bar type Allows you to select the tie bar type that
you want to use.

. . . . General Parameters

Buttons, commands, or options Description
Bar sizes no smaller than stack
above

Allows you to ensure that bar sizes do not
reduce in lower stacks.

Match bar position to stack
above

Allows you to have the starting
arrangement for longitudinal bars match
the arrangement of the bars in the stack
above if the section geometry matches.

Increase main bar size
preferentially

Allows you to have the corner bars
increased in preference to the
intermediate bars.

All bars start off at the same size (unless
the initial bar size is driven by the current
arrangement or the stack above), but
when the check fails, the corner bars will
be increased in size if all bar sizes are the
same. Otherwise, the intermediate bars
will be increased in size. This means that
when the final design is produced, either
all bars will be the same size or the corner
bars will be one size larger than the
intermediate bars.

Alternatively, if you require all bar sizes to
be the same size, clear the option. This
way, all bar sizes are increased together.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
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anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Design Columns for FE
Chasedown analysis results

Allows you to specify that the columns are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Wall

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Vertical bars Allows you to adjust the following settings

applied to vertical bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the design process.
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• Maximum center spacing: Sets the

maximum value for bar spacing when
a wall is set to auto design mode. The
exact spacing may be reduced to meet
the requirements of the design if the
design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the
concrete section area.

• Maximum reinforcement ratio: Sets
the maximum allowable area of
reinforcement as a ratio of the
concrete section area.

Vertical bars in end zone Allows you to adjust the following settings
applied to vertical bars in the end zone
area:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process in the
end zone area.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process in the end zone area.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the end
zone area.

• Maximum reinforcement ratio: Sets
the maximum allowable area of
reinforcement as a ratio of the end
zone area.

Horizontal bars Allows you to set the minimum allowable
bar size that can be used in the design
process of horizontal bars and the
minimum allowable area of reinforcement
as a ratio of the end zone area.

Tie/horizontal bars Allows you to set the minimum and
maximum allowable bar sizes that can be
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used in the tie/horizontal bar design
process and specify the value whose
multiples the designed bar spacings are.

Tie/confinement bars Allows you to set the minimum and
maximum allowable bar sizes that can be
used in the tie/confinement bar design
process.

Confinement bars in end zone Allows you to set the minimum and
maximum allowable bar sizes that can be
used in the confinement bar design
process.

Substitute loose bars if mesh
inadequate

Allows you to use additional loose bars in
the end zones when the mesh is
inadequate.

. . . . Detailing Settings

Buttons, commands, or options Description
Cut length rounding increment Allows you to specify a value to which cut

lengths are rounded.
Kicker dimension Allows you to specify the height of column

kicker cast above the slab level.
Assumed foundation depth for
starter bars

Allows you to control the length of starter
bars at the base of the wall in drawings.

Join identical bars where
possible

Allows you to merge bars together only if
the bar size and layout in the current and
adjacent stack are identical and proving
that the max bar length is not exceeded.

Number of span region ties
required to use separate
regions

Allows you to specify the minimum
number of span region ties that are
necessary for a span region to be
indicated on the detail, and in
consequence, standardize the tie spacing
on the detail.

Provide ties through full
foundation depth

Allows you to draw ties through the full
depth of the foundation.

Foundation penetration depth
of ties

Allows you to specify the penetration
depth of ties into the foundation.

NOTE The option is only available in the
If the Provide ties through full
foundation depth option is
cleared.
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Provide ties through floor
depth for internal walls

For walls restrained by flat slabs: ties are
always provided through the floor depth
irrespective of this setting.

For walls restrained by beam and slab:
ties are always provided through the
beam depth for edge walls but are only
provided for internal walls when the
option is selected. When the option is
cleared, ties are provided up to the soffit
of the shallowest beam depth.

Tie bar type Allow you to select the tie bar type that
you want to use.Tie bar type in end zones

. . . . General Parameters

Buttons, commands, or options Description
Bar sizes no smaller than stack
above

Allows you to ensure that bar sizes do not
reduce in lower stacks.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Design Walls for FE Chasedown
analysis results

Allows you to specify that the walls are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.
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Slab

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Minimum spacing ( slab auto-
design)

Allows you to set the minimum allowable
clear bar spacing used in the slab item
auto design process.

As the option only applies to slab items, it
allows panel design to more readily select
bars at a wider spacing, while allowing
patch design to more readily pass by
reducing minimum spacing check failures
in the patches.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.

Bar spacing increment Allows you to set a value whose multiples
the bar spacings are.

Maximum bar length Allows you to set the maximum length of
a bar.

Bar length increment Allows you to set a value whose multiples
the bar lengths are.

Use mesh where possible Select to use mesh where possible in bars.
Make bob for top steel of
cantilevers

Allows you to apply a bob to the end of
the top steel in cantilevers.

Auto selection of outer bars Allows you to automatically select the
bars in the outer layer.
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. . . . Patches

Buttons, commands, or options Description
Use mesh where possible Select to use mesh where possible in

patches.
Patch Size Allows you to set the default patch size to

be used.
Center strip width Allows you to set the width of the center

strip in beam patches.
Edge strip width as proportion
of patch width

Allows you to control how the patch width
is split between edge and center strips in
column patches.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Allowance for additional
detailing bars

Allows you to specify a percentage by
which the total mass of bars for slabs or
mats shown in material listing reports and
in slab or mat detailing drawings is
increased.
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Punching Shear

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement bars Allows you to set the minimum and

maximum allowable bar sizes that can be
welded to the rail in the design process
and set the maximum allowable diagonal
spacing for radial layouts.

Spacing along rail Allows you to set the minimum and
maximum allowable bar spacing along
each rail and specify a value whose
multiples the bar spacings are.

Spacing to first reinforcement
line

Allows you to set the minimum and
maximum spacing from the column face
to the first reinforcement line and define
a value whose multiples the spacings
from the column face are.

Auto-design Allows you to select whether the auto
design method is to minimize the bar size
or minimize the number of rails and
specify the minimum number of studs per
face that will be used when auto-
designing from minima.

Diagonal spacing between rails Allows you to set the maximum diagonal
spacing between the outermost studs in
the last critical perimeter for circular
arrangements.

Spacing between rails in Y
direction

Allows you to set the minimum and
maximum allowable rail spacing in the Y
direction and specify a value whose
multiples the bar spacings in the Y
direction are.

Spacing between rails in Z
direction

Allows you to set the minimum and
maximum allowable rail spacing in the Z
direction and specify a value whose
multiples the rail spacings in the Z
direction are.

Spacing from last line to outer
perimeter

Allows you to set the maximum spacing
from the last reinforcement line to the
outer perimeter.
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Foundations - General

Buttons, commands, or options Description
Minimum distance from
column/wall face to base/cap
edge

Allows you to specify the minimum
distance from the column or wall face to
the base edge or cap edge.

Use presumed bearing capacity
method for pad bases and mats
(EN 1997-1 cl.6.5.2.4)

If this option is selected the bearing
pressure is checked for serviceability
combinations using the presumed
bearing resistance specified in the pad
base properties (no ‘STR’ and ‘GEO’
capacities).

NOTE The option is only available for
the Eurocode head code.

Isolated Foundations

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.

Bar spacing increment Allows you to set a value whose multiples
the bar spacings are.

Use mesh where possible Select to use mesh where possible in bars.

Tekla Structural Designer reference 2315 Settings



. . . . Foundation Size

Buttons, commands, or options Description
Minimum depth Allows you to set the minimum allowable

foundation depth.
Maximum depth Allows you to set the maximum allowable

foundation depth.
Auto-design depth increment Allows you to set the depth increment.
Minimum side length Allows you to set the minimum allowable

side length.
Maximum side length / strip
width

Allows you to set the maximum side
length under columns as a distance.

Maximum side length ratio
under columns

Allows you to set the maximum side
length ratio under columns.

Rounding increment for footing
dimensions

Allows you to specify a value to which the
overall footing size is rounded.

Default 3-pile cap shape Allows you to define whether the default
shape is triangular or rectangular when 3
piles are used.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.
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Buttons, commands, or options Description
(Pad Base tab)

Consider passive resistance of
soil for sliding check

Allows you to control whether the passive
resistance of the soil is included in the
check of Sliding Resistance.

(Pad Base tab)

Pad base shear reactions at
pinned bases

Ignorable percentage of passive
pressure

This allows you to ignore small shear
forces at pinned bases. The default of 1%
is typically a negligible load level which
would commonly be ignored. If you do
not want to ignore any shear forces, set
the value to zero.

(Pad Base tab)

FOS for sliding and uplift
checks

Allows you to edit the design safety factor
for these checks.

NOTE The option is only available for
the ACI/AISC head codes.

(Pile Cap tab)

Tolerance for pile position
variation

Allows you to specify the allowable
deviation value of the pile position from
its original plan position. The value is used
in the design moment calculations.

. . . . Piles

Buttons, commands, or options Description
Minimum number of piles for
pile caps under columns

Minimum and maximum numbers of piles
that apply when a pile cap under a
column has been set to auto design the
piles.

Maximum number of piles for
pile caps under columns
Minimum spacing option list Allows you to select whether the

minimum spacing check uses a set
minimum spacing value or a multiple of
the pile width or pile circumference.

Minimum spacing of piles Allows you to set the minimum spacing
value that you can select in the Minimum
spacing option list.

Minimum pile edge distance Allows you to set the minimum distance
from the pile face to edge of foundation.

Pile auto-design method list Allows you to select to use the smallest
number of high capacity piles or more
piles of lowest capacity when a pile cap
has been set to auto design.
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Buttons, commands, or options Description
Limit maximum critical section
size

When selected, allows you to specify a
maximum critical section size as a
multiple of the pile dimension.

Use pile capacity for pile
punching and shear checks

When selected, allows you to use pile
capacity for pile punching and punching
shear checks.

When unselected, the pile load is used.

Mat Foundations

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Minimum spacing ( slab auto-
design)

Allows you to set the minimum allowable
clear bar spacing used in the panel auto
design process.

As the option only applies to slab items, it
allows panel design to more readily select
bars at a wider spacing, while allowing
patch design to more readily pass by
reducing minimum spacing check failures
in the patches.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.

Bar spacing increment Allows you to set a value whose multiples
the bar spacings are.
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Buttons, commands, or options Description
Maximum bar length Allows you to set the maximum length of

bar.
Bar length increment Allows you to set a value whose multiples

the bar lengths are.
Auto selection of outer bars Allows you to automatically select the

bars in the outer layer.
Use mesh where possible Select to use mesh where possible in bars.

. . . . Patches

Buttons, commands, or options Description
Use mesh where possible Select to use mesh where possible in

patches.
Patch Size Allows you to set the default patch size to

be used.
Center strip width Allows you to set the width of the center

strip in beam patches.
Edge strip width as proportion
of patch width

Allows you to control how the patch width
is split between edge and center strips in
column patches.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

Allows you to specify a value used in the
calculation of the ultimate bond stress
from which the anchorage lengths are
determined. The allowable range is 0.5 to
1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation Allows you to specify a value is used in the
calculation to determine the limiting
nominal concrete cover cnom, lim. The full
calculation is:

cnom, lim = cmin + Δcdev
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Buttons, commands, or options Description

NOTE The option is only available for
the Eurocode headcode.

. . . . Piles

Buttons, commands, or options Description
Use pile capacity for punching
check

When selected, allows you to use pile
capacity for the pile punching check.

When unselected, the pile load is used.

Design Settings - Concrete > Precast

Beam

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement settings Allows you to adjust the Reinforcement

Class and nominal cover settings applied
to beam reinforcement:

. . . . Top / Bottom Longitudinal Bar Pattern

Buttons, commands, or options Description
Longitudinal Bar Pattern Allows you to select a pattern to be

viewed and modified.
Longitudinal Default Pattern Allows you to select the pattern that is

applied to new beams when they are first
created.

NOTE The Longitudinal Default
Pattern option cannot be used to
change the pattern applied to
existing beams. Instead, you
should modify the beam
properties.

Continuous Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
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Buttons, commands, or options Description
continuous spans. An interactive diagram
updates to match the changes you make.

• Bars: Selected checkboxes that are
greyed out are mandatory for the
selected pattern. Other bars can
optionally be included in the pattern
according to your needs.

• Region fields: The regions in which
bars are applied are defined as a
percentage of the span length.

NOTE The Top and Bottom Region fields
dictate how many design
sections appear in the Tedds
Calculation - a different design
section is required at each
interface between regions.

Pinned Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
single pinned spans. An interactive
diagram is also displayed and updates to
match the changes you make.

Cantilever Allows you to define how the selected
longitudinal bar pattern is applied to
cantilevers. An interactive diagram
updates to match the changes you make.

. . . . Stirrup (Link) Settings

Buttons, commands, or options Description
Normal When considering shear, the design shear

checks are performed in each of 3 regions
S 1 , S 2, and S 3. In each region, the
maximum vertical shear from all load
combinations is determined and this
maximum value used to determine the
shear reinforcement required in that
region.

• Region S1, Region S2, Region S3: The
regions are defined as fixed
proportions of the span of the beam.
By defining the extent of the S1 region,
the other regions are determined
automatically.
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Buttons, commands, or options Description
Cantilever In cantilevers, the design shear checks are

performed in 2 regions S 1 and S 2.

. . . . General Parameters

Buttons, commands, or options Description
Design Beams for FE
Chasedown analysis results

Allows you to specify that the beams are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Design precast beams for
lifting forces

Allows you to specify that the beams are
also to be designed for lifting forces, (the
lifting check being optional in the Tedds
calculation).

Column

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement settings Allows you to adjust the Reinforcement

Class and nominal cover settings applied
to column reinforcement:

. . . . General Parameters

Buttons, commands, or options Description
Design Columns for FE
Chasedown analysis results

Allows you to specify that the columns are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Design precast column for
lifting forces

Allows you to specify that the columns are
also to be designed for a set of lifting
forces, (the lifting check being optional in
the Tedds calculation).

Design Settings - Composite Beams
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Composite beams

Button, command, or option Description
Tolerance of rectilinearity The calculation of the effective width

of composite beams is only
performed if they lie within the
tolerance on rectilinearity adjusted
here.

The default tolerance is 15 degrees.
At greater angles, you will be
prompted to type the effective width
manually.

Update effective width prior to
design check

Allows you to determine the effective
width each time auto or check design
is run.

When the box is unselected, the
effective width is only set as part of
the initial design.

Design Settings - Design Forces

NOTE Values entered in the Ignorable Forces Below section:

• are considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members via Tekla
Tedds

Values entered in the Minimum Design Forces section:

• are considered when creating member end force reports/drawings and
foundation reaction reports/drawings in Tekla Structural Designer

• are considered when performing connection resistance checks in Tekla
Structural Designer

• are considered when designing connections in Tekla Connection
Designer, or IDEA StatiCa

• are not considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members via Tekla
Tedds

Ignore forces below

NOTE Values entered in the Ignorable Forces Below section:
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• are considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members
via Tekla Tedds

Design  
Ignore Forces Below Allow you to specify appropriate

negligible or nominal force levels to
prevent 3D analysis from exposing
small forces that are normally ignored
in design.

When the small forces in the 3D
analysis are below the specified
levels, they are ignored and the
design in Tekla Structural
Designerproceeds automatically.

Concrete beams (Eurocode only)

Button, command, or option Description
Torsion force % of concrete
resistance

Allows you to limit the maximum
torsion force to a % of the concrete
resistance.

Minimum design forces

NOTE Values entered in the Minimum Design Forces section:

• are not considered when designing steel and cast-in-place
concrete members in Tekla Structural Designer

• are not considered when designing timber or precast members
via Tekla Tedds

These settings provide flexibility to control minimum design values and
rounding increments used in the following:

• Member end force reports/drawings

• Foundation reaction reports/drawings

• Connection resistance checks

• Export of connection forces to another application for design (Tekla
Connection Designer or IDEA StatiCa)
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Setting Description
Brace Force

Axial Force

Click the links to see examples of how
the minimum entered here is used in:

• Member end force reports/
drawings (page 2325)

• Connection resistance checks
(page 2334)

• Exported connection forces
(page 2336)

Beam End Forces

Axial Force

Minor Axis Shear Force

Minor Axis Moment

Major Axis Shear Force

Major Axis Moment

Click the links to see examples of how
the minimums and rounding
increments entered here are used in:

• Member end force reports/
drawings (page 2325)

• Connection resistance checks
(page 2334)

• Exported connection forces
(page 2336)

Rounding Increment for Force

Rounding Increment for Moment
Foundation Reactions

Axial Force

Minor Axis Shear Force

Minor Axis Moment

Major Axis Shear Force

Major Axis Moment

Click the links to see examples of how
the minimums and rounding
increments entered here are used in:

• Foundation reaction reports/
drawings (page 2329)

• Exported connection forces
(page 2336)

Rounding Increment for Force

Rounding Increment for Moment

How Minimum Design Forces are used

The following topics illustrate how Minimum Design Forces are applied in
different areas of Tekla Structural Designer.

Member end force reports/drawings

Tekla Structural Designer reports member end forces (Beam end forces/
Bracing forces) based on analysis results.

The ‘Minimum Design Forces’ inputs under Brace Force/Beam End Forces
allow the user to specify minimum values for the reported forces, and also
apply rounding increments to them.
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NOTE While minimum design values and rounding increments are applied to
the member end force reports/drawings, they have no impact on steel
and concrete member design in Tekla Structural Designer, or timber and
precast design using Tekla Tedds.

Consider a fixed beam with axial force + major/minor shear + torsion + major/
minor moment.

Forces/moments are reported in the Beam End Force report.

The user wants the forces rounded to the nearest 5kN and moments to the
nearest 10kNm so inputs 5kN in the ‘Rounding Increment for Force’ and
10kNm in the ‘Rounding Increment for Moment’ under Beam End Forces.
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The Beam End Forces report displays rounded value of forces and moments.

NOTE The rounding increment for moment applies to major axis and minor
axis moments, but does not apply to torsional moments (Mx).

The user might want the forces reported to be not less than minimum values,
for example they might enter 200kN in the ‘Major Axis Shear Force’ under
‘Beam End Forces.
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This results in the report being updated as follows.

The changes to the rounding increments and mimimum force are also
reflected in the Beam End Forces drawing.
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Foundation reaction reports/drawings

Tekla Structural Designer reports foundation reactions based on analysis
results.

The ‘Minimum Design Forces’ inputs under Foundation Reactions allow the
user to specify minimum values for the reactions, and also apply rounding
increments to them.

NOTE Changed force/moment values are for reporting purposes only.

Consider a fixed end support.

Forces/moments are reported in the Foundation Reactions report.
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The user wants these reported values to be not less than certain minimum
values, so inputs the required minimums under Foundation Reactions.
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The Foundation Reactions report shows minimum design forces/moments
specified by the user.
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The user also wants the forces rounded to the nearest 5kN and moments to
the nearest 10kNm so inputs 5kN in the ‘Rounding Increment for Force’ and
10kNm in the ‘Rounding Increment for Moment’ under Foundation
Reactions.

When the report is updated, any values exceeding the minimums are rounded
up accordingly.
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The changes are also reflected in the Foundation Reactions drawing, which
now shows the same minimum values of design force and moment.
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Connection resistance checks

Tekla Structural Designer performs connection resistance checks for simple
beams and braces which use design forces from the analysis results.

The ‘Minimum Design Forces’ inputs under Brace Force/Beam End Forces
allow the user to specify minimum values for these forces, and also apply
rounding increments to them.

Consider a simple beam connection.

Review Data of Connection Resistance shows the following details.

The user wants the forces rounded to the nearest 5kN so inputs 5kN in the
‘Rounding Increment for Force’ under Beam End Forces.
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By closing and re-opening the Connection Resistance Review Data, the
connection resistance check is updated and now uses the rounded value.

The user also wants a minimum design force of 75 kN for connection
resistance check so inputs 75 kN in the ‘Major Axis Shear Force’ under Beam
End Forces.
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By closing and re-opening the Connection Resistance Review Data once again,
the connection resistance check is updated to use the specified minimum
design force.

Because the minimum design force is being used this is indicated in the table
under the 'Note' column.

Exported connection forces

Forces exported to Tekla Connection Designer or IDEA StatiCa from Tekla
Structural Designer are based on analysis results.

The ‘Minimum Design Forces’ inputs allow the user to specify minimum values
for the exported forces, and also apply rounding increments to them.
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Consider a base plate connection exported to Tekla Connection Designer and
designed for axial load and major shear.

The user wants to design the base plate connection for a minimum shear of 50
kN and for a minimum axial load of 500 kN, so inputs these values under
Foundation Reactions.
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NOTE For other connection types the values under Brace Forces/Beam End
Forces would be edited instead.

Rounding increments could also be applied if required. These would
only apply to forces and moments exceeding the above minimums.

To apply the new minimums to the existing connections, it is necessary to click
Update Connections from the Project Workspace.

The base plate connection is now designed for the minimum shear of 50 kN
and for the minimum axial load of 500 kN specified by the user.
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Design Settings - Design Groups and Autodesign

Design groups

Button, command, or option Description
Members to design using groups Allows you to select the member

types for which you want to apply
grouped design.

When the members are grouped, only
one member in the group is designed.
This design is then copied to the
remaining members in the group, so
that they can be checked. Any failing
member in the group is redesigned,
and the process is repeated until all
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Button, command, or option Description
members pass, or a design is not
possible.

Autodesign settings

  
Reset Autodesign to off... Allows you to control what happens

to individual steel and concrete
member auto design settings and
isolated foundation auto design
settings at the end of the design
process. The options are:

• Always: the auto design setting is
automatically cleared at the end of
the design process, so that each
member is put into check mode.

• Never: the autodesign settings is
always retained as it is at the end
of the design process.

• When check status is at worst:

• Pass: The auto design setting is
only automatically cleared at
the end of the design process
for members with design
status Pass.

• Warning: The auto design
setting is only automatically
cleared at the end of the
design process for members
with design status Pass or
Warning.

• Fail: The auto design setting is
only automatically cleared at
the end of the design process
for members with design
status Pass, Warning, or Fail.

• Invalid: The auto design
setting is only automatically
cleared at the end of the
design process for members
with design status Pass,
Warning, Fail or Invalid.
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• Beyond Scope: The auto

design setting is only
automatically cleared at the
end of the design process for
members with design status
Pass, Warning, Fail, Invalid, or
Beyond Scope.

TIP The most practical use of When
check status is at worst is to
set it to Pass and start with all
members in auto design mode.
At the end of the first design
run, passing members would be
set to check mode, allowing you
to focus on the remaining
members still in auto design
mode.

Design Settings - Design Warnings
Warnings used as guidance during the design of a structure to US seismic
provisions are in effect by default. These can be de-activated as found useful
from this page.

Design Warnings (AISC/ASC Head code only)

Button, command, or option Description
Concrete Seismic Warnings
Specified concrete grade is too low • Compliance with ACI 318-08 and

ACI 318-11 Section 21.1.4.2, “(..) f’c,
shall not be less than 3000 psi.“

• Applies to normal weight
reinforced concrete columns and
beams part of Special Moment
Frames

• Applies to normal weight
reinforced concrete walls assigned
as Special Reinforced Concrete
Structural Walls

• Prompts the designer to increase
the concrete grade of the member

Specified longitudinal
reinforcement grade too high

• Compliance with ACI 318-11
Section 21.1.5.2, “(..)
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Button, command, or option Description
reinforcement resisting earth-
quake induced flexure, axial force,
or both, shall comply with ASTM
A706, Grade 60.”

• Applies to normal weight
reinforced columns and beams
part of Special Moment Frames

• Applies to normal weight
reinforced concrete walls assigned
as Special Reinforced Concrete
Structural Walls

• Prompts the designer to use lower
longitudinal reinforcement grades

Column at the end of the beam is
not in the same seismic frame

• Used to validate if the frame of
which the beam is part of is
correctly set-up as a seismic frame

• Applies to normal weight
reinforced concrete beams part of
a seismic force resisting system

• Applies to both SRFS type and
direction

• Checks both ends of each beam
span

• Prompts the designer to set up a
consistent SFRS type and direction
between all members of the frame

Beam at the end of the column is
not in the same seismic frame

• Used to validate if the frame of
which the column is part off is
correctly set-up as a seismic frame

• Applies to normal weight
reinforced concrete columns part
of a seismic force resisting system

• Checks the top of each column
stack

• Prompts the designer to set up a
consistent SFRS type and direction
between all members of the frame

Beam support region size is too
small

• Compliance with ACI 318-08 and
ACI 318-11 Section 21.3.4.2, “(..)
hoops shall be provided over
lengths not less than 2h measured
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Button, command, or option Description
from the face of the supported
member toward the midspan”

• Applies to normal weight
reinforced concrete beams part of
Intermediate and Special Moment
Frames

• Comes into effect if the length of
the end shear design regions is
smaller than the requirement

• Prompts the designer to review
the shear design regions - Design
options

High seismic to conventional
demand on non-SFRS beams

High seismic to conventional
demand ratio of non-SFRS columns

High seismic to conventional
demand of non-SFRS walls

• Used to recognize when a
member has a significant
contribution to the building’s
lateral force resistance but has not
been assigned to the SFRS with
the required ductility properties

• Specifically apply to each member
type

• The highest non-seismic design
ratio from bending and shear
design is obtained

• The highest seismic design ratio
from bending and shear design is
obtained

• Comes into effect when the ratio
between seismic and non-seismic
values is higher than a given
threshold (default = 1.0)

• The maximum seismic/non-
seismic ratio threshold that
triggers the warning is set through
the Seismic to conventional
minimum demand ratio field
described below

• Prompts the designer to either
include the member in the SFRS or
review the structure layout to
reduce the contribution of the
member to the lateral force
resistance
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Button, command, or option Description
Non-SFRS design requirements
applicable in SDC D-F

• Compliance with ACI 318-08 and
ACI 318-11 Sections 21.13.1,
“Requirements of section 21.13
apply to members not designated
as part of the seismic-force-
resisting system in structures
assigned to SDC D, E and F”

• Applies to normal weight
reinforced concrete beams,
column and walls not included in
the SFRS

• Comes into effect in Seismic
Design Category, SDC D or above

• Prompts the designer to apply
code prescribed requirements on
top of current design

Steel Static Warnings
Additional notional loads required
when alpha Pr/Py > 0.5, C2.3

• Compliance with 7.3 (3) of AISC
360-05 and C2.3 of AISC 360-10
requires the stiffness of certain
members to be reduced. When
the ratio of the required axial
compressive force (Pr) and the
axial yield strength (Py = Fy Ag) is >
0.5 then this stiffness must be
reduced further

• As an alternative which is the
approach adopted in Tekla
Structural Designer, an additional
notional load of 0.001 Yi can be
applied instead

• When the program identifies that
the ratio of Pr/Py exceeds 0.5 a
warning is given to alert the
designer

• If this additional notional load has
been dealt with by the designer
then this warning is no longer
relevant and this option allows
you to switch off the warning

Concrete Seismic
Seismic to conventional minimum
demand ratio

• Sets the maximum seismic/non-
seismic ratio threshold, which is
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Button, command, or option Description
used to trigger the High seismic
to conventional
demandwarnings listed above

• Default: 1.000

Design Settings - Steel Joists

Steel joists

NOTE Steel joists are only applicable in the US.

Button, command, or option Description
Uniform load tolerance If the calculated percentage load

tolerance for steel joists is less than
this value, the load is classified as
Uniform.

Equivalent load tolerance If the calculated percentage load
tolerance for steel joists is greater
than this value, the load is classified
as Non-uniform.

NOTE If 0% equivalent load
tolerance is specified, only
pure uniform loading is
accepted.

Maximum sum of concentrated
loads

Allows you to specify a user-defined
maximum sum of concentrated loads
that limits K, LH and DLH joists. If any
concentrated loads exceed the
specified maximum sum, the relevant
load combination is classified as Non-
uniform.

Maximum eccentricity of zero
shear

In the equivalent uniform load
method, the position of the point of
zero shear relative to the center span
point of the joist is determined.

The option allows you to specify the
maximum eccentricity of zero shear
value in the equivalent uniform load
method. If the position is located
outside the value, the load is
classified as Non-uniform.
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Button, command, or option Description
Deflection increase to allow for
shear

Deflections due to live load are
calculated using the following
effective inertia value:

Ieffective = Igross / (1 + R),

where

R = the deflection increase to allow
for shear effects (defaulted to 15%)
and applied to KCS only.

The option allows you to adjust the
value of R, (the deflection increase to
allow for shear, percentage).

Design Settings - Sway & Drift Checks

Sway & drift check settings

Button, command, or option Description
Merge short stacks With this setting off the Sway/Drift,

Wind Drift & Seismic Drift checks are
performed for all column stacks and
wall panels irrespective of their stack
lengths.

With this setting on you can specify a
minimum stack length.

NOTE The ‘Merge short stacks’
option does not apply to
columns/walls where you
have elected to merge stacks
manually (via the column/wall
properties).

The following logic is applied to
merging stacks when the setting is on:

1. Start at the topmost stack of the
column/wall.

2. If the stack length is less than the
merge limit then merge with the
stack below.

3. Check again to see if then new
length exceeds the merge limit, if
not then merge again with the
next stack below.
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Button, command, or option Description
4. Repeat step 3 as required until

the stack length exceeds the
merge limit.

5. For subsequent stacks repeat
steps 2 and 3 as required until
the length exceeds the merge
limit.

6. When the bottommost stack is
reached, if this needs to be
merged, merge with the stack
above.

NOTE If a single stack column or
single panel wall length is less
than the merge short stacks
limit it is not considered for
sway/drift, wind drift, seismic
drift checks.

Check wind cases only Allows you to set that the wind drift
check performed on all columns only
considers the effect of the wind load
cases in each wind combination.

Clear the setting to consider the
effects of all load cases in wind
combinations, such as drift induced
by gravity loads.

Design Settings - Fire check

Fire check (Eurocode Head code only)

Button, command, or option Description
Time interval for critical
temperature iteration if
'Unprotected'

default 5 sec

Time interval for critical
temperature iteration if 'Protected'

default 30 sec

Design Settings - Timber
The settings allow you to apply your own set of timber design defaults that
broadly apply to all members. These are incorporated into Tedds calculations
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as default variables, which can then be edited within the calculation if
required.

Timber (US Headcode)

Button, command, or option Description
Service condition NDS: Service condition

• Dry (default)

• Wet
Temperature range • up to 100 degF (default)

• 100 degF to 125 degF

• 125 degF to 150 degF
Is section incised • yes

• no (default)

The incisions made when applying a
preservative treatment result in a loss
of area and section modulus. When
you indicate that the section is
incised, appropriate incising factors
are applied in the Tedds calculation.

Timber (Eurocode)

Button, command, or option Description
Service class • 1 (default)

• 2

• 3
Individual grade stamp • yes

• no (default)

Depending on the National Annex
being worked to, the partial factor for
material properties can be reduced
when timber has been individually
marked.

Slab deflection settings
The Slab Deflection page and its subpages allow you to control the slab
deflection defaults applied:
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• In the current project - when accessed from the Slab Deflection Settings
dialog (page 2440) on the Slab Deflection tab.

• In new projects - when accessed from the Settings dialog (page 2424) on
the Home tab.

Slab deflection settings when accessed from the Slab Deflection Check
Catalogue

Button, command, or option Description
New Load Event Defaults subpage
Start time offset Allows you to define a default start

time offset value for new event load
start times. The value of a new event
load start time is always the previous
event start time + the default start
time offset.

Construction load Allows you to define a default value
for new construction loads.

NOTE The default construction load
value depends on the head
code that you are using.

New Check Defaults subpage
Deflection limit, L / Allows you to define a default

deflection limit to new checks added
to the

When a new check is added to the
Slab Deflection Check Catalogue it
initially defaults to the deflection limit
set here.

Aging, Creep & Shrinkage subpage
Allowance for shrinkage effects in
total deflection

Allows you to define an amplification
base factor for shrinkage.

NOTE The value must be within the
range from 0.1 to 0.9.

Aging Coefficient Allows you to select between 2 creep/
aging methods: User defined and
Automatic.

NOTE The Aging Coefficient option
is only available for the US
head code.
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Button, command, or option Description
Modification Factors subpage Allows you to adjust the properties

used for the different element types
in the iterative cracked section
analysis.

Iteractive Cracked Section Analysis subpage
Global Convergence Criteria Allows you to modify the following

options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 200.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.00100.

• Relative: Default: ON.

TIP To resolve global convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

Local Convergence Criteria Allows you to modify the following
options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 500.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.000001.

• Smoothing Parameter: A
property only available for the
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Button, command, or option Description
Eurocode head code. Default =
0.005.

TIP To resolve local convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

• If you are using the
Eurocode head code,
increase the value in
Smoothing Parameter.

Slab deflection settings in the Settings dialog

Button, command, or option Description
New Load Event Defaults subpage
Start time offset Allows you to define a default start

time offset value for new event load
start times. The value of a new event
load start time is always the previous
event start time + the default start
time offset.

Construction load Allows you to define a default value
for new construction loads.

NOTE The default construction load
value depends on the head
code that you are using.

New Check Defaults subpage
Deflection limit, L / Allows you to define a default

deflection limit to new checks added
to the

When a new check is added to the
Slab Deflection Check Catalogue it
initially defaults to the deflection limit
set here.

Aging, Creep & Shrinkage subpage
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Button, command, or option Description
Allowance for shrinkage effects in
total deflection

Allows you to define an amplification
base factor for shrinkage.

NOTE The value must be within the
range from 0.1 to 0.9.

Aging Coefficient Allows you to select between 2 creep/
aging methods: User defined and
Automatic.

NOTE The Aging Coefficient option
is only available for the US
head code.

Load Event Sequence subpage Allows you to modify the global event
sequence according to your needs.

TIP The global event sequence
provides the basis for the model
event sequence that you can
modify, whereas the model
event sequence provides the
basis for a submodel event
sequence that you can modify.

Drawing settings
The Drawings page and its subpages allow you to adjust different drawing
settings:

• In the current project - when accessed from the Drawing Settings dialog
(page 2405) on the Draw tab.

• In new projects - when accessed from the Settings dialog (page 2424) on
the Home tab.

Export preferences

NOTE The Export Preferences subpage is only available when drawing
settings are accessed from the Settings dialog (page 2424)
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Setting Description
Drawing Variant list Allows you to select the drawing

category whose export preferences
you want to modify.

Minimum Text Block Spacing Allows you to define a minimum value
between independent drawing blocks.

NOTE If the value is too great, text
labels can end up far from
the objects to which they
refer.

Available Scales list Displays the existing drawing scales.

NOTE You can add user-defined
scales in the list by typing the
scale in the Scale field and
clicking the Add button, or
delete them by selecting the
scale and clicking the
Remove button.

Scale Allows you to create a user-defined
drawing scale by typing it in the field.

Name Allows you to specify a name for a
user-defined drawing scale.

Layer configurations

Setting Description
Drawing Variant list Allows you to select the drawing

category whose layer configurations
you want to modify.

NOTE Use the subpages of the 
Layer Configurations
subpage to modify the
required drawing type.

Available Configurations list Displays the available layer
configurations and allows you to
select or modify them. You can use
the following buttons to modify the
available layer configurations:

• Add: creates an empty layer
configuration that you can modify
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Setting Description
in the Active Configuration
section.

• Add copy...: allows you to copy a
drawing item to create a new layer
configuration.

• Remove: deletes the selected
layer configuration.

Active Configuration Displays the name and layers in the
selected layer configuration.

Name Displays and allows you to modify the
name of the selected layer
configuration.

Layers list Displays and allows you to select or
clear the layers that are included in
the selected layer configuration.

TIP If you access the drawing
settings from the Draw tab and
modify them, consider saving
the changes to a settings set, so
that you can use them in later
projects as well.

Layer styles

Setting Description
Drawing Variant list Allows you to select the drawing

category whose layer styles you want
to modify.

NOTE Use the subpages of the 
Layer Styles subpage to
modify the required drawing
type.

Available Styles list Displays the available layer styles and
allows you to select or modify them.
You can use the following buttons to
modify the available layer styles:

• Add: creates an empty layer style
that you can modify in the Active
Style section.
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Setting Description
• Add copy...: allows you to copy a

drawing item to create a new layer
style.

• Remove: deletes the selected
layer style.

Active Style Displays the name and layers in the
selected layer style.

Name Displays and allows you to modify the
name of the selected layer style.

Apply to All... This button opens a dialog for rapidly
applying a single color, report color,
line type, font, or font size to all layers
in the active layer style.

Layers list Displays and allows you modify the
appearance of layers that are
included in the active layer style.

Description The layer description is fixed and
can't be changed.

Name The layer name as it will appear in the
drawing can be edited if required.

Is Merged,

Merged with

By checking the box you are able to
merge two or more layers together.
All objects in the merged layer are
drawn in the Merged with layer,
adopting its line type, font and font
size.

Color The colors specified here are used for
the different layers in the dxf drawing
output

Report Color Member Reports have the facility to
include a member drawing along with
the calculations and diagrams etc.
When a member report is printed the
drawings adopt the report colors that
have been specified here.

Line Type Different line types can be specified
for the different drawing layers as
required.

Font Different fonts can be specified for
the different drawing layers as
required.
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Setting Description
Font Size Different font sizes can be specified

for the different drawing layers as
required.

Planar drawing options

. . . . General (all drawing variants)

Setting Description
Hatching Allows you to select how columns and

walls are hatched in planar drawings.
You can select or clear the following
options:

• Show columns and walls above
the level as hatched: The
columns and walls that continue
above the current level are
hatched.

• Show transfer columns and
walls as cross hatched: Transfer
columns and walls are cross
hatched.

Force and Moment Values
NOTE Applies to the following

drawing variants:

• Foundation Reactions

• Beam End Forces

• Column Splice Loads

Allows you to select which force and
moment values are displayed in
planar drawings. The options are:

• Strength factors: Displays the
strength factors in planar
drawings.

• Service factors: Displays the
service factors in planar drawings.

Additionally factor by allows you to
specify a value by which the strength
or service factors are factored in the
selected drawing category.
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Setting Description
Moment Values

NOTE Applies to the following
drawing variants:

• Foundation Reactions

• Beam End Forces

• Column Splice Loads

Allows you to select which moment
values are displayed in planar
drawings. The options are:

• None: Does not display any
moment values.

• Only greater than: Moment
values are only displayed if their
value is greater than the value
specified here.

• All: Displays all moment values,
even if zero.

Shear Force Values
NOTE Foundation Reactions

drawing variant only.

Allows you to select which shear
values are displayed in Foundation
Reactions drawings. The options are:

• None: Does not display any shear
values.

• Only greater than: Shear values
are only displayed if their value is
greater than the value specified
here.

• All: Displays all shear values, even
if zero.

Axial Force Values
NOTE Beam End Forces drawing

variant only.

Allows you to select which axial force
values are displayed in planar
drawings. The options are:

• None: Does not display any axial
force values.
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Setting Description
• Only greater than: Axial force

values are only displayed if their
value is greater than the value
specified here.

• All: Displays all axial force values,
even if zero.

Display End Forces for
NOTE Beam End Forces drawing

variant only.

Allows you to select the members for
which end forces are displayed.

Enveloped Reaction Values
NOTE Beam End Forces drawing

variant only.

Include coincident forces: when this
option is selected, further options are
presented allowing you to choose the
max/min values and coincident forces
to display when the beam end forces
drawing is created for a loading
envelope.

. . . . Beams (all drawing variants)

Setting Description
Grouped Beam Labelling Allow you to modify the labeling of

beams when the beams have been
designed using groups. You can select
or clear the following options:

• Use detail group name: Select
the option to use the detail group
name in the beam label, or clear
the option to use the design group
name in the beam label.

• Include the beam name: Select
the option to include the beam
name in the beam label for
grouped beams.

Concrete Beam Labelling Position Allows you to set the position of the
beam label in relation to the beam in
planar drawings. The options are:

• Above
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Setting Description
• Inside

• Below
Beam Mark Position Allows you to adjust the appearance

and position of the beam mark in
relation to the brace in planar
drawings. To display beam marks,
select Show beam mark. The
position options are:

• Above

• Below
Beam Attributes Position Allows you to adjust the appearance

and position of beam attributes in
relation to the beam in planar
drawings. To display beam attributes,
select Show beam attributes. The
position options are:

• Above

• Below
Beam Attributes Allows you to select which beam

attributes are displayed in planar
drawings and how they are displayed.
You can select or clear the following
options:

• Show beam size in parentheses:
Places brackets around the beam
size in the beam label.

• Grade: Displays the beam grade in
planar drawings.

• Camber: Displays the camber in
steel beams. To modify the
camber prefix, type the desired
value in the Camber prefix field.

• Composite properties: Displays
composite beam properties. To
change the separators inside
which the number of studs is
displayed, select the desired the
Stud separator list.

• Transverse reinforcement:
Displays transverse reinforcement
in planar drawings.
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. . . . Braces (all drawing variants)

Setting Description
Brace Mark Position Allows you to adjust the appearance

and position of the brace mark in
relation to the brace in planar
drawings. To display brace marks,
select Show brace mark. The
position options are:

• Above

• Below
Brace Attributes Position Allows you to adjust the appearance

and position of brace attributes in
relation to the brace in planar
drawings. To display brace attributes,
select Show brace attributes. The
position options are:

• Above

• Below
Brace Attributes Allows you to select whether brace

grades are displayed in planar
drawings.

. . . . Columns (all drawing variants)

Setting Description
Grouped Column Labelling Allow you to modify the labeling of

columns when the columns have
been designed using groups. You can
select or clear the following options:

• Use detail group name: Select
the option to use the detail group
name in the column label, or clear
the option to use the design group
name in the label.

• Include the column name: Select
the option to include the column
name in the column label for
grouped columns.

Column Mark Position Allows you to adjust the appearance
and position of the column mark in
relation to the brace in planar
drawings. To display column marks,
select Show column mark. The
position options are:
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Setting Description
• Above

• Below
Column Attributes Position Allows you to adjust the appearance

and position of the column attribute
in relation to the brace in planar
drawings. To display column
attributes, select Show column
attributes. The position options are:

• For position in elevation:

• Above

• Below

• For position in cross-section:

• To the right of the mark

• Below the mark
Column Attributes Allows you to select which column

attributes are displayed in planar
drawings and how they are displayed.
You can select or clear the following
options:

• Show column size in
parentheses: Places brackets
around the column size in the
column label.

• Grade: Displays the column grade
in planar drawings.

2x scale for steel columns Allows you to double the scale of steel
columns to simplify viewing the
columns and their orientation.

. . . . Walls (all drawing variants)

Setting Description
Wall Labelling position Allows you to set the position of the

wall label in relation to the wall in
planar drawings. The options are:

• Above

• Inside

• Below
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Setting Description
Show wall size in parentheses Allows you to select whether brackets

are placed around the wall size in the
wall label.

Wall Reactions Allows you to select whether or not to
include distributed vertical reaction
values of walls in the foundation
reactions planar drawing. These are
available in two different formats:

• Show distributed wall reactions
table: a table with the distributed
wall reaction end values is
included in the drawing,

• Show vertical reaction values:
values are added for each wall in
the planar drawing,

• Distributed (Maximum):
Maximum absolute values of
the vertical distributed reaction
retaining sign,

• Distributed (Average):
Average value of the vertical
distributed reaction along the
length of the bottom analytical
chord of the wall,

• Distributed (Extremes):
Extreme values at each end of
the wall bottom analytical
chord,

• Total: Single integrated total
vertical reaction of the wall.

. . . . Slabs/Mats (all drawing variants)

Setting Description
Panel Labelling Allows you to select which panel

properties are included in panel
labels and how panel labels are
displayed in planar drawings.
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Setting Description
You can select or clear the following
options:

• Include panel reference: Allows
you to include the panel reference
in the panel label.

• Include panel thickness: Allows
you to include the panel thickness
in the panel label.

• Include surface offset (if non-
zero): Allows you to include any
surface offset that has been
applied to the panel in the panel
label.

• Include border around label:
Allows you to add a border around
the label.

• Align label to panel
reinforcement: Allows you to
select how the panel label is
aligned to the panel span
direction. Select the option to
achieve the result displayed on the
left, and clear the option to
achieve the result displayed on the
right.

Include panel span direction
symbol

Allows you to select whether a
direction symbol is displayed in the
slab or mat geometry.
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. . . . Loads (Loading Plan drawing variant only)

Setting Description
Display size Allows you to adjust the width and

height of line, udl, and vdl loads and
the size of point loads in planar
drawings. The different options that
you can adjust are:

• Width of line/UDL/VDL loads on
plan: Line, UDL, and VDL loads are
drawn as hatched rectangles of
fixed width when drawn in plan.
The option allows you to adjust
the width of the hatched
rectangle.

• Height of line/UDL/VDL loads on
plan: Line, UDL, and VDL loads are
drawn as hatched rectangles of
fixed width when drawn in plan.
The option allows you to adjust
the height of the hatched
rectangle.

• Point load marker size: Allows
you to adjust the size of point
loads in planar drawings.

Show dimensions for panel loads Allows you to include the dimensions
of panel loads in planar drawings.

Include dimensions to reference
points

Allows you to include the dimensions
from panel loads to their reference
points in planar drawings.

Show dimensions for member
loads

Allows you to include the dimensions
of member loads in planar drawings.

Member detail options

. . . . Beam Detail

Setting Description
Content subpage
Grouped Beams tab
Show number of beams in group If the beams in the model have been

arranged into detailing groups,
selecting the option causes the
detailing number to be used as the

Tekla Structural Designer reference 2364 Settings



Setting Description
member label instead of the beam
reference.

If detailing groups have not been
used, the beam reference is always
used as the member label.

Levels tab
Show span levels Allows you to display the span levels

on the elevation.
Cross-sections tab
Spans list Allows you to select which cross-

sections to display. You can decide to
display no cross-sections, only the
cross-sections for first spans of multi-
span beams, or all spans.

Positions list If cross-sections are displayed, the list
allows you to select where they are
positioned. You can decide to only
position cross-sections for spans, for
supports, or for supports and spans.

Bar annotation list Allows you to select the cross-section
annotation. The options are:

• None

• Standard

• IStructE
Display bar marks If the cross-section annotation is set

to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Show slab lines in section Select the option to display slab lines
in sections, as shown in the first
image:

Clear the option to not display slab
lines in sections, as shown in the
second image:
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Setting Description
Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Show steel bar layer information Allows you to display steel bar layer
information (B1, B2, T1, T2, and so
on).

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL).

Anchorage lengths list Allows you to select whether any
required anchorage lengths are
dimensioned, not dimensioned, or the
dimension is replaced by a standard
label (AL).

Axes list Allows you to select whether axes are
not displayed, are displayed above
the beam with dimensions, or are
displayed below the beam with
dimensions.

Additional bottom span bar
positioning dimensions

Allows you to dimension any existing
optional second span bars from the
face of the support.

Support region length If different stirrup regions have been
used along a beam span, the option
allows you to dimension the length of
the support regions on the elevation.

First and last stirrups Allows you to add dimensions from
the face of the supports to the first
and last stirrups.

Support columns and clear spans Allows you to add dimensions
showing the width of each supporting
column and the clear beam span
between supports.
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Setting Description
Beam section Allows you to dimension the beam

depth and width on the cross-section.
Slabs in beam sections Allows you to dimension the slab

depth on the cross-section.
Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in beam detail
drawings.

Style subpage
Beam Labels tab
Print beam labels below the detail Allows you to display the beam label

centrally below each span. Clear the
option to position the label
immediately above each span.

Underline beam labels Allows you to to underline the beam
label on the elevation.

Label every span of multi-span
beams

Allows you to display a label for each
span in multi-span beams.

Cross-sections tab
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Restart section labels in each beam
line

Allows you to restart the section
labels for each line when multiple
beam lines are displayed on the same
drawing sheet.

Add beam name label as prefix to
section labels

Allows you to prefix each section label
with the beam name.

Place cross-sections underneath
the elevation

Allows you to to position cross-
sections under the elevation.

Longitudinal Bars tab
Draw bobs as shifted Allows you to apply a slight offset to

bobbed bars in drawings, so that the
bobbed bars do not overlap each
other in drawings an therefore, the
drawings are easier to read.

Display only a single side bar in
detail

Allows you to draw only a single side
bar is drawn full length when multiple
side bars are required in each face.
Clear the option to draw all side bars
full length.

Stirrups tab
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Setting Description
Draw stirrup labels in line Allows you to display stirrup labels in

line on the elevation, as shown in the
first image:

Clear the option to display stirrup
labels above the line, as shown in the
second image:

Print stirrup labels inside beam Allows you to display the stirrup
labels inside the beam. Clear the
option to display the stirrup labels
below the beam.

Stirrup label distance from bottom
edge [n] % of the beam depth

Allows you to control the vertical
position of stirrup labels that are
positioned inside the beam.

Dimensions tab
Lap and anchorage rounding
increment

Allows you to control the rounding
increment of lap and anchorage
dimensions.

. . . . Column Detail

Setting Description
Content subpage
Grouped Columns tab
Show number of columns in group Allows you to display the number of

columns in a column group.
Levels tab
Show levels Allows you to label the construction

levels.
Cross-sections tab
Show cross-sections Allows you to display cross-sections

through each stack.
Bar annotation list Allows you to select the cross-section

annotation. The options are:

• None

• Standard

• IStructE
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Setting Description
Display bar marks If the cross-section annotation is set

to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL or
CL).

Support region length Allows you to dimension the support
regions on the elevation.

Levels Allows you to add dimensions
between levels.

Grid line offsets Allows you to add dimensions from
the grid to the column face on the
elevation.

Connecting elements and clear
heights

Allows you to add dimensions
connecting elements and clear
heights.

Column section Allows you to add column dimensions
to the column section.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in column detail
drawings.

Style subpage
Column Labels tab
Underline column labels Allows you to to underline the column

label on the elevation.
Cross-sections tab
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Setting Description
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Restart section labels in each
column line

Allows you to restart the section
labels for each line when multiple
column lines are displayed on the
same drawing sheet.

Add column name label as prefix to
section labels

Allows you to prefix each section label
with the column name.

Ties tab
Draw tie labels in line Allows you to display tie labels in line

on the elevation, as shown in the
image on the left. Clear the option to
display tie labels above the line, as
shown in the image on the right.

Dimensions tab
Lap dimension rounding increment Allows you to control the rounding

increment of lap dimensions.

. . . . Wall Detail

Setting Description
Content subpage
Levels tab
Show levels Allows you to label the construction

levels.
Cross-sections tab
Show cross-sections Allows you to display cross-sections

through each stack.
Bar annotation list Allows you to select the cross-section

annotation. The options are:

• None

• Standard

• IStructE
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Setting Description
Display bar marks If the cross-section annotation is set

to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL or
CL).

Support region length Allows you to dimension the support
regions on the elevation.

Levels Allows you to add dimensions
between levels.

Grid line offsets Allows you to add dimensions from
the grid to the column face on the
elevation.

Wall section Allows you to add wall dimensions to
the wall section.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in wall detail
drawings.

Style subpage
Wall Labels tab
Underline wall labels Allows you to underline the wall label

on the elevation.
Cross-sections tab
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Add wall name label as prefix to
section labels

Allows you to prefix each section label
with the wall name.
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Setting Description
Don't label typical panel bars Allows you to not label typical bars in

cross-sections. Clear the option to
label every bar in cross-sections.

Horizontal Bars and Ties tab
Draw labels in line Allows you to display tie labels in line

on the elevation, as shown in the
image on the left. Clear the option to
display tie labels above the line, as
shown in the image on the right.

Label bars inside panel Allows you to label bars inside the
wall panel.

Dimensions tab
Lap dimension rounding increment Allows you to control the rounding

increment of lap dimensions.

Member schedule options

. . . . General

Setting Description

NOTE The settings that you see on the General tab depend on which
drawing category subpage you have selected in the left side pane.

Item list Allows you to select an item to view
the text label that will applied to it in
the concrete beam schedule drawing.

Text Allows you to modify the text
displayed in the beam schedule for
the item selected in the Item list.

Size Column Format Allows you to select whether to
display the width of the beam or its
height first in the size column.

Use single column for size Allows you to display both the width
and height in a single column.
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Setting Description
Use single column for bottom bars Allows you to display the bottom bars

in a single column
Omit top middle bars column Allows you to omit the top middle

bars from the schedule drawing.
Use single column for stirrups Allows you to display the stirrups in a

single column.
Show design group name Allows you to display only the design

group name in the mark column.
Show grouped column number Allows you to display column groups.
Include starter bars Allows you to include starter bars in

member schedule drawings.
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in member schedule
drawings.

Bar annotation list Allows you to select the cross-section
annotation. The options are:

• Standard

• IStructE
Display bar marks Allows you to display bar marks in

cross-section labels.
Show outline of stack below Allows you to display the outline of

the column stack below.
Dimension column section Allows you to add column dimensions

to the column section.
Dimension levels Allows you to add dimensions

between levels.
Show outline of panel below Allows you to display the outline of

the wall panel below.
Dimension wall section Allows you to add wall dimensions to

the wall section.

. . . . Bar Key

Setting Description
Reference column Lists every reference that can

potentially appear in the bar bending
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Setting Description
details table in concrete beam
schedule drawings.

TIP Hover the mouse pointer over a
reference to see the bar and its
associated note.

Allows you to use a custom name for
the selected reference.
Allows you to specify the custom
name that replaces the original
reference in the bar bending details
table if the

Slab and mat layout options

. . . . General

Setting Description
Layout subpage
General tab
Show columns and walls above the
level as hatched

Allows you to hatch columns and
walls that continue above the current
level.

Show transfer columns and walls
as cross hatched

Allows you to cross-hatch transfer
columns and walls.

. . . . Beams

Setting Description
Use detail group name Allows you to use the detail group

name in the beam label.

Clear the option to use the design
group name in the beam label
instead.

Include the beam name Allows you to include the beam name
in the label for grouped beams.

Beam Labelling position Allows you to set the position of the
beam label in relation to the beam in
slab and mat layout drawings. The
options are:

• Above

• Inside
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Setting Description
• Below

Show beam mark Allows you to display beam marks in
slab and mat layout drawings. The
position options for beam marks are:

• Above

• Below
Show beam attributes Allows you to display beam attributes

in slab and mat layout drawings. The
position options for beam attributes
are:

• Above

• Below
Show beam size in parentheses Allows you to place brackets around

the beam size in the beam label.
Grade Allows you to display the beam grade

in slab and mat layout drawings.

. . . . Braces

Setting Description
Show brace mark Allows you to display brace marks in

slab and mat layout drawings. The
position options for brace marks are:

• Above

• Below
Show brace attributes Allows you to display brace attributes

in slab and mat layout drawings. The
position options for brace attributes
are:

• Above

• Below
Brace Attributes Allows you to select whether brace

grades are displayed in slab and mat
layout drawings.
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. . . . Columns

Setting Description
Use detail group name Allows you to use the detail group

name in the column label.

Clear the option to use the design
group name in the column label
instead.

Include the column name Allows you to include the column
name in the label for grouped
columns.

Show column mark Allows you to display column marks in
slab and mat layout drawings. The
position options for column marks
are:

• Above

• Below
Show column attributes Allows you to display column

attributes in slab and mat layout
drawings. The position options for
column attributes are:

• For position in elevation:

• Above

• Below

• For position in cross-section:

• To the right of the mark

• Below the mark
Show column size in parentheses Allows you to place brackets around

the column size in the column label.
Grade Allows you to display the column

grade in foundation layout drawings.
2x scale for steel columns Allows you to double the scale of steel

columns to simplify viewing the
columns and their orientation.

. . . . Walls

Setting Description
Wall Labelling position Allows you to set the position of the

wall label in relation to the wall in slab
and mat layout drawings. The options
are:
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Setting Description
• Above

• Inside

• Below
Wall Attributes Allows you to select whether brackets

are placed around the wall size in the
wall label.

. . . . Slabs/Mats

Setting Description
Include panel reference Allows you to include the panel

reference in the panel label.
Include panel thickness Allows you to include the panel

thickness in the panel label.
Include surface offset (if non-zero) Allows you to include any surface

offset that has been applied to the
panel in the panel label.

Include border around label Allows you to add a border around
the label.

Align label to panel reinforcement Allows you to select how the panel
label is aligned to the panel span
direction. Select the option to achieve
the result displayed on the left, and
clear the option to achieve the result
displayed on the right.

Include panel span direction
symbol

Allows you to select whether a
direction symbol is displayed in the
slab or mat geometry.
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Setting Description
Extend loose bar panel
reinforcement lines across full
panel

Allows you to draw bar panel
reinforcement across the entire
panel.

Clear the option to display the loose
bar reinforcement as shown in the
following image:

Always show main bar layer for
rectangular mesh

If the mesh is not a square mesh, the
main bars are normally put on the
outer layer of the drawing, and no
text is required in the drawing.
However, if the bars are not on the
outer layer of the drawing, they are
indicated by adding B2 (if bottom
mesh) or T2 (if top mesh) aligned to
the main bar direction.

NOTE If a square mesh (has the
same size and spacing of bars
in both directions) is applied,
a square mesh symbol is
used, and bars are shown
equally spaced in both
directions.

If the mesh is not a square
mesh (does not have the
same size and spacing of bars
in both directions), a
rectangular mesh symbol is
used. Bars are shown in both
directions, but with closer
spacing for the more closely
spaced bars in the mesh.

Anchorage rounding increment Allows you to specify the rounding
value applied to the anchorage
length.

. . . . Patches

Setting Description
Show patches with no
reinforcement

Allows you to display patches that
have no reinforcement specified in
drawings.
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Setting Description
Draw full anchorage lengths Allows you to display bars with full

anchorage lengths.
Draw curtailed (indicative)
anchorage lengths = max()

Allows you to draw curtailed
(indicative) anchorage lengths instead
of full anchorage lengths and specify
their size.

. . . . Punching Shear

Setting Description
Show punching reinforcement
details

Allows you to include a detail to the
side of the layout showing the
punching shear reinforcement
provided.

Don't show area of steel
requirement where rails have been
designed

Allows you to only display the area of
steel requirement for punching shear
check items where rails are not
provided (such as walls or column
drops).

Clear the option to display the area of
steel requirement for all punching
check items.

Hide punching reinforcement on
the main layout

Allows you to hide the punching
reinforcement on the main layout.
The reinforcement is still displayed in
the punching check detail drawing,
provided that Show punching
reinforcement details is selected.

Slab and mat punching check detail options

Button, command, or option Description
Content subpage
Dimensions tab
Show column to first stud spacing Allows you to add a dimension from

the column face to the first stud.
Show stud spacing Allows you to add dimensions

displaying the stud spacings along the
rail.

Show rail spacing Allows you to add dimensions
displaying the rail spacings.
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Button, command, or option Description
Include schematic showing stud
dimensions

Allows you to add a schematic
displaying the stud width and height
above the rail.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in punching check
detail drawings.

Style subpage
Show column as hatched Allows you to hatch the column.
Underline punching check label Allows you to underline the punching

check label in punching check detail
drawings.

Foundation layout options

. . . . General

Setting Description
Show columns and walls
above the level as hatched

Allows you to hatch the columns and walls
that continue above the current level.

Show transfer columns and
walls as cross hatched

Allows you to cross-hatch transfer columns
and walls.

Show pile location and
loading table

Click Columns to choose which columns of
tabular data are to be included in the table on
the drawing.

NOTE Only the single most critical load
condition is reported in the table for
each pile.

- could be tension or compression

- could be a gravity, wind, or seismic
combination

. . . . Beams

Setting Description
Use detail group name Allows you to use the detail group name in

the beam label.

Clear the option to use the design group
name in the beam label instead.
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Setting Description
Include the beam name Allows you to include the beam name in the

label for grouped beams.
Concrete Beam Labelling
Position

Allow you to modify the labeling of beams
when the beams have been designed using
groups. You can select or clear the following
options:

• Use detail group name: Select the option
to use the detail group name in the label,
or clear the option to use the design group
name in the label.

• Include the beam name: Select the
option to include the beam name in the
label for grouped beams.

Show beam mark Allows you to display beam marks in
foundation layout drawings. The position
options for beam marks are:

• Above

• Below
Show beam attributes Allows you to display beam attributes in

foundation layout drawings. The position
options for beam attributes are:

• Above

• Below
Beam Attributes Allows you to select which beam attributes

are displayed in foundation layout drawings
and how they are displayed. You can select or
clear the following options:

• Show beam size in parentheses: Places
brackets around the beam size in the
beam label.

• Grade: Displays the beam grade in planar
drawings.

• Camber: Displays the camber in steel
beams. To modify the camber prefix, type
the desired value in the Camber prefix
field.

• Composite properties: Displays
composite beam properties. To change the
separators inside which the number of
studs is displayed, select the desired the
Stud separator list.
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Setting Description
• Transverse reinforcement: Displays

transverse reinforcement in foundation
layout drawings.

. . . . Braces

Setting Description
Show brace mark Allows you to display brace marks in

foundation layout drawings. The position
options for brace marks are:

• Above

• Below
Show brace attributes Allows you to display brace attributes in

foundation layout drawings. The position
options for brace attributes are:

• Above

• Below
Brace Attributes Allows you to select whether brace grades are

displayed in foundation layout drawings.

. . . . Columns

Setting Description
Use detail group name Allows you to use the detail group name in

the column label.

Clear the option to use the design group
name in the column label instead.

Include the column name Allows you to include the column name in the
label for grouped columns.

Show column mark Allows you to display column marks in
foundation layout drawings. The position
options for column marks are:

• Above

• Below
Show column attributes Allows you to display column attributes in

foundation layout drawings. The position
options for column attributes are:

• For position in elevation:

• Above

• Below

• For position in cross-section:
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Setting Description
• To the right of the mark

• Below the mark
Show column size in
parentheses

Allows you to place brackets around the
column size in the column label.

Grade Allows you to display the column grade in
foundation layout drawings.

2x scale for steel columns Allows you to double the scale of steel
columns to simplify viewing the columns and
their orientation.

. . . . Walls

Setting Description
Wall Labelling position Allows you to set the position of the wall label

in relation to the wall in foundation layout
drawings. The options are:

• Above

• Inside

• Below
Wall Attributes Allows you to select whether brackets are

placed around the wall size in the wall label.

. . . . Slabs/Mats

Setting Description
Include panel reference Allows you to include the panel reference in

the panel label.
Include panel thickness Allows you to include the panel thickness in

the panel label.
Include surface offset (if
non-zero)

Allows you to include any surface offset that
has been applied to the panel in the panel
label.

Include border around label Allows you to add a border around the panel
label.

Align label to panel
reinforcement

Allows you to select how the panel label is
aligned to the panel span direction. Select the
option to achieve the result displayed on the
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Setting Description
left, and clear the option to achieve the result
displayed on the right.

Include panel span
direction symbol

Allows you to select whether a direction
symbol is displayed in the slab or mat
geometry.

Show pile location table Allows you to include a table showing the pile
locations in foundation layout drawings.

Show pile reference Allows you to display the pile references in
foundation layout drawings.

. . . . Isolated Foundations

Setting Description
Show pile type name Allows you to include the pile type names in

the footing attributes displayed for each pile
cap in foundation layout drawings.

Show foundation details Allows you to include pad base or strip base
and pile cap details, displaying the designed
reinforcement, on the side of the foundation
layout drawing.

Show reinforcement
quantities table

Allows you to include the reinforcement
quantity table for the pad bases and strip
bases and pile caps displayed in foundation
layout drawings.

Show pad/strip base
schedule

Allows you to include the reinforcement
schedule for the pad bases or strip bases in
foundation layout drawings.

Show pile cap schedule Allows you to include the reinforcement
schedule for the pile caps in foundation layout
drawings.
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Setting Description
Show allowable pile
capacity

Allows you to include the allowable pile
capacity table for the piles under pile caps in
foundation layout drawings.

Show overall dimensions Allows you to include the overall dimensions
of the pad bases or strip bases and pile caps
in foundation layout drawings.

Show pile spacings Allows you to include the pile cap pile spacing
dimensions in foundation layout drawings.

Include the foundation
name

Allows you to include the pad base or strip
base or pile cap name in the footing mark for
grouped footings in foundation layout
drawings.

Labelling Position Allows you to control where the footing mark
and attributes are displayed for isolated
foundations. The position options are:

• Above

• Below

Isolated Foundation detail options

. . . . Content

Setting Description
Content subpage
Grouped Foundations tab
Show number of
foundations in group

Allows you to display the number of bases or
pile caps in the group.

Cross-sections tab
Positions list Allows you to select how cross-section

positions are displayed. You can select to not
display cross-section positions at all, display a
length-wise section or display cross-sections
in both directions.

Pile Labels tab
Show pile type name Allows you to include the pile type name in

the pile label.
Dimensions tab
Show overall dimensions Allows you to include the overall dimensions

of the base/pile cap.
Show supported member
dimensions

Allows you to include dimensions of the
column or wall being supported.
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Setting Description
Show pile spacings Allows you to include dimensions from center

to center of each pile for pile caps.
Quantities tab
Show reinforcement
quantities table

Allows you to include reinforcement quantity
tables in isolated foundation detail drawings.

. . . . Style

Setting Description
General tab
Show supported member
as hatched

Allows you to hatch columns and walls that
are supported on the base pile cap in isolated
foundation detail drawings.

Underline foundation label Allows you to underline the foundation label
on the detail in isolated foundation detail
drawings.

Cross-sections tab
Section label style list Allows you to select the label style to be

applied to cross-sections in isolated
foundation detail drawings.

Restart labels in each
foundation

Allows you to restart labeling from the
beginning of each section when multiple
foundations are included in the same
drawing.

See also

Adjust and apply drawing settings (page 968)

Settings set settings
The Settings Sets page in the Settings dialog box controls the settings sets
which are used to create the model/analysis/design settings in new projects,
and which can also be used to replace the model/analysis/design settings in
existing projects.

Button, command, or option Description
Available settings sets list Allows you to select a settings set

whose content you can view and
modify on the other pages of the 
Settings dialog box.

Add Copy Creates a new settings set based on
the one selected in the Available
settings sets list. You can then
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Button, command, or option Description
customize the new settings set on the
other pages of the Settings dialog
box.

>> Active Makes the settings set that is selected
in the Settings dialog box the active
settings set.

Import... Allows you to import a settings set
from another region. The selected
settings set appears in the Settings
dialog box.

Rename Allows you to rename the settings set
that is selected in the Available
settings sets list.

Remove Deletes the settings set that is
selected in the Available settings
sets list.

Open Folder Opens the folder in which the existing
settings sets are located.

See also

Manage settings sets (page 1000)

General settings
The General page and its subpages in the Settings dialog box allow you to
configure the language, captions, autosave settings, confirmation messages,
and updates in Tekla Structural Designer.

Button, command, or option Description
Language subpage
Select the preferred language list Allows you to select whether the

terms in the interface and the output
are in US English or UK English.

NOTE The language cannot be
configured differently in
different settings sets.

Appearance page
Show captions on top Allows you to select whether you

want to show captions on the top or
the bottom of the Project
Workspace.
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Button, command, or option Description
Autosave subpage
Enabled Allows you to select whether Tekla

Structural Designer creates automatic
backups of models. Autosave may be
useful, for example, when restarting
Tekla Structural Designer after a
crash.

Interval Allows you to determine the interval
at which Tekla Structural Designer
creates automatic backups of models.

Confirmation subpage
Confirm on list Allows you to select the operations

that you want to confirm each time.
Update Service subpage
Enable Update Service Allows you to select whether you

want Tekla Structural Designer to
notify you when new product updates
or service packs can be installed, so
that you can keep Tekla Structural
Designer up to date.

Check for updates when starting
Tekla Structural Designer

Allows you to select whether Tekla
Structural Designer check if new
updates are available each time it
starts.

Check for non critical updates
every [n] days

Allows you to determine the interval
at which Tekla Structural Designer
checks if new non-critical updates are
available.

Yes, I am willing to participate
anonymously

Allows you to select whether the
Tekla Customer Experience
Improvement Program can collect
anonymous information on your
hardware configuration and your use
of Tekla products to improve the
customer experience of Tekla
products.

Results Viewer settings
The Results Viewer page and its subpages in the Settings dialog box allow
you to configure the appearance of the on-screen results viewer for the
settings set selected in the Select the settings set to edit list.
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NOTE Unlike other settings, changes made to the active settings set on the
Results Viewer page are instantly applied to the current session
when you click OK to close the Settings dialog box.

Button, command, or option Description
General subpage
Viewer font --> Change... Allows you to modify the font that is

displayed on the left side pane of the
results viewer.

Styles subpage
Report Styles list Allows you to select the style whose

font, color, or other properties you
want to modify. The options are:

• Calc Normal: not used in the
current version.

• Table: controls all the text
displayed on the right side pane of
the results viewer except for the
first row in any table.

• Table Heading: controls the
heading row, or first row, in any
table.

Font --> Change... Allows you to change the font used
for the currently selected style.

Colors --> Foreground --> Change... Allows you to change the foreground
color of the selected style.

Colors --> Background --> Clear Allows you to use a clear background
for the selected style.

Colors --> Foreground --> Change... Allows you to change the background
color of the selected style.

Vertical alignment Allows you to modify the vertical
alignment of the selected style.

Indentation Allows you to determine the
indentation of the selected style.

Line spacing Allows you to determine the line
spacing of the selected style.
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Structure default settings
The Structure Defaults page in the Settings dialog box allows you to
configure miscellaneous structure default settings that are applied to the
settings set selected in the Select the settings set to edit list.

Button, command, or option Description
Construction Levels --> Default
Type

Allows you to define the default type
for the new constructions levels you
create in the Construction Levels
dialog box.

Grid & Construction Lines -->
Extension length

Allows you to define the default
extension length of grid and
construction lines.

Pattern loadcases Allows you to define whether load
patterns are applied to load cases.

Nominal Cover Allows you to modify the nominal
cover of different members.

NOTE Unlike other settings,
changes made to the nominal
cover settings are instantly
applied to new members.

Section default settings
The Section Defaults page in the Settings dialog box allows you to specify the
default section size for each member type when a new member is create. The
default section sizes are applied to the settings set selected in the Select the
settings set to edit list.

To change the default section size for a member type, click the section size in
the Section column.

Section order default settings
The Section Order Defaults page in the Settings dialog box allows you to
modify the default section orders for different countries by clicking the desired
order in the Section Order column.
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Solver settings
The Solver page in the Settings dialog box allows you to specify the solver
method that is applied to the settings set selected in the Select the settings
set to edit list.

Button, command, or option Description
Global Matrix Storage Allows you to specify the global

matrix storage method. The options
are Compressed Sparse Row and
Skyline.

NOTE We recommend that you
select the Compressed
Sparse Row option because
it generally reduces the
analysis time, particularly in
the case of finite element
analysis.

Scene settings
The Scene page and its subpages in the Settings dialog box allow you to
control the color and opacity of each object type in scene views when using
the settings set selected in the Select the settings set to edit list.

NOTE Unlike other settings, changes made to the active settings set on the
Scene page are instantly applied to the current session when you click
OK to close the Settings dialog box.

Button, command, or option Description
Graphics subpage
Driver

NOTE The default settings on the
Graphics subpage are the
recommended settings. Do
not adjust them unless the
Tekla Support Team instructs
you to do so.

Antialiasing
Transparency

Colors subpage
Background color list Allows you to select whether the table

below displays and allows you to
adjust the colors for a light or dark
background.
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Button, command, or option Description
Gradient Background Unselect this option to apply a

uniform white or black background to
each window, with no gradient
applied.

Reset Colors Resets all the colors to the default
settings.

Color Name Displays the interface item to which
the color applies.

TIP An arrow is displayed to the left
of some of the items, this can be
clicked on in order to set the
colors for sub-items.

Opacity Allows you to set the opacity of each
color.

Color Allows you to set the color for each
interface item according to your
needs.

Fonts subpage
Reset Fonts Resets all the fonts to the default

settings.
Font Name Displays the interface item to which

the font applies.
Font Allows you to change the font used

for the interface item.
Size Allows you to adjust the size of the

font.
Bold Allow you to further format the font.
Italic
Contours subpage
Lower bound [%] Displays the lower bound of each FE

contour in the results view.

TIP To adjust the size of the lower
bound, modify Size [%].

Upper bound [%] Displays the upper bound of each FE
contour in the results view.

TIP To adjust the size of the upper
bound, modify Size [%].
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Button, command, or option Description
Size [%] Allows you to adjust the size of

individual contours according to your
needs. Note that the sum of the sizes
must equate to 100 %.

Color Allows you to change the color of a
contour.

Split Divides the contour that is currently
selected in the table into two
contours that are each half the size of
the original contour.

Delete Deletes the contour that is currently
selected in the table.

Reset Resets the contours to the default
configuration that consists of 10
evenly sized contours.

Utilization Ratios subpage
Minimum value Allows you to adjust the minimum

value of a ratio band.

NOTE The value of the highest ratio
band can be increased above
1.0, if necessary.

Color Allows you to change the color of a
ratio band.

Add Creates a new ratio band that you can
modify to the bottom of the table.

Delete Deletes the ratio band that is
currently selected in the table.

Reset Resets the ratio bands to the default
configuration that consists of 5 evenly
sized ratio bands.

Sort Rearranges the ratio bands in order
of the values (from highest to lowest).

View Settings subpage
Do not display values of storey
shear below

Allows you to limit the values of
storey shear for a new model. This
way, you can easily ignore the small
values of storey shear that might
otherwise detract you from the more
important storey shear values. The
storey shear values that are less than
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Button, command, or option Description
the limiting value are not displayed in
the results view.

Show full pile length Allows you to select whether Tekla
Structural Designer displays the full
length of piles or a shorter pile length
that you can specify.

2 x scale for steel columns Allows you to double the scale of steel
columns in 2D views in order to
simplify viewing the columns and
their orientation.

Report settings
The Report page and its subpages in the Settings dialog box allow you to
modify the appearance of reports.

NOTE Unlike other settings, changes made to the active settings set on the
Report page are instantly applied to the current session when you
click OK to close the Settings dialog box.

Button, command, or option Description
Styles subpage
Report Styles list Allows you to select a style used in

reports whose font, color, or other
properties you want to modify.

Font --> Change... Allows you to change the font used
for the currently selected style.

Colors --> Foreground --> Change... Allows you to change the foreground
color of the selected style.

Colors --> Background --> Clear Allows you to use a clear background
for the selected style.

Colors --> Background --> Change... Allows you to change the background
color of the selected style.

Vertical alignment Allows you to modify the vertical
alignment of the selected style.

Indentation Allows you to determine the
indentation of the selected style.

Line spacing Allows you to determine the line
spacing of the selected style.

Page Options subpage
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Button, command, or option Description
Page margins Allows you to adjust the margins on

report pages.
Margin frame --> Draw page margin
frame

Allows you to select whether Tekla
Structural Designer creates a margin
frame to separate the report text
from the margins.

Margin frame --> Color --> Change... Allows you to change the color of the
margin frame.

First page number Allows you to determine the number
from which the page numbers start.

Page number prefix Allows you to specify a prefix to the
page number.

Table Options subpage
Border Style Allows you to specify the table border

style. You can select to have no table
borders, a single line border, or a
double line border.

Border Properties --> Color -->
Change...

Allows you to change the table border
color.

Border Properties --> Width Allows you to adjust the table border
width.

Table width --> [] percent of page
width

Allows you to specify the width of all
tables included in reports.

Use landscape orientation for wide
tables

When enabled (default) the report
page orientation will automatically
change to landscape mode when the
table header will not fit in portrait
orientation.

NOTE You can reduce the need for
landscape orientation and
number of pages by;
reducing page margins
(default values may be quite
wide); increasing the
allowable table width from 90
to 95% of the available width

Document Options subpage
Show document header Allows you to include the header at

the top of each report page.
Show border in document header Draws a border around each field cell

in the header.
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Button, command, or option Description
Show document footer Allows you to include the header at

the top of each report page.
Show border in document footer Draws a border around each field cell

in the footer.
Show document field description in
line with the value

Allows you to display the field
descriptions in line with the field
values in each cell.

If you do not select the Show
document field description in line
with the value option, the field
values are displayed on a new line.

Underline document field cell Underlines the cell value of each field.
Image width --> [] percent of page
width

Allows you to specify the width of all
images included in reports.

Paragraphs --> Spacing Allows you to specify the paragraph
spacing in reports.

Start each item on new page Allows you to start each report
chapter on a new page.

Start each member report on new
page

Allows you to start each member
report on a new page.

Picture Fonts subpage
Reset Fonts Resets all the fonts to the default

settings.
Font Name Displays the report item to which the

font applies.
Font Allows you to change the font used

for a report item.
Size Allows you to adjust the size of the

font.
Bold Allow you to further format the font.
Italic

See also

Adjust and apply report settings (page 953)

Performance settings
The Performance page in the Settings dialog box allow you to optimise
analysis and design performance according to your preference and your PC’s
capabilities.
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Button, command, or option Description
General To optimise performance choose one

of the following:

• Conserve memory (default)

• Favour speed

NOTE We recommend the 'Favour
speed' option is used only on
higher specification PC’s with
multi-core processors and
the recommended amount of
RAM.

Design Options are provided to allow you to
take advantage of multi-core
processing in the design and chase-
down phases.

• Use multi-core processors for
design

• Run chase-downs concurrently

15.5 Dialogs
This section covers some of the important dialogs in Tekla Structural Designer
and their different options.

Click the links below to find out more:

• Analysis Settings dialog (page 2398)

• Connection Resistance dialog (page 2399)

• Construction Levels dialog (page 2402)

• Design Settings dialog (page 2404)

• Drawing Settings dialog (page 2405)

• Edit Reinforcement dialog (page 2405)

• Interactive Beam Design dialog (page 1311)

• Interactive Column Design dialog (page 1327)

• Interactive Wall Design dialog (page 1345)

• Load Event Sequences dialog (page 2410)

• Loading dialog (page 531)

• Materials dialog (page 2418)
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• Model Settings dialog (page 2422)

• Sections dialog (page 2423)

• Settings dialog (page 2424)

• Slab Deflection Check Catalogue (page 2425)

• Slab Deflection Settings dialog (page 2440)

• Snow wizard (ASCE7) (page 2435)

• Snow wizard (Eurocode) (page 2426)

• Sub Models dialog (page 2438)

Analysis Settings dialog

Summary

The Analysis Settings dialog and its subpages allow you to adjust the settings
applied to the different analyses.

Location

On the Analyze tab, click Settings.

Content

Button, command or
option

Description

1st Order Non-Linear See 1st order non-linear
settings (page 2278)

2nd Order Non-Linear See 2nd order non-linear
settings (page 2279)

1st Order Modal See 1st order modal settings
(page 2281)

2nd Order Buckling See 2nd order buckling
settings (page 2284)

1st Order Seismic See 1st order seismic settings
(page 2285)

Iterative Cracked
Section Analysis

See Iterative cracked section
analysis settings (page 2288)

Modification Factors See Modification factors
(page 2290)

Meshing See Meshing settings
(page 2291)
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Button, command or
option

Description

Composite Steel
Beams

See Composite steel beams
settings (page 2291)

OK button Apply the changes to the
current project.

Cancel button Cancel the changes.
Save button Save the changes back to the

active settings set for future
use.

Load button Revert to the model settings
specified in the active settings
set.

Connection Resistance dialog
The Connection Resistance dialog displays the pre-defined connection
resistances for steel beams to Eurocode and US head codes. It can also be
used to add or edit user-defined connection resistances.

To open the dialog:

1. Click the Home tab.

2. Click  Materials.

The Materials dialog is displayed.

3. On the Sections page, check that the required head code and material are
displayed.

NOTE Both steel and cold formed materials can have resistances
defined, unless the head code is US, in which case resistances can
be defined for steel only.

4. Click Connection Resistance

The dialog content is described below.
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1. Title Bar

The title bar displays:

• The currently selected head code.

• For India this also displays LS or WS, and for US displays LRFD or ASD,
according to the setting of the currently open model.

2. Filters

The filter settings determine what is displayed elsewhere in the viewer.

The Member Type filter has options for:
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• Simple Beam

• Brace

3. Connection Types

Pre-defined and user-defined Connection Types are listed here according to
the Filter settings.

• Click the Add... button to add a user-defined Connection Type (page 1010).

• Click the Edit... button to edit a user-defined Connection Type.

• Click the Delete button to delete a user-defined Connection Type.

NOTE The Edit... and Delete buttons are only active when a user-defined
Type is selected.

4. Info box

Displays information related to the currently selected Connection Type. For
user-defined Connection Types the information displayed here can be added
or edited via the Add… and Edit… buttons in the Connection Types area of the
viewer.

5. Resistances

• Resistance values are listed in the window according to the Filter settings
and the currently selected Connection Type. The resistance values (for
user-defined Connection Types) can be edited directly.

• The ‘Active’ setting means that, when ticked, the particular resistance will
be considered in the check. The Active status can be edited directly in this
window for individual resistances but is more quickly edited using Activate/
Deactivate. All pre-defined resistances start out Active.

• If ‘Hide undefined values’ is un-ticked those resistances which have zero
value currently assigned will be displayed along with the other sections.
This box is ticked by default when opening the viewer.

• If ‘Hide inactive values’ is ticked those resistances which have ‘Active’ un-
ticked will be hidden in this window. This box is un-ticked by default when
opening the viewer.

• Use the Edit... button to edit the bolt row count or resistance or Active
status of a user-defined Connection Type. Note that multiples of the same
section size can be added through the Edit Resistances dialog, so that the
same size with different bolt row counts and resistances can be defined.

Click here for an example (page 1012) showing the use of Edit... as
described above.
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• Use the Activate/Deactivate... button to change the Active setting for
multiple sections. Set the filters in the Activate/Deactivate dialog, then set
either Activate or Deactivate, and then Apply if you want to change further
Active settings or Apply & Close to finish.

Click here for a Eurocode example (page 810) or here for a US example
(page 812) showing the use of Activate/Deactivate as described above.

6. OK and Cancel

Button Description
OK Commit all changes made in the

viewer to the database.
Cancel Closes the dialog box without saving

changes.

See also:

Check simple connection resistance (page 809)

Construction Levels dialog
The Construction Levels dialog allows you to define the levels required in
order to construct your model.

Choose from:

• On the Model tab, click Construction Levels.

• In the Structure tree, double-click Levels.

Content

Button,
command or

option

Description

Options  
Ref Allows you to assign a unique reference to a construction

level.
Name Allows you to assign an optional name to further assist

identification. For example, "First floor" or "Mezzanine".
Type Allows you to select the Type from the drop down menu:

• T.O.S. = Top of steel

• S.S.L. = Structural slab level
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Button,
command or

option

Description

• T.O.F. = Top of foundation

WARNING Slabs are modeled above the level when they
are set to T.O.S or T.O.F but below the level
when they are set to S.S.L

Level Allows you to assign the height of the construction level
above the base level.

Spacing Allows you to assign the distance of this construction level to
the one immediately below.

Source Allows you to assign the level as Unique or the same as
another level. Unique levels can be edited independently,
whereas edits to indentical levels are applied at both levels
simultaneously.

Slab Th. Allows you to set the default thickness for any slab created
on the level.

Floor Allows you to assign the construction level as a major level in
the building. Floor levels determine the number of sub
models that are created for the chasedown analysis. Floor
levels are also used to determine items such as your inter
story height.

There will certainly be a number of levels that are clearly
floor levels, but there could be many others that are not. For
example you create intermediate levels in order to define:

• half landing levels and stairs

• K bracing. You require a construction level for the
intermediate bracing connection points

• Steps in the building floor levels

When you define a level that is clearly not a floor, then you
should not check the option. If a floor exists only at some
locations in the level (e.g. in a building with stepped floor
levels), then you should check the option where applicable.

Buttons  
OK Allows you to save any changes made.
Cancel Allows you to discard any changes made.
Insert Above Allows you to insert a new construction level above the

currently highlighted level with the same spacing.
Insert Below Allows you to insert a new construction level below the

currently highlighted level with the same spacing.

Tekla Structural Designer reference 2403 Dialogs



Button,
command or

option

Description

New on Top Allows you to insert multiple construction levels above the
uppermost level with variable spacings

NOTE 3*5 inserts three levels, each at 5m spacing

3,4,5 inserts three levels at spacings of 3,4 and 5m
respectively.

New at the
Bottom

Allows you to insert multiple construction levels below the
lowest level with variable spacings

Delete Allows you to delete the selected level.

Design Settings dialog
The Design Settings dialog applies design settings to the current project.

Location

On the Design tab, click Settings.

Content

Button, command or
option

Description

Analysis See Analysis (page 2294)
General See General (page 2294)
Concrete See Concrete > Cast-in-place

(page 2296) and Concrete >
Precast

Composite Beams See Composite Beams
(page 2322)

Design Forces See Design Forces
(page 2323)

Design Groups See Design Groups
(page 2339)

Autodesign See Autodesign (page 2340)
Design Warnings
(AISC/ASC only)

See Design Warnings
(page 2341)

Steel Joists See Steel Joists (page 2345)
Sway & Drift Checks See Sway and Drift Checks

(page 2346)
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Button, command or
option

Description

Fire check See Fire check (page 2347)
OK button Apply the changes to the

current project.
Cancel button Cancel the changes.
Save button Save the changes back to the

active settings set for future
use.

Load button Revert to the model settings
specified in the active settings
set.

Drawing Settings dialog

Location

On the Draw tab, click Settings.

Content

Button, command or option Description
General > Default export
directory

Specifies the default folder for creation of
dxf files

Layer Configuration See Layer configurations (page 2353)
Layer Styles See Layer styles (page 2354)
Options > Planar Drawings See Planar drawing options (page 2356)
Options > Member Details See Member detail options (page 2364)
Options > Member Schedules See Member schedule options (page 2372)
Options > Slabs and Mats See Slab and mat layout options

(page 2374)
Options > Foundations See Foundation layout options (page 2380)
OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings

set for future use.
Load button Revert to the model settings specified in

the active settings set.
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Edit Reinforcement dialog

Summary

The Edit Reinforcement dialog box allows you to modify the reinforcement
used in a punching shear check. The graphic in the dialog box previews the
reinforcement and updates to match the changes that you make. The graphic
also indicates other items that are specific to the check location.

Location

To display the dialog:

1. Right click on an existing punching check item.

2. In the context menu, select Edit Reinforcement.

Content

1. Use reinforcement

Selecting the Use reinforcement option allows you to apply a default
punching reinforcement arrangement that can either be checked or used as
the starting reinforcement for an auto design.
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2. Preview graphic

The components of the preview graphic are as follows:

Stud rail reinforcement

Stud rail reinforcement is only shown if you have selected the Use
reinforcement option.

The red design rails signify rails considered in design.

The blue detailing rails are only considered for detailing purposes.

Perimeters

Perimeters are displayed as dashed lines around the column section and will
have different shapes and positioning depending upon the head code being
worked to.

Control Perimeter (EC)

The control perimeter is the perimeter of the dark grey area as shown above.
This will vary depending on existing slab edges and openings.
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Critical Perimeter (ACI)

The critical perimeter is the perimeter of the dark grey area as shown above.
This will vary depending on existing slab edges and openings.

Slab opening dead zones

Slab opening dead zones are displayed as interruptions in perimeters and
reinforcement.

Punching shear check local axis

Using the YZ system orients the X axis upwards following the right-hand rule.
This is also the local axis system for the column elements, so it is easier to
relate.

Additional Perimeters

If reinforcement is found to be required, additional perimeters will be
displayed representing positions beyond the critical/control perimeter where
the reinforcement requirement is checked.
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3. Auto-design

If you select the Auto-design option, the reinforcement is increased until
either a pass is achieved or the limiting reinforcement parameter limits have
been exceeded. You can then select the starting point in the Select
reinforcement starting from list.

The Select reinforcement starting from list allows you to select the staring
point for auto-design procedures. The options are:

• Minima: removes the current arrangement and starts the reinforcement
with the minimum allowed bar size.

• Current: auto design starts from the current bar arrangement. The
Current option is only available if you have selected Use reinforcement in
the Properties window.

4. Select reinforcement parameters

Reinforcement type

In the current release, only stud reinforcement is available.

Arrangement type

Allows you to define whether the reinforcement arrangement is orthogonal or
circular.

Rib type

Allows you to specify the reinforcement rib type.

Grade

The reinforcement grades that are available here are set in the Materials
dialog box.

Bar size

The reinforcement bar sizes that are available here are in the Materials dialog
box.

Spacing from column face

Defines the spacing of the first bar in each rail from the column face.

NOTE The option is only available if the Use reinforcement option has been
selected.

Tekla Structural Designer reference 2409 Dialogs



Spacing

Defines the spacing between bars along each rail.

NOTE The option is only available if the Use reinforcement option has been
selected.

5. Studs parameters

Number of studs per rail

Allows you to define the number of studs on each rail.

Number of diagonal stud rails on one corner

Allows you to define the number of stud rails adjacent to each corner of the
column.

NOTE The option is only displayed when Arrangement type is set to
Circular.

Number of studs per column face

Allows you to define the number of stud rails adjacent to the column face in
the local y and z directions.

Rails spacing

Allows you to define the spacing between rails in the local y and z directions.

6. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

See also

Create punching shear checks (page 801)

Design and check punching shear (page 803)
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Load Event Sequences dialog
The Load Event Sequences dialog is used to define all the construction stage
events that slabs in a sub model will go through starting from the day the
slabs are cast.

To display the dialog:

• On the Slab Deflection toolbar, click Event Sequences

The dialog content is described below.

1. Event sequences and submodels pane

Event Sequences

Select Event Sequences to show a summary of the model event sequence and
any custom event sequences that have been defined.

When this page is active you can:

• Add a Custom Load Event Sequence.

• Remove a selected Custom Load Event Sequence.

• Review which Event Sequences are used in submodels
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Model Event Sequence

Select Model Event Sequence to display the various event sequence
parameters for editing.

When this page is active you can:

• Review the existing Load Events and edit all the quantities (except included
loadcases)

• Add an event to the end of the sequence

• Insert an event above the selected event in the sequence

• Remove events

• Move Up or Move Down events to re-order the sequence

• Reset the Model Event Sequence to the default Event Sequence in the
active Settings Set

Custom Event Sequences

Pages for custom event sequences are only displayed if they have been added
from the Event Sequences page.
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When a custom event sequence page is active you can:

• Review the existing Load Events and edit all the quantities (except included
loadcases)

• Add an event to the end of the sequence

• Insert an event above the selected event in the sequence

• Remove events

• Move Up or Move Down events to re-order the sequence

• Reset the custom event sequence to be the same as the Model Event
Sequence

NOTE Model Event Sequences and Custom Event Sequences do not behave
differently - they are both just Event Sequences.

Load Event sub-pages

Load Event sub-pages are displayed under the Model Event Sequence, and any
custom Event Sequences pages. Each Load Event has a separate sub-page
which is used to define the loadcases included in the Load Event.
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The [>>] and [<<] buttons are used to add or remove loadcases from the
Included Loadcases list.

On submodel specifies the percentage of each included loadcase on the
submodel.

From chasedown specifies the percentage of each included loadcase from
the chasedown.

NOTE For propping loadcases - “From Chasedown” should be 0%.

Submodels

Select Submodels to assign a custom event sequence to a submodel if
required.

• With this row selected you can edit the section size and grade for all stacks
simultaneously.
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2a. Event sequence parameters table (Eurocode)

The input parameters required for each event are:

• Event Number - Automatic

• Event Name - A user defined name to help explain the event

• Load Start time - The time at which the event takes place

• Beta - a coefficient to take account of the influence of the duration of
loading. (See: EC2 Clause 7.4.3) This coefficient is used to account for the
fact that tension stiffening effects reduce over time.

Tension stiffening is the phenomenon that when the concrete is not fully
cracked, there is still concrete in the tension zone that transfers some
tensile forces, so the stiffness is greater than that of the fully cracked
stiffness (and less than the uncracked stiffness). Since this effect reduces
over time, to model loads with a longer duration, you want to model a
lower stiffness, which means setting beta = 0.5.

In Tekla Structural Designer, Beta defaults to 1.0 where the start event time
is ≤ 30 days and 0.5 if >30 days, but may be changed for any event.

Tension stiffening reduces over time because of increased cracking and
bond failure between the steel reinforcement and concrete.
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These phenomena cannot be reversed, so reduced tension stiffening
cannot be recovered.

For this reason, if Beta is set to 0.5, and then in a later event set to 1.0, a
warning flag is shown.

• Temperature - Used in the calculation of the Composite Modulus. The
effective age of concrete is adjusted to account for the defined
temperature.

• Relative Humidity - Used in the calculation of creep.

• Number of Exposed Faces - Used for the calculation of creep.

• Construction load - The construction load you wish to allow for at the
chosen load event.

• Loadcase - You select the load cases you wish to be included in the event.

• On submodel - The % of load to apply to the slab, applied directly to the
sub-model.

• From chasedown - The % of load to apply to the slab, from the reactions
established in analysis of the sub-models above.

2b. Event sequence parameters table (ACI)

The input parameters required for each event are:

• Event Number - Automatic

• Event Name - A user defined name to help explain the event

• Load Start time - The time at which the event takes place

• Ultimate Creep Coefficient
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• Aging Coefficient

• Number of Exposed Faces - Used for the calculation of creep.

• Construction load - The construction load you wish to allow for at the
chosen load event.

• Loadcase - You select the load cases you wish to be included in the event.

• On submodel - The % of load to apply to the slab, applied directly to the
sub-model.

• From chasedown - The % of load to apply to the slab, from the reactions
established in analysis of the sub-models above.

3. Update custom event sequences

If you select the Update custom event sequences option, changes made to
the Event in the Model Event Sequence are also replicated in custom event
sequences.

4. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Add Depends on the page selected in the

Event sequences and submodels
pane.

Insert Depends on the page selected in the
Event sequences and submodels
pane.

Remove Depends on the page selected in the
Event sequences and submodels
pane.

Move Up Depends on the page selected in the
Event sequences and submodels
pane.

Move Down Depends on the page selected in the
Event sequences and submodels
pane.

Reset Depends on the page selected in the
Event sequences and submodels
pane.
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Materials dialog
The Materials dialog box allows you to view material database properties and
manage material databases. The databases contain an extensive range of
sections, materials, reinforcement, decking and connectors for each head code
and country.

NOTE Although the Materials dialog can be used to view the properties for
any of the head codes, only the properties for the currently selected
head code in Model Settings can be applied to the model.

To display the dialog:

1. Click the Home tab.

2. Click  Materials.

The dialog content is described below.

Sections settings

The Sections page of the Materials dialog box allows you to view the available
steel, cold formed, cold rolled, and timber sections for each head code. You
can also add new user-defined sections.

Field or button Description
Upgrade If the button is visible, you can click it to upgrade

the material database to a newer version.
Unit System Allows you to select which units are used for

sections.
Head Code Allows you to select the head code whose material

database properties you want to view.
Material Allows you to select the material whose sections

you want to view.
Manage Sections Allows you to add, modify, and delete user-defined

sections.
Manage Section Orders Allows you to adjust section orders according to

your needs.
Connection Resistance Allows you to add connection resistance

information for a section.
Steel Joists Allows you to add steel joist information for a

section.
Plate Dimensions Allows you to adjust plate widths and thicknesses.
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Material settings

The Material page of the Materials dialog box allows you to view properties
of each grade of each material for each head code. You can also add new user-
defined sections.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Material Type Allows you to select the material type
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined material grades to the
Available Grades list.

View... Allows you to view the properties of
pre-defined material grades.

Delete Allows you to permanently delete
user-defined material grades.

>> Default Allows you to make the currently
highlighted material grade a default
material grade, so that it appears in
the Default Grade field.

Reinforcement settings

The Reinforcement page of the Materials dialog box allows you to view the
properties of reinforcement classes and bar sizes.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Country Allows you to select the country
whose material database properties
you want to view.
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Button or field Description
Type Allows you to select the type whose

material database properties you
want to view.

Rib Type Allows you to select the rib type
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined reinforcement classes or bar
sizes to the appropriate list.

View... Allows you to view the properties of
pre-defined reinforcement classes or
bar sizes.

Delete Allows you to permanently delete
user-defined reinforcement classes or
bar sizes.

>> Default Allows you to make the currently
highlighted reinforcement class a
default class, so that it appears in the
Default Class field.

Decking settings

The Decking page of the Materials dialog box contains different sub pages:
Metal Decking and Precast Concrete Decking. The Metal Decking page
allows you to view the properties of different profiles and gauges, and the
Precast Concrete Decking page allows you to view the properties of different
precast concrete planks and depths. The sub pages contain the same
commands.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Country Allows you to select the country
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined profiles, gauges, planks, or
depths to the appropriate list.

View... Allows you to view the properties of
pre-defined profiles, gauges, planks,
or depths.
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Button or field Description
Delete Allows you to permanently delete

user-defined profiles, gauges, planks,
or depths.

>> Default Allows you to make the currently
highlighted profile, gauge, plank, or
depth a default option, so that it
appears in the appropriate Default
field.

Shear Connectors settings

The Shear Connectors page of the Materials dialog box allows you to view
the properties of different connectors.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Country Allows you to select the country
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined sources or connectors to the
appropriate list.

View... Allows you to view the properties of
pre-defined sources or connectors.

Delete Allows you to permanently delete
user-defined sources or connectors.

>> Def. Metal Allows you to make the currently
highlighted option the default option
for metal, so that it appears in the
Default for Metal field.

>> Def. Concrete Allows you to make the currently
highlighted option the default option
for concrete, so that it appears in the
Default for Concrete field.
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Model settings

The Model page of the Materials dialog box allows you to both update the
material databases with new properties from the model and update material
properties in the model with new values from the material databases.

Button, field, or column Description
In Database Uses ? to display if there are

inconsistencies between the material
data in the model and the material
databases.

Add to Database Allows you to update the material
databases with values from the
model.

Update from Database Allows you to update the material
properties in the model with values
from the material databases.

Show only objects not saved in the
database

Hides the model properties that are
consistent with the material
databases.

Model Settings dialog
The majority of settings for the current project are accessed from the Model
Settings dialog.

Location

On the Home tab, click  Model Settings.

Content

Button, Command
or Option

Description

Design Codes See Design code settings (page 2264)
Units See Unit settings (page 2265)
References See Object reference settings (page 2266)
Loading See Loading settings (page 2268)
Grouping See Grouping model settings (page 2269)
Material List See Material list settings (page 2269)
Beam Lines See Beam line settings (page 2270)
Analysis Model See Analysis Model settings (page 2271)
Validation See Validation settings (page 2273)
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Button, Command
or Option

Description

Load reductions See Load reduction settings (page 2273)
EHF See EHF settings (page 2274)
User Defined
Attributes

See User-defined attribute settings (page 2274)

Graphics View
Settings

See Graphics view settings (page 2275)

Structural BIM See Structural BIM settings (page 2276)
OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings set for

future use.
Load button Revert to the model settings specified in the active

settings set.

Sections dialog
The Sections dialog box is used to select sections to apply to the model and
also to manage the sections stored in the material database.

The dialog content is described below.

1. Page pane: views the different section geometries.
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2. Item pane: views the different sizes of the selected section when you
select a section geometry Page pane. Any user-defined sections are
marked with *.

3. Details pane: views the details of the selected section when you click the
Details button.

4. Country droplist: allows you to display the sections of each country.

5. Geometry filter: allows you to filter sections according to their geometry.

6. Selected section: displays the details of the currently selected section.

7. Section filter: allows you to filter sections according to their details.

You can also use the following buttons to manage the sections:

• Add...: allows you to add a user-defined section to the material database.

• Delete: allows you to delete a user-defined section.

• Edit...: allows you to modify the properties of a user-defined section.

• Details: opens the Details pane and displays the properties of the
currently selected section.

Settings dialog
The Settings dialog allows you to manage defaults, collectively referred to as a
settings set, that are used in future projects. In addition, you can manage
general and display settings that are applied instantly to the current work
session.

Location

On the Home tab, click  Settings.

Content

List, Page, or
Button

Description

Select the settings
set to edit list,
Available settings
sets list

Allows you to select the settings set to view or modify.

Settings Sets See Settings set settings (page 2386)
General See General settings (page 2387)
Results Viewer See Results Viewer settings (page 2388)
Report See Report settings (page 2394)
Units See Unit settings (page 2265)
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List, Page, or
Button

Description

Design Codes See Design code settings (page 2264)
Design Settings See Design Settings (page 2293)
Analysis Settings See Analysis Settings (page 2278)
Loading See Loading settings (page 2268)
Structure Defaults See Structure default settings (page 2389)
Section Order
Defaults

See Section order default settings (page 2390)

References See Object reference settings (page 2266)
Drawings See Drawing settings (page 2352)
Material List See Material list settings (page 2269)
Beam Lines See Beam line settings (page 2270)
Analysis Model See Analysis Model settings (page 2271)
Solver See Solver settings (page 2390)
User Defined
Attributes

See User-defined attribute settings (page 2274)

Scene See Scene settings (page 2391)
Structural BIM See Structural BIM settings (page 2276)
Slab Deflection See Slab deflection settings (page 2348)
Performance See Performance settings (page 2396)
OK button Apply the changes.
Cancel button Cancel the changes.

Slab Deflection Check Catalogue
The Slab Deflection Check Catalogue is used to define the deflection checks
that are applied to check lines.

Location

On the Slab Deflection tab, click Deflection Checks.

Content

Each deflection check has a unique name and can either be defined as a total
or instantaneous check for a specific event, or a differential check between
load events. A deflection limit is set and you can specify if the check is to be
applied to each new check line as it is defined.

Field or button Description
Name Allows you to modify the check name.
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Field or button Description
Type Allows you to select the deflection check type, see

Display slab deflection analysis results (page 937) .
Start Event Allows you to select the start event for a

differential check.
Event Allows you to select the event to which the check

applies.
Deflection Limit Allows you to specify the deflection check limit.
Use in new Check Lines Check the box only to be automatically apply the

check to new check lines as they are created.
Add Allows you to add a new row in the table for

defining a new check.
Remove Removes the selected check from the table.

Snow wizard (Eurocode)

Summary

You can use the Snow wizard... to define sufficient site information to
calculate the snow loadcases.

Location

1. Ensure the head code is set as Eurocode with the required National
Annex.

2. On the Load tab, click Snow Load --> Snow wizard...

Plain Eurocode, Ireland and Sweden National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Plain
Eurocode,
Ireland and
Sweden
National
Annex)

The following basic data is required:

Exposure
Coefficient

User defined value. (Default 1.0)

Thermal
Coefficient

User defined value. (Default 1.0)
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Button,
command or

option

Description

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Density Define the density of snow. (Default 2.0
kN/m2)

Snow Load User defined value. (No default value)
Next Click to proceed to the next page of the

Snow wizard...
Page 2 - Snow
load cases
(Plain
Eurocode,
Ireland and
Sweden
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.
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Button,
command or

option

Description

Loadcase Type
(Plain Eurocode
and Ireland
National Annex)

Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1
Loadcase Type
(Sweden
National Annex)

Each loadcase has a loadcase type which
can be:

• Snow

• Snow Sk > 2 kN/m2

• Snow Sk > 3 kN/m2

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

UK National Annex

Button,
command or

option

Description

Page 1 - Basic
data (UK
National
Annex)

The following basic data is required:
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Button,
command or

option

Description

Exposure
Coefficient

User defined value. (Default 1.0)

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Density Define the density of snow. (Default 2.0
kN/m2)

Snow Load  
Zone Number, Z Zone Number. (Default 2.0 kN/m2)
Altitude, A Altitude. (Default 1.0)
Characteristic
Ground Snow
Load, sk

Characteristic ground snow load
calculated as

sk = (0.15 + (0.1 * Z + 0.05)) + ((A - 100)/
525)

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
load cases (UK
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically
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Button,
command or

option

Description

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Finland National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Finland
National
Annex)

The following basic data is required:
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Button,
command or

option

Description

Topography Options are:

• Windswept

• Normal (Default)

• Sheltered
Exposure
Coefficient

Value determined from Topography.

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Weight
Density

Define the density of snow. (Default 2.0
kN/m2)

Characteristic
Ground Snow
Load

User defined value. (No default value)

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
load cases
(Finland
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically
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Button,
command or

option

Description

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow, Sk > 2.75 kN/m2

• Snow Drift

• Ice

Refer to EC 1992-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Norway National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Norway

The following basic data is required:
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Button,
command or

option

Description

National
Annex)
Topography Options are:

• Windswept

• Normal (Default)

• Sheltered
Exposure
Coefficient

Value determined from Topography.

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Weight
Density

Define the density of snow. (Default 2.0
kN/m2)

Altitude, H User defined value.
Basic Reference
Altitude

User defined value.

Basic Snow Load User defined value.
???? User defined value.
???? User defined value.
Characteristic
Ground Snow
Load

Automatically determined from the
above values.

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
load cases
(Norway
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.
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Button,
command or

option

Description

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1992-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.
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Snow wizard (ASCE7)

Summary

You can use the Snow wizard... to define sufficient site information to
calculate the snow loadcases.

Location

1. Ensure the snow loading code is set as ASCE7.

2. On the Load tab, click Snow Load --> Snow wizard...

Content

Button,
command or

option

Description

Page 1 - Basic
data (ASCE7
Snow wizard)

The following basic data is required:

Ground snow
load

(No default)

Terrain Category Options are:

• B (urban, suburban, wooded) -
Default

• C (open terrain scattered
obstructions),

• D (flat unobstructed areas), Above
treeline, Alaska no trees

Exposure Options are:

• Fully exposed

• Partially exposed
Exposure factor,
Ce

Ce is determined from the following
table:

 Ful
ly

Exp
ose

d

Full
y

Exp
ose

d

Shel
tere

d

B 0.9 1 1.2
C 0.9 1 1.1
D 0.8 0.9 1
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Button,
command or

option

Description

 Ful
ly

Exp
ose

d

Full
y

Exp
ose

d

Shel
tere

d

Abov
e
treeli
ne

0.7 0.8 0

Alask
a

0.7 0.8 0

Thermal
Condition

Option are:

• All except below

• Structures kept just above freezing

• Unheated open air structures

• Structures kept below freezing

• Continuously heated greenhouses
Thermal factor,
Ct

Ct is determined from the following
table:

A 1
B 1.1
C 1.2
D 1.3
E 0.85

Risk Category Option are:

• I

• II

• III

• IV
Snow
Importance
factor, Is

Is is determined from the following
table:

I 0.8
II 1
III 1.1
IV 1.2
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Button,
command or

option

Description

Flat Roof Snow
load, , pf

pf is determined from the following:

pf = 0.7 * Ce * Ct * Is * pg

Next Takes you to the next page.
Page 2 - Snow
load cases (AISC
Snow wizard)

This page is used to specify the
loadcases as follows:

Minimum Snow
Load

Option are:

• Yes

• No
Balanced Snow
Load

Option are:

• Yes

• No
Unbalanced
Snow Load

Option are:

• No

• 1

• 2

• 3

• 4

You can select between 1 and 4 cases to
generate (1 Unbalanced..., 2
Unbalanced, etc.)

Draft Snow Load Option are:

• No

• 1

• 2

• 3

• 4

You can select between 1 and 4 cases to
generate (1 Unbalanced..., 2
Unbalanced, etc.)

Rain on Snow
Surcharge

Option are:

• Yes

• No
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Button,
command or

option

Description

Finish Completes the Snow wizard... and sets
up the loadcases based upon the input.

Sub Models dialog
The Sub Models dialog box allows you to split the structure into a continuous
series of sub models, working from the top of the building down to, and
including the foundations.

Location

In the Structure tree, double-click Sub Models.

Content

Button,
Command or

Option

Description

Options  
Level Before any analysis has been performed,

only two levels are displayed, one at a
distance (2m) above the highest
construction level and a second at the
same distance below the lowest level.
These cannot be changed. Hence, at this
point, there is a single sub-model
comprising the whole structure.

Active Only active levels act to divide the
structure into sub-models. The top and
bottom levels must always remain active,
as there must always be at least one sub
model.

Once intermediate levels have been
inserted, you can choose to inactivate
them if required. When this occurs the
sub-models immediately above and below
the level in question are merged into a
single sub-model.

Auto Generate If any adjustments to the cutting planes or
cutting plane levels, or any of them are set
as inactive you must also clear Auto-
Generate. Otherwise the changes you
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Button,
Command or

Option

Description

have made will be lost the next time the
sub models are generated.

Buttons  
OK Allows you to save any changes made.
Cancel Allows you to discard any changes made.
Insert Above Allows you to insert a new sub model

between the selected level and the one
above. It defaults to being located half way
between the two, however this can be
edited manually, provided it remains
between the two reference levels.

Insert Below Allows you to insert a new sub model
between the selected level and the one
below. It defaults to being located half way
between the two, however this can be
edited manually, provided it remains
between the two reference levels.

Delete  
Generate Allows you to auto generate default sub

models or not

• Checked

Auto Generate creates default sub
models for every level specified as a
floor in the Construction Levels dialog.
It is optional as default sub models are
automatically generated for you when
you run the analysis, provided the Auto
Generate box on the dialog is checked.
You may choose to do this if you want
to review the sub models prior to the
first run of the analysis.

• Unchecked

Does not Auto Generate sub models
prior to the first run of the analysis.

NOTE The Generate button can also be
used to revert back to the default
sub models at any time.
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See also

Manage sub models (page 661)

Create sub models (page 662)

Slab Deflection Settings dialog
The Slab Deflection Settings dialog and its subpages allow you to adjust the
settings applied to the different analyses.

Location

On the Slab Deflection tab, click Settings.

Content

Button, command or option Description
• New Load Event Defaults

• New Check Defaults

• Aging, Creep & Shrinkage

• Modification Factors

• Iterative Cracked Section
Analysis

See: Slab deflection settings

OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings

set for future use.
Load button Revert to the model settings specified in

the active settings set.
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Area Load (command) .............................2180
Area Mat (command) ...............................2180
Autodesk Revit Export (command) ........2180
Automatically join all beams .....................505
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2056
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Bays Mat (command) .............................. 2180
Beam (command) .................................... 2181
Beam line settings ................................... 2270
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Beam releases ..........................................2084
Bearing Wall (command) .........................2181
BIM Integration .......................................... 300
BIM Integration ribbon ............................2207
Brace(command) ..................................... 2181
Calculate slab deflections ......................... 931
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Cellbeam Export (command) ..................2181
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architectural grid ........................................377
Change the view regime ............................280
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Check in Tedds ......................................... 2182
Check Line Reports...................................1424
Check lines in depth ................................ 1421
Check member .........................................2238
Check members ....................................... 2239
Check model .............................................2239
Check model patches .............................. 2239
Check model slabs ...................................2240
Check panel .............................................. 2240
Check plane .............................................. 2240
Check plane patches ............................... 2241
Check plane slabs .................................... 2241
Check punching shear .............................2242
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Check selection ........................................ 2242
Check using Tekla Tedds..........................2242
Check wall ................................................. 2246
Check walls ............................................... 2247
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1714

Classification (Columns: AS 4100)...........2059
Classification (Columns: EC3 Eurocode).1918
Clear Tekla Tedds Data ........................... 2247
Cloud Export (command) ........................2182
Column (command) .................................2183
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318 ............................................................. 1780
Column releases ...................................... 2097
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.................................................................... 2052
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.................................................................... 1897
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.................................................................... 1903
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.................................................................... 1248
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AS 4100)..................................................... 2057
Compression buckling resistance (Member
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AS 4100)..................................................... 2065
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2019
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Concrete beam design to EC2 (Eurocode) ....
1937
Concrete column design to ACI 318 ...... 1772
Concrete slab ........................................... 1239
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Eurocode)...................................................1905
Concrete slab design to ACI 318 ............ 1827
Concrete wall design to ACI 318 ............ 1803
Configure and display member reports ..948
Configure and display model reports ..... 947
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(beams seismic: ACI 318)......................... 1771
Confinement reinforcement for ductility
(columns seismic: ACI 318)...................... 1803
Connection Resistance dialog ................ 2399
Connector layout...................................... 1240
Construction Levels command............... 2248
Construction levels dialog ...................... 2402
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Construction stage design (Composite
beams: BS 5950)....................................... 2025
Construction stage design (Composite
beams: EC4 Eurocode) ............................ 1906
Construction stage events ...................... 1393
Copy (command).......................................2183
Copy and rotate objects ............................495
Copy Loads (command)........................... 2182
Copy material grades ................................ 870
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reinforcement ............................................ 868
Copy or modify user-defined attributes . 873
Copy properties ..........................................871
Copy quick connector layout.....................881
Copy section sizes ......................................870
Copy shear connectors ............................. 891
Copy transverse reinforcement ............... 894
Copy web openings ................................... 896
Copy westok openings .............................. 896
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EC2) ............................................................1938
Cover to Reinforcement (Concrete column:
EC2) ............................................................1957
Cover to Reinforcement (Concrete wall: EC2)
.................................................................... 1975
Cover to Reinforcement(ACI 318)........... 1731
Cracking of concrete (SLS) (Composite
beams: EC4 Eurocode)............................. 1915
Create a new project based on a template
.......................................................................246
Create a new template ..............................246
Create a pile type catalogue ..................... 838
Create a sub structure ............................ 1031
Create a sub structure group ................. 1034
Create a truss ............................................. 463
Create and manage user-defined attributes
.................................................................... 1026
Create and modify patches ...................... 790
Create and modify reports ....................... 944
Create beam end force drawings ............ 973
Create column drops .................................459
Create column splice load drawings ........974
Create concrete cores................................ 435
Create concrete member schedule drawings
.......................................................................982
Create continuous beams .........................405
Create curved beams ................................ 406
Create DELTABEAMS .......................... 411,413

Create diaphragm loads ............................547
Create door or window openings ............ 432
Create drawing scales ............................... 968
Create drawings ......................................... 965
Create drawings in batches ...................... 984
Create foundation drawings .....................980
Create free form trusses ...........................464
Create full UDLs ......................................... 544
Create gable posts or parapet posts ....... 394
Create general arrangement drawings ... 972
Create Infills (command)..........................2183
Create isolated foundations ..................... 836
Create load cases .......................................515
Create load combinations manually ........520
Create load groups .................................... 517
Create loading plan drawings ...................975
Create mat foundations ............................841
Create member detail drawings .............. 976
Create modal mass combinations ...........521
Create models ............................................ 347
Create nodal loads .....................................554
Create pad base columns ......................... 836
Create partial-length torsional UDLs and
VDLS .............................................................546
Create partial-length UDLs or VDLs .........544
Create planar drawings .............................972
Create point loads and moment loads ... 545
Create punching shear checks ................. 801
Create reports ............................................ 947
Create reports sand drawings ..................944
Create settlement loads ............................554
Create slab and mat drawings ................. 979
Create slab or mat openings .................... 455
Create space trusses ................................. 464
Create strip base walls .............................. 837
Create sub models .....................................662
Create temperature loads ........................ 554
Create torsion full UDLs ............................545
Create trapezoidal loads ........................... 545
Create Westok Cellular, Westok Plated or
FABSEC beams ............................................410
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configurations ............................................ 969
Create, modify, or delete layer styles ......971
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the load input ............................................. 670
Custom event sequences............... 1404,1422
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Cutting Planes (command)...................... 2183
D2. Axial tension (Columns: AISC 360)... 1691
Deemed to satisfy slab deflection checks
example (ACI)............................................ 1463
Deemed to satisfy slab deflection checks
example (Eurocode)................................. 1427
Deflection check (beams: ACI 318) ........ 1747
Deflection checks (SLS) (Composite beams:
EC4 Eurocode)........................................... 1914
Delete construction levels ........................ 369
Delete panel, member, and structure loads
.......................................................................555
Delete sub models .....................................663
Delete sub structure ................................1033
Delete the snow model ............................. 577
Description of a typical event sequence ....
1394
Design All Gravity (command) ................2184
Design All RSA (command) ..................... 2185
Design All Static (command) ...................2184
Design code settings ............................... 2264
Design codes reference .......................... 1662
Design Concrete Gravity (command) .... 2184
Design Concrete RSA (command) .......... 2184
Design Concrete Static (command) ....... 2184
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1838
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(beams: ACI 318) .............................1741,1742
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Design for Combined Axial and Bending
(column and wall:ACI 318 ....................... 1779
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Design for in plane shear (walls:ACI 318) ....
1807
Design for Shear (column and wall:EC2) ....
1972
Design for Shear (column and wall:ACI 318)
.................................................................... 1780
Design for walking excitation DG11 ...... 1849
Design isolated foundations .....................840
Design mat foundations ............................846
Design Mats (command) .........................2186

Design member ....................................... 2248
Design members ......................................2249
Design method (Angles and tees: BS 5950)
.................................................................... 2041
Design method (Beams: AISC 360)......... 1671
Design method (Composite beams: EC4
Eurocode)...................................................1903
Design model ........................................... 2250
Design model patches .............................2250
Design model slabs ................................. 2251
Design Moment Calculations (Column and
wall: ACI 318) ............................................ 1777
Design Pad Bases (command) ................2186
Design panel .............................................2251
Design parameters for horizontal bars
(concrete wall: ACI 318) ...........................1806
Design Parameters for Horizontal Bars
(Concrete wall EC2) ..................................1977
Design Parameters for Longitudinal Bars
(Concrete column: ACI 318) .................... 1773
Design parameters for longitudinal bars
(ACI 318) .................................................... 1733
Design Parameters for Longitudinal Bars
(Concrete column: EC2) ...........................1958
Design parameters for longitudinal bars
(EC2) ...........................................................1938
Design Parameters for LVertical Bars
(Concrete wall: ACI 318) .......................... 1804
Design Parameters for Vertical Bars
(Concrete wall: EC2) .................................1976
Design Patches (command) ....................2185
Design philosophy of DG11 floor vibration
.................................................................... 1846
Design philosophy of P354 floor vibration ....
1991
Design Pile Caps (command) ..................2186
Design plane .............................................2252
Design plane patches .............................. 2252
Design plane slabs ...................................2253
Design procedure for double angles (Angles
and tees: AISC 360)................................... 1701
Design punching shear............................ 2253
Design Punching Shear (command) ...... 2185
Design review filters .................................. 853
Design ribbon ...........................................2208
Design selected members and walls........782
Design selection .......................................2254
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Design settings....
2294,2323,2339,2345,2346,2347
Design settings ............ 2296,2320,2322,2341
Design Settings - Minimum Design Forces
Examples....................................................2325
Design Settings dialog .............................2404
Design slabs (command)..........................2185
Design slabs, create and design patches,
create and run punching shear checks....789
Design Steel Gravity (command) ............2184
Design Steel Static (command) .............. 2184
Design using Tekla Tedds........................ 2255
Design wall ................................................2261
Design walls ..............................................2261
Desing options ......................................... 2293
Dialog boxes .............................................2397
Diaphragm Load (command) ................. 2186
Diaphragm loads and diaphragm load
tables ........................................................... 546
Dimension (command) ............................2187
Display analysis results.............................. 671
Display reactions ........................................673
Display solver models ............................... 724
Display sway drift and story shear ...........676
Draw ribbon ............................................. 2211
Drawing categories ....................................965
Drawing settings ...................................... 2352
Drawing Settings dialog .......................... 2405
E. Axial compression (Beams: AISC 360) 1673
Edit Event Sequences................................. 932
Edit Reinforcement dialog....................... 2405
Edit ribbon ................................................ 2211
Editing a Custom Event Sequence.......... 1402
Effective Depth of Section (Concrete beam:
ACI 318) ..................................................... 1737
Effective Depth of Section (Concrete beam:
EC2) ............................................................1944
EHF settings .............................................. 2274
Element (command) ................................ 2187
Eurocodes..................................................1863
Event sequences ...................................... 1393
Example reports .........................................958
Exclude individual nodes from a rigid
diaphragm .................................................. 660
Exclude slab items from a diaphragm .....661
Export a model to Autodesk Revit Structure
.......................................................................327

Export a model to Autodesk Robot
Structural Analysis ..................................... 340
Export a model to IFC ................................ 328
Export a model to STAAD ..........................339
Export a model to Tekla Structures ......... 318
Export a model to the cloud ..................... 341
Export reports ............................................ 957
Export tabular results to Excel.................. 930
Export to and import from other
applications ................................................ 327
Export to Trimble applications.................. 317
F2. Flexure (Beams: AISC 360)................. 1674
Factors that affect rigorous slab deflection
estimates................................................... 1385
FE meshing, sub models and diaphragms ....
636
Filter reports ...............................................951
Filter tabular data ...................................... 929
Find (command) .......................................2187
First-order (Elastic) analysis........... 1139,1143
Flexural reinforcement (beams seismic: ACI
318).............................................................1771
Flexural requirements (beams seismic: ACI
318).............................................................1763
Flexural requirements (columns seismic: ACI
318).............................................................1796
Format reports ........................................... 952
Foundations ribbon .................................2213
Frame (command) ................................... 2187
Free Points (command)............................2189
Full UDL (command) ................................2189
Further help and update information...... 241
G2. Shear strength (Columns: AISC 360)1691
General parameters (EC2) ...................... 1935
General requirements (beams seismic: ACI
318).............................................................1761
General requirements (columns seismic: ACI
318).............................................................1794
General requirements (walls seismic: ACI
318).............................................................1824
General settings .......................................2387
Generate load combinations automatically
.......................................................................519
Get familiar with the user interface .........247
Get started with analysis ...........................623
Get started with slab deflection analysis 931
Graphics view settings ............................ 2275
Grouping model settings ........................ 2269
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H1. Combined forces (Beams: AISC 360)....
1675
Home ribbon ............................................ 2217
How bearing walls are represented in solver
models..........................................................761
How do I assess the worst elastic critical
load factor for the building?.1142,1145,1146
How is the elastic critical load factor
calculated?........................................1142,1146
How meshed walls are represented in
solver models ............................................. 750
How mid-pier walls are represented in
solver models.............................................. 755
How to use the Project Workspace to
manage connections ................................. 273
How to use the Project Workspace ..........261
Identify the nodes constrained by rigid
diaphragms .................................................660
IFC Export (command) .............................2189
Import a project from a Structural BIM
Import file ................................................... 301
Import grids from DXF files .......................377
Import loadcases and combinations from a
spreadsheet.................................................522
Import model data .....................................300
Install a Tekla Structural Designer service
pack ................................................................96
Install and license Tekla Structural Designer
.......................................................................238
Inter-story shear and cumulative story
shear.............................................................901
Interactive Beam Design dialog ............. 1311
Interactive Column Design dialog ..........1327
Interactive Wall Design dialog ................1345
Introduction to floor vibration (DG11)... 1844
Introduction to floor vibration (P354).... 1989
Join (command).........................................2189
Joist(command) ........................................ 2190
Level Load (command) ............................2190
Limitations (beams seismic: ACI 318) ....1749
Limitations (Concrete beam: ACI 318) ...1732
Limitations (Concrete beam: EC2) ......... 1937
Limitations (Concrete members: ACI 318) ....
1730
Limitations and assumptions (columns
seismic: ACI 318) ...................................... 1781
Limitations and assumptions (walls seismic:
ACI 318) ..................................................... 1808

Limitations of Seismic Design................. 1194
Line Load (command) ..............................2190
Load cases (British Standards)................2007
Load combination classes .........................518
Load Event Sequences dialog .................2410
Load reduction settings .......................... 2273
Load ribbon .............................................. 2218
Loading (Eurocode)...................................1864
Loading dialog............................................. 531
Loading settings .......................................2268
Make a level an identical copy of another
level ..............................................................368
Make a level an independent copy of
another level ...............................................369
Manage and view result strips ................. 685
Manage architectural grids and grid lines ....
370
Manage display and design result lines...688
Manage drawings in batches ....................984
Manage FE meshed slabs.......................... 637
Manage FE meshed walls ..........................653
Manage load cases .................................... 514
Manage load cases, groups, combinations,
envelopes and patterns............................. 514
Manage load combinations ...................... 518
Manage load groups ..................................516
Manage load patterns ............................... 527
Manage material databases ...................1004
Manage models ..........................................991
Manage properties and property sets .. 1021
Manage scene views ..................................275
Manage schedule drawings in batches ... 988
Manage sub models .................................. 661
Mat foundation design workflow (metric
units)...........................................................1594
Mat foundation design workflow (US
customary units)....................................... 1608
Mat Opening (command) ........................2190
Material list settings ................................ 2269
Material lists for cold formed.................... 926
Material lists for concrete.......................... 913
Material lists for general materials...........927
Material lists for steel................................. 907
Material lists for timber..............................924
Measure (command) ............................... 2190
Measure Angle (command) .................... 2190
Member strength checks (ULS) (Composite
beams: EC4 Eurocode)............................. 1908

2446



Merge planes ..............................................511
Merge Planes (command)........................2190
Metal deck ................................................ 1239
Method 1: Simplified Event Sequence +
Simplified Combined Creep and Shrinkage
Allowance...................................................1468
Method 3: Detailed Event Sequence +
Rigorous Creep and Shrinkage Allowance....
1480,1487
Minimum Area Mat (command) .............2192
Minimum area of shear reinforcement
(beams: ACI 318) ...................................... 1745
Mirror (command).................................... 2192
Mirror objects to new locations ............... 496
Model ribbon ............................................2222
Model Settings.......................................... 2263
Model Settings dialog...............................2422
Model SidePlate connections.................... 833
Model steel beams and cold formed beams
.......................................................................407
Modify assumed cracked settings ........... 875
Modify auto design settings .............. 865,875
Modify BIM status ...................................... 867
Modify column splice positions ................872
Modify concrete column alignment or
specify offsets .............................................400
Modify end fixity ........................................ 867
Modify gravity only settings ......................880
Modify panel, member, and structure loads
.......................................................................555
Modify punching shear check position ... 880
Modify SidePlates .......................................892
Modify slenderness settings .....................878
Modify stud auto layout ............................ 893
Modify the geometry of steel trusses ......465
Modify the position of beams .................. 407
Modify the properties of a construction
level ..............................................................369
Modify the properties of existing trusses ....
465
Modify the report structure ......................950
Moment Load (command) ...................... 2191
Move (command)......................................2191
Move a brace .............................................. 421
Move an rotate objects ............................. 495
Move DXF Shadow (command)............... 2191
Move Model (command)..........................2191
Navigate reports ........................................ 955

New (command) .......................................2192
Nodal Load (command) .......................... 2192
Object properties .....................................2066
Object reference settings ........................2266
Observations on the Different Methods1496
OCBF (Seismic: AISC 341) ........................ 1706
Open a 3D view of a sub structure ........ 1034
Open a 3D view of a sub model ............... 663
Open solver view ..................................... 2262
Open view .................................................2262
Overview (Composite beams: EC4 Eurocode)
.................................................................... 1904
Overview of load groups ...........................516
Overview of load patterns ........................ 528
Overview of one-way and two-way load
decomposition............................................ 557
Pad and strip base design to ACI 318 ....1827
Pad Base Column (command) ................2192
Patch Column (command) ...................... 2193
Patch Load (command) ........................... 2193
Performance settings .............................. 2396
Perimeter Load (command) ................... 2193
Pile (command) ........................................ 2193
Pile Array (command) ..............................2193
Pile Cap Column (command) ..................2194
Pile cap design to ACI 318........................1838
Pile capacity (ACI 318).............................. 1838
Piled mat foundation design workflow
(metric units)............................................. 1633
Piled mat foundation design workflow (US
customary units)....................................... 1622
Point Load [Member] (command) ......... 2194
Point Load [Panel] (command) ...............2194
Polygon Load (command) .......................2194
Portal Frame(command) .........................2195
Precast concrete planks ..........................1236
Precast concrete planks (Composite beams:
EC4 Eurocode)........................................... 1906
Print reports ............................................... 957
Project Wiki (command) ..........................2194
Provided performance P354 floor vibration
.................................................................... 1995
Punching Check (command) ...................2194
Rationalize (command)............................ 2195
Rectangular Mat (command) ..................2195
Reference ..................................................2066
References ACI 318 ..................................1843
References EC2 ........................................ 1989

2447



Rename sub structure .............................1033
Renumber all load cases ...........................516
Renumber all load combinations .............526
Report ribbon ...........................................2228
Report settings .........................................2394
Report terminology ....................................944
Requirements when in SDC D - F(beams
seismic: ACI 318)....................................... 1770
Reset reinforcement marks in concrete
detail drawings ...........................................986
Results Viewer settings ........................... 2388
Reverse (command)..................................2195
Review and apply property sets ...............873
Review and copy deflection limits ............879
Review and copy size constraints ............ 892
Review and modify diaphragm settings ..865
Review and modify drift checks ............... 879
Review and modify member filters ......... 871
Review and modify restraints ...................882
Review and modify SFRS type and direction
settings ........................................................890
Review and modify sway checks .............. 893
Review and modify user defined utilization
ratios ............................................................894
Review and modify wind drift checks ......897
Review concrete beam flanges .................872
Review design summary tabular results..898
Review drawings ........................................ 987
Review drift check tabular results.............901
Review floored area tabular results......... 929
Review foundation and pile design ......... 850
Review material list tabular results ......... 902
Review member design .............................849
Review models ........................................... 848
Review ribbon .......................................... 2229
Review slab and mat design ..................... 851
Review story shear tabular results........... 900
Review sub structures .............................1034
Review sub structures ............................... 872
Review sway check tabular results........... 900
Review tabular data ...................................898
Review the slab mesh before the analysis ....
639
Review the wall mesh before the analysis ....
654
Review where property sets have been
applied ...................................................... 1024
Review wind drift check tabular results... 902

Rigorous slab deflection analysis example
(Eurocode)................................................. 1430
Rigorous slab deflection workflow......... 1384
Robot Export (command) ....................... 2195
Roof Panel (command) ............................2196
Roof Panel Properties ............................. 2140
RoofType ..................................................... 568
RSA seismic results .................................... 691
Run a 1st order linear or non-linear analysis
.......................................................................664
Run a 1st order modal analysis ................665
Run a 2nd order buckling analysis ...........666
Run a seismic analysis ...............................667
Run analyses ...............................................664
Run FE chasedown or grillage chasedown
analysis ........................................................668
Run Slab Deflection Analysis..................... 936
Run the snow load wizard .........................568
Scene content categories ..........................282
Scene settings .......................................... 2391
Scope of DG11 floor vibration.................1844
Scope of floor vibration (P354)................1990
Second-order analysis.................... 1140,1144
Section axes (Angles and tees: AISC 360)....
1697
Section classification (Beams: AISC 360)1673
Section classification (Columns: AISC 360)....
1690
Section default settings ...........................2390
Section order default settings ................2390
Seismic cantilevers beams seismic: ACI 318)
.................................................................... 1770
Seismic design (walls: ACI 318) ...............1807
Seismic design and detailing (columns: ACI
318) ............................................................1780
Seismic design and detailing (beams: ACI
318) ............................................................1748
Seismic design rules (Braces: AISC 360).1695
Seismic design rules (Columns: AISC 360)....
1692
Seismic Design to ACI 318........................1840
Select a section in the Sections dialog box
.......................................................................358
Select between static, gravity and RSA
design .......................................................... 778
Select in visible views .............................. 2262
Select the member report style ............... 949
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Select whether to design steel, concrete, or
all ..................................................................777
Sensitive use analysis DG11 ................... 1855
Serviceability limit state (SLS) (Composite
beams: AISC 360)...................................... 1682
Set the design type to review ................... 848
Setting out steel and cold formed columns
.......................................................................396
Setting up Slab Deflection checks in advance
.................................................................... 1422
Settings dialog...........................................2424
Settings set settings .................................2386
Settlement Load (command) ..................2196
Shear Capacity (Beams: EC3 Eurocode). 1891
Shear capacity (Columns: AS 4100)........ 2059
Shear design (pile cap: ACI 318)..............1838
Shear Only Wall (command) ...................2203
Shear only walls overview..........................757
Show and alter state .......................... 864,873
Show references ...................................... 2262
Side Reinforcement (Concrete beam: EC2)
.................................................................... 1944
Side skin reinforcement in beams (ACI 318)
.................................................................... 1737
SidePlate connections................................ 825
SidePlate connections theory....................826
Sign conventions and coordinate systems
.......................................................................697
Slab deflection calculations in depth..... 1408
Slab deflection methods ......................... 1382
Slab deflection optimization .....................942
Slab deflection results and reports ......... 937
Slab Deflection ribbon .............................2232
Slab deflection settings ........................... 2348
Slab Deflection Settings dialog ...............2440
Slab deflection status and utilization .... 1424
Slab Load (command) ............................. 2196
Slender beams (ACI 318) .........................1733
Slender beams (Concrete beam: EC2) ...1937
Sloped Plane (command) ........................2197
Snow loading .............................................. 567
Solver settings .......................................... 2390
Spacing of shear reinforcement (beams: ACI
318) ............................................................1746
Specify a column splice ............................. 398
Specify concrete column alignment relative
to the grid ................................................... 399
Specify the brace type and section size .. 419

Specify the drawing layout ....................... 985
Specify the loading for load-dependent
drawings ......................................................986
Split (command)........................................2198
STAAD Export (command) ...................... 2198
Start Tekla Structural Designer................. 241
Steel beam design to AISC 360................1671
Steel beam design to EC3 (Eurocode).... 1889
Steel beam limitations and assumptions
(Beam: EC3 Eurocode)..............................1889
Steel beam limitations and assumptions
(Beams: AISC 360)..................................... 1671
Steel brace design to AS 4100................. 2064
Steel brace design to AISC 360................1693
Steel column design to BS 5950..............2033
Steel design to AISC 360 ASD and LRFD.1669
Steel design to EC3 and EC4....................1886
Steel single, double angle and tee section
design to AISC 360.................................... 1696
Steel single, double angle and tee section
design to EC3 (Eurocode).........................1927
Stresses in 2D elements ............................679
Strip Base Wall (command) .................... 2198
Strip Mat (command) .............................. 2198
Structural BIM Import (command) ........ 2198
Structural BIM settings ............................2276
Structure default settings ....................... 2389
Stud strength.............................................1239
Sub Model Properties ..............................2072
Sub Models ...............................................2438
Sub Models command............................. 2263
Support (command) ................................ 2199
Support properties .................................. 2142
TCD Export (command) ...........................2199
Tekla Structures Export (command) ......2199
TEL File Import (command) .................... 2199
Temperature Load (command) ..............2200
The Materials dialog box .........................2418
The Sections dialog box .......................... 2423
The Slab Deflection Check Catalogue ....2425
Timber property assumptions ............... 1021
Torsion design - loading (Beams: AISC 360)
.................................................................... 1676
Torsion Full UDL (command) ..................2201
Torsion UDL (command) .........................2201
Torsion VDL (command) ......................... 2201
Total, differential, and instantaneous
deflection types ........................................1407
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TPFD Export (command) .........................2199
Transverse reinforcement (beams seismic:
ACI 318)...................................................... 1766
Transverse reinforcement (columns seismic:
ACI 318)...................................................... 1799
Trapezoidal Load (command) ................ 2201
Trimble Connect (command) ..................2199
Truss (command) .....................................2200
UDL (command) ....................................... 2201
Ultimate Axial Load Limit (column and
wall:ACI 318 .............................................. 1773
Ultimate Limit State - Strength (Beams: EC3
Eurocode)...................................................1890
Understanding event sequence deflections
.................................................................... 1405
Unit settings ............................................. 2265
Update load patterns ................................ 530
Update snow loads .................................... 577
Upgrade material databases ..................1020
Use of check lines to check deflections (ACI)
.................................................................... 1501
Use templates in new projects .................246
User-defined attribute settings ..............2274
Validate (command)................................. 2201
Validation settings ................................... 2273
Validity of the amplified forces method.1144
Variable Area Load (command) ..............2202
Variable Patch Load (command) ............2202
VDL (command) ........................................2202
Vibration Check (command) ...................2202
View active masses by node ..................... 769
View and modify wind properties ............271
View buckling factors .................................770
View drawings ............................................ 987
View load status ......................................... 270
View modal frequencies and modal masses
.......................................................................770
View mode shapes .....................................691
View notional forces and seismic equivalent
lateral forces ...............................................677
View solver node and solver element
properties ................................................... 734
View status...................................................272
View tabular results for core lines ........... 768
View tabular results for mode shapes .... 768
View tabular results for nodal deflections ....
765
View tabular results for result lines .........767

View tabular results for solver element end
forces ...........................................................766
View tabular results for support reactions
.......................................................................765
View tabular results for wall lines ............767
View tabular solver model data ............... 764
View tabulated solver node and element
data ..............................................................764
View the dynamic masses for modal mass
combinations ..............................................769
View the revision history of drawings ..... 988
View the solver model used for a particular
analysis ........................................................733
View the summed mass for modal mass
combinations ..............................................768
View total masses by node ....................... 769
Walk (command) ...................................... 2203
Wall Panel (command) ............................ 2202
What is a solver model...............................633
Windows ribbon .......................................2232
Work with check lines.................................934

1
1st order nonlinear - Nonlinear Supports....
1650
1st order linear - 3D truss........................1648
1st order linear - Simple cantilever........ 1645
1st order linear - Simply supported square
slab............................................................. 1646
1st order linear - Thermal load on simply
supported beam....................................... 1649
1st order modal - Bathe and Wilson
eignenvalue problem............................... 1658
1st order modal - Simply supported beam....
1657
1st order nonlinear - Displacement loading
of a plane frame........................................1651
1st Order Nonlinear - Simple cantilever 1650

2
2nd order buckling - Euler strut buckling....
1659
2nd order buckling - Plane frame...........1659
2nd order linear - simple cantilever....... 1652
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2nd order linear - Simply supported beam
.................................................................... 1653
2nd order nonlinear - Compression only
element...................................................... 1656
2nd order nonlinear - Tension only cross
brace...........................................................1655

3
3D analysis ................................................1173
3D pre analysis processes....................... 1166

A
Accounting for lateral loading in chasedown
results ........................................................1182
Add materials for a head code................1016
Add overhangs to existing slab or mat edges
.......................................................................457
Add, edit and delete user-defined sections
.................................................................... 1004
Additional reinforcement for torsion
(Concrete beam: EC2) ..............................1954
Additional Tension Reinforcement (Concrete
beam: EC2) ................................................1952
Adjust and apply report settings...............953
All heights method................................... 1106
Allowing for global imperfections....
1149,1150,1151
Allowing for global second-order effects....
1138
Allowing for member imperfections...... 1151
Allowing for member imperfections (ACI/
AISC)........................................................... 1151
Allowing for member imperfections (BS)....
1152
Allowing for member imperfections
(Eurocode)................................................. 1152
Analysis limitations and assumptions......627
Analysis types in Tekla Structural Designer
.......................................................................623
Analysis verification examples................ 1645
Ancillaries.....................................................474
Angle and tee limitations (BS 5950) .......2042
Angle and tee limitations (EC3 Eurocode) ....
1928

Application of notional loads in
combinations (ASCE7) ............................. 1666
Apply attribute filters to material lists and
reports........................................................1030
Apply panel loads........................................538
Apply property sets to existing entities. 1023
Apply seismic loads.................................... 577
Apply wind loads manually without a wind
model........................................................... 565
ASCE Horizontal Design Spectrum............611
ASCE7/UBC Horizontal Design Spectrum
Taiwan.......................................................... 619
ASCE7/UBC Horizontal Design Spectrum
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